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Preface
This guide provides the information you need to work with your Forcepoint product.

Conventions
This guide uses these typographical conventions and icons.

Book title, term, emphasis Title of a book, chapter, or topic; a new term; emphasis.

Bold Text that is strongly emphasized.

User input, code, message Commands and other text that the user types; a code sample; a
displayed message.

Interface text Words from the product interface like options, menus, buttons, and
dialog boxes.

Hypertext A link to a topic or to an external website.

Note: Additional information, like an alternate method of accessing an
option.

Tip: Suggestions and recommendations.

Important/Caution: Valuable advice to protect your computer system,
software installation, network, business, or data.

Warning: Critical advice to prevent bodily harm when using a
hardware product.

Find product documentation
On the Forcepoint support website, you can find information about a released product, including product
documentation, technical articles, and more.

You can get additional information and support for your product on the Forcepoint support website at
https://support.forcepoint.com. There, you can access product documentation, Knowledge Base articles,
downloads, cases, and contact information.

http://forcepoint.com
https://support.forcepoint.com
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 PART I
Introduction to the
Forcepoint Next Generation
Firewall solution

Contents

• The Forcepoint Next Generation Firewall solution on page 25
• Introduction to Forcepoint NGFW in the Firewall/VPN role on page 31
• Introduction to Forcepoint NGFW in the IPS and Layer 2 Firewall roles on page 41

Before setting up Forcepoint™ Next Generation Firewall (Forcepoint NGFW), it is useful to know what the different
components do and what engine roles are available. Forcepoint NGFW was formerly known as Stonesoft® Next
Generation Firewall by Forcepoint.
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 CHAPTER 1

The Forcepoint Next Generation
Firewall solution

Contents

• Security Management Center on page 25
• Components in the Forcepoint NGFW solution on page 26
• Benefits of the SMC on page 28
• Licensing components and features on page 29

The Forcepoint NGFW solution consists of one or more Forcepoint NGFW Engines, and the Forcepoint NGFW
Security Management Center (SMC), formerly known as Stonesoft® Management Center by Forcepoint (SMC). The
SMC is the management component of the Forcepoint NGFW solution.

Security Management Center
The Security Management Center (SMC) is the centralized management component of the Forcepoint NGFW
solution. The SMC makes the Forcepoint NGFW solution especially well-suited to complex and distributed
network environments.

The SMC configures and monitors all components in the Forcepoint NGFW solution. The centralized
management system provides a single point of contact for many geographically dispersed administrators.

The unified management platform provides major benefits for organizations of all sizes:

• By allowing automatic coordinated responses when a security threat is detected, interaction between
components managed by the same Management Server creates security benefits. Automatic coordinated
responses provide instant blocking of unwanted traffic, and reduce the need for immediate human
intervention.

• Multiple administrators can log on at the same time to efficiently configure and monitor all NGFW Engines.
The SMC provides a single user interface. This interface allows unified configuration, monitoring, and
reporting of the whole Forcepoint NGFW solution with the same tools and within the same user session.

• The reuse of configuration information across components in the system allows you to:
• Avoid the laborious and error-prone duplicate work of configuring the same details for all components

individually.
• Export and import the configurations between multiple separate systems.

The SMC is designed to manage large installations and geographic distribution. The SMC design creates
flexibility and allows scaling up the existing components and adding new types of components to the system
without sacrificing its ease-of-use.
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Components in the Forcepoint NGFW
solution

The Forcepoint NGFW solution includes NGFW Engines, SMC server components, and SMC user interface
components.

 
Figure 1: Components in the Forcepoint NGFW solution

Number Component Description

1 Management
Client

The Management Client is the user interface for the SMC. You use the Management
Client for all configuration and monitoring tasks. You can install the Management
Client locally as an application, or you can start the Management Client with a web
browser using the Java Web Start feature. You can install an unlimited number of
Management Clients.

2 Web Portal The Web Portal is the browser-based user interface for the services provided by the
Web Portal Server.

3 Management
Server

The Management Server is the central component for system administration. One
Management Server can manage many different types of engines.

4 Log Server Log Servers store traffic logs that can be managed and compiled into reports.
Log Servers also correlate events, monitor the status of engines, show real-time
statistics, and forward logs to third-party devices.

5 Web Portal
Server

The Web Portal Server is a separately licensed optional component that provides
restricted access to log data, reports, and policy snapshots.

6 NGFW
Engines

NGFW Engines inspect traffic. You can use NGFW Engines in the Firewall/VPN,
IPS, or Layer 2 Firewall role.
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Management Clients
The Management Client is the tool for all day-to-day configuration and management tasks, including network
interface configuration and remote upgrades.

All commands and configuration changes are relayed through the Management Server, so the Management
Clients never connect to the NGFW Engines directly. Management Clients also connect to Log Servers to fetch
log entries for administrators to view. Many Management Clients can be deployed anywhere in the network.

Management Server
The Management Server is the central component for system administration. One Management Server can
manage many different types of engines.

The Management Server provides the following types of services:

• Administration and system commands: The Management Server is the central point of all administration tasks
(accessed through the Management Client).

• Configuration database: The Management Server stores all configuration information for Firewall/VPN, IPS,
and Layer 2 Firewall engines and other system components.

• Monitoring: The Management Server tracks the operating state of the system components and relays this
information to the administrators.

• Alert notifications: The Management Server can notify administrators about new alerts in the system, for
example, by sending out an email or an SMS text message.

• Certificate authorities (CAs): The Management Server installation includes two basic CAs:
• An Internal CA that issues all certificates that system components need for system communications.
• VPN CA that can be used to issue certificates for VPN authentication.

Log Server
Log Servers store traffic logs that can be managed and compiled into reports. Log Servers also correlate events.

Multiple Log Servers can be deployed, which is useful in geographically distributed systems. Log Servers provide
the following types of services:

• Log data: Log Servers receive and store logs from other system components and make the data available for
viewing and generating reports.

• Statistics and status data: Log Servers receive, relay, and store information about the operation of other
system components and keep a record available for generating reports.

• Event correlation: Log Servers detect patterns of events in traffic inspected by multiple NGFW Engines.

Web Portal Server
The Web Portal Server is a separately licensed optional component that can be used to provide restricted access
to log data, reports, and policy snapshots.

The Web Portal Server provides a web-based interface that users who have Web Portal user accounts can
access with their web browsers.
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Benefits of the SMC
The SMC has three main benefits: centralized remote management of system components, support for large-
scale installations, and server high availability.

Centralized remote management
A centralized point for managing all system components simplifies the system administration significantly.

Ease of administration is central to the SMC. The centralized management system:
• Provides administrators with visibility into the whole network.
• Simplifies and automates system maintenance tasks.
• Reduces the work required to configure the system.

You can also combine information from different sources without having to integrate the components with an
external system.

The centralized management system is not an add-on; the system has been designed from the start to be
centrally managed.

The main centralized management features in the Security Management Center include the following:

• Sharing configuration data in different configurations eliminates the need for duplicate work, which reduces the
complexity of configurations and the amount of work required for changes. For example, an IP address used
in the configurations of several different NGFW Engines has to be changed only one time in one place. It has
to be changed only once because it is defined as a reusable element in the system.

• Remote upgrades can be downloaded and pushed automatically to several components. A single remote
upgrade operation updates all necessary configuration details on the NGFW Engines, including operating
system patches and updates.

• Fail-safe policy installation with automatic rollback to prevent policies that prevent management connections
from being installed.

• The integrated backup feature allows saving all system configurations stored on the Management Server in
one manually or automatically run backup.

• Central access point for administrators with centralized access control. The Management Client requires
no separate installation, because it can be made available centrally and be started through a web browser.
Several administrators can be logged on at the same time and simultaneously change the system. Conflicting
changes are automatically prevented. Administrator rights can be easily adjusted in a highly granular way.

Support for large-scale installations
The Security Management Center is scalable from managing a single NGFW Engine up to a system consisting of
hundreds of components.

Several Log Servers are required in larger systems, but a single Management Server can still effectively manage
large installations. Features that make large-scale installations easy to manage include:
• The possibility to separate configurations into isolated Domains.
• To filter configuration definitions in and out of view based on user-defined categories.
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High availability
You can optionally install one or more additional Management Servers or Log Servers.

If the active Management Server is damaged, loses power, or becomes otherwise unusable, additional
Management Servers allow system control without delays and loss of configuration information. A special
Management Server license for multiple Management Servers is required.

Note:  The Forcepoint NGFW Security Management Center Appliance (SMC Appliance) does not
support high availability for the Management Server or the Log Server.

Log Servers can also be used as backups for each other to allow continued operation when a Log Server
goes offline. When a Log Server becomes unavailable, engines can automatically start sending new logs and
monitoring data to another pre-selected Log Server. Log Servers do not automatically synchronize their data, but
you can set up automatic tasks in the system for backing up important records.

Licensing components and features
License files provide your system a proof of purchase. The Management Server maintains license files.

You receive most licenses as proof-of-license (POL) codes. The proof-of-serial (POS) license code for Forcepoint
NGFW appliances is printed on a label attached to the appliances. Using your license code, you can log on to the
License Center and view and manage your licenses at: https://stonesoftlicenses.forcepoint.com.

Generally, each SMC server and each Firewall, IPS, Layer 2 Firewall, and Master NGFW Engine node must be
separately licensed in your SMC. Virtual NGFW Engines do not require their own licenses.

• The SMC components must always be licensed by importing a license file that you create at the Forcepoint
website.

• Licenses for Forcepoint NGFW appliances can be generated automatically. You might also need to generate
these licenses manually at the Forcepoint website, depending on the appliance model and Management
Server connectivity.

The use of some individual features is also limited by license.

All licenses indicate the latest version for which they are valid and are valid on all earlier software versions up
to the version indicated. Licenses are by default automatically updated to the newest version possible for the
component. If automatic license updates are not possible or disabled, you must generate new licenses manually
before upgrading to a new major release.

License upgrades are included in maintenance contracts. If the maintenance contract of a component expires, it
is not possible to upgrade the license to any newer version. Evaluation licenses are valid for 30 days.

https://stonesoftlicenses.forcepoint.com
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 CHAPTER 2

Introduction to Forcepoint NGFW
in the Firewall/VPN role

Contents

• Overview of Forcepoint NGFW in the Firewall/VPN role on page 31
• Forcepoint NGFW benefits on page 31

NGFW Engine in the Firewall/VPN role provides access control and VPN connectivity.

Overview of Forcepoint NGFW in the
Firewall/VPN role

Forcepoint NGFW in the Firewall/VPN role provides access control and VPN connectivity.

The term Firewall refers to the combination of the Forcepoint NGFW software in the Firewall/VPN role, and the
hardware device or the virtual machine that the software runs on.

Firewalls have the following representations in the SMC:

• The Single Firewall and Firewall Cluster elements are containers for the main configuration information directly
related to the Firewall.

• The individual physical engine devices are shown as one or more Nodes under the main Firewall element in
some views of the Management Client.

The Forcepoint NGFW software includes an integrated operating system (a specially hardened version of Linux).
There is no need for separate operating system patches or upgrades. All software on the engines is upgraded
during the software upgrade.

Forcepoint NGFW benefits
In addition to standard firewall features, the Forcepoint NGFW provides additional advanced features.

How Multi-Layer inspection works
Multi-Layer inspection combines application layer inspection, stateful inspection, and packet filtering technologies
flexibly for optimal security and system performance.

Like stateful inspection, the Forcepoint NGFW in the Firewall/VPN role uses state tables to track connections
and judge whether a packet is a part of an established connection. Forcepoint NGFW also features application-
layer inspection through specific Protocol Agents for enhanced security to inspect all data up to the application
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layer. Forcepoint NGFW in the Firewall/VPN role can also act as a packet filter for types of connections that do
not require the security considerations of stateful inspection.

By default, all Firewall Access rules implement stateful inspection. You can flexibly configure rules with simple
packet filtering or an extra layer of application level security as needed.

Forcepoint NGFW in the Firewall/VPN role applies application level inspection with or without proxying the
connections, depending on what is required. Application level inspection can be selected for certain types of
traffic by using a protocol-specific Protocol Agent for the connections.

Protocol Agents are also used to handle protocols that generate complex connection patterns, to redirect traffic
to proxy services, and to change data payload if necessary. For example, the FTP Protocol Agent can inspect the
control connection and only allow packets containing valid FTP commands. If an FTP data connection is opened
using a dynamically assigned port, the Protocol Agent detects the port and allows the traffic. If network address
translation (NAT) is applied to the connection, the Protocol Agent changes the packet payload IP address and
port. The Protocol Agent change allows the connection to continue despite the NAT.

Related concepts
Protocol Agents overview on page 1005

Layer 2 interfaces for Forcepoint NGFW in the
Firewall/VPN role
Layer 2 interfaces on NGFW Engines in the Firewall/VPN role allow the engine to provide the same kind of traffic
inspection that is available for NGFW Engines in the IPS and Layer 2 Firewall roles.

Layer 2 interfaces on NGFW Engines in the Firewall/VPN role provide the following benefits:

• When the same engine has both layer 2 and layer 3 interfaces, administration is easier because there are
fewer NGFW Engine elements to manage in the SMC.

• It is more efficient and economical to use one NGFW hardware device that has both layer 2 and layer 3
interfaces because a smaller number of NGFW appliances can provide the same traffic inspection.

• When you use layer 2 interfaces on NGFW Engines in the Firewall/VPN role, the NGFW Engine can use
options and features that are not available on NGFW Engines in the IPS or Layer 2 Firewall roles.
For example, an NGFW Engine in the Firewall/VPN role can use Forcepoint Endpoint Context Agent (ECA),
Forcepoint User ID service, NetLinks for communication with the SMC, and dynamic control IP addresses,
while also providing the same kind of traffic inspection that is available for NGFW Engines in the IPS and
Layer 2 Firewall roles.

Advanced traffic inspection
The Firewall’s traffic inspection process is designed to ensure a high level of security and throughput. The
Firewalls’ policies determine when to use stateful connection tracking, packet filtering, or application-level
security.

The Firewall uses the resources necessary for application-level security only when the situation demands it, and
without unnecessarily slowing or limiting network traffic.

Some types of connections can be selected for inspection of the data content against harmful or otherwise
unwanted patterns in connections. The deep packet inspection features provide IPS-type capabilities right on the
Firewall, and help in finding and stopping malicious or suspicious network activities. You can even inspect the
content of encrypted HTTPS connections using the built-in deep packet inspection features.
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An anti-malware scanner complements the standard traffic inspection features.

Deep packet inspection
Deep packet inspection includes measures such as malware detection, web content filtering, intrusion detection,
or some other check of the actual data being transferred.

Device performance limits can be quickly reached when several advanced inspection features are active. For this
reason, use these features in environments where the traffic load stays relatively low even at peak times. When
higher traffic volumes are needed, it is recommended to redirect traffic to proxy services and to use IPS devices.

Related concepts
URL filtering and how it works on page 989
Anti-malware scanning overview on page 1003

Built-in clustering for load balancing and high
availability
The Firewall provides innovative built-in clustering and load-balancing features that provide several benefits over
traditional solutions.

Traditionally, to achieve high availability on the firewall itself, additional hardware switches, software clustering
products, or special load-balancing devices have been added and maintained. This often results in the transfer of
a single point of failure to another network component — typically the network link.

Forcepoint NGFW Firewalls have built-in support for clustering, which allows operating up to 16 physical Firewall
devices as a single unit. All units can actively handle traffic at the same time. No special configuration is required
in the surrounding network as the whole implementation is achieved through basic networking standards.

The Firewall engines dynamically load-balance individual connections between the cluster nodes, transparently
transferring connections to available nodes in case a node becomes overloaded or experiences a failure. The
processing of network traffic is automatically balanced between the cluster nodes. This way, the performance of
the Firewall upgrades by simply adding new nodes to the cluster when necessary. You can also take individual
nodes offline during business hours for maintenance purposes. Connections handled by that particular engine are
transparently redistributed to other online nodes.

The Forcepoint NGFW Firewall also comes with built-in technology for high availability and load balancing
between different network connections.

Benefits of clustering
Clustering firewall nodes can significantly reduce the risk of problems with availability and maintenance.

A Single Firewall can be a single point of failure. This can affect the availability of business critical applications
and complicate the maintenance of the firewall equipment. Clustering firewall nodes can significantly reduce the
risk of these problems.

The Forcepoint NGFW solution uses built-in clustering technology. No additional software or hardware is needed
to cluster several nodes. If a node itself or the surrounding network equipment malfunctions, the other nodes in
the cluster take over the traffic processing, minimizing any disruptions to the traffic flow. Similarly, maintenance
is easier with a cluster, because individual nodes can be taken offline and even exchanged for new hardware
without causing service outages.
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Firewall Clusters also balance the load of traffic processing between the firewall nodes. You can flexibly add
nodes to scale up the Firewall Cluster, improving the throughput and performance.

Communication between Firewall Cluster nodes
Information between Firewall Clustered nodes is synchronized through selected interfaces via a heartbeat
network that uses multicast transmissions.

The Firewall Cluster nodes exchange information constantly. The state tables that list open connections (state
sync) and the operating state of the other nodes (heartbeat) are exchanged. This exchange of information
guarantees that all nodes have the same information about the connections. If a firewall node becomes
unavailable, the other nodes of the cluster immediately notice the change. The exchange of information
between clustered Firewall nodes is synchronized through selected interfaces via a heartbeat network using
multicast transmissions. The heartbeat messages are authenticated, and can also be encrypted if necessary.
Authentication is enabled by default.

Load balancing
In load-balanced clustering, traffic is balanced between the nodes dynamically.

In a Firewall Cluster configuration, the recommended way to cluster the nodes is load-balanced clustering, where
traffic is balanced between the nodes dynamically. Load-balanced clustering provides both fault tolerance and
performance benefits.

The traffic arriving at the Firewall Cluster is balanced across the nodes according to the settings of the cluster’s
load-balancing filter. This filtering process distributes packets between the firewall nodes and keeps track of
packet distribution. The Firewall determines the packet ownership of the nodes by comparing the incoming
packet with node-specific values based on the packet headers. The load-balancing filter is preconfigured for
optimal performance and is not meant to be adjusted independently by the system administrators.

The Firewall Cluster keeps track of which node is handling each ongoing connection. As a result, all packets
that are part of a given connection can be handled by the same node. Some protocols use multiple connections,
which are sometimes handled by different nodes, but this distribution does not usually affect the processing of the
traffic.

Standby operation
In standby clustering, only one node at a time processes traffic, and other nodes wait on standby.

Nodes that wait on standby are ready to take over when the currently active node goes offline. Nodes that should
not take over automatically can be set offline. The drawback with standby mode is that there is no performance
gain in clustering the firewalls.

Clustering modes for firewalls
You can configure traffic to be directed to the cluster using several modes.

There are several modes for how traffic can be directed to the cluster. The modes are explained in the following
table. If necessary, see the documentation for the router, hub, or switch you are using for information about which
mode is best in your environment:
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Table 1: Clustering modes

Mode Description

Packet dispatch Packet dispatch is the recommended clustering mode. One node per physical interface
is the dispatcher that handles the distribution of traffic between the different nodes for all
CVIs on that physical interface. The assigned node handles the traffic processing.

No additional switch configuration is needed.

This mode can also be used with hubs but it is not the optimal clustering mode with hubs.

Unicast MAC Unicast MAC is the recommended mode when hubs are used. This mode cannot be used
with most switches.

All nodes in the cluster share unicast MAC address for the CVI. All nodes in the cluster see
all packets

Multicast MAC The nodes share multicast MAC address for the CVI. All nodes in the cluster see all
packets.

Do not use this mode instead of the packet dispatch mode except in special cases, for
example, if MAC address of the network interface cards cannot be changed.

Multicast MAC
with IGMP

The clustering works otherwise the same as in the Multicast MAC mode except that the
engine answers to IGMP membership queries.

This mode allows limiting multicast flooding when the switch does not support static MAC
address forwarding tables.

All CVIs on the same physical interface must use the same mode. It is possible to set different cluster modes for
CVIs that are defined for different physical interfaces.

Packet Dispatch mode and how it works
In Packet Dispatch mode, one node acts as the dispatcher and assigns packets to the other nodes.

In Packet Dispatch mode, the node selected as the dispatcher on the physical interface assigns the packets to
itself or to some other node. The assigned node then handles the actual resource-intensive traffic processing.
The dispatcher attempts to balance the nodes’ loads evenly, but assigns all packets that belong to the same
connection to the same node. The node that acts as the packet dispatcher can be different for CVIs on different
physical interfaces. The following illustration shows an example of how packet dispatch handles a connection.
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Figure 2: Packet Dispatch CVI Mode

1 The dispatcher node for CVI 1 receives a new packet.

2 The dispatcher node either handles the packet itself or dispatches the packet to one of the other
firewall nodes for processing according to the load-balancing filter. The packet is sent to the other node
through the interface the packet arrived from.

3 The dispatcher node for CVI 2 forwards the replies within the open connection to the same node.

One node is responsible for handling each connection. The node responsible for the connection handles all
resource-consuming tasks: it determines if the connection is allowed to continue, translates addresses as
necessary, and logs the connection.

The dispatcher node controls the CVI’s IP address and MAC address. The other nodes use their own physical
interface’s MAC address for the same CVI. When the dispatcher node goes offline, one of the other nodes
becomes the dispatcher node. The new dispatcher node changes its interface’s MAC address to the address
defined for the Packet Dispatch CVI.

The network switch must update its address table without significant delay when the packet dispatcher MAC
address is moved to another firewall node. This operation is a standard network addressing operation where the
switch learns that the MAC address is located behind a different switch port. Then, the switch forwards traffic
destined to the CVI address to this new packet dispatcher.
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Multi-Link technology
Single-node and clustered Firewall installations both support Multi-Link, which guarantees high availability for
network connections by using alternative network links.

Multi-Link allows configuring redundant network connections out of standard network connections without the
complexity of traditional solutions that require redundant external routers and switches. There is no need to use
complex routing protocols, such as:
• Border gateway protocol (BGP) and hot standby routing protocol (HSRP)
• Peering arrangements between the ISPs.

Any IP-based link with a dedicated IP address range can be used as part of a Multi-Link configuration. You can
also define standby links that are used only when primary links fail. The illustration that follows shows a basic
Multi-Link setup with a Single Firewall that has two active and one standby network links to the Internet.

 
Figure 3: Multi-Link technology

Most often, multiple network links are used to guarantee continuity of Internet access, but Multi-Link can be used
to provide redundant links to internal networks as well. Traffic is dynamically balanced across the different links
based on a performance measurement or based on the links’ relative bandwidths. The traffic automatically fails
over to other links when the Firewall detects that one of the links fails. The Firewall uses NAT to direct the traffic
through the different links to make the source IP address valid for the link used.

Multi-Link technology provides highly available network connections for the following scenarios:

• Outbound connections: Multi-Link routing makes sure that outbound traffic always uses the optimal link toward
its destination and allows configuring standby links as backups. The traffic can be distributed across the links
in several different ways.

• Inbound connections: The built-in inbound traffic management feature can use Multi-Link to guarantee
continuity of services your company offers to external users.

• VPN connections: The Multi-Link tunnel selection for VPN traffic is done independently from other types of
traffic. Standby links can also be selected independently for a VPN.

Related concepts
Getting started with outbound traffic management on page 739
Using Multi-Link with Server Pools in inbound traffic management on page 755
Multi-Link and VPNs on page 1142
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Built-in inbound traffic management
The built-in Server Pool feature allows Firewalls to monitor a pool of alternative servers that offer the same
service to the users.

If one of the servers becomes unavailable or overloaded, the Firewall automatically redirects new connections
to the alternative servers. Server pools can also interact with the Multi-Link feature for high availability of the
incoming network connection.

Related concepts
Getting started with inbound traffic management on page 753

Quality of Service (QoS) and bandwidth
management
Quality of Service (QoS) Policies are interface-specific rules on a Firewall that help you ensure that important
network services are given priority over less important traffic.

With QoS rules, you can set up a minimum guaranteed bandwidth and maximum bandwidth limit for traffic, and
set a priority value for the traffic. You can optionally define settings for Active Queue Management (AQM) to
queue and send traffic according to a scheduling algorithm. Sending traffic reduces the volume of dropped or
retransmitted packets when there is network congestion.

Quality of Service and bandwidth management features are not supported for Modem interfaces of Single
Firewalls.

You can also create DSCP Match/Mark rules that read or write DiffServ Code Point (DSCP) type of service (ToS)
field values. Creating DSCP Match/Mark rules allows you to integrate the Firewall with other network equipment
that implements QoS management in your own or your ISP’s network.

Related concepts
Quality of Service (QoS) and how it works on page 949

Integrating Firewall/VPN with IPS and Layer 2
Firewalls
You can use Forcepoint NGFW in the Firewall/VPN, IPS, and Layer 2 Firewall roles together for traffic inspection.

IP address blacklisting is a shared feature for NGFW in the Firewall/VPN, IPS, and Layer 2 Firewall roles.
Blacklisting allows blocking harmful traffic not just at the component that detects it, but also on other engines on
the connection path.

Instead of using NGFW Engines in the IPS or Layer 2 Firewall role, you can also use layer 2 interfaces on NGFW
Engines in the Firewall/VPN role for traffic inspection.

Related concepts
Layer 2 interfaces for Forcepoint NGFW in the Firewall/VPN role on page 32
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Clustered Multi-Link VPNs
Forcepoint NGFW in the Firewall/VPN role provides fast, secure, and reliable VPN connections. The added
benefits of the clustering and Multi-Link technologies provide load balancing and failover for both the VPN
gateways and the network connections.

The system’s scalability allows administrators full control over how many tunnels are created and used.

The VPN links can be in three different modes: active, aggregate, and standby. If there are multiple links in active
mode, traffic is dynamically balanced across the different links based on a performance measurement or based
on the links’ relative bandwidths. If there are multiple links in aggregate mode, each connection is balanced
between all the aggregate links in round robin fashion. The standby links are only used if the active or aggregate
links fail.

Related concepts
VPNs and how they work on page 1127
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 CHAPTER 3

Introduction to Forcepoint NGFW
in the IPS and Layer 2 Firewall
roles

Contents

• What IPS engines and Layer 2 Firewalls do on page 41
• How IPS engines and Layer 2 Firewalls inspect traffic on page 42
• How IPS engines and Layer 2 Firewalls respond to incidents on page 42
• Main benefits of IPS engines and Layer 2 Firewalls on page 43
• IPS Cluster load balancing on page 44
• Disconnect mode for IPS engines and Layer 2 Firewalls and how it works on page 45

The NGFW Engines in the IPS and Layer 2 Firewall roles are part of the Forcepoint NGFW solution. The IPS
component provides intrusion detection and prevention, and the Layer 2 Firewalls provide access control and deep
inspection of traffic.

What IPS engines and Layer 2 Firewalls
do

An IPS engine or a Layer 2 Firewall is responsible for picking up and examining network traffic in real time. The
engines perform event correlation and analysis for traffic they inspect.

The engines can also initiate immediate responses to any threats that they detect. Depending on how they are
installed, engines can also block traffic based on commands that other components send.

IPS engines and Layer 2 Firewalls can be flexibly scaled up to form clusters of up to 16 devices that work as a
single virtual entity. Clustering IPS engines improves performance and provides high availability for the traffic
inspection service. Only one Layer 2 Firewall node in the Layer 2 Firewall Cluster is active at a time. The other
Layer 2 Firewall nodes remain in standby mode. If the active Layer 2 Firewall node fails, one of the standby
nodes automatically starts processing traffic.

The IPS engines and Layer 2 Firewalls include an integrated operating system (a specially hardened version
of Linux). There is no need for separate operating system patches or upgrades; all software on the engines is
upgraded during the software upgrade.

Layer 2 Firewalls are basic firewalls with a limited set of features. They provide access control and deep
inspection of traffic. More advanced firewall features such as VPNs and authentication are not supported on
Layer 2 Firewalls.
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How IPS engines and Layer 2 Firewalls
inspect traffic

There are two main phases in the traffic inspection process: detecting anomalies in traffic and normalizing the
suspicious traffic for closer inspection.

Layer 2 Firewalls and IPS engines examine traffic in a similar way. The main difference is that a Layer 2 Firewall
drops packets that have not specifically been allowed to pass according to the engine’s policy. An IPS engine, in
contrast, by default allows packets to pass if the engine’s policy does not set a more specific action.

First, the IPS engine or Layer 2 Firewall inspects the network traffic for any anomalies. If the engine detects
ambiguities in the traffic, it normalizes the traffic before inspecting it further. Traffic normalization also helps the
engine in detecting attempts to use evasion techniques (for example, packet fragmentation, TCP segmentation,
or combinations of evasions) to bypass inspection altogether.

In this process, known attacks are detected through attack signatures that are augmented with protocol
awareness to form powerful attack fingerprints. Protocol awareness decreases the number of false positives
compared to simple signatures. Each pattern is applied only to the correct type of traffic. For example, an attack
that uses HTTP can be detected when the pattern is seen in HTTP traffic. The HTTP pattern does not falsely
match an email message header transported over SMTP.

While fingerprinting accurately detects known attacks, it does not detect attacks that are not yet known. IPS and
Layer 2 Firewall engines provide two types of anomaly detection to complement fingerprinting:

• Protocol analysis identifies violations in network communications, such as unexpected data, wrong connection
states, and additional or invalid characters. Detecting such violations is useful because many attacks
purposely violate standards to trigger abnormal operating responses in vulnerable target systems.

• Statistical anomaly detection gathers traffic statistics to detect events such as slow scans and unusual number
of connections. This method tracks patterns based on frequency and sequence of events, or the occurrence of
sets of related events within a specified time range. For example, many connection attempts from one host to
many ports and IP addresses is certainly a network scan of some kind.

How IPS engines and Layer 2 Firewalls
respond to incidents

There are various responses that an IPS engine and a Layer 2 Firewall can take when it detects traffic of interest.
For example, they can log the connection or actively filter out the traffic.

Several responses are available:

• As the mildest response, an event can be logged. The log entries can be used, for example, for generating
statistical reports. Generating statistical reports might be appropriate, for example, for tracking trends in
normal network traffic patterns.

• A step up from a log entry is to generate an alert entry that can be escalated to administrators through multiple
configurable alert channels. Alert channels include email, mobile phone text messaging (SMS), and SNMP, in
addition to being used like log entries.

• Also, logs and alerts can record the full packet headers and data payload for further analysis.

Note:  Storing or viewing the packets’ payload can be illegal in some jurisdictions due to laws
related to the privacy of communications.
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• Blacklisting makes it possible to block unwanted network traffic for a specified time. IPS engines and Layer
2 Firewalls can add entries to their own blacklists based on events in the traffic they inspect. They can also
send blacklist requests to other NGFW Engines. Connections that match the blacklist are mainly stopped
(depending on the enforcing component’s policy).

The available responses on an IPS engine or Layer 2 Firewall depend on the engine’s physical configuration.

Main benefits of IPS engines and Layer 2
Firewalls

IPS engines and Layer 2 Firewalls have four key benefits: accuracy, manageability, scalability, and high
availability.

Accuracy of IPS engines and Layer 2 Firewalls
To provide the best possible accuracy, the IPS and Layer 2 Firewall engines provide multiple detection methods
that complement each other.

Effective response to network security incidents requires the capability to recognize an enormous number of
possible threats. The IPS system must not produce a high number of false alarms that:
• Engage the system administrators in needless investigations.
• Automatically stop legitimate business communications.

Attack signatures are supplemented with protocol-specific matching to produce accurate fingerprints of attacks.
The observations on network traffic are not passed on to administrators directly, but instead collected together for
further analysis and combined presentation.

What is considered to be a serious threat to a crucial system in one environment might not be considered an
event at all in another network. There is more than one set of traffic inspection policies that would work ideally
in every environment. So IPS and Layer 2 Firewall provides detailed customization possibilities for the entire
inspection process. The efficient configuration tools provide default policies that can be edited using drag and
drop, while still allowing highly detailed controls for advanced configuration.

With accurate detection results, efforts can be concentrated on countering real threats instead of working on
analyzing an endless stream of false alarms.

Manageability of IPS engines and Layer 2
Firewalls
IPS engines and Layer 2 Firewalls provide network administrators the tools to save time, reduce mistakes, and
get a network overview.

While ease-of-use is one of the main goals for the product, IPS engines and Layer 2 Firewalls do not achieve it
by cutting the available features. The system provides extensive inspection process tuning possibilities, detailed
information for monitoring, advanced automation, and tools for complete remote management (including all
software upgrades). The distributed architecture allows components to be on separate computers and in different
networks. Components can even be in different countries and continents – and still be easily managed as a
single system.
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An easy-to-use system helps the administrators concentrate on investigating the security threats instead of
configuring the security systems.

Scalability and high availability of IPS engines
and Layer 2 Firewalls
IPS engines must be scalable to meet the growing demands and high availability. Clustering combines devices
together in a single, virtual entity.

Introduction of new tools and services that rely on network access means that network traffic continues to grow
over time. Network traffic continues to grow even in companies that are not otherwise expanding.

Clustering also provides high availability for the intrusion detection services. If the system is down during an
attack, attackers have a head start. Having a head start allows the attackers to penetrate deeper into the network
and cover up their tracks. An IPS Cluster is a group of IPS nodes that work as a single logical entity to share the
load of traffic processing. A Single IPS is an IPS engine that consists of a single node. If a node in an IPS Cluster
stops processing traffic, the inspection can switch over to the other remaining IPS node transparently. If the
active Layer 2 Firewall node in a Layer 2 Firewall Cluster fails, one of the standby nodes automatically takes over
traffic inspection. This way, it is also possible to conduct online maintenance of individual IPS engines without
corresponding interruptions in traffic inspection.

IPS engines can be transparently clustered together into a single virtual entity in which the performance of each
node contributes to the total throughput. Clustering IPS engines allows new devices to be added flexibly as traffic
volumes grow while retaining the existing equipment and configurations. Clustering improves performance by
balancing the load intelligently between the clustered IPS nodes.

Optional high availability measures are also available for the Security Management Center.

Note:  The SMC Appliance does not support high availability for the Management Server or the
Log Server.

Scalability and high availability guarantee that the system can adapt to growing needs, simplify planned
maintenance, and protect against hardware failure.

IPS Cluster load balancing
In a load-balanced cluster, traffic is dynamically balanced between the nodes.

The recommended way to cluster the nodes in an IPS Cluster is load-balanced clustering, where traffic
is balanced between the nodes dynamically. Load-balanced clustering provides both fault tolerance and
performance benefits.

When load-balanced clustering is used, the traffic arriving at the IPS Cluster is balanced across the nodes with a
load-balancing filter. This filtering process distributes packets between the IPS Cluster nodes and tracks packet
distribution. The IPS Cluster determines the packet ownership of the nodes by comparing the incoming packet
with node-specific values based on the packet headers.

The IPS Cluster tracks which node is handling each ongoing connection. As a result, the same node can handle
all packets that are part of a given connection. Some protocols use multiple connections, which are sometimes
handled by different nodes, but this usually does not affect the processing of the traffic.
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Disconnect mode for IPS engines and
Layer 2 Firewalls and how it works

IPS engines and Layer 2 Firewalls support disconnect mode, which enables constant monitoring of link
connections and minimizes delays caused by link failures.

When IPS engines or Layer 2 Firewalls are deployed in inline mode, link failures cause significant traffic transfer
delays if the link failure is undetected. Failure to detect link failures can be prevented in disconnect mode.

If a link fails on one side of an Inline Interfaces pair, the IPS engine or Layer 2 Firewall:
• Detects the failure
• Simulates cable disconnection on the other side
• Takes down the other side's link transmitter (TX)

The IPS engine or Layer 2 Firewall continues to monitor the receiver (RX) side of a pair of Inline Interfaces. It
detects when the link is up again and brings the transmitter (TX) backup accordingly.

By default, disconnect mode is active on:
• All IPS appliances that support the feature
• On all Forcepoint NGFW appliances that are used in the IPS or Layer 2 Firewall role
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 PART II
Deployment

Contents

• Deploying the SMC on page 49
• Deploying Forcepoint NGFW in the Firewall/VPN role on page 55
• Deploying Forcepoint NGFW in IPS and Layer 2 Firewall roles on page 67

Before you can set up the system and start configuring elements, you must consider how the different SMC
components should be positioned and deployed.
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Deploying the SMC
Contents

• Overview of SMC deployment on page 49
• Security considerations for SMC deployment on page 50
• Positioning the Management Server on page 51
• Positioning Log Servers on page 52
• Positioning Management Clients on page 52
• Example: SMC deployment on page 53
• Post-installation steps for the SMC on page 53

When deploying the SMC, there are some general guidelines for positioning components to guarantee the security of
the system.

Overview of SMC deployment
The positioning of SMC components depends on the size and complexity of the network environment.

Supported platforms for SMC deployment
SMC server components can be installed on third-party hardware or they are available as a dedicated Forcepoint
NGFW Security Management Center Appliance (SMC Appliance).

Third-party hardware
CAUTION:  Do not install the SMC components on the Forcepoint NGFW hardware.

• You can install the SMC on third-party hardware that meets the hardware requirements. The hardware
requirements can be found at https://support.forcepoint.com.

• You can install all SMC server components on the same computer, or install separate components on different
computers.

• In a large or geographically distributed deployment, we recommend installing the Management Server, Log
Server, and optional Web Portal Server on separate computers.

https://support.forcepoint.com
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SMC Appliance
The Management Server and a Log Server are integrated with the hardware operating system as a dedicated
server appliance.

Management Client
Although the Web Start distribution of the Management Client is certified to run only on the listed official
platforms, it can run on other platforms. These platforms include Mac OS X and additional Linux distributions with
JRE (Java Runtime Environment) installed.

General SMC deployment guidelines
The basic SMC installation consists of a Management Server, a Log Server, and Management Clients.

It is possible to run the Management Server and the Log Server on the same computer in low-traffic
environments. In larger environments, the components are run on dedicated servers. Several Log Servers
might be needed in large or geographically distributed organizations. The Management Clients connect to the
Management Server for configuring and monitoring the system and to Log Servers for browsing the log entries.

Table 2: General guidelines for SMC deployment

SMC component General guidelines

Management Server Position on a central site where it is physically accessible to the administrators
responsible for maintaining its operation.

Log Servers Place the Log Servers centrally and locally on sites as needed based on log data volume
and administrative responsibilities.

Web Portal Server The Web Portal Server can be deployed in any location that has network access to the
Management Server and the Log Servers.

Management Clients Management Clients can be used from any location that has network access to the
Management Server and the Log Servers.

Security considerations for SMC
deployment

The information stored in the Security Management Center (SMC) is highly valuable to anyone conducting or
planning malicious activities in your network. Someone who gains administrator rights to the Management Server
can change the configurations.

An attacker can gain access by exploiting operating system weaknesses or other services running on the same
computer to gain administrator rights in the operating system.

Important:  Secure the Management Server computer. Anyone who has administrator rights to
the operating system can potentially view and change any SMC configurations.

Consider at least the following points to secure the Management Server and Log Server:
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• Prevent any unauthorized access to the servers. Restrict access to the minimum required both physically and
with operating system user accounts.

• We recommend allowing access only to the required ports.
• Never allow Management Client connections from insecure networks.
• Take all necessary steps to keep the operating system secure and up to date.
• We recommend that you do not run any third-party server software on the same computer with the SMC

servers.
• We recommend placing the servers in a separate, secure network segment without third-party servers and

limited network access.

You can optionally use 256-bit encryption for the connection between the engines and the Management Server.
This option requires both the engines and the Management Server to be version 5.5 or later. You must also use
an Internal ECDSA Certificate Authority to sign certificates for SMC communication.

When you create and use a new Internal ECDSA Certificate Authority to sign certificates for system
communication, the Management Server and the engine re-establish their trust relationship. After the
Management Server and the engine re-establish their trust relationship, 256-bit encryption is enabled for the
connection between the engines and the Management Server.

Related reference
Security Management Center ports on page 1429
Forcepoint NGFW Engine ports on page 1432

Positioning the Management Server
The Management Server is positioned on a corporate headquarters or data center central site where it can reach
all other Security Management Center (SMC) components.

The Management Server does not need to be close to administrators. The Management Clients connect to the
Management Server and Log Servers over the network using an encrypted connection.

We recommend using the same SMC to manage all your engines. This unified approach simplifies managing
physically distributed network environments and allows closer integration, for example, sending blacklist requests
from IPS engines to Firewalls. The configuration information and log data can then be shared and used efficiently
together. A single Management Server can manage many components efficiently. You can optionally install one
or more additional Management Servers for a High Availability setup. Only one Management Server is active at a
time. The additional Management Servers function as standby Management Servers.

Note:  The SMC Appliance does not support high availability for the Management Server or the
Log Server.

The Management Server also handles active alerts and alert escalation to inform the administrators of critical
events. In an environment with multiple Management Servers, all active alerts are replicated between the
Management Servers.
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Positioning Log Servers
Log Servers store engine-generated logs and traffic captures. Several Log Servers can be located both on a
central site as well as at remote sites.

The transferred amounts of data can be substantial, so the primary concern for Log Server deployment is the
number and throughput of the engine components that send data to the Log Server. A single shared Log Server
can be sufficient for a number of remote sites with low traffic volumes, whereas a large office with very high
volumes of network traffic might require even several Log Servers for efficient use.

Positioning Management Clients
The Management Client provides an interface for managing and monitoring the entire system.

With access to the Management Server and Log Servers, Management Clients can be used anywhere for:
• System administration
• Log and alert browsing

The Firewall/VPN and IPS engines are managed through the Management Server, so the Management Client
never connects directly to the engines.

The Management Clients can be installed locally or started through Java Web Start. The difference between
the installations is that locally installed clients are upgraded locally and individually. The Web Start installation
is updated centrally and the individual Management Client installations are automatically upgraded. Also, local
installations are possible only on supported Security Management Center platforms. Running the Web Start
version is also possible on other platforms that have the required version of Java runtime environment (JRE)
installed.
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Example: SMC deployment
In this example deployment, a company has operations in three different locations. There are some NGFW
Engines and administrators who are responsible for managing the local equipment at each site.

 
Figure 4: Example of a distributed Security Management Center (SMC) deployment

Site A is the main site of the company. The active Management Server that manages all local and remote
components is at Site A. The main administrators responsible for maintaining the server are also stationed there.
There are also two separate Log Servers at Site A. There are a high number of NGFW Engines at this site,
producing a high volume of logs. The Log Servers also work as backup servers for each other.

Site B is a large branch office that is also designated as the disaster recovery site for the main site. The most
important services are duplicated. This site has a moderate number of NGFW Engines. A separate Log Server is
installed at Site B to ensure swift log browsing for the local administrators.

Site C is a small branch office that has only a few NGFW Engines. There is a single local administrator who is an
infrequent user of the SMC. There are no SMC components at Site C; the local NGFW Engines send their data to
the Log Servers at Site A.

Post-installation steps for the SMC
After installing the SMC, you must complete some configuration tasks to guarantee the efficient management and
security of the system.

The basic administration tasks you must complete after installation include the following:

• Schedule automatic Backup Tasks to back up the essential configuration information stored on the
Management Server.

• Set up automated tasks to manage the gathered log data and prevent the Log Server storage space from
filling up with logs.

We also highly recommend that you set up the following features:

• Define additional administrator accounts and delegating administrative tasks.
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• Review settings for automatic updates and making sure the feature works to keep your system current.
• Define custom alerts and alert escalation policies.

To efficiently manage the system, you must also familiarize yourself with monitoring system operation.
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The positioning of a firewall depends on the network environment and the function of the firewall.

Supported platforms for Forcepoint
NGFW deployment

You can run NGFW Engines on various platforms.

The following general types of platforms are available for NGFW Engines:

• Purpose-built Forcepoint NGFW appliances

Note:  For information about supported appliance models, see Knowledge Base article 9743.

• VMware ESX and KVM virtualization platforms
• Microsoft Hyper-V virtualization platform (Firewall/VPN role only)
• Microsoft Azure cloud (Firewall/VPN role only)
• Amazon Web Services (AWS) cloud (Firewall/VPN role only)
• Third-party hardware that meets the hardware requirements

The NGFW Engine software includes an integrated, hardened Linux operating system. The operating system
eliminates the need for separate installation, configuration, and patching.

Related concepts
Hardware requirements for installing Forcepoint NGFW on third-party hardware on page 57
Configuration of Master NGFW Engines and Virtual NGFW Engines on page 515

https://support.forcepoint.com/KBArticle?id=Next-Generation-Firewall-appliance-software-support-table
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Deploying NGFW Engines on cloud-
based virtualization platforms

You can deploy NGFW Engines on cloud-based virtualization platforms, such as the Amazon Web Services
(AWS) cloud and the Microsoft Azure cloud.

NGFW Engines on cloud-based virtualization platforms provide VPN connectivity, access control, and inspection
for services hosted on cloud-based virtualization platforms.

For information about deploying NGFW Engines in the AWS cloud, see the document How to deploy Next
Generation Firewall in the Amazon Web Services cloud and Knowledge Base article 10156.

For information about deploying NGFW Engines in the Azure cloud, see the document How to deploy Next
Generation Firewall in the Azure cloud and Knowledge Base article 14485.

After deployment, you can manage NGFW Engines on cloud-based virtualization platforms using the
Management Client in the same way as other NGFW Engines. If you deploy NGFW Engines that use the scaling
feature, you can only preview the NGFW Engines and make changes to the Firewall policies.

Note:  Only the Firewall/VPN role is supported. Firewall Clusters, Master NGFW Engines, and
Virtual Firewalls are not supported.

Licensing
Two licensing models are supported.
• Bring Your Own License — You pay only the AWS or Azure standard runtime fee for the NGFW Engine

instance. You must install a license for the NGFW Engine in the SMC.
• Hourly (pay as you go license) — You pay the AWS or Azure standard runtime fee for the NGFW Engine

instance plus an hourly license fee based on the runtime of the NGFW Engine. No license installation is
needed for the NGFW Engine in the SMC.

Note:  In Forcepoint NGFW versions 6.1 and 6.2, only the Bring Your Own License model is
available for Forcepoint NGFW in the AWS cloud.

For features that require separate licenses, the SMC automatically detects which licensing model the NGFW
Engine uses.

Support for scaling in cloud-based
virtualization platforms
When NGFW Engines are deployed from the Microsoft Azure or AWS cloud environment, additional instances
can be created and removed, depending on traffic load.

You deploy the Cloud Auto-Scaled Firewalls from the cloud environment, and in the Management Client, the
Cloud Auto-Scaled Firewalls are automatically added to Cloud Auto-Scaled Group elements. You can monitor the
Cloud Auto-Scaled Firewalls in the Home View, for example.

https://support.forcepoint.com/KBArticle?id=How-to-deploy-Next-Generation-Firewall-in-the-Amazon-Web-Services-cloud
https://support.forcepoint.com/KBArticle?id=000014485
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Limitations
• Cloud Auto-Scaled Firewalls cannot be edited in the Management Client.
• The automatic scaling feature is only supported in the Azure cloud. In the AWS cloud, you must add and

remove instances manually.

Running NGFW Engines as Master
NGFW Engines

There are some hardware requirements and configuration limitations when you use an NGFW Engine as a
Master NGFW Engine.

Running the NGFW Engine as a Master NGFW Engine does not require a third-party virtualization platform.
When you run Forcepoint NGFW as a Master NGFW Engine, the Forcepoint NGFW hardware provides the virtual
environment and resources for the hosted Virtual NGFW Engines. You must always install the Forcepoint NGFW
software on a hardware device to run the NGFW Engine as a Master NGFW Engine.

You can run Master NGFW Engines on the following types of hardware platforms:

• Purpose-built Forcepoint NGFW appliances with 64-bit architecture
• Third-party hardware with 64-bit architecture that meets the hardware requirements

The following requirements and limitations apply when you use an NGFW Engine as a Master NGFW Engine:
• Each Master NGFW Engine must run on a separate 64-bit physical device.
• All Virtual NGFW Engines hosted by a Master NGFW Engine or Master NGFW Engine cluster must have the

same role and the same Failure Mode (fail-open or fail-close).
• Master NGFW Engines can allocate VLANs or interfaces to Virtual NGFW Engines. If the Failure Mode of

the Virtual IPS engines or Virtual Layer 2 Firewalls is Normal (fail-close) and you want to allocate VLANs to
several engines, you must use the Master NGFW Engine cluster in standby mode.

Related concepts
Hardware requirements for installing Forcepoint NGFW on third-party hardware on page 57
Configuration of Master NGFW Engines and Virtual NGFW Engines on page 515

Hardware requirements for installing
Forcepoint NGFW on third-party
hardware

There are some basic hardware requirements when you run Forcepoint NGFW on third-party hardware.

CAUTION:  Check that the Automatic Power Management (APM) and Advanced Configuration
and Power Interface (ACPI) settings are disabled in BIOS. Otherwise, the engine might not start
after installation or can shut down unexpectedly.
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CAUTION:  The hardware must be dedicated to the Forcepoint NGFW. No other software can be
installed on it.

The following basic hardware requirements apply:
• (Recommended for new deployments) Intel® Xeon®-based hardware from the E5-16xx product family or

higher

Note:  Legacy deployments with Intel® Core™2 are supported.

• IDE hard disk and CD drive

Note:  IDE RAID controllers are not supported.

• Memory:
• 4 GB RAM minimum for x86-64-small installation
• 8 GB RAM minimum for x86-64 installation

• VGA-compatible monitor and keyboard
• One or more certified network interfaces for the Firewall/VPN role
• Two or more certified network interfaces for IPS with IDS configuration
• Three or more certified network interfaces for Inline IPS or Layer 2 Firewall

Hardware for Firewall Cluster nodes
You can run different nodes of the same cluster on different types of hardware.

The hardware the cluster nodes run on does not need to be identical. Different types of equipment can be used
as long as all nodes have enough network interfaces for your configuration. Firewall Clusters can run on a
Forcepoint NGFW appliance, on a standard server with an Intel-compatible processor, or as a virtual machine on
a virtualization platform.

If equipment with different performance characteristics is clustered together, the load-balancing technology
automatically distributes the load so that lower performance nodes handle less traffic than the higher
performance nodes. However, when a node goes offline, the remaining nodes must be able to handle all traffic on
their own to ensure High Availability. For this reason, it is usually best to cluster nodes with similar performance
characteristics.

Guidelines for deploying Forcepoint
NGFW in the Firewall/VPN role

There are some general deployment guidelines for Firewalls, Master NGFW Engines, and the SMC.

Table 3: Guidelines for deploying Forcepoint NGFW in the Firewall/VPN role

Component General Guidelines

Management Server Position on a central site where it is physically accessible to the administrators
responsible for maintaining its operation.
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Component General Guidelines

Log Servers Place the Log Servers centrally and locally on sites as needed based on log data volume
and administrative responsibilities.

Management Clients Management Clients can be used from any location that has network access to the
Management Server and the Log Servers.

Management Server Position on a central site where it is physically accessible to the administrators
responsible for maintaining its operation.

Firewalls Position Firewalls at each location so that all networks are covered.
Firewalls can be clustered. Functionally, the Firewall Cluster is equal to a single high-
performance Firewall. Cluster deployment sets up a heartbeat link between the Firewalls.
The heartbeat link allows the devices to:
• Track each others’ operating status.
• Agree on the division of work.
• Exchange information on traffic.

Master NGFW
Engines

Position Master NGFW Engines where Virtual NGFW Engines are needed. For example,
at a hosting location for MSSP services or between networks that require strict isolation.
Master NGFW Engines can be clustered. A clustered Master NGFW Engine provides
scalability and High Availability. In a Master NGFW Engine Cluster, the Virtual Resource
is active in one Master NGFW Engine at a time. Cluster deployment sets up a heartbeat
link between the Firewalls. The heartbeat link allows the devices to:
• Track each others’ operating status.
• Agree on the division of work.
• Exchange information on traffic.

Positioning Firewalls
The Firewall is a perimeter defense, positioned between networks with different security levels.

Firewalls generally control traffic between:

• External networks (the Internet) and your internal networks.
• External networks (the Internet) and DMZ (demilitarized zone) networks.
• Between internal networks (including DMZs).

Firewalls separate the different networks by enforcing rules that control access from one network to another.
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Figure 5: The Firewall in different types of network segments

Not all organizations necessarily have all types of networks that are shown here. One Firewall can cover
all enforcement points simultaneously if it is practical in the network environment and compatible with the
organization’s security requirements.

In multi-layer deployment, a Firewall can have both layer 2 physical interfaces and layer 3 physical interfaces.
Layer 2 interfaces on Firewalls allow the engine to provide the same kind of traffic inspection that is supported on
IPS engines and Layer 2 Firewalls.
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Figure 6: The Firewall in a multi-layer deployment

1 Traffic inspection only

2 Routed traffic and traffic inspection

3 Layer 3 physical interface
These interfaces can route traffic.

4 Layer 2 physical interface of the inline IPS interface or inline Layer 2 Firewall interface type
These interfaces cannot route traffic. They can only provide traffic inspection.

5 Layer 2 physical interface of the capture interface type
These interfaces cannot route traffic. They can only provide traffic inspection.

6 DMZ network

7 Department A internal network

8 Department B internal network

9 Internal network

10 External networks
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Using firewalls to separate internal and
external networks
The most common and most important use for a firewall is to separate internal networks from the public Internet.

Table 4: External network considerations for firewalls

Description Implications on Firewalls

Main purpose Connectivity between the protected
and public networks.

The Firewall selects which traffic is permitted into
and out of the internal networks and translates
addresses between internal IP addresses and public
IP addresses. The Firewall is typically also a VPN
endpoint.

Hosts Only equipment directly connected
to the public network, such as
routers and the Firewall.

The communicating hosts in external networks are
unknown in many cases. IP address spoofing is a
possibility. External hosts can be trusted if they are
identified using VPN authentication mechanisms.

Users Access to this network is open,
but local access to the hosts is
restricted to the administrative staff
only.

Internal users are known and trusted. Users in
public networks are unknown and untrusted. VPN
authentication and encryption can be used to allow
specific users access from external networks to
internal resources.

Traffic volume Varies from low to high, generally
the full bandwidth of all Internet
links combined.

Hardware requirements vary depending on the
environment. Clustering allows flexible firewall
throughput adjustments. Multi-Link allows High
Availability and load balancing for outbound
connections. QoS Policies can control the bandwidth
use.

Traffic type Any type of traffic can be
encountered, especially in incoming
traffic.
Some filtering is done by the
Internet service provider.

The Firewall controls which traffic is allowed into your
networks. It is beyond the Firewall’s control what and
how much traffic it receives from the public networks.
Advanced inspection checks can be activated on
the Firewall and traffic can be redirected to a proxy
service, depending on the protocol.

Network security Little or no access controls to
pre-filter traffic arriving from the
Internet. Ensure that the hosts in
this network are security-hardened
and actively patched against known
vulnerabilities.

Ensure the Firewall’s policy is as restrictive as
possible. Generally, new connections are not allowed
from the external to the internal networks (servers
for external services are placed in DMZs). After use,
disable SSH access to the Firewall’s command line
from external networks.
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Using firewalls to separate internal networks
Internal networks are mixed environments with servers and end-user computers. Firewalls restrict traffic between
the different internal networks, but traffic within each network is often not secured in any significant way.

Table 5: Internal network considerations for firewalls

Description Implications on Firewalls

Main purpose Network services and connectivity
for authorized end users. Back-end
servers that serve other networks
and user groups.

Internal networks transfer confidential data but can be
permissive for the traffic within the network. Firewalls
can control access between different internal networks
to enforce different security levels and prevent some
types of network threats.

Hosts Mixed environment consisting of
servers, laptops, desktops, network
printers, and copiers.

Network communications of the servers and the end-
user computers differ in characteristics. Hosts can be
actively maintained and patched to reduce some types
of risks. Access between networks can be restricted
based on the type of host. Firewall logs provide a
record of network use and alerts can be configured for
unusual connection attempts.

Users Authorized personnel. Users can be considered trusted, but on various levels.
The Firewall authenticates users for access between
internal networks that have different security levels.

Traffic volume Varies from low to high. Grows
highest at network choke-points in
large environments.

Installation at network choke-points often requires
high-performance hardware. Clustering can provide
load balancing and High Availability in critical
locations.

Traffic type Diverse, with many different
applications communicating within
and in/ out of the network.

The Firewall policy must balance users’ demands for
a wide range of different services with the need to
keep the internal networks safe. Advanced inspection
features further inspect permitted communications.

Network security A “trusted network” where the users
and the traffic are considered to be
authorized.

The Firewall establishes boundaries between networks
to protect sensitive data and essential services.
Availability of network services sometimes overrides
security.
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Using firewalls to separate DMZ networks
DMZ networks (demilitarized zone networks, also known as perimeter networks) are isolated environments for
servers that offer services mainly for external access.

Table 6: DMZ considerations for firewalls

Description Implications on Firewalls

Main purpose DMZs provide a limited number of
services, mostly for external users.
The services are often business-
critical and open for public access.

The Firewall selects which traffic is permitted into
and out of the DMZs. The Firewall typically also
translates IP addresses from public IP addresses
that are routable in the external networks to private
addresses used in internal networks. VPNs can be
used to provide services for partner-type users.

Hosts A uniform environment consisting
mainly of servers that often provide
public or semi-public services.

A limited number of services are provided to an often
large number of hosts. Some types of administrative
access are allowed to a few specific trusted hosts.

Users Mostly unknown, but some
services can be for specific
users. Administrators have wider
permissions.

Users are often unknown or authenticated by the
target servers themselves. Firewall authentication
can be useful for restricting administrator rights from
internal networks.

Traffic volume Low to medium, generally the
full bandwidth of all Internet links
combined (shared with other local
networks). Traffic to other local
networks can be high in volume.

Hardware requirements vary depending on the
environment. Clustering allows flexible adjustments to
throughput. The inbound traffic management features
can balance traffic between redundant servers.

Traffic type Rather uniform traffic, with only
specific applications and servers
communicating within, into, and out
of the networks.

The Firewall controls which traffic is allowed access
in and out of each DMZ from external and internal
networks. Usually, only a few specific services have
to be allowed. Advanced inspection checks can be
activated on the Firewall and traffic can be redirected
to a proxy service, depending on the protocol.

Network security A network between the trusted and
untrusted security zones allowing
access for authorized and public
use.

External access to services makes the servers in a
DMZ a target for attacks. Connections between the
DMZ networks and to other internal networks facilitate
further attacks, so these connections must be strictly
controlled.

Post-installation steps for Forcepoint
NGFW in the Firewall/VPN role

There are some steps to follow after you have completed the installation, installed a basic policy, and turned the
Firewalls online.

Note:  The configuration information is stored on the Management Server. Most changes are
transferred to the engines only when you install or refresh the Firewall Policy.
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The basic administration tasks you must learn or complete next include the following:

• Read and control the operating state of Firewall engines.
• Adjust the automatic tester that monitors the operation of the Firewalls and the surrounding network.
• Develop your Firewall Policies further.

The most typical customization steps include:

• Configure multiple network connections for load-balanced, highly available networking.
• Configure traffic management for incoming connections to groups of servers.
• Set up bandwidth management and traffic prioritization policies.
• Configure the firewall to redirect traffic to proxy services.
• Configure secure connectivity between different locations and for traveling users.

Cable connection guidelines for
Firewalls

The cabling of Firewalls depends on the engine type and the installation.

Make sure that all copper cables are correctly rated (CAT 5e or CAT 6 in gigabit networks).

If you have a two-node Firewall Cluster, it is recommended to use a crossover cable without any intermediary
devices between the nodes. If you use an external switch between the nodes, follow these guidelines:

• Make sure that portfast is enabled on the external switches.
• Make sure that the speed/duplex settings of the external switches and the Firewall devices are set to Auto.
• Configure the external switches to forward multicast traffic.

For layer 2 physical interfaces on Firewalls, follow these cable connection guidelines:

• Capture interfaces — Follow the cable connection guidelines for IPS and Layer 2 Firewalls.
• Inline IPS interfaces — Follow the cable connection guidelines for IPS.
• Inline Layer 2 Firewall interfaces — Follow the cable connection guidelines for Layer 2 Firewalls.

Related concepts
Cable connection guidelines for IPS and Layer 2 Firewalls on page 89
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 CHAPTER 6

Deploying Forcepoint NGFW in
IPS and Layer 2 Firewall roles

Contents

• Supported platforms for Forcepoint NGFW deployment on page 67
• Running NGFW Engines as Master NGFW Engines on page 68
• Hardware requirements for installing Forcepoint NGFW on third-party hardware on page 68
• Guidelines for deploying IPS engines and Layer 2 Firewalls on page 69
• Positioning IPS engines and Layer 2 Firewalls on page 70
• Deploying IPS engines in IDS or IPS mode on page 73
• IPS deployment examples on page 80
• Post-installation steps for Forcepoint NGFW in the IPS role on page 84
• Deploying Layer 2 Firewalls in IPS or Passive Firewall mode on page 84
• Layer 2 Firewall deployment example on page 88
• Post-installation steps for Forcepoint NGFW in the Layer 2 Firewall role on page 88
• Cable connection guidelines for IPS and Layer 2 Firewalls on page 89
• Speed and duplex settings for NGFW Engines on page 92

The positioning of an IPS engine or Layer 2 Firewall depends on the network environment and the function of the IPS
engine or Layer 2 Firewall.

Supported platforms for Forcepoint
NGFW deployment

You can run NGFW Engines on various platforms.

The following general types of platforms are available for NGFW Engines:

• Purpose-built Forcepoint NGFW appliances

Note:  For information about supported appliance models, see Knowledge Base article 9743.

• VMware ESX and KVM virtualization platforms
• Microsoft Hyper-V virtualization platform (Firewall/VPN role only)
• Microsoft Azure cloud (Firewall/VPN role only)
• Amazon Web Services (AWS) cloud (Firewall/VPN role only)
• Third-party hardware that meets the hardware requirements

https://support.forcepoint.com/KBArticle?id=Next-Generation-Firewall-appliance-software-support-table
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The NGFW Engine software includes an integrated, hardened Linux operating system. The operating system
eliminates the need for separate installation, configuration, and patching.

Running NGFW Engines as Master
NGFW Engines

There are some hardware requirements and configuration limitations when you use an NGFW Engine as a
Master NGFW Engine.

Running the NGFW Engine as a Master NGFW Engine does not require a third-party virtualization platform.
When you run Forcepoint NGFW as a Master NGFW Engine, the Forcepoint NGFW hardware provides the virtual
environment and resources for the hosted Virtual NGFW Engines. You must always install the Forcepoint NGFW
software on a hardware device to run the NGFW Engine as a Master NGFW Engine.

You can run Master NGFW Engines on the following types of hardware platforms:

• Purpose-built Forcepoint NGFW appliances with 64-bit architecture
• Third-party hardware with 64-bit architecture that meets the hardware requirements

The following requirements and limitations apply when you use an NGFW Engine as a Master NGFW Engine:
• Each Master NGFW Engine must run on a separate 64-bit physical device.
• All Virtual NGFW Engines hosted by a Master NGFW Engine or Master NGFW Engine cluster must have the

same role and the same Failure Mode (fail-open or fail-close).
• Master NGFW Engines can allocate VLANs or interfaces to Virtual NGFW Engines. If the Failure Mode of

the Virtual IPS engines or Virtual Layer 2 Firewalls is Normal (fail-close) and you want to allocate VLANs to
several engines, you must use the Master NGFW Engine cluster in standby mode.

Hardware requirements for installing
Forcepoint NGFW on third-party
hardware

There are some basic hardware requirements when you run Forcepoint NGFW on third-party hardware.

CAUTION:  Check that the Automatic Power Management (APM) and Advanced Configuration
and Power Interface (ACPI) settings are disabled in BIOS. Otherwise, the engine might not start
after installation or can shut down unexpectedly.

CAUTION:  The hardware must be dedicated to the Forcepoint NGFW. No other software can be
installed on it.

The following basic hardware requirements apply:
• (Recommended for new deployments) Intel® Xeon®-based hardware from the E5-16xx product family or

higher
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Note:  Legacy deployments with Intel® Core™2 are supported.

• IDE hard disk and CD drive

Note:  IDE RAID controllers are not supported.

• Memory:
• 4 GB RAM minimum for x86-64-small installation
• 8 GB RAM minimum for x86-64 installation

• VGA-compatible monitor and keyboard
• One or more certified network interfaces for the Firewall/VPN role
• Two or more certified network interfaces for IPS with IDS configuration
• Three or more certified network interfaces for Inline IPS or Layer 2 Firewall

Guidelines for deploying IPS engines
and Layer 2 Firewalls

There are some general deployment guidelines for IPS engines, Layer 2 Firewalls, and the Security Management
Center (SMC).

Naturally, there are valid reasons to make exceptions to these general rules depending on the actual network
environment.

Table 7: General guidelines for IPS and Layer 2 Firewall deployment

Component General Guidelines

Management
Server

Position on a central site where it is physically accessible to the administrators responsible for
maintaining its operation.

Log Servers Place the Log Servers centrally and locally on sites as needed based on log data volume and
administrative responsibilities.

Management
Clients

Management Clients can be used from any location that has network access to the
Management Server and the Log Servers.

IPS engines Position IPS engines at each location so that traffic in all appropriate networks can be
inspected.
IPS engines can be clustered. Functionally, the IPS Cluster is equal to a single high-
performance IPS engine. Cluster deployments set up heartbeat links between the IPS engines.
The heartbeat links allow the devices to track each others’ operating status and agree on the
division of work.

Layer 2
Firewalls

Position Layer 2 Firewalls at each location so that traffic in all appropriate networks can be
inspected.
Layer 2 Firewalls can be clustered for High Availability. Only one Layer 2 Firewall node in the
Layer 2 Firewall Cluster is active at a time. If the active Layer 2 Firewall node goes offline,
another Layer 2 Firewall node automatically starts processing traffic.
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Component General Guidelines

Master NGFW
Engines

Position the Master NGFW Engines where Virtual NGFW Engines are needed. For example, at
a hosting location for MSSP services or between networks that require strict isolation. Master
NGFW Engines can be clustered. A clustered Master NGFW Engine provides scalability and
High Availability. In a Master NGFW Engine Cluster, the Virtual Resource is active in one
Master NGFW Engine at a time. Cluster deployments set up heartbeat links between the
engines. The heartbeat links allow the devices to track each others’ operating status, agree on
the division of work, and exchange information on traffic.

Positioning IPS engines and Layer 2
Firewalls

IPS and Layer 2 Firewall engines pick up passing network traffic for inspection in real time. The positioning of the
engines is the most critical part of the deployment.

Each engine can inspect the network traffic of one or more network segments in IDS and IPS configurations.

The following table describes the modes for IPS engines and Layer 2 Firewalls.

Table 8: Modes for IPS engines and Layer 2 Firewalls

Role Default Policy Mode Description

Inline In inline (IPS) mode, an IPS engine actively filters traffic. The
IPS engine is connected as a “smart cable” between two network
devices, such as routers and a switch. The IPS engine itself
does not route traffic: packets enter through one port, are
inspected, and exit through the other port that makes up the pair
of Inline Interfaces. Failover network interface cards (NICs) are
recommended on the IPS engine to allow network connectivity
when the IPS engine is offline. An inline IPS engine can also
transparently segment networks and control network access.

IPS Allows everything
that is not
explicitly denied
in the policy.

Capture In capture (IDS) mode, an IPS engine listens to network traffic
that is replicated to the IPS engine through:
• Port mirroring (switch SPAN ports)
• Dedicated network TAP devices

Inline In inline (IPS) mode, a Layer 2 Firewall engine actively filters
traffic. The engine is connected as a “smart cable” between
two network devices, such as routers. The engine itself does
not route traffic: packets enter through one port, are inspected,
and exit through the other port that makes up the pair of Inline
Interfaces. Fail-open network interface cards (NICs) can only be
used on the Layer 2 Firewall if the Failure Mode of the pair of
Inline Interfaces is Normal. An inline Layer 2 Firewall can also
transparently segment networks and control network access.

Layer 2
Firewall

Denies everything
that is not
explicitly allowed
in the policy.

Capture
(Passive
Firewall)

In capture (Passive Firewall) mode, a Layer 2 Firewall listens to
network traffic that is replicated to the Layer 2 Firewall through
port mirroring (switch SPAN ports).
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Role Default Policy Mode Description

Passive
Inline

A Layer 2 Firewall installs inline between two network devices,
such as routers and a switch, but does not filter traffic. An
inline Layer 2 Firewall can be set to Passive Firewall mode by
configuring the Layer 2 Firewall to only log connections.

The same IPS engine can be used for both IPS and IDS operation simultaneously. For example, an IPS engine
can be deployed inline to examine traffic from one network to another and capture traffic that stays within each
network.

Take the following into consideration when you decide where to install the engines:

• The critical assets to be protected and the potential attack paths.
• The most suitable locations along the attack path for detecting and responding to attack attempts to protect

the assets.
• The volume and profile of traffic to be inspected at each location.

Select the engine role based on the way the engine handles inspected traffic:

• Use a Layer 2 Firewall if traffic must be denied unless it is explicitly allowed.
• Use an IPS engine if traffic must be allowed unless it is denied.

 
Figure 7: Example of positioning engines in different network segments

The illustration outlines common deployment scenarios for IPS engines in general internal networks and in
DMZ networks. Layer 2 Firewalls can be used in similar scenarios. IPS engines and Layer 2 Firewalls are not
necessarily needed at each of these points in all environments. A single IPS engine or a single Layer 2 Firewall
can also cover several or even all scenarios simultaneously if the physical setup makes it practical.

Positioning IPS engines and Layer 2 Firewalls
in internal networks
In internal networks, access is permissive for purely internal communications, but there are strict controls at the
perimeter firewall that separates the internal network from public networks.

Inbound traffic from public networks to internal networks is forbidden with few exceptions.
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Table 9: Internal network considerations for IPS engines and Layer 2 Firewalls

Description Considerations for IPS engines and Layer 2 Firewalls

Main purpose Network services and
connectivity for authorized
users. Back-end servers that
serve other networks and user
groups.

IPS engines and Layer 2 Firewalls can be used within internal
networks and for strengthening the perimeter defense with
additional layers of inspection.

Hosts Mixed environment consisting
of servers, laptops, desktops,
network printers, and copiers.

IPS engines and Layer 2 Firewalls can control access between
internal hosts uncontrolled by other devices. Connections
between internal network zones are of particular interest for
inspection.

Users Authorized personnel. Access
in and out of the network
controlled by a Firewall.

End-user-controlled devices can be distinguished from other
hosts to create more accurate and fine-grained rules.

Traffic volume Varies from low to high.
Grows highest at network
choke-points in large
environments.

Installation at network choke-points where traffic levels are
high requires high-performance hardware. Clustering and load
balancing can be applied to increase performance and provide
High Availability in critical locations.

Traffic type Diverse with many different
applications communicating
within and in/ out of the
network.

A wide range of permitted applications means that the policy
has a wide scope. Access control and inspection can be fine-
tuned based on the security levels of the different network
segments or zones. TLS inspection can be activated to inspect
SSL/TLS encrypted traffic. The IPS engines and Layer 2
Firewalls can also detect and control Application use.

Network
security

A “trusted network” where
the users and the traffic are
considered to be authorized.

The primary line of defense is at the perimeter.
It is possible that authorized users in the trusted network
become willingly or accidentally involved in a security incident.

Positioning IPS engines and Layer 2 Firewalls
in DMZ networks
DMZ networks (demilitarized zone networks, also known as perimeter networks) allow inbound access to a wide
range of users, but are unified environments in terms of devices.

The services offered are limited in number as well and their allowed usage is often strictly defined.

Table 10: DMZ considerations for IPS engines

Description Considerations for IPS engines

Main purpose DMZs provide a limited
number of services for
external users. The services
are often business-critical and
open for public access.

DMZs are a tempting target for attacks because of their
accessibility, importance, and visibility. IPS engines provide
crucial protection in DMZs, unless the DMZs are already
protected by firewalls.
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Description Considerations for IPS engines

Hosts Often a uniform environment
consisting mainly of servers.
No outbound communication
is initiated from the DMZ to
the public networks.

Most sources are not trusted and IP address spoofing is
a possibility. Internal networks can be considered more
trustworthy if there is a Firewall that prevents IP address
spoofing.

Users Most services are public, but
some services might also
be offered to specific users.
Administrators have wider
permissions.

For recognized users, allowed and forbidden activities can be
specified in great detail for each type of access.

Traffic volume Low to medium, generally the
full bandwidth of all Internet
links combined (shared with
other local networks). Traffic
to other local networks can be
high in volume.

Hardware requirements vary greatly depending on the
environment. Clustering allows flexible adjustments to the
inspection performance.

Traffic type Rather uniform traffic, with
only well-known applications
and servers communicating
within and into the networks.

The limited, well-defined set of protocols and applications
means inspection can be tuned in great detail. If servers
provide HTTPS services, decrypting the traffic for inspection
might require heavy processing.

Network
security

A network between the trusted
and untrusted security zones
allowing access for authorized
and public use.

External access to services makes the servers in a DMZ a
tempting target for attacks. Connections between the DMZs
and other networks facilitate further attacks.

Deploying IPS engines in IDS or IPS
mode

IPS engines can be configured in IPS mode or IDS mode.

IPS deployment in IDS mode
One of the options in IDS mode is to use network TAP devices that copy packets for the IPS engines.

In an IPS Cluster, all nodes must receive all packets. The nodes agree over the heartbeat link which node
inspects which connections.
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Figure 8: Single IPS in IDS mode with a network TAP
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Figure 9: IPS Cluster in IDS mode with network TAPs
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Figure 10: Single IPS in IDS mode with a network TAP and an interface for sending resets

1 A pattern in captured traffic triggers the reset.

2 IPS sends a reset within the same broadcast domain to each communicating host posing as the other
host by using its IP address and MAC address.

 
Figure 11: IPS Cluster in IDS mode with network TAPs on a redundant link

1 Switches balance traffic across redundant links.

2 Links are combined into a Logical Interface to inspect whole connections.
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Packets can also be duplicated for inspection through a SPAN or mirror port on a switch/router. In an IPS Cluster,
each node must be connected to a SPAN or mirror port of its own. Hubs are not recommended, but you can
use hubs in configurations where the low performance of a hub is not an issue. For example, in a basic testing
environment.

 
Figure 12: IPS Cluster in IDS mode with SPAN/mirror ports

An IPS Cluster can be deployed alongside a Firewall Cluster. In this configuration, the IPS Cluster is in the same
broadcast domain as the Firewall.

 
Figure 13: IPS connected to SPAN ports alongside redundant switches

In a redundant disaster-recovery setup, Firewall Cluster nodes can be far apart. The IPS engines are not
clustered in this configuration, but they have identical policies.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Deploying Forcepoint NGFW in IPS and Layer 2 Firewall roles  | 78

 
Figure 14: Single IPS engines in a distributed disaster-recovery environment

IPS deployment in IPS mode
In an inline IPS configuration, the IPS engines are installed directly in the traffic path.

Fail-open network cards are recommended to allow traffic flow when the IPS engines are offline.

CAUTION:  Always use standard cabling methods with an inline IPS engine. Use crossover
cables to connect the appliance to hosts and straight cables to connect the appliance to switches.
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Figure 15: Single inline IPS engine

 
Figure 16: Serial IPS Cluster



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Deploying Forcepoint NGFW in IPS and Layer 2 Firewall roles  | 80

The same node handles the packets within a connection.

 
Figure 17: Redundant single inline IPS engines alongside a Firewall Cluster

IPS engines are connected alongside each individual Firewall engine. The IPS engines have the same policy, but
they are not clustered.

Note:  In this deployment scenario, the Medium-Security Inspection Policy must be used on the
IPS engines.

Related concepts
Cable connection guidelines for IPS and Layer 2 Firewalls on page 89

IPS deployment examples
These examples show how to deploy Forcepoint NGFW in the IPS role in an organization.

The scenario presented here is not meant to be representative of a typical installation. The main focus here
is to highlight some of the criteria that you can use when planning your deployment. The example covers
considerations that affect most installations, but is not an exhaustive list of the factors you might need to
consider. The IPS system could be deployed in alternative ways even in this example scenario, depending on
issues that are not covered here, such as the physical layout of the individual local networks, the hardware
available, and budget constraints.
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This example explains the IPS deployment at a company that has three offices: headquarters in London, a
branch office in Munich and a small satellite office in Vienna.

 
Figure 18: The example company’s networks

All offices have IPS components. There are also SMC components at the two larger sites. The example company
has some critical assets to protect and some of the networks experience a heavy traffic load. The example
company has decided on a High Availability solution for most locations and acquired the following components:

• Three IPS engines
• One Management Server
• Two Log Servers

Example: large-scale IPS installation
The following is an example of a large-scale installation with two Single IPS engines.

The example company’s main office at London has many end users and servers. The servers host nearly all
company external services and receive a high volume of traffic. The large end-user base generates a high
volume of network traffic as well. There are many different applications and protocols in use, resulting in a diverse
traffic pattern. The most important asset that the company wants to protect at its headquarters are the web
servers hosting the company’s online store. The main system administrators work at the main office site.
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Figure 19: Headquarters in London

In this case, the company has made the following decisions:

• Because most of the administrators are at this site, the Management Server that controls the whole distributed
system is located here.

• There are many administrators and components, so there is also a Log Server here.
• Several DMZs for different services handle a high total volume of traffic. Part of the traffic is encrypted HTTPS,

which uses significant processing power to decrypt for inspection. As the overall load is heavy, the company
decided to protect the DMZs using a dedicated high-performance Forcepoint NGFW appliance.

• A separate single IPS is installed to protect the diverse high-volume communications of the internal networks.
• The Management Server and the Log Server are placed in a dedicated DMZ for security.

Example: medium-scale IPS installation
The following is an example of a medium-scale installation with an IPS Cluster.

The example company’s branch office at Munich has a moderate number of end-user clients. Some services are
only offered at the London headquarters and used remotely through a VPN. There are still many local servers,
but mostly for internal and partner use. Also, there are some administrators at this location who are responsible
for the:
• Daily upkeep of the office infrastructure
• Small satellite office in Vienna
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Figure 20: Large branch office in Munich

In this case, the company has made the following decisions:

• Because there are administrators who browse logs extensively at this site, there is a dedicated Log Server
here.

• One IDS is installed to inspect the network traffic in a DMZ that supports partner access.
• The IPS Cluster is placed in a dedicated DMZ for security.

Example: small-scale IPS installation
The following is an example of a small-scale installation with a Single IPS engine.

The example company’s small satellite office at Vienna has a relatively low number of end-user clients, and
there are no servers of any major significance. Users rely mostly on the services at the Munich office, which they
access through a VPN. Also, the users have direct Internet access for general web browsing. There are no local
administrators. Administrators in Munich manage the systems remotely.

 
Figure 21: Small satellite office in Vienna

To inspect the low-volume traffic that the end users’ Internet and VPN-bound communications generate, the
company installs a Single IPS at the office. Since there are no local administrators and the traffic volumes are
low, the logs are sent to the Munich Log Server. When the logs are sent to the Munich Log Server, it is quick and
easy for the responsible administrators there to view and manage the data.
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Post-installation steps for Forcepoint
NGFW in the IPS role

There are some steps to follow after you have completed the installation, installed a basic policy, and turned the
IPS engines online.

Note:  The configuration information is stored on the Management Server. Most changes are
transferred to the engines only when you install or refresh the IPS policy.

The basic administration tasks you must learn or complete next include the following:

• How to read and control the operating state of IPS engines.
• Adjusting the automatic tester that monitors the operation of the IPS engines and the surrounding network.

After you have installed your first IPS policy, your next task is gathering information about the events detected
in your networks during a “tuning period”. Once you have enough information on what kind of traffic — malicious
and harmless — can be seen in your network, you can edit your policies to improve the detection accuracy and to
get rid of false alarms. The most typical customization steps include:

• Creating your own policy or policy template.
• Editing the Ethernet rules, Access rules, and Inspection rules.
• Creating your own custom Situations.

Deploying Layer 2 Firewalls in IPS or
Passive Firewall mode

Layer 2 Firewalls can be configured in IPS mode or Passive Firewall mode.

Layer 2 Firewall deployment in IPS mode
In an IPS configuration, the Layer 2 Firewalls are installed inline directly in the traffic path.

CAUTION:  Always use standard cabling methods with an inline Layer 2 Firewall. Use crossover
cables to connect the appliance to hosts and straight cables to connect the appliance to switches.
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Figure 22: Single inline Layer 2 Firewall
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Figure 23: Active/Standby Layer 2 Firewall Cluster

Related concepts
Cable connection guidelines for IPS and Layer 2 Firewalls on page 89

Layer 2 Firewall deployment in Passive Firewall
mode
In Passive Firewall mode, a Layer 2 Firewall inspects but does not actively filter traffic.

Layer 2 Firewalls can be deployed in Passive Firewall mode in two ways:

• In capture mode to inspect packets that have been duplicated for inspection through SPAN or mirror ports.
• In passive inline mode by setting the engine to only log connections by default.

In a capture mode installation, packets are duplicated for inspection through a SPAN or mirror port on a switch/
router. In a Layer 2 Firewall Cluster, each node must be connected to a SPAN or mirror port of its own.
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Figure 24: Passive Firewall: a Single Layer 2 Firewall in capture mode with SPAN/mirror ports

When you select Only Log Connection mode for the global Default Connection Termination, you can deploy
Layer 2 Firewalls in Passive Firewall mode in an inline configuration.

 
Figure 25: Passive Firewall: a Single Layer 2 Firewall in passive inline mode
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Layer 2 Firewall deployment example
This example shows how to deploy Forcepoint NGFW in the Layer 2 Firewall role in an organization.

The scenario presented here is not meant to be representative of a typical installation. The main focus here is to
highlight some of the criteria that can be used in planning deployment. The example covers considerations that
affect most installations, but does not comprise an exhaustive list of all factors that you might need to consider.
The Layer 2 Firewalls can be deployed in alternative ways in this example scenario. For example, depending
on issues that are not covered here, such as the physical layout of the individual local networks, the hardware
available, and budget constraints.

Single Layer 2 Firewall example
This example uses a Single Layer 2 Firewall in an organization that has a large internal network. Administrators
want to prevent hosts connected to different switches in the same network segment from communicating directly
at the protocol level. Using the Layer 2 Firewall makes it possible to implement access control for any Ethernet
protocols between switches within the same network segment. There is no need to change the network topology.

 
Figure 26: Single Layer 2 Firewall in an intranet

Post-installation steps for Forcepoint
NGFW in the Layer 2 Firewall role

There are some steps to follow after you have completed the installation, installed a basic policy, and turned the
Layer 2 Firewall engines online.

Note:  The configuration information is stored on the Management Server. Most changes are
transferred to the engines only when you install or refresh the Layer 2 Firewall Policy.

The basic administration tasks you must learn or complete next include the following:



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Deploying Forcepoint NGFW in IPS and Layer 2 Firewall roles  | 89

• How to read and control the operating state of Layer 2 Firewall engines.
• Adjusting the automatic tester that monitors the operation of the Layer 2 Firewalls and the surrounding

network.

After you have installed your first Layer 2 Firewall Policy, your next task is gathering information about the events
detected in your networks during a “tuning period”. Once you have enough information on what kind of traffic
— malicious and harmless — can be seen in your network, you can edit your policies to improve the detection
accuracy and to get rid of false alarms. The most typical customization steps include:

• Creating your own policy or policy template.
• Editing the Ethernet rules, Access rules, and Inspection rules.
• Creating your own custom Situations.

Cable connection guidelines for IPS and
Layer 2 Firewalls

The cabling of IPS engines and Layer 2 Firewalls depends on the engine type and the installation.

Make sure that all copper cables are correctly rated (CAT 5e or CAT 6 in gigabit networks).

Follow standard cable connections with inline IPS engines and Layer 2 Firewalls:

• Use straight cables to connect the IPS engines and Layer 2 Firewalls to external switches.
• Use crossover cables to connect the IPS engines and Layer 2 Firewalls to hosts (such as routers or Firewalls).

Note:  Fail-open network interface cards support Auto-MDIX, so both crossover and straight
cables might work when the IPS engine is online. However, only the correct type of cable allows
traffic to flow when the IPS engine is offline and the fail-open network interface card is in bypass
state. It is recommended to test the IPS deployment in offline state to make sure that the correct
cables are used.

Cable connections for Master NGFW Engines that host Virtual IPS engines or Virtual Layer 2 Firewalls follow the
same principles as the connections for inline IPS engines and Layer 2 Firewalls.
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Figure 27: Correct cable types for Single IPS engines and Single Layer 2 Firewalls

 
Figure 28: Correct cable types for Serial IPS Clusters
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Figure 29: Correct cable types for Active/Standby Layer 2 Firewall Clusters

 
Figure 30: Correct cable types for Serial Virtual IPS Clusters



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Deploying Forcepoint NGFW in IPS and Layer 2 Firewall roles  | 92

 
Figure 31: Correct cable types for Active/Standby Virtual Layer 2 Firewall Clusters

Speed and duplex settings for NGFW
Engines

Mismatched speed and duplex settings are a frequent source of networking problems.

The basic principle for speed and duplex settings is that network cards at both ends of each cable must have
identical settings. This principle also applies to the automatic negotiation setting: if one end of the cable is set to
auto-negotiate, the other end must also be set to auto-negotiate and not to any fixed setting. Gigabit standards
require interfaces to use auto-negotiation. Fixed settings are not allowed at gigabit speeds.

For Inline Interfaces, the settings must be identical on both links within each Inline Interface pair. Use identical
settings on all four interfaces, instead of just matching settings at both ends of each cable (two + two interfaces).
If one of the links has a lower maximum speed than the other link, the higher-speed link must be set to use the
lower speed.
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Figure 32: Speed/duplex settings
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 PART III
Setting up

Contents

• Using the Management Client on page 97
• Network address translation (NAT) and how it works on page 123
• Configuring system communications on page 127
• Managing elements on page 149

After deploying the SMC components, you are ready to start using the Management Client and carrying out some of
the first configuration tasks.
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 CHAPTER 7

Using the Management Client
Contents

• Management Client and how it works on page 97
• Log on to the SMC on page 104
• Log on to the SMC using certificate-based authentication on page 105
• Customize the Management Client layout on page 106
• Bookmark Management Client views on page 107
• Change the logon view on page 109
• Centralized management of global system settings on page 109
• View, approve, and commit pending changes on page 110
• Create logon banners and export banners on page 112
• Change the default language of the Management Client on page 113
• Using search features on page 114
• Communicating with other administrators on page 118
• Use Tools Profile elements to add commands to elements on page 119
• Use the online Help locally on page 120

The Management Client provides the user interface for setting up, managing, and monitoring all features in the SMC.

Management Client and how it works
Use the Management Client for configuring, controlling, and monitoring the Security Management Center (SMC).

You can manage the NGFW Engines in the Management Client. You can also use the Management Client to
monitor third-party devices.

The Management Client offers several task-specific views. There are alternative ways to switch between the
different views:

• The main menu and the toolbar shortcuts are always available.
• More links are provided, for example, in the right-click menus of elements and in the logs. You can also

bookmark your most frequently visited views.

You have several options for opening a new view:

• Clicking a link or main toolbar icon replaces the current view with the new one.
• Clicking while holding the Ctrl key opens the new view as a new tab.
• Clicking while holding the Shift key opens the new view as a new window.

To open a new empty tab, click  New Tab on the right of the previous tab. You can also use the keyboard
shortcut Ctrl+T. From the list of views that opens, select the view to be shown in the new tab.
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Related concepts
Introduction to elements on page 149
Getting started with monitoring the system on page 179
Overviews and how they work on page 196
Getting started with the Logs view on page 241
System monitoring tools in the Management Client on page 180

Related tasks
Change the logon view on page 109

What the Logs view shows
The Logs view can show entries generated by any SMC components and third-party components that send data
to the SMC.

The logged data includes alert and audit entries (depending on administrator rights). You can filter the display by
any combination of details that exist in the records. There are four different arrangements: Records, Statistics,
Details, and Log Analysis.

Records arrangement
The Records arrangement allows you to view selected details of many entries at a time. The columns in the table
are fully customizable. This default view arrangement displays logs as a table. The Query pane allows you to
select data to display.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Using the Management Client | 99

 
Figure 33: The Logs view in the Records arrangement

Statistics arrangement
The Statistics arrangement allows you to generate basic summaries of the log data currently displayed in the
Logs view. The basic summaries are similar to the charts in overviews, and include the ability to drill into the logs
through individual chart items.
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Figure 34: Statistics arrangement

Details arrangement
The Details arrangement gives an overview of an individual log entry.
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Figure 35: Details arrangement

Log Analysis arrangement
The Log Analysis arrangement provides various tools to analyze and visualize log data. For example, you can
combine logs by service or situation, sort logs by column type, view the data as charts or diagrams. The various
tools make it easier to notice patterns and anomalies in traffic.
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Related concepts
Getting started with the Logs view on page 241

What the Configuration view shows
The Configuration view allows you to view, change, and add configuration information in the system.

There are branches in the Configuration view for NGFW Engine, Network Element, VPN, Administration,
Monitoring, and User Authentication configuration tasks.

The configurations are stored as elements, which are shown in a tree structure. Elements are created and
changed through the right-click menus that open when you right-click a tree branch or an element. The main level
of the branches contains the elements that change most often. Supporting and less frequently changed elements
can be found under the Other Elements branch.

• The NGFW branch allows you to manage NGFW Engine elements and configure NGFW Engine policies.
• The Network Elements branch allows you to manage various hosts, networks, and servers.
• The VPN branch allows you to configure VPNs, VPN Gateways, and SSL VPN Portals.
• The Administration branch allows you to manage the system, including access rights, updates, licenses,

administrator accounts, and alert escalation.
• The Monitoring branch allows you to create statistical reports, diagrams, and configure more monitoring-

related features (such as third-party device monitoring).
• The User Authentication branch allows you to configure user authentication and directory services, and

manage user accounts.
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Figure 36: NGFW branch of the Configuration view

Related concepts
Introduction to elements on page 149

The Policy Editing view
The instructions for traffic handling are stored as rules in Policy elements. You can view and edit the rules in the
Policy Editing view.

You can open policies in two modes. Any number of administrators can simultaneously check the rules in preview
mode. When you open the policy in edit mode, the policy is locked for you exclusively.

The Policy Editing view has tabs for:
• Different types of rules in the policy
• Side pane for selecting and creating elements that you use in the rules

Related concepts
Getting started with policies on page 787

Reporting
The reporting feature allows you to create statistical summaries based on log data and stored statistical data. The
Reports can be viewed in the Management Client or exported automatically or manually.

Related concepts
Getting started with reports on page 269
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Log on to the SMC
The Management Client connects to the Management Server and to Log Servers.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select the Management Server in one of the following ways.
• Select an existing Management Server IP address or DNS name.
• Click Add Server, then enter the IP address or DNS name of the Management Server.

In Demo Mode, select 127.0.0.1.

2) Enter the user name and password for the Administrator you defined during the Management Server or SMC
Appliance installation.
In Demo Mode, use the following credentials:
• User name — demo
• Password — demo

Note:  In FIPS mode, previously used user names are not shown in the logon dialog box.

3) Click Log On.

Result

After you log on to the Management Client, the Management Client shows the date and time when you last
logged on to the Management Client, and the IP address from which you last logged on. If your administrator
permissions have been changed since the last time you logged on, you are notified that your permissions have
been changed.
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Log on to the SMC using certificate-
based authentication

You can log on to the SMC using an X.509 certificate stored in the Windows certificate store or on a smart card,
such as a Common Access Card (CAC).

Before you begin
To use smart cards for authentication, you must have smart card reader hardware and software.

To use certificate files for authentication, you must save the certificates in the Windows certificate store.

You must export the TLS Credentials element that is used by the Management Server, import the
certificate on each administrator's computer, and configure the operating system to trust the certificate.

Note:  Certificate-based authentication is only supported for Management Clients installed in
Windows 10.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If you have a smart card, insert the smart card into the smart card reader.

2) Select Use Client Certificate Authentication.

3) Select the Management Server in one of the following ways.
• Select an existing Management Server IP address or DNS name.
• Click Add Server, then enter the IP address or DNS name of the Management Server.

4) (First logon only) To accept the certificate chain for the Management Server, click Accept.

5) If there is more than one certificate on the smart card or in the Windows certificate store, select the certificate
to use for authentication, then click Select.

6) (Smart card only) In the PIN field, enter then PIN for the smart card, then click Login

Result

After you log on to the Management Client, the Management Client shows the date and time when you last
logged on to the Management Client, and the IP address from which you last logged on. If your administrator
permissions have been changed since the last time you logged on, you are notified that your permissions have
been changed.
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Customize the Management Client layout
You can select different panes and view options through the  Menu > View menu. You can also change the
size of the text in various views.

Some layout options are specific to the currently active view, and some options are global. The layout is saved as
your preference for further use.

Tip:  Bookmark alternative layouts to quickly return to a specific view and layout at any later time.

Steps

1) To resize a pane, drag by the outer edge of the pane as usual when resizing.

2) To move a pane, drag by the title bar at the top like you would move a window.
You can move the panes in several positions that are highlighted as you drag the pane around. Drop the
pane where you prefer to have it. If the highlighted area completely covers some other pane, the second
pane adds a tab.

 

3) To temporarily hide a pane, select the collapse icon on the pane border.
 

To expand the pane, click the icon again.

4) To change the size of the text in policies, Configuration views, or the Logs view, for example, select 
Tools > Text Size.

5) To restore the views to their defaults, select  Menu > View > Layout > Reset Layout.
The text size is not affected.
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Bookmark Management Client views
Bookmark frequently used views and arrange bookmarks into folders to more easily find them.

Bookmarks can store many of the settings you have selected in views. For example, you can bookmark a Logs
view with particular filtering settings. Several windows and tabs can be stored behind a single click when you
combine bookmarks into Bookmark Folders.

Bookmarks in the default Shared Bookmarks folder are shown to all administrators that log on to the same
Management Server. Other bookmarks are private to the Management Clients of individual administrators.

Bookmark the current view in the Management
Client
You can create a bookmark for the currently active tab and other window-level elements in the configuration you
select.

Some view-specific options are stored in bookmarks. For example, the:
• Currently active filter in the Logs view.
• Type of elements that are listed in a Configuration view at the time the bookmark is created.

Bookmarking is a main window action, so the properties dialog boxes for the various elements are never included
in the bookmark.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Arrange the view as you would like to see it when the bookmark is opened.

2) Select  Menu > Bookmark > Add Bookmark.

3) (Optional) The default name is taken from the bookmarked view’s title, but you can change the name in the
Name field. You can also add comments for your reference in the Comment field.

4) (Optional) Next to the In Folder field, click Select and select the folder where the bookmark is placed.
• The default Bookmarks creates the folder at the top level of the bookmarks tree.
• Select the Shared Bookmarks folder if you want other administrators to see this bookmark. All other

folders are private to your Management Client.
• Select the Toolbar folder or one of its subfolders to add the bookmark folder to the toolbar. If the Toolbar

folder is not available, activate the bookmarks toolbar.

5) (Optional) Deselect Window Layout if you prefer the bookmark to not change the layout of the window when
you open it.

6) Click OK.
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Bookmark all open tabs in the Management
Client
You can create a Bookmark Folder that contains bookmarks for all tabs you have open in the same window.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the tabs you want to bookmark in the same window.

2) Close any tabs you do not want to bookmark.

3) Select  Menu > Bookmark > Bookmark All Tabs.

4) Fill in the Bookmark Folder properties and click OK.

Create bookmark folders in the Management
Client
Bookmark folders organize bookmarks and make it easier to open several bookmarks at once.

The folders you create are also added as items under the  Menu > Bookmark menu.

Tip:  You can bookmark all open tabs in a bookmark folder that is automatically created to contain
new bookmarks.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > Bookmark > Manage Bookmarks.

2) Right-click Bookmarks in the tree, then select New Bookmark Folder.

3) Enter a name in the Name field. You can also add comments for your reference in the Comment field.

4) (Optional) Click Select next to the In Folder field, then select the folder where the bookmark is placed.
• The default Bookmarks creates the folder at the top level of the bookmarks tree.
• Select the Shared Bookmarks folder if you want other administrators to see this bookmark. All other

folders are private to your Management Client.
• Select the Toolbar folder or one of its subfolders to add the bookmark folder to the toolbar. If the Toolbar

folder is not available, activate the bookmarks folder.

5) Click OK.
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Add bookmarks to the toolbar in the
Management Client
You can add your bookmarks to the toolbar under the shortcut icons.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > View > Layout > Bookmark Toolbar.
The bookmark toolbar is shown under the toolbar icons.

2) Click the default New Toolbar Folder item.

3) Enter the name for the first folder to add to the toolbar and click OK.
The first folder appears in the toolbar. The Toolbar folder is added to the bookmark hierarchy, allowing you
to add, remove, and edit the bookmarks in the toolbar.

Next steps

Add bookmarks to the toolbar by storing the bookmark in the Toolbar folder or one of its subfolders. Move
existing bookmarks to the toolbar by dragging and dropping the bookmark or bookmark folder to the Toolbar
folder in the  Menu > Bookmark > Manage Bookmarks tree.

Change the logon view
You can choose which view opens when you log on to the Management Client, replacing the default Home view.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Arrange the screen with the windows, tabs, and views you want to have open at each logon.

2) Select  Menu > Bookmark > Save as Startup Session.

Centralized management of global
system settings

Use the Global System Properties dialog box to centrally manage global system settings and configure password
policy settings.

Note:  You can only change the settings when you are logged on to the Shared Domain.
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The dialog box has the following tabs:
• Updates — Contains settings related to updates, upgrades, and licenses. Only administrators with Manage

Updates and Upgrades permissions can change these settings.
• Change Management — Contains an option for enforcing an approval workflow. Only administrators with

unrestricted permissions (superusers) can change this setting.
• Password Policy — Contains settings for password strength, password expiration, failed logons, and actions

related to temporary and long-term inactivity. Only administrators with Manage Administrator permissions can
change these settings.

• Global Options — Contains options for showing users in the Home view.
Also contains an option for authorizing McAfee® Global Threat Intelligence™ (McAfee GTI) and McAfee®

Threat Intelligence Exchange (TIE) usage. Only administrators with unrestricted permissions can enable
McAfee GTI and Threat Intelligence Exchange.

• Logon Banner — Contains the settings and text entry for the message displayed to all administrators in the
Select a Management Server logon screen.

Note:  The text from the banner also appears in the logon window of the SMC Appliance
console and Web Portal.

Related tasks
Configure automatic updates and upgrades on page 1258

View, approve, and commit pending
changes

You can view the configuration changes that you and other administrators have made before the new
configurations and policies are transferred to the NGFW Engines. If an optional approval workflow is enforced,
changes must be approved before they are transferred to the engines.

Before you begin
You must refresh the policy on the target engine or engines after an upgrade to NGFW 6.2 before you
can see the pending changes in the Management Client.

Pending changes are shown by default in the Home view for all engines and on the engine-specific home pages.

You can view, commit, and transfer pending changes to the engines. You can use pending changes to prevent
transferring configurations that are not complete. You cannot reject individual changes. If you want to override
a change, edit the element or policy again, then approve both changes. If a later change overrides an earlier
change, only the most recent change is transferred to the engine.

You can optionally enable an approval workflow in which an administrator must approve changes before they are
committed. For example, a supervisor or senior administrator can view and approve the changes made by other
administrators. Administrators with the following permissions can view the changes, approve the changes, and
transfer the configurations to the engines:

• Administrators that have the Approve Changes permission
• Administrators with unrestricted permissions (superusers)
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By default, the same administrator who made the changes cannot approve the changes. You can optionally allow
administrators to approve their own changes.

You can approve pending changes individually, but you must commit all of the changes at the same time. You
can commit pending changes only when all changes have been approved.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) (Optional) To compare the pending changes to the engine's current policy, click View Changes on the home
page of the engine.

2) (Optional) To view recent policy uploads, click View Recent Commits. To return to the Pending Changes
pane, click View Pending Changes.

3) If an approval workflow is enforced, approve some or all pending changes.
• To approve an individual pending change, click the Approval Status checkmark icon for that change.
• To approve all changes, click Approve All.

4) To commit all pending changes and transfer them to the engine or engines, click Commit Changes.

Result

The changes made to configurations and policies by all administrators are transferred to the engines.

Related concepts
What the Pending Changes pane shows on page 187

Related tasks
Enforce an approval workflow on page 362
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Create logon banners and export
banners

You can create logon banners that show all administrators information about the selected Management Server,
and export banners that are added to exported elements to indicate that the export contains sensitive or classified
data.

Create logon banners for administrators
Create a banner that shows all administrators information about the selected Management Server.

Before you begin
You must be logged on as an administrator with unrestricted permissions in the Shared Domain to
create logon banners.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Global System Properties.

2) On the Banners tab, select Show Logon Banner.

Note:  The logon banner is not enforced by default.

3) In the text box, enter the text for the logon banner.
You can use HTML to format the text.

4) Click OK.

Create export banners
You can create a banner that is added at the beginning of each exported XML file or HTML file to indicate that the
export contains sensitive or classified data.

Export banners are added to the following kinds of exports:

• Elements exported as XML
• HTML printouts
• HTML reports

Note:  Export banners are not added to log data that is exported or forwarded.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Global System Properties.

2) On the Banners tab, select Include Export Banner.

Note:  The export banner is not enforced by default.

3) In the text box, enter the text for the export banner.
Only plain text is supported.

4) Click OK.

Change the default language of the
Management Client

Each administrator can change the default language of the Management Client during installation or manually
after installation. The options are English and Japanese.

Before you begin
During a local installation of the SMC, you can set the default language of the Management Client to
English or Japanese in the installation wizard. Each administrator can select English or Japanese in the
logon dialog box when logging on to the Management Client.

Steps

1) To change the language after installation, locate the locale.properties file in the <user>/.stonegate/
user_locale folder.

2) Change the smc.locale.default setting in the locale.properties file to the language you want:
• smc.locale.default=ja for Japanese
• smc.locale.default=en for English

3) Save changes to the locale.properties file.
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Using search features
You can search for elements, references to other elements, duplicate IP addresses, duplicate Service elements,
unused elements, users, and elements in the Trash.

Note:  Administrator permissions restrict which elements appear in the search results. Each
administrator only sees elements for which they have permissions. If you use administrative
Domains, the search results only show elements in the Domain that you are currently logged in to,
and elements in the Shared Domain.

Use the search bar
The search bar is always shown at the top of the Management Client window. You can search for elements,
policies, and folders, for example.

The search results are grouped and ranked by relevance. When editing an element or a policy, you can drag-
and-drop elements from the search results list. You can also perform tasks from the search results. For example,
if you search for “password”, in the Actions category, you can change the Management Server database
password. If you search for the name of an engine, you can open the Engine Editor in preview mode.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Enter a search word or phrase in the search bar.

2) To open the properties of an element in the search results, click the element.
If you click a policy or engine, the policy or engine opens in preview mode.

Tip:  If you search for an element type, you can create a new element under the New
category.
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3) To preview an element in the search results list, place the cursor over the element.

Tip:  You can also use the keyboard arrow keys to move up and down in the list.

You can see some of the properties of the element. You can also perform some drill-down actions, such as
checking where an element is used.

4) To view a full list of search results, select  Show All Matching Elements.
The element search view opens, and your search criteria is used automatically.

Use type-ahead search
Type-ahead search allows you to quickly filter elements.

You can use type-ahead search in most views in which element lists, tables, or trees are displayed. You can also
use type-ahead search in rule cells in policies.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Activate type-ahead search in one of the following ways:
• Select an element in a list, table, or tree.
• Click the small  Search icon in any view that includes the icon.
• In a policy editing view, click a rule cell in which elements can be used.

2) Type the information that you want to search for (for example, an element name, an IP address, a comment,
or a TCP/UDP port number).

Result

The Management Client filters the display to only show the elements that include what you typed.
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Note:  In policy editing views, when you have a Category Filter activated, only search results that
match the Category Filter are displayed.

Use the search tool
Use the search tool to find elements in the SMC.

Table 11: Available search options

Search option Description

Search Search for elements based on an element property, such as a name, comment, or IP
address.

Search References Search for references to elements, to see where they are used. For example, you can
find the references to elements you want to delete; referenced elements cannot be
deleted until the references are removed.

Tip:  You can also right-click an element, then select Tools > Where
Used?.

Search DNS Search for hosts by their DNS name. The DNS search queries a DNS server, and the
hosts found on the DNS server are compared to the Host elements defined in the SMC.

Note:  The Management Server must have Zone Transfer rights to be able
to make queries on the DNS server.

Search Duplicate
IPs

Search for elements that have the same IP address in the SMC.

Search Duplicate
Services

Search for Service elements that have the same protocol and destination port number.

Search Unused
Elements

Search for elements that are not referenced by any other element.

Search Users Search for users from an LDAP domain.

Search Trash Search for elements that have been moved to the Trash.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > Search, then a search option.
 
Figure 37: The Element Search

2) Enter the search criteria.

3) (Optional) Select options to limit the search.

4) Click Search to start the search.
The search results are displayed.

Tip:  If the element you searched for does not exist, right-click the empty search results, then
create a Host or Network element that has the name and IP address configured according to
your search terms.

Create Host elements from DNS search results
If the DNS search results do not find an existing Host element for a host name, you can create Host elements
based on the host names and IP address found by the search.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click one or more IP addresses in the search results, then select Create Network Element(s).

2) (Optional) If you want to add the new Host elements to a Group, select Create in a Group, then enter a
name in the Group Name field.
If the Group element does not yet exist, a new Group is automatically created.

3) Define a name for the new Host elements.

4) Click OK.
The Network Element Creation view opens in a new tab to show the progress of the element creation
process. The status of each new element is displayed in the Info column:
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• If the status is Created, the element was successfully created.
• If the status is Not created (name already in use), an element with the selected name exists. If you want

to change the Host element's name, right-click the Name cell, then select Properties to open the element
properties. Change the name and click OK to save the changes.

5) Click Close to close the Network Element Creation tab and return to the search results.
The names of the new elements are shown in the Network Element column.

Communicating with other
administrators

The administrator messaging feature allows you to communicate with other administrators who are currently
logged on to the Management Client.

For example, you can inform administrators about service breaks before upgrading the SMC. Administrator
messaging is enabled by default.

Enable or disable messaging
An administrator with unrestricted permissions can enable or disable administrator messaging.

If Domain elements have been configured, the setting is applied in all Domains.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Expand the Access Rights branch in the Administration tree.

3) Right-click Administrators and select or deselect Administrator Messaging Enabled.

Send messages to other administrators
Administrators can send messages to all other administrators.

Only administrators who have the Manage Administrators permission can send messages to individual
administrators. Each administrator must be logged on to a unique administrator account for individual messages
to be sent.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Click  Send Message in the status bar at the bottom right of the Management Client.
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2) Select the Administrators to whom you want to send the message.
• (Administrators with the Manage Administrators permission) Click  Select to select individual

administrators.
• Click  Set All Administrators to send the message to all administrators.

3) Enter your message, then click Send.
The message is sent to the selected administrators.

Use Tools Profile elements to add
commands to elements

You can add commands (for example, tracert, SSH, or ping) to an element’s right-click menu with Tools Profiles.
The commands are added in the Tools submenu.

Create Tools Profile elements
Tools Profile elements add commands to the right-click menus of other elements. You can include information
dynamically from the element definition in the command.

Only one Tools Profile can be selected for each element, but each Tools Profile can include several commands.

The commands are run on the workstation that is running the Management Client. Commands are operating
system-specific. You must add a separate command for each operating system. Administrators see commands
according to their operating system (for example, a Linux command is not shown if the Management Client is
running in Windows).

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Tools Profile, then select New Tools Profile.

3) Enter the Name for the new Tools Profile. This is added as an item under the Tools submenu of elements
that the Tools Profile is attached to.

4) Click Add, then select the operating system.

5) Double-click the Name cell, then enter the item to add.

6) (Optional) To run the command in a console application, such as the command prompt in Windows or
terminal in Linux, select Run in console.

7) Double-click the Command cell, then enter the command or the full path to the application.
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8) (Optional) Double-click the Parameters cell, then enter the parameters for the command.
In addition to static parameters, the following two variables can be used:
• ${IP} — the primary IP address of the element that is right-clicked.
• ${NAME} — the name of the element that is right-clicked.

9) Click OK.

Attach Tools Profile elements to elements
You can attach a Tools Profile to elements that have a single primary IP address.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an element and select Properties.

2) Select the Tools Profile in one of the following ways:
• Select a Tools Profile from the list.
• Select Other and browse to the Tools Profile.
• Select New and create a Tools Profile.

3) Click OK.
The commands defined in the Tools Profile are added to the right-click menu of the element in the Tools
submenu.

Use the online Help locally
You can configure the Management Client to use a copy of the online Help from your own computer or from a
server in the local network.

By default, the Management Client’s online Help is accessed through the Internet. When you use the online Help
locally, the online Help is available even when there is no Internet connectivity.

Note:  When you use a local copy of the online Help, you must manually update the online Help
when a new version is available.

Steps

1) Download the online Help .zip file for your release from http://help.stonesoft.com/onlinehelp/StoneGate/
SMC/.

2) Extract the .zip file to a suitable location in your local network.
You can also extract the Help file to a share or your local intranet server.

3) On the computer where you use the Management Client, browse to the <user home>/.stonegate/data folder.

http://help.stonesoft.com/onlinehelp/StoneGate/SMC/
http://help.stonesoft.com/onlinehelp/StoneGate/SMC/
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Example: In Windows, browse to C:\Users\<user_name>\.stonegate.

Note:  If the Management Client is open, close it before editing the SGClientConfiguration.txt
file.

4) Edit the SGClientConfiguration.txt file.

5) Add a parameter HELP_SERVER_URL= and enter the path to the main folder under which the online Help
files are stored as the value for the parameter.
• If you extracted the online Help on the same computer where you use the Management Client, enter

file:/// and the path.
Example: If you extracted the online Help on your own computer to C:\help\ngfw_620_help_en-us, enter
HELP_SERVER_URL=file:///C:/help/ngfw_620_help_en-us.

Note:  Use only forward slashes (/) in the URL even if the operating system uses
backslashes (\) in file paths. If the path contains spaces, replace them with %20 in the
URL.

• If you extracted the online Help on a server in the local network, enter http:// and the path.
Example: If you extracted the online Help to a folder called ngfw_620_help_en-us on an intranet server,
enter HELP_SERVER_URL=http://<intranet.server>/ngfw_620_help_en-us.

6) Save the changes to the SGClientConfiguration.txt file.

7) Start the Management Client.

Result

The Management Client automatically uses the online Help from the specified location.
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 CHAPTER 8

Network address translation (NAT)
and how it works

Contents

• Network address translation and how it works on page 123
• Static source translation on page 124
• Dynamic source translation on page 125
• Static destination translation on page 125
• Destination port translation on page 126

Network address translation (NAT) means changing the IP address or port information in packets. Most often, NAT is
used to allow internal hosts to communicate via networks where their actual address is not routable and to conceal the
internal network structure from outsiders.

Network address translation and how it
works

Network address translation (NAT) changes the source or destination IP address or port for packets traversing
the firewall.

NAT is most often used to hide internal networks behind a single or just a few routable IP addresses on the
external network. NAT is also often used to translate an external, routable destination address into the private
internal address of a server. For destination NAT, port translation (sometimes referred to as PAT) is also possible
when the protocol in question uses ports. Port translation can be used to redirect a standard service, such as
HTTP (port 80/TCP), to a non-standard port (for example, port 8080/TCP). The NAT rules are stored in policy
elements.

NAT is applied to traffic that has been already been allowed by Access rules that have connection tracking
enabled. If you have Access rules that turn off connection tracking for some traffic, you cannot use address
translation with those connections.

There are five possible methods for network address translation (these methods are explained in more detail in
the next sections):
• Static source translation, which translates each single IP address to some other single IP address (one-to-one

relationship).
• Dynamic source translation, which translates several IP addresses to a single IP address or a small pool of IP

addresses (many-to-one/many-to-some relationship) differentiated by port. This method is not supported with
Multi-Link if the Loose connection tracking mode is used.

• Static destination translation, which translates each single IP address to some other single IP address (one-to-
one relationship).

• Destination port translation, which translates a port to a different one (one-to-one relationship).
• Both source translation and destination translation for the same connection.
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Dynamic destination translation is done automatically as part of the Server Pool feature.

Also, when NAT is applied, return address translation is needed to allow reply packets to reach the correct
sender or to show the source address that the destination host expects. However, return address translation does
not normally need configuration as it is applied automatically with the help of connection tracking.

Related concepts
Getting started with inbound traffic management on page 753
Getting started with policies on page 787

Static source translation
In static source translation (one-to-one source translation), the source IP address of a certain host is always
translated using the same specific IP address.

Static source translation provides one-to-one source translation. Often, the original source address is the actual
assigned IP address for a device on an internal network or DMZ. The translation is then applied to a public IP
address belonging to the public IP address range assigned by the Internet service provider (ISP).

 
Figure 38: Static source ttanslation

1 The packet starts out with the original source (SRC) and destination (DST) IP addresses.

2 The firewall replaces the source address of the packets with a translated source IP address.

3 The server responds, using the translated IP address as the destination of the reponse.

4 Connection tracking information is used to automatically translate the reply packets. The firewall
replaces the destination IP address in the server’s response with the original address so that the
responses find their way back to the host.

You can also define static translation using whole networks. There is still a fixed one-to-one relationship
between each original and translated IP address, so the original and translated networks must be of the same
size. The addresses map to their counterparts in the other network. For example, if you translate the network
192.168.10.0/24 to 212.20.1.0/24, the host 192.168.10.201 is always translated to 212.20.1.201.
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Dynamic source translation
Dynamic source translation allows translating many original IP addresses to a much smaller pool of translated
addresses, even a single IP address.

Dynamic source translation, sometimes referred to as hide NAT, is often used to mask the internal networks of a
company behind one or a few public, routable IP addresses provided by an ISP.

This illustration shows the process for dynamic source translation. Because dynamic source translation involves
multiple hosts using the same IP address (in a many-to-one or many-to-some relationship), the firewall needs
more information to differentiate the connections when the reply packets arrive. For this, the firewall uses the
source port.

 
Figure 39: Dynamic source translation

1 Hosts make connections.

2 Each host is assigned a unique port from one of the unreserved high ports to track its connections.

3 The reply packet is sent to the same unique port.

4 The destination is translated to the original source address and port

Static destination translation
Destination translation is typically needed to translate new incoming connections from a server’s public IP
address to the server's private IP address.

You can use static destination translation for both IP addresses and ports.

In this illustration, a host on the Internet connects to a server on the internal network.
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Figure 40: Static destination translation

1 The host connects to the external, public IP address.

2 The Firewall translates the destination address to the private IP address of the server on the internal
network.

3 The server sends its response back.

4 The Firewall automatically translates the source address back to the external IP address.

You can also define static translation for whole same-size networks at once. This works in the same way as in
static source translation.

Destination port translation
Destination NAT can also be used to translate ports.

For example, web traffic to the corporate web servers on a DMZ would typically come in on port 80. However,
an administrator might want to run the web service on a non-standard port for security or network management
reasons. The original destination port can be translated using static destination port translation with or without
destination address translation.
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 CHAPTER 9

Configuring system
communications

Contents

• Considerations for setting up system communications on page 127
• Define contact IP addresses on page 129
• Select the Location for the Management Client on page 135
• Create HTTP Proxy elements on page 136
• Using certificates to secure communications to external components on page 137
• Enabling TLS protection for traffic to external components on page 141
• Configuring NTP for the SMC Appliance and NGFW Engines on page 142
• Configuring SMC Appliance communications on page 145
• Considerations for Multi-Link system communication on page 146

System communications involve traffic between SMC components, traffic between SMC components and external
components that are a part of the system configuration, and external access into the system.

Considerations for setting up system
communications

Firewalls and Layer 2 Firewalls do not automatically allow communications of other system components that pass
through the engine. Make sure that all necessary traffic is allowed in the engine's policy.

The predefined Firewall Template Policy and Layer 2 Firewall Template Policy allow most types of system
communications between the engine and the components it interacts with. You must create rules to allow any
other communications through Firewalls or Layer 2 Firewalls.

System communications through a NAT device
If NAT is applied between two SMC components, you must define the translated IP address as a contact
address. In NATed communications, the contact address is contacted instead of the component’s real IP
address. A single component can have several contact addresses.

Location elements define when a contact address is used and which of the defined contact addresses is used.
When NAT is applied between two communicating SMC components, you must separate them into different
Locations. Components that are in the same Location use the primary IP address when communicating with
each other and ignore all contact addresses. When components contact a component that belongs to a different
Location, they use the defined contact address.
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For example, when a Management Server contacts an engine node through NAT, the Management Server
uses the NATed contact address, not the engine’s real IP address. The NAT device between the components
translates the NATed address to the engine’s real IP address as usual.

There is one system element related to contact addresses, the Default Location. If you do not select a Location
for an element that has the Location option, the element’s Location is set to Default.

You can define a Default contact address for contacting a component (defined in the Properties dialog box of the
element). When components that belong to another Location contact the element and the element has no contact
address defined for its Location, the element’s Default contact address is used.

Example of using contact addresses and Locations
 
Figure 41: Example network with Locations

In this example scenario, a Management Server and a Log Server manage SMC components both at a
company’s headquarters and at three branch offices.

• The SMC servers and the Central Firewall are at the “Headquarters” Location.
• The Remote Firewalls are all at the “Branch Office” Location.

In this scenario, contact addresses are typically needed as follows:

• The Firewall at the headquarters or an external router can provide the SMC servers external IP addresses
on the Internet. The components at the branch offices contact the servers through the Internet. The external
addresses of the SMC servers must be defined as contact addresses for the “Branch Office” location.

• The Branch Office Firewall or an external router can provide external addresses for the SMC components
at the branch office. The external IP addresses of the engines must be defined as contact addresses for the
“Headquarters” Location so that the Management Server can contact the components.

• Alternatively, the external address of each component can be defined as a Default contact address without
adding a specific entry for “Headquarters” or “Branch Office”. The Default contact address is used when a
component does not have a specific contact address definition for the contacting component’s Location. The
components must still be divided into separate Locations for the contact address to be used.

If there are Management Clients used at any of the branch offices, each administrator must also select
“Branch Office” as their Location in the Management Client. Selecting the Management Client Location allows
administrators to view logs from a remote Log Server that is behind a NAT device.

Related concepts
Network interfaces for engines on page 539
Defining IP addresses as elements on page 895
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Related tasks
Select the Location for the Management Client on page 135

Related reference
Security Management Center ports on page 1429
Forcepoint NGFW Engine ports on page 1432

Define contact IP addresses
Contact addresses are required when NAT is applied between to SMC components. You can define contact
addresses for NGFW Engines, Master NGFW Engines, and most types of server elements.

The contact addresses are defined in the element properties. The contact addresses are based on Location
elements. You can also define a Default contact address that is used whenever no contact address is defined for
a certain Location.

You create the Locations and add elements to the Locations based on how your network is set up. Then you
define the Contact Addresses for each element for each Location in the properties of the elements. All SMC
components in other Locations then use the addresses defined for their Location for contact.

Related concepts
Considerations for Multi-Link system communication on page 146

Related tasks
Define endpoints for VPN Gateway elements on page 1150

Create Location elements
If network address translation (NAT) is applied between communicating SMC components, the components must
be assigned to different Locations in the configuration. You create the Locations and add elements to them based
on how your network is set up.

If a system has several Locations, but each component always has the same external IP address, each element
only needs a Default contact address. When new system elements are added, they have to be assigned a
specific Location, but they only need a Default contact address.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Expand the Other Elements branch in the Administration tree.

3) Right-click Locations and select New Location.
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4) Enter a Name and an optional Comment.

5) Browse to the type of elements you want to assign to the Location element in the Resources pane.

6) Select one or more elements and click Add.
The selected elements are added to the Content pane.

7) Click OK.

Define Management Server or Log Server
contact addresses
If NAT is used between SMC components or if SMC servers are contacted by external servers, you can configure
contact addresses for Management Servers and Log Servers.

You can configure multiple contact addresses for each type of server.

If you use Multi-Link, we recommended defining a separate contact address for each NetLink for the
Management Server and the Log Server. This way, if a NetLink goes down, the engines can still be managed and
can still send status and log data to the Log Server.

Note:  If the IP addresses at which the server can be reached change, you must manually update
the server contact addresses.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Network Elements.

2) Browse to Servers.

3) Right-click the server element for which you want to define a contact address and select Properties.
The Properties dialog box for that server opens.

4) Select the Location of this server.

5) If necessary, edit the contact addresses.

• A default contact address is automatically entered based on the element properties.
• If the server has multiple default contact addresses, separate the addresses with commas.

6) (Optional) Click Exceptions to define further contact addresses for contacting the server from specific
Locations.

7) Click Add and select a Location.
A new row is added to the table.
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8) Click the Contact Address column and enter the IP addresses that the components belonging to this
Location must use when they contact the Server.
You can enter several contact addresses per Location for Management Servers and Log Servers.
Separate the contact addresses with a comma.

Note:  Elements that belong to the same Location element always use the primary IP
address (defined in the element’s properties) when contacting each other. Elements that do
not belong to a specific Location belong to the Default Location.

9) Click OK to close the Exceptions dialog box.

10) Click OK to close the Server Properties dialog box.

Related tasks
Select the Location for the Management Client on page 135
Change the Management Server IP address on page 458

Define contact addresses for engines
You must define a Location and a contact address if NAT is applied to the communications between the engine
and some other component that contacts the engine.

If you use Multi-Link, add contact addresses for each NetLink.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine element and select Edit <element type>.
The Engine Editor opens.

3) In the General pane, select the Location for this element.

4) Browse to Interfaces in the navigation pane on the left.

5) In the tree view, expand the tree and double-click the Cluster Virtual IP Address (CVI), Node Dedicated IP
Address (NDI), or the IP address for which you want to define a contact address.
On Firewall Clusters, the CVI contact address is used for VPNs and NDI contact addresses are used for
other system communications.
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Define contact addresses for a single engine or
a Cluster Virtual IP Address
If NAT is applied to communications between the engine and some other component that contacts the engine,
define the Default contact address for the single engine or the Cluster Virtual IP Address (CVI). You can also
define location-specific contact addresses.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine element and select Edit <element type>.

3) In the General pane, select the Location for this element.

4) Browse to Interfaces in the navigation pane on the left.

5) In the tree view, expand the tree and double-click the Cluster Virtual IP Address (CVI) or the IP address for
which you want to define a contact address.
On Firewall Clusters, the CVI contact address is used for VPNs and NDI contact addresses are used for
other system communications.

6) In the IP Address Properties dialog box, define the Default contact address. The Default contact address
is used by default whenever a component that belongs to another Location connects to this interface.
• If the interface has a static Default contact address, enter the Default contact address in the Default

field.
• If the interface has a dynamic Default contact address, select Dynamic (next to the Default field)

before entering the Default contact address.

7) If components from some Locations cannot use the Default contact address to connect to the interface,
click Exceptions to define Location-specific contact addresses.

8) Click Add and select the Location.

9) Click the Contact Address column and enter the IP address that the components in this Location use
when they contact the interface or select Dynamic if the interface has a dynamic contact address.

Note:  Elements that belong to the same Location element always use the primary IP
address (defined in the element’s properties) when contacting each other. Elements that do
not belong to a specific Location belong to the Default Location.

10) Click OK to close the Exceptions dialog box.

11) Click OK to close the IP Address Properties dialog box.

Related tasks
Select the Location for the Management Client on page 135
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Define contact addresses for Node Dedicated
IP Addresses
If NAT is applied to communications between the engine and some other component that contacts the engine,
define the Default contact address for the Node Dedicated IP Address (NDI). You can also define location-
specific contact addresses.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine element and select Edit <element type>.

3) In the General pane, select the Location for this element.

4) Browse to Interfaces in the navigation pane on the left.

5) In the tree view, expand the tree and double-click the Node Dedicated IP Address (NDI) or the IP address
for which you want to define a contact address.
On Firewall Clusters, the CVI contact address is used for VPNs and NDI contact addresses are used for
other system communications.

6) In the IP Address Properties dialog box, double-click the Contact Address cell and define the contact
address for each node in the Node Dedicated IP Address section.

7) Enter the Default contact address.
The Default contact address is used by default whenever a component that belongs to another Location
connects to this interface.

8) If components from some Locations cannot use the Default contact address, click Add to define Location-
specific contact addresses.

9) Click the Contact Address column and enter the IP address that the components assigned to this
Location must use when they contact the node.

Note:  Elements that belong to the same Location element always use the primary IP
address (defined in the element’s properties) when contacting each other. Elements that do
not belong to a specific Location belong to the Default Location.

10) Click OK to close the Exceptions dialog box.

11) Once you have defined the contact addresses for each node, click OK to close the IP Address Properties
dialog box.

Related tasks
Select the Location for the Management Client on page 135



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Configuring system communications | 134

Define contact addresses for an IPS Cluster or
a Layer 2 Firewall Cluster
If NAT is applied to communications between the IPS Cluster or Layer 2 Firewall Cluster and some other
component that contacts the cluster, define the Default contact address for the IPS Cluster or a Layer 2 Firewall
Cluster. You can also define location-specific contact addresses.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine element and select Edit <element type>.
The Engine Editor opens.

3) In the General pane, select the Location for this element.

4) Browse to Interfaces in the navigation pane on the left.

5) In the tree view, expand the tree and double-click the Cluster Virtual IP Address (CVI) or the IP address for
which you want to define a contact address.
On Firewall Clusters, the CVI contact address is used for VPNs and NDI contact addresses are used for
other system communications.

6) In the IP Address Properties dialog box, double-click the Contact Address cell.

7) Enter the Default contact address at the top of the dialog box.
The Default contact address is used by default whenever a component that belongs to another Location
connects to this interface.

8) If components from some Locations cannot use the Default contact address, click Add to define Location-
specific contact addresses.

9) Click the Contact Address column and enter the IP address that the components belonging to this
Location must use when they contact the interface.

Note:  Elements that belong to the same Location element always use the primary IP
address (defined in the element’s properties) when contacting each other. Elements that do
not belong to a specific Location belong to the Default Location.

10) Click OK to close the Exceptions dialog box.

11) Click OK to close the IP Address Properties dialog box.

Related tasks
Select the Location for the Management Client on page 135
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Define contact addresses for an External VPN
Gateway
Define a contact address for an External VPN Gateway if the IP address for contacting the gateway is different
from the IP address of the gateway's interface (for example, because of NAT).

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Gateways.

3) Right-click an External VPN Gateway element, then select Properties.

4) In the External VPN Gateway Properties dialog box, click the Endpoints tab.

5) Right-click an endpoint and select Properties.

6) Enter the Default contact address or select Dynamic if the Default contact address is dynamic.

• The Default contact address is used by default whenever a component that belongs to another Location
connects to this endpoint.

7) (Optional) If some components cannot use the Default contact address, click Exceptions to define contact
addresses that the components use to connect to this endpoint.

8) Click Add and select a Location.
A new row is added to the table.

9) Click the Contact Address column and enter the IP address that components belonging to this Location
use when they contact the endpoint, or select Dynamic.

10) Click OK to close the Exceptions dialog box.

11) Click OK to close the Endpoint Properties dialog box.

Select the Location for the Management
Client

If NAT is applied between the Management Client and a Log Server, you might need to change the Location of
the Management Client to view the logs.

The Location to select depends on the system configuration. The Default selection is appropriate if the Log
Server has a specific Location and the Log Server’s Default contact address is correct for your current network
connection.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Click the Location name in the status bar at the bottom right corner of the Management Client window, then
select the Location.

 

Next steps

You might also need to add a Location and define a contact address for this specific Location in the Log Server’s
properties.

Create HTTP Proxy elements
You can send HTTP requests through an HTTP proxy so that the NGFW Engine does not need to access the
external network directly.

You can use HTTP proxies when the NGFW Engine needs to communicate with file reputation services, sandbox
services, URL categorization services, and certificate validation services.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Engine Properties > HTTP Proxies.

3) Right-click HTTP Proxies, then select New > HTTP Proxy.

4) Configure the settings.

5) Click OK.
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Using certificates to secure
communications to external components

You can use certificates to secure communications from the SMC servers or NGFW Engines to external
components. You can, for example, create a certificate request in the SMC, export the certificate request, sign
the certificate request with an external Certificate Authority (CA), and then import the signed certificate in the
SMC.

Create Trusted Certificate Authority elements
If you want to use a certificate signed by a Certificate Authority (CA) that is not one of the default Trusted
Certificate Authority elements, you must create a new Trusted Certificate Authority element.

For example, if you want to use the Forcepoint User ID Service server's certificate to secure communications
from Forcepoint User ID Service to the NGFW Engine, you must define the CA as a Trusted Certificate Authority
element and import the certificate, then define the CA as a trusted CA in the TLS Profile element that is used in
the Forcepoint User ID Service configuration on the NGFW Engine.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Certificates > Certificate Authorities > Trusted Certificate Authorities.

3) Right-click Trusted Certificate Authorities, then select New Trusted Certificate Authority.

4) Enter a unique Name.

Note:  All fields except the Name on the General tab are grayed out. The grayed out fields
are always filled in automatically based on information contained in the certificate you import
and you cannot change them.

5) On the Certificate tab, import a certificate.

6) Click OK.

Next steps

If you want to use the Trusted Certificate Authority in a TLS Profile element, modify the TLS Profile element
properties.

Related tasks
Create TLS Profile elements on page 141
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Create a certificate request
To create a certificate request, you must create a TLS Credentials element.

Note:  TLS Credentials elements represent both certificate requests and signed certificates in the
Management Client. In the Configuration view, the State  column for the TLS Credentials element
shows whether the element represents a certificate request or a signed certificate.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Certificates > TLS Credentials.

3) Right-click TLS Credentials and select New TLS Credentials.

4) Complete the certificate request details.

a) Enter a name for the certificate.

b) In the Common Name field, enter the IP address or domain name of the server.

c) Complete the remaining fields as needed.

d) Click Next.

5) Sign the certificate request or finish creating the certificate request.
• To create a self-signed certificate, select Self-Sign.
• To create a certificate signed by the Management Server's Internal Certificate Authority, select Sign with

Internal CA.
• Click Finish  to finish creating the certificate request.

Result

The TLS Credentials element is added to Administration > Certificates > TLS Credentials. The State column
shows whether the TLS Credentials element represents a certificate request or a signed certificate.

Next steps

If you want to sign the certificate request with an external Certificate Authority, export the certificate request.
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Export a certificate request
If you want to sign a certificate request with an external Certificate Authority, you must export the certificate
request.

Note:  TLS Credentials elements represent both certificate requests and signed certificates in the
Management Client. In the Configuration view, the State  column for the TLS Credentials element
shows whether the element represents a certificate request or a signed certificate.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Certificates > TLS Credentials.

3) Right-click the certificate request, then select Export Certificate Request.

4) Copy or export the certificate request.
• Copy the certificate request, then paste it in an external application to sign it externally.

Note:  If you copy and paste the certificate request, include the “Begin Certificate Request”
header and the “End Certificate Request” footer.

• Click Export, browse to the location where you want to save the certificate request, then click Save.

5) Click Cancel to close the Export Certificate Request dialog box.

Next steps

Sign the certificate request in an external application, then import the signed certificate request in the SMC.

Import an externally signed certificate
If you signed a certificate request with an external Certificate Authority, you must import the signed certificate in
the SMC.

Note:  TLS Credentials elements represent both certificate requests and signed certificates in the
Management Client. In the Configuration view, the State  column for the TLS Credentials element
shows whether the element represents a certificate request or a signed certificate.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Certificates > TLS Credentials.
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3) Right-click the certificate request that has been signed by an external Certificate Authority, then select
Import Signed Certificate.

4) Select one of the following options to import the signed certificate.
• Browse to the signed certificate file on your local workstation.
• Copy and paste the content of the signed certificate into the dialog box.

Note:  If you copy and paste the content of the signed certificate, include the “Begin
Certificate Request” header and the “End Certificate Request” footer.

5) Click OK.

Result

The status information in the State column shows that the certificate request has now been signed.

Export the active Internal Certificate Authority
You can use the Management Server's active Internal Certificate Authority as the trusted Certificate Authority
for securing communications from external components, such as the Forcepoint User ID Service, to the NGFW
Engines.

You must export the certificate of the active Internal Certificate Authority, then configure the external component
to trust the active Internal Certificate Authority, and import the certificate of the active Internal Certificate Authority
on the external component.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Certificates > Certificate Authorities > Internal Certificate Authorities.

3) Right-click the active internal certificate authority, then select Properties.

4) On the Certificate tab, click Export.

5) Save the certificate.

6) Click Cancel to close the properties of the internal certificate authority.

Next steps

Configure the external component to trust the Internal Certificate Authority, and import the certificate of the active
Internal Certificate Authority on the external component.

For information about configuring the Forcepoint User ID Service server to trust the Internal Certificate Authority
and use the certificate of the Internal Certificate Authority, see the document How to integrate Forcepoint User ID
Service with other Forcepoint products and Knowledge Base article 14100.

https://support.forcepoint.com/KBArticle?id=000014100
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Enabling TLS protection for traffic to
external components

You can optionally enable TLS protection for forwarding log or audit data from the Management Server or Log
Server to external syslog servers. You can also enable TLS protection for authenticating connections from
NGFW Engines to the Forcepoint User ID Service server, and for enabling TLS encryption for LDAP connections
between the NGFW Engine and external LDAP or Active Directory servers.

Create TLS Profile elements
TLS Profile elements contain, for example, the settings for cryptography, trusted certificate authorities, and the
TLS version used in TLS-protected traffic.

You can use TLS Profile elements for the following purposes:

• Enabling TLS-protected audit or log data forwarding to an external syslog server
• Enabling TLS encryption for LDAP connections between the NGFW Engine and external LDAP or Active

Directory servers
• Defining the TLS settings for HTTPS connections for browser-based user authentication
• Defining the trusted certificate authority for client certificate authentication for browser-based user

authentication
• Authenticating connections between the NGFW Engine and the server on which Forcepoint User ID Service

has been installed

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Certificates > Other Elements > TLS Profiles

3) Right-click TLS Profiles, then select New TLS Profile.

4) In the Name field, enter a unique name for the TLS Profile.

5) Select the TLS cryptography suite set to be used.

6) Select the trusted Certificate Authorities.
• Select Trust Any  if you want to allow the use of any valid Certificate Authority.
• Select Trust Selected, then click Add to specify the trusted Certificate Authorities.

7) Configure the other settings as needed.

8) Click OK.
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Configuring TLS Server Identity
TLS server identity determines how the identity of the syslog server to which log data is forwarded from the
Management Server or the Log Server is verified.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others > Log Server or Others > Management Server.

3) Right-click the Log Server or Management Server from which you want to forward log or audit data, then
select Properties.

4) Click the Log Forwarding or Audit Forwarding tab.

5) Double-click the TLS Server Identity cell and define the TLS server identity in order to check the identity of
the TLS server to secure the TLS-protected traffic from the Log Server or the Management Server.

6) Select the server identity type field to be used.

7) (Optional) Click Fetch from Certificate to fetch the value of the server identity type field from a certificate.

Note:  You can fetch the value of the server identity field from a certificate only if the server
identity field is Distinguished Name, SHA-1, SHA-256, SHA-512, or MD5).

8) In the Identity Value  field, enter the value of the server identity field.

9) Click OK.

Configuring NTP for the SMC Appliance
and NGFW Engines

You can use external NTP servers to provide time synchronization for the SMC Appliance and NGFW Engines.

By default, the SMC Appliance uses the public Forcepoint NTP servers. The Management Server and default Log
Server synchronize with the SMC Appliance time.

By default, NGFW Engines get time setting commands from the Management Server. If an NGFW Engine is
configured to use NTP and it can successfully get the time from an external NTP server, the NGFW Engine
ignores time setting commands from the Management Server.

You must have an SMC Appliance to configure NTP for SMC servers in the Management Client.

Note:  You cannot configure NTP in the Management Client for SMC installations on third-party
hardware or virtualization platforms. On third-party hardware or virtualization platforms, the SMC
gets the time from the operating system. When you use third-party hardware or virtualization
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platforms, you must configure NTP at the operating system level on the third-party hardware or
virtualization platform. For more information, see Knowledge Base article 9680.

Create NTP Server elements
NTP Server elements represent the external NTP servers to provide time synchronization for the SMC Appliance
and NGFW Engines.

You can use the same NTP servers for the SMC Appliance and NGFW Engines.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Network Elements.

2) Right-click Servers, then select New > NTP Server.

3) In the Name field, enter a unique name.

4) (Optional) In the Host Name field, enter the host name of the NTP server.

Note:  If you do not enter a host name, you must enter an IPv4 address or an IPv6 address.

5) (Optional) In the IP Address or IPv6 Address field, specify the IP address in one of the following ways:
• Enter the IPv4 or IPv6 address of the NTP server.

The same NTP Server element can have both an IPv4 address and an IPv6 address.
• To automatically resolve the IP address from the host name in the Name field, click Resolve.

Note:  If you do not enter an IPv4 address or an IPv6 address, you must enter a host name.

6) From the Key Type drop-down list, select the key type.

7) In the Key ID field, enter a unique numerical identifier for the key.
The value must be between 1—65534.

8) In the Key field, enter the key.

9) Click OK.

https://support.forcepoint.com/KBArticle?id=Time-synchronization-with-NTP-in-Stonesoft-architecture
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Enable NTP time synchronization on the SMC
Appliance
You can configure the SMC Appliance to use external NTP servers so that network devices accurately log events
and complete scheduled tasks.

Before you begin
You must have an SMC Appliance to configure NTP in the Management Client.

Note:  You cannot configure NTP synchronization from both the command line of the SMC
Appliance and the Management Client. Command line changes persistently override any NTP
changes that you configure in the Management Client.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Management Client, select  Menu > System Tools > Global System Properties.

2) On the NTP tab, select Enable time synchronization from NTP server.

3) To add a row to the table, click Add.

4) To add an NTP server, right-click the NTP Server cell, select Select, then select an NTP Server element.

5) (Optional) If there is more than one NTP server, select the preferred NTP server.

6) Click OK.

Enable NTP time synchronization for NGFW
Engines
You can configure NGFW Engines to use external NTP servers.

In environments where there are Master NGFW Engines and Virtual NGFW Engines, you can select NTP servers
only for Master NGFW Engines. Virtual NGFW Engines do not communicate directly with NTP servers.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an NGFW Engine, then select Edit <element type>.

3) In the navigation pane on the left, browse to General > NTP.
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4) Select Enable time synchronization from NTP server.

5) To add a row to the table, click Add.

6) To add an NTP server, right-click the NTP Server cell, select Select, then select an NTP Server element.

7) (Optional) If there is more than one NTP server, select the preferred NTP server.

8) Click  Save and Refresh.

Configuring SMC Appliance
communications

You can configure SSH access to the SMC Appliance, configure serial console connections for the SMC
Appliance, and set a BIOS password for the SMC Appliance.

Configuring SSH access to the SMC Appliance
You can access the SMC Appliance command line through SSH.

Note:  In FIPS mode, SSH access to the SMC Appliance is not allowed.

Two authentication options are available:
• Logon and password — All administrators with unrestricted permissions (superusers) in SMC can use their

password to log on to the SMC Appliance through SSH.
• Public and private key — You can generate a public and private RSA key pair for each administrator

or server. For more information about using an RSA key pair to authenticate to the SMC Appliance, see
Knowledge Base article 12503.

Related concepts
Getting started with administrator accounts on page 353

Connect to the SMC Appliance using a serial
console
You can configure the serial port on the SMC Appliance to receive serial console connections.

Steps

1) From the command line, log on to the SMC Appliance.

https://support.forcepoint.com/KBArticle?id=Set-up-the-SMC-Appliance-for-public-key-authentication
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2) To enable the serial console, enter the following command:

sudo smca-system toggle-console

Tip:  To disable the serial console, enter the same command again.

The SMC Appliance is now listening for serial console connections.

3) To connect to the serial console, connect a console cable from your computer to the SMC Appliance, then
open a terminal console program with these settings:

• Bits per second — 9600
• Data bits — 8
• Parity — none
• Stop bits — 1

Use the SMC Appliance to make outbound
serial connections
You can configure the serial port on the SMC Appliance to make outbound serial connections, for example to
NGFW appliances.

Steps

1) From the command line, log on to the SMC Appliance.

2) If the serial console is enabled, enter the following command to disable the serial console:

sudo smca-system toggle-console

The SMC Appliance stops listening for serial console connections.

3) Connect a console cable from the SMC Appliance to the other device.

4) Enter the following command to start the screen utility:

screen /dev/ttyS0 9600

Considerations for Multi-Link system
communication

If a remotely managed Firewall has Multi-Link, we recommend adding a primary and a secondary control
interface for different ISP connections. Adding a control interface for each ISP connection guarantees
connectivity if one of the ISP connections fails.
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Make sure that you configure these addresses consistently in the following parts of the configuration:
• For the interface address on the Firewall.
• For the external contact addresses (if applicable).
• In the NAT rules of the Firewall that protects the Security Management Center (SMC) servers (as necessary).

If there is a Multi-Link connection between a Management Server or Log Server and the components that contact
them, define a contact address for each network connection. Make sure that your NAT rules translate from each
external address to the correct internal address of the SMC server.

Related concepts
Defining Multi-Link routes for firewalls on page 714

Related tasks
Select system communication roles for firewall interfaces on page 569
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 CHAPTER 10

Managing elements
Contents

• Introduction to elements on page 149
• Benefits of exporting or importing elements on page 158
• Restore elements from Snapshots on page 162
• Lock elements on page 165
• Unlock elements on page 165
• How the Trash works on page 166
• How Categories help you view only certain elements on page 169
• Legacy elements and options on page 174

Certain tasks are common to most elements. Some of these tasks are not mandatory for defining an element, but are
still helpful as you get your SMC up and running.

Introduction to elements
Apart from a few minor exceptions, all configurations are created in the SMC, where information is stored as
reusable elements.

For example, the NGFW Engines, traffic inspection policies, IP addresses, log filters, backups, and the licenses
for the system components are all displayed as elements.

Different element types are provided for different concepts. The elements in the system define information both
for adjusting the traffic inspection policies and for managing the system. This chapter gives you a brief description
of each type of element.

System administration elements
You can view the types of elements used for system administration and their descriptions.

Table 12: Types of elements for system administration

Element Type Explanation

Access Control
Lists

Sets of elements that you can grant to one or more administrator
accounts when assigning administrator rights.

Administrator
Roles

Sets of actions that administrators are allowed to carry out both globally
and specifically on some set of elements.

Administrators SMC administrator accounts.

Access Rights

API Clients Accounts for the users of the SMC Application Programming Interface
(API).
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Element Type Explanation

Web Portal
Users

User accounts for the Web Portal.

Alert Chains Lists of administrators and contact methods for escalating Alerts.

Alert Policies Rules for choosing which Alerts are escalated using which Alert Chain.

Alert Senders System components that can send Alerts.

Alerts Labels for Alerts that help in separating different Alerts from each other in
Alert escalation.

Alert
Configuration

Policy
Snapshots

Saved versions of the alert configuration. Created each time you install or
refresh the Alert Policy on a Domain.

Bookmarks User-created shortcuts to views in the Management Client.

Licenses The components’ licenses (proof of purchase).

Definition System maintenance Tasks and Task definitions.Tasks

History History of running and executed Tasks both started by users and
generated by the system.

Tools Profiles Additional, user-configured commands/tools for components.

Backups Management Server and Log Server backups.

Categories Allow filtering the view in the Management Client to a subset of elements.

Domains Create boundaries for managing elements and configurations based on
administrator configurations.

Engine
Upgrades

Packages for remote upgrades that have been manually or automatically
imported into the system.

Geolocations Used for illustrating the geographical location of IP addresses (for
example, in logs and diagrams).

Internal
Certificate
Authorities

Management Server’s Internal Certificate Authority that issues all
certificates that components need for system communications. A new
Internal Certificate Authority is automatically generated before the old one
expires.

Internal
Certificates

Certificates that are used in communications between the system
components.

Locations Used for defining contact addresses when NAT (IP address translation) is
applied to communications between system components.

Trash Stores elements that you have deleted. You can permanently delete
elements that have been moved to the Trash.

Trusted Update
Certificates

Used to verify the digital signatures of dynamic update packages and
engine upgrades. A new Trusted Update Certificate is automatically
added through a dynamic update package before the old one expires.

Updates Dynamic update packages that update definitions in your installation.
Most of the content is Situations (used in deep packet inspection).

Other Elements

Web Portal
Localizations

Used for translating the Web Portal between languages.
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Elements used in the configuration of NGFW
Engines
You can view the types of elements used for configuring NGFW Engines.

Table 13: Types of elements in NGFW configuration

Element Type Explanation

NGFW Engines Configurations particular to individual NGFW Engines,
such as interface configurations.

Policies The rules for inspecting and handling network traffic.

Network Elements Represent IP addresses.

Endpoint Information Endpoint Application and Endpoint Settings elements
can be used for matching in Access rules. The
elements can be used to identify applications used
on endpoint clients, and also determine the operating
system or status of the local anti-virus or firewall.

Ethernet Services Definitions for protocols that can be used for traffic
filtering on the Ethernet level.

Event Bindings Sets of log events that can be used in Correlation
Situations to bind together different types of events in
traffic.

File Types Elements that represent different types of files that can
be allowed or blocked in Access rules.

HTTPS Inspection Exceptions Lists of domains that can be used to exclude some
traffic from HTTPS decryption and inspection.

Logical Interfaces Interface reference that can combine several physical
interfaces into one logical entity. Used for defining
traffic handling rules.

MAC Addresses Represent MAC addresses in Ethernet-level traffic
filtering.

Network Applications Provide a way to dynamically identify traffic patterns
related to the use of a particular application.

Policy Snapshots Saved versions of the NGFW Engine configurations.
Created each time you install or refresh a policy on an
NGFW Engine.

Protocols Supported network protocols. Can be used to define
new Services for matching traffic in policies. You
cannot add, delete, or change the Protocol elements.

QoS Classes An identifier that can be assigned to network traffic to
define QoS policies for the traffic.

Services Network protocols and ports.

Other Elements

Situations Patterns that deep inspection looks for in traffic.
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Element Type Explanation

TLS Matches Define matching criteria for the use of the TLS
(transport layer security) protocol in traffic, and specify
whether TLS traffic is decrypted for inspection.

Vulnerabilities References that link some Situations to publicly
available databases of known vulnerabilities in various
software.

Dynamic Routing Elements Elements and Access Lists used for configuring
dynamic routing. For more information on elements
used in configuring dynamic routing, see the chapter
about dynamic routing.

Anti-spam The Anti-Spam feature is no longer supported in
NGFW version 6.2.0 and later.

DNS Relay
Profiles

Define the host name mappings, domain-specific
DNS servers, fixed domain answers, and DNS answer
translations that the firewall uses when it provides
DNS services to the internal network.

Sandbox
Services

Define the settings for connecting to a sandbox server
for Forcepoint Advanced Malware Detection.

SNMP agents Configuration information for sending SNMP traps to
external components about system events related to
NGFW Engines.

User
Identification
Services

Represent integrated Forcepoint User ID Service
servers and McAfee Logon Collector servers that
associate users with IP addresses.

Note:  The legacy Stonesoft User Agent
is not supported in Forcepoint NGFW
version 5.9 or later. Use the Forcepoint
User ID Service or the McAfee Logon
Collector instead. McAfee Logon Collector
is only supported in Forcepoint NGFW
version 5.8 or later.

User
Authentication
Pages

Define the look of the logon page, challenge page,
and different status pages shown to end users who
authenticate through a web browser.

User Responses Settings for notifying end users about different policy
actions.

Engine
Properties

ECA
Configurations

Define settings for securing connections between
endpoint clients and the NGFW Engine.

Related concepts
Network elements on page 154
Service elements on page 155
Situation elements on page 156
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User authentication elements
You can view the types of elements used for configuring user authentication and directory services and the
element descriptions.

Table 14: Types of elements in user authentication configuration

Element Type Explanation

Authentication Methods Configured authentication methods for end-user and administrator authentication.
Used in rules that require end-user authentication.

Servers Active Directory Servers, LDAP Servers, RADIUS Authentication Servers, and
TACACS+ Authentication Servers for end-user and administrator authentication
and directory services.

Users End users stored in the internal LDAP database or an external LDAP database.
Used in rules that require end-user authentication.

Other
Elements

SMTP
Servers

SMTP servers that send email or SMS messages about changes to user accounts
to end users. The same SMTP Servers can also be used to send Alerts to
Administrators.

Monitoring elements
Use the monitoring elements to configure the monitoring features in the SMC.

Table 15: Types of elements in monitoring

Element Type Explanation

Diagrams Allow you to visualize your network environment and
monitor the system graphically.

Incident Cases Facilitate data collection during security incidents.

Overviews Customizable views for system status monitoring,
statistics, and shortcuts to configuration tools.

Design Define how log data and statistical data from engines
are processed and displayed in reports.

History Saved statistical presentations of network traffic and the
system.

Reports

Sections Define statistical items that are included in a report and
the way that the items are displayed.

Logging Profiles Define the logging characteristics for a third-party
device (what data from the third-party device logs is
shown).

MIBs Allow you to import and browse management
information bases to support third-party SNMP
monitoring.

Third-Party Devices

Probing Profiles Define how the Management Server tests if third-party
devices are running.
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Element Type Explanation

Data contexts Defines the log data types shown in the Logs view or
the Reports view.

Filters Allow log data filtering in various tasks.

Geolocations Show where Hosts (for example, attackers) are on a
world map and how much traffic they create.

Blacklist Saved version of blacklist entries for an NGFW Engine.
Created when you save a Blacklist Snapshot in the
Blacklist view.

Connections Saved version of connection entries for an NGFW
Engine. Created when you save a Connections
Snapshot in the Connections view.

Logs Saved version of log, alert, and audit entries for
an NGFW Engine. Created when you save a Logs
Snapshot in the Logs view.

Routing Saved version of routing entries for an NGFW Engine.
Created when you save a Routing Snapshot in the
Routing view.

SSL VPNs Saved version of active SSL VPN connections. Created
when you save an SSL VPN snapshot in the SSL VPN
Monitoring view.

Users Saved version of active users for an NGFW Engine.
Created when you save a User Snapshot in the Users
view.

Monitoring Snapshots

VPN SAs Saved version of active VPN SAs for an NGFW Engine.
Created when you save a VPN SA snapshot in the VPN
SAs view.

Network Elements Represent IP addresses.

Other
Elements

Overview Templates Templates that allow you to create a statistical overview
with predefined information selected for the view.

Related concepts
Network elements on page 154

Network elements
Network elements represent included IP addresses in NGFW Engine configurations.

Table 16: Types of network elements

Element Type Explanation

Address Ranges Define a set of consecutive IP addresses between a start address and end address that you
define.
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Element Type Explanation

Aliases Context-dependent elements with no fixed value. The value is defined per engine and is
determined when a policy containing the Alias is installed.

Countries Country elements contain lists of IP addresses registered in a particular country.

Domain Names The name of an Internet domain that is automatically resolved by an NGFW Engine to all IP
addresses associated with the domain.

Expressions Allow defining IP addresses using logical operators, which simplify the definition of complex
sets of addresses.

Groups Allow collecting together other Network Elements of any type. Represents all IP addresses
defined in the included elements.

Hosts Represent a single IP address.

IP Address Lists Represent a list of IP addresses.

Networks Represent a complete (sub)network of addresses.

NGFW Engines Configurations particular to individual NGFW Engines, such as the interface configuration.

Routers Represent a next-hop router in configurations where required. In policies, represent a single
IPv4 or IPv6 address.

Servers Represent an SMC server or an external server that provides a service to the system. In
policies, represent a single IP address.

Traffic Handlers Configure outbound and inbound traffic management features (load balancing and high
availability).

Zones Interface reference that can combine several network interfaces of NGFW Engines into one
logical entity. Used for defining interface matching requirements in traffic handling rules in
policies.

Related concepts
Introduction to expressions on page 1437

Service elements
Service elements are used in Access rules to match traffic and to set parameters for handling the traffic.

There are predefined system Service elements for official (IANA-reserved) and well-known protocols and services
(such as DNS, FTP, and HTTP). You can also create your own custom Service elements to specify a port that is
not predefined or to define custom options for handling some types of traffic.

Table 17: Types of Services

Element Type Explanation

Group Groups of services containing the Service elements that together fulfill a certain role (for
example, the services that allow IPsec VPN connections).

ICMP Identifies the message by the ICMP Type and Code fields.

IP-proto Identifies the protocol by the IP address header Protocol field.
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Element Type Explanation

SUN-RPC Identifies the Sun remote procedure call (RPC) service by the program identifier.

TCP Identifies the service by the TCP header Source Port or Destination Port fields.

UDP Identifies the service by the UDP header Source Port or Destination Port fields.

With Protocol Default Services containing Protocols that have default parameters set to typically used
values.

With Proxy Default Services containing SSM Proxy Protocol Agents.

Situation elements
Situation elements are used in Inspection rules to define patterns that deep packet inspection looks for in traffic.

The Situations tree is constructed differently compared to most other trees. The Situations tree contains several
alternative groupings, so most Situations are shown in several places. The groupings allow you to easily find
Situations that are specific to the task at hand. For example, Situations specific to the HTTP protocol (some
of which are specific to particular web browsers) are stored at the following location in the Situations tree:
Situations > By Type > Traffic Identification > Browsers.

Some branches are groupings that you can add to yourself. You can use most of these branches in Inspection
rules. The Situation Type groupings are used as the basis for the tree-based Inspection rules configuration in
Inspection Policy elements.

Situations and their groupings are updated in dynamic update packages. The following table lists the default
branches at the time of writing this document.

Table 18: Default groupings of Situations at the time of publishing this document

Tree branch Explanation

All Situations All Situations in the system without any grouping.

Anti-Malware Events triggered in the malware scan.

Correlations Correlation Situations for detecting patterns in event data.

DoS Detection Situations for detecting DoS (denial-of-service) attacks.

DXL Situations related to McAfee® Threat Intelligence Exchange (TIE).

Files Situations based on identifying file types from traffic. Content identified
based on file type fingerprints is redirected to appropriate file streams.

Protocols Situations that identify protocols from traffic.

Scan Detection Situations for detecting network scans.

By Context

System System-internal events.

By Hardware Situations that detect something specific to a particular hardware platform
grouped by platform (for example, x86 (32-bit) or x86-64 (64-bit)). An
example of something hardware specific is an attempt to exploit a known
vulnerability that only exists on a particular platform.

By Tag

By Operating
System

Situations that detect something specific to a particular operating system,
grouped by operating system (for example, Windows (for all Windows
versions) or Windows 2000).
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Tree branch Explanation

By Situation Tag Free-form grouping for some special use cases. The Recent Updates
branch is especially useful. The branches dynamically list Situations that
have been recently added to the system in the 1–5 most recent dynamic
update packages. (This list helps in tuning your policies.)

By Software Situations that detect something specific to a particular software, grouped
by brand or product name (for example, Adobe Acrobat or Microsoft
Office).

By Type These Situations are shown as the main Rules tree in the Inspection
rules.

By Vulnerability Situations that detect attempts to exploit known vulnerabilities grouped by
vulnerability name.

Custom Situations Custom Situations that the administrators create. Custom Situations can
also appear in the other branches.

VPN elements
You can view the types of elements used for configuring VPNs and the element descriptions.

Table 19: Types of elements in the VPN configuration

Element Type Explanation

Policy-Based VPNs Configurations particular to a VPN between two or
more VPN gateways.

Route-Based VPN Tunnels Configurations particular to VPN tunnels between
Firewall interfaces that are designated as tunnel
endpoints.

SSL VPN Portals Configurations particular to Firewalls that act as SSL
VPN Portals.

SSL VPN Portal Policies Defines which services are available in the SSL VPN
Portal and which users can access the services.

SSL VPN Portal Services Defines the SSL VPN Portal Services used through the
SSL VPN Portal.

SSL VPN SSO Domains Defines the SSL VPN SSO Domain where the same
username and password is valid.

SSL VPN Portal

SSL VPN Portal Service Profiles Defines the settings for SSO and cookie protection in
the SSL VPN Portal Services.

Gateways Configurations particular to individual VPN Gateways,
such as IP address information.

Gateway
Certificates

Information about certificates that Firewalls use as
identification in VPNs.

Other Elements Certificates

VPN Certificate
Authorities

Certificate issuers whose signature is accepted as
proof of identity on certificates in one or more VPNs.
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Element Type Explanation

Gateway Profiles Information about the capabilities of particular types
and versions of VPN gateway devices. Allow automatic
configuration validation.

Gateway
Settings

Advanced global Firewall settings related to VPN
performance tuning.

Profiles

VPN Profiles The main authentication, encryption, and integrity
checking settings for VPNs.

TLS Cryptography Suite Sets Settings that define which cryptographic algorithms are
allowed to be used in the SSL VPN.

Benefits of exporting or importing
elements

The ability to export and import most kinds of elements allows you to reuse or restore them without having to
create them again.

• You can reuse elements in a different SMC.
• You can import old versions of elements or deleted elements by restoring them from a Policy Snapshot or

from an Element Snapshot.
• You can restore elements that have been moved to the Trash.

You can export and import elements using the following interfaces:
• Management Client
• Command Line Interface tools (sgExport or sgImport)

You can export elements to the following file types using the  Menu > File > Print option:

• .html
• .pdf

Note:  Exported files are meant for importing elements into the database of a Management
Server. They are not meant to be viewed or edited in external applications.

You can import elements from the following file types:
• .csv — You can create a .csv file and import values from it.
• .tsv — You can create a .tsv file and import values from it.
• .zip — You can import elements from a .zip file of elements exported from the Management Client.

Note:  When you export and import elements that have been moved to the Trash, all references
to the elements remain valid. An element that has been exported from the Trash remains in the
Trash when imported to an environment with several Management Servers.

Related concepts
Restore elements from Snapshots on page 162



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Managing elements | 159

Related tasks
Save elements, log data, reports, and statistics on page 264
Export selected elements on page 159
Export all elements on page 160
Create .csv or .tsv files for importing elements on page 160
Restore elements from the Trash on page 167
Import user information on page 1092
Export user information on page 1093

Export selected elements
You can export most kinds of individual elements.

You cannot export some kinds of elements, such as administrator accounts and certificates. To export an
element that references an element that cannot be exported, you must first manually create a corresponding
element that has the same name as the referenced element. Otherwise, the export fails.

To protect sensitive data in exports, export .zip files are automatically encrypted in FIPS mode. If you have
defined an export banner, the text of the banner is added at the beginning of each exported XML file to indicate
that the export contains sensitive or classified data.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > File > Export > Export Elements.

2) Select an option:
• Enter a file name for the export file.
• Click Browse to select the location where you want to create the file.

3) (Optional) In the Password field, enter the password for the encrypted export file.

Note:  In FIPS mode, you must enter a password.

4) (Optional) To view and export elements that have been moved to the Trash, select  Tools > Show Deleted
Elements.

5) Select the elements that you want to export, then click Add.

6) When you have finished adding elements to the Content list, click Export.
A new tab opens to show the progress of the export.

Related tasks
Create export banners on page 112
Import elements from a file on page 161
Export user information on page 1093
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Export all elements
You can export all elements as a group.

You cannot export some kinds of elements, such as administrator accounts and certificates. To export an
element that references an element that cannot be exported, you must first manually create a corresponding
element that has the same name as the referenced element. Otherwise, the export fails.

To protect sensitive data in exports, export .zip files are automatically encrypted in FIPS mode. If you have
defined an export banner, the text of the banner is added at the beginning of each exported XML file to indicate
that the export contains sensitive or classified data.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > File > Export > Export All Elements.

2) Select an option:
• Enter a file name for the export file.
• Click Browse to select the location where you want to create the file.

3) (Optional) In the Password field, enter the password for the encrypted export file.

Note:  In FIPS mode, you must enter a password.

4) (Optional) To view and export elements that have been moved to the Trash, select  Tools > Show Deleted
Elements.

5) Click Export.
A new tab opens to show the progress of the export.

Related tasks
Create export banners on page 112
Import elements from a file on page 161
Export user information on page 1093

Create .csv or .tsv files for importing elements
You can create .csv (comma-separated value) files or .tsv (tab-separated value) files for importing elements.

In a .csv file, commas separate all values. In a .tsv file, a tab character separates all values.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Create a new .csv or .tsv file. (For example, you can use a spreadsheet application.)

2) In the first row of the file, specify the header as follows:
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• .csv files — Enter ip,name,comment.
• .tsv files — Enter ip<tab>name<tab>comment.

Note:  Only the IP address is mandatory in the header row. All data entered in the file must
follow the format of the header row.

3) Enter the IP address of the element and optionally a name and a comment on the row below the header. Use
the same format as in the header.

Note:  Only the IP address is mandatory. If you have other parameters in the header row,
enter a separator (a comma or tab) even if you do not enter a name or comment in the row.

Example: If the header row is ip,name,comment and you want to omit the name and the comment in
the .csv file, enter 10.1.1.1,,.

Example: If the header row is ip<tab>name<tab>comment and you want to omit the name and the
comment in the .tsv file, enter 10.1.1.1<tab><tab>.

If you omit the name, the SMC automatically generates a name for the element based on its IP address. The
SMC detects the element type based on the syntax of the IP address as follows:
• 10.10.10.10 — Specifies a Host element.
• 10.10.10.0/24 — Specifies a Network element.
• 10.10.10.10–20.20.20.20 — Specifies an Address Range element.

4) (Optional) For each element, add another row to the file.

5) Save the file.

Related tasks
Import elements from a file on page 161

Import elements from a file
You can import elements from a .csv or .tsv file.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > File > Import > Import Elements.

2) Select the files you want to import, then click Import.
The Management Server automatically checks if any elements in the file to be imported have the same name
and XML content as any elements that exist. A new tab opens.
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3) If any conflicts are found between elements in the import file and existing elements, select the Action for
each conflict according to the conflict type.

Tip:  If there is a conflict between existing elements and elements in the Policy Snapshot, the
differences are shown in color in the XML format. To view the elements in XML format, select

 Tools > Show XML.

4) When there are no more conflicts, click Continue to start the import.

5) When the import is finished, click Close.

Related concepts
Benefits of exporting or importing elements on page 158

Restore elements from Snapshots
You can restore all elements from a Policy Snapshot or select the elements to be restored.

Related tasks
Restore all elements from Policy Snapshots on page 162
Restore selected elements from Policy Snapshots on page 163

Restore all elements from Policy Snapshots
You can restore all elements from a Policy Snapshot.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Policy Snapshots.

3) To open the list of Policy Snapshots, expand the Policy Snapshot type.

4) Right-click the Policy Snapshot from which you want to restore elements, then select Restore.

5) If any conflicts are found between elements in the Policy Snapshot and the existing elements, resolve them
by selecting the Action.

Tip:  If there is a conflict between existing elements and elements in the Policy Snapshot, the
differences are shown in color in the XML format. To view the elements in XML format, select

 Tools > Show XML.
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6) When there are no more conflicts, click Continue.

7) When the restoration is finished, click Close.

Related tasks
Restore selected elements from Policy Snapshots on page 163

Restore selected elements from Policy
Snapshots
You can restore selected elements from a Policy Snapshot.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Policy Snapshots.

3) Expand the branch for the Policy Snapshot Type.

4) Right-click the Policy Snapshot from which you want to restore elements, then select View Policy
Snapshot.

5) Select one or several elements to restore, right-click, then select Tools > Restore.

6) If any conflicts are found between the elements in the Policy Snapshot and the existing elements, resolve
them by selecting the Action.

Tip:  If there is a conflict between existing elements and elements in the Policy Snapshot, the
differences are shown in color in the XML format. To view the elements in XML format, select

 Tools > Show XML.

7) When there are no more conflicts, click Continue to start the restoring.

8) When the restoration is finished, click Close.

Related tasks
Restore all elements from Policy Snapshots on page 162
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Restore elements from Element Snapshots
You can restore elements from Element Snapshots, which are stored in Audit logs.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Display Element Snapshots in the Logs view.

2) Right-click the audit entry of an element, then select Compare to Current Element.

Note:  If the Element Snapshot properties differ from the properties of the existing element, a
red border is displayed. You can view the red border around the Audit Log Version (snapshot)
and the Current Version of the element.

Tip:  If there is a conflict between existing elements and elements in the Policy Snapshot, the
differences are shown in color in the XML format. To view the elements in XML format, select
Show: XML.

3) To restore the properties of the Element Snapshot to the current element, click Restore.

4) If any conflicts are found between the elements in the Element Snapshot and existing elements, resolve
them by selecting the Action:
• Import — The element that exists is overwritten with the element in the Element Snapshot.
• Duplicate — The element in the Element snapshot is renamed by adding a number to the end of the

element’s name and imported as a new element.
• Do not Import — The element is not imported.

5) Click Continue.

6) When the import is done, click Close.

Related concepts
Restore elements from Snapshots on page 162

Related tasks
View and compare Element Snapshot elements on page 210
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Lock elements
An administrator who is allowed to edit an element can lock the element and add a comment to explain the
reason for locking it.

Before you begin
To lock or unlock an element, you must be logged on to the Shared Domain or the Domain in which the
element is stored.

Note:  You cannot lock predefined system elements or elements that have been sent to the Trash.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the element you want to lock, then select Tools > Lock.

2) Enter a Comment explaining the reason for locking the element.

3) Click OK.
The element is now locked and a lock symbol is displayed on its icon.

Unlock elements
Unlock an element so that you can edit or delete it.

Before you begin
To lock or unlock an element, you must be logged on to the Shared Domain or the Domain in which the
element is stored.

Locked elements are displayed with a lock symbol. Unlock a locked element before editing or deleting it. Any
administrator who is allowed to edit the locked element can unlock it.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the element you want to unlock, then select Tools > Unlock.

2) In the dialog box that opens, click Yes to confirm the unlock.
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How the Trash works
Before deleting an element, you move it to the Trash.

In the Management Client, you can view and search for elements in the Trash. An administrator with unrestricted
permissions can search for elements in the Trash in all administrative Domains.

Before working with the Trash feature, review the following considerations:
• If you want to delete an administrator account, first disable the account. Then you can delete the disabled

Administrator element in the Administration branch of the Configuration view.
• Domains cannot be moved to the Trash. You can only permanently delete Domains.
• An element in the Trash is still valid in any previous configuration where the element was used before it was

moved to the Trash. However, you cannot add an element that is in the Trash to any new configuration.
• When you export and import elements that have been moved to the Trash, all references to the elements

remain valid. An element that has been exported from the Trash remains in the Trash when imported to an
environment with several Management Servers.

• You can also restore elements that have been moved to the Trash. An element in the Trash is permanently
deleted only when you delete it from the Trash or when you empty the Trash.

Related tasks
Delete elements from the Trash on page 167
Restore elements from the Trash on page 167
Disable administrator accounts on page 371
Delete a Domain on page 406

Move elements to the Trash
You move elements to the Trash before deleting them permanently.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the element, then select Delete.
A confirmation dialog box opens.

2) If the element you are moving to the Trash is used in any configuration, view and remove all references to
the element:

a) Click Open References to view the references.

b) To remove the references, right-click each element that references the element that you want to remove,
select Edit, and remove the element from the configuration.

3) Click Yes.
The element is moved to the Trash.
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Related tasks
Restore elements from the Trash on page 167
Delete elements from the Trash on page 167
Disable administrator accounts on page 371
Delete a Domain on page 406

Restore elements from the Trash
You restore elements from the Trash so that you can add them to new configurations.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > View > Trash.

2) Right-click the element that you want to restore, then select Undelete.

Note:  You can view the references to the element you are restoring. In the confirmation
dialog box, click Open References.

3) Click Yes.
The element is restored.

Related tasks
Move elements to the Trash on page 166
Delete elements from the Trash on page 167

Delete elements from the Trash
You can permanently delete an element that you moved to the Trash.

If you select  Tools > Show Deleted Elements to view the elements that have been moved to the Trash, you
can delete the element from the Trash in your current view. Otherwise, you can either delete a single element
from the Trash branch or delete all elements in the Trash by emptying the Trash.

To permanently delete an element:
• Administrators must have sufficient rights.
• The element must not be used in any configuration, for example, in a policy.

CAUTION:  Deletion is permanent. There is no undo. To recover a deleted element, you must
either recreate it or restore it from a previously created backup or XML export file that contains the
element.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > View > Trash.

2) Right-click the element that you are deleting, then select Delete.
A confirmation dialog box opens.

3) If the element you are moving to the Trash is used in any configuration, view and remove all references to
the element:

a) Click Open References to view the references.

b) To remove the references, right-click each element that references the element that you want to remove,
select Edit, and remove the element from the configuration.

4) Click Yes.
The element is permanently deleted.

Related tasks
Restore elements from the Trash on page 167

Empty the Trash
You can permanently delete all elements in the Trash at one time.

CAUTION:  Deletion is permanent. There is no undo. To recover a deleted element, either
recreate it or restore it from a previously created backup or XML export file that contains the
element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > View > Trash.

2) Select  Tools > Empty Trash.
A confirmation dialog box opens.

3) Click Yes.
All elements in the Trash are permanently deleted.

Related tasks
Restore elements from the Trash on page 167
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How Categories help you view only
certain elements

Categories allow you to restrict which elements are displayed in the Management Client. When you activate a
Category Filter, elements that do not belong to one of the selected Categories are filtered out of your view.

Categories help you manage large networks by filtering the elements that are displayed. You can create separate
Categories for elements that belong to a Firewall, IPS, or Layer 2 Firewall configuration and then select the
category you want to configure. You can freely select how to assign the Categories, and quickly and flexibly
change which combinations of Categories are shown according to your tasks.

In a large installation, there can be hundreds of elements, but you usually do not need to work with all elements
at the same time. Category elements allow you to group related elements according to any criteria you want.
Using Categories, you can quickly filter your Management Client view. Elements that do not belong to the
selected Category are filtered out so that only the relevant elements are visible. Categories allow you to manage
many elements more efficiently by making it easier to find the elements you need.

There are two predefined Categories:
• The System Elements  Category is assigned to all default elements in the SMC. You can use it to display all

predefined elements in the system.
• The Not Categorized Category contains all elements that have not yet been assigned a Category.

Grouping Category elements with Category
Tag elements
If you have many custom Category elements, you can group the Categories using Category Tag elements.
Category Tags can also be used to filter elements in Management Client views.

After you have created a Category Tag, you can select that Category Tag for a Category. You can also arrange
Category Tags into groups by selecting a parent Category Tag for Category Tag elements.

When Category Filters are available, Category tags can be used as filtering criteria in the Management Client.

Category configuration overview
You can create and combine Categories in a custom Category Filter.

Follow these general steps to configure a custom Category Filter:

1) Create a Category.

2) Associate elements with the Category.

3) Select a Category as the active Category Filter.

4) Combine Categories in a custom Category Filter.
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Related tasks
Create new Category elements on page 170
Select Categories for elements on page 171
Activate Category Filters on page 171
Combine Category elements in custom filters on page 173

Create new Category elements
You can create as many Categories as you need, and you can base the Categories on any criteria.

For example, you can create separate Categories for elements related to different geographic locations. The
same element can belong to several Categories. Categories are stored as elements and they are visible to other
administrators as well.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Other Elements > Categories.

3) Right-click Categories, then select New Category.

4) Give the Category a unique name.

5) (Optional) Enter a Comment for your own reference.

6) Click OK.

Related tasks
Select Categories for elements on page 171
Activate Category Filters on page 171

Add Category elements to groups using
Category Tag elements
Add Categories to groups using Category Tags for easier management of categorized elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.
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2) Browse to Other Elements > Categories.

3) Right-click Categories, then select New > Category to create a Category, or right-click an existing Category
to open the Category properties.

4) Select a Category Tag for the Category.

a) To select a category, click Add.

b) To create a Category Tag, select  Tools > New > Category Tag.

5) Click OK.

Select Categories for elements
You can select any number of Categories for each element without restrictions.

There are no automatic checks to consider; elements that reference each other do not need to be in the same
Category. If you are using a Category Filter, the Categories included in the Category Filter are added to new
elements when you create them. You can also manually select other Categories for elements and remove the
automatically added Categories.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Click Select next to the Category field in the properties of a new or existing element.
The Category Selection dialog box for the element opens.

2) Add or remove Categories as needed.

3) Click OK.

Related tasks
Create new Category elements on page 170
Activate Category Filters on page 171

Activate Category Filters
In most views, you can select a Category Filter to restrict which elements are displayed. You can also filter by
more than one Category at a time.

The Category Filters are selected in the toolbar of the Management Client. You can create a custom Category
Filter containing any combination of Categories. For example, you can combine a Category for a particular
geographic location and a Category for critical servers. This custom Category Filter combination only displays
elements related to the critical servers at one location. The Category Filter is applied in all views.

Note:  The selected Category Filter is applied in all views until you select a different Category
Filter or Category Filter Not Used.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) If the Category Filter selection is not visible in the toolbar, select  Menu > View > Layout > Category
Filter Toolbar.

2) Select an existing Category.
• If the Category you want to use is not listed, select Select, select the Category, then click Select.
• To display the elements that do not belong to any Category, select the Not Categorized filter.
• To display the predefined system elements, select the System Elements filter.

Result

Only the elements that belong to the selected Category are displayed. To display all elements again, select
Category Filter Not Used.

Related tasks
Combine Category elements in custom filters on page 173

Activate the default Category Filters for
Domain elements
When you create a Domain, you can set the default Category Filters that are automatically used when you log on
to the Domain.

If you change the Category Filter, you can revert to the default Category Filter for the Domain.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If the Category Filter selection is not visible in the toolbar, select  Menu > View > Layout > Category
Filter Toolbar.
The Category Filter selection is displayed in the toolbar.

2) In the Category Filter toolbar, select Default Category Filter for Domain.

Related tasks
Create new Category elements on page 170
Activate Category Filters on page 171
Create Domain elements on page 401
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Filter elements by Category Tag
Use Category Tags to filter categorized elements in different Management Client views.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If the Category Filter selection is not visible in the toolbar, select  Menu > View > Layout > Category
Filter Toolbar.

2) Select a Category Tag from the Category Filter menu to filter elements by Category Tag.

Note:  If the Category Tag you need is not listed, select Other and navigate to the Category
Tag.

Result

The elements in the view are filtered to only show elements in Categories that have the selected Category Tag.

Combine Category elements in custom filters
You can combine several Category Filters to display elements that are in any of the selected Categories.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Category Filter toolbar, select Define Custom Category Filter.

2) Select the Categories you want to add, then click Add.

3) (Optional) If you want to view elements that do not have a Category (they belong to the Not Categorized
Category), select Show Not Categorized.

4) (Optional) If you want to view elements that are predefined elements (they belong to the System Elements
Category), select Show System Elements.

5) Click OK.
Only the elements assigned to the selected Categories are displayed.

Related tasks
Create new Category elements on page 170
Activate Category Filters on page 171
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Examples of Categories
The examples illustrate some common uses for Categories and general steps on how each scenario is
configured.

Example: Creating category elements for a
firewall and an IPS configuration
This scenario shows an example of using categories to show only Firewall or IPS engine configurations.

Company A is a large enterprise planning a new system. The system includes several Firewall and IPS engines.
Each Firewall and IPS engine has its own policy. The company’s administrators are only required to manage the
Firewall engines and their policies or the IPS engines and their policies at a time. To restrict which engines and
policies are displayed, the following steps are taken:

1) The headquarters administrator creates two Categories: one for the elements that belong to the Firewall
configuration and another for the elements that belong to the IPS configuration.

2) The headquarters administrator creates the elements that represent the Firewalls, Firewall policies, IPS
engines, and IPS policies. The administrator then selects the appropriate Category for each element while
defining its properties.

3) The administrators select the appropriate Category as the Category Filter so that only the elements in the
Firewall or IPS configuration are displayed.

Example: Combining category elements
This scenario shows an example of combining categories that are used at different sites.

Company B has sites in New York, Toronto, and Mexico City. The company’s administrators have defined
separate Categories for the elements that belong to each site, because administrators usually work with the
elements of one site at a time. Today, however, Administrator A must apply the same configuration changes to
the New York and Toronto sites. Administrator A does not want to create a Category for this temporary need.
To be able to filter the elements belonging to both the New York and Toronto sites, Administrator A does the
following:

1) Creates a custom Category Filter that contains the New York and Toronto Categories. The elements at both
the New York and Toronto sites are displayed, and elements in the Mexico City Category are filtered out.

2) Makes the configuration changes to the elements in the New York and Toronto sites.

3) Selects the Category Filter Not Used filter to display all elements again.

Legacy elements and options
Elements and options related to features that are no longer supported might be visible in the Management Client
if you configured them using an earlier Forcepoint NGFW software version, and are included only for backward
compatibility.

For information about these features in earlier software versions, see the version-specific documentation.
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Feature No longer supported starting from

• Stonesoft Authentication Server
• Stonesoft User Agent

Forcepoint NGFW 5.9.0

Anti-Spam Forcepoint NGFW 6.2.0

McAfee Endpoint Intelligence Agent (McAfee EIA) Forcepoint NGFW 6.3.0

McAfee Advanced Threat Defense Forcepoint NGFW 6.4.0
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 PART IV
Monitoring

Contents

• Monitoring Forcepoint NGFW components on page 179
• Monitoring third-party devices on page 221
• Viewing and exporting logged data on page 241
• Reports on page 269
• Filtering data on page 291
• Working with Diagram elements on page 305
• Incident Case elements on page 319

You can use the SMC to monitor system components and third-party devices. You can also view and filter logs, and
create Reports from them.
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 CHAPTER 11

Monitoring Forcepoint NGFW
components

Contents

• Getting started with monitoring the system on page 179
• System monitoring tools in the Management Client on page 180
• Overviews and how they work on page 196
• Monitoring users in the Home view on page 201
• Monitoring connections, blacklists, VPN SAs, users, routing, and SSL VPNs on page 203
• View and compare Element Snapshot elements on page 210
• Monitoring connections using Geolocation elements on page 211
• Monitoring configurations and policies on page 214
• Monitor administrator actions on page 215
• Monitor tasks on page 215
• Traffic captures and how they work on page 216
• Checking maintenance contract information on page 217
• Check when internal certificates or CAs expire on page 219

You can monitor Forcepoint NGFW components and view system summaries in the Management Client.

Getting started with monitoring the
system

There are several ways to monitor the system in the Management Client.

• Monitor the status of individual components and view a summary of the system status.
• Monitor the status of elements that belong to different administrative Domains.
• Create customizable overviews of the system.
• View user information and user alerts
• Monitor enforced blacklists, open connections, active VPN SAs, active users, routing, and SSL VPN sessions.
• View, approve, and commit pending changes made to configurations and policies of engines.
• Check which configurations and policies are currently applied in the system.
• Check which actions administrators take.
• Check the status of Tasks that schedule commands to run automatically.
• Monitor the status of the maintenance contract.
• Monitor the status of internal certificates and internal certificate authorities.
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Related concepts
Getting started with monitoring third-party devices on page 221
Getting started with the Logs view on page 241
Getting started with reports on page 269

System monitoring tools in the
Management Client

There are various tools and views that you can use to monitor the NGFW system.

The Domain Overview
Domain elements allow you to group elements that belong to specific configurations. The Domain Overview
allows you to see the status of all Domains and their elements.

If the configurations are divided into different administrative Domains, the Domain Overview is shown as the
first view after logon. The Domain Overview is only available to administrators who have permissions for several
domains. You can then select the Domain that you want to manage.

Related concepts
Getting started with Domain elements on page 399

What the Home view shows
The Management Server automatically tracks the operation of the Forcepoint NGFW components, and the status
is shown in the Home view of the Management Client. You can also monitor users and the status of third-party
devices.

There are several ways to open the Home view. For example:
• Select  Home.
• Right-click an element that is monitored, then select Monitoring > Home.

Related concepts
Getting started with monitoring third-party devices on page 221

How the Home view is arranged
In the Home view, you can view the status of NGFW components and monitored third-party devices.

By default, when you start the Management Client, you see the Home view. This view provides the operating and
connectivity status of SMC components and third-party components that are set up to be monitored through the
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SMC. The status information is stored on Log Servers. The Management Server compiles the Home view based
on data from all Log Servers.

 
Figure 42: Home view

1 Status tree — Status of monitored system elements
To see the status of a component in the Status tree, expand the tree, then place the cursor over any
element. You can see the element's IP address and status in a tooltip.

2 Organize by drop-down list — Options for sorting the elements in the Status tree

3 Status cards for NGFW Engines, VPNs, and other monitored elements or the Home page for the
selected element — Show detailed information about the status and configuration of monitored
elements.
Click the card for an element to open the element's home page.

Click  New to add an element of the selected type

4 Card Size options — Options for changing the size of status cards and what information they show

5 Pending Changes pane — Shows configuration and policy changes that have not yet been transferred
to the engines. The Recent Commits pane opens in the same place and shows recent policy uploads.

6 Drill-downs pane — Shortcuts to more details of the selected element. Blank if no element is selected
in the Status tree.

7 Info pane — Details of the selected element. Blank if no element is selected in the Status tree.

8 Location for monitoring the system
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Figure 43: Card size toolbar

1 Auto — Selects the card size automatically based on the space available.

2 Sum — Shows the number of engines for each status. This card size is useful for large installations.

3 Small card size

4 Medium card size

5 Large card size

Different sizes of cards show different information.

 
Figure 44: Small cards

Small cards show only the status of the element.
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Figure 45: Medium cards

Medium cards show the status of the element, when the last policy upload was made, and whether there are any
active alerts for the element.

 
Figure 46: Large cards

Large cards show the status of the element, configuration information about the element, and whether there are
any active alerts for the element. For engine elements, the cards also show the current load of the engine.

What the NGFW Engine and VPN home pages
show
Home pages show different information depending on the type of element.

Click the status card of an element or select the element in the Status tree to open the home page for the
element.
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To edit the layout of the element home pages, click  Edit at the top right corner of the view. You can resize
panes, or drag new panes into the view. To remove a pane, drag the pane to the top of the view.

 
Figure 47: NGFW Engine home page

Table 20: Panes in engine element home pages

Pane Description

Configuration Shows information about the configuration status of the engine. To preview the properties of
the engine or the engine policy, click the engine name or policy name. To edit the properties
of the engine or to edit the policy, click  Edit.

If the configuration of an engine has not yet been completed, you can continue the
configuration (for example, save the engine’s initial configuration or upload a policy to the
engine) directly from the engine’s home page. The remaining configuration steps are shown
on the home page.

System
Connections

Shows the selected element’s status and the status of its connections with other NGFW
components. Also shows the number of endpoint clients that are sending ECA information.

Pending
Changes

Shows configuration and policy changes that have not yet been transferred to the engines.
Provides options for viewing, approving, and committing pending changes.

Recent
Commits

Shows recent policy uploads. Opens in the same place as the Pending Changes pane.
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Pane Description

Alerts Shows active alerts for the engine. The Situation type gives you an indication of what the
alert is related to (caused by, for example, user behavior checks, suspected attacks, access
rules, or licensing).

When you select an individual engine node in the Status tree, the hardware diagram page for the node opens.
The hardware diagram shows details about the status of network ports. More detailed information is shown in the
Info pane for network interfaces and hardware (appliance) status.

 
Figure 48: Policy-based VPN element home page

Table 21: Panes in policy-based VPN element home pages

Pane Description

Configuration Shows information about the configuration status of the VPN. To preview the VPN, click the
name of the VPN. To edit the VPN, click  Edit.

VPN Diagram Shows the gateways and the topology of the VPN.

Tunnels Shows the status of the tunnels in the VPN.
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Figure 49: Monitoring Group home page for route-based VPN tunnels

Table 22: Panes in Monitoring Group home pages

Pane Description

Configuration Shows an overview of the tunnels in the group.

VPN Diagram Shows the gateways and how the tunnels are connected between them.

Tunnels Shows the status of the tunnels.
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What the Pending Changes pane shows
The Pending Changes pane shows configuration and policy changes that have not yet been transferred to the
engines. What the pane shows depends on whether an engine's home page or the Home view is open.

 
Figure 50: Pending Changes pane for an engine on the engine's Home page

1 The number of pending changes for the current engine

2 Opens the Recent Commits pane

3 A menu with options to view audit data and to find out where the element is used

4 The approval status of the pending change

5 The element where the change was made
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Figure 51: Pending Changes pane for all engines in the Home view

1 The total number of pending changes for all engines

2 Opens the Recent Commits pane

3 The approval status of the pending change

4 A menu with options to view audit data and to find out where the element is used

5 The engine or engines affected by the pending change

6 The element where the change was made
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What the Recent Commits pane shows
The Recent Commits pane shows the list of recent policy uploads on the selected engine or all engines,
depending on whether an engine's home page or the Home view showing all engines is open.

 
Figure 52: Recent Commits pane for an engine on the engine's Home page

1 Opens the Pending Changes pane

2 Options for viewing, comparing, and restoring Policy and Element Snapshots

3 Opens the Policy Snapshot view for the selected engine type
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Figure 53: Recent Commits pane for an engine in the Home view

1 Opens the Pending Changes pane

2 Options for viewing, comparing, and restoring Policy and Element Snapshots

3 Shows the engine or engines to which the policy was uploaded

4 Opens the Policy Snapshot view for the selected engine type

What the Info pane shows
The Info pane is shown by default in most views. In addition to element details, the Info pane shows the most
important status information for components.

The Info pane shows detailed information about the component that you select. The type of element determines
which tabs are shown.

For example, the Interfaces tab shows information about the network ports of the selected engine node, such
as speed and duplex. The Status tab shows the status of hardware and services. For example, for NGFW
appliances, the Status tab shows the hardware status of the selected device. If the anti-malware feature is used,
the status of the anti-malware signature database is shown.
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Figure 54: Info pane for an NGFW Engine

1 Status

2 Configured interfaces

View the status of appliance configurations
When you configure a Forcepoint NGFW appliance using the plug-and-play configuration method, you can view
the status of the configuration process.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > View Appliance Configuration Status.

Related concepts
Management connections for engines and how they work on page 639
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Shortcuts for monitoring different elements
Actions for monitoring a component are available in the Monitoring branch of the element's right-click menu. The
available actions depend on the component type.

 
Figure 55: Monitoring submenu in right-click menu for components — for Firewalls

1 View component status.

2 View log data for component.

3 View the currently active connections, blacklist entries, VPN SAs, users, static and dynamic routes, and
SSL VPNs.

4 View or edit a detailed Overview or third-party Overview.

5 Select an Overview that is not listed.

Related concepts
Getting started with the Logs view on page 241
Getting started with reports on page 269

Related tasks
View Domain status on page 406
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How component statuses are indicated
The status of NGFW components and monitored third-party components is indicated by colors in most views
where the elements are displayed. The status of various system communications is indicated by colors in
monitoring diagrams and in the Info pane.

In addition to element status colors, the following icons indicate status:

• Pending configuration or policy changes on an engine are indicated by a blue balloon showing the number of
changes next to the engine in the Status tree.

• Hardware malfunctions are indicated with special icons in the Status tree. If any problems are indicated,
always check the logs and alerts to find out what is causing the problems.

Icons that indicate malfunctions
Engine hardware malfunction is indicated with an icon on top of the affected engine’s icon in the Status tree and
on all top-level branches of the tree.

For more information about the hardware malfunction, select the engine in the Status tree, then click the Status
tab in the Info pane.

Table 23: Hardware malfunction icons

Icon Hardware status Description

Warning A predefined Warning level has been reached in hardware monitoring
(for example, the remaining file system capacity is less than 15%). The
system also generates a log entry.

Alert A predefined Alert level has been reached in hardware monitoring (for
example, the remaining file system capacity is less than 5%). The system
also generates an alert entry.

Replication malfunction icon
In an environment with more than one Management Server, the configuration data is replicated to all
Management Servers that are online. If the replication of configuration data among the Management Servers
fails, an exclamation point on a yellow triangle is shown. You can see this icon on top of the Management
Server’s icon in the Status tree for each Management Server that is not synchronized with the other Management
Servers.

Element status colors
The element-level status gives an overview of the status of all engine nodes that are represented by the element
(also shown for single-node components).

Table 24: Element-level status

Color Element status Description

Green All OK All nodes have a normal status (online or standby).
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Color Element status Description

Yellow Warning Some nodes have an abnormal status or have been commanded offline,
but are still sending status updates normally.

Red Alert All nodes have an abnormal status, there are one or more nodes
that have not sent expected status updates, or all nodes have been
commanded offline.

Gray Unknown status No policy has been installed on any of the nodes.

White Not monitored An administrator has disabled monitoring for all nodes.

Node status colors
The node status gives more detailed information about individual engines.

Table 25: Node-level status

Color Node status Description

Green Node or server
online

The node or server is online.

Green (with
slot)

Locked online The node is locked online to prevent automatic status transitions. The
node does not change state unless commanded by an administrator.

Cyan Standby mode Used with clustered engines when the cluster is in Standby mode. The
node is in standby mode. One of the standby nodes goes online when the
previous online node goes to a state in which it does not process traffic.

Purple Node offline The node is offline and does not process traffic.

Purple (with
slot)

Locked offline The node is locked offline to prevent automatic status transitions. The
node does not change state unless commanded by an administrator.

Gray Timeout or unknown
status

The Management Server does not know the status of the node.

White Not monitored An administrator has disabled monitoring for the node.

Gray outline Under work, no
contact to SMC yet

The node is under work and has not contacted the SMC yet.

Green
outline

Under work, no first
policy upload yet

The node is under work, has contacted the SMC, but the first policy
upload has not yet been made.

NetLink status colors
NetLink status shows the status of the network links in a Multi-Link configuration.

Note:  The NetLink elements are queried and the status is displayed only if Probing settings are
configured in the NetLink elements and the Outbound Multi-Link element is included in the engine
configuration. (To include the Outbound Multi-Link element in the engine configuration, you add an
outbound balancing NAT rule to the policy.)
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Table 26: NetLink status icons

Color NetLink status Description

Green OK The NetLink is up.

Gray Unknown status The Management Server does not know the status of the NetLink.

White Not monitored An administrator has disabled monitoring for the NetLink.

VPN status colors
The VPN status shows the health of the VPN tunnels.

Table 27: VPN status

Color Cluster status Description

Green Tunnels up All tunnels have a normal status (online or standby) and there is traffic.

Yellow Warning An error was detected, at least for some traffic, but the tunnels are usable
in principle, and some other traffic might be getting through.

Red Error Some or all tunnels are down.

Blue Idle The tunnels are valid, but there has not been recent traffic.

White Not configured The VPN has no valid tunnels, because the VPN configuration is not
complete or does not allow any valid tunnels.

Connectivity status colors
Element diagrams and the Connectivity tab in the Info pane show the status of the connectivity between
elements.

See the tooltip for the status color for more details.

Table 28: Connectivity status

Color Status Explanation

Green OK The connection is active (there have been communications within the last
2 minutes) and no problems have been reported.

Red Error The Management Server received a report that connection attempts have
failed.

Cyan Idle Connection between components is still open but there is a pause in
communications.

Yellow Warning There are problems with heartbeat or state synchronization between
nodes in a Firewall Cluster. Only one of the interfaces used for heartbeat
or state synchronization functions properly. This warning does not affect
how the cluster functions.

Blue Closed The connection was closed by one of the components.

Gray Timeout, Unknown The Management Server does not know the status of the connection. The
connection might or might not be working.
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Overviews and how they work
Customizable Overviews contain information on the system’s status, including shortcuts to frequently used views
and statistical charts of the system’s operation. An example of a frequently used view is a log filtered by criteria
that you configured. Examples of statistical charts are engine load and traffic flow.

You can create new Overviews on an empty template or start your customization based on one of the default
Overview templates.

What Overview elements show
Overviews contain high-level status and statistical information.

You can use overviews to view:
• The system status
• Bookmarks, such as logs filtered with specific criteria
• Statistical charts on system operation (such as engine load) and the traffic flow

 
Figure 56: Example overview

1 Information is displayed as resizeable sections.

2 Use this pane to conveniently edit the content and appearance of the selected section.
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You can create several different overviews for different purposes. Several default overviews are provided as
templates.

In addition to status information, you can add various statistics related to the traffic and the operating state of
components. You can display information in various ways, such as tables, maps, and different types of charts.
Statistics can trigger an alert when the value of a monitored item reaches a limit you set.

Create Overview elements
After you create an Overview element, you can add a summary of the system status or statistics.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Overviews > New Overview.

2) Select the Overview template:
• To add your own Overview sections to an empty grid, select Empty Overview, then click OK.
• To use one of the predefined Overview templates, select the template from the list, then click OK.

Modify Overview elements
Add System Summary sections and Statistics sections to customize your Overview.

Add System Summary Sections to Overview
elements
The system summary is shown in the default start view, but you can also add it to your own Overviews.

It is possible to add more than one system summary to the same overview, but the information displayed is
always the same.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Overviews and an Overview.

2) Select  New > System Summary Section.

3) (Optional) Adjust the placement and size of the new section by dragging and dropping the section or its
edges. Resizing is based on preset grid positions. For resizing to work, drag the edge until it snaps to the
next position on the screen.

4) Click  Save or select  Tools > Save As.
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Add Statistics Sections to Overview elements
If you want to see statistical information in table or chart form, add a Statistics Section.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Overviews and an Overview.

2) Select  New, then select a section from the list.

Tip:  If you cannot find an appropriate section in the list, select Select, then select a section in
the Select Section dialog box.

Tip:  If you want to add a section based on a statistical item, select Create from Item, then
select an item from the Select Item dialog box.

3) Define the basic section properties in the Section Properties pane.

4) (Optional) Click the Senders tab, then select which elements are shown in the section.

5) (Optional) Adjust the placement and size of the new section by dragging and dropping the section or its
edges.

Note:  Resizing is based on preset grid positions. For resizing to work, drag the edge until it
snaps to the next position on the screen.

6) Click  Save or select  Tools > Save As.

Create Statistics Sections
You can save a section you have customized in one Overview as a Statistics Section. Saving allows you to
create the same type of section with the same settings in other Overviews.

After you create a Statistics Section, you can add the new section to other Overviews.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Overviews and an Overview.

2) Right-click any section in the Overview, then select Save As New Section.

3) Define the basic section properties on the General tab of the Section Properties dialog box.

4) Select the diagram settings in the Visualization tab.
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5) Select the diagram type.

Note:  You can change this selection when you include the section in an Overview. The
options available depend on the diagram settings you made in the previous step. If available,
enter the number of items to be included in the Top Limit field. If you selected Progress as
the diagram type, you can select Graph per sender or Scale per Second.

6) (Optional) Click the Items tab, then select or remove statistics items for the section.

7) (Optional) Click the Senders tab, then select which elements are shown in the section.

8) Click OK.

9) Click  Save or select  Tools > Save As.

Related concepts
Creating and editing local filters on page 295

How Statistical Items help you visualize data
Statistics process and visualize data. They help you focus on the most relevant information in the system (for
example, trends in network traffic) and find changes and anomalies in network traffic.

You can use statistics in Overviews and Reports, and when you browse Logs or Connections. Filters are
available to help you find information.

Statistical items count log entries, summaries of log fields included in those entries (like traffic volumes in log data
containing accounting information), or specified statistical data (counter items). The items are organized based on
the component types, as the runtime data they produce is different.

Note:  Log entries are referred to as records in the item names.

Add Statistical Items to Overview elements
To see a representation of statistical data in an Overview, add a Statistical Item.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Overviews and an Overview.

2) In the Section Properties pane, click Items.

3) Click Add.

4) Select the items.

5) In the Properties dialog box, click OK.
The items are added to the section and their data is displayed in the section.
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Remove Statistical Items from Overview elements
If you no longer find a Statistical Item useful or relevant, you can remove it.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Section Properties pane, click Items.

2) From the section, select the item that you want to remove, then click Remove.

3) In the Properties dialog box, click OK.
The item is removed from the section.

Set thresholds for monitored items in Overview
elements
Thresholds activate automatic tracking of monitored items in Overviews. The values of the monitored items are
checked once an hour.

For Progress items, the total of the values is compared to the threshold limit. The threshold is considered
exceeded if the average level of the curve is above the threshold limit during the tracking period.

For Top Rate and Top Rate Curve items, the highest value is compared to the threshold limit. The threshold is
considered exceeded if the highest value is above the threshold limit during the tracking period. If the threshold
limit is exceeded, an alert is sent.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Overviews and an Overview.
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2) Select Enable Alert Threshold.
 

1 Drag the threshold line to set the alert limit

2 Alert threshold option enabled

3 Enter the alert limit manually

3) Specify the threshold limit in one of the following ways:
• Drag and drop the threshold line in the overview section.
• Enter the Limit as a number in the Section Properties pane.

4) (Optional) Select the tracking period during which monitored items are compared to the threshold limit from
the For drop-down list. By default, one hour is selected.

5) (Optional) Select the Severity of the alert that is sent when the threshold limit is exceeded. By default, Low
is selected.

6) Click  Save or select  Tools > Save As.

Related tasks
Create Overview elements on page 197

Monitoring users in the Home view
In the Home view of the Management Client, there are user dashboards where you can see an overview of user
activity. For example, you can see if there is any activity that indicates suspicious behavior, such as the use
of certain applications, attempts to access specific networks, or if a user has been associated with an attack
Situation.

When users have been active and have caused log data to be generated, they are shown in the Users section
of the Home view. You can configure the time period within which a user must have been active. You can see
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charts and general statistics of user activities, and if you select an individual user, you can see more detailed
information about the user and their activities. If user information from Active Directory (AD) and the Endpoint
Context Agent (ECA) service is available, the information is shown in separate panes in the Home view.

If there are no user names stored in log data, or in regions where privacy laws dictate that users must not be
easily identified, you can display the IP addresses of users instead of their names.

Note:  To be able to monitor users by name, you must enable the logging of user information in
the Firewall IPv4 and IPv6 Access rules.

There are a set of system User Check Alerts, and you can add your own custom alerts. After configuring the
rules, the generated alerts are shown in the User section of the Home view.

Follow these general steps to configure showing users in the Home view:

1) Enable the showing of user information in the Home view.

2) (Optional) Create custom User Alerts.

3) Define rules that generate User Alerts.

Enable showing users in the Home view
To monitor users in the Home view, you must enable the option in the global system properties.

The settings defined in the global system properties apply to all administrators in all Administrative Domains.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Global System Properties.

2) On the Global Options tab, select Show Users in the Home View.

3) Configure the other settings in the User Information section.

4) Click OK.

Create User Alerts for User Alert Checks
When users exceed a threshold defined in a User Alert Check, User Alerts are generated.

In the Custom Alert, use the Situation type User Behavior Check.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.
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2) Right-click Alert Configurations, then select New > Custom Alert.

3) Configure the settings, then click OK.

Define rules that generate User Alerts
You can use different kinds of checks that generate User Alerts.

To see all the available User Alert Checks, select  Configuration, then browse to Administration > Other
Elements > User Alert Checks.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Configure User Alerts.

2) Click Add, then select  Tools > New > User Alert Check.

3) Configure the settings, then click OK.

4) To disable a User Alert Check, deselect the checkbox to the left of the User Alert Check.
If you do not want to use a system User Alert Check, you must disable the check.

5) Click OK.

Monitoring connections, blacklists, VPN
SAs, users, routing, and SSL VPNs

Firewalls track allowed connections, active VPN SAs, active users, routing, and SSL VPN sessions. Firewall,
Layer 2 Firewall, and IPS engines also track combinations of IP addresses, ports, and protocols that are
blacklisted.

Note:  To be able to monitor users by name, you must enable the logging of user information in
the Firewall IPv4 and IPv6 Access rules.

You can monitor in the following ways:

• You can view currently open connections, enforced blacklist entries, active VPN SAs, active users, routing,
and SSL VPNs.

• You can save, view and compare snapshots of currently open connections, enforced blacklist entries, active
VPN SAs, active users, routing, and SSL VPN sessions.

When monitoring users, you can only monitor the users connected to a particular NGFW Engine. To see a
summary of the activity of all active users, enable showing users in the Home view.
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Related tasks
Define logging options for Access rules on page 875
Enable showing users in the Home view on page 202

View connections, blacklists, VPN SAs, users,
routing, and SSL VPNs
There are several views in which you can monitor the status of the system.

The lists of connections, blacklisted entries, active VPN SAs, active users, routes, and SSL VPN sessions are
automatically updated in the Current Events mode. The blacklist entries are added and removed according to
their duration.

The Blacklist view does not show whether connections matching the entries are blocked by the Firewall, Layer 2
Firewall, or IPS engine. Nor does it show any history of entries that have already expired. Use the Logs view to
see information about actual connections that are allowed and denied. Depending on the logging options selected
in the policy, you can also use the Logs view to see past blacklist entry creation.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an NGFW Engine, then select Monitoring > <view type>.

Tip:  If the Drill-downs pane is open, you can also select Monitoring > <view type> from
there.

2) To browse the data, select an option from the toolbar.
You can adjust the view and the displayed data in a similar way as in the Logs view.

3) To filter data or open or compare snapshots, select the Filter tab or the Snapshots tab in the Query pane.

4) To combine entries having the same value for a given column type, right-click the heading of the
corresponding column, then select Aggregate by <column name>.

5) Select one or more entries in the table, then right-click for a menu of actions you can take.

• To view more information about related log events, select Show Referenced Events.
• To blacklist connections manually, select New Blacklist Entry or New Entry.
• To close a connection in the Connections view, select Terminate.
• To remove a blacklist entry in the Blacklist view, select Remove Entry.
• To force an SA to renegotiate in the VPN SAs view, select Delete.
• To close the end user’s session in the Users view, select Delete.
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Related concepts
Getting started with the Logs view on page 241
Browsing log data on page 249
Blacklisting traffic and how it works on page 1065

Related tasks
Blacklist traffic manually on page 1071

Terminate connections manually
In the Connections view, you can manually terminate any current connection.

For example, you can remove an inactive connection that has not been properly closed. Terminating an open
connection alone does not prevent any new connection from opening again.

You can terminate connections manually on the following types of engines and interfaces:

• Layer 3 physical interfaces on Firewalls
• Inline Interfaces on Firewalls, IPS engines, and Layer 2 Firewalls

Note:  You cannot terminate connections manually on Capture Interfaces on Firewalls, IPS
engines, or Layer 2 Firewalls.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an NGFW Engine, then select Monitoring > Connections.

2) Select one or more connections in the table.

3) Right-click a selected row, then select Terminate.

Save snapshots of connections, blacklists,
VPN SAs, users, routing, and SSL VPNs
You can save snapshots so you can later view and compare them, or restore earlier versions of elements.

The saved snapshots are stored in the following directories.

Table 29: Snapshot storage directories

Snapshot type Server Directory

Blacklist Log Server <installation directory>/data/storage/snapshots/blacklist/



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Monitoring Forcepoint NGFW components | 206

Snapshot type Server Directory

Connection Log Server

Management Server

<installation directory>/data/storage/snapshots/connections/

VPN SA Log Server <installation directory>/data/storage/snapshots/VPN SAs/

User Log Server <installation directory>/data/storage/snapshots/users/

Routing Log Server <installation directory>/data/storage/snapshots/routing/

SSL VPN Log Server <installation directory>/data/storage/snapshots/SSL VPNs/

Note:  If you installed the Management Server in the C:\Program Files\Forcepoint\SMC directory
in Windows, some program data might be stored in the C:\ProgramData\Forcepoint\SMC
directory.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an NGFW Engine, then select Monitoring > <view type>.

Tip:  If the Drill-downs pane is open, you can also select Monitoring > <view type> from
there.

2) To select the entries for the snapshot, click  Pause.
The system automatically creates a temporary snapshot of the currently displayed entries. The name of
the temporary snapshot is displayed on the Snapshots tab in the Query pane. The temporary snapshot is
automatically deleted.

3) Click  Save.

4) Enter a name for the snapshot, then click OK.
The name of the snapshot is displayed on the Snapshots tab in the Query pane.

Export snapshots of connections, blacklists,
VPN SAs, users, routing, and SSL VPNs
You can export snapshots from the Monitoring view to save stored snapshots elsewhere (for example, on your
local workstation).

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.
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2) Browse to Other Elements > Monitoring Snapshots, then browse to one of the following:

• Blacklist > Log Server
• Connections > Log Server or Management Server
• Logs > Management Server
• Routing > Log Server
• SSL VPNs > Log Server
• Users > Log Server
• VPN SAs > Log Server

3) Right-click a snapshot, then select Export.

4) Select the location to save the snapshot to, then click Select.

View snapshots of connections, blacklists,
VPN SAs, users, routing, and SSL VPNs
The snapshots are listed in the Monitoring view. You can also open snapshots saved on your local workstation.

View snapshots stored on SMC servers
You can view the snapshots you have saved.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Other Elements > Monitoring Snapshots, then browse to one of the following:

• Blacklist > Log Server
• Connections > Log Server or Management Server
• Logs > Management Server
• Routing > Log Server
• SSL VPNs > Log Server
• Users > Log Server
• VPN SAs > Log Server

3) Right-click a snapshot, then select Open.
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View snapshots stored on local workstations
If you have exported a snapshot to your local workstation, you can later view the snapshot.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Other Elements > Monitoring Snapshots, right-click one of the items in the tree, then select
Open Local Snapshot.

3) Select the snapshot, then click Open.

Compare snapshots of connections, blacklists,
VPN SAs, users, routing, and SSL VPNs
You can compare snapshots of connections, blacklists, VPN SAs, users, routing, and SSL VPNs with another
snapshot of the same type. You can also compare a snapshot with the current blacklist, connections, VPN SAs,
users, or routing entries.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Other Elements > Monitoring Snapshots, then browse to one of the following:

• Blacklist > Log Server
• Connections > Log Server or Management Server
• Logs > Management Server
• Routing > Log Server
• SSL VPNs > Log Server
• Users > Log Server
• VPN SAs > Log Server

3) Right-click the snapshot, then select Open.

4) In the Query pane, click the Snapshots tab.

5) Using one of the following methods, select the first snapshot for comparison:
• To compare a temporary snapshot of the current entries with a saved snapshot, click  Pause to create

the temporary snapshot. The name of the temporary snapshot is displayed in the first snapshot selection
field.

• Otherwise, click  Select next to the first snapshot selection field, then select a snapshot.
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6) Select the Compare with checkbox.

7) Click  Select next to the second snapshot selection field, then select a second snapshot.

8) Click Apply.
The results of the comparison are highlighted.

 
Figure 57: Snapshot comparison results

The icons in the first column signify whether the entry has changed. 

Icon Description

Entry only exists in snapshot 1

Entry is included in both snapshots

Entry only exists in snapshot 2

Aggregated entries

No icon There are more than 100 entries that match the Aggregate by <column name> selection. No
further comparison can be done.
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Figure 58: Example of snapshot comparison with entries aggregated by service

Tip:  To open a snapshot for comparison directly in the Monitoring view, right-click the
snapshot, then select Compare to Current.

Related concepts
Browsing log data on page 249

View and compare Element Snapshot
elements

You can view earlier configurations of an element and compare them to the current configuration with Element
Snapshots. You can also restore earlier configurations of an element.

Element Snapshots are automatically generated and saved in Audit logs each time element properties are saved.
An Element Snapshot contains all properties of an element saved in the Properties dialog box.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Select Audit from the drop-down list in the Query pane, then click Apply.
All Element Snapshots generated during the defined time range are displayed in the Snapshot column of the
log entry table.

Tip:  If the column is not displayed, to add it, select  Tools > Columns > Column
Selection.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Monitoring Forcepoint NGFW components | 211

 

1 Element snapshot

2 Snapshot column

3 Audit selected

3) To view an Element Snapshot in more detail, right-click the Audit entry, then select View Element
Snapshot.

4) To compare an Element Snapshot to the current configuration of the same element, right-click an Audit entry,
then select Compare to Current Element.

Note:  If the Element Snapshot properties differ from the current element properties, a red
border is displayed around the Audit Log Version (snapshot) and Current Version of the
element.

Tip:  To display all values of the snapshot and the current element in XML format with
differences indicated in red, select Show: XML.

5) To close the Compare Elements dialog box, click OK.

Related concepts
Benefits of exporting or importing elements on page 158

Related tasks
Select columns in the log entry table on page 260

Monitoring connections using
Geolocation elements

Using Geolocation elements, you can define the physical locations of network elements, such as Hosts.

You can also see, for example, how much traffic the elements create.
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This product includes GeoLite data created by MaxMind, available from http://www.maxmind.com. The location
information for public IP addresses is based on the GeoLite data created by MaxMind. The IP addresses in the
Geolocation database are updated when the Management Server is upgraded.

You can also create Geolocations manually in the SMC. Geolocations based on internal IP addresses must
be configured manually, as these addresses cannot be found in the Geolocation database based on public IP
addresses. Creating a Geolocation manually for a public IP address overrides location data found for the address
in the Geolocation database.

Geolocation maps are available in Reports, Statistics, and Overviews.

Note:  You cannot use Geolocation elements to filter network traffic. Use Country elements for
that purpose.

Create Geolocation elements
A Geolocation represents the physical location of a network element. When you create a Geolocation, select the
elements that belong to it.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Expand Other Elements.

3) Right-click Geolocations, then select New Geolocation.

4) Enter the Name and Address.

5) To define the Coordinates, select an option:
• To automatically resolve the Geolocation coordinates, click Resolve from Address.
• Enter the Latitude and Longitude in Decimal Degrees format (for example, latitude 49.5000° and

longitude -123.5000°).

6) Click the Content tab, then select the elements that belong to the Geolocation.

7) Click OK.

Set a Geolocation for an element
You can set many elements to use the same Geolocation.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an element, then select Tools > Set Geolocation.

http://www.maxmind.com
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2) Select a Geolocation for the element, then click Select.

Geolocations and IP addresses in Google Maps
You can view the actual location of a Geolocation element or an IP address in more detail in Google Maps.

You can use the Show in Google Maps option in:
• Geolocation maps included in Overviews and Reports
• The Logs view
• The Whois Information dialog box

View Geolocation element locations in
Overviews and Reports
Geolocation elements are displayed in Google Maps based on the location data that was entered for them.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) On a Geolocation map in an Overview or Report section, right-click a location, then select Show in Google
Maps.
The location is opened in Google Maps in your default web browser.

Related concepts
Overviews and how they work on page 196
Designing reports on page 272

View IP address locations in the Logs view
In the Logs view, you can see a location (for example, a city or street address) for an IP address in Google
Maps.

Only IP addresses associated with a location can be displayed in Google Maps. In the Logs view, these IP
addresses are indicated with a country flag icon next to the IP address.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Select a log entry with an IP address that has a flag icon associated with it.

3) Right-click the IP address in the Fields pane, then select Show in Google Maps.
The location is opened in Google Maps in your default web browser.
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View IP address locations from the Whois
Information dialog box
When checking the Whois information for an IP address, you can see the location (for example, a city or street
address) in Google Maps.

Only IP addresses associated with a location (for example, a city or street address) can be displayed in Google
Maps.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Right-click the IP address of a log entry that has a flag icon associated with it, then select Whois <IP
address>.

3) Right-click the Whois Information dialog box, then select Show in Google Maps.
The location is opened in Google Maps in your default web browser.

Monitoring configurations and policies
The engines receive their configuration when a policy is installed.

You can monitor the policies and configurations installed on the engines in the following ways:
• You can check which policy is being enforced and when it was last installed.
• You can quickly view the most recent version of the installed policy.
• You can view the configurations that were transferred in each past policy installation and compare them to

each other or the current policy stored on the Management Server.
• You can view, approve and commit the changes to the configuration and policies of engines that have not

been transferred yet.

Related concepts
Getting started with policies on page 787

Related tasks
Check the currently installed policy on page 801
View, approve, and commit pending changes on page 110
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Monitor administrator actions
A record of administrator actions is maintained in the SMC.

The records can only be viewed by administrators who are allowed to view Audit logs. They can be browsed like
any other logs in the Logs view.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Audit.
The Logs view opens with the Audit logs selected for viewing.

2) Browse and filter the logs.

Related concepts
Getting started with the Logs view on page 241

Monitor tasks
You can check the status of running tasks and executed tasks (for example, upgrade tasks and system tasks).

Note:  System tasks that run automatically are not visible in the History branch.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Expand the Tasks branch.

3) To show Tasks that are running, select the History branch.
You can see the following columns:
• Progress — Shows the progress of a running Task.
• Info — Shows additional details about the execution of a Task.
• State — Shows the status of the Task.

4) To show tasks that have previously been run, right-click the History branch, then select Show Executed
Tasks.

Related concepts
Creating Task Definitions on page 1294
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Related tasks
Schedule Tasks on page 1300
Start Tasks manually on page 1301
Stop running Tasks on page 1302

Traffic captures and how they work
You can capture network traffic data for network troubleshooting purposes. This data helps you to analyze
network traffic to and from the engines.

It is also often useful to have this data available when contacting Forcepoint support.

Traffic capture creates a .zip file that contains a tcpdump CAP file, which is compatible with standard “sniffer”
tools such as tcpdump, WinDump, or Wireshark. You can select whether to include full packet information or
only IP address headers in the tcpdump. You can also include a free-form description and information about your
configuration and trace files in the traffic capture .zip file.

The data can be archived and analyzed later, as the traffic capture .zip file is saved on the Management Server
or in a directory on your local workstation.

Traffic captures can only be taken on nodes that are online and have a policy uploaded.

Note:  You must have permissions to send Advanced Commands to be able to take traffic
captures.

You can stop or cancel a traffic capture at any point once it has been started.
• If you stop a traffic capture, all captured tcpdump data is compressed and sent to the Management Server or

to your local workstation.
• If you cancel a traffic capture, all captured tcpdump data is deleted.

Related tasks
Create Administrator Role elements on page 358

Take traffic captures
If you want to analyze network traffic, capture the network traffic data.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an NGFW Engine, then select Tools > Capture Traffic.

3) Select one or more interfaces whose traffic you want to capture, then click Select.

https://support.forcepoint.com
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4) (Optional) Click Add to add more interfaces to the traffic capture.
You can also add interfaces from other types of engines.

Tip:  You can create tcpdump files for several different interfaces in the same Traffic Capture
task. The Traffic Capture .zip file contains a separate CAP file for each interface included in
the capture.

5) (Optional) To limit the scope of the traffic capture, click the Limit by field, then enter an IPv4 or IPv6
address.
The IP address must match either the source or destination of the packets included in the capture.

6) Define the other traffic capture options.

7) Click Start Capture.

Related concepts
Alert log messages for troubleshooting on page 1345
Log messages for troubleshooting on page 1347
Error messages for troubleshooting on page 1353

Checking maintenance contract
information

You can view maintenance contract and support level information for your licenses in the Management Client by
allowing your Management Server to contact Forcepoint servers.

This information is available for each license in the Licenses > All Licenses branch of the Administration
Configuration view, if the Management Server can contact the servers.

To enable viewing maintenance contract and support level information permanently for your licenses, you must
allow the Management Server to connect to the servers.

Related concepts
Getting started with automatic updates and upgrades on page 1257
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Enable or disable automatic checking of
maintenance contract information
You need to allow the Management Server to connect to Forcepoint servers.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Global System Properties.

2) On the Updates tab, select Enable Sending Proof-of-License Codes to FORCEPOINT Servers.

3) Click OK.

View current maintenance contract information
When contract checking is enabled, you can view information on your support contract.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Licenses, then browse to All Licenses or a component-specific branch.
The licenses are shown in the table in the right pane.

3) Select the license that you want to view.

Note:  If information is not available, make sure that you have enabled the automatic
checking of maintenance contract information or manually fetch the latest information.

Manually fetch latest maintenance contract
information
If you do not allow contacting Forcepoint servers automatically, you can fetch the information manually.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Licenses, then browse to All Licenses or a component-specific branch.
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3) Right-click the selected branch, then select Check Maintenance Contract or Tools > Check Maintenance
Contract.
You are prompted to confirm that you want to send proof of license codes to Forcepoint.

4) Click Yes.
If the Management Server can connect to Forcepoint servers, the Management Client displays the
maintenance contract and support level information for the licenses. The information is available in the
Management Client until the Management Server is restarted.

Check when internal certificates or CAs
expire

You can check the status of internal certificates used in system communications and the status of the Internal
Certificate Authority that automatically signs the internal certificates.

The Internal Certificate Authority is valid for 10 years. It is renewed automatically. The SMC does not accept
certificates signed by an expired Internal Certificate Authority. All components must receive new certificates
signed by the new Internal Certificate Authority before the old Internal Certificate Authority expires. By default,
internal certificates are renewed automatically for engines and VPN gateways. For all other components, you
must generate the certificates manually.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Certificates > Internal Certificates or Certificates > Certificate Authorities > Internal
Certificate Authorities.
The existing internal certificates or Internal Certificate Authorities are displayed in the right pane.

Note:  For information about the expiration of the certificate or the Internal Certificate
Authority, see the Expiration Date column.

3) To view detailed information, right-click a certificate or Internal Certificate Authority, then select Properties.

Related concepts
Problems with certificates on page 1355

Related tasks
Check when VPN gateway certificates expire on page 1234
Check when VPN certificate authorities expire on page 1234
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 CHAPTER 12

Monitoring third-party devices
Contents

• Getting started with monitoring third-party devices on page 221
• Converting logs from third-party devices on page 222
• Methods for monitoring third-party device status on page 232
• Configuring Log Servers to monitor third-party devices on page 235
• Activate monitoring of third-party devices on page 236
• Configuring third-party devices for monitoring on page 237
• Changing the ports for third-party device monitoring on page 238
• Activate or deactivate third-party device monitoring alerts on page 239

The SMC can be configured to log and monitor other manufacturers’ devices in much the same way as SMC
components are monitored.

Getting started with monitoring third-
party devices

As well as SMC components, you can monitor third-party devices, with some limitations.

What the third-party device monitoring feature does
You can configure Log Servers for a full range of monitoring features for third-party devices:
• Log Servers can receive a syslog stream and store the information in SMC log format. The stored logs can

then be processed just like logs generated by SMC components. For example, the data can be included in
reports you generate.

• Log Servers can receive SNMP statistics information and NetFlow (v5 and v9) and IPFIX data from third-party
devices. You can view this information as part of your Overviews or create reports based on the received data.

• Log Servers can probe devices through several alternative methods. You can monitor the device status in the
Management Client in the same way as for the SMC components.

Limitations
Each Log Server can monitor a maximum of 200 third-party devices. This limit is enforced automatically.

SNMP statistics for third-party devices are limited to the amount of free and used memory, CPU load, and
interface statistics.

Your Management Server license might limit the number of managed components. Each monitored third-party
device is counted as a fifth of a managed unit.
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Third-party device monitoring configuration
overview
The steps you follow depend on the types of third-party devices you want to monitor.

Follow these general steps to configure the monitoring of third-party devices:

1) (Optional, for syslog data only) If you want to receive syslog data, define the syslog reception settings for
each type of third-party device.

2) (Optional) If you want to monitor the status of third-party devices and receive statistics from them, define the
status and statistics monitoring settings for each type of device.

3) Activate monitoring for the third-party device by adding monitoring settings in the properties of each element
that represents a third-party device. (Third-party devices are: Router, Host, Active Directory Server, LDAP
Server, RADIUS Authentication Server, and TACACS+ Authentication Server.)

4) Depending on features used, configure the third-party device for monitoring.

Related concepts
Converting logs from third-party devices on page 222
Methods for monitoring third-party device status on page 232
Configuring third-party devices for monitoring on page 237
Changing the ports for third-party device monitoring on page 238
Configuring Log Servers to monitor third-party devices on page 235

Related tasks
Activate monitoring of third-party devices on page 236
Activate or deactivate third-party device monitoring alerts on page 239

Converting logs from third-party devices
You can set up most external devices to send logs to the Log Server in syslog format.

The Log Server can convert incoming syslog entries to SMC log entries. You can use predefined Logging Profile
elements or create new elements to determine how the field values are selected from a syslog entry and inserted
into an SMC log entry. A Logging Profile must have at least one logging pattern. Logging patterns determine how
the fields from syslog entry are parsed to the appropriate log fields in an SMC log entry.

You can create logging patterns in the following ways:
• Ordered Fields — Use when the fields in the syslog message are not separated by keywords and the type

of field can only be deduced from its position. The received syslog entries are parsed in a sequence that you
define in the Logging Profile. If the incoming logs vary in structure, you must define a different sequence for
each type of structure. You can define several patterns in one Logging Profile.

• Key-Value Pairs — Use when the syslog message contains keywords that describe the type of field. The
received syslog entries are parsed based on key values that you define in the Logging Profile. You can define
the key values in any order. A single definition can be used even if logs vary in structure.
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It is easier to configure a pattern using key-value pairs. We recommend that you use key-value pairs if a third-
party device formats the relevant parts of the syslog packet as key-value pairs. Ordered fields can be used to
process all syslog data regardless of its format, but it is more difficult to configure a pattern as ordered fields.

If a match is found, the system simply converts the matching syslog entry to an SMC log field. You can define
Field Resolvers for more complex operations.

You can categorize incoming logs from third-party devices by selecting specific Log Data Tags for them. You can
categorize logs based on the log type, or the feature or product that generates the logs. For example, you can
associate the “Firewall” Log Data Tag with third-party firewall logs.

You can create categories by dividing the logging patterns in a Logging Profile in sections. Both ordered fields
and key-value pairs can be divided into sections. You can select one or several Log Data Tags for each section.
The selected Log Data Tags are shown for the matching log entries in the Fields pane of the Logs view if the
Log Data Tags column is enabled. In addition to the Log Data Tags you define in the Logging Profile, the default
“Third Party” and “Log Data” Log Data Tags are associated with all logs from third-party devices.

You can also use Log Data Tags as filtering criteria in the Logs view, in Reports, and in Local Filters for various
elements. (Elements include: Administrator, Log Server, and Management Server elements and Correlation
Situations).

Related concepts
Changing the ports for third-party device monitoring on page 238
Getting started with the Logs view on page 241
Getting started with filtering data on page 291

Related tasks
Create Logging Profile elements on page 223
Add Field Resolvers in Logging Profile elements on page 230

Create Logging Profile elements
A syslog packet consists of three parts: <PRI>, HEADER, and MSG. In a Logging Profile element, you define
patterns for converting the MSG part of the syslog packet to a SMC log entry.

A Logging Profile parses the data in a syslog message to the corresponding SMC log fields when the syslog entry
is converted to an SMC log entry. The parts of the syslog packet are explained in more detail in the following
table.

Table 30: Parts of the syslog packet

Section Description

<PRI> Contains facility and priority information.

The Log Server automatically extracts the Facility value from the <PRI> part and converts it
to the Syslog Facility field in SMC logs. You do not define patterns for mapping this section
in the Logging Profile.

HEADER Contains a time stamp and the host name or IP address of a device.

The Log Server automatically extracts the data in the HEADER part.

This section is optional in syslog packets, so not all devices send this data.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Monitoring third-party devices | 224

Section Description

MSG Contains the text of the syslog message. In the Logging Profile, you define the mapping for
parsing this part of the syslog packet.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Third-Party Devices > Logging Profiles.

3) Right-click Logging Profiles, then select New > Logging Profile.

4) Enter a name for the Logging Profile, then click OK.

5) (Optional) To insert fields, drag and drop items to the Header field from the Fields branch in the Resource
pane, or use type-ahead search.

 

Note:  You can add fields that are the same for all logging patterns that you define in the
Patterns pane. To omit a portion of data, add an Ignore field.

Important:  Type or copy and paste from the syslog message any tokens that appear before
and after the field values. If you do not insert the appropriate tokens, the data cannot be
parsed.

In the illustration, the header of the syslog entry contains the following data common for all patterns:

<Cisco time><space><Ignore><space><Ignore><space><Cisco original time>

As a result, the header contains the following data:

<Sep 21 04:04:56> <cisco-example.stonesoft.com> <1815452:> <Sep 21 04:04:55> %

Because the Ignore field is used for <cisco-example.stonesoft.com> and <1815452:>, the values
are not converted to SMC log entry format.

6) Select how Patterns are parsed:
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• Ordered Fields — The syslog entries are parsed in the specified order. If the incoming logs vary in
structure, you must define several patterns.

• Key-Value Pairs — The syslog entries are parsed based on key-value pairs that you define. You can add
key-value pairs in any order. You can use one pattern for all logs even if the logs vary in structure.

7) Click  Save.

Related concepts
Converting logs from third-party devices on page 222

Related tasks
Define logging patterns as ordered fields in Logging Profile elements on page 225
Define logging patterns as key-value pairs in Logging Profile elements on page 227

Define logging patterns in Logging Profile
elements
You can define logging patterns in the Logging Profile using ordered fields or key-value pairs.

Define logging patterns as ordered fields in
Logging Profile elements
The pattern that you define in a Logging Profile must be an exact match for the incoming syslog entry. If incoming
logs vary in structure, you must define a different pattern for each type of entry.

If several patterns match, the system uses the pattern with the most matching entries.

Each received syslog entry is converted to an SMC log entry. The field values that match a specified pattern are
copied without further processing to an SMC log field. Also, you can create Field Resolvers to convert specific
values in the syslog data to specific values in SMC logs.

You can use sections in the Logging Profile to organize the logging patterns. To create categories, you can
associate one or several Log Data Tags with each section. The Log Data Tags improve the way log entries can
be viewed and stored. However, they do not affect the way third-party log entries are converted into SMC log
entries. If you do not select specific Log Data Tags for a section, only the default “Third Party” and “Log Data” Log
Data Tags are shown for the matching log entries.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Logging Profile, select Ordered Fields as the Pattern.
 

2) (Optional) In the header row of the Patterns section, click the Select Log Data Tags link.
Select the Log Data Tags according to the type of traffic that matches the ordered fields in the section, then
click Add. The selected Log Data Tags are added to the Content list.

Note:  Log Data Tags make the converted third-party log data records visible in the
appropriate log data contexts. They also generate log data storage indexes, which speed up
the filtering by data tags.

3) To insert the field values, drag and drop items from the Fields branch in the left pane to the empty space in
the Patterns section. Or use type-ahead search.
Alternatively, you can define a Field Resolver, then add it to the pattern instead of a log field. To omit a
portion of data, add an Ignore field.

Important:  Type or copy and paste from the syslog message any tokens that appear before
and after the field values. If you do not insert the appropriate tokens, the data is not parsed.
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4) (Optional) If some incoming log entries have a different structure, press Enter to add more rows to the
Patterns section.

5) (Optional) To create another section in the same Logging Profile, click Add Section, then configure the new
section.

6) In the Unmatched Log Event section, select the action for handling syslog data that does not match any
defined logging patterns:
• Store in 'Syslog message' field — A log entry is created and all data is inserted into the Syslog

Message log field. The log entry is stored on the Log Server.
• Display in 'Syslog message' field (Current mode only) — A log entry is created and all data is inserted

into the Syslog Message log field. The log entry is displayed in the Current Events mode in the Logs view,
but it is not stored.

• Ignore — The data is discarded.

Related tasks
Add Field Resolvers in Logging Profile elements on page 230
Validate Logging Profile elements on page 231
Activate monitoring of third-party devices on page 236

Define logging patterns as key-value pairs in
Logging Profile elements
When you define key-value pairs for converting syslog data, the Log Server parses each received syslog entry
data based on the defined key-value pairs.

The data in the incoming syslog message must be formatted as key-value pairs.

You can use sections in the Logging Profile to organize the logging patterns. To create categories, you can
associate one or several Log Data Tags with each section. The Log Data Tags improve the way log entries can
be viewed and stored. However, they do not affect the way third-party log entries are converted into SMC log
entries. If you do not select specific Log Data Tags for a section, only default “Third Party” and “Log Data” Log
Data Tags are shown for matching log entries.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Logging Profile, select Key-Value Pairs as the Pattern.
 

2) (Optional) Click the Select Log Data Tags link in the header row of the Patterns section.
Select the Log Data Tags according to the type of traffic that matches the key-value pairs in the section, then
click Add. The selected Log Data Tags are added to the Content list.

Note:  Log Data Tags make the converted third-party log data records visible in the
appropriate log data contexts. They also generate log data storage indexes, which speed up
the filtering by data tags.

3) Drag and drop SMC log fields from the Fields branch in the left pane to the Field column.
Alternatively, you can define a Field Resolver and add it to the pattern instead of a log field. To omit a portion
of data, add an Ignore field. By default, the Ignore field is added to the Field column in the new section.

4) Double-click the Key column for the log field that you added, then type the corresponding key value as it
appears in the syslog message (for example, devTime).

5) (Optional) To add more key-value pairs to a section, right-click a row, then select Add Row.
The key values can be added in any order. The key values are converted to SMC log entries based on the
key values alone.

6) (Optional) To create another section in the same Logging Profile, click Add Section, then configure the new
section.

7) In the Unmatched Key section, select the action for handling syslog data that does not match any defined
logging patterns:
• Store in 'Syslog message' field — A log entry is created and all data is inserted into the Syslog

Message log field. The created log entry is stored on the Log Server.
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• Ignore — The data is discarded.

Related concepts
Converting logs from third-party devices on page 222

Related tasks
Define logging patterns as ordered fields in Logging Profile elements on page 225
Add Field Resolvers in Logging Profile elements on page 230
Validate Logging Profile elements on page 231
Activate monitoring of third-party devices on page 236

Benefits of adding Field Resolvers in Logging
Profile elements
Field Resolvers convert values in incoming syslog fields to different values in SMC logs.

There are two types of Fields Resolvers: multi-value field resolvers and date field resolvers.

Multi-valued field resolvers
You can use multi-valued field resolvers in the following case:

To convert one value to several log fields — In some cases, a single value can have several corresponding log
fields in SMC logs. A Field Resolver can parse a single value into multiple SMC log fields. For example, SMC
components set an Action, a Situation, and an Event for traffic filtering decisions. If the external component
notifies a “permitted” action, the Field Resolver can set the corresponding SMC log values for all 3 log fields.

Note:  You can also use multi-value field resolvers if the log data has a pre-set range of values
on the external devices and in the SMC. However, the possible values are different. For example,
you can map a range of alert severities in the original data to similar alert severities in SMC logs
(Info/Low/High/Critical).

Date field resolvers
You can use date field resolvers in the following case:

Converting time stamps — Different external devices use different date and time formats. A Field Resolver for
each different incoming format maps the times and dates correctly to the SMC log format. The date and time
syntax in Field Resolvers follows the Java standard.
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Add Field Resolvers in Logging Profile
elements
For converting syslog values, add a field resolver for either multiple values or for date and time.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Logging Profile, click the Field Resolvers branch in the left pane.

2) Drag and drop a Field Resolver to the Header field or to the Patterns pane.

3) If the Field Resolver you want is not listed, right-click a Field Resolver, then select New > Field Resolver.
Define the Field Resolver for either multiple values or for date and time.

Related tasks
Define Field Resolvers for multiple values in Logging Profile elements on page 230
Define Field Resolvers for date and time in Logging Profile elements on page 231
Validate Logging Profile elements on page 231

Define Field Resolvers for multiple values in
Logging Profile elements
You can set the Field Resolver to convert various fields to the correct format, or to combine more than one field
into one.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of the Field Resolver, select Multi-valued as the Field Type.

2) In Fields, click Add, then select the appropriate SMC log fields.
The incoming syslog data is inserted into the log fields you select.

3) To add a row to the table, click Add.

4) Enter the value that is used on the third-party device in the Value cell.

5) Enter or select the value you want to use for each selected SMC log field.

6) Click OK.
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Related tasks
Define logging patterns as ordered fields in Logging Profile elements on page 225
Define logging patterns as key-value pairs in Logging Profile elements on page 227
Define Field Resolvers for date and time in Logging Profile elements on page 231
Validate Logging Profile elements on page 231

Define Field Resolvers for date and time in
Logging Profile elements
You can set the Field Resolver to convert date and time values.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of the Field Resolver, select Date as the Field Type.

2) Click Select next to Time Field, then select the log field for which you want to define a time stamp.

3) In the Time Format field, enter the format that the third-party device uses for the time stamp.
Type the format according to Java standards. For the syntax, see:

http://docs.oracle.com/javase/1.5.0/docs/api/java/text/SimpleDateFormat.html

Example: Typing MMM dd HH:mm:ss maps the log time stamp as Jan 30 13:23:12.

4) Click OK.

Related tasks
Define logging patterns as key-value pairs in Logging Profile elements on page 227
Define logging patterns as ordered fields in Logging Profile elements on page 225
Define Field Resolvers for multiple values in Logging Profile elements on page 230
Validate Logging Profile elements on page 231

Validate Logging Profile elements
To verify that the syslog data is converted correctly to SMC log fields, you can test a Logging Profile that you
created.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Third-Party Devices > Logging Profiles.

http://docs.oracle.com/javase/1.5.0/docs/api/java/text/SimpleDateFormat.html
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3) Right-click the Logging Profile that you want to validate, then select Edit Logging Profile.

4) Click the Validation tab.

5) To select a file with syslog data, click Browse.
 

6) Click Validate.
The imported data is displayed in the first pane. The validation results are displayed in the second pane. The
first column of the results pane shows which logging pattern is used to convert each syslog entry.

Related tasks
Create Probing Profile elements for monitoring third-party devices on page 234
Activate monitoring of third-party devices on page 236

Methods for monitoring third-party
device status

The Log Server can actively probe the status of third-party components using several alternative methods.

The supported methods are:
• SNMPv1
• SNMPv2c
• SNMPv3
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• Pings
• TCP connection probes

When one of the SNMP status probing methods is used, you can also set up statistics reception for the device.
Statistics reception relies on SNMPv1 traps sent by the third-party device.

The SMC supports statistical monitoring of the following details:
• Amount of free and used memory
• CPU load
• Interface statistics

Related concepts
Changing the ports for third-party device monitoring on page 238

Related tasks
Import MIBs for monitoring third-party devices on page 233
Create Probing Profile elements for monitoring third-party devices on page 234
Activate monitoring of third-party devices on page 236

Import MIBs for monitoring third-party devices
You can import third-party MIBs (management information bases) to support third-party SNMP monitoring.

Before you begin
You must have a MIB file for the device from the device vendor.

The OIDs (object identifiers) allow resolving the SNMP traps when they appear in log entries. If the OIDs are not
resolved, they appear in the logs using a more difficult to read dotted notation. Only SNMPv1 Trap Reception is
supported.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Third-Party Devices > MIBs.

3) Right-click MIBs, then select Import MIBs.

4) Browse for the MIB file to import, then click Import.

5) (Optional) When the import is finished, click Close.

6) In the navigation pane, browse to MIBs > All MIBs or MIBs > By Vendor.
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7) To view the contents of a MIB, right-click it, then select Properties.
The General tab shows the contents of a MIB as is. To view information about the objects that the MIB
defines, click the OID Tree tab. The information includes the object identifiers, their OIDs in dot notation, and
possibly a description of the object.

8) Click OK.

Related tasks
Create Probing Profile elements for monitoring third-party devices on page 234

Create Probing Profile elements for monitoring
third-party devices
Probing Profiles define the monitoring of third-party device status (using SNMPv1/SNMPv2c/SNMPv3/Ping/TCP)
and the settings for receiving statistics information from them (using SNMPv1).

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Third-Party Devices > Probing Profiles.

3) Right-click Probing Profiles, then select New > Probing Profile.

4) Define the probing profile settings on the General tab.

5) On the Status tab, define the probing profile status settings.

6) (SNMP/SNMPv2c/SNMPv3 probing only) On the Statistics tab, define the settings for statistics reception
using SNMPv1 traps.

7) Click OK.

Related concepts
Converting logs from third-party devices on page 222

Related tasks
Activate monitoring of third-party devices on page 236
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Configuring Log Servers to monitor
third-party devices

Log Servers can be configured to monitor third-party devices.

You can select:

• A Probing Profile that defines how the Log Server monitors the device.
• A Logging Profile that defines how the received syslog data is converted into SMC log entries.

You can also configure Log Servers to receive SNMP traps or NetFlow (v5 or v9) or IPFIX data from third-party
devices.

Define monitoring rules on a Log Server
Configure the rules that send monitoring data to a Log Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others > Log Server.

3) Right-click the Log Server to which you want to send monitoring data, then select Properties.

4) Switch to the Monitoring tab.

5) To create a rule, click Add.

6) Configure the monitoring rules.

7) To remove a rule, select the rule, then click Remove.

8) Click OK.
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Create Access rules allowing third-party
monitoring
If a third-party device and the Log Server are separated by a Firewall or Layer 2 Firewall, edit the Policy to allow
traffic from the device to the Log Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand Policies, then browse to the type of policy you want to edit.

3) Right-click the Firewall or Layer 2 Firewall policy, then select Edit Firewall Policy or Edit Layer 2 Firewall
Policy.

4) Switch to the IPv4 Access or IPv6 Access tab, then add an Access rule with the following values:
• Source — the third-party element.
• Destination — your Log Server.
• Service — ICMP Ping, SNMP (UDP), or SNMP (TCP).

The Service depends on the probing method that is used in the Probing Profile selected in the Monitoring
rule.

• Action — Allow.
• Logging — None.

5) Save and install the policy to start using the new configuration.

Activate monitoring of third-party
devices

You can activate status monitoring, log reception, or both for a third-party device.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others > Third Party.

3) Right-click a third-party device, then select Properties.

4) On the Monitoring tab, select the Log Server to which the logs from the third-party device are sent.
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5) (Optional) To receive status information, select Status Monitoring, then select the Probing Profile.

6) (Optional) To receive logging information, select Log Reception, then select the Logging Profile.

7) (Optional) To receive SNMP traps from the third-party device, select SNMP Trap Reception.

8) (Optional) To receive NetFlow/IPFIX data from the third-party device, select NetFlow Reception.

9) Click OK.

Related concepts
Getting started with monitoring the system on page 179
Converting logs from third-party devices on page 222
Configuring third-party devices for monitoring on page 237
Changing the ports for third-party device monitoring on page 238
Getting started with the Logs view on page 241
Configuring Log Servers to monitor third-party devices on page 235
Defining IP addresses as elements on page 895
Getting started with directory servers on page 1075
Getting started with user authentication on page 1097

Related tasks
Create Probing Profile elements for monitoring third-party devices on page 234
Activate or deactivate third-party device monitoring alerts on page 239
Create Access rules allowing third-party monitoring on page 236

Configuring third-party devices for
monitoring

For any type of monitoring, confirm that the connections between the third-party device and the Log Server are
allowed through any possible traffic filtering in your network. When configuring third-party devices for monitoring,
be aware of some conditions.

• Ping and TCP status monitoring do not usually require additional configuration on the target device.
• SNMP-based polling usually requires that the target device is configured to respond to the Log Server’s SNMP

queries.
• Statistics sending (as SNMPv1 traps) must always be configured on the third-party device. For instructions on

these tasks, see the documentation of the third-party device.
• NetFlow or IPFIX reception requires that the third-party device is configured to send NetFlow or IPFIX data.

This configuration includes activating the service on the device and defining the reception port and IP address
of the NetFlow or IPFIX collector (the Log Server).

• If necessary, you can change the ports that the Log Server uses to listen to syslog, SNMP, NetFlow, and
IPFIX transmissions.
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Related concepts
Changing the ports for third-party device monitoring on page 238
Configuring Log Servers to monitor third-party devices on page 235

Related tasks
Activate monitoring of third-party devices on page 236
Activate or deactivate third-party device monitoring alerts on page 239
Create Access rules allowing third-party monitoring on page 236

Changing the ports for third-party device
monitoring

It is recommended to set your third-party devices to send data to the default ports that the Log Server listens to.

The default listening ports are:
• Windows — The Log Server listens to syslog on port 514 and SNMP traps on port 162.
• Linux — The Log Server listens to syslog on port 5514 and SNMP traps on port 5162.
• Windows and Linux — The Log Server listens to NetFlow and IPFIX data on port 2055.

If necessary, you can change the ports for syslog, SNMP, NetFlow, and IPFIX reception, but the port number in
Linux must always be higher than 1024.

If it is not possible to reconfigure the third-party device to send syslog data, SNMP traps, NetFlow data, or IPFIX
data to the correct port, you have other options. You can redirect traffic to a different port using an intermediate
network device or on the Log Server, using iptables in Linux:

iptables -t nat -A PREROUTING -p udp -m udp --dport 514 -j REDIRECT --to-ports 5514

Related concepts
Configuring Log Servers to monitor third-party devices on page 235

Related tasks
Activate monitoring of third-party devices on page 236
Activate or deactivate third-party device monitoring alerts on page 239
Create Access rules allowing third-party monitoring on page 236
Edit Log Server configuration parameters on page 432
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Activate or deactivate third-party device
monitoring alerts

You can activate or deactivate the status surveillance feature, which generates an alert if a monitored
component’s status remains unknown for 15 minutes.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others > Third Party.

3) Right-click an element, then select or deselect Options > Status Surveillance.

Related concepts
Configuring Log Servers to monitor third-party devices on page 235

Related tasks
Activate monitoring of third-party devices on page 236
Create Access rules allowing third-party monitoring on page 236
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 CHAPTER 13

Viewing and exporting logged
data

Contents

• Getting started with the Logs view on page 241
• Browsing log data on page 249
• Changing how log entries are displayed on page 259
• Exporting data from the Logs view on page 261
• Save data in PDF or HTML format on page 264
• Create rules from log entries on page 266

You can view log, alert, and audit entries through the log browsing views. You can view data from SMC servers, all
types of engines, and from third-party components that are configured to send data to the SMC.

Getting started with the Logs view
The Logs view displays all log, alert, and audit entries for the SMC.

You can view many types of entries from any number of components together or individually.

While you can view active alerts in the Logs view, you must acknowledge active alerts in the Active Alerts view.

Open the Logs view
There are several ways to access the Logs view.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) To access the Logs view, select an option:
• Select  Logs.
• To view logs sent by a component, right-click an element that produces logs, then in the Monitoring

submenu, select a log-related item.
• To open the Logs view with different filtering criteria, create different bookmarks.
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Related concepts
How the Logs view is arranged on page 242
Browsing log data on page 249
Changing how log entries are displayed on page 259
Exporting data from the Logs view on page 261

Related tasks
Create rules from log entries on page 266

How the Logs view is arranged
The default records arrangement is optimized for efficient browsing of many entries.

 
Figure 59: Logs view in the records arrangement
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Figure 60: Toolbar in the records arrangement

1 Current events mode

2 Stop the ongoing operation

3 Go to the first or last record

4 View graphical summaries based on the log entries

5 Opens the Log Analysis view

6 Opens the Tools menu

 
Figure 61: Status bar options for log browsing

1 Activity status

2 Server connectivity status

3 Set the time zone

4 The logged in user

5 The location — defines the Log Server contact address if there is NAT between the Management Client
and a Log Server

Note:  If NAT is applied between your Management Client and a Log Server, you must select the
correct Location for your Management Client to see the logs.

Logs view panes
You can select and deselect panes from  Menu > View > Panels.

The following panes are available in most arrangements:
• Fields pane — Provides quick access to categorized log entry details.
• Query pane — The most important tool in the Logs view. The Query pane allows you to filter the log entries

so that you can find the information you need.
• Task Status pane — Only available in the records arrangement. Displays the status of log-related tasks, such

as a log export that you start from the Logs view.
• Hex pane — Displays traffic recordings generated by the Excerpt logging option of an Inspection rule (other

recordings are viewed using an external viewer).
• Summary pane — Textual explanation of the event that generated the record.
• Event Visualization pane — A graphic showing important information about the event.
• Info pane — Displays detailed information on a selected log entry.
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Log entry table (records arrangement)
The log entry table in the default records arrangement is the primary view for the log entries. You can freely
select which details are shown and the order of the columns. Different types of entries contain different types of
information, so none of the entries use all columns.

When you right-click a cell in a log entry, the menu that opens allows you to select various actions related to
the log entry. The actions vary slightly depending on the information in the cell. For example, right-clicking an
element adds general element-specific actions (such as viewing the properties of the element). The actions
include, but are not limited to, the following:
• Details — Switch to the Details view of the selected record.
• Copy — Copy the entry details to the clipboard.
• View Rule — View the rule that generated the log entry (if applicable).
• Create Rule — Create a rule based on the entry.
• Whois — Look up the selected IP address in the online Whois database.
• Export — Export records or attach records to an Incident case.
• Filter Connections — Add basic details from the current selection to the Query pane.
• Show Connection — Add basic details from the selected connection to the Query pane.
• Search Related Events — Some special events are parts of a larger chain of events. This option shows other

events related to the selected log entry.
• New Blacklist Entry — Blacklist connections that match the entry’s details.
• Add Filter — Add the selected detail to the filter in the Query pane.
• New Filter — Create a filter based on the selected detail.

Related concepts
Considerations for setting up system communications on page 127
Details arrangement of the Logs view on page 245
Benefits of filtering log entries on page 250
Blacklisting traffic and how it works on page 1065

Related tasks
Use filters for browsing log entries on page 251
Browse log entries on a timeline on page 257
Check Whois records for IP addresses in log entries on page 258
Copy log entries in CSV format on page 262
Export log entries on page 262
Export IPS traffic recordings on page 263
Create rules from log entries on page 266
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Details arrangement of the Logs view
The Details arrangement of the Logs view gives an overview of an individual event.

 
Figure 62: Logs view in the Details arrangement

 
Figure 63: Toolbar in the Details arrangement

1 Stop the ongoing operation

2 Previous or next record

3 Show the Records arrangement

4 Opens the Tools menu

The Details arrangement also has the following panes:
• References pane (shown by default) — Displays a list of elements corresponding to the details in the record

and possibly more information about related records for some special records that are part of a larger event.
• Tasks pane — Shortcuts to configuration tasks that you can start based on the displayed entry (as in the

Records arrangement in the right-click menu for entries).
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Related concepts
Statistics arrangement of the Logs view on page 246

Statistics arrangement of the Logs view
In the Statistics arrangement of the Logs view, you can view charts of multiple events interactively. You can
create a quick report of the log entries that match the active Query. You can then further refine the Query by
viewing log entries that correspond to a chart segment.

 
Figure 64: Statistics arrangement

Tip:  Right-click the chart sections for options that allow you to drill-down into the details.

The Query pane in the Statistics arrangement includes another Section tab. You can use the tabs to control the
statistical display. The data can also be filtered in the same way as in other arrangements.
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Figure 65: Toolbar in the Statistics arrangement

1 Stop the ongoing operation

2 Refresh

3 Show the Records arrangement

4 View graphical summaries based on the log entries

5 Opens the Log Analysis view

6 Opens the Tools menu

7 Options for creating new sections and reports

8 Generate a new chart with a wider time range

The chart area in the Statistics arrangement can contain a pie chart, a bar chart, a line chart, stacked line chart,
or a map chart (based on an internal geolocation database). The available options depend on the chart type that
is selected:
• Top rate charts can be displayed as a pie chart, bar chart, or a map. A top rate chart shows the total numbers

of records that match the query.
• Progress charts can be displayed as a line chart, stacked line chart, bar chart, or stacked bar chart. A

progress chart illustrates the numbers of records plotted over time (similar to the timeline, but in more detail).

When a chart is generated, you can right-click for a menu of actions related to the section and possibly the
element that the section corresponds to. The actions available vary by section. Some of the most important
actions are listed as follows:
• Show Records — Opens the Records arrangement filtered to show the entries that comprise the chart

section you right-clicked.
• Add to Current Filter — Allows you to use sections to filter data by adding the section in question to the

Filter tab of the Query pane.
• Statistics item shortcuts — Drill down to create a chart from data that matches the previous chart section.

Related concepts
Log Analysis arrangement of the Logs view on page 248
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Add statistical items to a section of the
Statistics arrangement of the Logs view
You can add statistical items to a section of the Statistics view.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Query pane, click Items.

2) Click Add.

3) Select one or more items from the list, then click Select.

4) Click OK.

5) In the Query pane, click Apply to update the view.

Log Analysis arrangement of the Logs view
The Log Analysis arrangement provides various tools to analyze logs, alerts, and audit entries.

 
Figure 66: Log Analysis arrangement

• To combine logs by Service or Situation, select Aggregate > Aggregate by Service or Aggregate >
Aggregate by Situation.
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• To sort logs by column type, select Aggregate > Sort by Column, then click the heading of the
corresponding column.

• To view the data as charts, click Statistics, then select one of the predefined statistical items. Select Select to
select an item from a complete list of statistical items.

• To view the data as a diagram, click Visualizations, then select one of the visualization options.

Table 31: Visualization options

Option Explanation

Attack Analysis Displays information on Situations of the type Attack or Successful Attack.
Indicates allowed and disallowed connections between users and applications.

Audit Map Displays information on how users manipulate elements.

Application and
Executable Usage

Displays users and the applications that they use or access. Indicates allowed
and disallowed connections between users and applications.

Service Map Displays access to services in the network.

You can zoom in on the data presented in the visualization diagrams with the mouse wheel. Right-clicking
elements in the diagrams opens a pop-up menu with various options to further analyze the elements and add
them to filters. You can also, for example, drag and drop objects from the visualization diagram to the Query
pane to create a filter.

Related concepts
Browsing log data on page 249
Changing how log entries are displayed on page 259

Browsing log data
You can browse, filter, and search for log data in the Logs view.

Related concepts
Benefits of filtering log entries on page 250
Using Log Data Context elements on page 253
Viewing temporary log entries on page 257

Related tasks
View log entry details in the Fields pane on page 250
View log entries from specific components on page 252
Analyze log, alert, and audit entries on page 255
Sort log entries on page 255
Save snapshots of log, alert, and audit entries on page 256
View snapshots of log, alert, and audit entries on page 257
Browse log entries on a timeline on page 257
Check Whois records for IP addresses in log entries on page 258



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Viewing and exporting logged data | 250

View log entry details in the Fields pane
The Fields pane provides several alternative views to the log entry that is selected.

The pane is most useful in the Records arrangement. This arrangement shows a subset of fields and the
information contained in the selected field. Using the Records arrangement, you can quickly browse the logs
table for the exact details you are looking for without scrolling sideways or rearranging the columns.

The Watchlist item allows you to create a customized list of fields for your own use. The Watchlist is specific to
each Management Client installation.

You can look up a selected IP address in the online Whois database.

If an IP address in a log entry has a country flag icon next to it, a Geolocation (for example, a street, city, or
country) has been associated with it. You can view the physical location of these IP addresses in Google Maps.

To change your personal Watchlist of log fields, follow these steps:

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) If the Fields pane is not visible, select  Menu > View > Panels > Fields.

3) In the list at the top of the pane, select Watchlist.

4) Change the selection to the fields you want to use:
• To remove fields, right-click the field, then select Remove (to remove one field) or Clear (to remove all

fields).
• To add more fields, drag and drop cells from the log entry table to the Fields pane. (The value of the field

is irrelevant in this case.)
• To add a field to the Watchlist from other views in the pane, right-click the field, then select Add to

Watchlist.

Related tasks
View IP address locations in the Logs view on page 213
Check Whois records for IP addresses in log entries on page 258

Benefits of filtering log entries
Efficient use of the logs requires that you filter the records displayed in the Logs view.

Filtering is done using the Query pane, which allows you to select the type of log data that it displayed. It also
contains the follow tabs for filtering log data:
• Filter tab allows you to filter entries based on any information in the entries. The Log Data Context specifies

the log data type.
• Senders tab allows you to filter entries according to the component that created the entry. Filtering by sender

speeds up log browsing when there are many log sending components, but you are only interested in a limited
set.

• Storage tab allows you to filter entries according to the servers on which the entries are stored.
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Options on the three tabs allow you to set more filtering criteria.

Related concepts
Using Log Data Context elements on page 253

Related tasks
Use filters for browsing log entries on page 251

Use filters for browsing log entries
You can quickly create local filters by dragging and dropping. You can filter logs by time, use criteria stored in
Filter elements, and save a Query as a permanent filter.

Note:  The time selection refers to the entries’ creation time stamp (not the reception time at
the Log Server, which is also included in many entries). Internally, the SMC and engines always
use universal time (UTC). The times are displayed according to the time zone selected in your
Management Client’s status bar.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) If the Query pane is not visible, select  Menu > View > Panels > Query.
You can drag and drop any field from the log entries to the Filters tab to create a Filter, select existing Filter
elements, or add a filtering criterion. To add a criterion, use the toolbar icon and type in the detail. You can
then further change and use the Filters you have created.

3) Select an option:
• To change a detail manually, double-click the detail.
• Right-click a field in the log entry table or in the Fields pane, then select Add Filter: <field name> to add

the item and its value as a new filter row.
• Right-click an item in the log entry table or in the Fields pane, then select New Filter: <item name> to

define a value for the item and add it as a new filter row.
• To add an empty row, right-click a filter row or empty space, then select Row.
• To search based on a word or a string, right-click the Query pane, select New > Filter: String, then type

your search string.
• To remove a detail, right-click it, then select Remove <detail description>.
• To remove a whole row, right-click something other than a detail on the row you want to remove, then

select Remove.
• Temporarily disable a filter row by right-clicking it, then selecting Disable.
• To save the current filtering criteria as a permanent Filter element, click  Save at the top of the Filter tab

in the Query pane.

4) After you make changes to filters, click Apply.
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Related concepts
Getting started with filtering data on page 291

Related tasks
View log entries from specific components on page 252

View log entries from specific components
You can filter logs based on the components that created the entries.

If the Senders tab is empty, data from all components is displayed in the Logs view. The Senders tab allows you
to maintain the sender filtering independent of changes on the Filter tab. Restricting the included senders makes
log browsing faster when there are many components in the SMC.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Switch to the Senders tab in the Query pane.

3) Click  Select at the top of the Senders tab.

4) Select the elements you want to use as the senders, then click Select.

5) Click Apply.
The log data is refreshed, and only logs from the selected senders are displayed.

Related tasks
View log entries from specific servers and archive folders on page 252

View log entries from specific servers and
archive folders
You can specify which servers and storage folders to include.

By default, the Logs view fetches data from the active log storage folder for all data storage servers, except
those Log Servers that are excluded from log browsing.

You view logs from the active storage folder on specific Log Servers and Management Servers. You can also
view logs from archives stored on Log Servers or archives stored locally on the computer where you are using
the Management Client. In an environment with multiple Management Servers, active alerts are automatically
replicated between the Management Servers. Log Servers store all logs that other components have sent to it as
well as audit data for the Log Server’s own operation.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) In the Query pane, switch to the Storage tab.

3) In the server list, select the servers and storage folders that you want to include.

4) Click Apply.
The log data is refreshed and filtered according to the selected servers and folders.

Related tasks
Edit Log Server configuration parameters on page 432

Using Log Data Context elements
You can use Log Data Contexts to select which type of log data is displayed in the Logs view and in the Reports
view.

You can select a predefined Log Data Context or create a Log Data Context. You can also define the selection of
columns for each Log Data Context.

Tip:  To view log entries for the SMC Appliance, select the SMC Appliance log data context in the
Query  pane.

Related tasks
Create Log Data Context elements on page 253
Select log entry columns for Log Data Context elements on page 254

Create Log Data Context elements
The Log Data Context allows you to select which type of log data to display.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Click the Log Data Context drop-down list in the Query pane or in the Log Type section in the Report
Properties pane, Report Section properties, or Report Item properties. Then select New.

3) Enter a Name for the new Log Data Context.
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4) To add Filters to the Log Data Context, click Select.

Note:  Log Data Tags index Log Data. We recommend that you select a Log Data Tag as a
Filter.

5) Click OK.

Related tasks
Use filters for browsing log entries on page 251
Select log entry columns for Log Data Context elements on page 254

Select log entry columns for Log Data Context
elements
You can edit the selection of columns that are displayed in a Log Data Context.

You can also save user-specific settings, save the updated column selection as the default settings, or reset the
columns to the default settings for each Log Data Context.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Verify that the Log Data Context is selected in the Query pane or Log Type section in the Report Properties
pane, Report Section properties, or Report Item properties.

3) Select  Tools > Columns > Column Selection.

4) Add the columns that you want to be displayed, then click OK.

5) Save the current column selection:
• To save the column selection as your personal settings for the Log Data Context, select  Tools >

Columns > Save Your Local Settings.
• (Custom Log Data Contexts only) To save the column selection as the default settings for all

administrators, select  Tools > Columns > Save Default Settings.
• To discard changes to the column selection and revert to the previously saved default settings, select 

Tools > Columns > Reset to Default Settings.

Related tasks
Select columns in the log entry table on page 260
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Edit Log Data Context elements
You can change the name and edit the filters for a Log Data Context that you have created.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) From the Log Data Context drop-down list, select Select.

3) Right-click the Log Data Context that you want to change, then select Properties.

4) Edit the properties, then click OK.

Related tasks
Use filters for browsing log entries on page 251

Analyze log, alert, and audit entries
The Log Analysis view provides various tools to analyze logs, alerts, and audit entries.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Select Analyze.

Related concepts
Log Analysis arrangement of the Logs view on page 248

Related tasks
Save snapshots of log, alert, and audit entries on page 256
View snapshots of log, alert, and audit entries on page 257

Sort log entries
By default, log entries are sorted according to their creation time. You can alternatively sort log entries according
to any other column heading.

Large numbers of logs can require significant resources to be sorted. The Log Analysis view can shorten your
selected time range if your current Query matches too many records to be efficiently sorted.
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Note:  The Current Events view is always sorted according to entry creation time. Sorting can
only use stored data, so any temporary data visible in the view is permanently lost if you change
the sorting.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Select Analyze.

3) Click the column heading by which you want to sort the logs.
Depending on the column you click, the sort can take a while.

Save snapshots of log, alert, and audit entries
You can save snapshots of log, alert, and audit entries in the Log Analysis view.

The snapshots are saved on the Management Server, and are listed in the Monitoring view.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Select the entries for the snapshot.
You can select a maximum of 100000 entries.

3) Select Analyze.

4) Click  Save.

5) Enter a name for the snapshot, then click OK.

Related concepts
Browsing log data on page 249

Related tasks
View snapshots of log, alert, and audit entries on page 257
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View snapshots of log, alert, and audit entries
The snapshots of log, alert, and audit entries are listed in the Monitoring view.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Other Elements > Monitoring Snapshots > Logs > Management Server.

3) Right-click a snapshot, then select Open.

Browse log entries on a timeline
You can skip around logs from different time periods using the timeline.

In the Records and Details view arrangements, part of the timeline is hidden by default. You can view the full
timeline by dragging its upper edge.

Depending on your selection, the timeline allows you to browse freely (the Automatic option) or stops when the
first or last entry within the specified time range is reached.

When you are browsing within a set time range, you cannot accidentally browse out of the time range set in the
Query pane. Square brackets are shown at each end to show the limits of the range.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Drag the arrowhead to browse.

• The arrow also indicates the selected start position (from the beginning or the end of the time range).
• The chart plots the number of matching entries over time.

Viewing temporary log entries
The Logs view has two operating modes. One mode shows a fixed time frame, the other is a stream of current
log entries, which also includes temporary entries.

In the normal mode, you can browse entries freely from any time period. When you activate the Current Events
mode by clicking  Play, the log entries update automatically to show the stream of log entries as they arrive at
the Log Servers. Typically, you must filter out some entries to keep the pace of the Current Events mode slow
enough that you can keep up with the entries.

The Current Events mode also displays temporary entries that are not stored on the Log Server (Transient log
entries and log entries that are pruned out before permanent storing) so you might see more logs than in the
normal mode. Temporary entries only exist within the current view and are permanently lost when the view is
refreshed or closed. The updates in the Current Events mode are automatically deactivated when you select an
entry or start browsing manually.
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Note:  Under some operating conditions, a small portion of log entries can arrive in mixed order.
Because the Current Events mode attempts to maintain a logical flow of events, out-of-sequence
entries are not shown. You might see a notification message if this happens.

Check Whois records for IP addresses in log
entries
To get more information about the source of traffic that triggered a log entry, you can look up the Whois record of
IP addresses in log entries.

The Whois record contains registration information and related contact details provided at the time of domain
registration. The contents of the Whois record vary depending on the information provided by the owner of the
domain or network segment. For IP addresses used by customers of an ISP, the information shown in the Whois
record is usually the ISP’s information.

The Whois information is queried from the relevant Regional Internet Registry (RIR). These registries include the
ARIN (American Registry for Internet Numbers), the RIPE NCC (Réseaux IP Européens Network Coordination
Centre), and the APNIC (Asia Pacific Network Information Centre). More information about the main RIRs can be
found at the following links:
• ARIN at a glance: https://www.arin.net/about_us/overview.html
• RIPE Database: https://www.ripe.net/manage-ips-and-asns/db
• About APNIC: https://www.apnic.net/about-APNIC/organization

The computer running the Management Client performs the Whois query. To be able to perform Whois queries,
the security policy applied on the computer running the Management Client must meet the following criteria:
• DNS queries must be allowed so that the Management Client can resolve the relevant RIR server IP address.
• Opening TCP43 (Whois) connections must be allowed.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Right-click an IP address, then select Whois.

Tip:  You can also view the physical location of an IP address in Google Maps.

The Whois record for the IP address is displayed.

Related concepts
Monitoring connections using Geolocation elements on page 211
Geolocations and IP addresses in Google Maps on page 213

Related tasks
View IP address locations from the Whois Information dialog box on page 214

https://www.arin.net/about_us/overview.html
https://www.ripe.net/manage-ips-and-asns/db
https://www.apnic.net/about-APNIC/organization
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Query McAfee ePO information in log entries
Query McAfee ePO information about IP addresses to get information about the hardware and software on client
computers.

Before you begin
A McAfee® Agent must be installed on the client computers.

You can query the following information about client computers:
• Hardware details
• Information about software that is running on the client computer, such as McAfee Agent
• The status of Endpoint Protection products

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Right-click an IP address in a log entry, then select ePO Information on.
Information about the client computer is displayed.

Related tasks
Integrate McAfee ePO with Forcepoint NGFW on page 969

Changing how log entries are displayed
There are various ways in which you can customize how entries in the Log view are displayed.

Related concepts
Selecting the time zone for log browsing on page 260
Exporting data from the Logs view on page 261

Related tasks
Increase or decrease text size in log entries on page 260
Select columns in the log entry table on page 260
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Increase or decrease text size in log entries
You can increase, decrease, and reset the text size in the Logs view.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Select  Tools > Text Size, then select an option.

Selecting the time zone for log browsing
The SMC and engines use universal time (UTC) internally. The times in the Logs view are changed to your
selected time zone as they are displayed.

By default, this time zone is the local time zone of the computer you are using. Changing the time zone does not
affect the actual time stamps of the log entries.

If the times in the log entries seem incorrect, verify that the time and time zone are set correctly in your operating
system, on the Management Server, and on all Log Servers.

Select columns in the log entry table
You can select which columns are shown in the Logs view and customize how the columns are shown. You can
add and remove columns and change the order and width of columns.

You can save the column selection and their settings for each Log Data Context. You can also view subsets of
column information in the Fields pane.

You can arrange the columns in the following ways:
• To change the order of the columns — Drag the column header to a different location.
• To expand the column to the width of its contents — Double-click the column header.
• To view a menu of actions for adjusting the column widths — Right-click a column header.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Select  Tools > Columns > Column Selection.

3) Select Add and Remove to include and exclude selected fields.
The Columns to Display list on the right shows your selections.

4) To organize selected fields on the Columns to Display list, select Up or Down.
Fields at the top are shown at the left of the log record table.
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5) Click OK.

Related concepts
Using Log Data Context elements on page 253
Log entry fields on page 1473

Related tasks
View log entry details in the Fields pane on page 250

Tools for customizing the Logs view
To make logs easier to read, you can customize how the data is displayed in the Logs view.

The following options are available in the Tools menu:
• Show Milliseconds — Shows milliseconds in the log creation time.
• Use Color Filters — Enables log entry highlighting. Different colors highlight different types of logs.
• Show Icons — Shows the icons of the elements.

You can resolve IP addresses, protocols, and senders as DNS names or SMC elements. Resolving affects the
view only and does not affect stored log data.

The following options for resolving are available in the Tools menu:
• Resolve Addresses by DNS — Enables IP address resolution using DNS.
• Resolve Addresses by Elements — Enables IP address resolution using element definitions.
• Resolve Senders — Enables the IP addresses of engines and SMC servers to be resolved using element

definitions.

Note:  IP address and port resolving works by comparing the information in the logs to internal
and external information sources. If the information available is incorrect or ambiguous, the result
might not reflect the actual hosts and services involved in the communications. For example, if a
detail matches two elements, the first match is displayed even if the other element was used in the
corresponding rule.

Exporting data from the Logs view
You can export log entries in various ways and formats.

Related tasks
Save elements, log data, reports, and statistics on page 264
Copy log entries in CSV format on page 262
Export log entries on page 262
Export IPS traffic recordings on page 263
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Copy log entries in CSV format
Log, alert, and audit data can be copied directly from the Logs view, then pasted in comma-separated values
(CSV) format.

For a limited number of entries, a simple copy and paste is the quickest export method.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Highlight the rows you want to copy, then copy and paste them to the other application, for example a
spreadsheet application.
The entries are copied with the column titles.

Export log entries
Log, alert, and audit data can be exported directly from the Logs view. Use the export command for large
numbers of entries.

To schedule export tasks that are executed automatically, use the Log Data Tasks tool to export logs instead.

To export the data in a human-readable format, we recommend saving the entries in a .pdf or .html file instead.
You can use this option when the exported data does not need further processing.

If you have defined an export banner, the text of the banner is added at the beginning of each exported HTML file
to indicate that the export contains sensitive or classified data.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) (Optional) To export only some of the entries that match your current Query, select some rows in the
Records arrangement.

3) Right-click one of the entries, then select Export > Export Log Events.

4) Configure the settings, then click OK.

Result

The Task Status pane opens and shows the progress of the export.

Related concepts
Log data management and how it works on page 1273
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Related tasks
Create export banners on page 112
Save elements, log data, reports, and statistics on page 264
Export IPS traffic recordings on page 263
Edit Log Server configuration parameters on page 432

Export IPS traffic recordings
You can set IPS Inspection rules to record network traffic as a logging option in both the Exceptions and the
Rules tree.

These recordings are stored on the Log Servers. Recordings generated by the Excerpt option are shown directly
in the Logs view. Longer recordings, however, are meant to be viewed in an external application and are not
directly viewable.

Tip:  To display the Hex pane, select  Menu > View > Panels > Hex.

To view the recording, you can:
• Retrieve the recording through the log entry.
• Define a Task for exporting IPS recordings.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Highlight the rows that are associated with recordings.

Note:  To browse for more entries that have a recording, change the selection in the Fields
pane to Full Capture. (This selection is available when an entry that has an associated
recording is selected.) The Record ID field is displayed with an identification number for
entries that are associated with a recording.

3) Right-click a selected entry, then select Export > Export IPS Recordings.

4) From the File Export Format drop-down list, select the file format.

5) Select where to export the file.

6) Specify what happens when a previous file with the same name exists in the same folder.

7) Click OK.
The Task Status pane opens and shows the progress of the export.

Related concepts
Inspection Policy elements and how they work on page 847
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Related tasks
Export log entries on page 262
Create an Export Log Task on page 1283

Save data in PDF or HTML format
You can save lists of elements, logged data, reports, statistics, and diagrams in PDF format or as HTML. You can
customize the format of the PDF files.

Save elements, log data, reports, and statistics
You can save lists of elements, logged data, reports, statistics, and diagrams in PDF format or as HTML.

If you have defined an export banner, the text of the banner is added at the beginning of each exported HTML file
to indicate that the export contains sensitive or classified data.

Note:  Export banners are not added to log data that is exported or forwarded.

For exports in PDF, you can modify the style template to indicate that the export contains sensitive or classified
data.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In most elements and views, select  Menu > File > Print.

Related tasks
Create export banners on page 112

Use style templates in PDFs
You can use the background style templates when saving as PDF. You can use the templates in the
Management Client and the Web Portal as permitted by account permissions and Domain boundaries.

The style template is a standard PDF file you create with some or all of the following elements:

• One or more cover pages that are attached to the printed PDF before the content pages.
• A content page background with a header and footer. The height of the header and footer can be adjusted.

The same single page is used as the background for all content pages.
• One or more trailing pages that are attached to the printed PDF after the content pages.
• Your PDF template file can contain pages that you do not want to use. These pages are ignored.
• A one-page PDF file is used as a content page. Your PDF template file must contain at least two pages if you

want to add cover and trailing pages.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Viewing and exporting logged data | 265

You can create the template, for example, by creating a suitable document in a word processor and saving it as
a PDF. Design separate templates for the different page sizes (A3, A4, A5, or Letter) and orientations (portrait or
landscape) you anticipate using.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Create a PDF file that contains a template page for the content and optionally one or more cover and trailing
pages.

2) Open the Print to or Print Elements to dialog box, for example, by right-clicking a log entry and selecting
Print.

3) Under Page Setup, select New from the Style Template list.

4) Enter a unique Name for the new Style Template.

5) Click Browse and select the PDF file you want to use as a template.

6) Select how the pages are used:
• (Optional) The Front Pages from are inserted before the content pages without modifications. Fill in just

the first field for a single-sheet front page.
• The Content Page is used as the background for all pages that have system-generated content.
• The Header Height and Footer Height define how much space (in millimeters) is left between the top

and bottom of the page, and the first or last line of content. This setting prevents the generated content
from overlapping text or graphics on your content page.

• (Optional) The Back Pages from are inserted after the content pages without modifications. Fill in just the
first field for a single-sheet trailing page.

Tip:  You can use the same pages for different roles. For example, you can select the same
page as a content page and a back page to add an empty page at the end of the PDF. The
PDF template file must have at least two pages, even if you only use one of the pages.

7) Click OK.

Manage PDF style templates
You can change PDF style template settings and delete templates you no longer need.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the Print to dialog box, for example, by right-clicking a log entry and selecting Print.

2) Under Page Setup, select Select from the Style Template list.
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3) Right-click a Style Template and select an action from the right-click menu. You can Select the selected
Style Template or select Properties to adjust the template settings. You can also selectCopy to copy the
template name or New Style Template to create a new style template.

Create rules from log entries
You can use log entry details to generate new rules.

To convert a log entry to a rule, the log entry must be created based on a rule (the entry contains a rule tag).
Creating a rule this way allows you to make quick exceptions to the current policy. You can create the following
types of rules:
• A rule that allows a connection from an entry that logs stopped traffic
• A rule that stops a connection from an entry that logs allowed traffic
• A rule that changes the log level or stops the logging of matching connections

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) Highlight the rows you want to include in the operation. You can select multiple log entries to create several
rules in the same operation.

Note:
Do not include incompatible entries in the selection:

• If you select multiple log entries, the Sender of all entries must be the same component.
• All selected entries must have a value in the Rule Tag field. (Entries must be created by

rules in a policy.)

3) Right-click a selected log entry. Under Create Rule, select an option.

Note:  The selection determines how the handling of matching connections is changed.

4) (Optional) Click Select, then change to the policy where the new rule is added. (For example, you can insert
the rule in a subpolicy instead of the main policy.)

5) (Optional) Edit the Comment.
The comment is added to the rule’s Comment cell.

6) Select the Action. All actions create the displayed rules at the beginning of the first insert point in the
selected policy. You can also optionally install the policy with the new rule or open the policy for editing (with
the new rule highlighted for you).

Note:  You cannot edit the rule in this dialog box. To edit the rule, select Add Rules and Edit
the Policy.

7) Click OK.
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Related concepts
The different parts of the policy editing view on page 857

Related tasks
Install policies on page 800
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 CHAPTER 14

Reports
Contents

• Getting started with reports on page 269
• Restricting a report's scope on page 271
• Designing reports on page 272
• Generate and view reports on page 280
• Exporting reports on page 285
• Example of reports on page 290

Reports are summaries of logs and statistics that allow you to combine large amounts of data into an easily viewable
form.

You can process data from logs and engine statistics and generate easy-to-read diagrams, charts, and tables. The
reports you generate are based on a Report Design. A Report Design can be a predefined design, a predefined design
that you modify, or a custom design that you create.

Getting started with reports
The Management Client provides extensive reporting tools for generating reports on information stored in the
SMC. The summaries that make up the reports can be illustrated with different types of charts and tables.

Reports allow you to gather and visualize data in an easy-to-read format that provides an overview of what is
happening in the network and that you can customize. Reports are configured and generated in the Monitoring
view. You can view reports as graphs, charts, tables, and geolocation maps.

You can generate reports based on two types of runtime data:
• Log data — Consists of distinct events (for example, a connection opening or closing). It contains all details

about each event including the exact time when the event occurred. Log data can be filtered granularly, but
running statistics from the raw logs can be slow, especially when using a long data period.

• Counter data — Consists of pre-processed summaries of statistics that are based on sums or averages of
events or traffic units within a certain period. Counter data that is older than an hour is consolidated by the
hour. Counter items produce statistics quickly, even for long periods of data, but they can only be filtered by
sender.

You can create reports on log, alert, and audit entries and statistical monitoring information.

You can generate reports based on predefined Report Designs and Report Sections or on Report Designs that
you have created yourself. You can use your own Style Template for PDF creation to give the reports a unified
corporate look.

You can view the reports in the Management Client and in the Web Portal.

You can export reports in PDF, HTML, or plain text format, so that the files can be printed and shared. You can
also directly email reports as they are generated.

Various ready-made Report Designs are provided. You can customize the existing templates or design new
reports to meet your needs.
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In addition to creating and generating reports based on Report Designs, you can also quickly create reports in the
Logs view, in the Log Analysis arrangement, for example.

To provide auditing information in compliance with regulatory standards, you can generate a purpose-built
System Summary report that summarizes elements, administrators, policies, and other details about system
configuration and events.

Related concepts
Statistics arrangement of the Logs view on page 246

How reports are constructed
Reports are summaries of log data and statistical monitoring information. Reports consist of Report Items, Report
Sections, and Report Designs.

The following illustration shows their relationships.

 
Figure 67: Reporting objects and elements

The Report Design is the main container for a particular type of report. The Report Designs are used as the basis
for Report Tasks that generate the reports that you can view.

The Report Design consists of one or more Report Sections. A Report Section defines parameters for all items
within it. It mainly defines how the information is displayed, such as the type of chart and the number of top items
shown. Each Report Section in the Report Design creates a separate chart and table in the generated report.

Each Report Section contains one or more Report Items. Each Report Item represents a way to summarize the
data. For example, a Report Item might summarize the total number of connections counted between the start
and end times defined for the task that generates the report.
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Each item adds specific information to the chart or table that the Report Section generates. For example, the
items, total traffic volume, sent traffic volume, and received traffic volume, are shown as separate lines on the
curve chart that the Report Section generates.

Report configuration overview
Reports consist of Report Designs that include relevant sections and items.

Follow these general steps to create and generate reports:

1) Customize an existing Report Design or create a new Report Design.

2) Customize or add Report Sections or Items.

3) Generate the report.

Related concepts
Designing reports on page 272
Defining what Report Sections to use in a Report on page 275

Related tasks
Generate and view reports on page 280

Restricting a report's scope
There are various tools you can use to focus the scope of your Reports.

Data filters for reports
Filters are the main tool for increasing the granularity of reports.

The Report Items define some general criteria for selecting data. For example, you can produce a report of
connections by source IP address. Defining general criteria is a good way to get an overview, but in many cases,
you want more specific information.

For example, a general item such as the total number of logged connections can be made much more specific.
To make this item more specific, apply a filter that matches a single pair of source and destination IP addresses.
The filter only counts connections between these two hosts.

Only log-based raw data is suitable for log filters. Counter Statistics Data items use pre-counted statistical data
instead of logs, so most log data filters cannot be used with Counter Statistics Report Items. You can only filter
Counter Statistics Report Items by sender (the component that generated the statistics).

You can define a filter at one or more of the following levels:

1) Report Task — Applies to the single report produced by a particular task or to all reports produced by a task
that is scheduled to run regularly.
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2) Report Design — Applies to all reports produced using the Report Design.

3) Report Section — Applies to all items included in the section.

4) Report Item — Applies to that specific item only.

If filters are applied at several of these levels, all filters are applied and the log entries are filtered top-down in the
order listed. Each filtering stage completely excludes non-matching log entries for the stage in which the filter is
applied and all further stages. For example, select the filter, TCP destination port 80, for a Report Section. Then,
all items in that section only process information in log entries that mention TCP destination port 80.

Reports within administrative Domains
If there are administrative Domains configured, the reports are Domain-specific.

While logged on to a Domain, you can only create reports concerning the components that belong to that
Domain. If you are allowed to log on to the Shared Domain and have unrestricted permissions, you can create
Reports concerning components in any Domain.

The Reports created in the Shared Domain are visible to administrators in all other Domains. If the reports
contain sensitive data that must not be displayed to all administrators in all Domains, create the reports in a
specific Domain.

Related concepts
Getting started with Domain elements on page 399

Reporting on the configuration database and
audit logs
While other reports are based on logs and statistics, the System Report is based on information collected from
the Management Server’s configuration database and audit logs.

The report includes details like administrator and Web Portal user activity, account settings, configuration of and
changes to the Firewall and IPS engines, and configuration of the Management Server.

The report can help you provide the required data for auditing in compliance with regulations, such as the
Payment Card Industry (PCI) Data Security Standard.

The report is generated, exported, and edited in the same way as other types of reports. The only difference is
the content of the report.

Designing reports
Report Designs determine how to process the data and how the results are displayed.

They can also determine which template is used for PDF exports and which charts appear on them. Ready-made
Report Designs serve as a useful guide for constructing your own Report Designs. You can also create custom
Report Designs.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Reports | 273

 
Figure 68: Report Design

1 Report overview

2 Heading Section

3 Report Sections

4 Properties of the selected element

There are several ways to create Report Designs. Although you can start by defining a new empty Report
Design, it is often easier to use one of the predefined Report Designs as a template. The comments in the
properties of predefined Report Designs and Sections explain their general purpose.

The Report Design properties specify, for example, the time period for the report. You can define a period
comparison for the Report Design. This feature allows you to compare values between two identical time periods.
For example, if the time period is one week, you can compare the results for this week to the results from the
previous week.

Related tasks
Modify Report Design elements on page 274
Create Report Design elements on page 274
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Modify Report Design elements
If you have an existing Report Design, you can add or remove sections or items.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Reports > Design.

3) Right-click the Report Design that you want to edit, then select Edit Report Design.

4) After making your changes, click  Save or select  Tools > Save As.

Related tasks
Create Report Design elements on page 274

Create Report Design elements
First you create a Report Design, then you add items to it.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Reports > Design.

3) Right-click Design, then select New Report Design.

4) Select a template for the new Report Design, then click OK.

5) Enter a name for the new Report Design.

6) (Optional) Select a Filter.

Note:  When you generate a report, all filters defined in the report task properties, in the
Report Design, Report Sections, and individual Report Items are used to filter the data. If the
filters do not intersect, empty Report Sections might be generated in the report.

7) Adjust the other properties as needed.

8) Click  Save or select  Tools > Save As.
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Related concepts
Using Log Data Context elements on page 253
Defining what Report Sections to use in a Report on page 275
Creating and editing local filters on page 295

Defining what Report Sections to use in a
Report
A Report Design consists of one or more Report Sections, which define parameters for all Report Items. You can
modify and create Report Sections in a Report Design.

Each Report Section in the Report Design creates a separate chart or table (or both) in the generated report.

Tip:  To browse and edit predefined Report Sections, select  Configuration, then browse to
Monitoring > Reports > Sections.

Tip:  You can create customized report sections from the Statistics arrangement of the Logs view.

Customize Report Sections and Items
You can add predefined Report Sections to your Report Design and then modify their contents and properties
according to your needs.

Tip:  Use Heading Sections that contain a description to group the different Report Sections.

A Report Section represents a collection of Report Items in reports. Each Report Section adds a separate
summary (chart or table) to the report. Depending on the summary type, the summary can be presented in one or
more of the following ways:
• Bar chart
• Stacked bar chart
• Curve chart
• Stacked curve chart
• Pie chart
• Geolocation map
• Table

The available types of Report Section summaries are explained in the following table.
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Table 32: Summary types

Summary type Description Visualization

Progress Illustrates how events are spread out within the reporting
period. This summary type is useful for finding trends in the
data.
Example: A line chart showing the volume of traffic during a
24-hour period.

A bar chart, stacked bar
chart, curve chart, or stacked
curve chart.

Top Rate Illustrates events with the highest occurrences. This
summary type is useful for highlighting the most common
values in the data.
Example: A bar chart showing the number of connections
to the five IP addresses that have received the most
connections yesterday.

The first Report Item in a top rate summary section
must have a sorting criteria “by X” (for example, allowed
connections by source IP address). The sorting criteria is
applied to all items in the section for ranking the top rates.

A bar chart, a pie chart, or
a geolocation map. A bar
chart is more suitable for
displaying many top rates,
whereas a pie chart is better
at illustrating the relative
proportions. A geolocation
map shows the distribution
of events according to
physical location.

Summary Table A simple table for displaying the exact event counts.
This summary type is useful for providing data for further
processing, for example, in a spreadsheet application.

A table.

System
Information

Summarizes current configuration information in the
Management Server’s internal database.
Example: A listing of all engines with the software versions,
names of the currently installed policies, and the latest
policy upload times.

A table.

A Report Item represents a value that you want counted in log data or statistical monitoring information. (Allowed
traffic in bits or the number of allowed connections are examples of values that can be counted.)

The data for the Report Items is generated in the following ways:
• A simple count of how many log entries have a certain value within the reporting period. For example, the

Allowed Connections Report Item counts the log entries that have the value Allowed in the Action field. A
simple count is how the results for most Report Items are summed.

• A count of how many log entries have a certain value within the reporting period grouped “by X” criteria.
For example, Allowed connections by source IP address presents a chart for an adjustable number of IP
addresses that have the most allowed connections within the reporting period.

• Sums or averages of traffic volumes in log entries for Report Items of the “traffic” type (for example, Allowed
traffic). Access rules that have the accounting option enabled in the Firewall Policy generate the data for
“traffic” items. Interface statistics often provide more accurate total volumes, since accounting (and logging in
general) is not active for all rules.

• Values stored in the Management Server’s database for System Information items. The statistical data is
pre-summarized. It is not as detailed as the monitoring statistics displayed in the Home view and cannot be
filtered in detail like the log data.

Related concepts
Data filters for reports on page 271



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Reports | 277

Related tasks
Modify Report Sections on page 277
Create Report Sections on page 278

Modify Report Sections
You can add predefined Report Sections to your Report Design, then edit their contents and properties according
to your needs.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Reports > Design.

3) Right-click the Report Design that you want to edit, then select Edit Report Design.

4) Select the section in the Report Design.
The section properties are displayed in the Section Properties pane.

5) Edit the section properties.

6) (Optional) Group Sections under a Heading Section.

a) Right-click a Section that you want to add to a group, then select Move to New Heading Section.

b) In the Section Properties pane, enter a name and optionally a description for the group of Sections.

7) (Optional) To change the order of the Sections or to add more Sections under a Heading Section, drag them
to the order you want.

8) Click  Save or select  Tools > Save As.

Related concepts
Using Log Data Context elements on page 253
Creating filters on page 292

Related tasks
Create Report Sections on page 278
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Create Report Sections
You can create new Report Sections in a Report Design.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Reports > Design.

3) Right-click the Report Design that you want to edit, then select Edit Report Design.

4) Right-click in the Report Design, then select Add New Section.

5) Select a section from the list.

Note:  If you cannot find an appropriate section in the list, select Select, then select a section
in the Select Section dialog box. If you want to add a section based on a statistical item,
select Create from Item, then select an item from the Select Item dialog box.

The new section is added to the Report Design and the background of the new section is highlighted.

6) Modify the section properties.

7) Click  Save or select  Tools > Save As.

Related tasks
Modify Report Sections on page 277

Create and modify Report Items
You can add and edit statistical items in Report Sections.

Statistical items count the following types of data:
• Log entries (referred to as records in the item names)
• Summaries of some log fields included in those entries (such as traffic volumes in log data that contains

accounting information)
• Gathered statistical data (counter items)
• System information to summarize current configuration information in the Management Server’s internal

database
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Add Report Items
You can add Items to a Report Section.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Reports > Design.

3) Right-click the Report Design that you want to edit, then select Edit Report Design.

4) Select the Report Section to which you want to add Items.

5) In the Section Properties pane, click Items.

6) Select Add > Add Item, then select the Items to add.

Tip:  You can add one nested Item under the first Item. Select Add > Add Secondary Item,
then select the Item to add. The Item is nested in the generated Report.

7) Click OK.

Related tasks
Modify Report Items on page 279

Modify Report Items
You can modify Items that are included in a Report Section.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Reports > Design.

3) Right-click the Report Design that you want to edit, then select Edit Report Design.

4) Select the Report Section in which you want to modify the Item selection.

5) In the Report Properties pane, click Items.

6) Right-click the item that you want to modify, then select Properties.

7) Modify the Item properties.
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8) To save the changes to the Item properties, click OK.

9) (Optional) To change the order of the added Items, drag and drop them.

10) Click OK.

11) Click  Save or select  Tools > Save As.

Related concepts
Using Log Data Context elements on page 253

Generate and view reports
Reports are generated from the Report Designs that are under the Reports tree of the Monitoring Configuration
view.

When you generate a report, the Management Server sends the task to all Log Servers that are not excluded
from processing. The task’s progress and possible errors are shown next to the task under the selected Report
Design.

Each Log Server processes the task and returns the summary data for each Report Section. The Management
Server merges the data from the Log Servers into one report. If one of the selected Log Servers cannot be
contacted for any reason, the execution of the task is delayed until the Log Server becomes available.

Related concepts
Designing reports on page 272

Related tasks
Generate reports on page 280
View reports on page 284

Generate reports
After you have created your Report Design, you can set the time period that you want details about, then
generate your report.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Reports > Design.

3) Right-click a Report Design, then select Start.
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4) Select the Period Beginning and Period End for the report and enter the date as indicated. Then, in the
time of the workstation running the Management Client, enter the time using the 24-hour clock.

Note:  The default 1 Day Period option defines the previous day as the reporting period,
beginning at 00:00:00 that day and ending exactly 24 hours later.

5) (Optional) In the Start Earliest field, enter the delay in minutes after the end date and time.

Note:  Report generation begins after the specified delay has passed. The purpose of the
delay is to make sure that the system has all relevant data available. If the Period End date
and time are in the future, the report is generated on the specified date and time after the
Start Earliest delay has passed.

6) (Optional) To restrict the data included in the report, select a Filter.

Note:  When you generate a report, all filters defined in the report task properties, in the
Report Design, Report Sections, and individual Report Items are used to filter the data. If the
filters do not intersect, empty Report Sections might be generated in the report.

7) (Shared Domain only, and if more than one Domain exists) To make a report that includes information about
all Domains, select Report over All Domains.

Related tasks
Define report tasks on page 281
Cancel ongoing report tasks on page 284
View reports on page 284

Define report tasks
You can set the task to be repeated daily, and also set the output format for the task.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Reports > Design.

3) Right-click a Report Design, then select Start.

4) Click the Task tab.

5) Select how often you want to Repeat the report generation.
The time period selected in the Report Design determines the available choices.

6) (Optional) Select a Category.
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7) Select one or more outputs to be produced directly.

Note:  To view the report before deciding if you want to process it further, leave only Store
Report selected.

• Text Export/PDF Export/HTML Export — The report is stored as a text, PDF, or HTML file on the
Management Server in the <installation directory>/data/reports/files/<Report Design name>/ directory.
The report is named according to the time range chosen.

Note:  If you installed the Management Server in the C:\Program Files\Forcepoint
\SMC directory in Windows, some program data might be stored in the C:\ProgramData
\Forcepoint\SMC directory.

• Post Process — The report is generated according to options chosen and then a script is started. By
default, the script is SgPostProcessReport.bat, which is in the <installation directory>/data/reports/bin
directory on the Management Server.

8) (Optional) Enter the E-mail Address to which the completed report is sent directly as email. Separate
addresses with commas.

Note:  The SMTP server for sending reports must be defined in the Management Server’s
properties.

9) (PDF exports only) Select a Style Template. If you use the default Style Template, you can select whether
to create a portrait or landscape PDF. If you use a customized template, the orientation is defined in the
template.

Related concepts
Tab-delimited text report files on page 288

Related tasks
Use style templates in PDFs on page 264
Select data sources for reports on page 283
View reports on page 284
Modify Management Server elements on page 449

Post-processing report files
You can customize reports by post processing them as part of the Report Task.

Post-processing runs the <installation directory>/data/reports/bin/sgPostProcessReport script on the
Management Server and passes command arguments to the script. The following table explains the possible
command arguments.

Table 33: Command arguments for post-processing reports

Command argument Explanation

-creation_time YYYY/MM/DD hh:mm:ss The report creation time.

-filter_categ name The category assigned to the task filter.
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Command argument Explanation

-filter_name filter The name of the filter assigned to the task.

-html_file filename The file name of a report exported as HTML.

-pdf_file filename The file name of a report exported as PDF.

-period_begin YYYY/MM/DD hh:mm:ss The begin time of the reporting period.

-period_end YYYY/MM/DD hh:mm:ss The end time of the reporting period.

-report_categ name The category assigned to the report (and to the report
file).

-report_file_title title The title of the report file.

-report_name name The name of the report.

-text_file filename The file name of a report exported as plain text.

The script parses the values from the command arguments to use the values for post-processing. Only
parameters that have a defined value are forwarded to the post-processing script.

When a parameter has multiple values, each of the values is forwarded as a separate command argument.

Example of using multiple values
When the report has the two categories “Example Corporation” and “weekly report”, these values are forwarded
to the script as -report_categ Example Corporation and -report_categ weekly report.

Select data sources for reports
By default, the Management and Log Servers are selected as data sources, but you can select the source of your
choosing.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Reports > Design.

3) Right-click a Report Design, then select Start.

4) Click the Storage tab.

5) Select the data storage type:
• Default — The Management Servers and Log Servers are used as the data sources.
• Primary archive — Archived data is used as the data source.
• Custom — A combination of archived data and data provided by the Management and Log Servers is

used as the data source.

6) Select the Management Servers and Log Servers from which you want to include data in the report.
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7) To start generating the report, click OK.

Related tasks
View reports on page 284

Cancel ongoing report tasks
If the report you are generating includes large amounts of data, generating the report can take a long time.

This situation might result when, for example, the time frame is wide and the data filter in use does not restrict the
data sources.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Reports > History.

3) Right-click the task you want to cancel, then select Abort or Delete.

• Aborted tasks can be edited and restarted by double-clicking them.
• Deleted tasks are permanently removed.

View reports
After you generate a report, it is available for viewing in the Reports view.

A report might be automatically deleted according to the expiration setting defined in the Report Design. If you
want to keep a generated report permanently, we recommend exporting it.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Reports > History.
The created reports are automatically grouped according to their creation date.

3) To group reports by date or design, select  Tools > Organize By > By Date or  Tools > Organize By >
By Design.
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4) Double-click the report you want to view.

Tip:  If you want to see the data of a report section in table format, right-click the section, then
select Show Table. The table is added to the section.

The contents of the report are shown.

Related concepts
Exporting reports on page 285

Change the properties of generated reports
You can change the Category and expiration time of a report.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Reports > History.

3) Right-click the title of the report you want to change, then select Properties.

4) (Optional) Select a Category.

5) (Optional) To change the time when the report is automatically deleted, change the value in the Expiration
field. To delete the report yourself, select Never.

6) Click OK.

Related concepts
How Categories help you view only certain elements on page 169
Exporting reports on page 285

Related tasks
Generate and view reports on page 280

Exporting reports
You can export PDF, HTML, and text reports manually for previously generated reports or automatically when
generating the report.

Automatically exported files can be automatically sent out as email or saved in the <installation directory>/data/
reports/files/report_design/ directory on the Management Server.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Reports | 286

The report files are named according to the report’s time range as follows:
startdate_starttime_enddate_endtime_N, where N is a sequential number (starting from 1) that identifies files
from the same time range.

Example report file name
20150423_100000_20150424_180000_1.txt is the first text report generated for the time range from 23 April
2015 10:00:00 to 24 April 2015 18:00:00.

Related tasks
Generate and view reports on page 280

Export reports as PDF files
When you export a report file as a PDF file, a default template is automatically used for the report.

You can also import a Style Template for the report you are about to export.

Note:  After exporting, check the result. If the report text or charts are placed on top of your
template background, you might need to adjust the headers and footers in your template.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Expand the Reports branch, then select History.

3) Double-click the report you want to export.
The report opens.

4) Select what part of the report to export:
• To export the whole report — Select  Menu > File > Print.
• To export a section of the report — Right-click the section, then select Print section.

5) Select PDF as the Format.

6) Select a printing option:
• To open the PDF in your default PDF reader — Select Print to PDF reader.
• To save the PDF — Select Print to File, then browse to the location where you want to save the file.

7) (Optional) Select the Style Template.
If you use the default Style Template, you can select whether to create a portrait or landscape PDF. If you
use a customized template, the orientation is defined in the template.

8) Click OK.
The PDF is generated.
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Related tasks
Use style templates in PDFs on page 264
Generate and view reports on page 280

Export reports as HTML files
When you export a report as an HTML file, a default template is automatically used as the background for the
report.

If you have defined an export banner, the text of the banner is added at the beginning of the HTML file to indicate
that the export contains sensitive or classified data.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Expand the Reports branch, then select History.

3) Double-click the report you want to export.
The report opens.

4) Select what part of the report to export:
• To export the whole report — Select  Menu > File > Print.
• To export a section of the report — Right-click the section, then select Print section.

5) Select HTML as the Format.

6) Click Browse, then select where you want to save the HTML files.

7) Click OK.
The HTML files are saved in the defined location. The HTML report opens in your default web browser.

Related tasks
Generate and view reports on page 280
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Export reports as tab-delimited text files
You can export a plain text file, without any formatting.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Expand the Reports branch, then select History.

3) Double-click the report you want to export.

4) Select what part of the report to export:
• To export the whole report — Select  Menu > File > Print.
• To export a section of the report — Right-click the section, then select Print section.

5) Select TXT as the Format.

6) Click Browse, then select where you want to save the file.

7) Click OK.

Tab-delimited text report files
Tab-delimited text files can be used for further processing.

The tab-delimited text files contain the statistics in tabulated tables. The tab characters and the operating
environment-specific line endings delimit the text.

Table 34: Structure of a tab-delimited text report file

Line no. File content Description

1 <report title>, <start time> - <end time> Start and end time define the reporting period
in format YYYY/MM/DD hh:mm:ss.

2 <empty line>

3 <section content for each section> Each section of the report follows the format
described in the following table.

Line no. Section content Description

1 <section name>[; <section comment>] Optional section comment with a leading
semicolon (;) might follow the section name.

2 <empty line>

3 <section data> | “No data” Section data follows the format described in
the following table. If the section contains no
data, the text “No data” is displayed instead.
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Line no. Section content Description

Section's last
line

<empty line>

Line no. Section data content Description

1 <table heading> Tab delimited column labels. Some columns
might not have a label, and labels might be
padded with trailing spaces.

2 <empty line>

3 <table rows> Tab delimited values. Value in any given
column can be empty. The column values are
not padded.

Section data's
last line

<empty line>

Email reports
Reports can be emailed directly as they are generated.

Before you begin
Define the SMTP server settings in the Management Server’s properties.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Report Design.

2) Click the Task tab, then enter the E-mail Address.
To enter multiple email addresses, separate them with commas.

Related tasks
Modify Management Server elements on page 449
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Example of reports
The example illustrates a common use for reports and general steps on how the scenario in question is
configured.

Example: Identifying a disruptive internal user
An example of administrators looking for a specific trend in network activity to identify a specific user.

Administrators at Company A notice that downloads have gone up dramatically over the past week. They suspect
that there might be an individual user that is excessively downloading files from the Internet. To confirm their
suspicions, the Administrators decide to run a report that shows them who has used the most bandwidth in the
network.

The administrators take the following steps:

1) Activate Log Accounting Information for each rule that allows connections from internal hosts to the Internet
and install the policy. (Incoming connections to internal workstations are not allowed.)

2) Wait for a full workday for the logs with accounting information to be generated.

3) Create a filter that matches the IP address space of regular workstations as the source address and any
external IP addresses as the destination address.

4) Create a Report Design based on the Firewall Daily summary and attach the filter created in the previous
step to the Report Design.

5) Increase the “Top Limit” value for the section “Traffic by src. IP” to see more results.

6) Generate a report for the previous day to check the traffic volumes for the top hosts.
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 CHAPTER 15

Filtering data
Contents

• Getting started with filtering data on page 291
• Creating filters on page 292
• Organizing Filter elements on page 302
• Examples of filters on page 303

Filters allow you to select data based on values that it contains. Most frequently, you use filters when viewing logs, but
filters can also be used for other tasks, such as exporting logs and selecting data for reports.

Getting started with filtering data
Network traffic can generate a large amount of log data. You can use filters to select data for many operations
such as viewing log entries in the Logs view or generating statistical reports.

Related concepts
Getting started with the Logs view on page 241
Creating filters on page 292
Organizing Filter elements on page 302

Related tasks
Use filters for browsing log entries on page 251

What filters do
Filters allow you to efficiently manage the large amounts of data that the system generates. Filters select entries
by comparing values defined in the Filter to each data entry included in the filtering operation. The operation can
use the filter to either include or exclude matching data.

You can use filters for selecting data in the following tasks:

• Browsing logs, alerts, and audit data.
• Browsing in all session monitoring views.
• Creating reports.
• Selecting which logs administrators who have restricted accounts or Web Portal User accounts are allowed to

view.
• Defining how logs are highlighted in the Logs view.
• Forwarding logs to external third-party devices.
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• Forwarding audit data to external third-party devices.
• Browsing which IP addresses, ports, and protocols are on the engines’ blacklists.
• Pruning log data.
• Exporting and deleting log data and alerts.
• Creating Correlation Situations to analyze engine and Log Server events.

Filter types
There are two types of filters in the Management Client: local and permanent filters.

• Local filters are specific to a view or an element. You cannot use a local filter anywhere else in the
Management Client.

• Permanent Filter elements, which you can use anywhere in the Management Client. There are predefined
permanent Filters. You can also create new permanent Filters.

How filters are created
You can create filters in four basic ways.

• Based on criteria you define — You can create a local filter or permanent Filter element, and define filtering
criteria in the Filter properties.

• Based on other Filters — You can create a copy of a Filter element or copy-and-paste parts of filters to other
filters.

• Based on existing log entries — You can create local filters in Monitoring views where you can view logs, then
save them as permanent Filter elements.

• Based on element configuration — Some local filters are created automatically by your selections in specific
views or elements.

You cannot edit the predefined Filters, but you can create editable copies. Filter elements can be imported and
updated when you activate new dynamic update packages, so the selection and names of predefined filters can
change.

The default Filter elements are in the System Elements Category and have the Tags System or Correlation (for
filters used in Correlation Situations).

Creating filters
You can create local filters that are specific to an element or view, then save them as permanent Filter elements
to use globally.

Related concepts
Creating and editing local filters on page 295

Related tasks
Create or edit Filter elements on page 298
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Basics of constructing filters
You construct filters using fields, values of the fields, and operations.

Filters are constructed from the following parts:

• The fields that you want to match in the data (for example, there are separate fields for source IP address and
port in logs). You can filter data according to any field.

• The values in those fields that you want to match (for example, the exact port number or IP address you are
interested in).

• operations define how the fields and values are matched to data entries (especially if there are several fields
included as the filtering criteria).

A filter can have one or several fields. The more fields you have in a filter, the more specific the selection of log
data becomes. For example, you can use the IP source field in the filter and get a selection of log data that
matches the source IP address you specify. To limit the selection of log data even further, you could add a field
for the destination port used.

Different types of data entries contain different types of information, so the fields you add also restrict the
general type of data that your filter matches. It is possible to create a filter that can never match any data if the
combination of fields is not found in any single entry. However, everything depends on the general structure of
the filter. It is possible to create filters that match related data in different types of entries using different fields as
criteria. Depending on the field, you can define one to several values that you want to look for in the data. There
are some operations (for example, Defined) for which a field value is not needed.

Operations define how field values in log data are compared to the field values defined in the filter. You can have
as many operations in a filter as necessary, and you can also nest operations inside other operations. When you
add two fields, you must always combine the fields with an operation. Each field in a filter is attached to one of
these operations:

• Calculations (BITWISE and SUM OF)
• Comparisons (for example, EQUAL TO, GREATER THAN, SMALLER THAN)
• Logicals (AND, NOT, OR)

Filter example
 
Figure 69: Matching events with a filter

The illustration shows a Filter with several fields and operations. This Filter matches if the destination IP address
is in the 192.168.11.0/24 network AND the destination port is 80 or greater OR if the destination IP address is in
the 192.168.12.0/24 network AND the destination port is 80 or greater.

A data entry of a connection to host 192.168.11.10 on port 80 matches the first AND operation in the example
filter. The same connection does not match the second AND operation in the Filter. Since the two AND
operations are combined with OR, the Filter as a whole is considered a match and the data is selected for the
task that is being carried out.
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Filters that match a single value
A filter that matches a single source IP address:

Src Addr EQUAL TO 192.168.1.101

Where Src Addr is a field, EQUAL TO is the operation, and the IP address is a value.

Filters that match several values
A filter that matches any non-empty value for destination port:

Dst Port IS DEFINED

A filter that matches all destination ports between 1024 and 49152:

Dst Port BETWEEN 1024 AND 49152

A filter that matches any of three alternative destination ports:

Dst Port IN 51111, 52222, 53333

Complex filters that use logical operations
You can add the logical operations NOT, AND, and OR. The NOT operation negates the criteria you set.

A filter that matches all destination ports except ports between 1024 and 49152:

NOT

Dst Port BETWEEN 1024 AND 49152

When you add more than one field to a filter, you must define how the fields are used in relation to each other.
You must use either AND (all field values must be present in the same entry) or OR (a data entry matches the
filter if any one field value is found).

A filter that matches if the destination port is lower than 1024 and the source is a particular IP address:

AND

Src Addr EQUAL TO 192.168.1.101

Dst Port SMALLER THAN 1024

A filter that matches either of two destination ports:

OR

Dst Port EQUAL TO 80

Dst Port EQUAL TO 8080

You can apply the AND and OR operations to other AND and OR statements to create more complex statements.
You can also negate whole AND and OR sections with NOT

Related concepts
Creating and editing local filters on page 295

Related tasks
Create or edit Filter elements on page 298
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Creating and editing local filters
Local filters are valid only in the view or in the element in which they are created.

Local filters that you create in the following Monitoring views are temporary. They are only available until you
close the view:

• Logs view.
• Connections view.
• Blacklist view.
• Users view.
• VPN SAs view.
• Routing Monitoring view.
• SSL VPNs Monitoring view.

Local filters created or edited for the following elements are saved with the element:

• Report Designs.
• Administrator elements.
• Log Server elements.
• Management Server elements.
• Correlation Situations.

You can save local filters as permanent Filter elements in all views. These Filter elements can then be used
anywhere in the Management Client.

Create local filters
You can create local filters in various views in the Management Client.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open a view or element for editing.
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2) Depending on the view or dialog box, create the local filter in one of the following ways:

View/Dialog box Configuration steps

Monitoring views
(Logs, Connections,
Blacklist, VPN SAs,
Users, Routing, or
SSL VPNs)

On the Filter tab in the Query pane, click New, then select New > Filter to create
a filter from a list of available fields, or select New > Filter:<field name> to create
a filter based on a preselected field.

Tip:  You can also drag and drop log data rows onto the Filter tab

Report
Design

1) Select the name of the Report Design.

2) In the Report Properties pane, click the Select Element button next to the
Filter field.

Report
Section

1) Select the Report Section.

2) In the Section Properties pane, click the Select Element button next to the
Filter field.

Reports
view

Report
Item

Double-click the Report Item.

Administrator
Properties dialog box

1) Switch to the Permissions tab.

2) Click Select next to Filter. The Local Filter Properties dialog box opens.

Log Server
Properties or
Management Server
Properties dialog box

1) For the Log Server, switch to the Log Forwarding tab, then click Add to add
a Log Forwarding rule.

2) For the Management Server, switch to the Audit Forwarding tab, then click
Add to add an Audit Forwarding rule.

3) Double-click the Filter cell. The Local Filter Properties dialog box opens.

Correlation Situation
Properties dialog box

1) Switch to the Context tab.

2) Click Select next to the Context field, then select Compress, Group, Match,
or Sequence.

3) For Compress or Match, click Select next to the Compress filter field. The
Local Filter Properties dialog box opens.

4) For Group or Sequence, double-click the Event Match cell. The Local Filter
Properties dialog box opens.

3) (If not in a Monitoring view) Select Add > New > Filter to create a filter from a list of available fields or Add >
New > Filter:<field name> to create a filter based on a preselected field.
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4) Edit the filter in the Filter Properties dialog box.
• If you are creating a filter from a list of available fields, enter an optional name in the Name field. Select

the setting for Undefined Value Policy, then define the filtering criteria.
• If you are creating a filter based on a preselected field, edit the filter properties. The available options

depend on the field type.

5) Click Apply.
The filter is added to the Local Filter Properties dialog box.

In a Monitoring view, the filter is added to the Filter tab in the Query pane.

6) (Optional) Edit the local filter:
• To negate a filter row, click the corresponding checkbox. This option filters out entries that match the filter.
• If a row contains more than one item, click the operator cell to toggle between the and and or operators.

 

1 Negate a filter.

2 Toggle between operators.

7) (Optional) To save a local filter as a permanent Filter element, click Save. In a Monitoring view, click  Save.
You can use Filter elements in any view.

8) Click OK. In a Monitoring view, click Apply.

Related tasks
Save local filters as permanent Filter elements on page 297

Save local filters as permanent Filter elements
Local filters are specific to the view or element for which they have been created. Saving local filters as
permanent Filter elements allows you to apply these filters anywhere in the Management Client.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Create a local filter.

2) In the Local Filter Properties dialog box, click Save. In a Monitoring view, click  Save.
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3) Enter a name for the filter in the Name field, then click OK.

Related tasks
Create local filters on page 295

Create or edit Filter elements
All the permanent Filter elements are stored and can be edited from one view.

Tip:  An easy way to create a permanent Filter element is to create a local filter, then save it as a
Filter element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Expand the Other Elements branch.

3) To create a new filter:

a) Right-click Filters.

b) Select New > Filter.

4) To edit an existing filter:

a) Browse to Filters > All Filters.

b) Right-click the filter, then select Properties.

5) Edit the filter properties, then define the filtering criteria.

6) Click OK.

Related concepts
Benefits of filtering log entries on page 250

Related tasks
Save local filters as permanent Filter elements on page 297
Add or edit criteria in Filter elements on page 299
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Add or edit criteria in Filter elements
You can add new criteria or edit the criteria of Filters that you have created.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Other Elements > Filters > All Filters.

3) Right-click a filter you have created, then select Properties.

Tip:  To edit a filter based on an existing system filter, right-click the filter, then select
New > Duplicate.

4) Select the setting for Undefined Value Policy.
This setting defines how data entries are matched when a field is included in the filter, but is not present
in the entry. For example, a filter defines a range of destination ports, but the operation encounters a log
entry from a protocol that does not use ports, such as ICMP.

5) If there is no logical operation (AND or OR) at the correct level, add one using the shortcut buttons above
the editing pane.
You can nest logical operations to create more complex filters. For example, you can create two AND
sections under an OR condition to match either of the two sets of criteria.

6) To change a logical operation, right-click the operation, select Change To, then select the new operation.

7) To add a field:

a) Right-click the logical operation to which you want to add a field, then select New > Select.

b) Click Fields, then browse to the field group that contains the field you want to add, or browse to All
Fields for a list of all available fields.

c) Select the field, then click Select.

8) To edit the field:

a) Right-click the field that was added, then select Edit.

b) Select the Comparison.
The available comparison selection depends on the selected field and whether the field already
contains one or more values.

The most common comparisons are:
• Any Value — Allows you to match any non-empty value in the field.
• Between — Allows you to match a range (for example, a range of TCP/UDP ports).
• Contains — Allows you to match any of several alternative values (for example, both an IPv4

address and an IPv6 address).
• In — Allows you to match a single value (for example, an IP address or Network element).
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c) Depending on the comparison and type of field, define the values that you want the filter to match in
one of the following ways:

• Enter one or more values. For the In or Contains comparison, click Add to add the entered value
to the value list.

• Double-click the empty space in the value list, then select an element.
• To edit a value that has been added to the value list, double-click the value.
• To remove a value, right-click the value, then select Remove.

d) Click Apply.

9) To remove criteria, right-click the criteria, then select Remove Row or Remove.
If you select Remove Row, all criteria nested under the row is moved up one level.

If you select Remove, all criteria nested under the row is also removed.

10) Click OK.

Related concepts
Log entry fields on page 1473

How missing values are handled in Filter
elements
You can adjust what happens when the Filter element is matched to data that does not contain any value for a
field that the filter defines.

By default, log data matches the filter only if all fields in the filter are also found in log data.

Since there are different types of data entries, some entries might not contain any value for some field that a filter
contains. For example, an Alert entry warning you that the monitoring connection from a Firewall engine has been
lost does not contain any source or destination IP address information. The reason for this is that the entry is not
related to traffic processing. If you apply a filter that matches an IP address in the Logs view, the Alert is filtered
out of the view. Missing values that cannot be verified as matching or non-matching are called undefined values
in the configuration.

To define in more detail how missing fields are handled, you have two options:

• The Undefined value policy setting defines whether log data matches the filter if there are missing fields.
• The Any Value Comparison operation allows you to define specific fields in the filter that the log data must

always have. The value that the field contains is not taken into account. Data entries that do not have these
fields do not match the filter.

You can use one of the four Undefined value policy settings to define how missing values are handled. The
setting works differently depending on the structure of the filter. The results of logical operations (AND, OR,
NOT) in the filter depend on the Undefined value policy setting. A logical operation is typically either true or false.
However, if a field in the filter does not exist in a data entry, the logical operation is left undefined.
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Table 35: Undefined value policy settings

Setting Description

False by comparison A Comparison operation is false if log data does not have all fields used in the filter.
Depending on the structure of the filter, the log data does or does not match the
Filter. For example, if the outermost operation in the filter is AND, the log data does
not match the filter if any of the inner operations are false.

False by filter Log data does not match the filter if the outermost operation in the filter is
undefined because log data does not have all fields used in the filter. The filter is
false.

True by filter Log data matches the filter if the outermost operation in the filter is undefined
because log data does not have all fields used in the filter. The filter is true.

Undefined If the outermost operation is undefined because log data does not have all fields
used in the filter, the undefined result is passed to the component that uses the
filter. The handling of the undefined result varies according to the component that
uses the filter.
In most cases, this setting works in the same way as “False by filter”. If the
outermost operation is undefined because log data does not have all fields in the
filter, the data does not usually match the filter.

Undefined value policy settings
 
Figure 70: Undefined values when matching an event

A filter has the IP destination and Destination port fields. ICMP traffic, for example, does not have the
Destination port field. If ICMP traffic is matched with the example filter, the filtering results vary according to the
selected Undefined value policy:

• False by comparison — The AND operations are false. As a result, the OR operation is also false. The event
does not match the filter.

• False by filter — The AND operations are undefined (neither true nor false). As a result, the OR operation is
also undefined. The setting interprets the undefined result as false. The event does not match the filter.

• True by filter — The AND operations are undefined (neither true nor false). As a result, the OR operation is
also undefined. The setting interprets the undefined result as true. The event matches the filter.

• Undefined — The AND operations are undefined (neither true nor false). As a result, the OR operation is also
undefined. The Undefined setting passes the undefined value to the component that uses the log data. The
handling of the data varies according to the component. Most components handle the data in the same way as
False by filter, so that the event does not match this filter.
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Organizing Filter elements
Adding Filter Tags to permanent Filter elements that you create makes it easier to find filters when you want to
use them. You can select several Filter Tags for each Filter element that you create.

Create Filter Tag elements
Filter Tags help you organize Filter elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Other Elements > Filters.

3) Right-click Filters, then select New > Filter Tag.

4) Enter a name in the Name field.

5) Click OK.

Related tasks
Change the Filter Tags of Filter elements on page 302

Change the Filter Tags of Filter elements
You can add Filter Tags to Filter elements, to make it easier to find a filter.

Tip:  These steps show how to add or remove Filter Tags to multiple Filters, but you can also edit
Filter Tags on the Tags tab in the properties of an individual Filter element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Other Elements > Filters, then select one or more Filter elements.

Tip:  If you want to remove all references to a Filter Tag so that you can delete the Filter
Tag, select all the filters in the All Filters branch. The selection includes filters that do not
reference the Filter Tag that you want to remove.
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3) To add a tag:

a) Right-click a Filter, then select Add Tag > Filter Tag.

b) Select the Filter Tag you want to add.

Note:  We do not recommend that you assign the System or Correlations Filter Tags.

c) Click Select.

4) To remove a tag:

a) Right-click a Filter, then select Remove Tag > Remove.

b) Select the Filter Tag you want to remove.

Note:  You cannot remove the System or Correlations Filter Tags from predefined
system elements.

c) Click Select.

Related tasks
Create Filter Tag elements on page 302

Examples of filters
These examples illustrate some common uses for filters and general steps on how the scenarios are configured.

Example: Create a filter for log entries
associated with specific users
This scenario shows an example of using filters to include logs in a report.

Company A wants a report of users who have authenticated themselves within a certain time frame. To create
the report, the company’s administrator needs a filter to select the logs concerning the authenticated users. The
administrator:

1) Creates a Filter element.

2) Selects the Auth. User field to filter the user names of authenticated users.

3) Selects the in operation.

4) Adds the wildcard * as the value to the Auth. User field to match all authenticated users in log data.
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Example: Create a filter for pings in a network
This scenario shows an example of using filters to exclude logs from a report.

Company B’s administrator has noticed that the number of ping attempts (ICMP echo requests) in the internal
network has increased. The administrator wants a report of all recent pings in the local network to make sure
an outsider has not taken over the the servers in the internal network. The administrator frequently pings from
the HOST 2 workstation in the internal network. The administrator knows that pings coming from HOST 2 are
legitimate, and wants to exclude pings from HOST 2 from the report.

The administrator needs a new filter for generating the report. The administrator:

1) Creates a Filter element in which the source IP address field in log data is compared to the internal network’s
addresses, and the ICMP type is compared to Echo.

2) Adds a condition that the IP address in the log data must not belong to the HOST 2 workstation.
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 CHAPTER 16

Working with Diagram elements
Contents

• Getting started with Diagram elements on page 305
• Using the Diagram Editor on page 306
• Create Diagram elements on page 307
• Edit the background of Diagram elements on page 308
• Create new elements in Diagram elements on page 308
• Create Diagram elements from configured elements on page 309
• Add comments to Diagram elements on page 310
• Set the layout of Diagram elements on page 311
• Connecting elements in Diagram elements on page 311
• Creating links between Diagram elements on page 313
• View diagram elements on page 315

Diagrams allow you to visualize your network security environment.

Getting started with Diagram elements
Diagrams allow you to generate a model of the elements you have already configured. You can also design a
model of your network and configure Security Management Center (SMC) elements at the same time.

You can also use diagrams to view and monitor the status of the elements in your system.

What you can do with diagrams
Diagrams allow you to:

• Maintain and understand the network structure.
• Monitor the status of your network graphically.
• Illustrate your network topology.
• Configure SMC elements and other network devices while designing your network.
• Store and print network topologies.

What should I know before I begin
• There are three types of diagrams: Connectivity Diagrams show the status of the connections between

elements that belong to the same configuration. VPN Diagrams show the status of VPN connections. IP
Diagrams are diagrams of a network.
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• In addition to creating diagrams manually, you can create diagrams automatically from elements that are
monitored in the Home view. The Home view also automatically displays a Connectivity Diagram or VPN
Diagram to show the connectivity status of an engine you select.

Diagram configuration overview
Diagrams allow you to create models of network configurations.

Follow these overall steps to configure diagrams:

1) Create a diagram.

2) Define the diagram background color and image.

3) Insert elements in the diagrams either manually or automatically.

4) Customize the diagram layout.

5) Make manual or automatic connections between the elements in the diagram.

6) Create relationships between diagrams.

Related tasks
Create Diagram elements on page 307
Edit the background of Diagram elements on page 308
Create new elements in Diagram elements on page 308
Set the layout of Diagram elements on page 311
Automatically connect elements in Diagram elements on page 312
Manually connect elements in Diagram elements on page 312
Specify a parent Diagram element on page 313
Create links from one diagram element to another on page 314
View diagram elements on page 315

Using the Diagram Editor
Diagrams are created and edited in the Diagram Editor.

There are two methods for creating diagrams. You can create a diagram from previously configured elements
or add new elements to the SMC and draw the diagram simultaneously. When you create network elements as
you draw the diagram, the elements are added to the SMC configuration with the other elements. If you edit the
configured elements (such as an IP address change), the changes are automatically updated in your diagram.
The automatic updates to the diagrams reduce the need to update your network documentation.
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Figure 71: Diagram editing toolbar in the diagram editor

1 Zoom

2 Collapse selected elements together

3 Arrange selected elements

4 Connect elements

5 Add text

6 Create new elements

Create Diagram elements
You can create a diagram from previously configured elements or add new elements to the SMC and draw the
diagram simultaneously.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Diagrams.

3) Right-click Diagrams, then select New > Connectivity Diagram, New > VPN Diagram, or New > IP
Diagram according to which diagram type you want to create.

4) Create a diagram using the various options.

5) Click  Save.

6) Name the diagram, then add an optional comment for your own reference.

7) (Optional) Select a parent diagram for the new diagram.

8) Click OK.
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Related tasks
Edit the background of Diagram elements on page 308
Create new elements in Diagram elements on page 308

Edit the background of Diagram
elements

Background images and colors enhance the appearance of your diagrams and make layout easier.

For example, you can use a map as the background image and arrange the elements in the diagram according to
their geographical location.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Diagrams.

3) Right-click the diagram, then select Edit.

4) Right-click the diagram’s background, then select Properties.

5) Using the available options, define the background properties.

6) Click OK.

Related tasks
Create new elements in Diagram elements on page 308

Create new elements in Diagram
elements

You can add new elements to the SMC and draw the diagram simultaneously.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.
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2) Browse to Diagrams.

3) Right-click the diagram, then select Edit.

4) Select the type of element you want to create in the toolbar, then click the diagram in the place where you
want to add the element.
The new element appears grayed-out because it has not been configured yet.

5) Double-click the new element.

6) Define the element’s properties.

7) Click OK.
The newly configured element is no longer grayed-out, and it is added to the appropriate category in the All
Elements list.

Related concepts
Defining IP addresses as elements on page 895

Related tasks
Set the layout of Diagram elements on page 311

Create Diagram elements from
configured elements

You can create a diagram from previously configured elements.

You can generate IP Diagrams, VPN Diagrams, and Connectivity Diagrams automatically from the elements that
are monitored in the Security Management Center.

Automatically generated IP Diagrams and VPN Diagrams are based on routing information, so they show
elements that belong to the same routing configuration. Automatically generated Connectivity Diagrams contain
elements that belong to the same configuration as defined in server, Firewall, IPS engine, and Layer 2 Firewall
properties.

You can edit the automatically generated diagram in the same way as any diagram. For example, you can add
more elements to the diagram by dragging and dropping configured elements from the list in the Resources
pane. Editing the automatically generated diagram can be useful for documenting your system although the
elements might not belong to the same configuration.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Diagrams.
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3) Right-click Diagrams, then select New > Connectivity Diagram, New > VPN Diagram, or New > IP
Diagram.

4) Browse to the type of element that you want to add to the diagram.

5) (In automatic diagram creation) Select an element that is monitored from the list in the Resources pane,
then drag and drop it onto the diagram.

6) Add the elements to the diagram.
• (In automatic diagram creation) Right-click the element’s icon, then select Auto Generate > Add

from Configuration or Auto Generate > Add from Routing. The elements that belong to the same
configuration or routing configuration are added to the diagram. The links between the elements are
also added automatically.

• (In manual diagram creation) Drag the existing elements from the list in the Resources pane, then drop
them onto the diagram.

7) Click  Save.

8) Name the diagram, then add an optional comment for your own reference.

9) (Optional) Select a parent diagram for the new diagram.

10) Click OK.

Related tasks
Set the layout of Diagram elements on page 311

Add comments to Diagram elements
Text comments allow you to add notes and labels to diagrams.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Diagrams.

3) Right-click the diagram, then select Edit.

4) Click  Text Tool.

5) Click the diagram in the place where you want to add the comment.

6) Select the font properties that you want to use, then enter the comment.

7) Click OK.
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8) If necessary, select the comment, then drag the comment to change its position.

Related tasks
Set the layout of Diagram elements on page 311

Set the layout of Diagram elements
You can set the layout of a diagram manually, or you can select one of the automatic layout options.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Diagrams.

3) Right-click the diagram, then select Edit.

4) To move elements, click  Hand Tool, then drag and drop the elements to their places.
In addition to moving individual elements by dragging and dropping, you can also use the Hand Tool to move
all elements in a diagram.

5) To arrange elements automatically, do the following.

a) Click  Select Components, then select the elements that you want to arrange.

b) Select  Layout Tools, then an option.

Related tasks
Automatically connect elements in Diagram elements on page 312
Manually connect elements in Diagram elements on page 312

Connecting elements in Diagram
elements

You can connect elements in diagrams automatically or manually.

The automatic connections are based on the IP addresses of the elements or on the Routing configuration.

To help you maintain the clarity of your diagrams, you can also use turning points. Turning points are useful, for
example, in complex diagrams where connections would otherwise cross each other.

To create a turning point, click  Add Turning Point. Click in the middle of the connection between the two
elements, then drag the turning point to the direction of your choice to create an angle.
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Related tasks
Automatically connect elements in Diagram elements on page 312
Manually connect elements in Diagram elements on page 312

Automatically connect elements in Diagram
elements
You can connect elements automatically either based on the routing configuration or on the IP addresses of the
elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Diagrams.

3) Right-click the diagram, then select Edit.

4) Click  Select Components.

5) Select the elements that you want to connect.

6) Select Tools > Auto Connect by Routing or Tools > Auto Connect by Addresses from the menu.
The connections between the elements appear.

Related concepts
Creating links between Diagram elements on page 313

Manually connect elements in Diagram
elements
You can use the Connection Tool to connect elements in diagrams manually.

If the connection you create has a red, crossed-out circle on it, the connection is not valid. A connection might
be invalid, for example, if you connect an element to a network with an address range that does not include that
element’s IP address. Such connections are allowed so that you can plan a configuration change without actually
editing the elements until you are finished.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Diagrams.

3) Right-click the diagram, then select Edit.

4) Click  Connection Tool.

5) Click and hold the first element to be linked.

6) Drag the mouse pointer to the second element, then release the mouse button.
The elements are connected unless the connection is not allowed. You might have to insert a Network
element between two elements before you can connect them.

Related concepts
Creating links between Diagram elements on page 313

Creating links between Diagram
elements

You can create links between related diagrams.

You can specify a parent diagram to organize the diagrams into a hierarchy. You can also create links between
diagrams under the same parent diagram.

Related tasks
Specify a parent Diagram element on page 313
Create links from one diagram element to another on page 314

Specify a parent Diagram element
For each diagram, you can specify another diagram as its parent diagram. Parent diagrams allow you to organize
diagrams in a hierarchy.

All diagrams that have the same parent diagram are shown as branches below the parent diagram in the tree.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.
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2) Browse to Diagrams.

3) Right-click the diagram for which you want to specify a parent diagram, then select Properties.

4) Click Select.

5) Select a parent diagram from the diagram list.

6) Click OK.
The diagram is now displayed as a branch under the selected parent diagram in the tree.

Related tasks
Create links from one diagram element to another on page 314

Create links from one diagram element to
another
When you have a large network, linking allows you to use just a network icon to represent individual network
segments in a top-level diagram. You can create links from them to more detailed diagrams.

Before you begin
Before you can add a link, you must have at least two diagrams under the same parent diagram.

You can attach links to any of the elements in the diagram. When you double-click a link, another diagram opens.

Note:  You cannot create links between two diagrams that have different parent diagrams.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Diagrams.

3) Right-click the element that you want to function as a link, then select Link To.

4) Select the diagram to link to.

5) Click  Save.

Related tasks
Specify a parent Diagram element on page 313
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View diagram elements
You can view diagrams without opening them for editing.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Diagrams.

3) Right-click the diagram, then select Preview Connectivity Diagram, Preview VPN Diagram, or Preview IP
Diagram.

Related tasks
Collapse element groups in Diagram elements on page 315
Expand element groups in Diagram elements on page 316
Zoom in or out in Diagram elements on page 316

Benefits of collapsing or expanding element
groups in Diagram elements
Collapsing or expanding clustered engine elements makes complicated diagrams simpler, as the individual items
can be viewed only when needed.

You can collapse and expand clustered engine elements, such as a Firewall Cluster, an IPS Cluster, or a Layer
2 Firewall Cluster. You can also collapse and expand groups of elements (any group of elements you select) to
hide the individual nodes or elements. You can collapse and expand clusters and element groups while viewing
and editing diagrams.

Collapse element groups in Diagram elements
Collapsing clustered engine elements makes complicated diagrams simpler.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Diagrams.

3) Right-click the diagram, then select Edit.

4) Click  Select Components, then select two or more elements, or at least one of the nodes belonging to an
expanded cluster.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Working with Diagram elements | 316

5) Click  Collapse Selected Components.
If several elements were selected, they are now shown as a single cloud with the tooltip Collapsed Area.
Clustered elements are collapsed into an appropriate cluster icon.

Related tasks
Zoom in or out in Diagram elements on page 316

Expand element groups in Diagram elements
You can expand element groups to view the individual elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Diagrams.

3) Right-click the diagram, then select Edit.

4) Select a clustered element or a group of collapsed elements.

5) Click  Expand Selected Component.
The individual nodes or elements are displayed. The nodes are shown with a yellow sign containing a minus
sign to illustrate their association to an expanded cluster.

Related tasks
Zoom in or out in Diagram elements on page 316

Zoom in or out in Diagram elements
You can use various methods to zoom in the diagram, such as using the Diagram Navigation tool to zoom into
selected parts of the diagram.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Browse to Diagrams.

3) Right-click the diagram, then select Edit.

4) If the Diagram Navigation pane is not displayed, select  Menu > View > Panels > Diagram Navigation to
activate the Diagram Navigation tool.
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5) Click and drag in the area outside the black rectangle to zoom in and out.

6) Click inside the black rectangle to adjust which part of the diagram is shown.

7) Select  Zoom > Default Zoom to see the default zoom view again.
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 CHAPTER 17

Incident Case elements
Contents

• Getting started with Incident Case elements on page 319
• Create Incident Case elements on page 320
• Set a context for Incident Case elements on page 321
• Attaching data to Incident Case elements on page 321
• Add Players to Incident Case elements on page 325
• Add journal entries to Incident Case elements on page 326
• Working with existing Incident Case elements on page 326
• Example: Incident Case scenarios on page 329

When suspicious activity is detected, it is important to collect information about the incident and act quickly. The
Incident Case element is a tool for investigating incidents of suspicious activity.

Getting started with Incident Case
elements

The Incident Case element allows you to gather together the data, actions, system configuration information, and
files related to a specific incident.

This information is useful for effective incident investigation, and also helps to provide evidence for legal action or
to demonstrate compliance with operational standards.

Limitations of Incident Cases
When you write a Memo in an incident case, text does not automatically wrap in the Incident Memo Properties
dialog box. You must press Enter at the end of each line if you want your text to break to a new line.

Memos are permanently deleted when you remove them from an incident case. Other types of attachments can
be added again if you remove them by mistake.

Related concepts
Attaching data to Incident Case elements on page 321
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Incident Case configuration overview
Incident cases can be started as needed. You can then add various types of information from the system to them,
as well as your own comments.

The configuration of Incident Cases involves the following general steps:

1) Create an Incident Case.

2) Attach relevant Logs, Policy Snapshots, Memos, and files to the Incident Case.

3) Add the network elements involved in the incident to the Incident Case.

4) Add journal entries to the Incident Case.

Related concepts
Attaching data to Incident Case elements on page 321

Related tasks
Create Incident Case elements on page 320
Set a context for Incident Case elements on page 321
Add Players to Incident Case elements on page 325
Add journal entries to Incident Case elements on page 326

Create Incident Case elements
The Incident Case element stores the information related to the incident.

When you create an incident case, the Data Collection, Player List, and Journal tabs are visible. The History tab
is at the bottom of the view with the General tab.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Right-click Incident Cases and select New Incident Case.

3) Enter a unique Name, (optional) Comment, and (optional) Priority.

• The priority you define is for your own categorization and does not affect the way the case is handled in
the Security Management Center.

• The State cannot be changed during the creation of the new incident case.

4) Click OK.
The new incident case opens for editing.
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Related concepts
Attaching data to Incident Case elements on page 321

Related tasks
Set a context for Incident Case elements on page 321
Add Players to Incident Case elements on page 325
Add journal entries to Incident Case elements on page 326
Change the state of Incident Case elements on page 328

Set a context for Incident Case elements
You can set a context for solving a particular Incident Case in the Management Client.

The SMC then generates a list of your actions in the Management Client and attaches the selected Incident Case
in the audited actions. You can view the actions on the History tab of the Incident Case.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > View > Layout > Incident Context Toolbar.

2) Select the Incident Case to which you want to add information.
The status bar switches to orange when an Incident Case is selected.

Related concepts
Attaching data to Incident Case elements on page 321

Related tasks
Add Players to Incident Case elements on page 325
Add journal entries to Incident Case elements on page 326

Attaching data to Incident Case
elements

You can use the Data Collection tab to attach information to provide context for investigating the incident.

The following types of data can be attached to the Incident Case:
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Table 36: Data collection

Data Item Explanation

Logs Log, alert, and audit entries from Firewall or IPS engines and Log and Management Servers.

Policy Snapshot A record of a configuration stored in the upload history. Policy Snapshots help to establish
which policies were in place at the time of the incident.

Memo A simple text file for attaching excerpts of text, for example, by copying and pasting from
email, IRC or instant messaging.

File Any type of file. For example, saved reports, text files, saved e-mail messages, packet
capture files, or screenshot images.

Related tasks
Attach logs and audit entries to Incident Case elements on page 322
Attach Policy Snapshots to Incident Case elements on page 323
Attach memos to Incident Case elements on page 324
Attach files to Incident Case elements on page 324

Attach logs and audit entries to Incident Case
elements
There are several ways to attach logs and audit entries to an Incident Case.

You can attach selected single logs or audit entries, selected groups of logs or audit entries, or all logs or audit
entries that match your query criteria. It is also possible to attach log and audit data to Incident Cases directly
from the Logs view.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Tools > Attach > Logs on the Data Collection tab of the incident case.
The Logs view opens.

2) (Optional) To restrict the data that is displayed, specify your search criteria in the Query pane.

3) Attach a single log or a selected group of logs.

a) Select the logs you want to attach.

b) Right-click the selection and select Export > Attach Log Events to Incident.

4) To attach all logs that match your filtering criteria, right-click any log entry and select Export > Attach Log
Events to Incident.

5) Enter a unique Description for the logs.
The description is used as the name of the data item in the Incident Case.
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6) Select Other from the Incident Case Target drop-down list.

7) Select the Incident Case that you want to attach the logs to and click Select.

8) Specify which logs you want to attach:
• Select Selected logs to add only the specific log entries you selected.
• Select Filtered logs from to add all log entries that match your query criteria.

9) (Optional) Select Create Link Only if you want to create a reference to the logs without duplicating the log
files.

10) (Optional) Select Create also Players based on the following log fields and select the fields if you want
to automatically fetch the player information related to the logs.

11) (Optional) Select Time out to automatically stop the export if it takes too long.

12) Click OK.
The selected logs are attached to the incident case and appear in the Data Collection tab.

Related concepts
Benefits of filtering log entries on page 250

Related tasks
Attach Policy Snapshots to Incident Case elements on page 323
Attach memos to Incident Case elements on page 324
Attach files to Incident Case elements on page 324
Add Players to Incident Case elements on page 325
Add journal entries to Incident Case elements on page 326

Attach Policy Snapshots to Incident Case
elements
Policy Snapshots help to establish which policies were in place at the time of the incident.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Tools > Attach > Policy Snapshot on the Data Collection tab.

2) Select the policy snapshot you want to attach and click Select.
The policy snapshot is attached to the incident case and appears on the Data Collection tab.
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Related tasks
Attach memos to Incident Case elements on page 324
Attach files to Incident Case elements on page 324
Add Players to Incident Case elements on page 325
Add journal entries to Incident Case elements on page 326

Attach memos to Incident Case elements
Memos allow you to take notes about the incident.

You can copy and paste from the clipboard into a memo. Memos can be edited and deleted after they are added
to the incident case. If you want to add permanent, read-only comments and notes about the incident, add journal
entries instead.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Tools > Attach > Memo on the Data Collection tab.

2) Give the memo a descriptive Name.
The name is used as the name of the data item in the incident case.

3) Type or paste the text of the memo in the Text field.

4) Click OK.
The memo is added to the Data Collection list.

Related tasks
Attach files to Incident Case elements on page 324
Add Players to Incident Case elements on page 325
Add journal entries to Incident Case elements on page 326

Attach files to Incident Case elements
You can attach any type of files, such as saved reports, text files, saved e-mail messages, packet capture files, or
screen captures to incident cases.

If you want to attach a newer version of a file, you must first remove the existing attachment from the incident
case.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Tools > Attach > File on the Data Collection tab.
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2) Browse to the file you want to attach. Select the file and click Open.
The file is added to the Data Collection list.

Related tasks
Add Players to Incident Case elements on page 325
Add journal entries to Incident Case elements on page 326

Add Players to Incident Case elements
A player is any element that was involved in the incident.

The related players can be fetched automatically when attaching logs or audit entries, or you can add players
manually. Alternatively, you can copy and paste elements to the Player List tab of an incident case. Attaching
players to an incident case creates a reference to an element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Tools > New Player on the Player List tab.

2) Give the player a unique Name.
This name is used in the Player list.

3) Enter the IPv4 Address of the player or enter the DNS Name of the player and click Resolve to resolve the
DNS name to an IP address. Elements shows a list of player elements.

4) (Optional) Add a Comment.

5) Click OK.
The player is added to the Player list.

Related concepts
Attaching data to Incident Case elements on page 321

Related tasks
Add journal entries to Incident Case elements on page 326
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Add journal entries to Incident Case
elements

The journal allows you to record your observations and comments about administrator actions during the incident
investigation.

Adding journal entries is especially useful when more than one administrator is investigating the same incident
simultaneously. Journal entries are automatically marked with a time stamp. Once a journal entry is added, it
cannot be removed, which provides an audit for incident management (for example, to be used as evidence in
court).

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Type the journal entry in the Additional Comment field and click Commit.
The journal entry is added to the list.

Related concepts
Attaching data to Incident Case elements on page 321

Related tasks
Add Players to Incident Case elements on page 325

Working with existing Incident Case
elements

After you have created an Incident Case element, you can edit the contents and properties of the Incident Case.

Related tasks
Open Incident Case elements for editing on page 326
Change the priority of Incident Case elements on page 327
Change the state of Incident Case elements on page 328
View the history of Incident Case elements on page 328

Open Incident Case elements for editing
You can edit the players and data that are attached to an Incident Case.

Note:  You cannot edit or remove journal entries.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Monitoring.

2) Select Incident Cases in the tree view.

3) Right-click the incident case and select Edit Incident Case.
The Incident Case view opens.

4) Edit the Incident Case as needed.
Changes are automatically saved when you close the Incident Case view.

Related concepts
Attaching data to Incident Case elements on page 321

Related tasks
Add Players to Incident Case elements on page 325
Add journal entries to Incident Case elements on page 326
Change the priority of Incident Case elements on page 327
Change the state of Incident Case elements on page 328
View the history of Incident Case elements on page 328

Change the priority of Incident Case elements
As the investigation of the incident progresses, you can change the priority of the Incident Case as necessary.

The default Priority of an incident case is Low when an incident case is created. The priority you define is for your
own categorization and does not affect the way the case is handled in the SMC.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Incident Case you want to change the priority for and select Properties.

2) Select the new Priority and click OK.

Related tasks
Change the state of Incident Case elements on page 328
View the history of Incident Case elements on page 328
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Change the state of Incident Case elements
The state information is only for your own reference. As the investigation of the incident case progresses, you can
change its state accordingly.

The default state of an incident case is Open when an incident case is created.

When the investigation is finished, you can close the incident case. The incident case stays in the system, but
its state is shown as closed. It is a good idea to keep resolved incident cases as a record of past incidents or for
future reference in dealing with new incidents.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Incident Case you want to change the state for and select Properties.

2) From the available options, select the new State.

3) Click OK.
The state of the incident case is changed.

Related tasks
View the history of Incident Case elements on page 328

View the history of Incident Case elements
The Incident History tab shows the logs and audit entries that track actions performed in this Incident Case
view.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Tools > Incident History.

Related concepts
Getting started with Incident Case elements on page 319

Related tasks
Create Incident Case elements on page 320
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Example: Incident Case scenarios
There are many ways an administrator can become aware of suspicious activity in the system. The most likely
way is by noticing something unusual in the logs or audit entries, or being warned about a potential problem in an
alert.

Example: Investigation by more than one
administrator
This scenario shows an example of incident investigation by multiple administrators.

1) An administrator creates as Incident Case element.

2) The administrator delegates work to other administrators.

3) Each administrator collects data and players, and attaches them to the incident case.

4) An administrator reacts to contain the incident, for example, by stopping an engine or changing a Firewall
policy.

5) An administrator might try to eradicate the problem, for example, by installing software patches or updating
anti-malware programs.
• The administrator can write a new comment in the incident journal to inform the other administrators

about what has been done.

6) When the problem is resolved, the administrator closes the incident case.

Example: Investigation of a false positive
This scenario shows an example of an incident investigation of a false positive.

1) The administrator creates an Incident Case element.

2) While collecting data, the administrator discovers that the suspicious event was not a real problem.

3) The administrator closes the incident case as a false positive.
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Example: Investigation of suspected backdoor
traffic
This scenario shows an example of incident investigation of a compromised server.

The administrator receives an IPS alert that there is active two-way backdoor traffic between a server in the
organization's internal network and an unknown host in the Internet. The administrator then:

1) Opens an Incident Case to help manage this incident.

2) Searches for previous logs from the Firewall and IPS engines to identify the vulnerability that allowed the
server to be compromised.

3) Attaches the relevant logs to the incident case.

4) Reinstalls the server, and installs patches to prevent the same vulnerability from being exploited again.

5) Closes the incident case.
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 PART V
Controlling engines

Contents

• Controlling engine operation on page 333
• Working on the engine command line on page 345

You can command and set options for engines through the Management Client or on the engine command line. You
can also stop traffic manually.
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 CHAPTER 18

Controlling engine operation
Contents

• Commanding engines remotely on page 333
• Set engine options on page 338
• Change a NetLink state manually on page 342
• Disable cluster nodes temporarily on page 342
• Re-enable disabled cluster nodes on page 343
• Editing engine configurations on page 344

You can command and set options for Firewall engines, Layer 2 Firewall engines, IPS engines, Master NGFW
Engines, Virtual Firewalls, Virtual IPS engines, and Virtual Layer 2 Firewalls through the Management Client.

Commanding engines remotely
You can send commands to engines remotely through the Management Client.

You can control Firewalls, Layer 2 Firewalls, IPS engines, Master NGFW Engines, Virtual Firewalls, Virtual IPS
engines, and Virtual Layer 2 Firewalls through each engine element’s right-click menu. The commands available
depend on the type of component. In a cluster, the commands that affect the operating state of the engines can
only be given to the individual nodes, not to the whole cluster.

You can also give commands and set options for more than one engine at a time by Shift-selecting or Ctrl-
selecting the elements.

Note:  For abnormal situations, there are limited tools for giving some basic commands (such as
go online or offline) through the engine's command line interface. Under normal circumstances,
you should control the engines remotely through the Management Client.

Turn engines online
You can turn engines in the offline state online through the right-click menu.

When engines are in the offline state, the status icon is blue and the status text reads offline. You can turn
engines online if there are no configuration issues that would prevent the node or cluster from operating normally.
Typical issues that can prevent a node from going online include policy issues, automatic tests failing, or
heartbeat connection problems between nodes in clusters.

Note:  You might also be able to give commands to nodes in the unknown state (gray icon), but
you might not see a change of status. Because the actual operating status is not available, the
node might already be online. In this case, you might receive an error if you try to command the
node online.
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Note:  If the cluster is set to standby mode, only one node at a time can be online. Commanding a
standby node online switches the current online node to standby.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Engines, then expand the nodes of the engine that you want to turn online.

3) Right-click the engine node, then select Commands > Go Online or Commands > Lock Online.

4) (Optional) In the Confirmation dialog box that opens, enter an Audit Comment.
The comment is included in the audit log entry that is generated.

5) Click Yes.
The engine is turned online shortly.

Related tasks
Adjust general Firewall clustering options on page 685
Adjust IPS clustering options on page 688
Adjust Layer 2 Firewall clustering options on page 688
Adjust general Master NGFW Engine clustering options on page 689
Troubleshoot engines that do not go or stay online on page 1363

Turn engines offline
In the offline state, engines stop processing traffic, but remain otherwise operational and ready to be turned
online again.

Engines in the offline state can be turned on either automatically or by an administrator’s command, depending
on the configuration.

CAUTION:  When you turn a node offline, it stops processing traffic. On Firewalls, Layer 2
Firewalls, and Master NGFW Engines, traffic is stopped unless other cluster nodes can take over.
On Virtual Firewalls, Virtual IPS engines, and Virtual Layer 2 Firewalls, traffic is always stopped.
On IPS engines, the behavior depends on the Failure Mode of the interfaces.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Engines, then expand the nodes of the engine that you want to turn offline.

3) Right-click the node, then select Commands > Go Offline or Commands > Lock Offline.
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4) (Optional) In the Confirmation dialog box that opens, enter an Audit Comment.
The comment is included in the audit log entry that is generated.

5) Click Yes.
The engine is turned offline shortly.

Related concepts
Configuring interfaces for IPS engines on page 574

Related tasks
Turn engines online on page 333

Set nodes to standby mode
When a cluster runs in standby mode, only one node at a time processes traffic. The other running nodes are on
standby.

Standby nodes monitor the traffic so that they can take over if the active node fails. Only one node at a time is
in the online state, and the rest are either in the standby or offline state. When you command an online node to
standby, a standby node in the cluster (if there is one) automatically goes online to take over the traffic.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Engines, then expand the nodes of the engine that you want to set to standby mode.

3) Right-click a node, then select Commands > Standby.

4) (Optional) In the Confirmation dialog box that opens, enter an Audit Comment.
The comment is included in the audit log entry that is generated.

5) Click Yes.
The node is set to standby mode shortly.

Related concepts
Getting started with advanced engine settings on page 683
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Reboot nodes
In rare cases, you might need to reboot Forcepoint NGFW nodes.

CAUTION:  If you are rebooting a cluster, reboot the nodes one by one to avoid breaks in service.
If you command all nodes to reboot, all nodes reboot at the same time.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Engines, then expand the nodes of the engine that you want to reboot.

3) Right-click the node, then select Commands > Reboot.

Next steps

Monitor the rebooting process by following the changes in the status of the element.

Power off the NGFW Engine
If needed, you can power off the NGFW Engine.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to NGFW Engines, then expand the nodes of the NGFW Engine that you want to power off.

3) Right-click the node, then select Commands > Power Off.

Reset the NGFW appliance to factory settings
If needed, you can reset the NGFW appliance to factory settings. To make sure that confidential information is
removed, the stored data can be overwritten multiple times.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to NGFW Engines, then expand the nodes of the NGFW Engine that you want to reset.
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3) Right-click the node, then select Commands > Reset to Factory Settings.

4) Enter how many times you want the stored data on the file system to be overwritten.

5) Click OK.

Refresh the currently installed policy on
engines
You can reinstall the currently installed policy of one or more components to transfer configuration changes since
the last policy installation.

Each type of NGFW Engine has its own type of policy. Inspection Policies are used by all types of NGFW
Engines.

Note:  In clusters, all nodes must be either operational or explicitly disabled for the policy
installation to succeed.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click the NGFW Engine, then select Current Policy > Refresh.

3) Click OK.

Related concepts
Getting started with policies on page 787

Related tasks
Disable cluster nodes temporarily on page 342

Remove Virtual NGFW Engines from Master
NGFW Engines
You can remove a Virtual NGFW Engine from a Master NGFW Engine if the Virtual NGFW Engine is no longer
needed.

When you remove a Virtual NGFW Engine from a Master NGFW Engine, the Virtual NGFW Engine goes offline
and stops processing traffic. The Virtual NGFW Engine element is kept in the Security Management Center. You
can associate the Virtual NGFW Engine with a different Virtual Resource to activate the Virtual NGFW Engine on
a different Master NGFW Engine. The Master NGFW Engine must host Virtual NGFW Engines in the same role
as the Virtual NGFW Engine you want to activate.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click the Virtual NGFW Engine, then select Commands > Remove Virtual Engine from Master
NGFW Engine.
A new tab opens to show the progress of the operation. The Virtual NGFW Engine is removed from the
Master NGFW Engine.

Related concepts
Modify Master NGFW Engines and Virtual NGFW Engines on page 524

Related tasks
Create Master NGFW Engine elements on page 518
Create Virtual Resource elements on page 520
Add Virtual Firewall elements on page 521
Add Virtual IPS elements on page 522
Add Virtual Layer 2 Firewall elements on page 523

Set engine options
You can set options for Firewalls, Layer 2 Firewalls, IPS engines, Master NGFW Engines, Virtual Firewalls,
Virtual IPS engines, and Virtual Layer 2 Firewalls through the Management Client.

Enable or disable engine status monitoring
By default, monitoring is automatically activated for all engines, but can be turned off as necessary.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click the NGFW Engine, then select Options.

3) Deselect or select Monitored.
Shortly, the status changes to Not Monitored and the icons associated with the element turn white.

Related concepts
Getting started with monitoring the system on page 179
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Enable or disable diagnostics on engines
Diagnostics mode provides more detailed log data for troubleshooting purposes.

Note:  Disable the diagnostics after troubleshooting to avoid overloading the Log Server with log
data.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click the NGFW Engine, then select Options > Diagnostics.

3) Select or deselect the Enable diagnostic logs for the selected features option at the top of the dialog box.

4) Select the features for which you want diagnostic log data on the engine when diagnostics are enabled.

5) Click OK.
The changes are applied immediately.

Related concepts
Getting started with the Logs view on page 241

Enable or disable user database replication on
firewalls or Master NGFW Engines
You can enable or disable the replication of the Management Server’s internal LDAP database to a Firewall
engine or a Master NGFW Engine.

The Management Server's internal LDAP database stores accounts for end users for authentication purposes.
Firewall engines have a local replica of the Management Server’s internal LDAP database. By default, all
changes are immediately replicated from the Management Server’s internal LDAP database to the local replicas
on Firewall engines.

Master NGFW Engines have one combined local replica of the Management Server’s internal LDAP database
for each Domain in which a Virtual NGFW Engine has users in the internal LDAP database. By default, changes
are replicated from the Management Server’s database to the local replicas on the Master NGFW Engines. The
information that is replicated to Master NGFW Engines depends on the User Authentication configuration of the
Virtual NGFW Engines.

Note:  Changing the replication of the Management Server’s internal LDAP database for a Master
NGFW Engine also changes the replication of the Management Server’s internal LDAP database
for all Virtual NGFW Engines hosted by the Master NGFW Engine.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click the NGFW Engine, then select Options.

3) Select or deselect User DB Replication.

Related concepts
Getting started with directory servers on page 1075

Enable or disable status surveillance on
engines
Status surveillance generates an alert when engines change to an unknown state.

By default, there is no warning to administrators if the status of the engines changes to an unknown state. You
can optionally activate the status surveillance feature. The status surveillance feature generates an alert if a
single engine or none of the engines in a cluster do not send a status update for 15 minutes.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click the NGFW Engine, then select Options.

3) Select or deselect Status Surveillance.

Next steps

Make sure that System Alerts are escalated so that the notification is sent if status surveillance detects a failure.

Related concepts
Alert escalation and how it works on page 377

Enable or disable SSH access to engines
Secure remote access to the engines is provided by the SSH daemon process. This process can be started and
stopped remotely.

For maximum security, we recommend disabling SSH access whenever it is not used.

Alternatively, you can enable and disable SSH access when logged on to the node.
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SSH uses TCP port 22. Make sure that the connections are allowed in the policies of any Firewalls or Layer 2
Firewalls involved in the communications (including the Firewall or Layer 2 Firewall that you are trying to contact).

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Engines, then expand the nodes of the engine for which you want to enable or disable SSH
access.

3) Right-click a node, then select Commands > Enable SSH or Commands > Disable SSH.

Result

The SSH process is started or stopped on the engine.

Related tasks
Configuring SSH access to the SMC Appliance on page 145
Reconfigure engine settings on page 347

Change the engine root password
The password for access to the engine command line can be changed remotely through the Management Client.

The user account for accessing the command line is always root. Alternatively, if you remember the old
password, you can change the password when logged on to the node.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Engines, then expand the nodes of the engine for which you want to change the root password.

3) Right-click a node, then select Commands > Change Password.

4) Enter the new password in both fields, then click OK.
The new password is effective immediately.

Related tasks
Reconfigure engine settings on page 347
Change your own engine password on page 368
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Change a NetLink state manually
You can manually command NetLinks to the Active or Standby state.

To change a NetLink’s state, it must be operational. You cannot send commands to NetLinks that have the
unknown (gray) status.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others > Multi-Link.

3) Expand the firewall, right-click the NetLink whose state you want to change, then select a command from the
Commands menu.

Related tasks
Create NetLink elements for Multi-Link configuration on page 715

Disable cluster nodes temporarily
Disabling a cluster node allows continued management of the other cluster members if one node goes out of
operation.

You can disable nodes in Firewall Clusters, IPS Clusters, Layer 2 Firewall Clusters, or Master NGFW Engines.
When you disable a node, you can physically remove it from the cluster without removing its definition from the
system.

Disabling a node indicates to the other nodes and the Management Server that it is not necessary to try to
contact it. Disabling a node prevents unnecessary communication attempts, alerts, and test failures. Disabling
a node also allows policy installations on the other nodes when one node is shut down or malfunctions. No
commands can be sent to a disabled node and no monitoring information is available for it.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Turn off the cluster node that you want to disable.

2) In the Management Client, select  Configuration.

3) Right-click the NGFW Engine, then select Edit <element type>.

4) In the navigation pane on the left, browse to General > Clustering.

5) In the Nodes table, select Disabled for the nodes you want to disable.

6) Click  Save and Refresh.
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Related tasks
Re-enable disabled cluster nodes on page 343

Re-enable disabled cluster nodes
You can re-enable nodes in a cluster that you have temporarily disabled.

When a Firewall Cluster, IPS Cluster, Layer 2 Firewall Cluster, or Master NGFW Engine node has been disabled,
its configuration is typically made obsolete by policy installations done on the other cluster nodes. Having an
obsolete configuration prevents the node from operating normally and might in some cases disturb the operation
of the whole cluster.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) (Recommended) Before connecting the disabled node (the same physical device or a replacement), set the
node to the initial configuration state using the NGFW Initial Configuration Wizard (sg-reconfigure) on the
engine command line.

Note:  If you reintroduce a disabled node that has a working configuration, the node must
receive the heartbeat traffic from other nodes and accept it (based on certificates). Otherwise,
the node considers itself the only available cluster member and goes online. Cluster nodes
that do not communicate with each other might prevent the whole cluster from processing
traffic.

2) In the Management Client, select  Configuration.

3) Right-click the NGFW Engine, then select Edit <element type>.

4) In the navigation pane on the left, browse to General > Clustering.

5) Deselect the Disabled option in the Nodes table for the nodes you want to re-enable, then click OK.

6) Click  Save and Refresh to ensure that all nodes have the same configuration.

Note:  If the policy installation is unsuccessful, return the previously disabled node to the
initial configuration state.

7) (Optional) In the Home view, right-click the node, then select Commands > Go Online or Commands >
Standby to return the node to operation.
The node is set to online or standby mode shortly.

Related tasks
Reconfigure engine settings on page 347
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Editing engine configurations
The engines can be configured in various ways.

• The network card drivers, mapping of physical interfaces on the network cards to Interface IDs, and speed/
duplex settings are defined using the NGFW Initial Configuration Wizard. You can use the NGFW Initial
Configuration Wizard on the engine command line or in a web browser.

• Other engine-specific settings are defined in the Engine Editor in the Management Client.

Related concepts
Editing existing engine elements on page 498
Modify Master NGFW Engines and Virtual NGFW Engines on page 524
Getting started with routing on page 701

Related tasks
Disable cluster nodes temporarily on page 342
Re-enable disabled cluster nodes on page 343
Reconfigure engine settings on page 347
Convert a Single Firewall element to a Firewall Cluster element on page 501
Convert a Single IPS element to an IPS Cluster element on page 504
Convert a Single Layer 2 Firewall element to a Layer 2 Firewall Cluster element on page 506
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 CHAPTER 19

Working on the engine command
line

Contents

• Considerations for working on the engine command line on page 345
• Access the engine command line on page 346
• Reconfigure engine settings on page 347
• Create engine scripts on page 349
• Send commands to Virtual NGFW Engines on page 350

Although the engines are managed remotely, some operations on the Linux command line on the engines are useful
for troubleshooting and local maintenance operations.

Considerations for working on the
engine command line

Nearly all engine configuration is done through the Management Client, but some engine settings and options
must be defined and configured on the command line.

What you can do on the engine command line
• Reconfigure the engine’s keyboard layout, time zone, network card settings, and network card to Interface ID

mapping.
• Create scripts that run when the engine changes its state.
• Establish contact between the engine and the Management Server.
• Manually revert to the previous configuration.
• Run various troubleshooting tools, both general and specific to Forcepoint NGFW.

Limitations of the engine command line
Changes made on the engine command line apply only to the node on which they were made. If you want to
change settings for other engines, such as all nodes in a cluster, you must make the same changes separately
on the command line of each engine.

Some engine configuration options, such as network interface settings, cannot be changed through an SSH
console. To be able to change these settings, you must connect using a serial cable or connect a display and
keyboard directly to the engine hardware.
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The Management Server contact settings that are displayed in the NGFW Initial Configuration Wizard (sg-
reconfigure) do not show the engine’s actual working configuration (transferred whenever the engine’s policy is
installed or refreshed). The NGFW Initial Configuration Wizard displays the values that were set when the node
was initialized.

If you are not a root user on the engine, your permissions to execute commands might be limited. This might be
the case if your SMC account has been replicated on the engine and your permissions have been limited in the
local sudo configuration file.

What do I need to know before I begin?
All command-line tools that are available for single NGFW Engines are also available for Virtual NGFW Engines
that have the same role. However, there is no direct access to the command line of Virtual NGFW Engines.
Commands to Virtual NGFW Engines must be sent from the command line of the Master NGFW Engine that
hosts the Virtual NGFW Engines.

Related tasks
Send commands to Virtual NGFW Engines on page 350
Access the engine command line on page 346
Reconfigure engine settings on page 347
Create engine scripts on page 349

Access the engine command line
There are several ways you can connect to the engine and access the engine command line.

Steps

1) Connect to the engine in one of the following ways:
• Physically using a serial cable and a terminal console program with these settings:

• Bits per second — 9600 or 115,200
• Data bits — 8
• Parity — None
• Stop bits — 1.

Note:  The serial console port speed is 9600 bps in most NGFW appliances. The speed
is 115,200 bps in the latest NGFW appliance models. See the hardware guide for your
NGFW appliance model for more information.

• Physically using a monitor and keyboard connected directly to the engine hardware.
• Remotely using an SSH client. SSH access to the engine can be enabled and disabled through the

Management Client.

2) If you have root administrator permissions, log on and enter the engine password.
If you forget the password, you can change it in the Management Client.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Working on the engine command line | 347

3) If you do not have root permissions and your administrator account has been replicated on the engine, log on
using your administrator user name and personal password for the engine.
If you forget the engine-specific password, ask an SMC administrator with Manage Administrators rights to
create you a new one in the Management Client.

Related tasks
Enable or disable SSH access to engines on page 340
Change the engine root password on page 341
Reconfigure engine settings on page 347
Create engine scripts on page 349

Reconfigure engine settings
On the command line of the NGFW Engine, you can use the NGFW Initial Configuration Wizard to change
settings that were defined during the installation of the NGFW Engine.

The NGFW Initial Configuration Wizard also allows you to re-establish a trust relationship between the NGFW
Engine and the Management Server if the trust is lost.

Note:  On NGFW Engines that are fully configured, you can change each setting individually
without changing the other settings. All steps are optional.

Steps

1) Start the NGFW Initial Configuration Wizard using one of the following commands:
• sg-reconfigure --no-shutdown — The NGFW Initial Configuration Wizard starts without shutting

down the NGFW Engine. You cannot change network interface settings in this mode.
• sg-reconfigure — The NGFW Engine shuts down and the NGFW Initial Configuration Wizard starts.

All options are available if you have a local connection. If you have a remote SSH connection, you cannot
change network interface settings.

2) Change the general settings.
• Change the keyboard layout for command-line use.
• Change the time zone for command-line use.
• Change the host name of the engine.
• Enable or disable SSH access to the engine command line.

Note:  Unless you have a specific reason to enable SSH access to the engine command
line, we recommend leaving it disabled.

3) Change the password for the root user account.

a) Highlight Change, then press Enter.

b) Enter and confirm the new password for the root user account.

c) Highlight OK, then press Enter.
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4) Change the bootloader password.

a) Highlight Change, then press Enter.

b) Enter and confirm the new bootloader password.

c) Highlight OK, then press Enter.

5) Change the network card settings and the mapping of network cards to Interface IDs.

6) Change the settings on the Prepare for Management Contact screen.

Note:  The Management Server contact details are not used by the NGFW Engine after a
policy has been installed from the Management Server. They are shown for your reference
only.

• To re-establish the trust relationship between the NGFW Engine and the Management Server, select
Contact Management Server, then enter a new one-time password.
Select this option when you want to replace a missing or expired certificate, or if the trust relationship
with the Management Server is lost for any other reason, such as changing the Management Server’s IP
address.

CAUTION:  If there is a Firewall or Layer 2 Firewall between a remote NGFW Engine
and the Management Server, you must allow the connection in the Firewall or Layer 2
Firewall Access rules. If there is a NAT device between a remote NGFW Engine and the
Management Server, you must also configure NAT rules for the connection in the Firewall
Policy. Otherwise, the NGFW Engine cannot contact the Management Server.

• To reset the NGFW Engine to the post-installation state, select Switch to Initial Configuration.

CAUTION:  Selecting this option removes all configuration and policy information that has
been transferred to the NGFW Engine. The post-installation state uses a policy that allows
communication only between the NGFW Engine and the Management Server. You must
install a policy on the NGFW Engine before it can be operational again.

Related concepts
Connect engines to the SMC on page 641

Related tasks
Access the engine command line on page 346

Related reference
Forcepoint NGFW Engine commands on page 1421



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Working on the engine command line | 349

Create engine scripts
Engine scripts run when the engine changes its state.

The script names and locations cannot be changed. If the scripts are not found, engine operation continues as
normal. If a script is found, it is executed and a log entry is created. To stop scripts from running, you must delete
or move the script.

Note:  If you want to use a script in a cluster, create or copy the script on all nodes in the cluster.
Then all nodes function in the same way when their state changes.

Steps

1) Create a text file with the commands you want the engine to execute (the first line of the script must be #!/
bin/sh) in one of the following ways:
• Create and edit the script on the engine’s command line using the vi text editor.
• Create and edit the script on a different host and transfer the file to the engine, for example, using SSH.

2) Save the script in the correct folder on the engine.

Table 37: Possible scripts on the engines

Triggering event Script location and name

Engine operating system boots /data/run-at-boot

Administrator refreshes or installs the policy /data/run-at-policy-apply

Engine enters the Online state /data/run-at-online

Administrator issued the ‘Lock Online’ command /data/run-at-locked-online

Engine enters the Offline state /data/run-at-offline

Administrator issued the ‘Lock Offline’ command /data/run-at-locked-offline

Engine enters the Standby state /data/run-at-standby

3) Make the file executable by typing the following command:
chmod a+x /data/<script name>

Result

The script is executed whenever the engine encounters the triggering event for running the script.

Related tasks
Access the engine command line on page 346

Related reference
Forcepoint NGFW Engine commands on page 1421
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Send commands to Virtual NGFW
Engines

Commands to Virtual NGFW Engines are sent from the command line of the Master NGFW Engine that hosts the
Virtual NGFW Engines.

All command-line tools that are available for single NGFW Engines are also available for Virtual NGFW Engines
that have the same role.

Steps

1) Connect to the command line on the Master NGFW Engine.

2) Enter commands in the following format:
se-virtual-engine [options]

Table 38: Options for se-virtual-engine Command

Option Description

-h | --help Shows the help message for the se-virtual-engine
command.

-l | --list Lists the active Virtual NGFW Engines.

-v <ID> |

--virtual-engine=<ID>

Specifies the ID of the Virtual NGFW Engine on
which to execute the command.

-e | --enter Enters the command shell for the Virtual NGFW
Engine specified with the -v or --virtual-
engine option. To exit the command shell, type
exit. Using the command shell is recommended if
you want to send multiple commands to the Virtual
NGFW Engine.

-E “<command [options]>” |

--execute=”<command [options]>”

Executes the specified command on the Virtual
NGFW Engine specified with the -v or --virtual-
engine option. Executing individual commands
is recommended if you only want to send a few
commands to the Virtual NGFW Engine. You can
also execute individual commands to send the same
command to multiple Virtual NGFW Engines.

Related tasks
Access the engine command line on page 346

Related reference
Forcepoint NGFW Engine commands on page 1421
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 PART VI
SMC configuration

Contents

• Administrator accounts on page 353
• Alert escalation on page 377
• Domain elements on page 399
• Setting up the Web Portal on page 409
• Distributing Management Clients through Web Start on page 421
• Configuring the Log Server on page 425
• Configuring SMC servers for high availability on page 437
• Reconfiguring the SMC and engines on page 449

Security Management Center (SMC) configuration allows you to customize how the SMC components work.
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 CHAPTER 20

Administrator accounts
Contents

• Getting started with administrator accounts on page 353
• How administrator accounts work on page 354
• Default administrator account elements on page 355
• Administrator account configuration overview on page 357
• Creating Administrator Role and Access Control List elements on page 357
• Add administrator accounts on page 359
• Enforce an approval workflow on page 362
• Restrict the log data an administrator can view on page 363
• Customize log colors for administrators on page 363
• Replicate administrator accounts on engines on page 364
• Enable and define password policy settings on page 366
• Change administrator passwords on page 367
• Authenticate administrators using RADIUS or TACACS+ methods on page 368
• Authenticate administrators using certificate-based authentication on page 370
• Disable administrator accounts on page 371
• Delete administrator accounts on page 372
• API client accounts and how they work on page 372
• Configure SMC API on page 373

Administrator accounts define administrator rights and permissions in the SMC.

Getting started with administrator
accounts

An administrator account specifies the actions for which the administrator has permissions, such as creating
elements and browsing logs.

You can define administrator rights for each administrator. You can give different permissions to each
administrator globally, for specific administrative Domains, for specific groups of elements, and even for individual
elements. Depending on the element, there are different levels of access that you can grant.

The Management Server contains information about all elements to make sure that administrator actions
are limited by the rights defined in the administrator account. Administrators can edit an element only if they
are allowed to edit all configurations where the element is used. The Management Server also prevents
administrators from deleting elements that are still used in some other configuration, from editing the same Policy
element simultaneously, and from making conflicting changes to the same element.
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How administrator accounts can be configured
• An unrestricted (superuser) administrator is created during the installation of an SMC Appliance.
• You can configure administrators in the Management Client with these steps:

1) Sets of administrator permissions are defined as reusable lists.

2) Each list of permissions is applied to a specific group of elements.

3) Define the administrator permissions.
Several different pairs of permissions and elements can be applied to a single administrator account.
These permissions can include, for example, viewing access to some elements and editing access to
other elements. You can also create unrestricted accounts for “superusers” that have permissions for any
action on any element. Some maintenance tasks require an unrestricted account.

Command-line administrator rights are available for engines and for the all-in-one SMC Appliance. To log
on to the SMC Appliance command line, Administrators must have SMC Appliance Superuser administrator
permissions. Administrators with unrestricted permissions (superusers) are allowed to log on to the SMC
Appliance command line only if there are no administrators with SMC Appliance Superuser permissions. All
administrator accounts with SMC Appliance Superuser permissions are automatically replicated to the SMC
Appliance and can execute root-level commands using the sudo tool.

In the Management Client, administrator accounts can be configured to replicate to engines. If needed,
administrator accounts can also be granted sudo permission to engines.

How administrator accounts work
Many elements are used in the configuration of administrator accounts, including NGFW Engine, Policy, Access
Control List, Administrator Role, and Filter elements.

Two types of elements represent administrator accounts in the SMC:

• Administrator elements define accounts for administrators who are allowed to manage elements through the
Management Client or on the engine and view information in the Web Portal.

• Web Portal User elements define accounts for users who are allowed to view information in the Web Portal.
The Web Portal Server is a separately licensed component.

Note:  Accounts that are used to log on to the Management Client can also be used to log on
to the Web Portal. Web Portal User accounts that can only be used to log on to the Web Portal
are created separately.

The elements used with Administrator elements:



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Administrator accounts | 355

 
Figure 72: Elements for administrator account definitions

• Administrator Roles define sets of allowed actions.
• Access Control Lists contain elements and allow you to more easily apply the Administrator Roles to several

engines and policies. There are some default Access Control List elements that are automatically populated
and can represent additional element types.

• If an administrator is allowed to view logs, you can use Filters to select which logs are displayed to the
administrator.

• If you use administrative Domains, you can give administrators access to any number of Domains.

Default administrator account elements
There are several predefined Administrator Roles and Access Control Lists that help you configure Administrator
permissions. You cannot edit the predefined elements.

The following table describes the predefined Administrator Roles that you can optionally use instead of or in
addition to customized Administrator Roles you create. All permissions listed here are always applied to a specific
set of elements that you define.

Table 39: Predefined administrator roles

Administrator role Permissions given

Viewer View the properties of elements.

Owner View the properties, and edit and delete elements. When an administrator creates an
element, the administrator is automatically set as an Owner of that element.

Operator View the properties of elements, send commands to engines, refresh policies, upload
policies, and browse logs and alerts (if applied to components that send logs).
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Administrator role Permissions given

Editor Operator permissions and additional permissions to create, edit, and delete elements.

All elements automatically belong to one or several predefined Access Control List elements in addition to the
Access Control Lists you create yourself.

Table 40: Predefined Access Control List elements

Access Control List Description

All Elements All elements that are defined in the system.

All Domains All Domain elements in the system. Can be used with Administrator
elements only if Domain elements have been configured.

All Administrators

All API Clients

All Firewall Policies

All Firewalls

All Incident Cases

All Inspection Policies

All IPS Policies

All Layer 2 Firewall Policies

All Layer 2 Firewalls

All Layer 2 Interface Policies

All Third Party Devices

All Web Portal Users

All elements of the type mentioned in the name of the Access Control List.

All Sensors and Analyzers

All SOHO Firewalls

All SSL VPN Gateways

All legacy elements of the type mentioned in the name of the Access
Control List.

All Simple Elements All elements except elements that have a dedicated system Access
Control List.

The contents of the Access Control Lists are Domain-specific if Domain elements have been configured in
the system. For example, in the Shared Domain, ALL IPS Policies refers to all IPS Policies that belong to the
Shared Domain.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Administrator accounts | 357

Administrator account configuration
overview

You must configure an administrator account for each administrator. You can create customized task and
element lists that can be used to define permissions for administrators.

Follow these general steps to configure administrator accounts:

1) (Optional) Define customized reusable lists of allowed tasks for accounts with restricted permissions.

2) (Optional) Define customized reusable lists of elements for defining access rights for restricted accounts.

3) Create an administrator account for each administrator.

4) (Optional) Configure the password policy requirements for administrator passwords.

CAUTION:  Do not use shared accounts. Using shared accounts makes auditing difficult and can
make it difficult to discover security breaches.

Related tasks
Create Administrator Role elements on page 358
Create Access Control List elements on page 359
Add administrator accounts on page 359
Enable and define password policy settings on page 366

Creating Administrator Role and Access
Control List elements

You can use Administrator Role and Access Control List elements in accounts that define restricted administrator
permissions.

You can either use the predefined Administrator Roles and Access Control Lists or create custom ones.

Related tasks
Create Administrator Role elements on page 358
Create Access Control List elements on page 359
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Create Administrator Role elements
Administrator Role elements specify a restricted set of permissions that include the right to create, edit, and
delete elements.

Each administrator can have several different Administrator Roles applied to different sets of elements. There
are some default Administrator Roles, but if you want to customize the permissions in any way, you must create
custom Administrator Role elements. The Administrator Role contains a fixed list of permissions that you can
activate.

Important:  Select only the minimum necessary permissions for each role. Administrators who are
allowed to edit administrator accounts can freely give themselves any permissions.

CAUTION:  Changes made to an Administrator Role are applied immediately to every
administrator account that uses the role (possibly including the account you are currently logged
on with). Make sure that the permissions are correct before you apply changes to existing
Administrator Roles.

If you change the permissions for existing administrator accounts, the administrators are notified that their
permissions have changed the next time that they log on to the Management Client.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Access Rights and select New > Administrator Role or right-click an existing Administrator
Role to edit and select Properties.

3) (New Administrator Role only) In the Name field, enter a unique.

4) Select the permissions that are applied to the elements selected for the role.

5) Click OK.

Related concepts
Traffic captures and how they work on page 216

Related tasks
Create Access Control List elements on page 359
Add administrator accounts on page 359
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Create Access Control List elements
An Access Control List defines a group of granted elements for which an administrator has rights.

If an Administrator Role gives the rights to install policies and browse logs and alerts, you must apply the
Administrator Role to NGFW Engines in the Administrator element. The Access Control Lists that you create can
include engines and policies.

The predefined Access Control Lists (in Administration > Access Rights > Access Control Lists) allow you
to give access to all elements of a certain type. When you create an element, it is automatically added to the
relevant default Access Control List. For example, a new Firewall element is automatically included both in the
ALL Elements and ALL Firewalls Access Control Lists.

Note:  You must create custom Access Control Lists if you want to give access to a limited
number of elements within one type.

If you change the permissions for existing administrator accounts, the administrators are notified that their
permissions have changed the next time that they log on to the Management Client.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Access Rights and select New > Access Control List or right-click an existing Access Control
List and select Properties.

3) (New Access Control List only) In the Name field, enter a unique name.

4) Select the elements you want to add to the Access Control List from Resources and click Add.
The selected elements are added to the Granted Elements list in the right pane.

5) Click OK.

Related tasks
Add administrator accounts on page 359
Define administrator permissions for engines on page 658

Add administrator accounts
Administrator elements represent administrator accounts in the SMC. Administrators configure and monitor the
SMC and the NGFW Engines.

An account with unrestricted permissions is automatically created during installation to guarantee that a
superuser account is available in the SMC. With this first account, you can create the necessary administrator
accounts for daily management tasks. For the SMC Appliance, the account created during installation is also a
user for the appliance.

The administrator accounts for the users of the optional Web Portal are defined with Web Portal User elements.
All other administrator accounts are defined with Administrator elements.
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There are three ways to authenticate administrator logons:

• You can authenticate administrators using a password stored in the internal database of the SMC.
• You can use a RADIUS or TACACS+ authentication method provided by an external authentication server.
• You can authenticate administrators using an X.509 certificate stored in the Windows certificate store or on a

smart card, such as a Common Access Card (CAC).

Note:  Certificate-based authentication is not supported for Web Portal Users.

Note:  We highly recommend that you define a unique administrator account for each
administrator. Using shared accounts makes auditing difficult and can make it difficult to discover
security breaches.

There are two general permission levels for the administrators:

• Unrestricted permissions give the administrators the right to manage all elements without restriction, and the
right to run scripts that require the administrators to authenticate themselves.
Administrators with unrestricted permissions can optionally also have Console Superuser permissions that
allow the administrators to log on to the SMC Appliance command line.

• Restricted permissions allow you to define the administrator’s rights in detail using the Administrator Roles
with individual elements and Access Control Lists.

If you change the permissions for existing administrator accounts, the administrators are notified that their
permissions have changed the next time that they log on to the Management Client.

If you use administrative Domains, there are some more considerations:

• You must create administrator accounts with unrestricted permissions in the Shared Domain.
• You must select Domains for each administrator role.
• Restricted accounts in the Shared Domain cannot access elements from any other Domains.
• Restricted accounts in other Domains can be granted elements that belong to the Shared Domain. However,

the granted elements must belong to a Domain that is allowed for the administrator role selected for the
account. For example, an administrator account in another Domain has the operator role in the Shared
Domain. The administrator can be granted a policy template from the Shared Domain. The administrator can
view the full contents of the policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Access Rights and select New > Administrator.

3) In the Name field, enter a unique name.
The administrator uses this user name to log on to the Management Client.

4) To authenticate administrator logons using a user name and password on the Management Server,
configure these options.

a) From the Authentication drop-down list, select Local Username and Password.
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b) In the Password fields, enter and confirm the password, or click Generate Password to generate a
temporary random password.
Generated passwords are one-time passwords. The administrator is automatically prompted to enter a
new password at the first logon.

Note:  If you replicate administrator accounts as local accounts on engines, you must
define a separate password for the local engine accounts.

c) (Optional, manually entered passwords) To require the administrator to enter a new password at the first
logon, select Require Administrator to Change Password at First Logon.

5) To authenticate administrator logons using RADIUS or TACACS+ authentication by an external
authentication server, configure these options.

a) From the Authentication drop-down list, select RADIUS or TACACS+.

b) From the Authentication Method drop-down list, select an Authentication Method element, or click
Select to select a different Authentication Method element.

6) To authenticate administrator logons using certificate-based authentication, configure these options.

a) From the Authentication drop-down list, select Client Certificate.

b) From the Client Identity Type drop-down list, select the certificate field that is used to identify the
administrator.

c) Specify the value of the certificate field in one of the following ways:

• In the Identity Value field, enter the value of the certificate field.
• Click Fetch From Certificate, then import the certificate to get the value from the certificate.

7) On the Permissions tab, define the administrator permissions.

CAUTION:  Select only the minimum necessary permissions for each Administrator account.

8) For administrator accounts with restricted permissions, define the rights and granted elements.

a) Click Add Role.
A new Administrator Role appears in the list.

b) Click the Role cell and select the administrator role that defines the rights you want to set.

c) Right-click the Granted Elements cell for the role and select Edit Granted Elements.

d) Select the elements to which the rights granted by the administrator role apply.
The Set to ALL action depends on the type of elements. For example, if you browse to Firewalls
and click Set to ALL, the item All Firewalls is added. You can also select one or more predefined or
user-created Access Control Lists. Simple elements includes all elements except elements that have
a dedicated system Access Control List. For example, there are dedicated Access Control Lists for
different types of NGFW Engines and their policies.

e) (Optional) If Domain elements have been configured, click the Domains cell to select the Domains in
which the rights granted by the administrator role and the selected elements apply.
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f) (Optional) If Domain elements have been configured, leave Allow Administrators to Log On to the
Shared Domain selected to allow the administrator to log on to the Shared Domain. Otherwise, the
administrator is only allowed to log on to the specified Domains.

9) Click OK.

Related concepts
The Domain Overview on page 180
Creating Administrator Role and Access Control List elements on page 357
Getting started with Domain elements on page 399

Related tasks
Enable and define password policy settings on page 366
Authenticate administrators using RADIUS or TACACS+ methods on page 368

Enforce an approval workflow
You can optionally enable an approval workflow in which an administrator must approve changes before they are
committed and transferred to the engines.

Administrators with the following permissions can view the changes, approve the changes, and transfer the
configurations to the engines:

• Administrators that have the Approve Changes permission
• Administrators with unrestricted permissions (superusers)

By default, the same administrator who made the changes cannot approve the changes. You can optionally allow
administrators to approve their own changes.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Global System Properties.

2) On the Change Management tab, select Require Approval for Changes in NGFW Engine Configuration.

3) Click OK.

Related tasks
View, approve, and commit pending changes on page 110
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Restrict the log data an administrator
can view

If an administrator is allowed to view logs and alerts, you apply local filters to the log data before it is displayed to
the administrator.

The filters that you create here are specific only to the Administrator element in question, unless you save them
as permanent Filter elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Expand the Access Rights branch and click Administrators.

3) Right-click the Administrator and select Properties.

4) Click the Permissions tab.

5) Under Log Filters, click Select.

6) Define the Local Filter's properties.

7) Click OK.

Related concepts
Getting started with filtering data on page 291
Creating and editing local filters on page 295

Related tasks
Save local filters as permanent Filter elements on page 297
Add administrator accounts on page 359
Customize log colors for administrators on page 363

Customize log colors for administrators
By default, certain logs are shown with a colored background in the Logs view. Using administrator-specific log
colors makes it easier to draw the administrator’s attention to particular logs.

You can customize the default log colors used by default in all administrator accounts or define administrator-
specific log colors in the Administrator element’s properties. To use customized colors for logs, you must also
create one or more filters that match those logs. Only administrators with the right to manage administrator
accounts can customize log colors.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Expand the Access Rights branch and click Administrators.

3) Right-click the Administrator and select Properties.

4) In the Administrator Properties dialog box, click the Color Filters tab.

5) Select the log type for which you want to change color filters.

6) (Optional) To add a new filter for a log type, click Add and double-click the Filter cell in the new color filter
row.

7) Select the color.
• Double-click the Color cell of the filter for which you want to change the color and select a color from the

palette.
• Click More Colors to select a custom color.

The selected colors are assigned to the filters and they are used whenever logs match the filter.

8) Click OK.

Related concepts
Creating and editing local filters on page 295

Related tasks
Disable administrator accounts on page 371
Monitor administrator actions on page 215

Replicate administrator accounts on
engines

You can replicate SMC administrator accounts as local administrator accounts on selected engines. This enables
several administrators to access an engine locally with the security privileges of the root user.

Before you begin
Before replication, each administrator must have an existing SMC administrator account. However, they
must not have existing accounts on the engine.

Several administrators might need to access a single engine for troubleshooting or for configuring features that
are not yet available through the Management Client. It is a good security practice to create each of them a
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separate account with a personal password and permissions. This practice enables more granular and accurate
auditing as well.

The root administrator can limit and configure the engine administrators' permissions individually in the local
engine sudo security policy. When an administrator is allowed to use sudo commands to execute root-level
commands on the engine, by default all commands are allowed on the engine. You can limit the commands
allowed for an administrator by editing the configuration for the sudo package. Engine configuration files for sudo
are in the /data/config/sudoers.d/ directory on the engine.

Note:  Administrator Permissions and Roles or other configurations done in the Management
Client are not replicated on the engine.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Expand the Access Rights branch and click Administrators.

3) Right-click the Administrator and select Properties.

4) Click the Account Replication tab.

5) Select Replicate Account on Selected Engines.

6) (Optional) To allow the use of sudo commands to execute root-level commands, select Allow executing
root-level commands with the sudo tool.

7) In the Password field, enter the password and confirm it in the Confirm field. You can also click Generate
Password to generate a random 7-digit alphanumeric password.

8) To select the NGFW Engines elements where the accounts are replicated to, click Add.

9) Select Access Control Lists, Domains, or NGFW Engines and then select the element by clicking
Select.

10) Click OK.

Result

The administrator account is replicated on the engines if the engines are online and have a connection to the
Management Server.
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Enable and define password policy
settings

If you authenticate administrators or Web Portal users with internal authentication, you can enforce a password
policy.

Before you begin
You must be logged on using an administrator account with sufficient permissions to change the
password policy settings. Permissions to manage Administrator elements or unrestricted permissions
are required. If administrative Domains are configured, you must be logged on to the Shared Domain.

The settings in the password policy are applied to all administrator and Web Portal user accounts defined using
Administrator and Web Portal User elements.

You can define the following settings in the password policy:
• Session limits and idle timeouts
• Restrictions on failed logon attempts
• Automatic disabling of inactive accounts
• Requirements for password age and expiration
• Requirements for password strength

Note:  If you have previously changed the default password policy settings in the
SGConfiguration.txt file, the settings are automatically applied on the Password Policy tab. Any
further modifications you make to the SGConfiguration.txt file have no effect.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Global System Properties.

2) Click the Password Policy tab.

3) Select Enforce Password Settings for All the Administrators and Web Portal Users.

Note:  The password policy is enforced by default.

4) Select the password policy settings.
For information about the options that you must select in a Common Criteria certification environment, see
the Common Criteria Certification User’s Guide.

5) Click OK.
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Change administrator passwords
If you have not configured administrator passwords to automatically expire, we recommend that you change
administrator passwords regularly.

Related tasks
Enable and define password policy settings on page 366

Change passwords of other administrators
An administrator who has the right to manage administrator accounts can change any other administrator’s
password.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Access Rights > Administrators or Access Rights > Web Portal Users.

3) Right-click the Administrator or Web Portal User element and select Properties.

4) In the Password field, enter and confirm the password.

5) Click OK.

Change your own administrator password
All administrators can change their own passwords in the Management Client or the Web Portal.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Password > Change Password.

2) In the Old Password field, enter your current password.

3) In the New Password field, enter a new password.

4) In the Confirm New Password field, confirm the new password.

5) Click OK.
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Change your own engine password
If administrator accounts have been replicated on engines, administrators can change their own local engine
passwords using the Management Client.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Management Client, select  Menu > System Tools > Password > Change Engine Password.

2) In the New Password field, enter a new password.

3) In the Confirm New Password field, confirm the new password.

4) Click OK.

Related tasks
Change the engine root password on page 341

Authenticate administrators using
RADIUS or TACACS+ methods

You can authenticate administrators and Web Portal users using RADIUS or TACACS+ authentication methods.

Before you begin
You must have an external authentication server that provides RADIUS or TACACS+ authentication
methods.

The Management Server’s internal user database does not allow external authentication servers to query the
administrator account information. To use external authentication, you must manually create an account both in
the SMC for defining the permissions and in the external directory for logon authentication. The administrator’s
user name for the Management Server and for the directory that the external authentication server uses must
match exactly.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Add one of the following types of server elements to integrate the external server, then define the shared
secret used in the communications in the server element.
• Add a RADIUS Authentication Server element, then add a RADIUS Authentication Method.

Note:  To use a RADIUS Authentication Server that has an IPv6 address, the
Management Server must also have an IPv6 address.
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• Add a TACACS+ Authentication Server element, then add a TACACS+ Authentication Method.
• Add an Active Directory Server element, then add a RADIUS Authentication Method.

2) Add an Access rule that allows traffic from your Management Server to the external authentication server.

3) Select  Configuration, then browse to Network Elements.

4) Select Network Elements > Servers.

5) Right-click the Management Server, then select Properties.

6) From the RADIUS Method or TACACS+ Method drop-down list, select the authentication protocol for
authenticating the Management Server’s communications with the external authentication server.
The supported RADIUS authentication protocols are PAP, CHAP, MSCHAP, MSCHAP2, and EAP-MD5.

The supported TACACS+ authentication protocols are ASCII, PAP, CHAP, and MSCHAP.

CAUTION:  To guarantee the security of the SMC, communications between the
Management Server and the external authentication server must remain confidential. We
recommend transferring these connections over secure networks only.

7) (RADIUS Authentication Servers only) Set up the external server for use with the Management Server.

a) Define the Management Server as a RADIUS client on your server.

b) Define the same authentication method on your server as you selected in the Management Server
properties in the previous step.

8) In the Management Client, configure RADIUS or TACACS+ authentication the properties of each
Administrator or Web Portal User account.

a) Select  Configuration, then browse to Administration.

b) Select Access Rights > Administrators.

c) Right-click an Administrator element, then select Properties.

d) From the Authentication drop-down list, select RADIUS or TACACS+.

e) From the Authentication Method drop-down list, select an Authentication Method element, or click
Select to select a different Authentication Method element.

f) Click OK.

Related tasks
Add administrator accounts on page 359
Create Active Directory Server elements on page 1079
Create RADIUS or TACACS+ Authentication Server elements on page 1104
Define Authentication Method elements for external servers on page 1105
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Authenticate administrators using
certificate-based authentication

You can authenticate administrators using an X.509 certificate stored in the Windows certificate store or on a
smart card, such as a Common Access Card (CAC).

Before you begin
To use smart cards for authentication, you must have smart card reader hardware and software.

To use certificate files for authentication, you must save the certificates in the Windows certificate store.

Certificate-based authentication is only supported for Management Clients installed in Windows 10. Certificate-
based authentication is not supported for Web Portal Users.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Configure the Management Server for certificate-based authentication.

a) Select  Configuration, then browse to Network Elements.

b) Select Network Elements > Servers.

c) Right-click the Management Server, then select Properties.

d) Next to the TLS Credentials field, click Select, then select a TLS Credentials element.

e) Next to the TLS Profile field, click Select, then select a TLS Profile element.
The TLS Profile element defines the cryptographic suite for TLS connections, the trusted certificate
authorities, options for certificate matching, and whether certificates are checked against certificate
revocation lists.

f) Click OK.

2) In the properties of each Administrator, configure certificate-based authentication.

a) Select  Configuration, then browse to Administration.

b) Select Access Rights > Administrators.

c) Right-click an Administrator element, then select Properties.

d) From the Authentication drop-down list, select Client Certificate.

e) From the Client Identity Type drop-down list, select the certificate attribute that is used to identify the
administrator.
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f) Specify the value of the certificate attribute in one of the following ways:

• In the Identity Value field, enter the value of the certificate attribute.
• Click Fetch From Certificate, then import the certificate to get the value from the certificate.

g) Click OK.

3) Export certificate from the TLS Credentials element that is used by the Management Server, then import the
certificate on each administrator's computer and configure the operating system to trust the certificate.
Alternatively, you can sign the certificate request for the Management Server using a CA that is already
trusted by the administrators' client operating systems.

Related tasks
Add administrator accounts on page 359
Log on to the SMC on page 104

Disable administrator accounts
If an administrator account is no longer needed, you can disable the administrator account to remove access for
the administrator.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Expand the Access Rights branch and click Administrators.

3) Right-click the Administrator and select Disable Administrator.
A Confirmation dialog box opens.

4) Click Yes to confirm that you want to disable the Administrator.
The Administrator element is marked as Obsolete and all scheduled Tasks created by the Administrator are
ignored.

Related tasks
Add administrator accounts on page 359
Delete administrator accounts on page 372
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Delete administrator accounts
When you permanently delete an administrator account, all history of changes the administrator has made to
elements is also deleted permanently.

Before you begin
You must disable the administrator account before you can delete it.

A history of the changes that an administrator makes to elements is saved in the SMC. If you delete the
administrator account, all history information about the changes the administrator has made is lost. Audit entries
that reference the administrator are preserved.

Note:  There must be at least one account with unrestricted permissions in the SMC. It is not
possible to delete the last remaining unrestricted account.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Expand the Access Rights branch and click Administrators.

3) Right-click the Administrator element and select Delete.
A Confirmation dialog box opens.

CAUTION:  Deletion is permanent. There is no undo. To recover a deleted administrator
account, you must either recreate it or restore it from a previously created backup that
contains the Administrator element.

4) Click Yes.
The Administrator element is permanently deleted.

Related tasks
Disable administrator accounts on page 371
Restore elements from the Trash on page 167

API client accounts and how they work
You can use the application programming interface (API) of the SMC to run certain actions in the SMC remotely
using an external application or script.

You must grant all API clients access to the SMC in the Management Client. You can define the API clients and
their permissions using API Client elements. For more information on how to configure API Client elements in the
Management Client, see the Forcepoint NGFW SMC API Reference Guide.
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Configure SMC API
The Application Programming Interface (API) of SMC allows external applications to connect with the SMC.

Note:  If there is a firewall between SMC and the other applications, make sure that there is an
Access rule to allow communication.

The SMC API can be used to run actions remotely using an external application or script. For more information
about using SMC API, see the Forcepoint NGFW SMC API Reference Guide.

Create TLS credentials for SMC API Clients
If you want to use encrypted connections, the SMC API Client needs TLS credentials to connect with the
Management Server.

Note:  You can import the existing private key and certificate if they are available.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Management Client, select  Configuration.

2) Browse to Administration > Certificates > TLS Credentials.

3) Right-click TLS Credentials, then select New TLS Credentials.

4) Complete the certificate request details.

a) In the Name field, enter the IP address or domain name of SMC.

b) Complete the remaining fields as needed.

c) Click Next.

5) Select Self Sign.

6) Click Finish.

Result

The TLS Credentials element is added to Administration > Certificates > TLS Credentials. The State column
shows that the certificate has been signed.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Administrator accounts | 374

Enable SMC API
To allow other applications to connect using the SMC API, enable SMC API on the Management Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Management Client, select  Home.

2) Browse to Others > Management Server.

3) Right-click the Management Server, then select Properties.

4) Click the SMC API tab, then select Enable.

5) (Optional) In the Host Name field, enter the name that the SMC API service uses.

Note:  API requests are served only if the API request is made to this host name. To allow
API requests to any host name, leave this field blank.

6) Make sure that the listening port is set to the default of 8082 on the Management Server.

7) If the Management Server has several IP addresses and you want to restrict access to one, enter the IP
address in the Listen Only on Address field.

8) If you want to use encrypted connections, click Select, then select the TLS Credentials element.

9) Click OK.

Create an API Client element
External applications use API clients to connect to SMC.

Before you begin
SMC API must be enabled for the Management Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Access Rights.

3) Right-click Access Rights and select New > API Client.
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4) In the Name field, enter a unique name for the API Client.

5) Use the initial authentication key or click Generate Authentication Key to generate a new one.
A random 24-character alphanumeric authentication key is automatically generated.

Important:  This key appears only once, so be sure to record it. The API Client uses the
authentication key to log on to SMC API.

6) Click the Permissions tab.

7) Select the permissions for actions in the SMC API.

8) Click OK.
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Alert escalation
Contents

• Alert escalation and how it works on page 377
• Creating Alert elements on page 380
• Configure notifications for alerts on page 382
• Alert Chain elements and how they work on page 383
• Creating Alert Policy elements on page 385
• Install Alert Policy elements on page 387
• Acknowledge active alerts on page 387
• How custom scripts for alert escalation work on page 388
• Create SMTP Server elements on page 389
• Use a script for SMS notification on page 390
• SNMP for the SMC Appliance on page 391
• Test alerts on page 394
• Examples of alert escalation on page 395

The SMC can escalate the alerts generated so that notifications are sent to the administrators through multiple
channels.

Alert escalation and how it works
Alerts notify you if something unexpected or suspicious happens. It is important for administrators to respond to
alerts to maintain the health of the SMC.

Alert entries inform the administrators when an event in the system requires their attention. For example, alerts
are sent when there is a problem with the system, when a test or task fails, or when a rule that is configured to
trigger an alert matches. Alerts can also be sent when a threshold for a user alert check is exceeded.

Active alerts are stored on the Management Server until the alerts are acknowledged. In an environment
with multiple Management Servers, each active alert is stored on each Management Server. Alert entries are
displayed in the Active Alerts view and in the Logs view with other types of log entries.

If you have configured the Management Client to show users in the Home view, you can see a summary of user
alerts. Select a user to see the user alerts that the user has generated.

The Management Server can send out different types of notifications to administrators. Alert escalation stops
when one of the administrators acknowledges the alert or when all configured alert notifications have been sent.
When an alert entry is acknowledged, it is removed from the Active Alerts view and from the Management
Server, and an audit entry is created.
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Figure 73: Alert escalation

1 An event on a system component triggers an alert entry.

2 The alert entry is sent to the Log Server, which stores it.

3 The Log Server forwards the alert entry to the Management Server, where it is handled as an active
alert.

4 The Management Server matches the alert entry to the Alert Policy to select the correct Alert Chain.

5 The Alert Chain triggers a series of notifications that are sent to administrators.

For example, an Alert Chain can first notify one of the administrators by email and wait for acknowledgment for
10 minutes. If the alert is not acknowledged in time, the Management Server can send another notification as an
SMS text message.

Limitations
• Only one email recipient can be configured for each notification. To send an email to several people at

the same time, you must configure an email group on the mail server or configure several notifications
consecutively without delays.

• Only SMC servers can send Test Alerts. Test Alerts always have default Severity and Situation information.
• By default, the maximum number of active alerts is 3000 per Domain. You can change the

default number of active alerts per Domain by adjusting the MAX_ACTIVE_ALERTS and
CRITICAL_ACTIVE_ALERTS_EXTRA_SPACE parameters in the SGConfiguration.txt file that is stored
on the Management Server. The maximum number of alerts of any Severity is 2000. After 2000 alerts of any
Severity have been sent, only Critical alerts are still sent until the total number of active alerts is 3000.

Default alert escalation elements
The alert system includes some predefined elements for configuring alert escalation.

The following default alert escalation elements are included:

• System Situations — System Situations contain definitions for events in the system that trigger a System
Alert. There are no configurable parameters for System Situations and you cannot adjust when these
Situations are triggered.
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• System Alert — This Alert element is used for alerts triggered by critical events in the system’s internal
operation (System Situations). System Alerts always require administrator action. Make sure that your Alert
Policies escalate System Alerts.

• Default Alert — This Alert element defines the alert that is triggered if no other alert is specified. The Default
Alert is used in the default Inspection Policy. You can also use it in your own custom configurations.

• Test Alert — This Alert element is used when you test alert handing.
• Default Alert Chain — This Alert Chain escalates all alerts to all administrators through user notification in the

Management Client.
• Default Alert Policy — This Alert Policy contains a rule that escalates all alerts using the Default Alert Chain.

Alert escalation configuration overview
Configuring how alerts are escalated involves several general steps.

 
Figure 74: Elements in the configuration

The configuration consists of the following general steps:

1) (Optional) Create Custom Alert elements for more precise matching in the Alert Policy.

2) Define which events trigger alerts.

3) Define how alert notifications are sent to administrators.

4) Create lists of actions to take when an alert is escalated.

5) Define which alerts are matched against which Alert Chain.
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Information included in alert notifications
The amount of information the alert notification includes depends on the Alert Notification used.

Table 41: Contents of escalated alerts

Alert notification Information included in the notification

Custom script Depends on the script you create.

Email Includes the full details of the alert, the full situation description, and the contents of all
hex viewable fields as a hexadecimal dump and ASCII.

SMS (text message) SMS messages sent using an external script are limited to one line in length, with no
character limit for that one line. SMS messages sent by SMTP and HTTP do not have
this limit.

The standard character limit for an SMS message is 160 characters. Only log fields that
fit into the notification message are selected, in the following order: Situation name,
Severity, source IP address, destination IP address, destination port, Sender, Logical
Interface, and the creation time of the alert.

SNMP Only log fields that fit into the notification message are selected, in the following order:
Situation name, Severity, source IP address, destination IP address, destination
port, Sender, Logical Interface, alert creation time, traffic recording excerpt, and the
application protocol.

Rule order in alert policies and alert chains
The system processes Alert Policies and Alert Chains from top down, so the order of the rules is important.

• In Alert Policies, rules must proceed from rules with the most limited scope to rules that are the most general.
• In Alert Chains, the order of the rules determines the order in which the alert notifications are sent.

Custom alert scripts for alert escalation
You can write a script that executes custom commands for alert escalation.

To send alert notifications using Custom Alert Scripts, you must define the Root Path on the Management
Server where custom alert scripts are executed. The default location is <installation directory>/data/
notification. All custom scripts must be stored in the same root path that is defined in the properties of the
Management Server that controls the Shared Domain.

The example notification script notify.bat in Windows and notify.sh in Linux can be edited for your own
use. In Linux, the sgadmin user needs read, write, and execute permissions in the script’s directory.

Creating Alert elements
You can use one of the predefined Alert elements or define a Custom Alert element.

There are three predefined Alert elements in the SMC:
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• The System Alert is reserved for alerts about the system operation.
• The Default Alert is a ready-made element that defines the alert that is triggered if no specific alert is triggered.
• The Test Alert is used in Alert Policies for testing Situations.

You can also define Custom Alert elements, which are useful if you want to configure different alert notifications
for different types of events. You can create Custom Alerts and create specialized handling rules for them in your
Alert Policy. System Events are automatically associated with the System Alert element.

Related tasks
Test alerts on page 394

Create Custom Alert elements
You can define your own custom Alert elements for more precise matching in the Alert Policy.

Defining custom Alert elements allows you to configure different alert notifications for different types of events
and write more specific alert messages. If you set up the Management Server to send SNMP traps when alerts
are triggered, you can define the SNMP code for the associated alert entries.

Alert entries are always triggered by an event, and information regarding the event is automatically included in
the alert entry. How much information is included depends on the type of Alert Notification.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Alert Configurations, then select New > Custom Alert.

3) Configure the settings, then click OK.

Next steps

If you edited a Custom Alert that is already used in an Alert Policy, refresh the Alert Policy on the Domain or
Domains.

Defining what triggers an alert
There are several different types of events that can trigger an alert.

The following events can trigger alerts:
• A warning or error in the operation of the SMC
• A test failure
• A match to a rule
• A threshold in a user alert check is exceeded
• A match to a pattern defined in a Situation element.

System Alerts and custom alerts are always triggered by an event in the system. In addition to the System Alerts
triggered by internal events in the SMC, you can configure the following events to trigger alerts:
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• You can configure a rule in your Firewall, Layer 2 Firewall, Layer 2 Interface, or IPS Policy to trigger an alert. .
• You can activate Status Surveillance on engines to trigger an alert when the Management Server does not

receive status updates for a while.
• You can configure the engine tester to issue an alert whenever a test fails (for example, when a network link

goes down). Some tests that run on the engine by default might already be configured to issue alerts.
• Server Pool Monitoring Agents can trigger alerts when they detect problems with the servers.
• You can set thresholds for user alert checks to trigger alerts when the threshold is reached.
• You can set thresholds for monitored items in Overviews to trigger alerts when the threshold is reached.

Related concepts
Getting started with the engine tester on page 649
Getting started with inbound traffic management on page 753

Related tasks
Set thresholds for monitored items in Overview elements on page 200
Enable or disable engine status monitoring on page 338
Define logging options for Access rules on page 875

Configure notifications for alerts
Alert Notifications are ways to send notifications to administrators.

By default, alert notifications are only sent to administrators through user notification in the Management Client.
You can also send alerts in the following ways:

• E-Mail — Alert notifications are sent as email using an SMTP server.
• SMS — Alert notifications are sent as an SMS text message over HTTP, using an SMTP server, or with a

script that forwards the message to a third-party tool (for example, gnokii). You can add multiple SMS Channel
Types. If the first SMS channel fails, the subsequent SMS channels are used in the order in which they are
listed.

• SNMP — The SNMP Trap Code specified in the custom alert is sent using an SNMP server.
• Custom Alert Scripts — Alerts are sent for processing to a script you create.

SMS messages sent by script are limited to one line in length. The maximum length of the SMS messages sent
by script depends on the third-party tool that is used in sending the messages. The standard character limit for
SMS messages is 160 characters. To use a script, install a third-party tool that forwards the SMS messages
(for example, gnokii) and the drivers for the tool on the same host. If the tool is not installed on the Management
Server host, configure the script for sending the alert notifications to access the tool remotely.

Note:  If you have installed a third-party tool, make sure that your Firewall Policy or Layer 2
Firewall Policy allows the traffic from the Management Server to the host.

If you want to send alerts in one or more of these ways, you must integrate external components, such as a GSM
modem or an SMTP server. This integration is done in the properties of the Management Server element. In an
environment with multiple Management Servers, you must define alert notifications for all Management Servers,
even if a Management Server does not currently control any Domains.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others > Management Server.

3) Right-click the active Management Server, then select Properties.

4) Click the Notifications tab, then configure one or more notification methods.

5) Click OK.

Alert Chain elements and how they work
Alert Chain elements define which notification channels are used to send alert notifications to administrators.

Alert Chains contain rows that are read from top to bottom. Alert Chains are used in Alert Policies. The Alert
Policy defines which Alerts trigger Alert Chains. You can also add delays between the notifications to give the
administrators time to respond.

The Final Action row determines what happens when all Alert Channels in the Alert Chain have been tried, but
none of the administrators have acknowledged the alert:

• The alert escalation can stop.
• The alert can be automatically acknowledged.
• The alert can be redirected to some other Alert Chain.
• The alert processing can return to the Alert Policy for further matching.

Create Alert Chain elements
Alert Chain elements specify how alert notifications are sent to administrators.

You can create multiple Alert Chains.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Alert Configurations > Alert Chains.

3) Right-click Alert Chains, then select New Alert Chain.

4) Configure the settings, then click OK.
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Result

The Alert Chain opens for editing.

Edit Alert Chain elements
Alert Chain elements are composed of rows ordered from top to bottom. Each row specifies a notification method
and a recipient.

You can only enter one recipient and one notification method per row. You must add more rows in the following
cases:
• You want to use the same notification method for more than one recipient.
• You want to use more than one notification method for the same recipient.

The Final Action row determines what happens when all Alert Channels in the Alert Chain have been tried, but
none of the Administrators have acknowledged the alert.

Tip:  It is not mandatory to add any rows to an Alert Chain. For example, you can use only the
Final Action to automatically acknowledge or stop the escalation of alert entries that the Alert
Policy directs to the chain.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Alert Configurations > Alert Chains.

3) Right-click an Alert Chain, then select Edit <name>.

4) Add a rule:
• In an empty Alert Chain, right-click the Final Action row, then select Rule > Add Rule.
• In an Alert Chain with existing rules, right-click a rule, then select Rule > Add Rule Before or Rule >

Add Rule After.

5) Select the Alert Channel.

6) Specify the Destination of the alert notification.
The destination information varies according to the selected alert channel.

7) (Recommended) Double-click the Threshold to Block cell, then set a limit for how many alerts the
designated recipient is sent.

8) (Mandatory for the Delay channel, optional for other channels) In the Delay cell, enter the number of
minutes before the next row of the alert chain is processed.

• The purpose of the delay is to give to the recipient of the notification enough time to acknowledge the
alert before the next notification is sent.

• If sending the notification through the selected channel fails, the delay entered here is ignored. If you
want to add delays that are always valid, add a row with Delay as the alert channel, then set the delay
on that row.
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9) Select the Final Action that the SMC takes if the last row of the Alert Chain is reached.

10) Click  Save.

Creating Alert Policy elements
Alert Policies determine the criteria for selecting which alerts generated by various sources are escalated to
which Alert Chains.

Firewalls, Layer 2 Firewalls, IPS engines, and SMC servers are possible sources for alerts. If Domain elements
have been configured, you can select a Domain as a Sender in an Alert Policy in the Shared Domain.

An Alert Policy contains rules for matching incoming alert entries. Alert entries that match an Alert Policy rule are
escalated to the Alert Chain defined in the rule. Make sure that your Alert Policies also escalate System Alerts. If
an alert entry does not match any rule in the Alert Policy, the alert entry is not escalated.

The fields in Alert Policy rules are explained in the following table.

Table 42: Alert Policy fields

Option Definition

ID A unique identifier for the rule. You cannot edit the ID.

Sender Allows you to limit the rule to match alerts entries generated by one or more particular
components.
NGFW Engines and SMC servers are possible senders for alerts. If Domain elements
have been configured in your system, a Domain can also be selected as a Sender in an
Alert Policy in the Shared Domain.

Alert and Situation Allows you to limit the rule to match alert entries that are based on one or more particular
Alert elements or Situation elements.

Time Allows you to limit the time of day and day of the week when the rule is active. For
example, you can send different notifications for weekends or nights.

Severity Allows you to limit the rule to match alert entries that have a Severity value within a
certain range.
For example, you can escalate only the most critical alerts using SMS notification, and
escalate the other alerts using email notification.

Chain Defines the Alert Chain that is used for escalating matching alert entries.

Comment
(Optional)

A comment for your own reference.

Rule Name Contains a rule tag that cannot be edited. You can optionally also add a name for the
rule, which is displayed alongside the rule tag.
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Create Alert Policy elements
Alert Policies specify Alert Chains and the Alerts that trigger them.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Alert Configurations > Alert Policies.

3) Right-click Alert Policies, then select New Alert Policy.

4) Configure the settings, then click OK.

Result

The Alert Policy opens for editing.

Edit Alert Policy rules
Alert Policy rule settings include the Alert Sender, the Alert and Situation, Time, and Severity.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Alert Configurations > Alert Policies.

3) Right-click an Alert Policy, then select Edit <name>.

4) Add a rule:
• In an empty Alert Policy, right-click the rule table, then select Rule > Add Rule.
• In an Alert Policy with existing rules, right-click a rule ID, then select Rule > Add Rule Before or Rule >

Add Rule After.

5) (Optional) Select the Alert Sender or keep the option Set to ANY.

6) (Optional) Specify the Alert and Situation that this rule matches.

7) (Optional) Double-click the Time cell, select when you want the rule to be applied, then click OK.

• If you do not specify a validity time, the rule is always applicable.
• The time is entered as UTC (GMT) time. You must calculate the effects of the time difference on your

local time. (UTC does not adjust for daylight savings time.)

8) (Optional) Double-click the Severity cell, then specify the Severity value or the range of Severity values
that this rule matches.
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• To define a single Severity value, select Severity, then one of the Severity options.
• If you want the rule to match a range of Severities, select Severity Range, then define the range in the

From and To lists.

9) Select which Alert Chain is processed when an alert event matches this rule.

10) Click  Save.

Install Alert Policy elements
Changes made to Alert Policies or the Alert Chains used by the Alert Policy take effect when you install the Alert
Policy on a Domain.

You can install the same Alert Policy on multiple Domains. In this case, you must install the Alert Policy from the
Shared Domain or from the Domain to which the Alert Policy belongs.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Alert Configurations > Alert Policies.

3) Right-click the Alert Policy, then select Install Policy.

4) Select the Domains on which you want to install the Alert Policy, then click Add.

5) Click OK.

Acknowledge active alerts
New alerts are handled as active alerts until they are acknowledged. To stop alert escalation, you acknowledge
active alerts.

When an SMC component generates an alert, it sends the alert to the Log Server. The Log Server stores the
alert entry. A new alert entry is handled as an active alert by the Management Server. A Domain’s active alerts
are visible when you are logged on to the Domain. Active alerts are stored on the Management Server until the
alerts are acknowledged. In an environment with multiple Management Servers, active alerts are automatically
replicated between the Management Servers.

Alert entries are displayed in the Active Alerts view and in the Logs view with other types of log entries. You can
also view alert entries in the Web Portal.

You can acknowledge alert entries in the Active Alerts view. When an alert entry is acknowledged, it is removed
from the Active Alerts view and from the Management Server. An audit entry is created when an alert is
acknowledged. All Alert Chain processing for that alert entry is stopped. You can acknowledge alerts one by one.
You can alternatively aggregate similar types of alerts as a group and acknowledge the whole group of alerts at
the same time.
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Note:  When you acknowledge an alert entry, alert escalation stops for that alert entry and no new
notifications are sent out from the Management Server to administrators.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Click  Active Alerts in the bottom right corner of the Management Client.
By default, the Active Alerts view opens with all active alerts aggregated by Situation.

 
Figure 75: Active Alerts view

2) Select one or more alert entries.
• To aggregate the alert entries by time or sender, select  Tools > Aggregate > Sort by Time or 

Tools > Aggregate > Aggregate by Sender.
• To view the individual alerts, select  Tools > Details.
• The Query pane allows you to filter the active alert entries so that you can find the information you need.

3) Right-click the selected alerts, then select Acknowledge.

Related concepts
Benefits of filtering log entries on page 250

How custom scripts for alert escalation
work

Before writing a custom alert script, review the following information about the command arguments and script file
location.

All custom scripts must be stored in the same root path that is defined in the properties of the Management
Server that controls all Domains.

The example notification script notify.bat in Windows and notify.sh in Linux can be edited for your own use. In
Linux, the sgadmin user needs read, write, and execute permissions in the script’s directory.

The alert information is given to the script as command arguments as described in the following table.
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Table 43: Arguments passed to the custom scripts

Argument
Number

Content Description

1 Alert ID The unique identifier for the alert.

2 Alert Name The name defined in the alert properties.

3 Alert
Originator

The IP address of the component that generated this alert.

4 Alert Date The date when the alert was originally generated.

5 Alert Message A short alert description.

6 Alert Severity The Severity value of the alert from 1–10, where 1 is the least severe and 10
is the most severe. The numeric Severity value corresponds to the following
Severity value in the generated alert: 1= Info, 2–4=Low, 5–7=High, and 8–
10=Critical.

7 Alert Short
Description

The contents of the Comment field in the alert properties.

8 Event ID IPS only: reference to the event ID that triggered the alert.

9 Situation
Description

Long description of the Situation that triggered the alert.

Alert scripts stored in the directory defined in the Management Server element’s properties can be called from
Alert Chains by their name.

When the alert script is executed, the output (stdout) is appended to the notify.out file in the script’s
directory. The error output (stderr) is appended to the notify.err file in the script’s directory. The Linux
script in the following illustration is an example of how to create an operating system log entry using the custom
script alert notification.

Example custom alert script

#!/bin/sh
# This script uses the ‘logger’ utility to create an operating system
# log entry of the alert notification.
PATH=/bin:/usr/bin

# Create log entry: “SMC Alert (<ALERT_ID>): Severity <SEVERITY> 
#    : <ALERT_NAME> : <ALERT_DESCRIPTION>”

/usr/bin/logger “SMC Alert ($1): Severity $6 : $2 : $5”

exit 0

Create SMTP Server elements
SMTP Server elements define the properties of SMTP servers that you can use, for example, to send email and
SMS notifications.

You can also use SMTP Server elements as the Source or Destination in a policy. SMTP Server elements can be
used in the properties Management Server elements for emailing Reports and sending alerts as email and SMS.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Alert escalation | 390

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Network Elements > Servers.

3) Right-click Servers, then select New > SMTP Server.

4) Configure the settings, then click OK.

Related tasks
Email reports on page 289

Use a script for SMS notification
You can use a script to send alert notification SMS messages through a third-party tool that forwards the SMS
messages to the administrators.

Before you begin
If there is a Firewall or a Layer 2 Firewall between the Management Server and the host on which the
tool for forwarding the SMS messages is installed, you must allow the traffic from the Management
Server to the host. Do this in the Firewall or Layer 2 Firewall Policy. You must install the tool that
forwards the SMS messages from the Management Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Install a third-party tool (for example, gnokii) to forward SMS messages and the drivers for the tool on the
host.
See the tool-specific instructions for information about configuring the tool.

2) In the Management Client, select  Home.

3) Browse to Others > Management Server.

4) Right-click the Management Server, select Properties, then click the Notifications tab.

5) Select Add > Script.

6) Define the following script properties:
• Name — The file name of the script.
• Script Path — The full path to the script that sends the SMS, or the relative path from the execution

directory.
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• Execution Path — The directory in which the script is executed. The execution log is stored in this
directory.

7) (Optional) Click Test if you want to test that the SMS messages are sent correctly.

8) Click OK.

9) Click OK in the Management Server properties to save the changes to the notifications.

SNMP for the SMC Appliance
SNMP traps and monitoring access can be configured to receive information about the health of the SMC
Appliance.

Using SNMP monitoring software or an SNMP station, the appliance can be polled for information about
available disk space, memory utilization, and running processes. Polling the appliance regularly helps you to
identify appliance events early, such as partitions becoming full or processes running hot. SNMP Traps can be
configured so that the appliance alerts the specified user or community.

Both SNMP 2c and 3 are supported. Configuring SNMP access to the SMC Appliance is done from the
Management Client. The list of available Net-SNMP common MIBs can be found in the /usr/share/snmp/mibs
directory. Visit http://www.net-snmp.org for MIB descriptions.

Note:  SNMP users and communities have read-only access to the appliance.

Related tasks
Configure SNMP for NGFW Engines

Related reference
SNMP traps and MIBs on page 1461

Create an SNMP Agent for SNMP version 1 or
2c
Configure an SNMP Agent for SNMP version 1 or 2c so that NGFW Engines can share network management
information using the SNMP protocol, or for SNMP version 2c so that the SMC Appliance can share network
management information using the SNMP protocol.

Note:  The SMC Appliance does not support SNMP v1.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

http://www.net-snmp.org
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2) Browse to Other Elements > Engine Properties > SNMP Agents.

3) Right-click SNMP Agents, then select New SNMP Agent.

4) In the Name field, enter a unique for the SNMP Agent.

5) From the Version drop-down list, select v1 or v2c.
For the SMC Appliance, you must select v2c.

6) (Optional) In the Monitoring section, click Add, then enter the community string.
The community string is used for authentication in monitoring.

7) (Optional) In the Listening Port field, enter the UDP port number that the SNMP agent listens to.

8) In the Contact field, enter the contact information for the person responsible for the NGFW Engines or the
SMC Appliance.

9) Click OK.

Create an SNMP Agent for SNMP version 3
Configure an SNMP Agent for SNMP version 3 so that NGFW Engines or the SMC Appliance can share network
management information using the SNMP protocol.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Engine Properties > SNMP Agents.

3) Right-click SNMP Agents, then select New SNMP Agent.

4) In the Name field, enter a unique for the SNMP Agent.

5) From the Version drop-down list, select v3.

6) In the User Names section, add one or more users names.

a) Click Add.

b) In the User Name field, enter the user name.

c) From the Protocol options, select the authentication protocol, then enter a password in the Password
field.

d) From the Privacy options, select the privacy protocol, then enter a password in the Privacy
Password field.
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7) (Optional) In the Monitoring section, click Add, then select the user for monitoring.

8) (Optional) In the Listening Port field, enter the UDP port number that the SNMP agent listens to.

9) In the Contact field, enter the contact information for the person responsible for the NGFW Engines or the
SMC Appliance.

10) Click OK.

Configure what triggers SNMP traps
The trap parameters define where and how SNMP traps are sent from NGFW Engines and the SMC Appliance.

The same SNMP Agent element can be used for NGFW Engines and the SMC Appliance. Some settings only
apply to NGFW Engines. Settings that are not supported for the SMC Appliance are ignored when the SNMP
Agent is used for the SMC Appliance.

In addition to the general events, the tester on each NGFW Engine can send SNMP traps when a test fails.

Note:  If the Destinations field is left empty, no traps are sent, and the other trap parameters are
ignored. If the Destinations field has a value, the rest of the trap parameters must also have a
value.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Engine Properties > SNMP Agents.

3) Open the SNMP Agent properties in one of the following ways:
• Right-click an existing SNMP Agent element, then select Properties.
• To create an SNMP Agent element, right-click SNMP Agents, then select New SNMP Agent.

4) In the Traps section, specify the sender of the SNMP trap.
• SNMPv1 — (NGFW Engines only) In the Community field, enter a community string.
• SNMPv2c — In the Community field, enter a community string.
• SNMPv3 — From the User Name drop-down list, select a user name.

5) Click Add, then enter the IP address and UDP port where the traps are sent.

6) (NGFW Engines only) In the Active Traps section, select the events for which you want to set a trap.

7) Click OK.
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Activate the SNMP agent for the SMC
Appliance
You can configure access for SNMP software or stations to gather data about the SMC Appliance.

Before you begin
Create and configure an SNMP Agent element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Global System Properties

2) Click the SNMP tab.

3) From the SNMP Agent drop-down list, select the SNMP Agent that you want to activate.

4) In the SNMP Location field, enter the string that is returned on queries to the SNMPv2-MIB or SNMPv2-
MIB-sysLocation object.

5) In the Listening IP Addresses field, add one or more IPv4 or IPv6 addresses.

6) (SNMPv3 only) In the SNMP Engine ID field, enter a unique identifier for the SMC Appliance.

7) Click OK.

Related tasks
Activate the SNMP agent on NGFW Engines on page 670

Test alerts
You can test the correct functioning of the alerts by sending a Test Alert.

Test Alerts have a severity value of Info and have their own specific Situation. Firewall, Layer 2 Firewall, and IPS
engines cannot send Test Alerts. The sender is always an SMC server, so it is not possible to test how alerts
from other components are handled using a Test Alert.

Note:  A Test Alert is escalated only if the Alert Policy rules match Test Alerts.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Alert escalation | 395

2) Browse to Alert Configurations > Alerts.

3) Right-click the alert to test, then select Test Alert.

4) Select the server that sends the alert, then click Select.

5) Verify that the alert entry appears in the Active Alerts view.

Related tasks
Acknowledge active alerts on page 387

Examples of alert escalation
These examples show some common uses for alert escalation, and general steps on how each example is
configured.

Example: disabling alert escalations for a
specific situation
You might want to disable alert escalations for a specified Situation, as shown in the following example.

The administrators at company A notice that the system issues an alert every time someone mistypes their
password when logging on using the Management Client. They have set up their IPS system to detect if there are
several failed logons within a short period (which could indicate malicious activity). For this reason, they decide
that they do not want to receive alert notifications about failed logons.

The administrators:

1) Create an Alert Chain and name it Auto-acknowledge.

2) Set the final action for the Auto-acknowledge Alert Chain to Acknowledge without adding any new rows.

3) Add the following new rule at the top of the Alert Policy:

Sender Alert and Situation Chain

ANY "Management Server: Login Failed" Situation Element "Auto-acknowledge" Alert Chain

4) Refresh the Alert Policy on the Shared Domain.

Alerts for failed logons are still generated and stored, but they do not trigger any alert notification and they are
never shown in the Active Alerts view. For example, reports can still include information about failed logon
attempts to highlight excessive logon failures.
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Example: escalating alerts to specific
administrators and sites
You can escalate alerts to specified locations and administrators, as shown in the following example.

Company B has two sites, a branch office (BO) and a headquarters (HQ) site, which both have their own
administrators. Both sites have a Firewall and a Log Server, and the shared Management Server is at the HQ
site. Domains are not used, so all elements are in the Shared Domain. The administrators decide to set up alert
escalation.

For the most severe alert entries, alerts are sent as an SMS text message to the shared mobile phone each site
has for the administrator on duty. If the administrator at one site does not acknowledge the alert entry within 15
minutes, the alert notification is sent to the administrator at the other site.

For less severe alert entries, the alerts are only escalated to the site where the alert entry is created. At first, the
less severe notifications are sent only through a User Notification in the Management Client. After an hour, the
alert notification is sent as an SMS text message to the shared mobile phone of the site where the alert entry is
created.

The administrators:

1) Create new Alert Chains for high-severity and low-severity alert entries for both the HQ and the BO sites.
There are four Alert Chains in total.
“HQ Important Alerts” contains the following rules:

Channel Destination Delay

SMS [Phone number for HQ shared mobile phone] 15 min

SMS [Phone number for BO shared mobile phone]

“HQ Minor Alerts” contains the following rules:

Channel Destination Delay

User Notification HQ Administrator A

HQ Administrator B

[other administrators]

60 min

SMS [Phone number for HQ shared mobile phone]

The “BO Important Alerts” and “BO Minor Alerts” Alert Chains are the same as the HQ Alert Chains, but with
the BO Administrators and a different phone number.

2) Create an Alert Policy with the following rules:

Sender Alert and Situation Severity Chain

HQ Firewall

HQ Log Server

Management Server

ANY High... Critical HQ Important Alerts

HQ Firewall

HQ Log Server

Management Server

ANY Info...Low HQ Minor Alerts
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Sender Alert and Situation Severity Chain

BO Firewall

BO Log Server

ANY High...Critical BO Important Alerts

BO Firewall

BO Log Server

ANY Info...Low BO Minor Alerts

3) Configure SMS Notification in the Management Server’s properties.

4) Install the new Alert Policy on the Shared Domain.
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Domain elements
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• Move elements between Domains on page 404
• View Domain status on page 406
• Delete a Domain on page 406
• Examples of Domain elements on page 407

Domain elements allow you to restrict which elements are displayed to the administrators in the Management Client
and in the optional Web Portal. They also allow you to define in which administrative Domains an administrator has
permissions. Configuring Domains requires a special license.

Getting started with Domain elements
Domain elements help you manage large networks and define administrator permissions.

In a large system, there can be different geographical sites that are managed by different administrators.
Typically, most of the administrators only manage SMC components at their own site. Only a few main
administrators are responsible for the overall system health across all sites. Domain elements allow you to
group elements that belong to specific configurations (for example, elements that belong to a particular site or
customer). The elements in different Domains are kept separate from each other.

The administrators’ rights within a Domain depend on the permissions defined in the administrator accounts. You
can grant access for an administrator to one or more Domains and define the permissions for each Domain in
fine detail.

How Domains can be configured
• Domain elements allow you to group elements that belong to specific configurations (for example, elements

that belong to a specific customer or site).
• You can use Domains to divide responsibilities between administrators, so that administrators only have

access to elements in specific Domains.
• You must have a special license to be able to configure Domain elements. The number of Domains that you

can create depends on the license.
• The ALL Domains Access Control List is a default Access Control List that you can use in administrator

accounts to grant access to all defined Domains.
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• The predefined Shared Domain is meant for all elements that do not belong to a particular customer or site.
All predefined system elements belong to the Shared Domain. If there is no Domain license in the SMC or no
Domains have yet been configured, all elements belong to the Shared Domain.

Shared Domain
• The elements in the Shared Domain are displayed to all administrators when they are logged on to any

Domain in the Management Client.
• Domains, Management Servers, Log Pruning Filters, and Administrator accounts with unrestricted

permissions are elements that automatically belong to the Shared Domain. You can only create these
elements in the Shared Domain, and you cannot move them to any other Domain.

• Licenses and update packages always belong to the Shared Domain.
• If you have Master NGFW Engine and Virtual NGFW Engine elements, the Master NGFW Engine must either

belong to the Shared Domain or to the same Domain as the Virtual NGFW Engines.

Related concepts
Configuration of Master NGFW Engines and Virtual NGFW Engines on page 515

How Domain elements work
Elements belong to one or more Domains. Administrator permissions in the Domain determine which elements
administrators can manage.

When Domains are used, each element automatically belongs to a Domain. An element can only belong to one
Domain at a time. By default, all elements belong to the Domain in which they are created. The Shared Domain
is meant for elements that are used in several Domains, for example, high-level policy templates. All predefined
system elements also automatically belong to the Shared Domain.

When administrators log on to a Domain, they can manage the elements in the Domain according to the
permissions granted for that specific Domain. Administrators can also view most elements that belong to the
Shared Domain even when they are not allowed to log on to the Shared Domain. However, the contents of the
elements are only displayed to administrators who have permission to view those elements’ contents. Elements
in the Shared Domain can only be edited from within the Shared Domain.

If there are existing elements when you first start using Domains, all existing elements belong to the Shared
Domain. You can move the elements to other Domains as necessary. In an environment with more than one
Management Server, you can also change the active Management Server that controls all Domains.

Using elements with administrative Domains
Each element automatically belongs to either the Domain in which it was created or to the Shared Domain. When
you create elements, first log on to the correct Domain and then create the elements so that the elements belong
to the right Domain.

You can freely decide to which Domain most elements belong, except for the following elements:

• Domains, Management Servers, Log Pruning Filters, and Administrator accounts with unrestricted
permissions are elements that automatically belong to the Shared Domain. You can only create these
elements in the Shared Domain, and you cannot move them to any other Domain.
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• Licenses and update packages always belong to the Shared Domain.
• The Management Server’s internal LDAP user database (the LDAP Domain element called InternalDomain).

Configure external LDAP servers in the Domains to create Domain-specific accounts for end-user
authentication.

• If you have Master NGFW Engine and Virtual NGFW Engine elements, the Master NGFW Engine must either
belong to the Shared Domain or to the same Domain as the Virtual NGFW Engines.

In addition, there are limitations for selecting the Domain for some elements that are closely associated with other
elements:

• A Log Server that is selected as the Log Server for a Management Server must belong to the Shared Domain.
• If a Log Server has a backup Log Server, both Log Servers must belong to the same Domain.
• A Log Server and the NGFW Engines that send their event data to the Log Server must be in the same

Domain.
• A Task and the target of the Task (for example, an Export Log Task and the target Log Servers) must be in

the same Domain. Otherwise, the Task cannot be run.
• By default, all elements used in a VPN must belong to the same Domain. You can also use some elements

that belong to the Shared Domain when you configure a VPN in another Domain. These elements include the
VPN Client gateway, Certificate Authorities, Gateway Certificates, Gateway Profiles, Gateway Settings, and
VPN Profiles.

Note:  The elements in the Shared Domain are displayed to all administrators when they are
logged on to any Domain in the Management Client.

Related concepts
How Categories help you view only certain elements on page 169

Create and modify Domain elements
Create Domain elements, for example, to group elements in different configurations and restrict administrator
permissions.

You can import and set a logo for each Domain.

Create Domain elements
Only administrators that have unrestricted permissions can create Domains.

Before you begin
To create or manage Domains, you must log on to the active Management Server.

You can create as many Domains as you need. Your Domain license defines how many Domains you can create.

A service break for the SMC is highly recommended when introducing Domains into the system, assigning the
existing elements to the correct Domains, and changing the administrator accounts.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Domain elements | 402

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Expand the Other Elements branch.

3) Right-click Domains and select New Domain.

4) Give the Domain a unique Name.

5) (Optional) Enter a Comment for your own reference.

6) (Optional) Fill in the E-mail Address and Phone Number fields with information that you want to be
displayed in the Domain Overview.
You can enter, for example, the information for the contact person at your company or the administrator
responsible for the Domain.

7) (Optional) Click Add and select the Categories to use in the Default Category Filter.

8) Click OK.

Related concepts
How Categories help you view only certain elements on page 169

Related tasks
Log on to a Domain on page 403
Move elements between Domains on page 404

Set a Domain logo
You can define a logo for each Domain. The Domain logo is displayed in the upper right corner of the
Management Client window and next to the Domain’s name in the Domain Overview. The Domain logo is also
displayed in the Web Portal.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Expand the Other Elements branch and click Domains.

3) Right-click the Domain and select Properties.

4) Click the Logo tab in the Domain Properties dialog box.

5) Select the logo option from the list:
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• Select None to remove a previously selected logo so that the Domain has no logo.
• Select a logo from the list or select Select and select a logo in the dialog box that opens.
• Select New to import a new logo.

6) Click OK.
The Logo tab shows a preview of the selected Logo.

7) Click OK.

Related tasks
Write announcements to Web Portal users on page 418

Import a Domain logo
Before you can associate a logo with a domain, you must import it.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Expand the Other Elements branch and click Domains.

3) Right-click the Domain and select Properties.

4) In the Logo Properties dialog box, enter a unique Name for the logo.

5) Click Browse and select the image (a .jpg, .gif, .png, .tif, .bmp, or .pnm file).

6) Click OK.
The Logo tab shows a preview of the selected Logo.

7) Click OK.

Log on to a Domain
If you only have permissions in a single Domain, you automatically log on to the Domain when you log on to the
Management Client. If you have permissions in more than one Domain, you must log on to the correct Domain
before managing elements that belong to the Domain.

You can be logged on to more than one Domain at the same time.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) To log on to a Domain at the same time as you log on to the Management Client, select or enter the server’s
IP address in the Server Address field, enter a forward (/) or backward (\) slash, and the name of the
Domain in the Management Client Logon dialog box.
For example, 192.168.200.31/Example Domain or 192.168.200.31\Example Domain.

Tip:  Select Remember Server Address to avoid entering the information when logging on in
future.

2) To log on to a Domain in the Domain Overview that opens automatically after you log on to the Management
Client, right-click the Domain, then select Log On to <Domain name>.
If the Domain Overview is not open, select  Menu > File > New Tab, then select Domain Overview.

3) To log on to a Domain from the Configuration view of the Management Client, follow these steps.

a) Select  Configuration, then browse to Administration.

b) Browse to Other Elements > Domains.

c) Right-click the Domain, then select Log On to <Domain name>.

Related tasks
Create Domain elements on page 401

Log off from all Domains
If you have permissions in more than one Domain, you can log off from all Domains through the Domain
Overview.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > File > New Tab, then select Domain Overview.

2) Select File > Log out from All.

Move elements between Domains
You can move most elements from one Domain to another.

You can move existing elements from one Domain to another. Only administrators with unrestricted permissions
can move elements between Domains. When you start moving elements from one Domain to another, the
Management Server automatically searches for element references. You can then either remove the references
between the elements or move the referred or referencing elements. In addition to individual elements, you can
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also move all elements associated with a Category. Using Categories can make moving elements easier if you
need to move many elements.

The following elements always belong to the Shared Domain and cannot be moved:

• Predefined system elements
• Domains
• Management Servers
• Licenses
• Update packages
• Log Pruning Filters.
• Administrator accounts with unrestricted permissions

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Log on to the Domain from which you want to move elements.

2) Select the elements that you want to move to another Domain.

Tip:  To hide elements that belong to the Shared Domain, select  Tools > Show Only
Current Domain.

3) Right-click one of the selected elements, then select Tools > Move to Domain.

4) Click Select next to the Target Domain field, then select a Domain.

5) Click Move.
The Management Server automatically searches for references to or from the selected elements in the
current Domain.
A new view opens and shows the reference status.

• If the element you are moving references another element, you must either remove the references or
move the referenced element as well.

6) If the Element References pane shows Referring or Referenced Elements, expand the branches to see
the referring or referenced elements and resolve the element references:
• If more detailed information is available for an element, double-click ... in the Details column next to the

element.
• If you also want to move the referring or referenced element, select the referring or referenced element,

then click Add.
• If you do not want to move the referring or referenced element, right-click the element, then edit it to

remove the references to the element that you are moving.

If you want to move a Host element that is used in a policy, but not the policy itself, remove the Host from the
policy before moving the Host to a different Domain.

7) If you have resolved a reference, click Refresh View to update the status of element references.

• You must resolve all element references before moving the selected elements.
• If the Element References pane is empty, there are no element references.
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8) Click Continue to move the elements to the selected Domain.

View Domain status
The Domain Overview allows you to see at a glance the status of the Domains and their elements. You do not
need to log on to each Domain to monitor its status.

The Domain Overview is available only to administrators who have permissions in more than one Domain. The
Domain Overview only shows information from the Domains in which the administrator has permissions. The
information in the Domain Overview depends on the administrator’s rights. The Domain Overview shows the
statuses of the elements and the number of alerts in each Domain. The Domain Overview also shows any other
information (for example, email addresses and telephone numbers) defined in the Domain properties.

Note:  The Domain Overview automatically opens when an administrator who has permissions in
more than one Domain logs on to the Management Client without specifying a Domain.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > File > New Tab, then select Domain Overview.

Related tasks
Log on to a Domain on page 403
Log off from all Domains on page 404

Delete a Domain
If you delete a Domain, all elements that belong to the Domain are also deleted.

If there are elements that you do not want to delete, move them to another Domain before deleting the Domain.
You cannot delete the predefined Shared Domain. Only administrators who have unrestricted permissions can
edit and delete Domains.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Expand the Other Elements branch and click Domains.

3) Right-click the Domain and select Delete.
A Confirmation dialog box opens.

4) If the Domain you are deleting is used in any configuration, click Open References in the Confirmation
dialog box to view the references. Right-click each element and select Edit to remove the references.
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5) Click Yes.
A Confirmation dialog box opens.

6) Type YES to confirm that you want to permanently delete the Domain.

Related tasks
Create Domain elements on page 401
Move elements between Domains on page 404

Examples of Domain elements
You might want to create a different Domain for each of your organization's customers or sites.

Example: Create Domain elements for different
customers
You can create a different Domain for each of your organization's customers, as shown in the following example.

Company A is a Managed Security Service Provider (MSSP) with many customers. The networks of different
customers must be kept separate. The administrators who manage the customer networks must only be allowed
to see the networks for which they are responsible. Most of the administrators only manage a single customer’s
network, but some of the administrators are responsible for several customers’ networks.

The administrator decides to use Domain elements to group the elements belonging to each customer and
to make it easier to manage the different customer networks. The administrator also decides to use Category
elements to tag the existing elements that are included in each Domain. As the user database information must
not be available across Domains, the administrator decides to use an external LDAP server in each Domain for
user authentication.

Company A’s administrator:

1) Arranges a service break with the customers before introducing Domains into the system.

2) Logs on to the Shared Domain and creates the following elements:
• A separate Domain element for each customer.
• The Administrator elements (the administrator accounts) for the administrators who manage several

customers’ networks in several Domains.
• A Category element for each customer’s elements.

3) Defines a default Category Filter that includes the customer-specific Category for each customer’s elements.

4) Logs on to each customer’s Domain and creates the Administrator elements (the administrator accounts) for
the administrators who manage only that particular customer’s network.

5) While logged on to each Domain, configures the elements for using an external LDAP server for
authenticating the users in the Domain and for storing the Domain’s user database.
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6) While logged on to the Shared Domain, moves all customer-specific elements from the Shared Domain to
the correct customer-specific Domain.
• To make it easier to move the elements, the administrator first selects the customer-specific Category and

then all elements that belong to the Category.

7) When all customers’ Domains and their elements have been configured and the service break is over, the
administrators for each customer company log on to the Management Client.
• The administrators who are responsible for a single customer’s networks automatically log on to the

Domain assigned to them when they log on to the Management Client. They only see the elements that
belong to their own configuration and the elements in the Shared Domain.

• The administrators who have permissions in several Domains must select the Domain when they have
logged on to the Management Client.

Example: Create Domain elements for different
sites
You can create a different Domain for each of your organization's sites, as shown in the following example.

Company B is a large enterprise planning a new system. The system includes 12 different sites, each of which
contains 10 networks. The administrators at each site only need to be able to see the networks at their own
sites. The headquarters administrator decides to use the Management Server’s internal LDAP user database for
user authentication in all Domains. This means that all administrators in each Domain are able to view the user
database information.

The headquarters administrator:

1) Logs on to the Shared Domain and creates Domains to represent each of the 12 sites.

2) Configures the user database and user authentication using the internal LDAP directory of the SMC while
logged on to the Shared Domain.

3) Logs on to each Domain that represents a site’s configuration and creates the elements for the Domain:
• The Administrator elements (the administrator accounts) for the administrators of each site.
• All other elements that belong to each Domain.

When the administrators at each site log on to the Management Client, they also automatically log on to the
Domain assigned to them. They only see the elements that belong to their own site’s configuration and also the
elements in the Shared Domain.
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Setting up the Web Portal
Contents

• Getting started with the Web Portal on page 409
• Define Web Portal Server settings on page 410
• Activate HTTPS on the Web Portal Server on page 411
• Change Access rules to allow Web Portal connections on page 412
• Create Web Portal User accounts on page 414
• Customizing the Web Portal on page 416
• Write announcements to Web Portal users on page 418

The Web Portal provides browser-based access to logs, reports, and Policy Snapshots for specific authorized users.
The Web Portal is provided by the Web Portal Server, which is an optional component that you can purchase for your
SMC.

Getting started with the Web Portal
Using the Web Portal, customers of managed service providers can access information about their systems.

Note:  You must have licenses for running a Web Portal Server and for creating Web Portal
Users.

What the Web Portal does
The Web Portal provides restricted clientless access to logs, reports, and Policy Snapshots. It is useful for
managed service providers for providing customers information about their systems. There is no software for end
users to install; they can access the information using a web browser.

Limitations of the Web Portal
If Domains are configured, each Web Portal User account is always restricted to working within a single Domain.
Administrators with full unrestricted accounts can select between domains after logging on to the portal if the Web
Portal Server element is in the Shared Domain.

In addition to the licensed limit for the number of user accounts, each Web Portal Server has a limit for the
maximum number of concurrent users.
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Web Portal configuration
The process of setting up a Web Portal consists of the following overall steps.

1) Define a Web Portal Server element.

2) If providing the Web Portal over HTTPS, generate a certificate for the server.

3) Allow the necessary connections in the Firewall Access rules.

4) Install the Web Portal Server. See the Forcepoint Next Generation Firewall Installation Guide for instructions.
• We recommend placing the Web Portal Server in a DMZ network if you offer access to external users.
• You must generate and install a license for the Web Portal Server.

5) Create Web Portal User accounts for the end users.
• The number of Web Portal users you can configure is limited by license. You must generate and install a

separate license for the Web Portal Users.
• Management Client administrator accounts are also valid in the Web Portal.

6) (Optional) Make installation-specific changes to your portal.

Define Web Portal Server settings
The Web Portal Server is a web server that offers end users access either through plain HTTP or through the
secure HTTPS protocol.

The Web Portal Server retrieves data from other SMC servers, filters it, and presents the resulting data to the
users.

CAUTION:  Always use HTTPS unless the connections are otherwise secured.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others.

3) Select  Tools > New > Server > Web Portal Server.

4) Enter a unique Name and the IP Address for the Web Portal Server.

5) Select the correct Location if necessary in your environment.

6) Select the Log Server to which you want the Web Portal Server to send its logs.

7) Switch to the Web Portal tab, then select Enable to activate the Web Portal.
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8) (Optional) Enter the Host Name that the Web Portal uses.

9) (Optional) Change the (TCP) Port Number that the service listens to.
By default, port 8080 is used.

Note:  Make sure that the listening port is not already in use on the server.

10) (Optional) If the Web Portal Server has several addresses and you want to restrict access to one address,
specify this address in Listen Only on Address.

11) (Optional) Activate HTTPS on the Web Portal Server to secure Web Portal connections.

12) (Optional) Select Generate Server Logs if you want log files to be generated on the file system when the
Web Portal is accessed.

13) (Optional) Select Use SSL for Session ID to track sessions to the Web Portal Server using SSL IDs.
Do not select the option if your network requires you to use cookies or URLs for session tracking.

14) (Optional) On the NAT tab, configure settings for element-based NAT.

15) Click OK.

Related concepts
Considerations for setting up system communications on page 127
Element-based NAT and how it works on page 645

Related tasks
Activate HTTPS on the Web Portal Server on page 411

Related reference
Security Management Center ports on page 1429

Activate HTTPS on the Web Portal
Server

To protect the transported information from eavesdropping, you can encrypt the communications by activating
HTTPS on the Web Portal Server.

If you secure the Web Portal connections using HTTPS, the Web Portal Server requires a certificate. You can
either self-sign the certificate directly in the dialog box or use an externally signed certificate:

• If you self-sign the certificate directly, web browsers display a warning to the users and require them to accept
the certificate. The certificate is valid for one year. Renewing is done by recreating the certificate in the same
way as a new certificate is created.
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• Alternatively, you can sign the certificate using an external certificate authority that the clients already trust. An
example would be one of the large commercial certificate authorities or a company-internal certificate authority
that all clients are configured to trust.

Certificates have a fixed validity time (from a certain date and time to a certain date and time). Make sure that
the date, time, and time zone settings are correct on both the Management Server and the Web Portal Server
computers. Clients also check the certificate validity, but incorrect time settings on the client computers typically
do not prevent the Web Portal from being used. Instead, browsers typically display a warning that users can
dismiss.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others > Web Portal Server.

3) Right-click the Web Portal Server, then sleect Properties.

4) On the Web Portal tab click Select next to the Server Certificate field.

5) Select a TLS Credentials element.

6) Click OK.

Change Access rules to allow Web
Portal connections

If Web Portal connections are routed through a firewall, you must change the IPv4 Access rules in your security
policy to allow them. Web Portal connections include connections to the Management Server and the Log Server
as well as end-user connections.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Allow the following connections in the IPv4 Access rules as needed:

Table 44: Access rules for the Web Portal Server

Source Destination Port/Service Action

Web Portal users’ networks (or hosts) Web Portal Server Port defined in the Web
Portal Server Properties
dialog box.

Allow

Web Portal Server Management Server SG Control
(8902-8913/TCP)

Allow

Web Portal Server Log Server SG Data Browsing (Web
Portal Server)
(8916-8917/TCP)

Allow

Note:  Remember to adjust the NAT rules as well if it is necessary in your network setup.
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Create Web Portal User accounts
The accounts for the optional Web Portal are defined with Web Portal User elements. It is highly recommended to
create a unique Web Portal User account for each Web Portal User.

 
Figure 76: Elements for Web Portal User accounts

• Engine elements define which logs, reports, or policy snapshots are displayed.
• Policies, sub-policies, and template policies define which parts of the Policy Snapshots are displayed.
• Report Designs define which reports are displayed. The Web Portal user is allowed to view all generated

reports that are based on the granted Report Designs.
• Filters define which logs are displayed. You can also add Filters that the Web Portal User can choose to apply

when browsing logs.

Web Portal Users can also use internal authentication or external RADIUS authentication.

If administrative Domains are used, there are some more considerations:

• Each Web Portal User account is limited to a single Domain.
• The Web Portal User is allowed to see all information in the Policy Snapshots from the granted engines. If

a policy’s template is in the Shared Domain, the Web Portal User can also see the rules inherited from the
template in the Policy Snapshot.

• The Web Portal Users might be allowed to view reports generated in the Shared Domain depending on their
granted elements.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Access Rights and select New > Web Portal User.

3) In the Name field, enter the user name that the Web Portal user uses to log on to the Web Portal.

4) To authenticate the Web Portal User locally with the firewall, select Local Authentication, then configure
the settings for local authentication.

a) To manually specify a password, enter and confirm the password in the Password field and the
Confirm Password field.

CAUTION:  We recommend that passwords be at least eight characters long and
contain a combination of numbers, letters, and special characters. Secure passwords
are never based on personal information such as names, birthdays, social ID numbers,
phone numbers, street names, or registration plate numbers.

b) To generate a random alphanumeric password, click Generate Password.

c) In the Account Expiration settings, define when the account expires.

5) To authenticate the Web Portal User with an external authentication server, select External
Authentication, then select the authentication method from the Authentication Method drop-down list.

6) Select engines from which the Web Portal User is allowed to view logs and Policy Snapshots.

a) Click the Engines tab.

b) To grant all engines to the Web Portal User, select Allow ANY.

Note:  If Domain elements have been configured, only the engines in the current
Domain are granted to the Web Portal user.

c) To select individual engines, click Add, then select the engines and click Select.

7) On the Policies tab, select the policies from which the Web Portal User is allowed to view Policy
Snapshots.
You can only select policies that are installed on engines granted to the Web Portal User. You can define
in detail which parts of the policies are shown in the Policy Snapshots.

8) On the Logs tab, select log browsing permissions for the Web Portal User.

9) On the Reports tab, select the kinds of reports that the Web Portal User can access.

10) Click OK.
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Customizing the Web Portal
You can customize the look of the Web Portal and change the languages in which the Web Portal is localized.

Add Web Portal languages
You can add new translations of the Web Portal interface labels in addition to the default languages offered.

When you edit the language files, save the file using the UTF-8 or the UTF-16 character encoding.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Other Elements > Web Portal Localizations.
A list of existing Web Portal Localizations opens.

3) Right-click the list and select New Web Portal Localization.

4) Click Import and browse to the location of the language file.
You are prompted to confirm the change of Locale.

5) Click Yes.
The contents of the imported language file are displayed in the dialog box.

6) Click OK to save the changes.

Enable or disable Web Portal languages
Web Portal Localization languages can be enabled or disabled through the Management Client.

Disabled Web Portal Localizations are marked with an icon.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Other Elements > Web Portal Localizations.
A list of existing Web Portal Localizations opens.

3) Right-click the Web Portal Localization and select Enable or Disable.
The language is shown or hidden in the Web Portal language selection options.
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Customizing the look of the Web Portal
The Web Portal pages presented to the users are generated dynamically based on configuration files.

The following aspects of the presentation can be adjusted:

• If you are using Domains, the icon in the Web Portal is sourced from the icon defined for the Domain in the
Management Client.

• You can add new languages.

It is possible to customize the Web Portal source files more extensively, but with some major limitations:

• Any changes to files are overwritten at upgrade.
• It might not be possible to reuse customized files after an upgrade. You might have to customize the

corresponding new files after the upgrade.
• Customization requires knowledge of HTML and CSS coding.

With these issues in mind, the following local files on the Web Portal Server control how content is shown to
users, and are fairly safe to edit:

• The CSS files are stored in <installation directory>/webserver/webapps/webclient/resources/css/.
• The page template files that are stored in <installation directory>/webserver/webapps/webclient/ as

several .jsp files.
• The help pages that are stored in <installation directory>/webserver/webapps/webclient/help/ as several .jsp

files.

Note:  We recommend that you create backups of the files before you edit them.

Related tasks
Set a Domain logo on page 402
Add Web Portal languages on page 416
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Write announcements to Web Portal
users

You can display announcements to the administrators who log on to the Web Portal. The announcements can be
used, for example, for service break notifications.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the properties of the correct element:

• Announcements in the Web Portal Server element are shown for all users that connect to that Web Portal
Server.

• Announcements in the Management Server properties are shown for all users.
• If administrative Domains have been configured, the announcements defined for the Domains are shown

to the users of that specific Domain. If in the Shared Domain, all users see the announcements.
• You can define an announcement in any combination of these elements. Each type of announcement

adds a bullet point for users who can view several announcements.

2) Switch to the Announcement tab.

3) Select Display Announcement to Web Portal Users, and enter the announcement in the field below.
The length is limited to 160 characters. You can add formatting to the announcement with standard HTML
tags (which are also included in the character count).

Tip:  If you deselect the Display Announcement to Web Portal Users option, you can later
display the announcement without typing it in again.

4) Click OK.
The announcement is displayed on the home page of the Web Portal (Services page) to affected users the
next time they load the page.

HTML code examples

Note:  If you leave out the protocol (HTTP:// or HTTPS:// part) from a URL, the protocol is
attached automatically based on the protocol the Web Portal Server is using. If the wrong protocol
is used, it can prevent an otherwise valid link from working.

• These tags produce <b>boldface</b> text.
• These tags produce <u>underlined</u> text.
• This text is displayed in the automatically added bullet point.

</li><li>But this text is displayed in a second bullet point underneath.
• Here is an internal <a href=”policies/policies.jsf”>link</a>.
• Here is an external <a href=”http://www.example.com”>link</a>.
• Here is a small image scaled to be roughly proportionate with the surrounding text:

<img height=”20px” src=”http://www.example.com/images/note_icon.jpg”>



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Setting up the Web Portal | 419



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Setting up the Web Portal | 420



Distributing Management Clients through Web Start | 421

 CHAPTER 24

Distributing Management Clients
through Web Start
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• Distribute Web Start from external servers on page 423
• Access the Web Start Management Clients on page 424

The Management Client can be distributed through Web Start. There is no need for each administrator to upgrade
their client when the SMC is upgraded to a new version. The version of the client must always match the version of the
Management Server.

Getting started with Web Start
distribution

Distributing Management Clients through Web Start allows users to log on to the Management Client through a
web browser.

What Web Start distribution does
The Management Server can be configured to serve a webpage for starting the Management Client. When the
SMC is upgraded, the Web Start files are also updated, and Web Start automatically downloads the updated
version when the user logs on. Alternatively, you can make the Management Clients available on some other
server, with the following limitations.

Limitations of Web Start distribution
The new version is available to Web Start users when the SMC is upgraded only if the Management Server is
used as the Web Start Server. If the Web Start package is on another server, delete the existing files and install a
new Web Start package after each upgrade. See Distribute Web Start from external servers.

When the Web Start package is installed on a network drive, the path must be the same for all administrators that
use that version of Web Start. If the network drive paths vary, you can put the package on a web server instead,
for example, in the intranet of your company.
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What do I need to know before I begin?
A current version of Java Runtime Environment (JRE) must be installed on each computer where you install the
Web Start. Download the JRE for free from http://www.java.com.

Related tasks
Distribute Web Start from external servers on page 423

Web Start distribution configuration overview
The process of setting up Web Start distribution consists of the following overall steps.

1) Enable Web Start access in one of the following ways depending on where users access the Web Start
logon:
• Enable Web Start access on the Management Server.
• Configure Web Start access on a separate web server or shared network drive.

2) Test the Web Start distribution.

Activate Web Start on the Management
Server

When you install the Management Server, the files needed for distributing the Management Clients are included
in the installation. You can simply enable Web Start access to these files on the Management Server.

A webpage is activated that administrators can load using a web browser to start the Management Client.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others > Management Server.

3) Right-click the Management Server, then select Properties.

4) Switch to the Web Start tab.

5) Select Enable.

6) (Optional) Enter the Host Name that the Web Start service uses.

http://www.java.com
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7) (Optional) Enter the (TCP) Port Number that the service listens to.
By default, the standard HTTP port 80 is used on Windows and 8080 on Linux (which does not allow using
reserved ports for this type of service).

Note:  Make sure that the listening port is not in use on the server. For ports reserved for
SMC services, see the appendix regarding Security Management Center ports.

8) (Optional) If the Management Server has several addresses, to restrict access to one address, specify the
IP address in the Listen Only on Address field.

9) (Optional) Select Generate Server Logs if you want to log all file load events for further analysis with
external web statistics software.

10) Click OK.

Related reference
Security Management Center ports on page 1429

Distribute Web Start from external
servers

You can use Web Start even if you do not want to use the Management Server as a Web Start Server. In this
case, you can put the Web Start package on any web server.

The Web Start package can also be put on a shared network drive. When the Web Start package is installed on a
network drive, the path must be the same for all administrators that use that version of Web Start.

Note:  You must delete the existing files and install a new Web Start package according to these
instructions each time you upgrade the SMC. Otherwise, any administrators that use Management
Clients that are installed through Web Start are not able to log on.

Steps

1) Browse to Forcepoint_SMC_Installer > Webstart on the installation DVD.

CAUTION:  The Web Start installation creates an index.html file. Any existing index.html file is
overwritten. We strongly recommend creating a directory for the Web Start files.

2) Copy all files and all directories from the Web Start directory on the installation DVD to where you want the
Web Start files to be served.

3) On the command line, change to the directory where the Web Start files are on your server.

4) Run the Web Start setup script.
Give the URL or the path of the directory where the Web Start files are on your server as the parameter.
• Windows: cscript webstart_setup.vbs <web start directory>
• Linux: ./webstart_setup.sh <web start directory>
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Table 45: Example Web Start paths

Installation on Example Web Start directory

Web server http://www.example.com/webstart/

Network drive file://localhost/C:/support/webstart/

5) If necessary, change the configuration of the web server to return the appropriate MIME type for .jnlp files
(application/x-java-jnlp-file).
See the manual of your web server for instructions on how to configure the MIME type.

6) Delete the webstart_setup.vbs and webstart_setup.sh script files from the directory.
For security reasons, do not have script files in the same directory as the generated Web Start files and other
shared client files.

Access the Web Start Management
Clients

After the Web Start package is installed, or the Management Server is enabled as a Web Start Server,
administrators can install the Management Client using Web Start.

Before you begin
There must be a current version of Java Runtime Environment (JRE) installed (the required version is
shown on the example logon page provided).

Note:  If Web Start access is required through the firewall, you must allow these connections in
your firewall’s policy. They are not allowed by default.

Steps

1) Enter the Web Start download page address in your web browser:
http://<server address>:<port>
The port is only needed if the server is configured to run on a different port from the HTTP standard port 80.

2) Click the link for the Web Start Management Client.
Web Start automatically checks if the version on the server is already installed on your local computer. If not,
the new client is automatically installed on your computer. This check is done each time the client is started
this way, automatically upgrading your client installation without any action from you.

The client starts and displays the logon dialog box.

3) Log on with your account credentials.
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Configuring the Log Server
Contents

• Modify Log Server elements on page 425
• Select backup Log Servers for high availability on page 426
• Forwarding log data from Log Servers to external hosts on page 427
• Edit Log Server configuration parameters on page 432
• Certify Log Servers on page 434

You can modify a Log Server element, configure settings for Log Servers, and recertify Log Servers.

Modify Log Server elements
One Log Server element is automatically created during SMC installation. You can change the settings as
necessary.

You can:

• Rename the Log Server element.
• Change the Log Server’s IP address.
• Change the platform on which the Log Server runs.
• Define other Log Servers that you can use as backup Log Servers.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others > Log Server.

3) Right-click the Log Server, then select Properties.

4) Change the Log Server properties.

Note:  We recommend that you always use the default port 3020 if possible. To use a non-
standard port, manually add Access rules to allow communications using the new port from
the NGFW Engines to the Log Server.

Note:  Be careful when excluding Log Servers from reporting. If you select this setting for a
Log Server that is in use, there is no warning that generated reports are missing data.

5) Click OK.
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Related concepts
Define contact IP addresses on page 129
Getting started with reports on page 269
Element-based NAT and how it works on page 645

Related tasks
Create Location elements on page 129

Select backup Log Servers for high
availability

You can select one or more backup Log Servers for each Log Server for high availability.

Before you begin
You must already have more than one Log Server.

The same Log Server can simultaneously be the main Log Server for some components and a backup Log
Server for components that primarily use another Log Server. You can also set Log Servers to be backup Log
Servers for each other so that whenever one goes down, the other Log Server is used.

Note:  The SMC Appliance does not support high availability for the Management Server or the
Log Server.

If Domain elements have been configured, a Log Server and its backup Log Server or Log Servers must belong
to the same Domain.

CAUTION:  If the log volumes are high, make sure that the backup Log Server can handle the
traffic load in failover situations.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others > Log Server.

3) Right-click the Log Server for which you want to select a backup Log Server, then select Properties.

4) Click the High Availability tab.

5) Click Add.
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6) Select one or more Log Servers, then click Select.

7) Click OK.

Related concepts
Log Servers for HA on page 438

Forwarding log data from Log Servers to
external hosts

You can forward log data from Log Servers to external hosts to back up the data or to process the data in an
external system.

You can define which type of log data you want to forward and in which format. You can also use Local Filter
elements to specify in detail which log data is forwarded.

Log data does not need to be stored on the Log Server to be sent to the external host. If log pruning is applied,
any log data that the Immediate Discard log pruning filters delete is not forwarded to the external host.

Add log forwarding rules to Log Servers
Add log forwarding rules to the Log Server to enable log forwarding.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others > Log Server.

3) Right-click the Log Server from which you want to forward log data, then select Properties.

4) Click the Log Forwarding tab.

5) To create a rule, click Add.

Tip:  To remove a rule, select the rule, then click Remove.

6) In the select Target Host cell, select the external host to which the log data is forwarded.

a) Double-click the Target Host cell.

b) Select a Host element.

c) Click Select.
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7) To add a rule, click Add.

8) Configure the log forwarding rules.

9) Click OK.

Enable TLS protection for log or audit data
forwarding
You can optionally enable TLS protection for log or audit data forwarding to an external syslog server.

Before you begin
Because there is a connection to an external system, public key infrastructure (PKI) integration,
including certificate revocation list (CRL) checking, must already be configured.

Optionally, you can check the identity of an external syslog server to secure the TLS-protected traffic from the
Log Server or the Management Server to the syslog server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others > Log Server or Others > Management Server.

3) Right-click the Log Server or Management Server from which you want to forward log or audit data, then
select Properties.

4) Click the Log Forwarding or Audit Forwarding tab.

5) To add a rule, click Add.

6) In the select Target Host cell, select the external host to which the log or audit data is forwarded.

a) Double-click the Target Host cell.

b) Select a Host element.

c) Click Select.

7) In the Service cell, select TCP with TLS.

8) In the Port, Format, Data Type (Log Server only), and Filter cells, select the settings according to your
needs.
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9) In the TLS Profile cell, select the TLS profile for TLS-protected log data forwarding.

a) Double-click the TLS Profile cell.

b) Select a TLS Profile element.

c) Click Select.

10) (Optional) Double-click the TSL Server Identity cell and define the TLS server identity in order to check
the identity of the TLS server to secure the TLS-protected traffic from the Log Server or the Management
Server.

11) Define the Log Server or Management Server TLS certificate options.
This certificate is used as the client certificate when connecting to the external syslog server.
• To use the server's internal certificate, select Use Internal Certificate.
• To use the certificate contained in a TLS Credentials element, select Use Imported Certificate, then

click Select.
Select a TLS Credentials element.

• To leave the server's certificate unauthenticated, select No Client Authentication.

12) Click OK.

Enable logging for monitored traffic
To generate log data that can be forwarded to an external host, you must enable logging for the traffic that you
want to monitor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand Policies, then browse to the type of policy you want to edit.

3) Right-click the policy and select Edit <policy type>.

4) Click the IPv4 Access or IPv6 Access tab, then edit the rule that allows the traffic that you want to
monitor.
If there is no Access rule for the traffic that you want to monitor, create the Access rule.

5) Double-click the Logging cell.

6) Select Override Collected Values Set With “Continue” Rules.

7) From the Log Level drop-down list, select Stored or Essential.

8) (Optional) If you want to forward logs using the NetFlow or IPFIX format, select Log Accounting
Information in the Connection Closing drop-down list.
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9) Click OK.

10) Save and install the policy to start using the new configuration.

Related concepts
Getting started with Access rules on page 817

Define general syslog settings
You can adjust general log forwarding settings by editing the LogServerConfiguration.txt. Adjusting these settings
is optional.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Stop the Log Server:
• If you run the Log Server as a service in Windows, you can stop it in the Windows Control Panel’s

Services list.
• In Linux, run the script <installation directory>/bin/sgStopLogSrv.sh.

2) Create a text file on the Log Server that lists the fields to forward in the correct order.
See Knowledge Base article 10010 for more information.

Tip:  The <installation directory>/data/fields/syslog_templates/ directory contains example
configuration files.

https://support.forcepoint.com/KBArticle?id=How-to-define-log-fields-included-in-logs-forwarded-by-SMC
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3) Change the parameters in LogServerConfiguration.txt.
The file is located in <installation directory>/data/.

Table 46: Log Server configuration

Parameter Value Description

SYSLOG_CONF_FILE <File name> Path to the file you created in Step
2, which defines the fields that are
forwarded and their order.

SYSLOG_MESSAGE_PRIORITY 0–191 a The priority of the syslog message is
included at the beginning of each UDP
packet (the default is 6).

a) As defined in RFC 3164
(http://www.ietf.org/rfc.html).

SYSLOG_USE_DELIMITER ALWAYS_EXCEPT_NULL

NEVER

ALWAYS

Defines whether to use double quotes
(“) in syslog messages to delimit the field
values.

The default setting
“ALWAYS_EXCEPT_NULL” uses
double quotes only for non-empty fields.
“NEVER” does not use delimiters.
“ALWAYS” uses double quotes as
delimiters for all empty and non-empty
field values.

4) Save the file and restart the Log Server.

Related concepts
Log entry fields on page 1473

Related reference
Syslog entries on page 1508

Add Access rules allowing traffic from Log
Servers to external hosts
If the external host and Log Server are separated by a Firewall or Layer 2 Firewall, you must add rules to allow
traffic from the Log Server to the host.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

http://www.ietf.org/rfc.html
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2) Expand Policies, then browse to the type of policy you want to edit.

3) Right-click the policy, then select Edit Firewall Policy or Edit Layer 2 Firewall Policy.

4) Click the IPv4 Access or IPv6 Access tab, then add an Access rule with the following values:
• Source — Log Server
• Destination — Host element
• Service — Syslog (UDP), Syslog (TCP), or NetFlow (UDP), depending on the protocol used. For TLS-

protected traffic, select TCP with TLS.

The same Service and Port that was selected in the Log Forwarding rule must be selected here.
• Action — Allow
• Logging — None (recommended in most cases)

Note:  Logging the log forwarding can create a loop where the log forwarding creates a
log entry each time. If you want to log the log forwarding, create a local filter in the Log
Forwarding rule to exclude logs related to forwarding.

5) Save and install the policy to start using the new configuration.

Edit Log Server configuration
parameters

To configure the Log Server in detail, you can edit LogServerConfiguration.txt. Normally, it is not necessary to
configure the Log Server outside of the Management Client. However, under special circumstances, you might
want more control over the way the Log Server behaves.

Steps

1) Stop the Log Server:
• If you run the Log Server as a service in Windows, you can stop it in the Windows Control Panel’s

Services list.
• In Linux, run the script <installation directory>/bin/sgStopLogSrv.sh.

2) On the Log Server, browse to <installation directory>/data/, then open LogServerConfiguration.txt in a text
editor.

3) Change the parameter values, then save the file.

4) Restart the Log Server.

Related reference
Log Server configuration parameters on page 433
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Log Server configuration parameters
Not all parameters are included in the default configuration file. Some parameters might have to be added
manually.

Table 47: Log Server configuration parameters in LogServerConfiguration.txt

Parameter name Description

ARCHIVE_DIR_0 Directory that is used for storing the logs archived by the Log Data tasks. By default,
ARCHIVE_DIR_0=${SG_ROOT_DIR}/data/archive.
You can define up to 32 directories: ARCHIVE_DIR_0 … ARCHIVE_DIR_31.

AUDIT_ARCHIVE_DIR Directory used for archiving audit logs. By default, ${SG_ROOT_DIR}/data/audit/
archive.

AUDIT_DISK_LIMIT The threshold for minimum available disk space for audit logs. If the free disk space
goes below this limit, the Log Server stops storing audit logs.

AUDIT_LOG_DIR Directory used for audit logs. By default, ${SG_ROOT_DIR}/data/audit/log.

DISK_THRESHOLD_IN_KBYTES The threshold for minimum available disk space (in kilobytes). If the free disk space
goes below this limit, the Log Server stops storing log records (100000 by default).

LOG_BACKUP_DIR Directory used for Log Server backup files. By default, ${SG_ROOT_DIR}/backups.
The backup files must be moved to a separate media after creating a backup.

LOG_EXPORT_DIR Directory used for storing the files exported by Log Data tasks. By default,
${SG_ROOT_DIR}/data/export.

LOG_FW_PORT Log Server port that listens for connections from the NGFW Engines (3020 by default).
Changing this value requires reinstalling the Log Server software.

LOG_LOGFILE_DIR Directory used for storing the logfile.txt that logs the task scheduler operations. By
default, ${SG_ROOT_DIR}/data.

LOG_QUERY_TIMEOUT Timeout (in milliseconds) for queries in the Logs view (30000 by default).

LOG_SCRIPT_DIR Directory for the scripts used in Log Data tasks. By default, ${SG_ROOT_DIR}/data/
script.

LOG_SERVER_ADD IP address of the Log Server. Changing this value requires reinstalling the Log Server
software.

MGT_SERVER_ADD IP address of the Management Server. Do not change this parameter value directly to
the file. Instead, use the sgChangeMgtIPOnLogSrv.bat (or .sh) script to change this
parameter value.

NETFLOW_RECEPTION_PORT The UDP port for receiving NetFlow data. If this parameter has not been defined, the
default port (2055 for both Windows and Linux) is used.

Note:  In Linux, the value of this parameter must always be higher than
1024.

PHY_LOC Log Server database location. By default, ${SG_ROOT_DIR}/data/db/logserver.

PHY_PORT Log Server database port that the Log Server connects to (1314 by default).

SNMP_COMMUNITY SNMP community string used for sending SNMP messages from the Log Server (public
by default).

SNMP_ENTERPRISE_OID SNMP Enterprise Object Identifier (OID) used for SNMP messages sent from the Log
Server (.1.3.6.1.4.1.1369 by default).
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Parameter name Description

SNMP_TRAP_RECEPTION_PORT Defines the port used for receiving SNMP traps. The default port is UDP 162 in
Windows and UDP 5162 in Linux.

Note:  Only the reception of SNMPv1 traps is supported.

SYSLOG_CONF_FILE Configuration file for syslog data. By default, the file is stored in ${SG_ROOT_DIR}/
data/fields/syslog_templates.

SYSLOG_MESSAGE_PRIORITY The priority (0–191) of the syslog message is included at the beginning of each UDP
packet (the default is 6). See RFC 3164.

SYSLOG_RECEPTION_PORT The UDP port for receiving syslog. If this parameter has not been defined, the default
port (514 for Windows or 5514 for Linux) is used.

Note:  In Linux, the value of this parameter must always be higher than
1024.

SYSLOG_RECEPTION_TCP_PORT The TCP port for receiving syslog. If this parameter has not been defined, the UDP
default port (514 for Windows and 5514 for Linux) is used.

Note:  In Linux, the value of this parameter must always be higher than
1024.

SYSLOG_USE_DELIMITER Defines whether to use double quotes (“) in syslog messages to delimit the field values.
The default setting ALWAYS_EXCEPT_NULL uses double quotes only for nonempty
fields. NEVER does not use delimiters. ALWAYS uses double quotes as delimiters for all
empty and nonempty field values.

Certify Log Servers
If the Log Server was not certified during the installation or if it needs a new certificate, certify the Log Server
manually.

Steps

1) Stop the Log Server:
• If the Log Server is installed as a service in Windows, stop it in the Windows Control Panel’s Services

list.
• In Linux, run the script <installation directory>/bin/sgStopLogSrv.sh.

2) Request the certificate:
• In Windows, run the script <installation directory>/bin/sgCertifyLogSrv.bat.
• In Linux, run the script <installation directory>/bin/sgCertifyLogSrv.sh.

3) Enter the credentials for an administrator account with unrestricted permissions.

4) If administrative Domains are configured and the Log Server does not belong to the Shared Domain, enter
the name of the Domain.
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5) Wait for the certification to finish and start the Log Server again.
• In Windows, start it in the Windows Control Panel’s Services list.
• In Linux, run the script <installation directory>/bin/sgStartLogSrv.sh.
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 CHAPTER 26

Configuring SMC servers for high
availability

Contents

• Using additional SMC servers for high availability on page 437
• Management Server HA configuration overview on page 438
• Log Server HA configuration overview on page 442
• Manage HA Management Servers on page 445

You can install several Management Servers and Log Servers to provide high availability for the SMC.

Note:  The SMC Appliance does not support high availability for the Management Server or the Log
Server.

Using additional SMC servers for high
availability

You can install additional Management Servers and Log Servers for high availability.

The high availability (HA) solution includes automatic incremental replication of the configuration data stored on
the Management Server. This way, manual intervention is minimized, and the SMC can be fully managed and
monitored without manually reinstalling and restoring a backup.

A Management Server and a Log Server are required for configuration changes to and system monitoring
of engines. Although engines work independently without the SMC according to their installed configuration,
configuration changes and system monitoring are not possible without a Management Server and Log Server.
The Management Server in particular is a critical component, as it is the only place where the full configuration
information is stored.

Management Servers for HA
When a Management Server is active, the Management Server has control of all Domains and can be used for
configuring and managing the SMC. Only one Management Server at a time can be the active Management
Server.

The changes made on the active Management Server are replicated incrementally to the other Management
Servers: only the changed parts of the management database are replicated, and the replication takes place in
real time.

To use additional Management Servers, you must have a special Management Server license that includes the
high availability feature. The license is a combined license for all Management Servers and it must list the IP
addresses of all Management Servers.
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Additional Management Servers automatically replicate the configuration data on the active Management Server.
If the active Management Server becomes unusable, you must manually activate another Management Server,
which allows you to work normally.

Note:  The additional Management Servers are meant for backup and disaster recovery purposes.
Only one Management Server at a time can be used for configuring and managing the SMC.

Log Servers for HA
Installing additional Log Servers ensures that system monitoring continues if one Log Server fails.

CAUTION:  The logs are not copied between the Log Servers. To back up log data, set up an
Archive Log Task to copy log data from the Log Server to some other location.

Alert escalation proceeds normally, new logs can be browsed, and the engine status and statistics can be
examined. However, the log data is not automatically replicated between the Log Servers, so some log data is
always unavailable during outages. We recommend that you select the same Log Server for all engines in the
same location. If different engines send events to different Log Servers, it is not possible to correlate events, as
none of the Log Servers see all events.

Any Log Server can be used both as the main Log Server for some components and as a backup Log Server for
one or more other Log Servers. However, consider the load of the Log Servers before you set up a Log Server as
a backup Log Server, to avoid overloading when failover occurs.

You can set up additional Log Servers with normal Log Server licenses. A separate license for each Log Server is
required, even if the Log Server is used only as a backup.

You can install a new Log Server that works as a backup for another Log Server. You can also set existing Log
Servers to be used as backups for another Log Server.

Management Server HA configuration
overview

Configuring additional Management Servers requires the following overall steps.

1) Create elements for the additional Management Servers.

2) License the additional Management Servers.

3) Allow communications to the new Management Servers through firewalls as necessary.

4) Install the Management Server software on the target servers.
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Create additional Management Server elements
Any new Management Server elements you add to an existing SMC are considered to be additional Management
Servers. You can set up several additional Management Servers.

The number of additional Management Servers you can create depends on the Management Server license.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others.

3) Select  Tools > New > Server > Management Server.

4) Enter a unique Name and IP Address.

5) (Optional) If NAT is used to translate addresses in communications between this server and other SMC
components, define the Location and Contact Address.

6) Select the Log Server to which the Management Server sends its logs.

7) If you use a RADIUS server for authenticating administrators, select the RADIUS Method that is used in the
authentication.

8) (Optional) If you want to send alert notifications or reports from the Management Server, switch to the
Notifications tab.
• If you want to send alerts by email, as SMS text messages, through a custom script, or as SNMP traps,

define the alert channels.
• You can use an SMTP server to send generated reports directly from the Management Server. Select the

SMTP Server or create an SMTP Server element.

Enter the Sender Address that is shown as the email sender. Remember to allow these connections in
the Firewall Policy if necessary.

9) Click OK.

Related concepts
Define contact IP addresses on page 129

Related tasks
Create Location elements on page 129
Email reports on page 289
Authenticate administrators using RADIUS or TACACS+ methods on page 368
Configure notifications for alerts on page 382
Create SMTP Server elements on page 389
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Install licenses for additional Management
Servers
Using additional Management Servers requires a special combined license that lists the IP addresses of all
Management Servers within the same SMC.

After receiving the proof-of-license (POL) code, generate the license at https://stonesoftlicenses.forcepoint.com.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Install Licenses.

2) Browse to the license file on your local workstation and click Install.

3) Select  Configuration, then browse to Administration.

4) Browse to Licenses > Unlicensed Components > Servers and make sure that the additional Management
Server is not listed there.
If the server is listed, check that the IP address information is the same in the license and the additional
Management Server element.

Related tasks
Generate licenses on page 1308

Access rules for additional Management
Servers
The Firewall Template policy contains rules that allow connections between the Firewall and all SMC servers. If
other components connect through a Firewall to additional Management Servers, add rules that allow this traffic.

You might also have to add NAT rules.

The rules in the Firewall Template policy are IPv4 Access rules that allow the system communications.

Related concepts
Getting started with Access rules on page 817

Related reference
Security Management Center ports on page 1429
Forcepoint NGFW Engine ports on page 1432

https://stonesoftlicenses.forcepoint.com
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Install additional Management Server software
Additional Management Servers are installed using the SMC Installation Wizard.

Before you begin
To install the software, you need the SMC installation files.

Steps

1) Start the installation in one of the following ways:
• From a .zip file: unzip the file and run setup.exe on Windows or setup.sh on Linux.
• From a DVD: insert the installation DVD and run the setup executable from the DVD:

Operating System Path to Executable

Windows 64-bit \Forcepoint_SMC_Installer\Windows-x64\setup.exe

Linux 32-bit /Forcepoint_SMC_Installer/Linux/setup.sh

Linux 64-bit /Forcepoint_SMC_Installer/Linux-x64/setup.sh

Note:  If the DVD is not automatically mounted in Linux, mount the DVD with the following
command: mount /dev/cdrom /mnt/cdrom

2) Proceed according to instructions in the Installation Wizard until you are prompted to select which
components you want to install.

Note:  If you install the SMC in C:\Program Files\Forcepoint\SMC, the installation creates
an extra C:\ProgramData\Forcepoint\SMC folder, which duplicates some of the folders in
the installation directory. Some of the program data is also stored in the C:\ProgramData
\Forcepoint\SMC folder.

3) If you also want to install a Log Server and a local Management Client on this computer, leave Typical
selected and click Next. Otherwise, select Custom, select the components you want to install and click
Next.

4) Select the IP address of the Management Server from the list or type it in.

Note:  This IP address must be the IP address defined for the corresponding Management
Server element.

5) Type in the IP address of the Log Server for sending alerts.

6) Select Install as an Additional Management Server for High Availability.

7) Click Next and follow the instructions to start the installation.
A logon prompt for replication opens.
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8) Log on using an unrestricted administrator account.
The Management Server Selection dialog box opens.

9) Select the correct Management Server from the list and click OK.
The databases are synchronized.

Note:  If the synchronization fails for some reason (such as a network connection problem),
run the sgOnlineReplication script on the additional Management Server when connectivity is
restored.

Tip:  You can view replication information in the Info pane when you select the Management
Server.

Related tasks
Obtain SMC installation files on page 1317

Log Server HA configuration overview
Configuring additional Log Servers requires several high-level steps.

1) Add an element for the additional Log Server.

2) License the additional Log Server.

3) Define the Log Server as a backup Log Server for another Log Server.

4) Make sure the communications between SMC components and the additional Log Server are allowed.

5) Install the Log Server software on the target server.

CAUTION:  The logs are not copied between the Log Servers. To back up log data, set up an
Archive Log Task to copy log data from the Log Server to some other location.

Create additional Log Server elements
You can set up several backup Log Servers for each Log Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others.
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3) Select  Tools > New > Server > Log Server.

4) Enter a unique Name and IP Address.

5) (Optional) If NAT is used to translate addresses in communications between this server and other SMC
components, define the Location and Contact Address.

6) (Optional) Change the Log Server’s TCP Port number if necessary. We recommend always using the default
port 3020 if possible.

Note:  If you use a non-standard port, add rules to allow communications from the engines to
the Log Server ports, even when using the Firewall Template policy.

7) (Optional) Select Exclude from Log Browsing, Statistics and Reporting if you do not want the Log Server
to gather statistical information for monitoring and reports. A scenario for using this option is if the Log Server
is not used for daily operations.

Related concepts
Define contact IP addresses on page 129

Related tasks
Create Location elements on page 129

Install licenses for additional Log Servers
Each Log Server requires a separate license, even if it is only used as a backup for some other Log Server.

After receiving the proof-of-license (POL) code, generate the license at https://stonesoftlicenses.forcepoint.com.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Install Licenses.

2) Browse to the license file on your local workstation and click Install.

3) Select  Configuration, then browse to Administration.

4) Browse to Licenses > Unlicensed Components > Servers and make sure that the additional Log Server is
not listed there.
If the server is listed, check that the IP address information is the same in the license and the additional Log
Server element.

Related tasks
Generate licenses on page 1308

https://stonesoftlicenses.forcepoint.com
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Access rules for additional Log Servers
The Firewall Template policy contains rules that allow connections between the Firewall and all SMC servers. If
other components connect through a Firewall to additional Log Servers, add rules that allow this traffic.

You might also have to add NAT rules.

The rules in the Firewall Template are IPv4 Access rules that allow the system communications.

Related concepts
Getting started with Access rules on page 817

Related reference
Security Management Center ports on page 1429
Forcepoint NGFW Engine ports on page 1432

Install additional Log Server software
Additional Log Servers are installed using the SMC Installation Wizard.

Before you begin
To install the software, you need the SMC installation files.

Steps

1) Start the installation in one of the following ways:
• From a .zip file: unzip the file and run setup.exe on Windows or setup.sh on Linux.
• From a DVD: insert the installation DVD and run the setup executable from the DVD:

Operating System Path to Executable

Windows 64-bit \Forcepoint_SMC_Installer\Windows-x64\setup.exe

Linux 32-bit /Forcepoint_SMC_Installer/Linux/setup.sh

Linux 64-bit /Forcepoint_SMC_Installer/Linux-x64/setup.sh

Note:
If the DVD is not automatically mounted in Linux, mount the DVD with the following
command:

mount /dev/cdrom /mnt/cdrom

2) Proceed according to instructions in the Installation Wizard until you are prompted to select which
components you want to install.

3) Select Custom, then select Log Server.
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4) Finish the installation according to instructions in the Installation Wizard.
You must certify the Log Server before the Log Server can connect to the Management Server.

Result

The additional Log Server is now installed and shown in green (Online) in the Home view.

Related tasks
Obtain SMC installation files on page 1317

Manage HA Management Servers
When multiple Management Servers are configured, one Management Server is defined as active. You can
manually change the active Management Server.

You can also disable database replication and synchronization for selected Management Servers.

Set the active Management Server
When a Management Server is the active Management Server, it has full control of all Domains. When you switch
to a different Management Server, you must manually change the active Management Server.

Setting a Management Server to standby releases full control of all Domains. Another Management Server can
take full control of all Domains and become the new active Management Server.

The engines continue to operate normally even when no Management Server is reachable, so there is no
interruption to any network services.

Note:  Changing the active Management Server is primarily meant for disaster recovery. We do
not recommend switching the active Management Server unless it is necessary.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Control Management Servers.

2) Right-click an additional Management Server and select Set Active.
• You can alternatively change the active Management Server using the command line.
• If the currently active Management Server is unreachable, set a different Management Server to active

in the Control Management Servers dialog box. You are prompted to confirm setting the Management
Server to active.

CAUTION:  If the active Management Server is unreachable when you make the switch,
but might possibly recover, disconnect the active Management Server from the network.
You avoid having two active Management Servers online at the same time. Set the
previous active Management Server to standby and manually synchronize the databases
to return to normal operation.
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Related reference
Security Management Center commands on page 1409

Disable or enable automatic database
replication from active Management Server to
additional Management Servers
By default, changes in the configuration information stored on the currently active Management Server are
automatically copied to all other Management Servers.

Before you begin
There must be a route between the Management Client and the Management Servers. If there is no
route between the Management Client and the Management Servers, you cannot send a command
through the Control Management Servers dialog box.

Automatic management database replication is incremental and continuous; only the changed parts of the
database are replicated and the replication is done in real time.

Note:  The management database is not synchronized automatically between the Management
Servers after a Management Server upgrade. You must synchronize the database manually after
the upgrade.

Disabling the automatic database replication is not recommended unless you have a specific need to do so. For
example, you might need to prevent excessive failed replication attempts when you know that the Management
Server will be unreachable for a long time. An example scenario would be changing the Management Server’s
hardware or the Management Server’s IP address.

CAUTION:  Re-enable automatic database replication in the Management Server’s properties
when the Management Server is reachable. You must synchronize the management database
manually once the Management Server is working normally.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Control Management Servers.

2) Right-click the Management Server and select Replication > Include Server in Replication or
Replication > Exclude Server from Replication.
You are prompted to confirm that you want to include or exclude the server.

3) Click Yes.
The Management Server is included or excluded until the next full database replication.
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Synchronize databases between active
Management Server and additional
Management Servers
You must synchronize the configuration information manually through the Management Client after upgrading the
Management Servers or after restoring a backup.

Before you begin
There must be a route between the Management Client and the Management Servers. If there is no
route between the Management Client and the Management Servers, you cannot send a command
through the Control Management Servers dialog box.

Manual management database synchronization is primarily meant for resynchronizing the databases after
upgrading the SMC. We do not recommend using manual database synchronization unless you have a specific
need to do so.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Connect to the active Management Server using the Management Client.

2) Select  Menu > System Tools > Control Management Servers.

3) If the Management Client is in a different network than the additional Management Server, select the
Location from which to send the command.
This action ensures that the command is sent to the correct Contact Address for the Management Server.

4) For each additional Management Server that you want to synchronize:

a) Right-click the Management Server and select Replication > Full Database Replication.
You are prompted to confirm the replication.

b) Click Yes.
All existing configurations on the additional Management Server are overwritten.

c) Click OK to acknowledge the completion of the synchronization and wait for the Management Server to
restart.
After the Management Server has restarted, its Replication Status is updated in the Control
Management Servers dialog box.

5) Click Close to close the Control Management Servers dialog box.
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 CHAPTER 27

Reconfiguring the SMC and
engines

Contents

• Modify Management Server elements on page 449
• Configure SMC API on page 451
• Forward audit data from Management Servers to external hosts on page 453
• Change the Management Server database password on page 456
• Change the Management Server or Log Server platform on page 457
• Change Management Server and Log Server IP addresses on page 458
• Create Internal ECDSA Certificate Authority elements on page 462
• Troubleshooting connecting to Management Servers on page 464
• Things to consider when changing the NGFW Engine role on page 465

You can modify settings for Management Servers, change hardware platforms or the IP addresses used in system
communications, change the type of certificate authority, and change the role of NGFW Engines.

Modify Management Server elements
One Management Server element is automatically created during SMC installation. You can change the settings
as necessary.

Note:  You can rename the Management Server element freely, but you cannot delete the
Management Server that the SMC is connected to.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) (Multiple Management Servers only) Select  Menu > System Tools > Control Management Servers,
then temporarily exclude the Management Servers you are about to edit from database replication.
Temporarily exclude the Management Servers from database replication, for example, for troubleshooting
purposes, while changing the Management Server’s hardware, or changing the Management Server IP
address.

2) Select  Home.

3) Browse to Others > Management Server.

4) Right-click the Management Server, then select Properties.
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5) (Optional) Change the Name of the Management Server.

6) (Optional) If NAT is used to translate addresses in communications between this server and other SMC
components, define the Location and Contact Address.

7) Select the Log Server to which the Management Server sends its logs.

8) If you use a RADIUS server for authenticating administrators, select the RADIUS Method that is used in
the authentication.

9) (Optional) If you want to send alert notifications or reports from the Management Server, select the
Notifications tab.
• If you want to send alerts by email, as SMS text messages, through a custom script, or as SNMP traps,

define the alert channels.
• You can use an SMTP server to send generated reports directly from the Management Server. Select

the SMTP Server or create an SMTP Server element. Enter the Sender Address that is shown as the
email sender. Remember to allow these connections in the Firewall Policy if necessary.

10) (Optional) If the connection from the Management Server to the Forcepoint servers requires a proxy
server, select the Connection tab and configure the Proxy Settings.

a) Select Use Proxy Server for HTTPS Connection, then enter the Proxy Address and Proxy Port.

b) If the proxy server requires user authentication, select Authenticate to the Proxy Server, then enter
the Proxy User Name and Proxy User Password.

Tip:  Deselect Hide if you want to view the Proxy Password in plain text.

11) If the replication status in the Info pane indicates a problem with database replication, synchronize the
management databases manually.

12) Click OK.

Related concepts
Define contact IP addresses on page 129

Related tasks
Create Location elements on page 129
Email reports on page 289
Authenticate administrators using RADIUS or TACACS+ methods on page 368
Configure notifications for alerts on page 382
Create SMTP Server elements on page 389
Synchronize databases between active Management Server and additional Management Servers on page 447
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Configure SMC API
The Application Programming Interface (API) of SMC allows external applications to connect with the SMC.

Note:  If there is a firewall between SMC and the other applications, make sure that there is an
Access rule to allow communication.

The SMC API can be used to run actions remotely using an external application or script. For more information
about using SMC API, see the Forcepoint NGFW SMC API Reference Guide.

Create TLS credentials for SMC API Clients
If you want to use encrypted connections, the SMC API Client needs TLS credentials to connect with the
Management Server.

Note:  You can import the existing private key and certificate if they are available.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Management Client, select  Configuration.

2) Browse to Administration > Certificates > TLS Credentials.

3) Right-click TLS Credentials, then select New TLS Credentials.

4) Complete the certificate request details.

a) In the Name field, enter the IP address or domain name of SMC.

b) Complete the remaining fields as needed.

c) Click Next.

5) Select Self Sign.

6) Click Finish.

Result

The TLS Credentials element is added to Administration > Certificates > TLS Credentials. The State column
shows that the certificate has been signed.
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Enable SMC API
To allow other applications to connect using the SMC API, enable SMC API on the Management Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Management Client, select  Home.

2) Browse to Others > Management Server.

3) Right-click the Management Server, then select Properties.

4) Click the SMC API tab, then select Enable.

5) (Optional) In the Host Name field, enter the name that the SMC API service uses.

Note:  API requests are served only if the API request is made to this host name. To allow
API requests to any host name, leave this field blank.

6) Make sure that the listening port is set to the default of 8082 on the Management Server.

7) If the Management Server has several IP addresses and you want to restrict access to one, enter the IP
address in the Listen Only on Address field.

8) If you want to use encrypted connections, click Select, then select the TLS Credentials element.

9) Click OK.

Create an API Client element
External applications use API clients to connect to SMC.

Before you begin
SMC API must be enabled for the Management Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Access Rights.

3) Right-click Access Rights and select New > API Client.
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4) In the Name field, enter a unique name for the API Client.

5) Use the initial authentication key or click Generate Authentication Key to generate a new one.
A random 24-character alphanumeric authentication key is automatically generated.

Important:  This key appears only once, so be sure to record it. The API Client uses the
authentication key to log on to SMC API.

6) Click the Permissions tab.

7) Select the permissions for actions in the SMC API.

8) Click OK.

Forward audit data from Management
Servers to external hosts

You can configure Management Servers to forward audit data to external hosts in CSV, XML, or McAfee ESM
format. Forwarding audit data enables you to handle and process audit data with external devices.

Add rules for forwarding audit data from
Management Servers
Configure the rules that forward audit data from a Management Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others > Management Server.

3) Right-click the Management Server from which you want to forward audit data, then select Properties.

4) Click the Audit Forwarding tab.

5) To create a rule, click Add.

Tip:  To remove a rule, select the rule and click Remove.

6) In the select Target Host cell, select the external host to which the audit data is forwarded.

a) Double-click the Target Host cell.
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b) Select a Host element.

c) Click Select.

7) In the Service cell, select the network protocol for forwarding the audit data.

8) (Optional) Double-click the Port cell, then enter the port that is used for audit data forwarding.

Note:  You might have to define an Access rule that allows traffic to the target host. In this
case, make sure that the Port you select is also used as the Port in the Access rule.

9) In the Format cell, select the audit data forwarding format.

10) (Optional) Double-click the Filter cell, then define a Local Filter element that defines which audit data is
forwarded.

Note:  The Local Filter is only applied to the audit data that matches the Audit Forwarding
rule.

11) Click OK.

Related tasks
Enable TLS protection for log or audit data forwarding on page 428

Enable TLS protection for log or audit data
forwarding
You can optionally enable TLS protection for log or audit data forwarding to an external syslog server.

Before you begin
Because there is a connection to an external system, public key infrastructure (PKI) integration,
including certificate revocation list (CRL) checking, must already be configured.

Optionally, you can check the identity of an external syslog server to secure the TLS-protected traffic from the
Log Server or the Management Server to the syslog server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Others > Log Server or Others > Management Server.
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3) Right-click the Log Server or Management Server from which you want to forward log or audit data, then
select Properties.

4) Click the Log Forwarding or Audit Forwarding tab.

5) To add a rule, click Add.

6) In the select Target Host cell, select the external host to which the log or audit data is forwarded.

a) Double-click the Target Host cell.

b) Select a Host element.

c) Click Select.

7) In the Service cell, select TCP with TLS.

8) In the Port, Format, Data Type (Log Server only), and Filter cells, select the settings according to your
needs.

9) In the TLS Profile cell, select the TLS profile for TLS-protected log data forwarding.

a) Double-click the TLS Profile cell.

b) Select a TLS Profile element.

c) Click Select.

10) (Optional) Double-click the TSL Server Identity cell and define the TLS server identity in order to check
the identity of the TLS server to secure the TLS-protected traffic from the Log Server or the Management
Server.

11) Define the Log Server or Management Server TLS certificate options.
This certificate is used as the client certificate when connecting to the external syslog server.
• To use the server's internal certificate, select Use Internal Certificate.
• To use the certificate contained in a TLS Credentials element, select Use Imported Certificate, then

click Select.
Select a TLS Credentials element.

• To leave the server's certificate unauthenticated, select No Client Authentication.

12) Click OK.
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Create Access rules allowing traffic from
Management Servers to external hosts
If the external host and Management Server are separated by a Firewall or Layer 2 Firewall, edit the Policy to
allow traffic from the Management Server to the host.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Policies

3) Browse to Firewall Policies or Layer 2 Firewall Policies, depending on the type of policy that you want to
edit.

4) Right-click the Firewall or Layer 2 Firewall policy, then select Edit Firewall Policy or Edit Layer 2 Firewall
Policy.

5) Click the IPv4 Access or IPv6 Access tab, then add an Access rule with the following values:
• Source: your Management Server
• Destination: the target Host element
• Service: Syslog (UDP) or Syslog (TCP), depending on the protocol used. For TLS-protected traffic,

select TCP with TLS. The same Service and Port that was selected in the Audit Forwarding rule must be
selected here.

• Action: Allow

6) If you have finished editing the policy, click  Save and Install.

Change the Management Server
database password

The Management Server contains a database for storing the configuration information. The password for the
database is automatically created during the installation of the Management Server. In some rare cases, you
might need this password to complete an operation. In these cases, you can change the database password.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Password > Change Database Password.

2) Enter the password in the New Password and the Confirm New Password fields.

3) Click OK to confirm the change.
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Change the Management Server or Log
Server platform

You can change the hardware or the operating system that the Management Server or Log Server components
run on.

Note:  For any Web Portal Server, install the new Web Portal Server as a fresh installation as
instructed in the Forcepoint Next Generation Firewall Installation Guide.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Take backups of your Management Servers and your Log Servers.

Note:  The Web Portal Server has no information to back up.

2) (Multiple Management Servers only) Open the Control Management Servers dialog box and temporarily
exclude the additional Management Servers from database replication.

3) Install new Management Servers and Log Servers on the new platforms.
See the Forcepoint Next Generation Firewall Installation Guide.

4) Restore the Management Server and Log Server backups from the old environment to the new installation.

5) (Hardware change) Shut down and disconnect the old Management Server or Log Server hardware.

6) (Hardware change) Connect the new Management Server or Log Server to the network environment.

7) If the replication status in the Info pane indicates a problem with database replication, synchronize the
management databases manually.

Related concepts
Restoring backups on page 1265

Related tasks
Synchronize databases between active Management Server and additional Management Servers on page 447
Back up system configurations on page 1263



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Reconfiguring the SMC and engines | 458

Change Management Server and Log
Server IP addresses

You can change the IP addresses of the Management Server and Log Server without losing management
connectivity. The steps to change the Management Server’s IP address depend on whether the Management
Server and Log Server are on separate or on the same appliance.

When you change IP addresses, other connections between the different components might be temporarily lost.
Make sure that the connections return to normal after the IP address changes.

Before changing the IP address, we recommend making a backup of the Management Server and Log Server.

Related tasks
Change the IP address of combined Management Servers and Log Servers on page 460
Back up system configurations on page 1263

Change the Management Server IP address
When the Management Server and Log Server are installed on different appliances, you can change the IP
address of the Management Server by following these steps.

Before changing the IP address, we recommend making a backup of the Management Server and the Log
Server.

Note:  If any Firewalls between the Management Server and other components do not use a
policy based on the Firewall Template, check that they allow all necessary connections.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Request an IP address change for the Management Server license at
https://stonesoftlicenses.forcepoint.com.

2) (Multiple Management Servers only) Open the Control Management Servers dialog box and temporarily
exclude the Management Servers for which you are changing the IP address from database replication.
For more information, see the topic that explains how to synchronize Management databases manually.

3) Add Firewall IPv4 Access rules (and possibly NAT rules) that allow policy upload connections from the
new IP addresses to the Firewall.
The services needed for the communications between the different components are explained in the topic
that lists SMC ports.

4) (Firewalls with Node-Initiated contact to Management Server only) Open the Management Server
Properties and add the new Management Server IP address as a Contact Address.
The Firewall must be able to contact the Management Server at both the current Management Server IP
address and the new Management Server IP address.

5) Refresh the Firewall Policies.

https://stonesoftlicenses.forcepoint.com
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6) Stop the Management Server and Log Server services.

7) Change the IP address of the host server in the operating system.

8) On the Management Server, run the command
sgChangeMgtIPOnMgtSrv <new Management Server IP address>

9) On all Log Servers, run the command
sgChangeMgtIPOnLogSrv <new Management Server IP address>

10) Start the Management Server and Log Server services and log on using the Management Client.

11) Install the new Management Server license when prompted.

12) Remove the Firewall IPv4 Access rules that you created in Step 3 and refresh the Firewall Policies.
After running the IP address change scripts, the Alias elements in the inherited rules translate to the right
IP addresses.

13) If the replication status in the Info pane indicates a problem with database replication, synchronize the
management databases manually.

Related tasks
Define Management Server or Log Server contact addresses on page 130
Synchronize databases between active Management Server and additional Management Servers on page 447
Change the IP address of combined Management Servers and Log Servers on page 460
Back up system configurations on page 1263

Related reference
Security Management Center ports on page 1429

Change the Log Server IP address
When the Management Server and Log Server are installed on different appliances, you can change the IP
address of the Log Server by following these steps.

When you change the Log Server’s IP address, the traffic between the Log Server and the engines is interrupted
and the logs are spooled on the engines. Changing the IP address might also mean that the transfer of engine
status and statistics information is temporarily interrupted.

Before changing the IP address, we recommend making a backup of the Management Server and the Log
Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Request a license binding change for the Log Server if the license is bound to the Log Server’s IP address at
https://stonesoftlicenses.forcepoint.com and install the new license.

https://stonesoftlicenses.forcepoint.com
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2) Edit the <installation directory>/data/LogServerConfiguration.txt file on the Log Server and update the Log
Server IP address.

3) In the Management Client, open the Log Server properties and update the Log Server IP address.

4) Stop and restart the Log Server service.

5) Refresh the policies of all engines that send data to the Log Server.

Related tasks
Edit Log Server configuration parameters on page 432
Back up system configurations on page 1263

Change the IP address of combined
Management Servers and Log Servers
When the Management Server and the Log Server are installed on the same system, you can change the IP
address for both Servers in one procedure.

When you change the Log Server’s IP address, the traffic between the Log Server and the engines is interrupted
and the logs are spooled on the engines. Changing the IP address might also mean that the transfer of engine
status and statistics information is temporarily interrupted.

Before changing the IP addresses, we recommend making a backup of the Management Server and the Log
Server.

Note:  If any Firewalls between the Management Server and other components do not use a
policy based on the Firewall Template, check that they allow all necessary connections.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Request a license binding change to the new IP address for the Management Server license, and also the
Log Server if the license is bound to an IP address.
Make the request at https://stonesoftlicenses.forcepoint.com.

2) (Multiple Management Servers only) Open the Control Management Servers dialog box and temporarily
exclude the Management Servers for which you are changing the IP address from database replication.
For more information, see the topic that explains how to synchronize Management databases manually.

3) Add Firewall IPv4 Access rules (and possibly NAT rules) that allow policy upload connections from the
new IP addresses to the Firewall.
The services needed for the communications between the different components are explained in the topic
that lists SMC ports.

https://stonesoftlicenses.forcepoint.com
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4) (Firewalls with Node-Initiated contact to Management Server only) Open the Management Server
Properties and add the new Management Server IP address as a Contact Address.
The Firewall must be able to contact the Management Server at both the current Management Server IP
address and the new Management Server IP address.

5) Refresh the Firewall Policies.

6) Stop the Management Server and Log Server services.

7) Change the IP address of the host server in the operating system.

8) Run the sgChangeMgtIPOnMgtSrv script on the Management Server.
For more information, see the topic that explains SMC commands.

9) Run the sgChangeMgtIPOnLogSrv script on the Log Server.

10) Edit the <installation directory>/data/LogServerConfiguration.txt file on the Log Server and update the Log
Server IP address.
For more information, see the topic that explains changing Log Server configuration parameters.

11) Start the Management Server service and log on using the Management Client.

12) Install the new licenses when prompted.

13) Open the Log Server properties and update the IP address.

14) Start the Log Server service.

15) Remove the Firewall IPv4 Access rules that you created in Step 3 and refresh the Firewall Policies.
After running the IP address change scripts, the Alias elements in the inherited rules translate to the right
IP addresses.

16) If the replication status in the Info pane indicates a problem with database replication, synchronize the
management databases manually.

Related tasks
Edit Log Server configuration parameters on page 432
Synchronize databases between active Management Server and additional Management Servers on page 447
Change the Management Server IP address on page 458
Change the Log Server IP address on page 459
Start Tasks manually on page 1301
Back up system configurations on page 1263

Related reference
Security Management Center commands on page 1409
Security Management Center ports on page 1429
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Create Internal ECDSA Certificate
Authority elements

Switching to an internal ECDSA certificate authority enables 256-bit encryption on the Management Server for
connections between the Management Server and engines.

The Elliptic Curve Digital Signature Algorithm (ECDSA) is a digital signature algorithm that uses elliptic curve
cryptography. You can switch to using an Internal ECDSA certificate authority to sign the certificates that
components use to identify each other in system communications.

When you create an Internal ECDSA Certificate Authority element, SMC components gradually start using the
new Internal ECDSA CA to sign certificates. Initially, the new Internal ECDSA CA is in the Created for Different
Certificate Type state. When the new Internal ECDSA CA is ready to begin signing certificates, it changes to the
Ready to Use for Different Certificate Type state. At first, only Management Server certificates are signed by
the new Internal ECDSA CA. Certificates for other components are signed by whichever Internal CA is currently
used by the Management Server. In an environment with multiple Management Servers, the new ECDSA CA
changes to the Active state when all Management Servers use the new Internal ECDSA CA.

CAUTION:  When you start using an internal ECDSA certificate authority, you must recertify
all SMC servers. You might also need to make initial contact between the engines and the
Management Server. Engines with versions earlier than 5.5 cannot communicate with the
SMC when 256-bit encryption is used with an internal ECDSA certificate authority. We strongly
recommend creating a Management Server backup before creating an Internal ECDSA Certificate
Authority element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Other Elements > Internal Certificate Authorities.

3) Right-click Internal Certificate Authorities and select Create New Internal ECDSA Certificate
Authority.
You are prompted to confirm that you want to create an Internal ECDSA Certificate Authority element.

4) Click Yes.

• The Internal ECDSA Certificate Authority element creation process begins and a new tab opens to
show the progress of the process.

• When the process is finished, the progress report shows the steps that you must take next.
• The status of the ECDSA CA is Created for Different Certificate Type.

5) Restart the Log Server and the Web Portal Server.
For more information, see the topic that explains SMC commands.

6) Start the Renew Internal Certificate Authorities Task.
For more information, see the topic that explains starting Tasks manually.
When the Task is finished, the status of the ECDSA CA is Ready to Use for Different Certificate Type.
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7) Right-click the Renew Internal Certificate Authorities Task in the History branch and select Show
Progress Report.
The progress report shows which steps you must take next. Follow the instructions to resolve any issues.
For example, you might be prompted to check the status or connectivity of some engines.

8) Recertify the Management Server. For more information, see the topic that explains renewing SMC server
certificates.

9) Start the Renew Internal Certificate Authorities Task again.
When the Task is finished, the status of the ECDSA CA is Active.

10) Recertify the Log Server and the Web Portal Server.

• If an engine cannot communicate with the Management Server, check that 256-bit encryption is
enabled on the engine. Then make initial contact between the engine and the Management Server. For
more information, see the topic that explains enabling 256-bit security strength for engines.

• For other certificate-related problems, see the topic that lists certificate problems.

Related concepts
Problems with certificates on page 1355

Related tasks
Back up system configurations on page 1263
Renew SMC server certificates on page 1357

Related reference
Security Management Center commands on page 1409

Enable 256-bit security strength for engines
When you start using a new internal ECDSA certificate authority, 256-bit encryption is automatically enabled on
the engines. If an engine can't communicate with the Management Server, manually enable 256-bit encryption on
the engine and make initial contact between the engine and the Management Server.

Both the engines and the Management Server must be version 5.5 or later.

CAUTION:  Engines with versions earlier than 5.5 cannot communicate with the SMC when 256-
bit encryption is used with an internal ECDSA certificate authority.

Note:  When using the NGFW Initial Configuration Wizard in a web browser, 256-bit encryption is
automatically used. See the Forcepoint Next Generation Firewall Installation Guide.

Steps

1) Start the NGFW Initial Configuration Wizard on the command line using one of the following commands:
• sg-reconfigure --no-shutdown: The NGFW Initial Configuration Wizard starts without shutting

down the engine. Network interface settings cannot be changed in this mode.
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• sg-reconfigure: The engine shuts down and the NGFW Initial Configuration Wizard starts. All options
are available if you have a local connection. If you have a remote SSH connection, you cannot change
network interface settings (the engine uses the no-shutdown mode).

2) Select Next on each page until the Prepare for Management Contact page opens.

3) Select Contact or Contact at Reboot and press the spacebar.

4) Enter the Management Server IP address and the one-time password.

Note:  The one-time password is engine-specific and can be used only for one initial
connection to the Management Server. Once initial contact has been made, the engine
receives a certificate from the SMC for identification. If the certificate is deleted or expires,
repeat the initial contact using a new one-time password.

5) Select 256-bit Security Strength and press the spacebar to use 256-bit encryption for the connection to the
Management Server. 256-bit encryption must also be enabled for the Management Server.

6) (Optional) Select Edit Fingerprint and press Enter. Fill in the Management Server’s certificate fingerprint
(also shown when you saved the initial configuration).
Filling in the certificate fingerprint increases the security of the communications.

7) Select Finish and press Enter.
The engine now tries to make initial Management Server contact. The progress is displayed on the command
line.

Related tasks
Create Internal ECDSA Certificate Authority elements on page 462

Troubleshooting connecting to
Management Servers

If an engine that has been changed cannot connect to the Management Server, you have several troubleshooting
options.

If an engine cannot connect to the Management Server because of changes in the configuration, you can restore
the contact. Generate a new initial configuration for the engine (through the engine’s right-click menu), then
run the NGFW Initial Configuration Wizard on the command line. See the Forcepoint Next Generation Firewall
Installation Guide.

If you suspect that the engine’s configuration is out of date, select the option to return the engine to the initial
configuration state. For more information, see the topic that explains reconfiguring engine settings.

CAUTION:  Returning the engine to the initial configuration state clears the engine’s configuration.
Only management communications are allowed, and no traffic is allowed to pass through the
engine.
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Related tasks
Reconfigure engine settings on page 347

Things to consider when changing the
NGFW Engine role

You can change the role of an NGFW Engine, converting one type of NGFW Engine to another, if you have a
specific need to do so.

Consider these things when changing the role:

• You can only change the NGFW Engine role for engines that currently have Forcepoint NGFW software
installed. To change the role of engines that currently have specific engine software (for example, Firewall/
VPN) installed, you must reinstall the engine software. See the Forcepoint Next Generation Firewall
Installation Guide.

• Changing the engine role is only supported on modular appliances, for engines installed on a virtualization
platform, or for engines installed on your own hardware. You cannot change the engine role on small
appliances.

• You must have an NGFW Engine license that is valid for all engine roles. You cannot change the role of
engines that have a license for a specific type of engine.

• If using the NGFW Initial Configuration Wizard on the engine command line, you must connect through a
serial console or VGA console. It is not possible to change the engine’s role using an SSH connection to the
engine.

Prepare for changing the NGFW Engine role
Before you change the role of an NGFW Engine from one type to another, perform these high-level steps to
create an engine element for the new role.

Note:  You cannot use the same primary control IP address in multiple elements. You must either
change the primary control IP address in the engine’s current interface configuration or delete the
existing engine element before creating the new engine element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Create the correct type of engine element for the new role and define the basic properties.

2) Configure the engine’s interfaces.

3) Configure the routing.
• Routes to directly connected networks are automatically added for all NGFW Engine roles.
• For Firewalls, add a default route and any routes through next-hop gateways to networks that are not

directly connected to the Firewalls.
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• You might need to define a default route for IPS engines and Layer 2 Firewalls if the SMC components
are not on a directly connected network.

4) Generate the initial configuration for the engine and save the configuration on a USB drive.
For more information, see the topic that explains management contact procedure for engines.

Related concepts
Getting started with engine elements on page 471
Network interfaces for engines on page 539
Connect engines to the SMC on page 641
Getting started with routing on page 701

Clear the existing engine configuration before
changing the NGFW Engine role
Before you change the role of an NGFW Engine from one type to another, clear the existing engine configuration.

Steps

1) Connect to the engine’s command line using a monitor and keyboard or a serial cable, and log on as root.
If you use a serial cable, use a terminal console program to connect to the NGFW appliance with these
settings:
• Bits per second — 9600 or 115,200
• Data bits — 8
• Parity — None
• Stop bits — 1.

Note:  The serial console port speed is 9600 bps in most NGFW appliances. The speed is
115,200 bps in the latest NGFW appliance models. See the hardware guide for your NGFW
appliance model for more information.

2) Enter the command sg-clear-all.
The engine restarts and you are prompted to select the system restore options.

CAUTION:  Using the system restore options clears all configuration information from the
engine. It is not possible to recover the engine’s previous configuration.

3) Type 2 and press Enter.
You are prompted to select the number of overwrites for the data partition.

4) Type 0 and press Enter.
You are prompted to select the number of overwrites for the swap partition.

5) Type 0 and press Enter.
You are prompted to select whether to remove the spool partition.
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6) Type 2 and press Enter.
You are prompted to select the number of overwrites for the spool partition.

7) Type 0 and press Enter.
You are prompted to confirm that you want to clear the configuration.

8) Type YES and press Enter.
The system starts clearing the engine’s configuration.

CAUTION:  Do not turn off or restart the engine while the configuration is being cleared.
Doing so can cause a serious error that prevents the engine from starting.

9) Press Enter to restart the engine when prompted.
The engine restarts and the NGFW Initial Configuration Wizard starts on the command line.

Reconfigure the engine after clearing the
existing configuration
After you create an engine element and clear the existing engine configuration, you can change the role of an
NGFW Engine from one type to another.

For details about how to make initial contact using the NGFW Initial Configuration Wizard in a web browser, see
the Forcepoint Next Generation Firewall Installation Guide.

Steps

1) Select Role and press Enter.

2) Select the new role for the NGFW Engine and press Enter.
The role-specific NGFW Initial Configuration Wizard starts.

3) Select one of the following configuration methods:
• Select Import and press Enter to import a saved configuration.
• Select Next and press Enter to manually configure the engine’s settings.

4) (Manual configuration only) Configure the Operating System Settings and Network Interfaces.
See the Forcepoint Next Generation Firewall Installation Guide.

5) Select Switch Engine node to initial configuration and fill in the Management Server information.

6) Select Contact and enter the Management Server IP address and the one-time password.

CAUTION:  Select 256-bit Security Strength only if the engine is not able to communicate with
the Management Server after you start using a new ECDSA Certificate Authority. Engines
with versions earlier than 5.5 cannot communicate with the SMC when 256-bit encryption is
used with an Internal ECDSA Certificate Authority.
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7) (Optional) Select Edit Fingerprint and press Enter. Fill in the Management Server’s certificate fingerprint
(also shown when you saved the initial configuration).
Filling in the certificate fingerprint increases the security of the communications.

8) Select Finish and press Enter.
The engine makes initial contact with the Management Server.

9) Install a policy on the engine.

Related tasks
Install policies on page 800
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 PART VII
Engine element
configuration

Contents

• Creating and modifying engine elements on page 471
• Creating and modifying Master NGFW Engine and Virtual NGFW Engine elements on page 515
• Network interface configuration on page 539
• Connecting engines to the SMC on page 639
• Element-based network address translation (NAT) on page 645
• Configuring the engine tester on page 649
• Engine permissions on page 657
• DNS Relay on page 661
• Setting up SNMP for NGFW Engines on page 667
• Alias element translations for engines on page 673
• Add-on features for engines on page 677
• Advanced engine settings on page 683

You can create and modify Firewalls, IPS engines, Layer 2 Firewalls, Master NGFW Engines and Virtual NGFW
Engines. You can configure the engine properties, activate optional features, and configure advanced engine settings.
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 CHAPTER 28

Creating and modifying engine
elements

Contents

• Getting started with engine elements on page 471
• Creating engine elements on page 472
• Editing existing engine elements on page 498
• Configure global contact policy settings for node-initiated contact to the Management Server on page 512
• Synchronizing engine times on page 513

Engine elements contain the configuration information that is directly related to the Firewalls, IPS engines, and Layer 2
Firewalls. The configuration information includes interface definitions, cluster mode selection, tester settings, and other
engine-specific options.

Getting started with engine elements
Engine elements are used for the configuration and management of your Firewalls, IPS engines, and Layer 2
Firewalls.

Engine elements contain settings that cannot be reused in the configuration of other components, such as the
network interface configuration. Engine elements also determine which reusable elements are included in the
configuration of a particular component. (For example, a component can send its log data to the Log Server,
which is a reusable element.) All engines are centrally configured and controlled through the Management
Server.

If you are configuring new engine elements for the first time, follow the instructions in the Forcepoint Next
Generation Firewall Installation Guide.

Engine configuration overview
Configuring Firewalls, IPS engines, and Layer 2 Firewalls consists of several general procedures.

1) Install a license for the engine.

2) Create an engine element and define the basic properties.

3) Configure the engine’s interfaces.

4) Configure the routing.
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5) Generate the initial configuration for the engine and use it to establish a connection between the engine and
the Management Server.

6) Install a policy on the engine.

Related concepts
Creating engine elements on page 472
Network interfaces for engines on page 539
Configuration of Master NGFW Engines and Virtual NGFW Engines on page 515
Connect engines to the SMC on page 641
Getting started with routing on page 701
Getting Started with licenses on page 1305

Related tasks
Install policies on page 800

The Engine Editor and how it works
The Engine Editor combines all NGFW Engine configuration information into one view that is easy to access and
navigate. You can quickly save and validate all changes using the Engine Editor toolbar.

You can use the Engine Editor to configure the following settings:
• General — General NGFW Engine settings
• Interfaces — Interface configuration
• Routing — Routing and antispoofing configuration
• Add-Ons — Settings related to NGFW Engine add-ons and additional services.
• Policies — Information about the Security Policy used on the NGFW Engine and settings related to element-

based NAT and Aliases. Also contains settings for Automatic rules
• VPN (Firewalls only) — Settings related to the VPN configuration and SSL VPN configuration
• Advanced Settings — Advanced NGFW Engine settings (Traffic Handling, SYN Rate Limits, Log Handling,

Scan Detection, DoS Protection, Idle Timeouts, and Tunneling)

You can use the Engine Editor to edit or view an NGFW Engine configuration:
• To edit an NGFW Engine configuration, right-click the NGFW Engine, then select Edit.
• To view an NGFW Engine configuration, right-click the NGFW Engine, then select Preview. You can also

double-click the NGFW Engine.

Creating engine elements
You can either create an element or copy and edit an existing element.

Before you define an engine element, make sure that you have a license for it. The element can be configured
without a license, but you must have a license to make the engine operational.

You can create engine elements in these ways:
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• Single Firewall and Firewall Cluster elements one by one
• Several new Single Firewall and Firewall Cluster elements at the same time with a wizard
• IPS and Layer 2 Firewall elements one by one

Related concepts
Configuration of Master NGFW Engines and Virtual NGFW Engines on page 515

Related tasks
Create Single Firewall elements on page 473
Create multiple Single Firewall elements using the Create Multiple Single Firewalls wizard on page 474
Create Firewall Cluster elements on page 486
Create multiple Firewall Cluster elements using the Create Multiple Firewall Clusters wizard on page 487
Create Single IPS elements on page 493
Create IPS Cluster elements on page 494
Create Single Layer 2 Firewall elements on page 495
Create Layer 2 Firewall Cluster elements on page 496
Duplicate existing engine elements on page 497

Create Single Firewall elements
Single Firewall elements represent firewalls that consist of one physical device.

Note:  Single Firewall elements can be converted to Firewall Cluster elements. You can also
create several Single Firewall elements at the same time using the Create Multiple Single
Firewalls wizard.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click NGFW Engines and select New > Firewall > Single Firewall.

3) In the Name field, enter a unique name.

4) Select the Log Server to which the Firewall sends its event data.

5) (Optional) In DNS IP Addresses field, add one or more DNS IP addresses.
DNS IP addresses are IP addresses of external DNS servers. Firewalls use these DNS servers to resolve
Domain names to IP addresses. Firewalls need DNS resolution to contact services that are defined using
URLs or domain names, and to resolve fully qualified domain names (FQDNs) used in policies. When DNS
relay is configured, these DNS servers are used unless domain-specific DNS servers are specified in a DNS
Relay Profile element.

Note:  If you have defined NetLink-specific DNS IP addresses, adding DNS IP addresses
overrides the NetLink-specific DNS IP addresses.
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• To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the
dialog box that opens.

• To define an IP address using a network element, click Add and select Network Element.

6) If there is a NAT device between this Firewall and other SMC components, select the Location for this
engine.

7) (Optional, appliances only) Enter the Proof-of-Serial (POS) code delivered with the appliance if you want to
configure the engine using plug-and-play configuration.

8) (Optional) If you want to include the Firewalls in predefined categories, select the appropriate Categories.

9) (Optional) If you want to add custom commands to the Firewall’s right-click menu, add a Tools Profile.

Related concepts
Defining Host elements on page 898
Configuring interfaces for Firewalls on page 543

Related tasks
Attach Tools Profile elements to elements on page 120
Create Location elements on page 129
Select Categories for elements on page 171
Create multiple Single Firewall elements using the Create Multiple Single Firewalls wizard on page 474
Activate the SNMP agent on NGFW Engines on page 670
Define External DNS Server elements on page 780

Create multiple Single Firewall elements using
the Create Multiple Single Firewalls wizard
You can create multiple Single Firewall elements at the same time using the Create Multiple Single Firewalls
wizard.

Use the wizard to create firewalls for plug-and-play configuration, where the appliances configure themselves
automatically after they are plugged in and connected to the network. Only specific Forcepoint NGFW appliances
can use plug-and-play configuration.

Using the Create Multiple Single Firewalls wizard offers several benefits:
• It is easy to create several Firewall elements at the same time.
• You can select IP addresses as Endpoints for the VPN Gateway elements that represent the Firewalls in

VPNs.
• You can define a policy that is automatically installed on the Firewalls when they make initial contact to the

Management Server.
• (Plug-and-play configuration only) You can upload Firewall configurations to the Installation Server. This

way, you can avoid uploading the configurations one by one or transferring the initial configurations to the
appliances manually.
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You can create a specific number (1–1000) of Single Firewall elements. Or you can use the Proof-of-Serial (POS)
codes delivered with the Forcepoint NGFW appliances to create the Single Firewall elements. When you use
POS codes in the wizard, all appliances must be the same model. If you have POS codes for different types of
appliances, you must run the wizard separately for each appliance model to create the elements. Before you
create Firewall elements, note the serial numbers and geographical locations of the appliances.

Note:  The Firewall properties you define in the Create Multiple Single Firewalls wizard are
common to all Firewalls created with the wizard. Consider carefully which properties all Firewalls
share and which properties must be defined separately for each Firewall.

Once you have created the Firewalls through the wizard, you can change the properties of each individual
Firewall.

Related concepts
Defining Host elements on page 898

Related tasks
Create Location elements on page 129
Select Categories for elements on page 171
Create Single Firewall elements on page 473
Edit several engines at once on page 499
Activate the SNMP agent on NGFW Engines on page 670
Define External DNS Server elements on page 780

Start the Create Multiple Single Firewalls wizard
Start the Create Multiple Single Firewalls wizard to create multiple Single Firewall elements at the same time.
Define general settings for the Single Firewall elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click NGFW Engines and select New > Firewall  > Multiple Single Firewalls.
The Create Multiple Single Firewalls wizard opens.

3) To create multiple Single Firewall elements based on POS codes, follow these steps to start the
configuration.

a) In the Proof-of-Serial Codes field, enter the POS codes.

b) (Optional) Select a Firewall on which you want to base the Firewalls’ configuration from the Base
Configuration On list.

c) Click Next.
The Proof-of-Serial Code Information page opens.
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d) Make sure that the details on the Proof-of-Serial Code Information page are correct and click Next.
The Define Basic Firewall Information page opens.

4) If you do not have POS codes, follow these steps to start the configuration.

a) Enter the Number of Single Firewalls (1-1000).

b) (Optional) Select a Firewall on which you want to base the Firewalls’ configuration from the Base
Configuration On list.

c) Click Next.
The Define Basic Firewall Information page opens.

5) Enter a common Name Prefix. The system adds either a running number or the serial number of the
appliance to the name prefix to generate a unique name for each individual Firewall.

6) Select the Log Server to which the Firewall sends its event data.

Note:  Name Prefix and Log Server are the only mandatory properties you must define at
this stage. Review the other properties carefully to see which ones to define as the shared
properties for all Firewalls created with the wizard.

7) (Optional) In DNS IP Addresses field, add one or more DNS IP addresses.
DNS IP addresses are IP addresses of external DNS servers. Firewalls use these DNS servers to resolve
Domain names to IP addresses. Firewalls need DNS resolution to contact services that are defined using
URLs or domain names, and to resolve fully qualified domain names (FQDNs) used in policies. When DNS
relay is configured, these DNS servers are used unless domain-specific DNS servers are specified in a
DNS Relay Profile element.

Note:  If you have defined NetLink-specific DNS IP addresses, adding DNS IP addresses
overrides the NetLink-specific DNS IP addresses.

• To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the
dialog box that opens.

• To define an IP address using a network element, click Add and select Network Element. Select an
existing element, or click New and add an element.

8) Select the Location for the Firewalls if there is a NAT device between these Firewalls and other SMC
components.

Note:  Select a Location only if all Firewalls you create with the wizard belong to the same
Location element.

9) Define other settings according to your environment:
• If you have a Forcepoint NGFW appliance, enter the Proof-of-Serial (POS) code delivered with the

appliance.
• If you want to include the Firewalls in predefined categories, select the appropriate Categories.
• If you want to add custom commands to the Firewalls’ right-click menu, add a Tools Profile.
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10) Click Next.
The Review and Edit Names and Comments page opens.

11) Review the names of the Firewalls. If necessary, right-click the name and select Edit Name.

Note:  We recommend giving each Firewall a unique, descriptive name after the common
Name Prefix, such as the geographical location where the particular Firewall engine will be
used.

12) Click Next.
The Define Interfaces for the Firewalls page opens.

Define interfaces for multiple Single Firewalls
You must define at least one layer 3 physical interface and one IPv4 address for the Firewalls.

When you define interfaces for multiple Single Firewalls, the same interface properties are available for every
Firewall element in the Engine Editor. However, we recommend that you configure all shared interface properties
in the wizard. After you exit the wizard, you must configure the properties separately for each Firewall.

The interface properties you define for the first Firewall are used to automatically create the corresponding
properties for the rest of the Firewalls. These properties also include the IP addresses, which are automatically
generated in numeric order. Make sure that the IP addresses that are assigned to the Firewalls are not used by
any other components.

To use a Layer 3 Physical Interface for communication with the Management Server, begin by defining a Layer 3
Physical Interface with a dynamic IP address. This way, the Layer 3 Physical Interface is assigned Interface ID 0.
When connecting the cables to the appliance, connect the cable for the control connection to Ethernet port 0. See
the relevant Hardware Guide for detailed information about mapping the Interface IDs with specific ports on the
appliances.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) On the Define Interfaces for the Firewalls page of the Create Multiple Single Firewalls wizard, click Add
and select the type of interface that you want to add. Add the required number of network interfaces in the
following order:

a) Define Layer 3 Physical Interfaces.

b) Define integrated ADSL modems.

c) Define integrated 3G modems.

d) Define Tunnel Interfaces.

e) Define integrated wireless modems.

f) Define SSID Interfaces.

g) Define integrated switches and Port Group Interfaces.

2) (Optional, Physical Interfaces only) Add the required number of VLANs.
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3) (Not applicable to Modem interfaces) Configure the IP address settings for the first one of the Firewalls.

4) (Optional) Click Options to configure Loopback IP addresses.

5) (Recommended) Click Options to define which IP addresses are used in particular roles in system
communications.

6) (Optional) Configure more routing settings:
• Add static ARP entries.
• Configure Multicast Routing.

7) Click Next.
The Review and Edit Firewall Interfaces page opens.

8) Review the interfaces and edit them, if necessary. Properties of the Modem Interfaces cannot be edited.

9) Click Next.
The Define Routing for the Multiple Single Firewall Elements page opens.

Related concepts
IP addresses for Single Firewall interfaces on page 560
Loopback IP addresses for firewalls on page 570

Related tasks
Create Single Firewall elements on page 473
Add layer 3 physical interfaces for NGFW Engines in the Firewall/VPN role on page 544
Add VLAN interfaces for firewalls on page 549
Add ADSL Interfaces for Single Firewalls on page 550
Add Wireless Interfaces for Single Firewalls on page 551
Add SSID Interfaces for Single Firewalls on page 552
Add Modem Interfaces for Single Firewalls on page 554
Add tunnel interfaces for firewalls on page 556
Select system communication roles for firewall interfaces on page 569
Activate the internal DHCP server on a firewall interface on page 572
Configure advanced properties for firewall interfaces on page 559
Add manual ARP entries to NGFW Engines on page 624

Define routing for multiple Single Firewalls
Routes to directly connected networks are automatically added. You must add a default route and any routes
through next-hop gateways to networks that are not directly connected to the firewalls.

Steps

1) On the Define Routing for the Multiple Single Firewall Elements page of the Create Multiple Single
Firewalls wizard, drag and drop the appropriate Router and Network elements under the correct interfaces in
the right pane.
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2) Click Next.
The Review and Edit Routing for the Multiple Single Firewall Elements page opens.

3) Review the routing and edit, if necessary.

4) Click Next.
The Define NAT Definitions for the Firewalls page opens.

Related tasks
Add routes for firewalls on page 709
Create multiple Single Firewall elements using the Create Multiple Single Firewalls wizard on page 474

Add NAT definitions for multiple Single
Firewalls
On the Define NAT Definitions for the Firewalls page, you can define how the Single Firewalls translate
network IP addresses.

NAT rules are automatically generated and organized in the Firewall Policy based on the NAT definitions created
in the Firewall properties.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If you do not want to configure NAT definitions, click Nexton the Define NAT Definitions for the Firewalls
page of the Create Multiple Single Firewalls wizard. Otherwise, continue to the next step.

2) (Optional) If no more-specific NAT definitions match the traffic, select Use Default NAT Address for Traffic
from Internal Networks. This setting uses the default NAT address as the Public IP Address.

3) (Optional) Click Show Details to view the Default NAT Address properties.

4) Add or change the NAT definitions.

5) Click Next.
The Select Additional Configuration Options page opens.

Related tasks
Create multiple Single Firewall elements using the Create Multiple Single Firewalls wizard on page 474
Add NAT definitions for element-based NAT on page 646
Edit or remove NAT definitions for element-based NAT on page 647
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Select additional configuration options for
multiple Single Firewalls
On the Select Additional Configuration Options page, define optional properties for the Firewalls.

After defining the interfaces and routing, you have configured all mandatory properties for the Firewalls. We
recommend that you define all shared properties of the Firewalls in the wizard.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If you do not want to configure additional options, click Next on the Select Additional Configuration
Options page of the Create Multiple Single Firewalls wizard. Otherwise, continue to the next step.

2) To define tester settings, engine permissions, add-ons (settings for TLS inspection, transparent user
identification, or anti-malware), or advanced settings for the Firewalls, select Define Additional Firewall
Properties.

3) Click Next.

Define Tester settings for multiple Single
Firewalls
On the Define Tester Settings for the Firewalls page, you can set periodic self-tests for the Firewalls to ensure
that they function properly.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) On the Define Tester Settings for the Firewalls page of the Create Multiple Single Firewalls wizard, in the
Global Settings section, specify settings that are common to all tests.

2) Add test entries.

3) Click Next.
The Define Permissions for the Firewalls page opens.

Related concepts
Getting started with the engine tester on page 649

Related tasks
Select additional configuration options for multiple Single Firewalls on page 480
Specify global engine tester settings on page 650
Add engine tests on page 650
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Define NTP settings for multiple Single
Firewalls
You can configure NGFW Engines to use external NTP servers.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) On the Define NTP Settings for the Firewalls page, select Enable time synchronization from NTP
server.

2) To add a row to the table, click Add.

3) To add an NTP server, right-click the NTP Server cell, select Select, then select an NTP Server element.

4) (Optional) If there is more than one NTP server, select the preferred NTP server.

5) Click Next.
The Define Add-Ons for the Firewalls page opens.

Define permissions for multiple Single Firewalls
You can define which access control lists the Firewalls belong to, what permissions individual administrators
have, and which policies are allowed for the Firewalls.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) On the Define Permissions for the Firewalls page of the Create Multiple Single Firewalls wizard, define
administrator permissions on the Firewalls.

2) Select the permitted policies for the Firewalls.

3) Click Next.
The Define NTP Settings for the Firewalls page opens.

Related concepts
Getting started with administrator accounts on page 353
Getting started with engine permissions on page 657

Related tasks
Select additional configuration options for multiple Single Firewalls on page 480
Define administrator permissions for engines on page 658
Select allowed policies for engines on page 659
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Define Add-Ons for multiple Single Firewalls
On the Define Add-Ons for the Firewalls page, you can define settings for TLS inspection, transparent user
identification, browser-based user authentication, and anti-malware for the Firewalls.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) (Optional) On the Define Add-Ons for the Firewalls page of the Create Multiple Single Firewalls wizard,
select the appropriate Client Protection Certificate Authority element for TLS Inspection.

2) (Optional) Click Add and select the TLS Credentials  element. The selected elements are added to the list.

3) (Optional) Select the User Identification Service  element that the Firewall communicates with for
transparent user identification.

4) (Optional) Click User Authentication to enable browser-based user authentication.

5) (Optional) Select Anti-Malware to configure the anti-malware settings.

6) Click Next.
The Define Advanced Settings for the Firewalls page opens.

Related concepts
Configure anti-malware on engines on page 678
TLS inspection and how it works on page 1037
Enabling access control by user on page 1084

Related tasks
Select additional configuration options for multiple Single Firewalls on page 480
Configure TLS inspection for server protection on page 1042
Configure TLS inspection for client protection on page 1044
Enable browser-based user authentication on page 1108

Define advanced settings for multiple Single
Firewalls
On the Define Advanced Settings for the Firewalls page, you can define various system parameters and traffic
handling parameters for the Firewalls.

CAUTION:  Improper adjustments to some of the advanced settings can seriously degrade the
performance of the system.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) If you do not want to configure advanced settings, click Next on the Define Advanced Settings for the
Firewalls page of the Create Multiple Single Firewalls wizard, then select IP addresses as VPN endpoints
for multiple Single Firewalls.

2) Otherwise, adjust the advanced settings.

a) Adjust the system parameters of the Firewalls.

b) Adjust the traffic handling parameters of the Firewalls.

3) Click Next.

4) Continue the configuration in the next relevant topic.
• If you are creating the Firewall elements using POS codes, upload the multiple Single Firewall initial

configuration to the Installation Server.
• Otherwise, select IP addresses as VPN endpoints for multiple Single Firewalls.

Related tasks
Select additional configuration options for multiple Single Firewalls on page 480
Upload the multiple Single Firewall initial configuration to the Installation Server on page 485
Select a Firewall Policy for multiple Single Firewalls on page 486

Select IP addresses as VPN Gateway endpoints
for multiple Single Firewalls
On the Define End-Points for the Internal VPN Gateways page, you can define VPN endpoints (IP addresses)
for the Firewalls.

The endpoints are used when the Firewall acts as a gateway in a VPN. The same endpoint cannot be used in
both a policy-based VPN and in a Route-Based VPN Tunnel element. Each IP address can only be used once.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If you do not want to configure VPN gateway endpoints using the Create Multiple Single Firewalls wizard,
continue the configuration in one of the following ways:
• If you are creating the Firewall elements using POS codes, click Next twice, then upload the multiple

Single Firewall initial configuration to the Installation Server.
• Otherwise, click Next twice and select a Firewall Policy for multiple Single Firewalls.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Creating and modifying engine elements | 484

2) Otherwise, on the Define End-Points for the Internal VPN Gateways page of the Create Multiple Single
Firewalls wizard, select the IPv4/IPv6 addresses that you want to use as endpoints.
Typically, these IP addresses belong to interfaces toward the Internet, which are selected by default.
Both IPv4 and IPv6 addresses can be used as endpoints in IPsec VPN tunnels. Only IPv4 addresses are
supported as endpoints in SSL VPN tunnels or for access to the SSL VPN Portal. If you have more than
one Internet connection, select an IP address from each ISP to make Multi-Link load balancing and failover
possible.

3) To change the properties of an endpoint, right-click the name and select Properties.

a) (Optional) In the Name field, enter a name for the endpoint.

b) Optional) In the Mode list, select a mode to define how the endpoint is used in a Multi-Link configuration.
You can override the mode settings in each individual VPN.

c) (Optional) To activate encapsulation for NAT traversal in site-to-site VPNs, select a NAT-T option. NAT
device traversal might be needed at the local or remote gateway end.
The gateway always allows VPN clients to use NAT-T regardless of these settings. NAT-T always uses
the standard UDP port 4500.

Note:  The TCP Tunneling option is included for backward compatibility with legacy
Forcepoint NGFW software versions. Selecting this option has no effect on Forcepoint
NGFW version 5.9.0 or later.

d) (Optional) Review the phase-1 properties of the endpoints and change them, if necessary.

e) (Optional) To restrict the types of VPN configurations that the endpoints can be used in, select Selected
types only and select one or more of the following options:

• IPsec VPN — The endpoints can be used in IPsec tunnels in policy-based or route-based VPNs.
• SSL VPN Tunnel — The endpoints can be used in SSL VPN tunnels.
• SSL VPN Portal — The endpoints provide access to the SSL VPN Portal.

Note:  Only endpoints that have an IPv4 address can be used in SSL VPN tunnels or to
provide access to the SSL VPN Portal.

4) Click OK to close the Properties dialog box.

5) Click Next.
The Review and Edit Internal VPN Gateway End-Points page opens.

6) Review the endpoint details and change them, if necessary.

7) Click Next.

8) Continue the configuration in one of the following ways:
• If you are creating the Firewall elements using POS codes, upload the multiple Single Firewall initial

configuration to the Installation Server.
• Otherwise, select a Firewall Policy for multiple Single Firewalls.
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Related concepts
Defining VPN gateways on page 1149

Related tasks
Select a Firewall Policy for multiple Single Firewalls on page 486

Upload the multiple Single Firewall initial
configuration to the Installation Server
Uploading the initial configuration to the Installation Server makes the configuration available for use in plug-and-
play installations.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Make sure that Upload Initial Configuration is selected.

2) (Optional) Select Enable SSH Daemon to allow remote access to the engine command line. SSH access
can be helpful in remote troubleshooting.
• After management contact is established, you can enable and disable remote command-line access to

the engine at any time through the right-click menu of the engine. We recommend disabling SSH access
whenever it is not needed and making sure that your Access rules allow SSH access to the engines from
the administrators’ IP addresses only.

• While the Firewall Template does not allow these connections, the temporary policy activated right after
the engine’s initial configuration does allow SSH access from the Management Server’s IP address. (The
temporary policy is in effect until you install the working policy.) Alternatively, you can upload a working
policy to be installed on the Firewalls after they have contacted the Management Server.

CAUTION:  If you enable SSH, set the password for command-line access after the initial
configuration either through the Management Client or by logging on to the command
line. When the password is not set, anyone with SSH access to the engine can set the
password.

3) Select the Local Time Zone and the Keyboard Layout for use on the command line. The time zone setting
is only for displaying the time on the local console; the engines always use UTC (GMT) time internally. The
clock is automatically synchronized to match the Management Server’s time.

4) Click Next. The Review and Edit Local Time Zones page opens.

5) Review the local time zones of the Firewalls and change them, if necessary.

6) Click Next.
The Select a Policy to Install on the Firewalls page opens.

Related tasks
Select additional configuration options for multiple Single Firewalls on page 480
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Select a Firewall Policy for multiple Single
Firewalls
On the Select a Policy to Install on the Firewalls page, you can select a predefined policy to install on the
Firewalls after the Firewalls have contacted the Management Server for the first time.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Create Multiple Single Firewalls wizard, navigate to the Select a Policy to Install on the Firewalls
page.

2) If you do not want to select a policy to be installed on the Firewalls, click Next and proceed to the Summary
page. Click Finish to finish the creation of multiple Single Firewall elements.

3) Otherwise, click Select and select the Policy from the list.

4) Click Next.
The Summary page opens.

5) Review the details of the Firewalls you are about to create. To change a detail, click Previous to navigate
back to the correct wizard page, then click Next to navigate forward to the Summary page.

Note:  If you go back to the Define Interfaces for the Multiple Single Firewall Elements
page or an earlier page, you must redefine the interfaces that the Firewalls use for connecting
to the Internet.

6) Click Finish.
The multiple Single Firewall elements are created.

Related tasks
Select additional configuration options for multiple Single Firewalls on page 480

Create Firewall Cluster elements
Firewall Cluster elements consist of 2–16 physical firewall devices that work together as a single entity.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click NGFW Engines, then select New > Firewall > Firewall Cluster.

3) In the Name field, enter a unique name.
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4) Select the Log Server to which the Firewall Cluster sends its event data.

5) (Optional) In DNS IP Addresses field, add one or more DNS IP addresses.
DNS IP addresses are IP addresses of external DNS servers. Firewall Clusters use these DNS servers
to resolve Domain names to IP addresses. Firewall Clusters need DNS resolution to contact services that
are defined using URLs or domain names, and to resolve fully qualified domain names (FQDNs) used in
policies. When DNS relay is configured, these DNS servers are used unless domain-specific DNS servers
are specified in a DNS Relay Profile element.

Note:  If you have defined NetLink-specific DNS IP addresses, adding DNS IP addresses
overrides the NetLink-specific DNS IP addresses.

• To enter a single IP address manually, click Add, then select IP Address. Enter the IP address in the
dialog box that opens.

• To define an IP address using a network element, click Add, then select Network Element.

6) Select the Location for this engine if there is a NAT device between this Firewall Cluster and other SMC
components.

7) (Optional) If you want to include the Firewall Clusters in predefined categories, select the appropriate
Categories.

8) (Optional) If you want to add custom commands to the Firewall Cluster's right-click menu, add a Tools
Profile.

Related concepts
Defining Host elements on page 898
Configuring interfaces for Firewalls on page 543

Related tasks
Attach Tools Profile elements to elements on page 120
Create Location elements on page 129
Select Categories for elements on page 171
Activate the SNMP agent on NGFW Engines on page 670
Define External DNS Server elements on page 780

Create multiple Firewall Cluster elements using
the Create Multiple Firewall Clusters wizard
You can create multiple Firewall Cluster elements at the same time using the Create Multiple Firewall Clusters
wizard.

Once you have created the Firewall Clusters through the wizard, you can change the properties of each cluster.
You can also change some shared properties of several Firewall Clusters at the same time. It is not possible to
use plug-and-play configuration with multiple Firewall Clusters.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Creating and modifying engine elements | 488

Related concepts
Defining Host elements on page 898

Related tasks
Attach Tools Profile elements to elements on page 120
Create Location elements on page 129
Select Categories for elements on page 171
Add nodes to clusters on page 508
Activate the SNMP agent on NGFW Engines on page 670
Define External DNS Server elements on page 780

Start the Create Multiple Firewall Clusters
wizard
Start the Create Multiple Firewall Clusters wizard and define general settings for the Firewall Cluster elements.

Before you begin
You must have an existing Firewall Cluster element on which to base the configuration.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click NGFW Engines and select New Firewall > Multiple Firewall Clusters.
The Create Multiple Firewall Clusters wizard opens.

3) Enter the Number of Firewall Cluster elements (1-1000).

4) Select a Firewall Cluster on which you want to base the Firewall Clusters’ configuration from the Base
Configuration on list and click Next.
The Define Basic Firewall Information page opens.

5) Enter a common Name Prefix.
The SMC adds a running number to the name prefix to generate a unique name for each Firewall Cluster.

6) Select a Log Server to which the Firewall Clusters send their event data.

Note:  Name Prefix and Log Server are the only mandatory properties you must define
at this stage. Review the other properties carefully to see which ones to define as shared
properties for all Firewall Clusters created with the wizard.
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7) (Optional) In DNS IP Addresses field, add one or more DNS IP addresses.
DNS IP addresses are IP addresses of external DNS servers. Firewall Clusters use these DNS servers
to resolve Domain names to IP addresses. Firewall Clusters need DNS resolution to contact services that
are defined using URLs or domain names, and to resolve fully qualified domain names (FQDNs) used in
policies. When DNS relay is configured, these DNS servers are used unless domain-specific DNS servers
are specified in a DNS Relay Profile element.

Note:  If you have defined NetLink-specific DNS IP addresses, adding DNS IP addresses
overrides the NetLink-specific DNS IP addresses.

• To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the
dialog box that opens.

• To define an IP address using a network element, click Add and select Network Element.

8) Select the Location for this Firewall Cluster if there is a NAT device between this Firewall Cluster and
other SMC components.

Note:  Select a Location only if all Firewall Clusters you create with the wizard belong to
the same Location element.

9) Define other settings according to your environment:
• If you want to include the Firewall Clusters in predefined categories, select the appropriate Categories.
• If you want to add custom commands to the Firewall Clusters’ right-click menu, add a Tools Profile.
• Add, change, or remove nodes as needed.

10) Click Next.
The Review and Edit Names and Comments page opens.

11) Review the names of the Firewall Clusters. If necessary, right-click the name or comment and select Edit
Name or Edit Comment.

12) Click Next.
The Define Interfaces for the Multiple Firewall Elements page opens.

Define interfaces for multiple Firewall Clusters
You must define at least one layer 3 physical interface and one IPv4 address for the Firewall Clusters.

The following interface types are available:
• Layer 3 physical interface for Ethernet connections
• VLAN interface for dividing a single physical network link into several virtual links
• Tunnel interface that defines a tunnel endpoint in route-based VPNs

The same interface properties are available for every Firewall Cluster element in the Engine Editor. However, we
recommend that you configure all shared interface properties in the wizard. After you exit the wizard, you must
configure the properties separately for each Firewall Cluster.

The interface properties you define for the first Firewall Cluster are used to automatically create the
corresponding properties for the rest of the Firewall Clusters. These properties include the IP addresses, which
are automatically generated in numeric order. Make sure that the IP addresses assigned to the Firewall Clusters
are not used by any other components.
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To use a layer 3 physical interface for communication with the Management Server, begin by defining a layer 3
physical interface with an IP address. This way, the layer 3 physical interface is assigned interface ID 0. When
connecting the cables to the appliance, connect the cable for the control connection to Ethernet port 0. See the
Forcepoint Next Generation Firewall Installation Guide for detailed information about mapping the interface IDs
with specific ports on the appliances.

Note:  On Firewall Clusters, the routing information is configured simultaneously for all cluster
nodes and all nodes always have identical routing tables.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Click Add and select the type of interface. Add the required number of network interfaces in the following
order:
• Define layer 3 physical interfaces.
• (Optional) Define tunnel interfaces.

2) (Optional, physical interfaces only) Add the required number of VLANs.

3) Configure the IP address settings for the first one of the Firewall Clusters.

4) (Optional) Click Options to configure Loopback IP addresses.

5) (Recommended) Click Options to define which IP addresses are used in particular roles in system
communications.

6) (Optional) Configure more routing settings:
• Add static ARP entries.
• Configure Multicast Routing.

7) Click Next.
The Review and Edit Firewall Interfaces page opens.

8) Review the interfaces and edit them, if necessary. Click Next.

9) Define and review the routing. Click Next.

10) Click Next.
The Define NAT Definitions for the Firewalls page opens.

Related concepts
Loopback IP addresses for firewalls on page 570
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Related tasks
Define routing for multiple Single Firewalls on page 478
Add layer 3 physical interfaces for NGFW Engines in the Firewall/VPN role on page 544
Add VLAN interfaces for firewalls on page 549
Add tunnel interfaces for firewalls on page 556
Select system communication roles for firewall interfaces on page 569
Activate the internal DHCP server on a firewall interface on page 572
Configure advanced properties for firewall interfaces on page 559
Add manual ARP entries to NGFW Engines on page 624

Add NAT definitions for multiple Firewall
Clusters
On the Define NAT Definitions for the Firewalls page, you can define how the Firewall Clusters translate
network addresses.

NAT rules are automatically generated and organized in the Firewall Policy based on the NAT definitions created
in the Firewall properties.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If you do not want to configure NAT definitions, click Next.

2) (Optional) To use the default NAT address as the Public IP Address, select Use Default NAT Address for
Traffic from Internal Networks. Select this option when there is not a more specific NAT definition matching
the traffic.

3) (Optional) Click Show Details to view the Default NAT Address properties.

4) Add or edit the NAT definitions.

5) Click Next.

Next steps

You are now ready to select additional configuration options for multiple Firewall Clusters.

Related tasks
Add NAT definitions for element-based NAT on page 646
Edit or remove NAT definitions for element-based NAT on page 647



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Creating and modifying engine elements | 492

Select additional configuration options for
multiple Firewall Clusters
You can define more properties for the Firewall Clusters on the Select Additional Configuration Options page.

We recommend that you define all shared properties of the Firewall Clusters in the wizard.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If you do not want to configure additional options, click Next. Otherwise, continue to the next step.

2) To define more properties for the Firewall Clusters, select Define Additional Firewall Properties.

a) (Optional) Define tester settings.

b) (Optional) Define NTP settings.

c) (Optional) Define permissions.

d) (Optional) Define advanced settings.

3) On the Summary page, review the details of the Firewall Clusters you are about to create.

Tip:  To edit a detail, click Previous to navigate back to the correct wizard page, then click
Next to navigate forward to the Summary page.

4) Click Finish to add multiple Firewall Cluster elements to your system.

Related tasks
Define Tester settings for multiple Single Firewalls on page 480
Define permissions for multiple Single Firewalls on page 481
Define advanced settings for multiple Single Firewalls on page 482

Define NTP settings for multiple Firewall
Clusters
You can configure NGFW Engines to use external NTP servers.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) On the Define NTP Settings for the Firewalls page, select Enable time synchronization from NTP
server.

2) To add a row to the table, click Add.
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3) To add an NTP server, right-click the NTP Server cell, select Select, then select an NTP Server element.

4) (Optional) If there is more than one NTP server, select the preferred NTP server.

5) Click Next.

Create Single IPS elements
Single IPS elements represent IPS engines that consist of one physical IPS device.

Single IPS elements can be later converted to IPS clusters.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click  NGFW Engines  and select New > IPS > Single IPS.

3) In the Name field, enter a unique name.

4) Select the Log Server to which the IPS engine sends its event data.

5) (Optional) In DNS IP Addresses field, add one or more DNS IP addresses.
DNS IP addresses are IP addresses of external DNS servers. IPS engines use these DNS servers to resolve
Domain names to IP addresses. IPS engines need DNS resolution to contact services that are defined using
URLs or domain names, and to resolve fully qualified domain names (FQDNs) used in policies.
• To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the

dialog box that opens.
• To define an IP address using a network element, click Add and select Network Element.

6) Select the Location for this engine if there is a NAT device between this IPS engine and other SMC
components.

7) (Optional) If you want to include the IPS engine in predefined categories, select the appropriate Categories.

8) (Optional) If you want to add custom commands to the IPS engine’s right-click menu, add a Tools Profile.

Next steps

You are now ready to configure interfaces for the Single IPS.

Related concepts
Defining Host elements on page 898
Configuring interfaces for IPS engines on page 574
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Related tasks
Attach Tools Profile elements to elements on page 120
Create Location elements on page 129
Select Categories for elements on page 171
Convert a Single IPS element to an IPS Cluster element on page 504
Activate the SNMP agent on NGFW Engines on page 670
Define External DNS Server elements on page 780

Create IPS Cluster elements
IPS Cluster elements combine 2–16 physical IPS devices into a single entity.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click NGFW Engines and select New > IPS > IPS Cluster.
The Engine Editor opens.

3) Give the element a unique Name.

4) Select the Log Server to which the IPS Cluster sends its event data.

5) (Optional) In DNS IP Addresses field, add one or more DNS IP addresses.
DNS IP addresses are IP addresses of external DNS servers. IPS Clusters use these DNS servers to
resolve Domain names to IP addresses. IPS engines need DNS resolution to contact services that are
defined using URLs or domain names, and to resolve fully qualified domain names (FQDNs) used in policies.
• To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the

dialog box that opens.
• To define an IP address using a network element, click Add and select Network Element.

6) Select the Location for this engine if there is a NAT device between this IPS Cluster and other SMC
components.

7) (Optional) If you want to include the IPS Clusters in predefined categories, select the appropriate
Categories.

8) (Optional) If you want to add custom commands to the IPS Cluster's right-click menu, add a Tools Profile.

Next steps

You are now ready to configure interfaces for the IPS Cluster.
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Related concepts
Defining Host elements on page 898
Configuring interfaces for IPS engines on page 574

Related tasks
Attach Tools Profile elements to elements on page 120
Create Location elements on page 129
Select Categories for elements on page 171
Activate the SNMP agent on NGFW Engines on page 670
Define External DNS Server elements on page 780

Create Single Layer 2 Firewall elements
Single Layer 2 Firewall elements represent Layer 2 Firewalls that consist of one physical device.

Single Layer 2 Firewall elements can be later converted to Layer 2 Firewall Clusters.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click NGFW Engines and select New > Layer 2 Firewall > Single Layer 2 Firewall.

3) Give the element a unique Name.

4) Select the Log Server to which the Layer 2 Firewall engine sends its event data.

5) (Optional) In DNS IP Addresses field, add one or more DNS IP addresses.
DNS IP addresses are IP addresses of external DNS servers. Layer 2 Firewalls use these DNS servers to
resolve Domain names to IP addresses. Layer 2 Firewalls need DNS resolution to contact services that are
defined using URLs or domain names, and to resolve fully qualified domain names (FQDNs) used in policies.
• To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the

dialog box that opens.
• To define an IP address using a network element, click Add and select Network Element.

6) (Optional) Define one or more DNS IP Addresses. The Layer 2 Firewall engine uses the IP addresses of
DNS servers to resolve domain names and URL filtering categorization services (defined as URLs). There
are two ways to define IP addresses.
• To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the

dialog box that opens.
• To define an IP address using a network element, click Add and select Network Element.

7) Select the Location for this engine if there is a NAT device between this Layer 2 Firewall engine and other
SMC components.
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8) (Optional) If you want to include the Layer 2 Firewall engine in predefined categories, select the appropriate
Categories.

9) (Optional) If you want to add custom commands to the Layer 2 Firewall engine’s right-click menu, add a
Tools Profile.

Next steps

You are now ready to configure interfaces for the Single Layer 2 Firewall.

Related concepts
Defining Host elements on page 898
Configuring interfaces for Layer 2 Firewalls on page 588

Related tasks
Attach Tools Profile elements to elements on page 120
Create Location elements on page 129
Select Categories for elements on page 171
Activate the SNMP agent on NGFW Engines on page 670
Define External DNS Server elements on page 780

Create Layer 2 Firewall Cluster elements
Layer 2 Firewall Cluster elements combine 2–16 physical Layer 2 Firewall devices into a single entity.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click NGFW Engines and select New > Layer 2 Firewall > Layer 2 Firewall Cluster.
The Engine Editor opens.

3) Give the element a unique Name.

4) Select the Log Server to which the Layer 2 Firewall Cluster sends its event data.

5) (Optional) In DNS IP Addresses field, add one or more DNS IP addresses.
DNS IP addresses are IP addresses of external DNS servers. Layer 2 Firewall Clusters use these DNS
servers to resolve Domain names to IP addresses. Layer 2 Firewall Clusters need DNS resolution to
contact services that are defined using URLs or domain names, and to resolve fully qualified domain names
(FQDNs) used in policies.
• To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the

dialog box that opens.
• To define an IP address using a network element, click Add and select Network Element.
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6) Select the Location for this engine if there is a NAT device between this Layer 2 Firewall Cluster and other
SMC components.

7) (Optional) If you want to include the Layer 2 Firewall Clusters in predefined categories, select the appropriate
Categories.

8) (Optional) If you want to add custom commands to the Layer 2 Firewall Cluster's right-click menu, add a
Tools Profile.

Next steps

You are now ready to configure interfaces for the Layer 2 Firewall Cluster.

Related concepts
Defining Host elements on page 898
Configuring interfaces for Layer 2 Firewalls on page 588

Related tasks
Attach Tools Profile elements to elements on page 120
Create Location elements on page 129
Select Categories for elements on page 171
Activate the SNMP agent on NGFW Engines on page 670
Define External DNS Server elements on page 780

Duplicate existing engine elements
If you have similar configurations at several sites, you can duplicate an existing engine element to reduce the
need for manual configuration.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the existing engine element and select New > Duplicate.
The Engine Editor opens.

2) Give the engine element a unique Name.

3) Adjust the rest of the properties as needed.
Change at least the IP address used for communication with the Management Server. (Or configure the
duplicated element to use a different control IP address.) The control IP address must be unique for each
engine.

4) Click OK.
The new engine element is added to the element tree.
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Related concepts
Network interfaces for engines on page 539

Related tasks
Edit individual engine elements on page 498

Editing existing engine elements
You can change the properties of an individual engine element or the common properties shared by several
engine elements.

Existing engine elements are shown in the Home view under engine-specific branches. Firewall, IPS, and Layer
2 Firewall elements are shown in the Configuration view under the NGFW Engines branch. Changing the
common properties of several engine elements restricts you to actions and values that are applicable to all
engine elements at the same time. You can also convert a Single Firewall, a Single IPS engine, or a Single Layer
2 Firewall into a cluster.

Related concepts
Changing control IP addresses for engines on page 509
Configuration of Master NGFW Engines and Virtual NGFW Engines on page 515

Related tasks
Edit several engines at once on page 499
Convert a Single IPS element to an IPS Cluster element on page 504
Convert a Single Layer 2 Firewall element to a Layer 2 Firewall Cluster element on page 506
Add nodes to clusters on page 508

Edit individual engine elements
You can change the properties specific to one individual engine element, such as IP address definitions, by
editing the engine element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine, then select Edit <element type>.

3) Use the navigation pane on the left to find the settings that you want to edit.

4) Edit the configuration information as required.
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5) Select from the following:
• To validate the changes, select  Tools > Validate.
• To validate and save the changes, click  Save.
• To validate and save the changes and refresh the security policy on the engine, click  Save and

Refresh.

Note:  Validation issues are displayed in the Issues pane. Double-click an issue to return to
the section in which the issue can be fixed.

Edit several engines at once
You can select several engine elements and change the properties common to all engine.

The following limitations apply when you change the properties of several engines at once:
• Properties specific to one individual engine element, such as IP address definitions, are never available in the

common properties.
• If you select both single and clustered engine elements, the cluster-specific options are not available.
• If you select elements of different types, you can only set the Log Server, Location, SNMP Agent, and

Comment options and some system parameters.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Shift-select or Ctrl-select the engine elements you want to change.

2) Right-click one of the selected items and select Common Properties.

3) Select the options you want to set for all selected engines.
The options you see depend on how similar in type the selected engines are

4) Click OK.
All selected engines now use the same settings for the options that you changed.

Convert Single Firewall elements to Firewall
Cluster elements
You can use a conversion tool to change an existing Single Firewall engine into a Firewall Cluster.

The conversion tool maintains the relationship of the engine element with other configurations in the system,
allows you to maintain some existing interface configurations, and minimizes service interruptions. VPNs are an
example of other configurations in the system. VLANs defined on interfaces are an example of existing interface
configurations. The conversion requires you to select one Single Firewall element to convert to a cluster.

Make sure that enough IP addresses are available, especially if the Single Firewall is managed remotely. Each
clustered engine node needs at least one dedicated IP address for its management communications. Also, the
traffic that the nodes inspect requires at least one dedicated IP address per cluster.
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The following limitations apply when you convert Single Firewall elements to Firewall Cluster elements:
• It is not possible to combine two Single Firewall elements into a Firewall Cluster.
• A Single Firewall engine can only be converted to a two-node Firewall Cluster. If you want to add more nodes

to the cluster, you must add the nodes separately after the conversion.
• Due to differences in the supported configurations, there are some configurations that prevent you from

converting from a Single Firewall to a Firewall Cluster. These configurations are listed in the following table.

Table 48: Unsupported configurations on Firewall Clusters

Configuration Notes

ADSL interfaces Firewall clusters do not support integrated ADSL modems. To convert to a cluster, you must
switch to an external ADSL modem that the firewall engines access through an Ethernet
connection.

Wireless
interfaces

Firewall clusters do not support wireless interfaces.

Internal DHCP
Server on older
engine versions

Clustered firewalls support an internal DHCP server starting from software version 5.2.
Upgrade the engine as necessary before conversion.

Dynamic IP
addresses

Firewall clusters can only have static IP addresses. Clusters cannot use a dynamically
assigned (DHCP or PPPoE) IP address.

Modem
interfaces

Firewall clusters do not support integrated 3G modems. You must switch to a configuration
that uses an external 3G modem through an Ethernet connection to convert to a cluster.

Integrated switch Firewall clusters do not support integrated switches. To convert to a cluster, you must
change to a configuration that uses an external switch that the firewall engines access
through an Ethernet connection.

CAUTION:  If you change the control IP address of the existing node in this process, the
connection between the engine and the SMC is lost.

Prepare to convert a Single Firewall element to
a Firewall Cluster element
You must change the configuration of the Single Firewall element before you can convert it to a Firewall Cluster
element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If you are not using identical hardware, make sure that the performance levels match your needs.
Equipment with different performance levels can be used for balancing the load between the clustered
engines. For high availability when one engine is offline, the other engine must be able to handle all traffic
alone.
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2) Make sure that both firewall engines have their own license.
Firewall Clusters are licensed in the same way as two Single Firewall engines. All current firewall engine
licenses allow clustering the nodes, so no license changes are required to activate clustering.

3) Make sure that the engines are running software versions that are compatible with the Security Management
Center, and preferably that both engines are running the same version.
Although the cluster can be installed with engines running different software versions (unless otherwise
stated in the Release Notes), long-term use with mismatched versions is not supported.

4) If the firewall engine you are adding to the cluster already has a working configuration from previous use,
return it to the initial configuration state. You can set up the initial configuration state in the NGFW Initial
Configuration Wizard (sg-reconfigure) on the command line.
Do not establish a connection with the Management Server before the Firewall Cluster element is ready.

CAUTION:  If the Firewall engine has a working configuration, it goes online and processes
traffic when you power it on to configure it for the Firewall Cluster.

5) Connect the network cables to the new firewall engine and power it on.

Related concepts
Considerations for working on the engine command line on page 345
Getting Started with licenses on page 1305

Related tasks
Upgrade engines remotely on page 1324

Convert a Single Firewall element to a Firewall
Cluster element
Converting a Single Firewall to a Firewall Cluster requires you to convert the IP addresses used for these roles to
the correct types.

Firewall Clusters have more IP addressing requirements than Single Firewalls. The requirements are due to the
two types of IP addresses that clusters must have to function:
• An NDI (Node Dedicated IP Address) is used for communications between the engine itself and some other

host in the network. Other hosts can be other nodes in the cluster, the Management Server, or hosts you ping
from the engine’s command line.

• A CVI (Cluster Virtual IP Address) is used for handling traffic that the cluster examines. If other network
devices select the firewall’s IP address, converting the IP address to a CVI allows those external
configurations to remain the same. (Examples of other network devices are a default gateway or VPN
endpoint.)

You must change the IP address that is used for a particular role if the new interface type is not compatible with
that role.

The IP address requirements and related important considerations are listed in the following table.

https://support.forcepoint.com/Documentation
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Table 49: Interface type requirements by role on Firewall Clusters

Role Type Required Notes

Control interface
(Management
connections)

NDI Each node requires its own NDI address. Often, the same IP address on
a Single Firewall is used for both the engine’s own communications and
the traffic that the engine processes. In these cases, you can convert the
IP address that processes the traffic to a CVI. With the conversion, you
can avoid reconfiguring external equipment and you can add new NDI
addresses for the nodes.
Make sure that there are enough IP addresses available, especially if the
firewall is managed remotely.

DHCP relay CVI Configured in the physical interface properties.

DHCP relay for
VPN clients

NDI Configured in the VPN settings in the Engine Editor.

Heartbeat
interface

NDI Heartbeat and state synchronization communications between clustered
engines. We recommend using a dedicated interface for the heartbeat,
as reliable transmissions are critical to the operation of the cluster. If the
heartbeat traffic passes through a switch, make sure that the switch does
not throttle or block multicast traffic between the clustered engines.

Routing CVI Traffic that is sent to an NDI address is not routed to any other
destinations.
Surrounding network devices that use the firewall as a default gateway
must use a CVI address.

If the internal DHCP server is used and configured to assign the firewall
as the default gateway for clients, the default gateway IP address must be
a CVI. (Configure the CVI in the physical interface properties.)

VPN endpoints CVI Configured in the VPN settings in the Engine Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If you plan to convert the current IP address for management connections to a CVI:

a) Add the new NDI IP address as a Backup Control IP address in the Single Firewall element.

b) Adjust the Access and NAT rules of any firewalls on the communications path so that both current and
new control IP addresses can be used. Then refresh the policies of these firewalls.

c) Refresh the policy of the Single Firewall you plan to convert.

d) Deselect the Backup Control IP address option and configure the new NDI control IP address as the
Primary Control IP address.

Note:  We recommend that you do not use the IP address of an Aggregated Link
interface as the primary or secondary control IP address of the engine.

2) Add any new IP addresses that are required for the selected interface roles and configure the settings to
use those IP addresses.
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3) If configured, remove dynamic IP addresses, Modem Interfaces, ADSL Interfaces, integrated Switches,
and Port Group Interfaces. These configurations are not supported on clusters.

4) Right-click the Single Firewall element and select Configuration > Upgrade to Cluster.
An interface mapping dialog box opens.

5) Click the Upgrade to cell for each interface and select the IP address types for the interfaces.
• You can select both a CVI and an NDI to be created for the same physical interface. This working

configuration is recommended for all interfaces. However, it might not be appropriate at this stage,
because you cannot select which role the current IP address takes. More IP addresses are generated
automatically to create the CVIs and NDIs.

• Each selection is validated and you might not be able to select a type if it is incompatible with the
selected role of the interface. See the preceding table for a summary of requirements.

6) Click OK.
The Cluster Properties dialog box for the new Firewall Cluster element opens.

7) Switch to the Interfaces tab.

8) In addition to the Physical interfaces and IP addresses used on the Single Firewall, add the interfaces
and addresses needed for the cluster. Check that the IP addresses on all interfaces are unique and
unassigned, and change them if necessary.

9) Select Packet Dispatch as the CVI mode and enter the related unicast MAC address in the properties of
all Physical Interfaces that have CVI definitions.

10) Click Options and define which IP addresses are used in particular roles in system communications as
explained in Setting Interface Options for Firewalls (page 489).

11) If the internal DHCP server is used and configured to assign the firewall as the default gateway for clients,
verify that the default gateway IP address is a CVI. (See Physical Interface properties on the DHCP tab.)

12) Click OK.
You can still click Cancel to return to the previous configuration and undo the conversion.
The Single Firewall element is converted to a Firewall Cluster.

Related concepts
Network interfaces for engines on page 539

Related tasks
Select system communication roles for firewall interfaces on page 569



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Creating and modifying engine elements | 504

Activate the engine configuration after
converting a Single Firewall element to a
Firewall Cluster element
You must activate the new configuration to finish converting a Single Firewall element to a Firewall Cluster
element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If any external device uses the firewall as a default gateway or VPN endpoint and the previously used IP
address is converted to an NDI, reconfigure the external equipment to reference a CVI address.

2) Run the NGFW Initial Configuration Wizard on the command line (sg-reconfigure) or in a web browser.

3) Make sure the interface IDs are mapped correctly to network ports according to the engine’s cabling.

4) Make initial contact between the engine node and the Management Server.
Install and configure any new engine nodes as part of the cluster as in a new installation.

5) Install the policy on the cluster.
To refresh the policy of the existing node before the new nodes are initialized, set the inactive nodes in the
cluster element’s properties to disabled. (See the Cluster tab.) Otherwise, the policy installation fails due to a
lack of connectivity to all nodes.

If there are problems with the clustered configuration, you can return to single-node operation. To do so,
command one node offline through the right-click menu or through the command line.

Related concepts
Connect engines to the SMC on page 641

Convert a Single IPS element to an IPS Cluster
element
You can convert an existing Single IPS element to an IPS Cluster element.

Converting a Single IPS element to an IPS Cluster element maintains the relationship of the engine element with
other configurations in the system. The conversion requires you to select one Single IPS element to convert to an
IPS Cluster.

The following limitations apply when you convert a Single IPS to an IPS Cluster:
• It is not possible to combine two Single IPS elements into an IPS Cluster element.
• A Single IPS engine can only be converted to a two-node IPS Cluster. If you want to add more nodes to the

cluster, you must add the nodes separately after the conversion.

CAUTION:  If you change the control IP address of the existing node in this process, the
connection between the engine and the SMC is lost.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Make sure that both engines are licensed.
The licensing of clustered engine nodes is done in the same way as the licensing of two Single IPS
engines. All current IPS engine licenses allow clustering the nodes, so no license changes are required to
activate the feature.

2) Make sure that the engines are running software versions that are compatible with the Security
Management Center, and preferably that both engines are running the same version.
Although the cluster can be installed with the engines running different software versions (unless otherwise
stated in the Release Notes), long-term use with mismatched versions is not supported.

3) If the new IPS engine you want to add to the IPS Cluster already has a working configuration from
previous use, return it to the initial configuration state.
You can do so in the NGFW Initial Configuration Wizard (sg-reconfigure) on the command line.

Note:  Do not establish a connection with the Management Server before the IPS Cluster
element is ready.

4) Connect the network cables to the new node and power it on.

5) Right-click the Single IPS element that you want to upgrade to an IPS Cluster and select Configuration >
Upgrade to Cluster.
The Engine Editor opens.

6) Browse to Interfaces > Interface Options in the navigation pane on the left.

7) Define which IP addresses are used in particular roles in system communications.

8) Click  Save.

Note:  You can still close the Engine Editor without saving the changes to return to the
previous configuration and undo the conversion.

The Single IPS engine is converted to an IPS Cluster element.

9) Make initial contact between each node and the Management Server.
Install and configure any new engine nodes as part of the cluster as in a new installation.

10) Install the policy on the IPS Cluster.
To refresh the policy of the existing node before the new nodes are initialized, disable the inactive nodes
on the Clustering pane in the Engine Editor. Otherwise, the policy installation fails due to a lack of
connectivity to all nodes.

https://support.forcepoint.com/Documentation
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Related concepts
Considerations for working on the engine command line on page 345
Changing control IP addresses for engines on page 509
Connect engines to the SMC on page 641
Getting Started with licenses on page 1305
Getting started with upgrading NGFW Engines on page 1321

Related tasks
Add nodes to clusters on page 508
Select system communication roles for IPS interfaces on page 587

Convert a Single Layer 2 Firewall element to a
Layer 2 Firewall Cluster element
You can use a conversion tool to convert an existing Single Layer 2 Firewall to a Layer 2 Firewall Cluster.

Using the conversion tool maintains the relationship of the Single Layer 2 Firewall element and other
configurations in the system. The conversion requires you to select one Single Layer 2 Firewall element to
convert to a Layer 2 Firewall Cluster.

The following limitations apply when you convert a Single Layer 2 Firewall to a Layer 2 Firewall Cluster:
• It is not possible to combine two Single Layer 2 Firewall elements into a Layer 2 Firewall Cluster element.
• A Single Layer 2 Firewall can only be converted to a two-node Layer 2 Firewall Cluster. To add more nodes to

the cluster, add the nodes separately after the conversion.

CAUTION:  If you change the control IP address of the existing node in this process, the
connection between the engine and the SMC is lost.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Make sure that both engines are licensed.
The licensing of clustered engine nodes is done in the same way as the licensing of two Single Layer 2
Firewall engines. All current Layer 2 Firewall engine licenses allow clustering the nodes, so no license
changes are required to activate the feature.

2) Make sure that the engines are running software versions that are compatible with the SMC, and
preferably that both engines are running the same version.
Although the cluster can be installed with the engines running different software versions (unless otherwise
stated in the Release Notes), long-term use with mismatched versions is not supported.

https://support.forcepoint.com/Documentation
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3) If the new Layer 2 Firewall engine has a working configuration from previous use, return it to the initial
configuration state.
You can do so in the NGFW Initial Configuration Wizard (sg-reconfigure) on the command line.

Note:  Do not establish a connection with the Management Server before the Layer 2
Firewall Cluster element is ready.

4) Connect the network cables to the new node and power it on.

5) Right-click the Single Layer 2 Firewall element that you want to upgrade to a Layer 2 Firewall Cluster and
select Configuration > Upgrade to Cluster.
The Engine Editor opens.

6) Browse to Interfaces > Interface Options in the navigation pane on the left.

7) Define which IP addresses are used in particular roles in system communications.

8) Click  Save.

Note:  You can still close the Engine Editor without saving the changes to return to the
previous configuration and undo the conversion.

The Single Layer 2 Firewall engine is converted to a Layer 2 Firewall Cluster element.

9) Make initial contact between each node and the Management Server.
Install and configure any new engine nodes as part of the cluster as in a new installation.

10) Install the policy on the Layer 2 Firewall Cluster.
To refresh the policy of the existing node before the new nodes are initialized, disable the inactive nodes
on the Clustering pane in the Engine Editor. Otherwise, the policy installation fails due to a lack of
connectivity to all nodes.

Related concepts
Considerations for working on the engine command line on page 345
Changing control IP addresses for engines on page 509
Connect engines to the SMC on page 641
Getting Started with licenses on page 1305
Getting started with upgrading NGFW Engines on page 1321

Related tasks
Select system communication roles for Layer 2 Firewall interfaces on page 601
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Add nodes to clusters
By default, the Engine Editor displays two nodes in the Clustering pane. You can add new nodes to the cluster.

Before you begin
Before adding a node to the configuration, install the physical engine device and connect the cables.
At a minimum, connect the cables for the interfaces that enable communication with the Management
Server and between the clustered engines.

If the device has a working configuration from previous use, use the NGFW Initial Configuration Wizard
(sg-reconfigure) on the command line to return the device to the initial configuration state. Set up the
initial configuration state before connecting the device to the network. Do not make initial contact with
the Management Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the cluster and select Edit <element type>.

2) In the navigation pane on the left, browse to General > Clustering.

3) Click Add Node.

4) Give the node a unique Name.

5) In the Nodes table, review and update the information in the IP Address, Contact IP Address, and
Comment columns for each NDI. (Double-click the value you want to change.)
Firewall CVI details are identical between the nodes, so adding a node to a Firewall Cluster does not
require changing the CVI configuration in any way.

6) Click OK.

7) Click  Save.

8) Save the initial configuration for the new engine node to create a one-time password.

9) Make initial contact between the new engine and the Management Server.

10) Refresh the policy of the cluster to transfer the changes to the engines.
To refresh the policy of the existing node before the new nodes are initialized, disable the inactive nodes
on the Clustering pane in the Engine Editor. Otherwise, the policy installation fails due to a lack of
connectivity to all nodes.

Related concepts
Connect engines to the SMC on page 641
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Changing control IP addresses for engines
You can change an engine’s control IP address without losing management connectivity.

When you change IP addressing, other connections between the different components might be temporarily lost.
You must make sure that the connections return to normal after the IP address changes.

Note:  We recommend that you do not use the IP address of an Aggregated Link interface as the
primary or secondary control IP address of the engine.

Related tasks
Change engine control IP addresses within the same network on page 509
Change engine control IP addresses to a different network on page 510

Change engine control IP addresses within the
same network
You can change the control IP address of an engine to a new address that belongs to the same network as the
old address.

The new control IP addresses of IPS engines and Layer 2 Firewalls must always belong to the same network as
the existing control IP addresses. If management connectivity is no longer needed, change the control IP address
in the SMC and reinitialize the engine through the command line using a new one-time password.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If you have an IP-address-bound license for the engine, request a new Management Server POL code
bound license at https://stonesoftlicenses.forcepoint.com.
This change is required, because IP-address-bound licenses are no longer supported.

2) Install and bind the new license to the engine.

3) In the Engine Editor, create an interface for the new IP address and set the address as the backup control IP
address.

4) Install the policy on the engine.
From this point on, you can start using the new address in the network.

5) In the Engine Editor, set the old and new control IP addresses as the backup and primary control IP
addresses, respectively.

Note:  If your engine cannot use the old and new control IP addresses simultaneously,
remove the old control IP address from the Interfaces pane in the Engine Editor. Also remove
the corresponding network from the Routing pane in the Engine Editor.

6) Click  Save and Refresh.

7) Remove the old control IP address from the Interfaces pane and the Routing pane in the Engine Editor.

https://stonesoftlicenses.forcepoint.com
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8) Click  Save and Refresh again.

Note:  If the connection with the Management Server is lost while you try to change IP
addressing, run the NGFW Initial Configuration Wizard (sg-reconfigure) on the engine
command line. This action returns the engine to the initial configuration state and re-
establishes initial contact between the engine and the Management Server.

Related concepts
Network interfaces for engines on page 539
Management connections for engines and how they work on page 639
Connect engines to the SMC on page 641
Getting started with routing on page 701
Getting Started with licenses on page 1305

Change engine control IP addresses to a
different network
You can change the control IP address of a Firewall to a new IP address in a different network than the old one.

Because these steps require the configuration of Outbound Multi-Link, you can only change the control IP
address of Firewalls to a different network. For all other engine roles, you must change the IP address within the
same network.

If management connectivity is no longer needed, change the control IP address in the SMC and reinitialize the
engine through the command line using a new one-time password.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If you have an IP-address-bound license for the engine, request a new Management Server POL code
bound license at https://stonesoftlicenses.forcepoint.com.
This change is required, because IP-address-bound licenses are no longer supported.

2) Install and bind the new license to the engine.

3) Edit the Single Firewall or Firewall Cluster element in the Engine Editor and add an interface.
• Define the new primary control address as the backup control IP address.
• If your firewall is a cluster and you do not want to lose any connections, also define a new CVI for the

cluster.

4) Configure Outbound Multi-Link.
Create two NetLinks: one for the old control IP address and one for the new control IP address.

5) Install the policy on the engine.
From this point on, you can start using the new address in the network.

https://stonesoftlicenses.forcepoint.com
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6) To set the new and old control IP addresses as the primary and backup IP addresses, respectively, edit
the Single Firewall or Firewall Cluster element in the Engine Editor.

Note:  If your engine cannot use the old and new control IP addresses simultaneously,
remove the interface with the old control IP address from the Interfaces pane in the Engine
Editor. Also remove the elements and rules you created for the Multi-Link configuration.

7) Click  Save and Refresh.

8) Remove the interface with the old control IP address from the Interfaces pane in the Engine Editor.

9) Remove the elements and rules you created for the Multi-Link configuration.

10) Click  Save and Refresh again.

Note:  If the connection with the Management Server is lost while you try to change IP
addressing, run the NGFW Initial Configuration Wizard (sg-reconfigure) on the engine
command line. This command returns the engine to the initial configuration state and re-
establishes initial contact between the engine and the Management Server.

Related concepts
Editing existing engine elements on page 498
Network interfaces for engines on page 539
Management connections for engines and how they work on page 639
Connect engines to the SMC on page 641
Getting started with outbound traffic management on page 739
Getting Started with licenses on page 1305

Configure Layer 2 Settings for NGFW Engines
in the Firewall/VPN role
Layer 2 Settings for NGFW Engines in the Firewall/VPN role define the Layer 2 Interface Policy for the NGFW
Engine, and advanced settings for layer 2 physical interfaces on the NGFW Engine.

Layer 2 Interface Policies contain rules for traffic detected by layer 2 physical interfaces on NGFW Engines in the
Firewall/VPN role. To use layer 2 physical interfaces, you must select the Layer 2 Interface Policy for the NGFW
Engine. All layer 2 physical interfaces on the NGFW Engine use the same Layer 2 Interface Policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall, Firewall Cluster, or Virtual Firewall, then select Edit <element type>.

2) In the navigation pane on the left, browse to General > Layer 2 Settings.

3) From the Policy for Layer 2 Interfaces drop-down list, select the Layer 2 Interface Policy.

4) (Optional) Configure one or more of these advanced settings for layer 2 physical interfaces:
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• Connection tracking options
• Bypass options for Capture Interfaces and Inline IPS Interfaces

5) Click  Save and Refresh to transfer the changes.

Configure global contact policy settings
for node-initiated contact to the
Management Server

Communication between the Management Server and a Single Firewall, Single IPS, or Single Layer 2 Firewall
can be reversed. In this case, the engine opens a connection to the Management Server and keeps it open to
wait for any commands.

Before you begin
A Single Firewall, Single IPS, or Single Layer 2 Firewall with a dynamic Control IP Address has been
configured.

Reversing communication might be necessary in the following cases:

• The engine does not have a static IP address that the Management Server can contact. (Instead of a static IP
address, the engine has a dynamic IP address on the interface or intermediate dynamic NAT.)

• The Management Server’s connections are blocked because of a traffic filtering device between the
components.

The settings for communication between the Management Server and the engines are set in the
SGConfiguration.txt file stored on the Management Server. You can either use the default values for each setting
or change the settings by adding parameters and values to the SGConfiguration.txt file.

Steps

1) On the Management Server computer, browse to the <installation directory>/data directory.

Note:  If you installed the Management Server in the C:\Program Files\Forcepoint\SMC
directory in Windows, some program data might be stored in the C:\ProgramData\Forcepoint
\SMC directory.
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2) Edit the SGConfiguration.txt file and add the following parameters as needed.

Table 50: SGConfiguration parameters

Parameter name Description

DCP_INITIAL_DELAY Time (in seconds) to wait after initialization before the first connection attempt to the
Management Server. The default value is 5 seconds.

DCP_CONNECTION_INTERVAL Time (in seconds) to wait before connecting again to the Management Server after a
successful connection. The default value is 25 seconds.

DCP_RETRY_INTERVAL Time (in seconds) to wait before connecting again to the Management Server after a
failed connection attempt. The default value is 25 seconds.

DCP_IDLE_TIMEOUT Time (in seconds) before an idle connection is closed. The default value is 1800
seconds (30 minutes).

3) Save and close the file.

4) Refresh the policies of the engines to transfer the changes.

Related tasks
Select system communication roles for firewall interfaces on page 569
Select system communication roles for IPS interfaces on page 587
Select system communication roles for Layer 2 Firewall interfaces on page 601

Synchronizing engine times
NGFW Engine times are automatically synchronized to match the time of the Management Server. You can
optionally use an NTP server to synchronize NGFW Engine times.

By default, NGFW Engines get time setting commands from the Management Server. If an NGFW Engine is
configured to use NTP and it can successfully get the time from an external NTP server, the NGFW Engine
ignores time setting commands from the Management Server.

In environments where there are Master NGFW Engines and Virtual NGFW Engines, you can use NTP servers
to synchronize engine times only for Master NGFW Engines. Virtual NGFW Engines do not communicate directly
with NTP servers.

If the Management Server, Log Server, and the engines do not have the same time, there might be problems with
logging and monitoring. Also make sure that the computer you are using for Management Client access has the
time and time zone set correctly. Correct settings prevent time synchronization problems when you view statistics
or logs, generate reports, or schedule automatic maintenance tasks.

Related tasks
Enable NTP time synchronization for NGFW Engines on page 144
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 CHAPTER 29

Creating and modifying Master
NGFW Engine and Virtual NGFW
Engine elements

Contents

• Configuration of Master NGFW Engines and Virtual NGFW Engines on page 515
• Create Master NGFW Engine elements on page 518
• Create Virtual Resource elements on page 520
• Create Virtual NGFW Engines on page 521
• Modify Master NGFW Engines and Virtual NGFW Engines on page 524
• Convert Firewalls to Master NGFW Engines and Virtual Firewall elements on page 527
• Example: deploying Virtual Firewalls for MSSP customers on page 536

Virtual NGFW Engines are logically separate engines that run as virtual instances on a physical engine device. A
Master NGFW Engine is a physical engine device that provides resources for Virtual NGFW Engines.

Configuration of Master NGFW Engines
and Virtual NGFW Engines

Master NGFW Engines are physical devices that provide resources for multiple Virtual NGFW Engines.

Using Virtual NGFW Engines allows the same physical engine device to support multiple policies or routing
tables, or policies that involve overlapping IP addresses. This is especially useful in a Managed Security Service
Provider (MSSP) environment, or in a network environment that requires strict isolation between networks.

A Virtual Resource element defines the set of resources on the Master NGFW Engine that are allocated to a
Virtual NGFW Engine. Virtual Resource elements associate Virtual NGFW Engines with Physical Interfaces or
VLAN Interfaces on the Master NGFW Engine.

Any NGFW Engine that has a license that allows the creation of Virtual Resources can be used as a Master
NGFW Engine.

Before you define a new Master NGFW Engine element, make sure that you have an NGFW Engine license for
each Master NGFW Engine node. Virtual NGFW Engines do not require individual licenses. Instead, the NGFW
Engine license for the Master NGFW Engine defines how many Virtual Resources can be created. The number
of Virtual Resources limits the number of Virtual NGFW Engines: one Virtual NGFW Engine at a time can be
associated with each Virtual Resource.
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Protecting Virtual NGFW Engines
In the Virtual Resource, you can set the rate limit and throughput limit for the Virtual NGFW Engine. Setting the
rate limit helps protect the other Virtual NGFW Engines by ensuring that a single Virtual NGFW Engine does not
consume all the resources of a Master NGFW Engine.

 
Figure 77: Example of using rate limit and throughput limit for a Virtual Firewall
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1 In the properties of the Master NGFW Engine, open the Virtual Resource, then set the limits for the rate
limit or throughput limit, or for both.

2 Refresh the policy on the Virtual NGFW Engine.

3 When incoming network traffic exceeds the rate limit, the packets are dropped.
If a rate limit is defined, the limit must be much higher than the throughput limit.

4 When outgoing network traffic exceeds the throughput limit, the packets are queued.
If there is a QoS Policy set for the Virtual NGFW Engine, the policy handles the prioritization as normal.

Limitations
The following limitations apply to Master NGFW Engines and Virtual NGFW Engines:
• To use more than one Virtual NGFW Engine role, you must create a separate Master NGFW Engine for each

Virtual NGFW Engine role. Each Master NGFW Engine must be on a separate physical Master NGFW Engine
device.

• Virtual Firewalls do not support dynamic IP addresses or Wireless Interfaces.
• If there are multiple administrative Domains, the Master NGFW Engine must either belong to the Shared

Domain or to the same Domain as the Virtual NGFW Engines.
• Virtual NGFW Engines handle only the traffic routed through the Virtual NGFW Engine for inspection. All other

traffic, including communication between the Virtual NGFW Engines and the SMC components, is proxied
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by the Master NGFW Engine. Virtual NGFW Engines do not communicate directly with other Virtual NGFW
Engines.

Related concepts
Getting started with Domain elements on page 399

Master NGFW Engine and Virtual NGFW Engine
configuration overview
Master NGFW Engine and Virtual NGFW Engine configuration consists of creating Master NGFW Engines and
associating Virtual NGFW Engines with the Master NGFW Engines.

The configuration consists of the following general steps:

1) Generate and install NGFW Engine licenses for the Master NGFW Engine.

2) Create a Master NGFW Engine element.

3) Create a Virtual Resource element.

4) Configure Physical or VLAN Interfaces for the Master NGFW Engine and assign Virtual Resources to the
interfaces.

5) Create Virtual NGFW Engine elements.

6) Configure Physical, VLAN, or Tunnel Interfaces for the Virtual NGFW Engines.

7) Configure routing for the Master NGFW Engine and for Virtual Firewalls.

Note:  You cannot configure routing for Virtual IPS engines or Virtual Layer 2 Firewalls.

8) Install or refresh the policy on the Master NGFW Engine to transfer changes to the Master NGFW Engine’s
Physical/VLAN Interfaces and the mapping of Virtual NGFW Engines to Master NGFW Engine Interfaces.

9) Install or refresh the policy on the Virtual NGFW Engines.

Related concepts
Create Virtual NGFW Engines on page 521
Configuring Virtual Firewall interfaces on page 615
Getting Started with licenses on page 1305
Adding routes for Master NGFW Engines on page 714
Adding routes for Virtual Firewalls on page 714

Related tasks
Create Virtual Resource elements on page 520
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The Engine Editor and how it works
The Engine Editor combines all NGFW Engine configuration information into one view that is easy to access and
navigate. You can quickly save and validate all changes using the Engine Editor toolbar.

You can use the Engine Editor to configure the following settings:
• General — General NGFW Engine settings
• Interfaces — Interface configuration
• Routing — Routing and antispoofing configuration
• Add-Ons — Settings related to NGFW Engine add-ons and additional services.
• Policies — Information about the Security Policy used on the NGFW Engine and settings related to element-

based NAT and Aliases. Also contains settings for Automatic rules
• VPN (Firewalls only) — Settings related to the VPN configuration and SSL VPN configuration
• Advanced Settings — Advanced NGFW Engine settings (Traffic Handling, SYN Rate Limits, Log Handling,

Scan Detection, DoS Protection, Idle Timeouts, and Tunneling)

You can use the Engine Editor to edit or view an NGFW Engine configuration:
• To edit an NGFW Engine configuration, right-click the NGFW Engine, then select Edit.
• To view an NGFW Engine configuration, right-click the NGFW Engine, then select Preview. You can also

double-click the NGFW Engine.

Using Master NGFW Engines and Virtual NGFW
Engines with Domains
Virtual NGFW Engines associated with the same Master NGFW Engine can belong to different administrative
Domains.

However, the Master NGFW Engine must either belong to the Shared Domain or to the same Domain as the
associated Virtual NGFW Engines. For example, the Master NGFW Engine can belong to the Shared Domain,
while each associated Virtual NGFW Engine belongs to a different Domain.

Create Master NGFW Engine elements
A Master NGFW Engine is a physical engine device that provides the resources for Virtual NGFW Engines. One
physical Master NGFW Engine can support multiple Virtual NGFW Engines.

Before you begin
Before creating Master NGFW Engine elements, generate and install NGFW Engine licenses for the
Master NGFW Engines.

By default, a Master NGFW Engine element has placeholders for two nodes when the element is created. A
Master NGFW Engine can have 1–16 nodes. If you do not need to use clustering on the Master NGFW Engine,
you can remove one of the automatically created nodes.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click NGFW Engines and select New > Master NGFW Engine.
You are prompted to select the role for the Virtual NGFW Engines that this Master NGFW Engine hosts.

Note:  You cannot change the role of the Virtual NGFW Engines that the Master NGFW
Engine hosts after you create the Master NGFW Engine element.

3) Select the role for the Virtual NGFW Engines that this Master NGFW Engine will host and click OK.
The Engine Editor opens.

4) Give the element a unique Name.

5) Select the Log Server to which the Master NGFW Engine sends its log data.
The Master NGFW Engine also sends log data from the Virtual NGFW Engines to the same Log Server.

6) (Optional) In DNS IP Addresses field, add one or more DNS IP addresses.
DNS IP addresses are IP addresses of external DNS servers. Master NGFW Engines use these DNS
servers to resolve Domain names to IP addresses. Master NGFW Engines need DNS resolution to contact
services that are defined using URLs or domain names, and to resolve fully qualified domain names
(FQDNs) used in policies.
• To enter a single IP address manually, click Add and select IP Address. Enter the IP address.
• To define an IP address using a network element, click Add and select Network Element.

7) Select the Location for this Master NGFW Engine if there is a NAT device between this Master NGFW
Engine and other SMC components.

8) (Optional) If you want to include the Master NGFW Engine in predefined categories, select the appropriate
Categories.

9) (Optional) If you want to add custom commands to the Master NGFW Engine’s right-click menu, add a
Tools Profile.

10) (Optional) If you do not need to use clustering on the Master NGFW Engine, select one of the nodes and
click Remove Node.
You are prompted to confirm that you want to delete the selected node. Click Yes.

Next steps

You are now ready to create Virtual Resource elements.

Related concepts
Defining Host elements on page 898
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Related tasks
Attach Tools Profile elements to elements on page 120
Create Location elements on page 129
Select Categories for elements on page 171
Add nodes to Master NGFW Engine elements on page 525
Activate the SNMP agent on NGFW Engines on page 670
Define External DNS Server elements on page 780

Create Virtual Resource elements
Virtual Resources associate Virtual NGFW Engines with Physical Interfaces or VLAN Interfaces on the Master
NGFW Engine.

When you select the same Virtual Resource for a Physical Interface or VLAN Interface on the Master NGFW
Engine and for a Virtual NGFW Engine, the Virtual NGFW Engine is automatically associated with the Master
NGFW Engine. Create one Virtual Resource for each Virtual NGFW Engine that you plan to add.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click the Master NGFW Engine element, then select Edit Master NGFW Engine.

3) Browse to Interfaces > Virtual Resources.

4) Click Add.

5) Configure the settings.

6) Click OK.

7) Click  Save.

Next steps

Continue the configuration in one of the following ways:
• If you are creating a Master NGFW Engine, configure Master NGFW Engine interfaces.
• Associate the Virtual Resource with a Master NGFW Engine interface and with a Virtual NGFW Engine.

Related concepts
Master NGFW Engine interface configuration overview on page 605
Create Virtual NGFW Engines on page 521
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Related tasks
Add Master NGFW Engine Physical Interfaces for hosted Virtual NGFW Engines on page 609

Create Virtual NGFW Engines
Virtual NGFW Engine elements store the configuration information related to the Virtual NGFW Engines.

Note:  All Virtual NGFW Engines on the same Master NGFW Engine must have the same Virtual
NGFW Engine role (Firewall/VPN, IPS, or Layer 2 Firewall). To use more than one Virtual NGFW
Engine role, you must create a separate Master NGFW Engine for each Virtual NGFW Engine
role. Each Master NGFW Engine must be on a separate physical Master NGFW Engine device.

Add Virtual Firewall elements
Virtual Firewall elements store the configuration information related to the Virtual Firewalls.

Selecting a Virtual Resource for the Virtual Firewall automatically adds the Virtual Firewall to the Master NGFW
Engine where the Virtual Resource is used.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click NGFW Engines and select New > Firewall > Virtual Firewall.

3) In the Name field, enter a unique name.

4) Next to the Virtual Resource field, click Select and select a Virtual Resource on the Master NGFW Engine
to which you want to add the Virtual Firewall.

5) (Optional) In the DNS IP Addresses field, add one or more IP addresses.
DNS IP addresses are IP addresses of external DNS servers. Virtual Firewalls use these DNS servers
to resolve Domain names to IP addresses. Virtual Firewalls need DNS resolution to contact services that
are defined using URLs or domain names, and to resolve fully qualified domain names (FQDNs) used in
policies. When DNS relay is configured, these DNS servers are used unless domain-specific DNS servers
are specified in a DNS Relay Profile element.

Note:  If you have defined NetLink-specific DNS IP addresses, adding DNS IP addresses
overrides the NetLink-specific DNS IP addresses.

• To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the
dialog box that opens.

• To define an IP address using a network element, click Add and select Network Element.
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6) (Optional) Next to the Category field, click Select and select one or more categories.

7) Click  Save.
Do not close the Engine Editor.

Next steps

Configure interfaces for the Virtual Firewall.

Related concepts
Configuring interfaces for Virtual NGFW Engines on page 614
Defining Host elements on page 898

Related tasks
Select Categories for elements on page 171
Define External DNS Server elements on page 780

Add Virtual IPS elements
Virtual IPS elements store the configuration information related to the Virtual IPS engines.

Selecting a Virtual Resource for the Virtual IPS element automatically adds the Virtual IPS element to the Master
NGFW Engine where the Virtual Resource is used.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click NGFW Engines and select New > IPS > Virtual IPS.

3) In the Name field, enter a unique name.

4) Next to the Virtual Resource field, click Select and select a Virtual Resource on the Master NGFW Engine
to which you want to add the Virtual IPS.

5) (Optional) In the DNS IP Addresses field, add one or more IP addresses.
DNS IP addresses are IP addresses of external DNS servers. Virtual IPS engines use these DNS servers
to resolve Domain names to IP addresses. Virtual IPS engines need DNS resolution to contact services that
are defined using URLs or domain names, and to resolve fully qualified domain names (FQDNs) used in
policies.
• To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the

dialog box that opens.
• To define an IP address using a network element, click Add and select Network Element.

6) (Optional) Next to the Category field, click Select and select one or more categories.
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7) Click  Save.
Do not close the Engine Editor.

Next steps

Configure interfaces for the Virtual IPS engine.

Related concepts
Configuring interfaces for Virtual NGFW Engines on page 614
Defining Host elements on page 898

Related tasks
Select Categories for elements on page 171
Define External DNS Server elements on page 780

Add Virtual Layer 2 Firewall elements
Virtual Layer 2 Firewall elements store the configuration information related to the Virtual Layer 2 Firewalls.

Selecting a Virtual Resource for the Virtual Layer 2 Firewall automatically adds the Virtual Layer 2 Firewall to the
Master NGFW Engine where the Virtual Resource is used.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click NGFW Engines and select New > Layer 2 Firewall > Virtual Layer 2 Firewall.
The Engine Editor opens.

3) In the Name field, enter a unique name.

4) Next to the Virtual Resource field, click Select and select a Virtual Resource on the Master NGFW Engine
to which you want to add the Virtual Firewall.

5) (Optional) In the DNS IP Addresses field, add one or more IP addresses.
DNS IP addresses are IP addresses of external DNS servers. Virtual Layer 2 Firewalls use these DNS
servers to resolve Domain names to IP addresses. Virtual Layer 2 Firewalls need DNS resolution to contact
services that are defined using URLs or domain names, and to resolve fully qualified domain names
(FQDNs) used in policies.
• To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the

dialog box that opens.
• To define an IP address using a network element, click Add and select Network Element.

6) (Optional) Next to the Category field, click Select and select one or more categories.
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7) Click  Save.
Do not close the Engine Editor.

Next steps

You are now ready to configure interfaces for the Virtual Layer 2 Firewall.

Related concepts
Configuring interfaces for Virtual NGFW Engines on page 614
Defining Host elements on page 898

Related tasks
Select Categories for elements on page 171
Define External DNS Server elements on page 780

Moving a Virtual NGFW Engine to a different
Master NGFW Engine
The Virtual Resource selected in the properties of a Virtual NGFW Engine determines the Master NGFW Engine
to which the Virtual NGFW Engine belongs.

To move a Virtual NGFW Engine to a different Master NGFW Engine, you select a Virtual Resource that is
associated with a different Master NGFW Engine in the Virtual NGFW Engine's properties. The move becomes
effective when you refresh the policy on the Master NGFW Engine.

Modify Master NGFW Engines and
Virtual NGFW Engines

You can edit Master NGFW Engine, Virtual Firewall, Virtual IPS engine, and Virtual Layer 2 Firewall elements.
You can also convert an existing Single Firewall or Firewall Cluster into a Master NGFW Engine and Virtual
Firewalls.

Existing Master NGFW Engine, Virtual Firewall, Virtual IPS engine, and Virtual Layer 2 Firewall elements are
shown in the Engines branch of the Home view in their own branches, and in the NGFW > NGFW Engines
branch of the Configuration view.
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Add nodes to Master NGFW Engine elements
By default, the Master NGFW Engine element has two nodes on the Clustering pane of the Engine Editor. You
can add new nodes to the Master NGFW Engine element. Each Master NGFW Engine supports up to 16 nodes.

Before you begin
Install the additional physical engine device. Connect the cables for at least the interface for
communication with the Management Server and the interface for communications between the
clustered engines. If the device already has a working configuration from previous use, return it to
the initial configuration state in the NGFW Initial Configuration Wizard on the command line before
connecting it to the network. Do not make initial contact with the Management Server before you add
the node to the Master NGFW Engine configuration in the Management Client.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click the Master NGFW Engine and select Edit Master NGFW Engine.

3) In the navigation pane on the left, browse to General > Clustering.

4) Click Add Node.

5) Give the node a unique Name.

6) In the Nodes table, review and update the information in the IP Address, Contact IP Address, and
Comment columns for each NDI. (Double-click the value you want to change.)

7) Click OK.

8) Click  Save.

9) Save the initial configuration for the new Master NGFW Engine node to create a one-time password.

10) Make initial contact between the new engine and the Management Server.

11) Refresh the policy of the Master NGFW Engine to transfer the changes to the engines.

Related concepts
Connect engines to the SMC on page 641

Related tasks
Reconfigure engine settings on page 347
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Change the properties of Virtual Resources
Editing Virtual Resources allows you to change which Domain is associated with each Virtual Resource and edit
other settings in the Virtual Resource properties.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click the Master NGFW Engine and select Edit Master NGFW Engine.
The Engine Editor opens.

3) In the navigation pane on the left, browse to Interfaces > Virtual Resources.

4) Select a Virtual Resource and click Edit.

5) (Optional) Select a Domain to change the Domain to which the Virtual Resource belongs.

Note:  If the Virtual Resource is already associated with a Virtual NGFW Engine, you
cannot change the Domain here. Instead, move the Virtual NGFW Engine to another
Domain using the Move to Domain tool in the Virtual NGFW Engine’s right-click menu.
Moving the Virtual NGFW Engine to another Domain automatically moves the Virtual
Resource to the same Domain.

6) (Optional) Enter the Concurrent Connection Limit to set a limit for the total number of connections that
are allowed for the Virtual NGFW Engine associated with the Virtual Resource.
When the set number of connections is reached, the engine blocks the next connection attempts until a
previously open connection is closed.

7) (Optional) Select Show Master Interface IDs in Virtual Engine to show the Physical Interface IDs of the
Master NGFW Engine in the Interface properties of the Virtual NGFW Engine.

8) Click OK.

9) Click  Save.

10) Refresh the policy of the Master NGFW Engine to transfer the changes to the engines.

Related tasks
Create Virtual Resource elements on page 520
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Convert Firewalls to Master NGFW
Engines and Virtual Firewall elements

You can use a conversion tool to change a Single Firewall or Firewall Cluster element to a Master NGFW Engine
and Virtual Firewall elements.

The Master NGFW Engine must always be based on a Firewall. The Virtual NGFW Engines can only be in
the Virtual Firewall role. Only Single Firewalls or Firewall Clusters that are running on 64-bit hardware can be
converted to Master NGFW Engines and Virtual Firewalls.

Single Firewalls and Firewall Clusters with the following configurations cannot be converted to Master NGFW
Engines and Virtual Firewalls:
• Firewall Clusters that use a CVI as the Control IP address
• Firewall Clusters that have only a CVI on the Heartbeat Interface
• Single Firewalls that have ADSL Interfaces
• Single Firewalls that have Wireless Interfaces
• Single Firewalls that have a dynamic IP address
• Single Firewalls or Firewall Clusters that have a dynamic Contact Address
• Single Firewalls or Firewall Clusters that have DHCP settings on the interface for communication with the

Management Server

Related concepts
Defining Host elements on page 898

Related tasks
Attach Tools Profile elements to elements on page 120
Create Location elements on page 129
Select Categories for elements on page 171
Add nodes to Master NGFW Engine elements on page 525
Activate the SNMP agent on NGFW Engines on page 670
Define External DNS Server elements on page 780

Start the Convert Engine to Master NGFW
Engine and Virtual NGFW Engines wizard
Start the conversion tool and define general properties for the Master NGFW Engine and Virtual NGFW Engines.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.
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2) Right-click a Single Firewall or Firewall Cluster and select Configuration > Convert to Master NGFW
Engine and Virtual NGFW Engine(s).
The Convert Engine to Master NGFW Engine and Virtual NGFW Engines wizard starts.

3) (Optional) Select a Firewall on which to base the configuration from the Base Configuration On list.

4) Enter the Number of Virtual Engines to create.
The specified number of Virtual Resources are added to the table, and a Virtual Engine is associated with
each Virtual Resource.

5) (Recommended) Double-click the Virtual Resource Name field and edit the automatically generated
Virtual Resource Name for each Virtual NGFW Engine.

6) (Recommended) Double-click the Virtual NGFW Engine Name field and edit the automatically generated
Virtual NGFW Engine Name for each Virtual NGFW Engine.

7) Click Next.
The Define Basic Information for the Master NGFW Engine page opens.

8) Enter a Name for the Master NGFW Engine.
The name is also used to automatically generate the names of the nodes.

9) Select the Log Server to which the Master NGFW Engine sends its log data.

10) (Optional) In DNS IP Addresses field, add one or more DNS IP addresses.
DNS IP addresses are IP addresses of external DNS servers. Master NGFW Engines use these DNS
servers to resolve Domain names to IP addresses. Master NGFW Engines need DNS resolution to contact
services that are defined using URLs or domain names, and to resolve fully qualified domain names
(FQDNs) used in policies.
• To enter a single IP address manually, click Add and select IP Address. Enter the IP address.
• To define an IP address using a network element, click Add and select Network Element.

11) Select the Location for this Master NGFW Engine if there is a NAT device between this Master NGFW
Engine and other SMC components.

12) Define other settings according to your environment:
• To include the Master NGFW Engine in predefined categories, select the appropriate Categories.
• To add custom commands to the Master NGFW Engine’s right-click menu, add a Tools Profile.
• Add, edit, or remove nodes.

13) Click Next.
The Define Interfaces for the Master NGFW Engine page opens.
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Define interfaces for converted Master NGFW
Engine elements
All Master NGFW Engine interfaces must either have Interface Options defined or be associated with a Virtual
Resource.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If you want to use a Physical Interface to host a Virtual NGFW Engine, right-click a Physical Interface and
select Edit Physical Interface.

CAUTION:  The Control Interface is used for Master NGFW Engine communications. Do not
add a Virtual Resource to the Physical Interface that is used as the Control Interface.

2) Select the Virtual Resource to associate with the interface.

3) (Optional) Select Allow VLAN Definition in Virtual Engine to allow VLAN Interfaces to be added to the
automatically created Physical Interfaces in the Virtual NGFW Engine that is associated with this interface.

4) Select the Virtual Engine Interface ID.
This is the Physical Interface ID of the Virtual NGFW Engine that is associated with this interface.

5) Click OK to close the Physical Interface Properties dialog box.

6) (Optional) Click Options to select which IP addresses are used in particular roles in system communications.

7) (Optional) Add ARP Entries.

8) (Optional) Click Virtual Resources if you want to edit the name of the Virtual Resources.

9) Click Next and continue the configuration in one of the following ways:
• If Tunnel Interfaces are defined for the Single Firewall or Firewall Cluster on which the configuration

is based, the Distribute Tunnel Interfaces to Virtual NGFW Engines page opens. Move the Tunnel
Interfaces into the interface configuration for the Virtual NGFW Engines.

• If the Single Firewall or Firewall Cluster on which the configuration is based is associated with a VPN
Gateway element, the Review Distribution of Internal Gateways to Virtual NGFW Engines page
opens. Move the VPN Gateway elements into the configuration for the Virtual NGFW Engines.

• Otherwise, the Define Routing for the Master NGFW Engine page opens. Define routing for the
converted Master NGFW Engines.

Related tasks
Distribute VPN gateways to converted Virtual Firewall elements on page 530
Define routing for converted Master NGFW Engine elements on page 531
Select system communication roles for Master NGFW Engine interfaces on page 612
Add manual ARP entries to NGFW Engines on page 624
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Distribute Tunnel Interfaces to converted
Virtual Firewall elements
If Tunnel Interfaces are defined for the Single Firewall or Firewall Cluster element on which the configuration is
based, you must move the Tunnel Interfaces into the interface configuration for the Virtual Firewall elements.

Master NGFW Engines cannot use Tunnel Interfaces.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Review the distribution of Tunnel Interfaces to Virtual NGFW Engines.

2) (Optional) If you want to change how the Tunnel Interfaces are distributed to Virtual NGFW Engines, click the
Virtual Engine field for a Tunnel Interface and select the correct Virtual NGFW Engine from the list.

3) Click Next and continue the configuration in one of the following ways:
• If the Single Firewall or Firewall Cluster on which the configuration is based is associated with a VPN

Gateway element, the Review Distribution of Internal Gateways to Virtual NGFW Engines page
opens. Move the VPN Gateway elements into the configuration for the Virtual NGFW Engines.

• Otherwise, the Define Routing for the Master NGFW Engine page opens. Define routing for the
converted Master NGFW Engines.

Related tasks
Define routing for converted Master NGFW Engine elements on page 531

Distribute VPN gateways to converted Virtual
Firewall elements
If the Single Firewall or Firewall Cluster element on which the configuration is based is associated with a VPN
Gateway element, you must move the VPN Gateway configuration to the Virtual NGFW Engines.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Review the distribution of VPN Gateways to Virtual NGFW Engines.

2) (Optional) If you want to change how the VPN Gateways are distributed to Virtual NGFW Engines, click the
Virtual Engine field for a VPN Gateway. Then select the correct Virtual NGFW Engine from the list.

3) Click Next.
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Define routing for converted Master NGFW
Engine elements
Routes to directly connected networks are automatically added. You must add a default route and any routes
through next-hop gateways to networks that are not directly connected to the Master NGFW Engine.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Review and edit the routing.

2) Click Next.
The Select Additional Configuration Options page opens.

Related concepts
Adding routes for Master NGFW Engines on page 714

Select additional configuration options for
converted Master NGFW Engine elements
You can define additional properties for the Master NGFW Engine on the Select Additional Configuration
Options page.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select Define Additional Master NGFW Engine Properties and click Next.
The Define Tester Settings for the Master NGFW Engine page opens.

2) (Optional) Define tester settings.

3) Click Next.
The Define Permissions for the Master NGFW Engine page opens.

4) (Optional) Define permissions.

5) Click Next.
The Define Advanced Settings for the Master NGFW Engine page opens.

6) (Optional) Define advanced settings.

7) Click Next.
The Review Basic Information for Virtual NGFW Engines page opens.
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Related concepts
Getting started with the engine tester on page 649
Getting started with engine permissions on page 657
Adjust Master NGFW Engine clustering options on page 689

Related tasks
Adjust general Master NGFW Engine clustering options on page 689

Define NTP settings for converted Master
NGFW Engines
You can configure Master NGFW Engines to use external NTP servers.

Note:  You can select NTP servers only for Master NGFW Engines. Virtual NGFW Engines do not
communicate directly with NTP servers.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select Enable time synchronization from NTP server.

2) To add a row to the table, click Add.

3) To add an NTP server, right-click the NTP Server cell, select Select, then select an NTP Server element.

4) (Optional) If there is more than one NTP server, select the preferred NTP server.

5) Click Next.

Change the basic properties of converted
Virtual Firewall elements
Most of the basic settings for the Virtual NGFW Engine elements are inherited from the Master NGFW Engine.
Some settings can be adjusted.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select a Virtual NGFW Engine to review or edit its properties.

2) In the Name field, edit the name for the Virtual NGFW Engine.
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3) (Optional) In DNS IP Addresses field, add one or more DNS IP addresses.
These addresses are the IP addresses of the DNS servers that the Master NGFW Engine with which the
Virtual NGFW Engine is associated uses to resolve domain names. Virtual Firewalls need DNS resolution to
contact services that are defined using URLs or domain names, and to resolve fully qualified domain names
(FQDNs) used in policies. When DNS relay is configured, these DNS servers are used unless domain-
specific DNS servers are specified in a DNS Relay Profile element.

Note:  If you have defined NetLink-specific DNS IP addresses, adding DNS IP addresses
overrides the NetLink-specific DNS IP addresses.

• To enter a single IP address manually, click Add and select IP Address. Enter the IP address.
• To define an IP address using a network element, click Add and select Network Element.

4) Select the appropriate Categories.

5) Click Next.
The Review Interfaces for Virtual NGFW Engines page opens.

Related concepts
Defining Host elements on page 898

Related tasks
Select Categories for elements on page 171
Define External DNS Server elements on page 780

Change the interfaces and routing for
converted Virtual Firewall elements
The Virtual NGFW Engine interface configuration is automatically generated based on the Master NGFW Engine
interface configuration. Some settings can be adjusted.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Click Options to select which IP addresses are used in particular roles in system communications.

2) (Optional) Add ARP Entries.

3) (Optional) Click Multicast Routing to define static multicast or IGMP-based multicast forwarding (IGMP
proxying).

4) Click Next.
The Review and Edit Routing for Virtual Security Engines page opens.

5) Review and edit the routing.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Creating and modifying Master NGFW Engine and Virtual NGFW Engine elements | 534

6) Click Next.
The Review NAT Definitions for Virtual Security Engines page opens.

7) Continue the configuration in one of the following ways:
• If you want to add NAT definitions, review the NAT definitions for the converted Virtual Firewall elements.
• Otherwise, click Next. The Select Additional Configuration Options page opens.

Related concepts
Adding routes for Virtual Firewalls on page 714

Related tasks
Select additional options for Virtual Firewall interfaces on page 622
Add manual ARP entries to NGFW Engines on page 624

Add NAT definitions for converted Virtual
Firewall elements
On the Define NAT Definitions for Virtual Security Engines page, you can define how Virtual Firewalls
translate network addresses.

NAT rules are automatically generated and organized in the Firewall Policy based on the NAT definitions created
in the Firewall properties.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) To use the default NAT address as the Public IP Address if there is not a more specific NAT definition that
matches the traffic, select Use Default NAT Address for Traffic from Internal Networks.

2) To view the Default NAT Address properties, click Show Details.

3) In the NAT Definitions for list, select the Virtual Firewall for which you want to add NAT definitions .

4) Add or edit the NAT definitions.

5) Click Next.
The Select Additional Configuration Options page opens.

6) Continue the configuration in one of the following ways:
• If you want to define additional options, select additional configuration options for the converted Virtual

Firewall elements.
• Otherwise, Click Next. The Summary page opens.
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Related tasks
Add NAT definitions for element-based NAT on page 646
Edit or remove NAT definitions for element-based NAT on page 647

Select additional configuration options for
converted Virtual Firewall elements
You can define additional properties for the Virtual Firewall elements on the Select Additional Configuration
Options page.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) (Optional) Select Define Additional Properties for Virtual Security Engines and click Next.
The Review Permissions for Virtual Security Engines page opens.

2) (Optional) Select the Virtual NGFW Engine for which you want to define permissions and configure the
permissions.

3) Click Next.
The Review Add-Ons for Virtual Security Engines page opens.

4) (Optional) Select the Virtual NGFW Engine for which you want to define add-ons and configure the add-ons.

5) Click Next.
The Review Advanced Settings for Virtual Security Engines page opens.

6) (Optional) Select the Virtual NGFW Engine for which you want to define advanced engine properties and
define the advanced properties.

7) Click Next.
The Summary page opens.

Related concepts
Getting started with engine permissions on page 657
Enabling access control by user on page 1084

Related tasks
Activate TLS inspection on engines on page 1053
Enable browser-based user authentication on page 1108
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Finish converting Firewalls to Master NGFW
Engines and Virtual Firewall elements
When you have finished configuring the Master NGFW Engine and Virtual Firewall elements, you must finalize
the conversion.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Click Finish.
A new tab opens to show the progress of the conversion.

2) Click Close to close the tab when the conversion is complete.

3) Install or refresh the policy on the Master NGFW Engine.

4) Install a policy on the Virtual NGFW Engines.

Example: deploying Virtual Firewalls for
MSSP customers

An example of configuring Master NGFW Engines and Virtual Firewalls in an MSSP environment.

Company A is an MSSP (Managed Security Services Provider). Customer 1 and Customer 2 are customers of
Company A. The customers each want one Virtual Firewall with two Physical Interfaces. The administrators at
Company A decide to use their existing NGFW appliance as a Master NGFW Engine to host Virtual Firewalls for
Customer 1 and Customer 2. Separate administrative Domains have already been configured for each customer.
The engine already has a license that allows the creation of Virtual Resources.

The administrators at Company A:

1) Create a Master NGFW Engine element in the Shared Domain.

2) Create one Virtual Resource element for each customer’s Virtual Firewall and select the appropriate Domain
for each Virtual Resource:

Table 51: Virtual resources details

Virtual resource name Domain

Customer 1 Virtual Resource Customer 1 Domain

Customer 2 Virtual Resource Customer 2 Domain

3) Create the following Physical Interfaces on the Master NGFW Engine:
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Table 52: Physical interfaces details

Interface ID Description

0 Physical Interface for the Master NGFW Engine’s own traffic

1 Physical Interface for hosted Virtual Firewall traffic

4) Add an IPv4 address for each Master NGFW Engine node to Physical Interface 0.

5) Add the following VLAN Interfaces to Physical Interface 1 and select the appropriate Virtual Resource for
each VLAN Interface:

Table 53: VLAN interfaces details

Interface ID Virtual resource Description

VLAN 1.1 Customer 1 Virtual Resource VLAN Interface for the first Physical Interface on the
Virtual Firewall for Customer 1

VLAN 1.2 Customer 1 Virtual Resource VLAN Interface for the second Physical Interface on
the Virtual Firewall for Customer 1

VLAN 1.3 Customer 2 Virtual Resource VLAN Interface for the first Physical Interface on the
Virtual Firewall for Customer

VLAN 1.4 Customer 2 Virtual Resource VLAN Interface for the second Physical Interface on
the Virtual Firewall for Customer 2

6) Create a Virtual Firewall element for each customer and select the appropriate Virtual Resource for each
Virtual Firewall:

Table 54: Virtual firewall details

Virtual firewall Virtual resource

Customer 1 Virtual Firewall Customer 1 Virtual Resource

Customer 2 Virtual Firewall Customer 2 Virtual Resource

7) Add IP addresses to the Physical Interfaces on the Virtual Firewalls.

8) Refresh the policy on the Master NGFW Engine.

9) Refresh the policy on the Virtual Firewalls.
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 CHAPTER 30

Network interface configuration
Contents

• Network interfaces for engines on page 539
• Configuring interfaces for Firewalls on page 543
• Configuring interfaces for IPS engines on page 574
• Configuring interfaces for Layer 2 Firewalls on page 588
• Configuring interfaces for Master NGFW Engines on page 602
• Configuring interfaces for Virtual NGFW Engines on page 614
• Add manual ARP entries to NGFW Engines on page 624
• Examples of Single Firewall interface configuration on page 624
• Examples of Firewall Cluster interface configuration on page 626
• Examples of IPS engine interface configuration on page 629
• Examples of Layer 2 Firewall interface configuration on page 633

The network interface configuration for NGFW Engines is stored on the Management Server in the properties of Single
Firewall, Firewall Cluster, Single IPS, IPS Cluster, Single Layer 2 Firewall, Layer 2 Firewall Cluster, Master NGFW
Engine, and Virtual NGFW Engine elements.

Network interfaces for engines
The network interface configuration stored on the Management Server contains most of the settings for network
interfaces.

The interface configuration is done using the Management Client. The interface configuration stored on the
Management Server does not contain:
• The network card driver selection
• The mapping of the operating system port numbers to the numbers used in the Management Client
• The network card speed/duplex settings

Note:  If you use automatic configuration for appliances, the Interface IDs that you select in the
Management Client must match the port numbers on the physical appliances. Check the port
numbers in the relevant hardware guide.

Note:  The configuration transferred from the Management Server overwrites the settings that can
be defined through the engine command line. The settings contain the details for initial contact
with the Management Server to establish a trusted communications channel.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Network interface configuration | 540

Types of interfaces for NGFW Engines in the
Firewall/VPN role
You can configure several types of interfaces for NGFW Engines in the Firewall/VPN role.

Table 55: Types of interfaces for NGFW Engines in the Firewall/VPN role

Interface type Purpose of interface Limitations

Layer 3 physical
interface

System communications and traffic
inspection.

You cannot add both VLAN Interfaces and
IP addresses to a Physical Interface. If
an IP address is already configured for a
Physical Interface, adding a VLAN Interface
removes the IP address. If you plan to
use VLAN Interfaces, configure the VLAN
Interfaces first and then add IP addresses
to the VLAN Interfaces.

Layer 2 physical
interface

Traffic inspection.

Layer 2 interfaces on NGFW Engines in
the Firewall/VPN role allow the engine to
provide the same kind of traffic inspection
that is available for NGFW Engines in the
IPS and Layer 2 Firewall roles.

You cannot add layer 2 physical interfaces
of the Inline Layer 2 Firewall type to
Firewall Clusters in Load Balancing mode.
Only Standby mode is supported.

You cannot add IP addresses to layer 2
physical interfaces on NGFW Engines in
the Firewall/VPN role.

VLAN retagging is not supported on layer 2
physical interfaces of the inline IPS type.

VLAN interface Divides a single physical interface into
several virtual interfaces.

• You cannot add VLAN interfaces on
top of other VLAN Interfaces (nested
VLANs).

• You cannot create valid VLAN
Interfaces in a Virtual NGFW Engine
if the Master NGFW Engine interface
that hosts the Virtual NGFW Engine is a
VLAN Interface.

ADSL interface
(Single Firewalls
only)

Represents the ADSL port of a purpose-
built Forcepoint NGFW appliance.

An ADSL Interface is only supported on
Single Firewall engines that run on specific
Forcepoint NGFW appliances that have an
ADSL network interface card.

Wireless interface
(Single Firewalls
only)

Represents a wireless network interface
card of a purpose-built Forcepoint NGFW
appliance.

A Wireless Interface is only supported on
Single Firewall engines that run on specific
Forcepoint NGFW appliances that have a
wireless network interface card.

Modem interface
(Single Firewalls
only)

Represents a 3G modem connected to a
USB port on a purpose-built Forcepoint
NGFW appliance.

• A Modem Interface is only supported
on Single Firewall engines that run on
specific Forcepoint NGFW appliances.

• Modem Interfaces do not support VLAN
tagging.
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Interface type Purpose of interface Limitations

Tunnel interface A logical interface that is used as an
endpoint for tunnels in route-based VPNs.

• Tunnel Interfaces can only have static
IP addresses.

• Tunnel Interfaces do not support VLAN
tagging.

Integrated switch
(Single Firewalls
only)

Represents the switch functionality on a
purpose-built Forcepoint NGFW appliance.

• The switch functionality is only
supported on Single Firewall engines
that run on specific Forcepoint NGFW
appliances that have an integrated
switch.

• The integrated switch does not support
VLAN tagging.

Types of interfaces for NGFW Engines in the
IPS and Layer 2 Firewall roles
Interface definitions are an important part of IPS and Layer 2 Firewall elements.

Table 56: Types of interfaces for NGFW Engines in the IPS and Layer 2 Firewall roles

Interface type Purpose of interface Limitations

Physical Interface
(Normal type)

System communications.
These interfaces are used when the engine
is the source or the final destination of the
communications. An example is control
communications between the engine and
the Management Server.

Define at least one interface that is
dedicated to system communications for
each IPS engine or Layer 2 Firewall.

Physical Interface
(Capture Interface or
Inline Interface type)

Traffic inspection.
Define one or more traffic inspection
interfaces for each IPS engine or Layer 2
Firewall.

VLAN interface Divides a single physical interface into
several virtual interfaces.

• You cannot add VLAN Interfaces on
top of other VLAN Interfaces (nested
VLANs).

• You cannot create valid VLAN
Interfaces in a Virtual NGFW Engine
if the Master NGFW Engine interface
that hosts the Virtual NGFW Engine is a
VLAN Interface.
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Interface numbering
The interfaces have their own numbering in the SMC called interface ID. The interface IDs are mapped to the
corresponding network interfaces on the engine when you configure the Forcepoint NGFW software.

Table 57: Interface numbering for NGFW Engines

Interface type Interface numbering in the SMC

Layer 3 physical interface
(NGFW Engines in the
Firewall/VPN role)

Layer 2 physical interface
(NGFW Engines in the
Firewall/VPN role)

Physical interface
(NGFW Engines in the
IPS and Layer 2 Firewall
roles)

Each physical interface has a unique interface ID number in the SMC.

VLAN interface Each VLAN interface has a VLAN number in the SMC. The defined VLAN
interfaces are displayed, for example, as “5.202” for network interface 5 with VLAN
202.

ADSL interface Each ADSL interface has a unique interface ID number in the SMC.

Wireless interface The wireless interface has a unique interface ID number in the SMC.
An SSID (service set identifier) interface represents an 802.11 wireless LAN. You
can add several SSID interfaces to the wireless interface.

Modem interface Modem Interfaces are identified with modem numbers in the SMC.
The modem number is mapped to the modem’s IMEI (international mobile
equipment identity) number. Each modem is assigned a unique ID when you
connect the modem to the engine. You can change the mapping between the
modem’s IMEI number and the modem ID through the engine command line, if
necessary.

Tunnel interface Tunnel interfaces are numbered with tunnel interface ID numbers.
The mapping of Tunnel Interfaces to physical network interfaces on the engine
is done automatically by the engine operating system based on the routing
configuration.

Integrated switch Integrated switches are identified with switch IDs in the SMC. Integrated switches
have predefined switch IDs. For example, the switch ID is 0 on Forcepoint NGFW
110 appliances.
You can add port group interfaces to switches. Port group interfaces are identified
by port group IDs. The defined switches and port group interfaces are displayed,
for example, as 0.1 for switch ID 0 with port group 1.
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Network interface configuration overview
The network interface configuration process depends on the Forcepoint NGFW role.

The interface configuration proceeds as follows:

1) Define the interfaces and IP addresses according to the engine role.

2) Configure additional related settings depending on the features you want to use.

Related concepts
Configuring interfaces for Firewalls on page 543
Configuring interfaces for IPS engines on page 574
Configuring interfaces for Layer 2 Firewalls on page 588
Master NGFW Engine interface configuration overview on page 605
Configuring interfaces for Virtual NGFW Engines on page 614

Related tasks
Add manual ARP entries to NGFW Engines on page 624
Activate the internal DHCP server on a firewall interface on page 572
Add integrated switches for Single Firewalls on page 557

Configuring interfaces for Firewalls
The interface configuration process consists of several general steps.

The configuration proceeds as follows:

1) Add the required number of network connections:
• Add physical interfaces.
• (Optional, Single Firewalls only) Add an ADSL interface for the integrated ADSL modem.
• (Optional, Single Firewalls only) Add a wireless interface for the integrated wireless router.
• (Optional, Single Firewalls only) Add modem interfaces for 3G modem connections.
• (Optional, Single Firewalls only) Add a switch and port group interfaces for the integrated switch.

2) (Optional, physical interfaces only) Add VLAN interfaces to physical interfaces.

3) (Optional) Add tunnel interfaces for the route-based VPNs.

4) (Not applicable to modem interfaces) Configure the IP address settings.

5) (Optional) Add loopback IP addresses to assign IP addresses that do not belong to any directly connected
networks to the firewall.

6) Select the interfaces that are used for system communications.
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Related concepts
IP addresses for Single Firewall interfaces on page 560
Loopback IP addresses for firewalls on page 570

Related tasks
Add layer 3 physical interfaces for NGFW Engines in the Firewall/VPN role on page 544
Add VLAN interfaces for firewalls on page 549
Add ADSL Interfaces for Single Firewalls on page 550
Add Wireless Interfaces for Single Firewalls on page 551
Add Modem Interfaces for Single Firewalls on page 554
Add tunnel interfaces for firewalls on page 556
Add integrated switches for Single Firewalls on page 557
Select system communication roles for firewall interfaces on page 569

Add layer 3 physical interfaces for NGFW
Engines in the Firewall/VPN role
A layer 3 physical interface represents an actual network port on the engine.

Layer 3 physical interfaces correspond to network ports on the NGFW Engine. The number of defined layer 3
physical interfaces can be lower than the number of network ports on the hardware.

By default, the numbering of the layer 3 physical interfaces in the Management Client corresponds to the
operating system interface numbering on the engine. For example, Interface ID 0 is mapped to eth0 and ID 1
to eth1. However, the mapping is not fixed and you can change it through the engine command line. See the
relevant Hardware Guide for details about which Interface IDs to map with which network ports. On Firewall
Clusters, this mapping can be done differently from node to node. You must take care that the interface that
represents the same network interface on each node is correctly cabled to the same network.

An interface of the type None represents a single network port on the engine. An Aggregated Link represents two
or more network ports on the engine. An Aggregated Link in high-availability mode provides protection against
hardware failure. You can also use an Aggregated Link in load-balancing mode to increase throughput. You can
combine two network ports in an Aggregated Link in high-availability mode. You can combine up to eight network
ports in an Aggregated Link in load-balancing mode.

Note:  We recommend that you do not use the IP address of an Aggregated Link interface as the
primary or secondary control IP address of the engine.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall or Firewall Cluster and select Edit <element type>.

2) In the navigation pane on the left, select Interfaces.

3) Right-click the empty space and select New > Layer 3 Physical Interface.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Network interface configuration | 545

4) Define the interface properties.

5) Click OK.

6) Continue the configuration in one of the following ways:
• If you want to use VLANs, add the VLANs before adding IP addresses.
• Otherwise, add IP addresses directly to the layer 3 physical interfaces.

Related concepts
IP addresses for Single Firewall interfaces on page 560
Defining Zone elements on page 899
Quality of Service (QoS) and how it works on page 949

Related tasks
Configure advanced properties for firewall interfaces on page 559
Activate the internal DHCP server on a firewall interface on page 572

Adding layer 2 physical interfaces for NGFW
Engines in the Firewall/VPN role
Layer 2 physical interfaces on NGFW Engines in the Firewall/VPN role pick up traffic for inspection.

You can add one or more capture interfaces, inline IPS interfaces, and inline Layer 2 Firewall interfaces to NGFW
Engines in the Firewall/VPN role.

Table 58: Types of layer 2 physical interfaces for NGFW Engines in the Firewall/VPN role

Interface Type Description

Capture interface Capture interfaces listen to traffic that is not routed through the NGFW Engine.
Connections picked up through capture interfaces can be reset through reset
interfaces.

Inline IPS interface The interface is directly on the traffic path so that traffic passes through the
interface to reach its destination. The NGFW Engine can inspect the traffic coming
from one interface and either stop the traffic or send it out through the other
interface.

The default action for network traffic in Access rules is Allow. When Bypass mode
is used, if the interface is unable to process traffic, all traffic is allowed without
inspection.

Inline Layer 2 Firewall
interface

The interface is directly on the traffic path so that traffic passes through the
interface to reach its destination. The NGFW Engine can inspect the traffic coming
from one interface and either stop the traffic or send it out through the other
interface.

The default action for network traffic in Access rules is Discard. Bypass mode
cannot be used. If the interface is unable to process traffic, all traffic is blocked.
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Configure layer 2 physical interfaces for firewalls in the following order:

1) (Optional) Add Logical Interfaces.

2) (Optional) Add Reset Interfaces for Capture Interfaces.

3) Add Capture Interfaces, Inline IPS Interfaces, or Inline Layer 2 Firewall Interfaces.

Add logical interfaces
Logical interface elements allow you to group interfaces together according to network segment and interface
type.

Logical interfaces are used in the configuration of the following types of interfaces to represent one or more
network interfaces:
• Capture interfaces on Firewalls, IPS Engines, and Layer 2 Firewalls
• Inline interfaces on IPS engines and Layer 2 Firewalls
• Inline IPS interfaces on Firewalls
• Inline Layer 2 Firewall interfaces on Firewalls

You cannot use the same logical interface to represent both capture interfaces and inline interfaces on the same
engine. On Firewalls, you cannot use the same logical interface to represent both inline IPS interfaces and inline
Layer 2 Firewall interfaces. Otherwise, a logical interface can represent any number or combination of physical
interfaces or VLAN Interfaces.

There is one predefined logical interface element called default_eth. If you want to create both capture interfaces
and inline interfaces on the same NGFW Engine, you must add at least one more logical interface.

On IPS engines and Layer 2 Firewalls, a logical interface element called System Communications is
automatically assigned to interfaces that have an IP address that is used as the primary or backup Control IP
address. You can use the System Communications logical interface to represent all Control IP addresses in
IPS and Layer 2 Firewall Policies.

Note:
You cannot use the System Communications logical interface for the following types of
interfaces:

• Capture interfaces on Firewalls
• Inline IPS interfaces on Firewalls
• Inline Layer 2 Firewall interfaces on Firewalls

You can use logical interfaces in IPS Policies, Layer 2 Firewall Policies, and Layer 2 Interface Policies to limit
the scope of your rules. You can use logical interfaces to create rules that match based on which interface the
traffic was picked up from. For example, you can create a different logical interface for each VLAN and use them
to create rules that apply only to traffic from a specific VLAN.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Other Elements branch.
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3) Right-click Logical Interfaces and select New Logical Interface.

4) Enter a Name and an optional Comment for the new element.

5) (Optional) To prevent the engine from seeing a single connection as multiple connections when a switch
passes traffic between different VLANs, select the View Interface as One LAN option.

6) Click OK.

Related tasks
Add Capture Interfaces for IPS engines on page 583
Add Inline Interfaces for IPS engines on page 584
Add Capture Interfaces for Layer 2 Firewalls on page 597
Add Inline Interfaces for Layer 2 Firewalls on page 598

Add reset interfaces
Reset interfaces interrupt communications picked up through capture interfaces when the traffic matches a rule
that terminates connections.

Reset interfaces can deliver TCP resets and ICMP “destination unreachable” messages to interrupt
communications picked up through capture interfaces when the traffic matches a rule that terminates
connections.

The resets are sent using the source and destination addresses and MAC addresses of the communicating
hosts, so an IP address is not mandatory for a reset interface. You can optionally add an IP address if you also
want to use this interface for system communications.

VLANs are supported for sending resets, but the correct VLAN is selected automatically. The interface you want
to use as the reset interface must not have any manually added VLAN configuration.

You can use an existing system communications interface for sending resets if the reset interface connects to the
same networks as the capture interface, and there are no VLANs on the system communications interface.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element and select Edit <element type>.

2) In the navigation pane on the left, select Interfaces.

3) Create a new Physical Interface.
• For IPS engines and Layer 2 Firewalls, right-click the empty space and select New Physical Interface.
• For Firewalls, right-click the empty space and select New > Layer 3 Physical Interface.

4) Select an Interface ID.

5) Select the interface type according to the engine role:
• For IPS engines and Layer 2 Firewalls, select Normal Interface.
• For Firewalls, select None.
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6) Click OK.

Result

The Physical Interface is added to the interface list.

Note:  When you set up the physical network, make sure that the reset interface connects to the
same networks as the capture interfaces.

Next steps

Set up the capture interfaces that use this reset interface.

Related tasks
Add system communication interfaces for IPS engines on page 575
Add system communication interfaces for Layer 2 Firewalls on page 589
Add Capture Interfaces for Layer 2 Firewalls on page 597

Add layer 2 physical interfaces for NGFW
Engines in the Firewall/VPN role
Layer 2 physical interfaces on NGFW Engines in the Firewall/VPN role provide traffic inspection.

Layer 2 physical interfaces have definitions for the corresponding logical interface that the interface belongs to.
The logical interface represents one or more network interfaces that capture the traffic for inspection.

On inline IPS interfaces and inline Layer 2 Firewall interfaces, you must select a logical interface for each inline
interface.

Note:  You cannot use the same logical interface to represent both inline IPS interfaces and inline
Layer 2 Firewall interfaces.

For capture interfaces, the configuration depends on the deployment.

• When a capture interface is connected to a switch SPAN port, you must select a logical interface for each
capture interface. You can optionally select the same logical interface for more than one capture interface.

• When a network TAP device is used, you must select the same logical interface for two capture interfaces.
The monitored traffic going to different directions is captured through these two related network interfaces and
is then combined into a complete traffic flow on the logical interface.

To define a capture interface, you must select a reset interface for it. You can use Layer 3 physical interfaces that
meet the following requirements as reset interfaces:

• The Layer 3 physical interface connects to the same networks as the capture interfaces.
• There are no VLANs on the Layer 3 physical interface.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall or Firewall Cluster and select Edit <element type>.
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2) In the navigation pane on the left, select Interfaces.

3) Right-click the empty space and select New > Layer 2 Physical Interface.

4) From the Type drop-down list, select the interface type.

5) Define the physical interface properties.

Note:  You cannot select the same logical interface for a capture interface and an inline
interface on the same NGFW Engine.

CAUTION:  Using Bypass as the Failure Mode requires the NGFW Engine to have a fail-
open network interface card. If the ports that represent the pair of inline interfaces on the
appliance cannot fail open, policy installation fails. Bypass mode is not compatible with
VLAN retagging. In network environments where VLAN retagging is used, Normal mode is
automatically enforced.

6) Click OK.

Related concepts
Cable connection guidelines for IPS and Layer 2 Firewalls on page 89

Add VLAN interfaces for firewalls
VLANs divide a single physical network link into several virtual links. You can define VLANs for both Single
Firewalls and Firewall Clusters.

A Virtual Local Area Network (VLAN) is a logical grouping of hosts and network devices that allows creating
several separated networks on a single physical link. To allow this separation, the Firewall supports VLAN
tagging as defined in the IEEE 802.1q standard.

VLANs also make it easier to deploy geographically distributed Firewall Clusters (for example, a cluster whose
nodes are located in different buildings). Fewer physical interfaces and less cabling is needed. When you create
a VLAN interface, the CVI mode and MAC address are defined commonly for all virtual interfaces configured for
the same Physical interface definition.

One network interface can support up to 4094 VLANs. The defined VLAN interfaces are displayed, for example,
as “5.202” for network interface 5 with VLAN 202. The VLANs must also be defined in the configuration of the
switch or router to which the interface is connected.

Note:  If an IP address is already configured for a Firewall physical interface, adding a VLAN
interface removes the IP address. If you plan to use VLAN interfaces, configure the VLAN
interfaces first and then add IP addresses to the VLAN interfaces.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall or Firewall Cluster, then select Edit <element type>.

2) In the navigation pane on the left, browse to Interfaces.
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3) Right-click a physical interface, then select New > VLAN Interface.

4) Configure the settings, then click OK.

Result

The specified VLAN ID is added to the physical interface.

Next steps

Continue the configuration in one of the following ways:
• Add ADSL interfaces, Wireless interfaces, Modem interfaces, Tunnel interfaces, or integrated switches.
• Add IP addresses to the physical interfaces or VLAN Interfaces.

Related concepts
IP addresses for Single Firewall interfaces on page 560
Defining Zone elements on page 899
Quality of Service (QoS) and how it works on page 949

Related tasks
Configure advanced properties for firewall interfaces on page 559
Activate the internal DHCP server on a firewall interface on page 572

Add ADSL Interfaces for Single Firewalls
You can configure one ADSL Interface on each Single Firewall.

The supported ADSL standards are ANSI T1.413 issue 2n, G.dmt, G.lite, ADSL2 DMT, ADSL2 G.lite, Annex A,
and Annex B. ADSL is only supported on specific Forcepoint NGFW appliances that have an integrated ADSL
network interface card. ADSL Interfaces are not supported on Firewall Clusters.

Use the number of the ADSL port on the appliance as the Interface ID of the ADSL Interface. For information
about mapping the ADSL port on the appliance, see the relevant Hardware Guide.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall and select Edit Single Firewall.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click the empty space and select New > ADSL Interface.

4) Define the ADSL Interface properties.
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5) Click OK.
The ADSL Interface is added to the interface list.

Next steps

You are now ready to add IP addresses for the Single Firewall.

Related concepts
IP addresses for Single Firewall interfaces on page 560
Defining Zone elements on page 899
Quality of Service (QoS) and how it works on page 949

Related tasks
Configure advanced properties for firewall interfaces on page 559

Add Wireless Interfaces for Single Firewalls
You can define a Wireless Interface to use a Single Firewall as a wireless access point.

You can configure one Wireless Interface on a Single Firewall. Wireless Interfaces are only supported on specific
Forcepoint NGFW appliances that have an integrated wireless network interface card. Wireless Interfaces are not
supported on Firewall Clusters.

You can define several wireless LANs for the Wireless Interface. A wireless LAN is defined by adding an SSID
(service set identifier) interface for the Wireless Interface.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall and select Edit Single Firewall.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click the empty space and select New > Wireless Interface.

4) Define the Wireless Interface properties.

Note:  Use the number of the wireless port on the appliance as the Interface ID of the
Wireless Interface.

5) Click OK.
The Wireless Interface is added to the interface list.

Next steps

Define SSID interfaces for the Single Firewall.
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Related tasks
Add SSID Interfaces for Single Firewalls on page 552
Configure security settings for Single Firewall SSID Interfaces on page 553
Configure advanced properties for firewall interfaces on page 559

Add SSID Interfaces for Single Firewalls
You can define several SSID Interfaces for the Wireless Interface.

An SSID (service set identifier) interface represents an 802.11 wireless LAN. You can define several SSID
Interfaces for the Wireless Interface.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall and select Edit Single Firewall.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click the Wireless Interface, then select New SSID Interface.

4) Define the SSID Interface properties.

5) If you want to configure additional settings for the SSID Interface, continue the configuration in one of the
following ways:
• Configure security settings for the wireless connections.
• Filter wireless connections based on the clients’ MAC addresses.
• Activate the internal DHCP server on the SSID Interface.
• Add an IPv4 address to the interface.

6) Otherwise, save the changes to the SSID Interface.

a) Click OK to close the SSID Interface Properties dialog box.

b) Click  Save and Refresh.

Related concepts
Defining Zone elements on page 899
Quality of Service (QoS) and how it works on page 949
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Related tasks
Configure security settings for Single Firewall SSID Interfaces on page 553
Configure MAC filtering for Single Firewall SSID Interfaces on page 554
Activate the internal DHCP server on a firewall interface on page 572
Add IPv4 addresses to Single Firewall interfaces on page 562

Configure security settings for Single Firewall
SSID Interfaces
You can configure different security modes for SSID Interfaces.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) On the Security tab of the SSID Interface Properties dialog box, select the Security Mode settings.

2) Fill in the following options depending on the selected security mode:

Security mode Option

WEP Open
System

Select an option from the Key Length and Default Key lists, then enter 1 to 4 encryption
keys.

WPA Personal Select an option from the WPA Mode list, then fill in Pre-Shared Key field.

WPA
Enterprise

Select an option from the WPA Mode list, then fill in the Authentication Method field.

3) If you want to configure additional settings for the SSID Interface, continue the configuration in one of the
following ways:
• Filter wireless connections based on the clients’ MAC addresses.
• Activate the internal DHCP server on the SSID Interface.
• Add an IPv4 address to the interface.

4) Otherwise, save the changes to the SSID Interface.

a) Click OK to close the SSID Interface Properties dialog box.

b) Click  Save and Refresh.

Related concepts
Integrating external authentication services on page 1100
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Related tasks
Add IPv4 addresses to Single Firewall interfaces on page 562
Configure MAC filtering for Single Firewall SSID Interfaces on page 554
Activate the internal DHCP server on a firewall interface on page 572

Configure MAC filtering for Single Firewall
SSID Interfaces
MAC filtering allows you to restrict which clients can connect to the SSID Interface based on the clients’ MAC
address.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) On the MAC Filtering tab of the SSID Interface Properties dialog box, select an option from the MAC
Filtering Mode list.

2) Define the MAC filtering settings.

3) If you want to configure additional settings for the SSID Interface, continue the configuration in one of the
following ways:
• Activate the internal DHCP server on the SSID Interface.
• Add an IPv4 address to the interface.

4) Otherwise, save the changes to the SSID Interface.

a) Click OK to close the SSID Interface Properties dialog box.

b) Click  Save and Refresh.

Related tasks
Add IPv4 addresses to Single Firewall interfaces on page 562
Activate the internal DHCP server on a firewall interface on page 572

Add Modem Interfaces for Single Firewalls
A Modem Interface represents the settings of a 3G modem that provides a wireless link from a Single Firewall
to the Internet or to the Management Server. You can optionally define one or more Modem Interfaces for each
Single Firewall.

You can define one or more Modem Interfaces on a Single Firewall. The 3G modem is connected to a USB port
on the firewall engine.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall and select Edit Single Firewall.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click the empty space, then select New > Modem Interface.

4) Define the basic Modem Interface properties.

5) Enter the rest of the information (Access Point Name, Username and Password, and Service Name)
according to the instructions that you have received from your service provider.

6) If necessary, define the contact address information.
If components from some Locations cannot use the Default contact address, click Exceptions to define
Location-specific contact addresses.

7) Click OK.

8) If you are configuring a new Single Firewall, or if you want to change the roles the different interfaces have in
the configuration, select system communication roles for firewall interfaces.

9) Otherwise, update the routing configuration and transfer the changes to the firewall.

a) Select Routing in the navigation pane on the left.

b) Adjust the routing configuration as necessary.

c) Click  Save and Refresh.

Related concepts
Defining Zone elements on page 899

Related tasks
Define contact addresses for a single engine or a Cluster Virtual IP Address on page 132
Change or remove the PIN codes of Single Firewall Modem Interfaces on page 556
Select system communication roles for firewall interfaces on page 569
Add manual ARP entries to NGFW Engines on page 624
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Change or remove the PIN codes of Single
Firewall Modem Interfaces
In some cases, you might need to change or remove your PIN code.

If you change the SIM card of a 3G modem that is connected to a Single Firewall and the PIN code is enabled
on the new SIM card, you must change the PIN code information about the related Modem Interface. You must
remove the PIN code if a PIN code was enabled on the old SIM card but a PIN code is not enabled on the new
SIM card.

You must also change the PIN code if you have received the message “PIN code differs from initial contact
settings” at policy installation after you have finished configuring the Firewall. This message means that the PIN
code in the Modem Interface properties does not match the PIN code that you have entered for the 3G modem
in the engine’s command-line interface. If there are other problems with the PIN code, you can check through the
engine’s command line interface which PIN code was used in the initial configuration. You can then change the
PIN code information if necessary.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) On the engine command line, enter the sg-reconfigure command to start the NGFW Initial Configuration
Wizardand change the 3G modem’s PIN code information.

2) In the Management Client, right-click the Single Firewall and select Edit Single Firewall.

3) In the navigation pane on the left, select Interfaces.

4) Right-click the Modem Interface, then select Properties.

5) Change the PIN code information, then click OK.

6) Click  Save and Refresh.

Related tasks
Add Modem Interfaces for Single Firewalls on page 554

Add tunnel interfaces for firewalls
Tunnel interfaces are logical interfaces.

Any traffic that is routed to a tunnel interface and allowed by Access rules is automatically sent through the tunnel
to the peer endpoint defined in the Route-Based VPN Tunnel element. Tunnel interfaces are only used in route-
based VPNs.

You can optionally add IPv4 or IPv6 addresses to a tunnel interface. Tunnel interfaces can only have static IP
addresses. Any IP address can be added to a tunnel interface, even if the same IP address is used on another
interface or as a loopback IP address. Adding an IP address to a tunnel interface allows you to define the source
IP address of traffic sent from the NGFW Engine itself. For example, an IP address is recommended to provide
a source IP address for dynamic routing daemons, for IGMP proxy, and for Protocol Independent Multicast -
Sparse-Mode (PIM-SM) configuration. If no IP address is added to the tunnel interface, the source IP address
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for traffic sent from the NGFW Engine is automatically selected. The selection is done according to the Bypass
Default IP Address setting in the interface options for the NGFW Engine.

The mapping of tunnel interfaces to physical network interfaces on the NGFW Engine is done automatically
based on the routing configuration.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an NGFW Engine, then select Edit <element type>.

2) Browse to Interfaces.

3) Click Add, then select Tunnel Interface.

4) Configure the settings.

5) Click OK.

6) If you want to add a source IP address for traffic sent from the engine node, add IPv4 addresses or IPv6
addresses to the tunnels.

7) If you do not want to add IP addresses, select system communication roles for firewall interfaces to define
how the source IP address for traffic sent from the engine node is selected.

8) Click  Save and Refresh.

Related concepts
Quality of Service (QoS) and how it works on page 949
VPNs and how they work on page 1127

Related tasks
Add tunnel interfaces for Virtual Firewalls on page 618
Configure advanced properties for firewall interfaces on page 559
Select system communication roles for firewall interfaces on page 569
Add IPv4 addresses to Single Firewall interfaces on page 562
Add IPv6 addresses to Single Firewall interfaces on page 565
Add IPv4 and IPv6 addresses to Firewall Cluster interfaces on page 566

Add integrated switches for Single Firewalls
An integrated switch represents the switch functionality on purpose-built Forcepoint NGFW appliances. Integrated
switches eliminate the need for an external switch device and reduce costs and clutter.

You can configure one integrated switch on a Single Firewall. The switch functionality is only supported on
specific Forcepoint NGFW appliances that have an integrated switch.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall and select Edit Single Firewall.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.

3) In the right pane, right-click the empty space and select New Switch.

4) In the Switch Properties dialog box, define the switch properties.

5) Click OK.
The switch is added to the interface list.

Next steps

Add port group interfaces to the switch.

Add Port Group Interfaces for Single Firewalls
You can define one or more port group interfaces for an integrated switch. Port groups simplify port and network
segment configuration.

Before you begin
You must add the integrated switch before you can add port group interfaces.

Traffic inside a port group is not inspected. The traffic between port groups is inspected by the firewall in the
same way at other traffic.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall, then select Edit Single Firewall.

2) In the navigation pane on the left, select Interfaces.

3) In the right pane, right-click the switch and select New Port Group Interface.

4) In the Port Group Interface Properties dialog box, define the port group interface properties.

5) Click OK.
The port group interface is added to the interface list. The defined switches and port group interfaces are
displayed, for example, as 0.1 for switch ID 0 with port group 1.
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Next steps

Add IP addresses to the port group interface.

Configure advanced properties for firewall
interfaces
Advanced settings for firewall interfaces allow you to configure SYN Rate Limits, Log Compression, and IPv6
Router Advertisements.

SYN Rate Limits are applied to TCP connections. Each TCP connection starts with a SYN packet. If the SYN
Rate Limits defined for the Firewall are reached, the Firewall drops new TCP connections.

Log Compression is useful when the routing configuration generates a large volume of antispoofing logs or the
number of Discard logs becomes high (for example, as a result of a SYN flood attack).

Router advertisements are packets that contain network layer configuration parameters. Enabling IPv6 Router
Advertisements in the Physical Interface properties or Port Group Interface properties of an integrated Switch
allows devices that connect to the same IPv6 network as the Firewall to acquire IP addresses automatically. The
Router Advertisement messages specify what configuration information the Firewall offers to devices that connect
to the same network as the firewall.

Note:  The SYN Rate Limits and Log Compression settings in the interface properties override the
general SYN Rate Limits and Log Compression settings. These settings are defined in the Engine
Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall or Firewall Cluster and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click a Physical Interface, a VLAN Interface, an ADSL Interface, a Tunnel Interface, Wireless
Interface, or a Port Group Interface of an integrated Switch and select Edit Physical Interface, Edit VLAN
Interface, Edit ADSL Interface, Edit Tunnel Interface, Edit Wireless Interface, or Edit Port Group
Interface.
The properties dialog box for the interface opens.

4) Switch to the Advanced tab.

5) Select Override Engine’s Default Settings.
The options for SYN Rate Limits and Log Compression are enabled.
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6) (Optional) Define the SYN Rate Limits.

CAUTION:  The recommended values for the SYN Rate Limits depend on your network
environment. If the Custom settings are not carefully configured, the capacity of the Firewall
engine might suffer or SYN Rate Limits might not work correctly.

7) (Optional) Enable Log Compression and enter values for the Antispoofing entries and (optionally) for
Discard entries.

• Do not enable Log Compression if you want all the antispoofing and Discard entries to be logged as
separate log entries (for example, for reporting purposes or for Firewall statistics).

• By default, each generated Antispoofing and Discard log entry is logged separately and displayed
as a separate entry in the Logs view. Log Compression settings allow you to define the maximum
number of separately logged entries. When the defined limit is reached, a single antispoofing log entry
or Discard log entry is logged. The single entry contains information about the total number of the
generated Antispoofing log entries or Discard log entries. After this, the logging returns to normal and
all generated entries are once more logged and displayed separately.

8) (Physical Interfaces or Port Group Interfaces of an integrated Switch only) Select Send IPv6 Router
Advertisements and specify what configuration information is offered in the Router Advertisement
messages to devices that connect to the same network as the firewall.

9) Click OK.

10) Click  Save and Refresh.

Related tasks
Add layer 3 physical interfaces for NGFW Engines in the Firewall/VPN role on page 544
Add VLAN interfaces for firewalls on page 549
Add ADSL Interfaces for Single Firewalls on page 550
Add Wireless Interfaces for Single Firewalls on page 551
Add tunnel interfaces for firewalls on page 556
Configure SYN rate limits for engines on page 694
Configure log handling settings for engines on page 695
Add integrated switches for Single Firewalls on page 557

IP addresses for Single Firewall interfaces
You can define several types of IP addresses for the Single Firewall's interfaces.

The interfaces of a Single Firewall can have the following types of IP addresses:
• Each layer 3 physical interface can have one or more static or dynamic IP addresses. A layer 3 physical

interface can have multiple dynamic IP addresses only if you add VLAN interfaces and the VLAN interfaces
each have a dynamic IP address. Otherwise, a layer 3 physical interface can only have a single dynamic IP
address. The same interface can have both IPv4 and IPv6 addresses.

• Each Aggregated Link interface can have one or more static IP addresses. The same interface can have both
IPv4 and IPv6 addresses.

• Each VLAN interface can have one or more static IP addresses or a single dynamic IP address. The same
interface can have both IPv4 and IPv6 addresses.

• An ADSL interface can have one or more static IPv4 addresses or a single dynamic IPv4 address.
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• Each SSID interface defined for the optional Wireless interface can have a single IPv4 or IPv6 address.
• A Tunnel interface can have one or more static IP addresses.
• A Port Group interface of an integrated Switch can have one or more static IP addresses or a single dynamic

IP address. The same interface can have both IPv4 and IPv6 addresses.

Note:  You cannot add IP addresses to layer 2 physical interfaces.

You might need to define a contact address if you enter a private static address and NAT is used to translate it
to a different external IP address. The external IP address must be configured as the contact address if other
SMC components must use the external IP address to contact this Firewall or if the IP address is used as a VPN
endpoint.

To use the firewall as an IGMP proxy for multicast routing, the IP addresses for the downstream interfaces must
be the lowest IP addresses among all IGMP queries in the local networks.

Related concepts
Define contact IP addresses on page 129

Dynamic IP addresses for Single Firewall
interfaces and how they work
Single Firewalls support the use of DHCP, PPPoA, PPPoE, and SLAAC to assign dynamic IPv4 or IPv6
addresses on the firewall’s network interfaces. PPP is only supported for IPv4 addresses.

Typically, a dynamic IP address is used in smaller sites with xDSL connections that have no static IP address
available for the firewall. Modem Interfaces always have dynamic IP addresses that are provided through PPP.

Instead of an IP address, each interface with a dynamic IP address is identified in the SMC by a DHCP Index.
This is a number that is used to distinguish different interfaces with dynamic IP addresses from one another.

When a firewall has a fixed IP address, the Management Server can contact the firewall whenever there is
need. When the firewall has a dynamic IP address, the Management Server does not have a fixed IP address
to contact, so the firewall contacts the Management Server instead. You can also define that a firewall that
has a fixed IP address contacts the Management Server. The frequency of these contacts can be adjusted
as necessary. If the contact is lost (for example, the Internet connection goes down), the Management Server
queues the commands you have made to the firewall and executes them when contact is re-established.

If the address the engine uses for system communications is dynamic, the engine opens a communications
channel to the Management Server and the Management Server never attempts to contact the engine outside
this connection. If the management traffic flows through an interface that has a dynamic address, you can adjust
timeouts and other settings related to these communications.

Dynamic IP addresses also affect policy-based VPNs: other VPN gateways cannot open VPN connections to
the gateway if the address is dynamic. Instead, the gateway with the dynamic endpoint must always initiate
the VPN. After the VPN tunnel is established, connections can be made in both directions as usual. VPN client
connections can be forwarded through a site-to-site VPN from some gateway that has a static IP address (VPN
hub configuration).

Because the dynamic IP address assignment includes the next-hop gateway address, the routing for interfaces
with a dynamic address is defined using special dynamic Router and NetLink elements.

There are default Alias elements that can be used in the Firewall’s policy to represent its own dynamic
addresses. For each dynamic address interface there are four Alias elements distinguished by the DHCP index
number:



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Network interface configuration | 562

• $$ DHCP Interface X.ip: The current dynamic IP address allocated to this interface
• $$ DHCP Interface X.gateways: The received IP address for the default router
• $$ DHCP Interface X.dns: The received IP address of the DNS server
• $$ DHCP Interface X.net: The network behind the interface with a dynamic IP address

Note:  These Aliases are meant for use in the policies of the Firewall that has the dynamic IP
address. They are translated to the values of the Firewall the policy is installed on, so they cannot
be used in the policies of other components.

Related tasks
Configure global contact policy settings for node-initiated contact to the Management Server on page 512
Add Modem Interfaces for Single Firewalls on page 554

Add IPv4 addresses to Single Firewall
interfaces
You can add IPv4 addresses to layer 3 physical interfaces, VLAN interfaces, ADSL interfaces, SSID interfaces,
tunnel interfaces, and port group interfaces of an integrated switch.

Dynamic IPv4 addresses are supported on layer 3 physical interfaces, VLAN interfaces, ADSL interfaces, and
port group interfaces. Dynamic IP addresses are not supported on Aggregated Link interfaces.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall, then select Edit Single Firewall.

2) Browse to Interfaces.

3) Right-click a layer 3 physical interface, VLAN interface, SSID interface, tunnel interface, or port group
interface, then select New > IPv4 Address, or right-click an ADSL interface, then select New IPv4
Address.

4) Configure the IP address information in one of the following ways:
• Select Static, then enter the IPv4 Address. The Network Settings are automatically entered.

Tip:  To resolve the IP address from a DNS name, right-click the field, then select
Resolve From DNS Name.

• (Physical, VLAN, ADSL, and port group interfaces only) Select Dynamic, then select the DHCP
index from the Dynamic Index drop-down list. The index is used for identification in other parts of the
configuration (such as Firewall Policies) to represent the possibly changing IP address.

5) (Physical, ADSL, SSID, VLAN, and port group interfaces only) If necessary, define the contact address
information.
• Enter the Default contact address or select Dynamic (next to the Default field) if the interface has a

dynamic contact address. The Default contact address is used by default whenever a component that
belongs to another Location connects to this interface.
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• If components from some Locations cannot use the Default contact address, click Exceptions to define
Location-specific contact addresses.

• Dynamic contact addresses are not supported on SSID interfaces.

6) (Static IPv4 addresses only) Check the automatically filled-in Netmask, then adjust it as necessary.

7) (Optional) Configure additional features for this interface:
• (Static IPv4 addresses only) If you want to use VRRP on the physical interface, VLAN interface, or port

group interface of an integrated switch, add virtual routers to Single Firewall interfaces.
• (Dynamic IPv4 addresses only) If the interface requires PPPoE or PPPoA support, add point-to-point

protocol clients to Single Firewall interfaces.
• (Dynamic IPv4 addresses only) If you do not want a default route to be created through the interface,

deselect Automatic Default Route.

8) Click OK.

9) Click  Save.

10) Continue the configuration in one of the following ways:
• Add IPv6 addresses to a physical interface, VLAN interface, SSID interface, tunnel interface, or port

group interface.
• Add modem interfaces.
• If you are creating a Firewall, or if you want to change the roles the different interfaces have in the

configuration, select system communication roles for firewall interfaces.
• If you added IP addresses to tunnel interfaces, define routing for route-based VPNs.

Related concepts
Dynamic IP addresses for Single Firewall interfaces and how they work on page 561

Related tasks
Define contact addresses for a single engine or a Cluster Virtual IP Address on page 132
Add Modem Interfaces for Single Firewalls on page 554
Add virtual routers to Single Firewall interfaces on page 563
Add point-to-point protocol clients to Single Firewall interfaces on page 564
Add IPv6 addresses to Single Firewall interfaces on page 565
Select system communication roles for firewall interfaces on page 569
Add loopback IP addresses for Single Firewalls on page 571
Add manual ARP entries to NGFW Engines on page 624

Add virtual routers to Single Firewall interfaces
Virtual Router Redundancy Protocol (VRRP) allows high-availability router configurations.

VRRP support is only available on Physical Interfaces, VLAN Interfaces, or Port Group Interfaces of Single
Firewalls. One virtual router can be configured for each Physical Interface or VLAN Interface. The virtual router
can have either backup or active status. The virtual router configured for one interface does not take into account
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the status of possible virtual routers configured on other interfaces. VRRP is only supported for static IPv4
addresses.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the IP Address properties, click VRRP Settings.

2) Select Enable VRRP.

3) Enter the ID, Priority, and IPv4 Address according to the configuration of the virtual router.

4) Click OK to close the VRRP Settings dialog box.

5) Click OK to close the IP Address Properties dialog box.

6) If you are creating a Firewall, or if you want to change the roles the different interfaces have in the
configuration, select system communication roles for firewall interfaces.

7) Otherwise, click  Save and Refresh.

Related tasks
Add Modem Interfaces for Single Firewalls on page 554
Add IPv4 addresses to Single Firewall interfaces on page 562
Add IPv6 addresses to Single Firewall interfaces on page 565
Select system communication roles for firewall interfaces on page 569

Add point-to-point protocol clients to Single
Firewall interfaces
You can use PPPoE or PPPoA clients to connect the Firewall to an external ADSL modem without configuring
routing and NAT settings on the ADSL modem.

Point-to-Point Protocol over Ethernet (PPPoE) and Point-to-Point Protocol over ATM (PPPoA) clients on the
Firewall simplify the installation of an appliance when PPPoE or PPPoA is used by the network link connected
to the interface. Activating the PPPoE or PPPoA client on the Firewall allows you to connect the Firewall to an
external ADSL modem in transparent bridge mode. You must also activate the PPPoE or PPPoA client on the
Firewall if you have a specific appliance that has an ADSL port and the ISP for the ADSL connection requires
PPPoE or PPPoA. The PPPoE client is supported only for dynamic IPv4 addresses on Single Firewalls.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the IP Address properties, click PPP Settings.

2) Select the Mode that the ADSL modem connected to the interface supports:
• PPPoE: can be used with Physical Interfaces, ADSL Interfaces, and Port Group Interfaces.
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• PPPoA: can be used with ADSL interfaces only.

3) Enter the User Name and Password, and optionally the Service Name, according to the local PPPoE or
PPPoA configuration.

Tip:  Deselect Hide if you want to view the Password in plain text in the dialog box.

4) Click OK to close the PPP Settings dialog box.

5) Click OK to close the IP Address Properties dialog box.

6) If you are creating a Firewall, or if you want to change the roles the different interfaces have in the
configuration, select system communication roles for firewall interfaces.

7) Otherwise, click  Save and Refresh.

Related tasks
Add Modem Interfaces for Single Firewalls on page 554
Add IPv4 addresses to Single Firewall interfaces on page 562
Add IPv6 addresses to Single Firewall interfaces on page 565
Select system communication roles for firewall interfaces on page 569

Add IPv6 addresses to Single Firewall
interfaces
You can add IPv6 addresses to layer 3 physical interfaces, VLAN interfaces, SSID interfaces, tunnel interfaces,
and port group interfaces of an integrated switch on Single Firewalls.

Dynamic IPv6 addresses are supported on layer 3 physical interfaces, VLAN interfaces, and port group
interfaces. Dynamic IP addresses are not supported on Aggregated Link interfaces.

Note:  If you have added VLAN interfaces to physical interfaces, you must add the IPv6
Addresses to the VLAN interfaces.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall, then select Edit Single Firewall.

2) Browse to Interfaces.

3) Right-click a layer 3 physical interface, VLAN interface, SSID interface, tunnel interface, or port group
interface, then select New >  IPv6 Address.

4) Configure the IP address information in one of the following ways:
• Select Static, then enter the IPv6 Address. The Network Settings are automatically entered.
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Tip:  To resolve the IP address from a DNS name, right-click the field, then select
Resolve From DNS Name.

• (Physical, VLAN, and port group interfaces only) Select Dynamic, then select the DHCP index from the
Dynamic Index drop-down list. The index is used for identification in other parts of the configuration
(such as Firewall Policies) to represent the possibly changing IP address.

5) (Dynamic IPv6 addresses only) If necessary, define the contact address information.
• Enter the Default contact address or select Dynamic (next to the Default field) if the interface has a

dynamic contact address. The Default contact address is used by default whenever a component that
belongs to another Location connects to this interface.

• If components from some Locations cannot use the Default contact address, click Exceptions to define
Location-specific contact addresses.

• Dynamic contact addresses are not supported on SSID interfaces.

6) (Static IPv6 addresses only) Check the automatically filled-in Prefix Length, then adjust it if necessary.

7) (Optional) Configure additional features for this interface:
• (Dynamic IPv6 addresses only) If you do not want a default route to be created through the interface,

deselect Automatic Default Route.
• (Dynamic IPv6 addresses only) If you want to use DHCPv6 to get the IPv6 address, select Use

DHCPv6 to get IPv6 Address.

8) Click OK.

9) Click  Save.

10) Continue the configuration in one of the following ways:
• Define Modem interfaces.
• If you are creating a Firewall, or if you want to change the roles the different interfaces have in the

configuration, select system communication roles for firewall interfaces.
• If you added IP addresses to tunnel interfaces, define routing for the route-based VPNs.

Related tasks
Add Modem Interfaces for Single Firewalls on page 554
Add IPv4 addresses to Single Firewall interfaces on page 562
Select system communication roles for firewall interfaces on page 569
Add loopback IP addresses for Single Firewalls on page 571

Add IPv4 and IPv6 addresses to Firewall
Cluster interfaces
You can add IPv4 and IPv6 addresses to layer 3 physical interfaces, VLAN interfaces, and tunnel interfaces on
Firewall Clusters.

IPv6 addresses are supported on Firewall Clusters with dispatch clustering mode. IPv6 and IPv4 addresses can
be used together on the same Firewall Cluster.
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Firewall Clusters can have two types of IP addresses.

Table 59: Types of IP addresses for Firewall Clusters

IP address
type

Description When to use it

Cluster Virtual
IP address
(CVI)

An IP address that is used to handle traffic
routed through the cluster for inspection. All
nodes in a cluster share this IP address.

Allows other devices to communicate with the
Firewall Cluster as a single entity.

Each CVI inherits the MAC address defined
for the physical interface. The MAC/IP address
pair always remains the same as only the
location of the MAC address changes to the
current dispatcher node (packet dispatch).
This configuration makes the external network
equipment forward traffic to the correct
node for dispatching. The CVIs on different
physical interfaces cannot have duplicate MAC
addresses.

Define a CVI for the interface if traffic that
the firewall inspects is routed to or from the
interface.

Node
Dedicated IP
address (NDI)

An IP address that is used for traffic to or from
an individual node in a cluster. Each node in
the cluster has a specific IP address that is
used as the NDI.

NDIs are used for the following purposes:

• Node-to-node communications, such as
heartbeat connections between the engines
in a cluster and other traffic to or from
individual nodes.

• Traffic between each individual node and
the Management Server and Log Server

• Communications with external components
(such as authentication servers, or hosts
that are probed in network connectivity
tests)

When you define NDIs, you must define both
node-specific properties (such as the node’s
IP address) and properties that all nodes in the
cluster share. All nodes must have the same
netmask value for their NDI.

Define at least 2 NDIs: one for management
connections and one for the heartbeat traffic
between the nodes.

We recommend that you define an NDI for
each interface that has a CVI, if practical.
Some features might not work reliably without
an NDI.

If there is a CVI without a corresponding
NDI from the same network segment,
communications that require an NDI ‘borrow’
an IP address. The address can be borrowed
from another NDI on the same physical
interface, VLAN interface, or aggregated
link interface. If there is no NDI on the
same physical interface, VLAN interface,
or aggregated link interface, the default IP
address for outgoing traffic is used. The
‘borrowed’ IP address can be used without
issues with routers that strictly follow the ARP
standard. You might need to create a static
ARP entry if some routers do not strictly follow
the ARP standard.

You can define one or more CVI or NDI for the same physical interface or VLAN interface. You can also define
only a CVI or only an NDI for a physical interface or VLAN interface. If the physical interface is an aggregated
link, all interfaces that belong to the aggregated link share the IP address definitions.

You might also need to define a contact address if the CVI or NDI is private and NAT is used to translate the IP
address to a different external IP address. The external IP address must be configured as the contact address in
the following cases:

• Other SMC components must use the external IP address to contact this Firewall (NDI).
• This IP address is a VPN endpoint (CVI).
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall Cluster, then select Edit Firewall Cluster.

2) Browse to Interfaces.

3) Right-click a layer 3 physical interface, VLAN interface, or tunnel interface, then add the IP address in one
of the following ways:
• To add an IPv4 address, select New > IPv4 Address
• To add an IPv6 address, select New > IPv6 Address

Note:  If you have added VLAN interfaces to a physical interface, add the IP addresses to
the VLAN interfaces.

4) (Optional) If this interface does not receive or send IPv6 traffic that the Firewall examines, deselect
Cluster Virtual IP Address.

Note:  By default, both Cluster Virtual IP Address and Node Dedicated IP Address are
selected.

5) To add a CVI address, enter the IP address in the IPv4 Address or IPv6 Address field.

Tip:  To resolve the IP address from a DNS name, right-click the field, then select Resolve
From DNS Name.

6) (IPv4 addresses only) If necessary, define the contact address for the Firewall Cluster.
• In the Default field, enter the default contact address. The default contact address is used by default

whenever a component that belongs to another Location connects to this interface.
• If components from some Locations cannot use the default contact address, click Exceptions to define

Location-specific contact addresses.

7) To add NDI addresses for the nodes, click the IPv4 Address or IPv6 Address cell in the table, then enter
the IP address for each node.

Tip:  To resolve the IP address from a DNS name, right-click the field, then select Resolve
From DNS Name.

8) (IPv4 addresses only) If necessary, double-click the Contact Address cell in the table, then define the
contact address for each node.
• In the Default field at the top of the dialog box, enter the default contact address.
• If components from some Locations cannot use the default contact address, click Add to define

Location-specific contact addresses.

9) (IPv4 addresses only) Check the automatically filled-in Netmask, then adjust it as necessary.

10) (IPv6 addresses only) Check the automatically filled-in Prefix Length, then adjust it as necessary.

11) Click OK.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Network interface configuration | 569

12) Click  Save.

13) Continue the configuration in one of the following ways:
• If you are creating a Firewall Cluster, or if you want to change the roles the different interfaces have in

the configuration, select system communication roles for firewall interfaces.
• If you added IP addresses to tunnel interfaces, define routing for route-based VPNs.
• Otherwise, refresh the policy to transfer the changes.

Related concepts
IP addresses for Single Firewall interfaces on page 560

Related tasks
Define contact addresses for a single engine or a Cluster Virtual IP Address on page 132
Define contact addresses for Node Dedicated IP Addresses on page 133
Select system communication roles for firewall interfaces on page 569
Add loopback IP addresses for Firewall Clusters on page 571
Add manual ARP entries to NGFW Engines on page 624

Select system communication roles for firewall
interfaces
You can select which IP addresses are used for particular roles in system communications (for example, in
communications between the Firewall and the Management Server).

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall or Firewall Cluster and select Edit <element type>.

2) In the navigation pane on the left, select Interfaces > Interface Options.

3) In the Interface Options pane on the right:

a) From the Primary control IP address drop-down list, select the primary control IP address for
communications with the Management Server.

Note:  We recommend that you do not use the IP address of an Aggregated Link
interface as the primary or secondary control IP address of the engine.

b) (Optional, recommended) From the Backup control IP address drop-down list, select a backup control
IP address for Management Server contact (used if the primary fails).

c) Select Node-Initiated contact to Management Server if the engine is behind a device that applies
dynamic NAT to the inbound management connections or blocks them. When this option is selected, the
engine opens a connection to the Management Server and maintains connectivity.
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d) (Firewall Clusters only) Select the primary Heartbeat Interface for communications between the nodes.
We recommend that you use a Physical Interface, not a VLAN Interface. We strongly recommend that
you do not direct any other traffic through this interface. A dedicated network helps ensure reliable and
secure operation.

CAUTION:  Primary and Backup Heartbeat networks exchange confidential information.
If dedicated networks are not possible, configure the cluster to encrypt the exchanged
information.

e) (Firewall Clusters only) Select a backup Heartbeat Interface that is used if the Primary Heartbeat
Interface is unavailable.
It is not mandatory to configure a backup Heartbeat Interface, but we strongly recommend it. If heartbeat
traffic is not delivered, the cluster cannot operate and traffic is disturbed. We strongly recommend that
you use a dedicated interface for the backup heartbeat as well.

f) In the Default IP Address for Outgoing Traffic field, select the IP address that the nodes use if they
have to initiate connections through an interface that has no Node Dedicated IP Address.

4) Click OK.

5) Click  Save and Refresh.

Next steps

You are now ready to configure routing.
• If this is a new Firewall, add routes for Firewalls.
• If you are configuring Tunnel Interfaces for route-based VPNs, define the routing for the route-based VPNs.

Related concepts
Loopback IP addresses for firewalls on page 570

Related tasks
Save the initial configuration details or upload them to Installation Server on page 642
Adjust general Firewall clustering options on page 685

Loopback IP addresses for firewalls
You can use Loopback IP addresses to assign IP addresses that do not belong to any directly connected
networks to the firewall.

Loopback IP addresses are not connected to any physical interface and they do not create connectivity to any
network.
• You can add several loopback IP addresses to each Firewall.
• Any IP address that is not already used as a Cluster Virtual IP Addresses (CVI) or Node Dedicated IP

Addresses (NDI) on another interface can be used as a loopback IP address.
• The same IP address can be used as a loopback IP address and as the IP address of a Tunnel Interface.
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• Loopback IP addresses can be used as the Identity for Authentication Requests, the Source for Authentication
Requests, and the Default IP Address for Outgoing Traffic.

• Loopback IP addresses cannot be used as Control IP addresses for communication with the Management
Server or as Heartbeat Interfaces.

Related tasks
Add loopback IP addresses for Firewall Clusters on page 571

Add loopback IP addresses for Single Firewalls
You can optionally define one or more loopback IP addresses for the firewall.

Any IP address that is not used to route traffic on another interface can be used as a loopback IP address. The
same IP address can be used as a loopback IP address and as the IP address of a Tunnel Interface.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall and select Edit Single Firewall.
The Engine Editor opens.

2) In the navigation pane on the left, browse to Interfaces > Loopback.
The Loopback pane opens on the right.

3) Click Add.
A row is added to the table.

4) Click the Loopback Address cell and enter the loopback IP address.

Note:  If the IP address you want to use as a loopback IP address is already used as a
Cluster Virtual IP Addresses (CVI) or Node Dedicated IP Addresses (NDI) on another
interface, you must remove the IP address from the interface configuration before using it as a
loopback IP address.

5) Click OK.

6) Click  Save and Refresh.

Add loopback IP addresses for Firewall
Clusters
You can optionally define one or more loopback IP addresses for the Firewall Cluster.

Any IP address that is not already used as a Cluster Virtual IP Addresses (CVI) or Node Dedicated IP Addresses
(NDI) on another interface can be used as a loopback IP address. The same IP address can be used as a
loopback IP address and as the IP address of a Tunnel Interface.

Whether to define a CVI or NDI loopback address depends on the traffic for which the loopback IP address is
used:
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• A CVI loopback IP address is used for loopback traffic that is sent to the whole cluster. All the nodes in the
cluster share it.

• An NDI loopback IP address is used for loopback traffic that is sent to a specific node in the cluster. NDI
loopback IP addresses must be unique for each node.

Note:  If the IP address you want to use as a loopback IP address is already used as a CVI or
NDI on another interface, you must remove the IP address from the interface configuration before
using it as a loopback IP address.

If you use NDI Loopback IP addresses, you must define an NDI loopback IP address for all nodes.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall Cluster and select Edit Firewall Cluster.
The Engine Editor opens.

2) In the navigation pane on the left, browse to Interfaces > Loopback.
The Loopback pane opens on the right.

3) Click Add below the table to which you want to add a loopback IP address.
A row is added to the table.

4) (CVI only) Click the CVI Address cell and enter the loopback IP address for the cluster.

5) (NDI only) Click the NDI Address cell for each node and enter the node-specific loopback IP address.

6) Click OK.

7) Click  Save and Refresh.

Activate the internal DHCP server on a firewall
interface
You can use the internal DHCP server in a Single Firewall or Firewall Cluster to assign IPv4 addresses to hosts
in the protected network.

This solution is meant for small installations. It might be more practical to assign the IP addresses using the
firewall rather than relay the DHCP requests from a separately maintained local DHCP server or from some other
site’s DHCP server through a VPN.

The internal DHCP server can be set up independently on several Physical Interfaces, VLAN Interfaces, and Port
Group Interfaces of an integrated Switch. When VLAN or Port Group Interfaces are configured, the DHCP server
must be set up separately for each VLAN or Port Group. Only IPv4 addresses are supported. To use this feature,
the Firewall interface must have at least one IPv4 address.

Note:  You can use the internal DHCP server to provide IP addresses to the VPN client Virtual
Adapter only if you use Single Firewalls as VPN gateways.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall or Firewall Cluster element and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click a Physical Interface, VLAN Interface, SSID Interface, or Port Group Interface and select Edit
Physical Interface, Edit VLAN Interface, Edit SSID Interface, or Edit Port Group Interface.
The properties dialog box for the interface opens.

4) Switch to the DHCP tab.

5) Select DHCP Server as the DHCP Mode.
The DHCP Server options are displayed.

6) Define the DHCP Address Range that the Firewall assigns to clients in one of the following ways:
• Click Select and select an Address Range element.
• Click Address and enter a single IP address or an IP address range.

Note:  The DHCP address range must be in the same network space defined for the
Physical Interface. The DHCP address range must not contain the Firewall’s NDI or CVI
addresses or broadcast IP addresses of networks behind the Firewall. On Firewall Clusters,
the DHCP Address range is automatically divided between the nodes.

7) (Optional) In the Primary DNS Server and Secondary DNS Server fields, enter the IP addresses of the
external DNS servers that clients use to resolve domain names.
If there is a listening IP address for DNS Relay on the same interface, clients use the DNS services
provided by the firewall by default. If you want clients to use a different external DNS server, enter the IP
address of the external DNS server in the Primary DNS Server field.

8) (Optional) In the Primary WINS Server and Secondary WINS Server fields, enter the IP address that
clients use to resolve NetBIOS computer names.

9) In the Default Gateway field, enter the IP address of the gateway through which traffic from clients is
routed.

10) (Optional) Enter the Default Lease Time after which IP addresses assigned to clients must be renewed.

11) (Optional) Enter a comma-separated Domain Name Search List to configure DNS search suffixes.

12) (Optional, clusters only) Select Override DHCP Ranges per Node and enter the DHCP Address Range
for each node

CAUTION:  Enter unique ranges for each node. Overlapping ranges can cause IP address
duplication.

13) Click  Save and Refresh to transfer the new configuration to the engines.
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Related concepts
Getting started with Access rules on page 817

Configuring interfaces for IPS engines
The interface configuration for Single IPS engines and IPS Clusters consists of several main steps.

Follow these general steps to configure IPS interfaces:

1) Define the required number of Physical Interfaces.

2) Add the required number of VLANs.

3) Add IP addresses or a traffic inspection role to the interface.
• IP addresses are required for interfaces that are used for system communications.
• Interfaces that have a traffic inspection role work transparently in the network and do not have IP

addresses.

4) Select the interfaces that are used for system communications.

Related concepts
Configuring interfaces for Firewalls on page 543
IP addresses for IPS engines on page 578
Types of traffic inspection interfaces for IPS engines on page 581
Configuring interfaces for Layer 2 Firewalls on page 588

Related tasks
Add system communication interfaces for IPS engines on page 575
Add VLAN Interfaces for IPS engines on page 576
Select system communication roles for IPS interfaces on page 587
Add manual ARP entries to NGFW Engines on page 624

Heartbeat network for IPS Clusters
The nodes in an IPS cluster exchange status information through a heartbeat network using multicast
transmissions.

If an IPS node becomes unavailable, the other nodes of the cluster immediately notice this, and connections
are reallocated to the available nodes. A dedicated network is recommended for at least the primary heartbeat
communications.
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Add system communication interfaces for IPS
engines
Normal Interfaces are used for communication between the IPS engine and the Management Server.

Physical Interfaces correspond to network ports on the IPS engine. In an IPS Cluster, each physical interface
definition represents a network interface on all nodes of the cluster. By default, the numbering of the Physical
Interfaces in the Management Client corresponds to the operating system interface numbering on the engine. For
example, Interface ID 0 is mapped to eth0, and Interface ID 1 is mapped to eth1. However, the mapping is not
fixed and you can change it through the engine command line. This mapping can be done differently from node to
node as long as you take care that the same interface on each node is correctly cabled to the same network.

In a Single IPS, Normal Interfaces are used for:
• Communication between the IPS engine and the Management Server.
• Sending event information and traffic recordings to Log Servers.
• As the Reset Interface for sending TCP Reset responses.

In an IPS Cluster, Normal Interfaces handle all traffic for which the end-point of the communication is a node
itself. Normal Interfaces are used for:
• Heartbeat communication between the nodes.
• Communication between each individual node and the Management Server.
• Sending event information and traffic recordings to Log Servers.
• For any other traffic between the node itself and some other host.

Normal Interfaces in an IPS Cluster are also used as the Reset Interface for sending TCP Reset responses.

Each Single IPS engine or node in an IPS Cluster needs at least one Normal interface for communicating with
other SMC components. You can define more than one system communication interface if it is necessary in your
network environment. It is recommended to create a separate Normal Interface that is used for communication
with the Management Server rather than using the same Normal Interface for sending event information and
traffic recordings to Log Servers, and for communication with the Management Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single IPS or IPS Cluster and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click the empty space and select New Physical Interface.

4) Define the Physical Interface properties.
Select Normal Interface as the Type.

CAUTION:  Make sure that you set the interface speed correctly. When the bandwidth is set,
the IPS engine always scales the total amount of traffic on this interface to the bandwidth you
defined. This scaling happens even if there are no bandwidth limits or guarantees defined for
any traffic.
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5) Click OK. The Physical Interface is added to the interface list.

6) Continue the configuration in one of the following ways:
• Add VLAN interfaces to the Physical Interface.
• Add IP addresses to the system communication interfaces.

Related concepts
IP addresses for IPS engines on page 578
Defining Zone elements on page 899
Quality of Service (QoS) and how it works on page 949

Related tasks
Configure advanced properties for IPS interfaces on page 586

Add VLAN Interfaces for IPS engines
VLANs divide one physical network link into several virtual links.

A Virtual Local Area Network (VLAN) is a logical grouping of hosts and network devices that appear as a single
network segment regardless of the physical topology. IPS engines support VLAN tagging as defined in the IEEE
802.1q standard. One physical interface can support up to 4094 VLANs.

VLAN tagging can be used:
• To inspect VLAN tagged traffic (no VLAN Interface configuration required on the IPS engine).
• To define different inspection rules for different VLANs (requires defining VLAN Interfaces for the IPS engine).
• For sending the IPS engine’s management and logging connections through a directly connected VLAN

segment.

Traffic picked up from a VLAN tagged interface can be inspected without configuring VLAN tagging on the
IPS engine. However, you must configure the VLANs on the IPS engine if you want to create different traffic
inspection rules for different VLANs. Even then, not all VLANs necessarily have to be specified on the IPS
engine. The traffic inspection is customized for the VLANs by defining different Logical Interfaces for the different
VLAN Capture Interfaces. The Logical Interface elements are then used in the IPS Policy rules to define which
rules are used for which VLANs.

When you use VLAN Inline Interfaces, the interface numbers must be different and the VLAN identifier must
be identical in both of the Inline Interfaces. For example, 3.101 and 4.101 would be a valid pair of VLAN Inline
Interfaces. Also, when a VLAN Interface is used for an Inline Interface, it cannot be simultaneously used for any
other types of interfaces. The VLAN identifiers you configure on the IPS engine must match the switch or router
configuration.

When you use VLAN with Capture Interfaces, the network interface used as the Reset Interface for sending TCP
Reset responses must be defined in the Capture Interface’s properties. The reset is automatically tagged for the
same VLAN that triggers a reset. The Reset Interface must be connected to the same VLAN/Broadcast domain
as the Capture Interface to reach the communicating hosts.

If the IPS engine encounters unknown VLANs, it might or might not inspect the traffic. This is controlled by the
Inspect Unspecified VLANs option in the Inline and Capture Interface definitions (by default, the option is set so
that all traffic is inspected).

CAUTION:  Do not add any manual VLAN definitions to an interface you want to use for sending
resets. Adding VLANs prevents selecting the interface as a Reset Interface and also removes the
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Reset Interface from any existing selections. The IPS engine automatically uses the correct VLAN
when sending resets.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single IPS or IPS Cluster and select Edit <element type>.

2) In the navigation pane on the left, select Interfaces.

3) Right-click a Physical Interface and select New > VLAN Interface.

4) Define the VLAN Interface properties.

CAUTION:  The throughput for each VLAN Interface must not be higher than the throughput
for the Physical Interface to which the VLAN Interface belongs.

CAUTION:  Make sure that you set the interface speed correctly. When the bandwidth is set,
the IPS engine always scales the total amount of traffic on this interface to the bandwidth you
defined. This scaling happens even if there are no bandwidth limits or guarantees defined for
any traffic.

CAUTION:  The MTU for each VLAN Interface must not be higher than the MTU for the
Physical Interface to which the VLAN Interface belongs.

5) Click OK.

6) Click  Save and Refresh.

Result

The VLAN Interface is now ready. The VLAN Interface is identified as Interface-ID.VLAN-ID, for example 2.100
for Interface ID 2 and VLAN ID 100.

Related concepts
IP addresses for IPS engines on page 578
Defining Zone elements on page 899
Quality of Service (QoS) and how it works on page 949

Related tasks
Configure advanced properties for IPS interfaces on page 586
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IP addresses for IPS engines
You can add IP addresses to system communication interfaces on IPS engines.

An IPS engine’s system communication interfaces (Normal interfaces) can have the following types of IP
addresses:
• A Physical Interface can have one or more static or dynamic IP addresses. A Physical Interface can have

multiple dynamic IP addresses only if you add VLAN Interfaces on the Physical Interface and the VLAN
Interfaces each have a dynamic IP address. Otherwise, a Physical Interface can only have a single dynamic
IP address.

• A VLAN Interface can have one or more static IP addresses or a single dynamic IP address.

When a Normal Interface is used for communication with the Management Server, as the Heartbeat Interface
in an IPS Cluster, or for communication with the Log Server, an IP Address is needed. When the same Normal
Interface that is used for communication with the Management Server and Log Server is also used as a Reset
Interface for sending TCP Reset responses, it can have an IP address. When a Normal Interface is used only as
a Reset Interface, it must not have an IP address.

All nodes in an IPS Cluster must have the same netmask value for the IP address of their respective Normal
Interfaces. The IP addresses specified for each node are used whenever the nodes need to be contacted
individually.

You might need to define a contact address if you enter a private static address and NAT is used to translate it to
a different external IP address. The external IP address must be configured as the contact address if other SMC
components need to use the external IP address to contact the engine.

Related concepts
Define contact IP addresses on page 129

Related tasks
Add IPv4 and IPv6 addresses to IPS Cluster interfaces on page 580

Add IPv4 and IPv6 addresses to Single IPS
interfaces
You can add IPv4 and IPv6 addresses to system communication interfaces on Single IPS engines.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single IPS element and select Edit Single IPS.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click a Physical Interface or VLAN Interface and select New > IPv4 Address or New > IPv6
Address.

4) Configure the IPv4 or IPv6 address settings in one of the following ways:
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• Select Static and enter the IPv4 Address or IPv6 Address. The Network Settings are automatically
entered.

Tip:  To resolve the IP address from a DNS name, right-click the field, then select
Resolve From DNS Name.

• Select Dynamic and select the DHCP index from the Dynamic Index drop-down list if the interface
gets its IP address from a DHCP server. The DHCP Index is a number for your own reference to
identify the DHCP interface.

5) (IPv4 addresses and dynamic IPv6 addresses only) If necessary, define the contact address information.
• Enter the Default contact address or select Dynamic (next to the Default field) if the interface has a

dynamic contact address. The Default contact address is used by default whenever a component that
belongs to another Location connects to this interface.

• If components from some Locations cannot use the Default contact address, click Exceptions to define
Location-specific contact addresses.

6) (Static IPv4 addresses only) Check the automatically filled-in Netmask and adjust it as necessary.

7) (Static IPv6 addresses only) Check the automatically filled-in Prefix Length and adjust it as necessary.

8) (Optional) Configure additional features for this interface:
• (Dynamic IPv4 or IPv6 addresses only) If you do not want a default route to be created through the

interface, deselect Automatic Default Route.
• (Dynamic IPv6 addresses only) If you want to use DHCPv6 to get the IPv6 address, select Use

DHCPv6 to get IPv6 Address.

9) Click OK.

10) Continue the configuration in one of the following ways:
• If you are creating a new IPS element, add traffic inspection interfaces.
• If you are editing an existing IPS element, select system communication roles for IPS interfaces.

Related concepts
Types of traffic inspection interfaces for IPS engines on page 581

Related tasks
Define contact addresses for a single engine or a Cluster Virtual IP Address on page 132
Select system communication roles for IPS interfaces on page 587
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Add IPv4 and IPv6 addresses to IPS Cluster
interfaces
You can add IPv4 and IPv6 addresses to system communication interfaces on IPS engines.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an IPS Cluster and select Edit IPS Cluster.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.

3) Right-click a physical interface or a VLAN interface and add the IP address in one of the following ways:
• To add an IPv4 address, select New > IPv4 Address
• To add an IPv6 address, select New > IPv6 Address

4) Click the IPv4 Address or IPv6 Address cell in the table and enter the IP address for each node.

Tip:  To resolve the IP address from a DNS name, right-click the field, then select Resolve
From DNS Name.

5) (IPv4 addresses only) If necessary, double-click the Contact Address cell in the table and define the
contact address for each node.
• In the Default field at the top of the dialog box, enter the default contact address. The default contact

address is used by default whenever a component that belongs to another Location connects to this
interface.

• If components from some Locations cannot use the default contact address, click Add to define
Location-specific contact addresses.

6) (IPv4 addresses only) Check the automatically filled-in Netmask and adjust it as necessary.

7) (IPv6 addresses only) Check the automatically filled-in Prefix Length and adjust it as necessary.

8) Click OK.

9) Click  Save.

10) Continue the configuration in one of the following ways:
• If you are creating a new IPS element, add traffic inspection interfaces.
• If you are editing an existing IPS element, select system communication roles for IPS interfaces.

Related concepts
Types of traffic inspection interfaces for IPS engines on page 581
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Related tasks
Define contact addresses for an IPS Cluster or a Layer 2 Firewall Cluster on page 134
Select system communication roles for IPS interfaces on page 587

Types of traffic inspection interfaces for IPS
engines
Capture Interfaces and Inline Interfaces on IPS engines pick up traffic for inspection.

IPS engines pick up traffic from the network for inspection. There are two ways to install the IPS engines:
• In an IDS-like configuration in which the traffic is only captured for inspection.
• In a full IPS configuration where the IPS engine is installed inline, directly on the traffic path so that traffic must

always pass through the IPS engine to reach its destination. Only traffic that attempts to pass through Inline
Interfaces can be actively filtered.

Connections picked up through Capture Interfaces can be reset through specially set up Reset Interfaces. To
define a Capture Interface, you must define a Reset Interface for it. Capture Interfaces and Inline Interfaces can
be defined on the same IPS engine and used simultaneously.

Logical Interface elements allow you to group interfaces together according to network segment and interface
type. You can then use the Logical Interface elements as matching criteria when you edit the rules in your IPS
policies. There is one predefined Logical Interface element (called default_eth) that can be used in interface
configurations. If you want to create both Capture and Inline Interfaces on the same IPS engine, you must add at
least one more Logical Interface.

Related tasks
Add reset interfaces on page 547
Add Capture Interfaces for IPS engines on page 583
Add Inline Interfaces for IPS engines on page 584

Add logical interfaces
Logical interface elements allow you to group interfaces together according to network segment and interface
type.

Logical interfaces are used in the configuration of the following types of interfaces to represent one or more
network interfaces:
• Capture interfaces on Firewalls, IPS Engines, and Layer 2 Firewalls
• Inline interfaces on IPS engines and Layer 2 Firewalls
• Inline IPS interfaces on Firewalls
• Inline Layer 2 Firewall interfaces on Firewalls

You cannot use the same logical interface to represent both capture interfaces and inline interfaces on the same
engine. On Firewalls, you cannot use the same logical interface to represent both inline IPS interfaces and inline
Layer 2 Firewall interfaces. Otherwise, a logical interface can represent any number or combination of physical
interfaces or VLAN Interfaces.

There is one predefined logical interface element called default_eth. If you want to create both capture interfaces
and inline interfaces on the same NGFW Engine, you must add at least one more logical interface.
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On IPS engines and Layer 2 Firewalls, a logical interface element called System Communications is
automatically assigned to interfaces that have an IP address that is used as the primary or backup Control IP
address. You can use the System Communications logical interface to represent all Control IP addresses in
IPS and Layer 2 Firewall Policies.

Note:
You cannot use the System Communications logical interface for the following types of
interfaces:

• Capture interfaces on Firewalls
• Inline IPS interfaces on Firewalls
• Inline Layer 2 Firewall interfaces on Firewalls

You can use logical interfaces in IPS Policies, Layer 2 Firewall Policies, and Layer 2 Interface Policies to limit
the scope of your rules. You can use logical interfaces to create rules that match based on which interface the
traffic was picked up from. For example, you can create a different logical interface for each VLAN and use them
to create rules that apply only to traffic from a specific VLAN.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Other Elements branch.

3) Right-click Logical Interfaces and select New Logical Interface.

4) Enter a Name and an optional Comment for the new element.

5) (Optional) To prevent the engine from seeing a single connection as multiple connections when a switch
passes traffic between different VLANs, select the View Interface as One LAN option.

6) Click OK.

Add reset interfaces
Reset interfaces interrupt communications picked up through capture interfaces when the traffic matches a rule
that terminates connections.

Reset interfaces can deliver TCP resets and ICMP “destination unreachable” messages to interrupt
communications picked up through capture interfaces when the traffic matches a rule that terminates
connections.

The resets are sent using the source and destination addresses and MAC addresses of the communicating
hosts, so an IP address is not mandatory for a reset interface. You can optionally add an IP address if you also
want to use this interface for system communications.

VLANs are supported for sending resets, but the correct VLAN is selected automatically. The interface you want
to use as the reset interface must not have any manually added VLAN configuration.

You can use an existing system communications interface for sending resets if the reset interface connects to the
same networks as the capture interface, and there are no VLANs on the system communications interface.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element and select Edit <element type>.

2) In the navigation pane on the left, select Interfaces.

3) Create a new Physical Interface.
• For IPS engines and Layer 2 Firewalls, right-click the empty space and select New Physical Interface.
• For Firewalls, right-click the empty space and select New > Layer 3 Physical Interface.

4) Select an Interface ID.

5) Select the interface type according to the engine role:
• For IPS engines and Layer 2 Firewalls, select Normal Interface.
• For Firewalls, select None.

6) Click OK.

Result

The Physical Interface is added to the interface list.

Note:  When you set up the physical network, make sure that the reset interface connects to the
same networks as the capture interfaces.

Next steps

Set up the capture interfaces that use this reset interface.

Add Capture Interfaces for IPS engines
Capture Interfaces listen to traffic that is not routed through the IPS engine.

You must define Capture Interfaces if you want to use the IPS engine to inspect traffic that does not flow through
the IPS engine. You can have as many Capture Interfaces as there are available physical ports on the IPS
engine. External equipment must be set up to mirror traffic to the Capture Interface.

Capture Interfaces have definitions for the corresponding Logical Interface that the interface belongs to. The
Logical Interface represents one or more network interfaces that capture the traffic for inspection:
• When a Capture Interface is connected to a switch SPAN port, each Capture Interface is bound to one Logical

Interface. More than one Capture Interface can optionally be bound to the same Logical Interface.
• When a network TAP device is used, two Capture Interfaces are bound to the same Logical Interface. The

monitored traffic going to different directions is captured through these two related network interfaces and is
then combined into a complete traffic flow on the Logical Interface.

You cannot select the same Logical Interface for a Capture Interface and an Inline Interface on the same IPS
engine.

A Reset Interface can be selected for a Capture Interface to send TCP Reset responses for the traffic captured
from the interface. The Reset Interface is a Normal Interface that can reach the communicating components with
the TCP Reset (for example, a Normal Interface connected to the monitored network).
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single IPS or IPS Cluster and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click the empty space, then select New Physical Interface.

4) Define the interface properties.

Note:  Select Capture Interface as the interface Type.

5) Click OK to save the interface settings.

6) Continue the configuration in one of the following ways:
• If you are creating a IPS element, select system communication roles for IPS interfaces.
• Otherwise, click  Save and Refresh to activate the new interface configuration.

Related concepts
Defining Zone elements on page 899

Related tasks
Add VLAN Interfaces for IPS engines on page 576
Add logical interfaces on page 546
Add reset interfaces on page 547
Configure advanced properties for IPS interfaces on page 586
Select system communication roles for IPS interfaces on page 587

Add Inline Interfaces for IPS engines
Define Inline Interfaces if you want to position a Single IPS or Inline IPS Cluster directly in the traffic path so that
any traffic that is to be inspected goes through the IPS engine.

Inline Interfaces allow traffic to flow through the IPS engine, so that traffic that is deemed harmful can be actively
filtered out. An Inline Interface is configured with two Interface IDs, representing two physical interfaces or two
VLANs. The IPS engine can inspect the traffic coming from one interface and either stop the traffic or send it out
through the other interface. The two interfaces are equal in the configuration. Traffic that is allowed through is
always forwarded from one interface to the other (there is no routing decision involved). Inline Interfaces do not
have an IP address or a MAC address visible to the network.

Note:  Some Forcepoint NGFW appliances use a fail-open network card. Fail-open network cards
have fixed pairs of ports. Take particular care to map these ports correctly. Otherwise, the network
cards do not correctly fail open when the IPS engine is offline.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Network interface configuration | 585

In addition to the Interface IDs, Inline Interfaces also have definitions for the corresponding Logical Interface
that the interface belongs to. A single Logical Interface can represent one or more pairs of Inline Interfaces. The
Logical Interface element can be used to represent the interfaces in the IPS Policy. You cannot select the same
Logical Interface for a Capture Interface and an Inline Interface on the same IPS engine.

The number of Inline Interfaces you can configure is limited by the IPS engine’s license.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single IPS or IPS Cluster and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click the empty space, then select New Physical Interface.

4) Define the interface properties.

Note:  Select Inline Interface as the interface Type.

CAUTION:  Using Bypass as the Failure Mode requires the IPS appliance to have a fail-
open network interface card. If the ports that represent the pair of Inline Interfaces on the
appliance cannot fail open, the policy installation fails on the IPS engine. Bypass mode is not
compatible with VLAN retagging. In network environments where VLAN retagging is used,
Normal mode is automatically enforced.

5) Click OK to save the interface settings.

6) Continue the configuration in one of the following ways:
• If you are creating an new IPS element, select system communication roles for IPS interfaces.
• Otherwise, click  Save and Refresh to activate the new interface configuration.

Related concepts
Defining Zone elements on page 899
Quality of Service (QoS) and how it works on page 949

Related tasks
Add VLAN Interfaces for IPS engines on page 576
Add logical interfaces on page 546
Select system communication roles for IPS interfaces on page 587



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Network interface configuration | 586

Configure advanced properties for IPS
interfaces
Advanced settings allow you to configure SYN Rate Limits and Log Compression on the IPS engine’s interfaces.

SYN Rate Limits are applied to TCP connections. Each TCP connection starts with a SYN packet. If the SYN
Rate Limits defined for the IPS engine are reached, the IPS engine drops new TCP connections.

Log Compression is useful when the number of Discard logs becomes high (for example, as a result of a SYN
flood attack).

Note:  The SYN Rate Limits and Log Compression settings in the interface properties override the
general SYN Rate Limits and Log Compression settings. These settings are defined in the Engine
Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single IPS or IPS Cluster and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click a Physical Interface or a VLAN Interface and select Edit Physical Interface or Edit VLAN
Interface.
The properties dialog box for the interface opens.

4) Switch to the Advanced tab.

5) Select Override Engine’s Default Settings.
The options for SYN Rate Limits and Log Compression are enabled.

6) (Optional) Define the SYN Rate Limits.

CAUTION:  The recommended values for the SYN Rate Limits depend on your network
environment. If the Custom settings are not carefully configured, the capacity of the engine
might suffer or SYN Rate Limits might not work correctly.

7) (Optional) Enable Log Compression and enter values for the Discard entries.
Do not enable Log Compression if you want all Discard entries to be logged as separate log entries (for
example, for reporting purposes or for engine statistics).

By default, each generated Discard log entry is logged separately and displayed as a separate entry in the
Logs view. Log Compression settings allow you to define the maximum number of separately logged entries.
When the defined limit is reached, a single Discard log entry is logged. The single entry contains information
about the total number of the generated Discard log entries. After this, the logging returns to normal and all
generated entries are once more logged and displayed separately.

8) Click OK.
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9) Click  Save and Refresh to transfer the configuration changes.

Related concepts
Types of traffic inspection interfaces for IPS engines on page 581

Related tasks
Add system communication interfaces for IPS engines on page 575
Add VLAN Interfaces for IPS engines on page 576
Configure SYN rate limits for engines on page 694
Configure log handling settings for engines on page 695

Select system communication roles for IPS
interfaces
You can optionally change which interfaces are used for which types of system communications.

The Interface Options allow you to define:
• Which IP addresses are used as the primary and backup Control IP address
• Which interfaces are used as the primary and backup Heartbeat Interface (IPS Clusters only)
• The default IP address for outgoing traffic

By default, the first IP address you add to a Normal Interface is automatically selected as:
• The primary Control IP address
• The primary Heartbeat Interface (IPS Clusters only)
• The default IP address for outgoing traffic

You can optionally change which interface is used for each of these purposes, and define a backup Control IP
address and backup Heartbeat Interface (IPS Clusters only).

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single IPS or IPS Cluster and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces > Interface Options.

3) In the Interface Options pane on the right:

a) Select the Primary Control IP address for Management Server contact.

b) (Optional) Select a Backup Control IP address that is used if the Primary Control IP address is not
available.

c) Select Node-Initiated contact to Management Server if the engine is behind a device that applies
dynamic NAT to the inbound management connections or blocks them. When this option is selected, the
engine opens a connection to the Management Server and maintains connectivity.
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d) (IPS Clusters only) Select the Primary Heartbeat Interface for communications between the nodes.
We recommend that you use a Physical Interface, not a VLAN Interface. We strongly recommend that
you do not direct any other traffic through this interface. A dedicated network helps ensure reliable and
secure operation.

CAUTION:  Primary and Backup Heartbeat networks exchange confidential information.
If dedicated networks are not possible, configure the cluster to encrypt the exchanged
information.

e) (IPS Clusters only) Select a Backup Heartbeat Interface that is used if the Primary Heartbeat Interface is
unavailable.
It is not mandatory to configure a backup Heartbeat Interface, but we strongly recommend it. If heartbeat
traffic is not delivered, the cluster cannot operate and traffic is disturbed. We strongly recommend that
you use a dedicated interface for the backup heartbeat as well.

f) In the Default IP Address for Outgoing Traffic field, select the IP address that the nodes use if they
have to initiate connections through an interface that has no Node Dedicated IP Address.

4) Continue the configuration in one of the following ways:
• If you are creating a new IPS element, configure the routing.
• Otherwise, click  Save and Refresh to activate the new interface configuration.

Related concepts
Connect engines to the SMC on page 641

Related tasks
Adjust IPS clustering options on page 688
Add routes for IPS engines or Layer 2 Firewalls on page 718

Configuring interfaces for Layer 2
Firewalls

The interface configuration for Single Layer 2 Firewalls and Layer 2 Firewall Clusters consists of several main
steps.

1) Add the required number of Physical Interfaces.

2) Add the required number of VLAN Interfaces.

3) Add IP addresses or a traffic inspection role to the interfaces.
• IP addresses are required for interfaces that are used for system communications.
• Interfaces that have a traffic inspection role work transparently in the network and do not have IP

addresses.
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4) Select the interfaces that are used for system communications.

Related concepts
Configuring interfaces for Firewalls on page 543
Configuring interfaces for IPS engines on page 574
IP addresses for Layer 2 Firewalls on page 592
Types of traffic inspection interfaces for Layer 2 Firewalls on page 595

Related tasks
Select system communication roles for Layer 2 Firewall interfaces on page 601
Add system communication interfaces for Layer 2 Firewalls on page 589
Add VLAN interfaces for Layer 2 Firewalls on page 591
Add manual ARP entries to NGFW Engines on page 624

Network interfaces for using Layer 2 Firewalls
in Passive Firewall mode
You can configure Layer 2 Firewalls in Passive Firewall mode. In Passive Firewall mode, the engine captures
network traffic for inspection but does not actively filter traffic.

The most common way to configure a Layer 2 Firewall in Passive Firewall mode is to define Capture Interfaces
for listening to network traffic that does not flow through the Layer 2 Firewall. If you configure only Capture
Interfaces, the engine always functions in Passive Firewall mode. You can also use a Layer 2 Firewall that has
Inline Interfaces in Passive Firewall mode. To do this, you configure the engine to only log connections.

Add system communication interfaces for
Layer 2 Firewalls
Normal Interfaces are used for communication between the Layer 2 Firewall and the Management Server.

A Physical Interface element corresponds to a network port on the Layer 2 Firewall. By default, the numbering of
the Physical Interfaces in the Management Client corresponds to the operating system interface numbering on
the engine. For example, Interface ID 0 is mapped to eth0, and Interface ID 1 is mapped to eth1. However, the
mapping is not fixed and you can change it through the engine command line.

In a Single Layer 2 Firewall, Normal Interfaces are used for the following types of communication:
• Communication between the Layer 2 Firewall and the Management Server.
• For sending event information and traffic recordings to Log Servers.

In a Layer 2 Firewall Cluster, Normal Interfaces handle all traffic for which the endpoint of the communication is a
node itself. Normal Interfaces are used for the following types of communication:
• The Heartbeat communication between the nodes.
• Communication between each individual node and the Management Server.
• For sending event information and traffic recordings to Log Servers.
• For any other traffic between the node itself and some other host.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Network interface configuration | 590

Each Layer 2 Firewall needs at least one interface for communicating with other SMC components. You can
define more than one system communication interface if it is necessary in your network environment. Multiple
Normal Interfaces can be configured for the same physical network interface. It is recommended to create a
separate Normal Interface for each of the following uses:
• For communication with the Management Server.
• For sending event information and traffic recordings to Log Servers.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Layer 2 Firewall or Layer 2 Firewall Cluster and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.

3) In the Interfaces pane on the right, right-click the empty space and select New Physical Interface.

4) Define the Physical Interface properties.
Select Normal Interface as the Type.

CAUTION:  Make sure that you set the Interface speed correctly if you enter a Throughput
value for QoS. When the bandwidth is set, the Layer 2 Firewall always scales the total amount
of traffic on this interface to the bandwidth you defined. The bandwidth is scaled even if there
are no bandwidth limits or guarantees defined for any traffic.

5) Click OK. The Physical Interface is added to the interface list.

6) Continue the configuration in one of the following ways:
• If the system communications must use a particular VLAN on the directly connected network segment,

add VLAN interfaces.
• Otherwise, add IP addresses to the system communication interfaces.

Related concepts
Creating engine elements on page 472
Editing existing engine elements on page 498
IP addresses for Layer 2 Firewalls on page 592
Defining Zone elements on page 899
Quality of Service (QoS) and how it works on page 949

Related tasks
Configure advanced properties for Layer 2 Firewall interfaces on page 599
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Add VLAN interfaces for Layer 2 Firewalls
VLANs divide a single physical network link into several virtual links.

VLANs divide a single physical network link into several virtual links. VLANs can be defined for both single and
clustered Layer 2 Firewalls. The maximum number of VLANs for a single Physical Interface or Inline Interface
is 4094. The VLANs must also be defined in the configuration of the switch or router to which the interface is
connected.

Traffic picked up from a VLAN tagged interface can be inspected without configuring VLAN tagging on the Layer
2 Firewall. However, you must configure VLANs on the Layer 2 Firewall if you want to create different traffic
inspection rules for different VLANs. Even then, not all VLANs necessarily have to be specified on the Layer
2 Firewall. VLANs can optionally also be used for sending the Layer 2 Firewall’s management and logging
connections through a directly connected VLAN segment.

By default, all VLAN traffic is inspected in the same way as non-VLAN traffic. Configure VLAN Interfaces for the
physical interfaces if you want to customize traffic inspection for the different VLANs. The traffic inspection is
customized for the VLANs by defining different Logical Interfaces for the different VLAN Interfaces. The Logical
Interface elements are then used in the Layer 2 Firewall Policy rules to define which rules are used for which
VLANs.

If the Layer 2 Firewall encounters unknown VLANs, it might or might not inspect the traffic. The Inspect
Unspecified VLANs option in the Inline Interface definitions defines whether the Layer 2 Firewall inspects the
traffic. By default, the option is set so that all traffic is inspected.

When you use VLANs with Inline Interfaces, the interface numbers must be different and the VLAN identifier must
be identical in both of the Inline Interfaces. For example, 3.101 and 4.101 would be a valid pair of VLAN Inline
Interfaces. Also, when a VLAN Interface is used for an Inline Interface, it cannot be simultaneously used for any
other types of interfaces.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Layer 2 Firewall or Layer 2 Firewall Cluster and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click a Physical Interface and select New > VLAN Interface.

4) Define the VLAN Interface properties.

CAUTION:  The throughput for each VLAN Interface must not be higher than the throughput
for the Physical Interface to which the VLAN Interface belongs.

CAUTION:  Make sure that you set the interface speed correctly. When the bandwidth is set,
the Layer 2 Firewall always scales the total amount of traffic on this interface to the bandwidth
you defined. The bandwidth is scaled even if there are no bandwidth limits or guarantees
defined for any traffic.

CAUTION:  The MTU for each VLAN Interface must not be higher than the MTU for the
Physical Interface to which the VLAN Interface belongs.
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5) Click OK.
The specified VLAN ID is added to the Physical Interface.

6) Continue the configuration in one of the following ways:
• If you added a VLAN Interface to a Normal interface, add IP addresses to the VLAN Interface.
• If you added a VLAN Interface to an Inline Interface, the Inline Interface is ready to use. Click  Save and

Install to activate the new interface configuration.

Related concepts
IP addresses for Layer 2 Firewalls on page 592
Types of traffic inspection interfaces for Layer 2 Firewalls on page 595
Defining Zone elements on page 899
Quality of Service (QoS) and how it works on page 949

Related tasks
Add system communication interfaces for Layer 2 Firewalls on page 589
Configure advanced properties for Layer 2 Firewall interfaces on page 599

IP addresses for Layer 2 Firewalls
You can add IP addresses to system communication interfaces on Layer 2 Firewalls.

A Layer 2 Firewall’s system communication interfaces (Normal interfaces) can have the following types of IP
addresses:
• A Physical Interface can have one or more static or dynamic IP addresses. A Physical Interface can have

multiple dynamic IP addresses only if you add VLAN Interfaces on the Physical Interface and the VLAN
Interfaces have dynamic IP addresses. Otherwise, a Physical Interface can only have a single dynamic IP
address.

• A VLAN Interface can have one or more static IP addresses or a single dynamic IP address.

You might need to define a contact address if you enter a private static address and NAT is used to translate it to
a different external IP address. The external IP address must be configured as the contact address if other SMC
components need to use the external IP address to contact the engine.

Related concepts
Define contact IP addresses on page 129

Related tasks
Add IPv4 and IPv6 addresses to Single Layer 2 Firewall interfaces on page 593
Add IPv4 and IPv6 addresses to Layer 2 Firewall Cluster interfaces on page 594
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Add IPv4 and IPv6 addresses to Single Layer 2
Firewall interfaces
You can add IPv4 and IPv6 addresses to system communication interfaces on Single Layer 2 Firewalls.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Layer 2 Firewall and select Edit Single Layer 2 Firewall.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click a Physical Interface or a VLAN Interface and select New > IPv4 Address or New > IPv6
Address.

4) Configure the IPv4 or IPv6 address settings in one of the following ways:
• Select Static and enter the IPv4 Address or IPv6 Address. The Network Settings are automatically

entered.

Tip:  To resolve the IP address from a DNS name, right-click the field, then select
Resolve From DNS Name.

• Select Dynamic and select the DHCP index from the Dynamic Index drop-down list if the interface
gets its IP address from a DHCP server. The DHCP Index is a number for your own reference to
identify the DHCP interface.

5) (IPv4 addresses and dynamic IPv6 addresses only) If necessary, define the contact address information.
• Enter the default contact address or select Dynamic (next to the Default field) if the interface has a

dynamic contact address. The default contact address is used by default whenever a component that
belongs to another Location connects to this interface.

• If components from some Locations cannot use the default contact address, click Exceptions to define
Location-specific contact addresses.

6) (Static IPv4 addresses only) The Netmask field is automatically populated. Adjust it as necessary.

7) (Static IPv6 addresses only) The Prefix Length field is automatically populated. Adjust it as necessary.

8) (Optional) Configure additional features for this interface:
• (Dynamic IPv4 or IPv6 addresses only) If you do not want a default route to be created through the

interface, deselect Automatic Default Route.
• (Dynamic IPv6 addresses only) If you want to use DHCPv6 to get the IPv6 address, select Use

DHCPv6 to get IPv6 Address.

9) Click OK.

10) Continue the configuration in one of the following ways:
• If you are defining a new Layer 2 Firewall element, add traffic inspection interfaces.
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• If you are editing an existing Layer 2 Firewall element, select system communication roles for Layer 2
Firewall interfaces.

Related concepts
Types of traffic inspection interfaces for Layer 2 Firewalls on page 595

Related tasks
Define contact addresses for a single engine or a Cluster Virtual IP Address on page 132
Select system communication roles for Layer 2 Firewall interfaces on page 601

Add IPv4 and IPv6 addresses to Layer 2
Firewall Cluster interfaces
You can add IPv4 and IPv6 addresses to system communication interfaces on Layer 2 Firewall Clusters.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Layer 2 Firewall Cluster and select Edit Layer 2 Firewall Cluster.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.

3) Right-click a physical interface or a VLAN interface and add the IP address in one of the following ways:
• To add an IPv4 address, select New > IPv4 Address
• To add an IPv6 address, select New > IPv6 Address

4) Click the IPv4 Address or IPv6 Address cell in the table and enter the IP address for each node.

Tip:  To resolve the IP address from a DNS name, right-click the field, then select Resolve
From DNS Name.

5) (IPv4 addresses only) If necessary, double-click the Contact Address cell in the table and define the
contact address for each node.
• In the Default field at the top of the dialog box, enter the default contact address. The default contact

address is used by default whenever a component that belongs to another Location connects to this
interface.

• If components from some Locations cannot use the default contact address, click Add to define
Location-specific contact addresses.

6) (IPv4 addresses only) Check the automatically filled-in Netmask and adjust it as necessary.

7) (IPv6 addresses only) Check the automatically filled-in Prefix Length and adjust it as necessary.

8) Click OK.
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9) Click  Save.

10) Continue the configuration in one of the following ways:
• If you are creating a new Layer 2 Firewall Cluster element, add traffic inspection interfaces.
• If you are editing an existing Layer 2 Firewall Cluster element, select system communication roles for

IPS interfaces.

Related tasks
Define contact addresses for an IPS Cluster or a Layer 2 Firewall Cluster on page 134
Select system communication roles for Layer 2 Firewall interfaces on page 601

Types of traffic inspection interfaces for Layer
2 Firewalls
Capture Interfaces and Inline Interfaces on Layer 2 Firewalls pick up traffic for inspection.

Layer 2 Firewalls inspect network traffic. Layer 2 Firewalls are typically installed inline, directly on the traffic path
so that traffic must always pass through the Layer 2 Firewall engine to reach its destination. Only traffic that
attempts to pass through Inline Interfaces can be actively filtered.

You can also configure a Layer 2 Firewall in Passive Firewall mode. In Passive Firewall mode, a Layer 2 Firewall
has Capture Interfaces defined for inspections that listen to and log network traffic.

Connections picked up through Capture Interfaces can be reset through specially set-up Reset Interfaces.
Capture Interfaces and Inline Interfaces can be defined on the same Layer 2 Firewall and used simultaneously.

Logical Interface elements allow you to group interfaces together according to network segment. You can then
use the Logical Interface elements as matching criteria when you edit the rules in your Layer 2 Firewall policies.

Related tasks
Add logical interfaces on page 546
Add Capture Interfaces for IPS engines on page 583
Add Inline Interfaces for IPS engines on page 584

Add logical interfaces
Logical interface elements allow you to group interfaces together according to network segment and interface
type.

Logical interfaces are used in the configuration of the following types of interfaces to represent one or more
network interfaces:
• Capture interfaces on Firewalls, IPS Engines, and Layer 2 Firewalls
• Inline interfaces on IPS engines and Layer 2 Firewalls
• Inline IPS interfaces on Firewalls
• Inline Layer 2 Firewall interfaces on Firewalls

You cannot use the same logical interface to represent both capture interfaces and inline interfaces on the same
engine. On Firewalls, you cannot use the same logical interface to represent both inline IPS interfaces and inline
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Layer 2 Firewall interfaces. Otherwise, a logical interface can represent any number or combination of physical
interfaces or VLAN Interfaces.

There is one predefined logical interface element called default_eth. If you want to create both capture interfaces
and inline interfaces on the same NGFW Engine, you must add at least one more logical interface.

On IPS engines and Layer 2 Firewalls, a logical interface element called System Communications is
automatically assigned to interfaces that have an IP address that is used as the primary or backup Control IP
address. You can use the System Communications logical interface to represent all Control IP addresses in
IPS and Layer 2 Firewall Policies.

Note:
You cannot use the System Communications logical interface for the following types of
interfaces:

• Capture interfaces on Firewalls
• Inline IPS interfaces on Firewalls
• Inline Layer 2 Firewall interfaces on Firewalls

You can use logical interfaces in IPS Policies, Layer 2 Firewall Policies, and Layer 2 Interface Policies to limit
the scope of your rules. You can use logical interfaces to create rules that match based on which interface the
traffic was picked up from. For example, you can create a different logical interface for each VLAN and use them
to create rules that apply only to traffic from a specific VLAN.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Other Elements branch.

3) Right-click Logical Interfaces and select New Logical Interface.

4) Enter a Name and an optional Comment for the new element.

5) (Optional) To prevent the engine from seeing a single connection as multiple connections when a switch
passes traffic between different VLANs, select the View Interface as One LAN option.

6) Click OK.

Add reset interfaces
Reset interfaces interrupt communications picked up through capture interfaces when the traffic matches a rule
that terminates connections.

Reset interfaces can deliver TCP resets and ICMP “destination unreachable” messages to interrupt
communications picked up through capture interfaces when the traffic matches a rule that terminates
connections.

The resets are sent using the source and destination addresses and MAC addresses of the communicating
hosts, so an IP address is not mandatory for a reset interface. You can optionally add an IP address if you also
want to use this interface for system communications.

VLANs are supported for sending resets, but the correct VLAN is selected automatically. The interface you want
to use as the reset interface must not have any manually added VLAN configuration.
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You can use an existing system communications interface for sending resets if the reset interface connects to the
same networks as the capture interface, and there are no VLANs on the system communications interface.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element and select Edit <element type>.

2) In the navigation pane on the left, select Interfaces.

3) Create a new Physical Interface.
• For IPS engines and Layer 2 Firewalls, right-click the empty space and select New Physical Interface.
• For Firewalls, right-click the empty space and select New > Layer 3 Physical Interface.

4) Select an Interface ID.

5) Select the interface type according to the engine role:
• For IPS engines and Layer 2 Firewalls, select Normal Interface.
• For Firewalls, select None.

6) Click OK.

Result

The Physical Interface is added to the interface list.

Note:  When you set up the physical network, make sure that the reset interface connects to the
same networks as the capture interfaces.

Next steps

Set up the capture interfaces that use this reset interface.

Add Capture Interfaces for Layer 2 Firewalls
Capture Interfaces listen to traffic that is not routed through the Layer 2 Firewall.

You can have as many Capture Interfaces as there are available physical ports on the Layer 2 Firewall engine.
External equipment must be set up to mirror traffic to the Capture Interface.

Capture Interfaces are used to configure a Layer 2 Firewall in Passive Firewall mode. In Passive Firewall mode,
the Layer 2 Firewall only listens to traffic that does not flow through it.

Capture Interfaces have definitions for the corresponding Logical Interface that the interface belongs to. The
Logical Interface represents one or more network interfaces that capture the traffic for inspection. Each Capture
Interface is bound to one Logical Interface. More than one Capture Interface can optionally be bound to the same
Logical Interface.

You cannot select the same Logical Interface for a Capture Interface and an Inline Interface on the same Layer 2
Firewall.

A Reset Interface can be selected for a Capture Interface to send TCP Reset responses for the traffic captured
from the interface. The Reset Interface is a Normal Interface that can reach the communicating components with
a TCP Reset (for example, a Normal Interface connected to the monitored network).
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Layer 2 Firewall or Layer 2 Firewall Cluster and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click the empty space and select New Physical Interface.

4) Define the interface properties.

Note:  Select Capture Interface as the interface Type.

5) Click OK to save the interface settings.

6) Continue the configuration in one of the following ways:
• If you are creating a new Layer 2 Firewall element, select system communication roles for Layer 2

Firewall interfaces.
• If you added an interface to an existing Layer 2 Firewall element, click  Save and Refresh to activate

the new interface configuration.

Related concepts
Defining Zone elements on page 899

Related tasks
Add VLAN interfaces for Layer 2 Firewalls on page 591
Add logical interfaces on page 546
Add reset interfaces on page 547
Configure advanced properties for Layer 2 Firewall interfaces on page 599
Select system communication roles for Layer 2 Firewall interfaces on page 601

Add Inline Interfaces for Layer 2 Firewalls
Inline Interfaces allow traffic to flow through the Layer 2 Firewall, so that traffic that is harmful can be actively
filtered out.

An Inline Interface consists of two physical interfaces or two VLANs. This way, the Layer 2 Firewall can inspect
the traffic coming from one interface and either stop the traffic or send it out through the other interface. Traffic
that is allowed through is always forwarded from one interface to the other (there is no routing decision involved
in the interface selection).

In addition to the Interface IDs, Inline Interfaces also have definitions for the corresponding Logical Interface
that this interface belongs to. A single Logical Interface can represent one or more pairs of Inline Interfaces.
The Logical Interface element can be used to represent the interfaces in the Layer 2 Firewall Policy. You cannot
select the same Logical Interface for a Capture Interface and an Inline Interface on the same Layer 2 Firewall.
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Some Forcepoint NGFW appliances have a fail-open network card, so the Inline Interfaces must be configured
for those specific ports. Inline Interfaces do not have an IP address or a MAC address visible to the network.

The number of Inline Interfaces you can configure is limited by the Layer 2 Firewall’s license.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Layer 2 Firewall or Layer 2 Firewall Cluster and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click the empty space and select New Physical Interface.

4) Define the interface properties.

Note:  Select Inline Interface as the interface Type.

5) Click OK to save the interface settings.

6) Continue the configuration in one of the following ways:
• If you are creating a new Layer 2 Firewall element, select system communication roles for Layer 2

Firewall interfaces.
• If you added an interface to an existing Layer 2 Firewall element, click  Save and Refresh to activate

the new interface configuration.

Related concepts
Defining Zone elements on page 899
Quality of Service (QoS) and how it works on page 949

Related tasks
Add VLAN interfaces for Layer 2 Firewalls on page 591
Add logical interfaces on page 546
Select system communication roles for Layer 2 Firewall interfaces on page 601

Configure advanced properties for Layer 2
Firewall interfaces
Advanced settings allow you to configure SYN Rate Limits and Log Compression on the Layer 2 Firewall’s
interfaces.

SYN Rate Limits are applied to TCP connections. Each TCP connection starts with a SYN packet. If the SYN
Rate Limits defined for the Layer 2 Firewall are reached the Layer 2 Firewall drops new TCP connections.

Log Compression is useful when the number of Discard logs becomes high (for example, as a result of a SYN
flood attack).



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Network interface configuration | 600

Note:  The SYN Rate Limits and Log Compression settings in the interface properties override the
Layer 2 Firewall’s general SYN Rate Limits and Log Compression settings that are defined on the
Advanced tab in the Layer 2 Firewall and Layer 2 Firewall Cluster properties.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Layer 2 Firewall and select Edit Layer 2 Firewall.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click a Physical Interface or a VLAN Interface and select Edit Physical Interface or Edit VLAN
Interface.
The properties dialog box for the interface opens.

4) Switch to the Advanced tab.

5) Select Override Engine’s Default Settings.
The options for SYN Rate Limits and Log Compression are enabled.

6) (Optional) Define the SYN Rate Limits.

CAUTION:  The recommended values for the SYN Rate Limits depend on your network
environment. If the Custom settings are not carefully configured, the capacity of the engine
might suffer or SYN Rate Limits might not work correctly.

7) (Optional) Enable Log Compression and enter values for the Discard entries.
Do not enable Log Compression if you want all the Discard entries to be logged as separate log entries (for
example, for reporting purposes or for engine statistics).

By default, each generated Discard log entry is logged separately and displayed as a separate entry in the
Logs view. Log Compression settings allow you to define the maximum number of separately logged entries.
When the defined limit is reached, a single Discard log entry is logged. The single entry contains information
on the total number of the generated Discard log entries. After this, the logging returns to normal and all the
generated entries are once more logged and displayed separately.

8) Click OK.

9) Click  Save and Refresh to transfer the configuration changes.

Related tasks
Configure SYN rate limits for engines on page 694
Configure log handling settings for engines on page 695
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Select system communication roles for Layer 2
Firewall interfaces
Interface options allow you to select which interfaces are used for which types of system communications.

You can define the following settings for system communication:
• Which IP addresses are used as the primary and backup Control IP address
• Which interfaces are used as the primary and backup Heartbeat Interface (Layer 2 Firewall Clusters only)
• The default IP address for outgoing traffic

By default, the first IP address you add to a Normal Interface is automatically selected for the following roles:
• As the primary Control IP address
• As the primary Heartbeat Interface (Layer 2 Firewall Clusters only)
• As the default IP address for outgoing traffic

You can optionally change which physical interface is used for each of these purposes. You can also define a
backup Control IP address and backup Heartbeat Interface (Layer 2 Firewall Clusters only).

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Layer 2 Firewall or Layer 2 Firewall Cluster and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces > Interface Options.

3) In the Interface Options pane on the right:

a) Select the Primary Control IP address for Management Server contact.

b) (Optional) Select a Backup Control IP address that is used if the Primary Control IP address is not
available.

c) If the engine is behind a device that applies dynamic NAT to the inbound management connections or
blocks them, select Node-Initiated contact to Management Server. When this option is selected, the
engine opens a connection to the Management Server and maintains connectivity.

d) (Layer 2 Firewall Clusters only) Select the primary Heartbeat Interface for communications between the
nodes.
We recommend that you use a Physical Interface, not a VLAN Interface. We strongly recommend that
you do not direct any other traffic through this interface. A dedicated network helps guarantee reliable
and secure operation.

CAUTION:  Primary and Backup Heartbeat networks exchange confidential information.
If dedicated networks are not possible, configure the cluster to encrypt the exchanged
information.

e) (Layer 2 Firewall Clusters only) Select a backup Heartbeat Interface that is used if the Primary
Heartbeat Interface is unavailable.
It is not mandatory to configure a backup Heartbeat Interface, but we strongly recommend it. If heartbeat
traffic is not delivered, the cluster cannot operate and traffic is disturbed. We strongly recommend that
you use a dedicated interface for the backup heartbeat as well.
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f) In the Default IP Address for Outgoing Traffic field, select the IP address that the nodes use if they
initiate connections through an interface that has no Node Dedicated IP Address.

4) Click OK.

5) Continue the configuration in one of the following ways:
• If you are creating a new Layer 2 Firewall element, configure the routing.
• Otherwise, click  Save and Refresh to transfer the configuration changes.

Related concepts
Connect engines to the SMC on page 641

Related tasks
Adjust Layer 2 Firewall clustering options on page 688
Add routes for IPS engines or Layer 2 Firewalls on page 718

Configuring interfaces for Master NGFW
Engines

Master NGFW Engines can have two types of interfaces: interfaces for the Master NGFW Engine's own traffic,
and interfaces that are used by the Virtual NGFW Engines hosted on the Master NGFW Engine.

You can add Physical Interfaces and VLAN Interfaces to a Master NGFW Engine. If you want to use a Physical
Interface or VLAN Interface to host a Virtual NGFW Engine, you must select a Virtual Resource for the interface.
The same Virtual Resource can be used on more than one Master NGFW Engine interface to allocate multiple
interfaces to the same Virtual NGFW Engine. If you want the Virtual NGFW Engine to have multiple interfaces,
you must use the same Virtual Resource on more than one Master NGFW Engine interface.

If you want to use a Physical Interface or VLAN Interface for the Master NGFW Engine’s own traffic, you must not
select a Virtual Resource for the interface. You can configure several IPv4 addresses on each Physical Interface
or VLAN Interface that does not have a Virtual Resource associated with it. The interfaces for the Master NGFW
Engine’s own traffic are only used for system communications.

By default, the Physical Interface definitions for the Master NGFW Engine are mapped to the actual network
interfaces on the Master NGFW Engine hardware in numerical order. If necessary, you can change the mapping
using command-line tools on the Master NGFW Engine. This mapping can be done differently from one Master
NGFW Engine node to another. Make sure that the interface that represents the same network interface on each
Master NGFW Engine node is correctly cabled to the same network.
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Interfaces for Master NGFW Engines and Virtual Firewalls
 
Figure 78: Master NGFW Engine and Virtual Firewall architecture

In this example, the Master NGFW Engine has the following kinds of interfaces:

1) Physical Interface for hosted Virtual Firewall traffic.

2) VLAN Interfaces for hosted Virtual Firewall traffic.

3) Physical Interface for the Master NGFW Engine’s own traffic.
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Interfaces for Master NGFW Engines and Virtual IPS engines
 
Figure 79: Master NGFW Engine and Virtual IPS engine architecture

In this example, the Master NGFW Engine has the following kinds of interfaces:

1) Capture Interface for hosted Virtual IPS engine traffic.

2) VLAN Interface for hosted Virtual IPS engine traffic.

3) Inline Interface pair for hosted Virtual IPS engine traffic.

4) Inline VLAN Interface pair for hosted Virtual IPS engine traffic.

5) Normal Interface for the Master NGFW Engine’s own traffic.
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Interfaces for Master NGFW Engines and Virtual Layer 2 Firewalls
 
Figure 80: Master NGFW Engine and Virtual Layer 2 Firewall architecture

In this example, the Master NGFW Engine has the following kinds of interfaces:

1) Inline Interface for hosted Virtual Layer 2 Firewall traffic.

2) Inline VLAN Interface for hosted Virtual Layer 2 Firewall traffic.

3) Normal Interface for the Master NGFW Engine’s own traffic.

Master NGFW Engine interface configuration
overview
The interface configuration for Master NGFW Engines consists of several main steps.

Follow these general steps to configure Master NGFW Engine interfaces:

1) Define the required number of Physical Interfaces.

2) (Optional) Add the required number of VLANs.

3) Add IP addresses to the System Communication interfaces.
• IP addresses are required for interfaces that are used for system communications.
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• You cannot add both an IP address and a Virtual Resource to the same Physical Interface or VLAN
Interface.

4) Select which interfaces are used for different types of system communications.

Related concepts
Configuring interfaces for Firewalls on page 543
Configuring interfaces for IPS engines on page 574
Configuring interfaces for Layer 2 Firewalls on page 588
Configuring interfaces for Virtual NGFW Engines on page 614

Related tasks
Add VLAN interfaces to Master NGFW Engines on page 609
Add IPv4 and IPv6 addresses to Master NGFW Engine interfaces on page 610
Select system communication roles for Master NGFW Engine interfaces on page 612
Add manual ARP entries to NGFW Engines on page 624

Add system communication interfaces for
Master NGFW Engines
You must add at least one layer 3 Physical Interface for the Master NGFW Engine’s own communications.

Physical Interfaces correspond to network ports on the Master NGFW Engine. By default, the numbering of
the Physical Interfaces in the Management Client corresponds to the operating system interface numbering on
the engine. For example, Interface ID 0 is mapped to eth0, and Interface ID 1 is mapped to eth1. However, the
mapping is not fixed and you can change it through the engine command line.

The types of Physical Interfaces that you can define for the Master NGFW Engine’s own communications depend
on the role of the hosted Virtual NGFW Engines:

Table 60: Master NGFW Engine layer 3 interface types for system communication

Hosted Virtual
NGFW Engine Role

Master NGFW
Engine Interface
Type

Explanation

None Corresponds to a single network interface on the Master NGFW
Engine appliance.

Virtual Firewall

Aggregated Link
in High Availability
Mode

Represents two interfaces on the Master NGFW Engine
appliance.
Only the first interface in the aggregated link is actively used. The
second interface becomes active only if the first interface fails.

If you configure an Aggregated Link in High Availability mode,
connect the first interface to one switch and the second interface
to another switch.
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Hosted Virtual
NGFW Engine Role

Master NGFW
Engine Interface
Type

Explanation

Aggregated Link
in Load Balancing
Mode

Represents up to eight interfaces on the Master NGFW Engine
appliance.
All interfaces in the aggregated link are actively used and
connections are automatically balanced between the interfaces.

Link aggregation in the Load Balancing Mode is implemented
based on the IEEE 802.3ad Link Aggregation standard. If you
configure an Aggregated Link in Load Balancing Mode, connect
all interfaces to a single switch. Make sure that the switch
supports the Link Aggregation Control Protocol (LACP) and that
LACP is configured on the switch.

Virtual IPS Normal Interface Corresponds to a single network interface on the Master NGFW
Engine appliance. Only Normal Interfaces can be used for Master
NGFW Engine system communications when the hosted Virtual
NGFW Engines are in the Virtual IPS role.

Virtual Layer 2
Firewall

Normal Interface Corresponds to a single network interface on the Master NGFW
Engine appliance. Only Normal Interfaces can be used for Master
NGFW Engine system communications when the hosted Virtual
NGFW Engines are in the Virtual Layer 2 Firewall role.

If the Master NGFW Engine is a cluster, it is recommended to add at least two layer 3 Physical Interfaces for the
Master NGFW Engine:

• An interface for communications between the Management Server and the Master NGFW Engine.

Note:  We recommend that you do not use the IP address of an Aggregated Link interface as
the primary or secondary control IP address of the engine.

• An interface for the heartbeat communications between the Master NGFW Engine nodes. The heartbeat traffic
is critical to the functioning of the cluster, so it is highly recommended to have a dedicated heartbeat interface.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Master NGFW Engine, then select Edit <element type>.

2) In the navigation pane on the left, browse to Interfaces.

3) Click Add, then select Layer 3 Physical Interface.

4) From the Type drop-down list, select the interface type according to the role of the Virtual NGFW Engines
that the Master NGFW Engine hosts.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Network interface configuration | 608

5) Define the Physical Interface properties.
Do not select a Virtual Resource for an interface that is used for the Master NGFW Engine’s own
communications.

CAUTION:  Make sure that you set the Interface speed correctly. When the bandwidth is
set, the Master NGFW Engine always scales the total amount of traffic on this interface to
the bandwidth you defined. The bandwidth is scaled even if there are no bandwidth limits or
guarantees defined for any traffic.

6) Click OK.
The Physical Interface is added to the interface list.

7) Continue the configuration in one of the following ways:
• If you want to use VLANs on this Physical Interface, add the VLANs before adding IP addresses.
• Otherwise, add IP addresses directly to the Physical Interfaces for Master NGFW Engine system

communications.

Related concepts
Master NGFW Engine Physical Interfaces for hosted Virtual NGFW Engine communications on page 608
Defining Zone elements on page 899
Quality of Service (QoS) and how it works on page 949

Related tasks
Add VLAN interfaces to Master NGFW Engines on page 609
Add IPv4 and IPv6 addresses to Master NGFW Engine interfaces on page 610
Configure advanced properties for Master NGFW Engine interfaces on page 611

Master NGFW Engine Physical Interfaces for
hosted Virtual NGFW Engine communications
The types of Physical Interfaces that you can configure for the Master NGFW Engine depend on the role of the
Virtual NGFW Engines that the Master NGFW Engine hosts.

For Master NGFW Engines that host Virtual Firewalls, you can add Layer 3 physical interfaces and Layer 2
physical interfaces.
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Add Master NGFW Engine Physical Interfaces
for hosted Virtual NGFW Engines
Physical Interfaces that are used for hosted Virtual NGFW Engine communications can correspond to one or
more network ports on the NGFW Engine.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Master NGFW Engine, then select Edit <element type>.

2) In the navigation pane on the left, browse to Interfaces.

3) Depending on the role of the hosted Virtual NGFW Engine, click Add, then select Layer 3 Physical
Interface or Layer 2 Physical Interface.

4) Configure the settings, then click OK.

Result

The Physical Interface is added to the interface list.

Related concepts
Create Virtual NGFW Engines on page 521

Related tasks
Add IPv4 and IPv6 addresses to Master NGFW Engine interfaces on page 610
Select Virtual Resources for multiple Master NGFW Engine interfaces on page 613

Add VLAN interfaces to Master NGFW Engines
Master NGFW Engines can have two types of VLAN interfaces: VLAN interfaces for the Master NGFW Engine’s
own traffic, and VLAN interfaces that are used by the Virtual NGFW Engines hosted on the Master NGFW
Engine.

The maximum number of VLANs for a single physical interface is 4094. The VLANs must also be defined in the
configuration of the external switch or router to which the interface is connected.

On Master NGFW Engines that host Virtual IPS engines or Virtual Layer 2 Firewalls, the Virtual NGFW Engines
can inspect traffic from VLAN interfaces without configuring VLAN tagging.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click a Master NGFW Engine, then select Edit <element type>.
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3) Browse to Interfaces.

4) Right-click a physical interface, then select New > VLAN Interface.

5) Configure the settings, then click OK.
The specified VLAN ID is added to the physical interface.

6) Click  Save.

Next steps

Add IP addresses to the physical interfaces or VLAN interfaces for Master NGFW Engine system
communications.

Related concepts
Defining Zone elements on page 899
Create Virtual NGFW Engines on page 521
Master NGFW Engine Physical Interfaces for hosted Virtual NGFW Engine communications on page 608
Quality of Service (QoS) and how it works on page 949

Related tasks
Add IPv4 and IPv6 addresses to Master NGFW Engine interfaces on page 610
Select Virtual Resources for multiple Master NGFW Engine interfaces on page 613
Configure advanced properties for Master NGFW Engine interfaces on page 611

Add IPv4 and IPv6 addresses to Master NGFW
Engine interfaces
You can add several IPv4 addresses to each Physical Interface or VLAN Interface that does not have a Virtual
Resource associated with it.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click a Master NGFW Engine, then select Edit <element type>.

3) Browse to Interfaces.

4) Right-click a physical interface or a VLAN interface, then select New > IPv4 Address or New > IPv6
Address.

5) Configure the settings, then click OK.
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6) Click  Save.

Next steps

Continue the configuration in one of the following ways:
• If you are configuring a new Master NGFW Engine, or if you want to change the roles the different interfaces

have in the configuration, select system communication roles for Master NGFW Engine interfaces.
• Otherwise, refresh the policy to transfer the configuration changes.

Related concepts
Define contact IP addresses on page 129

Related tasks
Select system communication roles for Master NGFW Engine interfaces on page 612

Configure advanced properties for Master
NGFW Engine interfaces
Advanced settings allow you to configure SYN Rate Limits and Log Compression for interfaces that are used for
the Master NGFW Engine’s own traffic.

Advanced settings are not available for interfaces that are associated with a Virtual Resource.

SYN Rate Limits are applied to TCP connections. Each TCP connection starts with a SYN packet. If the SYN
Rate Limits defined for the Master NGFW Engine are reached, the Master NGFW Engine drops new TCP
connections.

By default, each generated Antispoofing and Discard log entry is logged separately and displayed as a separate
entry in the Logs view. Log Compression settings allow you to define the maximum number of separately logged
entries. When the defined limit is reached, a single antispoofing log entry or Discard log entry is logged. The
single entry contains information about the total number of the generated Antispoofing log entries or Discard log
entries. After this log entry, the logging returns to normal and all generated entries are once more logged and
displayed separately. Log Compression is useful when the routing configuration generates a large volume of
antispoofing logs or the number of Discard logs becomes high.

Note:  The SYN Rate Limits and Log Compression settings in the interface properties override the
general SYN Rate Limits and Log Compression settings. These settings are defined in the Engine
Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Master NGFW Engine and select Edit Master NGFW Engine.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.
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3) Right-click a Physical Interface or a VLAN Interface and select Edit Physical Interface or Edit VLAN
Interface.
The properties dialog box for the interface opens.

4) Switch to the Advanced tab.

5) Select Override Engine’s Default Settings.
The options for SYN Rate Limits and Log Compression are enabled.

6) (Optional) Define the SYN Rate Limits.

CAUTION:  The recommended values for the SYN Rate Limits depend on your network
environment. If the Custom settings are not carefully configured, the capacity of the Master
NGFW Engine might suffer or SYN Rate Limits might not work correctly.

7) (Optional) Enable Log Compression and enter values for the Antispoofing (Master NGFW Engines that host
Virtual Firewalls only) entries and for Discard entries.

Note:  Do not enable Log Compression if you want all Antispoofing and Discard entries to be
logged as separate log entries.

8) Click OK.

9) Continue the configuration in one of the following ways:
• If you are configuring a new Master NGFW Engine, or if you want to change the roles the interfaces have

in the configuration, select system communication roles for Master NGFW Engine interfaces.
• Otherwise, click  Save and Refresh to transfer the configuration changes.

Related tasks
Select system communication roles for Master NGFW Engine interfaces on page 612

Select system communication roles for Master
NGFW Engine interfaces
Select which Master NGFW Engine interfaces are used for particular roles in system communications.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Master NGFW Engine and select Edit Master NGFW Engine.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces > Interface Options.
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3) In the Interface Options pane that opens on the right:

a) From the Primary control IP address drop-down list, select the primary control IP address for
communications with the Management Server.

Note:  We recommend that you do not use the IP address of an Aggregated Link
interface as the primary or secondary control IP address of the engine.

b) (Optional, recommended) From the Backup control IP address drop-down list, select a backup control
IP address for Management Server contact (used if the primary fails).

c) (Master NGFW Engine Cluster Only) From the Primary heartbeat drop-down list, select the primary
interface for communications between the nodes.
We recommend using a physical interface, not a VLAN interface. We strongly recommend that you
do not direct any other traffic through this interface. A dedicated network helps guarantee reliable and
secure operation.

CAUTION:  Primary and backup heartbeat networks exchange confidential information.
If dedicated networks are not possible, configure the cluster to encrypt the exchanged
information.

d) (Master NGFW Engine Cluster Only) From the Backup heartbeat drop-down list, select the backup
heartbeat interface that is used if the primary heartbeat interface is unavailable.
It is not mandatory to configure a backup heartbeat interface, but we strongly recommend it. If heartbeat
traffic is not delivered, the cluster cannot operate and traffic is disturbed. We strongly recommend that
you use a dedicated interface for the backup heartbeat as well.

e) In the Default IP Address for Outgoing Traffic field, select the IP address that the nodes use if they
have to initiate connections through an interface that has no Node Dedicated IP address.

4) Click OK.

5) Click  Save and Refresh, then close the Engine Editor.

Next steps

Bind licenses to Master NGFW Engine elements.

Related concepts
Create Virtual NGFW Engines on page 521
Adjust Master NGFW Engine clustering options on page 689

Select Virtual Resources for multiple Master
NGFW Engine interfaces
You can select the same Virtual Resource for multiple existing Physical Interfaces or VLAN Interfaces on a
Master NGFW Engine.

This is especially useful if you want to associate a large number of Master NGFW Engine interfaces with the
same Virtual Resource.
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Note:  You cannot select a Virtual Resource for a Physical Interface or VLAN Interface that
already has an IP address.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Master NGFW Engine and select Edit Master NGFW Engine.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Ctrl-select or shift-select multiple Physical Interfaces or VLAN Interfaces.

4) Right-click the selected interfaces and select Select Virtual Resource.

5) Select the Virtual Resource to associate with the interfaces and click OK.

6) Continue the configuration in one of the following ways:
• If you are configuring a new Master NGFW Engine as part of the configuration process for Virtual NGFW

Engines, create the Virtual NGFW Engine elements.
• Otherwise, click  Save and Refresh to transfer the configuration changes.

Related concepts
Create Virtual NGFW Engines on page 521
Configuring interfaces for Virtual NGFW Engines on page 614

Configuring interfaces for Virtual NGFW
Engines

Physical interfaces in the properties of a Virtual NGFW Engine represent interfaces allocated to the Virtual NGFW
Engine in the Master NGFW Engine.

All communication between Virtual NGFW Engine and the SMC is proxied by the Master NGFW Engine.

Physical interfaces for Virtual NGFW Engines are automatically created based on the interface configuration in
the Master NGFW Engine properties. The number of physical interfaces depends on the number of interfaces
allocated to the Virtual NGFW Engine in the Master NGFW Engine. You can optionally edit the automatically
created physical interfaces.

You can add VLAN interfaces if the creation of VLAN interfaces for Virtual NGFW Engines is enabled in the
Master NGFW Engine properties. On Virtual Firewalls, you can also optionally add tunnel interfaces for route-
based VPNs.

By default, the interface definitions for the Virtual NGFW Engine are mapped to interfaces on the Master NGFW
Engine in the order in which the interfaces are created on the Master NGFW Engine.

The interface configuration for Virtual NGFW Engines consists of the following main steps:
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1) Edit the automatically created physical interfaces.

2) (Optional) Add the required number of VLANs.

3) (Optional, Virtual Firewalls only) Define tunnel interfaces for route-based VPNs.

4) (Virtual Firewalls only) Configure the IP address settings.

5) (Optional, Virtual Firewalls only) Define Loopback IP addresses to assign IP addresses that do not belong to
any directly connected networks to the virtual firewall.

6) (Virtual Firewalls only) Select the interfaces that are used in particular roles.

Related concepts
Configuring interfaces for Firewalls on page 543
Configuring interfaces for IPS engines on page 574
Configuring interfaces for Layer 2 Firewalls on page 588
Master NGFW Engine interface configuration overview on page 605

Related tasks
Add IP addresses to Virtual Firewall interfaces on page 619
Add VLAN interfaces to Virtual NGFW Engine interfaces on page 617
Add tunnel interfaces for Virtual Firewalls on page 618
Select additional options for Virtual Firewall interfaces on page 622
Add loopback IP addresses for Virtual Firewalls on page 623
Add manual ARP entries to NGFW Engines on page 624

Configuring Virtual Firewall interfaces
Physical interfaces in the properties of a Virtual Firewall represent interfaces allocated to the Virtual Firewall in
the Master NGFW Engine.

All communication between Virtual Firewalls and the SMC is proxied by the Master NGFW Engine. Physical
interfaces for the Virtual Firewall are automatically created based on the interface configuration in the Master
NGFW Engine properties. The number of physical interfaces depends on the number of interfaces allocated
to the Virtual Firewall in the Master NGFW Engine. You can optionally edit the automatically created physical
interfaces.

In addition to the automatically created physical interfaces, you can add the following types of interfaces to Virtual
Firewalls:
• You can add VLAN interfaces if the creation of VLAN interfaces for Virtual Firewalls is enabled in the Master

NGFW Engine Properties.
• You can optionally add tunnel interfaces for route-based VPNs.

Both IPv4 and IPv6 addresses are supported on Virtual Firewalls. You can define one or more static IP
addresses for Virtual Firewall interfaces.

You can optionally add loopback IP addresses to the Virtual Firewall. Loopback IP addresses allow you to
assign IP addresses that do not belong to any directly connected networks to the Virtual Firewall. Loopback IP
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addresses are not connected to any physical interface and they do not create connectivity to any network. Any IP
address that is not already used on another physical or VLAN interface in the same Virtual Firewall can be used
as a loopback IP address. The same IP address can be used as a loopback IP address and as the IP address of
a tunnel interface. Loopback IP addresses can be used as the Identity for Authentication Requests, the Source
for Authentication Requests, and the Default IP Address for Outgoing Traffic.

By default, the interface definitions for the Virtual Firewall are mapped to interfaces on the Master NGFW Engine
in the order in which the interfaces are created on the Master NGFW Engine.

Configuring Virtual IPS interfaces
Physical Interfaces in the properties of a Virtual IPS engine represent interfaces allocated to the Virtual IPS in the
Master NGFW Engine.

All communication between Virtual IPS engines and the SMC is proxied by the Master NGFW Engine. Physical
Interfaces for the Virtual IPS engine are automatically created based on the interface configuration in the Master
NGFW Engine properties. The number of Physical Interfaces depends on the number of interfaces allocated to
the Virtual IPS engine in the Master NGFW Engine. You can optionally edit the automatically created Physical
Interfaces. In addition to the automatically created Physical Interfaces, you can add VLAN Interfaces if the
creation of VLAN Interfaces for Virtual IPS engines is enabled in the Master NGFW Engine properties. By default,
the interface definitions for the Virtual IPS engine are mapped to interfaces on the Master NGFW Engine in the
order in which the interfaces are created on the Master NGFW Engine.

Configuring Virtual Layer 2 Firewall interfaces
Physical Interfaces in the properties of a Virtual Layer 2 Firewall represent interfaces allocated to the Virtual
Layer 2 Firewall in the Master NGFW Engine.

All communication between Virtual Layer 2 Firewalls and the SMC is proxied by the Master NGFW Engine.
Physical Interfaces for the Virtual Layer 2 Firewall are automatically created based on the interface configuration
in the Master NGFW Engine properties. The number of Physical Interfaces depends on the number of interfaces
allocated to the Virtual Layer 2 Firewall in the Master NGFW Engine. You can optionally edit the automatically
created Physical Interfaces. In addition to the automatically created Physical Interfaces, you can add VLAN
Interfaces to Virtual Layer 2 Firewalls if the creation of VLAN Interfaces for Virtual Layer 2 Firewalls is enabled
in the Master NGFW Engine Properties. The interface definitions for the Virtual Layer 2 Firewall are mapped to
interfaces on the Master NGFW Engine in the order in which the interfaces are created on the Master NGFW
Engine.

Change the properties of physical interfaces
for Virtual NGFW Engines
Physical interfaces for Virtual NGFW Engines are automatically created based on the interface configuration of
the Master NGFW Engine.

The number of physical interfaces depends on the number of interfaces allocated to the Virtual NGFW Engine
in the Master NGFW Engine. It is not recommended to add physical interfaces to Virtual NGFW Engines, as the
interfaces might not be valid. You can change the automatically created physical interfaces.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Virtual Firewall, Virtual IPS engine, or Virtual Layer 2 Firewall, then select Edit <element type>.

2) In the navigation pane on the left, browse to Interfaces.

3) Right-click a physical interface, then select Edit Physical Interface.

4) Configure the settings, then click OK.

5) Continue the configuration in one of the following ways:
• If you want to use VLANs, add the VLANs before adding IP addresses.
• (Virtual Firewall only) If you want to create route-based VPNs, add tunnel interfaces.
• (Virtual Firewall only) Otherwise, add IP addresses directly to the physical interfaces.
• Otherwise, click  Save and Refresh to transfer the configuration changes.

Related concepts
Create Virtual NGFW Engines on page 521
Adding routes for Master NGFW Engines on page 714
Defining Zone elements on page 899
Quality of Service (QoS) and how it works on page 949

Related tasks
Add logical interfaces on page 546
Add VLAN interfaces to Virtual NGFW Engine interfaces on page 617
Add tunnel interfaces for Virtual Firewalls on page 618
Configure advanced properties for Virtual NGFW Engine interfaces on page 620

Add VLAN interfaces to Virtual NGFW Engine
interfaces
VLANs divide a single physical network link into several virtual links.

VLAN interfaces can only be added for Virtual NGFW Engines if the creation of VLAN interfaces for Virtual
Firewalls is enabled in the Master NGFW Engine Properties. The maximum number of VLANs for a single
physical interface is 4094. The VLANs must also be defined in the configuration of the external switch or router to
which the interface is connected.

Note:  You cannot add VLAN interfaces on top of other VLAN interfaces. Depending on the
configuration of the Master NGFW Engine, you might not be able to create valid VLAN interfaces
for the Virtual NGFW Engine. Contact the administrator who configured the Master NGFW Engine.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Virtual Firewall, Virtual IPS engine, or Virtual Layer 2 Firewall, then select Edit <element type>.

2) In the navigation pane on the left, browse to Interfaces.

3) Right-click a physical interface, then select New > VLAN Interface.

4) Configure the settings, then click OK.
The specified VLAN ID is added to the physical interface.

5) Continue the configuration in one of the following ways:
• (Virtual Firewall only) If you do not want to add tunnel interfaces for route-based VPNs, add IP addresses

directly to the physical interfaces.
• Otherwise, click  Save and Refresh to transfer the configuration changes.

Related concepts
Adding routes for Master NGFW Engines on page 714
Defining Zone elements on page 899
Quality of Service (QoS) and how it works on page 949

Related tasks
Add logical interfaces on page 546
Add tunnel interfaces for Virtual Firewalls on page 618
Configure advanced properties for Virtual NGFW Engine interfaces on page 620

Add tunnel interfaces for Virtual Firewalls
Tunnel interfaces are logical interfaces.

Any traffic that is routed to a tunnel interface and allowed by Access rules is automatically sent through the tunnel
to the peer endpoint defined in the Route-Based VPN Tunnel element. Tunnel interfaces are only used in route-
based VPNs.

You can optionally add IPv4 or IPv6 addresses to a tunnel interface. Tunnel interfaces can only have static IP
addresses. Any IP address can be added to a tunnel interface, even if the same IP address is used on another
interface or as a loopback IP address. Adding an IP address to a tunnel interface allows you to define the source
IP address of traffic sent from the NGFW Engine itself. For example, an IP address is recommended to provide
a source IP address for dynamic routing daemons, for IGMP proxy, and for Protocol Independent Multicast -
Sparse-Mode (PIM-SM) configuration. If no IP address is added to the tunnel interface, the source IP address
for traffic sent from the NGFW Engine is automatically selected. The selection is done according to the Bypass
Default IP Address setting in the interface options for the NGFW Engine.

The mapping of tunnel interfaces to physical network interfaces on the NGFW Engine is done automatically
based on the routing configuration.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an NGFW Engine, then select Edit <element type>.

2) Browse to Interfaces.

3) Click Add, then select Tunnel Interface.

4) Configure the settings.

5) Click OK.

6) If you want to add a source IP address for traffic sent from the engine node, add IPv4 addresses or IPv6
addresses to the tunnels.

7) If you do not want to add IP addresses, select system communication roles for firewall interfaces to define
how the source IP address for traffic sent from the engine node is selected.

8) Click  Save and Refresh.

Related concepts
Adding routes for Master NGFW Engines on page 714
Defining Zone elements on page 899
Quality of Service (QoS) and how it works on page 949
VPNs and how they work on page 1127

Related tasks
Add tunnel interfaces for firewalls on page 556
Change the properties of physical interfaces for Virtual NGFW Engines on page 616
Configure advanced properties for Virtual NGFW Engine interfaces on page 620
Select additional options for Virtual Firewall interfaces on page 622

Add IP addresses to Virtual Firewall interfaces
You can add one or more static IP addresses for each Physical Interface, VLAN Interface, or Tunnel Interface on
a Virtual Firewall.

Both IPv4 and IPv6 addresses are supported on Virtual Firewalls.

You can optionally add loopback IP addresses to the Virtual Firewall. Loopback IP addresses allow you to
assign IP addresses that do not belong to any directly connected networks to the Virtual Firewall. Loopback IP
addresses are not connected to any physical interface and they do not create connectivity to any network. Any IP
address that is not already used on another Physical or VLAN interface in the same Virtual Firewall can be used
as a loopback IP address. The same IP address can be used as a loopback IP address and as the IP address of
a Tunnel Interface. Loopback IP addresses can be used as the Identity for Authentication Requests, the Source
for Authentication Requests, and the Default IP Address for Outgoing Traffic.
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You might need to define a contact address if you enter a private static address and NAT is used to translate it
to a different external IP address. The external IP address must be configured as the contact address if the IP
address is used as a VPN endpoint.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Virtual Firewall, then select Edit <Element type>.

2) In the navigation pane on the left, browse to Interfaces.

3) Right-click a Physical Interface, VLAN Interface, or Tunnel Interface, then select New > IPv4 Address or
New > IPv6 Address.

Note:  If you have added VLAN Interfaces to Physical Interfaces, add the IP Addresses to the
VLAN Interfaces.

4) Configure the settings, then click OK.

5) Continue the configuration in one of the following ways:
• If you are creating a new Virtual Firewall, or if you want to change the roles the different interfaces have in

the configuration, select interface options for Virtual Firewall interfaces.
• Otherwise, click  Save and Refresh to transfer the configuration changes.

Related concepts
Define contact IP addresses on page 129

Configure advanced properties for Virtual
NGFW Engine interfaces
Advanced settings allow you to configure SYN Rate Limits and Log Compression on the interfaces of a Virtual
NGFW Engine. You can also configure IPv6 Router Advertisements on a Virtual Firewall’s interfaces.

SYN Rate Limits are applied to TCP connections. Each TCP connection starts with a SYN packet. If the SYN
Rate Limits defined for the Virtual NGFW Engine are reached, the Virtual NGFW Engine drops new TCP
connections.

By default, each generated Antispoofing (Virtual Firewalls only) and Discard log entry is logged separately and
displayed as a separate entry in the Logs view. Log Compression settings allow you to define the maximum
number of separately logged entries. When the defined limit is reached, a single antispoofing log entry or Discard
log entry is logged. The single entry contains information about the total number of the generated Antispoofing
log entries or Discard log entries. After this log entry, the logging returns to normal and all generated entries are
once more logged and displayed separately. Log Compression is useful when the routing configuration generates
a large volume of antispoofing logs or the number of Discard logs becomes high.

Router advertisements are packets that contain network layer configuration parameters. Enabling IPv6 Router
Advertisements allows devices that connect to the same IPv6 network as the Virtual Firewall to acquire IP
addresses automatically. The Router Advertisement messages specify what configuration information the Virtual
Firewall has available
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Note:  The SYN Rate Limits and Log Compression settings in the interface properties override the
general SYN Rate Limits and Log Compression settings. These settings are defined in the Engine
Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Virtual Firewall, Virtual IPS engine, or Virtual Layer 2 Firewall and select Edit <element
type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens on the right.

3) Right-click a Physical Interface or a VLAN Interface and select Edit Physical Interface or Edit VLAN
Interface.
The properties dialog box for the interface opens.

4) Switch to the Advanced tab.

5) Select Override Engine’s Default Settings.
The options for SYN Rate Limits, Log Compression, and IPv6 Router Advertisements are enabled.

6) (Optional) Define the SYN Rate Limits.

CAUTION:  The recommended values for the SYN Rate Limits depend on your network
environment. If the Custom settings are not carefully configured, the capacity of the engine
might suffer or SYN Rate Limits might not work correctly.

7) (Optional) Enable Log Compression and enter values for the Antispoofing entries (Virtual Firewalls only)
and for Discard entries.

Note:  Do not enable Log Compression if you want all Antispoofing and Discard entries to
be logged as separate log entries (for example, for reporting purposes).

8) (Optional, Virtual Firewalls only) Select Send IPv6 Router Advertisements and specify what configuration
information is offered in the Router Advertisement messages.

9) Click OK.

10) Continue the configuration in one of the following ways:
• If you are creating a new Virtual Firewall, or if you want to change the roles the different interfaces have

in the configuration, select interface options for Virtual Firewall interfaces.
• Otherwise, click  Save and Refresh to transfer the configuration changes.
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Related tasks
Change the properties of physical interfaces for Virtual NGFW Engines on page 616
Add VLAN interfaces to Virtual NGFW Engine interfaces on page 617
Add tunnel interfaces for Virtual Firewalls on page 618
Configure SYN rate limits for engines on page 694
Configure log handling settings for engines on page 695

Select additional options for Virtual Firewall
interfaces
In the Virtual Firewall's interface options, you can select which IP addresses are used in particular roles.

Interface Options can only be configured for Virtual Firewalls.

All communication between Virtual Firewalls and the SMC is proxied by the Master NGFW Engine. Virtual
Firewalls do not have any interfaces for system communication.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Virtual Firewall, then select Edit Virtual Firewall.

2) In the navigation pane on the left, browse to Interfaces > Interface Options.

3) Select the interface options.

4) Click OK.

Next steps

Continue the configuration in one of the following ways:
• Add loopback IP addresses for the Virtual Firewall.
• If you are configuring a new Virtual NGFW Engine, click  Save, close the Engine Editor, then add routes for

the Master NGFW Engine.
• Otherwise, click  Save and Refresh to transfer the configuration changes.

Related concepts
Adding routes for Master NGFW Engines on page 714
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Add loopback IP addresses for Virtual
Firewalls
Loopback IP addresses allow you to assign IP addresses that do not belong to any directly-connected networks
to the Virtual Firewall.

Loopback IP addresses are not connected to any physical interface and they do not create connectivity to any
network.

• You can add several loopback IP addresses to each Virtual Firewall.
• Any IP address that is not already used on another Physical or VLAN Interface in the same Virtual Firewall

can be used as a loopback IP address.
• The same IP address can be used as a loopback IP address and as the IP address of a Tunnel Interface.
• Loopback IP addresses can be used as the Identity for Authentication Requests, the Source for Authentication

Requests, and the Default IP Address for Outgoing Traffic.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Virtual Firewall, then select Edit Virtual Firewall.

2) In the navigation pane on the left, browse to Interfaces > Loopback.

3) Click Add.
A row is added to the table.

4) Click the Loopback Address cell, then enter the loopback IP address.

Note:  If the IP address you want to use as a loopback IP address is already used on another
Physical or VLAN interface, you must remove the IP address from the interface configuration
before using it as a loopback IP address.

5) Click OK.

6) Continue the configuration in one of the following ways:
• If you are configuring a new Virtual NGFW Engine, click  Save, close the Engine Editor, then add routes

for the Master NGFW Engine.
• Otherwise, click  Save and Refresh.

Related concepts
Adding routes for Master NGFW Engines on page 714
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Add manual ARP entries to NGFW
Engines

You can add manual ARP entries for IPv4 and neighbor discover entries for IPv6 in the Engine Editor.

ARP (Address Resolution Protocol) entries and neighbor discovery entries are normally managed automatically
based on the routing configuration. It is not necessary to add manual ARP entries or neighbor discovery entries
unless there are problems with the automatic entries, such as devices that do not respond to gratuitous ARP
requests, or that impose a significant delay on such operations.

The manual ARP entries and neighbor discovery entries are generated by the engines regardless of the policy
installed on the nodes.

You can configure two kinds of ARP entries:

• A Static ARP entry gives the engine a permanent reference to an IP address/MAC address pair.
• A Proxy ARP entry gives a Firewall engine a reference to an IP address/MAC address pair for which the

Firewall provides proxy ARP. Proxy ARP is possible only for hosts located in networks directly connected to
the Firewall.

Firewalls support both static and proxy ARP entries defined with IPv4 and IPv6 addresses. IPS engines, Layer 2
Firewalls, Master NGFW Engines, and Virtual NGFW Engines support only static ARP entries defined with IPv4
addresses.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element and select Edit <element type>.

2) In the navigation pane on the left, browse to Interfaces > ARP Entries.

3) To add an ARP entry, click Add ARP Entry.

4) In the Type cell, select the type of ARP entry you want to add.

5) In the Interface ID  cell, select the interface on which you want to apply this ARP entry.

6) Double-click the IP Address cell, then enter an IPv4 or IPv6 address.

7) Double-click the MAC Address cell, then enter the MAC Address.

8) Click  Save and Refresh to transfer the new configuration to the engines.

Examples of Single Firewall interface
configuration

These examples illustrate common configurations for a Single Firewall and general overviews of the steps for
how each example is configured.
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Example: setting up a Single Firewall
An example of creating a new Single Firewall and configuring the interfaces.

Company A has opened a new branch office. The administrator at the branch office is setting up a Single Firewall
in the branch office network.

 
Figure 81: Branch office network

The Branch Office Firewall has two interfaces with internal and external routers:

• The internal router is connected to Interface ID 0.
• The external router is connected to Interface ID 1.

The SMC has already been installed at the remote site, and the branch office administrator is now ready to install
and configure the Single Firewall. The administrator:

1) Creates a Single Firewall element (Branch Office Firewall) and defines the Log Server at the remote site as
its Log Server.

2) Creates an interface for connecting to the internal router and gives it the following properties:
• Interface ID: 0.
• IP Address: 172.16.2.1.

3) Creates an interface for connecting to the external router and gives it the following properties:
• Interface ID: 1.
• IP Address: 212.20.2.254.

4) Saves the initial configuration of the Branch Office Firewall on a USB drive.

5) Installs the firewall engine in the server room.

6) Inserts the USB drive in the firewall, turns it on, and waits until the Management Client shows that contact is
established between the engine and the Management Server.

7) Checks the routing configuration and adds the first few rules for allowing traffic through the firewall.

8) Installs a Firewall Policy using the Management Client to transfer the first working configuration to the
firewall.
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Adding a new interface to an existing Single
Firewall element
An example of adding an interface to a Single Firewall.

In the previous example, the administrator initially configured the firewall at the company’s new branch office with
just two interfaces. Now the administrator decides to add a physically separated DMZ network for access to/from
that office’s mail server to properly control both internal and external traffic with this publicly exposed server. The
administrator:

1) Creates an interface for the DMZ and gives it the following properties:
• Interface ID: 2
• IP Address: 192.168.2.1.

2) Creates new rules in the firewall’s policy to allow traffic to/from the DMZ and NAT rules to translate between
the private and public IP address of the mail server.

3) Connects the new DMZ router to the firewall.

4) Installs a Firewall Policy using the Management Client to transfer the new working configuration to the
Firewall.

Examples of Firewall Cluster interface
configuration

These examples illustrate the configuration of a Firewall Cluster with general steps for how each example is
configured.

Example: setting up a Firewall Cluster element
An example of creating a Firewall Cluster element and configuring the interfaces.

The administrators at the headquarters of Company A want to set up a Firewall Cluster. The cluster consists
of two cluster nodes: Node 1 and Node 2. The HQ Cluster Firewall has a dedicated heartbeat network
(10.42.1.0/24), and it is connected to two internal networks: Headquarters Intranet (172.16.1.0/24) and
Management Network (192.168.10.0/24). It uses Multi-Link to ISP A and ISP B for its connection to the Internet.
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Figure 82: Headquarters Network

The administrators:

1) Create a Firewall Cluster element (HQ Cluster) and define HQ Log as its Log Server.

2) Define the physical interfaces 0–4.

3) Define the CVIs and NDIs for the physical interfaces. Except for the IP addresses, the node-specific
properties for Node 1 and Node 2 are the same.

Table 61: Cluster Interfaces

Interface ID Type IP Address Comment

0 NDI for Node1 10.42.1.1 Heartbeat

0 NDI for Node2 10.42.1.2 Heartbeat

1 CVI 129.40.1.254 ISP B

1 NDI for Node1 129.40.1.21 ISP B

1 NDI for Node2 129.40.1.22 ISP B

2 CVI 212.20.1.254 ISP A

2 NDI for Node1 212.20.1.21 ISP A

2 NDI for Node2 212.20.1.22 ISP A

3 CVI 192.168.10.1 Management Network

3 NDI for Node1 192.168.10.21 Management Network

3 NDI for Node2 192.168.10.22 Management Network
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Interface ID Type IP Address Comment

4 CVI 172.16.1.1 Headquarters Intranet

4 NDI for Node1 172.16.1.21 Headquarters Intranet

4 NDI for Node2 172.16.1.22 Headquarters Intranet

4) Save the initial configuration of the engines in the Management Client.

5) Map the interface identifiers in the configuration to the physical interfaces on each engine’s command line
and establish contact between each engine and the Management Server.

6) Install a Firewall Policy on the Firewall Cluster in the Management Client to transfer the working configuration
to the firewall engines. The nodes exchange authentication information and begin to work as a cluster.

Example: adding a node to a Firewall Cluster
element
An example of adding a node to an existing Firewall Cluster element and configuring the interfaces.

Company A’s Firewall currently consists of two nodes. However, the load on the Firewall is exceptionally high, so
the administrator has decided to add another node to ensure continuity of network services even when one of the
nodes is offline. The administrator does the following:

1) Adds a third node in the Firewall Cluster element’s properties.

2) Defines the node-specific IP addresses for the NDI interfaces of the new node.
• The cluster-level interface configuration does not need adjustments, since it is shared by all nodes.

3) Installs the new engine and performs the initial configuration.

4) Refreshes the security policy of the Firewall Cluster.
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Examples of IPS engine interface
configuration

These examples illustrate some common uses for IPS engines and general steps for how each example is
configured.

Example: IPS Capture Interface configuration
with SPAN
An example of using SPAN ports on switches to duplicate packets for inspection.

The administrator at company A wants to set up a Single IPS engine and deploy it in IDS configuration using
SPAN ports on the switches to duplicate packets for inspection. The following illustration shows the interfaces of
the IPS engine in IDS configuration.

 
Figure 83: Capture Interfaces with SPAN

In this example, Interface ID 0 is a Normal Interface used for management connections, and sending TCP Reset
responses for network segment A. Interface ID 1 is a Capture Interface for capturing network traffic from the
network segment A switch for inspection. Interface ID 2 is a Capture Interface for capturing network traffic from
the network segment B switch for inspection. Interface ID 3 is a Normal Interface used for sending TCP Reset
responses for network segment B.

The administrator does the following:

1) Creates a Single IPS element and selects the Log Server to which it sends log data and the traffic
recordings.

2) Defines Interface ID 0 as a Normal Interface and adds an IP address to it.
• The IP address on Interface ID 0 is automatically selected as the Primary Control IP address because

Interface ID 0 is the first Normal Interface with an IP address.

3) Defines Interface ID 3 as a Normal Interface without an IP address.
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• Because Interface ID 3 is used only as a Reset Interface, it must not have an IP address.

4) Defines Interface ID 1 as a Capture Interface and selects Interface ID 0 as the Reset Interface.

5) Defines Interface ID 2 as a Capture Interface and selects Interface ID 3 as the Reset Interface.

6) Saves the initial configuration of the engine in the Management Client.

7) Maps the interface IDs to the physical interfaces in the NGFW Initial Configuration Wizard and makes initial
contact with the Management Server.

8) Installs an IPS Policy in the Management Client to transfer the configuration to the engine.

Example: IPS Capture Interface configuration
with TAP
An example of using a network TAP device to forward packets for inspection.

The administrator at company B wants to set up a Single IPS engine and deploy it in IDS configuration using a
network TAP device. WireTAP copies transmitted (Tx) and received (Rx) packets from the monitored cable and
forwards them to separate links for further analysis in the Single IPS engine. The following illustration shows the
interfaces of the Single IPS engine in IDS configuration.

 
Figure 84: Capture Interfaces with TAP

In this example, Interface ID 0 is a Normal Interface used for management connections, and sending TCP Reset
responses. Interface ID 1 is a Capture Interface that listens to the received (Rx) packets from the network TAP.
Interface ID 2 is a Capture Interface that listens to transmitted (Tx) packets from the network TAP. Interface IDs
1 and 2 share the Logical Interface, which combines the traffic from both physical interfaces so that it can be
inspected as a complete traffic flow.

The administrator does the following:
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1) Creates a Single IPS element and selects the Log Server to which it sends log data and the traffic
recordings.

2) Creates a Logical Interface called Capture for the two Capture Interfaces.

3) Defines Interface ID 0 as a Normal Interface and adds an IP address to it.

4) Defines Interface ID 1 and Interface ID 2 as Capture Interfaces, selects Interface ID 0 as the Reset Interface,
and selects the Logical Interface called Capture for both.

5) Saves the initial configuration of the engine in the Management Client.

6) Connects the network cables to the appropriate NICs.

7) Maps the interface IDs to the physical interfaces in the NGFW Initial Configuration Wizard and makes initial
contact with the Management Server.

8) Installs an IPS Policy in the Management Client to transfer the configuration to the engine.

Example: IPS Inline Interface configuration
An example of deploying a Single IPS in the traffic path.

The administrator at Company C wants to set up a Single IPS engine and deploy it in the traffic path. The
following illustration shows the interfaces of the inline Single IPS engine.

 
Figure 85: Inline IPS engine

In this example, the IP address on Interface ID 0 is configured as the Control IP address for management
connections. Interface ID 1 and Interface ID 2 are an Inline Interface pair that share the Logical Interface, called
Inline. Traffic comes in through Interface ID 1. Any traffic that is allowed by the IPS engine leaves through
Interface ID 2.

The administrator does the following:
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1) Creates a Single IPS element and selects the Log Server to which it sends log data and the traffic
recordings.

2) Creates a Logical Interface called Inline for the Inline Interface pair.

3) Defines Interface ID 0 as a normal interface and adds an IP address to it.

4) Defines Interface IDs 1 and 2 as an Inline Interface pair and selects the Logical Interface called Inline for the
pair.

5) Saves the initial configuration of the engine in the Management Client.

6) Connects the network cables to the appropriate NICs.

7) Maps the interface IDs to the physical interfaces in the NGFW Initial Configuration Wizard and makes initial
contact with the Management Server.

8) Installs an IPS Policy in the Management Client to transfer the configuration to the engine.

Example: IPS Cluster serial inline deployment
This scenario shows an example of an IPS Cluster in a serial inline deployment.

The following illustration shows the interfaces of the inline IPS Cluster.

 
Figure 86: Inline serial IPS cluster

In this example, the IPS Cluster consists of two nodes. Interface ID 0 is a Normal Interface used for the heartbeat
communication between the nodes. Interface ID 1 is a Normal Interface used for communication with the
Management Server. Interface ID 2 and Interface ID 3 are an Inline Interface pair that share one Logical
Interface, called Inline. Traffic enters each IPS node through Interface ID 2 and leaves through Interface ID 3.
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The administrators:

1) Create an IPS Cluster element and select the Log Server to which the IPS Cluster sends event data and
traffic recordings.

2) Define Interface ID 0 as a Normal Interface and add IP addresses for each of the nodes. The IP address on
Interface ID 0 is automatically selected as the Primary Control IP address, the Primary Heartbeat Interface,
and the Log communication source IP Address.

3) Define Interface ID 1 as a Normal Interface and add IP addresses for each of the nodes.

4) Define Interface IDs 2 and 3 as an Inline Interface pair and select the Logical Interface called Inline for the
pair.

5) Select Interface ID 0 as the Primary Heartbeat Interface and select the IP address on Interface ID 1 as the
Primary Control IP address in the Interface Options.

6) Save the initial configuration of the engine in the Management Client.

7) Connect the Heartbeat and Inline Interfaces between the nodes with crossover cables, and the rest of the
interfaces with straight cables.

8) Map the interface IDs to the physical interfaces in the NGFW Initial Configuration Wizard and make initial
contact with the Management Server.

9) Install an IPS Policy on each of the nodes in the Management Client to transfer the configuration to the IPS
Cluster.

Examples of Layer 2 Firewall interface
configuration

These examples illustrate some common uses for Layer 2 Firewalls and general steps for how each example is
configured.

Example: Layer 2 Firewall Inline Interfaces in
inline mode
An example of deploying a Layer 2 Firewall in the traffic path in inline mode.

The following illustration shows the interfaces of the inline Layer 2 Firewall.
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Figure 87: Inline Layer 2 Firewall

In this example, the IP address on Interface ID 0 is configured as the Control IP address for management
connections. Interface ID 1 and Interface ID 2 are an inline interface pair that share the Logical Interface, called
Inline. Traffic comes in through Interface ID 1. Any traffic that is the Layer 2 Firewall allows leaves through
Interface ID 2.

The administrator does the following:

1) Creates a Single Layer 2 Firewall element and selects the Log Server to which the Layer 2 Firewall engine
sends its log data.

2) Creates a Logical Interface called Inline for the Inline Interface pair.

3) Defines Interface ID 0 as a normal interface and adds an IP address to it.

4) Defines Interface IDs 1 and 2 as an inline interface pair and selects the Logical Interface called Inline for the
pair.

5) Saves the initial configuration of the engine in the Management Client.

6) Connects the network cables to the appropriate physical interfaces on the engine.

7) Maps the interface IDs to the physical interfaces in the NGFW Initial Configuration Wizard and makes initial
contact with the Management Server.

8) Installs a Layer 2 Firewall Policy in the Management Client to transfer the configuration to the engine.
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Example: Layer 2 Firewall Capture Interfaces in
Passive Firewall mode
An example of deploying a Layer 2 Firewall in Passive Firewall mode.

The administrator at company B wants to set up a Single Layer 2 Firewall and deploy it in Passive Firewall mode
using SPAN ports on the switch to duplicate packets for inspection. The following illustration shows the interfaces
of the Layer 2 Firewall in Passive Firewall mode with Capture Interfaces.

 
Figure 88: Capture Interfaces with SPAN

In this example, Interface ID 0 is a Normal Interface used for management connections and sending TCP Reset
responses. Interface ID 1 is a Capture Interface used for capturing network traffic from the network switch for
inspection.

The administrator does the following:

1) Creates a Single Layer 2 Firewall element and selects the Log Server to which the Layer 2 Firewall engine
sends its log data.

2) Defines Interface ID 0 as a Normal Interface and adds an IP address to it.
• The IP address on Interface ID 0 is automatically selected as the Primary Control IP address because

Interface ID 0 is the first Normal Interface with an IP address.

3) Defines Interface ID 1 as a Capture Interface and selects Interface ID 0 as the Reset Interface.

4) Saves the initial configuration of the engine in the Management Client.
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5) Maps the interface IDs to the physical interfaces in the NGFW Initial Configuration Wizard and makes initial
contact with the Management Server.

6) Installs a Layer 2 Firewall Policy in the Management Client to transfer the configuration to the engine.

Example: Layer 2 Firewall Inline Interfaces in
Passive Firewall mode
An example of deploying a Layer 2 Firewall in Passive Firewall mode in the traffic path.

The administrator at company C wants to set up a Single Layer 2 Firewall and deploy it in Passive Firewall mode
in an inline configuration. The following illustration shows the interfaces of the Single Layer 2 Firewall in Passive
Firewall mode with Inline Interfaces.

 
Figure 89: Inline Interfaces in Passive Firewall Mode

In this example, the IP address on Interface ID 0 is configured as the Control IP address for management
connections. Interface ID 1 and Interface ID 2 are an inline interface pair that share the Logical Interface, called
Inline (Passive Terminate). Traffic comes in through Interface ID 1 and leaves through Interface ID 2.

The administrator does the following:

1) Creates a Single Layer 2 Firewall element and selects the Log Server to which the Layer 2 Firewall engine
sends its log data.

2) Creates a Logical Interface called Inline (Passive Terminate) for the Inline Interface pair.

3) Defines Interface ID 0 as a Normal Interface and adds an IP address to it.

4) Defines Interface IDs 1 and 2 as an inline interface pair and selects the Logical Interface called Inline for the
pair.

5) Configures the Layer 2 Firewall engine to only create Terminate (passive) log entries:
• For all connections that match the Access rules with the Discard action in the Layer 2 Firewall Policy.
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• All Inspection rules with the Terminate action in the Inspection Policy.

6) Saves the initial configuration of the engine in the Management Client.

7) Connects the network cables to the appropriate physical interfaces on the engine.

8) Maps the interface IDs to the physical interfaces in the NGFW Initial Configuration Wizard and makes initial
contact with the Management Server.

9) Installs a Layer 2 Firewall Policy in the Management Client to transfer the configuration to the engine.
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Connecting engines to the SMC
Contents

• Management connections for engines and how they work on page 639
• Connect engines to the SMC on page 641

To maintain the security of your system, the engines establish an authenticated and encrypted connection with Log
Servers and Management Servers.

Management connections for engines
and how they work

When you connect the engines to the SMC, the engines make initial contact with the Management Server and
receive a certificate.

The certificate allows the engine to authenticate itself to other components in all further communications. When
components contact each other, they check if the other component’s certificate is signed by the same Internal
Certificate Authority as their own certificate. The certificate authority runs on the Management Server, but is
separate from the Management Server itself. The initial contact procedure is secured using a one-time password.

If the engines are Forcepoint NGFW appliances, you can connect them to the SMC using the plug-and-play
configuration method. In plug-and-play configuration, you upload the initial configuration to the Installation Server.
When the engines are turned on with all cables connected, they download the initial configuration from the
Installation Server. After this, the engines automatically install the initial configuration and make initial contact with
the Management Server. You can also specify a predefined policy to be installed on the engines when they make
initial contact with the Management Server.

Limitations
• The plug-and-play configuration method is only available for Forcepoint NGFW appliances. You must

have a valid proof-of-serial (POS) code for each appliance you want to configure using the plug-and-play
configuration method.

• Virtual NGFW Engines do not communicate directly with the SMC. All communication between Virtual NGFW
Engines and the SMC is proxied by the Master NGFW Engine.

What should I know before I begin?
• Engine certificates expire in three years from the date that they are issued. If the automatic certificate renewal

option is active for the engine, the certificate is renewed automatically before it expires.
• If the certificate of the engine is lost or expires, the initial contact procedure must be repeated to reconnect the

engine to the other components.
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• The internal certificate authority that signs the engine certificates is valid for ten years. The internal certificate
authority is automatically renewed six months before the expiration date and new certificates signed by the
new internal certificate authority are automatically created for the engines. If the automatic certificate renewal
fails, you must again make initial contact with the Management Server so that the engine receives a new
certificate.

• When a new Internal Certificate Authority is created, its initial status is Ready to Use and it is not yet Active.
A new Internal Certificate Authority in a Ready to Use state only signs Management Server certificates.
Certificates for other SMC components are signed by the Internal Certificate Authority that is used by the
Management Server. In an environment with multiple Management Servers, the new Internal Certificate
Authority reaches Active status when all the Management Servers are using the new Internal Certificate
Authority.

• You must install a policy using the Management Client to transfer the complete configuration to the engine.

Related tasks
View the status of appliance configurations on page 191

Configuration overview of connecting engines
to the SMC
Configuring management connections for engines consists of these main steps.

1) Configure the engine in the Management Client.

2) Save an initial configuration for the engine on the Management Server. This triggers the creation of a one-
time password that the engine uses to connect to the Management Server.

3) Install the engine to make the engine contact the Management Server.

4) Install a policy on the engine to transfer the full working configuration from the Management Server to the
engine.

Related concepts
Connect engines to the SMC on page 641

Related tasks
Reconfigure engine settings on page 347
Install policies on page 800
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Connect engines to the SMC
Save the initial configuration to enable the engines to connect to the SMC. Install a policy on the engines to
complete the engine configuration.

Saving an initial configuration allows you to establish a management connection for new Firewall engines, IPS
engines, Layer 2 Firewall engines, and Master NGFW Engines for the first time. If you are installing a new engine
or want to replace the engine’s previous working configuration, this operation also allows you to save relevant
parts of the configuration on a USB drive and import it during the engine installation.

Saving an initial configuration also allows you to reconnect previously configured engines that have lost the
connection. This might be because of a missing or expired certificate or because the internal certificate authority
that signs the engine certificates has been renewed and the engines have not yet received a new certificate
signed by the new internal certificate authority.

Note:  All communication between Virtual NGFW Engines and the SMC is proxied by the Master
NGFW Engine. You cannot save an initial configuration for a Virtual NGFW Engine.

When you save the initial configuration, a one-time password is created. This password is required if you use the
NGFW Initial Configuration Wizard to configure engines.

Save the initial configuration and generate the
one-time password
Save the initial configuration to establish a management connection for Firewall engines, IPS engines, Layer 2
Firewall engines, and Master NGFW Engines. Saving the initial configuration generates the one-time password
required for manual engine configuration using the NGFW Initial Configuration Wizard.

Note:  All communication between Virtual NGFW Engines and the SMC is proxied by the Master
NGFW Engine. You cannot create a one-time password for a Virtual NGFW Engine.

The one-time password that is created is specific to each engine. Keep track of which engine has which
password. If you mix them up or lose them, you can repeat the procedure and create new initial configurations for
those engines.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Save the initial configuration information:
• For an individual engine: right-click the bottom-level node element, then select Save Initial

Configuration.
• For all engines in a cluster: right-click the top-level cluster element, then select Configuration > Save

Initial Configuration.

Note:  If there is a Firewall between the engine and the Management Server, allow the
connection in the Firewall’s IPv4 Access rules. If there is a NAT device between the engine
and the Management Server, also configure NAT rules for the connection. Otherwise, the
engine cannot contact the Management Server.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Connecting engines to the SMC | 642

2) (Optional) If you want to manually enter details in the NGFW Initial Configuration Wizard or if the engine
already has the correct configuration, select View Details, then write down the one-time password.
The password is mandatory and is used to authenticate the engine to the Management Server. The
fingerprint can also be optionally used to make the engine verify the identity of the Management Server.

Next steps

To use plug-and-play configuration or automatic configuration, continue by uploading the initial configuration
details to the Installation Server or saving them on a USB drive.

Save the initial configuration details or upload
them to Installation Server
Save the initial configuration details to complete the management contact. You can upload the configuration
details to the Installation Server or save them, for example, on a USB drive.

Uploading the initial configuration details to the Installation Server is the simplest configuration method. However,
this method can only be used with Forcepoint NGFW appliances that support plug-and-play configuration. The
method is only available for Single Firewalls that have a dynamic control IP address.

Saving the initial configuration details on a USB drive allows automatic configuration by booting the appliance
with the USB drive inserted. Alternatively, you can import the configuration details from a USB drive in the NGFW
Initial Configuration Wizard.

You can also save the initial configuration details in some other suitable location or on the clipboard. You can
then copy and paste them or enter them manually in the NGFW Initial Configuration Wizard.

CAUTION:  The information must be handled securely when saving the initial configuration
details on a USB drive or in some other location. The initial configuration files include the one-time
password for establishing the trust relationship between the Management Server and the engine.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) (Optional) If you already have a policy you want to use for the engine, click Select, then select a policy as
the initial security policy.

2) (Optional) Select the Local Time Zone and the Keyboard Layout for use on the command line.
The time zone setting is only for displaying the time on the local console; the engines always use UTC
(GMT) time internally. The clock is automatically synchronized to match the Management Server’s time.
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3) (Optional) In the Save or Upload Initial Configuration dialog box, select Enable SSH Daemon to allow
remote access to the engine command line. SSH access can be helpful for remote troubleshooting.

• You can enable and disable remote command-line access to the engine at any time after management
contact is established through the right-click menu of the engine. We recommend that you disable SSH
access whenever it is not needed. Make sure that your Access rules allow SSH access to the engines
from the administrators’ IP addresses only.

• The Firewall Template, IPS Template, and Layer 2 Template policies do not allow these connections.
However, the temporary policy activated right after the engine’s initial configuration (in force until you
install the working policy) allows SSH access from the Management Server’s IP address. Alternatively,
you can upload a working policy to be installed on the engine after it has contacted the Management
Server.

CAUTION:  If you enable SSH, set the password for command-line access after the initial
configuration either through the Management Client or by logging on to the command line.
When the password is not set, anyone with SSH access to the engine can set the password.

4) Save the initial configuration or upload it to the Installation Server:
• If you are using the automatic configuration method, click Save As in the USB Drive Installation section,

then click Save to save the initial configuration file on a USB drive.
• (Single Firewalls that have a dynamic control IP address) If you are using the plug-and-play configuration

method, select Upload in the Installation Cloud section to upload the initial configuration automatically
to the Installation Server.

• If you want to copy and paste the initial configuration details in the NGFW Initial Configuration Wizard or
in some other location, click Copy to Clipboard in the Manual Installation section.

• If you want to enter the initial configuration details manually in the NGFW Initial Configuration Wizard,
click Save as in the Manual Installation section, then click Save to save the details in a suitable location.

5) Click Close.

6) Continue the configuration in one of the following ways:
• If you selected to upload the initial configuration to the Installation Server, connect the cables, then turn

on the appliance. The appliance contacts the Installation Server and downloads the initial configuration.
• To configure the appliance automatically using a USB drive, turn on the appliance with a USB drive

inserted.
• Otherwise, turn on the appliance and import the configuration to the NGFW Initial Configuration Wizard.

For more information, see the Forcepoint Next Generation Firewall Installation Guide.

Related tasks
View the status of appliance configurations on page 191
Reconfigure engine settings on page 347
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Installing policies on engine elements
Install a policy using the Management Client to transfer the complete configuration from the Management Server
to an engine.

After the installation, the engine is ready to start processing traffic. The engines do not receive any clustering
settings until the first time you install a policy on them and the working configuration is received from the
Management Server.

If you do not include a policy in the initial configuration, only the interface used for the control connection with the
Management Server is configured after the engine establishes contact with the Management Server.
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Element-based network address
translation (NAT)

Contents

• Element-based NAT and how it works on page 645
• Add NAT definitions for element-based NAT on page 646
• Edit or remove NAT definitions for element-based NAT on page 647

Element-based NAT allows you to define NAT addresses in the properties of an element. The NAT definitions define
how firewalls translate network IP addresses.

Element-based NAT and how it works
With element-based NAT, you select which elements have their own NAT address and define the NAT addresses
for those elements.

Note:  Element-based NAT is not intended for complex network environments. In more complex
network environments, we recommend adding NAT rules to the Firewall policy.

What element-based NAT does
You can add NAT definitions to the following types of elements:

• NGFW Engines — Single Firewalls, Firewall Clusters, Master NGFW Engines, and Virtual Firewalls
• Servers — Active Directory Servers, Proxy Servers, DHCP Servers, External DNS Servers, LDAP Servers,

Log Servers, Management Servers, SMTP Servers, TACACS+ Servers, Web Portal Servers
• Some elements in the Network Elements branch of the Configuration view, for example, Address Ranges,

Groups, Hosts, Networks, and Routers.

In addition to using element-based NAT, you can manually add NAT rules to the Firewall Policy if you want to
configure NAT in more detail. Remember, however, that a more specific manually created NAT rule might prevent
traffic from matching NAT rules that are automatically generated from NAT definitions. For more information
about manually adding NAT rules, see the topic that explains how firewall NAT rules work.

You can also use a default NAT address for all internal networks to automatically translate traffic from internal
networks to the public IP address of the external interface. This can be useful, for example, in simple network
environments. Default NAT can only be selected in the engine properties.

Note:  When several IP addresses from the same network are available, the SMC automatically
selects the smallest IPv4 address as the default NAT address.
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An internal element that has a static NAT definition can be used in the Destination cell of an Access rule.
Traffic also matches the destination IP address that corresponds to the element’s public IP address in the NAT
definition.

What do I need to know before I begin?
• NAT rules are automatically generated and organized in the Firewall Policy based on the NAT definitions

created in the element properties.
• NAT rules generated from NAT definitions are not visible in the Firewall Policy, and are applied after the NAT

rules that you have added manually to the policy.
• The SMC automatically generates both the source and destination NAT rules from the NAT definitions.

Related concepts
Getting started with NAT rules on page 835

Add NAT definitions for element-based
NAT

NAT definitions define the NAT addresses for elements.

When you add a NAT definition to an engine, the NAT definition is also added to the elements that are included
in the engine’s NAT configuration. You primarily configure NAT definitions in the Engine Editor. It is also possible
to configure NAT definitions in a network element’s properties, depending on your permissions in the Domain to
which the elements belong.

NAT definitions are automatically arranged in order from most specific to least specific: manually added NAT
rules, then NAT definitions, and finally default NAT. If there is not a more specific match after the NAT rules, and
the NAT definitions are checked, default NAT is used. This means that NAT rules that are generated from NAT
definitions and from using the Default NAT Address do not override the rules that you have manually added to the
Firewall Policy.

Note:  You must refresh the Firewall policy on the engine after you have edited the NAT definition
of any element to transfer the changes.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element and select Edit <element type>.

2) In the navigation pane on the left, browse to Policies > Element-based NAT.
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3) (Optional) Select Use Default NAT Address for Traffic from Internal Networks to use the default NAT
address as the Public IP Address if there is not a more specific NAT definition that matches the traffic.
When you select this option, a NAT rule is generated at the end of the NAT rules in the Firewall Policy. If
no NAT rule matches the traffic, no NAT is applied unless you enable the Default NAT Address.

Note:  Rules generated from NAT definitions are not displayed in the Firewall Policy.

4) (Optional) Click Show Details to view the Default NAT Address properties.

5) Click Add NAT Definition.

6) Select Static or Dynamic as the Translation Type.

7) Select an element as the Private IP Address.

Note:  Only Host, Server, or Network elements are allowed with static NAT.

8) Select one of the following as the Public IP Address.
• Default NAT Address
• Element
• Interface
• IP Address

9) (Optional) Click Add to add elements as Port Filters.

10) Click OK to save the NAT definition.
NAT rules for element-based NAT are generated automatically, and are added to the Firewall Policy of the
engine that uses the NAT definition in its configuration.

11) Click  Save and Refresh.

Related concepts
Getting started with NAT rules on page 835

Related tasks
Edit or remove NAT definitions for element-based NAT on page 647

Edit or remove NAT definitions for
element-based NAT

Edit outdated NAT definitions or remove unnecessary NAT definitions.

Note:  You must refresh the Firewall policy on the engine after you have edited the NAT definition
of any element to transfer the changes.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to Policies > Element-based NAT

3) Select the NAT definition and click Edit NAT Definition or Remove NAT Definition.
• If you selected Edit NAT Definition, edit the NAT definition settings and click OK.
• If you selected Remove NAT Definition, click Yes in the confirmation dialog box that opens.

4) Click  Save and Refresh.

Related tasks
Add NAT definitions for element-based NAT on page 646
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Configuring the engine tester
Contents

• Getting started with the engine tester on page 649
• Specify global engine tester settings on page 650
• Add engine tests on page 650
• Configuring additional test-specific settings for engine tests on page 651
• View configured engine tests on page 655
• Remove engine tests on page 655
• Disable or enable engine tests on page 656

The tester runs various checks on the engines and initiates responses based on the success or failure of these tests.

Getting started with the engine tester
The engines can be configured with periodical self-tests to make sure that each Firewall engine, IPS engine,
Layer 2 Firewall engine, and Master NGFW Engine is functioning correctly.

What the tester does
The tester runs checks at certain intervals, depending on the state of the engine (online, offline, or standby).
Depending on the result, the tester can turn the engine online or offline, send alerts, and send SNMP traps.

Limitations
• The tester also runs internal system tests that cannot be edited or disabled. These tests are meant for

recognizing certain configuration problems and internal error conditions, such as nodes in the cluster having
different policies.

• Tests cannot be run on Virtual NGFW Engines.

Related concepts
Creating engine elements on page 472
Editing existing engine elements on page 498
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Engine tester configuration overview
You can define the settings to run tests on NGFW Engines.

1) Configure the global tester settings that are common to all tests.

2) Configure the settings for running individual tests.

Related concepts
Disable or enable engine tests on page 656
Configuring additional test-specific settings for engine tests on page 651

Related tasks
Remove engine tests on page 655

Specify global engine tester settings
The global settings of the tester have default values that you can override to meet your needs.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall, IPS engine, Layer 2 Firewall, or Master NGFW Engine element, and select Edit
<element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to General > Tester.
The Tester pane opens on the right.

3) Configure the global settings.

Add engine tests
As well as test-specific settings, some tests share common settings.

You can receive notification of test failures as Alerts or as SNMP traps. A test can switch also nodes offline or
online based on the result.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall, IPS engine, Layer 2 Firewall, or Master NGFW Engine element, and select Edit
<element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to General > Tester.
The Tester pane opens on the right.

3) Under the test entry table, click Add and select the test type.

4) Configure the common settings.

5) Click OK.

6) Click  Save and Refresh to transfer the new configuration to the engines.

Related concepts
Getting started with SNMP configuration for engines on page 667

Configuring additional test-specific
settings for engine tests

The settings available to you vary according to the test you select. Some of the tests have additional, test-specific
settings.

Configure settings for the External engine test
For the tester to run External tests, configure the available settings.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Retry Count field, enter the number of times the tester tries to execute the test
We recommend always setting the retry count to more than 1 to avoid creating overly sensitive tests that
burden the system unnecessarily.

2) In the Test Timeout field, enter the timeout in milliseconds.

• If the test being run does not return a response in the specified time, the test is considered to have failed.
• We recommend a timeout of 500–1000 milliseconds, depending on the external test script.

3) In the Command Line field, enter the script path.
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Example: /data/home/root/connectivity.sh

4) Click OK.

Note:  The external script must return an exit code of 0 (zero) if it succeeds. Any non-zero
return value is a failure.

5) Click  Save and Refresh to transfer the new configuration to the engines.

Configure settings for the File System Space
engine test
For the tester to run File System Space tests, configure the available settings.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Specify the partition in the Partition field.

2) Enter the minimum amount of Free Space in kilobytes.
When the amount of free space drops below this amount, the engine executes the chosen action.

3) Click OK.

4) Click  Save and Refresh to transfer the new configuration to the engines.

Configure settings for the Free Swap engine
test
For the tester to run Free Swap tests, configure the available settings.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Enter the minimum amount of Free Space in kilobytes.
When the amount of free space drops below this amount, the engine executes the chosen action.

2) Click OK.

3) Click  Save and Refresh to transfer the new configuration to the engines.
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Configure settings for the Inline Pair Link
Speed engine test
For the tester to run Inline Pair Link Speed tests, configure the available settings.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Enter the Test Timeout in milliseconds.
If the test being run does not return a response in the specified time, the test is considered to have failed.
Avoid overly short timeout values.

2) Click OK.

3) Click  Save and Refresh to transfer the new configuration to the engines.

Configure settings for the Link Status engine
test
For the tester to run Link Status tests, configure the available settings.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select the Interface on which the test is run:
• ALL Physical Interfaces, Modem Interfaces (Single Firewalls only), ADSL Interfaces (Single Firewalls

only), and Wireless Interfaces (Single Firewalls only).
• (Clusters only) ALL with CVI.
• A single Physical Interface, a Modem Interface (Single Firewalls only), an ADSL Interface (Single

Firewalls only), or a Wireless Interface (Single Firewalls only).

Note:  On Firewalls, only the first interface that belongs to an Aggregated Link is shown in
the list of interfaces. However, the Link Status test checks the status of all interfaces in the
Aggregated Link.

2) (Aggregated link in load-balancing mode only) Select the percentage of aggregated links that must be down
for the test to be considered failed.

3) Click OK.

4) Click  Save and Refresh to save the changes to the configuration and refresh the policy on the engine.
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Configure settings for the Multiping engine test
For the tester to run Multiping tests, configure the available settings.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Retry Count field, enter the number of times the tester tries to execute the test.
We recommend always setting the retry count to more than 1 to avoid creating overly sensitive tests that
burden the system unnecessarily.

2) In the Test Timeout field, enter the timeout value in milliseconds.
If the test being run does not return a response in the specified time, the test is considered to have failed.
Avoid timeout values that are too short.

3) In the Source Address drop-down list, select the source address for the test:
• DEFAULT — The source IP address is selected automatically based on the routing configuration.

In a cluster, if the physical interface that routes the ping packet out has an NDI (Node Dedicated IP
address), this address is used as the source address. Otherwise, the NDI selected as Default IP for
Outgoing Traffic is used.

• A single physical interface, a VLAN interface, a modem interface (Single Firewalls only), an ADSL
interface (Single Firewalls only), an SSID interface (Single Firewalls only), or a port group interface
(Single Firewalls only). If the Node ID selection is ALL, each node uses the IP address of the selected
interface as the source IP address for the test. If a single node is selected in Node ID in a cluster, the
source address and the multiping test itself apply to that node only.

4) Specify the target addresses of ICMP echo requests.

Note:  The test is considered to have failed if none of the target addresses respond.

a) To add a row to the Target Addresses table, click Add.

b) Enter an IPv4 or IPv6 address.

5) Click OK.

6) Click  Save and Refresh to transfer the new configuration to the engines.

Configure settings for the Policy test
The Policy test is no longer supported in NGFW version 6.1.0 and later.
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View configured engine tests
The test entries that you have configured are displayed in the Tester pane of the Engine Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall, IPS engine, Layer 2 Firewall, or Master NGFW Engine element and select Edit
<element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to General > Tester.
The Tester pane opens on the right. All configured test entries are displayed in a table. The selected states,
actions, and parameters for the tests are shown.

Remove engine tests
Removing a test permanently removes the test settings from the selected NGFW Engine.

Alternatively, you can also stop a test from running without removing it

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall, IPS engine, Layer 2 Firewall, or Master NGFW Engine element and select Edit
<element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to General > Tester.
The Tester pane opens on the right.

3) Select the test entry that you want to remove.

4) Click Remove.
A Confirmation dialog box opens.

5) Click Yes to confirm that you want to remove the test.
The test is permanently removed.

6) Click  Save and Refresh to transfer the new configuration to the engines.
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Disable or enable engine tests
You can disable or enable any individual test or all tests that are run on a specified node.

You do not have to enable test entries that you configure to activate them. All test entries that you configure are
automatically activated and available to the tester after a policy refresh or install.

Disable or enable individual engine tests
Temporarily disable individual unused engine tests, or enable the individual tests you want to run.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall, IPS engine, Layer 2 Firewall, or Master NGFW Engine element and select Edit
<element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to General > Tester.
The Tester pane opens on the right.

3) Deselect or select the option in the Active column of the test.

4) Click  Save and Refresh to transfer the new configuration to the engines.

Disable or enable all custom tests on engines
Temporarily disable all custom tests on a node, or enable all custom tests you want to run on a node.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall, IPS engine, Layer 2 Firewall, or Master NGFW Engine element and select Edit
<element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to General > Tester.
The Tester pane opens on the right.

3) In the Global Settings section, deselect or select the option in the Active column of one or more nodes.

4) Click  Save and Refresh to transfer the new configuration to the engines.
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Engine permissions
Contents

• Getting started with engine permissions on page 657
• Define administrator permissions for engines on page 658
• Select allowed policies for engines on page 659

You can set permissions to control the administration of the engines.

Getting started with engine permissions
You can define the permissions that enable or restrict administrators to edit and view an engine's properties.

What engine permission control does
Engine permissions control can be used in two ways:

• To prevent some administrators from editing and viewing an engine’s properties to prevent unauthorized
modifications and protect confidential details.

• To restrict the policies that can be installed on the engine to prevent service outages caused by the wrong
policy being installed on the engine by accident.

Note:  Engine permission control does not affect the local permissions to execute command-
line commands on the engine. You can replicate administrator accounts on engines and then
configure permissions to execute commands using the sudo tool. The Local Administrators
section in the Administrator Permissions pane shows the local administrators defined, if any.

What do I need to know before I begin?
• Your administrator account must have editing permissions for the engine element.
• Permissions for Master NGFW Engines and Virtual NGFW Engines are configured separately. Otherwise,

engine permissions are configured for Master NGFW Engines and Virtual NGFW Engines in the same way as
for other types of engines.

• Access control in the Security Management Center.

Related concepts
Getting started with administrator accounts on page 353
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Engine permissions configuration overview
You can define the permissions that permit users to edit and view engine elements, and allow policies to install
on the engine.

Configuring engine permission involves the following general steps:

1) Define which administrators are allowed to edit and view the element.

2) Define which policies can be installed on the engine.

Define administrator permissions for
engines

Define the administrator permissions that permit users to access and view engine options.

Before you begin
Your administrator account must have editing permissions to the engine element.

You can either add an Access Control List or an individual Administrator-Administrator Role pair as permitted on
the engine. The rights that the Access Control List grants to the administrators are defined in the properties of the
administrator accounts (defined with Administrator elements).

Administrators with restricted permissions can refresh or upload an engine's policy only if the administrator is a
permitted administrator for both the engine and the policy. The engines might not accept all policies.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the element for editing in one of the following ways depending on the element type:

Element type Description

Engine element 1) Right-click an engine element and select Edit <element type>. The Engine Editor
opens.

2) In the navigation pane on the left, browse to General > Permissions.

Policy element 1) Right-click the policy and select Properties.

2) Click the Permissions tab.

2) Click Add for the Access Control Lists and select one or more Access Control Lists to which you want the
engine to belong.
To create an Access Control List, select  Tools > New > Access Control List.
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3) To add a permission, click Add Permission under Permissions.
A new row appears on the administrator list.

4) Click the Administrator cell and select the Administrator.

5) Right-click the Administrator Role cell and select Edit Administrator Role.

6) Select a role and click Add.

7) Click OK to close the Select Elements dialog box.

8) Save the changes in one of the following ways depending on the element type:

Element type Description

Engine element Click  Save.

Policy element Click OK to close the dialog box.

Note:  Changes to administrator permissions are immediately distributed and taken into
account in all related elements.

Related concepts
Creating Administrator Role and Access Control List elements on page 357

Related tasks
Create Access Control List elements on page 359

Select allowed policies for engines
Assign Policy or Template Policy permissions for engines.

Before you begin
Your administrator account must have editing permissions to the engine element.

By default, any policy can be installed on any engine as long as the policy is of appropriate type for the type of
engine. To prevent accidental installations of the wrong policy, you can select the allowed policy for each engine
in the engine element’s properties. The policy selection is enforced regardless of the administrator permissions
that the installing administrator has.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element and select Edit <element type>.
The Engine Editor opens.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Engine permissions | 660

2) In the navigation pane on the left, browse to General > Permissions.
The Permissions pane opens on the right.

3) In the Policies section at the bottom, select the Policy:
• To allow the installation of any policy, click Set to Any.
• Otherwise, click Add.

4) Select the correct Policy or Template Policy.
If you select a Template Policy, any policy based on the template can be installed.

5) Click  Save and Refresh.
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DNS Relay
Contents

• Getting started with DNS relay on page 661
• Enable DNS relay on page 664

DNS relay allows the firewall to provide DNS services for clients in internal networks.

Getting started with DNS relay
In DNS relay, clients send DNS requests to a DNS resolver, which forwards the requests to a remote DNS
server. In Forcepoint NGFW, the firewall can act as a local DNS resolver for clients in the internal network.

 
Figure 90: How DNS relay works

1 Clients in the internal network send DNS requests to the firewall.

2 The firewall forwards the DNS requests to remote DNS servers.

3 Remote DNS servers send DNS responses to the firewall.

4 The firewall provides the responses to the clients in the internal network.

The firewall temporarily stores the results of DNS requests in its cache until the time limit specified in the time to
live (TTL) value for the DNS entry is reached. When a client makes a DNS request for a domain that has recently
been requested, the firewall provides the IP address from the cache. Caching reduces the load on upstream DNS
servers and improves performance.

In addition to providing DNS services for clients in the internal network, the firewall can also optionally do the
following:

• Return fixed DNS results for specific hosts or domains.
• Forward DNS requests to different DNS servers depending on the domain in the DNS request.
• Translate IPv4 addresses resolved by external DNS servers to IPv4 addresses in the internal network.

You can configure DNS relay on Single Firewalls, Firewall Clusters, and Virtual Firewalls.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

DNS Relay | 662

DNS relay configuration overview
To use DNS relay, you must configure settings for the firewall in the Management Client, and configure clients in
your network environment.

Follow these general steps to set up DNS relay:

1) (Optional) Create a DNS Relay Profile element.

2) Define DNS IP addresses for the firewall in the Engine Editor.

3) Configure DNS Relay options for the firewall in the Engine Editor.

4) In your internal network environment, configure devices to use the selected listening IP addresses on the
firewall as a DNS resolver.

Fixed DNS results
You can optionally configure the firewall to return fixed DNS results for specific hosts or domains without relaying
the request to any DNS server.

You can define fixed DNS results in two ways.

Table 62: Ways to define fixed DNS results

Option for fixed DNS
results

Description

Host name mappings You statically map host names and aliases for host names to IPv4 or IPv6
addresses. When a client requests DNS resolution for a host name that is included
in the fixed mappings, the firewall resolves the IP address based on the mappings.
Host name mappings simplify the configuration when you only need to resolve a
small number of host names in internal networks to static IP addresses.

You define host name mappings as pairs of IP addresses and host names in the
Host Name Mappings section of DNS Relay Profile elements.

Fixed domain answers The firewall replies to requests for specific domain names with IPv4 addresses,
IPv6 addresses, domain names, or empty DNS replies. When the firewall provides
an empty DNS reply, the client receives the same response as for domains for
which no DNS record is found.
Fixed domain answers are useful if you always want to direct requests for specific
domains to specific destinations. For example, you can reply to all requests for the
domain of an advertising network with an empty reply to block unwanted ads on
web pages.

You define fixed domain answers as pairs of domains names and values that
the firewall returns in the Fixed Domain Answers section of DNS Relay Profile
elements.
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Domain-specific DNS servers
The firewall can use domain-specific DNS servers to forward DNS requests to different DNS servers depending
on the requested domain.

For example, the firewall can forward queries for internal domains to remote internal DNS servers, and forward
other queries to a public DNS server, such as a DNS server maintained by your Internet Service Provider (ISP).

When you forward queries for external domains to public DNS servers, users get the DNS result that is
geographically closest to them. Using the geographically closest IP address improves the quality of services that
use DNS load balancing, such as cloud services that have regionally distributed data centers.

You define domain-specific DNS servers in DNS Relay Profile elements as pairs of domain names and DNS IP
addresses in the Domain-Specific DNS Servers section of DNS Relay Profile elements.

In the Engine Editor, you specify the IP addresses that are used as source IP addresses when the firewall
makes domain-specific DNS queries. If you send DNS queries through a VPN tunnel, you must select source
IP addresses. In other configurations, selecting source IP addresses is optional. If you do not select a source IP
address, the source IP address is automatically selected based on the route to the external DNS server.

An automatic rule allows traffic from the firewall to domain-specific DNS Servers. If you send the DNS queries
through a VPN tunnel, you must disable the automatic rule.

Related concepts
Rules for DNS relay on page 663

DNS answer translations
DNS answer translations guarantee that DNS replies for users in internal networks always contain internal IP
addresses even if a public DNS server returns an external IP address for the same domain.

DNS answer translations map IPv4 addresses resolved by external DNS servers to IPv4 addresses in the internal
network. When an IPv4 address in a DNS result matches one of the specified DNS answer translations, the
firewall modifies the DNS result so that users in internal networks receive the internal IP address.

You define DNS answer translations in DNS Relay Profile elements as pairs of original IPv4 addresses and
translated IPv4 addresses in the DNS Answer Translations section of DNS Relay Profile elements.

Rules for DNS relay
Traffic for DNS Relay is allowed by automatic rules by default. We recommend using automatic rules.

The automatic rules allow the following traffic for DNS relay:

Table 63: Automatic rules for DNS relay

Automatic rule Traffic allowed

Allow Traffic from
Listening IP Addresses to
DNS Relay Port

Traffic from the listening IP addresses of the firewall to port 53/TCP and port 53/
UDP for DNS relay.
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Automatic rule Traffic allowed

Allow Connections to
Domain-Specific DNS
Servers

Traffic from the firewall to domain-specific DNS Servers.
If you want to send the DNS traffic through a policy-based VPN, you must disable
this automatic rule. If you disable this automatic rule, you must add IPv4 or IPv6
Access rules to allow traffic from the firewall to the DNS servers. You must also
add IPv4 or IPv6 NAT rules if you want to apply NAT or port translation to the DNS
traffic.

If you create Access or NAT rules to match specific DNS traffic, use one or more of the following elements:

• DNS Service Group — Matches both TCP and UDP traffic on port 53
• DNS (TCP) Service — Matches TCP traffic on port 53
• DNS (UDP) — Matches UDP traffic on port 53

Enable DNS relay
To enable DNS relay, you must configure DNS Relay settings for the firewall. You can optionally create custom
DNS Relay Profile elements.

Create DNS Relay Profile elements
DNS Relay Profile elements contain the host name mappings, domain-specific DNS servers, fixed domain
answers, and DNS answer translations that the firewall uses when it provides DNS services to the internal
network.

If you do not want to define custom settings, you can use the predefined Cache Only DNS Relay Profile element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Engine Properties > DNS Relay Profiles.

3) Right-click DNS Relay Profiles, then select New DNS Relay Profile.

4) In the Name field, enter a unique name.

5) Configure options in one or more of the following sections:
• Host Name Mappings — Statically map host names, aliases for host names, and unqualified names (a

host name without the domain suffix) to IPv4 or IPv6 addresses.
• Domain-Specific DNS Servers — Forward DNS requests to different DNS servers depending on the

requested domain.
• Fixed Domain Answers — Direct requests for specific domains to IPv4 addresses, IPv6 addresses, fully

qualified domain names (FQDNs), or empty DNS replies.
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• DNS Answer Translations — Map IPv4 addresses resolved by external DNS servers to IPv4 addresses
in the internal network.

Note:  You can add a maximum of 50 rows to the DNS Relay Profile element.

6) Click OK.

Configure DNS Relay settings in the Engine
Editor
To enable DNS relay, configure DNS Relay settings for the firewall in the Engine Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click a Single Firewall, Firewall Cluster, or Virtual Firewall element and select Edit <element type>.

3) In the DNS IP Addresses field, add the IP addresses of one or more external DNS servers to which the
firewall forwards DNS requests from clients in the internal network.
• To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the

dialog box that opens.
• To define an IP address using a network element, click Add and select Network Element.

4) In the navigation pane on the left, browse to General > DNS Relay.

5) From the DNS Relay Profile drop-down list, select a DNS Relay Profile element.
• If you created a custom DNS Relay Profile element, select your custom element.
• To enable DNS relay without defining custom settings, select the predefined Cache Only DNS Relay

Profile element.

6) In the Listening IP Addresses field, add one or more IP addresses.
Clients in the internal network can use all of the specified IP addresses to send DNS requests to the firewall.

7) (Optional) From the Source for Domain-Specific DNS Queries drop-down list, select the interface that is
used as the source IP address when the firewall forwards DNS requests to domain-specific DNS servers.
When According to Routing is selected, the source IP address is automatically selected based on the route
to the external DNS server.

Next steps

Configure devices in the internal network to use the selected listening IP addresses on the firewall as a DNS
resolver.
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Setting up SNMP for NGFW
Engines

Contents

• Getting started with SNMP configuration for engines on page 667
• Create an SNMP Agent for SNMP version 1 or 2c on page 668
• Create an SNMP Agent for SNMP version 3 on page 668
• Configure what triggers SNMP traps on page 669
• Activate the SNMP agent on NGFW Engines on page 670

SNMP is a standard protocol that different equipment can use to send network management-related information to
each other. You can configure NGFW Engines to send SNMP traps to external equipment.

Getting started with SNMP configuration
for engines

NGFW Engines can send SNMP traps to a central network monitoring system when system events occur, such
as when a test fails.

SNMP Agent elements define the settings according to which the NGFW Engines send SNMP trap messages to
compatible external software. The same SNMP Agent can be used by multiple NGFW Engines and by the SMC
Appliance.

The SNMP Agent supports SNMPv1 (RFC1157), SNMPv2c (RFCs 1901 and 3416), and SNMPv3 (RFC 3414).
See the documentation of the receiving software for information about which version to use.

The MIBs are included in the Security Management Center installation files.

To configure SNMP for NGFW Engines, you must create an SNMP Agent element, then configure it for SNMPv1,
SNMPv2c, or SNMPv3. You must also define what triggers SNMP traps and activate the SNMP Agent on the
NGFW Engines.

Related reference
SNMP traps and MIBs on page 1461
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Create an SNMP Agent for SNMP version
1 or 2c

Configure an SNMP Agent for SNMP version 1 or 2c so that NGFW Engines can share network management
information using the SNMP protocol, or for SNMP version 2c so that the SMC Appliance can share network
management information using the SNMP protocol.

Note:  The SMC Appliance does not support SNMP v1.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Engine Properties > SNMP Agents.

3) Right-click SNMP Agents, then select New SNMP Agent.

4) In the Name field, enter a unique for the SNMP Agent.

5) From the Version drop-down list, select v1 or v2c.
For the SMC Appliance, you must select v2c.

6) (Optional) In the Monitoring section, click Add, then enter the community string.
The community string is used for authentication in monitoring.

7) (Optional) In the Listening Port field, enter the UDP port number that the SNMP agent listens to.

8) In the Contact field, enter the contact information for the person responsible for the NGFW Engines or the
SMC Appliance.

9) Click OK.

Create an SNMP Agent for SNMP version
3

Configure an SNMP Agent for SNMP version 3 so that NGFW Engines or the SMC Appliance can share network
management information using the SNMP protocol.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.
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2) Browse to Other Elements > Engine Properties > SNMP Agents.

3) Right-click SNMP Agents, then select New SNMP Agent.

4) In the Name field, enter a unique for the SNMP Agent.

5) From the Version drop-down list, select v3.

6) In the User Names section, add one or more users names.

a) Click Add.

b) In the User Name field, enter the user name.

c) From the Protocol options, select the authentication protocol, then enter a password in the Password
field.

d) From the Privacy options, select the privacy protocol, then enter a password in the Privacy
Password field.

7) (Optional) In the Monitoring section, click Add, then select the user for monitoring.

8) (Optional) In the Listening Port field, enter the UDP port number that the SNMP agent listens to.

9) In the Contact field, enter the contact information for the person responsible for the NGFW Engines or the
SMC Appliance.

10) Click OK.

Configure what triggers SNMP traps
The trap parameters define where and how SNMP traps are sent from NGFW Engines and the SMC Appliance.

The same SNMP Agent element can be used for NGFW Engines and the SMC Appliance. Some settings only
apply to NGFW Engines. Settings that are not supported for the SMC Appliance are ignored when the SNMP
Agent is used for the SMC Appliance.

In addition to the general events, the tester on each NGFW Engine can send SNMP traps when a test fails.

Note:  If the Destinations field is left empty, no traps are sent, and the other trap parameters are
ignored. If the Destinations field has a value, the rest of the trap parameters must also have a
value.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Engine Properties > SNMP Agents.

3) Open the SNMP Agent properties in one of the following ways:
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• Right-click an existing SNMP Agent element, then select Properties.
• To create an SNMP Agent element, right-click SNMP Agents, then select New SNMP Agent.

4) In the Traps section, specify the sender of the SNMP trap.
• SNMPv1 — (NGFW Engines only) In the Community field, enter a community string.
• SNMPv2c — In the Community field, enter a community string.
• SNMPv3 — From the User Name drop-down list, select a user name.

5) Click Add, then enter the IP address and UDP port where the traps are sent.

6) (NGFW Engines only) In the Active Traps section, select the events for which you want to set a trap.

7) Click OK.

Activate the SNMP agent on NGFW
Engines

The SNMP Agent is responsible for SNMP-related tasks on the NGFW Engines.

Before you begin
If you use SNMPv3, there must be one or more user names defined in the properties of the SNMP
Agent element.

When you use SNMPv3, you can specify the SNMP engine ID for each single NGFW Engine and each node
of NGFW Engine clusters. The SNMP engine ID is a unique identifier for the NGFW Engine that is used by the
SNMP agent. The engine ID is used with a hash function to generate keys for authentication and encryption of
SNMPv3 messages. If you do not specify the SNMP engine ID, an SNMP engine ID is automatically generated.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to General > SNMP.

3) From the SNMP Agent drop-down list, select the SNMP Agent that you want to activate.

4) In the SNMP Location field, enter the string that is returned on queries to the SNMPv2-MIB or SNMPv2-
MIB-sysLocation object.

5) In the Listening IP Addresses field, add one or more IPv4 or IPv6 addresses.

6) (Optional, SNMPv3 only) Specify the value of the SNMP Engine ID option.
• Single NGFW Engines — In the SNMP Engine ID field, enter a unique identifier for the NGFW Engine.
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• NGFW Engine clusters — Browse to General > Clustering, then enter a unique identifier for each node
in the SNMP Engine ID cell.

7) Click  Save and Refresh to transfer the changes.

Related tasks
Add engine tests on page 650
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Alias element translations for
engines

Contents

• Getting started with Alias element translations on page 673
• Add Alias element translation values on page 674
• Remove Alias element translation values on page 675

Alias elements can be used to represent other network elements in configurations. The value an Alias takes in a
configuration can be different on each engine where the Alias is used.

Getting started with Alias element
translations

Alias element translation values are set for each engine. You can change the translation values through the
engine properties or in the properties of the Alias element itself.

What Alias elements do
Use Alias elements in your policies to represent IP addresses. Aliases differ from Group elements in that they do
not represent all elements at once. The Alias elements do not contain any IP address information themselves.
The values that the Aliases receive in a policy depend on the translation value you set for each Alias in the
engine elements’ properties. This way, the same policy can be used on several engines. The IP address
information is filled in correctly according to the translation values for each engine. Alias elements are especially
useful in policy templates and sub-policies.

What do I need to know before I begin?
Aliases are configured for NGFW Engines. The NGFW Engines use the translated values in the data they send to
the Log Server.

If you use Master NGFW Engines and Virtual NGFW Engines, you must configure Aliases separately for the
Master NGFW Engines and for the Virtual NGFW Engines.

There are some predefined Aliases in the SMC. Reserved Aliases cannot be edited. The names of reserved
Aliases start with two $$ symbols. Reserved Aliases receive their translation values automatically based on
the engine’s configuration. You can also create Aliases. User-created Aliases and predefined Aliases that you
can edit start with one $ symbol. Predefined Aliases that you can edit do not receive their translation values
automatically.
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Related concepts
Creating engine elements on page 472
Editing existing engine elements on page 498

Add Alias element translation values
To use Alias elements to represent other network elements in a policy, define the translation values of the Alias
elements for each engine that uses the policy. The same Alias element can have different translation values on
different engines.

Add Alias element translation values through the engine properties or in the properties of the Alias element itself.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Click NGFW Engines.

3) Right-click an engine element and select Edit <element type>.

4) In the navigation pane on the left, browse to Policies > Aliases.

5) Select the Alias element whose value you want to edit.

6) Define the value for the Alias:
• If you want the Alias to match any IP address on this engine, right-click the Value cell for the Alias and

select Set to Any. Skip to Step 8.
• Otherwise, right-click the Value cell and select Edit Value.

7) Browse in the Resources pane for an element you want to use as the translation value on this engine.
If the element does not exist, you can create one through the right-click menu for the correct element type.

8) Select the elements and click Add.
The elements are added to the Alias Value pane.

9) Click OK to close the Alias Value Properties dialog box.

10) Click  Save and Refresh.
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Remove Alias element translation values
When you no longer need Alias element translation values, remove them from the engine element properties.

If there are no translation values for a particular Alias element for an engine, the Translation Value is None. If
Aliases with the value None are used alone as matching criteria in a rule in a policy, the rule never matches any
traffic.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element and select Edit <element type>.

2) In the navigation pane on the left, browse to Policies > Aliases.

3) Right-click the Value cell of the Alias and select Edit Value.

4) Remove the elements.
• To remove selected elements, select the elements in the Alias Value pane and click Remove.
• To remove all elements, click Remove All.

5) Click OK to close the Alias Value Properties dialog box.

6) Click  Save and Refresh.
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Add-on features for engines
Contents

• Getting started with add-on features for engines on page 677
• Edit add-on settings for engines on page 678
• Configure anti-malware on engines on page 678

There are several engine element add-on features that you can use on Firewalls, IPS engines, Layer 2 Firewalls,
Virtual Firewalls, Virtual IPS engines, and Virtual Layer 2 Firewalls.

Getting started with add-on features for
engines

In the Add-Ons pane in the Engine Editor, you can enable several optional add-ons for engines, such as TLS
inspection, browser-based user authentication, anti-malware, and file reputation checks.

Some add-ons are separately licensed features.

Table 64: Supported roles for add-on features

Add-on Supported on

TLS Inspection Firewalls, IPS engines, Layer 2 Firewalls, Virtual Firewalls, Virtual IPS engines,
Virtual Layer 2 Firewalls

ECA Settings Firewalls, IPS engines, Layer 2 Firewalls, Virtual Firewalls

User Authentication Firewalls, Virtual Firewalls

User Identification Firewalls, IPS engines, Layer 2 Firewalls

Anti-Malware Firewalls, IPS engines, Layer 2 Firewalls, Master NGFW Engines

File Reputation Firewalls, IPS engines, Layer 2 Firewalls, Master NGFW Engines

Anti-Spam The Anti-Spam feature is no longer supported in NGFW version 6.2.0 and later.

Sidewinder Proxy Firewalls

ThreatSeeker Firewalls, IPS engines, Layer 2 Firewalls, Virtual Firewalls, Virtual IPS engines,
Virtual Layer 2 Firewalls

OPC UA Inspection Firewalls, IPS engines, Layer 2 Firewalls
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Related concepts
TLS inspection and how it works on page 1037
Enabling access control by user on page 1084
Configure anti-malware on engines on page 678
Creating engine elements on page 472
Editing existing engine elements on page 498

Related tasks
Enable browser-based user authentication on page 1108

Edit add-on settings for engines
You can edit add-on settings in the Engine Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element, then select Edit <element type>.

2) In the navigation pane on the left, expand the Add-Ons branch.

3) Browse to the add-on settings that you want to edit, then adjust the settings.

4) Click  Save and Refresh to save the changes to the configuration and refresh the policy on the engine.

Related concepts
TLS inspection and how it works on page 1037
Enabling access control by user on page 1084
Configure anti-malware on engines on page 678

Configure anti-malware on engines
You can enable anti-malware in the engine properties. The File Filtering Policy used in the engine policy
determines which traffic is inspected for malware.

The supported protocols in anti-malware inspection are FTP, HTTP, HTTPS, IMAP, POP3, and SMTP.

The anti-malware solution depends on the NGFW Engine version:

• If the engine version is 5.6 or earlier, the anti-malware solution is provided by ClamAV and the anti-malware
database is updated with new malware definitions every hour.

Anti-malware is only supported on Firewalls.
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• If the engine version is 5.7 or later, the anti-malware solution is provided by McAfee and there are more
options for the anti-malware database update frequency. You can also use an HTTP proxy to connect to anti-
malware database update mirrors.

In version 5.7, anti-malware is supported only on Firewalls. In version 5.8 or later, it is supported on all Single
and Clustered NGFW Engines and Virtual NGFW Engines (configured on the Master NGFW Engine).

When you upgrade the engine, the anti-malware engine and anti-malware database mirror URL are updated
automatically. If you downgrade the engine, you must manually revert the mirror URL.

If the engine version is 5.5.5 or later, you can update the anti-malware database manually. If you upgrade the
anti-malware database manually before upgrading the engine, the engine starts inspecting the traffic for malware
when it goes online.

Related tasks
Add Access rules on page 869

Manually update the anti-malware database on
engines
If you want the engine to have an up-to-date anti-malware database before you upgrade the engine, you can
manually update the anti-malware database on an NGFW Engine or individual nodes of an NGFW Engine
Cluster.

The update command in the Management Client uses the default anti-malware database mirror URL.

Note:
You must update the anti-malware database by running the avdbfetch script on the engine
command line in the following cases:

• To use an alternative mirror
• To use an HTTP proxy
• To update the anti-malware database by copying the database to the engine from a USB

memory stick

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Engines, then expand the nodes of the engine for which you want to update the anti-malware
database.

3) Right-click an engine node, then select Commands > Update Anti-Malware Database.

Result

The anti-malware database update begins. The update can take a while.
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Related concepts
Getting started with upgrading NGFW Engines on page 1321

Related reference
Forcepoint NGFW Engine commands on page 1421

View the status of the anti-malware database
on engines
You can view the progress of the anti-malware database update or check when the anti-malware database was
last updated.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Engines, then expand the nodes of the engine which you want to view the status of.

3) In the Info pane, click the Status tab. Expand the Anti-Malware branch to view the details.

Enable the anti-malware feature on engines
To use anti-malware, you must enable the anti-malware feature in the Engine Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an NGFW Engine, then select Edit <element type>.

3) In the navigation pane on the left, browse to Add-Ons > Anti-Malware.

4) Select Enable.

5) Select the log level from the Malware Log Level drop-down list.
• The log levels are the same as used in Access rules.
• If you selected Alert in the Malware Log Level drop-down list, select the Alert element from the list.
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6) In the Malware Signature Update Settings section, select how often the engine checks for updates to the
anti-malware database.

Note:  The engine queries DNS servers to resolve the anti-malware database URLs. Define
at least one DNS IP address on the General branch of the Engine Editor.

7) Enter the URL of the anti-malware database mirror in the Mirror(s) field.
The engines contact the mirror to update the anti-malware database. Separate multiple addresses with
commas.

8) Continue the configuration in one of the following ways:
• If you have not yet defined when to use anti-malware inspection, edit the rules in the File Filtering Policy.
• Otherwise, click  Save and Refresh to transfer the changes.

Related tasks
Define logging options for Access rules on page 875
Add Access rules on page 869
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Advanced engine settings
Contents

• Getting started with advanced engine settings on page 683
• Open the advanced settings on page 684
• Adjusting Firewall clustering options on page 684
• Adjust IPS clustering options on page 688
• Adjust Layer 2 Firewall clustering options on page 688
• Adjust Master NGFW Engine clustering options on page 689
• Configure inspection of tunneled traffic on page 692
• Configure settings for certificate validation on page 692
• Set connection timeouts on page 693
• Configure SYN rate limits for engines on page 694
• Configure log handling settings for engines on page 695
• Configure DoS protection settings for NGFW Engines on page 696
• Configure scan detection settings for engines on page 697

Advanced settings cover various system parameters related to different features.

Getting started with advanced engine
settings

Advanced settings system parameters generally have default values that are appropriate for most installations
without any need for adjustments. Some values can be overridden in policies rule-by-rule when exceptions are
needed.

CAUTION:  Improper adjustments to some of the advanced settings can seriously degrade the
performance of the system. Do not adjust the advanced settings unless you have a specific need
to do so.

Related concepts
Creating engine elements on page 472
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Open the advanced settings
To adjust advanced settings for an NGFW Engine, you must open the Engine Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an NGFW Engine, then select Edit <element type>.

2) Browse to Advanced Settings.

3) Adjust the settings.

4) Click  Save.

Adjusting Firewall clustering options
You can check and adjust some of the settings related to how the Firewall Cluster behaves and exchanges
information from node to node.

If you are an advanced user, it is also possible to tune settings related to how the traffic load is balanced between
several online nodes. However, we strongly discourage you from changing the load-balancing settings unless
Forcepoint support instructs you to make particular changes.

Related concepts
Getting started with advanced engine settings on page 683

Node state synchronization
The nodes of a Firewall Cluster periodically exchange synchronization messages to synchronize state data.

State synchronization is essential for the following features:

• Dynamic load balancing
• Transparent switchover of nodes in case of failure or maintenance
• Handling of related connections when a service (for example, FTP) opens multiple connections

Regular, timer-launched synchronization events are needed to synchronize state data and to avoid cutting
connections in case of node failure. Timed synchronization events are divided into full and incremental sync
messages.

https://support.forcepoint.com
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Table 65: Sync messages

Type Explanation

Full Sync
Messages

Contain all connection data about the traffic handled by a node at the time when the
message was sent. When new data is received, it replaces the existing data. Full sync
requires more bandwidth and processing time.

Incremental
Sync Messages

Contain only data on connections that were created or changed since the last full or
incremental sync message. Incremental sync needs less bandwidth and processing time.
Since the incremental changes are sent only once, the system might lose connections if the
data is lost. While able to produce accurate data with frequent updates, incremental sync
requires full sync to provide reliable synchronization data.

By default, a combination of full and incremental sync messages is exchanged between nodes. This way,
frequent updates on incremental changes and recurrent reports on existing connections are combined.

In cases where synchronization of connection information between nodes is causing a disturbance to specific
traffic, you can disable synchronization for the traffic using rule options in the Policy. Disabling synchronization
reduces the traffic volume on the active heartbeat interface, but it also prevents transparent failover of
connections to other nodes.

Security level for state synchronization
Because synchronization controls the inter-node traffic within a heartbeat network, you must ensure the security
of the heartbeat and synchronization data.

Traffic between nodes can be authenticated, or both authenticated and encrypted. Traffic between nodes
can also optionally be sent without authentication or encryption. However, this makes it possible to both sniff
synchronization data and send fraudulent messages to open connections.

Note:  Independent of the security level, all critical information such as passwords and encryption
keys are protected. They are never sent in plaintext.

Adjust general Firewall clustering options
To tune the settings that relate to how the traffic load is balanced between several online nodes, adjust the
Firewall clustering options.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall Cluster element and select Edit Firewall Cluster.
The Engine Editor opens.

2) In the navigation pane on the left, browse to General > Clustering.

3) Configure the settings.

Note:  Do not adjust the settings in the Advanced Cluster Settings dialog box unless you
are certain it is necessary.
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4) Click  Save and Refresh to transfer the changes.

Related concepts
Creating engine elements on page 472

Related tasks
Defining Access rule Action options on page 871

Manually tune the Firewall load-balancing filter
The Firewall Cluster’s load-balancing filter can be manually edited if there is a specific need for modifications.

CAUTION:  Do not manually tune the load-balancing filter unless you are certain it is necessary.
Normally, there is no need to tune the load-balancing filter, because the configuration generates
all required entries automatically. Unnecessary tuning can adversely affect the operation of the
filter.

Any edited load-balancing parameters are combined with the automatically created filtering entries. However,
editing the load-balancing parameters of the Firewall Cluster without careful consideration can cause conflicts in
filtering decisions.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall Cluster element and select Edit Firewall Cluster.
The Engine Editor opens.

2) In the navigation pane on the left, browse to General > Clustering.

3) In the Clustering Mode section, click Clustering.

4) On the Manual LB Filters tab of the Advanced Cluster Settings dialog box , select an option from the
Filter Mode drop-down list to define how traffic is balanced between the nodes.

5) (Optional) Select Load-Balancing Filter Uses Ports to include a port value for selecting between all nodes.
This setting decreases the granularity of VPN load balancing, and increases the granularity of other traffic
load balancing. In typical networks, traffic is balanced based on IP address information only. If there is a
dominating pair of communication IP addresses, apply the Use Ports option in the load-balancing filter entry
only to their traffic.

CAUTION:  Enabling the Load-Balancing Filter Uses Ports option is not compatible with
some features, such as mobile VPNs.

6) Click OK.

7) Click  Save and Refresh to transfer the changes.
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Related concepts
Creating engine elements on page 472

Add Firewall load-balancing filter entries
You can manually add IP addresses to the Firewall Cluster's load-balancing filter.

CAUTION:  Do not manually tune the load-balancing filter unless you are certain it is necessary.
Normally, there is no need to tune the load-balancing filter, because the configuration generates
all required entries automatically. Unnecessary tuning can adversely affect the operation of the
filter.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall Cluster element and select Edit Firewall Cluster.

2) In the navigation pane on the left, browse to General > Clustering.

3) In the Clustering Mode section, click Clustering.

4) Click the Manual LB Filters tab.

5) Click Add to generate a new filter entry row.

6) Double-click the IP Address field.

7) Select whether you want to filter an IPv4 Network, an IPv6 Network, or a Range of IP addresses.

8) Enter the IPv4 address and netmask, the IPv6 address and prefix, or the address range, and click OK.

9) Click the Action cell and select an action.

10) If you selected Replace by as the action, click the Replacement IP field and enter the replacement IP
address.

11) (Optional) Select any additional options.

12) Click OK.

13) Click  Save and Refresh to transfer the changes.
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Adjust IPS clustering options
IPS Clusters operate by default in load-balancing mode. This means that all configured nodes in an IPS Cluster
are online simultaneously and the traffic is distributed among the operational nodes. The load balancing aims to
keep the traffic load as evenly distributed as possible.

Alternatively, the IPS Cluster can run in standby mode. In that case, only one IPS node at a time is online and
processing traffic, while the others are in standby mode. Only if the online node fails, one of the standby nodes
goes online to take over the connections being handled by the failed node.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an IPS Cluster element and select Edit IPS Cluster.
The Engine Editor opens.

2) In the navigation pane on the left, browse to General > Clustering.
The Clustering pane opens on the right.

3) Configure the settings.

4) Click  Save and Refresh to transfer the changes.

Related concepts
Creating engine elements on page 472

Adjust Layer 2 Firewall clustering
options

By default, Layer 2 Firewall Clusters operate in active-standby mode.

Only one Layer 2 Firewall node at a time is online and processing traffic, while the others are standby. Only if the
online node fails, one of the standby nodes goes online to take over the connections being handled by the failed
node.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Layer 2 Firewall Cluster element and select Edit Layer 2 Firewall Cluster.
The Engine Editor opens.

2) In the navigation pane on the left, browse to General > Clustering.
The Clustering pane opens on the right.

3) Configure the settings.
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4) Click  Save and Refresh to transfer the changes.

Related concepts
Creating engine elements on page 472

Related tasks
Defining Access rule Action options on page 871

Adjust Master NGFW Engine clustering
options

You can check and adjust some of the settings related to how the Master NGFW Engine behaves and exchanges
information from node to node.

If you are an advanced user, it is also possible to tune settings related to how the traffic load is balanced between
several online nodes. However, we strongly discourage you from changing the load-balancing settings unless
Forcepoint support instructs you to make particular changes.

Related concepts
Creating engine elements on page 472
Getting started with advanced engine settings on page 683

Adjust general Master NGFW Engine clustering
options
To tune the settings that relate to how the traffic load is balanced between several online nodes, use the Master
NGFW Engine Clustering options.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Master NGFW Engine element and select Edit Master NGFW Engine.
The Engine Editor opens.

2) In the navigation pane on the left, browse to General > Clustering.

3) Configure the settings.

Note:  Do not adjust the settings in the Advanced Cluster Settings dialog box unless you
are certain it is necessary.

https://support.forcepoint.com
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4) Click  Save and Refresh to transfer the changes.

Related tasks
Defining Access rule Action options on page 871

Manually tune the Master NGFW Engine load-
balancing filter
The Master NGFW Engine's load-balancing filter can be manually edited if there is a specific need for
modifications.

CAUTION:  Do not manually tune the load-balancing filter unless you are certain it is necessary.
Normally, there is no need to tune the load-balancing filter, because the configuration generates
all required entries automatically. Unnecessary tuning can adversely affect the operation of the
filter.

Any edited load-balancing parameters are combined with the automatically created filtering entries. However,
editing the load-balancing parameters of the Master NGFW Engine without careful consideration can cause
conflicts in filtering decisions.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Master NGFW Engine and select Edit Master NGFW Engine.
The Engine Editor opens.

2) In the navigation pane on the left, browse to General > Clustering.

3) In the Clustering Mode section, click Clustering.

4) On the Manual LB Filters tab, select an option from the Filter Mode drop-down list to define how traffic is
balanced between the nodes.

5) (Optional) Select Load-Balancing Filter Uses Ports to include a port value for selecting between all nodes.
This setting decreases the granularity of VPN load balancing, and increases the granularity of other traffic
load balancing. In typical networks, traffic is balanced based on IP address information only. If there is a
dominating pair of communication IP addresses, apply the Use Ports option in the load-balancing filter entry
only to their traffic.

CAUTION:  Enabling the Load-Balancing Filter Uses Ports option is not compatible with
some features, such as mobile VPNs.

6) Click OK.

7) Click  Save and Refresh to transfer the changes.
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Related concepts
Creating engine elements on page 472

Add Master NGFW Engine load-balancing filter
entries
You can manually add IP addresses to the Master NGFW Engine's load-balancing filter.

CAUTION:  Do not manually tune the load-balancing filter unless you are certain it is necessary.
Normally, there is no need to tune the load-balancing filter, because the configuration generates
all required entries automatically. Unnecessary tuning can adversely affect the operation of the
filter.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Master NGFW Engine element and select Edit Master NGFW Engine.
The Engine Editor opens.

2) In the navigation pane on the left, browse to General > Clustering.
The Clustering pane opens on the right.

3) In the Clustering Mode section, click Clustering.

4) Click the Manual LB Filters tab.

5) Click Add to generate a new filter entry row.

6) Double-click the IP Address field.

7) Select whether you want to filter an IPv4 Network, an IPv6 Network, or a Range of IP addresses.

8) Enter the IPv4 address and netmask, the IPv6 address and prefix, or the address range, and click OK.

9) Click the Action cell and select an action.

10) If you selected Replace by as the action, click the Replacement IP field and enter the replacement IP
address.

11) (Optional) Select any additional options.

12) Click OK.

13) Click  Save and Refresh to transfer the changes.
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Configure inspection of tunneled traffic
You can define in the Advanced Settings how the IPS engine or Layer 2 Firewall inspects tunneled traffic.

If traffic is tunneled using IP-in-IP or Generic Routing Encapsulation (GRE), the payload of the tunneling packet
can be checked against the Access rules several times.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an IPS or Layer 2 Firewall element and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to Advanced Settings > Tunneling.
The Tunneling pane opens on the right.

3) Define the settings.

4) Click  Save and Refresh to transfer the configuration changes.

Related concepts
Getting started with advanced engine settings on page 683

Configure settings for certificate
validation

Certificate validation settings allow you to define the settings that the NGFW Engine uses when it connects to a
Certificate Revocation List (CRL) or Online Certificate Status Protocol (OCSP) server.

The NGFW Engine validates certificates and checks the certificate revocation status for features that have
certificate validation and certificate revocation checks enabled, such as features that use a TLS Profile in the
configuration.

Certificate validation settings allow you to define an HTTP Proxy to use for CRL and OCSP lookups, and a
timeout for connections from the NGFW Engine to the CRL or OSCP server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall, IPS, or Layer 2 Firewall element, then select Edit <element type>.

2) Browse to Advanced Settings > Certificate Validation.

3) Select the HTTP proxy that fetches the CRL list or communicates with the OCSP responder server.
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4) (Optional) Enter the timeout for communication from the NGFW Engine to the CRL or OSCP server.

Note:  The default timeout is 120 seconds.

5) Click  Save and Refresh to transfer the configuration changes.

Set connection timeouts
You can define general timeouts for removing idle connections from the state table, including non-TCP
communications that are handled like connections.

The timeout prevents wasting engine resources on storing information about abandoned connections. Timeouts
are a normal way to clear traffic information with protocols that have no closing mechanism. The communicating
client and server also have timeouts for closing inactive connections.

You can set timeouts by protocol and by TCP connection state. Idle timeouts set in Access rules override these
global settings.

Timeouts do not affect active connections. The connections are kept in the state table as long as the interval of
packets within a connection is shorter than the timeouts set.

CAUTION:  Setting excessive timeouts for many connections consumes resources excessively
and can disturb the operation of the engine.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall, IPS, or Layer 2 Firewall element and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to Advanced Settings > Idle Timeouts.

3) Click the Timeout(s) column and enter the timeout value for the protocol in seconds.

4) (Optional) Click Add to add a protocol to the list and enter the timeout for the protocol.

5) Click  Save and Refresh to transfer the configuration changes.

Related concepts
Creating engine elements on page 472
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Configure SYN rate limits for engines
You can configure SYN rate limits to reduce the risk of SYN flood attacks against the Firewall, IPS engine, Layer
2 Firewall, Master NGFW Engine, or Virtual NGFW Engine.

SYN rate limits are applied to TCP connections. Each TCP connection starts with a SYN packet. If the SYN rate
limits defined for the engine are reached, the engine drops new TCP connections.

The global SYN rate limits that you define in the NGFW Engine properties are applied as default settings on all
interfaces. You can also define SYN rate limits that override the global settings in each interface’s properties.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to Advanced Settings > SYN Rate Limits.
The SYN Rate Limits pane opens on the right.

3) In the SYN Rate Limits Mode, select Automatic or Custom.

CAUTION:  The recommended values for the SYN rate limits depend on your network
environment. If the custom settings are not carefully configured, the capacity of the engine
might suffer or SYN rate limits might not work correctly.

4) (Custom only) In the Allowed SYNs per Second field, enter the number of allowed SYN packets per
second.

5) (Custom only) In the Burst Size field, enter the number of allowed SYNs before the engine starts limiting the
SYN rate.

CAUTION:  We recommend setting the Burst Size value to at least one tenth of the Allowed
SYNs per Second value. If the burst size is too small, SYN rate limits do not work. For
example, if the value for Allowed SYNs per Second is 10000, the Burst Size value must be
at least 1000.

6) Click  Save and Refresh to transfer the configuration changes.

Related concepts
Creating engine elements on page 472

Related tasks
Configure advanced properties for firewall interfaces on page 559
Configure advanced properties for IPS interfaces on page 586
Configure advanced properties for Layer 2 Firewall interfaces on page 599
Configure advanced properties for Master NGFW Engine interfaces on page 611
Configure advanced properties for Virtual NGFW Engine interfaces on page 620
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Configure log handling settings for
engines

Log Handling settings allow you to adjust logging when the log spool on the Firewall, IPS, Layer 2 Firewall, or
Master NGFW Engine fills up.

Logs are spooled locally when the Log Server is not available. The Master NGFW Engine spools its own logs and
the logs sent by the Virtual NGFW Engines that the Master NGFW Engine hosts.

You can also configure Log Compression to save resources on the engine. By default, each generated
Antispoofing and Discard log entry is logged separately and displayed as a separate entry in the Logs view. Log
Compression allows you to define the maximum number of separately logged entries. When the defined limit is
reached, a single Antispoofing log entry or Discard log entry is logged. The single entry contains information on
the total number of the generated Antispoofing log entries or Discard log entries. After this, logging returns to
normal and all generated entries are once more logged and displayed separately.

The general Log Compression settings you define in the Engine Editor are applied as default settings on all
interfaces. You can also define Log Compression and override the global settings in each interface’s properties.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall, IPS, Layer 2 Firewall, or Master NGFW Engine element and select Edit <element
type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to Advanced Settings > Log Handling.
The Log Handling pane opens on the right.

3) Select the Log Spooling Policy to define what happens when the engine’s log spool becomes full.

4) (Optional) In the Log Compression table, enter values for Antispoofing entries (Firewall only) and for
Discard entries.
Do not enable Log Compression if you want all Antispoofing and Discard entries to be logged as separate
log entries (for example, for reporting or statistics).

5) Click  Save and Refresh to transfer the configuration changes.

Related concepts
Creating engine elements on page 472

Related tasks
Configure advanced properties for firewall interfaces on page 559
Configure advanced properties for IPS interfaces on page 586
Configure advanced properties for Layer 2 Firewall interfaces on page 599
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Configure DoS protection settings for
NGFW Engines

You can configure three forms of protection that can help prevent Denial of Service (DoS) attacks: SYN flood
protection and slow HTTP request protection against rate-based DoS attacks, and TCP reset protection against
TCP reset attacks.

The following settings can be configured when the Rate-Based DoS Protection Mode is enabled:

• SYN flood protection — In a SYN flood attack, an attacker sends many TCP SYN packets to a server
without any intention of completing the TCP handshake. The SYN packets are often sent with forged source
IP addresses. If the rate of unanswered SYN-ACK packets exceeds the threshold set in the DoS protection
options, the SYN flood protection is activated, and log data is generated.

SYN flood protection can also be activated by the detection of too many half-open TCP connections. An
attacker can create a large number of half-open TCP connections to use up resources on the NGFW Engine.
To guard against this, you can set a limit for the number of half-open TCP connections per destination IP
address. When the limit is exceeded, the SYN flood protection is activated, and log data is generated.

When the SYN flood protection is activated, the NGFW Engine acts as a SYN proxy. The NGFW Engine
completes the TCP handshake with the client, and only initiates the connection with the server after the client
has completed the TCP handshake.

• Slow HTTP request protection — When the NGFW Engine receives an HTTP request, it analyzes the data
transfer rate and length of time it takes to read the header fields of the HTTP request. If the sender of the
request tries to keep the connection open for an unreasonable length of time, consuming excessive resources,
the NGFW Engine blacklists the sender’s IP address for a specified length of time.

In addition, you can configure protection against DoS attacks that are based on TCP resets:

• TCP reset protection — In a TCP reset attack, an attacker sends forged TCP segments with an RST flag
in an attempt to make the NGFW Engine drop TCP connections. The NGFW Engine detects the sequence
numbers of the TCP RST segments to determine whether it is under a TCP Reset attack. If the segment’s
sequence number is in the current receive window but does not exactly match the expected sequence
number, the NGFW Engine might send back a challenge ACK message. The connection is dropped only if
the original sender responds to the challenge ACK with a new TCP reset that contains the correct sequence
number.

You can enable all forms of DoS protection on all NGFW Engine and Virtual NGFW Engine types.

Note:  If Rate-Based DoS Protection Mode is set to On or Off in the Engine Editor, you can
override the setting in Access rules. If Rate-Based DoS Protection Mode is set to Disabled, you
cannot enable rate-based DoS protection in an Access rule. You cannot override the TCP reset
protection setting in Access rules.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an NGFW Engine, then select Edit <element type>.

2) Browse to Advanced Settings > DoS Protection.

3) Configure the settings.

4) Click  Save and Refresh to transfer the configuration changes.
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Related concepts
Creating engine elements on page 472

Related tasks
Defining Access rule Action options on page 871

Configure scan detection settings for
engines

Before an attack, attackers might scan the network for open ports. When you enable scan detection on an
engine, the number of connections or connection attempts within a time window is counted. If the number of
events reaches the threshold set in the scan detection options, an alert is generated.

If scan detection is enabled or set to Off in the Engine Editor, you can override the scan detection mode in
Access rules. If scan detection is set to Disabled in the Engine Editor, you cannot enable scan detection in an
Access rule.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to Advanced Settings > Scan Detection.
The Scan Detection pane opens on the right.

3) (Optional) Select the Scan Detection Mode.

4) (If Scan Detection is On or Off) Enter the number of TCP, UDP, and ICMP events and the time window for
detecting the events before an alert is generated.

5) Click  Save and Refresh to transfer the configuration changes.

Related concepts
Creating engine elements on page 472

Related tasks
Defining Access rule Action options on page 871
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 PART VIII
Routing

Contents

• Configuring routing and antispoofing on page 701
• Configuring dynamic routing on page 725
• Outbound traffic management on page 739
• Inbound traffic management on page 753

Use the Management Client to configure static or dynamic routing, and use a Multi-Link configuration to manage and
distribute inbound and outbound connections.
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 CHAPTER 40

Configuring routing and
antispoofing

Contents

• Getting started with routing on page 701
• Using routing and antispoofing on page 703
• Routing configuration overview on page 706
• View and add default routes on page 707
• Add single-link routes on page 708
• Add routes for firewalls on page 709
• Adding routes for Master NGFW Engines on page 714
• Adding routes for Virtual Firewalls on page 714
• Defining Multi-Link routes for firewalls on page 714
• Define routing for route-based VPNs on page 718
• Add routes for IPS engines or Layer 2 Firewalls on page 718
• Remove routes on page 719
• Modify antispoofing on page 720
• Check routes with a Route Query on page 722
• Examples of routing configuration on page 723

Routing is the process of defining through which network interface the engine forwards traffic from a source address to
a destination address. Antispoofing is the process of defining which addresses are considered valid source addresses
for the networks connected to each interface.

Getting started with routing
Routing information is used for deciding which network interface is used to reach any given destination address.

The SMC automates most of the routing and antispoofing configuration. Much of the configuration is generated
automatically based on the IP addresses of the network interfaces.

It is only necessary to change routing and antispoofing for IPS engines, Layer 2 Firewalls, and Master NGFW
Engines if other SMC components are not located indirectly connected networks. IPS engines, Layer 2 Firewalls,
and Master NGFW Engines that host Virtual IPS engines or Virtual Layer 2 Firewalls do not forward traffic from
one network to another.

The routing and antispoofing information is displayed and configured graphically in interface-based trees
in the Routing pane and Antispoofing pane in the Engine Editor. The routing information is stored on the
Management Server. The information is transferred to the engines when the policies are installed or refreshed.

In addition to the routing information that is automatically generated, you must manually add any networks that
are not directly connected to the engine to the routing tree. If the Automatic Default Route option is selected



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Configuring routing and antispoofing | 702

for an interface, a default route is automatically created through the interface. You must add a default route for
packets whose destination IP address is not included anywhere else in the routing tree.

IP address spoofing is an attack where the source IP address in a packet is changed to gain unauthorized access
or to cause a denial-of-service (DoS). Such attacks can be prevented with antispoofing rules. The antispoofing
configuration is generated automatically based on the routing tree. Antispoofing is always enforced on all
interfaces. You can change the antispoofing configuration, but in most environments, there is no need to do so.

New Networks are automatically added to routing when you change the engine’s interface properties. However,
none of the Networks are automatically removed, so you must check the Routing pane in the Engine Editor for
obsolete entries and remove them manually. This behavior prevents the system from removing currently unused
routes that you might want to use again later. All additions and deletions in the Routing pane are automatically
reflected in the Antispoofing pane in the Engine Editor. Manual definitions in the Antispoofing pane in the
Engine Editor are preserved regardless of routing changes.

Changes to the routing or antispoofing configuration are only transferred to the engine when you refresh the
policy. When you change the routing or antispoofing for a Master NGFW Engine, you must refresh the policy on
the Master NGFW Engine. When you change the routing or antispoofing for a Virtual NGFW Engine, you must
refresh the policy on the Virtual NGFW Engine.

How routing works
Basic routing information for directly connected networks is added automatically to both routing and antispoofing
based on IP addresses you have defined for the engines’ interfaces. You must manually define routing for firewall
Tunnel Interfaces used in route-based VPNs. IPS engines and Layer 2 Firewalls do not route traffic. You might
need to define a default route for IPS engines and Layer 2 Firewalls if other SMC components are not on a
directly connected network.

Antispoofing is used on Firewalls, IPS engines, Layer 2 Firewalls, Master NGFW Engines, and Virtual Firewalls.
Antispoofing configuration is added and updated automatically based on the routing configuration. Firewalls, IPS
engines, Layer 2 Firewalls, Master NGFW Engines, and Virtual Firewalls always enforce antispoofing. By default
a connection is allowed to originate only from the interface that has a routing entry for the connection’s source IP
address.

Limitations
• Routing and antispoofing can only be configured for interfaces that have IP addresses. It is not possible to

define routing or antispoofing for the following types of interfaces because they do not have IP addresses:
• Capture Interfaces and Inline Interfaces on IPS engines or Layer 2 Firewalls, or on Master NGFW Engines

that host Virtual IPS engines or Virtual Layer 2 Firewalls.
• Capture Interfaces, Inline IPS Interfaces, and Inline Layer 2 Firewall Interfaces on NGFW Engines in the

Firewall/VPN role.
• All interfaces on Virtual IPS engines and Virtual Layer 2 Firewalls.

• The basic routing configuration does not determine which traffic is routed through policy-based VPNs. Routing
is checked after policy-based VPN traffic is encapsulated inside encrypted packets with different source and
destination IP address information.

• Only IPv4 addresses are supported in DHCP relay and multicast routing.
• Multicast routing is not supported on Wireless Interfaces.
• IGMP Proxy mode for multicast routing is not supported on Tunnel Interfaces.

Related tasks
Edit the Quagga configuration file on page 737
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Using routing and antispoofing
Using policy routing, you can override the configuration defined in the Routing pane in the Engine Editor.

Policy routing
With policy routing, you can route traffic through a selected gateway. Policy routing can be used in cases where
the same IP address is used by different hosts in different networks and it is not possible to resolve the IP
addresses in any other way. These policy routing entries override other routing configuration defined in the
Routing pane in the Engine Editor.

A policy routing entry includes the following information:
• Source IP address
• Destination IP address
• Netmasks or prefixes for the source and destination addresses
• The IP address of the selected gateway

Antispoofing configuration might need to be changed accordingly when using manual policy routing entries.

Multicast routing
IP multicasting is the transmission of an IP datagram to all hosts in a multicast host group, which is identified by
a single destination IP address. You can configure static multicast and IGMP-based multicast forwarding of IPv4
traffic. You can also configure dynamic multicast routing using the Quagga Routing Suite on the engine command
line.

Static multicast does not rely on IGMP (Internet Group Management Protocol) messaging. Because of the static
nature of the configuration, static multicast is suitable for enduring configurations, such as mutually agreed
multicast traffic between organizations.

In IGMP-based multicast forwarding (IGMP proxying), the firewall maintains a list of subscriptions to the multicast
host group and forwards multicast traffic to the subscribed hosts. The firewall periodically queries the downstream
networks for hosts that want to join the multicast host group. The firewall also processes unsolicited IGMP join/
leave requests received from downstream networks. As multicast traffic is only sent to the currently subscribed
hosts, IGMP-based multicast forwarding can save bandwidth and provide faster service. IGMP-based multicast
forwarding is only supported in tree topology networks. See RFC 4605 for more information.

If you use Multi-Link together with IGMP-based multicast forwarding, make sure that you do not create routing
loops. If you add a NetLink to an engine’s upstream interface, do not add a NetLink to any of the engine’s
downstream interfaces.

Changing antispoofing definitions
In rare cases, you might need to change the default antispoofing definitions to make exceptions to the
antispoofing rules (for example, if you have defined policy routing manually). You can also disable antispoofing
for an interface, if necessary.
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Monitoring routing
You can monitor the currently active routing configuration of an engine in the Routing Monitoring view.
The routing configuration can be viewed as a table or diagram. You can also save versions of the routing
configurations as snapshots in the Routing Monitoring view.

Related concepts
Multicasting vs. unicasting or broadcasting on page 1515

Related reference
Forcepoint NGFW Engine commands on page 1421

Default elements for routing and antispoofing
Networks that correspond to the IP addresses of each interface are automatically added to the routing and
antispoofing configurations of IPS, Firewall, Layer 2 Firewall, Master NGFW Engine, and Virtual Firewall
elements.

Firewalls
The system includes a default network element called Any network, which is needed to define the default route.
The system also includes a Host element for Bootp/DHCP clients in the Antispoofing pane of the Engine Editor
for Firewall, Master NGFW Engine, and Virtual Firewall elements.

Note:  Layer 2 physical interfaces on firewalls are not included in the routing and antispoofing
configuration.

IPS and Layer 2 Firewalls
The system includes a default network element called Any network, which is needed to define the default route
for IPS engines, Layer 2 Firewalls, and Master NGFW Engines.

Routing and antispoofing tree view and how it
works
To understand how the engine reads routing definitions, look at the network interfaces in the Routing or
Antispoofing tree view.

The Routing pane in the Engine Editor automatically displays the interfaces and a Network element for each
network that is directly connected to the engine. The Network is created based on the IP addresses that you
define for each interface. Interfaces that belong to an aggregated link always share routing information. Only the
first interface that belongs to the aggregated link is displayed in the Routing pane and Antispoofing pane in the
Engine Editor.

The Routing pane has two display modes:
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• Traditional tree view
• Simple table view (IPv4 and IPv6 routes are shown in separate tables.)

You can change the display modes using the Display Mode menu at the top of the view.

The Routing Tools pane at the bottom of the Routing pane has three tabs:
• Default Route — View and create default routes.
• Add Route — Create new routes.
• Query Route — Search for routes.

When the engine reads routing definitions, it selects the most specific route and antispoofing definition it finds
for each packet. The engine first checks if there is a route defined for the specific destination IP address of the
packet (a Host element). Then the engine checks routes to the defined networks (a Network element), and finally
uses the default route (the Any Network element) if none of the other routes match the packet’s destination
address. If there are overlapping definitions, the more specific one is considered first.

The more specific destination is considered first in routing
Interface 1 has a Host element for 192.168.0.202, and Interface 2 has a Network element for 192.168.0.0/24. A
packet to 192.168.0.202 is routed through Interface 1, and the Interface 2 definition is not considered for those
packets at all.

 

Interface 1 is always used for a destination of 192.168.0.202 because it has a Host element with the most specific
address under it.

The Antispoofing pane in the Engine Editor defines the source addresses of traffic that are considered valid (not
spoofed) for each interface. If an interface receives a packet with a source address that is not a valid address for
the networks connected to that interface, the packet is discarded. This is the case, for example, when an external
interface receives a packet with an internal source. The engine selects the most specific antispoofing definition it
finds for each packet.

Only the most specific destination is considered valid in antispoofing
In the Antispoofing tree automatically generated based on the previous routing example, antispoofing discards
any traffic with the address 192.168.0.202 if it originates from Interface 2, because it has the less specific
definition for that address (the Network 192.168.0.0/24).

Packets from Host A (192.168.0.202) are only considered valid if they originate from Interface 1, because it has
the most specific route to the host’s address.
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Both interfaces are considered valid
To allow the traffic to originate from both interfaces, you would also have to add the Host element for
192.168.0.202 under Interface 2, so that the definitions are equally specific (both interfaces contain the Host
element) and therefore both definitions are valid at the same time.

 

Both Interface 1 and Interface 2 are considered valid routes to Host A (192.168.0.202) because the Host element
is included under both interfaces.

Routing configuration overview
Routing configuration involves adding a default route, adding routes to networks that are not directly connected,
and adding routes to networks that can be reached through route-based VPNs.

1) Add the default route.
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2) Add routes to networks that are not directly connected, but require a next-hop gateway.

3) Add routes to networks that are reachable through the Tunnel Interfaces used in route-based VPNs.

In addition to examining packets, Firewalls, Master NGFW Engines, and Virtual Firewalls must determine how to
route packets. The SMC automates most of the routing and antispoofing configuration. Much of the configuration
is generated automatically based on the IP addresses of the network interfaces.
• Routing and antispoofing for Master NGFW Engines are configured in the same way as routing and

antispoofing for Firewall Clusters.
• Routing and antispoofing for Virtual Firewalls are configured in the same way as routing and antispoofing for

Single Firewalls.

Usually, only a default route is needed for the IPS engines, Layer 2 Firewalls, and Master NGFW Engines.
Default routes are used when the engines open connections to some network other than the directly
connected networks. No routes have to be defined if an IPS engine, Layer 2 Firewall, or Master NGFW Engine
communicates only in its local IP network.

Routing and antispoofing can only be configured for interfaces that have IP addresses. Capture Interfaces and
Inline Interfaces cannot have IP addresses. For this reason, it is not possible to configure routing or antispoofing
for these types of interfaces. Capture Interfaces and Inline Interfaces are the only type of interfaces that you
can define for Virtual IPS engines and Virtual Layer 2 Firewalls. Because of this, it is not possible to configure
routing or antispoofing for Virtual IPS engines or Virtual Layer 2 Firewalls. On Master NGFW Engines, routing
and antispoofing can only be configured for the Master NGFW Engine’s system communications interfaces.

View and add default routes
Use the Routing Tools pane to view and add default routes.

View the default route
Use the Show Default Route function to quickly check which route is currently set as the default route.

Note:  The Automatic Default Route setting enables the automatic creation of default routes for
interfaces with dynamic IP addresses on single engines. The Automatic Default Route option is
selected by default for new interfaces with dynamic IP addresses. Only Single Firewalls, Single
IPS engines, and Single Layer 2 Firewalls can have dynamic IP addresses.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine, then select Edit <element type>.

3) Browse to Routing.

4) In the Routing Tools pane, click the Default Route tab, then click Show Default Route.
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Result

The current default route or default routes for the engine are shown. The default routes are highlighted.

Add a default route
If you want to change the automatically created default route, use the Default Route tab of the Routing Tools
pane to define a new default route.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine, then select Edit <element type>.

3) Browse to Routing.

4) In the Routing Tools pane, click the Default Route tab.

5) In the Gateway field, enter an IP address. You can also double-click the field and select a gateway device
for the route.

6) Click Add.
The default route is added to the configuration.

7) Click  Save.

Add single-link routes
Use the Routing Tools pane to add a static route to a particular network.

Note:  If there are two or more alternative routes to the same destination, create a Multi-Link route
instead.

Routing decisions are made for each packet by matching from the most specific route definition to the most
general. However, any policy routing entries you define override the other routing information. For packets
subject to address translation, routing is always done after NAT using the translated addresses.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click a Firewall, Virtual Firewall, or Master NGFW Engine, then select Edit <element type>.
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3) In the navigation pane on the left, select Routing.

4) In the Routing Tools pane at the bottom of the Routing pane, click the Add Route tab.

5) In the Destination field, enter an IP address.
You can also double-click the field, then select a destination device.

6) In the Gateway field, enter an IP address.
You can also double-click the field, then select a gateway device.

7) Click Add.
The route is added to the configuration.

8) Click  Save.

Add routes for firewalls
Firewalls route network traffic. You must add a default route if the Automatic Default Route option is not
selected for any interfaces. You must also add any routes through next-hop gateways to networks that are not
directly connected to the firewalls.

On firewall clusters, the routing information is configured simultaneously for all cluster nodes and all nodes
always have identical routing tables. If you are configuring a route-based VPN, you must manually define the
routing for the Tunnel Interfaces.

Configure DHCP message routing on firewalls
The firewall can relay DHCP messages. If DHCP messages are routed through the firewall (from a network
segment to some other, isolated segment), you must enable DHCP relay on the firewall interface properties for
the interface where the DHCP requests are originating from (client’s network).

Only IPv4 addresses are supported in DHCP relay. You can enable DHCP relay only on firewall interfaces that
have at least one IPv4 address.

This DHCP relay configuration does not relay DHCP messages from VPN Clients.

Define a DHCP Server
A DHCP Server dynamically assigns IP addresses.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Network Elements tree.

3) Right-click Servers and select New > DHCP Server.
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4) Enter a unique Name and IP Address.

Note:  Only IPv4 addresses are supported for DHCP relay in the SMC.

5) A Location and Contact Address is needed if there is a NAT device between a firewall and the server, so
that the firewall cannot connect directly to the IP address defined for the interface.

6) Click OK to apply the changes to the DHCP Server properties.

Related concepts
Define contact IP addresses on page 129

Related tasks
Create Location elements on page 129

Enable DHCP relay on firewalls
You must select which firewall interfaces perform DHCP relay. Activate the relay on the interface toward the
DHCP clients.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall or Firewall Cluster element and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Interfaces.
The Interfaces pane opens.

3) Right-click a physical, VLAN, or Port Group interface and select Edit <interface type>.
• When configuring VLAN interfaces, set the DHCP relay separately for each VLAN.
• When configuring Port Group interfaces, set the DHCP relay separately for each Port Group.

4) Click the DHCP tab, and select DHCP Relay as the DHCP Mode.

5) Select the DHCP server from the list of servers on the left and click Add.
To create a DHCP Server element, select  Tools > New > DHCP Server.

6) Adjust the maximum allowed packet size if you have a specific need to do so.

7) (Optional) Select the CVI or IP address you want to use for DHCP Relay.

8) Click OK.

9) Click  Save to save and validate changes.
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Configure multicast traffic routing on firewalls
The Firewall supports static multicast, IGMP-based multicast forwarding (IGMP proxying), and multicast routing
using protocol-independent multicast (PIM).

Static multicast is suitable for enduring configurations, while IGMP-based forwarding and PIM can save
bandwidth and provide faster service.

Static multicast allows you to configure static routes for multicast traffic between a source IP address and firewall
interface pair, and a destination (multicast) IP address and firewall interface pair. Static multicast is often used for
enduring configurations, such as mutually agreed multicast traffic between organizations (for example, multicast
news feeds and video conferences).

IGMP-based multicast forwarding is only supported in tree topology networks. Only IPv4 addresses are
supported in multicast routing.

In IGMP-based multicast forwarding, the firewall maintains a list of hosts that are subscribed to the multicast host
group. It forwards the traffic sent to the multicast IP address only to the currently subscribed hosts.

Note:  In addition to configuring the firewall, routers and other network devices must be configured
to allow IP multicasting along the path to the client machines.

Three variants of PIM are supported: PIM sparse mode (PIM-SM), PIM dense mode (PIM-DM), and PIM source-
specific multicast (PIM-SSM), and the mode can be set separately for different multicast groups.

Related tasks
Configure PIM on page 734

Define static multicast on firewalls
You can configure static routes for multicast traffic between a source IP address and firewall interface pair and a
destination (multicast) IP address and firewall interface pair.

Note:  Make sure your IPv4 Access rules allow the static multicast traffic to pass through the
firewall.

Note:  Wireless Interfaces cannot be used in multicast routing.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall or Firewall Cluster element and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to Routing > Multicast Routing.
The Multicast Routing pane opens on the right.

3) Select Static as the Multicast Routing Mode.
The options for the mode are enabled.
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4) Click Add.
A new entry appears in the table.

5) Configure the values for the entry.

6) Click  Save and Refresh to transfer the changed configuration.

Related concepts
Getting started with Access rules on page 817

Define IGMP-based multicast forwarding on
firewalls
You can configure IGMP-based multicast forwarding for a specified Firewall element.

IGMP-based multicast forwarding (IGMP proxying) is implemented on the Firewall based on RFC 4605. IGMP-
based multicast forwarding is only supported in tree topology networks. RFC 4605 includes support for source-
specific multicast (SSM) with IGMP version 3. SSM is not supported with IGMP-based multicast forwarding.
However, you can configure Access rules that filter multicast traffic based on the source.

The firewall maintains a membership database of the subscriptions from the downstream networks and sends
unsolicited reports or leaves on the upstream interface when the subscription database changes. It also sends
IGMP membership reports when queried on the upstream interface.

Note:  Make sure your IPv4 Access rules allow this traffic to pass through the firewall.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall or Firewall Cluster element, then select Edit <element type>.

2) In the navigation pane on the left, browse to Routing > Multicast Routing.

3) Select IGMP Proxy as the Multicast Routing Mode.

4) (Optional) Select the Upstream Interface and the IGMP Querier Settings for it.
• If the multicast servers and the hosts are in the local networks, or if you want to limit the multicast to the

local networks, it is not necessary to define the Upstream Interface. In that case, leave Not Set selected
for Upstream Interface.

• (Firewall Clusters only) You can only select as the Upstream Interface an interface that has a Cluster
Virtual IP Address (CVI). You cannot select a Heartbeat Interface as the Upstream Interface.

• You might need to select a specific IGMP Querier Settings element, for example, to troubleshoot multicast
accessibility on hosts, or if some hosts use an earlier IGMP version.

5) Click Add to define Downstream Interfaces.
The firewall periodically queries the downstream networks for hosts that want to join or leave the multicast
host group.
A new entry appears in the table.
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6) Click the Interface cell and select the Downstream Interface from the list.
• You can use each interface only once in the IGMP proxy configuration.
• (Firewall Clusters only) The interface that you select as a Downstream Interface must have Node

Dedicated IP Addresses (NDIs). It cannot be a Heartbeat Interface. It is recommended that the Node
Dedicated IP Addresses increase in the same order on each node: for example, 192.168.1.10 and
192.168.2.10 for node A, and 192.168.1.11 and 192.168.2.11 for node B.

Note:  The downstream interfaces must have the lowest IP addresses among all IGMP
queries in the local networks.

7) Click the IGMP Querier Settings cell, then select the IGMP Querier Settings element that uses the IGMP
version for the downstream interface.
You might need to select a specific IGMP Querier Settings element, for example, to troubleshoot multicast
accessibility on hosts, or if some hosts use an earlier IGMP version.

8) Click  Save and Refresh to transfer the changed configuration.

Related concepts
Getting started with Access rules on page 817

Configure policy routing on firewalls
Policy routing is used to resolve duplicate IP addressing issues.

Policy routing allows you to route traffic based on both source and destination IP address. Policy routing is useful
if the same IP address is in use on more than one physical host in different networks and it is not possible to
resolve the situation by changing IP address or by using NAT. Usually, there is no need to add any policy routing
entries.

Note:  Policy routing is only used if duplicate IP addresses are used in different networks. To
configure alternative routes to the same destination, use Multi-Link routing.

Policy routing entries are applied before the regular routes defined in the Routing tree (overriding those
configurations if matches are found). They are processed exactly in the order specified in the Policy Routing
window; the first matching policy routing entry is applied to a connection and any further entries are ignored.

Policy routing entries are not automatically added to the Antispoofing pane, so you might need to update the
antispoofing information manually.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall or Firewall Cluster element and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to Routing > Policy Routing.
The Policy Routing pane opens on the right.

3) Click Add.
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4) Click the cells and enter the required routing information.

Note:  Routing is done after NAT.

5) Click  Save and Refresh to transfer the changed configuration.

Related concepts
Using routing and antispoofing on page 703
Defining Multi-Link routes for firewalls on page 714

Adding routes for Master NGFW Engines
Routing information for directly connected networks is added automatically. For networks that are not directly
connected to the Master NGFW Engine, you must add the routing information.

Basic routing information for directly connected networks is added automatically to both routing and antispoofing
based on IP addresses you have defined for the engines’ interfaces. You must add a default route and any routes
through next-hop gateways to networks that are not directly connected to the Master NGFW Engine.

Adding routes for Virtual Firewalls
Routing information for directly connected networks is added automatically. For networks that are not directly
connected to the Virtual Firewall, you must add the routing information.

Basic routing information for directly connected networks is added automatically to both routing and antispoofing
based on IP addresses you have defined for the engines’ interfaces. You must add a default route and any
routes through next-hop gateways to networks that are not directly connected to the Virtual Firewall. If you are
configuring a route-based VPN, you must manually define the routing for the Tunnel Interfaces.

Note:  You cannot configure routing for Virtual IPS engines and Virtual Layer 2 Firewalls.

Defining Multi-Link routes for firewalls
When you use Multi-Link routing, traffic is routed through different network connections (NetLinks) according to
traffic conditions, the availability of the different links, and explicitly configured preferences you set.

Most often, Multi-Link is used for Internet connections, but Multi-Link can be used to provide alternative routes to
any other network as well. You can define a Multi-Link route for firewalls and Virtual Firewalls.

Multi-Link uses multiple NetLinks to balance the load of outbound traffic and ensure High Availability of Internet
connectivity. With each new outbound connection, the system selects the fastest route for the connection from
the available NetLinks. Multi-Link routing can be used for both IPv4 and IPv6 traffic.
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Figure 91: NetLinks in the Routing tree view

In this illustration, a Multi-Link configuration is used to define a default route to the Internet (to “Any network”)
through the ISP A and ISP B NetLinks. Separate network interfaces can be used for each NetLink, which is
recommended for the Multi-Link configuration. It is also possible to configure multiple NetLinks for a single
network interface. However, this is not recommended, as configuring multiple networks on the same interface
introduces a single point of failure.

For each NetLink, a range of IP addresses is defined for NATing the source IP address of an outbound
connection that goes through the NetLink. A NAT rule in the Firewall Policy defines the Outbound Multi-Link
element that is used for Multi-Link outbound connections.

Multi-Link route configuration overview
1) Create a NetLink for each alternative route.

2) Add Networks under the NetLinks in the Routing tree to define a route.

Create NetLink elements for Multi-Link
configuration
NetLink elements are used to represent alternative routes that lead to the same destination IP addresses.

NetLinks usually represent Internet connections, but can be used for other communications links as well.

Although the Management Client might not require all settings to be filled in at this point, we recommend that you
fill in all settings as instructed here to achieve a fully functional configuration and to avoid having to readjust the
settings later. To monitor the status of the network links, you must define the probe IP addresses in the NetLink
properties.
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A Router or a NetLink element represents a next-hop gateway that forwards packets to networks that are not
directly connected to the engine.

You can use a single Router if a single route is enough for routing traffic to a network through an interface or an
aggregated link. If you want to create separate routes for traffic to a network through two or more interfaces, you
must use NetLinks.

Tunnel interfaces for route-based VPNs do not use Router or NetLink elements. Instead, networks that are
reachable through the VPN tunnel are added directly to the tunnel interface as if they were directly connected
networks.

Note:  Only NetLinks that are used in an Outbound Multi-Link element are probed. Status
monitoring is not available for NetLinks that are only used in Routing.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine, then select Edit <element type>.

3) In the navigation pane on the left, select Routing.

4) Expand the tree under the interface under which you want to create the NetLink.

5) Right-click the network to which the NetLink belongs, then select Add.

6) Select Traffic Handlers.

7) Select  Tools > New > Static NetLink or  Tools > New > Dynamic NetLink.

8) Give the NetLink a unique Name.

9) (Static NetLink only) Select the next-hop Gateway the NetLink uses.
• Selecting Select opens a dialog box that allows you to create a new element if needed.
• The Gateway is usually added as a Router element, but you can also choose another Firewall

according to your network configuration.

10) (Static NetLink only) Click Select next to the Network field, then define the address space that the ISP
has assigned to your organization.
Do not select the Any Network element for the NetLink. Select or create Network elements that represent
the specific public IP addresses assigned by your ISP and routed to the Internet provider’s router.

11) (Optional) Enter the Provider Name of your ISP.

12) (Optional) Enter or adjust the Probing settings.

Note:  Select IP addresses that give reliable results of end-to-end connectivity to
destinations that need to be reached through the link (such as a remote server across
the Internet instead of an internal router or server of your ISP in the case of an Internet
connection).
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13) (Optional) If you plan to use the ratio-based load-balancing method, fill in the Input Speed and Output
Speed based on the real-life bandwidth this network connection provides. These values are used to
calculate how much traffic each link receives in relation to the other links.

14) Click OK.

Related concepts
Getting started with outbound traffic management on page 739

Add Multi-Link routes for firewalls
You can add a Multi-Link route for a Firewall or Virtual Firewall.

Note:  A Network element represents the IP addresses of a network or a subnetwork to which
the router or the NetLink forwards the traffic, or the IP addresses of a network that is reachable
through a route-based VPN tunnel.

Note:  The network interfaces for the NetLinks must have a node dedicated IP address (NDI)
defined for all nodes in clusters. Otherwise, the IP address of the interface marked as the default
IP address for outgoing connections is used, which can lead to incorrect load balancing.

CAUTION:  If you use Multi-Link with IGMP proxy multicast routing, make sure that you do not
create routing loops. If you add a NetLink to the upstream interface, do not add a NetLink to any
downstream interface.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall or Virtual Firewall element and select Edit <element type>.

2) From the navigation pane on the left, select Routing.

3) In the routing tree, browse to the NetLink through which you want to route traffic.

4) Add the element that contains the IP addresses that are routed through this interface:
• To add a default route, right-click the NetLink element and select Set As Default Route.

This inserts the default element Any Network under the NetLink in the routing tree.
• To add a route using a Host or Network element, right-click the NetLink element and select Add, then

select an existing element or create an element.

5) Click  Save and Install.

Note:  If you are configuring routing for Master NGFW Engines, install or refresh the policy
on the Master NGFW Engine and the Virtual NGFW Engines to transfer the changed
configuration.
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Define routing for route-based VPNs
To configure routing for VPNs that use Route-Based VPN Tunnel elements, add remote networks that can be
reached through the VPN tunnel to the tunnel interfaces.

The routing defines which traffic is sent through the VPN tunnel. The routing configuration also determines the
physical network interfaces on the engine to which the tunnel interfaces are automatically mapped.

Routing for route-based VPNs does not use Router or NetLink elements. Instead, you add the remote networks
that are reachable through the VPN tunnel directly to the tunnel interfaces as if they were directly connected
networks. Routes to local networks that are directly connected to the tunnel interface are automatically added if
the tunnel interface has an IP address with a netmask other than the /32 host netmask.

Example: A tunnel interface has the following IP address and netmask: 10.1.1.1/24. An automatic route to the
10.1.1.0/24 network is added for the tunnel interface.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall or Virtual Firewall element, then select Edit <element type>.

2) Browse to Routing.

3) In the routing tree, browse to the tunnel interface through which you want to route traffic.

4) Right-click the tunnel interface, select Add, then select an existing Network element or create a Network
element.

5) Click  Save and Install.

Add routes for IPS engines or Layer 2
Firewalls

IPS engines and Layer 2 Firewalls do not route traffic. You can only add routes through interfaces that have IP
addresses.

Capture Interfaces and Inline Interfaces on IPS engines and Layer 2 Firewalls do not have IP addresses. It is not
possible to configure routing for these interfaces.

You might need to define a default route through a Normal Interface if SMC components are not on a directly
connected network. You might need to add other routes if one or more SMC components are not directly
connected and cannot be reached through the default gateway.

A Router element represents the next-hop gateway device that forwards packets to the networks you define.

Note:  Virtual IPS engines and Virtual Layer 2 Firewalls do not communicate directly with other
SMC components. You cannot configure routing for Virtual IPS engines and Virtual Layer 2
Firewalls.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Configuring routing and antispoofing | 719

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an IPS or Layer 2 Firewall element and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Routing.
The Routing pane opens.

3) In the Routing Tools pane at the bottom of the Routing pane, click the Add Route tab.

4) In the Destination field, enter an IP address. You can also double-click the field and select a destination
device.

5) In the Gateway field, enter an IP address. You can also double-click the field and select a gateway device.

6) Click Add.
The route is added to the configuration.

7) Click  Save to save and validate changes.

Adding networks for IPS and Layer 2 Firewall
routing and antispoofing
The Network element represents the IP addresses of a network or a subnetwork to which the Router forwards
traffic.

• To add a default route, add the default Any network element to the Router you created.
• If you have to forward traffic to a network that is not directly connected and it cannot be reached through the

default gateway, you must define a Network element for this network and add it under the Router.

Remove routes
You can remove any element you have added to the Routing tree yourself at any time.

You cannot remove elements that are added automatically based on the IP addresses of the interfaces while they
are still in use. Use the Access rules to control access to or from these addresses.

Automatically added elements corresponding to a previous configuration are not automatically removed when the
IP address of an interface is changed. Instead, the elements that belong to the old configuration are shown as
invalid, and you must remove the obsolete elements manually.

Removing elements from routing does not delete the elements from the SMC.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select Routing.
The Routing pane opens.

3) Right-click the element in the Routing tree and select Remove.
The element is removed from routing.

4) Click  Save and Refresh to transfer the changed configuration.

Related concepts
Getting started with Access rules on page 817

Modify antispoofing
Antispoofing is an important security measure. Antispoofing is intended to prevent malicious attempts to use a
legitimate internal IP address to gain access from lower-security networks to higher-security networks.

Antispoofing determines which addresses are valid source addresses for the networks connected to each
interface. If an interface receives a packet with a source address that is not a valid source address for the
networks that are connected to that interface, the packet is considered to come from a spoofed IP address.

Firewalls, IPS engines, Layer 2 Firewalls, Master NGFW Engines, and Virtual Firewalls automatically determine
antispoofing rules based on the routing configuration for interfaces that have IP addresses. Antispoofing cannot
be configured for the following types of interfaces because they do not have IP addresses:

• Capture Interfaces and Inline Interfaces on IPS engines or Layer 2 Firewalls, or on Master NGFW Engines
that host Virtual IPS engines or Virtual Layer 2 Firewalls.

• Layer 2 physical interfaces on Firewalls.
• All interfaces on Virtual IPS engines and Virtual Layer 2 Firewalls.

In most cases, there is no need to change the antispoofing configuration in any way.

Deactivate antispoofing for an IP address
interface pair
In rare cases, you might need to change the default antispoofing definitions to make exceptions to antispoofing
(for example, if you have defined policy routing manually).

Manually changed entries are marked with a plus sign (+) (active entries) or a minus sign (–) (disabled entries) in
the Antispoofing pane.

Note:  Errors in the routing configuration (in the Management Client or in the surrounding network)
can cause legitimate packets to be incorrectly identified as coming from a spoofed IP address.
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Always make sure that the routing is configured correctly before changing antispoofing. For
example, routing loops generate log messages about spoofed packets. You cannot remove
routing loops by changing antispoofing.

By default, the engine interprets the antispoofing tree by selecting the most specific entry defined in the view. For
example, a definition of a single IP address is selected over a definition of a whole network. If an IP address must
be allowed access through two or more interfaces, the definition for each interface must be at the same level of
detail for the IP address.

Example: Interface A contains a Host element for 192.168.10.101 and Interface B contains a Network element
for 192.168.10.0/24. Connections from 192.168.10.101 are considered spoofed if they enter through Interface B,
even though the address is included in the Network element. The antispoofing configuration must be changed to
allow the address from Interface B.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine, then select Edit <element type>.

3) In the navigation pane on the left, browse to Routing > Antispoofing.

4) Right-click the interface, select Add, then select a Host or Network element.

5) (Optional) If you want to allow all connections from a network through a specific interface, right-click the
network under the correct interface, then select Absolute.

CAUTION:  Never mark the Any Network element as Absolute. Disabling antispoofing in this
way is a security risk. Resolve large-scale antispoofing conflicts with specific antispoofing
definitions or by changing routing.

All IP addresses that belong to that network are now allowed for the interface. More specific antispoofing
definitions for some addresses in the network can be defined for other interfaces.

6) Click  Save and Refresh to transfer the configuration.

Activate antispoofing for routable IP addresses
In rare cases, you might need to disable or remove an allowed IP address for an engine element.

The Antispoofing pane shows the allowed addresses for each interface. Only the first interface selected for an
aggregated link is shown. Manually changed entries are marked with a plus sign (+) (active entries) or a minus
sign (–) (disabled entries), to distinguish them from the automatically generated antispoofing entries.

There is rarely any need to change the automatically added entries. The preferred way of preventing routing for
IP addresses is to change the Routing view instead.

Note:  Disabling or removing elements in the Antispoofing pane prevents access. The IP
addresses a disabled or removed element represents are considered spoofed addresses.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to Routing > Antispoofing.
The Antispoofing pane opens.

3) Right-click the element and select Remove or Disable.
If you disabled the element, you can re-enable the element in the same way when needed.

4) Click  Save and Refresh to transfer the configuration.

Check routes with a Route Query
The Route Query tool allows you to check where packets with a certain IP address are routed according to the
current definitions.

The tool helps you check that the routing is correct and to quickly find a particular branch in the Routing tree.

Policy routing is not considered in this query. The route query uses the configuration that is stored on the
Management Server (shown in the Management Client). You must refresh the policy of the affected engines after
completing the configuration to transfer the changed routing information.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to Routing.

3) In the Routing Tools pane, click the Query Route tab.

4) (Optional, NetLinks only) In the Source field, enter an IP address. You can also double-click the field to
select a source device.

5) In the Destination field, enter an IP address. You can also double-click the field to select the destination
device.

6) Click Query.

Result

The route that matches the search criteria is shown.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Configuring routing and antispoofing | 723

Examples of routing configuration
The SMC provides features, such as Multi-Link routing, that allow you to manage many routing scenarios.

Example: Routing traffic with two firewall
interfaces
To route traffic to two interfaces, add a router for each interface.

Company A needs to route traffic to the Internet as well as to the internal Network B, which is not directly
connected to the company’s Branch Office Firewall. The company’s administrators decide to create a separate
route to the internal Network B and a default route for traffic to the Internet. They:

1) Edit the Branch Office Firewall and browse to the Routing pane.

2) Add a Router and Network B under Interface 0.

3) Add a Router under Interface 1 and set it as the default route.

4) Refresh the Firewall Policy on the Branch Office Firewall.

Example: Routing Internet traffic with Multi-
Link for a firewall
This scenario shows an example of using Multi-Link routing for High Availability.

Company B wants to guarantee High Availability of Internet connections through the company’s firewall. The
company’s administrators decide to use Multi-Link routing with two NetLinks to balance Internet connections.
They:

1) Create two NetLinks.

2) Combine the NetLinks into an Outbound Multi-Link element to balance the connections.

3) Open the Engine Editor and browse to the Routing pane.

4) Add one of the NetLinks under Interface 1 and the other NetLink under Interface 2 in the Routing tree.

5) Add the default route “Any network” under the NetLinks.

6) Add a NAT rule to the Firewall Policy to balance the connections between the NetLinks.

7) Refresh the Firewall Policy.
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Example: Using policy routing on a firewall
to route traffic to networks that use the same
address space
To manage traffic to networks that share the same address space, create a policy routing entry for each host.

Company C’s network is connected to two partners: Network A and Network B. The Network A and the Network
B partners use the same address space in their internal networks.

 
Figure 92: Policy routing in Company C

There are two hosts in Company C’s network. Host 1 works only with the Network A partner and Host 2 only with
the Network B partner. The administrators at Company C decide to use policy routing to route the traffic between
Company C’s network and the two partner sites. They:

1) Create policy routing entries for Host 1 and Host 2 on the Firewall HQ Cluster.
 
Figure 93: Policy routing entries for Host 1 and Host 2

2) Change the antispoofing rules so that they take into account the routing defined with the policy routing
entries.

3) Refresh the Firewall Policy on the Firewall HQ Cluster.
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 CHAPTER 41

Configuring dynamic routing
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• Using the command line to configure dynamic routing on page 736
• Restart dynamic routing processing on page 738

With dynamic routing, firewalls automatically change their routing when the network topology changes. The firewalls
can also exchange information about appropriate routing paths.

Getting started with dynamic routing
You can configure dynamic routing in the Management Client or on the engine command line.

Note:  We recommend that you configure dynamic routing only if you have experience and
knowledge of the general principles of dynamic routing and Quagga syntax. Poorly configured
dynamic routing can lead to adverse effects on networks, such as packets being directed to the
wrong interfaces or data being exposed to undesired networks.

The two methods for configuring dynamic routing are separate, and using both methods on the same engine is
not supported.

• If you configure dynamic routing for a firewall engine on the command line, that dynamic routing configuration
is not shown in the Management Client.

• If you configure dynamic routing for a firewall engine in the Management Client, the configuration overwrites
the dynamic routing configuration that you configured on the engine's command line.

In the Management Client, you can configure dynamic routing using border gateway protocol (BGP), open
shortest path first (OSPFv2), and protocol-independent multicast (PIM).

When using Quagga commands and syntax on the firewall engine's command line, the supported dynamic
routing protocols are BGP, OSPFv2, OSPFv3, PIM, and routing information protocol (RIP).

Dynamic routing is supported on Single Firewalls and Virtual Firewalls. Dynamic routing is supported on Firewall
Clusters, but not if all cluster nodes are online at the same time (active-active clustering). The rules that allow
dynamic routing traffic are created automatically.

Before installing a policy that includes a dynamic routing configuration, you can preview and save the
configuration in Quagga syntax.
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Dynamic routing configuration overview
The steps for configuring dynamic routing depend on the protocol you use and whether you configure it in the
Management Client or on the engine command line.

Follow these general steps to configure dynamic routing in the Management Client:

1) Create the elements for dynamic routing that you want to use in the configuration.

2) Configure the settings for dynamic routing for the Firewall, Firewall Cluster, or Virtual Firewall in the Engine
Editor.

3) (Recommended) Preview the dynamic routing configuration in Quagga format to check that the routing
configuration is what you intended.

Follow these general steps to configure a dynamic routing protocol on the command line:

1) Create an empty protocol-specific configuration file.

2) Start the protocol-specific routing daemon.

3) Start the Quagga command shell, then enter the dynamic routing commands.

Creating elements for dynamic routing
Before enabling dynamic routing in the Management Client, you can optionally create customized elements for
dynamic routing.

If the default elements meet your needs, it is not necessary to create custom elements.

Table 66: BGP elements for dynamic routing

Element Description

BGP Profile This element contains administrative distance, redistribution, and aggregation settings.
You can use this element in multiple Firewalls, Virtual Firewalls, and Firewall Clusters.
There is a default BGP Profile element that is used automatically.

Autonomous System An autonomous system (AS) is a group of IP routing prefixes controlled by an
administrative entity. Each AS has a unique identifying number. This element is used
to define the AS number. The number determines whether internal BGP (BGP peers
have the same AS number) or external BGP (BGP peers have different AS numbers)
is used.

BGP Peering An element that you place between a Firewall and another Firewall or an External
BGP Peer element in the Routing view in the Engine Editor. It contains the
parameters to define a BGP peering relationship, and implements inbound and
outbound policies through access lists and the Route Map.

BGP Connection
Profile

This element can be used to set a password for TCP MD5 authentication between
BGP peers, and to set timers, such as the keepalive value. You can use this element
in multiple BGP Peering elements. There is a default BGP Connection Profile element
that is used automatically.
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Element Description

External BGP Peer

(Optional)

Use this element to define the IP address and AS number of a BGP peer that is under
the administrative control of a third party, such as another organization or SMC.

Table 67: OSPFv2 elements for dynamic routing

Element Description

OSPFv2 Domain
Settings

Use this element to set the area border router (ABR) type, throttle timer settings,
and the max metric router link-state advertisement (LSA) settings. There is a default
OSPFv2 Domain Settings element that is used automatically.

OSPFv2 Profile This element contains administrative distance and redistribution settings. There is a
default OSPFv2 Profile element that is used automatically.

OSPFv2 Interface
Settings

This element contains the interface settings. You can also select the type of
authentication to use. There is a default OSPFv2 Interface Settings element that is
used automatically.

OSPFv2 Area Use this element to set the area ID and type. You can also configure the ABR settings
and virtual links.

OSPFv2 Key Chains This element contains the keys that you can use if the Message Digest authentication
type is used in an OSPFv2 Interface Setting element.

Table 68: PIM elements for dynamic routing

Element Description

PIM Profile This element contains the multicast groups and determines the PIM mode that is used.
There is a default PIM Profile element that is used automatically.

PIM Interface Settings This element contains various settings, such as the designated router (DR) priority and
the zone boundary router (ZBR) group. You must also set the IGMP Querier Settings
element to use. There is a default PIM Interface Settings element that you can use.

IGMP Querier Settings This element determines the IGMP version to use. You can also set the query interval
and robustness settings. You can use this element when configuring both PIM and
IGMP Proxy multicast. There are three default IGMP Querier Settings elements; one
element for each version of IGMP.

Table 69: Common elements for dynamic routing

Element Description

Route Map

(Optional)

An element that contains rules to control or manipulate received or
advertised routes based on matching conditions. The rules can be
edited in the same way as in policy elements.

IP Access List A filtering element that you can use in the Matching Condition cell of
a Route Map rule. You can filter by subnet. This element can also be
used to implement inbound and outbound filtering policies in a BGP
Peering element.

Access Lists

(Optional)

IP Prefix Access
List

Similar to an IP Access List, but includes the prefix length or netmask
as a filter. This element can be used in the Matching Condition cell of
a Route Map rule and in a BGP Peering element.
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Element Description

Community
Access List

A filtering element used for the BGP community attribute. If the Type
is Expanded, you can use regular expressions in the Community
Regular Expression cell. This element can be used in the Matching
Condition cell of a Route Map rule and in a BGP Peering element.

Extended
Community
Access List

A filtering element that represents the extended version of the
Community Access List. If the Type is Expanded, you can use regular
expressions in the Community Regular Expression cell. This element
can be used in the Matching Condition cell of a Route Map rule.

AS Path Access
List

A filtering element for the BGP AS path attribute. You can enter
regular expressions for matching AS paths (a sequence of AS
numbers). This element can be used in the Matching Condition cell of
a Route Map rule and in a BGP Peering element.

Create core elements for dynamic routing
Create the elements that contain dynamic routing configuration information. The elements can be used in multiple
Firewalls, Virtual Firewalls, and Firewall Clusters.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Dynamic Routing Elements.

3) Browse to BGP Elements, OSPFv2 Elements, or PIM Elements.

4) Right-click the type of element that you want to create, then select New <element type>.

5) Adjust the properties as needed, then click OK.

Create Access List elements
You can use Access List elements as a Matching Condition in a Route Map element. You can also use certain
Access Lists in BGP Peering elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Dynamic Routing Elements.

3) Right-click the type of Access List that you want to create, then select New <Access List>.
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4) Enter a name in the Name field.

5) (For Community Access Lists and Extended Community Access Lists) To use regular expressions for the
Community name, in the Type field, select Expanded.

6) To add a row to the table, click Add, then fill in the details for the row.

7) (Optional) To reorder the table, select a row, then click Up or Down.
The rows are processed from top to bottom.

8) (Optional) To remove a row, select the row, then click Remove.

9) Click OK.

Create Route Map elements
Use Route Map elements in more complex networks to control or manipulate routes. You can use Access List
elements as a Matching Condition in a Route Map rule.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Dynamic Routing Elements.

3) Right-click Route Maps, then select New Route Map.

4) Enter a name for the Route Map in the Name field, then click OK.
The Route Map opens for editing.

5) To add a rule, right-click the Route Map, then select Add Rule.

6) (Optional) To add a Rule Section, right-click the Route Map, then select Add Rule Section Before or Add
Rule Section After.
You can use Rule Sections to group similar rules. Double-click the Rule Section to give it a name.
Because you can jump to a Rule Section in the Goto action, use a unique name.

7) To add a Matching Condition for a rule, double-click the Matching Condition cell.

a) Click Add Row, then in the Type cell, select the type of matching condition.

b) If using an Access List or Next Hop, drag and drop the Access List from the left pane to the Value cell.

c) If using a Peer Address, drag and drop a Firewall or External BGP Peer from the left pane to the
Value cell.

d) To enter a Metric, double-click the Value cell.
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e) (Optional) To reorder the condition rows, select a row, then click Up or Down.
The rows are processed from top to bottom.

f) (Optional) To remove a condition row, select the row, then click Remove Row.

g) To save your changes, click OK.

8) To select the action for the rule, right-click the Action cell, then select Permit or Deny.

9) To change the Route Entry Settings, double-click the Route Entry Settings cell, adjust the settings, then
click OK.

10) (Optional) To jump to a Route Map, double-click the Call cell, then select a Route Map.

11) Select the Goto action.
By default, the action is Finish. Further rules are not processed.
• To jump to the following rule, double-click the Goto cell, then select Goto Next Rule.
• To jump to another Rule Section, select Goto Rule Section.

Configure BGP
You can configure dynamic routing using the BGP protocol on Firewalls, Virtual Firewalls, and Firewall Clusters.

Before you begin
We recommend that you first create elements for configuring dynamic routing.

Enable BGP on the Firewall, Firewall Cluster, or
Virtual Firewall
You must enable BGP for the Firewall, Firewall Cluster, or Virtual Firewall in the Engine Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine, then select Edit <element type>.

3) In the navigation pane on the left, browse to Routing > Dynamic Routing.

4) In the BGP section, select Enabled.
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5) (Optional) Enter the Router ID in the Router ID field.

6) If you do not want to use the default BGP Profile, select another BGP Profile element from the BGP
Profile drop-down list.

7) Select an Autonomous System element from the Autonomous System drop-down list.

8) (Optional) To add Announced Networks, click Add.
You can add hosts, networks, or groups that contain both hosts and networks.

9) (Optional) To add a network to the Antispoofing pane, click Add next to the Additional Networks to
Automatically Add to Antispoofing table.
You can add hosts, networks, or groups that contain both hosts and networks.

10) Click  Save.

Next steps

You are now ready to add a BGP Peering element to the engine on the Routing branch.

Add the BGP Peering element
You must add a BGP Peering element to the routing configuration.

Before you begin
You must enable BGP on the engine. To establish a BGP peering relationship with another Firewall or
Virtual Firewall, you must enable BGP on both Firewalls.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine, then select Edit <element type>.

3) In the navigation pane on the left, browse to Routing.

4) Right-click a directly connected network under an interface or right-click a Tunnel Interface, then select Add
BGP Peering.

5) Browse to the BGP Peering element, click Add, then click OK.
The element is added beneath the network or Tunnel Interface.

6) (Optional) To change the CVI address:

a) Right-click the BGP Peering element.
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b) Select IP addresses, then select an IP address.

7) Right-click the BGP Peering element, then select Add Firewall or Add External BGP Peer.

8) Browse to the Firewall, Virtual Firewall, Firewall Cluster, or External BGP Peer element, click Add, then click
OK.
The Firewall, Virtual Firewall, Firewall Cluster, or External BGP Peer element is added beneath the BGP
Peering element.

9) Click  Save.

Configure OSPFv2
You can configure dynamic routing using the OSPFv2 protocol on Firewalls, Virtual Firewalls, and Firewall
Clusters.

Before you begin
We recommend that you first create elements for configuring dynamic routing.

Enable OSPFv2 on the Firewall, Firewall
Cluster, or Virtual Firewall
You must enable OSPFv2 for the Firewall, Firewall Cluster, or Virtual Firewall in the Engine Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine, then select Edit <element type>.

3) In the navigation pane on the left, browse to Routing > Dynamic Routing.

4) In the OSPFv2 section, select Enabled.

5) (Optional) Enter the Router ID in the Router ID field.

6) If you do not want to use the default OSPFv2 Profile, select another OSPFv2 Profile element from the
OSPFv2 Profile drop-down list.

7) (Optional) To add a network to the Antispoofing pane, click Add next to the Additional Networks to
Automatically Add to Antispoofing table.
You can add hosts, networks, or groups that contain both hosts and networks.
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8) Click  Save.

Next steps

You are now ready to add an OSPFv2 Area element to the engine on the Routing branch.

Add an OSPFv2 Area element
You must add one or more OSPFv2 Area elements to the routing configuration.

Before you begin
You must have enabled OSPFv2 on the engine.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine, then select Edit <element type>.

3) In the navigation pane on the left, browse to Routing.

4) Right-click a directly connected network under an interface or right-click a Tunnel Interface, then select Add
OSPFv2 Area.

5) Browse to the OSPFv2 Area element, click Add, then click OK.
The element is added beneath the network or Tunnel Interface.

6) (Optional) Override the OSPFv2 Interface Settings element that is used in the OSPFv2 Area element.

a) Right-click the OSPFv2 Area element, then select Override Interface Settings.

b) Browse to the OSPFv2 Interface Settings element, click Add, then click OK.

7) (Optional) To change the communication mode, right-click the OSPFv2 Area element, then select Force
Communication Mode and one of the following options:

• Not Forced — This is the default option. Use this option if you do not want to use a different
communication mode.

• Point-to-Point — Select this option if the network is between two routers only.
• Passive — Select this option if you do not want the interface to send routing updates, but you do want the

interface to be announced.
• Unicast — Select a Host element, click Add, then click OK.

8) Click  Save.
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Configure PIM
You can configure dynamic multicast routing using a variant of the PIM protocol on Firewalls, Virtual Firewalls,
and Firewall Clusters.

Before you begin
We recommend that you first create elements for configuring dynamic routing.

Three variants of PIM are supported: PIM sparse mode (PIM-SM), PIM dense mode (PIM-DM), and PIM source-
specific multicast (PIM-SSM), and the mode can be set separately for different multicast groups. The variant to
use depends on many factors, such as the network topology, the number of recipients, and what the existing
infrastructure supports.

• Use PIM-SM when multicast traffic needs to travel greater logical distances; over WAN links, for example.
There is usually intermittent multicast traffic.

• Use PIM-DM when there are a lot of potential recipients and the logical distances are short; within a WAN, for
example. There is usually a high, constant load of multicast traffic. Messages are flooded over the network, so
this is not always the most efficient use of bandwidth.

• Use PIM-SSM when you want receivers to be able to specify the source IP address of the requested multicast
stream. This is the most efficient use of bandwidth, but all devices and client applications must have support
for IGMPv3 and this variant of PIM. However, SSM mapping allows IGMPv2 requests to be converted into
IGMPv3 requests.

Enable PIM on the Firewall, Firewall Cluster, or
Virtual Firewall
You must enable PIM for the Firewall, Firewall Cluster, or Virtual Firewall in the Engine Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine, then select Edit <element type>.

3) In the navigation pane on the left, browse to Routing > Multicast Routing.

4) From the Multicast Routing Mode drop-down list, select PIM.

5) If you do not want to use the default PIM Profile, select another PIM Profile element from the PIM Profile
drop-down list.

6) (Optional, PIM-SM only) Expand the Bootstrap Settings section, then modify the settings.

7) Click  Save.
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Next steps

You are now ready to add a PIM Interface Settings element to the engine on the Routing branch.

Add a PIM Interface Settings element
You must add one or more PIM Interface Settings elements to the routing configuration.

Before you begin
You must have enabled PIM on the engine.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine, then select Edit <element type>.

3) In the navigation pane on the left, browse to Routing.

4) Right-click a directly connected network under an interface or right-click a Tunnel Interface, then select Add
PIM Interface Settings.
When configuring a Firewall Cluster, the interface must have a CVI address defined.

5) Browse to the PIM Interface Settings element, click Add, then click OK.
The element is added beneath the network or Tunnel Interface.

6) (Optional) To change the IP address used, right-click the PIM Interface Settings element, then select IP
Addresses and an IP address.

7) Click  Save.

Preview the dynamic routing
configuration in Quagga syntax

To make sure the dynamic routing configuration done in the Management Client is what you intended, preview
the configuration in Quagga syntax.

You can also save the configuration as a .conf file, for testing with the Quagga suite.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click the Firewall, Firewall Cluster, or Virtual Firewall, then select Configuration > Dynamic Routing >
Quagga Preview.
The Quagga Configuration Preview dialog box opens, and you can see the configuration in Quagga
syntax.

3) To save the configuration:

a) To select where to save the configuration, click Browse.

b) Click Save.

The configuration is saved in .conf format.

Using the command line to configure
dynamic routing

You can enter dynamic routing commands through the Quagga suite on the command line of the firewall engine.

Important:  If you make changes to dynamic routing using the Management Client, all the
changes you made on the command line are overwritten.

Dynamic routing with the Quagga suite is supported on Single Firewalls and Virtual Firewalls. For Virtual
Firewalls, configuration is done on the command line of the Master NGFW Engine. Dynamic routing is supported
on Firewall Clusters, but not if all cluster nodes are online at the same time (active-active clustering).

Firewall Clusters or Master NGFW Engines automatically synchronize the Quagga configuration files between
nodes, and automatically start and stop the routing daemon if the online node changes. You only edit the Quagga
configuration for the online node.

Dynamic routing is configured on the node’s command line using the vtysh shell for Quagga routing software.

Note:  Configuring dynamic routing requires SSH access to the command line. We recommend
that you disable SSH access whenever it is not needed. Make sure that your Access rules allow
SSH access to the engines from the administrators’ IP addresses only.

Detailed instructions for configuring the Quagga suite can be found on the Quagga Software Routing Suite
website at http://www.nongnu.org/quagga/docs.html.

http://www.nongnu.org/quagga/docs.html
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Edit the Quagga configuration file
To configure dynamic routing on the command line of the firewall engine, edit the Quagga configuration file.

The protocol-specific configuration file (for example, ospfd.conf) must exist in the /data/config/quagga directory,
and the routing daemon must be running before you configure dynamic routing using vtysh. Otherwise, vtysh
cannot save protocol-specific configurations.

Steps

1) Open an SSH connection to the command line console of the engine.

2) To create empty protocol-specific configuration files, enter, for example:
sg-dynamic-routing sample-config ripd ospfd bgpd

3) To start the routing daemon, enter:
sg-dynamic-routing restart|force-reload

4) To start the Quagga command shell, enter:
vtysh

Related concepts
Adjust Master NGFW Engine clustering options on page 689

Related tasks
Access the engine command line on page 346
Adjust general Firewall clustering options on page 685

Related reference
Forcepoint NGFW Engine commands on page 1421

Back up or restore command-line dynamic
routing configurations
You can back up and restore the engine’s current dynamic routing configuration that has been configured on the
command line of the engine.

Note:  This operation does not back up or restore configurations done in the Management Client;
those configurations are included in Management Server backups.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.
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2) Right-click the engine, select Configuration > Dynamic Routing, then select one of the following:
• Backup — To save the current dynamic routing configuration. This action overwrites the previously saved

backup.
• Restore — To restore a saved dynamic routing configuration.

A progress summary opens in a new tab.

3) Click Close when the backup or restoration is complete.

Related tasks
Edit the Quagga configuration file on page 737

Restart dynamic routing processing
If routes are not being updated as expected, you can restart the dynamic routing processing.

Note:  Instead of issuing the BGP stop and start commands, the engine issues the BGP graceful
restart command.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click the Firewall or Virtual Firewall, then select Configuration > Dynamic Routing > Restart.

3) In the Confirmation dialog box, add an optional comment for auditing, then click Yes.
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 CHAPTER 42

Outbound traffic management
Contents

• Getting started with outbound traffic management on page 739
• Configuring outbound Multi-Link settings on page 745
• Create outbound load-balancing NAT rules on page 748
• Monitoring and testing outbound traffic management on page 750
• Examples of Multi-Link on page 750

You can use Multi-Link to distribute outbound traffic between multiple network connections and to provide High
Availability and load balancing for outbound traffic.

Getting started with outbound traffic
management

To ensure outbound connectivity, you create an Outbound Multi-Link element and manually add NAT rules to the
Firewall Policy.

A single connection to the Internet is a single point of failure: if the connection becomes unavailable, all outbound
traffic is blocked. To prevent traffic from being blocked, Multi-Link distributes outbound traffic and balances the
load of outbound traffic between multiple network connections. Multi-Link ensures that Internet connectivity
remains available even when one or more network connections fail. You can also use Multi-Link with aggregated
links.

For outbound connections, you create an Outbound Multi-Link element and add NAT rules manually to the
Firewall Policy. For inbound connections, load balancing is provided by Server Pool elements.

If you use element-based NAT and multiple external IP addresses, the default NAT address works like an
Outbound Multi-Link and the NAT rules are automatically generated.

What outbound traffic management does
Single Firewalls, Firewall Clusters, and Virtual Firewalls can balance outbound traffic between two or more
network links (NetLinks) using the Multi-Link feature. NetLinks are combined into Outbound Multi-Link elements.
The NetLinks can be of different types and they can have different speeds. The NetLinks must be added under
the appropriate interfaces in the Routing tree to support Multi-Link. You can also use Multi-Link with aggregated
links.

Multi-Link allows you to:

• Balance outbound traffic between two or more alternative network links to increase the available bandwidth.
• Ensure that outbound network connectivity remains available even if network links fail. When a network link

fails, the firewall detects this and stops forwarding traffic through the failed link.
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Limitations
• Multi-Link is supported on Single Firewalls, Firewall Clusters, and Virtual Firewalls.
• VPN traffic is balanced independently from the settings covered in this configuration (when the firewall is the

VPN endpoint).
• Multi-Link is only supported for IPv4 traffic.

What do I need to know before I begin?
For a truly redundant configuration, we recommend connecting each link through different physical network
equipment (such as routers).

If you configure element-based NAT, you can use an Outbound Multi-Link element as a NAT address in a NAT
definition.

Related concepts
Getting started with inbound traffic management on page 753
Network address translation and how it works on page 123
Multi-Link and VPNs on page 1142

Load-balancing methods for outbound traffic
Load balancing can be based on either of two methods: Round Trip Time or Ratio.

• Round Trip Time — When this method is used, NetLink performance is measured for each new TCP
connection by sending the initial request (SYN) to the destination through all available NetLinks. When the
destination host sends the reply (SYN-ACK), the NetLink that receives the reply first is used to complete the
TCP connection establishment. The firewall cancels the slower connection attempts by sending a TCP Reset
(RST) to the destination through the other NetLinks.
This way, the fastest route is automatically selected for each connection. Information about the performance
of each NetLink is cached, so no new measurement is made if a new connection is opened to the same
destination within a short time period.

• Ratio — When this method is used, traffic is distributed between all available NetLinks according to the
relative capacity of the links. The bandwidths of the other NetLinks are automatically compared to the
bandwidth of the NetLink with the most bandwidth to produce a ratio for distributing the traffic. When the
volume of traffic is low, the ratio of actual traffic distribution is approximate. When the volume of traffic is high,
the ratio of traffic handled by each NetLink is closer to the ratio calculated from the link capacity.

Using standby NetLinks for High Availability in
outbound traffic management
Standby NetLinks allow you to define a NetLink as a backup that is only activated when all primary NetLinks are
unavailable.

This minimizes the use of NetLinks that are more expensive or otherwise less preferable, while still ensuring
the High Availability of Internet connectivity. To test which NetLinks are available, the status of the NetLinks is
monitored. As soon as one or more primary NetLinks become active again, the standby NetLinks are deactivated.
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The deactivated NetLink still handles the previously established connections, but new connections are no longer
sent to the standby NetLink. You can define multiple active and standby NetLinks.

When load balancing is used with standby NetLinks, traffic is only distributed between the NetLinks that are
currently active. Standby NetLinks are only activated when failure is detected, not to balance the load.

Using standby NetLinks on the same interface as other NetLinks affects the interface speed you enter in the
configuration of QoS for firewall interfaces.

Related concepts
Link status probing in outbound traffic management on page 741

Related tasks
Define QoS Policy elements on page 958

Link status probing in outbound traffic
management
To monitor the status of the NetLinks, the firewall must be configured to probe each NetLink.

Probing is always recommended, and it is mandatory with the following features:

• The Ratio-based load-balancing method
• Failover to Standby NetLinks
• Inbound traffic balancing with dynamic DNS updates

Traffic is correctly balanced between active working links without probing if Round Trip Time balancing is
used, since failed links are eliminated from use in the periodic round-trip time checks. Although traffic is always
allocated to a working link, information about the status of the links is not available unless you add NetLink
probing to the configuration.

The probe is made using ICMP echo requests (ping) to IP addresses you define. Make sure the Probe IP
Addresses that you select produce a reliable measurement of the link performance. For example, probing the IP
address of an ADSL router usually succeeds even if the ISP network is unreachable. Probing the default gateway
provided to you by the ISP might succeed even if the ISP is not able to forward traffic anywhere outside the ISP’s
own network. Several alternative probe IP addresses can be added to avoid probing failures caused by a probed
host going down.

Benefits of using Multi-Link in outbound traffic
management
Multi-Link is used for High Availability to ensure that business-critical traffic gets through even when one or more
Internet connections fail.

Standby NetLinks act as backup Internet connections that are only activated if all primary NetLinks fail. Using
standby NetLinks provides High Availability of Internet connectivity, but is less expensive than having multiple
NetLinks active at the same time. Using Multi-Link for load balancing can also help reduce costs. Traffic can be
balanced between two slower, less expensive, Internet connections instead of one faster connection.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Outbound traffic management | 742

Multi-Link with a Single Firewall in outbound
traffic management
You can configure Multi-Link with Single Firewalls using network or modem interfaces.

Single Firewall interfaces with Multi-Link
 

In this scenario, interface 1 is used as the network interface for Internet traffic that is routed through ISP A.
Interface 2 is used as the network interface for Internet traffic that is routed through ISP B.

CAUTION:  We do not recommend defining two or more IP addresses for a single physical
interface. If two IP addresses are defined, the router behind the interface forwards the traffic to the
different ISPs. This creates an additional single point of failure at the intermediate router, and the
associated cabling and network cards.

Multi-Link configuration with two Modem Interfaces on a Single Firewall
You can also configure Multi-Link with Single Firewalls by replacing one or more physical interfaces with Modem
Interfaces and 3G modems.

 

In this scenario, Modem Interface 1 is used for Internet traffic that 3G Modem 1 routes through ISP A. Modem
Interface 2 is used for Internet traffic that 3G Modem 2 routes through ISP B.
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Multi-Link with a Firewall Cluster in outbound
traffic management
You can configure Multi-Link with a Firewall Cluster consisting of two nodes by using two routers and physically
connecting each node to each router.

 
Figure 94: Cluster interfaces for Multi-Link

In this scenario, the Firewall Cluster consists of two nodes. On both nodes, Interface 1 is used as the CVI for
Internet traffic that is routed through ISP A. Interface 2 is used as the CVI for Internet traffic that is routed through
ISP B. Both nodes have one physical interface for each CVI, so that both nodes are physically connected to both
routers leading to the Internet.

CAUTION:  We do not recommend configuring Multi-Link by connecting two CVIs to a single
router, which in turn connects to both ISPs. It creates a single point of failure.

Using multiple outbound Multi-Link elements
You can create multiple Outbound Multi-Link elements, and each NetLink can belong to more than one Outbound
Multi-Link element at the same time. This can be useful, for example, when you want a certain type of traffic to be
balanced only between some of the NetLinks, and another type of traffic to be balanced between all NetLinks.

Outbound traffic management configuration
overview
Outbound traffic management is configured using NetLink elements which represent network connections.

You can use Multi-Link on Single Firewalls, Firewall Clusters, and Virtual Firewalls.
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In the SMC, NetLink elements represent the network connections for Multi-Link. Usually, a NetLink element is
used to represent an ISP connection. However, NetLinks can also represent a leased line, xDSL, or any other
type of network connection mediated by your firewall.

There are two types of NetLinks: static and dynamic NetLinks.
• Static NetLinks are supported in the routing configuration for both IPv4 and IPv6 traffic.
• Dynamic NetLinks are used only with Single Firewalls, as dynamic IP addresses are not supported for Firewall

Clusters.

Note:  If you configure wireless Multi-Link on a Modem Interface of a Single Firewall, only
Dynamic NetLinks are supported, as Modem Interfaces always have dynamic IP addresses.

 
Figure 95: Elements in a Multi-Link configuration

This illustration shows the elements that are used to configure Multi-Link. Each NetLink element contains a
Router element and a Network element. The Router element represents the router for that network connection.
The Network element represents the set of public IP addresses allocated by the provider of the network
connection. NetLinks are added to the Routing tree under the Interface IDs and the Modem numbers that
represent the physical interfaces or the 3G modems toward the routers used for the Internet connections.

Multiple NetLinks are combined into an Outbound Multi-Link element. Outbound Multi-Link elements are the
central elements used to configure load balancing for outbound traffic. Outbound load balancing is implemented
by using the Outbound Multi-Link elements in the Firewall Policy’s NAT rules. Outbound Multi-Link elements are
only supported for IPv4 traffic.

1) Configure routing with at least two NetLinks.

2) If you want the firewall to select the NetLink based on the type of traffic, create QoS Classes and assign
them to traffic.
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3) Create an Outbound Multi-Link element to group your NetLinks and define traffic management settings.

4) In the Firewall Policy, create NAT rules for outbound load balancing.

Related concepts
Defining Multi-Link routes for firewalls on page 714
Quality of Service (QoS) and how it works on page 949

Related tasks
Create Outbound Multi-Link elements on page 745

Configuring outbound Multi-Link
settings

Outbound Multi-Link elements are used for combining NetLinks and for setting options for the high availability and
load balancing features.

You must configure the basic settings for the Round Trip Time or Ratio methods in the properties of each
NetLink.

Create Outbound Multi-Link elements
The Outbound Multi-Link element collects together the NetLinks and sets options for load balancing.

To group the NetLinks together as a single entity, you must create an Outbound Multi-Link element that includes
the NetLinks. To create the Outbound Multi-Link element, you must define the following:
• Which NetLinks are included
• The load-balancing method for determining which link is selected for each new outbound connection
• Whether each NetLink in the Outbound Multi-Link element is an Active or Standby NetLink

You can create multiple Outbound Multi-Link elements, and each NetLink can belong to more than one Outbound
Multi-Link element at the same time.

You can optionally assign QoS Classes to NetLinks in the Outbound Multi-Link element to specify which traffic is
routed through which NetLink. NAT rules can alternatively be used to select a particular link, but if you use QoS
Classes, traffic can still fail over to other links if the selected link fails.

The same QoS class can be assigned to more than one NetLink in the same Outbound Multi-Link element to
balance traffic through those selected NetLinks when those links are available. If you want to use QoS class to
specify which traffic uses which NetLink, you must assign the QoS class to the traffic in an Access rule or with the
QoS policies based on the DSCP codes in the traffic.

The Outbound Multi-Link elements you create do not work on their own; you must use them in the Firewall
Policy’s NAT rules to select traffic for outbound load balancing.

Note:  If you use element-based NAT and multiple external IP addresses, the default NAT
address works like an Outbound Multi-Link element.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Network Elements > Traffic Handlers.

3) Right-click Traffic Handlers and select New > Outbound Multi-Link.

4) Give the Outbound Multi-Link element a unique Name.

5) (Optional) Add a free-form Comment for your own reference.

6) Specify the Method for link selection:
• Round Trip Time: The firewall periodically probes the NetLinks to test them for speed and selects the

fastest available active NetLink for each new outbound connection.
• Ratio: Traffic is distributed between all available active NetLinks according to the relative bandwidth of

each NetLink. The NetLink with the highest bandwidth is assigned the largest portion of the traffic.

Related concepts
Using bandwidth management and traffic prioritization on page 953

Select NetLinks for Outbound Multi-Link
elements
NetLink elements represent multiple network connections in the Multi-Link configuration.

Before you begin
To introduce a new Internet connection, you must define a NetLink element that represents the Internet
connection in the SMC.

The NetLink element contains the IP addresses that are used for translating source IP addresses (NAT) so that
outgoing connections receive the correct IP address depending on the ISP. This allows the correct routing of the
return packets. Each NetLink must have a unique IP address space.

A NetLink can be either static or dynamic. Dynamic NetLinks are supported only for Single Firewalls. In addition,
only Dynamic NetLinks are supported if you configure Multi-Link using 3G modems with a Single Firewall. You
can use the same NetLink with several firewalls. If you want to use NetLinks with a firewall that has several
interfaces with dynamic IP addresses, you must create a separate Dynamic NetLink element for each interface
with a dynamic IP address.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.
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2) Select to Network Elements > Traffic Handlers.

3) Right-click the Outbound Multi-Link element and select Properties.

4) On the General tab of the Outbound Multi-Link Properties dialog box, click Add.

5) From the NetLink drop-down list, select a NetLink element.

6) From the Network drop-down list, select the Network element that represents the IP address space in the
directly connected external network of this network link.

7) In the Selected Range fields, specify the IP address range for dynamic source address translation
(NAT) for the internal source IP addresses on this NetLink. To define a single IP address, enter the same
address in both fields.
Because Multi-Link works without external arrangements, the address translation is necessary for correct
routing of packets.

8) From the Type drop-down list, select an option to specify how traffic is routed through the NetLink.

9) (Optional) Select the QoS Classes for traffic handled by this NetLink and click Add.
You can use the QoS classes to assign the NetLink with or without activating the actual QoS features.
• You can select the same QoS class for several NetLinks to balance the traffic between the NetLinks.

If none of the NetLinks with the appropriate QoS class are available, or if the traffic has not been
assigned a QoS class, the traffic is distributed between the NetLinks according to the Method you
specify in the Outbound Multi-Link element properties.

• QoS classes are assigned based on ToS codes in network traffic or in the Access rules. Traffic that has
been assigned the selected QoS class uses this NetLink if the NetLink is available.

10) Click OK.
The NetLink is listed in the Multi-Link Members list.

11) Click OK in the Outbound Multi-Link Properties dialog box.

Related concepts
Quality of Service (QoS) and how it works on page 949
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Define destination cache settings for NetLinks
in Outbound Multi-Link elements
Information about the performance of each NetLink is cached. No new measurement is made if a new connection
is opened to the same destination within a short time period. You can define the duration of the cached
information.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Outbound Multi-Link Properties dialog box, select the Advanced tab.

2) Deselect Default.

3) Enter the Timeout (in seconds) after which a new measurement of NetLink performance is made.
The default is 3600 seconds.

4) Enter the number of Maximum Retries for checking each NetLink.
The default is 2.

5) Click OK.

Create outbound load-balancing NAT
rules

To balance outbound connections between the NetLinks, define NAT rules using the source NAT addressing
defined in the Outbound Multi-Link element.

You can create several Outbound Multi-Link elements to balance different types of traffic differently. If you do
not want to balance some traffic, direct the traffic through a specific NetLink with a normal NAT rule before the
balancing rule.

You activate Multi-Link for outbound connections in the Firewall Policy with NAT rules that match certain traffic
for Outbound Multi-Link address translation. Other NAT rules can translate the source addresses in outbound
connections to the IP address space of a particular ISP. The traffic is automatically routed through a particular
link, even if the link fails. Only the part of traffic that matches a NAT rule with the Outbound Multi-Link element is
balanced between different links.

Some protocols cannot use dynamic NAT based on IP/port translation. To provide high availability and load
balancing for these protocols, you can use static NAT with an Outbound Multi-Link element in an outbound load-
balancing NAT rule. When static NAT is used, the size of the source network must be the same as the size of the
Multi-Link network.

Note:  If you use element-based NAT, NAT rules are automatically generated. In addition, you can
use an Outbound Multi-Link element as a NAT address in a NAT definition.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Policies > Firewall Policies.

3) Right-click a Firewall Policy and select Edit.

4) On the IPv4 NAT tab, add a rule.

5) Specify the source, destination, and service according to the traffic that you want to balance using an
Outbound Multi-Link element.

6) Double-click the NAT cell.

7) Select Dynamic as the Translation Type.

8) Click Select next to the IP Address Pool field.

9) Browse to Network Elements > Traffic Handlers and select the Outbound Multi-Link element.

10) (Optional) In the First Port to Use and Last Port to Use fields, enter port numbers for source port
translation.
The default is to use all “free” high ports from 1024–65535.

Note:  Make sure that the IP address pool and port range are large enough to translate the
number of simultaneous connections that match this NAT rule.

11) To generate proxy ARP entries, select Automatic Proxy ARP (Recommended).
For proxy ARP to work, the untranslated IP address of all hosts whose IP address is translated must be
included in the routing tree. There must be a CVI with an address from the same network in the Firewall
element’s properties. Otherwise, the Network or Host must be manually added to the routing tree.

12) Click OK.

13) Click  Save and Install.

Related concepts
Element-based NAT and how it works on page 645
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Monitoring and testing outbound traffic
management

The status of the different NetLinks can be monitored in the Home view.

Status is displayed based on the results of status probes to the Probing addresses configured in the NetLink
elements.

You can test that the outbound traffic management configuration works as intended by generating traffic and then
disabling network connections, for example, by unplugging cables (in a cluster, disable the same link on all active
nodes to simulate ISP failure).

Note:  By default, if you unplug a cable from a node in a cluster, the automatic engine tester
recognizes this as a malfunction and turns the node offline (unless it is the last node that remains
online). To override this automatic test, command all nodes to “Lock Online” during the test.

Most connections that are currently open on the link that goes down are cut and must be reopened by the
communicating applications, since the external IP address used in the communications changes to an address of
the new link. Any type of traffic can switch to using a different link transparently if it is transported through a Multi-
Link VPN between two Firewalls.

If the Ratio-based load-balancing method is used, a link is used until a failure is detected based on the link status
probes to the Probing addresses configured in the NetLink elements. With the Round Trip Time method, new
connections are directed to working links (since the link that responds the fastest is chosen) even if probing is not
configured or working.

Related concepts
Getting started with monitoring the system on page 179

Examples of Multi-Link
Multi-Link technology has many uses, some of which might apply to your situation.

Example: Using Multi-Link to prepare for ISP
downtime
This scenario shows an example of using Multi-Link to configure connections to two ISPs. This configuration
guarantees connectivity if one ISP fails.

Company A wants to make sure that their Internet connection remains available even when one ISP connection
fails. The company has subscribed to one Internet connection each from ISP A and ISP B. The administrators
decide to use Multi-Link to guarantee High Availability of Internet connectivity.

The administrators do the following:

1) Create NetLink elements to represent connections to ISP A and ISP B.
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2) Place the ISP A and ISP B NetLinks under the correct interfaces in the Routing tree.

3) Create an Outbound Multi-Link element and add the ISP A and ISP B NetLinks to it.

4) Define the following NAT rule in the Firewall Policy so that traffic from the internal network to destinations
that are not internal is handled by the Outbound Multi-Link element:

Source Destination Service NAT

Internal Network
element

Not Internal
expression

ANY Dynamic load balancing: My Multi-Link

Example: Excluding NetLinks from handling a
QoS Class of traffic
Using Multi-Link technology and QoS classes, you can exclude VoIP traffic from a satellite connection.

Company B has three Internet connections: IPS A, ISP B, and ISP C, which is a satellite link. Because of the long
latency in satellite connections, the administrators do not want any VoIP traffic to be routed through ISP C. They
decide to use QoS classes so that VoIP traffic is only routed through ISP A and ISP B.

To do this, the administrators:

1) Create NetLink elements to represent connections to ISP A, ISP B, and ISP C.

2) Place the ISP A, ISP B, and ISP C NetLinks under the correct interfaces in the Routing view.

3) Define a QoS class and assign it to VoIP traffic.

4) Create an Outbound Multi-Link element and add the ISP A, ISP B, and ISP C NetLinks to it.

5) Select the QoS class for the ISP A NetLink and the ISP B NetLink in the Outbound Multi-Link element
properties. No QoS class is assigned to ISP C.

6) Define the following NAT rule for outbound load balancing in the Firewall Policy:

Source Destination Service NAT

ANY ANY ANY Dynamic load balancing: Multi-Link Element

Example: Balancing traffic according to link
capacity
To manage ISP connections having very different bandwidths, you configure an Outbound Multi-Link element and
select ratio load balancing.

Company B has three ISP connections that have different bandwidths:

• ISP A 20 Mbit/s



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Outbound traffic management | 752

• ISP B 10 Mbit/s
• ISP C 4 Mbit/s

The administrators want the traffic to be divided between the NetLinks according to the ratio of their relative
bandwidths. This means that ISP A handles twice as much traffic as ISP B and five times as much traffic as ISP
C. The administrators have already created and configured NetLink elements to represent each ISP connection,
so now they:

1) Combine the NetLinks for each ISP connection into an Outbound Multi-Link element and select the Ratio
load-balancing method.

2) Define the following NAT rule for outbound load balancing in the Firewall Policy:

Source Destination Service NAT

ANY ANY ANY Dynamic load balancing: Multi-Link Element

Example: Balancing traffic between Internet
connections
This scenario shows an example of using Multi-Link to balance the load of traffic between two smaller Internet
connections instead of one larger connection.

The administrator at Company B determines that a 4 megabyte Internet connection is required to handle the
volume of traffic their network receives. However, Company B is a small company on a tight budget, and the
cost of a single 4 megabyte connection is too high. The administrator decides to subscribe to one 2 megabyte
connection each from ISP A and ISP B, and use Multi-Link to balance the load of traffic between the two
connections to reduce costs.

The administrator:

1) Creates NetLink elements to represent connections to ISP A and ISP B.

2) Places the ISP A and ISP B NetLinks under the correct interfaces in the Routing tree.

3) Creates an Outbound Multi-Link element and adds the ISP A and ISP B NetLinks to it.

4) Defines the following NAT rule in the Firewall Policy so that traffic from the internal network to destinations
that are not internal is balanced by the Outbound Multi-Link element (My Multi-Link):

Source Destination Service NAT

Internal Network
element

Not Internal
expression

ANY Dynamic load balancing: My Multi-Link
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 CHAPTER 43

Inbound traffic management
Contents

• Getting started with inbound traffic management on page 753
• Defining Server Pool elements on page 757
• Install Server Pool Monitoring Agents on page 763
• Uninstall Server Pool Monitoring Agents on page 764
• Configuring Server Pool Monitoring Agents on page 765
• Enable Server Pool Monitoring Agents on page 776
• Entering Server Pool IP addresses for your DNS Server on page 777
• Create Access rules for inbound load balancing on page 778
• Configuring dynamic DNS updates for Server Pools on page 779
• Test Monitoring Agents on the command line on page 782
• Monitor Monitoring Agents on the command line on page 782
• Examples of Server Pools on page 783

Inbound traffic management ensures that services remain available even when one or more servers or NetLinks fail,
and balances the load of incoming traffic more efficiently between a group of servers. Inbound traffic management is
not supported on Layer 2 Firewalls or on layer 2 physical interfaces on Firewalls.

Getting started with inbound traffic
management

Inbound traffic on a Firewall can be managed with a Server Pool.

What inbound traffic management does
Server Pools primarily provide load balancing and High Availability for two or more servers that offer the same
service to users. Server Pools also control which NetLink incoming traffic uses. Inbound traffic management can:
• load-balance incoming traffic between several servers to even out their workload
• monitor the server’s status so that the traffic is not directed at unavailable or overloaded servers (optional

Monitoring Agents can be installed on each server)
• send dynamic DNS (DDNS) updates to a DNS server to prevent incoming traffic from attempting to use a non-

functioning NetLink in a Multi-Link configuration (with or without using the other features of Server Pools).
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Limitations
• DDNS updates have no access control, so the communications must be secured in other ways.
• Standby servers cannot be defined for a Server Pool. Only load balancing between the servers in the Server

Pool is supported.
• Only TCP and UDP protocols are supported for Server Pools.
• Source address translation is not supported for Server Pools.
• Server Pools are only supported for IPv4 traffic.

What do I need to know before I begin?
It is recommended that each Server Pool offers one type of service. If the servers provide several services (for
example, HTTP and HTTPS), create a separate Server Pool for each service.

Server Pools
 
Figure 96: How Server Pools and related elements are used together

Host elements represent your servers in the SMC. One or more Host elements are added as Server Pool
members to a Server Pool element. The Server Pool element must be used in an IPv4 Access rule in the Firewall
Policy for incoming traffic to be routed to the pool members. There can be several Server Pools for different
services. The Access rules define which traffic is directed to which pool.

The Server Pool is a built-in load balancer in the Firewall that can be used for distributing incoming traffic
between a group of servers to balance the load efficiently and to ensure that services remain available even
when a server in the pool fails. The Server Pool has a single external IP address that the clients can connect to.
The Firewall uses NAT to distribute the incoming traffic to the different servers.

The server load is distributed to the Server Pool members based on each server’s availability. Monitoring Agents
installed on each server can be used to monitor server availability and load balancing. Alternatively, the server
availability can be checked by periodically sending simple ICMP Echo Requests (ping) or by periodically sending
TCP strings to check that the expected response is returned. The ping test only checks the server’s connectivity,
the TCP test checks that specific services are available, and the Monitoring Agents provide additional information
about the server’s load and functioning.

If the tests or the Monitoring Agent report a server failure, the server is removed from the Server Pool and the
connections are distributed to the remaining servers. When a server is removed from the Server Pool, traffic from
existing connections can still be sent to the server (since in typical use scenarios the other servers would not be
able to handle them in any case) without sending new connections to the failed member. With Monitoring Agents,
the server can be completely excluded from handling traffic.

When a previously unavailable server comes back online, existing connections are not redistributed, but some of
the new connections that are opened are again directed to the server that rejoins the pool.
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Additionally, Multi-Link can be used with Server Pools to provide the connecting clients access to the Server Pool
through multiple Internet connections, increasing Server Pool availability.

Using Multi-Link with Server Pools in inbound
traffic management
If you have configured Multi-Link, it can be used to improve Server Pool availability.

You can also use Multi-Link with just one server in the Server Pool to take advantage of dynamic DNS updates.
 
Figure 97: Multi-Link configuration for a Server Pool

As an addition to the basic configuration, the NetLinks and (optionally) the External DNS Server are also
specified for the Server Pool.

When dynamic DNS updates are not used, Multi-Link is based on assigning an IP address for the Server Pool in
each NetLink. The Server Pool’s DNS entry on the external DNS server must be configured with an IP address
for each NetLink so that clients can access the servers through the different NetLinks. When the connecting client
requests the IP address for the Server Pool’s DNS name, the DNS server sends the Server Pool’s DNS entry
with the IP addresses on the different NetLinks. The client connects to one of these addresses and the Firewall
allocates the connection to one of the Server Pool members. If the first Server Pool IP address is unreachable,
the client can connect to the Server Pool’s next IP address on a different NetLink (depending on the client
application).

When dynamic DNS updates are used, the firewall updates the DNS entries automatically based on the
availability of the NetLinks. When a NetLink becomes unavailable, the Server Pool’s IP address for that link is
automatically removed from the DNS entry on the external DNS server. When the NetLink becomes available, the
IP address is again automatically added to the DNS entry.
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Related concepts
Configuring dynamic DNS updates for Server Pools on page 779

Default elements for Server Pools in inbound
traffic management
You can use Server Pools to load-balance servers without using Multi-Link for inbound traffic management.

To do this, use the special “Not specified” default NetLink element.

Inbound traffic management configuration
overview
The process of configuring inbound traffic management consists of the following overall steps.

 
Figure 98: Elements in the configuration

1) Create Host elements for all servers you want to include in the Server Pool.

2) Define a Server Pool element and define settings for inbound traffic management.

3) Make sure that the servers’ public, external IP addresses in the Server Pool properties correspond to their IP
addresses in the DNS server.

4) Update your Firewall Policy to include inbound traffic management.

5) (Optional) If you want to use Server Pool Monitoring Agents, install, configure, and enable them.

6) (Optional) If you want to send dynamic DNS (DDNS) updates to a DNS server, configure the updates.

Related concepts
Entering Server Pool IP addresses for your DNS Server on page 777
Configuring dynamic DNS updates for Server Pools on page 779
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Related tasks
Create Access rules for inbound load balancing on page 778
Install Server Pool Monitoring Agents in Windows on page 763

Defining Server Pool elements
The Server Pool element collects servers that provide a particular service into a single element and defines the
settings for handling the inbound traffic.

Create Server Pool elements
Add servers to Server Pools based on the services that the servers provide.

All servers included in the server pool are equal. It is possible for the servers in a server pool to provide more
than one service, but it is recommended to create a separate server pool element for each type of service.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Network Elements branch.

3) Right-click Traffic Handlers and select New > Server Pool.

4) Enter a unique Name for the Server Pool.

5) Click OK.

Define external addresses of server pools
Define the external address of a server pool as a property of the Server Pool element.

Clients make their incoming connections to the address of the Server Pool. The Firewall decides which server
handles the connection and translates (in a NAT operation) the public address to the private IP address of
that server. The external address or addresses of the Server Pool are defined as properties of the Server Pool
element.

Note:  Make sure that other NAT configurations do not overlap with the NAT of the Server Pool.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Select Network Elements > Traffic Handlers.

3) Right-click a Server Pool element and select Properties.

4) In the External Addresses section, click Add.

5) Select a NetLink element, or if you want to configure load sharing without traffic balancing between
NetLinks, select Not Specified.

6) From the Network drop-down list, select the Network element that is used for the Server Pool’s external
NATed address.

7) In the IP Address field, enter the external NATed destination IP address for the Server Pool.
Client computers contact this address when accessing the service that the servers in the Server Pool offer.

Note:  The IP address you enter here must be reserved for NAT and it must not be used by
any equipment in your network. Remember to update your DNS server with any changes in
IP addressing.

8) From the Status drop-down list, select Enabled.

9) (Recommended) Select Proxy ARP Entry Generation to automatically generate a proxy ARP for the
NATed address in the selected Network. Otherwise, define the ARP entry manually in the Firewall element
properties.

10) Click OK.

Add members to Server Pool elements
Add Host elements to Server Pool elements to balance traffic between the servers.

Before you begin
You must have a Host element for the internal IP address of each member of the server pool.

The Firewall uses the internal IP address of each member of the server pool to select which server handles
which traffic that arrives at the server pool’s external address. When you define a Host element, you enter the IP
address that the firewall uses to contact the server. Only Hosts with IPv4 addresses can be used in the server
pool.

The server pool can have any number of members. If you have only one server and you want to balance the
inbound traffic between your NetLinks, you can define a server pool with just one Host. This approach allows
dynamic DNS update Information to be used to prevent contacting clients from attempting to use a NetLink that is
out of service.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Network Elements branch.

3) Right-click Traffic Handlers and select New > Server Pool.

4) In the Server Pool Members section, click Add.

5) Select the elements for the members of the server pool.
• Select an existing Server element (for servers that have some special role in the SMC configuration) or

Host element (for other servers).
• Select Tools > New to create an element.

6) From the Allocate Traffic to Servers by drop-down list, select the granularity for the server selection.
The granularity defines how likely it is that traffic is redirected to a particular server. Usually it is best to
choose the least granular option that still produces an acceptable distribution of traffic. The options are (from
least granular to most granular):

Note:
Consider the type of traffic when selecting the allocation method. Connections from the same
source might be directed to different servers in the following cases:

• Using the Host setting if the host’s IP address apparent to the SMC can change.
• Using the Connection setting in all cases.

Depending on the services offered, this behavior might deteriorate service quality.

Configure server availability monitoring
There are different methods for monitoring whether a server or a service running on a server is available.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Network Elements branch and select Traffic Handlers.

3) Right-click a Server Pool element and select Properties.

4) Select the Monitoring tab.

5) In the Frequency Check field, define how often you want the availability to be checked.

6) From the Method drop-down list, select the method for monitoring the availability of the servers in the Server
Pool.
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7) (TCP or HTTP methods) Specify the additional options.
The text in the Request field is sent by the firewall in the first packet after the TCP handshake. The text
in the Response field is checked against the first data packet received from the server after the TCP
handshake.

Tip:  The response is evaluated using a begins with pattern. It is not necessary to enter
the complete text of the response.

When using TCP, if the Request and Response fields are left empty, the Firewall only checks that a
connection can be established.

For example, to check for the HTTPS service, enter 443 as the port number, but leave the Request
and Response fields empty. In this case, the firewall only checks that a connection to port 443 can be
established.

8) Click OK.

Related concepts
Install Server Pool Monitoring Agents on page 763

Related tasks
Enable Server Pool Monitoring Agents on page 776

Using Server Pool Monitoring Agents
Server Pool Monitoring Agents provide advanced features for monitoring the server load and status.

The ping monitoring relies on checking the server availability, and the TCP monitoring relies on checking the
availability of specific services. However, Monitoring Agents run on each server to check the server status and
load. The Monitoring Agents can also run system checks on the servers and send log messages to the SMC.
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Figure 99: Firewall queries Server Pool Monitoring Agents on each server

A Monitoring Agent runs as a service (port 7777/UDP by default) on the Server Pool member. The firewall
queries the Monitoring Agent on each Server Pool member to check the status and load of the server.

 
Figure 100: Server Pool Monitoring Agents provide status information

The Monitoring Agent on each Server Pool member provides information about the server load and status to the
firewall.
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Figure 101: Firewall balances connections between Server Pool members

The firewall balances the incoming connections between the Server Pool members according to the status and
load information it receives from the Monitoring Agents.

 
Figure 102: Server Pool Monitoring Agents: Test failure

The Server Pool Monitoring Agent also has a tester that is configured to run predefined tests or user-defined
programs. Automatic action can be configured based on the results of the test. When a test fails, an alert is sent
to the Firewall engines. Optionally, the agent can also take the server out of the Server Pool by changing its
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status from “OK” to “Excluded”. When a server is excluded from the Server Pool, all new connections are directed
to other available servers in the pool. The excluded server does not process any connections.

Server Pool Monitoring Agents are available for Windows and Linux platforms.

Install Server Pool Monitoring Agents
Server Pool Monitoring Agents can be installed on the Server Pool servers to monitor the availability and load of
the Server Pool members.

Server Pool Monitoring Agents are installed on the servers that form the Server Pool to report the server’s health
and load. The Firewall uses the information to send traffic to the server that can best handle the additional load
and avoid sending new connections to a server that is inoperative. The Monitoring Agent has various in-built tests
and it can also run external scripts or programs on the server to check that the server is functioning properly. You
must install the Server Pool Monitoring Agents onto all members of the Server Pool.

Install Server Pool Monitoring Agents in
Windows
Install Server Pool Monitoring Agents on all members of a Windows-based server pool. Perform this task on all
Server Pool members.

Steps

1) On the server, copy the ServerPool_Monitoring_Agent_Installer\Windows\ directory from the SMC
installation DVD to a suitable location.

2) Run the sgagent.exe self-extracting installation program.

Install Server Pool Monitoring Agents in Linux
Install Server Pool Monitoring Agents on all members of a Linux-based server pool. Perform this task on all
server pool members.

Steps

1) On the server, copy the ServerPool_Monitoring_Agent_Installer/Linux/ directory from the SMC installation
DVD to a suitable location.

2) In the terminal, change directories to the location where you copied the directory, extract the SGFWagent
package, then run the rpm command.
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For example, you can use the following commands.

cp SGFWagent.tar /var/spool/pkg
cd /var/spool/pkg
tar -xf SGFWagent.tar
rpm -i sgagent-4.0.0.build403-1.i386.rpm

The name of the .rpm file might vary, depending on the version you are using.

Install Server Pool Monitoring Agents in Solaris
Install Server Pool Monitoring Agents on all members of a Solaris-based server pool. Perform this task on all
server pool members.

Steps

1) On the server, copy the ServerPool_Monitoring_Agent_Installer/Solaris/ directory from the SMC installation
DVD to a suitable location.

2) In the terminal, change directories to the location where you copied the directory, extract the SGFWagent
package, then run the pkgadd command.
For example, you can use the following commands:

cp SGFWagent.tar /var/spool/pkg
cd /var/spool/pkg
tar -xf SGFWagent.tar
pkgadd

3) Select SGFWagent for installation.

Uninstall Server Pool Monitoring Agents
You can uninstall the Server Pool Monitoring Agents you no longer need.

Steps

1) On the server, uninstall the Monitoring Agent according to the operating system of the server.
• In Windows, in the Windows Control Panel, click Add/Remove Programs and select Monitoring Agent.

Follow the instructions to remove the Monitoring Agent.
• In Linux, run the following command: rpm -e sgagent.
• In Solaris, run the following command: pkgrm SGFWagent.
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Configuring Server Pool Monitoring
Agents

Server Pool Monitoring Agents are configured in two files. The sgagent.local.conf file is specific for each server.
The sgagent.conf file applies to all servers in the pool.

Both files are found in the following directory on each server:
• Windows: Program Files\Stonesoft\StoneGate Monitoring Agent\
• Linux: /etc/stonegate/
• Solaris: /opt/sgagent/etc/

The sgagent.local.conf file contains server-specific information, and is different for each server. If you do not want
to change the default values, there is no need to edit this file.

The sgagent.conf file contains information that refers to the entire Server Pool.

Editing sgagent.local.conf
You can edit the sgagent.local.conf file for each Server Pool member or use the default values.

The server-specific file sgagent.local.conf includes information to identify the Server Pool member if default
values are not used. If the file is not configured, the Monitoring Agent uses the system host name as the default
value to identify the member. If edited, this file must be different on each Server Pool member.

Statement Description

host host_name Specifies the host_name of the server. If no value is defined, the system host
name is used.

set alias value Defines the value of an alias that can be used as a variable in the global
sgagent.conf configuration.

For example, to configure the member of the Server Pool where sgagent.local.conf resides to use server1 as its
host name, and to set the alias hostip to 192.168.1.1:

host server1
set hostip 192.168.1.1

Editing sgagent.conf
You define attributes for the entire Server Pool in the sgagent.conf file.

The file common to all Server Pool members is called sgagent.conf. In this file, you define attributes for the
entire Server Pool. In most cases, the Server Pool members are similar in configuration and function, so the
tests performed on each member are also similar. Usually, the same sgagent.conf file is used on all servers. The
sgagent.conf file contains two sections: the statement section and the test section.
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An example sgagent.conf file

# ---------------------------START OF STATEMENT SECTION
begin host server1
config boot-delay 5:00 # set the config delay on the slow member
end
begin host not server1
config boot-delay 20 # 20s config delay on other members
end
config alert-interval 1:00:00
config startup-script /etc/scripts/startup.sh
# Monitor one minute load average and set alert threshold at 5
load-index 500 load-average-1
# ---------------------------START OF TEST SECTION
# Tests
test "webster listening"
interval 2:00
action exclude
recovery 10:00
command portlistening 80 %hostip%
# Check that this member's
# port 80 is listening.
test "server1 running baz"
interval 10:00
action exclude
host server1
script /etc/init.d/baz start
command servicerunning baz
test "external1"
interval 10:00
action alert
command external 3 700 /usr/lib/webster/test.sh 212.20.2.21

Statements in the sgagent.conf statement
section
You can define general commands for the tests the Monitoring Agents perform in the statement section.

A statement can apply to all or only some members of the Server Pool.

Table 70: Statements in the sgagent.conf statement section

Statement Description

begin host host_name If you want a statement to apply to certain Server Pool members only, the statement must
start with the begin host command followed by the name of the Server Pool member.

The begin host command can be followed by actual server names or an exclusion. In an
exclusion, begin host is followed by not and the server name, instead of just a server
name. This exclusion indicates that the setting is applied to all other servers except the one
specified.

For example, the following statement would apply to all members in the Server Pool except
server1:

begin host not server1
config settings
end
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Statement Description

config

[port port_number]

[boot-delay time]

[alert-interval time]

[alert-script path]

[startup-script path]

[overload-script
path]

[listen IP_address
[:port]

[load-index threshold

index_name

[[index-parameter]]

[load-index-action
exclude time]

Defines the option in question.

If a statement applies to all members in the Server Pool, you can enter the setting on a
single line without using begin or end.

end Ends the statement when begin is used.

Options in the sgagent.conf statement section
When you want to configure a particular setting, the syntax starts with the command config.

The available options are listed in the following table:

Table 71: Options in the sgagent.conf statement section

Option Description

port port_number Specifies the port that the Server Pool uses for communication with the engines.

All Server Pool members must use the same port number; the port setting cannot start with
the begin host command. The port number can be from 0–65535.

By default, the port is set to 7777. If you use another port instead of the default port, you
must edit the IPv4 and IPv6 Access rules to allow connections to the new port.

boot-delay time Defines how long the tester waits before starting the tests after the system has been booted
up or restarted to ensure that all necessary processes have completed their startup.

Time is entered in the format [(hh:)mm:]ss. The default is 30 seconds.

alert-interval time Defines how long the system waits before sending a new alert in response to a test failure to
prevent excessive alerts from being sent.

Time is entered in the format [(hh:)mm:]ss. The default is 1 hour.

alert-script path Specifies the path to a custom alert script.

You must use quotation marks if the path contains spaces. This is only needed when you
want to use a custom alert script. There is no default value.

startup-script path Specifies the path to the custom script to be run when the Monitoring Agent starts.

You must use quotation marks if the path contains spaces.
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Option Description

overload-script path Specifies the path to the custom script to be run if the load index exceeds the threshold
value defined with the load-index statement.

You must use quotation marks if the path contains spaces.

listen IP_address
[:port]

Specifies the IP address the Monitoring Agent listens on.

If no IP address is specified, the first IP address of the interface is used by default. If no port
is defined, the default port (7777) is used.

load-index threshold
index_name [index-
parameter]

Defines the method that is used to measure the load.

We recommend using the same method of measurement for all members of the Server Pool.
If the load measurement exceeds the defined threshold, a log message and an alert are
generated. The index_name can be a complex expression combining multiple methods
with basic arithmetic operations (+ - * /), such as "index-name + index-name".

load-index-action
exclude [time]

Excludes the server from handling traffic for the specified time (in seconds) when the
threshold value of the load-index is reached.

When the server has switched to the Excluded state, the server does not return to the
normal state until the specified length of time has elapsed, even if the load of the server has
dropped to a normal level.

Table 72: Index_name options

Option Description

processor-load time Measures the average processor load level over the specified time period.

The time is entered in the format [(hh:)mm:]ss. The returned value is a percentage value
from 0–100.

processor-kernel-load
time

Measures the average processor time spent in the kernel mode over the specified time
period.

The time is entered in the format [(hh:)mm:]ss. The returned value is a percentage value
from 0–100.

load-average- minutes Measures the average number of processes waiting in the execution queue due to reserved
resources over the specified number of minutes.

The options for the value of minutes are 1, 5, or 15. The returned value is the load average
for the specified time period multiplied by 100.

Monitoring Agent statement configuration
examples
When you add options for Monitoring Agents to the statement section of the sgagent.conf file, you can use the
following examples as a guide.

Port option example
To use port 5555 for the communication between the engines and the Server Pool members instead of the
default port:

config port 5555



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Inbound traffic management | 769

Boot-delay option example
To set a boot delay of 20 seconds on server1:

begin host server1
config boot-delay 20
end

Alert-interval option example
To set an alert interval of 1 hour on servers 1 and 2:

begin host server1 server2
config alert-interval 1:00:00
end

Alert-script option example
To run alertscript.sh every time an alert is generated:

config alert-script /etc/test/alertscript.sh

Startup-script option example
To run startup.sh when the Monitoring Agent starts on server1:

begin host server1
config startup-script /etc/test/startup.sh
end

Overload-script option example
To run overload.sh script when the threshold value of the load index is reached on server2:

begin host server2
config overload-script /etc/test/overload.sh
end

Listen option example
To make the Monitoring Agent of server2 listen to the IP address 192.168.10.31 using the default port 7777:

begin host server2
config listen 192.168.10.31
end
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Load-index option example
This example demonstrates how the measurement of load-average-5 is used on all servers except server1 to
compare against the threshold value 4. When the load-average is higher than 4, a log message is generated:

begin host not server1
config load-index 400 load-average-5
end

Because server1 is ignored in the previous statement, it would typically have its own statement with different
options, such as the following statement:

begin host server1
config load-index 400 load-average-1
end

Load-index-action option example
To set the server status to Excluded when the threshold value of the load index is reached on server2:

begin host server2
config load-index-action exclude 10
end

Parameters in the sgagent.conf test section
You can use the parameters described in the following table to configure internal and external tests for Monitoring
Agents.

The second part of the sgagent.conf file specifies which tests the Monitoring Agents carry out on the servers they
monitor. A test begins with the test definition, followed by optional parameter lines, and ends with the command
definition. The test and command parameters are always required. The interval, action, host, script,
and recovery parameters are optional and have their default values if not specified for the test.

Parameters in the sgagent.conf test section
Parameter Description

test name Begins the test definition. Specifies the name of the test.
The name appears in the logs and alerts in the event of a failure. It should be descriptive to
give the administrators enough information about what has happened. The test name can be
any string. You must use quotation marks if the name contains spaces.

This parameter is required and has no default value.

interval time Defines how often the test is executed.
Time is entered in the format [(hh:)mm:]ss. The minimum interval is 3 seconds and the
maximum is 1 day. If no interval is defined, the default is 60 seconds.

action alert|exclude Defines what to do if the test fails.

• alert creates an alert entry and runs the alert script if one is defined for the test.

• exclude sets the server status to Excluded and creates an alert. No new connections
are directed to the excluded server and the current connections are moved to the other
members of the Server Pool.

• If no action is set for the test, alert is the default action.
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Parameter Description

host server Defines the server to be tested. If the name of the server is specified in the host field of
sgagent.local.conf, that name must be used here. Otherwise, the default host name of the
server must be used.
You can also list multiple server names, separated by spaces.

If no specific server is defined, the test is performed on all Server Pool members by default.

script [always|
repeat] path

Specifies how many times the script is executed after the test fails, and the path to the script
file. You must use quotation marks if the path contains spaces.
There are two options for how many times to execute the script after the test fails:

• repeat defines the number of failures after which the script is no longer run. The counter
is reset each time the server status changes, or the test succeeds.

• always runs the script without restrictions on the number of failures.

If no argument is given, the script is run only after the first failure by default.

recovery always|time Determines how long the tester reruns a failed test to see if it succeeds on the next attempt.
There are two options for specifying the time period:

• always : There are no time limits on how long the tester waits for the test to succeed
again. The server state is changed from Excluded to OK when the test succeeds.

• time : If the test succeeds in the defined time period after a failure, the server state is
changed from Excluded to OK. Time is entered in the format [(hh:)mm:]ss.

If no recovery options are specified, the test is never rerun after a failure, and the server
state remains Excluded.

command external|
test_expression
[ retry ]
[ timeout ] [ path ]
[ parameters ]

Specifies which test script to use, and the options for running the test. This parameter is
required and has no default value.
There are two options for specifying the test script:

• external : Indicates that an external test is used. External tests can be created by
combining predefined tests with AND, OR, and NOT operators, or you can write your
own script. External tests must return an exit code of 0 (zero) to indicate success. Any
non-zero return value is interpreted as a failure.

• test_expression : Specifies the internal test to run. For more information about the
internal tests, see Internal tests for Monitoring Agents.

The other options are used as follows:

• retry : Specifies how many times the script is run before the test is considered failed.

• timeout : Specifies how long (in milliseconds) the tester waits for the test result.

• path : Specifies the path to the external test script. You must use quotation marks if the
path contains spaces. The path is required for external tests, and is not used for internal
tests.

• parameters : Specifies any possible parameters that a specific test might need.

Related concepts
Editing sgagent.local.conf on page 765

Related reference
Internal tests for Monitoring Agents on page 772
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Monitoring Agent test configuration examples
When adding internal or external tests for Monitoring Agents to the sgagent.conf file, you can use the following
examples as a guide.

Internal Test Example
In this example, the test checks that server1 is listening to traffic on port 80. In this example, the port information
and the IP address of the server are required in the command definition. The test is performed every two minutes,
and if there is a failure, the server is excluded from the Server Pool. If the test fails, the /etc/init.d/port
start script is run. If the subsequent tests succeed within 10 minutes of the failure, recovery occurs and the
server returns to the OK state:

test “port listening test”
interval 2:00
action exclude
host server1
script /etc/init.d/port start
recovery 10:00
command portlistening 80 192.168.1.1

External Test Example
In this example, the external test script test.sh is run. There are three attempts to run the test before it is
considered failed, and the tester waits for one second before the test is timed out. The test is run every 10
minutes, and if there is a failure an alert is generated:

test “multiple_services”
interval 10:00
action alert
command external 3 1000 /usr/lib/server/test.sh 192.168.1.1

Internal tests for Monitoring Agents
You can add the internal tests for Monitoring Agents described in the following table to the test section of the
sgagent.conf file.

All internal tests available for the Server Pool monitoring are listed in the following table.

Note:  Some of the internal tests might not work on virtualization platforms.

Table 73: Internal tests

Test Description

swapfree limit Checks the available swap space.
If the current amount of free swap space drops below the limit (given in kilobytes), the test
fails.

processcount count Checks how many processes are currently running.
If the number of processes exceeds the count, the test fails.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Inbound traffic management | 773

Test Description

multi-ping retry
timeout

ip_address

[ip_address [...]]

Sends ICMP Echo Request messages to the defined IP addresses and waits for the replies.

The test fails if none of the IP addresses answers the ping query.

• retry specifies how many ICMP Echo Request packets are sent to each IP address.

• timeout defines how long (in milliseconds) the tester waits for the reply.

filesystem partition
free_space

Checks whether there is enough space left on a particular partition.

The test fails if the amount of free_space (in kilobytes) is lower than the free space on the
partition. You can also identify the partition by its path.

File system tests are quite taxing on the operating system. We recommend that you set an
interval of at least 15 minutes when using this test.

servicerunning
service_name

Checks whether the specified service is running on the server.

The test fails if the specified service or process is not running. On Windows platforms, the
test checks whether the service called service_name is running. In UNIX environments, the
test checks whether the process named service_name is running.

ip-listening
ip_address

Checks whether the specified ip_address is listening on the server.

The test fails if the host does not have the specified IP address.

portlistening port
[ip_address
[protocol]]

Checks whether the specified port is listening on the server.

The test fails if the port is not in the listen state. You can optionally specify the ip_address at
which to check for the port. The protocol can be TCP or UDP.

portanswer retry
timeout

query

response

port

[ip_address]

Checks whether the TCP port answers a TCP query with the expected response.

The test fails if the port does not answer, or the answer differs from the expected response.

• retry specifies how many attempts are made before the test is considered failed.

• timeout specifies how long the tester waits after sending a query to the port. The timeout
is entered in milliseconds. If no response is received within the time period, the test fails.

• query specifies the TCP query to send. You must use quotation marks if the query
contains spaces. If no query parameter is specified, nothing is sent to the port.

• response specifies the expected response to the TCP query. You must use quotation
marks if the response contains spaces.

• port specifies the port to which the query is sent.

• ip_address is the IP address to which the query is sent.

httpanswer retry
timeout

URL

file

port

[ip_address]

Checks whether the server answers an HTTP request for the specified URL with the
expected file.

The test fails if the server does not answer the HTTP request or if the reply does not contain
the contents of the specified file.

• port specifies the port to which the request is sent.

• retry specifies how many attempts are made before the test is considered failed.

• timeout specifies how long the tester waits after sending a query to the port. The timeout
is entered in milliseconds. If no response is received within the time period, the test fails.

• ip_address is the IP address to which the request is sent. If no address is specified, the
tester sends the query to the localhost address by default.

networkinterface-up
interface

Checks that the specified interface is up.

The test fails if the specified network interface does not exist or is down. In Windows, this
test behaves similarly to the networkinterface-linkstatus test described next.
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Test Description

networkinterface-
linkstatus interface

Checks the link-layer status of the specified interface.

The test fails if the specified network interface is not linked.

file-exists path Checks whether a file exists on the server.

The test fails if the file is not found at the specified path.

Monitoring Agent internal test examples
When you add internal tests for Monitoring Agents to the sgagent.conf file, you can use the following examples as
a guide.

Each test has an example configuration, which might differ from what you configure for your own environment.

swapfree
This example checks that there is at least 1500 kilobytes of free space on server 2. The test runs at one-hour
intervals and sends an alert if the test fails.

test “swapfree test”
interval 1:00:00
host server2
action alert
command swapfree 1500

process_count
This example checks that there are a maximum of 2500 processes running on server2. The test runs at 60-
second intervals and sends an alert if the test fails:

test process_count
interval 60
host server2
action alert
command prosesscount 2500

multi-ping
This example tests the connectivity of server2. The tester sends three ICMP Echo requests to the IP addresses
192.168.1.2 and 192.168.1.254, and waits 1000 milliseconds for a reply. The test runs at 30-second intervals. If
the test fails, server2 is excluded from the Server Pool.

test “multi-ping test”
interval 30
host server2
action exclude
command multi-ping 3 1000 192.168.1.2 192.168.1.254
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filesystem
This example checks that there is at least 1000 kilobytes of free space in the /var/tmp partition on server2. The
test runs at 15-second intervals and sends an alert if the test fails.

test “free space in filesystem”
interval 15
host server2
action alert
command filesystem /var/tmp 1000

servicerunning
This example checks that the ntpd service is running. The test runs at 15-second intervals. If the test fails, the
ntpd start script is run. If the test succeeds again within one minute of failing, recovery occurs and the server is
returned to the OK state. Otherwise, the server is excluded from the Server Pool.

test “is ntp running -test”
interval 15
script /etc/init.d/ntpd start
action exclude
recovery 1:00
command servicerunning ntpd

ip-listening
This example checks that server2 is listening at the IP address 192.168.1.1. The test runs at 30-second intervals,
and the server is excluded from the Server Pool if the test fails.

test ip-listening
interval 30
host server2
action exclude
command iplistening 192.168.1.1

port-listening
This example checks that server2 and server3 are listening on port 80. The test runs at 30-second intervals, and
the server is excluded from the Server Pool if the test fails.

test port-listening
interval 30
host server2 server3
action exclude
command portlistening 80

httpanswer
This example checks that the server sends the contents of the file /web/file.html as a part of its response to a
URL request for http://www.example.com/index.html on port 80. The request is attempted four times, and the
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tester waits 3500 milliseconds for a response before retrying. The test runs at 30-second intervals, and the server
is excluded from the Server Pool if the test fails.

test http_answering
interval 30
action exclude
command httpanswer 4 3500 /www.example.com/index.html /web/file.html 80

networkinterface-up
This example checks that the eth0 interface is up. The test runs at 45-second intervals, and an alert is sent if the
test fails.

test etc0_up
interval 45
action alert
command networkinterface-up eth0

networkinterface-linkstatus
This example checks that the eth0 interface is linked. The test runs at 45-second intervals, and an alert is sent if
the test fails.

test “link status on eth0”
interval 45
action alert
command networkinterface-linkstatus eth0

file-exists
This example checks that the /important/index.html file exists. The test runs at 2-minute intervals, and an alert is
sent if the test fails.

test “index -file exists”
interval 2:00
action alert
command file-exists /important/index.html

Related reference
Parameters in the sgagent.conf test section on page 770

Enable Server Pool Monitoring Agents
Enable Server Pool Monitoring Agents for one Server Pool element.

Note:  Do not enable the Monitoring Agents before you configure them.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Network Elements > Traffic Handlers.

3) Right-click the Server Pool element for which you want to enable the Monitoring Agents and select
Properties.

4) Click the Monitoring tab, then select Agent as the Method.

5) In the Frequency Check field, define how often the status is checked.

6) (Optional) Enter the Port if you want to use a port other than the default port (7777).

Note:  Remember to edit the corresponding IPv4 and IPv6 Access rules to allow connections
to the new port.

7) Click OK.

Related concepts
Configuring Server Pool Monitoring Agents on page 765

Entering Server Pool IP addresses for
your DNS Server

When using static DNS entries (recommended), you must make sure that the IP addresses for your Server Pool
are properly entered into your DNS server’s records.

The Server Pool has one IP address per NetLink (Internet connection) in a Multi-Link configuration and a single
IP address in a single-link configuration. If you decide to use dynamic DNS updates, you must configure the DNS
server to accept the DDNS updates from the firewall. If the servers have multiple IP addresses, make sure the IP
addresses are all defined on the DNS server to ensure operation as intended.

See the documentation of your DNS server software for instructions on how to enter the IP addresses.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Inbound traffic management | 778

Create Access rules for inbound load
balancing

You can apply Server Pool load balancing to the firewall configuration by adding the Server Pool to an IPv4
Access rule in the Firewall Policy.

When the rule matches traffic, the Server Pool uses NAT to change the destination IP address to the IP address
of the server that the firewall selects for the connection. Reverse NAT (for the replies the server sends back to
the client) is handled automatically. No separate NAT rule is required.

The IPv4 Access rules specify which traffic is directed to the Server Pool.

Note the following:
• The Server Pool does automatic NAT from the external addresses you configured in the Server Pool element

to the addresses of the included servers. Make sure that there are no overlapping NAT rules in the policy. You
can add a NAT rule that disables further NAT for matching connections (empty NAT cell), if necessary.

• If you want to balance traffic that arrives through a VPN using a Server Pool, NAT must be enabled in the
properties of the VPN element (NAT is disabled by default for traffic that uses a VPN).

• You must create a separate rule for each Server Pool.
• If the same Server Pool provides more than one service, you must create a separate rule for each Service.
• You must enable Connection Tracking for the rule that directs traffic to the Server Pool. The Server Pool uses

NAT, which does not work without Connection Tracking.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the Firewall Policy for editing and add an IPv4 Access rule.

2) Configure the rule to match the Source, Destination, and Service of the traffic you want to direct to the
Server Pool.

Note:  Each rule must contain only one Service.

3) Set the Action to Allow and enable Connection Tracking in the Action Options.
The following example rules direct traffic from outside networks to the HTTP Server Pool and to the HTTPS
Server Pool.

Source Destination Service Action

NOT internal
Expression

HTTP Server Pool HTTP Allow Connection tracking: normal

NOT internal
Expression

HTTPS Server Pool HTTPS Allow Connection tracking: normal

4) If you are using static DNS entries, save and Install the Firewall Policy to transfer the changes.

Related tasks
Add rules allowing dynamic DNS updates on page 781
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Configuring dynamic DNS updates for
Server Pools

The Firewall can automatically update dynamic DNS (DDNS) entries for the Server Pool according to the
available NetLinks.

The firewall engine removes the Server Pool IP addresses for NetLinks that are not available from the DNS
entry, and adds the IP addresses back when the NetLink becomes available again. When the connecting client
requests the Server Pool’s IP address from the DNS server, the client receives a list of IP addresses that only
contains IP addresses that work.

Firewalls support the Dynamic DNS protocol and can send DDNS updates to a specified DNS server. If a network
connection specified by a NetLink element fails, the dynamic DNS updates notify the DNS, which then removes
the corresponding IP address from its records.

To configure DDNS updates, you must have already defined the necessary NetLinks and the Server Pool
element. To use DDNS updates, you must set up a DDNS-capable DNS server in your network. The DNS server
must be configured as the primary DNS server for the domain.

Note:  Using dynamic DNS updates is a security risk.

Related concepts
Improving dynamic DNS security on page 780

Dynamic DNS configuration overview
To minimize any security risk, follow these overall steps when configuring DDNS.

1) Implementing DDNS can be a security risk. Read about the security risks involved before proceeding with
the configuration.

2) To enable monitoring of the status of your NetLinks, you must add probe IP addresses in the NetLinks’
properties.

3) Define the External DNS Server element.

4) Edit the Server Pool element to include information about how the DNS server is updated.

5) Edit the active policy to allow DDNS updates.

Related tasks
Create NetLink elements for Multi-Link configuration on page 715



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Inbound traffic management | 780

Improving dynamic DNS security
You can improve the security of dynamic DNS updates.

CAUTION:  Although Firewalls support dynamic DNS updates, the protocol itself poses a security
risk because there is no access control. If you must use dynamic DNS updates, do so only after
careful research, planning, and testing.

There are actions you can take to improve the security of dynamic DNS updates:
• Always place the DNS servers behind the Firewall for protection from IP address spoofing.
• Use BIND or an equivalent DNS server that allows you to define which hosts are allowed to send dynamic

updates.
• Consider using static DNS entries instead, as DDNS is not necessarily needed with inbound load balancing.

In that case, the DNS entries are not removed automatically from the DNS server if an ISP fails, but you can
sometimes solve these problems by other means. For example, some web browsers can automatically try
other IP addresses if one address does not respond.

Define External DNS Server elements
There are some cases in which you must define an External DNS Server element.

• (Firewalls only) For dynamic DNS (DDNS) updates with a Multi-Link configuration.
• (Firewalls only) If you want to use a DNS server for resolving malware signature mirrors.
• If you want to use a DNS server for resolving domain names and URL filtering categorization services on

Firewalls, IPS engines, and Layer 2 Firewalls.

You can also optionally use External DNS Server elements to specify the DNS servers to which the firewall
forwards DNS requests when you configure DNS relay.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Network Elements branch.

3) Right-click Servers and select New > External DNS Server.

4) Enter a unique Name and IP address for the server.

5) Enter a Time to Live (TTL) interval in seconds. It defines how long a DNS entry can be cached before
querying the DNS server again.
The default is 1 second.

6) Enter an Update Interval in seconds. It defines how often the DNS entries can be updated to the DNS
server if the link status changes constantly.
The default is 10 seconds.
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7) (Optional) If the device has additional IP addresses, you can enter them as Secondary IP Addresses
instead of creating additional elements. However, secondary IP addresses are only used in the Source and
Destination cells in rules. They are ignored otherwise.

8) Click OK.

Define the dynamic DNS update information
You must define the settings for the Dynamic DNS updates sent from your Firewall to the DNS server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Network Elements > Traffic Handlers.

3) Right-click the Server Pool and select Properties.

4) Select Enable Dynamic DNS Updates.

5) Select the DNS Server element to which the DDNS updates are sent.

6) Enter the Fully Qualified Domain Name for the Server Pool service.
Example: www.example.com

7) Click OK.

Add rules allowing dynamic DNS updates
You might need to add a rule that allows the Dynamic DNS updates from your Firewall to the specified DNS
server.

In addition to creating a rule for inbound load balancing, you might also need to add a rule allowing the Dynamic
DNS updates from your Firewall to the specified DNS server.

The Firewall Template allows this traffic by default. If your policy is based on an unmodified Firewall Template,
there is no need to add a rule that allows Dynamic DNS updates.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Firewall Policy and select Edit.
The policy opens for editing.

2) Add the following Access rule:
• Source: the address (toward the DNS server) of the Firewall or NDIs of all nodes in the Firewall Cluster
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• Destination: the DNS server
• Service: the DNS Service Group
• Action: Allow

3) Save and install the policy.

Related tasks
Create Access rules for inbound load balancing on page 778

Test Monitoring Agents on the command
line

You can test the Server Pool Monitoring Agents on the command line.

The monitoring tool allows you to query the agents locally or remotely to check their status.

Steps

1) On the command line, browse to the folder where the Monitoring Agent is installed.

2) Run one of the following commands:
• Linux: sgagentd -d test [file_name]
• Windows: agent test [file_name]

Where file_name is a configuration you want to test. Giving the file name is optional, but if you omit the file
name, the test is run with the active configuration.

Related reference
Server Pool Monitoring Agent commands on page 1428

Monitor Monitoring Agents on the
command line

You can monitor the Server Pool Monitoring Agents on the command line.

Steps

1) On the command line, browse to the folder where the Monitoring Agent monitoring tool is installed:

• In Windows, the program is installed in the folder where the Monitoring Agent itself is installed.
• On Linux and Solaris, the program is installed in usr/bin.
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2) (Optional) Copy the sgmon program to a remote host that you want to use for testing the Monitoring Agents.

3) Run the command sgmon -h to see usage instructions, then run your monitoring commands according to
the syntax displayed.
The host argument is mandatory. To get the status locally on the server where the Monitoring Agent is
installed, use localhost as the host argument.

Examples of Server Pools
Using Server Pools, you can manage incoming traffic to your web servers.

Example: Load balancing for web servers
To configure and monitor load balancing for multiple web servers, you can set up a Server Pool and install
Monitoring Agents on the individual servers.

Company A has three web servers to handle the large volume of traffic its website receives. The administrators
have already created Host elements to represent their web servers and created NAT rules to assign an external
address to each web server.

Now the administrators want to distribute the load of the traffic between the servers. The administrators also want
to monitor the status and the load of the servers, and receive an alert whenever one of the web servers in the
Server Pool fails. The administrators decide to set up a Server Pool and install Monitoring Agents on the web
servers. The administrators:

1) Delete the existing NAT rules that translate the IP address of each server so that the Server Pool can do
automatic NAT without conflicts.

2) Create a Server Pool element and add the Host elements to it. Because they are not balancing incoming
connections to the Server Pool between multiple Internet connections, the administrators select the Not
Specified NetLink.

3) Install a Server Pool Monitoring Agent on each server in the Server Pool and configure the Monitoring
Agents to measure the load average on the server. They also set up a test that checks each server’s
connectivity every 60 seconds and sends an alert if the test fails.

4) Enable the Server Pool Monitoring Agents in the Server Pool element.

5) Add the following IPv4 Access rules in the Firewall policy to allow HTTP connections from addresses that are
not internal (Not Internal expression) to the Server Pool.

Source Destination Service Action

Not Internal
expression

Server Pool
element

HTTP Allow
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Example: Setting up Multi-Link and dynamic
DNS updates
You set up dynamic DNS updates, so that Server Pool NetLink addresses, which correspond to the available
Internet connections, are updated automatically on the DNS server.

The administrators at Company A have already configured a Server Pool (see the previous example). Now they
want to make sure that web services remain available even when an Internet connection fails. They also want the
Server Pool’s NetLink addresses to be automatically updated on the DNS server based on the availability of the
Internet connections.

The administrators have already configured Multi-Link routing with the necessary NetLink elements to represent
each of their Internet connections. A DNS server has also already been set up in the network. The administrators
decide to add the NetLinks to the Server Pool and set up Dynamic DNS (DDNS) updates.

The administrators do the following:

1) Configure the DNS server to accept DDNS updates from the firewall.

2) Edit the NetLink elements to add probe IP addresses for testing the NetLinks’ status.

3) Edit the Server Pool element’s properties and replace the default Not Specified NetLink with the NetLink
elements that represent their Internet connections.

4) Define an External DNS Server element to represent the DDNS-capable server in the SMC.

5) Enable dynamic DNS updates and configure the dynamic DNS settings in the Server Pool element’s
properties.
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 PART IX
Traffic inspection policies

Contents

• Creating and managing policy elements on page 787
• Ethernet rules on page 811
• Access rules on page 817
• NAT rules on page 835
• Inspection Policy elements on page 847
• Editing policies on page 855
• Defining IP addresses on page 895
• Working with Service elements on page 903
• Defining Situation elements on page 917
• Using Network Application elements on page 937
• Defining User Response elements on page 945
• Quality of Service on page 949
• File filtering on page 965
• Integrating Endpoint Context Agent on page 981
• Filtering URLs on page 989
• Anti-malware scanning on page 1003
• Protocol Agents on engines on page 1005
• Sidewinder Proxies on page 1017
• Setting up TLS inspection on page 1037
• Redirecting traffic to a proxy service for external inspection on page 1059
• Blacklisting IP addresses on page 1065

Policies are key elements that contain rules for allowing or blocking network traffic and inspecting the content of traffic.
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 CHAPTER 44

Creating and managing policy
elements

Contents

• Getting started with policies on page 787
• Create template policies or policies on page 796
• How sub-policies work on page 798
• Install policies on page 800
• Using policy elements and rules on page 804
• Deleting policies templates or sub-policies on page 806
• Firewall Policy elements examples on page 807
• IPS Policy example on page 809

Policy elements are containers for the rules that determine how NGFW Engines, Master NGFW Engines, and Virtual
NGFW Engines examine traffic. The policy elements for the engines include Template Policies, Policies, and Sub-
Policies.

Getting started with policies
Policies organize traffic processing rules hierarchically, to make administration easier and to optimize traffic
inspection performance.

What policy elements do
• Firewall, IPS, and Layer 2 Firewall Policies contain the rules according to which the NGFW Engines allow or

block traffic.
• Layer 2 Interface Policies contain rules according to which NGFW Engines in the Firewall/VPN role allow or

block traffic detected by Capture Interfaces, Inline IPS Interfaces, and Inline Layer 2 Firewall Interfaces on
NGFW Engines in the Firewall/VPN role.

• The same policy can be shared by several NGFW Engines that have the same role, several Master NGFW
Engines, and several Virtual NGFW Engines that have the same role.

• Inspection Policies contain the rules according to which the NGFW Engines inspect traffic. The same
Inspection Policy can be shared by several Firewall Policies, IPS Policies, and Layer 2 Firewall Policies.

Note:  Inspection Policies are not supported in Layer 2 Interface Policies.

• Each policy must always be based on a Template Policy. Template Policies contain rules that are inherited
into any template or policy below it in the policy hierarchy.
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• You can also insert Sub-Policies in your policies. A Sub-Policy is a set of IPv4 or IPv6 Access rules that
can be matched conditionally to a restricted part of the traffic. Using Sub-Policies can improve processing
performance. Sub-Policies can also enforce administrative boundaries.

• Policies can share Policy Templates and Sub-Policies. In shared rules, Alias elements can represent IP
addresses that depend on the environment, so that the actual values are defined separately for each
component.

What do I need to know before I begin?
• Master NGFW Engines always use Firewall Policies, regardless of the role of the Virtual NGFW Engines they

host.
• Virtual Firewalls use Firewall Policies.
• Virtual IPS engines use IPS Policies.
• Virtual Layer 2 Firewalls use Layer 2 Firewall Policies.

Default policy elements
Predefined Policies, Template Policies, and Inspection Policies provide an easy starting point for determining
what kinds of rules your system needs.

Four kinds of policy elements are used in the policy configuration for NGFW Engines, Master NGFW Engines,
and Virtual NGFW Engines:
• A Template Policy is a policy that can be used as the basis for Policy or other Template Policy elements. The

rules in the Template Policy are copied as inherited rules into the Policies and Template Policies that are
based on the Template Policy. You can edit the inherited rules only by editing the original Template Policy
from which the rules were inherited.

• An Inspection Policy element is a set of Inspection rules that are referenced from the Inspection tab of Policy
and Template Policy elements. You can use the same Inspection Policy in multiple Policy and Template Policy
elements.

• A Sub-Policy element is a section of IPv4 Access rules that you can insert into Policies and Template Policies.
The rules in the sub-policy are conditional rules that allow you to define matching criteria that determines
whether the sub-policy applies to a connection. You can edit the rules by editing the sub-policy where the
rules belong.

• A Policy element gathers together all rules from the different policy elements. Policies include the rules added
directly to the Firewall, IPS, or Layer 2 Firewall Policy, the rules from the higher-level Template Policy, and
possibly rules from one or more sub-policies. For example, an IPS Policy is always based on an IPS Template
Policy element, and a Layer 2 Firewall Policy is always based on a Layer 2 Firewall Template Policy element.

The hierarchy of how rules are inherited between the main policy elements is shown in the following illustration.
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Figure 103: Rule inheritance (without Inspection rules inherited from Inspection Policies)

In this illustration, Template Policy A is the basis for Template Policy B, so Template Policy B contains all rules
defined in Template Policy A.

Template Policy B also contains all rules in a Sub-Policy, as well as rules defined directly in Template Policy B.

The example Policy inherits the following rules:

• All rules in Template Policy A.
• All rules in Template Policy B.
• All rules in the Sub-Policy.

In addition to the inherited rules, the example policy also contains any rules that the administrators add to it
directly. In the policy, the administrators can only edit the rules that were added directly to the policy. To change
rules inherited from Template Policy A, Template Policy B, or the Sub-Policy, they must edit the policy in which
the rules were originally defined.

A hierarchy such as the one outlined here is useful to:
• Reduce the need for creating the same or similar rule in several policies. For example, any rule added to

Template Policy A is also added to any policy created based on that template. The next time the policies
based on Template Policy A are installed on the engines, the new rule is used on all those engines. There is
no need to edit each individual policy separately.

• Restrict the editing rights of administrators. For example, administrators who are granted rights to only policies
cannot edit the rules defined in the Template Policies on which the policies are based. Their actions have no
effect on rules that are placed above the row where the Template Policy allows them to insert new rules. In the
hierarchy shown in the illustration, the insert points for the Policy are defined in Template Policy B. Template B
can be edited only in the place where there is an insert point in Template Policy A.

• Reduce the likelihood of mistakes affecting important communications. Template Policies can be reserved
for defining only the rules for essential communications, so that most daily editing is done in the lower-level
policies. If the Template Policy is properly designed, rules in the lower-level policy cannot override the rules in
the Template Policy. Good organization also makes it easier to read policies, and reduces the risk of errors.

• Improve processing performance. Using sub-policies, whole blocks of rules can be skipped during processing
when a connection does not match the rule that directs the traffic processing to the sub-policy. Using sub-
policies reduces the processor load, which can lead to better throughput if the processor load is constantly
high.

The default policy elements are introduced into the SMC when you import and activate a recent dynamic update
package (for example, during the installation). The elements might change when you install newer update
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packages. None of the default policy elements can be changed. However, you can make copies of the default
policies if you have to create a changed version.

Table 74: Default policy elements for NGFW Engines

Element type Default name Description

Firewall
Template

A Template Policy that contains the predefined Access rules necessary for the
firewall to communicate with the SMC and some external components.

The Firewall Template Policy uses Inspection rules from the No Inspection
Policy. The rules in the No Inspection Policy do not enforce inspection.

Firewall
Template
Policy

Firewall
Inspection
Template

Firewall Template Policy that uses Inspection rules from the High-Security
Inspection Template.

Firewall Sub-
policy

DHCP Relay A Sub-Policy containing rules that allow the firewall to relay DHCP requests
from a host in one internal network to a DHCP server in a different network, as
well as DHCP requests from VPN clients to an internal DHCP server.

High-Security
IPS Template

IPS Template Policy that uses Inspection rules from the High-Security
Inspection Template.

A Template Policy containing the predefined Access rules necessary for the
IPS engine to communicate with the SMC and some external components.

The High-Security IPS Template Policy provides an easy starting point for
determining what kinds of rules your system needs.

IPS Template
Policy

Medium-
Security IPS
Template

IPS Template Policy that uses Inspection rules from the Medium-Security
Inspection Policy.

Customized
High-Security
Inspection
IPS Policy

Example of a customized IPS Policy that uses Inspection rules from the
Customized High-Security Inspection Template. Used in testing IPS at ICSA
Labs and NSS Labs.

IPS Policy

Default IPS
Policy

Basic IPS Policy that uses Inspection rules from the High-Security Inspection
Template. Can be used as a starting point for creating a customized IPS Policy.

The Default IPS Policy does not add any rules to the rules defined in the IPS
Template. It allows you to install the predefined rules in the IPS Template on
the IPS engine right after installation. (Template Policies cannot be installed on
the engines.)

Layer 2
Firewall
Template

A Template Policy that contains the predefined Access rules necessary for the
Layer 2 Firewall to communicate with the SMC and some external components.

The Layer 2 Firewall Template uses Inspection rules from the No Inspection
Policy. The rules in the No Inspection Policy do not enforce inspection.

Layer 2
Firewall
Template
Policy

Layer 2
Firewall
Inspection
Template

A Template Policy that is based on the Layer 2 Firewall Template.

The Layer 2 Firewall Inspection Template uses Inspection rules from the
High-Security Inspection Template. The Layer 2 Firewall Inspection Template
enables deep inspection for all traffic.

Layer 2
Interface
Policy

Layer 2
Interface
Template

A Template Policy that contains rules for traffic detected by Capture Interfaces,
Inline IPS Interfaces, and Inline Layer 2 Firewall Interfaces on firewalls.
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Element type Default name Description

No Inspection
Policy

Suitable for Firewall deployments, in which only packet filtering is needed.
Disables deep packet inspection.

Medium-
Security
Inspection
Template

For Firewalls, Layer 2 Firewalls, inline IPS deployments in asymmetrically
routed networks, and IPS deployments in IDS mode. Terminates reliably
identified attacks and logs Situations that have some degree of inaccuracy.
Low risk of false positives.

High-Security
Inspection
Template

For Firewall, Layer 2 Firewall, and inline IPS use. Extended inspection
coverage and evasion protection. Not for asymmetrically routed networks.
Terminates reliably identified attacks, and Situations that have some
inaccuracy. Moderate false positive risk.

Inspection
Policy

Customized
High-Security
Inspection
Policy

This policy is an example of a highly customized Inspection Policy for network
environments in which unconditional inspection coverage and evasion
protection are required. The risk of false positives is high in production use.

You can add new Template Policies without basing them on any existing Template Policy.

However, in most cases we recommend using the IPS Template as the starting point for your customized IPS
Template Policies and IPS Policies. We recommend using the Layer 2 Firewall Template as the starting point for
your customized Layer 2 Firewall Template Policies and Layer 2 Firewall Policies.

Situations are the central elements in the Inspection rules of your Inspection Policies. The Situation elements
detect exploit attempts against known vulnerabilities and other commonly known security threats. Dynamic
updates include new and updated Situations. New patterns in traffic might begin to match when a new dynamic
update is activated and you refresh the Inspection Policy.

In most environments, we recommend using the High-Security Inspection Policy as the starting point for
Inspection Policies. The High-Security Inspection Policy provides extended inspection coverage. It also protects
the network against evasions, which are attempts to disguise attacks to avoid detection and blocking by network
security systems. The only difference between the rules in the High-Security Inspection Policy and the Medium-
Security Inspection Policy is in the way the Inspection rules handle Situations that are categorized as Suspected
Attacks. The High-Security Inspection Policy terminates Suspected Attacks with an alert, whereas the Medium-
Security Inspection Policy only logs Suspected Attacks.

Situations that belong to the Suspected Attacks category contain basic fingerprints. Suspected Attacks also
contain traffic patterns that might indicate malicious activities but are not any verified attack patterns. Suspected
Attacks can detect zero-day attacks (attacks that are not yet publicly known), but can sometimes block some
legitimate traffic if the traffic pattern resembles malicious activities.

Policy hierarchies
The policy structure is a hierarchy based on templates.

The structure allows you to:

• Reuse rules without duplicating them.
• Assign and enforce editing rights of different parts of a single policy to different administrators.
• Reduce the resource consumption of the engines.
• Make policies easier to read.

The template and policy hierarchy is flattened when the Policy is transferred to the engines. The policy looks the
same to the engines regardless of how it is organized on the Management Server (as long as the rules are in
the same order). You can also create sections of conditional IPv4 Access rules that you can insert into the other
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policy elements. The engine can skip the processing of a conditional block of rules based on whether certain
common matching criteria is found in the packet being examined.

If your environment is simple and you do not need the benefits outlined here, you can create a simple policy
hierarchy. You can, for example, start with one Firewall Policy built on the provided Firewall Template. The same
Firewall Policy can be used on more than one engine. Likewise, you can use the same IPS Policy on any number
of IPS engines and Virtual IPS engines, and the same Layer 2 Firewall Policy on any number of Layer 2 Firewalls
and Virtual Layer 2 Firewalls.

How NGFW Engines examine traffic
NGFW Engines check the validity of packets, then process only the valid packets.

Firewalls, Master NGFW Engines, or Virtual Firewalls pass through only traffic that is explicitly allowed in the
Firewall Policy. All other traffic is discarded. All connections are handled in the same way, including connections
that the NGFW Engine itself opens, and the management connections that the NGFW Engine is intended to
receive.

On Firewall Clusters and clustered Master NGFW Engines, the load-balancing filter first determines which node
in the cluster actually processes the received packet. The processing then begins on the selected node.

NGFW Engines check new connections against the policy, rule by rule. The header on each packet arriving on
an interface is examined for the source and destination IP address, and protocol-related information, such as the
port. The authentication status of the user attempting a connection and the current date and time can also be
included as parameters in the examination process.

An IPS engine or Layer 2 Firewall matches traffic to different protocols and then checks the definitions for known
vulnerabilities and other threats for that protocol. The protocol is assigned first, before the deep inspection.
An NGFW Engine in inline mode can also filter traffic based on protocols, IP addresses, and the interface that
received the traffic without analyzing the traffic for threat patterns. IPS engines and Layer 2 Firewalls can be
installed either in inline mode or in capture mode.

The following table describes the packet processing flow for NGFW Engines. The following abbreviations are
used for the roles and interface types:

• FW — Firewall/VPN role
• IPS — IPS role and layer 2 physical interfaces of the inline IPS interface type on NGFW Engines in the

Firewall/VPN role
• L2FW — Layer 2 Firewall role and layer 2 physical interfaces of the inline Layer 2 Firewall interface type on

NGFW Engines in the Firewall/VPN role

Some stages apply to all roles.

Table 75: Packet processing

Stage Role Event / Check Action Notes

1 PACKET IN ALL
Incoming packet

2 Ethernet
rules

IPS,
L2FW

Allowed?

YES NO Packet
dropped

The NGFW Engine checks Ethernet frames against the
Ethernet rules in the policy. The packet is processed
until it matches an Ethernet rule that tells whether to
allow or to discard the packet.
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Stage Role Event / Check Action Notes

3
Packet
validity
checks

ALL

Valid packet?

YES NO Packet
dropped

The NGFW Engine checks the validity of packets to
protect the NGFW Engine from processing invalid
packets. Depending on the action in the Inspection
Policy, NGFW Engines in the IPS and Layer 2 Firewall
roles can either terminate invalid packets or bypass
the traffic without processing the invalid packets. For
self-protection reasons, NGFW Engines in the Firewall/
VPN role always terminate invalid packets without
establishing a connection.

Packets dropped in this phase produce log entries with
specific situations, such as TCP_Segment-SYN-No-
Options. Not all invalid packet drops are logged unless
Packet Filter diagnostics is enabled.

Note:  Invalid Packet Situations are always
log rate limited.

4 Antispoofing FW

Spoofed?

NO YES Packet
dropped

Checks that the traffic is coming in through the correct
interface or VPN tunnel as defined in the routing and
antispoofing configuration or VPN configuration.

5 Connection
tracking ALL

Existing connection or
new related connection?

YES NO
Access rule

matching

Checks the current connection tracking information to
see if the packet is part of an established connection
(for example, a reply packet to a request that has been
allowed). If TCP SYN rate limits or other DoS protection
features are enabled, they are enforced at this stage.

If the packet is not part of an existing connection, the
packet is compared with the Access rules in the installed
policy. The processing continues until the packet
matches a rule that tells the NGFW Engine to allow
or stop the packet. If there is no rule match anywhere
else in the policy, the packet is allowed or discarded
according to the final action of the policy.

6 Access rule
matching ALL

Allowed by Access rules?

YES NO Packet
dropped

If the packet is not part of an existing connection,
the packet is matched to IPv4 or IPv6 Access rules
according to the IP protocol used.

• If the traffic is tunneled using IP-in-IP or Generic
Routing Encapsulation (GRE), the traffic can be
checked against the IPv4 or IPv6 Access rules
several times. The traffic is rematched according to
the number and type of layers in the tunnel and the
settings of the NGFW Engine.

• The processing of the packet continues until the
packet matches a rule that tells the NGFW Engine
to allow or discard the packet. If the packet does
not match any Access rule, the final action depends
on the NGFW Engine role. An IPS engine allows
the packet to pass through, while a Layer 2 Firewall
drops the packet.
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Stage Role Event / Check Action Notes

7 Protocol
Validation ALL

Valid for connection state?

YES NO Packet
dropped

If the packet is allowed as an existing connection or in
an Access rule, checks that the packet is valid for the
state of the connection. If not, the packet is dropped.
For example, a TCP connection must always begin with
a SYN packet (as defined in the protocol standards).
The NGFW Engine checks that the first packet of a new
connection is a valid SYN packet.

8

Inspection
and File
Filtering
Rules

ALL

Harmful pattern or file?

NO YES
Action
defined
for rule

Applies Inspection rules to connections that are selected
for deep packet inspection or file filtering in the Access
rules.

• Inspection applies to all packets in a connection, so
the Inspection rules are applied even if the packet is
a part of an existing connection.

• The Inspection rules are used to look for patterns
of interest in allowed connections. The patterns
can indicate potential attacks, exploits, or other
possible threats. They can also be any other patterns
of interest, such as multiple logon attempts, use
of peer-to-peer or instant messaging software, or
protocol violations in the traffic.

• If a pattern in traffic matches a pattern defined in a
rule, the actions defined in the rule are taken.

9 NAT
Modifications FW

Address Translation (if
needed for the connection)

Applies Network Address Translation (NAT) rules to
IPv4 and IPv6 connections. The source and destination
addresses are translated according to the first matching
NAT rule (or not done at all, if a NAT rule so defines). If
none of the NAT rules match, the packet continues with
the original addresses. By default, NAT is not applied to
traffic to or from policy-based VPNs.

10 VPN FW

Policy-based
VPN processing

Policy-based VPN processing includes finding the
correct tunnel from the VPN configuration. If a VPN
configuration does not match Access rules correctly,
packets might be discarded with the message ”VPN
tunnel selection failed”.

11
Routing /
Route-

based VPN
FW

Route Selection

GRE/IP-IP encapsulated
with policy-based VPN?

NO YES

Go back
to policy-

based VPN
processing

If a Zone is used as the Destination in an Access rule,
the packet is matched against the Access rules after
the final route has been selected. If the packet does
not match a rule due to applied NAT, it is dropped. If
the packet is routed to a tunnel interface, the packet
is encapsulated according to the route-based VPN
configuration.

12 QoS ALL
QoS Processing The packet is let through the NGFW Engine according

to its priority and any bandwidth limits or guarantees that
might have been defined.

13 PACKET
OUT ALL Outgoing packet
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Access rule matching based on the payload of
connections
When you use some types of Service elements in Access rules, the NGFW Engine can only determine whether
the connection matches a rule when the payload of the packets is checked against the Access rules.

When you use elements such as Network Applications, URL Categories, or URL Lists in the Service field of an
Access rule, matching is based on the payload of the packets. When the first SYN packet of a new connection is
processed, the NGFW Engine cannot determine whether the connection matches the Access rule. The NGFW
Engine can only determine whether the connection matches the Access rule when the NGFW Engine processes
a payload in the connection, such as an HTTP request in an HTTP connection.

The NGFW Engine checks traffic against the Access rules from the top down. When traffic matches a rule
that tells the NGFW Engine to allow or discard the packet, the NGFW Engine stops checking traffic against
the Access rules. Because the first matching rule defines how the first packet is forwarded, connections might
not match the intended rule. Some settings, such as the use of VPNs, NAT, SSM Proxies, and TCP MSS
enforcement, cannot be applied after a connection has been established. When the payload in the connection
matches a rule, other traffic in the same connection cannot match later rules that apply these settings.

To prevent traffic from matching the wrong rule, use more specific source and destination criteria in the rules, or
change the rule order.

In this example, rules that have the same source and destination use different elements in the Service field.

Table 76: Example rules

ID Source Destination Service Action

1.1 Internal networks ANY URL Category:
Education

Allow

1.2 Internal networks ANY HTTP Use VPN: Corporate
VPN

When the NGFW Engine starts processing a new HTTP connection from the internal network, the first SYN
packet of the connection potentially matches rule 1.1. The connection is allowed to continue, but traffic is not sent
into the VPN tunnel. When the NGFW Engine processes a packet from the same connection that includes an
HTTP request, the NGFW Engine checks the URL categorization for the requested URL. If the URL matches the
Education category, the traffic is allowed to continue. If the URL matches a different category, or does not match
any category, the connection is discarded with a log message that indicates a conflict between rules 1.1 and 1.2.

Policy element configuration overview
After you decide on a policy hierarchy, you can populate the policy elements with rules for handling the traffic.

Policy elements are only containers for the actual traffic handling rules. When you have decided on a policy
hierarchy, you can populate the policy elements with the rules for handling the traffic.

1) (Optional) Create a custom template and add the rules and insert points.

2) Create a custom policy and add the rules.

3) (Optional) Create sub-policies and add the IPv4 Access rules.
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Related concepts
How sub-policies work on page 798

Related tasks
Create template policies or policies on page 796

Create template policies or policies
Template Policy elements are used as a basis for Policies and other Template Policies.

Every Policy and Template Policy that you create is based on a Template Policy. You can base several policies
on the same Template Policy. The Template Policy or a customized copy of the Template Policy is always at the
highest level of the policy hierarchy. It is not mandatory to create any custom Template Policies if you feel that it
is not necessary in your environment.

When editing policies, the main difference between Policies and Template Policies are the special rows called
insert points. Insert points are shown in both Template Policies and in Policies, but you can add them only to
Template Policies. The insert points added to Template Policies mark where new rules can be added to policies
that are based on the templates. If you create a Template Policy and do not base the Template Policy on any
predefined Template Policy, you must add insert points separately for Access rules, NAT rules, and Ethernet
rules.

 
Figure 104: Insert point in a Template Policy and the inheriting (Template) Policy

This illustration shows what the same insert point looks like in a Template Policy and in the inheriting policy
elements. The color of the insert point indicates whether the insert point has been added in the current Template
Policy for inheritance to lower levels (orange) or whether it has been inherited from the higher-level Template
Policy (green). Only the orange insert points are inherited to lower-level policy elements. You must add at least
one new insert point at each Template Policy level to make the lower-level policies editable. When you add the
first new rule to the green insert point, the rule replaces the insert point. Any number of rules can then be added
directly above and below that first rule. The engine reads rules in order from the top down. The rules above the
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insert point in the higher-level Template Policy cannot be canceled by anything a lower-level policy adds into the
insert point.

Rules defined in the Template Policy itself cannot be edited in lower-level policies that use the Template Policy.
Such inherited rules are shown only on your request and they are displayed with a gray background. Only the
actual rules are inherited from a higher-level Template Policy into the lower-level policies and Template Policies.
The rights to edit policies and Template Policies are defined separately.

A Firewall Policy, IPS Policy, Layer 2 Firewall Policy, or Layer 2 Interface Policy is the element that gathers all
rules from the different policy elements:
• Rules inherited from the Template Policy that is used as the basis of the policy
• Rules from one or more Sub-Policies added to the policy
• Rules added directly to the policy
• Rules from the Inspection Policy that is referenced from the Inspection tab in the policy

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click the Policies branch and select one of the following options:
• New > Firewall Policy.
• New > IPS Policy.
• New > Layer 2 Firewall Policy.
• New > Layer 2 Interface Policy

3) In the properties dialog that opens, enter a Name for the element.

4) Select the Template you want to base this template or policy on.

5) (Optional) Switch to the Permissions tab and grant rights for the template or policy.

a) To add a permission, click Add Permission.
A new row appears on the administrator list.

b) Click the Administrator cell and select the Administrator.

c) Double-click the Administrator Role cell to select the correct role.

6) Click OK.
The new Template Policy or Policy opens in the Policy Editing view.

If you changed administrator permissions for the policy, the changes are applied immediately. The
permissions are also automatically updated in the properties of the administrator’s account.
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How sub-policies work
Sub-Policies are sections of Access rules that you can insert in the IPv4 or IPv6 Access rules of Policies,
Template Policies, or other Sub-Policies.

Sub-Policies can also be used to organize the policies and to delegate administrator rights. You can restrict
specific administrators to edit, add, or delete rules within a limited section of IPv4 or IPv6 Access rules, which is
more restrictive than giving access to a template or policy.

A Sub-Policy is inserted into some other policy element by adding a Jump rule to the policy element. The Jump
rule directs connections that match the Jump rule for matching against the rules in the Sub-Policy.

 
Figure 105: A collapsed Sub-Policy

 

 
Figure 106: An expanded Sub-Policy

The illustrations show the same Jump rule in a policy in the collapsed and the expanded state. The rules of the
Sub-Policy are shown on a gray background, because they can be edited only within the Sub-Policy itself, not in
the Firewall Policy that uses the rules.

You could use a Sub-Policy, for example, for examining traffic destined to a group of servers located in one
particular network. The Jump rule could then use the destination network as a criteria for directing connections
for matching against the Sub-Policy. Any connection that was destined to some other network would not get
matched against any of the rules in the Firewall Sub-Policy. This makes the matching process faster, because
the engine can skip a whole Sub-Policy by comparing a connection to just one simple rule for any non-matching
connection. If the Sub-Policy rules were inserted directly into the main Firewall Policy, the engine would have
to compare all connections to all those rules individually (since that is the only way to find out whether the
connection matches the rules). The performance benefit gained depends on the number and complexity of the
rules that can be placed in a Sub-Policy. It also depends on how heavy the engine load is to begin with.

The main goal of Sub-Policies is to match only part of the traffic against the rules in the Sub-Policy and allow
other traffic to bypass the Sub-Policy. Rules in a Sub-Policy should have at least some identical matching criteria
(source, destination, service, source VPN, or user authentication details). These criteria can be used to select
only a portion of the traffic for the sub-policy checks.

There are two ways to create Sub-Policies: you can either create a Sub-Policy and add Access Rules to it
manually or select Access rules in a policy and convert them into a Sub-Policy.
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Create empty sub-policies
Before you can edit a sub-policy, you must create an empty sub-policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click the Policies branch and select one of the following options:
• New > Firewall Sub-Policy.
• New >  IPS Sub-Policy.
• New > Layer 2 Firewall Sub-Policy.
• New > Layer 2 Interface Sub-Policy

3) Enter a unique Name for the element.

4) (Optional) Click the Permissions tab and adjust the Access Control Lists at the top part of the dialog box to
include the Sub-Policy on one or more custom Access Control Lists.

5) Click OK.
The new Sub-Policy opens in the Policy Editing view.

Create sub-policies from existing Access rules
You can convert IPv4 and IPv6 Access rules in an existing policy into a Sub-Policy.

The IPv4 and IPv6 Access rules do not have to be consecutive. However, if you add several references to a
Sub-Policy in the same policy, all Sub-Policy rules are checked at each reference point, even if those rules were
already checked at a previous reference point. This can be avoided, for example, by adding a rule at the end of
the Sub-Policy that stops all connections that did not match the other rules.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the policy or template and select Edit <policy type>.

2) On the IPv4 Access or IPv6 Access tab, select the rules that you want to add to the Sub-Policy.

3) Right-click one of the selected rules and select Create Sub-Policy.

4) Enter a Name for the Sub-Policy and click OK.
The Sub-Policy element is created, a new Jump rule that references the Sub-Policy is automatically added to
the policy, and the selected rules are moved to the Sub-Policy.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Creating and managing policy elements | 800

5) Edit the Jump rule cells to be as specific as possible, so that traffic is not unnecessarily matched to the sub-
policy.
If necessary, you can add more references to the Sub-Policy, for example, by copy-pasting the Jump rule.

6) (Optional) Add the Sub-Policy to a custom Access Control List:

a) Right-click the Action cell in the Jump rule and select Properties.
The Properties dialog box for the Sub-Policy opens.

b) Switch to the Permissions tab and adjust the Access Control Lists at the top part of the dialog box.

c) Click OK.

Install policies
After creating or editing a policy, you must install or refresh the policy on the engine.

Policy installation transfers any new engine configuration information in addition to the policy. Whenever you
update the engine’s configuration, you must reload the policy on the engine so that the changes take effect.
These changes include, for example, changes in the routing configuration, the VPN configuration, and the
properties of the NGFW Engine element itself. You must reload the policy even if the changes are not directly
related to the rules in the policy.

Note:  When you install a changed or a new Firewall Policy, any existing connections that are
not allowed by the new Firewall Policy are dropped. The existing connections allowed by the
new Firewall Policy continue uninterrupted. These connections include related connections and
authenticated connections on the engines.

If the policy installation fails, the system automatically rolls back to the previously installed configuration. By
default, a rollback also occurs if the system detects that the new policy or related configuration (such as routing
configuration) does not allow the Management Server to connect to the engines. This safety feature prevents you
from inadvertently installing a configuration that would cause the critical management connections to fail.

You can only install Policy elements. Template Policy and Sub-Policy rules are installed as part of the main
Policy. A Policy Snapshot is automatically created each time you install or refresh a policy. You can install a
policy through the Policy element or through the engine element. The following procedure explains the first
method.

Note:  You cannot install Layer 2 Interface Policies on engines. Instead, you select the Layer 2
Interface Policy for the NGFW Engine in the Engine Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Policies branch, then select the policy type.

3) Right-click the policy you want to install, then select Install Policy.
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4) Select the engines on which you want to install the same policy, then click Add.
You can install the same policy on several engines at the same time. The SMC tracks the policies installed
on engines and automatically selects the Target when possible.

5) (Optional) Leave Keep Previous Configuration Definitions selected to allow established connections to
continue using existing configurations (such as NAT rules) until they finish.

• If the previous configurations are erased, connections that use them are dropped.
• All previously established connections that the newly installed policy does not allow are always dropped

regardless of this setting.

6) (Optional) Leave Validate Policy before Upload selected to validate the rules in the policy.
See

Note:  You cannot validate the policy if you are installing the policy on several engines.

7) Click OK.

8) If validation issues are found, read the Issues tab in the Info pane and take one of the following actions:
• Double-click an issue to view the corresponding configuration.
• Click Continue.

9) Check the progress of the installation and make sure that it is successful.
With multiple engines, the progress is indicated through colored icons on the left (click the icon to view the
details):
• Yellow: Ongoing installation
• Blue: Waiting for the installations on other components to finish
• Red: Failure
• Green: Success

Related concepts
Viewing policy validation issues on page 892

Related tasks
Validate rules automatically on page 890
Configure Layer 2 Settings for NGFW Engines in the Firewall/VPN role on page 511

Check the currently installed policy
You can check the details of the currently installed policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.
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2) Right-click the engine, then select Current Policy > Info.
A message is displayed on the screen with the following information:
• Name of the installed policy
• Name of the administrator who installed the policy
• Date (year-month-day) and time of the policy installation

3) Click OK to close the message.

Preview the currently installed policy
You can preview the policy that is currently installed on the Management Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click the engine, then select Current Policy > Preview.
A preview of the policy in its current format on the Management Server opens.

Note:  The policy on the Management Server might be different from the actual currently
installed policy if the policy has been edited after it was installed.

Check and compare Policy Snapshots
You can compare two policy snapshots, or check which policy was in place at a particular time.

Each time a policy is successfully installed, a record of that configuration is stored in the upload history. These
policy snapshots enable you to the check which policies were uploaded and when, and allows you to run an
automatic check for policy refresh needs.

Note:  The policy snapshot is only stored when the policy is successfully installed. No snapshot is
stored if the policy installation fails.

View Policy Snapshots
A policy snapshot captures a policy's configuration at the time it was installed.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Policy Snapshots.
A list of policy snapshots with the upload times and dates appears.
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3) Double-click the policy snapshot you want to view.
The details of the selected policy snapshot open.

Tip:  You can also view the snapshot in HTML format: right-click a snapshot and select
Tools > Save as HTML File.

4) Select elements in the other pane to see their details. The elements are organized in the following groups:

• Policy: The policy whose installation created the snapshot.
• Target: Properties of the engine on which the policy has been saved.
• Elements: Elements included in the policy.

Tip:  Select Show XML to view the policy snapshot in XML format.

Compare Policy Snapshots
You can compare any two policy snapshots from the list to check for changes between policy installations.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the comparison in one of the following ways:
• To compare any two snapshots to each other, select two policy snapshots, right-click, and select

Compare Snapshots .
• To compare a policy snapshot to the engine's current policy, right-click a policy snapshot and select

Compare > Compare Snapshot to Engine’s Current Policy.
• To compare a policy snapshot to the most recently saved policy on the Management Server, right-click

the policy snapshot and select Compare > Compare Snapshot to Most Recently Saved Policy

The changes are highlighted in the policy and shown as a summary.

2) Select objects in the summary to focus on them.
For example, if you select a network element, its properties are shown. The objects are organized in the
following groups:
• Targets — The engine on which the policy has been saved.
• New Elements — Elements added to the policy.
• Removed Elements — Elements that have been removed from the policy.
• Modified Elements — Elements that exist in both policies but that have been edited.

Change templates of policies
You can change the template of a Firewall, IPS, or Layer 2 Firewall policy.

For example, if you created policy A based on template X, you can later change the parent template for policy A
so that policy A inherits rules from template Y.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Policies tree and select the appropriate policy type.

3) Right-click the correct policy and select Properties.
The Properties dialog box for the policy opens, showing the Policy tree.

4) Select the new parent template.
The parent template must have insert points for the types of rules that the Policy contains.

5) Click OK.
The policy is moved under your chosen template in the tree view, and starts using rules from the new
template.

Using policy elements and rules
Names, comments, and the Continue action make policy rules easier to use. You can also enable policy
validation and configure user responses and connection tracking.

Validating policies
You can automatically validate the policy while editing and during policy installation.

The number of rules in a policy can grow large over time. It can become difficult, for example, to notice
configuration errors in a policy. To make policy management easier and to make sure that the policy does not
contain misconfigured rules, you can automatically validate the policy while editing and during policy installation.
You can select different criteria for validating the policy. You can, for example, check the policy for duplicate and
empty rules or check if there are rules that cannot match traffic.

Additionally, the engines automatically count how many times each Access rule has matched. Engines also count
the number of matches to NAT rules. You can run an analysis over a selected time frame in the policy editing
view to display rule counter hits for each rule (in the Hits cell). Rule analysis allows you to find otherwise valid
rules that are unnecessary because they match traffic that does not appear in your networks.

Configuring connection tracking
Connection tracking means that the engine keeps a record of all currently open connections (stateful inspection).

With connection tracking, the engine can verify that the connection proceeds according to the protocol standards.
Connection tracking is also required for changing addresses using NAT and enforcing some other connection-
related settings. By default, connection tracking is on.

However, it is not necessary to track the state of certain kinds of connections (for example, SNMP traps). Some
applications can also communicate in a non-standard way that prevents them from being allowed through the
engine when connection tracking is used. For those connections, you can disable connection tracking in the
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Access rules, which allows the engine to function as a simple packet filter for those connections. However,
disabling connection tracking also prevents the use of some features that require connection tracking.

When connection tracking is off, each packet that you want to allow must match an Access rule that allows
the packet. This means that even if two-way communications are always opened one way, both directions of
communication must be explicitly allowed in Access rules. Reply packets are not recognized, so they are not
automatically allowed through. If done carelessly, turning off connection tracking reduces the benefits you gain
from your engine and might even weaken security. You might have other options: sometimes using the correct
Protocol Agent helps.

Note:  Before disabling connection tracking, always check if there is a Protocol Agent for the
protocol in question. The Protocol Agents can pass connections that require special handling
when connection tracking is on, which is always a more secure option.

When connection tracking is enabled in an Access rule, the Service cell of the rule must contain one of the
protocols supported for connection tracking (ICMP, TCP, UDP, or another protocol that belongs to the IP protocol
suite). ICMP and UDP are stateless protocols that do not contain any connection data. However, ICMP and
UDP packets contain data that the engine can use to build virtual connections. The engine can also build virtual
connections based on the IP address and IP protocol data in other types of IP packets.

You can choose between several connection tracking modes, depending on the traffic type and how strictly you
want the connections to be tracked. The effect of the connection tracking setting in the Access rules depends on
the traffic type.

If Connection Tracking is on, you can also set the Idle Timeout for connections. The timeout is meant for clearing
the engine’s records of old connections that the communicating hosts leave hanging. The timeout concerns
only idle connections, so connections are not cut because of timeouts while the hosts are still communicating.
The timeout defined for an Access rule overrides the default idle timeout value that is set for the protocol in the
engine’s properties.

CAUTION:  Setting excessively long timeouts for many connections can consume engine
resources and degrade engine performance and stability. Be especially careful when defining
timeouts for ICMP and UDP. The ICMP and UDP virtual connections do not have closing packets.
The engine keeps the records for the ICMP and UDP connections until the end of the timeout.

Connection Tracking options in Access rules also allow you to override the limit for connections from a single
source or destination IP address defined in the Traffic Handling settings for NGFW Engines and in the
properties of some interface types. When the set number of connections is reached, the engine blocks the next
connection attempts until a previously open connection is closed.

Changes in the Connection Tracking mode affect how existing connections are handled when you install
or refresh the policy. When you install or refresh the policy on an engine, the engine checks if the existing
connections are still allowed in the policy. If the connection tracking mode changes from Loose to Strict, existing
virtual ICMP connections are only allowed if they began with a valid packet (for example, not with a response
packet). In addition, if the mode changes from Normal to Strict, existing TCP connections are only allowed if all
packets in the connection have been seen. In all other cases, changes in connection tracking mode do not affect
existing ICMP, TCP, and UDP connections at policy installation.

Policy Snapshots
A Policy Snapshot is a stored record of a policy configuration.

A Policy Snapshot is stored in an engine’s upload history whenever a policy is installed or refreshed on the
engine. The Policy Snapshots allow you to check which policies and other configuration information were
uploaded, and when they were uploaded. You can also compare any two Policy Snapshots and see the
differences between them.
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Continue rules
The Continue action for a rule sets default options for traffic matching.

The Continue action for a rule sets default options (such as logging options and idle timeout) for the traffic
matching process. Options set in Continue rules are used for subsequent rules that match the same criteria
as the Continue rule, unless the rules are set to override the options. Continue rules are also useful in the
hierarchical structure of the policies. Template Policies are convenient for setting options with a Continue rule,
because all Policies and Template Policies that use the template inherit the option settings you have specified.

Related concepts
Configuring default settings for several Access rules on page 823

Adding comments to rules
You can add comments to rules to provide useful information to administrators and to make policies easier to
read.

Each policy can include a large number of rules. Adding comments provides administrators with useful
information and also makes it easier to read policies. You can add comments to all types of rules. In rule tables,
you can add comments in the rule’s Comment cell. You can also add a Rule Section, which begins with a
comment row and can include one or more rules.

The Rule Section automatically includes all rules below the Rule Section until the next Rule Section in the policy.
You can expand and collapse the Rule Sections as necessary. The comment row in a Rule Section is displayed
against a colored background (with configurable colors). Rule Sections are useful in visually separating the
sections of rules within a single policy.

Naming rules
You can specify an optional name or short description for Access rules, NAT rules, Ethernet rules, Exceptions in
Inspection Policies, and rules in QoS Policies and Alert Policies.

Names help administrators identify individual rules in large rule tables. You can also search for a rule by its name.
If a rule has been named, the name is displayed in the Logs view as well.

Deleting policies templates or sub-
policies

If no policies are based on a policy template, you can delete the template. Similarly, you can delete a Sub-Policy
as long as no Jump rules use it.

To delete a template, there must be no policies that are based on that template. The deletion is not allowed until
you either delete the policies or switch them to use a different template.

To delete a Sub-Policy, there must be no policies that have Jump rules that use the Sub-Policy. The deletion is
not allowed until you edit or remove the Jump rules in the policies.
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Related concepts
How the Trash works on page 166

Related tasks
Change templates of policies on page 803

Firewall Policy elements examples
Using Firewall Policy elements, you can protect essential communications, make Firewall rules more readable
and Firewall Policies more efficient, and manage network administrator rights.

Protecting essential communications example
You can make sure that essential communications are protected and cannot be cut off.

Company A has a firewall system administered by multiple administrators of various degrees of familiarity with
networking, firewalls, and Forcepoint NGFW Firewalls. The administrators must often make quick changes to
respond to the needs of the company and attend to any problems detected.

In this situation, it is possible that someone might accidentally change the Firewall Policy in such a way that
important services are cut off. The administrators decide to separate the rules allowing the most important
business communications from rules that deal with non-essential traffic to minimize this risk. The administrators:

1) Create a Firewall Template Policy and select the predefined Firewall Template as the basis of the policy.

2) Cut and paste the rules allowing essential communications from their current Firewall Policy into the new
Firewall Template Policy.

In this case, all administrators are allowed to edit the new Firewall Template Policy as well.

3) Add an insert point below the copied rules in the Firewall Template Policy.

Having the insert point below the essential rules prevents the rules added to the inheriting Firewall Policy
from affecting the essential communications.

4) Reparent their current Firewall Policy to use the new template, moving it down a step in the policy hierarchy.

5) After validating the policy and making sure that the rules are correct, refresh the current Firewall Policy.

Most daily editing is done in the Firewall Policy. There is less risk of someone accidentally changing the
essential rules in the Firewall Template Policy, because the rules are not editable in the Firewall Policy.
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Improving readability and performance
example
You can make Firewall rules more readable and improve the performance of Firewall Policies.

Company B has two separate DMZs, one for the extranet and one for other web services. The number of
services offered is large. The company also has many partners and customers that have varying access rights
to the different services. The administrators realize that many of the rules in their policies are related to the DMZ
connections. The rest of the rules govern access to and from the company’s internal networks. Many of the rules
have been entered over time by inserting them at the beginning of the rule table, so rules governing access to the
different networks are mixed. Finding all rules that govern access to a particular network takes time.

The administrators decide that they want to make their Firewall Policy more readable and at the same time
optimize the way the firewall handles traffic, so they:

1) Create two new Firewall Sub-Policies: one for each DMZ.

2) Cut and paste the rules from the current Firewall Policy into the correct Firewall Sub-Policy.

3) Add Jump rules to the Firewall Policy, to direct the examination of traffic to/from the different networks to the
correct Firewall Sub-Policy.

4) Refresh the Firewall Policy.

Restricting administrator editing rights in
Firewall Policies example
You can restrict the editing rights of network administrators in your organization, as needed.

Company C is implementing a distributed network with multiple sites: one central office where most of the
administrators work, and several branch offices in different countries. The branch offices mostly have IT staff with
only limited networking experience, but who are still responsible for the day-to-day maintenance of the network
infrastructure at their site. They must be able to, for example, add and remove Access rules for testing purposes
without always contacting the main administrators.

The administrators decide to limit the permissions of the branch office IT staff so that they are not able to edit the
policies of the firewalls at any of the other sites. The administrators:

1) Create a Firewall Template Policy and select the predefined Firewall Template as the basis of the policy.

2) Add rules to the Firewall Template Policy using Alias elements to cover the essential services that each of
these sites has, such as the VPN connections to the central site.

Using a common Firewall Template Policy for all branch offices also eliminates the need to make the same
changes in several policies, easing the workload.

3) Create a Firewall Policy based on the new Firewall Template Policy for each of the branch office sites.

Although the same Firewall Policy might work for all sites, in this case the administrators decide against
it. Separate policies are needed for the separation of editing rights. The policies are based on the same
Firewall Template Policy, so rules can still be shared without duplicating them manually.

4) Grant each Firewall Policy to the correct Firewall element.
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After this, only the correct policy can be installed on each firewall. No other policy is accepted.

5) Create administrator accounts with restricted rights for the branch office administrators and grant the correct
Firewall element and Firewall Policy to each administrator.
• The branch office administrators are now restricted to editing one Firewall Policy and can install it on the

correct firewall.
• The branch office administrators are not allowed to edit the Firewall Template Policy the policy is based

on. They also cannot install any other policies on any other firewalls.

IPS Policy example
You might want to restrict the policy editing rights of administrators to the IPS engines at their sites.

Restricting administrator editing rights in IPS
Policies example
You can restrict the policy editing rights of administrators to the IPS engines at their sites.

Company A is implementing a distributed network with multiple sites: one central office where most of the
administrators work, and several branch offices in different countries. The branch offices mostly have IT staff with
only limited networking experience, but who are still responsible for the day-to-day maintenance of the network
infrastructure and the IPS engines at their site. They must be able to, for example, add and remove Access rules
for testing purposes without always contacting the main administrators.

The administrators decide to limit the permissions of the branch office IT staff so that they are not able to edit the
policies of the IPS engines at any of the other sites. The administrators:

1) Create an IPS Template Policy based on the predefined IPS Template.

2) Add rules to the IPS Template Policy using Alias elements to cover the essential services that each of these
sites have.

Using a common IPS Template Policy for all branch offices eliminates the need to make the same changes
in several policies, easing the workload.

3) Create an IPS Policy based on the new template for each of the branch office sites.

Although a single IPS Policy for all sites could work, in this case the administrators decide against it.
Separate policies are needed for the separation of editing rights. The policies are based on the same
template, so rules can still be shared without duplicating them manually.

4) Grant each IPS Policy to the correct IPS engine elements.

After this, only the correct IPS Policy can be installed on each IPS engine. No other policy is accepted.

5) Create accounts with restricted rights for the branch office administrators and grant the correct IPS engine
element and IPS Policy to each administrator.
• The branch office administrators are now restricted to editing one IPS Policy and can install it on the

correct IPS engine.
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• The branch office administrators are not allowed to edit the template the IPS Policy is based on. They
also cannot install any other policies on any other IPS engines.
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Getting started with Ethernet rules
Ethernet rules are lists of matching criteria and actions that define whether Ethernet protocol traffic is allowed or
discarded.

Ethernet rules are used by IPS engines, Layer 2 Firewalls, and layer 2 physical interfaces on Firewalls.

The traffic matching in Ethernet rules is based on the Source and Destination MAC Address in the packets.
Any Ethernet network traffic, such as ARP, RARP, IPv6, Cisco Discovery Protocol (CDP), and Spanning
Tree Protocol (STP), can be checked against the Ethernet rules. Ethernet traffic can be allowed or discarded.
Regardless of the action taken, a matching rule can also create a log or alert entry.

The following types of interfaces can stop traffic when the Discard action is used:

• Inline IPS Interfaces on Firewalls
• Inline Layer 2 Firewall Interfaces on Firewalls
• Inline Interfaces on IPS engines
• Inline Interfaces on Layer 2 Firewalls

For the following types of interfaces, only the Allow action is available:

• Capture Interfaces on Firewalls
• Capture Interfaces on IPS engines
• Capture Interfaces on Layer 2 Firewalls

If your policy is based on the IPS Template or the Layer 2 Firewall Template, the Ethernet rules direct IPv4 and
IPv6 traffic to the Inspection Policy for inspection, and let ARP, RARP, and STP traffic through. You can use
the first Insert Point in the template to make exceptions to this behavior for certain MAC addresses or Logical
Interfaces. We recommend that you insert any other changes at the second insert point.

Make sure that your Ethernet rules direct IP traffic for inspection against Access rules by applying the default
IPv4 and IPv6 Services to traffic. When traffic does not match any Ethernet rule, the traffic is let through without
further inspection.
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Configuration of Ethernet rules
You can use Ethernet rules in IPS, Layer 2 Firewall, and Layer 2 Interface Policy and Template Policy elements.
Sub-Policies cannot contain Ethernet rules.

 
Figure 107: Newly inserted Ethernet rule - Main cells

1

1 NGFW Engine applies action when it finds a match

This illustration shows an Ethernet rule that has been inserted into the policy. The Source, Destination, and
Service cells are set to NONE, so this rule does not until they are changed to ANY or a more specific value.
The Logical Interface cell is also matched against traffic, but it is not mandatory to change it if you want the rule
to apply regardless of the interface. The other editable cells specify further conditions and options for handling
matching connections. It is not necessary to edit all cells in each rule. Ethernet rules are read from the top down.
More specific rules must be placed above more general rules that match the same traffic.

The illustration below shows the types of elements that you can use in Ethernet rules.

 
Figure 108: Elements in Ethernet rules

Table 77: Cells in Ethernet rules

Cell Description

Logical Interface Accepts Logical Interface elements. Traffic matches the rule based on which interface
the traffic is picked up from.

Source

Destination

Accept MAC address elements.

You can set these cells to ANY to make the rule match all possible source or destination
MAC addresses. You can also add more than one element in each cell to make the rule
match multiple MAC addresses. The source and destination MAC addresses specified in
an Ethernet rule are compared to the MAC addresses in each packet’s header. Based on
these and other criteria, the rule is applied to matching packets.
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Cell Description

Service Accepts Ethernet Services elements.

Defines which protocols the Ethernet rule applies to. You can set the Service to ANY to
make the rule match all protocols.

Action Defines what happens when a packet matches the Ethernet rule. The following actions
are available:

• Allow — The traffic is let through the engine.
• Discard — The traffic is silently dropped if going through an Inline interface.

These actions stop the processing from continuing down the rule table for any packet
that matches the rule. Rules with these actions must be placed so that the more limited
the rule is in scope, the higher up in the rule table it is. If the traffic does not match any of
the Ethernet rules by the end of the policy, the final action is applied.

Note:  When the Allow action is used for IPv4 or IPv6 traffic in the Ethernet
rules, the traffic is then checked against the IPv4 or the IPv6 Access rules.
The final action for the IPv4 and IPv6 traffic is determined according to
traffic type by the IPv4 or the IPv6 Access rules.

Default elements for Ethernet rules
The predefined Ethernet rules in default template policies allow the most common types of Ethernet traffic.

The following default template policies contain predefined Ethernet rules:

• IPS Template
• Layer 2 Firewall Template
• Layer 2 Interface Template

Because the template policies are added and updated through dynamic update packages, your templates might
look different from the example here.

 
Figure 109: IPS template - Ethernet rules

This illustration shows a green insert point at the top of the rule table, three default rules below it, and then
another insert point.
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• The first rule contains the IPv4 protocol and allows the matching traffic to pass through.
• The second rule contains the IPv4 protocol and allows IPv4 traffic with further inspection against the IPv4

Access rules.
• The third rule contains the IPv6 protocol and allows IPv6 traffic with further inspection against the IPv6Access

rules.

The two insert points indicate where you can add Ethernet rules to a policy that uses the template policy. The first
insert point above the default rules allows you to make exceptions to how traffic that matches the three default
rules is checked. For example, you could add a rule defining that no IPv4 or IPv6 traffic is allowed between
certain MAC addresses.

The second insert point below the default rules allows you to define how traffic that matches other protocols is
checked. The final action depends on the type of template policy.

• IPS Template — Allow all
• Layer 2 Firewall Template — Discard All
• Layer 2 Interface Policy — Discard All for Inline Layer 2 Firewall Interfaces. Allow all for Capture Interfaces

and Inline IPS Interfaces.

Examples of Ethernet rules
These examples illustrate some common modifications to the default Ethernet rules and general steps on how
each example is configured.

Example: Logging protocol use in Ethernet
rules
An example of configuring Ethernet rules to log the use of Ethernet protocols.

The administrators at Company A have installed an IPS engine in Transparent Access Control mode and they
want to create some custom Ethernet rules. The administrators know that most traffic uses the IPv4 protocol,
but they are not sure which other Ethernet protocols are being used in the company’s network. They decide to
temporarily log the use of Ethernet protocols, excluding IPv4.

To log all Ethernet protocol traffic excluding IPv4, the administrators:

1) Create an IPS Policy based on the IPS Template.

2) Add a rule in the Ethernet rules to exclude IPv4 traffic from logging:

Table 78: Ethernet rule for excluding IPv4 traffic from logging

Source Destination Service Action Options

ANY ANY IPv4 Allow Logging: None

3) Add a rule to log the use of other Ethernet protocols:
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Table 79: Ethernet rule for logging Ethernet protocol use

Source Destination Service Action Options

ANY ANY ANY Allow Logging: Stored

4) Save and install the policy on the IPS engine.

5) View the logs generated by the matches to the Ethernet rules in the Logs view.

6) Disable the logging Ethernet rule to prevent excess log data from being generated.

Example: restricting the use of Ethernet
protocols
An example of configuring Ethernet rules to restrict which Ethernet protocols are allowed.

Now that the administrators at Company A from the previous example have a clear picture of which Ethernet
protocols are being used, they want to restrict allowed protocols. The administrators determine that ARP and
Spanning Tree Protocol (STP) must be allowed. Since most traffic will use these protocols, the administrators do
not want to log matches to the rules that allow specific protocols.

They decide to block the Cisco Discovery Protocol (CDP) on the logical interface named Inline Interface because
of security problems, and log detected CDP use.

To block the use of the CDP protocol, the administrators:

1) Add a new rule in the Ethernet rules to allow ARP, Spanning Tree Protocol (STP), and IPv4 without
producing any logs:

Table 80: Ethernet rule for allowing ARP and STP use

Logical Interface Source Destination Service Action Options

ANY ANY ANY ARP, STP, IPv4 Allow Logging: None

2) Add another rule to block the use of Cisco Discovery Protocol (CDP) on the Inline Interface, and produce
logs that will be stored:

Table 81: Ethernet rule for blocking CDP use

Logical Interface Source Destination Service Action Options

Inline Interface ANY ANY CDP Discard Logging: Stored

3) Add a rule on the last line of the Ethernet rules to block the use of other Ethernet protocols without producing
logs:
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Table 82: Ethernet rule for blocking other Ethernet protocols

Logical Interface Source Destination Service Action Options

ANY ANY ANY ANY Discard Logging: None

4) Save and install the policy on the IPS engine.
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Access rules are lists of matching criteria and actions that define how the engine treats different types of network
traffic. They are your main configuration tool for defining which traffic is stopped and which traffic is allowed.

Getting started with Access rules
Access rules filter traffic by defining matching criteria and an action that is applied to packets that match all
criteria defined in the rule.

Access rules are used by Firewalls, IPS engines, Layer 2 Firewalls, Master NGFW Engines, Virtual Firewalls,
Virtual IPS engines, and Virtual Layer 2 Firewalls:
• In Firewall and Layer 2 Firewall policies, the Access rules are the most important type of rules. The criteria you

define in the Access rules determines which connections are allowed. By default, Firewall and Layer 2 Firewall
Access rules stop traffic that you do not specifically allow.

Note:  Master NGFW Engines always use Firewall Policies regardless of the role of the Virtual
NGFW Engines they host. Virtual Firewalls use Firewall Policies. Virtual IPS engines use IPS
policies. Virtual Layer 2 Firewalls use Layer 2 Firewall Policies.

• In IPS policies, Access rules can be used to optionally filter out some traffic and to exclude some traffic from
further inspection. Only traffic on Inline Interfaces can be filtered with Access rules. IPS engines allow all
traffic that you do not specifically deny. For IPS policies based on the IPS Template, all traffic allowed by rules
placed after the inherited rules is inspected against the Inspection Policy by default.

Overview of Access rules
Access rules are traffic handling rules in which you define the details of traffic examination and which action to
take when matching details are found.

The IPv4 and IPv6 Access rules are stored in policy elements.

Access rules apply to all network interfaces, unless you use Zone elements to match traffic based on which
interfaces traffic passes through.

The traffic matching is based on the information contained in the packets:
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• Source and destination IP addresses.
• Protocol-specific information, such as the port information for protocols that use ports.
• Payload data in the packets, such as HTTP requests in an HTTP connection.

Additional matching criteria that is not based on information in the packets includes:
• The interface the traffic is coming from or going to. This allows you to restrict which traffic is allowed through

which interfaces in more detail than basic antispoofing.
• (Firewalls only) The VPN the traffic is coming from (on an engine where that VPN terminates). This allows

creating rules that apply to VPN traffic only, or rules that apply to all traffic except VPN traffic.
• (Firewalls only, IPv4 only) User authentication (allowing you to create rules that define the end users who are

allowed to make connections and the authentication methods for the end users).
• The User or User Group of a user who has logged on to an integrated Microsoft Active Directory domain

(allowing you to create user-specific rules without configuring authentication).
• The day of the week and the time of day (allowing you to enforce rules only during certain times, such as

working hours).

The Access rules provide several different ways to react when some traffic is found to match a rule. You can:
• Specifically allow the traffic.
• (Firewalls only, IPv4 only) Allow the traffic on the condition that the user has passed authentication.
• (Firewalls only) Allow the traffic on the condition that a VPN is established.
• (Firewalls only) Allow the traffic on the condition that the same source or destination IP address does not have

an excessive number of connections already open (concurrent connection limit).
• Allow the traffic with inspection against the Inspection Policy.
• Allow the traffic without further inspection.
• (Firewalls and inline interfaces only) Specifically stop the traffic.

Regardless of which of the above actions is taken, a matching rule can also create a log or alert entry.

In addition to traffic allowed by the Access rules, Firewalls allow the following types of traffic:

• Traffic that is allowed automatically based on the NGFW Engine configuration or by static rules generated by
the Management Server.

• Traffic that is allowed by automatic rules for traffic to and from the engine.
• Traffic that is allowed by the default template on which the Firewall Policy is based.

Firewalls automatically allow the following types of traffic with specific configurations:

• DHCP requests and replies for an interface for which a DHCP server is enabled.
• DHCP requests and replies for an interface that has a dynamic IP address.
• State synchronization between cluster nodes.
• IPv6 Neighbor Discovery traffic.

Related concepts
Getting started with policies on page 787
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Configuring Access rules
Access rules filter traffic by defining matching criteria and an action that is applied to packets that match all
criteria defined in the rule.

IPv4 Access rules are configured on the IPv4 Access tab, and IPv6 Access rules are configured on the IPv6
Access tab inside the following elements:
• Firewall Policy
• IPS Policy
• Layer 2 Firewall Policy
• Layer 2 Interface Policy
• Template Policy
• Sub-Policy

You can create new Access rules in the Policy Editing View. You can also create IPS and Layer 2 Firewall
Access rules in the Logs view. Use one or more selected log entries to create these rules (only available for IPS
and Layer 2 Firewall IPv6 Access rules, not for Firewall IPv6 Access rules).

Before starting to build policies, make sure that you understand the network element types available and how you
can use them efficiently to define the resources that you want to protect and control.

Configuring Firewall Access rules
 
Figure 110: Newly inserted Firewall IPv4 Access Rule - Main cells

1 2

1 Mandatory cells for matching traffic

2 Engine applies this Action when it finds a match

This illustration shows an Access rule that has been inserted into the policy. The matching cells are set to
<None> and the action is set to Discard. These settings prevent the rule from having any affecting in case a new
rule is added to the policy accidentally. It is not necessary to edit all cells in each rule. However, the mandatory
cells for traffic matching (Source, Destination, and Protocol) must be set to some value other than <None> for
the rule to be valid. The Source VPN cell is also matched against traffic in the inspection process, but it can be
left empty to match all traffic. The other editable cells specify further conditions and options, such as logging.

The following illustration shows the types of elements that you can use in IPv4 and IPv6 Access rules.
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Figure 111: Elements in Firewall Access rules

Network and User Elements

Protocol

Services QoS Class

Configuring IPS and Layer 2 Firewall Access rules
 
Figure 112: Newly inserted IPS or Layer 2 Firewall Access Rule - Main cells

1 2

1 Mandatory cells for matching traffic

2 Engine applies this Action when it finds a match

This illustration shows an Access rule that has been inserted into the policy. The matching cells are set to
<None> to prevent the rule from affecting traffic in case a new rule is added to the policy accidentally. It is not
necessary to edit all cells in each rule, but the mandatory cells for traffic matching (Source, Destination, and
Service) must be set to some value other than <None> for the rule to be valid. The Logical Interface cell is also
matched against traffic, but it is not mandatory to change its value if you want the rule to apply regardless of the
interface. The other editable cells specify further conditions and options for handling connections that match the
cells that are used for traffic matching.

The following illustration shows the types of elements that you can use in IPv4 and IPv6 Access rules.

 
Figure 113: Elements in IPS and Layer 2 Firewall Access rules

Logical Interfaces
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Related concepts
Getting started with directory servers on page 1075
Getting started with user authentication on page 1097
Overview of external user authentication on page 1101
Bandwidth management on page 951
Traffic prioritization on page 951

Considerations for designing Access rules
One of the crucial issues in designing policies is the order of the rules.

Rules are read from the top down. The actions Allow, Refuse, Discard, and Use VPN (Firewall only) stop the
processing from continuing down the rule table for any connection that matches the rule. You must place rules
with any of these actions so that the more limited the rule is in scope, the higher up in the rule table it is.

Example: An Access rule that allows connections to the IP address 192.168.10.200 must be put above an Access
rule that stops all connections to the network 192.168.10.0/24.

In Firewall and Layer 2 Firewall policies, traffic that does not match any of the Access rules by the end of the
policy is discarded by default. In IPS policies, traffic that does not match any of the Access rules by the end of the
policy is allowed by default. In Layer 2 Interface Policies, the final action depends on the type of interface. Inline
Layer 2 Firewall Interfaces discard all traffic. Capture Interfaces and Inline IPS Interfaces allow all traffic.

Related concepts
Example: exempting traffic from inspection in IPS Access rules on page 832

Default elements for Access rules
There are several predefined elements for configuring Access rules.

Default elements for Firewall Access rules
There are two predefined Firewall Template Policies called Firewall Template and Firewall Inspection Template.
They contain the basic Access rules that allow communications between the engine on which the policy is
installed and other SMC components. The Firewall Inspection Template is based on the Firewall Template.

You must use one of the predefined Firewall Template Policies as the basis for defining your own templates and
policies. It is not possible to create a new template at the highest level of the policy hierarchy. No changes can
be made directly to the predefined Firewall Template Policies. However, you can create your own copies of the
predefined Firewall Template Policies if you have a specific need to edit the rules in them.

Note:  If you use a copy of a predefined Firewall Template Policy, you may have to adjust your
rules manually when the system is upgraded to account for changes in system communications.
Upgrades can change only the predefined Firewall Template Policies, not the copies.

There is a yellow row near the end of the list of rules on the IPv4 Access and IPv6 Access tabs in the predefined
Firewall Template Policies. The yellow row marks the insert point, where rules can be added in the inheriting
Firewall Policy and Firewall Template Policy elements.
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The rules above the insert point detail the various kinds of system communications. Most of the IP addresses are
defined using Aliases to make the rules applicable on any system where they are installed. These Aliases are
default elements. The Service cell is the best starting point for understanding in greater detail what these rules
do.

There are two rules below the insert point. The rule directly below the insert point has the action Refuse for the
Ident protocol traffic. This action stops the traffic and sends an ICMP error message to the Ident request sender.
This rule exists to prevent Ident requests from being silently dropped (as the next rule specifies for all other
traffic). Silently dropping Ident requests might cause delays in legacy environments where the Ident protocol
is used. The last rule before the end of the policy is a rule that discards all traffic and creates a log entry that is
stored. This rule’s purpose is to make sure that this connection dropping is logged. This rule is important because
the engine silently drops the connection without creating a log entry if the matching process reaches the end of
the policy.

Default elements for IPS and Layer 2 Firewall Access rules
The IPS Template and the Layer 2 Firewall Template have predefined Ethernet rules, IPv4, and IPv6 Access
rules. Because the default policy elements are introduced when you import and activate a recent dynamic update
package, the templates you currently have in your SMC might look slightly different from the one that is presented
in this section. Newer versions of the templates work in the same way as described below. Any changes to the
templates are documented in the Release Notes document for each dynamic update package.

There are several IPv4 and IPv6 Access rules with various Services defined with Continue as the action and a
yellow insert point indicating the place where a Policy that uses the template can be edited.

The Access rules that you add at the insert points in custom policies based on the IPS Template or the Layer
2 Firewall Template are usually specific exceptions to the rules inherited from the template. For example,
you could insert a rule there that allows a connection between two particular hosts to continue without any
further inspection. Or, you could instert a rule for inline IPS engines to always stop traffic between particular IP
addresses and ports.

Related reference
Security Management Center ports on page 1429
Forcepoint NGFW Engine ports on page 1432

Restricting Firewall Access rule matches
based on the source VPN
You can match Firewall Access rules based on whether the traffic is coming from a particular policy-based VPN.

You can define that the rule matches only non-VPN traffic, or only traffic from a particular policy-based VPN.

Using Access rules
There are some additional concepts that are useful when working with Access rules.

Related concepts
Using policy elements and rules on page 804
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Allowing system communications in Access
rules
You must add Access rules for some types of communication between SMC components.

The necessary communications between the engine and other SMC components are allowed in the predefined
Firewall Template Policy, IPS Template, and Layer 2 Firewall Template. However, the predefined templates do
not allow other SMC components to communicate through the engine to some third SMC component.

For example, when you have a firewall and a Log Server at a remote site that are managed by a Management
Server behind a firewall at a central site, you must create rules in the Firewall Policy at the central site to allow:
• Management and monitoring connections to/from the remote firewall.
• Monitoring and log browsing connections from the central site to the remote Log Server.
• Any remote-site Management Client connections to the Management Server at the central site.

If NAT is applied to the connections, Access rules alone are not enough. You must also create Location elements
and add Contact Addresses for the elements to define which translated addresses are necessary for making
contact.

If you have inline IPS engines or Layer 2 Firewalls, be careful that you do not define rules that would prevent
other SMC components from communicating with each other.

There are predefined Service elements for all system communications. You can use these elements to create
Access rules.

Related concepts
NAT and system communications on page 840

Related reference
Security Management Center ports on page 1429
Forcepoint NGFW Engine ports on page 1432

Configuring default settings for several Access
rules
The Continue action allows you to set default values for some settings in rules to avoid defining the same
settings for several rules individually.

When a connection matches a rule with Continue as the action, some of the rule’s settings are written in memory
but the matching continues until another rule that matches is found. This matching rule uses the defaults set in
the Continue rule unless the rule specifically overrides the defaults with different settings. This way, you do not
have to define the settings for each rule separately.

You can use Continue rules to set default settings for a general type of traffic and define settings for individual
rules only when required. There are also default values that are used for rules that are set to use the values of a
Continue rule, but there is no previous matching Continue rule.

The options that can be set using Continue rules in Access rules include:
• The Connection Tracking option:

• For Firewalls, the default is on.
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• Idle Time-out also overrides the global defaults set in the engine’s properties.
• The concurrent connection limits define the maximum number of connections allowed from a single source

or destination IP address.
• The logging options (for Firewalls, the default is Stored).
• The Protocol option inside the Service used (for Firewalls, this option is used to apply a Protocol to rules with

ANY as their Service).
• The QoS Class (default is that no specific QoS Class is assigned).

Continue rules are defined the same way as other rules. However, you must remember that when any of the
options listed above is set in the Continue rule, many or even all rules below can be affected. The Continue rule
options are used by the rules below if the source, destination, service port, and the optional source VPN match
the same connection as the Continue rule. Continue rules are inherited from Template Policies into lower-level
templates and policies like any other rules.

Continue rules behave in the same way as any other rules. A Continue rule can be overridden by:
• A later Continue rule that has an identical scope (such as Source and Destination)
• Partially overridden by a Continue rule that partially overlaps with the previous Continue rule
• A rule with the Allow or Apply VPN action that has an identical scope and specifies different settings.

When you define Continue rules with different matching criteria, you can have several Continue rules one after
another without them interfering with each other in any way at all.

Sub-Policies might require special attention with Continue rules: the Sub-Policies can have different options when
you insert them into different policies if the Sub-Policy rules do not override the options set by preceding Continue
rules. Also, when a Sub-Policy contains a Continue rule, the options are then used for further matching in the
higher-level policy (if the processing returns to the higher-level policy).

Using Continue rules to set Access rule logging
options
Instead of setting the log level for all rules individually, you can set a Continue rule in a template or in a policy to
set the default log level.

One common use for the Continue action is to set the default log level for all subsequent rules. The log level for
any subsequent matching rules can be left undefined. The rules trigger logging as defined in the Continue rule.

 
Figure 114: Setting the default log level

The default log level is set to Transient for any source, destination, or service. All subsequent rules in this policy
and any sub-policies log Transient by default. Individual rules can still override this option with specific log levels,
such as Essential or Stored.

If logging is not defined for a rule and there is no prior Continue rule that sets logging options, the default log level
is Stored.
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Using Continue rules to set the Protocol in
Access rules
The default Protocol can be set using the Continue action.

This way, the correct Protocol is also used for traffic that is allowed by rules that are set to match any Service.
These rules have no particular Service element that would set the correct protocol). This setting can even be
mandatory, for example, if you want to allow certain protocols that allocate ports dynamically. On Firewalls, the
Protocol is needed to associate the traffic with the correct protocol for further inspection and to handle some
types of traffic, such as FTP, correctly. The IPS Template and the Layer 2 Firewall Template include several
Continue rules that associate all traffic with Protocols according to standard ports. The Firewall Template includes
one Continue rule that defines that Protocols of the type Protocol Agent are used for the Service Group Default
Services with Agents.

 
Figure 115: Protocol Agent rule in Firewall Template

You can set a Protocol for more types of protocols or override the Default rule shown in the illustration above for
some or all connections. Do this by placing one or more Continue rules at the top or some other suitable place in
your own template or policy. The Source and Destination can be some specific addresses if you want to limit the
scope of your Continue rules.

Note:  A rule that matches the same source, destination, and service port as the Continue rule
and specifies an Protocol of the types Protocol Agent, Protocol Tag, or SSM Proxy for the Service
overrides the default set in the Continue rule. To avoid this limitation, do not add rules that specify
these types of Protocols for the same matching criteria as the Continue rules.

If you have TCP and UDP services set up in your network under non-standard ports, the traffic might not be
associated to the correct protocol. The traffic could therefore inspected at a more general (TCP or UDP) level. In
this case, you can create your own custom Service and add it in your policy to have the traffic inspected with the
correct protocol information. Only some protocols and some of their parameters are supported in the services that
are used in IPS policies.

You can also add your own rules for the opposite purpose: to have some traffic not inspected as a particular
protocol, but more generally as TCP or UDP traffic. In this case, you add a rule in your policy that includes the
general TCP or UDP Service element from the IP-proto branch of the Services tree.

Using Continue rules with Sidewinder Proxies
When you use Continue rules to specify a default Protocol, including Sidewinder Proxies, rules later in the policy
can override the defaults set in Continue rules.

These limitations are due to the way that rules are processed, and are not specific to Sidewinder Proxies.

If you use a Continue rule to specify a Sidewinder Proxy as a default Protocol, a rule later in the policy overrides
the Continue rule that specifies the Sidewinder Proxy when:
• The rule matches the same source, destination, and service port as the Continue rule.
• The rule specifies a Protocol of the type Protocol Agent or Protocol Tag for the Service.

To avoid this limitation, do not add rules that specify a Protocol of the type Protocol Agent or Protocol Tag for the
same matching criteria as the Continue rules for Sidewinder Proxies.
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Table 83: Example of a rule that overrides a Continue rule that specifies a Sidewinder Proxy

ID Source Destination Service Action

14.1 Internal network External SSM HTTP on port 80 Continue

14.7 Internal network External HTTP with Protocol
Agent on port 80

Allow

In this example, the second rule overrides the defaults set in the Continue rule because it specifies a Protocol
Agent for the same matching criteria as the Continue rule. HTTP traffic on port 80 from the internal network to
external destinations matches the second rule. The traffic does not use the Sidewinder Proxy.

A rule later in the policy does not override the default Protocol set in the Continue rule when:
• The rule matches the same source, destination, and port as the Continue rule.
• The rule does not specify a Protocol of the type Protocol Agent or Protocol Tag for the Service.

For example, the rule specifies a Service element without a Protocol Agent or Protocol Tag.

Table 84: Example of a rule that does not override a Continue rule that specifies a Sidewinder Proxy

ID Source Destination Service Action

14.1 Internal network External SSM HTTP on port 80 Continue

14.7 Internal network External HTTP on port 80 Allow

In this example, the second rule does not override the first because it specifies a Service element without a
Protocol Agent or Protocol Tag. Because there is no more specific rule for the same matching criteria, the traffic
uses the Sidewinder Proxy specified in the Continue rule.

Rematching tunneled packets in Access rules
You can rematch encapsulated traffic against the Access rules.

If an engine inspects traffic that is tunneled using IP-in-IP tunneling or Generic Routing Encapsulation (GRE), the
traffic can be checked against IPv4 or IPv6 Access rules several times. The number of checks depends on the
number and type of layers in the tunnel.

For example, when an IPv4 datagram contains an IPv6 datagram, the IPv4 datagram is first matched according
to Access rules. If the tunneling Service in the Access rule specifies that the encapsulated IPv6 datagram should
be matched again, the contents are then matched against the IPv6 Access rules.

To limit the number of encapsulating layers, the engine properties define the maximum rematch count. By default,
the maximum rematch count is 1. If this count is exceeded, the packet is allowed or discarded according to the
setting specified in the engine properties and a log or an alert is generated.

Enforcing safe search features in Access rules
The safe search feature helps schools and other organizations to limit web searches and filter out potentially
offensive content from search results.

Safe search can be implemented in two ways:
• DNS-based (used by Google SafeSearch)
• Safe search based on HTTP request modification (used by, for example, Bing, Yahoo, and DuckDuckGo)
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DNS-based solution for Google SafeSearch
When DNS (TCP with Google SafeSearch) or DNS (UDP with Google SafeSearch) services are in use,
Forcepoint NGFW redirects Google searches to Google's SafeSearch service by changing the DNS response.
It forces all users to use safe search while still allowing a secure connection via HTTPS. Changing safe search
settings in the browser does not disable safe search.

HTTP request modification for Bing, Yahoo, and
DuckDuckGo searches
Use HTTP (SafeSearch) or HTTPS (SafeSearch with decryption) services to enforce safe search with Bing,
Yahoo, and DuckDuckGo. Forcepoint NGFW modifies the search request by adding a "restriction" redirect
string to the search URL to prevent offensive content from showing in the search results. TLS inspection must
be configured, and you must have decryption enabled in the Access rule for HTTPS traffic for the safe search
enforcement to apply to HTTPS.

Using Alias elements in Access rules
You can use Alias elements to create a single rule that changes in meaning depending on where it is installed.

Alias elements are one of the most useful tools for reducing the complexity of a policy. Alias elements are like
variables in a mathematical equation—their value changes depending on the component on which they are
installed. Because Alias elements are able to change their meaning to adapt to local contexts, they can be used
to create a single rule. That rule then changes in meaning depending on where it is installed. With Alias elements,
you can avoid creating multiple, near-duplicate rule sets when you have several engines. The Alias element is
used like any other network element. However, the IP addresses that the Alias element represents depends on
the engine where the rules are installed. The IP address to engine mapping is defined in the Alias element.

For example, a company has its headquarters in Helsinki and branch offices in Atlanta, Munich, Tokyo, and
Montreal. Each office has its own web server. The web server rules could be put in a single Sub-Policy, but each
location’s web server has a different IP address. Normal rules would require allowing access to all IP addresses
on all engines, which is not only unnecessary, but can also be a security risk. Using Alias elements, the company
can create a single set of rules that are still valid when applied to multiple engines. These rules would not,
however, allow access to IP addresses that are not in use on a particular engine.

The administrator of the example company can create a web server alias, $WebServers. In the Alias element’s
properties, the administrator defines what $WebServers means for each component. For the IPS engine in
Helsinki, the web server would be defined as 192.168.1.101, for the IPS engine in Tokyo as 192.168.2.101, and
so on.

When the administrator installs a policy containing the web server rules with the Alias element, the addresses are
translated to the correct address on that component. Therefore, when the policy is installed on the Helsinki IPS
engine, the Alias element translates to an IP address of 192.168.1.101. The other addresses are not included in
the policy that is transferred to that particular engine.

In this way, Alias elements simplify policies without reducing security.

Creating user-specific Access rules
You can use User and User Group elements as the source or destination of a rule to create user-specific rules.

You can optionally integrate a Forcepoint User ID Service server or a McAfee Logon Collector server with
Forcepoint NGFW to associate users in an Active Directory database with IP addresses. This makes it possible



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Access rules | 828

to use User and User Group elements as the source or destination of a rule to create user-specific rules without
requiring user authentication.

Note:  McAfee Logon Collector is only supported in Forcepoint NGFW version 5.8 or later.

User-specific rules do not replace user authentication; they are a tool to simplify the configuration of access
control, and improve the end-user experience by allowing transparent access to services. They are intended
to be used for trusted users in a trusted environment where strong authentication is not required. User-specific
rules can be used together with user authentication rules to allow some user groups to access a service, while
otherwise requiring authentication for the same service.

Using Domain Name elements in Firewall
Access rules
You can use Domain Name elements in Access rules to represent a fully qualified domain name (FQDN) that
might be associated with multiple IP addresses.

If you have specified one or more DNS servers in the engine’s properties, the engine periodically queries the
DNS server to automatically resolve domain names to IP addresses. This makes it possible to create rules that
are valid even if new addresses are added to the domain or the domain’s IP addresses change. If the DNS server
returns multiple IP addresses for the same domain name, the engine associates all the IP addresses with the
domain name. However, if there are a large number IP addresses associated with the same domain name, the
DNS server might only reply with a few of the IP addresses at a time. In this case, the engine might need to make
more queries to the DNS server to resolve all the IP addresses for the domain name. By default, the engine
queries the DNS server every six minutes. Resolved IP addresses are kept in the engine’s DNS cache for a
maximum of one hour by default.

Note:  The DNS cache is not synchronized between nodes of a cluster. Each node separately
queries the DNS server using the node’s NDI address. It is possible that the DNS cache can be
different on different nodes of a cluster.

Using Zone elements for interface matching in
Access rules
Access rules apply to all network interfaces, unless you use Zone elements to match traffic based on which
interfaces traffic passes through.

Zone elements are interface references that can combine several network interfaces of an engine into one logical
entity. Using Zones in the Source or Destination cells allows you to restrict traffic according to which interfaces
the traffic passes through. Zones can be useful, for example, when a type of traffic is only valid it when it passes
through a specific interface, but basic Anti-Spoofing allows the traffic on any interface.
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Examples of firewall Access rules
These examples illustrate some common uses for Firewall Access rules and general steps on how each example
is configured.

Example: firewall Access rule order
An example of how Access rule order affects traffic matching.

Company A has an office network, a DMZ for WWW servers, and a second DMZ for an FTP server. The
administrators only need to add rules for the DMZ traffic.

 
Figure 116: Company A's communication of special interest

The WWW servers must be accessible to anyone from both internal and external networks. HTTP traffic is
inspected against the Inspection rules, excluding the administrators’ own PCs (on the right in the illustration),
since they often test the servers for vulnerabilities. The FTP server is accessible to all users in the general office
network, but only to certain external users (on the left) that authenticate using an external authentication server.

The administrators:

1) Create Host elements for the WWW servers, the FTP server, and the administrators’ PCs.

2) Create a Group element that contains the WWW server Host elements.

3) Create a Group element that contains the administrator PCs’ Host elements.

4) Configure an external authentication server for use with the Firewall.

5) Create User and User Group elements for the allowed external FTP users.

6) Add IPv4 Access rules with the Allow action for access to the DMZs:
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Table 85: Access rules for the DMZ

Source Destination Service Authentication Action

“Administrator
PCs” Group

“WWW
Servers”
Group

“HTTP”
Service

Allow (Deep Inspection Off)

ANY “WWW
Servers”
Group

“HTTP”
Service

Allow (Deep Inspection On)

Network
element
for Office
Network

“FTP Server”
Host

“FTP”
Service

Allow (Deep Inspection Off)

ANY “FTP Server”
Host

“FTP”
Service

“External Users” User Group
Require authentication with
the external authentication
method selected

Allow (Deep Inspection Off)

• As seen in the rule table, there are two rules for traffic to both the WWW servers and the FTP server.
• The rules are arranged so that the more specific rules are above the more general rules.

For example, the rule allowing administrators to connect to the WWW servers without checking against the
Inspection rules is above the more general rule. The general rule allows any connection to the servers as
subject to the Inspection rules.

• If the first two rules were in the opposite order, the rule specific to administrators would never match, as the
rule with the source as ANY would be applied first. The connection would be allowed according to that general
rule, and the firewall would stop checking the rule table.

Example: Continue rules in firewall Access
rules
An example of using Continue rules to set default options for several Firewall Access rules.

Company B has decided to implement QoS Policies. The administrators want to set the QoS Class for traffic
using a classification of high, medium, and low for all traffic depending on the sender. High priority is assigned
to a few hosts in different networks, medium priority to one internal network, and low priority to all other hosts.
The administrators want to follow how much traffic is allowed using the highest priority. Because of this, they
also want to make sure that this traffic is logged with the accounting option turned on. They decide that the lower
priorities of traffic don't need to be permanently logged at this point, so the administrators:

1) Configure the QoS features.

2) Create elements for all high-priority hosts.

3) Add the following Access rules to the top of their policy:
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Table 86: Continue rules for Logging and QoS Class

Source Destination Service Action Logging QoS Class

Important Hosts ANY ANY Continue Stored with
accounting

High priority

Network
element for
Important
Network

ANY ANY Continue Transient Medium priority

All other Hosts ANY ANY Continue Transient Low priority

After adding these rules, individual rules can override the settings as needed. However, most of the existing
rules governing access from internal networks to the Internet now use the QoS Class and Logging options as
set in these rules.

4) Transfer the policy to the firewall.

Example: User-specific firewall Access rules
An example of using access control by user to define Firewall Access rules that only apply to specific users.

Company C has an existing Microsoft Active Directory server that it uses for user accounts in its Windows
domain. Users are divided into groups according to the department they work in. The administrators have
already integrated the Active Directory user database with the SMC to be able to view and manage Users in the
Management Client.

There is already an Access rule that blocks access to a video sharing site. However, the marketing team needs
to be able to publish videos for its new marketing campaign on the site. The administrators want to allow users in
the marketing group to access the site, but do not want to require user authentication.

Because the video sharing site has multiple servers with different IP addresses, the administrators decide to use
a Domain Name element. This element dynamically resolves the IP addresses of servers in the video sharing
site’s Internet Domain.

The administrators:

1) Integrate a Forcepoint User ID Service server with Forcepoint NGFW.

2) Add the following Access rule before the rule that blocks access to the video sharing site:

Table 87: User-Specific Access Rule

Source Destination Service Action

Marketing user
group

Domain Name
element that
represents the
video sharing site

• HTTP
• HTTPS

Allow

3) Install the policy on the firewall.
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Examples of IPS Access rules
These examples illustrate some common uses for IPS Access rules and general steps on how each example is
configured.

Example: exempting traffic from inspection in
IPS Access rules
An example of using IPS Access rules to allow specific traffic without deep inspection.

At Company A, there is an IPS engine deployed between the general office network and a subnetwork.
 
Figure 117: Company A's networks

In the subnetwork, there are several servers that provide services to the general office network as well as
the Management Server and Log Server. There is also a Firewall deployed between the internal and external
networks. There is heavy traffic to the subnetwork where the internal servers are. The administrators decide
to exempt the log transmissions between the Firewall and the Log Server from being inspected against the
Inspection Policy to reduce the IPS engine’s workload. The administrators:

1) Create an IPS policy based on the IPS Template to replace the Default IPS Policy that they have currently
installed.

2) Add a rule in the Access rules for their IPS engine:

Table 88: Access Rule for exempting traffic from inspection against the Inspection policy

Source Destination Service Action Options

Firewall Log Server SG Engine to
Log

Allow Deep inspection: Off

Example: using Access rules to filter traffic on
an inline IPS engine
An example of using IPS Access rules to filter traffic between internal networks.

Administrators at company B decide that they want more control over which hosts and ports can be used
between two networks.
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Figure 118: Company B's network

Hosts in the two networks must be able to communicate between each other using certain specific ports. Also,
one of the administrators has a workstation connected to Network A. The administrator’s workstation must have
unrestricted access to Network B. The administrators decide that the inline IPS engine provides an acceptable
level of security between two internal networks.

The administrators:

1) Create elements for network A, network B, and administration host.

2) Add new Access rules for their inline IPS engine:

Table 89: Access rules for filtering traffic

Source Destination Service Action Options

Administrator
Network B

Administrator
Network B

ANY Allow Logging: Undefined
Deep inspection: On

Network A
Network B

Network A
Network B

Service
elements
for allowed
services

Allow Logging: Undefined
Deep inspection: On

ANY ANY ANY Allow Logging: Stored
Deep inspection: (irrelevant,
because dropped traffic is
never inspected further)

• Each of the first two rules allows traffic between the Source and the Destination in both directions.
The order of the elements within the Source, Destination, and Service cells makes no difference to the
outcome of the matching process.

• The order of the rules is important. The rules above proceed correctly from most specific to the least
specific. The two first rules must be in this order, because the administrators want all connections from
the Administrator host (which is in Network A) to always match the first rule and never the second one,
since the rules have different logging options.

• The last of the added rules stops all traffic that is not allowed in the rules above to prevent unauthorized
traffic from passing.

Note:  If the inline interfaces are on a fail-open network card, traffic passes freely
whenever the IPS engine is offline regardless of what the Access rules state.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Access rules | 834



NAT rules | 835

 CHAPTER 47

NAT rules
Contents

• Getting started with NAT rules on page 835
• Configuring NAT rules on page 836
• Using NAT and NAT rules on page 839
• Examples of NAT configuration on page 843

Getting started with NAT rules
NAT rules define how NAT (network address translation) is applied to traffic.

Firewalls, Master NGFW Engines, and Virtual Firewalls can perform NAT. NAT replaces the source or destination
IP addresses in packets with other IP addresses. NAT rules are matched to allowed connections after Access
rule matching. NAT is applied before a routing decision is made, so the address translation can affect how the
traffic is routed. NAT can be applied to IPv4 and IPv6 traffic.

Note:  Master NGFW Engines always use Firewall Policies regardless of the role of the Virtual
NGFW Engines they host. Virtual Firewalls use Firewall Policies.

In addition to manually configured NAT rules, you can also use element-based NAT to define how firewalls
translate network IP addresses. The NAT rules generated from NAT definitions are applied only after the NAT
rules that you have added manually to the policy. This means that the NAT rules that are generated from NAT
definitions do not override the rules that you have manually added to the policy.

You can define the following types of NAT:
• Static source NAT. Typically translates the internal (“real”) IP address of an internal host to a different IP

address in the external network.
• Static destination NAT. Typically translates the public IP address of an internal host to the private IP address,

so that the host (server) can receive new connections from external hosts. Allows IP address or port
translation (PAT), or both.

• A combination of both of the previous types of NAT. Typically translates both the Source and Destination
IP address in the same connection. Used, for example, to allow internal hosts to access your organization’s
public servers using the public IP addresses of both the client and the server.

• Dynamic source NAT. Typically translates the internal IP addresses of several internal hosts to one or a few
external IP addresses. Used to hide the internal network structure from outsiders and to avoid acquiring a
separate public IP address for each of the hosts.

• Dynamic destination NAT can be configured for IPv4 traffic as part of the Server Pool feature (not in NAT
rules).

General guidelines for adding NAT rules:
• NAT rules only apply to connections that are handled statefully (Connection Tracking option is enabled in the

Access rule that allows the connection).
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• NAT rules are applied to whole connections; reverse NAT for reply packets is automatic, so you do not need
to define rules for replies within a connection.

• Connections are matched against NAT rules with the same type of matching criteria as other types of rules.
The first matching NAT rule is applied and any other NAT rules are ignored. To prevent a NAT rule from
matching some connections, create a NAT rule that specifies no translation for those connections and place it
above the rule that matches.

• By default, NAT rules are ignored for traffic that enters or leaves a VPN tunnel. To match such traffic against
NAT rules, enable NAT in the VPN Gateway element’s properties.

• Routing decisions are made after NAT, so remember that translating the destination address can affect how
the traffic is routed. If not included in existing definitions, you might need to add the translated addresses to
the Routing tree.

• If you install the Firewall Policy with the Keep Previous Configuration Definitions option selected, previous
NAT rules are kept until all currently open connections that use those rules are closed. In some cases, the old
and the new rules can conflict and prevent policy installation until the option is deactivated.

Configuring NAT rules
Address translation is configured as part of the Firewall Policy using NAT rules.

NAT rules are configured on the IPv4 NAT and IPv6 NAT tabs in Firewall Policy and Firewall Template Policy
elements. Firewall Sub-Policies cannot contain NAT rules.

Note:  NAT rules are applied only after a packet matches an Access rule and is allowed by the
firewall. The Access rule must have connection tracking enabled (default).

 
Figure 119: Newly inserted NAT rule

1 Source, Destination, and Service are used to match the rule to traffic.

2 The NAT cell defines how the translation is done.

3 Used on makes the rule match on particular firewalls.

The illustration shows a NAT rule that has just been inserted into a policy. The Source, Destination, and
Service cells are set to <none> and they must be changed to something else for the rule to match any traffic.
The Used on cell is also used for traffic matching: you can add specific Firewall elements in this cell to make
the rule valid only on those firewalls, or you can leave it to the default ANY to make the rule valid on all firewalls
where the policy is installed.

The following table explains briefly what each NAT rule cell does (more information is included in the task flow
later in this chapter). The columns are presented here in the default order, but you can drag and drop them to
your preferred order in your own Management Client.
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Table 90: NAT rule columns

Cell Explanation

ID (Not editable.) Automatically assigned ID number that indicates the order of the rules in the
policy. The rules are matched against traffic in the order of the ID numbers. For example,
rule 4.3 is the third rule added in this Firewall Policy element to the insert point that is the
fourth NAT rule in the upper-level Template Policy element.

Source

Destination

A list of matching criteria that defines the IP addresses and interfaces that the rule matches.
The Source and Destination cells accept any elements in the Network Elements category,
as well as User and User Group elements. Both the Source and the Destination defined
must match the source and destination of a packet for the packet to match the rule. The
addresses you insert must be valid for the address translation operation, for example, static
source address translation requires that the Source cell contains a single continuous IP
address space.

Service Allows limiting the rule’s scope to a specific protocol (similar to Access rules). The Service
cell accepts only Service elements.

NAT The network address translation that is applied to connections that match the rule. You can
also set outbound load-balancing parameters in this cell. If you leave this cell empty, address
translation is not applied to matching connections. In other words, the rule specifies that NAT
is not applied to matching connections (to make an exception to the other NAT rules below).

Used on The firewalls on which the NAT rule is applied. Used for creating NAT rules when a shared
policy is used on several different firewalls. The Used on cell accepts only Firewall and
Firewall Cluster elements.

Comment Your free-form comment for this rule. You can also add separate comment rows in between
rules.

Rule Name Contains a rule tag and optionally a rule name.

Name: (Optional) Name or description for the rule. Displayed alongside the rule tag.

Tag: (Not editable) An automatically assigned unique identifier for the rule. Works as a link
between the log entries and the rule that has generated the log entries. The rule tag consists
of two parts (for example, @180.2). The first part of the tag is permanent and belongs to only
that rule. The second part changes when the rule is changed. The first part and the second
part are separated by a period.

Hit (Not editable) Shows the number of connections that have matched the rule. This
information is only shown if you have run a Rule Counter Analysis for the policy. The cell
shows “N/A” if there is no information available about the rule.

Related concepts
Outbound load-balancing NAT on page 842

Considerations for designing NAT rules
NAT rules are processed from the top down, and more specific rules must be placed above more general rules
that match the same traffic.

The traffic is matched based on the Source, Destination, Service, and Used on cells. The Source and
Destination addresses in the cells must be valid for the address translation operation (the Source cell for source
address translation and the Destination cell for destination address translation). When the first matching rule is
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found, the NAT defined for the rule is applied and the rest of the NAT rules are ignored. All NAT operations for
the same connection must be defined in the same NAT rule (if you want to apply both source and destination
translation to a connection).

Note:  NAT is applied after an Access rule has allowed the connection but before a routing
decision is made. Make sure that the Access rules allow the connection with the original (before
NAT) addresses. Make sure that the translated (after NAT) addresses are included under the
correct interface in the Routing pane of the Engine Editor, if necessary.

If you use element-based NAT, the NAT rules generated from NAT definitions are applied only after the NAT
rules that have been added manually to the policy. This means that the NAT rules that are generated from NAT
definitions do not override the rules that you have manually added to the Firewall policy. Remember, however,
that a more specific NAT rule can prevent traffic from matching the automatically generated NAT rules.

Default elements for NAT rules
The Firewall Template contains NAT rules that exclude some system communications from address translation.

The NAT rules exclude from address translation the communications between the firewall and the Management
Server that controls it. Also the communications from the firewall to the Log Server where the firewall sends its
log data are excluded. Do not use NAT rules to translate the addresses in these system communications. Define
Locations and Contact Addresses instead.

Related concepts
NAT and system communications on page 840

Defining Source, Destination, and Service for
NAT
Source, Destination, and Service are the main matching criteria that determine if a NAT rule is applied to a
connection.

These criteria are defined in the same way as in Access rules.

Defining address translation
Address translation is defined in the NAT cell of the NAT rules.

If a connection matches the rule, the address translation defined in the NAT cell is applied. You can leave the
NAT cell empty, if you do not want to apply NAT to any connections that match the rule. Otherwise, this cell
allows you to define that the source address, the destination address, or both addresses are translated.

Static translation implies a one-to-one relationship. Therefore, in static source and destination translation, the
translated address space must be as large as the original address space.

Dynamic source translation allows a many-to-one relationship, so that several hosts can use the same IP
address. In dynamic translation, a port is reserved for each host that is communicating. Then as many hosts can
communicate simultaneously using a single IP address as there are ports in the port range you define. However,
if the ports run out, translation cannot be done and some of the communications fail. If failures happen, you might
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need to divide your dynamic translation rule and use an extra IP address for the translation. Naturally, dynamic
translation can only be applied to communications that use ports (TCP and UDP-based protocols).

Defining the Firewalls that apply the NAT rules
You can use the Used on cell in the NAT rule to limit the scope of NAT rules based on the firewall where the rule
is installed.

This way, you can install the same policy on different firewalls and create NAT rules that take into account the
different addressing in the different networks. If you leave the cell empty, the rule is applied on any firewall where
the policy is installed.

How NAT affects other firewall configurations
Translated IP addresses are used in routing, in VPN site definitions, and system communications.

After adding or editing NAT rules, you must consider how these areas of communications are affected and what
changes are needed. If you are using Multi-Link, Outbound Multi-Links have their own NAT configurations that
must not overlap with the NAT rules you define.

In particular, check that:

• Access rules and Inspection rules use the addresses that are seen in the packets as they arrive on the firewall
(as they are before any NAT operation is done).

• Routing decisions are made after NAT, so the routing decision is made using the translated address. Make
sure that the translated address is included in the Routing pane of the Engine Editor under the correct
interface, unless the packets are forwarded to the default gateway.

• If you translate addresses of communications going through VPN tunnels, the translated addresses must be
included in the VPN site definitions.

Note:  By default, NAT is disabled with connections traversing a VPN (NAT rules are completely
ignored for VPN traffic). If you want the NAT rules to apply to connections traversing a VPN,
enable NAT in the properties of the VPN element.

Using NAT and NAT rules
There are some more concepts that are useful when working with NAT.

The following sections provide further information about configuring NAT:
• NAT and system communications
• Outbound load-balancing NAT
• Proxy ARP and NAT
• Protocols and NAT

For general information about using rules, see Using policy elements and rules.
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Related concepts
NAT and system communications on page 840
Outbound load-balancing NAT on page 842
Proxy ARP and NAT on page 842
Protocols and NAT on page 843
Using policy elements and rules on page 804

NAT and system communications
If NAT is needed between SMC components, you must define Contact Addresses for the communications so that
the components use the correct address for contact when needed.

Contact Addresses are used in a NAT environment for communications of SMC components with each other and
with some external components that function as a part of the system. An example of these is a RADIUS server
used for authenticating Administrators. Contact Addresses might also be needed for site-to-site VPNs and mobile
VPNs.

The Firewall Template includes NAT rules which define that NAT is not done for communications between the
firewall where the policy is installed and the Management Server and Log Server that the firewall uses. If these
connections require NAT, the configuration must be done as explained here. Other system communications
traversing the firewall can be translated as any other connections. However, Location and Contact Address
definitions are usually still needed for those components so that they know the correct addresses to use with
each other. See Situation where contact addresses are needed scenario.

Contact Addresses are defined for Locations, which is an element that represents all devices that are routable
behind a particular interface of a NAT device. The components that need Contact Addresses are placed in the
Locations according to the Contact Address they use.

Related concepts
Situations where contact addresses are needed on page 841



 Forcepoint Next Generation Firewall 6.4 | Product Guide

NAT rules | 841

Situations where contact addresses are needed
An example of a situation in which Contact Addresses are needed.

 
Figure 120: Contact address example

In this illustration, there are several remote firewalls that are managed through Management and Log Servers at
a central site. NAT is typically applied at the following points:
• The central site firewall or an external router can provide the SMC servers external IP addresses on the

Internet. The external addresses must be defined as Contact Addresses so that the remote firewalls can
contact the servers across the Internet.

• The central firewall’s IP address can be translated by an external router. The external IP address must be
defined as a Contact Address to allow VPN connections from the remote firewalls to the central site using that
address.

• NAT can also be applied at the remote sites (by external equipment) to translate the remote firewalls’ IP
address. In this case, you must define Contact Addresses for the remote firewalls so that the Management
Server can contact them. The communications between the remote firewalls and the Management Server can
also be reversed, so that the remote firewalls open the connections to the Management Server and maintain
the connections open while waiting for commands.

When Contact Addresses are needed, a single Location to group all remote sites might be enough. The SMC
servers’ and the central firewall's definitions must include a Contact Address for the “Remote Firewalls” Location.
However, if VPN communications between firewalls from different remote sites are allowed, it is necessary to
create a Location for each remote firewall and to add further Contact Addresses for the firewalls.

Contact addresses, Location elements, and
NAT
Contact Addresses represent the translated address of a component. Location elements group components
together, so that there is no NAT between them.

The Contact Address represents the translated address of a component. Contact Addresses are defined for each
Location element. The Location element is a way to group components together, in effect telling them that there
is no NAT device between them.

The SMC components on each side of a NAT device are grouped into two separate Location elements (if
necessary, more Location elements can be used). The Contact Address is defined in each element’s properties
for the other Location. When contacting some other component in their own Location, the components always
use the untranslated address. When contacting some component outside their own Location, the contacting
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component checks if the other component has a Contact Address defined for the contacting element’s Location. If
it finds one, it uses the Contact Address. If there is no Location-specific Contact Address defined, the contacting
component checks if the element has a Default Contact Address that components belonging to any other
Location use for contacting the element. If the element does not have a Default Contact Address, the connection
is attempted using the element’s untranslated address.

For example, when a Management Server contacts a firewall node through NAT, the Management Server uses
the translated Contact Address instead of the firewall node’s real Control IP address. The NAT device in between
translates the NAT address to the firewall’s real IP address as usual.

We recommend dividing elements into different Locations based on NAT and the communications the
components have, and not just based on actual physical sites. For example, you might have one central site and
several remote sites, and the system communications take place only from each remote site to the central site
(not between the remote sites). In this case only two Locations are needed no matter how many of the firewalls
use a translated address.

Note:  If NAT is performed between a Log Server and a Management Client, you might need to
select the correct Location for the Management Client as well.

Outbound load-balancing NAT
You can use NAT for outbound load-balancing.

In addition to source and destination translation, another main use for NAT is outbound load balancing. It is
used in a Multi-Link configuration where the Firewall balances outbound traffic between two or more network
connections. To be able to direct traffic to the faster connection, the firewall translates outgoing connections to
an address from a pool assigned to each available NetLink. In this case, the IP addresses used for the NAT are
defined in the properties of the Outbound Multi-Link element.

Related concepts
Defining Multi-Link routes for firewalls on page 714
Getting started with outbound traffic management on page 739

Proxy ARP and NAT
Automatic proxy ARP requires an explicit route to the host or network to be configured in the Routing pane of the
Engine Editor.

Proxy ARP (Address Resolution Protocol) is a specification that allows a device to respond to ARP requests on
behalf of some other device on the network. When network address translation is used on a firewall, the firewall is
typically configured to use proxy ARP so that it can accept packets for the translated addresses. The firewall uses
proxy ARP instead of requiring the administrator to assign all the translation addresses to the firewall’s network
interface.

In the Firewall, proxy ARP is handled automatically. Proxy ARP is enabled by default in the NAT cell in NAT rules
for each translation type, although you can deselect it, if necessary.
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Protocols and NAT
Protocols of the Protocol Agent type help with problems related to certain complex protocols and NAT.

In some protocols, such as FTP, IP address information is included in the data payload of the packets, which do
not normally include information for routing. Protocols of the Protocol Agent can examine the data payload of
packets arriving to the firewall and also edit it. For example, when the source address is included in a packet’s
data, the firewall can translate the original source address and also the address embedded in the data.

Related concepts
Protocol Agents overview on page 1005

Examples of NAT configuration
These examples illustrate some common uses for NAT rules and the general steps on how each example is
configured.

Example: configuring NAT for dynamic source
address translation
An example of configuring NAT for dynamic source address translation.

Company A uses private IP addresses that are not routable on the Internet in their internal network. The
administrators need to translate the internal IP addresses to IP addresses that are routable on the Internet to
make it possible to use external services. The administrators:

1) Create an Address Range element “External Addresses” for two consecutive IP addresses from the pool of
addresses that they have been assigned by their Internet service provider.

2) Add a NAT rule to their Firewall Policy:

Table 91: Dynamic translation rule for opening connections to the Internet

Source Destination Service NAT

“$ Local Protected
Sites” Alias

“NOT $ Local Protected Sites”
Expression

ANY Source: Dynamic to
External Addresses
1024–65535

• The administrators use the whole range of high ports (1024–65535) for translating the addresses in this
case.

• Return address translation is done automatically. Therefore, a single rule suffices to cover all (client)
hosts that only open connections themselves, and do not need to accept new connections coming from
external networks.

3) Refresh the Firewall Policy. All internal addresses are now hidden behind two IP addresses and a range of
ports.
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Example: configuring NAT for static address
translation
An example of configuring NAT for static address translation.

Company A has set up the firewall to translate the IP addresses of all communications between the internal and
the external network dynamically. However, the company also has a mail server, which must be able to accept
connections from external networks. For this, it must have a fixed translated IP address. The administrators:

1) Create the Host element “Mail Server” to represent the mail server’s private IP address.

2) Create the Host element “Mail Server NAT” to represent the mail server’s public IP address.

3) Add two new NAT rules above the general dynamic translation rule.
• In this case, new connections can be opened both from the mail server and from external hosts, so two

rules are necessary.

4) Change the newly added NAT rules as follows:

Table 92: Static translation rules for opening connections both ways

Source Destination Service NAT

“Mail Server” Host element “NOT $ Local
Protected Sites”
Expression

“SMTP” Service
element

Source: Static from
Mail Server to Mail
Server NAT

“NOT $ Local Protected Sites”
Expression

“Mail Server NAT”
Host

“SMTP” Service
element

Destination: Static
from Mail Server NAT
to Mail Server

• The first rule is for connections that the mail server opens to external hosts.
• The second rule is for connections that external hosts open to the mail server.
• Return address translation is done automatically, so if the connection would always be opened from one

end, a single rule would suffice.

5) Refresh the Firewall Policy.

Example: configuring NAT with hosts in the
same network
An example of configuring NAT to route traffic between hosts in the same network through the firewall.

Company B has two servers running in the same DMZ network. The servers keep contact with each other to
exchange some information. The administrators want to route the traffic through the firewall so that it is logged for
reporting purposes instead of letting the servers communicate with each other directly.
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Figure 121: Company B’s network setup

The administrators first intend to just configure the servers to use the external (NAT) address of the other
server as a destination and configure the related static destination NAT rule. However, they soon realize that
the receiver would see the real source address in the communications and the replies would be sent directly,
bypassing the firewall for the reply communications. This action would obviously prevent the connections. A static
source NAT is required in addition to the static destination NAT.

The administrators:

1) Create Host elements to represent the private addresses of the two servers.

2) Create Host elements to represent the public addresses of the two servers.

3) Add two new NAT rules before any other NAT rule that would match these connections:

Table 93: Static translation rules for opening connections both ways

Source Destination Service NAT

“Server A Private”
Host

“Server B Public”
Host

ANY Source: Static from Server A Private to
Server A Public

Destination: Static from Server B Public
to Server B private.

“Server B Private”
Host

“Server A Public”
Host

ANY Source: Static from Server B Private to
Server B Public

Destination: Static from Server A Public
to Server A private.

• When the servers are configured to contact each other using the public IP addresses, the
communications are routed through the firewall.

• The Firewall translates the destination to the other server’s private IP address and the private IP address
of the source to the public IP address to “hide” the private source address from the receiving host. This
way, the replies are sent to the public IP address and routed correctly through the firewall.
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Inspection Policy elements
Contents

• Inspection Policy elements and how they work on page 847
• How Inspection Policy elements are designed on page 848
• Set default options for Exception rules in Inspection Policy elements on page 853
• Example: Tuning an Inspection Policy element to eliminate false positives for a firewall on page 853

Inspection Policy elements define how the engines look for patterns in traffic allowed through the Access rules and
what happens when a certain type of pattern is found.

Inspection Policy elements and how they
work

Inspection Policy elements define how the main traffic analysis is done for traffic that has been allowed and
selected for deep inspection in the Access rules. They define what action the engine takes when a match is
found.

The Inspection Policy elements are selected in Firewall, IPS, and Layer 2 Firewall Policy elements. The
IPS Template and Layer 2 Firewall Template enable deep inspection for all IP traffic. Deep inspection is not
automatically enabled in the Firewall Template.

Deep inspection examines the packet payload throughout whole connections, and acts when something
threatening is discovered.

NGFW Engines examine IPv4 and IPv6 traffic against traffic patterns defined in Situation elements. NGFW
Engines and Log Servers process the detected events using Correlation Situation criteria. Dynamic update
packages are the main source of Situation elements. If you want to detect a specific traffic pattern (for example,
a particular internal file server in your network being accessed) or if you want to create an edited version of some
existing Situation element, you can also define new patterns as custom Situation elements. You can add your
custom Situation elements to the Rules tree by selecting a Situation Type for them.

There are three general types of cases for using Inspection Policy elements:
• You can detect attempts to exploit known vulnerabilities in your systems and prevent such attempts from

succeeding if the system is not patched against it.
• You can monitor traffic that does not cause alarm on the surface, but when examined for certain patterns, can

turn out to conceal actual threats. For example, you can detect if a series of occasional service requests are
someone secretly scanning the network structure or if a spike in traffic is a denial-of-service attack.

• You can also detect other sequences in traffic, such as the use of certain applications or even access to a
particular file.

Based on the detection results, the Inspection Policy element provides several different ways to react when some
traffic is found to match a pattern of interest:
• Stop the traffic if it is going through a Firewall.
• Stop the traffic if it is going through an IPS engine or Layer 2 Firewall with inline interfaces.
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• Reset the connection.
• Blacklist the connection on one or more NGFW Engines.
• Allow the traffic.

Regardless of which action is taken, a match can also create:
• A log entry with or without recording some of the detected traffic.
• An alert with or without recording some of the detected traffic.

Firewalls can inspect all protocols. Virtual NGFW Engines do not individually inspect traffic. One shared
inspection process running on the Master NGFW Engine handles the inspection and correlation for all Virtual
NGFW Engines associated with the Master NGFW Engine. To prevent excessive resource consumption on the
Master NGFW Engine, take care when configuring Inspection policies for use on Virtual NGFW Engines.

Related concepts
Getting started with policies on page 787
Getting started with Situation elements on page 917

How Inspection Policy elements are
designed

Inspection Policy elements activate checks for specific traffic patterns and define what action the engine takes
when a match is found.

Firewalls, IPS engines, and Layer 2 Firewalls inspect traffic based on Situation elements, which contain the
information about traffic patterns. Patterns can trigger immediate responses or be recorded. Detected events can
be matched against Correlation Situations, which combine and further analyze the traffic-based findings to detect
more threats and produce an easy-to-read event stream.

Inspection Policy elements are selected on the Inspection tab inside the Firewall, IPS, and Layer 2 Firewall
Policy and Template Policy elements. Sub-Policies cannot contain Inspection Policy elements. You can add new
rules to the Inspection Policy elements in the Policy Editing View and also in the Logs view based on log entries.

The Inspection Policy elements has two parts:
• The Inspection tab contains the main rules for finding traffic patterns. The Rules tree is applied to all traffic

that is not handled as Exceptions.
• The Exceptions tab contains rules that match specific portions of the traffic based on Logical Interface, IP

addresses, and Ports. Exceptions have some additional options, and can also set some of those options for
the main Rules by using Continue rules.

The main Rules tree on the Inspection tab contains a tree of Situations, which are organized under Situation
Types. This tree allows you to control which inspection checks trigger a reaction and which checks are ignored.
The Rules tree defines general checks that are applied to all patterns that are not handled by a more specific
definition. It is not possible to limit the scope of the checks to certain IP addresses or Logical Interfaces in the
Rules tree.
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Figure 122: Inspection tab - Rules tree

The Exceptions are matched before the main rules. The most frequent use of Exceptions is to eliminate false
positives. This typically requires permitting a pattern for some part of the traffic while the same pattern still
triggers a reaction when it is encountered in any other traffic.

 
Figure 123: Exceptions tab

The main matching cell is the Situation cell, which contains the actual patterns. The other matching cells are
Logical Interface, Source, Destination, Protocol, and Time. The role of the other matching cells is to limit the
scope of the rule to some specific traffic. For example, the engine can take different action based on which host is
the sender or receiver of traffic identified as malicious.

Verifying and tuning Inspection Policy
elements
Tuning increases the relevancy and accuracy of the findings that the system generates.

The most common way to introduce inspection is to start with a default Inspection Policy element. Tuning the
policy is important, because a general policy that is meant to work in all environments is not necessarily suited
to your particular network environment. A tuning period is needed to activate and deactivate inspection checks
based on the findings and your needs.
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To help policy tuning, you can use the passive termination feature. When passive termination is used, the engine
creates a special log entry that notes that a certain connection would have been terminated. However, the engine
does not actually terminate the connection. This allows you to check the logs and adjust your policy without the
risk of cutting important business communications. There are two levels of activating this feature:
• Passive termination can be activated globally in the engine’s properties for the initial policy tuning.
• Later on, you can test newly added Situations by setting individual Exception rules to passive termination

mode.

For cautious introduction of new Situations introduced in dynamic update packages, you can use the Tags for the
five most recent updates (Situations > By Tag > By Situation Tag > Recent Updates).

Rule order for Inspection Policy elements
The rules in Inspection Policy elements are read from the top down. More specific rules must be placed above
more general rules that match the same traffic.

The detailed rules specific to some IP addresses and Protocols are defined as Exceptions. The general rules that
are applied to remaining traffic are defined in the Rules tree on the Inspection tab.

The traffic matching in Inspection rules and exceptions is different from other types of rules, because it is done
based on the traffic pattern definitions in Situation elements. The engines monitor the network for all patterns
included in the policy. When a pattern is found, the Inspection rules and exceptions are matched based on the
Situation element that contains the detected pattern. Inspection rules and exceptions match certain patterns only.
Non-matching traffic is passed through without any reaction.

The Situation-based configuration logic means that the behavior of the Inspection rules and exceptions can
change without anyone editing the policy directly. Just creating a Situation element can include the Situation in
the policy if the Situation is associated with a Situation Tag or Situation Type grouping included in the policy.

Actual rules can look different even if they refer to the exact same Situation, since Situations have grouping
mechanisms. However, it makes no difference in matching a pattern whether you add the Situation as a single
element or together with other Situations through a Situation Tag or Situation Type.

The Permit action allows traffic that matches the traffic pattern and the Terminate action stops traffic that matches
the pattern. A Permit action does not unconditionally allow the traffic because processing still continues to look for
other patterns. However, a Permit match does prevent the exact same Situation from matching again if it appears
at any point further down in the policy.

Example: Situation A matches a Permit rule with the logging level set to “None”. There is a second rule that
contains Situation A below the first rule with Terminate as the action and the logging level set to “Stored”. The
logs do not show any matches to Situation A and the traffic that matches the pattern continues uninterrupted.

Similarly, the Terminate action prevents the same Situation from matching again as the policy is processed to the
end, but does not prevent other Situations from matching simultaneously.

It is important to note that for the purposes of configuring the system, each Situation element is a unique pattern
(with the exception that is discussed below). Avoid defining the exact same pattern in different Situation elements
because such duplicates in the policy can create unintended results and makes the policies difficult to manage.

Example: A Continue rule sets a User Response for Situation A, which matches the URL www.example.com.
A different rule specifies Termination for Situation B, which also matches www.example.com. When the users
access the URL, their connections are terminated without a User Response, because the User Response is set
for Situation A. However, the traffic is terminated by Situation B. The configuration handles these as two separate
patterns.

The exception where one Situation is used in the configuration to prevent a different Situation from matching is
URL filtering. When you whitelist URLs, the special URL filtering Situations stop further URL-based matching.
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Example: A URL filtering category defined in Situation A prevents users from accessing www.example.com
(among other sites). The administrators add www.example.com to a custom Situation B that is permitted higher
up in the policy. Users can now access www.example.com. With other types of Situations, matching connections
would continue to be terminated if two different Situations were used.

Virtual NGFW Engines do not individually inspect traffic. One shared inspection process running on the Master
NGFW Engine handles the inspection and correlation for all Virtual NGFW Engines associated with the Master
NGFW Engine. To prevent excessive resource consumption on the Master NGFW Engine, take care when
configuring Inspection policies for use on Virtual NGFW Engines.

Related concepts
Getting started with Situation elements on page 917

Default elements for Inspection Policy
elements
Default Inspection Policy elements are introduced when you import and activate a dynamic update package. The
rules in the Inspection Policy Templates can change when you activate new update packages.

To customize inspection, you must have a custom Inspection Policy element. The predefined templates are a
good starting point for your own customization.

Note:  Keeping your system up to date with latest dynamic updates is an essential part of
maintaining your Inspection Policy elements.

Table 94: Default Inspection Policy elements

Template Description

No Inspection
Policy

Suitable for Firewall deployments, in which only packet filtering is needed. Disables deep
packet inspection.

Medium-Security
Inspection
Template

For Firewalls, Layer 2 Firewalls, inline IPS deployments in asymmetrically routed
networks, and IPS deployments in IDS mode. Terminates reliably identified attacks and
logs Situations that have some degree of inaccuracy. Low risk of false positives.

High-Security
Inspection
Template

For Firewall, Layer 2 Firewall, and inline IPS use. Extended inspection coverage and
evasion protection. Not for asymmetrically routed networks. Terminates reliably identified
attacks, and Situations that have some inaccuracy. Moderate false positive risk.

Customized High-
Security Inspection
Policy

This policy is an example of a highly customized Inspection Policy for network
environments in which unconditional inspection coverage and evasion protection are
required. The risk of false positives is high in production use.

Activating deep inspection in Access rules
Action options in the Access rules define which traffic is inspected against the Inspection Policy.

Typically, you introduce deep inspection after creating and testing initial Access rules. You must specifically
activate deep inspection for the portion of traffic that you want to deep inspect. This activation is done in the
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Access rules. You also select which Inspection Policy element is used for deep inspection on the Inspection tab
of the Firewall, IPS, or Layer 2 Firewall policy.

Related concepts
Getting started with Access rules on page 817

Activating the relevant inspection checks
The Rules tree is the main tool for controlling deep inspection.

Traffic patterns of interest are defined in Situation elements. The inspection checks are based on selecting
the reaction to the Situations when the pattern is found. It is not mandatory to create any additional Situation
elements to activate inspection checks, because there are many default Situation elements and they are
continuously updated through dynamic update packages.

The Rules tree on the Inspection tab is the main tool that allows you to select which traffic patterns are permitted
and stopped. You can also select whether a log entry or an alert is triggered, and whether matching traffic is
recorded. All Rules in the Rules tree can be edited, including overrides that have been set in a higher-level
template. The Rules tree can contain a maximum of one instance of each Situation to prevent the definitions
within the Rules tree from overlapping.

Defining Exception rules in Inspection Policy
elements
Exception rules in Inspection Policy elements allow you to make changes to the Inspection Policy that are not
applied to all connections.

The Exceptions tab allows you to create detailed rules, which are processed before the Rules tree definitions on
the Inspection tab. The Exceptions have additional features compared to the Rules tree:
• You can make exceptions to the general Rules tree definitions based on Source, Destination, and Protocol

information.
• You can set options for connection termination (including User Responses) in addition to the options that

are available in the Rules tree. The Response options define an automatic client notification for any HTTP
connection that is terminated.

• You can create Continue rules to set Action Options and general rule Options for other Exceptions and the
Rules tree. The Rules tree contains specific definitions for logging, so the logging options set with Continue
rules do not affect traffic that matches the Rules tree.

• You can create rules in Inspection Policy Template elements that cannot be changed in the inheriting policies.
• You can create rules that are applied only on certain days or times of day.

In addition to individual Situation elements, the Situation cell can contain Tag and Situation Type elements.
These elements are shown as branches in the Situations tree and allow adding the whole branch of Situations
at once to a rule. Most of the Situations you add to the Exceptions are those that you regard as false positives in
your environment. An example might be Situations for exploit attempts against an operating system that is not
used in your organization).

In the Exceptions, it is highly unusual to set the Situation cell to ANY. This is not useful in most cases because
the patterns that Situations define range widely. There are Situations that detect something as benign as the use
of particular applications and Situations that detect something as malicious as successful attacks on a server.
The ANY setting also creates unnecessary load on the engines, as a high number of Situations is checked in
each matching connection.
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Tuning Inspection Policy elements to eliminate
false positives
False positives are matches to rules and exceptions in Inspection Policy elements that are incorrect or irrelevant
in your environment.

As the Inspection rules and exceptions are matched to traffic, there are always some false positives. By tuning
the Inspection Policy element to the actual traffic and applications in your network environment, you can increase
the relevance of inspection results greatly. To eliminate a false positive, you adjust either the Inspection Rules
tree or the Exception rules depending on whether the change should be applied globally or to traffic between
specific hosts. An easy way to create new Exceptions is to use an existing log entry as the basis: you can create
Exceptions through the right-click menu of log entries.

Related concepts
Example: Tuning an Inspection Policy element to eliminate false positives for a firewall on page 853

Set default options for Exception rules in
Inspection Policy elements

The Continue action allows you to set default values for some settings in Exception rules to avoid defining the
same settings for several rules individually.

You might want to set default settings for some Exception rules to avoid defining the same settings for several
rules individually. The Continue action in Exception rules is used to set such default options in the same general
way as in the Access rules. In Exception rules, all settings in the Action Options and the Logging cell can be
set using Continue rules. However, the Rules tree on the Inspection tab ignores any logging options set with
Continue rules. In the Rules tree, the rules either inherit the logging settings from a higher level in the tree or
define a specific logging option as an override.

Related concepts
Configuring default settings for several Access rules on page 823

Example: Tuning an Inspection Policy
element to eliminate false positives for a
firewall

An example of using Exception rules in the Inspection Policy element to eliminate a false positive.

The administrators in this example have started using inspection. They have installed a policy that includes only
the rules defined in the Loose Inspection policy. When they install the Firewall Policy, they soon start receiving
alerts.
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After some investigation, the administrators realize that a custom-built application causes the alert. This
application communicates in a way that happens to match the pattern of how an attacker would carry out a
certain exploit. The custom-built application is only used by a specific server and a few clients in the internal
network. The administrators quickly edit the Inspection policies to exclude those particular hosts for the Situation
in question. The administrators:

1) Create Host elements to represent the server and the clients.

2) Create a Group element that includes the client’s Host elements.
• The administrators name the Group so that it is immediately clear from the name that the Group contains

those hosts that must contact the server running their custom-built application. This makes the new rule
easier to read than if they included the hosts directly in the rule.

3) Add the following rule on the Exceptions tab in their Inspection Policy element:

Table 95: Rule for eliminating a false positive

Situation Source Destination Action Logging

The Situation element that is
mentioned in the alerts in the
Logs view.

The Group
defining the
clients.

The Host for the
internal server.

Permit None

• If the Situation matches traffic between any other hosts than those included in the Group, the IP address
does not match the hosts defined in the new rule. The processing will continue to the next rule, which
terminates the traffic and triggers an alert.

• The logging would not have to be set to None, because it is the default option. However, the
administrators want to do so anyway to make sure any rules that they add in the future cannot
accidentally set logging on for this rule.

4) Refresh the policy on the Firewalls.
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The rules in Firewall, IPS, Layer 2 Firewall, and Layer 2 Interface Policies allow you to control how the engines inspect
and filter network traffic, and how NAT (network address translation) is applied on Firewalls, Master NGFW Engines,
and Virtual Firewalls.

Getting started with editing policies
Rules in policies are instructions to the engines for handling traffic.

What rules do
There are five main types of rules.

• Ethernet rules (IPS, Layer 2 Firewall, and Layer 2 Interface Policies only) filter traffic based on MAC
addresses and low-level network protocols. These rules can be used to segment a network.

• Access rules filter traffic based on IP addresses and IP-based protocols. These rules control access to
resources. There are separate Access rules for IPv4 and IPv6 traffic.

• NAT rules (Firewall Policy only) change source or destination IP addresses in traffic that is allowed to pass
through the firewall. NAT (network address translation) can hide the network structure and allows several
computers to use the same IP address on the Internet. There are separate NAT rules for IPv4 and IPv6 traffic.

• Inspection rules in Inspection Policies filter traffic based on patterns in any of the information that is
transferred. These rules log complex traffic use patterns and find network attacks, network worms, or other
worrying or unwanted traffic like the use of peer-to-peer file transfer applications.
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• Exceptions in Inspection Policies create detailed exceptions to the Inspection rules to eliminate false positives
and to activate blacklisting or User Responses for specific traffic patterns.

The engines process the rules one type at a time in the order previously listed. IPv4 and IPv6 traffic can be
matched to both IPv4 and IPv6 Access rules in any order if traffic is tunneled, possibly several times.

Basic rule design considerations
Keep the following in mind when editing rules:
• Rule tables are read from the top down, so the order of the rules is important. Make sure that the rules

advance logically from specific rules at the top toward more general rules at the bottom whenever the
matching criteria in rules overlap.
Example: A rule that denies access to your server from a particular network must be placed above a general
rule that allows access from any source address.

• Any two rules that have identical matching criteria are redundant and should be merged. Automatic rule
validation can be used to find such mistakes.

• When rules are matched to traffic, the traffic is compared to each rule one by one until a match is found. What
happens when the end of the rule table is reached without any matches varies by the component and the type
of rules.

• If you use element-based NAT, the NAT rules generated from NAT definitions are applied only after the NAT
rules that you have added manually to the policy. This means that the NAT rules that are generated from NAT
definitions do not override the rules that you have manually added to the policy. Remember, however, that a
more specific manually created NAT rule can prevent traffic from matching the automatically generated NAT
rules.

What do I need to know before I begin?
There are different policy types for different NGFW Engine elements.

Table 96: Policy types

Policy type NGFW Engine elements

Firewall Policy Single Firewall, Firewall Cluster, Master NGFW Engine, Virtual Firewall

Note:  Master NGFW Engines always use Firewall Policies
regardless of the role of the Virtual NGFW Engines they host.

IPS Policy Single IPS, IPS Cluster, Virtual IPS

Layer 2 Firewall Policy Single Layer 2 Firewall, Layer 2 Firewall Cluster, Virtual Layer 2 Firewall

Layer 2 Interface Policy Single Firewall, Firewall Cluster

Note:  You select the Layer 2 Interface Policy for the NGFW Engine
in the Engine Editor.

Related tasks
Create template policies or policies on page 796
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The different parts of the policy editing
view

The tabs and options shown in the policy editing view depend on the type of policy you are editing.

Note:  Only one administrator at a time can edit a policy. Save your changes and close the policy
editing view when you are finished.

All policy editing views have by default the Resources pane on the left, the rule table on the right, and the policy
toolbar at the top of the page. The available elements in the Resources pane can be used as matching criteria in
different rule cells. There are tabs for the different rule types that are available for each type of policy.

 
Figure 124: Policy editing view (IPv4 Access tab)

1 Policy toolbar

2 Rule table

3 History for selected rule

4 Search tool

In the Inspection Policy Editing view, there are only two tabs: Exceptions and Inspection. Global Inspection
rules are configured on the Inspection tab, and exceptions to global Inspection rules on the Exceptions tab.
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Figure 125: Inspection Policy Editing view

1 Detailed Exceptions to the main Inspection rules

2 The main rules tree

The policy toolbar contains tools for managing the policy.
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Figure 126: Policy toolbar

1 Preview the policy in read-only mode

2 Save

3 Save changes and install policy on engines

4 Undo or Redo

5 Show Inherited rules passed down from higher-level templates

6 Automatic validation finds rules that are clearly incorrect

7 A Snapshot is made at each policy installation to allow change tracking

8 Search tool for finding rules

9 Display the number of hits for each rule

10 Toggle between element names and IP addresses

Related tasks
Create template policies or policies on page 796
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Editing rules in a policy
Editing rules consists of defining matching criteria for different rule cells and making sure that the rules are
organized in a logical way in the rule table.

Editing rule tables
Use the right-click menu options to add, remove, and organize rules in rule tables.

You can edit the rule tables in the following ways:
• Use the actions in the right-click menu, such as add, cut, copy, paste, and move. If you right-click a cell that

has cell-specific actions, the rule-specific actions are in the Rule submenu.
• Drag and drop (move) whole rules by the rule’s ID or Tag number.

 
Figure 127: Example of a right-click menu for a rule

1 Standard editing actions are available here and as keyboard shortcuts.

2 Convert the selected rules to a Sub-Policy.

3 Temporarily disable rules without deleting them.

4 Prevents editing the rule until the rule is explicitly unlocked.

5 Create collapsible rule sections.

6 View logs related to the rule.

Editing rule cells
Rule cells define the matching criteria for the rules.

Most rule cells require you to insert elements of specific types:
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• When you click the cell, the Resources list on the left shows the types of elements that you can insert in that
cell.

• You can drag and drop the correct elements into the cell from the Resources list, from another cell, or even
between tabs.

• You can define detailed sets of matching criteria in the Definitions dialog box for the Source, Destination, and
Service cells.

• You can create new elements in the Resources list (of the types that are currently displayed).

To edit rule cells that do not accept elements, right-click the cell and select an item from the right-click menu.
 
Figure 128: Right-click menu for the Action cell in a Firewall Access rule

1 Main options for the Action cell.

2 Opens a dialog box that contains more settings for the selected Action (if any exist).

Define Source, Destination, and Service criteria
in rules
You can create detailed sets of matching criteria for the rule in the Source, Destination, and Service cells.

You can create Source and Destination Definitions for the following types of rules:

• All types of rules in Firewall Policies.
• IPv4 and IPv6 Access rules in IPS, Layer 2 Firewall, and Layer 2 Interface Policies.

The following types of items can be used as matching criteria:
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Table 97: Matching criteria for Source and Destination Definitions

User IP Address Domain Name Zone

• User names and groups
of user names of users
that have authenticated
to the NGFW Engine.

• User and User Group
elements for users
stored on an integrated
Active Directory server
in an environment with
a Forcepoint User ID
Service server installed
and configured.

Any element from the
Network Elements branch
that directly represents an
IP address.

Domain Name elements. If
DNS Server IP addresses
have been defined in
the engine properties,
the engine automatically
resolves the Internet domain
names to IP addresses.

Zone elements for
interface matching.

Note:  VPN and NAT operations can change the routing of packets, potentially causing packets
that no longer match the Destination Zone of an Access rule to be discarded.

You can create Service Definitions for IPv4 and IPv6 Access rules in Firewall, IPS, Layer 2 Firewall Policies, and
Layer 2 Interface Policies. The following types of items can be used as matching criteria:

Table 98: Matching criteria for Service Definitions

Network Application Service (Port) TLS Match

Network Application elements
for application detection.

TCP and UDP Service
elements.

TLS Match elements for application
detection. TLS Match elements must be
used with a URL Situation Element or
with a Network Application element that
contains a TLS Match.

Note:  You cannot use Network Application elements and Service elements on different rows of
the Service Definition.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Source, Destination, or Service cell and select Edit Source, Edit Destination, or Edit
Service.

2) For each row of matching criteria that you want to add:

a) Click Add Row.

b) Drag and drop elements from the list on the left to the correct cell in the row.

Note:  All items on the same row must match the traffic for the row to match. You do not
have to insert elements into all cells on the same row.

3) When you are finished adding matching criteria, click OK.
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Related concepts
Enabling access control by user on page 1084
Defining Domain Name elements on page 896
How Access rules match traffic on page 870
Getting started with Network Application elements on page 937

Related tasks
Create TLS Match elements for network application detection on page 938

Adding comments in policies
You can add comments to the Comment cell in each rule or you can insert Rule Sections to add comment rows to
the policy.

There are two ways to add comments in policies:
• The Comment cell in each rule allows you to write rule-specific comments, for example, to record why the rule

was added. The History in the Info pane shows when the rule was added and last changed and through which
administrator account. Double-click the cell to edit the comment text.

• In rule tables, you can insert Rule Sections to visually structure the policy under collapsible sections of
rules that are preceded by a comment row. Double-click the row to edit the comment text. You can set each
comment row’s color through the Colors submenu in the comment row’s right-click menu.

The maximum length of both types of comments is 4096 characters.

Rule identifiers and how they work
The ID and Tag for each rule are automatically created and updated. You can optionally specify a name for each
rule.

Each rule has two non-editable identifiers:
• The ID cell shows the order of the rules. For example, the ID 14.1.2 shows that the rule is the second rule in

the policy. It is in an insert point that is the first rule in the parent template. That insert point is the 14th rule in
the top-level parent template. The number changes as you add, remove, and move rules.

• The Tag is the unique identifier of the rule in this policy. It contains a static part that does not change when
rules are added, removed, or moved, and a changing part that indicates the version of the rule. For example,
in Tag “@274.12”, “274” is the unchanging part and “12” indicates that the rule is in its 12th revision. The tag
is used, for example, to provide links from logs to rules that created the log entries.

In addition to non-editable identifiers, you can specify an optional name for each rule.

Naming rules
You can optionally add a name or short description to a rule to help identify it.

Note:  You cannot add a name or short description to the rules on the Inspection tab of Inspection
Policies.
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In the policy editing views, the name is displayed in the Rule Name cell with the rule tag, and on the General tab
of the Info pane. In the Logs view, in statistics, and in reports, the rule name is displayed instead of the rule tag in
the Rule Tag column. If no name is specified, the rule tag is shown.

The maximum length of a name or description is 254 characters. The name does not have to be unique. Double-
click the Rule Name cell in the editing view of a policy to edit the name text.

You can search for a specific rule by its name in the Search Rules view.

Searching in rules
You can search rules in rule tables and on the Inspection tab of Inspection Policies.

In rule tables, you can search rules based on most of the cells. Select  Tools > Search Rules to display the
search at the bottom of the rule table.

In the Rules tree on the Inspection tab of Inspection Policies, you can search the Situations through type-ahead
searching. When you type a part of the name of the Situation, the tree shows only matching Situations (and their
parent Situation Types, which make up the tree branches). The currently active type-ahead search is shown at
the bottom of the tree pane.

 
Figure 129: Rule search for rule tables

1 Drag and drop or enter the search criteria in selected cells.

2 Remove all search criteria.

3 Search rules that match all or any defined criteria.

4 Do not find rules that have ANY in a cell that is used as search criterion.

5 Hide rules that do not match the defined criteria.

You can add values in different ways:

• Drag and drop elements from the rule table, from different windows and tabs, or from the resource pane
(shown in edit mode).

• Right-click a cell, then choose Select to browse for elements.
• In the Source and Destination search cells, you can manually type in IPv4 or IPv6 addresses, networks, or

address ranges. Use standard notations (for example, 192.168.1.0/16, or 192.168.10.0 - 192.168.10.101 for
IPv4 networks, or 2001:0db8:1234::/48, or 2001:0db8:1234:: - 2001:0db8:1234::100 for IPv6 networks.

• In the Comment and Rule Name search cells, you can manually type in any part of the comment or name.

Fill in the relevant cells. The cells you leave empty are ignored in the search. The first rule that matches your
search is shown on a dark green background and all other matching rules are highlighted on a light green
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background. Click  Next or  Previous to move up or down from the currently selected rule to a matching rule
above or below.

Run a rule counter analysis
Each rule contains a Hits cell that shows how many times each rule in your policy has matched network traffic.
Viewing the rule hits allows you to find valid rules that match traffic that the engine does not encounter in the
network.

This feature complements the rule validation checks, which can find rule design errors. Engines count rule hits
automatically for all rules of supported types. The hits are stored as statistical counter data on the Log Servers.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Open the policy for preview or editing, then click the tab for the type of rules that you want to examine.

3) Select an engine from the Target Engine drop-down list.
If the drop-down list is not visible, select  Tools > Target Engine Selector.

4) Select  Tools > Rule Counters.

5) From the Period drop-down list, select the period for which you want to check the rule matches.
• Select one of the existing options.
• To define a custom period, select Custom.

6) (Optional) Click Add to add other engines to the Target list.

Tip:  You can run a rule counter analysis on several engines at the same time.

7) (Optional) To select Management or Log Servers for this operation, or to include archived data, click the
Storage tab, then change the selection.
Make sure that you include the Log Servers and folders that contain data for the target engine and the period
you selected.

8) Click OK to display the rule hits. The Hit information is displayed until you close the view.
The Hit cell in each rule is filled in with the number of connections that matched the rule during the chosen
period.
If there is no statistical information about the rule with your selected criteria, the Hit cell shows N/A (for
example, for rules added after the period analyzed).

Related tasks
Validate rules automatically on page 890
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Add Insert Points in Policy Templates
Insert Points mark the positions where rules can be added.

When you edit a Template Policy, add at least one new yellow Insert Point on all tabs if you want their inheriting
Policy or Policy Template to be editable. Green Insert Points are inherited insert points from the previous level,
and they are not inherited further down in the hierarchy. They only show you where the higher-level template
allows you to add rules and disappear when you add a rule or a new (yellow) insert point.

You can add as many insert points in the Template as your rule structure calls for.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the Policy template for editing.

2) Right-click the green insert point and select Add Insert Point or a rule that is editable in this Template and
select Rule > Add Insert Point Before or Add Insert Point After.

3) Give the insert point a descriptive Name and click OK. An inheritable (yellow) insert point is added to the
Template.

Related tasks
Create template policies or policies on page 796

Automatic rules and how they work
When you enable a feature that requires traffic between certain components to be allowed, rules allowing the
traffic are automatically created.

Automatic rules are created for traffic to and from the engine, never for traffic that passes through the engine.
Some features require more specific control over what traffic is allowed between specific components, and in
those cases you still have to configure Access rules manually.

Automatic rules are not visible in rule tables, but you can view a summary of currently used Automatic rules in
the Automatic Rules section of the Engine Editor. You can also change some settings for Automatic rules in the
Engine Editor.

Automatic rules are only created if the policy that is installed on the engine contains the Automatic Rules Insert
Point. The default Template Policies in the Management Client already contain this insert point. No further action
is needed for Automatic rules to be created if you base your Template Policies and Security Policies on the
recommended default Template Policies.

If you create a Template Policy that is not based on a default Template Policy, you must add the Automatic
Rules Insert Point manually. To do this, open the Template Policy for editing, right-click the ID cell of any rule,
and select Add Automatic Rules Insert Point. You can add the Automatic Rules Insert Point anywhere in the
Template Policy.
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Configure settings for Automatic rules
View a summary of Automatic rules and manage related settings in the Engine Editor.

Before you begin
The Template Policy used on the engine must contain the Automatic Rules Insert Point.

In the Automatic Rules section of the Engine Editor, you can set the log level and possible Alert element for
Automatic rules. For Firewalls, Virtual Firewalls, and Master NGFW Engines, you can also define whether traffic
from the engine to authentication ports is allowed.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine, then select Edit <element type>.

3) Browse to Policies > Automatic Rules in the navigation pane on the left.

4) (Firewalls, Virtual Firewalls, and Master NGFW Engines only) For the Allow Traffic to Authentication Ports
setting, select Yes or No.
By default, traffic to authentication ports is allowed.

5) Using the Log Level for Automatic Rules menu, set the log level for Automatic rules to None, Alert,
Essential, Stored, or Transient.
By default, logging is set to None.

6) (Optional, only if Log Level for Automatic Rules is set to Alert) Using the Alert menu, select the Alert
element to use.

7) Click  Save.

Add Ethernet rules
Ethernet rules define which Ethernet protocol packets the engines stop, and which packets are allowed through.

Ethernet rules are used in IPS, Layer 2 Firewall, and Layer 2 Interface Policies.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Policies branch and select one of the following types of policies:



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Editing policies | 868

• IPS Policies
• Layer 2 Firewall Policies
• Layer 2 Interface Policies

3) Open a Template Policy or Policy for editing, and switch to the Ethernet tab.

4) Add the rule in one of the following ways:
• Right-click the ID cell of an existing rule and select Add Rule Before or Add Rule After.
• Copy and paste an existing rule.

5) Specify the matching criteria.

6) Right-click the Action cell, then select the Action.

7) (Optional) Define options for triggering logs and alerts.

Define logging options for Ethernet rules
Ethernet rules can create a log or alert entry each time they match.

By default, logging options set in a previous rule with Continue as its action are used. If no such rule exists, the
default logging options defined in the template policy are used.

• Layer 2 physical interfaces on Firewalls log connections by default.
• Layer 2 Firewalls and Virtual Layer 2 Firewalls log connections by default.
• IPS engines and Virtual IPS engines do not log connections by default.

Each individual rule can be set to override the default values.

When the Log Server is unavailable, log entries are temporarily stored on the engine. When the engine is running
out of space to store the log entries, it begins discarding log data in the order of importance. Monitoring data
is discarded first, followed by log entries marked as Transient and Stored, and finally log entries marked as
Essential. The Alert entries are the last log entries to be discarded.

The settings for storing the logs temporarily on the engine are defined in the engine's log spooling policy.

Note:  A log entry is generated for each packet that matches an Ethernet rule. Use careful
consideration when setting the logging options to avoid producing an excessive amount of log
data.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Double-click the Logging cell in the rule.

2) Define the options.

Related tasks
Configure log handling settings for engines on page 695
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Define MAC addresses for Ethernet rules
MAC Address elements are used to match a certain source or destination MAC address in the Ethernet rules.

The MAC Address element defines the MAC (Media Access Control) address of a network card.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Other Elements branch.

3) Right-click MAC Addresses and select New MAC Address.

4) Name the element.

5) Enter the MAC Address. You can enter any valid MAC address including, for example, the broadcast
address (ff:ff:ff:ff:ff:ff).

6) Click OK.

Add Access rules
Access rules are used in Firewall, IPS, Layer 2 Firewall, and Layer 2 Interface Policies.

Before you begin
You must have a custom Policy element and permissions to edit it.

Firewalls, IPS engines, Layer 2 Firewalls, Virtual Firewalls, Virtual IPS engines, and Virtual Layer 2 Firewalls use
both IPv4 Access rules and IPv6 Access rules. Master NGFW Engines only use IPv4 Access rules.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Policies tree and select a type of policy (for example, Firewall Policies).

3) Open a Template Policy, Policy, or Sub-Policy for editing.

4) On the IPv4 Access tab or to the IPv6 Access tab, add a rule in one of the following ways:
• Right-click the ID cell of an existing rule and select Add Rule Before or Add Rule After.
• Copy and paste an existing rule.
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5) Specify the matching criteria.

6) Right-click the Action cell, then select the Action.

7) (Optional) Define options for triggering logs and alerts.

How Access rules match traffic
Access rules match traffic based on the Source, Destination, and Service cells. You can also specify other
optional matching criteria.

The Source and Destination cells specify the IP addresses that are compared to the IP addresses in each
packet’s header. Based on these and other criteria, the rule is applied to matching packets.

The Service cell defines which protocols the Access rule applies to. The Service also determines the applications
protocol used in the Inspection Policy for matching traffic (the protocol that is detected and selected for traffic by
an Access rule is a matching criteria in the Inspection Policy). By default, the Service is set to <None>, and you
must change the value to make the rule valid.

In addition to more specific matching criteria, the matching cells can be set to two more settings:

• ANY (available by right-clicking in a cell and selecting Set to ANY) matches all valid values for the cell, for
example, all IPv4 addresses.

• NONE is the default value for mandatory traffic matching cells that have no matching criteria in them. As long
as any cell in a rule contains NONE, the whole rule is invalid and is ignored.

Using Zones in the Destination cell of Access rules
Due to the processing order of Access and NAT rules, the interface through which the packet will be sent out
is not yet determined when Access and NAT rules are processed. During the matching against Access and
NAT rules, the destination Zone is matched based on the current routing decision for the packet. NAT and VPN
operations can change the route that is used when the packet is sent out. Because of this possibility, the packet
is checked against the Access rules again before being forwarded. If the changed destination Zone still matches,
traffic is processed according to the original rule. If the changed destination Zone does not match the Access
rule, the traffic is discarded. Carefully consider how the rules will be applied when using Zones in the Destination
Cell of Access rules when NAT and VPN operations can change the routing decision.

To define how an Access rule matches traffic, fill in the cells with elements.

Related concepts
Types of traffic inspection interfaces for IPS engines on page 581
Getting started with directory servers on page 1075
Getting started with Service elements on page 903
Getting started with user authentication on page 1097

Related tasks
Create Access rules for VPN configuration 1 on page 1200
Define Source, Destination, and Service criteria in rules on page 861
Define Authentication options for Firewall Access rules on page 876
Specify rule validity times on page 889
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Defining Access rule Action options
Action Options define additional action-specific options.

In Access rules, the Action Options define more action-specific options for:
• Deep inspection
• File filtering
• Connection tracking
• Rate-based DoS protection
• Scan detection
• User responses
• Blacklisting

If no options are specified, the Action Option settings from the previous Continue rule are applied.

Related concepts
Configuring default settings for several Access rules on page 823
Getting started with basic policy-based VPN configurations on page 1197
Anti-malware scanning overview on page 1003
Configuring connection tracking on page 804

Define Action options for the Apply Blacklist
action in Access rules
The options for the Apply Blacklist action in Access rules affect the reception of blacklist entries on engines.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Action cell in an IPv4 Access rule and select Apply Blacklist.

2) Double-click the Action cell.

3) Set the options, then click OK.

Related concepts
User Response elements and how they work on page 945
Blacklisting traffic and how it works on page 1065

Related tasks
Configure scan detection settings for engines on page 697
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Define Action options for the Discard action in
Access rules
The Discard Action Options in Access rules allow you to define an automatic User Response to be shown to the
user when an HTTP connection is discarded.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Action cell in an Access rule and select Discard.

2) Double-click the Action cell.

3) Set the options, then click OK.

Related concepts
User Response elements and how they work on page 945

Related tasks
Configure scan detection settings for engines on page 697

Define Action options for the Refuse action in
Access rules
The Refuse Action Options in Access rules allow you to define an automatic User Response to be shown to the
user when an HTTP connection is refused.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Action cell in an Access rule and select Refuse.

2) Double-click the Action cell.

3) Set the options, then click OK.

Related concepts
User Response elements and how they work on page 945

Related tasks
Configure scan detection settings for engines on page 697
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Define Action options for the Jump action in
Access rules
The Jump action directs traffic to a Sub-Policy.

The Jump action in IPv4 Access rules, and Firewall IPv6 Access rules adds a conditional section of rules to the
policy. If a connection matches the Jump rule’s matching criteria, it is matched against the rules in the Sub-Policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Action cell, then select Jump.

2) Set the options, then click OK.

Define Action options for the Allow action in
Firewall Access rules
The Allow Action Options in Access rules allow you to define additional options for traffic that has been allowed.

The Allow action options define the following aspects of Firewall traffic handling:

• You can control stateful inspection by setting options for connection tracking, including idle timeouts and TCP
segment size enforcement. The effect of the connection tracking setting depends on the traffic type.

• You can enable or disable rate-based DoS protection and scan detection if they have not been disabled in the
properties of individual NGFW Engines.

• (License permitting) For IPv4 or IPv6 traffic, you can enable deep inspection to match traffic against the
Inspection Policy. You can check IPv4 traffic for malware by setting deep inspection and anti-malware options.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Action cell in a firewall Access rule, then select Allow.

2) Double-click the Action cell.

3) Set the options, then click OK.

Related concepts
Configure anti-malware on engines on page 678
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Related tasks
Define Action options for the Permit action in Exception rules on page 887
Set connection timeouts on page 693
Adjust general Firewall clustering options on page 685
Configure DoS protection settings for NGFW Engines on page 696
Configure scan detection settings for engines on page 697

Define Action options for the Continue action in
Access rules
The Continue action in Access rules allows you to set default options for multiple rules.

If the Action in an Access rule is Continue, the options specified in the Continue rule are applied to any other
Access rule that the same packet matches. However, if the Access rules have rule-specific definitions, those will
be used instead.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Action cell in an Access rule and select Continue.

2) Double-click the Action cell.

3) Configure the options, then click OK.

Define Action options for the Use VPN action in
Firewall Access rules
The Use VPN Action options define how traffic is directed into the VPN.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Action cell in a firewall Access rule and select Use VPN.

2) Set the options on the Policy-Based VPN tab.

3) Click the Inspection tab and set the options.

4) Click OK.

Related concepts
Access rules for policy-based VPNs on page 1172
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Related tasks
Redirect traffic between VPN tunnels on page 1242

Define Action options for the Allow action in
IPS and Layer 2 Firewall Access rules
The Allow Action Options in Access rules allow you to define additional options for traffic that has been allowed.

The Allow action options define how the IPS or Layer 2 Firewall engine inspects traffic.
• You can control stateful inspection by setting options for connection tracking, including idle timeouts and TCP

segment size enforcement. The effect of the connection tracking depends on the traffic type and how strictly
you want the connections to be tracked.

• You can enable or disable rate-based DoS protection and scan detection if they have not been disabled in the
properties of individual NGFW Engines.

Enable or disable deep inspection for matching traffic in the IPS and Layer 2 Firewall Access rules. If deep
inspection is disabled, the traffic is not checked against the Inspection Policy.

If you use the IPS Template or the Layer 2 Firewall Template as the basis for your policy, deep inspection is
enabled by default for all supported protocols (with Continue rules). Deep inspection can be disabled for a
specific rule if necessary. Otherwise, make sure that your custom template policy directs all necessary Protocols
to be inspected.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Action cell in an IPS or Layer 2 Firewall Access rule and select Allow.

2) Double-click the Action cell.

3) Set the options, then click OK.

Related tasks
Set connection timeouts on page 693
Adjust general Firewall clustering options on page 685
Configure DoS protection settings for NGFW Engines on page 696
Configure scan detection settings for engines on page 697

Define logging options for Access rules
Access rules can create a log or alert entry each time they match.

By default, logging options set in a previous Access rule with Continue as its action are used. If no such rule
exists, Firewalls, Virtual Firewalls, Layer 2 Firewalls, and Virtual Layer 2 Firewalls log the connections by default.
IPS engines and Virtual IPS engines do not log the connections by default. Each individual rule can be set to
override the default values.
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Note:  Log pruning might override the logging options by deleting any number of generated log
entries when they are received at the Log Server.

Logging for the closing of the connection can be turned on or off, or on with accounting information. You must
collect accounting information if you want to create reports that are based on traffic volumes.

When the Log Server is unavailable, log entries are temporarily stored on the engine. When the engine is running
out of space to store the log entries, it begins discarding log data in the order of importance. Monitoring data
is discarded first, followed by log entries marked as Transient and Stored, and finally log entries marked as
Essential. The Alert entries are the last log entries to be discarded. The settings for storing the logs temporarily
on the engine are defined in the engine's log spooling policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Double-click the Logging cell.

2) Set the options.

3) Click OK.

Related concepts
Enabling access control by user on page 1084

Related tasks
Configure log handling settings for engines on page 695

Define Authentication options for Firewall
Access rules
The Authentication options define which users can authenticate and the type of authentication required.

(IPv4 only) A mobile VPN always requires some form of authentication, but you can also add an authentication
requirement to non-VPN rules.

The authentication requirements are configured in the Authentication cell. The cell accepts User and User
Group elements to define the end users who are allowed to make connections allowed by the rule, and
Authentication Method elements to define the type of authentication required for connections that match the rule.

If the authentication fails, the connection is discarded. If the authentication succeeds, the connection is allowed
through.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Double-click the Authentication cell.

2) Configure the settings on the Parameters tab.
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3) On the Users tab, select the Users or User Groups that this rule applies to.

4) Switch to the Authentication Methods tab and select the Authentication Methods to use.

5) Click OK.

Related tasks
Create User Group elements on page 1090
Create User elements on page 1090

Add NAT rules
NAT rules define how NAT is applied to matching connections.

Before you begin
You must have a custom Policy element and permissions to edit it.

NAT rules are only available in Firewall Policy elements. NAT is not supported for layer 2 physical interfaces on
NGFW Engines in the Firewall/VPN role.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Add the NAT rule in one of the following ways:
• Right-click the ID cell of an existing NAT rule and select Add Rule Before or Add Rule After.
• Copy and paste an existing NAT rule.
• Copy and paste an Access rule to match the rule to the same Source, Destination, and Service.

2) Specify the portion of the traffic to which you want to apply NAT.

3) Define the translation you want to apply.

How NAT rules match traffic
NAT rules are matched based on IP addresses and services.

Each address translation operation places specific restrictions on what you can put in the cells. Consider the
design of your NAT rules and Access rules separately, because attempting to match the different types of rules
one-to-one is usually not effective or even possible.

To overwrite both the source and destination IP address in the same packet (for example, to achieve hairpin
NAT), configure both address translations in the same NAT rule.
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Tip:  With element-based NAT, the same connection can separately match the source and
destination NAT. Hairpin NAT is automatic.

Translate source addresses in packets
There are two types of source address translation: static source translation and dynamic source translation.

Tip:  With element-based NAT, you do not need to use separate static source and static
destination NAT rules. Static NAT is bidirectional.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Double-click the NAT cell in the NAT rule.

2) Select the translation type.

3) If you selected an address translation operation, configure the additional options according to the type of
operation.

Translate destination addresses in packets
Destination translation is typically used to translate new incoming connections from a server’s public IP address
to the server's private IP address.

Note:  Destination translation can change the routing of packets and potentially cause packets
that no longer match the Destination Zone of an Access rule to be discarded.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Double-click the NAT cell in the NAT rule.

2) On the Destination Translation tab, select the translation type.

3) Click OK.

Related concepts
How Access rules match traffic on page 870
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Examples of NAT rules
Read the following examples of NAT rules.

Example of a static source translation NAT rule
This example shows a static address translation that translates the addresses in one network to IP addresses in
another network.

In this example, the NAT is done to access a particular server on the Internet.
 
Figure 130: Example scenario

Table 99: Example NAT rule matching cells

Source Destination Service

192.168.18.0/24 213.28.200.140 HTTP

 
Figure 131: Example NAT settings

In static address translation using whole networks, each original source IP address has a static translated pair.
For example here, the host 192.168.1.6 is always translated to 193.25.25.6 and host 192.168.1.11 is always
translated to 193.25.25.11.
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Example of a dynamic source translation NAT
rule
This example shows a dynamic address translation that translates the addresses in one internal network to a
single external address for general web browsing.

 
Figure 132: Example scenario

Table 100: Example NAT rule matching cells

Source Destination Service

192.168.1.0/24 ANY HTTP

 
Figure 133: Example NAT settings

In dynamic address translation, several source IP addresses are translated using a smaller pool of translated
addresses with the help of port translation. Each client connection uses a different port on an IP address that
is shared between several different connections. Because each client reserves a port, the maximum number of
simultaneous connections can be calculated by multiplying the number of IP addresses by the number of ports
in the range. Every port and IP address pair must be free from any other use (duplicate connections cannot
successfully cross the firewall).
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Example of a destination translation NAT rule
This example shows a static address translation that translates the external IP address of a web server to the
server’s internal address.

The external IP address (213.28.200.140) of the web server is translated to the server’s internal address
(192.168.1.201).

 
Figure 134: Example scenario

Table 101: Example NAT rule matching cells

Source Destination Service

ANY 213.28.200.140 HTTP

 
Figure 135: Example NAT settings

Example of a combined source and destination
translation NAT rule
In this example, hairpin NAT is configured.

Clients in the internal network (192.168.1.0/24) contact the organization’s own public web server using the public
IP address (213.28.200.140). The server’s external address is translated to an internal address (192.168.1.201)
that belongs to the same internal network address space as the contacting clients. Source address translation is
used to prevent the server replies to the client’s original IP address. Such replies would be routed directly within
the local network instead of through the firewall, and the connections do not work without the reverse NAT that
the firewall provides.
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Figure 136: Example scenario

Table 102: Example NAT rule matching cells

Source Destination Service

192.168.1.0/24 213.28.200.140 HTTP

 
Figure 137: Example NAT settings

The NAT settings on each tab are not any different than when you apply only source translation or only
destination translation to matching connections. The key is that both definitions must be defined in the same NAT
rule, because none of the other NAT rules are considered after the first match is found.

Tip:  With element-based NAT, the same connection can separately match the source and
destination NAT. Hairpin NAT is automatic.

Add Inspection rules
Inspection rules filter traffic based on traffic patterns. Inspection rules are stored in Inspection Policy elements.

Before you begin
You must have a custom Policy element and permissions to edit it.

The rules tree on the Inspection tab is the main tool that allows you to select which traffic patterns are permitted
and stopped. You can also select whether a log entry or an alert is triggered, and whether matching traffic is
recorded.
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The rules table on the Exceptions table allows you to define detailed exceptions to the Inspection rule. The main
uses for Exceptions are to eliminate false positives and to activate blacklisting or User Responses for specific
traffic patterns.

Note:  For layer 2 physical interfaces on NGFW Engines in the Firewall/VPN role, you select the
Inspection Policy in the Firewall Policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Policies > Inspection Policies.

3) Right-click a Template Inspection Policy or Inspection Policy element, then select Edit Inspection Policy.

4) On the Inspection tab, adjust the rules.

5) (Optional) On the Exceptions tab, define exceptions.

Inspection rules tree and how it works
The rules tree is the main tool for controlling deep packet inspection in Inspection Policy elements.

The rules tree on the Inspection tab in Inspection Policies allows you to define what action the engine takes
when Situation matches are found and how they are logged. To edit these rules, click the Action cell or the
Logging cell of a rule and select the suitable option. The definitions on the Exceptions tab are matched before
the Rules tree on the Inspection tab.

In the rules tree, items that have subitems are Situation Type elements. The items that have no subitems are
individual Situation and Correlation Situation elements. The rules tree contains all Situation Types and the
Situations associated with them.

All levels of the rules tree are editable. By default, subitems inherit the Action and Logging options from their
parent item. If a subitem has any setting that differs from the parent item's settings, this is regarded an override.
If you change a value in an item that has subitems, all subitems that are set to use the default value inherit this
change. Any subitems that are set to an override continue to use that override.

Example
The parent item and 10 of the subitems are set to use the “Permit (Default)” action. Two of the subitems are
set to use the “Permit” action. You change the parent to use the “Terminate” action. Ten subitems change to
“Terminate (Default)”. Two subitems continue to use “Permit”.
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Figure 138: How overrides are highlighted in the rules tree.

1
2

1 Overrides

2 Default values shown in italics

In the list of options available in the right-click menu, “default” is included in the label. For example, “Permit
(default)” means that this action is the default action for the selected Situation Type or Situation.

Regardless of the settings in the rules tree in a higher-level Template Policy, it is still possible to change any
rules tree values in the inheriting policy. To add to a Template Policy rules that cannot be edited in the inheriting
policies, add the rules as Exceptions.

Related tasks
Configure log handling settings for engines on page 695

Add Situations to the Inspection rules tree
The Inspection rules tree can contain a maximum of one instance of each Situation to prevent the definitions
within the Rules tree from overlapping.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select the most appropriate Situation Type (these are all included at some level of the tree) as the Situation
Type in the properties of a custom Situation element.

Related tasks
Create custom Situation elements on page 919

Remove overrides from the Inspection rules
tree
You can reset branches in the rules tree to their default values.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an item in the tree and select Reset Branch.
The item you right-clicked and all its subitems are reset to the Default value.
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Define logging options for Inspection rules
Inspection rules can create a log or alert entry each time they match.

By default, an Inspection Policy uses the logging options set in a previous Exception rule with Continue as its
action. If no such rule exists, Firewalls, Virtual Firewalls, Layer 2 Firewalls, and Virtual Layer 2 Firewalls log
connections by default. IPS engines and Virtual IPS engines do not log connections by default.

Each individual Inspection rule can be set to override the default values of the engine role.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Switch to the Inspection tab.

2) Click the Logging setting of a rule and select Logging Options.

3) Set the options.

Note:  Storing or viewing the packets’ payload can be illegal in some jurisdictions due to laws
related to the privacy of communications.

Related tasks
Configure log handling settings for engines on page 695

Add Exception rules
Inspection Exceptions allow you to make changes to the Inspection Policy that are not applied to all connections.

Exception rules also allow you to set some options (using the Continue action) for Exceptions and rules that are
processed later. Exception rules also contain some additional options that are not available in the rules tree.

• You can match specific connections based on the IP addresses of the communicating hosts, the Service used,
and the Logical Interfaces of IPS engines and Layer 2 Firewalls. For example, an Exception can be used to
eliminate a false positive in traffic between two internal hosts without disabling inspection.

• You can set more responses to matches that are found. You can blacklist connections on an engine, and you
can add User Responses as notifications to some types of events.

Note:  Inspection Policies are not supported for layer 2 physical interfaces on NGFW Engines in
the Firewall/VPN role.

Related tasks
Create template policies or policies on page 796
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Add Exception rules in Inspection Policy
elements
The Exceptions tab allows you to create detailed rules that are processed before the Rules tree definitions on
the Inspection tab.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Add the Exception rule in one of the following ways:
• Right-click a generated log entry and select one of the options in the Create Rule submenu. The rule is

created as an Exception with matching details from the log entry.
• Right-click the ID cell in an existing Exception and select Add Rule Before or Add Rule After.
• Copy and paste an existing Exception rule.
• Copy and paste a rule from the Inspection tab to the Exceptions tab to match the same Situations and

options.
• Copy and paste an Access rule to match the Exception to the same Source, Destination, and Service.

2) Match the Exception rule to traffic.

3) Define the exception you want to apply.

4) (Optional) Define options for triggering logs and alerts.

Define what traffic Exception rules match
Exception rules in Inspection Policy elements are matched based on the patterns defined in Situation elements.

The traffic is checked against all patterns in the Inspection Policy. When a match is found, the Situation element
is used in looking up the rule that determines what happens to the traffic. If none of the Exceptions match, the
matching continues in the Rules tree.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Fill in the cells.
Setting a value in the Time cell is optional. All other cells must always contain a value.

Related concepts
Defining IP addresses as elements on page 895
Getting started with directory servers on page 1075
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Related tasks
Add logical interfaces on page 546
Define Source, Destination, and Service criteria in rules on page 861
Specify rule validity times on page 889

Define what action Exception rules take
The Action defines the command for the engine to carry out when a connection matches the Exception rule.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Action cell and select the action.

Define Action options for the Continue action
in Exception rules
The Continue action can set options for the Permit and Terminate actions in subsequent rules.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Action cell and select Continue.

2) Double-click the Action cell.

3) Set the options, then click OK.

Define Action options for the Permit action in
Exception rules
The options for the Permit action in Exception rules allow you to set additional options for traffic that has been
allowed.

On the Firewall, the options for the Permit action in Exception rules allow you to control the inspection options in
further detail and set a User Response for malware scanning or Situation matches.

Note:  Malware scanning is not supported on Virtual NGFW Engines.

On the IPS and the Layer 2 Firewall, the options for the Permit action in Exception rules allow you to blacklist
traffic.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Action cell, then select Permit.

2) Double-click the Action cell.

3) Set the options, then click OK.

Related concepts
Configure anti-malware on engines on page 678

Define Action options for the Terminate action
in Exception rules
The Terminate action options control connection termination, notifications, and the creation of blacklist entries.

Note:  Virtual NGFW Engines cannot send blacklist requests to other Virtual NGFW Engines.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Action cell and select Terminate.

2) Double-click the Action cell.

3) Select the action options, then click OK.

Related concepts
User Response elements and how they work on page 945

Define logging options for Exception rules
Inspection Exception rules can create a log or alert entry each time they match.

Firewalls, Virtual Firewalls, Layer 2 Firewalls, and Virtual Layer 2 Firewalls log connections by default. You can
override the default logging options in an Exception rule with Continue as its action. IPS engines and Virtual IPS
engines do not log connections by default.

Each individual Exception rule can be set to override the default values of the engine role.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Switch to the Exceptions tab.

2) Double-click the Logging cell of an Exception rule.

3) Set the options, then click OK.

Note:  Storing or viewing the packets’ payload can be illegal in some jurisdictions due to laws
related to the privacy of communications.

Related concepts
Add Exception rules on page 885

Related tasks
Configure log handling settings for engines on page 695
Add Situations to the Inspection rules tree on page 884
Remove overrides from the Inspection rules tree on page 884

Specify rule validity times
You can specify when Access rules and inspection Exception rules are applied.

You can set the validity of the rules by month, day of the week, and time of day. For example, you might have
certain rules that allow access only during business hours on weekdays. If you do not specify when a rule is valid
(the Time cell is left empty), the rule is always valid.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Double-click the Time cell in a rule.

2) Select the Month range during which the rule is effective.

3) Select one of the following:
• Days of Week — creates a weekly schedule.
• Days of Month — creates a monthly schedule.

4) In Day, select the beginning and end of the period during which the rule is enforced.

5) In Time, specify the times of day during which the rule is enforced.

Note:  The times are entered in Coordinated Universal Time (UTC). You must calculate which
UTC day and time corresponds to the time that you want to set. UTC time does not adjust for
Daylight Saving Time (summer time).
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6) Click OK.

Validate rules automatically
You can automatically validate the rules in a policy at any time.

You can also validate the policy when you install or refresh the policy on an engine. In both cases, you can also
select which issues are checked in the policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Start the policy validation in one of the following ways:
• If the policy is open in the Policy Editing view, select  Tools > Validate.
• If you are installing or refreshing a policy and the Task Properties dialog box is open, make sure that the

Validate Policy before Upload option is selected, then click Select Settings.

2) (Optional, available in the Policy Editing view) Select the Target engine on which you want to install the
policy to get more accurate results.
• The Target engine selection is used to resolve Alias elements when a policy is validated.
• If no Target engine is selected, all issues related to the engine configuration cannot be checked (for

example, parts of the VPN configuration).

3) (Optional) Edit the Validation Settings (the types of issues that are checked).

4) (Optional) Click Save as Default if you want to save the selected settings as the default set for future policy
validations.

5) Click OK.

Tip:  Any issues that are found are displayed in the Issues pane.

Start the policy validation
You can validate the rules in the Policy Editing view or when you install or refresh the policy on an engine.

In both cases, you can also select which issues are checked in the policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Start the policy validation in one of the following ways:
• If the policy is open in the Policy Editing view, select  Tools > Validate.
• If you are installing or refreshing a policy and the Task Properties dialog box is open, make sure that the

Validate Policy before Upload option is selected, then click Select Settings.
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2) (Optional, available in the Policy Editing view) Select the Target engine on which you want to install the
policy to get more accurate results.
• The Target engine selection is used to resolve Alias elements when a policy is validated.
• If no Target engine is selected, all issues related to the engine configuration cannot be checked (for

example, parts of the VPN configuration).

3) (Optional) Edit the Validation Settings (the types of issues that are checked).

4) (Optional) Click Save as Default if you want to save the selected settings as the default set for future policy
validations.

5) Click OK.

Result

Any issues that are found are displayed in the Issues pane.

Override default validation settings for rules
You can define rule-specific settings for policy validation.

The rule properties allow you to view some rule-specific information and select the settings that are applied to
the selected rule when the policy is validated. The rule-specific settings override the default validation options for
your administrator account.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Double-click the rule’s ID cell.

2) Click the Validate tab.

3) Edit the Validation Settings (the types of issues that are checked).

4) Click OK.
The selected Validation Settings are now applied to this rule when you next validate the policy. A green
checkmark is added to the rule’s ID cell in the rule table. This indicates that the Validation Settings of the rule
are different from those of the whole policy.
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Viewing policy validation issues
If policy validation finds issues, the issues are displayed in the Issues pane in the Policy Editing view or on the
tab that shows the progress of installation.

 
Figure 139: Issues pane
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2 Validate policy
and select validation properties

3 Number of found issues

4 Revalidate policy with the same validation settings

5 Rules with issues are listed by rule name

View the configuration in which a validation
issue was found
You can view the part of the configuration that caused a policy validation issue.

In rules, the ID cell shows the status of validation issues in the rule.

• If issues are found for a rule, the rule’s ID cell contains .
• If a rule’s Validation Settings override the Validation Settings of the whole policy, the rule’s ID cell contains .
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Figure 140: Rules with validation issues or rule-specific validation settings
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Double-click the issue. The relevant part of the configuration is shown.

2) Fix the issues that are indicated.

Disable validation warnings for rules
You can optionally set an issue listed in the Issues pane to be ignored for a specific rule.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the rule in the Issues pane and select Ignore Issue Type for Rule.
This issue type is no longer checked for this rule. A green checkmark is added to the rule’s ID cell in the rule
table. It shows that the rule’s Validation Settings are not the same as the policy’s Validation Settings.
You can change the overall selection of validation issues for a rule in the rules’s properties.

Exclude rules from policy validation
If you do not want to validate a certain rule in the policy, you can exclude the rule from policy validation.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the rule in the Issues pane and select Disable All Issues for the Rule.
The rule is no longer checked when you validate the policy. A green check mark is added to the rule’s ID
cell in the rule table. It shows that the rule’s Validation Settings are not the same as the policy’s Validation
Settings.
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How default rules can be changed
Rules inherited from the default Template policies cannot be edited directly. Instead, you can create a copy of the
default Template policies.

In most cases, templates and policies are inherited from the default Template policies. However, it is not possible
to edit these system elements. If you must edit the default templates, you can create a copy.

Version upgrades and dynamic updates might require changes to the default Template policies. These changes
are not applied to any copies of the templates. You must manually edit the copies to make sure that the system
communications continue to be allowed and all necessary inspection continues to be performed.

Create a custom version of a default Template
policy
It is not possible to directly edit a default Template policy. Instead, you must create a copy of the default
Template policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the template and select New > Duplicate.

2) Save the copy of the template under a different name.

3) Right-click existing policies that you want to use the edited template and select Properties.

4) Select your copy of the template in the Template pane and click OK.

CAUTION:  Incorrect modifications to the default Template policies can seriously disturb the
operation of the engines.
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 CHAPTER 50

Defining IP addresses
Contents

• Defining IP addresses as elements on page 895
• Access and modify network elements on page 900
• Edit Expression elements on page 900
• Using SMC elements to represent IP addresses in policies on page 901

When you define IP addresses as elements, you can use the same definitions in multiple configurations for multiple
components.

Defining IP addresses as elements
There are several types of elements in the SMC that represent IP addresses.

The elements that you can use for defining IP addresses are called network elements (not to be confused with
the Network element, which defines an IP network). Each element can be inserted in several places in the
Access, Inspection, or NAT rules (as source and destination of traffic). Network elements are also used in many
other places where you have to define IP addresses (for example, in routing and log filtering).

The primary tools for defining IP addresses are elements in the SMC whose only role is to define an IP address.
But elements created for configuring a feature in the SMC can also be used in policies (with some limitations) if
they represent an IP address.

Different types of elements allow you to flexibly define any set of IP addresses:
• Address Range elements allow you to define any continuous range of IP addresses.
• Alias elements represent a variable value in policies. The IP address value is filled in based on the engine on

which the policy is installed. Aliases make using the same policy on several engines practical.
• Country elements contain lists of IP addresses that are registered in a particular country.
• Domain Name elements represent all IP addresses that belong to a particular domain.
• Expression elements allow you to define any set of IP addresses in a single element. They are especially

suited for excluding some IP addresses from otherwise continuous ranges.
• Group elements allow you to combine different types of elements into a single element.
• Host elements represent a single device in the network. Each Host can represent one or more individual IP

addresses in policies.
• IP Address List elements contain IP addresses.
• Network elements represent complete network segments.
• Router elements represent a gateway device in the network and are primarily meant for configuring routing.

Each Router can represent one or more IP addresses in policies.
• Zone elements allow you to combine engines’ network interfaces into a single element.
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Defining Address Range elements
An Address Range element can specify any continuous range of IP addresses.

On the Address Range element’s NAT tab, you can view or edit the NAT definitions for the NAT configuration in
which the element is included. However, you primarily configure NAT definitions in the properties of a Firewall
engine.

Defining Alias elements
Alias elements represent different IP addresses depending on the engine on which they are used.

Alias elements are like variables: they can be given different IP address values in the policy depending on the
engine on which the policy is installed. This makes it possible to create rules that are valid on several engines
without including all IP addresses in the policies of all elements. Alias elements are especially useful in Template
Policies.

Tip:  You can view the IP addresses that the Alias represents in the policy of each component: in
a policy, select  Tools > Network Details. Then select a component from the list that is added
to the toolbar.

Some of the default system Aliases always receive their values directly from other parts of each engine’s
configuration and cannot be edited. These Aliases start with two $$ symbols. There are also some default Aliases
that either do not receive any value without your action, or allow you to add to and change the default values.
These Aliases start with one $ symbol, as do all Alias elements you create yourself.

Defining Country elements
Country elements are IP address lists based on country-level geolocation information. They are grouped within
continents.

Country elements can be used to filter traffic in Access rules, based on the source or destination country or an
entire continent. They can also be used in NAT rules, Inspection rules, and File Filtering rules.

Note:  You cannot edit or create Country elements or continents. Country elements are system
elements that are imported and updated when you activate new dynamic update packages.

Defining Domain Name elements
A Domain Name element represents all IP addresses that belong to a particular domain.

If you have entered the IP addresses of one or more DNS servers in the engine properties, the Firewall, IPS,
and Layer 2 Firewall engines periodically query the DNS server to automatically resolve domain names to IP
addresses. The use of DNS servers makes it possible to create rules that are valid even if new addresses are
added to the domain or the domain’s IP addresses change.

If the DNS server returns multiple IP addresses for the same domain name, the engine associates all IP
addresses with the domain name. However, if there are a many IP addresses associated with the same domain
name, the DNS server might only reply with a few of the IP addresses at a time. In this case, the engine might
need to make more queries to the DNS server to resolve all IP addresses for the domain name.
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By default, the engine queries the DNS server every six minutes. Resolved IP addresses are kept in the engine’s
DNS cache for a maximum of one hour by default.

Note:  The DNS cache is not synchronized between nodes of a cluster. Each node separately
queries the DNS server using the node’s NDI address. It is possible that the DNS cache might be
different on different nodes of a cluster.

Related concepts
Creating engine elements on page 472

Defining Expression elements
Expression elements allow you to combine other network elements with logical operators to represent complex
sets of IP addresses.

 
Figure 141: Expression element properties

1 2 3

4

1 Click Add Element to select an element to use in the Expression.

2 Logical operators

3 Undo and redo actions

4 The Expression

Logical Operators in Expressions are resolved in the following order (however, items inside parentheses are
evaluated before any items outside parentheses are considered):

1) Negations
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2) Intersections

3) Unions

Defining Group elements
The Group element can be used to combine any number of previously defined elements into a single element.

The elements can be of different types. You can use Group elements in policies to make the policies clearer to
read and to simplify the editing of configurations where the same elements always appear together. You can also
use Groups to add monitored elements that are displayed in the Home view.

Example: Host elements for file servers could be gathered together in a Group element, which is used in
several rules in different policies. When a new file server is introduced, it is added to the Group. The change is
propagated to all rules in all policies in which the Group is used.

On the Group element’s NAT tab, you can view or edit the NAT definitions for the NAT configuration in which the
element is included. However, you primarily configure NAT definitions in the properties of a Firewall engine.

Defining Host elements
A Host element represents the IP addresses of any single device.

Host elements are used to represent individual devices that have no additional special role in the SMC
configuration (such as being a next-hop router or an external authentication server).

You can optionally configure on the Monitoring tab that a Log Server monitors the device.

If you selected any of the options on the Monitoring tab, a new Monitoring rule for the Host is added on the
selected Log Server.

On the Host element’s NAT tab, you can view or edit the NAT definitions for the NAT configuration in which the
element is included. However, you primarily configure NAT definitions in the properties of a Firewall engine.

Defining IP Address List elements
IP Address List elements contain large lists of IP addresses, IP address ranges, or networks that can be used to
filter traffic in Access rules, NAT rules, Inspection rules, and File Filtering rules.

IP Address List elements are imported and updated when you activate new dynamic update packages. You can
also create your own IP Address List elements.

You can use IP Address List elements in Access rules to block the IP addresses used by specific services,
such as Tor, or anonymous proxies. You can also block IP address ranges used by known botnets. If there are
IP address ranges specific to your company that you want to control access to, create custom IP Address List
elements.
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Defining Network elements
A Network element represents the IP address space of a complete network or subnetwork.

On the Network element’s NAT tab, you can view or edit the NAT definitions for the NAT configuration in which
the element is included. However, you primarily configure NAT definitions in the properties of a Firewall engine.

Defining Router elements
A Router element represents a next-hop gateway’s IP address in routing configurations when the Router has a
fixed IP address.

The element can also be used to represent IP addresses in rules and other configurations as needed.

Note:  If the interface toward the next-hop gateway has a dynamic IP address, a special
Gateway (DHCP Assigned) element must be added directly through the right-click menu of the
automatically added Network (DHCP assigned) element in the Routing tree. The Gateway (DHCP
Assigned) element is not valid in policies. Use a corresponding Alias element instead.

You can optionally configure on the Monitoring tab that a Log Server monitors the device.

If you selected any of the options on the Monitoring tab, a new Monitoring rule for the Router is added on the
selected Log Server.

On the Router element’s NAT tab, you can view or edit the NAT definitions for the NAT configuration in which the
element is included. However, you primarily configure NAT definitions in the properties of a Firewall engine.

Defining Zone elements
Zone elements allow you to group network interfaces of Firewall, IPS, and Layer 2 Firewall engines.

You can use Zones to specify the receiving or sending interfaces in policies. The Zone element represents all
interfaces that belong to the Zone. All rules that include a Zone element also apply to any new interfaces that you
associate with the same Zone.

There are several predefined System Zones available:
• DMZ: interfaces connected to DMZ networks.
• External: interfaces connected to the Internet or other external networks.
• Guest: interfaces connected to guest networks.
• Internal: interfaces connected to internal networks.
• Node-internal: Firewall, IPS, and Layer 2 Firewall nodes themselves. This Zone is automatically assigned to

interfaces through which traffic to or from the engine node travels. It cannot be assigned to other interfaces,
but it can be used in policies.

Related concepts
How Access rules match traffic on page 870

Related tasks
Define Source, Destination, and Service criteria in rules on page 861
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Access and modify network elements
Network elements are different types of elements that represent IP addresses.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Network Elements.

2) To create or edit elements:
• In the right pane, click New and select an element from the drop-down list.
• In a tree view, right-click the Network Elements category or a subcategory and select New <element>.
• To create a copy of an existing element, right-click the element and select New > Duplicate.
• To edit an existing element, right-click the element and select Properties. Default system elements

cannot be edited.

Edit Expression elements
The criteria in an expression combine network elements (IP addresses) with logical operators.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Network Elements.

2) Browse to Expressions.

3) Right-click an Expression element, then select Properties.

4) Click inside the expression to display the cursor.
You can move the cursor using the arrow keys on your keyboard.

5) Click Add Element to add a new element, or click a logical operator.
Expressions can start with a negation operation or a section in parentheses.

6) To delete an element or logical operator, use the Delete or Backspace key on your keyboard.

7) Click OK to save your changes.

Examples

• Expression defining any other network but one internal network (172.16.1.0/24):
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• Expression for selecting Hosts in the Network 172.101.6.0/24 from a Group element which contains Hosts
from many different networks:

 

Using SMC elements to represent IP
addresses in policies

There are special considerations for using SMC elements in policies.

Many elements are created as part of configuring a particular feature. When such elements define an IP address
for a device, the element can also be used to represent the IP address in policies. However, there are some
special issues that might have to be considered depending on the element type.

Tip:  To view the actual IP addresses that the element adds to a policy, insert the element in a
rule, then select  Tools > Network Details.

SMC components
Using elements that represent SMC components as a source or destination IP address in policies can produce
unexpected results. Be careful especially when you use engine elements as source or destination IP addresses
in policies:
• Firewall, Single IPS, IPS Cluster, Single Layer 2 Firewall, and Layer 2 Firewall Cluster: These elements

represent all static IP addresses defined for all interfaces. Create separate Host elements to represent
individual IP addresses.

• Firewall Cluster: Represent all CVI IP addresses of all interfaces, but not the NDI addresses. Create separate
Host elements to represent individual CVI addresses and NDI addresses.

• Firewalls with dynamic IP addresses: The Firewall element does not represent any of the dynamic IP
addresses. There are default Aliases that can be used to represent the firewall’s own dynamic IP addresses in
the firewall’s own policy. Fixed IP address definitions are needed for the dynamically assigned IP addresses
when they have to be defined in the policies of any other components.

• SMC servers: Represent the single primary IP address defined for the element.
• Contact addresses are not taken into account when the element is used in a policy. Consider which IP

address has to be added to the rule and create separate Host elements for the contact addresses as
necessary.
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External Servers
Several types of external servers can be integrated with the SMC when configuring different features. In general,
each server element simply represents the single primary IP address defined in the element when used in a
policy. Some elements have additional considerations when used in policies:
• Secondary IP addresses: Many server elements can contain one or more secondary IP addresses in addition

to the primary address displayed for the element. The secondary addresses are equally valid in policies.
• Contact addresses: Some server elements can have a contact address. Contact addresses are not taken

into account when the element is used in a policy. Consider which IP address has to be added to the rule and
create separate Host elements for the contact addresses as necessary.

• Server Pools: The Server Pool element represents the external addresses that the clients contact. Use
the Server Pool in rules that allow clients’ traffic to the servers whenever you want to use the Server Pool
features. Elements that represent the individual members of the pool can be used to allow connections to
individual pool members (for example, to allow remote administration of each server).

Traffic handlers
Traffic handlers are used in Firewall Policies when configuring Multi-Link for Firewalls. They can be used in rules
in the following ways:
• In Source and Destination cells: A NetLink element represents the whole network address space that is

associated with the NetLink element. An Outbound Multi-Link element represents the network address spaces
of all NetLinks included in the Outbound Multi-Link element.

• In the NAT cell in NAT rules: When the source address is translated using the Outbound Multi-Link element as
the address space, the traffic is balanced between the included NetLinks according to the options selected for
the Outbound Multi-Link element.
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 CHAPTER 51

Working with Service elements
Contents

• Getting started with Service elements on page 903
• Creating Service elements on page 904
• Protocol elements and how they work on page 907
• Defining Protocol parameters on page 907

Service elements match traffic based on protocol or port and set options for advanced inspection of traffic. Service
elements are used in Firewall Policies, IPS Policies, Layer 2 Firewall Policies, and Layer 2 Interface Policies.

Getting started with Service elements
Service elements specify a network protocol, as well as source or destination ports for TCP and UDP traffic.

You can use Service elements to match rules to traffic in Ethernet rules (Ethernet Services), Access rules, and
NAT rules.

Services can refer to Protocol elements, which activate further inspection checks and advanced traffic handling.
Some Protocol elements have additional options that you can set in the Service element’s properties.

Most of the time, you can use the default Service elements to represent standard protocols and ports. For
example, you can enforce safe search features on the NGFW Engine by using predefined Services elements in
Access rules. However, you might need to create a custom Service in the following cases:
• If none of the default Service elements match the type of traffic you want to allow, for example, if some TCP or

UDP service in your network uses a non-standard port.
• If you want to set options for advanced traffic handling, for example:

• Access rules that disallow the use of either the active or passive FTP connection mode
• Firewall Access rules for redirection to proxy services
• Firewall Access rules and Firewall NAT rules for protocols that assign ports dynamically inside the packet

payload

 
Figure 142: Elements in the Services configuration

The configuration of Service elements consists of the following general steps:

1) Create a Service element that matches the correct protocol number and port number (if applicable).
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2) (Optional) Select one of the default Protocol elements if you want the traffic to be inspected further or if you
want to use a Protocol Agent.

3) (Optional) Add the Service to a Service Group to make it easier to insert several related Services into
configurations.

Related concepts
Enforcing safe search features in Access rules on page 826

Creating Service elements
There are predefined Service elements that correspond to reserved and commonly used protocols and ports. You
might also need to add your own custom Service elements for any non-standard ports in use or if you want to
define options for advanced traffic handling (Protocol Agents).

Create custom Service elements
Create a custom Service element if you need to match a protocol or port number that is not represented by the
default Service elements. You can also use a custom Service element to change the properties of a Service
element.

IP-based services are used in Access rules and NAT rules. Make sure that know which underlying protocol the
traffic you want to allow uses, and be aware of whether you must define a protocol number or a port number.
Usually, the Services you define yourself are TCP-based or UDP-based and are identified by the port number
they use. However, there are many common protocols that are not TCP-based or UDP-based (for example, ICMP
and RPC) and are identified by other information.

Example: The GRE protocol is transported directly over IP as protocol number 47 - on the same layer as TCP
(#6) and UDP (#17). Therefore, any custom Services created for TCP and UDP ports 47 do not allow GRE to
pass the Firewall.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Other Elements tree and select Services.

3) Create the Service element in one of the following ways:
• To create an element with no settings predefined, right-click the branch for the type of Service you want to

create, then select New > [Service type] Service.
• To create a Service based on some other Service element, right-click the existing Service, then select

New > Duplicate.

4) Give the new Service a unique Name and write an optional Comment.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Working with Service elements | 905

5) Configure the following options depending on the protocol:

Table 103: Required options for each protocol

Protocol Option

Dst. Ports (Optional)TCP and UDP

Src. Ports (Optional)

TypeICMP

Code (Optional)

Program Number

Version (Optional)

Allow TCP (Optional)

SUN RPC

Allow UDP (Optional)

IP Code

IANA assigns the protocol codes. See http://www.iana.org for a list.

6) (Optional) To associate the Service with a Protocol element, click Select next to the Protocol field and
select a Protocol element.
Selecting the Protocol is mandatory if the Service is used in an Access rule that directs packets to deep
inspection against the inspection rules. Some types of traffic might require a Protocol element of the type
Protocol Agent.

7) (Optional, not available for all Protocol elements) Set more options on the Protocol Parameters tab.

8) Click OK.

Related concepts
How Access rules match traffic on page 870

Create Ethernet Service elements
Create a custom Ethernet Service element if you need to match Ethernet-level traffic that is not represented
by the default Ethernet Service elements. You can also use a custom Ethernet Service element to change the
properties of an Ethernet Service element.

There are predefined Ethernet Service elements that correspond to commonly used Ethernet services. You can
use the predefined Ethernet Services if they meet your needs.

CAUTION:  Match any IP traffic you allow in Ethernet rules to the default IPv4 and IPv6 Services.
These Services match the traffic using the correct Protocol element. Only IP traffic matched to
the correct Protocol element is inspected further against the Access rules. Non-IP traffic is never
inspected any further.

Ethernet Services are used in IPS Policies, Layer 2 Firewall Policies, and Layer 2 Interface Policies.

http://www.iana.org
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Other Elements tree.

3) Right-click Ethernet Services and select New > Ethernet Service.

4) In the Name field, enter a unique name for the new Ethernet Service.

5) Select the Ethernet-level protocol and enter the details depending on the protocol:

Table 104: Required options for each protocol

Protocol Option

Ethernet 2 (DIX) MAC type

SSAPLLC

DSAP

VendorSNAP

Type

Note:  IEEE assigns the protocol codes. The Raw IPX and Protocol protocols do not have any
configurable options.

6) Click OK.

Create Service Group elements
Grouping several Service elements into Service Group elements simplifies your policies.

You can use the Service Group element in your policies instead of several individual Service elements. You can
group both default Service elements and custom Service elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Other Elements tree.

3) Right-click the Services or (IPS only) Ethernet Services branch according to the type of service you want to
create and select one of the following:
• New > [Service type] Service Group to create a Service Group under the branch for the selected type of

services (for example, TCP).
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• New > Service Group to create the Service Group under the Group branch (item not available if you
right-clicked Ethernet Services).

4) In the Name field, enter a unique name for the Service Group.

5) From the list on the left, select the Service elements that you want to include in the group and click Add.

6) Click OK.

Protocol elements and how they work
Protocol Elements identify traffic as being of a certain network protocol.

Protocol elements can be inserted directly in Inspection rule exceptions. In Access rules, the Protocol elements
are always contained in a Service element, which can then be inserted into the Service cell in rules. Some
Protocols add options that you can adjust to custom Service elements that you create. You cannot add or modify
the Protocol elements directly.

A Protocol element in Access rules identifies the protocol for inspection against Inspection rules. In Inspection
rules, the Protocol can be used to limit the scope of exception rules according to the Protocol (as identified in the
Access rules) in rules that otherwise match many Protocols. Also, the Protocols might activate some additional
software modules on the engines.

This action depends on the type of the Protocol element:
• Protocol Tag: a Protocol element that does not activate additional modules.
• Protocol Agent: a Protocol element that activates an additional module on the engines to provide advanced

application layer features.

Defining Protocol parameters
Many Protocols provide options for you to set in the Service that uses them.

Some of the parameters are only used by a specific type of component.

To set options for a Protocol, you must attach it to a custom Service element: either open the properties of a
custom Service you have created previously or create a Service.

Define DNS Protocol parameters
The DNS protocol parameters control DNS protocol enforcement.

When you activate this feature, the engines can determine if traffic on the DNS port is actual DNS traffic or some
other application that misuses this commonly open port. For example, peer-to-peer file transfer applications might
use this port).



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Working with Service elements | 908

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field and select
DNS.

2) On the Protocol Parameters tab, set the parameters for the Protocol.

3) Click OK.

Define FTP Protocol parameters
The FTP Protocol Agent keeps track of the ports used in File Transfer Protocol (FTP) sessions. You can also use
this Protocol Agent to redirect FTP traffic to a proxy service.

An FTP session starts with a control connection (by default, TCP port 21), and the communications continue
using a dynamically allocated port. The FTP Protocol Agent can open the actual ports used in FTP sessions as
needed so that the whole range of possible dynamic ports does not need to be allowed in the policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field and select
FTP.

2) On the Protocol Parameters tab, set the parameters for the Protocol.

Note:  Do not change options marked as Firewall Only from their default values when you
use the Service element on IPS engines or Layer 2 Firewalls.

3) Click OK.

Define GRE Protocol parameters
The Generic Routing Encapsulation (GRE) protocol is a tunneling protocol that allows the encapsulation of
network layer packets inside IP tunneling packets.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field and select
GRE.

2) On the Protocol Parameters tab, set the parameters for the Protocol.

3) Click OK.
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Define H323 Protocol parameters
The H323 Protocol Agent tracks H.323 connections.

H.323 consists of a series of different types of standards relating to, for example, video and audio services, real-
time transport, control channels and security. The H323 Protocol Agent can allow H.323 traffic through a firewall
when NAT is used.

Note:  T.120 connections, used for instance for file transfer and whiteboard drawing, are not
allowed by the H.323 Protocol Agent. To allow T.120, use the H.323 Service Group or the T.120
Service element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field and select
H323.

2) On the Protocol Parameters tab, set the parameters for the Protocol.

3) Click OK.

Define HTTP or HTTPS Protocol parameters
You can use the HTTP and HTTPS Protocol Agents to redirect traffic to a proxy service and to log the URLs from
HTTP requests.

You can also use the HTTPS agent to identify encrypted HTTPS traffic for decryption and inspection in the
Access rules, and to identify encrypted HTTPS traffic for inspection in the Inspection Policy.

You can configure parameters for the HTTP and HTTPS Protocol elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field, then select
HTTP or HTTPS.

2) On the Protocol Parameters tab, set the parameters for the Protocol.

3) Click OK.

Related concepts
How redirecting traffic for inspection works on page 1059
TLS inspection and how it works on page 1037
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Define IPv4 Encapsulation Protocol parameters
The IPv4 Encapsulation Agent provides protocol inspection for tunneled IPv4 traffic.

The parameters define if IPv4 packets encapsulated in IPv6 packets are rematched to the policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field and select
IPv4 Encapsulation.

2) On the Protocol Parameters tab, set the parameters for the Protocol.

3) Click OK.

Define IPv6 Encapsulation Protocol parameters
The IPv6 Encapsulation Agent provides protocol inspection for tunneled IPv6 traffic.

The parameters define if IPv6 packets encapsulated in IPv4 packets are rematched to the policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field and select
IPv6 Encapsulation.

2) On the Protocol Parameters tab, set the parameters for the Protocol.

3) Click OK.

Define MSRPC Protocol parameters
The MSRPC (Microsoft RPC) Protocol Agent allows related connections for the endpoint mapper (EPM) protocol.
It also handles NAT modifications for communications between Microsoft Outlook clients and Microsoft Exchange
servers.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field and select
MSRPC.

2) (Firewall only) On the Protocol Parameters tab, set the parameters for the Protocol.
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3) Click OK.

Define NetBIOS Protocol options
The NetBIOS Protocol Agent can be used to make NAT modifications in IP addresses transported in the payload
of Windows NetBIOS Datagram Service connections through the Firewall. It can also be used for deep inspection
on IPS engines and Layer 2 Firewalls.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom UDP Service you have created, click Select next to the Protocol field and
select NetBIOS (UDP).

2) On the Protocol Parameters tab, set the parameters for the Protocol Agent.

3) Click OK.

Define Oracle Protocol parameters
The Oracle Protocol Agent handles Oracle Transparent Network Substrate (TNS) protocol-based SQL*Net, Net7,
and Net8 connections.

CAUTION:  The Oracle Protocol Agent is for cases where TCP port 1521 is used only for
negotiating the port number for Oracle database connections, and the port number for the actual
connection is assigned dynamically. It must not be used in any other cases.

The Oracle Protocol Agent is meant only for non-SSL connections where the port number is assigned
dynamically. If TCP port 1521 is used for the actual database connection, do not use a Service that contains this
Protocol element. This can consume excessive resources on the firewall and lead to performance problems.
Instead, use a Service that matches TCP port 1521 without any Protocol element.

If you plan to use NAT for Oracle connections, you must configure the Oracle listener so that the listener tells the
client its original non-NATed IP address. This configuration, and the Protocol Agent itself, is necessary only if the
database is located on a different computer than the Oracle listener. The Oracle Protocol Agent does not modify
payload data because the database service connections could go through a different route than the listener
connection.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field and select
Oracle.

2) On the Protocol Parameters tab, set the parameters for the Protocol.

3) Click OK.
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Define RTSP Protocol parameters
The RTSP Protocol Agent allows RTP (Real-time Transport Protocol) and RTCP (Real-time Control Protocol)
media streaming connections initiated with RTSP through the engine.

The RTSP (Real Time Streaming Protocol) network control protocol is used for establishing and controlling media
sessions between clients and media servers. On firewalls, the Protocol Agent also handles NAT modifications to
the protocol payload.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field and select
RTSP.

2) On the Protocol Parameters tab, set the parameters for the Protocol.

3) Click OK.

Define Shell (RSH) Protocol parameters
The Shell (RSH) Protocol Agent manages Remote Shell connections and allows NAT modifications to the
standard output (stdout) stream.

Remote Shell (RSH) is a widely used remote management protocol. The Shell (RSH) Protocol Agent also
manages RExec connections.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field and select
Shell.

2) On the Protocol Parameters tab, set the parameters for the Protocol.

3) Click OK.

Define SIP Protocol parameters
The Session Initiation Protocol (SIP) agent can be used to handle multimedia connections that use SIP as their
transfer protocol.

Using the agent allows SIP to be used across a firewall that uses NAT. SIP uses TCP or UDP port 5060 to initiate
the connection, after which the traffic is allocated a dynamically assigned port. The Protocol Agent monitors the
actual ports used, so that the range of dynamic ports does not need to be allowed in the firewall policy.

The SIP agent can be configured to force the client or server address used within the SIP transport layer to be
used also for the media stream carried over SIP. This configuration is by default set for both client and server.
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Note:  Connections used for file transfer and whiteboard drawing are not allowed by the SIP
Protocol Agent. Allow them in a different rule as necessary.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field and select
SIP.

2) On the Protocol Parameters tab, set the parameters for the Protocol.

3) Click OK.

Define SMTP Protocol parameters
On Firewalls, the Simple Mail Transfer Protocol (SMTP) Protocol Agent can be used to redirect connections to a
proxy service. On Layer 2 Firewalls and IPS engines, the Protocol Agent can be used for protocol validation and
deep inspection.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field, then select
SMTP.

2) (Firewall only) On the Protocol Parameters tab, set the parameters for the Protocol Agent.

3) Click OK.

Related concepts
How redirecting traffic for inspection works on page 1059

Define SSH Protocol parameters
The SSH Protocol Agent validates the communications to make sure the protocol used really is SSH.

Secure Shell (SSH) is an encrypted remote use protocol. You can create custom SSH agents with different
settings, if necessary. The SSH Agent validates SSHv1 only. This Protocol Agent is available on Firewalls, IPS
engines, and Layer 2 Firewalls.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field and select
SSH.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Working with Service elements | 914

2) (Firewall only) On the Protocol Parameters tab, set the parameters for the Protocol.

3) Click OK.

Define SunRPC Proxy parameters
The Sun Remote Procedure Call (RPC) Protocol Agent assists the Firewall, Layer 2 Firewall, or IPS engine in
Portmapper connections.

There are both UDP and TCP-based Protocol Agents for Sun Remote Procedure Call (RPC) protocol. On
the firewall, these agents only assist the firewall in Portmapper connections. They make the handling of RPC
program numbers used in the Access rules more rapid. On IPS engines and Layer 2 Firewalls, these protocol
agents provide deep inspection.

Note:  The Protocol Agent is meant only for Portmapper connections. Allow other RPC services
using Service elements without the Protocol Agent.

The Portmapper Protocol Agents collect information about RPC services by interpreting the GET PORT and
DUMP PORTS requests and their respective answers. All information it collects is stored in the Portmapper
cache.

When the packet filter needs to evaluate RPC matches, it consults the Portmapper cache to check if the
destination of the packet has the appropriate service defined in the rule. If the cache does not have the requested
information available, the packet under evaluation is not let through and a query is sent to the destination host for
RPC information. The information received is stored in cache.

We recommend following these precautions with the RPC protocol:
• Attach the Portmapper Protocol Agent only to Portmapper connections passing through the firewall.
• Allow the firewall engine to send RPC queries.
• Optimize the structure of your security policy. See Knowledge Base article 10086 for more information.

RPC queries are sent from the firewall to TCP port 111 of the external host. You can use the SunRPC (TCP)
Service element or the SunRPC (UDP) Service element, or you can use the Portmapper Service element
with both TCP and UDP. We recommend adding the following rule above any other Portmapper rules to allow
connections without the Protocol Agent:

Table 105: Rule for RPC Queries

Source Destination Service Action

Firewall engine IP address (NDIs on clusters) Any SunRPC (TCP)

SunRPC (UDP)

Allow

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field and select
SunRPC ([TCP|UDP]).

2) (Firewall only) On the Protocol Parameters tab, set the parameters for the Protocol Agent.

https://support.forcepoint.com/KBArticle?id=Using-Sun-RPC-with-Next-Generation-Firewall
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3) Click OK.

Define TCP Proxy Protocol parameters
The TCP Proxy Protocol Agent is a legacy proxy agent that allows closing connections after a set amount of idle
time.

Note:  The TCP Proxy Protocol Agent is only supported for NGFW Engine version 6.1 or earlier.
For newer versions, use the SSM TCP Proxy Protocol Agent.

Certain TCP-based applications do not properly handle closing of connections but instead leave them open for a
long time, unnecessarily consuming resources. For such situations, the TCP proxy agent can be used to actively
close the connections after a certain idle time. The TCP Proxy Agent can also close a connection if connection
closing initiated by one of the communicating parties does not complete in a timely manner.

Apply this Protocol Agent strictly to those TCP connections that require this feature. Proxy operations use more
resources than normal TCP connection handling and therefore increase the firewall’s load.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field and select
TCP Proxy.

2) (Firewall only) On the Protocol Parameters tab, set the parameters for the Protocol Agent.

3) Click OK.

Define TFTP Protocol parameters
The Trivial File Transfer Protocol (TFTP) Protocol Agent transfers data using dynamically assigned ports.

A TFTP Agent is attached to a UDP connection established between the client and the server. The client opens
the control connection from a dynamically selected source port to the fixed destination port 69/UDP on the server.
A separate UDP data connection is established between the client and the server after the client has sent a
“read” of “write” command to the server. The server opens a data connection from a dynamic source port to the
client’s destination port. This port is same as the one used as the source port of the control connection.

The TFTP protocol (RFC 1350) does not limit the port range that can be used. This Protocol Agent is available on
Firewalls, IPS engines, and Layer 2 Firewalls. The TFTP Protocol Agent supports NAT operations (Firewall only).

The parameters in this protocol are for firewalls only.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the properties of a custom Service you have created, click Select next to the Protocol field and select
TFTP.
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2) (Firewall only) On the Protocol Parameters tab, set the parameters for the Protocol.

3) Click OK.
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Situation elements contain the context information that defines the pattern that the NGFW Engine looks for in the
inspected traffic. Situation elements also define the patterns that match events in the traffic.

Getting started with Situation elements
Situation elements define a pattern in traffic that the engine looks for.

The patterns and events are defined by selecting a Context for the Situation element. The Context contains the
information on the traffic to be matched, and the options you can set for the matching process.

The Inspection Policy defines how the Situation elements are matched to traffic and what action the engine takes
when a match is found.

Correlation Situation elements are Situation elements that group event data to find patterns in that data.

Situation elements also provide a description that is shown in the logs, and a link to relevant external information
(CVE/BID/MS/TA) in the form of a Vulnerability element attached to the Situation.

You can group Situations together using Tags. The Tag elements are shown as branches in the Situations tree
and they can be used in policies to represent all Situations that are associated with that Tag. For example, using
the Tag Windows in a rule means that the rule matches all Situations that are classified as concerning Windows
systems.

Associating a Situation with a Situation Type includes the Situation in the Rules tree in the Inspection Policy,
which is grouped according to the Situation Type.
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Depending on the Usage Context properties of a Correlation Situation, correlation can be done only on the
NGFW Engine, only on the Log Server, or on both the NGFW Engine and the Log Server. When correlation is
done only on the NGFW Engine, the Correlation Situation only matches when all correlated events are detected
by the same NGFW Engine. The following table lists the Usage Contexts for predefined Correlation Situations:

Table 106: Usage Contexts for predefined Correlation Situations

Correlation Context Usage Context

Compress Engine Only

Count Engine Only

Group Engine Only

Match Engine Only

Sequence Log Server Only

By default, correlation is done on both the NGFW Engine and the Log Server for custom Correlation Situations.

Situations configuration overview
Configuring Situation elements involves several main steps.

The Situation element uses different elements to form a representation of the traffic that you want to detect in
your Inspection Policy. The purpose of these elements is as follows:
• The Tag elements help you to create simpler policies with less effort. Tag elements represent all Situations

that are associated with that Tag. For example, using the Tag “Windows” in a rule means that the rule
matches all Situations that concern Windows systems.

• The Situation Type elements define the general category of the Situation and the branch of the Rules tree
under which the Situation appears (such as Attacks or Successful Attacks). One Situation Type can be
associated with each Situation.

• The Context element defines the traffic patterns the Situation detects. The Context binds the Situation to a
certain type of traffic and gives you a set of options or a field for entering a regular expression.

• The Vulnerability element associates your custom Situation with a commonly known vulnerability. It allows
you to attach a description of the Vulnerability and references to public vulnerability databases (which are
shown in the Logs view if a match is found).

The Context is the only mandatory element in a Situation. However, it is recommended to consistently associate
all relevant Tags with each custom Situation you create. The vulnerability description is not mandatory, but it is
helpful to have it for Situations that detect some publicly known issue.
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Figure 143: Elements in the configuration

1) Create a Situation element.

2) Give the Situation a Context, and fill in the context information according to the patterns in traffic that you
want to match.

3) (Optional) Associate the Situation with the relevant Tags.

4) (Optional) Associate the custom situation description with a relevant Vulnerability.

5) Use the Situation in the Inspection Policy.

Related concepts
Inspection Policy elements and how they work on page 847

Create custom Situation elements
You can create custom Situation elements in addition to using the predefined ones.

Before you begin
Creating new Situation elements requires detailed knowledge of the protocols that you want to inspect
and the traffic patterns related to their use.

You can create a Situation element to detect individual events or a Correlation Situation element to detect a
group of related events.

A Situation element collects together the related elements and settings and sets the severity value for the
Situation. The severity value can be set between Info (the least severe) to Critical (the most severe). You can use
the severity value to restrict which Situations added to the Situations cell are considered in Inspection Exceptions
and Alert Policies. For example, if a rule matches a large range of Situations you can create separate rules for
less severe and more severe Situations.
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The predefined Situation elements are updated through dynamic update packages. You can also create new
Situation elements to fine-tune the patterns that the engines look for in the traffic.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Other Elements branch and right-click the Situations branch in the tree view.

3) Select New > Situation or New > Correlation Situation.

4) In the Name field, enter a unique name.
Except for whitelisted URLs in URL Filtering, Situations are identified only by the element name. Creating
multiple Situations that match the same pattern can make the policy difficult to read and manage.

5) (Optional) In the Comment field, enter a comment for your reference.
The comment is only shown in the element properties and in the Info pane.

6) (Optional) Click Select and select the Situation Type with which to associate this Situation. You can only
select on Situation Type for each Situation. The Situation Type specifies the branch of the Rules tree
under which the Situation is included.

7) In the Description field, enter a description of the traffic pattern that the Situation represents.
This description is shown, for example, in log entries.

8) In the Severity drop-down list, select the severity value for the Situation.
The Severity is shown in the logs and can be used in Alert Policies as a criterion for alert escalation.

9) (Optional) In the Attacker and Target drop-down lists, select how the attacker and target are determined
when the Situation matches.
This information is used for blacklisting and in log entries.
• None does not define the Attacker and Target information, so blacklisting entries cannot be created

using the Attacker and Target options.
• IP Source and IP Destination are the IP addresses of the (last) packet that triggers the Situation.

Because the packet can be a request or a reply, make sure to select the option correctly based on the
pattern that the situation detects to avoid reversed labeling.

• Connection Source and Connection Destination IP addresses depend on which host opened the
connection and provide a constant point of reference to the client and server in the communications.

10) (Optional) Click Select to select a category for the correlation situation.

Related tasks
Add URL List elements to manually block or allow URLs on page 995
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Context options for Situation elements
Adding a Context to a Situation allows you to define what kinds of patterns you want to look for in the traffic.

For example, you can specify that you want to look for a certain character sequence in an HTTP stream from the
client to the server.

When you select a Context, you get a set of options or a field for entering a regular expression as parameters for
the Context. The parameters define the pattern you want to look for in the traffic.

Other types of context parameters are not listed in this guide. They concentrate on some aspect of a particular
kind of network traffic, and using them requires basic knowledge of the underlying network protocols. For more
information on what a particular Context is used for, see the Properties dialog box of the Context in question.

Context elements are protocol-specific, so they define what the Situation element matches. They provide a
framework for defining the parameters for each Situation. The parameters are entered as a regular expression
or through a set of fields and options that you can adjust, depending on the Context element selected. The
properties of each Context help in filling in the parameters for the Contexts.

Related tasks
Add URL List elements to manually block or allow URLs on page 995

Define Context options for Situation elements
The Context gives the Situation the information on which patterns you want it to match in the traffic.

For example, you might want to look for a certain character sequence in an HTTP stream from the client to the
server.

The Content gives you a set of options or a field for entering a regular expression that you can use to define the
pattern you want to look for in the traffic.

Note:  Except for whitelisted URLs in URL Filtering, Situations are identified only by the element
name. Avoid matching the same pattern in different Situation elements. Situations with duplicate
patterns can make the policy difficult to read and manage.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) On the Context tab of the Situation Properties dialog box, click Select.
The available Context categories are shown.
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2) Select the Context you want to associate with this Situation.

Note:
• The details related to the Contexts can be different from what is described here because

the Contexts might have been updated through dynamic update packages. Read the
Release Notes of each update package you import to see which elements are affected.

• For many Contexts, type in a regular expression.
• In other cases, open the Properties dialog box for the Context element for more

information.

The options for the selected Context are added to the Situation Properties.

Defining Context Options for Correlation
Situation elements

Correlation Contexts define the patterns for matching groups of related events in traffic.

Correlation Situations are used by NGFW Engines and Log Servers to conduct further analysis of detected
events. Correlation Situations do not handle traffic directly. Instead they analyze the events generated by
matches to Situations found in traffic. Correlation Situations use Event Binding elements to define the log events
that bind together different types of events in traffic.

Table 107: Correlation Context types

Correlation Context Type Description

Compress Combines repeated similar events into the same log entry, reducing clutter in
the Logs view.
Example: There is a custom Situation for detecting suspicious access to a
file server. An attacker is likely to browse through many files, triggering an
alert entry for each file. An Event Compress Situation can be used to combine
Situations together when the suspect’s IP address is the same.

Count Finds recurring patterns in traffic by counting how many times certain Situations
occur within the defined period, so that action can be taken if the threshold
values you set are exceeded.
Example: A Situation that detects access to a system could normally trigger just
a log entry. The Event Count Situation could be used to blacklist connections
when access by any single host is too frequent.

Group Finds event patterns in traffic by keeping track of whether all events in the
defined set of Situations match at least once in any order within the defined
time period.
Example: Individual attempts to exploit different vulnerabilities in a software
product in use on your server might not be too alarming if you know that your
system is patched against those vulnerabilities. However, when several such
events are found in a short period, it becomes more likely that someone is
trying to systematically attack the server. They might also already knows that
the server is running that particular piece of software. A Situation that belongs
to the Group Context can detect this kind of attack.
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Correlation Context Type Description

Match Allows you to use Filters to filter event data produced by specific Situations.

Sequence Finds event patterns in traffic by keeping track of whether all events in the
defined set of Situations match in a specific order within the defined time
period.
Example: Clients might use a certain type of request (for example, “give file
X”) to fetch a file from a file server. When administrators log on to the same
server, a successful administrator logon can be seen in the traffic as a certain
type of response (for example, “full access granted”). However, a vulnerability
in the server software can allow an attacker to send a specially crafted file fetch
request. This kind of request might look like a valid “give file x” command, but
actually causes the server to give the attacker administrator rights. This action
is seen as a normal-looking “full access granted” response from the server.
The Event Sequence Situation can detect when a “give file X” Situation match
is followed by a “full access granted” Situation match, which cannot be any
legitimate traffic.

Depending on the Usage Context properties of the Correlation Situation, correlation can be done only on the
NGFW Engine, only on the Log Server, or on both the NGFW Engine and the Log Server. By default, correlation
is done on both the NGFW Engine and the Log Server for custom Correlation Situations. For more information
about selecting the Usage Context, see the following Context-specific sections.

CAUTION:  In custom Correlation Situations, logging might be automatically enabled for the
correlated Situations even if the correlated Situations do not normally have logging enabled. If
the Situations produce a large amount of log data and correlation is done on the Log Server, the
increased amount of log data might overload the network or the Log Server even if no correlation
matches occur.

Define Context options for Correlation
Situation elements
Correlation Contexts define the patterns for matching groups of related events in traffic.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) On the Context tab of the Correlation Situation Properties dialog box, click Select.

2) Select the Context you want to associate with this Correlation Situation.

Related tasks
Add Tag elements to Situation elements on page 930
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Define Compress Context parameters for
Correlation Situation elements
The Compress Context combines repeated similar events into the same log entry, reducing clutter in the Logs
view.

CAUTION:  Be careful when defining the Compress Context options. You must make sure that
all event data you compress is part of the same event. Otherwise you risk losing valuable event
information.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Browse to the Situations you want to compress in the left pane of the dialog box and drag and drop them into
the Correlated Situations field.

CAUTION:  In custom Correlation Situations, logging might be automatically enabled for the
correlated Situations even if the correlated Situations do not normally have logging enabled. If
the Situations produce a large amount of log data and correlation is done on the Log Server,
the increased amount of log data might overload the network or the Log Server even if no
correlation matches occur.

2) Enter the Time Window Size in seconds. The matches to the Situations selected are combined to a
common log entry when they are triggered within the defined time period.

3) Enter the Events per Window. This defines the maximum number of events that are forwarded within the
Time Window defined.

4) Select a Log Fields Enabled option.

5) Double-click the Event Binding field and select the Event Binding that is used by the matching option you
selected in the previous step.

6) Select a Location to determine the execution order of this Compress operation in relation to other Compress
operations. Operations that share the Location are executed in parallel; each compress operation receives
the same events as the other compress operations in the same Location. The next Location receives only
the events that are left after the compression.

CAUTION:  Be careful when using the Early or Very Early Locations. The compression can
affect the other types of correlation tasks.

7) Click Edit and define a Compress filter in the Local Filter Properties dialog box. The filter is used for filtering
data to be included in the compression.

8) Make sure that Engine Only is selected as the Usage Context.

Note:  The purpose of the Compress context is to reduce the amount of data that is sent to
the Log Server. Including the Log Server in the Usage Context of a Compress context actually
increases the amount of data that is sent to the Log Server.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Defining Situation elements | 925

Related concepts
Creating and editing local filters on page 295

Define Count Context parameters
The Count Context finds recurring patterns in traffic by counting how many times certain Situations occur within
the defined period. Action can then be taken if the threshold values you set are exceeded.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Browse to the Situations you want to count in the left pane and drag and drop them to the Correlated
Situations field.

Note:  In custom Correlation Situations, logging might be automatically enabled for the
correlated Situations even if the correlated Situations do not normally have logging enabled. If
the Situations produce a large amount of log data and correlation is done on the Log Server,
the increased amount of log data might overload the network or the Log Server even if no
correlation matches occur.

2) Enter the Time Window Size in seconds. All events must occur during this length of time for the Correlation
Situation to match.

3) Enter the Alarm Threshold number. This is the number of times that the event must occur for the
Correlation Situation to match.

4) Select a Log Fields Enabled option.

5) Double-click the Event Binding field and select the Event Binding that is used by the matching option you
selected in the previous step.

6) (Optional) Select the Usage Context to define where correlation is done.

Note:  If you select a Usage Context that does not include the Log Server, events only match
if they are all detected by the same NGFW Engine or NGFW Engine Cluster.

Define Group Context parameters for
Correlation Situation elements
The Group context finds event patterns in traffic by keeping track of whether all events in the defined set of
Situations match at least once in any order within the defined time period.

The Group context has a table that allows you to define local filters and log fields for selecting which details are
considered when events are grouped. In this context, the order in which the events occur is not relevant. If you
would like the order of the events to matter, use the Sequence context instead.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Double-click the Event Match cells for each Member cell and define a local filter. The local filter selects the
events for examination.
You can add and remove members using the buttons to the right (to remove a member, first select a cell
within that member’s column).

2) Double-click the Needed Number cell of each member and enter the number of occurrences of the Event
Match that are required for the events to be grouped.

3) Double-click the Event Binding field and select the Event Binding that defines the set of log events to
match.

4) Drag and drop the relevant Situations to the Correlated Situations field.

5) Select whether you want to Keep and Forward Events.

6) Enter the Time Window Size in seconds. All events must occur during this length of time for the Correlation
Situation to match.

7) Select whether you want to trigger Continuous Responses.

8) (Optional) Select the Usage Context to define where correlation is done.

Note:  If you select a Usage Context that does not include the Log Server, events only match
if they are all detected by the same NGFW Engine or NGFW Engine Cluster.

Related tasks
Create or edit Filter elements on page 298

Define Match Context parameters for
Correlation Situation elements
The Match context allows you to use Filters to filter event data produced by specific Situations.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Browse to the Situations you want to count in the left pane of the dialog box and drag and drop them into the
Correlated Situations field.

CAUTION:  In custom Correlation Situations, logging might be automatically enabled for the
correlated Situations even if the correlated Situations do not normally have logging enabled. If
the Situations produce a large amount of log data and correlation is done on the Log Server,
the increased amount of log data might overload the network or the Log Server even if no
correlation matches occur.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Defining Situation elements | 927

2) Click Edit and define a local filter.

3) (Optional) Select the Usage Context to define where correlation is done.

Note:  If you select a Usage Context that does not include the Log Server, events only match
if they are all detected by the same NGFW Engine or NGFW Engine Cluster.

Related concepts
Creating and editing local filters on page 295

Define Sequence Context parameters for
Correlation Situation elements
The Sequence context finds event patterns in traffic by keeping track of whether all events in the defined set of
Situations match in a specific order within the defined time period.

The Sequence context has a table you can use to define, in order from left to right, the events that comprise a
sequence. This context allows detecting events such as when a request from a client triggers one pattern and the
response from a server triggers a second pattern.

The table has gray and white cells; white cells must be filled, gray cells are left empty. If you would like to match
events regardless of the order in which they occur, use the Group context instead.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Double-click the Event Match cell and define a local filter.

2) Double-click the Event Binding field and select the Event Binding that defines the set of log events to
match.

3) Click Add Event Before or Add Event After to add more Event rows.
• Define the Event Match for each row.
• Define the Event Binding for each row.

4) When you are finished defining the sequence, drag and drop the relevant Situations in the Correlated
Situations field below the table.

5) Select whether you want to Keep and Forward Events.

6) Enter the Time Window Size in seconds. All events must occur during this length of time for the Correlation
Situation to match.

7) Select one of the following options as the Usage Context:
• Engine and Log Server.
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• Log Server Only.

Note:  If you select a Usage Context that does not include the Log Server, events only match
if they are all detected by the same NGFW Engine or NGFW Engine Cluster.

Related concepts
Creating and editing local filters on page 295

Anti-Malware Contexts for Situation
elements

Anti-Malware Contexts are used to detect malware in HTTP, HTTPS, IMAP, POP3, and SMTP protocol traffic.

DoS Detection Contexts for Situation
elements

The DoS detection Contexts provide parameters for detecting DoS (Denial of Service) events in network traffic.

Scan Detection Contexts for Situation
elements

The Scan detection Contexts provide parameters for detecting attempts to scan which IP addresses are in use or
which ports are open in your systems.

Protocol-specific Contexts for Situation
elements

The protocol-specific Contexts are used to detect a particular characteristic in the network traffic.

For example, you can detect a certain option number used in IP packets, or set the maximum length for particular
arguments in FTP commands. You can also use the HTTP URL Filter to allow or deny access to specific
websites (Not supported on Layer 2 Firewalls).

For Contexts that have particular values to be filled in (instead of a regular expression), the parameters you
define in the Contexts often actually determine what is regarded as normal. This means that anything above/
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below/outside/not matching these values is regarded as a match for the Situation. In some cases, you might
define what the Situation does not match.

Effective modifications to the protocol-specific Contexts require you to be familiar with the protocols in question
and how the traffic in your network uses those protocols.

File Contexts for Situation elements
The File Contexts are used to detect malicious or suspicious content in transferred files regardless of the
transport protocol used.

When a file is detected, the file is inspected to identify the file type. Once the file type is identified, more specific
inspection can be applied to the file.

System Contexts for Situation elements
The System Contexts are used for errors and other system events.

The System Contexts are internal to the SMC, and they cannot be edited in any way.

Default elements for Situation elements
There are many predefined Contexts, Situations, Tags, and Vulnerabilities.

Predefined Contexts, Situations, Tags, and Vulnerabilities are imported and updated from dynamic update
packages. This also means that the set of elements available changes whenever you update your system with
new definitions. Both Situation elements and Context elements have a comment and a longer description that you
can view in the Management Client. This information is shown in the Info pane or in the Properties dialog for the
element and explains what each element is meant for.

The Release Notes of each dynamic update package list the new elements that the update introduces. If your
Management Server can connect to the Forcepoint website, you can view the Release Notes directly through the
Management Client.

Using Tags with Situation elements
Tag elements collect together several Situations that have something in common.

For example, you can use Tag elements to group Situations that detect threats against a particular Operating
System. Tags are shown as branches in the Situations tree. Tag elements help you organize the tree, and you
can use the Tags in the Inspection Policy to easily match the rule to all Situations that reference the Tag.

https://support.forcepoint.com/Documentation
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Create new Tag elements for Situation and
Vulnerability elements
Tag elements collect together several Situations and Vulnerabilities that have something in common.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Situations or Other Elements > Vulnerabilities.

3) Right-click the By Tag branch, then select New > <Tag Type>.

4) Enter a Name and optionally a Comment for the new Tag, then click OK.
The new Tag is added to the tree under the main category you selected in the previous step.

Add Tag elements to Situation elements
You can use Tag elements to group Situation elements and Situation Type elements to classify Situations.

You can use predefined Tags or create new ones according to any criteria (for example, create a Tag for
grouping together related services). Situation Types are predefined, and you cannot create new Situation Types.
You can associate multiple Tags with one Situation, but only one Situation Type can be associated with each
Situation.

You can use the Tags and/or Situation Types to represent a group of Situations in the Rules and Exceptions
of the Inspection Policy. This allows you to match a rule to all Situations that contain the Tag or Situation Type.
Situations that are associated with a Situation Type are automatically included in the Rules tree.

When you are editing the Situation properties, you can add tags.

Note:  If a Tag or Situation Type you add to a Situation is in use in some Inspection Policy, the
new Situation is automatically included in the policy when you save the Situation. The engines
start matching traffic to the Situation when you refresh the policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Situation properties, switch to the Tags tab.

2) Click Add Tags and select a Tag type from the list that opens.

3) Select the Tags you want to use with this Situation and click Select.

4) Click OK to confirm the Situation properties change.
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Add Tag elements to several Situation
elements from the element tree
You can add the same Tag element to several Situation elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Other Elements > Situations branch of the element tree and browse to the Situations you want
to tag.

3) Ctrl-select or Shift-select the Situations that you want to tag.

4) Right-click one of the selected Situations and select Add Tag.
The tag types are shown in a submenu.

5) Select the type of Tag you want to add.

6) Select the Tags you want to attach to the Situations.

Remove Tag elements from Situation elements
You can remove custom Tag elements that administrators have added.

The default Tags in System Situations (provided in Update Packages) cannot be removed.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Other Elements > Situations branch of the element tree and browse to the Situations you want
to edit.

3) Right-click the Situation and select Properties.

4) Switch to the Tags tab.

5) Right-click the Tag you want to remove and select Remove.

6) Click OK.
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Vulnerability elements and how they
work

Vulnerability elements provide a short description of the event that has matched and a reference to external
vulnerability information (CVE/BID/MS/TA).

When a Situation element refers to a Vulnerability element, the vulnerability information is included in the log
entries generated when the Situation matches traffic. You can also use the vulnerability IDs in the element search
to find Situation and Vulnerability elements that refer to a particular vulnerability.

Vulnerability information is included in dynamic update packages, so Situations provided by Forcepoint are
already linked to a Vulnerability when appropriate. You can associate Situations with an existing Vulnerability or
add a custom Vulnerability element.

Create Vulnerability elements
You can create custom Vulnerability elements to associate Situations with vulnerabilities that are not included in
the default Vulnerability elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Other Elements > Situations branch of the element tree.

3) Right-click the By Vulnerability branch in the tree view and select New > Vulnerability.

4) Give the Vulnerability a descriptive name and optionally a comment.
The Comment is not shown in the Logs view. Use the Description field to enter information to be shown in
the logs.

5) To create a reference to external vulnerability information, select one or more reference systems in the
Reference System section and enter the ID this vulnerability has in that system:
• Mitre: vulnerability ID format is CVE-YYYY-XXXX
• SecurityFocus: vulnerability ID format is BID-XXXXX
• Microsoft: vulnerability ID format is MSYY-XXX
• Us-Cert: vulnerability ID format is TAYY-XXXX

6) After you have entered the vulnerability ID, click Show next to the ID field to view the information about the
vulnerability in the reference system.

7) Type or copy-paste a short description of what the vulnerability is about into the Description field.

8) Under Situations, browse to the correct Situation elements, select them (one or several at a time) and click
Add to associate them with this Vulnerability.
The selected Situations are added to the Content field on the right.
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9) When you are finished adding Situations, click OK.
The selected Situations are now associated with this vulnerability, and a link to this Vulnerability is added on
the Situations’ properties dialog box.

Associate Vulnerability elements with Situation
elements
You can associate Situation elements with an existing Vulnerability element or add a custom Vulnerability
element.

You can add up to four references to public vulnerability databases to your custom Vulnerabilities (CVE/BID/MS/
TA). System vulnerabilities can have an unlimited number of references to any reference system, and can have
multiple references to the same reference system. The reference information is also shown in the Logs view.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Other Elements > Situations > By Vulnerability.

3) Right-click the correct Vulnerability in the tree and select Properties.

4) Select the Situation elements (one or several at a time) and click Add or Remove to change the selection in
the Content field on the right.

5) When you are finished adding Situations, click OK.
The selected Situations are now associated with this vulnerability, and a link to this Vulnerability is added on
the Situations’ properties dialog box.

Related tasks
Create custom Situation elements on page 919

Using Situation elements
You use Situation elements to define what you want to detect with the Inspection Policy.

Situations are generally used for:
• Detecting malicious patterns in traffic. The Situations supplied in dynamic update packages concentrate on

such known vulnerabilities and exploits.
• Reducing the number of alert and log entries you receive (using Correlation Situations).
• Detecting some other traffic patterns that you want to record. For example, you might be interested in the use

of certain applications.
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Although the general workflow requires making sure that a Situation you want to use is included in the Inspection
Policy, you might often not actually insert the Situation into the rule. Instead, you might use a Tag or Situation
Type element to represent a whole group of Situations.

Examples of custom Situation elements
These examples illustrate some common uses for Situations and the general steps on how each example is
configured.

Example: detecting the use of forbidden
software
Engine-specific examples of using custom Situations to detect traffic patterns associated with specific software.

Firewall engine
Company A has a Firewall that inspects all outgoing web traffic against the Inspection Policy. The use of instant
messaging clients across the Internet is forbidden in the company. The Inspection Policy is set to detect and log
Situations with the Instant Messaging Tag.

The company’s administrators have found out that some internal users have started chatting using a new little-
known instant messaging client that does not have a default Situation yet. The communications seem to be
standard HTTP directly from client to client. The administrators find one distinctive characteristic in the software:
when started, the software in question always connects to a particular address to check for updates using HTTP.

The administrators:

1) Create a custom Situation element with the name “Software X”.

2) Add the HTTP Request URI Context to the Situation and type in a regular expression that contains the
address they want the Situation to find using the SMC regular expression syntax.

3) Add the default system Tag Instant Messaging to the Situation.

4) Refresh the Firewall’s policy.

5) Open the Logs view and filter the view using the “Software X” Situation as the filtering criteria.

6) See which computers use the forbidden software and remove the software from the computers shown in the
logs.

IPS engine
Company A has an IPS engine deployed in between their internal network and the Internet. The IPS engine uses
a policy that is based on the IPS Template policy.

The administrators find out that some of the internal users have installed a piece of software on their computers
that the company’s security policy forbids. They consider this software a security risk.
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The administrators decide that they would like to detect the use of the software so that they can find out which
users have installed it. The administrators find one simple but distinctive characteristic in the software: when
started, the software in question always connects to a particular address to check for updates using HTTP.

The administrators:

1) Create a custom Situation element with the name “Software X”.

2) Add the HTTP Client Stream Context to the Situation and type in a regular expression that contains the
address they want the Situation to find using the SMC regular expression syntax.

3) Add one of the default Situation Types under Traffic Identification to the Situation.

4) Select the correct options for logging the traffic in the Rules tree in the Inspection Policy and install the policy
on the IPS engine.

5) Open the Logs view and filter the view using the “Software X” Situation as the filtering criteria.

6) See which computers use the forbidden software and take action based on which IP addresses are shown in
the logs.

Example: counting events to reduce number of
repeated queries to a server
An example of using the Count context in a Correlation Situation.

Company B has a Firewall and an IPS engine that monitor traffic to a DMZ network. The DMZ contains a server
that provides information to Company B’s partners. A while ago, users started complaining that the service had
slowed down.

Upon investigation, Company B’s administrators found out that the traffic had grown dramatically even though the
number of users and the data available had stayed the same. They found out that one of the partners had made
a misconfigured script that frequently copied several large catalogs from Company B’s server to their own server.
Furthermore, they had given the script to a few other partners as well. As a first step, the administrators decide to
immediately stop excessive queries to the server.

The administrators:

1) Create a custom Situation for detecting access to the catalog files.

2) Create a custom Correlation Situation and attach the Count Context to it. Then define the settings for the
Count Context to detect when there are more than 5 requests per minute to any of the files from the same
source address.

Table 108: Context settings for the example Correlation Situation

Field Option

Correlated Situations Custom Situation

Time Window 60

Alarm Threshold 5
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Field Option

Log Fields Enabled Select

Log Names Src Addr

3) Insert the Correlation Situation in the Inspection Policy with blacklisting as the Action. The traffic from the
offending hosts is stopped at the Firewall.

4) Refresh the Inspection Policy on the IPS engine.

Example: preventing access to forbidden
websites
An example of using Situations to block access to specific websites.

The Administrators at Company C have noticed that employees frequently visit websites that are not related to
their work. They want to block access to these websites to prevent employees from accessing them at work. To
prevent access, they:

1) Create a Situation element.

2) Add the Website Access Control Context to the Situation.

3) Specify the addresses they want to prevent access to. Access to the specified addresses is blocked.

4) Refresh the Inspection Policy on the IPS engine.
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 CHAPTER 53

Using Network Application
elements

Contents

• Getting started with Network Application elements on page 937
• Create TLS Match elements for network application detection on page 938
• Access rules for network application detection on page 940
• Example: blocking network application use on page 943

Network Application elements collect combinations of identified characteristics and detected events in traffic to
dynamically identify traffic related to the use of a particular network application.

Getting started with Network Application
elements

Network Application elements provide a way to dynamically identify traffic patterns related to the use of a
particular network application.

Network Application elements allow you to more flexibly identify traffic beyond specifying a network protocol and
ports for TCP and UDP traffic with a Service element. Matching is done based on the payload in the packets,
making it possible to identify the protocol even when non-standard ports are used. First, the protocol is identified,
then a protocol-specific pattern matching context is applied to identify the network applications.

Keep the following in mind when working with Network Application elements:
• There are several predefined Network Application elements available that define the criteria for matching

commonly used network applications. No configuration is required to be able to use Network Application
elements in Access rules.

• Predefined TLS Match elements are used in the properties of some predefined Network Application elements
to allow the Network Application to match the use of the TLS protocol in traffic.

• You cannot edit the predefined Network Application elements. However, Access rules can override the
properties of a predefined Network Application element.

• Creating Network Application elements requires detailed knowledge of the network applications you
want to detect and the traffic patterns related to their use. Creating Network Application elements is not
recommended.

• If a certificate for TLS inspection has been uploaded to the engine, adding a Network Application that allows
or requires the use of TLS to an Access rule enables the decryption of all TLS traffic. So does enabling the
logging of Application information in the Access rules.
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Network Applications configuration overview
No configuration is required to be able to use Network Application elements in Access rules.

There are several predefined Network Application elements available that define the criteria for matching
commonly used network applications. Creating Network Application elements or duplicating existing elements is
not recommended. To override the settings of a predefined Network Application, edit the Service Definition of the
rule in which you use the Network Application.

1) (Optional) Create TLS Match elements to override the properties of predefined Network Application
elements.

2) Use the Network Application element in the Access rules.

Default elements for Network Application
elements
There are several predefined elements for working with Network Application elements.

Application Type elements define general categories of network applications. One Application Type element can
be associated with each Network Application element. Application Type elements are predefined, and you cannot
create Application Type elements.

Tag elements help you to create simpler policies with less effort. Tag elements represent all Network Application
elements that are associated with that Tag. For example, the Media Tag includes several web-based image,
music, and video applications. Several Tags can be associated with each Network Application element.

TLS Match elements define matching criteria for the use of the TLS protocol in traffic. When a connection that
uses the TLS protocol is detected, the server certificate for the connection is compared to the TLS Match in the
Network Application definition. TLS connections are allowed only to sites that have trusted certificates that meet
the following criteria:
• The certificate domain name must match the domain name in the TLS Match element.
• The certificate must be signed by a valid certificate authority.
• The certificate must be valid (not expired or revoked).

The predefined elements are imported and updated from dynamic update packages. This means that the set of
elements available changes whenever you update your system with new definitions. The Release Notes of each
dynamic update package list the new elements that the update introduces.

Create TLS Match elements for network
application detection

TLS Match elements define matching criteria for the use of the TLS (transport layer security) protocol in traffic.

In addition to the predefined TLS Match elements used in predefined Network Application elements, you can
optionally define your own TLS Match elements.

TLS Match elements can match traffic based on the following criteria:
• Whether certificate validation succeeded, failed, or was not performed.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Using Network Application elements | 939

• The server domain name in a valid certificate.
• Specific reasons a certificate is regarded as invalid if certificate validation failed.
• The domain name in the Server Name Indication (SNI) field of the TLS Client Hello packet.

TLS Match elements also specify whether to decrypt TLS traffic to particular Internet domains for inspection.
TLS Match elements that deny decryption are applied globally. Even if the TLS Match element is not used in
the properties of any Network Application elements or in the Access rules, matching connections are never
decrypted. Denying decryption in a TLS Match prevents network applications from being detected in encrypted
connections to the specified domains. If the server certificate provides sufficient information to identify the
network application without decrypting the client communications, you can alternatively specify that decryption is
not necessary for network application identification in the Network Application properties.

A Network Application element matches a TLS connection only if a TLS Match element in the Network
Application also matches. However, TLS Match elements used in Service Definitions override the TLS Match of a
Network Application. In this case, the rule matches when the TLS Match elements specified in the rule match.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Other Elements branch.

3) Right-click TLS Matches, then select New TLS Match.

4) In the Name field, enter a unique name.

5) (Optional) Select Deny Decrypting to prevent connections from being decrypted for inspection.

Note:  Selecting this option prevents the network application where the TLS Match is used
from being identified if the traffic is encrypted. If you want to specify that decryption is not
necessary for identifying the network application, use the Application Identifiable by TLS
Match Alone option in the Network Application properties instead.

6) To define whether the server certificate validity is checked and what to match, select an option from the
Match Certificate Validation drop-down list.

7) Configure the additional settings depending on the option that you selected from the Match Certificate
Validation drop-down list:
• Validation Succeeded — Click Add, then enter the fully qualified domain name to match in the server

certificate.
• Validation Failed — (Optional) Select the specific types of invalid certificates to match.
• No Validation — There are no additional settings to configure.

8) Click OK.
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Access rules for network application
detection

To detect network application use, you must create Access rules that define the matching criteria.

The Service cell defines the protocols that are compared to the protocol-related information in each packet’s
header. You can use Network Application elements directly in the Service cell, or as part of the matching
criteria in the Service Definition dialog box. Any other criteria in the Service Definition dialog box override the
properties of the Network Application element. For example, the Google Network Application element matches
only TCP ports 80 and 443, but using Any TCP Service allows the Network Application element to match any
traffic pattern that resembles the use of Google, regardless of the port.

Alternatively, you can use Application Type elements and Tag elements directly in the Service cell. Application
Type elements represent general categories of network applications. Tag elements represent all Network
Application elements that are associated with that Tag.

Some network applications can open several related connections. If an Access rule that detects network
application use identifies a related connection, the related connection is matched against the Access rules again.
If the rule that detected the network application use has deep inspection enabled and the related connection
matches a rule that has deep inspection enabled, the related connection is matched against the Inspection
Policy. No NAT payload modifications are done for the connection that matches the rule that detected the
network application use. NAT payload modifications can be done for the related connections according to the
policy.

Create Access rules for network application
detection
To detect network application use, create Access rules that define the matching criteria.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Policies, then browse to the policies of the type that you want to edit.

3) Right-click a policy, then select Edit <policy type>.

4) On the IPv4 Access or IPv6 Access tab, add a rule in one of the following ways:
• Right-click the last row in an empty rules table, then select Add Rule.
• Right-click the ID cell of an existing rule, then select Add Rule Before or Add Rule After.

5) Drag and drop elements from the Resources pane to the Source and Destination cells, or define source
and destination criteria.

6) In the Action cell, select the action according to your needs.
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7) Drag and drop a Network Application, Application Type, or Tag element to the Service cell.

Note:
If a TLS Credentials or Client Protection Certificate Authority element has been uploaded to
the engine, adding a Network Application element that allows or requires the use of TLS might
enable the decryption of the following TLS traffic:

• TLS traffic from network applications that cannot be identified based on cached network
application information.

• TLS traffic that matches an Access rule that enables deep inspection if the Service cell
contains a Network Application or Service element that does not include a Protocol Agent.

• TLS traffic for which there is no TLS Match with the Deny Decrypting option that excludes
the traffic from TLS Inspection.

8) In the Logging cell, select options according to your needs.
If you want to include information about network application use in the logs, select Default or Enforced for
Log Application Information.

9) Click  Save and Install.

Override Network Application element
properties in Service Definitions
You can specify criteria in the Service Definition to override the properties of a Network Application element.

Before you begin
Create Access rules for network application detection.

Network Application elements can include protocols, port numbers, and TLS Matches. Normally, the Access
rule that contains the Network Application element only matches when the properties of the Network Application
element match:
• When Network Application elements include a protocol and port number, the rule matches only when the

protocol and port number match.
• When a TLS Match is specified in the properties of a Network Application element, the rule matches TLS

connections only if the TLS Match also matches.

When you use the Service Definition to override the properties of the Network Application element, the Access
rule that contains the Network Application element matches when the Service or TLS Matches specified in the
rule match.

For example, the predefined Google Mail Network Application matches only TCP ports 80 and 443. Adding Any
TCP Service to the Service Definition allows the Network Application to match any traffic pattern that resembles
the use of Google Mail, regardless of the port.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Policies, then browse to the policies of the type that you want to edit.

3) Right-click a policy, then select Edit <policy type>.

4) Click the IPv4 Access or IPv6 Access tab.

5) Right-click the Service cell, then select Edit Service.

6) To add a row to the Service Definition, click Add Row.

7) Drag and drop Service or TLS Match elements to the correct cells.
• TLS Match elements can only be used with Network Application elements that include a TLS Match in the

Network Application element properties.
• URL Situation elements cannot be used with Network Application elements.

Note:  All items on the same row must match the traffic for the row to match. You cannot
use a Network Application element and a Service element on different rows of the Service
Definition.

8) Click OK.

9) If you have finished editing the policy, click  Save and Install.

Log network application use
You can optionally log the use of network applications without using network application detection for access
control.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Policies, then browse to the policies of the type that you want to edit.

3) Right-click a policy, then select Edit <policy type>.

4) On the IPv4 Access or IPv6 Access tab, add a rule in one of the following ways:
• Right-click the last row in an empty rules table, then select Add Rule.
• Right-click the ID cell of an existing rule, then select Add Rule Before or Add Rule After.
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5) Drag and drop elements from the Resources pane to the Source and Destination cells, or define source
and destination criteria.

6) (Optional) Drag and drop a Network Application, Application Type, or Tag element to the Service cell.
It is not necessary to add a Network Application element if you only want to log the use of network
applications.

7) In the Action cell, select Continue.

8) Double-click the Logging cell.

9) Select Override Settings Inherited from Continue Rule(s).

10) In the Log Level drop-down list, select the log level for traffic that matches the rule.

11) Select Override Recording Settings Inherited from Continue Rule(s).

12) In the Log Application Information drop-down list, select Enforced.

Note:
If a TLS Credentials element or a Client Protection Certificate Authority element has been
uploaded to the engine, selecting Enforced might enable the decryption of the following
TLS traffic:

• TLS traffic from network applications that cannot be identified based on cached network
application information.

• TLS traffic that matches an Access rule that enables deep inspection if the Service
cell contains a Network Application or Service element that does not include a Protocol
Agent.

• TLS traffic for which there is no TLS Match with the Deny Decrypting option that
excludes the traffic from TLS Inspection.

13) Click OK.

14) Click  Save and Install.

Example: blocking network application
use

An example of using Network Application elements to block the use of specific network applications.

The administrators at Company A want to allow the use of HTTP in general, but block the use of social media
applications from its corporate network. When social media use is detected, the administrators want to redirect
users to the corporate security policy page on the company intranet.

The administrators:

1) Create a User Response element to redirect dropped connections to the corporate security policy intranet
page.
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2) Add the following Access rules:

Source Destination Service Action

Internal networks Not internal

networks
expression

Social Media
Application Tag

Discard
Response: User Response to redirect
connections to the intranet page

Internal networks Not internal
networks
expression

HTTP Allow

3) Refresh the firewall's policy.
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Defining User Response elements
Contents

• User Response elements and how they work on page 945
• Create User Response elements on page 947

With the User Response element, you can send customized replies to users, instead of just closing an HTTP or HTTPS
connection.

User Response elements and how they
work

User Response elements allow you to define custom responses that are sent to the user when an HTTP or
HTTPS connection is closed.

User Responses make it possible to explain to the user why the connection was closed instead of simply closing
the connection with no notification. They help administrators differentiate cases where the NGFW Engine closes
a connection from cases where a technical problem prevents the connection from going through.

When you combine User Responses with browser-based user authentication, you can also redirect users to their
original destination after they have authenticated to a Firewall. The redirection can be automatic or require the
users to click a link to the original HTTP destination address on the user authentication page after they have
authenticated.

You can use User Responses in Access rules and in Inspection Policies. Redirection to the user's original HTTP
destination after authentication must be configured in the Inspection Policy.

Limitations of User Responses
User Responses have the following limitations:

• To use User Responses with HTTPS traffic, you must enable decryption of HTTPS traffic.
• Some web browsers, such as Mozilla Firefox and Google Chrome, use HTTP Strict Transport Security (HSTS)

to enforce the use of HTTPS by default. The end user's web browser might not accept the certificate for TLS
inspection when HSTS is used.

User Response configuration overview
Configuring a User Response involves creating a User Response element, defining the response content, and
adding the User Response element to a policy.

Follow these general steps to configure User Responses:
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1) Create a User Response element.

2) Define the responses that are sent to the users when a connection is closed.

3) Use the User Response element in the Access rules and Inspection rules as required.

Related tasks
Add Access rules on page 869
Add Inspection rules on page 882
Create User Response elements on page 947

Variables for User Response elements and how
they work
Variables allow you to dynamically add details about the connection to the message that is shown to users. Users
can provide the information to their administrator when they report problems with the connection.

You can add variables to the  Message Response and Custom HTML response types. If the information that
the variables represent is available for the connection, the details are automatically added as text to the message
that is shown to users. For example, if the client's IP address is 192.168.22.33, the {{SrcIP}} variable is replaced
with 192.168.22.33 in the message. If the information is not available, N/A is shown in the message.

The following variables are supported:

Table 109: Variables for User Response elements

Variable Description

{{SrcIP}} The source IP address of the connection.

{{DstIP}} The destination IP address of the connection.

{{SrcPort}} The source port of the connection.

{{DstPort}} The destination port of the connection.

{{User}} The user name and LDAP domain of the user that made the connection in the
format user@domain.
If the LDAP domain is not available, only the user name is shown.

{{Group}} A comma-separated list of User Groups to which the user belongs.

{{Url}} The URL requested in the connection.

{{UrlCategory}} The URL Category for category-based URL filtering that the requested URL
matches.

{{Application}} The Network Application identified in the connection.

{{RuleTag}} The rule tag of the rule that blocked the connection.

{{TimeStamp}} The date and time of the connection.

{{FileName}} The name of the file that was detected in the connection.
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Variable Description

{{ArchiveName}} The file name of the compressed file that was detected in the connection.

{{MalwareName}} The name of the malware that was detected in the connection.

Create User Response elements
You can define a different User Response entry for each case in which an HTTP or HTTPS connection matches
a rule that closes the connection.

The HTTP or HTTPS connection is not allowed to continue in the following cases:

• Connection Blacklisted (HTTP only) — The connection was closed according to a rule with the Apply
Blacklist action.

• Connection Discarded by Access Rule (HTTP only) — The connection was discarded according to an
Access rule with the Discard action.

• Connection Terminated by Inspection Rule — The connection was terminated according to the Inspection
Policy.

• URL Not Allowed — The connection was closed by rules for URL filtering.
• Malware Found — The anti-malware feature detected malware in the connection.

Note:  In some cases, such as when inspecting a large file transfer, it is not possible to apply a
User Response to HTTPS traffic. In this case, the engine applies the default action for matching
traffic. If an HTTPS connection is discarded before the payload is decrypted, no User Response is
sent.

You can also redirect users to their original HTTP destination after they have authenticated to a Firewall. You
automatically redirect the users after they have authenticated, or you can require the users to click a link to the
original HTTP destination address on the user authentication page after authentication.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Other Elements branch, then select Engine Properties.

3) Right-click User Responses, then select New User Response.

4) In the Name field, enter a unique name.

5) For the entry that you want to change, expand the section.

6) From the Type of Response drop-down list, select one of the following responses:
• Message Response — (Optional) Customize the message to display to the user.
• URL Redirection — In the HTTP or HTTPS URL Destination field, enter the URL to which the

connection is redirected. The URL must begin with http:// or https://.
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• Custom HTML — (Optional) Customize the HTML source code for the message to display to the user.
The HTML source code must be a complete HTML page, including the <html> and <body> tags.

7) (Optional) To dynamically add details about the connection to the message for the Custom HTML and
Message Response response types, add variables.

a) Click the location in the HTML source code or message text where you want to add the variable.

b) Click Add Variable, then select the variable that you want to add.

c) (Optional) To preview the message in your default web browser, click Preview in Browser.

8) (Optional) To redirect users to their original destination after they have authenticated to the Firewall for the
URL Redirection response type, define the settings for the redirection.

a) To enable redirection to the original destination, select Enable Manual Redirection to Original URL
After Authentication.

b) (Optional) To automatically redirect the user to the original destination, select Enable Automatic
Redirection to Original URL After Authentication.

9) Click OK.
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Quality of Service
Contents

• Quality of Service (QoS) and how it works on page 949
• Create QoS Class elements on page 957
• Define QoS Policy elements on page 958
• Apply QoS to traffic on page 961
• Examples of bandwidth management and traffic prioritization scenarios on page 962

The Quality of Service (QoS) features allow you to manage bandwidth and prioritize connections on the engines. QoS
features are available on Firewalls, IPS engines, Layer 2 Firewalls, Master NGFW Engines, Virtual Firewalls, Virtual
IPS engines, and Virtual Layer 2 Firewalls.

Quality of Service (QoS) and how it
works

QoS (Quality of Service) allows you to manage the available network bandwidth and make sure that important
network services are given priority over less important traffic.

There are two Quality of Service (QoS) features: bandwidth management and traffic prioritization. Both features
are configured using the same tools. You can use both bandwidth management and traffic prioritization together
or bandwidth management or traffic prioritization individually for any given type of traffic. Bandwidth management
and traffic prioritization are not supported on Modem interfaces of Single Firewalls.

The Firewall can also read and write DiffServ Code Point (DSCP) markers in type of service (ToS) fields. The
markers allow you to integrate the Firewall with other network equipment that implements QoS management in
your own or your ISP’s network.

What QoS does
The QoS features help you in the following ways:
• You can set up a Guarantee for a type of traffic that must always be given a certain minimum share of the

available bandwidth.
• You can set up a Limit for maximum bandwidth for a type of traffic that must never use more than a certain

share of the available bandwidth.
• You can set a Priority value for the traffic. Higher priority traffic is sent forward to its destination before lower

priority traffic if the engine queues packets due to congestion.
• Active Queue Management (AQM) reduces the volume of dropped or retransmitted packets when there is

network congestion. AQM monitors the average queue size and uses a scheduling algorithm to determine the
statistical probability for dropping incoming packets.
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• The engine can read or write DiffServ Code Point (DSCP) type of service (ToS) field markers. The markers
allow the engine to be aware of the priorities set by other network equipment. Other equipment is also aware
of the priorities set in the QoS Policy.

• The engine can collect statistics about traffic that matches Access rules that apply a QoS Class to the traffic.
QoS Class-based statistics items are used in Overviews and Reports.

Limitations
• QoS is only available on some interface types:

NGFW Engine role Interface types

Firewall/VPN • Layer 3 physical interfaces
• Layer 2 physical interfaces of the Inline IPS Interface and Inline Layer 2

Firewall type
• VLAN interfaces
• Tunnel interfaces
• ADSL interfaces
• SSID interfaces
• Port group interfaces of an integrated switch

Note:  QoS is also available in the properties of policy-based VPNs

IPS, Layer 2 Firewall Physical interfaces of the Inline Interface type

• It is not possible to apply a bandwidth guarantee to incoming Internet traffic on your Internet link. By the time
the engine sees the traffic, the bandwidth has already been used. If you want guaranteed bandwidth for a
specific portion of your incoming Internet traffic, contact your ISP and ask if they can enforce this guarantee
for you.

• If you want to create QoS rules for both incoming and outgoing traffic, you must assign a QoS Policy to at
least two interfaces. Incoming traffic is processed according to the Firewall, IPS, or Layer 2 Firewall policy,
and then the QoS Policy is applied to the allowed traffic on the outgoing interface.

What do I need to know before I begin?
• There are three default QoS Classes: High Priority, Normal Priority, and Low Priority. These are used in

the default QoS Policy, Prioritize. The Prioritize QoS Policy is a sample policy that contains simple rules for
prioritizing traffic according to the three default QoS Classes. High Priority traffic is assigned the highest
possible priority value of 1. The Normal Priority value is 8, and Low Priority is assigned the lowest possible
value of 16. The default Prioritize policy does not provide any bandwidth guarantees or limits. If the default
Prioritize policy is sufficient for you, you can use the default QoS Classes and the Prioritize policy as they are.

• By default, the DSCP mark for the encrypted ESP packet in VPN traffic is inherited from the plaintext packet.
Selecting a QoS Policy in the properties of the policy-based VPN makes it possible to mark the ESP packet
after encryption.

• Priorities, limits, and guarantees are applied. DSCP codes are written to outgoing packets on the interface that
the traffic uses to exit the engine according to the QoS Policy and interface speed defined for that interface.

• For packets entering the engine, the QoS Policy on that interface is only used for reading DSCP codes and
matching them to QoS Classes for further use. It is the only QoS operation that is done on the interface that
the traffic uses to enter the engine.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Quality of Service | 951

Example: A new packet enters a Firewall through interface A and leaves the Firewall through interface B.
The priorities, guarantees, and limits configured on interface A are ignored for packets in this direction. Any
priorities, guarantees, and limits are configured and applied on interface B. If the packet contains a DSCP
code when entering the Firewall, the DSCP code is read and matched to a QoS Class on interface A. If a new
DSCP code is (over)written in the packet, the new code is written on interface B.

• The QoS Mode for each interface defines how QoS is applied to the interface. Depending on the QoS Mode,
you might also have to define the QoS Policy the interface uses and the speed of the interface.

Related concepts
Defining Policy-Based VPN elements on page 1164

Bandwidth management
Bandwidth management means giving a guaranteed minimum portion of the available bandwidth to some
types of traffic. It also sets limits for how much of the total available bandwidth each type of traffic is allowed to
consume at any given time.

You can set a limit, a guarantee, or both for any given type of traffic. These features can be used to guarantee
the quality of time-critical communications (even under normal network load), prepare for malfunctions, and limit
the total bandwidth needed.

Note:  Bandwidth management applies to outbound traffic only. The firewall can only indirectly
limit the bandwidth use of incoming traffic.

Related concepts
Managing bandwidth of incoming traffic on page 954

Traffic prioritization
You can ensure that essential or time-critical traffic flows without delays by giving it a higher priority value.

Even under normal traffic conditions, temporary traffic peaks sometimes occur. With many communications, slight
delays caused by queuing traffic are not noticeable to the user of the service. However, some connections, such
as streaming audio or video, are time-critical, and even relatively minor delays cause noticeable reduction in
service quality.

Normally, when packets are queued, they are sent onwards in the same order in which the packets were
received. To change this behavior, you can assign priority values to the traffic. For example, you can assign time-
critical connections a high priority. High-priority packets are placed before any lower-priority packets in the queue,
allowing the fastest possible delivery.

Active Queue Management (AQM) reduces the volume of dropped or retransmitted packets when there is
network congestion. AQM monitors the average queue size and uses a scheduling algorithm to determine the
statistical probability for dropping incoming packets. If the queue is almost empty, all packets are accepted. As
the queue size increases, the probability for dropping incoming packets also increases. When the queue is full, all
packets are dropped.
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Effects of bandwidth management and
prioritization
Bandwidth management and traffic prioritization improve the quality of service for important traffic. However, the
quality of service for traffic that you define as less important can decrease.

Both features are configured using the same tools. You can use both bandwidth management and traffic
prioritization together, or bandwidth management or traffic prioritization individual for any given type of traffic.
Bandwidth management and traffic prioritization are not supported on the Modem interfaces of Single Firewalls.

Usually the traffic management process allows all connections to proceed, although some traffic can occasionally
slow down when the bandwidth limits are reached. If there is prolonged congestion in the network, lower priority
traffic eventually starts to time out. If you set priorities without setting any maximum limits or minimum guarantees
for bandwidth, high-priority traffic can even use all available bandwidth, blocking all lower-priority traffic.

In most situations, the guaranteed minimum bandwidths given to important connections allow traffic to proceed.
However, even traffic with bandwidth guarantees might not get through, if network links are unable to maintain
throughput or if the volume of traffic continuously exceeds the throughput. Make sure that your bandwidth limits
and guarantees are granular enough to account for losing bandwidth, for example, due to ISP failure in a Multi-
Link environment. Track the total bandwidth use, so that you can increase the throughput before problems
appear.

The Firewall can also read and write DiffServ Code Point (DSCP) markers in type of server (ToS) fields. The
markers allow you to integrate the Firewall with other network equipment that implements QoS management in
your own or your ISP's network.

CAUTION:  Inappropriate bandwidth limits and guarantees only disturb traffic. Make sure the
guarantees and limits you set are appropriate for the volume of each type of traffic.

Default QoS elements
There are three default QoS Classes: High Priority, Normal Priority, and Low Priority. These are used in the
default QoS Policy, Prioritize.

The Prioritize QoS Policy is a sample policy that contains simple rules for prioritizing traffic according to the three
default QoS Classes. High Priority traffic is assigned the highest possible priority value of 1. The Normal Priority
value is 8, and Low Priority is assigned the lowest possible value of 16. The default Prioritize policy does not
provide any bandwidth guarantees or limits.

CAUTION:  If you set priorities without setting any bandwidth limits or guarantees, high-priority
traffic can use all available bandwidth, blocking all lower-priority traffic.

If the default Prioritize policy is sufficient for you, you can use the default QoS Classes and the Prioritize policy as
they are. Add the QoS Classes to Access rules. Then, configure the interfaces to use the Prioritize QoS Policy.

Related tasks
Apply QoS to traffic on page 961
Define QoS Policy elements on page 958
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Using bandwidth management and traffic
prioritization
You can use bandwidth management and traffic prioritization to ensure critical communications, prepare for
network link failures, and restrict non-essential traffic.

Bandwidth management and traffic prioritization are used for the following purposes:
• To ensure the quality of service for time-critical communications during occasional traffic peaks. Even if

there is ample bandwidth available, short periods of congestion can degrade the quality of some types of
communications.

• To prepare for severe congestion, caused by the loss of network links when there are technical problems. In a
Multi-Link environment, you can have several NetLinks. Ideally, the throughput of these links is large enough
that each link can alone handle the traffic. However, if it is not a viable option, it might become necessary to
choose which connections are given priority if network connections are lost.

• To reduce the total bandwidth needed, if it is not possible to increase throughput of the network links or add
new links. For example, important services (such as VPN connections and clients’ connections to extranets)
can be given priority over Internet browsing (all HTTP connections or based on IP addresses).

Designing QoS policy elements
The purpose of the QoS Policy is to determine which limit, guarantee, or priority is given to traffic marked with a
certain QoS Class.

Each QoS Class can appear in only one (active) rule on each tab of a QoS Policy. The same QoS Class can be
used on both the QoS tab and the DSCP Match/Mark tab of the same QoS Policy. The order of the QoS rules
does not matter. The classification of the traffic is made using Access rules.

Except for the QoS Class, all other cells for rules on the QoS tab are optional. However, at least one of the other
cells must be filled for the rule to affect the traffic. None of the cells exclude any of the other cells, so you are free
to select which cells you want to use for any given QoS Class. It is not necessary to define the use of all available
bandwidth in your QoS Policy. The bandwidth outside the guarantees, as well as bandwidth within the guarantees
that is not used for traffic, is used to handle the traffic that has no specific QoS rule. The traffic is handled on the
normal first-come-first-served-basis, using the medium priority of 8.

CAUTION:  If your guarantees are equal to the total throughput of an interface, any traffic without
a guarantee is blocked if all guarantees are fully used.

When you save the QoS Policy, the system checks for contradictions within each rule, such as a rule that sets
a limit that is lower than the guarantee for the same rule. When you refresh the firewall’s configuration, the QoS
Policies defined for the firewall’s interfaces are checked again, comparing the QoS rules to the throughput values
set for the interfaces. The values can be automatically scaled down if the sum of all guarantees in the QoS Policy
exceeds the interface’s throughput. However, the values are never scaled up.

The values for the bandwidth limits and guarantees can be entered either in kilobits or as percentages of the total
throughput of the interface. Technically, nothing prevents you from using both ways of entering values even in
the same rule. However, it is recommended to use one way of entering the values consistently throughout each
QoS Policy. Using mixed methods of entering the values makes it more difficult for the administrators to read
the QoS policy. Mixed methods can also prevent the system from checking for issues when you save the QoS
Policy, as the throughputs of the interfaces are not known. If the QoS Policy cannot be checked when you save
it, it is checked when the Firewall Policy is installed. Mistakes in the QoS Policy can prevent you from installing or
refreshing the Firewall Policy.
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Communicating DSCP markers to other
network equipment to prioritize traffic
You and your ISP might have routers that also decide how to handle packets based on the priority of the traffic.
DSCP (DiffServ type of service field) markers in the traffic are a standard way to indicate priorities in network
traffic.

It is possible to read or write DSCP markers for a particular type of traffic without configuring Access rules to
apply a QoS Class to the traffic. The matching is done based on the QoS Policy. When a packet that matches
a particular protocol comes in, the engine reads the DSCP markers and assigns a QoS Class according to the
DSCP Match/Mark rules of the QoS Policy. When the packet is sent out, the engine writes a DSCP mark in the
packets. The marking is based on the QoS Class according to the DSCP Match/Mark rules of the QoS Policy on
the interface through which the traffic leaves the engine.

The markers allow you to:
• Communicate the priority of this traffic to other devices that support QoS.
• Convert the packet to use a different classification scheme, if the QoS Class was originally assigned to

matching traffic by a DSCP match in the source interface’s QoS Policy.
• Remove the DSCP classification set by other devices by entering 0 as the value (shown in the policy as 0x00).

Two QoS Policies on two Physical Interfaces can be used together to translate between two different DSCP
schemes as shown in the illustration.

 
Figure 144: Translating between two DSCP schemes

In the illustration, the packets arrive at Physical Interface 1. The firewall reads the existing DSCP value and
compares it to the QoS Policy assigned to Physical Interface 1. The policy has a DSCP Match rule for the DSCP
marker with an associated QoS Class, which is then assigned to this traffic.

Note:  The same traffic must not match any firewall Access rule with a QoS Class definition.
The QoS Class in the Access rule overrides the QoS Class that is assigned based on the DSCP
marker.

When the packets are sent out through Physical Interface 2, the Firewall checks the QoS Policy assigned to this
Physical Interface. In this QoS Policy, a DSCP Match/Mark rule defines that traffic with the assigned QoS Class
is marked with a DSCP marker specified in the rule. The firewall overwrites the original DSCP marker before
sending the packets onwards.

Managing bandwidth of incoming traffic
Bandwidth management and traffic prioritization are most useful in managing outgoing traffic.

Bandwidth management and prioritization usually help manage the quality of service for traffic going out through
Internet links. These links are often the choke point in a corporate network due to the costs associated with
increasing the bandwidth.

Outbound traffic can be controlled easily and accurately with QoS Policies. Controlling incoming traffic is more
difficult, because when the engine sees the traffic, the packets have already traveled through congested links and
used bandwidth. Still, you might be able to limit some types of incoming traffic in a limited way. In this case, only
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limits apply. To set guarantees and priorities for traffic, consider other solutions, such as arranging for your ISP to
implement traffic management before the traffic is passed to your Internet links.

To limit the bandwidth incoming traffic consumes, you can apply the QoS Policy on the engine’s interfaces
connected to the internal network. This configuration is shown in the following illustration.

 
Figure 145: Applying QoS to incoming traffic

NGFW Engine

Access Rules

Network A

Internet

Network B

In the illustration, traffic is checked against the Access Rules, and allowed traffic is assigned a QoS Class. At
the interfaces connected to the internal network, the QoS Policies limiting the bandwidth use are enforced as the
traffic is sent onwards.

Limiting the bandwidth in this way requires that the application that is the source of the traffic scales down the
transmissions to match the available bandwidth. If an application does not scale down its bandwidth use, any
limits you set have no effect. The only option is to control the traffic at your ISP before it reaches the engine.

Collecting statistics based on QoS Classes
QoS Class-based statistics items are available even when QoS is not used for bandwidth management and traffic
prioritization.

Selecting the “QoS Statistics Only” QoS Mode for an interface allows the collection of QoS Class-based counters
without activating any other QoS feature. No QoS Policy is needed in this case, but you must define Access rules
to apply QoS Classes to traffic. QoS Class-based statistics items can be used in Overviews and Reports.

QoS configuration overview
To apply QoS to traffic, you have to create QoS classes and assign them to different types of traffic. You also
have to create QoS Policies that determine how traffic is handled, and define a QoS Mode for each engine
interface.
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Figure 146: Elements in the QoS configuration

Follow these general steps to configure QoS:

1) (Optional) Create a QoS Class element for each type of traffic that you want to handle differently on any
single network interface.

2) (Optional) Create one or more QoS Policies to define how each type of traffic is handled on the interfaces.

3) Assign QoS Classes to different types of traffic in your Access rules.

4) Define the QoS Mode of each interface.

Note:  You can select a QoS Mode and define a bandwidth for traffic in the properties of
a Physical, VLAN, ADSL, Tunnel, SSID Interface, or Port Group Interface of an integrated
Switch. Each Physical, VLAN, Tunnel, ADSL, SSID, or Port Group Interface has separate
QoS settings.

Bandwidth management and traffic prioritization are configured in QoS Policies. The policies contain rules for
the bandwidth guarantees, limits, and priorities you want to set for each type of traffic. The QoS Policies do not
contain traffic profiles: to define which QoS rule affects which type of traffic, the same QoS Class element is used
in QoS Policies and Access rules, to link them.

The QoS Mode for each interface defines how QoS is applied to the interface. By default, No QoS is selected.
You can select a QoS Mode and define a bandwidth for traffic in the properties of a Physical, VLAN, ADSL,
Tunnel, SSID Interface, or Port Group Interface. You can select different QoS Modes for each interface. It is not
mandatory to use QoS on all interfaces of the same engine. QoS is not supported on Capture Interfaces.

There are two ways the QoS Class can be applied to a packet:
• If traffic contains a DSCP code when entering the engine, and DSCP handling and throttling or full QoS are

enabled, the engine checks if the interface has a QoS Policy. If the DSCP Match/Mark tab of the QoS Policy
defines a QoS Class match for that code, the selected QoS Class is applied to the traffic.

• When traffic is inspected against the policy, the traffic might match an Access rule that includes a QoS Class.
The QoS Class specified in the QoS Class cell is always applied to the traffic, overwriting any other QoS Class
the traffic might have been assigned. Access rules are not needed if you only want to use DSCP handling and
throttling.

Using the QoS Class as a matching criterion, the engine checks if the interface that the packet uses to exit the
engine has a QoS Policy. If the QoS Policy contains a rule with the same QoS Class defined, the next steps
depend on the QoS rules and the current traffic situation. The QoS rule is applied to the connection and packets
are dropped, sent directly, or sent into the queue.
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Related concepts
Network interfaces for engines on page 539

Related tasks
Create QoS Class elements on page 957
Define QoS Policy elements on page 958
Apply QoS to traffic on page 961
Define DSCP Match/Mark rules in QoS Policy elements on page 960

Create QoS Class elements
QoS Classes are used to collect QoS statistics about traffic or to create a link between the Access rules and the
QoS Policy.

When traffic matches an Access rule, the QoS Class defined in the rule is applied to the traffic. QoS Classes can
also be used in Outbound Multi-Link elements to adjust the load balancing of different types of connections.

You must create one QoS Class for each rule you plan to add in any single QoS Policy, as the QoS Policy cannot
contain any overlapping rules. You can create as many QoS Classes as necessary. The QoS Policy must not
have overlapping rules. You must create one QoS Class for each rule you plan to add to the QoS Policy (each
type of traffic must have its own QoS Class). The same QoS Class can be used in multiple Access rules, so
several Access rules can point matching traffic to the same QoS rule.

There is a default QoS Policy and three default QoS Classes. The classes can be used to set priorities for high,
normal, and low priority traffic, without any bandwidth guarantees or limits.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Select Other Elements > QoS Classes.

3) Right-click QoS Classes, then select New QoS Class.

4) Give the QoS Class a Name.

5) Click OK.
The new QoS Class is added to the resources and can now be used in policies.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Quality of Service | 958

Define QoS Policy elements
QoS policies determine the rules that the engine follows when it decides which traffic is given priority and how the
available bandwidth is divided.

• One QoS Policy can be assigned for each Physical Interface, VLAN Interface, Tunnel Interface, ADSL
Interface, SSID Interface, Port Group Interface of an integrated Switch, and policy-based VPN. You can
assign the same QoS Policy to several interfaces.

• QoS Policies are tables of QoS rules and DSCP Match/Mark rules. If you only want to collect QoS statistics
about traffic, you do not need to define a QoS Policy.

• Because the QoS rules are separate from the Access rules, you can flexibly design the rules. For example,
you can create different QoS Policies for different interfaces of the same engine.

• All cells in the QoS rules are applied to outgoing packets. When using Full QoS, packets that do not match a
QoS rule are handled with priority 8 (middle of the scale) without bandwidth guarantees or limits.

• All cells in the DSCP Match/Mark rules except the DSCP Match cell are applied to outgoing packets. If
packets do not match a DSCP Match/Mark rule, DSCP markers in the traffic are preserved, but do not affect
how the engine handles traffic.

The QoS Mode for each interface defines how QoS is applied to the interface. By default, No QoS is selected.
You can select a QoS Mode and define a bandwidth for traffic in the properties of a Physical, VLAN, ADSL,
Tunnel, SSID, or Port Group Interface. You can select different QoS Modes for each interface. It is not mandatory
to use QoS on all interfaces of the same engine. The following table describes how QoS is applied for each QoS
Mode.

When using Full QoS, define the available throughput in the properties for each Physical, VLAN, ADSL, Tunnel,
SSID, or Port Group Interface or whose throughput you want to manage. There is no way to automatically find out
how much bandwidth each interface has. The throughput must correspond to the actual throughput that interface
offers to clients, that is, the outbound bandwidth of an Internet link that is connected to the interface. If there are
VLANs on a Physical Interface, the settings are only available in the properties of each VLAN.

Note:  When you define the throughput of an interface, the engine always scales the traffic to this
throughput. Take special care that you set the throughput value correctly.

If you use Multi-Link where more than one NetLink is connected to the same Physical Interface, the throughput
setting depends on the Multi-Link configuration:
• If you are using load-balancing Multi-Link, set the throughput to the combined outbound bandwidth of all

Internet links behind the Physical Interface.
• If you are using standby NetLinks, set the throughput to the outbound bandwidth of the primary (active)

NetLink. When the bandwidth of the backup NetLink is lower, set the throughput to the speed of the primary
NetLink, as it is the most used link.

Policy-based VPNs can optionally use a QoS Policy to define how DSCP matching or marking is done for VPN
traffic. In policy-based VPN traffic, the DSCP mark for the encrypted ESP packet is normally inherited from the
plaintext packet. Selecting a QoS Policy for the policy-based VPN makes it possible to mark the ESP packet after
encryption. Since the total throughput is undefined, Guarantees and Priorities cannot be used for policy-based
VPN traffic.

Related concepts
Collecting statistics based on QoS Classes on page 955
VPNs and how they work on page 1127
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Create QoS Policy elements
Create separate QoS Policy elements for QoS rules.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Select Policies > QoS Policies.

3) Right-click QoS Policies, then select New QoS Policy.

4) Type in a Name, then click OK.
The new QoS Policy opens for editing.

Define QoS rules in QoS Policy elements
After creating a QoS Policy, add QoS rules to it.

Follow these general guidelines when editing QoS rules:
• The order of the rules in a QoS Policy does not affect how the engine handles traffic, as the match is made

based on the QoS Class.
• If you want to use the same QoS Policy on interfaces that have different types of throughput and use the Full

QoS Mode, enter Guarantees and Limits as percentages.
• If you want to use the QoS Policy on interfaces that use DSCP Handling and Throttling QoS Mode, enter

Guarantees and Limits in kilobits per second.
• Operations are made according to the matching rule in the QoS Policy that is assigned to the interface that the

traffic uses to exit the engine.
• The rules do not need to cover all traffic. When Full QoS is used, traffic that is not covered is given a priority of

8 without limits or guarantees.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Select Policies > QoS Policies.

3) Right-click the policy you want to edit, then select Edit QoS policy.
The QoS Policy opens in the Policy Editing view.

4) Right-click the ID cell of a rule in the QoS Policy, select Add Rule Before or Add Rule After or the ID cell of
the Not Classified rule, then select Add Rule.
A new blank rule is added.

5) Click the QoS Class cell in the new rule, then select the QoS Class.
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6) Define how the engine handles traffic in this QoS Class using any combination of the available options.
Each one is optional.

7) Save the QoS Policy.

8) Refresh the engine’s policy to transfer the changes.

Related concepts
Network interfaces for engines on page 539

Define DSCP Match/Mark rules in QoS Policy
elements
Communicate traffic priorities using DSCP to ensure the best possible quality of service for important traffic.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Select Policies > QoS Policies.

3) Right-click the policy you want to edit, then select Edit QoS policy.
The QoS Policy opens in the Policy Editing view.

4) Click the DSCP Match/Mark tab in the QoS Policy.

5) Right-click the ID cell of an existing rule, then select Add Rule Before or Add Rule After or the ID cell of the
Not Classified rule, then select Add Rule.
A new blank rule is added.

6) Click the QoS Class cell in the new rule, then select the QoS Class.

7) Define how the engine reads or writes DSCP code for traffic in this QoS Class using the available options.

8) Save the QoS Policy.

9) Refresh the engine’s policy to transfer the changes.

Related concepts
Network interfaces for engines on page 539
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Apply QoS to traffic
You can apply QoS to traffic by selecting a QoS Class for an Access rule. The same QoS Class can appear in
several Access rules.

You can insert a QoS Class in an Access rule that allows traffic or in an Access rule that uses the Continue action
to set the same QoS Class for several rules. This way, you can assign a specific QoS Class to any traffic that you
can match with a single Access rule. If you only want to collect QoS statistics about traffic, define Access rules to
assign a QoS Class to the traffic.

The rules on the QoS tab of the QoS Policy are linked to different types of traffic using the QoS Classes. QoS
Classes are matched to traffic in the Access rules with the following actions:
• Access rules with the Allow action set a QoS Class for traffic that matches the rules.
• Access rules with the Continue action set a QoS Class for all subsequent matching rules that have no specific

QoS Class defined.
• Access rules with the Use VPN action (Firewall only) set a QoS Class for VPN traffic. Incoming VPN traffic

can also match a normal Allow rule after decryption. Otherwise, for outgoing traffic, encryption is done after
the QoS Policy is checked. For incoming traffic, decryption is done before the QoS Policy is checked.

If you want to read and use DSCP markers set by other devices, the QoS Class is assigned according to rules on
the DSCP Match/Mark tab of the QoS Policy.

Note:  If traffic is assigned a QoS Class using a DSCP Match rule, the same traffic must not
match Access rules that assign a different QoS Class to the same traffic. Such Access rules
override the QoS Class that has been set with a DSCP Match rule.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the Firewall, IPS, Layer 2 Firewall, or Layer 2 Interface Policy for editing.

2) Click the QoS Class cell of a rule that allows traffic or a Continue rule, then drag and drop a QoS Class
element into the cell.

• The QoS Class links connections to a rule on the QoS tab of the QoS Policy. There can be different rules
in different QoS Policies for the same QoS Class.

• Packets in both directions of a connection are assigned the same QoS Class (when connection tracking is
active for the rule).

• The applied QoS Class is shown in the logs. You can also generate reports based on this information.

3) Refresh the engine’s policy to transfer the changes.

Related concepts
Getting started with Access rules on page 817



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Quality of Service | 962

Examples of bandwidth management
and traffic prioritization scenarios

There are common uses for the bandwidth management features and general steps on how each scenario is
configured.

Example: ensuring quality of important
communications
In this example, Company A has two offices, one in Italy and one in France. The company has decided to replace
phone lines with VoIP telephony.

 
Figure 147: Company A networks

The illustration shows the two offices and the traffic between them. Telephone and email connections are an
important tool for the employees, who use these services to communicate with team members at the other office.
Also, employees at the Italian office must be able to use web-based tools at the French site. The administrators
determine the priorities as follows:
• The VoIP streaming audio is not only important, but it is also a time-critical service. VoIP streaming audio must

have the highest priority.
• Even though business email is important, email does not need to be delivered immediately after it has been

sent. This traffic can be assigned a lower priority.
• The web-based services are not time-critical, but delays and time-outs can annoy employees. The company

decides to give these services a lower priority than VoIP, but a higher priority than email. It is not necessary to
define a specific QoS Class for the medium-priority traffic because all traffic that is not classified is assigned a
medium priority.

The internal networks are fast, so there is no need to implement QoS Policies for those interfaces. Only
interfaces connected to the Internet need a QoS Policy. The administrators decide that the same QoS Policy can
be used at both sites, and that the default elements and the default Prioritize policy are suitable.

So now they:

1) Add the QoS Class “High Priority” to Access rules that permit VoIP traffic.

2) Add the QoS Class “Low Priority” to Access rules that permit email traffic.

3) Define the QoS Policy Prioritize to be used on the interfaces connected to the Internet at both sites. They
also define the types of interface throughput.
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4) Refresh the policies of both firewalls.

Example: using QoS to prepare for ISP
breakdown
Company B decides to use Multi-Link to ensure High Availability of network connections for important business
communications.

The company, an engineering subcontractor, is concerned about two types of connections:
• A VPN connection they have for accessing the internal tools and resources of an important client when doing

work for them.
• HTTPS connections to the extranet server that the company’s clients use to check the status of projects.

The company has a tight budget, and the cost of having enough bandwidth in both links even during peak hours
is deemed too high. They decide that only the two most important types of traffic must get through if one ISP link
goes down during peak hours. The company determines that 500 kbps is enough to handle those connections, so
they subscribe to 512 kbps links from two different ISPs. None of the communications are especially time-critical,
so the company decides not to prioritize the traffic.

Then the administrators:

1) Create a QoS Policy and two QoS Classes, called VPN and Extranet.

2) Create the QoS rules for the important connections by filling in the following cells:

Table 110: QoS rules in QoS Policy for Company B

QoS Class Guarantee

VPN 400

Extranet 100

3) Add the QoS Class “VPN” to the VPN rule for outbound traffic in the Firewall’s Access rules.

4) Add the QoS Class “Extranet” to the Access rule that allows outbound connections from the company
extranet.

5) Define the types of throughput and select the custom QoS Policy to be used for the Physical Interfaces that
correspond to the ISP links on the firewall.

6) Refresh the policy of the firewall.
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Example: limiting bandwidth
Company C has experienced a radical increase in the amount of network traffic and wants to limit non-essential
traffic to prioritize business communications.

It seems that many employees use bandwidth-intensive services, download large files, and listen to high-quality
Internet radio streams. The situation is starting to slow down business communications. Management would
rather prohibit connections that are not directly work-related than fund the required increase in bandwidth.

However, the administrators suggest a different approach: limiting the portion of the bandwidth that non-
essential traffic can use, so some employees can still listen to Internet radio, while business communications are
guaranteed the bandwidth they need. To ensure the quick delivery of time-critical business communications, they
also decide to prioritize the traffic using the three default QoS Classes.

The administrators:

1) Create a custom QoS Policy with the following rules:

Table 111: QoS rules in QoS Policy for Company C

QoS Class Priority Guarantee Limit

High Priority 1 35% 90%

Normal Priority 8 55% 90%

Low Priority 16 5% 50%

• Normal Priority traffic gets the largest guaranteed portion of the bandwidth because it has the largest
volume.

• High Priority and Normal Priority traffic can each use up to 90% of the bandwidth. Low Priority traffic
cannot consume more than 50% of the available bandwidth even if there is more bandwidth available. In
this configuration, there must be traffic in at least two of the classes for the bandwidth to be used up to
100%.

• Even Low Priority traffic is given 5% of the bandwidth to avoid total loss of service, which can cause more
complaints from users than slowed-down service.

2) Place a Continue rule at the top of the firewall Access rules that includes the Normal Priority QoS Class. This
way, all traffic that is not classified as High Priority or Low Priority is classified as Normal Priority.

3) Edit the Access rules to assign QoS Classes to traffic:
• Place the High Priority QoS Class into Access rules that permit important traffic.
• Place the Low Priority QoS Class into Access rules that permit low-importance traffic.

4) Define the types of throughput and select the new custom QoS Policy to be used for the Physical Interfaces
connected to the Internet on the firewall.

5) Refresh the policy of the firewall.
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Monitoring and restricting what data is sent out is an important part of data loss prevention (DLP). File filtering allows
you to restrict the file types that are allowed in and out through the firewall, and to apply malware detection to files.

How file filtering works
Use file filtering to scan files for malware and to restrict which file types are allowed through the firewall.

You can configure one or more malware detection methods that are applied to the traffic that matches the rules in
the File Filtering Policy. Scanning is done in the following order:

1) The file is checked against file reputation information in the engine's cache.
If no match is found, the configured malware detection methods are applied to the traffic in the order listed
here.

2) The file is scanned using one of the following file reputation services:
• McAfee® Threat Intelligence Exchange (TIE)
• McAfee® Global Threat Intelligence™ (McAfee GTI)

3) The file is scanned using anti-malware scan on the NGFW Engine.

4) The file is scanned using one of the following sandboxes:
• Cloud Sandbox — Forcepoint Advanced Malware Detection
• Local Sandbox — Forcepoint Advanced Malware Detection

The NGFW Engine allows or blocks the file according to the action defined in the File Filtering Policy.
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File filtering configuration overview
To use file filtering, integrate or configure one or more malware detection methods and add rules for file filtering.

 
Figure 148: Components and elements in the configuration

1 McAfee Global Threat Intelligence file reputation service or McAfee Threat Intelligence Exchange (TIE)
file reputation service

2 Forcepoint Advanced Malware Detection sandbox service

3 File Filtering Policy

4 Firewall, IPS, Layer 2 Firewall, or Layer 2 Interface Policy

5 NGFW Engine

The configuration of file filtering consists of the following general steps:

1) Integrate or configure one or more malware detection methods.
• (Optional) Integrate Forcepoint NGFW with one of the following file reputation services:

• McAfee Global Threat Intelligence
• McAfee Threat Intelligence Exchange (TIE)

• (Optional) Integrate Forcepoint NGFW with the Forcepoint Advanced Malware Detection sandbox service.
• (Optional) Enable Anti-Malware for the engine.

Note:  Each malware detection method is optional, but you must integrate or configure at
least one malware detection method.

2) Create a File Filtering Policy element and add rules to the File Filtering Policy.

3) Enable file filtering in a Firewall, IPS, Layer 2 Firewall, or Layer 2 Interface Policy element.
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Note:  File filtering is only available for protocols for which the engine can do deep inspection. If a
protocol is not included in the engine's deep inspection license, file filtering is not available for that
protocol.

Integrate file reputation services and
sandboxes

Integrating Forcepoint NGFW with file reputation services and sandboxes improves the malware detection
coverage of Forcepoint NGFW when you use file filtering.

Integrate McAfee GTI file reputation with
Forcepoint NGFW

Integrating Forcepoint NGFW with McAfee Global Threat Intelligence file reputation services allows access
control based on the scan results.

Note:  Integrating McAfee GTI requires enabling McAfee GTI File Reputation and authorizing the
use of the McAfee GTI service.

The McAfee GTI database contains classifications of files. When a file transfer matches a rule in the File Filtering
Policy that applies McAfee GTI file reputation, the NGFW Engine sends a hash of the file to the McAfee GTI
cloud. McAfee GTI file reputation compares the hash of the file against the McAfee GTI database.

Note:  Only a hash of the file is sent to the McAfee GTI cloud. No other data or telemetry
information is sent to the McAfee GTI cloud.

Use of McAfee GTI file reputation does not require a separate license in the SMC.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Authorize the use of McAfee GTI in the Management Client.

a) Select  Menu > System Tools > Global System Properties.

b) On the Global Options tab, select Enable McAfee Global Threat Intelligence (GTI) and Threat
Intelligence (TIE) usage.

2) Enable McAfee GTI file reputation checks.

a) Select  Configuration.

b) Right-click an engine, then select Edit <element type>.
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c) Browse to Add-Ons > File Reputation.

d) In the File Reputation Service drop-down list, select McAfee Global Threat Intelligence (GTI).

e) Click  Save and Refresh.

Result

McAfee GTI file reputation scan can now be used for malware detection in the File Filtering Policy.

Integrate TIE file reputation with
Forcepoint NGFW

Integrate Forcepoint NGFW with McAfee® Data Exchange Layer (DXL) and McAfee® Threat Intelligence
Exchange (TIE) file reputation to receive file reputation data from the TIE server. Use the reputation data in file
filtering to improve the malware detection coverage of Forcepoint NGFW.

Before you begin
To generate the DXL certificates required for the exchange of file reputation data with the TIE server,
you must configure an ePO Server element and initialize the ePO Server SSL context.

Note:  Integrating TIE file reputation requires enabling McAfee TIE and authorizing the use of the
McAfee TIE service.

DXL is a framework of client software and brokers that enables the exchange of real-time encrypted file
information between integrated security components in the network environment. The TIE server uses DXL to
collect file reputation data. When Forcepoint NGFW is integrated with DXL and TIE file reputation, Forcepoint
NGFW engines can request and automatically receive up-to-date file reputations from the TIE server. This
ensures that NGFW Engines always have the latest file reputations available for use in file filtering.

Use of TIE file reputation does not require a separate license in the SMC. However, the DXL service
components, such as the DXL broker, might require a separate DXL license.

Note:  You cannot use TIE file reputation with Sidewinder Proxies. If the File Filtering Policy uses
TIE file reputation, it is ignored for traffic that uses Sidewinder Proxies. If no other scanners are
available, file transfers are allowed or discarded according to the selection for the Action When
No Scanners Are Available option.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Authorize the use of TIE in the Management Client.

a) Select  Menu > System Tools > Global System Properties.
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b) On the Global Options tab, select Enable McAfee Global Threat Intelligence (GTI) and Threat
Intelligence (TIE) usage.

2) Enable TIE file reputation checks.

a) Select  Configuration.

b) Right-click an engine, then select Edit <element type>.

c) Browse to Add-Ons > File Reputation.

d) In the File Reputation Service drop-down list, select McAfee Threat Intelligence Exchange (TIE).

e) Next to the ePO Server field, click Select, then select the ePO Server element.

f) Click  Save and Refresh.
The DXL certificates are automatically generated.

Result

TIE file reputation scan can now be used for malware detection in the File Filtering Policy.

Integrate McAfee ePO with Forcepoint
NGFW

You need to integrate McAfee ePO if you use McAfee TIE for file reputation checking.

McAfee ePO is a centralized management tool for endpoint solutions deployed on multiple hosts. Integrating a
McAfee ePO server allows you to query information about client computers in the protected network.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Create an ePO Server element.

a) Select  Configuration, then browse to Network Elements.

b) Browse to Servers.

c) Right-click Servers and select New > ePO Server.

d) In the Name field, enter a unique name for the element.

2) Configure the contact information for connections to the McAfee ePO server.

3) Click OK.
You are prompted to initialize the SSL context trusted by the McAfee ePO server.
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4) Click Yes.
Information about the certificate authority that signed the certificate for communication with the McAfee ePO
server is displayed.

5) Click OK.
Contact is established with the McAfee ePO server.

6) Click OK.

Result

You can now query information about client computers in the protected network from the Logs view.

Forcepoint Advanced Malware Detection
and how it works

Forcepoint Advanced Malware Detection detects advanced threats by analyzing the behavior of files in the a
restricted operating system environment.

Two types of sandbox servers are available for Forcepoint Advanced Malware Detection:

Table 112: Sandbox servers for Forcepoint Advanced Malware Detection

Type of server Description

Cloud Sandbox — Forcepoint Advanced Malware
Detection

Files are analyzed externally on a cloud sandbox
server.

Local Sandbox — Forcepoint Advanced Malware
Detection

Files are analyzed locally on a Forcepoint Advanced
Malware Detection appliance.

File filtering using Forcepoint Advanced Malware Detection follows this process:
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1 When a file transfer matches a rule in the File Filtering Policy that applies the advanced malware
sandbox scan, the NGFW Engine sends a hash of the file to the sandbox server. If the file is a .zip
archive, the NGFW Engine sends a hash of each file in the archive to the sandbox server.

2 If the hash matches a file that has previously been analyzed, the sandbox server returns a file
reputation to the NGFW Engine. The NGFW Engine allows or blocks the file according to the File
Filtering Policy.

3 If the hash of the file does not match a previously analyzed file, the sandbox server returns the
Unknown file reputation for the file.
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4 The NGFW Engine allows, blocks, or delays the file transfer according to the Allow After options for
the rule in the File Filtering Policy.

5 If the file has not previously been analyzed, the NGFW Engine uploads a copy of the unknown file to
the sandbox server. If any of the files in a .zip archive have not previously been analyzed, the NGFW
Engine uploads a copy of the whole .zip archive to the sandbox server.

Note:  When you use the cloud sandbox for Forcepoint Advanced Malware Detection,
unknown executable, document, and archive files, including HTML and JavaScript,
are uploaded to the cloud sandbox servers. Do not use the cloud sandbox in countries
where transferring files or other data outside of the country is prohibited. Binary files that
are uploaded to the cloud sandbox might be stored in the cloud sandbox.

6 The sandbox server analyzes the behavior of the file in a restricted operating system environment. If
the file is a .zip archive, the sandbox server analyzes the behavior of each file in the archive.

7 When the analysis is complete, the sandbox server sends an updated file reputation to the NGFW
Engine. The updated file reputation is cached on the NGFW Engine that requested the scan and stored
on the sandbox server.

Note:  The updated file reputation does not affect files that have already been allowed or
discarded.

If the same file is transferred again, the sandbox server returns the stored file reputation for the file.
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Licenses for Forcepoint Advanced Malware
Detection
To use Forcepoint Advanced Malware Detection, you must download and install a license that includes the
Forcepoint Advanced Malware Detection feature.

For more information about how to obtain licenses for Forcepoint Advanced Malware Detection, see Knowledge
Base article 12514.

The license for the cloud sandbox includes two pairs of license keys and license tokens:

• A license key and license token for EU data centers
• A license key and license token for US data centers

CAUTION:  The license keys and license tokens allow access to confidential analysis reports.
Handle the license key and license token securely.

The license keys and license tokens for the cloud sandbox define the home data center where the cloud sandbox
analyzes and stores files. Make sure that you install the license key and license token for the region that you want
to use as your home data center. If the data center that the firewall contacts is in a different region than the home
data center that is specified in the license, files are forwarded to the home data center.

The license for the local sandbox includes a license key and license token for use with your Forcepoint Advanced
Malware Detection appliance.

Limitations of Forcepoint Advanced Malware
Detection
There are some limitations when you use Forcepoint Advanced Malware Detection.

Each engine communicates separately with the sandbox service. If different engines detect the same file before
an analysis result is stored on the sandbox server, the engines might upload the same file more than once.
However, if the hash of the file matches a stored result, the engine does not upload the file again.

Rules for Forcepoint Advanced Malware
Detection
Rules to allow communication with the sandbox service are automatically generated based on the NGFW Engine
configuration.

The Default File Filtering Policy applies the advanced malware sandbox scan settings defined for the engine
to some traffic by default. If you want to exclude specific traffic from these scans, add a more specific rule to a
custom File Filtering Policy, or add an Access rule that excludes the traffic from file filtering.

https://support.forcepoint.com/KBArticle?id=Licenses-for-Forcepoint-Advanced-Malware-Detection


 Forcepoint Next Generation Firewall 6.4 | Product Guide

File filtering | 974

Logging for Forcepoint Advanced Malware
Detection
Log entries related to allowed or blocked files contain information about the advanced malware sandbox scan
and about the status of the connection to the sandbox service.

The File Filtering Log Data Context shows all log entries related to file filtering events.

The following information is available in log entries:

• The Sandbox Reputation field shows the file reputation provided by the sandbox service.

Note:  Logging for allowed files is not enabled by default in the File Filtering Policy. You must
enable logging of allowed files to see the sandbox reputation of allowed files in the logs.

• When the NGFW Engine receives an updated file reputation from the sandbox service, the File reputation
updated Situation matches and a log entry is created.

• If the file reputation is not trustworthy, information messages can include a description of suspicious or
malicious behavior observed in the analysis.

• The information messages in log entries related to allowed or blocked files show errors related to the
connection to the sandbox service.

Using Forcepoint Advanced Malware Detection
with Master NGFW Engines and Virtual NGFW
Engines
In environments with Master NGFW Engines and Virtual NGFW Engines, you configure the settings for the
connection to the sandbox service on the Master NGFW Engine.

All Virtual NGFW Engines that are hosted by the same Master NGFW Engine use the same configuration. The
File Filtering Policy for each Virtual NGFW Engine defines whether the engine applies Forcepoint Advanced
Malware Detection to traffic.
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Integrate a Forcepoint Advanced
Malware Detection appliance with
Forcepoint NGFW

To use a local sandbox for Forcepoint Advanced Malware Detection, integrate a Forcepoint Advanced Malware
Detection appliance with Forcepoint NGFW.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In your network environment, install and configure the Forcepoint Advanced Malware Detection appliance.
For detailed instructions, see the documentation that is included in your appliance delivery.

2) Download and install licenses for Forcepoint Advanced Malware Detection.
For detailed instructions, see Knowledge Base article 12514.

Next steps

Create a Sandbox Service element to represent the Forcepoint Advanced Malware Detection appliance.

Define Sandbox Service elements
To use Forcepoint Advanced Malware Detection, you must create a Sandbox Service element that defines the
settings for the connection to the cloud sandbox or the local sandbox.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Engine Properties > Sandbox Services.

3) Right-click Sandbox Services, then select New Sandbox Service.

4) In the Name field, enter a unique name.

5) From the Data Centers drop-down list, select
• For the cloud sandbox, select Automatic, EU Data Centers, or US Data Centers.
• For the local sandbox, select Custom.

6) (Custom only) Enter the host name of the sandbox server in the Host Name field.
The host name is used to automatically generate the default values in the Server URL and Portal URL
fields. You can optionally change the URLs.

https://support.forcepoint.com/KBArticle?id=Licenses-for-Forcepoint-Advanced-Malware-Detection
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7) (Optional) To be able to view analysis history information in the external portal, enter the account for which
the file analysis reports are stored in the external portal in the Portal Username field.

8) (Custom only) Click Select next to the TLS Profile field, then select a TLS Profile element

9) Click OK.

Next steps

Connect Forcepoint NGFW to a sandbox service.

Connect Forcepoint NGFW to a sandbox
service

Configure the settings that Forcepoint NGFW uses to connect to the cloud sandbox or the local sandbox.

Before you begin
You must have a Sandbox Service element that defines the settings for the connection to the cloud
sandbox or the local sandbox.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine, then select Edit <element type>.

3) Browse to Add-Ons > Sandbox.

4) From the Sandbox Type drop-down list, select one of the following options:
• Cloud Sandbox - Forcepoint Advanced Malware Detection
• Local Sandbox - Forcepoint Advanced Malware Detection

Note:  To use a local sandbox, you must have a Forcepoint Advanced Malware Detection
appliance.

5) In the License Key field, enter or paste the license key for the connection to the sandbox service.
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6) In the License Token field, enter or paste the license token for the connection to the sandbox service.

CAUTION:  The license key and license token allow access to confidential analysis reports.
Handle the license key and license token securely.

Note:  For the cloud sandbox, the license defines the home data center where files are
analyzed and stored. Enter the license key and license token for the region that you want to
use as your home data center.

7) Click Select next to the Sandbox Service field, then select a Sandbox Service element.
• For the cloud sandbox, select the Sandbox Service element that represents the data center that the

firewall contacts to request file reputation scans.

Note:  If the data center that the firewall contacts is in a different region than the home
data center that is specified in the license, files are forwarded to the home data center.

• For the local sandbox, select the Sandbox Service element that represents your Forcepoint Advanced
Malware Detection appliance.

8) Click  Save and Refresh to transfer the changed configuration.

Result

You can now use the Advanced Malware Detection scan for malware detection in the File Filtering Policy.

View sandbox analysis reports
In an external portal or in the local portal provided by your Forcepoint Advanced Malware Detection appliance,
you can view detailed reports for files that have been analyzed by sandbox services.

When a file has been analyzed, log entries related to cloud sandbox or local sandbox scans include a link to the
analysis report in the Scan Report field.

Note:  You cannot view reports for log entries where the Scanner Details cell shows the
message "Sandbox Analysis Pending".

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Logs.

2) From the Log Data Context drop-down list on the Query pane, select File Filtering, then click Apply.
Only log entries related to file filtering events are shown.

3) In a log entry that includes a link in the Scan Report cell, right-click the link, then select Open URL in
default browser.
The portal opens in a web browser.

4) Enter your credentials to view the report.
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Restrict file types with file filtering
Configure file filtering if you want to restrict the file types that are allowed through the firewall, and to apply
malware detection to files.

Before you begin
Integrate or configure one or more malware detection methods.

Rules for file filtering are defined in the File Filtering Policy. When a file transfer is detected, the traffic is checked
against the File Filtering Policy. The first rule that matches the traffic is applied. If no matching rule is found, the
file transfer is allowed.

If you do not want to create a custom File Filtering Policy, you can use one of the following default File Filtering
Policy elements:

• Anti-Malware All — Applies the anti-malware and file reputation scanning methods that are defined in the
Engine Editor to all traffic. Rematches archive content for the following file types: Memory Dumps, Media File,
Data File, Text, Empty.

• Anti-Malware Legacy — Applies the anti-malware and file reputation scanning methods that are defined in
the Engine Editor to all traffic. Rematches archive content for all file types.

• Default File Filtering — Applies specific scanning methods and options depending on the file source, file
destination, and file type.

Related concepts
Configure anti-malware on engines on page 678

Related tasks
Integrate McAfee GTI file reputation with Forcepoint NGFW on page 967

Create File Filtering Policy elements
File Filtering Policy elements contain the rules for file filtering.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click Policies and select New > File Filtering Policy.

3) In the Name field, enter a unique name for the File Filtering Policy.

4) Click OK.
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Result

The File Filtering Policy opens for editing.

Add rules to File Filtering Policy elements
The rules in the File Filtering Policy allow you to define rule-specific options for malware detection.

Before you begin
You must create a File Filtering Policy element.

Rules are read from the top down. Place more specific rules above more general rules that match the same
traffic. For example, if there is a rule that allows a file type without scanning above a rule that applies scanning,
the matching files are allowed without scanning.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Add a rule in one of the following ways:
• Right-click the last row in an empty policy, then select Add Rule.
• Right-click the ID cell of an existing rule, then select Add Rule Before or Add Rule After.

2) Drag and drop elements from the Resources pane to the Source and Destination cells, or define source
and destination criteria.

Note:  The Source and Destination fields are the source and destination of the file transfer,
not the source and destination of the connection.

A client in the internal network downloads a file from a web server on the Internet. The source is the web
server that served the file. The destination is the client computer.

3) Drag and drop File Type Situations from the Resources pane to the File Type cell.

4) Right-click the Action cell, then select the action.

5) If you selected Allow After, select options for malware detection scans.
The scanning methods are applied in the order in which they are listed. If a file transfer is not blocked by an
earlier scan, the action specified for the last scanning method determines whether the file transfer is allowed
or blocked. If none of the enabled malware detection scanning methods are available, the action specified
for the  Action When No Scanners Are Available option determines whether the file transfer is allowed or
blocked.

6) (Optional) To configure the logging options, double-click the Logging cell in the rule.

7) Click  Save.
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Enable file filtering in policy elements
When you enable file filtering in Firewall, IPS, Layer 2 Firewall, or Layer 2 Interface Policy elements, traffic is
checked against the File Filtering Policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click a policy and select Edit <policy type>.

3) On the IPv4 Access or IPv6 Access tab, enable file filtering in existing rules or add new rules.
• Enable File Filtering in the action options of individual Access rules.
• Add rules with the Continue action to set defaults for file filtering.

4) (Not available in Layer 2 Interface Policies) On the Inspection tab, select the File Filtering Policy.
If there is no custom File Filtering Policy, the default File Filtering Policy is used.

5) To save and install the policy, click  Save and Install.

Related concepts
Getting started with policies on page 787

Support for McAfee Advanced Threat
Defense

McAfee Advanced Threat Defense is no longer supported in NGFW version 6.4.0 and later. We recommend that
you use Forcepoint Advanced Malware Detection instead.
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Integrating Endpoint Context
Agent

Contents

• ECA and how it works on page 981
• Create ECA Configuration elements on page 983
• Enable ECA on the NGFW Engine on page 984
• Define Endpoint Application elements on page 984
• Define Endpoint Settings elements on page 985
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If you have installed Forcepoint Endpoint Context Agent (ECA) clients on the endpoints in your network, you can collect
information about endpoint clients, and use the information for access control in the SMC.

CAUTION:  If McAfee Endpoint Intelligence Agent (McAfee EIA) is configured on the NGFW Engine
when you upgrade to version 6.3 or later, the NGFW Engine node is returned to the initial configuration
state and stops processing traffic. You must remove the McAfee Endpoint Intelligence Agent (McAfee
EIA) configuration and refresh the policy before you upgrade to version 6.3 or later. For more
information, see Knowledge Base article 14093.

ECA and how it works
Integrating ECA enables you to collect per-connection user and application information about Windows endpoint
clients that connect through an NGFW Engine managed by the SMC.

To use ECA, the ECA client must be installed on the endpoints. For more information about ECA clients, see the
Installation and Deployment Guide for Forcepoint Endpoint Context Agent.

The endpoints send metadata to the NGFW Engine, and you can use the information as criteria for access
control in policies. This information about the endpoints can also be viewed in log data and used in Report
elements.

On the home page for an NGFW Engine, you can see the number of endpoint clients that are connected and
sending information. You can also use the drill-down menu to see which users are connected.

ECA is supported on Firewalls, Layer 2 Firewalls, IPS engines, and on Virtual Firewalls. The NGFW Engine
license includes support for ECA integration.

You cannot use ECA if there is a NAT device between the NGFW Engines and the endpoints.

https://support.forcepoint.com/KBArticle?id=000014093
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Use cases
An example use case is a point of sale (PoS) terminal. For example, you can:

• Allow a certain browser version to access the corporate intranet, only if the local firewall on the endpoint is
enabled and the operating system was updated within the past 30 days.

• Allow the PoS application to access corporate servers
• Allow the Windows Update service
• Block all other applications

ECA configuration overview
The configuration of ECA consists of several general steps.

 
Figure 149: ECA elements

NGFW Engine Policy

CA
ECA Configuration Endpoint Application Endpoint Settings

Configuration XML file

AD CS

Endpoint clients

Follow these general steps to configure ECA integration:

1) Create or use a Certificate Authority from the domain where the endpoint clients are located, then import the
CA to the SMC as a Trusted Certificate Authority element. For more information, see Knowledge Base article
14099.

2) In the Management Client, create an ECA Configuration element that uses the created CA.

3) Enable ECA on the engine, and use the ECA Configuration element that you created.

https://support.forcepoint.com/KBArticle?id=000014099
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4) Export the ECA configuration XML file (eca.conf), and use the file when installing the ECA client on the
endpoints.
The file contains the details of all the NGFW Engines that use the same ECA Configuration element.

If additional NGFW Engines are added to the configuration, the updated eca.conf configuration file is
automatically sent to the endpoint clients.

5) (Optional) To use endpoint client information for access control, define Endpoint Application and Endpoint
Settings elements.

6) (Optional) In the engine's policy, configure Access rules using Endpoint Application and Endpoint Settings
elements as matching criteria.

7) (Optional) To view endpoint information in log data and Report elements, enable endpoint information
logging in the Access rules.

Access rules to allow communication between ECA components are automatically generated.

Create ECA Configuration elements
ECA Configuration elements contain the Trusted Certificate Authority element used to secure communication
between the NGFW Engine and the endpoint clients.

Before you begin
Create or use a Certificate Authority from the domain where the endpoint clients are located, then
import the CA to the SMC as a Trusted Certificate Authority element. For more information, see
Knowledge Base article 14099.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Engine Properties > ECA Configurations.

3) Right-click ECA Configurations, then select New ECA Configuration.

4) Configure the settings, then click OK.

Next steps

Enable ECA on the NGFW Engines, and select the ECA Configuration element that you created.

Related tasks
Create Trusted Certificate Authority elements on page 137

https://support.forcepoint.com/KBArticle?id=000014099
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Enable ECA on the NGFW Engine
Enable ECA on the NGFW Engines on which you want to receive endpoint client information.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click a NGFW Engine, then select Edit <element type>.

3) Browse to Add-Ons > Endpoint Integration.

4) From the Endpoint Service drop-down menu, select Forcepoint Endpoint Context Agent, then configure
the settings.

5) Click  Save.

6) Click Export ECA Configuration, then choose where to save the eca.conf XML file that contains the
configuration.
The details of all the NGFW Engines that use the same ECA Configuration element are included in the
exported eca.conf file. You must have finished configuring all the NGFW Engines before you export the file.

Next steps

Use the exported eca.conf file when installing the clients on the endpoints. For more information, see the
Installation and Deployment Guide for Forcepoint Endpoint Context Agent.

Define Endpoint Application elements
Use Endpoint Application elements for access control in the SMC.

Endpoint Application elements contain information about the applications used by the endpoint clients. The
elements are delivered in dynamic update packages, but you can also create elements manually. If you upgraded
the SMC, you might have Executable elements. We recommend using Endpoint Application elements instead.

Endpoint Application elements are categorized by usage type with Tag elements. You can use a Tag in a policy
to allow or block the use of a category of applications, such as instant messaging applications.
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Create Endpoint Application elements
Create Endpoint Application elements by defining the details of the applications used on the endpoints.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Endpoint Information > All Endpoint Applications.

3) Right-click All Endpoint Applications, then select New Endpoint Application.

4) Define the properties of the Endpoint Application element.

5) (Optional) To categorize the element with a Tag, click the Tags tab.

a) Select Add Tags > Endpoint Application Usage.

b) Browse for the Tag you want to use, then click Select.

6) Click OK.

Define Endpoint Settings elements
Use Endpoint Settings elements for access control based on endpoint information.

Endpoint Settings elements define what information to collect about the endpoint clients. For example, you can
check the operating system in use and whether it has received security updates, you can check if the anti-virus
software on the client is enabled and up-to-date, or you can check the status of the local firewall. Depending on
the type of information that you are checking for, you might want to allow or discard traffic from clients where the
criteria matches.

Create Endpoint Settings elements
Create Endpoint Settings elements by defining the information to check on the endpoint clients.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Endpoint Information > Endpoint Settings.

3) Right-click Endpoint Settings, then select New Endpoint Settings.
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4) Define the properties of the element.

5) Click OK.

Use endpoint information in Access
rules

In Access rules, you can configure the engine to allow or discard connections based on endpoint client
information.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Policies > <policy type>.

3) Right-click the policy you want to edit, then select Edit <policy type>.

4) Add a rule.

5) In the navigation pane, select Endpoint Information, browse to the Endpoint Application or Endpoint
Settings elements, then drag them to the Source cell.

Tip:  To select all Endpoint Application elements that have been categorized using the same
tag, drag the appropriate Tag element.

6) Define the other options for the rule as needed.

7) Save and install the policy to transfer the changes to the NGFW Engines.

Enable logging of endpoint information
Logging of endpoint information allows you to view endpoint client information and users in log data and Report
elements.

By default, endpoint information is logged when it is used for matching in the Access rules. You can optionally set
endpoint information to be logged whenever it is received.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the policy for editing.
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2) In an Access rule where Endpoint Application or Endpoint Settings elements are used, double-click the
Logging cell.

3) Make sure Override Recording Settings Inherited from Continue Rule(s) is enabled.

4) In the Log User Information and Log Endpoint Information drop-down lists, select the appropriate logging
option.

Note:  In order to log user information, both Log User Information and Log Endpoint
Information must be set to Enforced.

5) Click OK.

6) Save and install the policy to transfer the changes to the engines.
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URL filtering allows you to filter URLs based on categories of content or lists of individual URLs.

URL filtering and how it works
URL filtering compares the URLs that end-users attempt to access to URL categories or lists of URLs.

You can use URL filtering to prevent users from accessing websites that provide content that is objectionable,
potentially harmful, or not work-related. This kind of content filtering can increase network security and enforce an
organization’s policy on acceptable use of resources.

In URL filtering, the engines compare the URLs in HTTP and HTTPS requests against URL categories or lists of
URLs. There are two ways to define the URLs:
• You can use URL Category and URL Category Group elements to filter URLs based on URL categorization.
• You can use URL List elements to filter specific URLs.

You can use both methods together. You can also define allowed URLs manually if a URL that you want to allow
is included in a category of URLs that you otherwise want to block.

The URL categorizations are provided by the external Forcepoint™ ThreatSeeker® Intelligence Cloud service.
ThreatSeeker Intelligence Cloud (ThreatSeeker) provides categories for malicious websites and several
categories for different types of non-malicious content you might want to filter or log. The NGFW Engine sends
categorization requests using HTTPS to ThreatSeeker.

URL Category Group elements contain several related URL Categories. When you use URL Category Group
elements in the Access rules, the rule matches if any of the URL Categories included in the URL Category Group
match.

The engine can use the server name indication (SNI) in HTTPS traffic for URL categorization without decrypting
the HTTPS connection. When a web browser contacts a server to request a page using HTTPS, the browser
sends the server name in an unencrypted SNI field. However, the requested URL is not known when HTTPS
connections are not decrypted.
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You can use category-based URL filtering to create Access rules that disallow decryption for traffic in the
specified categories. For example, you can create rules that prevent traffic to online banking services from being
decrypted.

Note:  If the end user’s browser does not use SNI and the traffic does not match rules for
category-based URL filtering, the traffic might be decrypted.

You can configure the engine to respond in various ways when a match is found. For example, you can log the
matches or block the traffic. If you decide to block traffic, the engine can notify end users with a message in their
browsers. You can define customized User Response elements for URL filtering matches, such as a custom
HTML page that is displayed to the end user when a connection is blocked.

If the engine detects that it cannot connect to ThreatSeeker, all URLs match the Data Provider Error URL
Category. You can optionally add Access rules to discard all traffic that cannot be categorized.

Limitations
• Category-based URL filtering using the ThreatSeeker Intelligence Cloud service is a separately licensed

feature.
• Category-based URL filtering is based on the categorizations of the external service, so it is not possible to

manually add or directly edit the URL filtering categories. Add URL Lists to Access rules if you want to create
exceptions to the category-based URL filtering.

Note:  The engine can only use one kind of URL categorization at a time. If you used legacy
URL filtering with Forcepoint NGFW version 6.0 or earlier, you must migrate the engine to use
ThreatSeeker URL filtering when you upgrade the engine to version 6.1 or later.

Related concepts
How redirecting traffic for inspection works on page 1059

Related tasks
Migrate a single NGFW Engine to ThreatSeeker URL filtering on page 997
Migrate an NGFW cluster to ThreatSeeker URL filtering on page 998
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URL filtering configuration overview
The URL filtering feature is configured using category-based URL filtering and custom URL Lists.

 
Figure 150: Elements in the configuration

The Access rules define how URL Categories and URL Lists are matched to traffic and what reaction a match
triggers. URL Lists can override category-based URL filtering to allow some URLs manually.

Because an external service defines the URLs that are included in category-based URL filtering, it is not possible
to add or edit categories. The category names for category-based URL filtering are updated through dynamic
update packages.

1) (Category-based URL filtering) Enable ThreatSeeker for the engine.

2) (Category-based URL filtering) Make sure that the engine and the network are set up so that the engine can
contact the ThreatSeeker Intelligence Cloud servers to request URL categorizations.
• Make sure that DNS servers are defined for the engine in the General branch of the Engine Editor.
• Make sure that the engine can access the DNS server (UDP port 53, Service element "DNS (UDP)"). The

connections are automatically allowed from the engine on which the policy is installed, but not from other
components.

• (Optional) Configure an HTTP proxy for the connection to the ThreatSeeker Intelligence Cloud server in
the Add-Ons > ThreatSeeker branch of the Engine Editor.

3) (Optional) Create User Responses to notify users about matches that are found.

4) (Optional when using category-based URL filtering) Create URL Lists to block or allow URLs manually.

5) Add Access rules to define how URL filtering is applied.
• Create IPv4 or IPv6 Access rules to define how URL Categories are matched to traffic and what kind of

reaction a match triggers.
• Create IPv4 or IPv6 Access rules to define how URL Lists are matched to traffic and what kind of reaction

a match triggers.
For example, you can add rules for URL Lists to create exceptions to rules for category-based URL
filtering.

Related concepts
User Response elements and how they work on page 945
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Related tasks
Use an HTTP proxy to connect to the ThreatSeeker Intelligence Cloud server on page 993
Add Access rules for category-based URL filtering on page 994
Add URL List elements to manually block or allow URLs on page 995
Add Access rules for custom URL Lists on page 996
Migrate a single NGFW Engine to ThreatSeeker URL filtering on page 997
Migrate an NGFW cluster to ThreatSeeker URL filtering on page 998

Default elements for URL filtering
There are default elements for the categories you can use in category-based URL filtering and for creating
custom URL lists.

• URL Category elements represent the categories for category-based URL filtering.
• URL Category Group elements contain several related URL Categories.

You can find these elements under Network Applications > By Type > URL Category Group in the element
tree.

Note:  The URL Categories and URL Category Groups are predefined. It is not possible to add
or edit URL Categories or URL Category Groups.

• URL List elements allow you to manually define lists of URLs. You can find these elements under Network
Applications > By Type > URL List in the element tree.

Enable ThreatSeeker for engines
To start using ThreatSeeker categories for URL filtering, enable ThreatSeeker for the engine.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click an engine, then select Edit <element type>.

3) In the navigation pane on the left, browse to Add-Ons > ThreatSeeker.

4) Select Enable.

5) Select from the following:
• To validate the changes, select  Tools > Validate.
• To validate and save the changes, click  Save.
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• To validate and save the changes and refresh the security policy on the engine, click  Save and
Refresh.

Note:  Validation issues are displayed in the Issues pane. Double-click an issue to return to
the section in which the issue can be fixed.

Use an HTTP proxy to connect to the
ThreatSeeker Intelligence Cloud server

You can optionally configure an HTTP proxy for the engine's connection to the external ThreatSeeker Intelligence
Cloud server.

When you use an HTTP proxy, categorization requests are sent through the proxy instead of the engine
accessing the external network directly.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Add one or more HTTP Proxy elements.

a) Select  Configuration.

b) Browse to Other Elements > Engine Properties.

c) Right-click HTTP Proxies, then select New HTTP Proxy.

d) Configure the settings.

e) Click OK.

2) In the Configuration view, browse to NGFW > NGFW Engines.

3) Right-click an engine, then select Edit <element type>.

4) In the navigation pane on the left, browse to Add-Ons > ThreatSeeker.

5) Next to the HTTP Proxies list, click Add.

6) Select one or more HTTP Proxy elements, then click Select.

7) Click  Save.
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Add Access rules for category-based
URL filtering

Use category-based URL filtering in IPv4 or IPv6 Access rules in a Firewall Policy, IPS Policy, Layer 2 Firewall
Policy, or Layer 2 Interface Policy to define which traffic is logged or blocked when a URL match is found.

Before you begin
Category-based URL filtering requires that the engine is licensed to use the ThreatSeeker
categorization service. You must also define DNS server addresses in the NGFW Engine elements so
that the engines can send categorization requests to ThreatSeeker.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a policy and select Edit <policy type>.

2) On the IPv4 Access or IPv6 Access tab, add a rule.

Tip:  As a general guideline, we recommend placing rules that allow traffic above rules that
block traffic.

3) Drag and drop elements from the Resources pane on the left to the Source and Destination cells.

4) Add URL Category or URL Category Group elements for category-based URL filtering in one of the following
ways:
• Drag and drop one or more elements from the Resources pane on the left to the Service cell.
• Add elements to the Service definition.

When you use URL Category Group elements in a rule, the rule matches if any of the URL Categories in the
group match.

5) In the Action cell, select the action depending on the purpose of the rule.
• To allow matching traffic, select Allow.
• To block matching traffic, select Discard.

6) (Optional) In the Logging cell, configure the logging options for the rule.

7) Click  Save and Install.

Next steps

If you want to make exceptions to the category-based URL filtering, add rules to manually block or allow URL
Lists.
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Related concepts
Getting started with Access rules on page 817
User Response elements and how they work on page 945

Related tasks
Define Source, Destination, and Service criteria in rules on page 861

Add URL List elements to manually
block or allow URLs

URL List elements allow you to define custom lists of URLs to block or allow.

The action that you select in the Access rules determines whether the URLs in the URL List are blocked or
allowed.

When you use URL Lists in combination with category-based URL filtering, you can allow individual URLs that
are included in a blocked category. Using URL Lists to allow URLs only affects other URL-based filtering. It does
not exclude the traffic from other inspection checks. Traffic to allowed URLs might still be terminated if deep
inspection is enabled and the traffic matches Situations in the Inspection Policy.

There is no limit on the number of URL Lists that you can create or on the number of URLs that you can add to
each URL List. You can enter URLs as whole URLs or partial URLs. Partial URLs must end with a slash (/). The
URLs in the list can match all URLs in a domain, all URLs in a specified path, or exact URLs.

When you add an exact URL, only the specified URL matches. Other URLs in the same domain or path
do not match. For example, if you add the exact URL www.example.com/index.html, connections to
www.example.com/main.html do not match.

When you add domains or paths, connections might match more than one URL in the list. For example, if you
add the exact URL www.example.com/path/index.html and the path example.com/path/, both URLs
match if the engine detects a request to http://www.example.com/path/index.html.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to NGFW > Other Elements > Network Applications > By Type > URL List.

3) Right-click URL List and select New > URL List Application.

4) Add one or more URLs.
• To add the first URL, double-click the empty row.
• To add a URL above an existing URL, right-click the URL and select Add.
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• To add a URL below an existing URL, right-click the empty space in the list and select Add.

Tip:  You can also paste a URL or a list of URLs into the field. Each line of text is
automatically added on a separate line.

5) Enter the URL without the http:// protocol.
• To match all URLs in a domain, enter the domain name followed by a slash (/).

Example — example.com/
• To match all URLs in the specified path, enter the path followed by a slash (/).

Example — example.com/path/
• To match an exact URL, enter the URL.

Example — www.example.com/index.html

6) (Optional) On the Tags tab, select the Tags that you want to use with this URL List.

7) Click OK.

Next steps

To use the URL List element for URL filtering, add it to an Access rule.

Add Access rules for custom URL Lists
Use URL List elements in the Access rules to block or allow individual URLs.

Before you begin
If you want to add a User Response element to the rule, you must have a custom User Response
element.

You can use URL Lists in Firewall, IPS, Layer 2 Firewall, and Layer 2 Interface Policies.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a policy and select Edit <policy type>.

2) On the IPv4 Access or IPv6 Access tab, add a rule.

Tip:  As a general guideline, we recommend placing rules that allow traffic above rules that
block traffic.

3) Drag and drop elements from the Resources pane on the left to the Source and Destination cells.

4) Add URL List elements in one of the following ways:
• Drag and drop one or more elements from the Resources pane on the left to the Service cell.
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• Add elements to the Service definition.

5) In the Action cell, select the action depending on the purpose of the rule.
• To allow matching traffic, select Allow.
• To block matching traffic, select Discard.

6) (Optional, Discard action only) To display warnings or notes in the users’ browsers when URL filtering
prevents access, add a User Response element to the rule.

a) Right-click the Action cell and select Edit Options.

b) On the Response tab, select Override Settings Inherited From Continue Rule(s).

c) Next to the User Response field, click Select.

d) Select your custom User Response element and click Select.

e) Click OK.

7) (Optional) In the Logging cell, configure the logging options for the rule.

8) Click  Save and Install.

Related concepts
Getting started with Access rules on page 817
User Response elements and how they work on page 945

Related tasks
Define Source, Destination, and Service criteria in rules on page 861

Migrate a single NGFW Engine to
ThreatSeeker URL filtering

If you used legacy URL filtering with Forcepoint NGFW version 6.0 or earlier, you must migrate the engine to use
ThreatSeeker URL filtering when you upgrade the single NGFW engine to version 6.1 or later.

Before you begin
Category-based URL filtering using the ThreatSeeker Intelligence Cloud service is a separately licensed
feature. You must install a license that supports URL filtering using the ThreatSeeker Intelligence Cloud
service before you migrate the NGFW Engine.

The policy that is uploaded to the engine depends on the engine version. For engines running version 6.0 or
earlier, only rules that contain legacy URL Situation elements are applied. For engines running version 6.1 or
later, only rules that contain new URL Category elements are applied.
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Note:  Do not use legacy URL Situation elements and URL Category elements in the same rule.
Rules that contain both legacy URL Situation elements and URL Category elements are ignored.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Create a transition policy that contains both the legacy URL Situation elements and the new URL Category
elements.

2) Install the transition policy on the engine.
Policy validation warnings about the legacy URL Situation elements are expected. You can safely ignore the
warnings.
Because the engine has not yet been upgraded to version 6.1 or later, the rules that contain the legacy URL
Situation elements are applied.

3) Upgrade the engine to Forcepoint NGFW version 6.1 or later, then verify that it works correctly.

4) Install the transition policy again.
Because the engine is running version 6.1 or later, the rules that contain the new URL Category elements
are applied.

Migrate an NGFW cluster to
ThreatSeeker URL filtering

If you used legacy URL filtering with Forcepoint NGFW version 6.0 or earlier, you must migrate the engines to
use ThreatSeeker URL filtering when you upgrade the NGFW cluster to version 6.1 or later.

Before you begin
Category-based URL filtering using the ThreatSeeker Intelligence Cloud service is a separately licensed
feature. You must install a license that supports URL filtering using the ThreatSeeker Intelligence Cloud
service before you migrate the NGFW Engine.

Note:  We recommend upgrading the cluster during a maintenance break.

The policy that is uploaded to the engine depends on the engine version. For engines running version 6.0 or
earlier, only rules that contain legacy URL Situation elements are applied. For engines running version 6.1 or
later, only rules that contain new URL Category elements are applied.

Note:  Do not use legacy URL Situation elements and URL Category elements in the same rule.
Rules that contain both legacy URL Situation elements and URL Category elements are ignored.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Create a transition policy that contains both the legacy URL Situation elements and the new URL Category
elements.

Tip:  If you already have a transition policy that you used to upgrade a single engine to
NGFW 6.1 or later, you can use the same transition policy for the cluster.

2) Install the transition policy on the cluster.
Policy validation warnings about the legacy URL Situation elements are expected. You can safely ignore the
warnings.
Because the engines have not yet been upgraded to version 6.1 or later, the rules that contain the legacy
URL Situation elements are applied.

3) Upgrade the first node to Forcepoint NGFW version 6.1 or later, then verify that it works correctly.

4) Upgrade the other nodes to Forcepoint NGFW version 6.1 or later.

5) Install the transition policy again.
Because all nodes are running version 6.1 or later, the rules that contain the new URL Category elements
are applied.

Examples of URL filtering
These examples show some common uses for URL filtering, and general steps for how each example is
configured.

Example: Allowing a blocked URL
In this example, a company is using category-based URL filtering and wants to make an exception to categorized
URLs that are blocked by default.

A social media website that users in the marketing department need to access is blocked by category-based URL
filtering. To make an exception for users in the marketing department, the administrators:

1) Create a URL List element and enter the URL of the social media website.

2) Add the following type of Access rule above the rules that apply category-based URL filtering.

Table 113: Rule for allowing URLs

Source Destination Service Action

Marketing department
users' workstations

ANY Custom URL List
element

Allow

3) Save and install the policy.
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Example: Discarding connections when URL
categorization is not available
In this example, a company is using category-based URL filtering and wants to block traffic that cannot be
categorized.

When URL categorization is not available, it might be possible for users to access URLs that are usually blocked.
To prevent users from accessing potentially harmful URLs, the administrators want to discard connections to
external servers that cannot be categorized.

Note:  Depending on the matching criteria in the Access rules, discarding connections when URL
categorization is not available might block all HTTP and HTTPS traffic.

The administrators:

1) Add the following type of Access rule after the rules that apply category-based URL filtering.

Table 114: Rule to discard connections that cannot be categorized

Source Destination Service Action

Internal Network element Not Internal expression Data Provider Error
URL Category

Discard

Tip:  If the engine detects that it cannot connect to ThreatSeeker, all URLs match the Data
Provider Error URL Category.

2) Save and install the policy.

Example: Preventing decryption of private
connections
In this example, a company uses category-based URL filtering to prevent connections to online banking services
from being decrypted.

The company uses several different online banking services for business purposes. It also allows users in the
company network to connect to personal online banking services. The company does not want connections to
any online banking services to be decrypted for TLS inspection.

Because URLs can be categorized based on the server name information (SNI) in HTTPS traffic, connections
to online banking services can be identified without decrypting the traffic. Options in the Access rules specify
whether decryption is allowed for matching traffic.

To identify connections to online banking services and prevent them from being decrypted, the administrators:

1) Add the following type of Access rule.
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Table 115: Rule to prevent decryption of private communications

Source Destination Service Action

ANY ANY Financial Data and
Services URL Category

Allow

2) Edit the action options and select Disallowed for the Decryption option.

3) Save and install the policy.
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Anti-malware scanning
Contents

• Anti-malware scanning overview on page 1003
• Configuring anti-malware scanning on page 1004

An anti-malware scanner compares network traffic against an anti-malware database to search for malware. If malware
is found, the traffic is stopped or content is stripped out.

Anti-malware scanning overview
Anti-malware scanning is a resource-intensive activity and is practical mainly in branch-office-type settings, where
the physical setup is as simple as possible with little equipment onsite.

Anti-malware scanning is needed when there is Internet connectivity at the site (instead of VPN connectivity to a
central site where traffic can be scanned centrally).

The scanner can inspect IPv4 traffic. The supported protocols are HTTP, HTTPS, IMAP, POP3, and SMTP. If the
scanner detects infected files, it strips them out. If an email attachment is filtered out, a message is added to the
email notifying the recipient.

In branch-office-type environments without skilled administrators, a centrally managed anti-malware scanning
solution on the same hardware as Forcepoint NGFW makes maintenance easier than having separate
equipment.

Limitations
Firewall, IPS, and Layer 2 Firewall clusters can be used for anti-malware scanning. However, some restrictions
apply. Since the data being inspected is not synchronized between the nodes, connections that are undergoing
anti-malware scanning at the time of a failover are dropped. The applications must reopen the connections.

Scanning directly on the Forcepoint NGFW is not practical in high-traffic environments. The amount of data
gathered for scanning is large, since files must be inspected as a whole to block all infected content. Storing and
scanning files significantly increases the demand for resources as the volume of traffic grows. Redirecting traffic
to a proxy service for external inspection is a more economical and flexible solution.

Related concepts
How redirecting traffic for inspection works on page 1059
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Configuring anti-malware scanning
Configure the anti-malware settings in the Engine Editor of the element and activate anti-malware scanning in the
File Filtering Policy.

Activating anti-malware scanning
The anti-malware settings in the Engine Editor allow you to set a schedule for downloading updates to the anti-
malware database and change the settings for logging the malware found in network traffic.

Selecting traffic for anti-malware scanning
You can activate anti-malware scanning in the File Filtering Policy that is referenced in a policy.

Activating the scanning always also activates deep packet inspection for the same traffic (the traffic is also
checked against the Inspection rules). You can deactivate the anti-malware scanning if the download source is
trusted and the download process takes too long. You must define the services individually in the Service cell to
enable deep inspection and anti-malware scanning for them.

To not scan for certain destinations, create a more specific IPv4 Access rule before a more general one that does
not have the file filtering option defined.

For some content delivered through HTTP or HTTPS, anti-malware scanning might not be feasible. For example,
you might want to prevent videoconferencing sessions from being scanned for malware, to avoid any increase in
latency.
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Protocol Agents on engines
Contents

• Protocol Agents overview on page 1005
• Configuring Protocol Agents on page 1007
• Using Protocol Agents on page 1008
• Examples of Protocol Agents on page 1014

Protocol elements of the Protocol Agent type are special modules for some protocols and services that require
advanced processing. Protocol Agents can enforce policies on the application layer.

Protocol Agents overview
Protocol Agents are software modules for advanced processing of protocols that require special handling on the
Firewall, Layer 2 Firewall, or the IPS engine.

Special handling might be required due to the complexity of the protocols, address information in the data
payload, related connections, or other consideration. Protocol elements also associate the traffic with a certain
protocol for inspection against the Inspection Policy.

Protocol Agents on Firewalls can:
• Validate application-level protocol use (for example, FTP command syntax).
• Open related connections when required (for example, FTP data connections).
• Modify application data when required (for example, NAT in H.323 data payload).
• Redirect FTP, HTTP, HTTPS, and SMTP connections to proxy services.

Protocol Agents on Layer 2 Firewalls and IPS engines can:
• Validate application-level protocol use (for example, FTP command syntax).
• Open related connections when required (for example, FTP data connections).

Some protocols require the use of the correct Protocol Agent to pass inspection by the Firewall, Layer 2 Firewall,
or the IPS engine when traffic is handled using stateful inspection.

Using Protocol Agents for connection handling
When related new connections are opened based on information exchanged in an initial connection, Protocol
Agents might be needed.

Protocol Agents are provided to handle the following protocols:
• FTP with related active and passive data connections.
• H.323 conferencing protocol communications.
• Microsoft RPC (MSRPC) for Microsoft Exchange and Outlook communications.
• NetBIOS for the Windows NetBIOS datagram services.
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• Oracle TNS protocol communications.
• Remote Shell protocol communications.
• Sun RPC Portmapper communications.
• TFTP file transfers.

File transfer protocol (FTP)
FTP uses two related connections: a control connection and a separately established data connection. If the
control connection is allowed without the Protocol Agent, the firewall does not recognize that the data connection
is part of an existing connection. The connection is handles as a new connection, which usually leads to the data
transfer failing.

Using Protocol Agents for protocol validation
Protocol Agents can be used to validate communications against standards of specific protocols. Exactly how this
works depends on the protocol in question.

Here are a few examples:
• The FTP Protocol Agent can be set to strictly limit the allowed commands within the control connection to

standard commands as listed in the FTP specifications. If other commands are sent in the control connection,
the connection is dropped.

• The Oracle Protocol Agent can control the size of the Oracle TNS packets, or the location of the Listener
service regarding the database services.

• The SSH Protocol Agent can ensure that the SSH handshake is performed at the beginning of an SSH
connection.

Using Protocol Agents for NAT in application
data
Protocol Agents on Firewalls can be used to assist with network address translation (NAT) in the application data.

For example, the H.323 conferencing protocol includes the source and destination address information in the
data payload of the packets. In ‘normal’ traffic, all IP address information relevant to the communications is in
reserved spaces in the packet headers.

The H323 Protocol Agent can examine the data payload and change the addresses according to the network
address translation as needed. Therefore, when the source address is included in the protocol data, the source
address is also translated in the data payload. The receiving system then responds to the proper address.
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Configuring Protocol Agents
Protocol Agents are represented in the Management Client by Protocol elements that have Protocol Agent as
their type. Other Protocol elements are of the type Protocol Tag.

 
Figure 151: Using Protocol Agents

You do not add Protocol Agent elements directly to policies. You select Protocol Agents in custom Service
elements that you create. The custom Service elements are used in Access rules. Whenever traffic matches
a rule that contains a Service element with an associated Protocol Agent, the Protocol Agent is automatically
activated.

All Protocol Agents are default elements, and you cannot change them or add any new ones. There are also
default Service elements for most supported protocols that you can use to activate the Protocol Agents. However,
some Protocol Agents have parameters and options you can set by creating customized Services.

Creating custom Service elements with
Protocol Agents
In addition to default Service elements that are associated with specific Protocol Agents, you can create custom
Services.

There are default Service elements that link to Protocol Agents. These default Services can be used directly in
the Access rules. However, the default Services do not allow you to change the default parameters of Protocol
Agents that have configurable parameters.

If you want to change the way a Protocol Agent behaves, create a custom Service and attach the correct Protocol
Agent to that Service. The Service element contains the identifying information, such as a port number, that
determines which traffic the Service matches. In most cases, the identifying information makes sure that the
Protocol Agent is not applied to the wrong type of traffic.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Protocol Agents on engines | 1008

Setting parameters for Protocol Agents
When you create a custom Service that uses a Protocol Agent with configurable parameters, you specify the
parameters in the properties of the Service.

Related concepts
Using Protocol Agents on page 1008

Inserting the Service with Protocol Agent in
Firewall Access rules
Whether you create a custom Service or use a predefined Services that have a Protocol Agent attached to them,
define the traffic in the Access rules in your policies.

A Protocol Agent can be set either on a rule-by-rule basis or you can create a rule with Continue as the
Action. When there is a Continue rule, rules further down in the rule table that match traffic (same source and
destination) use the Protocol Agent defined in the Continue rule.

With Protocol Agents, the Continue rule affects only rules where the Service cell is set to ANY. More specific
Service definitions override the Continue rule, as all Service elements specify that either some particular Protocol
Agent or no Protocol Agent is used.

Some protocols might require a Protocol Agent if the Connection Tracking option is enabled for the rule. Those
protocols might not be allowed by a rule that has ANY as its Service unless a Protocol Agent is configured using
a previous matching Continue rule. The Firewall Template Policy contains a Continue rule that sets a Protocol
Agent to be used with Services in the Service Group called Default Services with Agents.

Protocol Agents validate traffic against the specifics of a particular protocol, so make sure that a Service is not
applied to traffic that does not use that protocol. Also, Protocol Agents are designed for particular types of uses,
so they might not always be appropriate even if the protocol matches.

Using Protocol Agents
There are Protocol Agents for many different protocols.

Most of the available Protocol Agents have configurable parameters that they add to the Services that use them.

If there are no configurable parameters for a Protocol Agent, there are no options, but there can still be a control
for turning the Protocol Agent on or off in the Service.

FTP Protocol Agent
One of the most common ways to transfer files across networks is using FTP. An FTP session starts with a
control connection (by default, TCP port 21), and the data connection continues using a dynamically allocated
port.

The Protocol Agent tracks the actual ports used so that ports can be opened only as needed for specific
connections. This way, the whole range of possible dynamic ports does not need to be allowed in the policy.
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The FTP Protocol Agent inspects protocol validity. There are two selectable levels of inspection: loose (default)
and strict.
• In loose mode, the Protocol Agent tries to identify information for opening the data connection. Loose mode is

needed with some non-standard FTP applications.
• With strict mode, protocol integrity can be enforced. All connections with commands that do not comply with

the RFC 959 FTP standard are dropped.

The FTP Protocol Agent can change payload data, if necessary. The change can be required to handle NAT
correctly.

The FTP Protocol Agent can also redirect traffic to a proxy service.

This Protocol Agent has parameters you can set in the Service properties.

Related concepts
How redirecting traffic for inspection works on page 1059

GRE Protocol Agent
The Generic Routing Encapsulation (GRE) protocol is a tunneling protocol that allows the encapsulation of
network layer packets inside IP tunneling packets.

The GRE Protocol Agent provides protocol inspection for tunneled GRE traffic. This Protocol Agent specifies
rematching parameters for GRE-encapsulated packets, and defines which traffic is tunneled. This Protocol Agent
has parameters that you can set in the Service properties.

GTP Protocol Agent
The GTP Protocol Agent provides protocol inspection for GTP traffic.

The GPRS Tunneling Protocol (GTP) is used to carry GPRS (general packet radio service) packets in GSM,
UMTS, and LTE networks. There are no configurable parameters for this Protocol Agent.

H323 Protocol Agent
H.323 defines a set of protocols as well as the components and procedures for real-time multimedia
communication.

H.323 consists of a series of different types of standards related to video and audio services, real-time transport,
control channels, and security.

On Firewalls, this Protocol Agent has parameters you can set in the Service properties:
• H.323 can open several related connections, which places demands on access control and NAT. The H323

Protocol Agent’s task is to track the related connections that are opened within the same session. Particularly,
if you want the Firewall to apply NAT to H.323 connections, you must make sure that the connections use this
Protocol Agent.

• The H323 Protocol Agent examines Call Signaling Channel (Q.931/H.225.0) connections and allows the
related Control Channel (H.245) connection to open. It also examines the H.245 connection and allows further
related connections (RTP and RTCP) to open, based on the port negotiations on the parent connection.
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• When NAT is applied to Q.931 connections, the Protocol Agent performs the same NAT to the related H.245
connection and changes the payload data of the parent connection. The same NAT operation is performed
also on the opened RTP and RTCP connections.

There are no configurable parameters for this Protocol Agent on IPS engines or Layer 2 Firewalls.

HTTP Protocol Agent
The HTTP Protocol Agent can be used on Firewalls to redirect traffic to a proxy service, and in all engine roles to
log the URLs from HTTP requests.

This Protocol Agent has parameters that you can set in the Service properties.

HTTPS Protocol Agent
The HTTPS Protocol Agent can be used for identifying encrypted HTTPS traffic for decryption and inspection in
the Access rules, for identifying encrypted HTTPS traffic for inspection in the Inspection Policy, and for redirecting
connections to a proxy service.

This Protocol Agent has parameters that you can set in the Service properties.

IPv4 Encapsulation Protocol Agent
The IPv4 Encapsulation Protocol Agent provides protocol inspection for tunneled IPv4 traffic on IPS engines and
Layer 2 Firewalls.

This Protocol Agent specifies rematching parameters for IPv4 packets encapsulated in IPv6 packets. This
Protocol Agent has parameters that you can set in the Service properties. This Protocol Agent is not available on
Firewalls.

IPv6 Encapsulation Protocol Agent
The IPv6 Encapsulation Protocol Agent provides protocol inspection for tunneled IPv6 traffic on IPS engines and
Layer 2 Firewalls.

This Protocol Agent specifies rematching parameters for IPv6 packets encapsulated in IPv4 packets. This
Protocol Agent has parameters that you can set in the Service properties. This Protocol Agent is not available on
Firewalls.

MGCP Protocol Agent
The MGCP (Media Gateway Control Protocol) Protocol Agent provides support for related RTP (Real-time
Transport Protocol) connections in Voice over IP (VoIP) traffic.

There are no configurable parameters for this Protocol Agent.
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MSRPC Protocol Agent
The MSRPC (Microsoft RPC) Protocol Agent allows related connections for the endpoint mapper (EPM) protocol.
It also handles NAT modifications for communications between Microsoft Outlook clients and Microsoft Exchange
servers.

The MSRPC Protocol Agent supports TCP as the EPM connection method. By default, the Microsoft RPC/ EPM
service is available on port 135/tcp and the communications continue using a dynamically allocated port. The
Protocol Agent monitors the ports used to dynamically allow the connections based on the port allocation. This
removes the need to allow the full range of ports.

If the traffic is Outlook/Exchange traffic, the Protocol Agent can also be used to support NAT for related
connections by changing the payload data of the control connection.

On Firewalls, this Protocol Agent has parameters that you can set in the Service properties. On IPS engines and
Layer 2 Firewalls, there are no configurable parameters for this Protocol Agent.

NetBIOS Protocol Agent
This Protocol Agent provides deep inspection for Windows NetBIOS Datagram Service connections. This
Protocol Agent is also used to allow Windows NetBIOS Datagram Service connections through the Firewall or
Layer 2 Firewall.

There are no configurable parameters for this Protocol Agent.

Oracle Protocol Agent
This Protocol Agent handles Oracle Transparent Network Substrate (TNS) protocol-based SQL*Net, Net7, and
Net8 connections.

It is for cases where TCP port 1521 is used only for negotiating the port number for Oracle database connections
and the port number for the actual connection is assigned dynamically.

This Protocol Agent is needed only if the database is on a different computer than the Oracle listener. The Oracle
Protocol Agent does not change payload data because the database service connections might go through a
different route than the listener connection. You can create custom Oracle agents with different settings when
required.

RTSP Protocol Agent
The RTSP (Real Time Streaming Protocol) network control protocol is used for establishing and controlling media
sessions between clients and media servers.

The RTSP Protocol Agent allows RTP (Real-time Transport Protocol) and RTCP (Real-time Control Protocol)
media streaming connections initiated with RTSP through the engine. On Firewalls, it also handles NAT
modifications to the protocol payload. This Protocol Agent has parameters you can set in the Service properties.
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SCCP Protocol Agent
The SCCP (Skinny Call Control Protocol) provides support for related RTP (Real-time Transport Protocol)
connections in VoIP traffic.

There are no configurable parameters for this Protocol Agent.

Services in Firewall Protocol Agent
This Protocol Agent is intended for system services running on Firewalls. On Layer 2 Firewalls and IPS engines,
it is also used with services running on Firewalls managed by the same Management Server as the Layer 2
Firewall or IPS engine.

This Protocol Agent is only intended for the system’s internal use. There are no configurable parameters for this
Protocol Agent.

Shell Protocol Agent
This Protocol Agent manages Remote Shell connections and RExec connections.

Remote Shell is a widely used remote management protocol. RExec is a remote protocol with which it is possible
to run commands on another computer.

This Protocol Agent has parameters that you can set in the Service properties.

SIP Protocol Agent
The Session Initiation Protocol (SIP) Protocol Agent can be used with Firewalls to handle multimedia connections
that use SIP as their transfer protocol (such as VoIP).

Using the SIP Protocol Agent allows SIP to be used across a Firewall that uses NAT. SIP uses TCP or UDP port
5060 to initiate the connection, after which the traffic is allocated a dynamically assigned port. The Protocol Agent
tracks the actual ports used, so that the whole range of dynamic ports does not need to be allowed in the Firewall
Policy.

The SIP Protocol Agent can be configured to force the client or server address used within the SIP transport layer
to also be used for the media stream carried over SIP (by default, enforced for both the client and the server).

This Protocol Agent has parameters you can set in the Service properties. This Protocol Agent is not available on
IPS engines or Layer 2 Firewalls.

SMTP Protocol Agent
On Firewalls, the Simple Mail Transfer Protocol (SMTP) Protocol Agent can be used to redirect connections to a
proxy service. On Layer 2 Firewalls and IPS engines, the Protocol Agent can be used for protocol validation and
deep inspection.

On Firewalls, this Protocol Agent has parameters that you can set in the Service properties. On IPS engines and
Layer 2 Firewalls, there are no configurable parameters for this Protocol Agent.
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SSH Protocol Agent
Secure Shell (SSH) is an encrypted remote use protocol.

This Protocol Agent validates the communications to make sure the protocol used really is SSH. The SSH Agent
validates SSHv1 only. On Firewalls, this Protocol Agent has parameters you can set in the Service properties. On
IPS engines and Layer 2 Firewalls, there are no configurable parameters for this Protocol Agent.

SunRPC Protocol Agent
The Sun Remote Procedure Call (RPC) Protocol Agent assists the Firewall, Layer 2 Firewall, or IPS engine in
Portmapper connections. It makes the handling of RPC program numbers used in the Access rules faster.

Only Portmapper connections going through the engine are assigned this Protocol Agent. This Protocol Agent is
not intended for other communications.

The SunRPC Protocol Agent collects information about RPC services by interpreting the GET PORT and DUMP
PORTS requests and their respective answers. All information it collects is stored in the Portmapper cache.

When the packet filter evaluates RPC matches, it checks the Portmapper cache to see if the destination of the
packet has the appropriate service defined in the rule. If the cache does not have the requested information
available, the packet under evaluation is not let through. A query is sent to the destination host for RPC
information. The reply information is stored in cache.

There are no configurable parameters for this Protocol Agent.

TCP Proxy Protocol Agent
The TCP Proxy Protocol Agent is used for TCP connections that need to be closed after a certain amount of idle
time.

Certain TCP-based applications do not properly handle the closing of connections and leave them open for a
long time, unnecessarily consuming resources. For such situations, the TCP Proxy Agent can be used to actively
close the connections after a certain idle time. In addition, the TCP Proxy Agent might cancel a connection if the
closing of the connection does not complete in a specified time.

On Firewalls, the handling of idle connections defined by the TCP Proxy agent is different from other connection
handling on the Firewall, because without the Protocol Agent, idle connections are removed from the Firewall’s
records without sending any notices to the communicating parties (according to the general TCP timeout set in
the Firewall properties, or an overriding timeout set in the rule that allowed the connection).

On Firewalls, this agent has parameters you can set in the Service properties. On IPS engines and Layer 2
Firewalls, there are no configurable parameters for this Protocol Agent.

TFTP Protocol Agent
The Trivial File Transfer Protocol (TFTP) Protocol Agent performs data transfer from a server to a client using
dynamically selected ports.

There are no specific limits to the port range in the TFTP protocol (RFC 1350). Apart from Access rules, the TFTP
Protocol Agent is also useful in NAT operations on Firewalls.

A TFTP Agent is attached to a UDP connection established between the client and the server. The client opens
the control connection from a dynamically selected source port to the fixed destination port 69/UDP on the server.
A separate UDP data connection is established between the client and the server after the client has sent a
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read or write command to the server. The server opens a connection from a dynamic source port to the client’s
destination port. The destination port is the same as the source port in the control connection.

On Firewalls, this agent has parameters you can set in the Service properties. On IPS engines and Layer 2
Firewalls, there are no configurable parameters for this Protocol Agent.

Examples of Protocol Agents
These examples illustrate some common uses for Protocol Agents and the general steps on how each example
is configured.

Example: preventing active mode FTP with a
Protocol Agent
Company A has an FTP server that allows access from the Internet. The Firewall must only allow users to make
passive mode FTP connections.

The administrators:

1) Create a Service element for passive FTP.

2) Attach the FTP Protocol Agent to the Service.

3) Change the active mode FTP setting to No in the Service properties.

4) Create an Access rule that allows users to connect to the FTP server using their custom-made Service
element.

5) Refresh the policy on the IPS engine.

Example: logging URLs accessed by internal
users with a Protocol Agent
Company B has decided to track which webpages the employees visit. In addition to logging the connections, the
administrators also want to log URLs.

An Access rule allows all outbound connections from the internal networks to the Internet, regardless of the
service. The administrators decide to add the HTTP Protocol Agent in a Continue rule.

The administrators:

1) Add the Continue rule above the existing Access rule, as follows.

Source Destination Service Action

Internal Networks Expression “NOT
Local Protected
Sites”

“HTTP (with URL Logging)” default
Service

Continue
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Source Destination Service Action

Internal Networks Expression “NOT
Local Protected
Sites”

ANY Allow

Note:  Using the “NOT Local Protected Sites” expression requires the Alias “Local Protected
Sites” to be configured with a translation value for the engine.

2) Refresh the engine’s policy.
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• Sidewinder Proxies and how they work on page 1017
• Using Sidewinder Proxies on page 1021
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• Supported advanced Sidewinder Proxy settings on page 1032

Sidewinder Proxies are software modules that provide network level proxies, protocol validation, and configurable
application level protocol filtering and translation on Forcepoint Next Generation Firewall.

Sidewinder Proxies and how they work
On Sidewinder firewalls, proxies provide high assurance protocol validation. On Forcepoint NGFW, Sidewinder
Proxies are software modules on engines that enable some of the proxy features that are available on
Sidewinder.

Note:  Not all features supported by proxies on Sidewinder are supported by Sidewinder Proxies
on Forcepoint NGFW.

Sidewinder Proxies terminate connections at the firewall, and make separate connections with each of the
communicating hosts. Hosts do not communicate with each other directly. Each host communicates only with
the Sidewinder Proxy. The proxy does not forward the original packet from one host to the other. Only the data
from the original packets is forwarded. For TCP connections, the TCP sequence numbers, ACKs, packet sizes,
windows, and other parameters are different on the two sides of the connection.

On Forcepoint NGFW, Sidewinder Proxies are supported for both Firewalls and Virtual Firewalls.
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Benefits of Sidewinder Proxies
Sidewinder Proxies provide these benefits.

Table 116: Benefits of Sidewinder Proxies

Benefit Description

More extensive attack prevention Sidewinder Proxies can prevent most attacks that involve modifying IP,
TCP, or UDP headers to evade detection. These kinds of attacks cannot
always be detected using signature-based detection alone.

Covert channel prevention Sidewinder Proxies can prevent attempts to covertly send data in the
header bits of IP, TCP, or UDP packets.

More detailed control of application
protocols

Sidewinder Proxies provide more granular control of application protocols.
For example, you can use the SSM HTTP Proxy for detailed HTTP
header filtering and control.

Limitations of Sidewinder Proxies
These limitations apply to Sidewinder Proxies.

• Sidewinder Proxies are not supported with legacy role-specific licenses. An NGFW license is required.
• Only the Firewall/VPN role is supported.
• On Firewall Clusters, connection failover is not supported.
• Master NGFW Engines only support advanced Sidewinder Proxy settings for the Virtual Firewalls that they

host. Master NGFW Engines cannot use Sidewinder Proxies for their own traffic.
• Sidewinder Proxies can be used with both IPv4 and IPv6 traffic. However, they do not support translation

between IPv4 and IPv6, or tunneling of IPv4 or IPv6 traffic in an IPv6 or IPv4 connection.
• Sidewinder Proxies do not support multicast traffic.
• You cannot use McAfee Threat Intelligence Exchange (TIE) file reputation with Sidewinder Proxies. If the

File Filtering Policy uses these file reputation scans, they are ignored for traffic that uses Sidewinder Proxies.
When you restrict file types with file filtering, the action specified for the Action When No Scanners Are
Available option determines whether the file transfer is allowed or blocked if no other scanners are available.

Related tasks
Restrict file types with file filtering on page 978
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Sidewinder Proxy configuration overview
To use Sidewinder Proxy, you must enable the feature and add Access rules. You can optionally add other
elements to customize how Sidewinder Proxies work.

 
Figure 152: Elements in the configuration

1 SSH Profile

2 Sidewinder Logging Profile

3 Service with Proxy

4 Access Rules

5 NGFW Engine

6 SSH Known Host List

7 SSH Known Hosts

Follow these general steps to configure Sidewinder Proxies:

1) (Optional) To customize logging options for Sidewinder Proxies, create Sidewinder Logging Profiles.

2) Enable Sidewinder Proxy for the engine in the Engine Editor.

3) (Optional) Create elements and configure settings for specific Sidewinder Proxies.

a) Create SSH Profiles for Sidewinder SSH Proxy.

b) Create SSH Known Hosts for Sidewinder SSH Proxy and group SSH Known Hosts using SSH Known
Hosts Lists.

c) Configure settings for Sidewinder SSH Proxy in the Engine Editor.

4) (Optional) Create custom Service elements and configure Protocol Parameters for Sidewinder Proxies.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Sidewinder Proxies | 1020

Note:  There are no configurable Protocol Parameters for the Sidewinder TCP Proxy or the
Sidewinder UDP Proxy.

5) Add Service elements to Access rules to specify which traffic uses Sidewinder Proxies.

Default elements for Sidewinder Proxy
The SMC has default elements that you can use to configure Sidewinder Proxy.

You cannot edit the default elements, but you can duplicate the default elements and edit the duplicated
elements.

Table 117: Default elements for Sidewinder Proxy

Type of Element Element Description

 Configuration > NGFW > Other Elements > Protocols > By Protocol Type > Proxy

SSM HTTP Proxy Allows you to use Sidewinder HTTP Proxy in Service elements,
and provides Protocol Parameters for detailed control of the HTTP
and HTTPS protocols.

This Protocol element is automatically selected in the properties of
the default SSM HTTP and SSM HTTP with TLS Enforced Service
elements.

SSM SSH Proxy Allows you to use Sidewinder SSH Proxy in Service elements,
and provides Protocol Parameters for detailed control of the SSH
protocol.

This Protocol element is automatically selected in the properties of
the default SSM SSH Service element.

SSM TCP Proxy Allows you to use Sidewinder TCP Proxy in Service elements.

Note:  This Protocol element has no configurable
Protocol Parameters.

Protocol

SSM UDP Proxy Allows you to use Sidewinder UDP Proxy in Service elements.

Note:  This Protocol element has no configurable
Protocol Parameters.
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Type of Element Element Description

[Protocol] with
[Proxy Protocol]

These Protocol elements combine a standard Protocol element
with a Sidewinder Proxy Protocol element. Combined Protocol
elements make the Protocol Parameters from both Protocol
elements available in the same Service element.

Note:  There are no default Service elements that
use the combined Protocol elements. You must
create custom Service elements to use these
Protocol elements.

 Configuration > NGFW > Other Elements > Services > With Proxy

SSM HTTP Allows you to use HTTP and HTTPS traffic with Sidewinder Proxy.
This Service element has the following default settings:
• Dst. Ports — 80
• Protocol — SSM HTTP Proxy

SSM HTTP with TLS
Enforced

Allows you to use HTTPS traffic with Sidewinder Proxy. This
Service element has the following default settings:
• Dst. Ports — 443
• Protocol — SSM HTTP Proxy

Service

SSM SSH Allows you to use SSH traffic with Sidewinder Proxy. This Service
element has the following default settings:
• Dst. Ports — 22
• Protocol — SSM SSH Proxy

Sidewinder Logging
Profile

Sidewinder Default Contains default settings that define which events detected by
Sidewinder Proxies are logged, and how often logs are created.

SSH Profile High Compatibility
Profile

Contains default settings for key exchange, encryption algorithm,
and message authentication that are compatible with a variety of
SSH server software.

SSH Host Keys ECDSA 256, DSA
1024, and RSA 1024

When you enable Sidewinder Proxy in the Engine Editor, these
SSH Host Keys are automatically created for the engine.

Using Sidewinder Proxies
You can use Sidewinder Proxies on Forcepoint NGFW to enforce protocol validation and to restrict the allowed
parameters for each protocol.

Sidewinder Proxies are primarily intended for users in high assurance environments, such as government or
financial institutions. In environments that limit access to external networks or access between networks with
different security requirements, you can use Sidewinder Proxies for data loss protection.
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Sidewinder HTTP Proxy
You can use the Sidewinder HTTP Proxy with HTTP and HTTPS traffic to enforce strict protocol standards, log
URLs in requests, validate requests, and block some types of content in requests.

You can use the Sidewinder HTTP Proxy with or without decryption.

• When decryption is enabled, the NGFW Engine decrypts HTTPS traffic, then applies the Sidewinder HTTP
Proxy and optionally inspection to the encapsulated HTML. After inspection, the NGFW Engine re-encrypts
the HTTPS traffic.

• When decryption is not enabled, the Sidewinder HTTP Proxy only validates HTTPS traffic to make sure that
the traffic contains valid HTTPS protocol messages.

Using the Sidewinder HTTP Proxy with decryption for HTTPS traffic provides the following benefits compared to
the standard TLS inspection feature:

• The Sidewinder HTTP Proxy can remove TCP options from HTTPS traffic.
• The Sidewinder HTTP Proxy can present a configurable warning page to inform users that their traffic is being

decrypted.

Decrypting and re-encrypting HTTPS traffic requires the following configurations:

• You must have a Client Protection CA and other elements required for TLS inspection. To avoid certificate-
related warnings in end users’ web browsers, the client protection CA certificate must be imported as a trusted
certificate in the browsers.

Note:  The Sidewinder HTTP Proxy only provides client protection. The Sidewinder HTTP
Proxy does not provide server protection for servers in the internal network. The Sidewinder
HTTP Proxy is not compatible with servers that use client certificates for authentication.

• You must configure an external DNS resolver, and select one or more DNS IP addresses in the Engine Editor.
The DNS resolver must be functioning and available to provide DNS results to the engine.

• To allow the certificate manager to communicate with an external certificate revocation list (CRL) server, you
must add an Access rule that allows HTTP traffic on port 80 between the firewall and the Internet for making
online certificate status protocol (OCSP) queries and fetching CRLs.

The Decryption option in the Allow Action Options in Access rules defines whether traffic that matches the rule is
decrypted. To exclude specific traffic from decryption by the SSM HTTP Proxy, add the following type of Access
rule:

Source Destination Service Action

Source IP address Destination IP address One or more of the following
Service elements:
• SSM HTTP with TLS Enforced
• A custom Service element that

uses the SSM HTTP Proxy
Protocol

Allow
Decryption: Disallowed

Related tasks
Configure TLS inspection for client protection on page 1044
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Sidewinder SSH Proxy
The Sidewinder SSH Proxy allows you to restrict the types of traffic and the commands that can be used with
SSH connections.

For example, you can use the Sidewinder SSH Proxy to block port forwarding or to restrict the commands
allowed in file transfers using the SSH protocol.

You can also use the Sidewinder SSH Proxy to enforce encryption strength for the connections. In the Protocol
Parameters, you can separately specify the key type and key length for each side of the connection. The Client
Advanced Settings define settings for connections between the Sidewinder SSH Proxy and the client. The
Server Advanced Settings define settings for connections between the Sidewinder SSH Proxy and the server.

Sidewinder TCP Proxy and Sidewinder UDP
Proxy
Sidewinder TCP Proxy and Sidewinder UDP Proxy provide protocol validation for TCP and UDP traffic.

There are no default Service elements for Sidewinder TCP and Sidewinder UDP Proxy. If you want to apply
the Sidewinder TCP Proxy or the Sidewinder UDP Proxy to TCP or UDP services, you must create custom
Service elements. There are no configurable Protocol Parameters for the SSM TCP Proxy or the SSM UDP
Proxy Protocol elements.

Using Sidewinder Proxies in combined
Protocol elements
Combined Protocol elements allow you to apply a standard Protocol element and a Sidewinder Proxy Protocol
element to the same traffic.

Combined Protocol elements make the Protocol Parameters from both Protocol elements available in the same
Service element.

Note:  There are no default Service elements that use the combined Protocol elements. You must
create custom Service elements to use these Protocol elements.

Combined Protocol elements have the following benefits:

• Sidewinder Proxy Protocol elements provide improved security compared to using non-proxy Protocol
elements alone.

• Protocol elements provide protocol-specific inspection and protocol validation that is not possible using
Sidewinder Proxy Protocol elements alone.

Combined Protocol elements appear under the  Configuration > NGFW > Other Elements > Protocols > By
Protocol Type > Proxy branch in the Configuration view.
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Change logging options for Sidewinder
Proxies

Sidewinder Logging Profiles define which events detected by Sidewinder Proxies create log entries, and how
often log entries are created.

If the settings in the default Sidewinder Logging Profile element meet your needs, there is no need to create a
custom Sidewinder Logging Profile element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Sidewinder Elements > Sidewinder Logging Profiles.

3) Right-click Sidewinder Logging Profiles, then select New Sidewinder Logging Profile.

4) In the Name field, enter a unique name.

5) Select logging options for Situation Categories or individual Situations.

6) Click OK.

Enable Sidewinder Proxy
To start using Sidewinder Proxy, you must enable the feature in the Engine Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click a Single Firewall or Firewall Cluster and select Edit <element type>.

3) In the navigation pane on the left, browse to Add-Ons > Sidewinder Proxy.

4) Select Enable.

5) (Optional) Select a customized Sidewinder Logging Profile.

a) Next to the Sidewinder Logging Profile field, click Select.

b) Select a Sidewinder Logging Profile element, then click Select.

6) Click  Save.
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Configure Sidewinder SSH Proxy
Follow these general steps to configure Sidewinder SSH Proxy.

1) (Optional) To define custom settings for key exchange, encryption algorithm, and message authentication,
create an SSH Profile element.

2) (Optional) Allow connections only to specific trusted servers.

a) Create SSH Known Host elements.

b) Group the SSH Known Hosts using SSH Known Hosts Lists.

c) Select SSH Known Hosts Lists in the Engine Editor.

3) (Optional) Add host keys for Sidewinder SSH Proxy in the Engine Editor.

4) Add custom Service elements for Sidewinder SSH Proxy.

Create SSH Profiles for Sidewinder SSH Proxy
SSH Profiles define custom settings for key exchange, encryption algorithm, and message authentication for SSH
connections that use the Sidewinder SSH Proxy.

If the default High Compatibility Profile SSH Profile element meets your needs, it is not necessary to create a
custom SSH Profile.

The lists of selected key exchange methods, cipher methods, and message authentication code (MAC) methods
are organized in order of preference. You can move selected items up or down in the list.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Sidewinder Elements > SSH Profiles.

3) Right-click SSH Profiles, then select New SSH Profile.

4) In the Name field, enter a unique name.

5) On the Key Exchange tab, select one or more key exchange methods, then click Add.

6) On the Cipher tab, select one or more cipher methods, then click Add.

7) On the MAC tab, select one or more MAC methods, then click Add.

8) Click OK.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Sidewinder Proxies | 1026

Next steps

If you want to allow connections only to specific trusted servers, create SSH Known Hosts.
Otherwise, select your custom SSH Profile in the Engine Editor.

Create SSH Known Hosts for Sidewinder SSH
Proxy
SSH Known Host elements contain the contact information, public key, and fingerprint that you use to
authenticate servers that you trust.

Tip:  The Sidewinder SSH Proxy logs the SSH server key for each connection attempt. You can
optionally add SSH Known Hosts from log entries using the right-click menu.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Sidewinder Elements > SSH Known Hosts > SSH Known Hosts.

3) Right-click SSH Known Hosts, then select New SSH Known Host.

4) In the Name field, specify the name of the element in one of these ways:
• Enter the domain name of the server.
• Enter a unique name for the server.

5) Enter one or more IP addresses.

Note:  You can enter both an IPv4 address and an IPv6 address. You can only enter one
address of each type.

• In the IPv4 Address field, enter the IPv4 address of the server.

Tip:  To automatically resolve the IP address from the domain name, enter the domain
name, then click Resolve.

• In the IPv6 Address field, enter the IPv6 address of the server.

6) If the server communicates on a port other than the default port (TCP 22), enter the port number in the
Port field.

7) To manually enter the SSH key for the server, enter the key as text.

a) From the Key Type drop-down list, select the algorithm used for the key.

b) In the SSH Key field, type or paste the key.
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8) To use an existing key file as the SSH key for the server, import the key file.

a) Click Import.

b) Select the key file, then click Open.

9) To retrieve a public key from a host, follow these steps.

a) From the Key Type drop-down list, select the algorithm used for the key.

b) Click Retrieve.

c) Select a firewall, then click Select.

The firewall sends a public key request to the host, and retrieves the SSH key and fingerprint.

10) Click OK.

Next steps

Group SSH Known Host elements using SSH Known Hosts Lists.

Group SSH Known Hosts in SSH Known Hosts
Lists
To allow connections only to specific trusted servers, group SSH Known Hosts in SSH Known Hosts Lists.

You select SSH Known Hosts Lists for each NGFW Engine in the Engine Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Sidewinder Elements > SSH Known Hosts > SSH Known Hosts Lists.

3) Right-click SSH Known Hosts Lists, then select New SSH Known Hosts List.

4) In the Name field, enter a unique name.

5) Click Add, select one or more SSH Known Host elements, then click Select.

6) Click OK.

Next steps

Select SSH Known Hosts Lists for engines
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Select SSH Known Hosts Lists for engines
To allow connections only to specific trusted servers, select SSH Known Hosts Lists in the Engine Editor.

Note:  When Use Strict Known Hosts List is selected for the Server Host Key Validation
option in the properties of the custom Service element for SSM SSH Proxy, you must select SSH
Known Hosts Lists for the engine. If you do not select an SSH Known Hosts List, connections are
not allowed to any hosts.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click a Single Firewall or Firewall Cluster and select Edit <element type>.

3) In the navigation pane on the left, browse to Add-Ons > Sidewinder Proxy.

4) Next to the SSH Known Hosts Lists table, click Add.

5) Select one or more SSH Known Hosts List elements, then click Select.

6) Click  Save.

Next steps

If the default SSH host keys do not meet your needs, or if you want to specify which host keys are used for
specific SSH Proxy Services, add host keys for Sidewinder SSH Proxy.
Otherwise, add custom Service elements for Sidewinder SSH Proxy.

Add host keys for Sidewinder SSH Proxy
In the Engine Editor, you can add host keys for Sidewinder SSH Proxy and specify which host keys are used for
specific SSH Proxy Services.

When you enable Sidewinder proxy in the Engine Editor, 3 default SSH Host Keys are automatically created
for the engine. You can optionally replace the automatically created host keys and create more host keys. You
can import existing host keys or generate host keys. You can also associate host keys with specific SSH Proxy
Services. Each engine on which you use the SSH Proxy Service must have one host key of each type.

Note:  You can only associate one key of each key type with the same Service. This limitation
includes the default Proxy Service that is used if you do not select a specific Service.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click a Single Firewall or Firewall Cluster and select Edit <element type>.
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3) In the navigation pane on the left, browse to Add-Ons > Sidewinder Proxy.

4) (Optional) Generate host keys.

a) Next to the Host Keys table, click Add.

b) From the Host Key Type drop-down list, select the algorithm to use for the key.

c) From the Host Key Length drop-down list, select the length of the key.

d) Click Add.

5) (Optional) Import existing host keys.

a) Next to the Host Keys table, click Import.

b) Select the key file, then click Import.

6) Specify which host keys are used for specific SSH Proxy Services.

a) In the Host Keys table, double-click the SSH Proxy Services cell.

b) From the Resources list, select one or more Service elements, then click Add.

c) Click OK.

7) Click  Save.

Next steps

Add custom Service elements for Sidewinder SSH Proxy.

Create custom Service elements for
Sidewinder Proxies

If the default Service elements for Sidewinder Proxies do not meet your needs, add custom Service elements for
Sidewinder Proxies.

Add a custom Service element in the following cases:

• You want to change the Protocol Parameters of the default Service elements for Sidewinder Proxies.
• You want to use combined Protocol elements.
• You want to apply the Sidewinder TCP Proxy or the Sidewinder UDP Proxy to TCP or UDP services.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.
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2) Browse to Other Elements > Services.

3) Create the Service element in one of the following ways:
• To create an element with no settings predefined, right-click the branch for the type of Service you want to

create, then select  New > TCP Service or  New > UDP Service.
• To create a Service based on an existing TCP or UDP Service element, right-click the existing Service,

then select New > Duplicate.
• To create a Service based on one of the default Service elements for Sidewinder Proxies, browse to With

Proxy, right-click the existing Service, then select New > Duplicate.

4) In the Name field, enter a unique name.

5) If you did not duplicate one of the default Service elements for Sidewinder Proxies, click Select next to
the Protocol field, browse to TCP Proxy or UDP Proxy, then select an SSM Proxy Protocol element or a
combined Protocol element.

6) On the Protocol Parameters tab, select options according to your needs.

Note:  There are no configurable Protocol Parameters for the Sidewinder TCP Proxy or the
Sidewinder UDP Proxy.

7) Click OK.

Next steps

Use the custom Service element in the Access rules.

Add rules for Sidewinder Proxy
Use one of the default Service elements for Sidewinder Proxy or a custom Service element in the Access rules to
specify which traffic uses Sidewinder Proxies.

In some cases, connections might not use the Sidewinder Proxy.

• If the policy contains rules that match traffic based on the payload, such as Applications or category-based
web filtering, connections might not match rules that specify an Sidewinder Proxy.
To avoid this limitation, do not add rules that match traffic based on the payload to the same policy where you
use SSM Proxies.

• If you use a rule with the Continue action to specify a Sidewinder Proxy as a default Protocol, rules later in the
policy can override the defaults set in Continue rules.
To avoid this limitation, do not add rules that specify a Protocol of the type Protocol Agent or Protocol Tag for
the same matching criteria as the Continue rules for SSM Proxies.

Because many websites use a combination of HTTP and HTTPS, users might not be able to connect to these
websites if you add only one rule that applies the Sidewinder HTTP Proxy to HTTPS traffic. We recommend that
you add a separate rule that allows unencrypted HTTP traffic or allow HTTP traffic in the same rule that applies
the Sidewinder HTTP Proxy to HTTPS traffic.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) To specify which traffic uses Sidewinder Proxies, add the following type of Access rules to the Firewall
Policy:

Table 118: Access rules for Sidewinder Proxy

Source Destination Service Action

The elements that
represent hosts
in the internal
network, or ANY.

The elements that
represent external
servers, or ANY.

One or more custom Service elements, or
one or more default Service elements for
Sidewinder Proxy.

Allow or Continue

2) Save and install the policy to start using the new configuration.

Advanced settings for Sidewinder
Proxies

Advanced Sidewinder Proxy settings enable optional behavior or set parameters.

Each setting has a name and a value. Some settings are specific to individual proxies. Most settings can be used
with any proxy, or for all proxies if you set them using shared proxy properties. If you do not specify a value, the
default values are used.

Note:  Changing the advanced settings requires detailed knowledge of the protocols involved
and how the parameters affect your environment. We do not recommend changing the advanced
settings unless you are instructed to do so by Forcepoint support.

In an environment with Master NGFW Engines and Virtual Firewalls, some advanced settings apply only to
Master NGFW Engines, and some advanced settings apply only to Virtual Firewalls. Settings that do not apply
to the type of engine on which they are configured are ignored. For example, if you configure a Master NGFW
Engine advanced setting for a Virtual Firewall, the setting has no effect on the Virtual Firewall.

Advanced settings that you configure for a Virtual Firewall affect only the individual Virtual Firewall. Advanced
settings that you configure for a Master NGFW Engine affect all Virtual Firewalls that are hosted by the Master
NGFW Engine.

https://support.forcepoint.com
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Supported advanced Sidewinder Proxy
settings

This table lists the most commonly used advanced settings for Sidewinder Proxies.

Note:  All advanced Sidewinder Proxy settings can be configured for Firewalls. Some settings can
be configured for Master NGFW Engines or for Virtual Firewalls. Settings that do not apply to the
type of engine on which they are configured are ignored.

Table 119: Supported advanced Sidewinder Proxy settings

Property Supported
proxy types

Accepted
values

Default value Supported
engine types

Description

allow_client_half_close HTTP 0 or 1 1 Firewall If 1, allows clients to receive
data after indicating that they
will send no more.

debug_level HTTP

SSH

TCP

UDP

0–4 0 Firewall,
Master NGFW
Engine

If any value other than 0,
enables debugging messages.
Higher values produce
more output. See also
send_debug_to_log.

display_user_warning_ttl HTTP Numerical
values in
seconds

43200 Firewall The default time an entry stays
in the decryption warning page
cache.

display_user_warning_dest HTTP 0 or 1 0 Firewall If 1, the decryption warning
page is displayed for each
unique combination of source
and destination address.
If 0, the decryption warning
page is displayed for each
unique source address.

enable_certificate_revocation_
check

HTTP 0 or 1 1 Firewall If 1, the HTTP proxy validates
the status of server certificates
using certificate revocation
lists (CRLs) or on-line
certificate status protocol
(OCSP).

encoded_url_max HTTP Numerical
values in
kilobytes

100000 (100
megabytes)

Firewall,
Master NGFW
Engine

Maximum size of an encoded
URL that can be decoded in
normalization. Normalization
can make up to 6 copies of a
URL.

header_waiting HTTP 0–100 25 Firewall,
Master NGFW
Engine

Limit for the percentage of
proxy sessions waiting for
additional HTTP header
information. If this limit is
reached, half of the waiting
sessions are discarded.
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Property Supported
proxy types

Accepted
values

Default value Supported
engine types

Description

max_header_total_size HTTP Numerical
values

65536 Firewall Maximum size of all HTTP
header data (not just individual
lines).

net.inet.ip.random_id HTTP

SSH

TCP

UDP

0 or 1 0 Firewall If 1, assigns random ip_id
values to outgoing IPv4
packets. The default behavior
is to assign a random initial
value for each proxy instance,
and increment for each
outgoing packet.

net.inet.ip.ttl HTTP

SSH

TCP

UDP

Numerical
values in the
number of
hops

64 Firewall The maximum time to live
(TTL) in hops for IPv4 packets
that are sent.

net.inet.tcp.always_keepalive HTTP

SSH

TCP

0 or 1 1 Firewall If 1, enables use of TCP
keepalive probes on all
connections.

net.inet.tcp.drop_synfin HTTP

SSH

TCP

0 or 1 1 Firewall If 1, drops TCP packets that
have SYN+FIN set.

net.inet.tcp.keepidle HTTP

SSH

TCP

Numerical
values in
milliseconds

7200000 (2
hours)

Firewall Time, in milliseconds, that the
connection must be idle before
keepalive probes are sent.

net.inet.tcp.keepinit HTTP

SSH

TCP

Numerical
values in
milliseconds

75000 (75
seconds)

Firewall Time allowed to establish
connection.

net.inet.tcp.keepintvl HTTP

SSH

TCP

Numerical
values in
milliseconds

75000 (75
seconds)

Firewall Time between keepalive
probes.

net.inet.tcp.msl HTTP

SSH

TCP

Numerical
values in
milliseconds

15000 (15
seconds, TCP
TIME_WAIT
time 30
seconds)

Firewall Maximum segment lifetime.
The default TCP TIME_WAIT
time is double this value.

net.inet.tcp.recvbuf_auto HTTP

SSH

TCP

0 or 1 1 Firewall If 1, enables automatic receive
buffer sizing.
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Property Supported
proxy types

Accepted
values

Default value Supported
engine types

Description

net.inet.tcp.recvbuf_inc HTTP

SSH

TCP

Numerical
values in
bytes

16K Firewall Incrementor step size of
automatic receive buffer.
Use the following suffixes to
specify larger values:

• K — Kilobytes

• M — Megabytes

• G — Gigabytes

net.inet.tcp.recvbuf_max HTTP

SSH

TCP

Numerical
values in
bytes

96K Firewall Maximum size of automatic
receive buffer.
Use the following suffixes to
specify larger values:

• K — Kilobytes

• M — Megabytes

• G — Gigabytes

net.inet.tcp.recvspace HTTP

SSH

TCP

Numerical
values in
bytes

64K Firewall Size of the initial TCP receive
window.
Use the following suffixes to
specify larger values:

• K — Kilobytes

• M — Megabytes

• G — Gigabytes

net.inet.tcp.rfc1323 HTTP

SSH

TCP

0 or 1 1 Firewall If 1, enables the TCP
timestamp option and window
scaling option specified in RFC
1323, which allows per-packet
timestamps, protection against
wrapped sequences, and
windows larger than 65535
bytes.

net.inet.tcp.sendbuf_auto HTTP

SSH

TCP

0 or 1 1 Firewall If 1, enables automatic send
buffer sizing.

net.inet.tcp.sendbuf_inc HTTP

SSH

TCP

Numerical
values in
bytes

8K Firewall Incrementor step size of
automatic send buffer.
Use the following suffixes to
specify larger values:

• K — Kilobytes

• M — Megabytes

• G — Gigabytes

net.inet.tcp.sendspace HTTP

SSH

TCP

Numerical
values in
bytes

32K Firewall Size of the initial TCP send
window.
Use the following suffixes to
specify larger values:

• K — Kilobytes

• M — Megabytes

• G — Gigabytes
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Property Supported
proxy types

Accepted
values

Default value Supported
engine types

Description

net.inet.udp.checksum UDP 0 or 1 1 Firewall If 1, requires checksums on
incoming UDP packets.

net.inet6.ip6.hlim HTTP

SSH

TCP

UDP

Numerical
values

64 Firewall,
Virtual
Firewall

The hop limit for IPv6 packets
that are sent.

reserved_allowed SSH 0 or 1 1 Firewall If 1, allows messages in the
reserved range.

send_debug_to_log HTTP

SSH

TCP

UDP

0 or 1 1 Firewall,
Master NGFW
Engine

If 1, debugging messages are
sent to the Log Server. If 0,
messages are written to a file.

Note:  Change
this value only if
instructed to do
so by Forcepoint
support.

server_requests_allowed SSH 0 or 1 1 Firewall If 1, allows global requests
from the server.

server_channels_allowed SSH 0 or 1 1 Firewall If 1, allows the server to open
channels.

sftp_extensions_allowed SSH 0 or 1 1 Firewall If 1, allows local SFTP
extension commands.

ssh_extensions_allowed SSH 0 or 1 1 Firewall If 1, allows local SSH
extension messages.

tls_cipher_override HTTP A single valid
OpenSSL
cipher string

ALL:-SEED:
-RC4: -
CAMELLIA: -
PSK: -MD5:
-SRP:-DES:
-ADH: -
AECDH: -
kDH: -kECDH:
-IDEA@
STRENGTH

Firewall The list of cipher algorithms
that the HTTP Proxy
negotiates with its peers. The
default cipher list includes
only cipher algorithms that are
allowed in FIPS mode.
Minus signs (-) exclude the
specified ciphers from the ALL
list.

Tip:  You can
use this setting to
restrict the default
cipher list or to
add more cipher
algorithms.

tls_curves_override HTTP A colon-
separated list
of OpenSSL
elliptic curve
names

P-521:P-384:
P-256

Firewall The list of the elliptic curves
supported by the HTTP Proxy.
The default list includes only
elliptic curves that are allowed
in FIPS mode.

https://support.forcepoint.com
https://support.forcepoint.com
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Property Supported
proxy types

Accepted
values

Default value Supported
engine types

Description

tls_key_curve_override HTTP A single
OpenSSL
elliptic curve
name

P-521 Firewall The default curve that the
HTTP Proxy uses to generate
the elliptic curve private key for
substitute certificates.

tls_protocol_override HTTP A colon-
separated list
of TLS version
strings. Valid
version strings
are SSLv3,
TLSv1.0,
TLSv1.1, and
TLSv1.2.

TLSv1.0:
TLSv1.1:
TLSv1.2

Firewall The TLS protocol versions
supported by the HTTP Proxy.
The default list includes only
TLS protocol versions that are
allowed in FIPS mode.

Tip:  You can
use this setting to
restrict the default
list or to add TLS
versions, such as
SSLv3, that are
not included in the
default list.

undefined_allowed SSH 0 or 1 1 Firewall If 1, allows messages for
which the proxy does not have
a protocol handler.
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The TLS inspection feature decrypts TLS connections so that they can be inspected for malicious traffic and then re-
encrypts the traffic before sending it to its destination.

TLS inspection and how it works
TLS Inspection allows you to decrypt TLS traffic so that it can be inspected.

The TLS protocol allows applications to communicate across a network in a way designed to ensure the
confidentiality and integrity of the communications. HTTPS uses the TLS protocol to secure HTTP connections.
When a browser connects to a server that uses HTTPS, the server sends a certificate to the browser. The
certificate contains the server's public key and a digital signature from a certificate authority that verifies the
server's identity. The browser and the server negotiate an encryption algorithm, which is used to create the
encrypted connection.

The TLS Inspection feature consists of server protection and client protection. Server protection inspects
incoming connections to servers in the protected network. Client protection inspects TLS outgoing connections
initiated by clients in the protected network. TLS Inspection requires two separate secure connections: one
from the client to the firewall and one from the firewall to the server. You can use client protection alone, server
protection alone, or client and server protection together.

When a server in the internal network is the destination of an incoming TLS connection, the engine uses the
server's credentials to decrypt and re-encrypt the traffic.

When a client in the internal network initiates a TLS connection to an external server, the firewall checks whether
the server’s certificate was signed by a certificate authority that is considered trusted. If the certificate was signed
by a trusted certificate authority, the engine makes a new certificate that matches the server's certificate. From
the point of view of a user in the internal network, the process is invisible: the connection is established in the
same way as a TLS connection made directly to the server.

When a server’s certificate is self-signed or has not been signed by a trusted certificate authority, the engine
cannot trust the server certificate. In this case, the engine makes a new self-signed certificate. This certificate is
presented to the user in the internal network. The user’s browser shows the same warning that it would show if it
received a self-signed certificate directly from a server. In this case, the user must decide whether to accept the
certificate.
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In both cases, the engine adds a Netscape Certificate Comment to the Extensions in the certificate to indicate
that the certificate is a dynamically created certificate for SSL/TLS deep inspection. Substituting the original
server certificate allows the firewall to decrypt and re-encrypt the traffic.

After decrypting the traffic, normal HTTP inspection and optionally malware scanning are applied. If the traffic is
allowed to continue, it is re-encrypted before it is forwarded.

Limitations
TLS inspection has the following limitations:
• TLS inspection for client protection cannot be done for traffic picked up through Capture interfaces.
• TLS inspection for server protection can be done for traffic picked up through both Capture interfaces and

Inline interfaces.

Note:  Due to security features of the TLS protocol, TLS decryption for traffic picked up through
Capture interfaces can only be done when RSA key exchange negotiation is used between the
client and the server.

• TLS inspection is not supported on Single IPS engines or on Single Layer 2 Firewalls if the engines are
deployed alongside a Firewall Cluster that uses dispatch clustering.

• Default Trusted Certificate Authority elements are automatically added to the SMC from dynamic update
packages and cannot be edited or deleted.

• TLS inspection is not supported on Master NGFW Engines.

What do I need to know before I begin?
Consider these things before configuring TLS inspection:
• Traffic that uses TLS might be protected by laws related to the privacy of communications. Decrypting and

inspecting this traffic might be illegal in some jurisdictions.
• The TLS communications mediated by the engine are decrypted for inspection, and the private keys of the

servers are stored unencrypted in the TLS Credentials elements on the Management Server and on the
engine. For these reasons, you must carefully consider security precautions when using TLS inspection. The
following recommendations are general guidelines for ensuring the security of the engine and the SMC:
• Run the Management Server on a hardened operating system.
• Disable SSH access to the engine’s command line.
• Make sure that the engine’s Control IP address is in a protected network.
• Save Management Server backups as encrypted files.

• When a certificate for client or server protection has been uploaded to the engine, it is possible to
unintentionally enable TLS decryption for all traffic in one of the following ways:
• Adding a Network Application that allows or requires the use of TLS to an Access rule
• Enabling the logging of Application information in the Access rules
• Enabling Deep Inspection in an Access rule with the Service cell of the rule set to ANY

• Strict TCP inspection mode is automatically applied to TCP connections when TLS Inspection is used.

Related concepts
How redirecting traffic for inspection works on page 1059
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TLS inspection configuration overview
To use TLS inspection, you must configure TLS Credentials elements and Client Protection Certificate Authority
elements. You must also activate client protection or server protection in the engine properties and enable TLS
inspection in the Access rules.

 
Figure 153: Elements in the configuration

The TLS Credentials and the Client Protection Certificate Authority are specified in the properties of the engine
that provides TLS Inspection. The engine uses the private key and certificate stored in the TLS Credentials to
decrypt traffic to and from TLS servers in the protected network for inspection.

The Client Protection Certificate Authority contains a private key and a certificate. The engine uses the private
key stored in the Client Protection Certificate Authority to sign the certificates presented to the end user, and the
certificate to negotiate encrypted connections with TLS servers.

TLS Match elements define matching criteria for the use of the TLS protocol in traffic, and allow you to prevent
specified traffic from being decrypted. TLS Matches that deny decrypting are applied globally, even if the TLS
Match elements are not used in the policy.

The HTTPS Inspection Exceptions element is a list of domains that are excluded from decryption and inspection.
The HTTPS Inspection Exceptions can be specified in the Protocol Parameters of a custom HTTPS Service,
which is used in the Access rules to select HTTPS traffic for inspection.

The Access rules define which traffic is decrypted and inspected. You can select specific traffic for decryption and
inspection, or you can enable the decryption and inspection of all TLS traffic.

When a certificate for client or server protection has been uploaded to the engine, it is possible to unintentionally
enable TLS decryption for all traffic in one of the following ways:
• Adding a Network Application that allows or requires the use of TLS to an Access rule
• Enabling the logging of Application information in the Access rules
• Enabling Deep Inspection in an Access rule with the Service cell of the rule set to ANY

TLS inspection configuration overview:

1) To configure server protection, create TLS Credentials elements.

2) To configure client protection, create Client Protection Certificate Authority elements.

3) (Optional) Define custom Trusted Certificate Authority elements in addition to the default system elements.
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4) (Optional) To exclude certain domains from decryption and inspection, define a TLS Match element or an
HTTPS Inspection Exceptions element.

5) Activate client protection or server protection in the properties of the engine and enable TLS inspection in the
Access rules.

Related concepts
Exclude traffic from decryption for TLS inspection on page 1049
Activating TLS inspection on page 1052

Related tasks
Configure TLS inspection for server protection on page 1042
Configure TLS inspection for client protection on page 1044
Define trusted certificate authorities for TLS inspection on page 1047

Default TLS inspection elements
The SMC has default elements that can be used for TLS inspection. The default elements cannot be edited, but
can be duplicated and then edited.

• The Default HTTPS Inspection Exceptions element is an HTTPS Inspection Exceptions element that excludes
domains used by the SMC and the engines from decryption and inspection. You cannot edit the Default
HTTPS Inspection Exceptions element. If you have to make changes, you can duplicate the Default HTTPS
Inspection Exceptions element and edit the copy.

• The default HTTPS (with decryption) Service element enables the decryption of HTTPS traffic that uses the
default port 443, excluding the domains that are specified in the Default HTTPS Inspection Exceptions. You
cannot edit the default HTTPS (with decryption) Service element. If you have to make changes, you can
duplicate the HTTPS (with decryption) Service element and edit the copy.

• There are predefined Trusted Certificate Authority elements that represent the signing certificates of major
certificate authorities. Default Trusted Certificate Authority elements are automatically added from dynamic
update packages and cannot be edited or deleted. When client protection is used, the engine checks whether
the certificate of an external server was signed by one of the Trusted Certificate Authorities. You can also
create your own Trusted Certificate Authority elements to represent other certificate authorities that the engine
should consider trusted.
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Using TLS inspection
Certain safety precautions must be considered before using TLS inspection. It is possible to apply malware
scanning and URL filtering to TLS inspected traffic.

Security considerations in TLS inspection
You must carefully consider security precautions when using TLS Inspection.

The TLS communications mediated by the engine are decrypted for inspection, and the private keys of the
servers are stored in the TLS Credentials elements on the Management Server. For this reason, the following
recommendations are general guidelines for ensuring the security of the engine and the SMC:
• Run the Management Server on a hardened operating system.
• Disable SSH access to the engine’s command line if it is not needed regularly.
• Make sure that the engine’s Control IP address is in a protected network.
• Save Management Server backups as encrypted files.

Deploying engines in TLS inspection
TLS Inspection requires two separate secure connections: one from the client to the engine and one from the
engine to the server. For this reason, engines must be deployed in inline mode to use TLS Inspection.

TLS Inspection cannot be done for traffic picked up through Capture interfaces.

TLS inspection cannot be used on redundant single inline engines deployed alongside a Firewall cluster using
dispatch clustering. In dispatch clustering, traffic is received by one node in the Firewall cluster. The node
forwards the traffic to the other Firewall nodes. This can result in a situation where one of the single inline
engines only receives one direction of the traffic, and the other single inline engine receives both directions of the
traffic. If one engine has created substitute certificates, and traffic is dispatched through a different engine without
passing through the engine that created the substitute certificates, the connection fails.

Related concepts
Guidelines for deploying IPS engines and Layer 2 Firewalls on page 69

Malware scanning of decrypted TLS traffic
Once TLS traffic has been decrypted, malware scanning can be done in the same way as for regular traffic.

Any traffic that is allowed to continue after malware scanning is re-encrypted and sent to its destination.

Related concepts
Anti-malware scanning overview on page 1003
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Configure TLS inspection for server
protection

If you want to inspect TLS traffic for which an internal server is the destination, you must create a TLS
Credentials element to store the private key and certificate of the server.

The private key and certificate allow the firewall to decrypt TLS traffic for which the internal server is the
destination so that it can be inspected. The TLS Credentials element stores the private key and certificate of an
internal server. The certificate and the associated private key must be compatible with OpenSSL and be in PEM
format. Make sure that the server’s private key and certificate are accessible from the computer where you use
the Management Client.

When a TLS Credentials element is used in TLS inspection, the private key and certificate allow the Firewall, IPS
engine, Layer 2 Firewall, or Virtual Firewall to decrypt TLS traffic for which the internal server is the destination so
that it can be inspected.

TLS Credentials elements can also be used in the properties of other elements to secure connections involving
those elements.

Table 120: Other elements where TLS Credentials elements can be used

Element Purpose

Web Portal Server The certificate is used to secure the server’s connections using HTTPS.

Management Server When a TLS Credentials element is used on the SMC API tab of the Management
Server Properties dialog box, the certificate is used to secure communications between
the SMC API client and the Management Server.

SSL VPN Portal The private key and certificate are used to establish SSL connections to the SSL VPN
Portal.

SSL VPN Portal
Service

The private key and the certificate are used in DNS Mapping to establish SSL
connections to the service.

Related tasks
Activate HTTPS on the Web Portal Server on page 411
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Create TLS credentials using an existing
certificate
If you have an existing private key and certificate, create a TLS Credentials element and import the private key
and certificate.

Before you begin
The private key and certificate must be saved in a location that you can access from the computer
where you run the Management Client.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Certificates > TLS Credentials

3) Right-click TLS Credentials, then select Import Private Key.

4) In the Name field, enter a unique name.

5) Next to the Private Key field, click Import, then browse to the private key.
If the private key is encrypted, you are prompted to enter the password.

6) Next to the Certificate field, click Import, then browse to the certificate.

7) (TLS Credentials for Web Portal Server only) Next to the Intermediate Certificate field, click Import, then
browse to the certificate from an intermediate CA that was used to sign the server certificate.

8) Click OK.

Create TLS credentials from a certificate
request
If you do not have an existing private key and certificate, create a certificate request and self-sign it to create a
TLS Credentials element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Certificates > TLS Credentials.
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3) Right-click TLS Credentials and select New TLS Credentials.

4) Complete the certificate request details.

a) Enter a name for the certificate.

b) In the Common Name field, enter the IP address or domain name of the server.

c) Complete the remaining fields as needed.

d) Click Next.

5) Select Self Sign.

6) Click OK.

Result

The TLS Credentials element is added to Administration > Certificates > TLS Credentials. The State column
shows that the certificate has been signed.

Configure TLS inspection for client
protection

Client Protection Certificate Authority elements are used to inspect TLS traffic between an internal client and an
external server.

When an internal client makes a connection to an external server that uses TLS, the engine generates a
substitute certificate that allows it to establish a secure connection with the internal client. The Client Protection
Certificate Authority element contains the credentials the engine uses to sign the substitute certificate it
generates. If the engine does not use a signing certificate that is already trusted by users’ web browsers when
it signs the substitute certificates it generates, users receive warnings about invalid certificates. To avoid these
warnings, you must either import a signing certificate that is already trusted, or configure users’ web browsers to
trust the engine’s signing certificate.

Note:  Traffic that uses TLS might be protected by laws related to the privacy of communications.
Decrypting and inspecting this traffic might be illegal in some jurisdictions.

Create Client Protection Certificate Authority
elements
Client Protection Certificate Authority elements contain the credentials the engine uses to sign the certificate it
generates.

If you want to inspect TLS traffic between a client in the internal network and an external server, you must create
a Client Protection Certificate Authority element.

You must configure users’ browsers to trust certificates signed using the credentials in the Client Protection
Certificate Authority element to avoid excessive warnings or error messages about invalid certificates.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Setting up TLS inspection | 1045

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Certificates > Certificate Authorities > Client Protection Certificate Authorities.

3) Right-click Client Protection Certificate Authorities, then select New Client Protection Certificate
Authority.

4) Enter a unique name Name.

5) (Optional) Enter the Validity time (in minutes) for the substitute certificates the engine creates.
Each substitute certificate expires at the end of the validity time, and the engine automatically generates
a new certificate. This process might produce warnings or error messages in the users’ web browsers. To
avoid excessive warnings, define a sufficiently long validity time, for example, several hours.

Note:  All fields except the Name and Validity time on the General tab are grayed out. The
grayed out fields are always filled in automatically based on information contained in the
certificate you generate or import, and you cannot change them.

6) On the Certificate tab, import an existing private key and certificate or generate a new private key and
signing certificate.

7) Click OK.

Import private keys and signing certificates for
client protection
If you already have a certificate authority that is trusted by users’ web browsers, you can import its private key
and signing certificate. The engine uses them when it signs the substitute certificates it creates.

Importing a private key and certificate removes the need to separately configure users’ web browsers to trust the
engine’s signing certificate. You can also import a private key and signing certificate that you generated outside
of the SMC even if you do not already have a certificate authority that is trusted by users’ web browsers. The
certificate and the associated private key must be compatible with OpenSSL and be in PEM format. Make sure
that the private key and certificate are accessible from the computer where you use the Management Client.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Certificates > Certificate Authorities > Client Protection Certificate Authorities.

3) Right-click Client Protection Certificate Authorities, then select New Client Protection Certificate
Authority.

4) Click the Certificate tab.
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5) Next to the Private Key field, click Import, then browse to the private key.

6) Next to the Certificate field, click Import, then browse to the certificate.
If users’ web browsers are not already configured to trust the certificate authority whose signing certificate
you imported here, add it to the list of certificate authorities that are trusted by users’ web browsers when you
are finished configuring TLS inspection in the SMC.

Generate private keys and signing certificates
for client protection
If you do not already have a private key and signing certificate for the engine, you can generate a private key and
signing certificate.

When you generate a private key and signing certificate in the SMC, you must export the certificate. You must
also add it to the list of certificate authorities that are trusted by users’ web browsers.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Certificates > Certificate Authorities > Client Protection Certificate Authorities.

3) Open the Client Protection Certificate Authority Properties dialog box in one of the following ways:
• Right-click Client Protection Certificate Authorities, then select New Client Protection Certificate

Authority.
• Right-click a Client Protection Certificate Authority element, then select Properties.

4) Click the Certificate tab.

5) Click Generate.

6) In the Common Name field, enter the certificate authority’s common name.

7) From the Public Key Length drop-down list, select the length of the public key to be generated.

8) In the Valid Until field, enter the date and time until which the signing certificate is valid.

Tip:  You can also select the date by clicking  Open Calendar.

By default, the signing certificate is valid for one year after the creations date and time.

9) Click OK.
A private key and signing certificate are generated.
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Export Client Protection CA certificates
To make the users’ web browsers trust the engine’s signing certificate, you must add the Client Protection CA
certificate to trusted certificates.

If the users’ web browsers are not configured to trust the engine’s signing certificate, users receive warnings
about invalid certificates. If you generated the signing certificate for client protection in the SMC, you must export
the certificate. You must also add it to the list of certificate authorities that are trusted by the users’ web browsers.

If you have integrated the SMC with McAfee ePO, you can also export a Client Protection CA certificate to the
McAfee ePO server. The McAfee ePO server can then deploy the certificate on the Windows-based endpoints
that it manages. For more information about the necessary configuration steps in the McAfee ePO user interface,
see McAfee ePO product documentation.

These instructions assume that you already have the Client Protection Certificate Authority Properties dialog
box open.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Certificates > Certificate Authorities > Client Protection Certificate Authorities.

3) Open the Client Protection Certificate Authority Properties dialog box in one of the following ways:
• Right-click Client Protection Certificate Authorities, then select New Client Protection Certificate

Authority.
• Right-click a Client Protection Certificate Authority element and select Properties.

4) Click the Certificate tab.

5) Click the Export option for the Certificate field, then browse to the location where you want to save the file.
When you are finished configuring TLS inspection in the SMC, add the exported certificate to the list of
certificate authorities that are trusted by users’ web browsers.

Related tasks
Integrate McAfee ePO with Forcepoint NGFW on page 969

Define trusted certificate authorities for
TLS inspection

If you are using client protection and users must connect to domains whose certificates are not signed by one of
the default Trusted Certificate Authorities, define your own Trusted Certificate Authority element to represent it.

Trusted Certificate Authority elements represent the certificates that identify certificate authorities. When a client
in the protected network connects to an HTTPS server, the engine checks whether the certificate authority that
signed the server’s certificate is one of the Trusted Certificate Authorities. If the certificate was signed by one of
the Trusted Certificate Authorities, the engine makes a substitute certificate that matches the server's certificate.
The engine then signs the substitute certificate with the Client Protection Certificate Authority signing certificate.
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If the server’s certificate is not signed by a Trusted Certificate Authority, the engine makes a new self-signed
certificate. In this case, users receive a warning that the issuer of the certificate is not trusted. In both cases,
client protection continues to function normally.

When you define a CA as trusted, all certificates signed by that CA are considered valid until their expiration date.

Create Trusted Certificate Authority elements
If you want to use a certificate signed by a Certificate Authority (CA) that is not one of the default Trusted
Certificate Authority elements, you must create a new Trusted Certificate Authority element.

For example, if you want to use the Forcepoint User ID Service server's certificate to secure communications
from Forcepoint User ID Service to the NGFW Engine, you must define the CA as a Trusted Certificate Authority
element and import the certificate, then define the CA as a trusted CA in the TLS Profile element that is used in
the Forcepoint User ID Service configuration on the NGFW Engine.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Certificates > Certificate Authorities > Trusted Certificate Authorities.

3) Right-click Trusted Certificate Authorities, then select New Trusted Certificate Authority.

4) Enter a unique Name.

Note:  All fields except the Name on the General tab are grayed out. The grayed out fields
are always filled in automatically based on information contained in the certificate you import
and you cannot change them.

5) On the Certificate tab, import a certificate.

6) Click OK.

Next steps

If you want to use the Trusted Certificate Authority in a TLS Profile element, modify the TLS Profile element
properties.

Import trusted certificate authority certificates
for TLS inspection
Import a certificate authority for the Trusted Certificate Authority element.

Make sure that the certificate authority’s certificate is accessible from the computer where you use the
Management Client.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Certificates > Certificate Authorities > Trusted Certificate Authorities.

3) Browse to Trusted Certificate Authorities, then right-click a Trusted Certificate element and select Edit.

4) Click the Certificate tab.

5) Click Import.

6) Browse to the certificate, then click Open.

7) Click OK.

Exclude traffic from decryption for TLS
inspection

Some traffic is automatically excluded from decryption. You can also exclude traffic from decryption globally, add
rules to exclude specific traffic from decryption, or create specific lists of domains to exclude from decryption.

Traffic to and from some servers that use TLS can contain users’ personal information that is protected by
laws related to the privacy of communications. Decrypting and inspecting this traffic might be illegal in some
jurisdictions.

You can exclude traffic from decryption and inspection in two ways: globally with a TLS Match element, or for
specific matching traffic with an HTTPS Inspection Exception element. In both cases, traffic to the specified
domains is allowed to pass through the engine without being decrypted.

The NGFW Engine mainly matches the specified domains based on the server name information (SNI) in the TLS
Client Hello packet before the server certificate is sent. You can also use category-based URL filtering to exclude
all traffic in the selected URL Categories from decryption based on the SNI in the traffic.

Note:  If the end user’s browser does not use SNI, the traffic might be decrypted.

TLS Matches define matching criteria for the use of the TLS protocol in traffic, and allow you to prevent specified
traffic from being decrypted. TLS Matches that deny decrypting are applied globally, even if the TLS Match
elements are not used in the policy. However, TLS Match elements that are used in specific Access rules can
override globally applied TLS matches.

In most cases, TLS Matches are the recommended way to prevent traffic from being decrypted and inspected.
Globally excluding domains from decryption might also prevent some Network Applications from being detected
in encrypted connections. In this case, you can use HTTP Inspection Exceptions exclude the domain from TLS
inspection.

The Decryption option in the Allow Action Options in Access rules defines whether traffic that matches the rule is
decrypted. To exclude specific traffic from decryption for TLS inspection, add the following type of Access rule:
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Source Destination Service Action

Source IP address Destination IP address One or more of the following
Service elements:
• HTTPS (with decryption)
• HTTPS (SafeSearch with

decryption)
• A custom Service element that

uses the HTTPS Protocol

Allow
Decryption: Disallowed

HTTPS Inspection Exceptions are used in a custom HTTPS service to define a list of domains for which HTTPS
traffic is not decrypted. The custom HTTPS service must be used in a rule, and only traffic that matches the rule
is excluded from decryption and inspection. HTTPS Inspection Exceptions are primarily intended for backwards
compatibility.

Globally exclude domains from decryption
TLS Match elements define matching criteria for the use of the TLS protocol in traffic, and allow you to prevent
the specified traffic from being decrypted.

TLS Matches that deny decrypting are applied globally, even if the TLS Match elements are not used in the
policy. However, TLS Match elements that are used in specific Access rules can override globally applied TLS
matches.

In most cases, TLS Matches are the recommended way to prevent traffic from being decrypted and inspected.
Globally excluding domains from decryption can also prevent some Network Applications from being detected in
encrypted connections. In this case, you can exclude the domain from TLS inspection.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > TLS Matches.

3) Right-click TLS Matches, then select New TLS Match.

4) In the Name field, enter a unique name.

5) Select Deny Decrypting.

6) From the Match Certificate Validation drop-down list, select Validation succeeded.

7) Click Add, then specify the Matching Domains to exclude from decryption.
We recommend adding the domain names that users access to guarantee that traffic is not decrypted. If no
domains are specified, any connection for which validation succeeded is excluded from decryption.

8) Click OK.
Connections are excluded from decryption as specified in the TLS Matches.
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Related concepts
Getting started with Network Application elements on page 937

Related tasks
Exclude domains from inspection of HTTPS traffic on page 1051
Define Source, Destination, and Service criteria in rules on page 861

Exclude domains from inspection of HTTPS
traffic
The HTTPS Inspection Exceptions element is a list of domains that are excluded from decryption and inspection.

HTTPS Inspection Exceptions are used in a custom HTTPS service to define a list of domains for which HTTPS
traffic is not decrypted. The custom HTTPS service must be used in a rule, and only traffic that matches the rule
is excluded from decryption and inspection. HTTPS Inspection Exceptions are primarily intended for backwards
compatibility.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Expand the Other Elements branch.

3) Right-click HTTPS Inspection Exceptions, then select New HTTPS Inspection Exceptions.

4) Enter a unique Name.

5) Click Add.

6) Enter the domain name or NetBIOS name, then click OK.
The domain name or NetBIOS name must exactly match the domain names that users access. Otherwise,
the domain is not excluded from decryption and inspection.

Note:  Wildcard characters in exceptions are interpreted literally. For example, *.example.com
matches the domain "*.example.com" rather than all subdomains of example.com.

Related concepts
URL filtering and how it works on page 989
Example: Preventing decryption of private connections on page 1000
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Activating TLS inspection
To activate TLS inspection, you must configure client or server protection on the engine and define the inspected
traffic in Access rules. You might also need to create a custom HTTPS Service element.

In the Engine Editor, you specify the Client Protection Certificate Authority (for client protection), or the TLS
Credentials (for server protection). Depending on the options you specify, you can configure only client
protection, only server protection, or both client and server protection.

CAUTION:
Uploading TLS Credentials or a Client Protection Certificate Authority to the engine might enable
decryption of TLS traffic that is not excluded from TLS inspection. The following configurations
might enable decryption of TLS traffic:

• Adding a Network Application that allows or requires the use of TLS to an Access rule
• Selecting the Enforced option for Log Application Information in the Access rules
• Enabling Deep Inspection in an Access rule if the Service cell contains a Network Application

or a Service that does not include a Protocol Agent

If the default HTTPS (with decryption) Service element meets your needs, you can use the default HTTPS (with
decryption) Service element in the Access rules without modification. You must create a custom HTTPS Service
in the following cases:
• To enable decryption for HTTPS traffic that uses a different port
• To select a different HTTPS Inspection Exceptions element
• To log the URLs in matching traffic
• To change any of the other settings in the Service Properties

The Access rules define which traffic is decrypted and inspected. Access rules that enable Deep Inspection and
use a custom HTTPS Service or the default HTTPS (with decryption) Service element select specific traffic for
decryption and inspection. To enable the decryption and inspection of all TLS traffic, you enable Deep Inspection
in an Access rule with the Service cell of the rule set to ANY. Traffic that matches the Access rule is decrypted
and inspected in the same way as unencrypted HTTP traffic according to the Inspection rules.

Activating TLS inspection consists of the following steps:

1) Activate client protection or server protection and upload certificates to the engine.

2) (Optional) Define a custom HTTPS Service element and enable TLS Inspection in the Protocol Parameters.

3) Create Access rules to select specific traffic for decryption and inspection or enable decryption and
inspection of all TLS traffic.

Related concepts
Overview of Access rules on page 817

Related tasks
Activate TLS inspection on engines on page 1053
Enable TLS inspection in a custom HTTPS Service on page 1053
Apply TLS inspection to traffic on page 1054
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Activate TLS inspection on engines
Depending on the elements you select in the engine properties, you can activate client protection alone, server
protection alone, or client and server protection together.

CAUTION:
Uploading TLS Credentials or a Client Protection Certificate Authority to the engine might enable
decryption of TLS traffic that is not excluded from TLS inspection. The following configurations
might enable decryption of TLS traffic:

• Adding a Network Application that allows or requires the use of TLS to an Access rule
• Selecting the Enforced option for Log Application Information in the Access rules
• Enabling Deep Inspection in an Access rule if the Service cell contains a Network Application

or a Service that does not include a Protocol Agent

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Click NGFW Engines.

3) Right-click an engine element and select Edit <element type>.

4) From the navigation pane on the left, select Add-Ons > TLS Inspection.

5) (For client protection) From the Client Protection Certificate Authority drop-down list, select a Client
Protection Certificate Authority element.
• To select an existing element, click Select and select the element.
• To create an element, click New.

6) (For server protection) Click Add, then select one or more TLS Credentials elements and click Select.

7) Click  Save and Refresh to transfer the configuration changes and upload the certificates.

Related tasks
Configure TLS inspection for client protection on page 1044

Enable TLS inspection in a custom HTTPS
Service
Create a custom HTTPS Service element and use it for TLS inspection.

The default HTTPS (with decryption) Service element enables the decryption of HTTPS traffic that uses the
default port 443, excluding the domains that are specified in the Default HTTPS Inspection Exceptions. If the
default HTTPS (with decryption) Service element meets your needs, you can use the default HTTPS (with
decryption) Service element in the Access rules without modification.
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You must create a custom HTTPS Service in the following cases:
• To enable decryption for HTTPS traffic that uses a different port
• To select a different HTTPS Inspection Exceptions element
• To log the URLs in matching traffic
• To change any of the other settings in the Service Properties

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Select Other Elements > Services > TCP.
A list of TCP Services opens on the right.

3) Right-click the default HTTPS (with decryption) Service, then select New > Duplicate.
The TCP Service Properties dialog box opens with the properties of the HTTPS Service.

4) Enter a unique Name for the custom Service.

5) (Optional) If traffic uses a different port than the default port 443, enter the port number in the first Dst. Ports
field.

6) Click the Protocol Parameters tab.

7) (Optional) Click Select next to the HTTPS Inspection Exceptions field, then select an HTTPS Inspection
Exceptions element.

8) (Optional) To log the URLs in matching traffic, select Yes for Logging of Accessed URLs.

9) Click OK.

Related tasks
Apply TLS inspection to traffic on page 1054

Apply TLS inspection to traffic
Use the default or custom HTTPS Service element in Access rules to define which traffic is decrypted and
inspected.

CAUTION:
Uploading TLS Credentials or a Client Protection Certificate Authority to the engine might enable
decryption of TLS traffic that is not excluded from TLS inspection. The following configurations
might enable decryption of TLS traffic:

• Adding a Network Application that allows or requires the use of TLS to an Access rule
• Selecting the Enforced option for Log Application Information in the Access rules
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• Enabling Deep Inspection in an Access rule if the Service cell contains a Network Application
or a Service that does not include a Protocol Agent

To select specific traffic for decryption and inspection, you create Access rules that use a custom HTTPS Service
or the default HTTPS (with decryption) Service element. To enable the decryption and inspection of all TLS
traffic, you enable Deep Inspection in an Access rule with the Service cell of the rule set to ANY.

You must enable Deep Inspection in the Action options of the Firewall Access rules to enable TLS inspection.
Deep Inspection is enabled by default in the IPS, Layer 2 Firewall, and Layer 2 Interface Access rules. Traffic that
matches the Access rules for TLS inspection is decrypted and matched against HTTP Situations in the Inspection
rules in the same way as unencrypted HTTP traffic. Any traffic that is allowed to continue by the Inspection Policy
is re-encrypted and sent to its destination.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) (Client Protection) Add a rule with the following properties to select traffic from clients in the internal network
for inspection.

Table 121: Access rules for client protection

Source Destination Service Action

The elements that
represent clients
in your internal
network or ANY.

The elements
that represent the
HTTPS servers
to which internal
clients connect, or
ANY.

Your custom HTTPS Service, the default
HTTPS (with decryption) Service, or set
to ANY.

Allow

Deep Inspection
selected in the
Action options.

2) (Server Protection) Add a rule with the following properties to select traffic to internal servers for inspection.

Table 122: Access rules for server protection

Source Destination Service Action

The elements
that represent the
clients that connect
to your HTTPS
server, or ANY.

The elements that
represent your
internal HTTPS
servers.

Your custom HTTPS Service, the default
HTTPS (with decryption) Service, or set
to ANY.

Allow

Deep Inspection
selected in the
Action options.

3) Save and install the policy to start using the new configuration.

Related concepts
Getting started with Access rules on page 817
URL filtering and how it works on page 989
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Examples of TLS inspection
These examples illustrate some common uses for TLS Inspection and general steps on how each scenario is
configured.

Example: server protection in TLS inspection
Company A’s server offers HTTPS services to their customers. The administrators want to be able to detect and
block attacks targeting the HTTPS server, even if the attacks are encrypted inside an SSL tunnel.

They decide to configure TLS Inspection to decrypt and inspect traffic to and from the HTTPS server.

The administrators do the following:

1) Create a TLS Credentials element and import the private key and certificate of the HTTPS server.

2) Select the TLS Credentials in the Engine Editor.

3) Create Access rules with the default HTTPS (with decryption) Service as the Service.

4) On Firewalls, use the Medium-Security Inspection Policy to look for attacks in HTTP traffic and check the
HTTP traffic against the anti-malware signatures. On IPS engines, use the Inspection rules from the IPS
Template to look for attacks in HTTP traffic.

5) Save and install the policy.

Example: client protection in TLS inspection
The administrators also want to detect and block -based attacks targeting the browsers of users in Company A’s
network to protect the workstations and internal networks.

In addition to searching for attacks, the administrators also want to enable malware scanning. However, the
employees at Company A often use online banking services that are secured with HTTPS, and these connections
should not be inspected. The administrators decide to configure TLS Inspection to detect and block attacks that
are encrypted inside an SSL tunnel and use a TLS Match element to globally exclude the online banking domains
from decryption and inspection.

The administrators do the following:

1) Create a Client Protection Certificate Authority element and generate a new certificate and private key. In
their network environment, the administrators add the Client Protection Certificate Authority they created to
the list of trusted certificate authorities in the users’ browsers.

2) Select the Client Protection Certificate Authority in the Engine Editor.

3) Create a TLS Match element that prevents decryption when certificate validation succeeds for the domain
names for the online banking sites that are excluded from decryption. Because the TLS Match is applied
globally, the administrators do not have to use it in any specific rules.

4) Create Access rules with the default HTTPS (with decryption) Service as the Service.
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5) On Firewalls, use the Inspection rules from the Medium-Security Inspection Policy to look for attacks in
HTTP traffic and check the HTTP traffic against the anti-malware signatures. On IPS engines, use the
Inspection rules from the IPS Template to look for attacks in HTTP traffic.

6) Save and install the policy.
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 CHAPTER 63

Redirecting traffic to a proxy
service for external inspection

Contents

• How redirecting traffic for inspection works on page 1059
• Create a Proxy Server element on page 1061
• Create a custom Service element for redirecting traffic on page 1062
• Add Access rules to redirect traffic on page 1062
• Example: redirecting traffic to the Internet to a proxy service on page 1063

In addition to inspecting traffic on the NGFW Engine, you can transparently redirect traffic to a proxy service in the
cloud or on premises. For example, you can redirect all HTTP and HTTPS traffic to the Forcepoint Web Security Cloud
service.

Forcepoint Web Security Cloud is a service that offers real-time protection against advanced threats and data theft.
You need a separate license to use the service. For more information, see http://www.forcepoint.com.

How redirecting traffic for inspection
works

You can redirect traffic to a proxy service where the traffic can be, for example, scanned for malware before the
traffic continues to its final destination.

You can configure a Single Firewall or Firewall Cluster to redirect FTP, SMTP, HTTP, and HTTPS traffic. The
main benefit in using the firewall to redirect traffic to a proxy service is that the redirection works transparently:
the communicating hosts need no additional proxy configuration when the redirection is done for them at the
firewall.

Proxies are typically used for malware scanning and content filtering, but there are more applications. Using an
external service allows you to expand the capabilities of the firewall with many other types of content screening.
For example, the service can strip certain types of attachments out of emails without blocking the message itself.
This type of feature is available directly on the firewall as well, but an external service is a better option in medium
to high throughput environments.

http://www.forcepoint.com
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Figure 154: Redirection of traffic
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1 Traffic from the client arrives at the Firewall.

2 Access rules in the Firewall policy determine which connections are redirected to the proxy service for
inspection.

3 The traffic is inspected and redirected to the original destination.
Replies are received with the IP address of the proxy service, so they are also redirected to the proxy
service.

Redirecting traffic configuration overview
Use Protocol Agents to redirect FTP, SMTP, HTTP, and HTTPS traffic to a proxy service for inspection.

 
Figure 155: Elements in the configuration

Firewall PolicyServiceProtocol Agent Firewall

Proxy Server

A custom Service element and a Proxy Server element are needed. A Service redirects connections to a proxy
service when one of the existing default Protocol elements of the type Protocol Agent is attached to the Service.
The Service element contains a parameter that defines to which Proxy Server the traffic is redirected to. The
Service can be used in Access rules in the Firewall Policy to select traffic to be redirected to the proxy service. If
you have several proxies available, you can create different Services.
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The Protocol Agent redirection allows using the proxy service as a transparent proxy: no additional configuration
is needed on the clients. The redirection is fully transparent to both the client and the server. The Protocol Agent
translates the destination address automatically to the proxy service's address to redirect the traffic. The proxy
service establishes the forward connection to the original destination address.

In addition to translating the real destination address to the proxy service address for redirection, the source
address is also translated for handling the redirection on the firewall. The translated source address can be any
address that is routed back from the proxy service to the firewall (so that replies are correctly handled). Further
address translation can be applied to the connection from the proxy service to the communications destination.

Follow these general steps to configure and use proxy services:

1) Create the Proxy Server element that represents the proxy service.

2) Create a custom Service element that references the Proxy Server.

3) Define the Access rules that select traffic for redirection.

Create a Proxy Server element
Create a Proxy Server element that defines the IP address or FQDN of the proxy service that you want to redirect
traffic to.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Network Elements > Servers.

3) Right-click Servers, then select New > Proxy Server.

4) Configure the settings.

5) On the Services tab, select the protocols to redirect.

6) If redirecting HTTP or HTTPS traffic, configure the details of the service to redirect traffic to.

7) Click OK.

Related tasks
Create Location elements on page 129
Define contact addresses for engines on page 131
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Create a custom Service element for
redirecting traffic

Before you can use redirect traffic for external inspection, you must create a custom Service element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Services.

3) Right-click Services, then select New > TCP Service.

4) Configure the settings.

5) Click Select next to the Protocol field, then select the TCP Protocol Agent.
The FTP, SMTP, HTTP, and HTTPS Protocol Agents can be used.

6) On the Protocol Parameters tab, select the Proxy Server to redirect traffic to.

7) Click OK.

Add Access rules to redirect traffic
Define the connections that you want to redirect to a particular Proxy Server in the IPv4 or IPv6 Access rules.

To activate redirection, you use a custom Service element. Both incoming and outgoing connections can be
redirected.

If the proxy service is in the cloud, a rule is needed to redirect the matching traffic to the proxy service. If the
proxy service is on premises, a rule is needed to redirect the matching traffic to the proxy service and another
rule is needed to allow the connection from the proxy service to the actual destination.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Policies > Firewall Policies.

3) Right-click a policy, then select Edit Firewall Policy.
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4) Add an IPv4 or IPv6 Access rule that redirects the traffic to the proxy service.

Source Destination Service Action

Original source address of
the traffic to be inspected
(for example, clients in the
internal network).

Original destination address
of the traffic (for example, a
web server).

Your custom Service
element that refers to the
Proxy Server.

Allow

5) (When the proxy service is on premises) Add a rule that allows redirecting connections from the proxy
service to the original destination.

Source Destination Service Action

Proxy Server’s IP address. Original destination IP
address (for example, a web
server).

A service element that does
not include redirection.

Allow

Example: redirecting traffic to the
Internet to a proxy service

The example company has decided to screen out non-work-related connections using a proxy service. The
company can screen the HTTP and HTTPS connections that employees open to the Internet.

The Proxy Server acts as a proxy for these connections. The administrators have already installed the proxy on
premises and configured it to process HTTP and HTTPS traffic according to the company’s policy.

To configure the redirection, the administrators:

1) Create a Proxy Server element to represent their proxy service.

2) Create a custom Service element for both HTTP and HTTPS (HTTP-PROXY-Redirect and HTTPS-PROXY-
Redirect) that refer to the Protocol Agents for those protocols.

3) Add the reference to the Proxy Server to the Protocol Agent parameters in the Service properties.

4) Create the Access rules that redirect connections to the proxy service, and the connections that the proxy
service then opens to the Internet or any other destination.

ID Source Destination Service Action

14.1 Internal Network element ANY HTTP-PROXY-Redirect Allow

14.2 Proxy Server element ANY HTTP Allow

14.3 Internal Network element ANY HTTPS-PROXY-Redirect Allow

14.4 Proxy Server element ANY HTTPS Allow

Connections opened from the corporate LAN are redirected to the proxy in rules 14.1 and 14.3. The proxy
then connects to the actual destination, which is allowed in rules 14.2 and 14.4.
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 CHAPTER 64

Blacklisting IP addresses
Contents

• Blacklisting traffic and how it works on page 1065
• Add Access rules for blacklisting on page 1068
• Configure automatic blacklisting of traffic on page 1069
• Blacklist traffic manually on page 1071
• Monitoring blacklisting on page 1072

Blacklisting is a way to temporarily block unwanted network traffic either manually or automatically with blacklist
requests from an NGFW Engine or Log Server. Firewalls, IPS engines, Layer 2 Firewalls, and Virtual NGFW Engines
can use a blacklist for blocking traffic.

Blacklisting traffic and how it works
Blacklists contain entries for blocking traffic temporarily based on traffic patterns that the engines detect or on
administrator commands.

Blacklisting allows you to temporarily stop traffic:
• Without editing and installing policies (manual blacklisting only)
• Based on events detected by engines
• Based on correlation of detected events
• On a different engine than the one that detects an event
• On multiple engines with a single administrator command or a single detected event

Blacklisting makes it possible to block unwanted network traffic for a specified time. Engines can add entries to
their own blacklists based on events in the traffic they inspect. NGFW Engines and Log Servers can also send
blacklist requests to other NGFW Engines. You can also blacklist IP addresses manually.

Example
A rule in the Inspection Policy detects a serious attack against a single host in your internal network. You can
configure the rule to trigger automatic blacklisting of connections from that host to any other host in your internal
networks.

Keep these limitations in mind when planning your blacklisting strategy:
• Layer 2 Firewalls can only blacklist IPv4 traffic.
• Virtual NGFW Engines cannot send blacklist requests to other Virtual NGFW Engines or to NGFW Engines.
• Firewalls and Layer 2 Firewalls do not enforce the blacklist by default. To enforce the blacklist, you must

define the points at which the blacklist is checked in the Access rules.
• If a connection is allowed by a rule placed above the blacklist rule, the connection is allowed regardless of the

blacklist entries.
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Automatic blacklisting can have unintended consequences that could disrupt business-critical traffic. Use
automatic blacklisting with careful consideration. The following two categories represent the typical risks
associated with blacklisting:

Table 123: Risks of blacklisting

Risk Explanation

Blacklisting legitimate
connections (false
positive)

If the defined pattern for detecting malicious traffic is inaccurate, legitimate traffic
might sometimes be blacklisted. Blacklisting legitimate connections causes service
downtime for hosts that are incorrectly identified as a source of malicious traffic.

Causing self-inflicted
denial-of-service (DoS)

When an attacker uses spoofed IP addresses, a different (legitimate) IP address
might be blacklisted instead of the attacker’s IP address. Blacklisting spoofed IP
addresses might cause a self-inflicted denial-of-service of legitimate traffic.

You can minimize these risks with good planning. Identify and evaluate the threats carefully before you configure
blacklisting.
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Blacklisting process
Blacklisting is executed as defined in the Access rules. Automatic blacklisting requests are sent as defined in the
Inspection Policy.

 
Figure 156: Blacklisting process

1 Engines add entries to their own blacklists for traffic they inspect.
• There is one blacklist for each Firewall, Layer 2 Firewall, IPS engine, or Virtual NGFW Engine.
• In engine clusters, there is one blacklist for each cluster. The nodes in the cluster exchange blacklist

information in their synchronization communications.

2 Log Servers send blacklisting requests as a response to correlation of detected events. When one
NGFW Engine sends a blacklisting request to another NGFW Engine, the Log Server relays the
blacklisting request to the Management Server.

3 Management Servers relay manual blacklisting commands from administrators, and blacklisting
requests sent by Log Servers to the NGFW Engines.
There is no direct communication between different Virtual NGFW Engines or between Virtual NGFW
Engines and the Management Server. For this reason, Virtual NGFW Engines cannot send blacklisting
requests to other Virtual NGFW Engines.

4 Engines enforce the entries on their blacklists according to their Access rules.
• Each blacklist entry exists only for a defined duration, after which the entry is removed from the

blacklist, and matching connections are again allowed. The duration of the blocking is defined when
the blacklist entry is created.

• Access rules check connections against the blacklist. If the IP addresses and ports in one of the
blacklist entries match, the connection is discarded.

• If the connection does not match a blacklisting Access rule or its related blacklist entries, the next
Access rule in the policy is checked as usual.
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Whitelisting traffic
Whitelisting means defining a list of IP addresses that must never be blacklisted.

Whitelisting is implemented by following general Access rule design principles. Blacklisting applies only at the
position of the blacklisting Access rules in the policy. Connections that have already been allowed or discarded
before the blacklisting rules are not affected by blacklisting. If an Access rule allows a connection, an Access rule
that refers to the blacklist further down in the policy cannot blacklist the connection.

Blacklisting configuration overview
Configuring blacklisting consists of several general steps.

Follow these general steps to configure blacklisting:

1) Define which traffic is matched against the blacklist in the Access rules.

2) (Automatic blacklisting only) Define the traffic that you want to blacklist automatically in the Exceptions in the
Inspection Policy.

After blacklisting is configured, you can monitor the currently active blacklist.

Related concepts
Monitoring connections, blacklists, VPN SAs, users, routing, and SSL VPNs on page 203

Add Access rules for blacklisting
Access rules define which connections are checked against the blacklist.

By default, Firewalls and Layer 2 Firewalls do not enforce the blacklist. To enforce the blacklist, you must define
the points at which the blacklist is checked.

The default High Security IPS Template and Medium Security IPS Template contain Access rules that apply
the engine's blacklist. If your IPS policy is based on these templates, it is not necessary to add Access rules for
blacklisting. You can optionally add more Apply Blacklist rules with different matching criteria at different points in
the policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the Firewall, IPS, Layer 2 Firewall, or Layer 2 Interface Policy for editing.
Blacklist enforcement for Virtual NGFW Engines is configured in the Firewall Policy, IPS Policy, or Layer 2
Firewall Policy that is used on the Virtual NGFW Engine.

2) On the IPv4 Access or IPv6 Access tab, define which Sources, Destinations, and Services are compared
with the blacklist.

Note:  Layer 2 Firewalls can only blacklist IPv4 traffic.
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3) Right-click the Action cell and select Apply Blacklist.

4) (Optional) Restrict which engines and servers are allowed to send blacklist requests.

a) Right-click the Action cell and select Edit Options.

b) On the Blacklisting tab, select Restricted for the Allowed Blacklisters for This Rule setting.

c) From the Available Blacklisters list, select the elements that you want to add to the Allowed
Blacklisters list and click Add.
Add the Management Server to allow manual blacklisting through the Management Clients. Add the Log
Server to allow it to relay blacklisting requests from other NGFW Engines.

d) Click OK.

Note:  By default, engines are allowed to add entries directly to their own blacklists for traffic
they inspect.

5) Install the policy on the engine to activate the changes.

Next steps

No further configuration is needed if you want to blacklist connections manually.

Related concepts
Getting started with Access rules on page 817

Configure automatic blacklisting of
traffic

Engines trigger automatic blacklisting based on the Blacklist Scope options in the Exceptions in the Inspection
Policy.

Engines add entries directly to their own blacklists for traffic they inspect. Engines can also send blacklisting
requests to other NGFW Engines. In this case, the engine sends the blacklisting request to the Log Server.
The Log Server relays the blacklisting request to the Management Server. The Management Server relays the
blacklisting request to the other NGFW Engines that enforce the blacklisting.

Engines generate blacklist entries based on the patterns they detect in the traffic flow. The blacklist entry that is
sent identifies traffic based on IP addresses and optionally the Protocol and port. The blacklist entries can include
whole networks, even if the events that trigger them are related to a single source or destination IP address.

Automatic blacklist entries are created using the detected event’s source and destination IP addresses, and
optionally the TCP or UDP ports. If the event does not contain this information, a blacklist entry cannot be
created. Netmasks can optionally be used to blacklist the detected event’s network.
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Add a rule for automatic blacklisting
You can add a rule for automatic blacklisting to the Inspection Policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) In the navigation pane on the left, browse to Policies > Inspection Policies.

3) Right-click the Inspection Policy and select Edit Inspection Policy.
The Inspection Policy opens for editing.

4) On the Exceptions tab, add a rule with the Situation, Source, Destination, and Protocol that match traffic
you want to blacklist.

5) Right-click the Action cell and select Terminate.

6) Right-click the Action cell and select Edit Options.

Define blacklisting rule Action options
When the blacklist entry is created, the actions taken depend on the options you set.

Before you begin
Add a rule for automatic blacklisting to the Inspection Policy.

You can define Blacklisting scope options for any type of Exception, including rules that use Correlation
Situations.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Select Rule Action Options dialog box, click the Blacklist Scope tab.

2) Select Override collected values set with “Continue” rules.

3) Select the type of Blacklist entry to create:
• To create a Blacklist entry that terminates only the current connection using the default options, select

Terminate the Single Connection. Proceed to step 4.
• To block the traffic for defined duration and configure the settings, select Block Traffic Between

Endpoints.

4) Select Blacklist Executors (the engines where the blacklist entry is sent), then click Add.
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5) (Optional) To include the engine that detects the situation in the list of blacklist executors, select Include the
Original Observer in the List of Executors.

6) Click OK.

7) Click  Save and Install.

Related concepts
Monitoring connections, blacklists, VPN SAs, users, routing, and SSL VPNs on page 203

Related tasks
Blacklist traffic manually on page 1071

Blacklist traffic manually
You can blacklist traffic manually on Firewalls, IPS engines, and Layer 2 Firewalls.

For example, you can temporarily block a suspicious or disruptive source of communications while you conduct
further investigations.

There are three ways to create new blacklist entries manually.
• Blacklist a connection found in the log data.
• Define a new blacklist entry for an NGFW Engine element.
• Create new blacklist entries in the Blacklist view, Connections view, Monitoring view, and Logs view.

The blacklist is not necessarily applied to all traffic. The Access rules determine how the blacklist is used.

Note:  If a connection is allowed by a rule placed above the blacklist rule in the Access rules, the
connection is allowed regardless of the blacklist entries. Check the logs to see which connections
are discarded based on blacklisting.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Create a new blacklist entry in one of the following ways:
• In the Blacklist view, Connections view, or Logs view — Right-click a row in the table and select New

Blacklist Entry or New Entry.
• To create a blacklist entry for a specific NGFW Engine — Right-click the NGFW Engine element in the

Connections view, Monitoring view, or Logs view, and select New Blacklist Entry or Blacklist > New
Entry.

2) Select the Duration for how long this entry will be kept.

• If you leave the value as 0, the entry only stops the current connections. Otherwise, the entry is enforced
for the specified period of time.

3) Select the Address to blacklist for Endpoint 1 and Endpoint 2.
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4) (Only if the protocol is TCP or UDP) Select the Port to blacklist for Endpoint 1 and Endpoint 2.

5) Select the Blacklist Executors that enforce the blacklist entry.

6) Click OK.
The blacklist entry is sent to the executor and the traffic is blocked.

Monitoring blacklisting
You can monitor active blacklisting entries in the Blacklist view.

The currently active blacklisting entries on the engine can be monitored in the Blacklist view. Blacklist monitoring
does not show you which connections are dropped. Blacklist monitoring only shows you the IP addresses that
are currently on the blacklist. The Logs view can show which connections are dropped, depending on the logging
options you have set. The blacklist can be sorted and filtered in the same way as log entries.
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 PART X
Users and authentication

Contents

• Setting up directory servers on page 1075
• Setting up user authentication on page 1097

User accounts are stored in internal databases or external directory servers. You can use Forcepoint NGFW in the
Firewall/VPN role or external authentication servers to authenticate users.
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 CHAPTER 65

Setting up directory servers
Contents

• Getting started with directory servers on page 1075
• Integrating external directory servers on page 1078
• Enabling access control by user on page 1084
• Defining user accounts on page 1089
• Add Users to User Group elements on page 1092
• Remove Users from User Group elements on page 1092
• Import user information on page 1092
• Export user information on page 1093
• Change user passwords on page 1093
• Remove the authentication settings of a user on page 1094
• Reset a firewall engine's local user database on page 1094
• Set user database replication on or off for Firewalls and Master NGFW Engines on page 1095
• Examples of Directory Servers on page 1096

A directory server provides access to information about user accounts in a user database. Both internal and external
directory servers can be used. Directory servers can be used for user authentication with Forcepoint NGFW in the
Firewall/VPN role.

Getting started with directory servers
A directory server is a server that contains a user database that is queried during the user authentication process.

You can store the user accounts in the Management Server’s internal user database, or on an external directory
server. Different users can be stored in different directories. Authentication is based on the user information, but
is a separate operation and is not necessarily done on the same server that stores the user information.

You can optionally use an integrated external Active Directory Server with an integrated Forcepoint User ID
Service server or McAfee Logon Collector to provide transparent user identification for access control by user.
Access control by user allows the use of Active Directory users as the source and destination of rules.

Note:  McAfee Logon Collector is only supported in Forcepoint NGFW version 5.8 or later.

To implement user authentication, you must define user accounts either in the internal user database or on an
external directory server.

If you use an external third-party authentication server and do not need to define different access rights for
different users, it is not necessary to integrate an external directory server with the SMC. You can create
a special User element with the name *external* in the internal user database to represent any user that
authenticates using the external authentication service.
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Limitations
• The internal LDAP user database does not allow external authentication servers to query user information.
• The internal LDAP database limits the length of the User and User Group DN (distinguished name) to a

maximum of 254 characters. Check the restrictions of external LDAP servers from the external server’s
documentation.

• If administrative Domains are configured, the internal user database is always in the Shared Domain. The user
accounts stored in the internal database are also always in the Shared Domain. If you want to limit the visibility
of end-user accounts, you must configure external LDAP databases separately for each Domain.

• User authentication is only supported on Firewalls. User authentication is not supported on layer 2 physical
interfaces on Firewalls.

What do I need to know before I begin?
• The Management Server has an internal LDAP user database.
• Alternatively, you can use external LDAP user databases (including Active Directory).
• Different users can be stored in different databases.

Depending where user information is stored, different authentication options are available. The following table
explains the possible combinations of internal and external directory servers and authentication servers:

Table 124: Combinations of internal and external directory servers and authentication servers

Internal authentication server External authentication server

Internal
directory
server

User and User group information are
maintained in the Management Server’s
internal user database. User and User
Group information can be managed using
the Management Client and can be used for
creating rules. Authentication can be done with
password, IPsec certificate, or preshared key.

A second, external user database is required
because the external authentication server has
no access to the internal database. The same
user information must be maintained separately in
the Management Server’s internal user database
and in the external user database. User and User
Group information can be used for creating rules.
Any authentication method supported by the
external authentication server can be used.
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Internal authentication server External authentication server

External
directory
server

The Management Server is defined as an
LDAP client for the external directory server.
User and User Group information is shown in
the Management Client, and can be used for
creating rules. Authentication can be done with
password, IPsec certificate, or preshared key.

If you define NGFW Engines as LDAP clients for
the external directory server, the NGFW Engine
can send the user name and password to the
external directory server for authentication. The
external directory server checks the user name
and password against the user’s credentials in
the external directory server, then replies to the
NGFW Engine whether authentication succeeded
or failed.

You can optionally define the Management Server
as an LDAP client for the external directory server.
You can also duplicate and manually maintain
the same user information separately in the
Management Server’s internal user database and
in the external user database.

Otherwise, you can create a single User element
named *external* to represent all externally
stored users. In this case, it is not possible to
create different rules for different externally
stored users. Each authentication rule includes
all external users. There can be several rules, but
any user that can authenticate in one rule can
also authenticate when any of the other rules is
triggered.

Any authentication method supported by the
external authentication server can be used.

Related concepts
Getting started with user authentication on page 1097

How internal user databases work
The Management Server includes an integrated LDAP directory for storing user information.

The Management Server’s internal user database can be used for authenticating users with passwords. Using an
internal LDAP directory is the simplest choice when there is no specific need to have an external LDAP server.

When the Management Server’s internal LDAP directory is used, the user and user group information is stored on
the Management Server. Each firewall node stores a replica of the user database, and any changes to the main
database are replicated immediately to the firewalls. This way, the firewalls can access their local directories
instead of constantly communicating user information over the network.

Note:  It is not possible to give external components (such as external authentication servers)
access to the Management Server’s internal LDAP directory.

If Domain elements have been configured, the Internal LDAP directory belongs to the Shared Domain. This
means that the administrators who log on to some other Domain are allowed to view the contents of the Internal
LDAP directory. If all user information should not be available to administrators in all Domains, you must use an
external LDAP directory in each Domain.
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Directory server configuration overview
User information is stored in an internal or an external LDAP (Lightweight Directory Access Protocol) directory.

The standard LDAP user management model consists of three different levels: LDAP domains, user groups, and
users. All three levels are represented as elements in the Management Client.

Follow these general steps to configure the directory server:

1) (Optional) Integrate an external LDAP directory server:

a) Define an LDAP Server or Active Directory Server element. The Active Directory Server element also
contains the settings for NPS authentication; generic LDAP Server elements define a directory server
only.

b) (Optional) Define an LDAP Domain.

2) Define the User Group and User information:

a) Import existing user information from some other Management Server.

b) Create new accounts or edit accounts stored in an external LDAP database.

Integrating external directory servers
You can use an external directory server to store user group and user information instead of or in addition to the
internal user database.

The external directory server can be an LDAP server, or a Microsoft Active Directory server that provides LDAP
services.

You can use an external directory server without integrating it with the SMC components. You can view user
information and use it for authentication against an external authentication service simply by allowing the SMC
components to connect to the LDAP database.

The Management Server and the NGFW Engines each use their own integrated LDAP client to query the
external LDAP directory directly. The external LDAP directory is not replicated into the internal directory on
the Management Server or into the local directory of the NGFW Engines. Instead, the external LDAP directory
is queried separately each time by the NGFW Engines each time a user attempts to authentication. The
external LDAP directory is also queried separately Management Server when you view the User elements in the
Management Client.

You can configure access to the directory server for both the Management Server and the NGFW Engines, or
for the NGFW Engines only. To take full advantage of user authentication features, we recommend configuring
access to the directory server for both the Management Server and the NGFW Engines.

Configuring access to the external directory server for both the NGFW Engines and the Management Server
allows the following:
• There is no need to manually duplicate user account information. User and User Group elements are

automatically added to the SMC from the external directory.
• Externally stored user accounts are shown in the Management Client and can be used to create different rules

for different users.
• In most cases, users can be also added, removed, and edited through the Management Client.
• Internal authentication methods can be used to authenticate externally stored users.
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If only the NGFW Engines can access the external directory server, the following restrictions apply:

• You can authenticate externally stored users only against authentication methods provided by an external
authentication server. Internal authentication methods are not available for externally stored users.

• A single element (User element named *external*) is used to represent all externally stored users in the
Firewall Policy. It is not possible to create different rules for different externally stored users.

Configuring schema files on external directory
servers
A schema file defines the attributes (individual pieces of data) that an account can contain.

Updating the external server’s schema with SMC-specific attributes is optional. Updating the schema also allows
you to add SMC-specific information to Users and User Groups through the Management Client.

You must update the schema file in the following cases:

• To be able to configure authentication requirements for specific Users or User Groups. Otherwise, you can
configure authentication only at the LDAP domain level.

• To use the User password authentication method to authenticate users using user names and passwords.
Alternatively, you can use the LDAP Authentication authentication method to authenticate users using user
names and passwords without updating the schema.

• To be able to edit information in the LDAP directory through the Management Client.

The method of configuring Schema files varies depending on which LDAP server you are using. The Schema
update is done outside the Management Client. In general, the schema update means that you add the SMC-
specific attributes to the existing user information on the external LDAP server. These include attributes for the
SMC-specific user name, password, and allowed authentication methods for the user.

Create LDAP Server or Active Directory Server
elements
If you want to use an external directory server, you must create an element to define the parameters for
contacting the server and the LDAP object classes.

You define the directory parameters in an LDAP Server element. If you are using an Active Directory server, you
can define both the directory and the authentication parameters in the same Active Directory Server element. If
you use administrative Domains, use a separate external LDAP Server or Active Directory Server in each Domain
to create user accounts that are specific to each Domain.

Create Active Directory Server elements
The Active Directory Server element contains both the user database and authentication service options for using
a Microsoft Active Directory server to store and authenticate users.

The settings in the Active Directory Server element can optionally include an account that the Management
Server and NGFW Engines use to connect to query the directory. The user account must exist in the Active
Directory Server’s user database. Make sure the account you use has the permissions to manage other user
accounts. The NGFW Engines and Management Server can also connect to query the directory without a user
name and password if the Active Directory Server allows anonymous bind requests.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Setting up directory servers | 1080

There are also values for some attributes that the Management Server and NGFW Engines look for in the
directory. We recommend that you do not use special characters or accented letters in the Distinguished Names
or user ID attributes. Currently, Active Directory has a limit of 160 characters for the Base DN, 24 characters for a
UID (user ID) and 64 characters for the OU (organizational unit).

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to User Authentication.

2) Right-click Servers, then select New > Active Directory Server.

3) On the General tab, configure the general settings.

4) (Optional) On the Advanced tab, add one or more secondary IP addresses for the server.
These IP addresses are included when the Active Directory Server element is used in rules, but SMC
components never use the addresses when initiating contact with the server.

5) (Optional) If you want the Active Directory Server to be monitored by the Log Server, configure the
monitoring settings on the Monitoring tab.

6) Click OK.

Related concepts
Define contact IP addresses on page 129

Related tasks
Create Location elements on page 129
Activate monitoring of third-party devices on page 236

Create LDAP Server elements
The LDAP Server element can be used to configure access to any LDAP server as a user database for the
Firewalls and the Management Server.

The settings in the LDAP Server element can optionally include an account that the Management Server and
NGFW Engines use to connect to query the directory.The user account must exist in the LDAP Server’s user
database. Make sure the account you use has the permissions to manage other user accounts. The NGFW
Engines and Management Server can also connect to query the directory without a user name and password if
the LDAP server allows anonymous bind requests.

There are also values for some attributes that the Management Server and Firewall engines look for in the
directory. We recommend that you do not use special characters or accented letters in the Distinguished Names
or user ID attributes. For character limits for these settings, see the documentation of your LDAP server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to User Authentication.
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2) Right-click Servers, then select New > LDAP Server.

3) On the General tab, configure the general settings.

4) (Optional) On the Advanced tab, add one or more secondary IP addresses for the server.
These IP addresses are included when the LDAP Server element is used in rules, but SMC components
never use the addresses when initiating contact with the server.

5) (Optional) If you want the LDAP Server to be monitored by the Log Server, configure the monitoring settings
on the Monitoring tab.

6) Click OK.

Related concepts
Define contact IP addresses on page 129

Related tasks
Create Location elements on page 129
Activate monitoring of third-party devices on page 236

Add LDAP object classes
If your Active Directory or LDAP server has LDAP object classes that are not defined in the SMC by default, add
those object classes to the LDAP Object classes.

This way, the existing classes on the Active Directory or LDAP server can also be used for authentication.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to User Authentication.

2) Right-click Servers and select New > LDAP Server, or right-click an existing LDAP Server element and
select Properties.

3) Click the Object Classes tab.

4) Enter the name of the User Object Class or Group Object Class and click Add.
The object class appears in the list.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Setting up directory servers | 1082

Configure LDAP attribute mapping
On the Attributes tab, you can define how attributes in the LDAP directory are mapped to user properties in the
SMC.

You might need to change or fill in these values according to the server’s configuration. Enter the same values for
the attributes that are defined in the LDAP Server’s schema file.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to User Authentication.

2) Right-click Servers and select New > LDAP Server, or right-click an existing LDAP Server element and
select Properties.

3) Click the Attributes tab.

4) Configure the Attribute settings.

Related concepts
Configuring schema files on external directory servers on page 1079

Add authentication methods to LDAP Server or
Active Directory Server elements
Authentication Methods specify the allowed authentication methods for the users stored on the Active Directory or
LDAP server.

You can optionally use LDAP authentication for simple password authentication against LDAP database on
the external directory server where user accounts are stored. When users authenticate to the NGFW Engine,
the NGFW Engine sends the user name and password to the external directory server for authentication. The
external directory server checks the user name and password against the user’s credentials in the directory, then
responds to the firewall whether authentication succeeds or fails.

Note:  Because the user name and password are sent through the LDAP connection, we
recommend using LDAPS or Start TLS when you use LDAP Authentication.

You can optionally use the Internet Authentication Service (IAS) in previous Windows Server versions or the
Network Policy Server (NPS) in Windows Server 2008 to authenticate end users. You must configure the IAS/
NPS as a RADIUS server, and define each Firewall engine that authenticates users as a separate RADIUS client
for IAS/NPS. Use the NDI addresses when you define Firewall Clusters as RADIUS clients for IAS/NPS. The
IAS/NPS must have access to user information in the Active Directory. The user accounts must have remote
access permissions. Set up the IAS/NPS as explained in the Microsoft Server documentation. The SMC does not
support the Message-Authenticator attribute option available in the IAS/NPS, and is not NAP-capable. Only PAP
authentication is supported.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) On the Authentication tab of the Active Directory Server or LDAP Server properties, configure the settings
according to the type of server.

2) Click OK.

Related tasks
Define Authentication Method elements for external servers on page 1105

Define LDAP domain elements
If you use an external LDAP directory for user management, you must create an LDAP Domain.

After the LDAP Domain is associated with the external server, the Management Server contacts the LDAP
directory server. You can then view and edit users and user groups through the Management Client.

Note:  If you use the Management Server's internal user database, the users and user groups are
always stored and managed in the default InternalDomain LDAP Domain.

You can select one LDAP Domain as the global Default LDAP Domain. You can also specify the default LDAP
domain for each NGFW Engine in the Engine Editor. Selecting a default LDAP domain allows users belonging
to that LDAP Domain to authenticate without specifying the LDAP Domain information. Users in other LDAP
Domains must specify their LDAP Domain whenever they authenticate themselves.

If you use administrative Domains, create a separate LDAP Domain in each administrative Domain to create user
accounts that are specific to each Domain. You can also use LDAP Domains in different administrative Domains
to point to different parts of the directory hierarchy in the same LDAP directory. The internal LDAP directory is
always in the Shared Domain, which makes its contents visible in all administrative Domains. You can select
one Default LDAP Domain in each administrative Domain. You can also select an LDAP Domain in the Shared
Domain as the Default LDAP Domain for all administrative Domains.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to User Authentication.

2) Right-click Users and select New External LDAP Domain.

3) In the Name field, enter a name for the LDAP Domain.
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4) Select Default LDAP Domain if this LDAP Domain is used for all authentication unless otherwise specified
in the IPv4 Access rules.

Note:  If the LDAP Domain you are creating is not the default LDAP Domain, users must type
in the domain name when they authenticate.

Only one LDAP Domain can be the default LDAP Domain. The previous default LDAP Domain is
automatically deselected.

5) Select a Server, then click Add to bind the LDAP Server to the LDAP Domain.

6) (Optional) On the Default Authentication tab, click Select to define the allowed authentication methods for
all accounts in this LDAP Domain.

Tip:  You can override the default setting by selecting different authentication methods in the
User Group or User properties.

We recommend that you set a default authentication method. If the authentication method is not defined yet,
you can return to this dialog box to complete the configuration after you create the authentication method.

7) Click OK.

Related tasks
Activate monitoring of third-party devices on page 236

Enabling access control by user
Access control by user lets you use User and User Group elements as the source or destination of rules to create
user-specific rules without user authentication.

You can use user-specific rules and user authentication rules to allow some user groups to access a service,
while otherwise requiring authentication for the same service.

Note:  User-specific rules do not replace user authentication. User-specific rules are a tool to
simplify the configuration of access control, and improve the end-user experience by allowing
transparent access to services. They are intended to be used for trusted users in a trusted
environment where strong authentication is not required.

Access control by user requires Forcepoint User ID Service or McAfee Logon Collector for transparent user
identification. The Forcepoint User ID Service and Logon Collector monitor logon events from the DC to associate
users with IP addresses. The Forcepoint User ID Service and McAfee Logon Collector also monitor logon events
from Microsoft Exchange Servers.

Note:  The Stonesoft User Agent is not supported in Forcepoint NGFW 5.9 or later. Use the
Forcepoint User ID Service or McAfee Logon Collector instead. McAfee Logon Collector is only
supported in Forcepoint NGFW version 5.8 or later.
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Related concepts
Getting started with editing policies on page 855

Integrate Forcepoint User ID Service with
Forcepoint NGFW
Integrating Forcepoint NGFW with Forcepoint User ID Service provides transparent user identification for access
control by user.

Before you begin
You have installed and configured the components that send the user, group, and IP address
information to the NGFW Engines. For information about integrating the Forcepoint User ID Service with
other Forcepoint products, see the document How to integrate Forcepoint User ID Service with other
Forcepoint products and Knowledge Base article 14100.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Management Client, create a Forcepoint User ID Service element.

a) Select  Configuration.

b) Browse to Other Elements > Engine Properties > User Identification Services.

c) Right-click User Identification Services, then select New > Forcepoint User ID Service.

d) In the Name field, enter a unique name for the Forcepoint User ID Service element.

e) In the IP Addresses field, enter the IP address of the server on which the Forcepoint User ID Service is
installed.

f) Enter the port for communication between the Forcepoint NGFW Engine and the Forcepoint User ID
Service server.

Note:  The default port number is 61613. Use the same port that is used in the Forcepoint
User ID Service configuration on the Forcepoint User ID Service server.

g) In the Monitored User Domains section, click Add to define an Active Directory domain from which the
NGFW Engine receives user information.

2) Enable TLS protection for the communication from the NGFW Engine to the Forcepoint User ID Service
server.

a) On the Certificate tab, click Select, then select a TLS Profile.

b) From the TLS Server Identity  drop-down list, select a TLS server identity.

https://support.forcepoint.com/KBArticle?id=000014100
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c) In the Identity Value  field, enter a value for the TLS server identity.

Note:  If the TLS server identity is Distinguished Name, SHA-1, SHA-256, SHA-512,
or MD5, click Fetch Certificate  to fetch the value of the TLS server identity from a
certificate.

3) Enable the Log Server to receive log data from the Forcepoint User ID Service.

a) On the Monitoring tab, select the Log Server that receives the log data from the Forcepoint User ID
Service.

b) (Optional) To receive status information from the Forcepoint User ID Service, select Status Monitoring,
then select a probing profile.

c) To receive log data from the Forcepoint User ID Service, select Log Reception, then select the logging
profile.
The logging profile defines in which log fields the log data from the Forcepoint User ID Service is stored.
If you create a new Logging Profile element that uses the default settings, all the log data is stored in the
Syslog message field.

4) Click OK.
The Forcepoint User ID Service element is created.

5) Select a Forcepoint User ID Service element for NGFW Engines.

a) Select  Configuration.

b) Right-click an engine, then select Edit <element type>.

c) Browse to Add-Ons > User Identification.

d) In the User Identification Service list, select a Forcepoint User ID Service element.
If the Forcepoint User ID Service element that you want to use is not listed, select Select, then select a
Forcepoint User ID Service element.

e) Click  Save and Refresh.

Next steps

If you want the Forcepoint User ID Service server to authenticate the NGFW Engine with the Management
Server's Internal Certificate Authority, export the certificate of the Management Server's active Internal Certificate
Authority.

Related tasks
Create Trusted Certificate Authority elements on page 137
Create TLS Profile elements on page 141
Export the active Internal Certificate Authority on page 140
Create Logging Profile elements on page 223
Create Probing Profile elements for monitoring third-party devices on page 234
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Integrate McAfee Logon Collector with
Forcepoint NGFW
Integrating Forcepoint NGFW with McAfee® Logon Collector provides transparent user identification for access
control by user.

Note:  McAfee Logon Collector is only supported in Forcepoint NGFW version 5.8 or later.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Logon Collector installation, generate or export a certificate for communication with the Logon
Collector.
For complete instructions, see the McAfee Logon Collector Administration Guide.

2) Save the certificate in a location that is accessible from the computer you use to run the Management Client.

3) In the Management Client, create a McAfee Logon Collector element.

a) Select  Configuration.

b) Browse to Other Elements > Engine Properties > User Identification Services.

c) Right-click User Identification Services, then select New > McAfee Logon Collector.

d) In the Name field, enter a unique name for the McAfee Logon Collector element.

e) In the IP Address field, enter the IPv4 address of the primary McAfee Logon Collector server.

Note:  The Port field contains the port number for communication between the Forcepoint
NGFW and the server. Do not change the port setting unless you must use another port
number.

4) (Optional) Complete the following fields in the High Availability section to configure the contact information
for connections to a secondary Logon Collector server.

Field Explanation

IP Address The IPv4 address of the secondary Logon Collector server.

Port The port number for communication between Forcepoint NGFW and the Logon
Collector server.

Note:  The default port number is 61613. Use the default port number
unless you must use a different port number.

5) Import the certificate for communication with the Logon Collector.

a) On the Certificate tab, click Import.

b) Select the certificate and click Open.
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6) Click OK.
The Logon Collector element is created.

7) Select a Logon Collector element for NGFW Engines.

a) Select  Configuration.

b) Right-click an engine, then select Edit <element type>.

c) Browse to Add-Ons > User Identification.

d) In the User Identification Service  list, select a Logon Collector.
If the Logon Collector that you want to use is not listed, select Select, then select a Logon Collector.

e) Click  Save and Refresh.

8) Export an SMC certificate for communication with the Logon Collector.

a) Select  Configuration, then browse to Administration.

b) Browse to Other Elements > Internal Certificate Authorities.

c) Right-click the internal certificate authority, then select Properties.

d) On the Certificate tab, click Export.

e) Save the certificate.

f) Click Cancel to close the properties of the internal certificate authority.

g) Import the certificate on the Logon Collector server.
For complete instructions, see the McAfee Logon Collector Administration Guide.

Select User Identification Service for NGFW
Engines
Select the User Identification Service for each NGFW Engine in the Engine Editor.

Each User Identification Service can be associated with one or more NGFW Engines, but only one User
Identification Service can be selected for each NGFW Engine.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click the NGFW Engine for which you want to select a Forcepoint User ID Service or a Logon Collector
element, then select Edit <element type>.

3) In the navigation pane on the left, browse to Add-Ons > User Identification.
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4) Select the User Identification Service element that this NGFW Engine communicates with.

CAUTION:  The Stonesoft User Agent is not supported in Forcepoint NGFW version 5.9
or later. Do not select a Stonesoft User Agent if the engine version is 5.9 or later. Use the
Forcepoint User ID Service or the McAfee Logon Collector instead. McAfee Logon Collector is
only supported in Forcepoint NGFW version 5.8 or later.

5) Click  Save.

Defining user accounts
User Group and User elements define the user account information for end users.

You can use User Group and User elements in Firewall IPv4 and IPv6 Access rules to add a requirement for
authentication. If you have integrated a Forcepoint User ID Service server or McAfee Logon Collector, you can
also use User Group and User elements as the source and destination of Access, Inspection, and NAT rules
without user authentication.

Note:  McAfee Logon Collector is only supported in Forcepoint NGFW version 5.8 or later.

Options for adding user accounts
If you are using the Management Server’s internal user database:

• If you have existing user accounts stored in an internal user database on another Management Server, you
can export or import the information between the databases.

• Otherwise, you must create the User Groups and Users individually.

If you are using an external directory server:

• If the LDAP database is integrated with the Management Server, you can view the user information in the
Management Client. However, for the accounts to be valid in Access rules, you must configure at least one
Authentication Method for the users. You can configure Authentication Methods as default settings for the
LDAP Domain and for the User Groups and Users.

• If the LDAP database is not integrated with the Management Server, the user accounts are not shown in the
Management Client and are not available for configuration.

Related concepts
Enabling access control by user on page 1084

Related tasks
Define LDAP domain elements on page 1083
Import user information on page 1092
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Create User Group elements
If you have many users, you might want to organize your users into several different User Groups.

You can organize the groups, for example, according to different services. A single user can belong to several
groups at the same time. You must have at least one User Group element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to User Authentication.

2) Expand the branch of the LDAP Domain that represents the correct user database. The default
InternalDomain LDAP Domain represents the internal database.

3) Right-click the parent group under the LDAP Domain (this is called stonegate for the internal database),
then select New > Internal User Group.

4) In the Name field, enter a name for the Internal User Group.

• The name is used as the common name (CN) for the group.
• The distinguished name (DN) is inherited from the LDAP Domain to which this Internal User Group

belongs.

5) (Optional) In the Expiration After field, enter a number of days after which the Internal User Group expires.
When the Internal User Group expires, it stays in the system but is invalid and does not allow authentication
until it is re-enabled.

6) Click the Authentication tab.

7) Click Add, then select one or more Authentication Methods.
If you select several Authentication Methods, you can restrict the Authentication Methods allowed for each
user in the User element properties and in Access rules that require authentication.

8) Click OK.

Create User elements
The User element defines who your users are and how they can identify themselves to get access to networks
and services as defined in your Firewall Access rules.

You create Users as members of a User Group. You do not have to specify all user parameters separately
for each individual User. A User that is a member of a User Group can inherit, for example, the Authentication
Method and account expiration time from the User Group. Each User Group must belong to an LDAP Domain.
We recommend creating a separate user account used for each user. Each user can belong to several User
Groups within the LDAP Domain. User-specific properties can override properties defined at the User Group
level.

You can import and export Users and User Groups through an LDIF file to or from some other Management
Server.
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Note:  Although you cannot edit User Group memberships in the User element properties, each
user can belong to several User Groups. After creating the User element, drag and drop it to other
User Groups to add more group memberships.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to User Authentication.

2) Browse to Users.

3) Add a user to a User Group in one of the following ways:
• Right-click a User Group and select New > Internal User (for the internal stonegate parent group).
• Right-click a User Group and select New Internal User (for a User Group under the internal stonegate

parent group).

4) In the Name field, enter a unique name to identify the User in the directory.
The name is used as the common name (CN) for the User. The distinguished name (DN) is inherited from
the LDAP Domain to which the User belongs.

5) (External directory only) Enter additional user information.

6) (Optional) Change the Activation settings for the user account.

7) Click the Authentication tab.

8) Click Add to select the Authentication Methods for the user.

• You can add more than one authentication method for each user. This way, you can put the User in
more than one User Group when the User Groups have different authentication methods.

• If you have not configured any Authentication Methods yet, you can create them in this dialog box.

9) Define the properties for the selected Authentication Method.

CAUTION:  Use strong passwords that are at least eight characters long and that contain
numbers, letters, and special characters. Do not base passwords on personal information
such as names, birthdays, ID numbers, phone numbers, street names, registration plate
numbers, or relatives’ names.

10) Click OK.

Result

The user account is created. If the user is stored in the internal LDAP database, the information is automatically
synchronized to the local databases on the Firewalls unless user database replication has been disabled.

Related concepts
Getting started with user authentication on page 1097
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Related tasks
Import user information on page 1092

Add Users to User Group elements
When you add a User to a group, they remain a member of the current User Group and also become a member
of the new group.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Drag and drop the User element to a User Group in the element tree.

Remove Users from User Group
elements

If Users do not belong in a User Group, remove them.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Browse to the User Group from which you want to remove the User.

2) Right-click the User element, then select Tools > Remove.
A confirmation message is shown.

3) To remove the user from the User Group, click Yes.

Import user information
You can import the user information from one Management Server’s internal LDAP user database to another
Management Server.

The internal LDAP user database is represented by the default LDAP Domain InternalDomain.

To be able to import user information successfully, the information must meet two conditions:
• The distinguished name (DN) must always be of type dn: cn=cn-of-the-user-or-group,dc=stonegate.
• All user groups must be directly attached under the dc=stonegate top-level group.
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Note:  The import feature is only meant for importing users exported from another Management
Server’s internal LDAP database. The import is not meant to work with other .ldif files.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > File > Import > Import Users.

2) Select the correct file, then click Import.
A new tab opens, showing the progress of the import.

3) When the import is finished, check the messages for any warnings before you close the tab.
If warnings were displayed, select  Configuration, then browse to User Authentication > Users >
InternalDomain to check the properties for those Users or User Groups.

Export user information
You can export the user information stored in the internal user database on one Management Server to an .ldif
file, to transfer it to another Management Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to User Authentication.

2) Browse to Users > InternalDomain.

3) Right-click InternalDomain and select Export Users.

4) Select the location, enter the file name, and click Export.
A new tab opens showing the progress of the export.

5) When the export is finished, check the messages for any warnings before you close the tab.

Change user passwords
If you use LDAP password authentication, you can reset and change a user’s password as necessary.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to User Authentication.
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2) Browse to Users and then to the correct LDAP Domain and User Group.

3) Right-click the User element and select Tools > Change Password.

4) In the New Password and Confirm New Password fields, enter and confirm the password.

5) Click OK.
The new password becomes valid immediately.

Remove the authentication settings of a
user

If you need to revoke a user's access rights quickly, you can remove all authentication settings of a user without
deleting the user.

For example, you might want to remove the authentication settings of a user if the user’s account has been
compromised.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to User Authentication.

2) Browse to Users, then to the correct LDAP Domain and User Group.

3) Right-click the User element, then select Tools > Clear Authentication Attributes.

4) In the Confirmation message, click Yes.

Reset a firewall engine's local user
database

You can replace the firewall’s local copy of the user database with a copy of the internal user database on the
Management Server.

If you use the internal user database of the SMC, the user information is stored centrally on the Management
Server. When changes are made, they are incrementally replicated to each firewall node to guarantee fault-
tolerant authentication. If necessary, you can perform a full synchronization manually.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Setting up directory servers | 1095

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall or individual nodes of a Firewall Cluster and select Commands > Reset User
Database.

2) Click Yes in the Confirmation message.
The node’s local copy of the user database is replaced with a copy of the internal user database on the
Management Server.

Set user database replication on or off
for Firewalls and Master NGFW Engines

The internal user database on the Management Server is replicated automatically to Firewall engines and Master
NGFW Engines.

The engine uses the local copy of the internal user database to authenticate users without a connection to the
Management Server. If you have a reason to do so, you can turn off the replication.

CAUTION:  If you want to prevent users from authenticating, remove the authentication settings of
a user instead of turning off the replication. Turning off the replication prevents any new users you
add after the operation from authenticating, but might not prevent existing users from doing so.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Single Firewall, Firewall Cluster, or Master NGFW Engine and select or deselect Options >
User DB Replication.

Related tasks
Remove the authentication settings of a user on page 1094
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Examples of Directory Servers
These examples illustrate some common uses for Directory Servers and general steps on how each scenario is
configured.

Example: using the internal user database
This scenario shows an example of separating users into groups for accessing different resources.

Company A has a general office network and a separate HR network for servers that contain HR information,
such as employee records and payroll information. The servers already restrict which users have access. For
auditing reasons, the administrators want to separate the users into groups and require authentication to access
the HR network. The administrators:

1) Create a User Group “HR Users” in the InternalDomain and assign one of the default internal authentication
methods.

2) Create User elements for each person with access rights under the HR Users group.

3) Define Access rules for user authentication on the firewall.

Example: integrating Microsoft Active
Directory Servers
This scenario shows an example of integrating Microsoft Active Directory servers.

For more information about configuring the Network Policy Server (NPS), see Microsoft’s documentation at
http://technet.microsoft.com.

Company B has an existing Microsoft Active Directory server that stores user information. They decide to
integrate this existing server’s directory services.

The administrators:

1) Define an Active Directory Server element.

2) Add the SMC-specific classes and attributes into the Active Directory server’s configuration to be able to fully
manage the user accounts through the Management Client.

3) Define the Management Server as an LDAP client for the Active Directory server.

4) Define the Firewall as an authentication client for the NPS.

5) Add an LDAP Domain element for the Active Directory server in the Management Client.

http://technet.microsoft.com
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 CHAPTER 66

Setting up user authentication
Contents

• Getting started with user authentication on page 1097
• Integrating external authentication services on page 1100
• Define IPv4 Access rules for authentication on page 1106
• Enable browser-based user authentication on page 1108
• Configure client certificate authentication for browser-based user authentication on page 1115
• Authenticate to firewalls or virtual firewalls on page 1117
• Customize the User Authentication Pages for browser-based user authentication on page 1118
• Monitoring and testing user authentication on page 1120
• Examples of user authentication on page 1120

You can implement user authentication to control which resources different end users can access. You can use
authentication as an access requirement in IPv4 Access rules in Firewall Policies. You can use both internal and
external user authentication servers.

Getting started with user authentication
User authentication means requiring the users to prove their identity before giving access to a network resource.

Authentication requires a user database that stores the user information and an authentication method that
inspects credentials and grants or denies access.

You can use the following kinds of authentication methods:

• The firewall's internal authentication methods
• Authentication methods provided by external RADIUS or TACACS+ authentication servers, such as NPS or

RSA Authentication Manager (SecurID)
• LDAP authentication for simple password authentication against the LDAP database on an external LDAP

server or Active Directory server

Alternatively, if strong authentication is not required, you can allow specific users to access services in a trusted
environment without requiring user authentication.

User authentication proceeds as follows:

1) The user opens an authentication connection to the firewall.

2) The firewall checks if the user exists and which authentication method the user can use.

3) The user-supplied credentials are verified.
• When you use the firewall's internal authentication methods, the firewall checks user credentials against

its own replica of the user database.
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• When you use authentication methods provided by an external server, the external server verifies the
user's credentials, then responds to the firewall whether authentication succeeds or fails.

4) If authentication succeeds, the firewall lists the user as an authenticated user, taking note of both user name
and authentication method.

5) When the user opens new connections, IPv4 Access rules that contain an authentication requirement can
now match. The user name and authentication method are both separately checked as matching criteria.

6) When the configured timeout is reached, the authentication expires and the user is removed from the list of
authenticated users. Access rules that require authentication no longer match the user’s connections.

With user authentication, you can:
• Maintain separation of internal networks that have different security levels when the confidentiality of the

information that is accessed does not need to be strictly enforced. For example, user authentication can
provide an extra access control measure for applications that already exchange information securely.

• Allow secure and confidential access from any location to any internal resources for Stonesoft VPN Client
users.

• Authenticate Administrator and Web Portal User logons.

The following limitations apply to user authentication:
• User authentication is only supported on Firewalls. User authentication is not supported on layer 2 physical

interfaces on Firewalls.
• Only IPv4 addresses are supported in user authentication. All elements used in user authentication must have

an IPv4 address.

Note:  RADIUS authentication servers that are used to authenticate administrators support
IPv6 addresses.

Related concepts
Integrating external directory servers on page 1078
Enabling access control by user on page 1084

Related tasks
Authenticate administrators using RADIUS or TACACS+ methods on page 368

Default elements for user authentication
There are predefined Authentication Method elements for user authentication on the firewall and for external user
authentication.

There are four predefined Authentication Method elements for user authentication on the firewall.

• Client Certificate is for certificate-based authentication.
• LDAP Authentication is for simple password authentication against LDAP databases on external LDAP or

Active Directory servers.
• Pre-Shared Key Method is for use with some third-party VPN clients.
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• User Password is for simple password authentication against the internal LDAP database, including user
authentication in Stonesoft VPN Client hybrid authentication.

To use the firewall for user authentication, you must use one of the predefined Authentication Method elements.

There are three predefined Authentication Method elements for use with RADIUS Authentication Server or
TACACS+ Authentication Server elements.

• Network Policy Server is for use with an external Network Policy Server (NPS) server.
• Pre-Shared Key Method is for use with some third-party VPN clients.
• User Password is for simple password authentication against the internal LDAP database.

User authentication configuration overview
Authentication methods define the authentication method used by particular users and user groups.

The following illustration shows how user authentication elements are configured.

 
Figure 157: Elements in the configuration
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1 User

2 Authentication Method

3 Active Directory Server, LDAP Server, RADIUS Authentication Server, or TACACS+ Authentication
Server

4 Firewall Policy

5 User Group

External RADIUS or TACACS+ authentication servers are configured as RADIUS Authentication Server or
TACACS+ Authentication Server elements. RADIUS or TACACS+ authentication servers can be located in
any network that allows them to communicate with the firewall that has an authentication rule in its policy.
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Authentication Method elements are associated with authentication servers to define the allowed authentication
methods for the server, or the servers that use a particular authentication method.

Authentication Method elements define the allowed authentication methods for IPv4 Access rules and for the
Users and User Groups. Both User and User Group elements can be used in IPv4 Access rules to define rules
that only match connections from specific, successfully authenticated users. A specific Authentication Method
definition is needed in each IPv4 Access rule especially when the Users and User Groups have several allowed
Authentication Methods. Otherwise, the rules can allow any defined Authentication Method that is allowed for the
included users.

Follow these general steps to configure user authentication:

1) (Optional) Create server elements and Authentication Method elements for external authentication services.

2) Add an authentication requirement to the relevant IPv4 Access rules.

3) (Stonesoft VPN Client authentication) Install the Stonesoft VPN Client software on the users’ computers. See
the Stonesoft VPN Client documentation for more information.

4) (Browser-based Authentication) Configure the authentication prompt:
• Enable users to authenticate using a browser-based authentication prompt.
• Customize the authentication prompt.

Related concepts
Integrating external authentication services on page 1100

Related tasks
Define IPv4 Access rules for authentication on page 1106
Enable browser-based user authentication on page 1108
Customize the User Authentication Pages for browser-based user authentication on page 1118

Integrating external authentication
services

An external authentication server can be any server that supports either the RADIUS or the TACACS+ protocol,
including Microsoft Active Directory servers.

Active Directory Server, RADIUS Authentication Server, and TACACS+ Authentication Server elements
define the settings necessary for connecting to an external authentication server.

Authentication Method elements define the allowed authentication methods for the server, or the servers that
use a particular authentication method.

In addition to the server element configuration in the Management Client, you must configure the external
authentication server to allow the firewalls to use the authentication services.
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Overview of external user authentication
External user authentication means that authentication services are provided by an authentication server outside
of the SMC.

You can use the following kinds of external authentication services:

• Authentication services that support the RADIUS or TACACS+ protocol, such as RSA Authentication Manager
or the NPS (Network Policy Server) of a Windows (Active Directory) server.

• LDAP authentication for simple password authentication against the LDAP database on the external directory
server where user accounts are stored.

User authentication is only supported for IPv4 traffic.

Note:  RADIUS authentication servers that are used to authenticate administrators support IPv6
addresses.

External user authentication proceeds as follows:
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Figure 158: External user authentication process
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1 The user opens an authentication connection to the firewall.

2 The firewall queries the directory server to check if the user exists and which authentication method the
user should use.

3 The firewall prompts the user to authenticate, then the user enters the credentials required for the
authentication method.

4 The firewall relays the user credentials to one of the following components depending on the
authentication method:
• For RADIUS or TACACS+ authentication methods, the firewall relays the user credentials to the

external authentication sever.
• For LDAP authentication, the firewall relays the user credentials to the directory server.

5 Depending on the authentication method, one of the following components verifies the user credentials
and responds to the firewall whether authentication succeeds or fails:
• For RADIUS or TACACS+ authentication methods, the external authentication server verifies the

user credentials.
• For LDAP authentication, the directory server verifies the user credentials.

Directory servers for external user
authentication
Storing the user information and authenticating the users are two separate concepts with separate options

You can use the same server for storing and authenticating the users, such as when you use a Microsoft Active
Directory server or an LDAP server for both tasks.

To define different IPv4 Access rules for different users and user groups with external authentication, you must
integrate an external directory server with the SMC.
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It is also possible to use an external authentication server without integration of an external directory server. In
this configuration, the user information is not available to the firewall. You cannot add different IPv4 Access rules
for different users and user groups. Instead, you add the user *external* with the external authentication methods
into the internal user database, and use it to define IPv4 Access rules for authentication.

Related concepts
Getting started with directory servers on page 1075

Using RADIUS in user authentication
Remote Authentication Dial-in User Service (RADIUS) is a protocol for carrying authentication, authorization, and
configuration information.

RADIUS is a widely supported standard. For example, Microsoft NPS and RSA Authentication Manager support
the protocol and can be used for user authentication in the SMC.

RADIUS uses UDP as its transport protocol. The exchanges between the client and the RADIUS server are
authenticated by using a shared secret, which is never sent over the network. User passwords transferred
between the client and the RADIUS server are encrypted using the MD5 message digest algorithm. The rest of
the RADIUS communications are in cleartext.

Servers that provide RADIUS-based authentication methods can also be used for authenticating administrators’
Management Client logons and wireless client connections to wireless interfaces on firewalls.

RADIUS authentication servers that are used for user authentication only support IPv4 addresses. RADIUS
authentication servers that are used to authenticate administrators support both IPv4 and IPv6 addresses.

Using TACACS+ in user authentication
Terminal Access Controller Access Control System Plus (TACACS+) is a protocol used for similar purposes as
RADIUS.

In general, TACACS+ provides a more secure method of user authentication than RADIUS. TACACS+ uses
TCP as the transport protocol instead of UDP, so transport is more reliable and less sensitive to disruption at the
network layer.

TACACS+ also separates authentication, authorization, and accounting services, whereas RADIUS provides
a user profile defining all user-specific parameters with the authentication. This separation of services allows
TACACS+ to use other forms of authentication, such as Kerberos, together with its own authorization.

TACACS+ uses a pre-shared key to authenticate exchanges. TACACS+ encrypts all traffic between the
authentication server and the device requesting authentication. User information, such as IDs and passwords, are
secured with the MD5 message digest algorithm.

Using LDAP authentication
When you use LDAP authentication, the external directory server where user accounts are stored verifies the
user credentials.

When users authenticate to the NGFW Engine, the NGFW Engine sends the user name and password to the
external directory server for authentication. The external directory server checks the user name and password
against the user’s credentials in the directory, then responds to the NGFW Engine whether authentication
succeeds or fails.

Note:  Because the user name and password are sent through the LDAP connection, we
recommend using LDAPS or Start TLS when you use LDAP Authentication.
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You can use LDAP authentication with the following features:

• IPsec and SSL tunnels in mobile VPNs
• The SSL VPN Portal
• Browser-based user authentication.

LDAP authentication has the following limitations:

• You cannot use LDAP authentication for users stored in the Management Server’s internal LDAP user
database.

• LDAP authentication is not supported for the WPA enterprise security mode on SSID Interfaces.

Note:  WPA enterprise security mode always requires an external RADIUS server that has
EAP support.

User authentication methods
Authentication Method elements define the authentication method used by particular authentication servers, and
by particular users and user groups.

The SMC supports many third-party authentication methods. You can integrate third-party authentication
products with the SMC through the RADIUS and TACACS+ protocols.

The following authentication methods can be used:

• User passwords stored in internal or external LDAP databases.
LDAP authentication is used for simple password authentication against external LDAP databases.

• Client certificates.
• Pre-shared keys (for use with some third-party VPN clients).
• External authentication provided by servers that support the TACACS+ (Terminal Access Controller Access

Control System Plus) protocol.
• External authentication provided by servers that support the RADIUS (Remote Authentication Dial-in User

Service) protocol.

Create RADIUS or TACACS+ Authentication
Server elements
You can authenticate end-user access through Firewalls and administrator’s logons to the SMC against external
authentication servers that support either the RADIUS or TACACS+ protocol.

RADIUS servers support both IPv4 and IPv6 addresses.

• User authentication is only supported for IPv4 traffic.
• Authentication of administrator logons is supported for both IPv4 and IPv6 traffic.

TACACS+ servers only support IPv4 addresses.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to User Authentication.
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2) Right-click Servers and select New > RADIUS Authentication Server or New > TACACS+ Authentication
Server.

3) Configure the settings on the General tab.

4) (Optional) Click the Secondary IP Addresses tab and add more IP addresses.
These IP addresses are only used in Access rules and routing. Firewalls always use the main IP address of
the RADIUS or TACACS+ authentication server when they contact the authentication server.

5) (Optional) If you want the RADIUS or TACACS+ authentication server to be monitored by the Log Server,
click the Monitoring tab and configure the monitoring settings.

6) Click OK.

7) Configure the RADIUS or TACACS+ authentication server to accept connections from your Firewall engines:

• Make sure that the shared secret is entered identically in the Management Client and on the RADIUS or
TACACS+ authentication server.

• The identity that the Firewall provides to the server is the IP address of the interface that has been
selected as the value for the Identity for Authentication Requests in the Firewall’s Interface Options.

Note:  The IP address used as the identity is a name only. The interface and IP address
used for the authentication-related connections is selected based on the Firewall’s routing
information just like for any other connection.

Result

The connections to RADIUS or TACACS+ authentication servers are allowed in the predefined Firewall Template.
Make sure your IPv4 Access and IPv4 NAT rules for user authentication are configured correctly for these
connections.

Related concepts
Define contact IP addresses on page 129

Related tasks
Create Location elements on page 129
Activate monitoring of third-party devices on page 236

Define Authentication Method elements for
external servers
Authentication Method elements represent the types of authentication provided third-party external authentication
servers in user properties and IPv4 Access rules.

You can use the following predefined Authentication Method elements without configuring a custom
Authentication Method element:

• Network Policy Server — This Authentication Method for NPS is automatically used for authentication with
Microsoft NPS and Active Directory.
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• LDAP Authentication — You can use this Authentication Method in the properties of LDAP Server or Active
Directory Server elements that provide simple password authentication against the external LDAP database.

To use other external authentication servers, or to use an Active Directory server for RADIUS-based
authentication, you must define custom Authentication Method elements.

Each Authentication Method element can be associated with one or more servers, but each RADIUS
Authentication Server or TACACS+ Authentication Server can only be associated with one Authentication Method
element. When multiple servers are associated with the same Authentication Method element, the servers are
used as alternative servers if the first contacted server does not respond. All servers associated with the same
Authentication Method element must contain identical information for each authenticating user. It is not possible
for the user to determine which of the alternative servers is contacted.

Authentication Method elements are used in the following configurations:
• In directory server element properties and in User and User group properties to specify the allowed

authentication methods for the users.
• In the properties of a RADIUS or TACACS+ Authentication Server, or an Active Directory Server to specify the

authentication method offered by the server.
• In the IPv4 Access rules to specify which authentication method users are required to use.

The RADIUS and TACACS+ protocols are generic communications protocols for user authentication. You can
use many different types of authentication methods that use the RADIUS and TACACS+ authentication protocols,
such as static passwords, one-time passwords, or any other user name/passcode-type authentication schemes.

Firewalls can also use the Internet Authentication Service (IAS) in previous Windows Server versions or the
Network Policy Server (NPS) in Windows Server 2008 to authenticate end users. If you use a Windows Server’s
IAS/NPS service for authentication, define Active Directory Server elements instead.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to User Authentication.

2) Right-click Authentication Methods, then select New Authentication Method.

3) In the Name field, enter the name, then select the authentication method Type.

4) Click Add, then select one or more RADIUS or TACACS+ Authentication Servers.

5) Click OK.

Define IPv4 Access rules for
authentication

The IPv4 Access rules in a firewall policy can be configured to match only when the user is authenticated.

In Firewall IPv4 Access rules, the Authentication cell specifies matching criteria for accessing a particular service
and for setting options for the authentication. Authentication rules can be used to require authentication to access
services and for authenticating VPN client users. With mobile VPNs, authentication is always mandatory. You can
also require authentication for non-VPN access. Mobile VPN user authentication does not require specific rules
for clients to authenticate. Browser-based authentication requires Access rules that allow access to the firewall
interface.
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CAUTION:  Only a VPN guarantees confidential information exchange. A rule that only requires
authentication does not significantly increase the security of access from external networks to
internal networks.

The authentication settings in a rule are configured in the same way regardless of whether a VPN is used. You
define the authentication parameters in the Authentication cell.

 
Figure 159: Authentication field in the IPv4 Access rules

The User, User Group, and Authentication Method elements are only used as matching criteria. Any of the
other rules above or below the rule for authentication can also match the authenticated user’s connections. If
necessary, you can define rules that discard connections from some combinations of Users and Authentication
methods.

An authentication method is activated when at least one rule that contains the corresponding Authentication
Method element is installed on the firewall. The authentication is granted for a specific duration based on source
IP address.

After the user successfully authenticates, the firewall adds the user to a list of authenticated users. The
next connection that the user opens can match an Access rule that requires authentication if the user and
authentication method match the parameters of the rule.

Connections from users who have not successfully authenticated, or whose authentication has expired do not
match rules that require authentication. The connection matching continues to rules further down in the policy.

It is especially important to consider whether other rules might match VPN client connections. If necessary, you
can define rules that discard connections from some combinations of Users and Authentication methods. You
can use the Source VPN cell in IPv4 Access rules to match VPN traffic or non-VPN traffic. The VPN Client can be
configured to receive an IP address from the organization’s internal IP address space.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the Firewall Policy for editing.

2) Add an IPv4 Access rule, then define the Source, Destination, and Service.

3) Right-click the Action cell and select the action:
• Select Allow to create a rule that allows access to a particular service.
• Select Use VPN if you want to direct connections into a VPN.

4) Double-click the Authentication cell.

5) On the Users tab, select the Users or User Groups that this rule applies to.

6) On the Authentication Methods tab, select the Authentication Methods or click Set to ANY to allow any
authentication method.
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7) Click OK to close the Authentication Parameters dialog box.

8) Install the policy to transfer the changes to the Firewall.

Related tasks
Enable browser-based user authentication on page 1108

Enable browser-based user
authentication

Browser-based user authentication allows end users to authenticate to a firewall or virtual firewall using any
standard web browser, or using external RADIUS or TACACS+ authentication servers.

End users usually authenticate through a VPN client, which requests the user to authenticate as needed. When
the VPN client is used, successful authentication opens a VPN tunnel.

End users can alternatively open an authentication page in a web browser. The end users can authenticate
using encrypted HTTPS connections as well as plain HTTP connections. Browser-based user authentication is
configured in the properties of the firewall. The IPv4 Access rules for allowing authentication connections are not
included in the Firewall Template Policy. You must add a rule that allows this traffic in the firewall’s policy. You
must also add IPv4 Access and Inspection rules to enable redirection of unauthenticated HTTP connections to
the logon page.

Related concepts
Getting started with basic policy-based VPN configurations on page 1197

Related tasks
Customize the User Authentication Pages for browser-based user authentication on page 1118

Enable browser-based user authentication on
the Firewall
Browser-based user authentication is configured in the properties of the Firewall.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall or Virtual Firewall, then select Edit <element type>.

2) In the navigation pane on the left, browse to Add-Ons > User Authentication.
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3) Select HTTPS to allow authentication using encrypted HTTPS connections and HTTP to allow
authentication using plain HTTP connections.

CAUTION:  Plain HTTP connections are unsecured and transfer the user name and
password in cleartext. Use encrypted HTTPS connections to avoid loss of sensitive
information.

4) (Optional) Change the port settings if you want to use a different port for the authentication interface.
You must use the same port settings when you define the IPv4 Access rules that allow the authentication
connections.

5) (Optional) Select Always Use HTTPS if the engine also listens on other ports and you want to redirect the
connections to the HTTPS port and enforce the use of HTTPS.
Example: The engine listens on port 80, but you want to redirect connections to port 443.

6) (Recommended) To prevent unauthorized access to resources, select the interfaces through which users
can authenticate to the Firewall or Virtual Firewall in the Listen on Interfaces section. Only interfaces that
have IPv4 addresses are supported.

7) From the User Authentication Page drop-down list, select a User Authentication Page element.
The User Authentication Page element defines the look of the logon page, challenge page, and status
page shown to end users when they authenticate.
If the User Authentication Page element you want to select is not listed, select Select, or select New to
create a User Authentication Page.

8) (Optional) Select Enable Session Handling to enable cookie-based strict session handling.
If the option is selected, the end user must keep the status page open. If the status page is closed or
cannot be refreshed, the connection is terminated.

9) (Optional) Select Refresh Status Page Every and define how often the status page is automatically
refreshed.

• The option is automatically selected when you select Enable Session Handling.
• If the option is selected, the end user must keep the status page open. If the status page is closed or

cannot be refreshed, the connection is terminated.

10) (Optional) In the navigation pane on the left, browse to Advanced Settings > Authentication, then
configure advanced settings for browser-based user authentication.
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Create and sign HTTPS certificates for
browser-based user authentication
If HTTPS is enabled for Browser-Based User Authentication, you must have a signed HTTPS certificate.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall or Virtual Firewall and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, browse to Add-Ons > User Authentication.

3) If HTTPS is not selected, select HTTPS.

4) Click HTTPS Settings.

5) Enter the certificate information.

6) Select how you want to sign the certificate:
• Select With External Certificate Authority if you want to create a certificate request for an external

Certificate Authority to sign.
• Select Internally with to sign the certificate using the Internal CA for Gateways of the SMC.

If more than one valid internal certificate authority is available, select which internal CA signs the
certificate request.

7) Click Generate Request.

8) (External certificate authorities only) When the certificate request is displayed, click Export and sign the
certificate with an external certificate authority.

9) Click Import Certificate to import the signed certificate.

10) Click OK to close the Certificate Request dialog box.

11) Click OK to close the Browser-Based User Authentication dialog box.

Add IPv4 access rules for browser-based user
authentication
Browser-based user authentication is not allowed by default in the Firewall Template policy. You must add a rule
that allows this traffic in the Firewall Policy.

To reduce the risk of resource consumption or DoS (denial of service) attacks, we recommend limiting the
number of connections from each source IP address. Under normal conditions, there should only be one
connection at a time from each source IP address. However, incomplete connections or other network errors
might temporarily result in more than one simultaneous connection attempt from the same IP address. Set the
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limit for your simultaneous connections according to your network environment so that the limit does not interfere
with legitimate connection attempts.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Firewall Policy and select Edit.
The policy opens for editing.

2) Add the following IPv4 Access rule:

Table 125: IPv4 Access rule for browser-based user authentication

Source Destination Service Action

ANY $$Local Cluster (CVI
addresses only) or $$Interface
ID X. (If specific listening
interfaces are selected on the
General tab in the Browser-
Based User Authentication
Properties.)

HTTP, HTTPS, or
both (Port settings
must be the same
as defined on the
General tab in the
Browser-Based
User Authentication
Properties.)

Allow
Connection tracking: Default

Connection limit by Source: the number
of simultaneous connection attempts you
want to allow

3) Install the policy to transfer the changes to the Firewall.

Enable redirection of unauthenticated HTTP
connections
To use Browser-Based User Authentication, you must define some IPv4 Access rules.

You must define the following IPv4 Access rules:

• An Access rule that allows all clients to access the logon page.
• An Access rule that allows authenticated users to establish HTTP connections.
• An Access rule that redirects unauthenticated HTTP traffic to the logon page.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the Firewall Policy for editing and add the following IPv4 Access rules:

Table 126: Example Access rules for unauthenticated HTTP connections

Source Destination Service Action Authentication

ANY IP addresses
of interfaces
through which
users can
authenticate.

HTTP

(Port settings must be the
same as defined on the
General tab in the Browser-
Based User Authentication
Properties.)

Allow

ANY IP addresses of
network services
that require
authentication.

HTTP Allow Users/User
Groups who
are allowed to
access services,
and appropriate
Authentication
Methods.

ANY IP addresses of
network services
that require
authentication.

HTTP Refuse

Connection tracking:
Default

Response: redirect to the
logon page.

2) Install the policy to transfer the changes to the engine.

Related concepts
User Response elements and how they work on page 945

Enable redirection to the original HTTP
destination
Add the necessary Access rules to configure the redirection of unauthenticated HTTP connections from the
status page to the HTTP destination that the user originally wanted to access.

You must define the following IPv4 Access rules:
• An Access rule that allows all clients to access destinations that do not require authentication.
• An Access rule that allows authenticated users to establish HTTP connections.
• An Access rule that redirects unauthenticated HTTP traffic to an Inspection rule.
• An Access rule that refuses all HTTP traffic.

Using the HTTP_Request-with-redirect-capability Situation, you must also define the following IPv4 Inspection
Exceptions in the Inspection Policy:
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• An Exception that permits all matching connections to access destinations that do not require authentication.
• An Exception that permits authenticated users to establish HTTP connections.
• An Exception that redirects unauthenticated HTTP traffic to the logon page using the original destination URL

as a parameter in the redirection.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the Firewall Policy for editing, then add the following IPv4 Access rules:

Table 127: Example Access rules for redirecting unauthenticated HTTP connections to the original
HTTP destination

Source Destination Service Action Authentication

ANY IP addresses of services that
do not require authentication.

HTTP

HTTPS

Allow

ANY ANY HTTP

HTTPS

Allow Users/User Groups who
are allowed to access
services, and appropriate
Authentication Methods.

ANY IP addresses of network
services that require
authentication.

HTTP Allow

Deep
Inspection:
on

ANY ANY HTTP Refuse

Note:  Deep Inspection must be enabled in the Access rules for redirecting unauthenticated
HTTP connections to the original HTTP destination. The redirection must be configured in the
Inspection Policy using the HTTP_Request-with-redirect-capability Situation.

2) Click  Save.

3) Open the Inspection Policy for editing.
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4) Add the following IPv4 Inspection Exceptions, then specify a User Response that redirects HTTP traffic
terminated by the Inspection rules to the URL of the logon page and onwards to the original HTTP
destination.

Table 128: Example Inspection Exceptions for redirecting unauthenticated HTTP connections to the
original HTTP destination

Situation Severity Source Destination Protocol Action

HTTP_Request-with-
redirect-capability

ANY ANY IP addresses
of services that
do not require
authentication

ANY Permit

HTTP_Request-with-
redirect-capability

ANY Users/User Groups
who are allowed to
access services,
and appropriate
Authentication
Methods.

ANY ANY Permit

HTTP_Request-with-
redirect-capability

ANY ANY ANY HTTP Terminate

Response: redirect
to the logon page,
including the original
URL as a parameter
in the redirection

5) Click  Save and Install to transfer the changes to the engine.

Related concepts
User Response elements and how they work on page 945
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Configure client certificate
authentication for browser-based user
authentication

In environments that require multi-factor user authentication, you can configure certificate-based authentication
using X.509 certificates for browser-based user authentication.

Before you begin
Before configuring client certificate authentication, configure the following:

• Integrate an external Active Directory server or LDAP server with the SMC.
• Enable browser-based user authentication.

Users can authenticate to the firewall using an X.509 certificate stored on their computers or on a smart card,
such as a Common Access Card (CAC). The NGFW Engine verifies that the certificate is valid and that the value
configured to be checked in certificate matches the value for the user in the LDAP server.

Note:  Enabling client certificate authentication prevents the use of user password authentication
in the same user session.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Create a TLS Profile element that defines the trusted certificate authority for the users' certificates.
Only users whose certificates are signed by the trusted certificate authority can successfully authenticate
using client certificates.

a) Select  Configuration, then browse to Administration.

b) Browse to Certificates > Other Elements > TLS Profiles

c) Right-click TLS Profiles, then select New TLS Profile.

d) In the Trusted Certificate Authorities section, select Trust Selected, then click Add to specify the
trusted certificate authorities that sign the users' client certificates.

e) Configure the other settings as needed, then click OK.

2) Configure client certificate authentication on the Firewall.

a) Right-click a Firewall or Virtual Firewall, then select Edit <element type>.

b) In the navigation pane on the left, browse to Add-Ons > User Authentication.

c) Next to the TLS Profile field, click Select, then select the TLS Profile element that you created.

d) In the navigation pane on the left, browse to Advanced > Authentication.
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e) From the Client Certificate Identity Field for TLS drop-down list, select the client certificate field that is
used to look up the user entry from the user domain.

f) Configure the other advanced options as needed, then click Save.

3) If you selected Distinguished Name as the Client Certificate Identity Field for TLS, configure the Active
Directory Server or LDAP Server element for client certificate authentication.

a) Select  Configuration, then browse to User Authentication.

b) Select Servers.

c) Right-click the LDAP Server or Active Directory Server element, then select Properties.

d) On the Client Certificate tab, enter the name of the value in the distinguished name that is checked to
verify the client identity.
The supported values are CN, email, and UID.

e) Make sure that the value of the UserId field on the Attributes tab matches the attribute that contains the
specified user information.

• CN — The value of the UserId field on the Attributes tab must be CN.
• email — The value of the E-mail field on the Attributes tab must match the attribute that contains

the user's email address.
• UID — The value of the UserId field on the Attributes tab match the attribute that contains the user's

UID.

f) Click OK.

4) Enable client certificate authentication on the Firewall.

a) Right-click a Firewall or Virtual Firewall, then select Edit <element type>.

b) In the navigation pane on the left, browse to Add-Ons > User Authentication.

c) Next to the TLS Profile field, click Select, then select the TLS Profile element that you created.

d) Click Save and Refresh.
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Authenticate to firewalls or virtual
firewalls

Users can authenticate using a compatible VPN client or a web browser.

Before you begin
To use smart cards for authentication, you must have smart card reader hardware and software.

To use certificate files for authentication, you must save the certificates in a location that is accessible
from your web browser.

If the users are authenticating for VPN access, they must authenticate using a compatible VPN client.

CAUTION:  If users authenticate over an unsecured connection, use a one-time password
scheme to reduce the risk of unauthorized access.

Steps

1) Access the authentication prompt in one of the following ways:
• Follow the instructions for the VPN client about connecting and authenticating to the firewall.
• Enter the IP address and port of the Firewall to open an authentication page in a web browser.

2) To authenticate using a user name and password, enter the user credentials.
If you only enter your user name without specifying the LDAP domain, the Firewall assumes the default
LDAP Domain. If your user account does not belong to the default LDAP Domain, add the LDAP Domain to
the user name with an @-character as a separator.
For example, type “fred@mobileusers” for the user “fred” in the LDAP Domain “mobileusers.”

3) To authenticate using a client certificate, follow these steps.

a) If you have a smart card, insert the smart card into the smart card reader.

b) If there is more than one certificate on the smart card or on your computer, select the certificate to use
for authentication.

c) (Smart card only) Enter then PIN for the smart card if you are prompted to do so.
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Customize the User Authentication
Pages for browser-based user
authentication

You can customize the logon page, challenge page, and different status pages that are shown to end users when
they authenticate using a web browser.

The pages you define are the same for all user groups. The default HTML pages are stored as a .zip file and they
are included in dynamic update packages.

Export the default User Authentication Page for
browser-based user authentication
You can export a default User Authentication Page element and edit the HTML pages using any HTML editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Engine Properties > User Authentication Pages.
The default User Authentication Page elements are displayed in the right pane.

3) Right-click the default User Authentication Page element, then select Properties.

4) Click Export and save the .zip file under a different name.

5) Click Cancel to close the dialog box.

Customize the default HTML pages for
browser-based user authentication
You can use an HTML editor to edit the HTML pages.

For example, you can add images and CSS files to the default pages.

Steps

1) Decompress the exported .zip file to your computer.
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2) Open the HTML file in an HTML editor.

CAUTION:  The following fields and buttons must not be removed from the default HTML
files.

HTML file Required fields

Logon page The Username and Password fields, and the Login button.

Challenge page The Challenge Response field and the Login button.

Status page The Logged On, Connection Status, and Authentication Message fields.

Status Page With
Automatic Redirection

The Logged On, Connection Status, Authentication Message, and Your
original destination fields.

Status Page With Manual
Redirection

The Logged On, Connection Status, Authentication Message, and
Continue to Your Original Destination From This Link fields.

3) Compress the customized files into a .zip file.

Import the custom HTML pages for browser-
based user authentication
To use the customized HTML pages, you must create a custom User Authentication Page element and import the
custom files.

The HTML files are validated during the import to make sure that the HTML pages conform to basic HTML
standards.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Browse to Other Elements > Engine Properties.

3) Right-click User Authentication Pages and select New User Authentication Page.

4) Click Browse in the User Authentication Page Properties dialog box and select the .zip file that you
created.
The files are validated during import. The Name is detected automatically based on the name of the .zip file.

5) (Optional) Preview the HTML pages by clicking the preview options.
• Preview Login Page
• Preview Challenge Page
• Preview Status Page
• Preview Status Page With Automatic Redirection
• Preview Status Page With Manual Redirection
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6) Click OK.

Monitoring and testing user
authentication

You can find information about successful and failed user authentication attempts, as well as the system’s own
connections to external authentication servers in the logs.

You can also create reports based on this data. There is a separate view for monitoring the currently active
authenticated users.

If there are problems with integration with external components, you can activate more detailed diagnostics
logging for authentication.

Related concepts
Monitoring connections, blacklists, VPN SAs, users, routing, and SSL VPNs on page 203

Related tasks
Enable or disable diagnostics on engines on page 339

Examples of user authentication
These examples illustrate common uses for User Authentication and general steps on how each scenario is
configured.

Example: authenticating VPN client users
This scenario shows an example of restricting VPN access so that only specific users can access the secure
network.

Company A’s employees include several consultants who frequently work at customer locations, but also
remotely access Company A’s secure network. All users are stored in the Management Server’s internal
directory, and there is a separate User Group called Consultants for accounts belonging to the consultants. The
administrators have set up a mobile VPN for remote access. They want to allow all users to establish a VPN
tunnel to the office, but allow only users in the Consultants group to access the secure network.

The administrators:

1) Create a rule that establishes a VPN tunnel and allows users in the Consultants group to access the Secure
Network after successful authentication:
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Source Destination Service Action Authentication

DHCP
address
range for VPN
clients
Internal
Networks

Secure Network HTTP
SSH

FTP

Enforce VPN Consultants User Group
User Password
Authentication

• This rule allows any users in any directory that is defined in the SMC to authenticate to a VPN client if
their allowed authentication methods include User Password.

• This rule allows any user whose account is stored in the internal directory to use a VPN client to establish
a VPN tunnel to the office.

2) Create a rule to allow users who have established VPN tunnels to access the company’s internal networks
from the DHCP-assigned IP addresses for VPN clients:

Source Destination Service Action Authentication

DHCP
address
range for VPN
clients

Internal
Networks

ANY Allow

3) Transfer the policy to the firewall.

Example: integrating Microsoft Active
Directory Servers
A general overview of integrating Active Directory servers.

For more information about configuring the NPS, see Microsoft’s documentation at http://technet.microsoft.com.

Company B has an existing Microsoft Active Directory server that stores user information. They decide to use this
existing information for user authentication.

The administrators:

1) Define an Active Directory Server element.

2) Add the SMC-specific classes and attributes into the Active Directory server’s configuration to be able to fully
manage the user accounts through the Management Client.

3) Define the Management Server as an LDAP client for the Active Directory server.

4) Define the Firewall as an authentication client for the NPS.

5) Add an LDAP Domain element for the Active Directory server in the Management Client.

6) Add an IPv4 Access rule with authentication defined as shown here.

http://technet.microsoft.com
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Table 129: Example Access rule for NPS authentication

Source Destination Authentication

IP addresses of
authenticated hosts.

IP addresses of
network services that
require authentication.

Some User or User Group elements from the AD’s LDAP
Domain. Require authentication with “Network Policy
Server” Authentication Method.

Example: using SecurID authentication with
the Stonesoft VPN Client
This example shows a general overview of using SecurID authentication for the Stonesoft VPN Client.

For more information about using SecurID authentication, see RSA’s documentation at https://www.rsa.com.

Company C is about to introduce remote Stonesoft VPN Client access to their network. The administrators
decide to add one-time passwords with SecurID cards with their existing RSA Authentication Manager server that
already shares the user information with the company’s LDAP server.

 
Figure 160: Company C's authentication scheme

The administrators:

1) Create an Agent Host record for the Firewall in the RSA Authentication Manager server.

2) Configure a mobile VPN in the Management Client with the default Hybrid Authentication selected as the
authentication method for connecting clients.

https://www.rsa.com
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• Hybrid authentication is available for the Stonesoft VPN Client. Hybrid authentication requires the VPN
Gateway (the firewall) to authenticate users using a certificate. The users must provide the correct User
Name/Password combination (validated by the RSA Authentication Manager server in this case).

3) Create a RADIUS Authentication Server element.

4) Create a custom Authentication Method element for the server and name it “SecurID.”

5) Add the “SecurID” Authentication Method in the correct User and User Group elements (stored on the
existing external LDAP server).

6) Add IPv4 Access rules with both an authentication and a VPN requirement defined as shown here:

Table 130: Example Access rule for SecurID authentication

Source Destination Authentication Action

The virtual IP
address range
used on the virtual
adapters of the
Stonesoft VPN
Client.

IP addresses of
network services
that require
authentication.

Some User or User
Group elements.
Require
authentication
with “SecurID”
Authentication
Method.

“Use VPN” with the “Enforce” option.
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 PART XI
Virtual private networks

Contents

• Getting started with VPNs on page 1127
• Configuring VPNs on page 1145
• Basic policy-based VPN configurations on page 1197
• Managing VPN certificates on page 1221
• Reconfiguring existing VPNs on page 1237
• VPN client settings on page 1247

Forcepoint NGFW supports both policy-based and route-based VPNs (virtual private networks).
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 CHAPTER 67

Getting started with VPNs
Contents

• VPNs and how they work on page 1127
• IPsec protocol in VPNs on page 1132
• Authentication in IPsec VPNs on page 1134
• Supported encryption methods for IPsec VPNs on page 1137
• Configuring IPsec VPNs with external gateway devices on page 1140
• Logs related to VPNs on page 1141
• Using a dynamic IP address for a VPN endpoint on page 1141
• Using a NAT address for a VPN endpoint on page 1141
• Clustering and VPNs on page 1142
• Multi-Link and VPNs on page 1142

A VPN extends a secured private network over public networks by encrypting connections so that they can be
transported over insecure links without compromising confidential data.

VPNs and how they work
VPNs secure the communications through authentication, encryption, and integrity checking mechanisms.

• Authentication provides a way for the devices at both ends of the VPN to confirm the identity of the other
device. Authentication prevents malicious parties from obtaining confidential data or access by posing as a
legitimate host.

• Encryption scrambles the transmissions to prevent anyone from viewing the content, providing privacy for the
communications.

• Integrity checking detects whether packets have been changed in transit, which could be a sign of malicious
tampering or transmission errors.

Forcepoint NGFW provides two types of VPNs. The main difference between the two is how traffic is selected to
use the VPN:

• Policy-based VPNs are configured using Policy-Based VPN elements. The firewall Access rules define which
traffic is sent to the VPN and which traffic is allowed out of the VPN.

• Route-based VPNs are configured using the Route-Based VPN Tunnel elements. Any traffic that is routed to
firewall interfaces that are designated as endpoints for a VPN tunnel is sent into the VPN tunnel. If Access
rules allow the traffic, it is automatically sent through the tunnel to the peer endpoint.

Policy-based VPNs are recommended for the following uses:

• To create mobile VPNs with IPsec tunnels, SSL VPN tunnels, or both IPsec and SSL VPN tunnels.
• To create VPNs in which some gateways act as central gateways and other gateways act as satellite

gateways (for example, star topology and VPN hub topology).
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Route-based VPN tunnels are recommended for the following uses:

• To use VPN tunnels as paths in dynamic routing.
• To protect the integrity of dynamic routing communications that are sent through the Internet.
• To protect and route multicast streams through the Internet.

Limitations
The following limitations apply to VPNs:
• You cannot use the same VPN tunnel in several configurations for a single NGFW Engine. For example:

• You cannot use the same VPN tunnel in two policy-based VPNs.
• You cannot create two Route-Based VPN Tunnel elements that have the same endpoints.
• You cannot create a Route-Based VPN Tunnel element that uses the same endpoints that are used in a

VPN tunnel in a policy-based VPN.
• VPNs are not supported on layer 2 physical interfaces on Firewalls.
• VPNs are not supported on Layer 2 Firewalls.
• If your Forcepoint NGFW installation is configured in a restricted operating mode to comply with regulatory

requirements, some VPN options are not available to you.
• Version-specific limitations in supported features for different Forcepoint NGFW versions are listed in the

Release Notes for the versions you are using. The SMC automatically prevents the use of unsupported
settings based on engine version.

Related concepts
VPN configuration overview on page 1145
Getting started with basic policy-based VPN configurations on page 1197
SSL VPN configuration on page 1186
Configuring route-based VPNs on page 1180
Configuring IPsec VPNs with external gateway devices on page 1140

Related tasks
Use a policy-based VPN to encrypt tunnels in route-based VPNs on page 1184

How policy-based VPNs work
In policy-based VPNs, the Access rules determine which traffic is sent into the VPN tunnels.

Types of tunnels in policy-based VPNs
Policy-based VPNs can have two types of tunnels:
• IPsec tunnels — The IPsec protocol allows any IP traffic to be transported in the VPN regardless of which

higher-level protocol the traffic uses on top of the IP protocol. Hosts can communicate through the VPN as if it
was a normal link without the need for application-specific configurations on the gateway device. IPsec is part
of both the IPv4 and IPv6 standards. IPsec is defined in RFC 4301.

https://support.forcepoint.com/Documentation
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• SSL VPN tunnels — SSL VPNs use secure sockets layer (SSL) encryption to provide secure remote access.
With SSL VPNs, authenticated users establish secure connections to internal HTTP-based services through a
web browser or through a client application.
You can also use SSL VPN tunnels with the Stonesoft VPN Client in mobile VPNs.

You can use SSL VPN tunnels alone, IPsec tunnels alone, or both SSL VPN and IPsec tunnels together in the
same policy-based VPN.

Site-to-site and mobile VPNs
You can create VPNs between gateway devices or between a VPN client and a gateway device:

• A site-to-site VPN is created between two or more gateway devices that provide VPN access to several hosts
in their internal networks. Site-to-site VPNs are supported for IPv4 and IPv6 traffic.

• A mobile VPN is created between a VPN client running on an individual computer and a gateway device.
Mobile VPNs are supported only for IPv4 traffic.

 
Figure 161: Site-to-site and mobile VPNs

For mobile VPNs, we recommend using the Stonesoft VPN Client solution. Stonesoft VPN Client is available for
the following platforms:
• Android (SSL VPN only)
• Mac OS (SSL VPN only)
• Windows (IPsec or SSL VPN)

In mobile VPNs with IPsec tunnels, you can alternatively use a third-party IPsec-compatible VPN client. However,
third-party clients do not support all features offered by Forcepoint NGFW.

Note:  Most VPN clients that are a part of a vendor-specific VPN gateway solution are
incompatible with gateways from other vendors.

The following limitations apply to mobile VPNs:
• Mobile VPNs can only be created in policy-based VPNs.
• All mobile VPNs that you configure in Forcepoint NGFW must be valid for Stonesoft VPN Client even if you

use only third-party VPN client software.
• VPN clients cannot connect directly to firewalls that have a dynamic IP address.

Instead, VPN clients connect through a central gateway that forwards the connections to the non-compatible
gateways using a site-to-site VPN.
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How route-based VPNs work
Devices that provide VPN access are called VPN gateways. With route-based VPNs, you can create only site-to-
site VPN tunnels between gateway devices.

There are two general types of VPN gateways in the SMC:

• VPN Gateway elements are NGFW Engines that are managed by the Management Server and administrative
Domain you are currently connected to with your Management Client.

• All other gateway devices are External VPN Gateway elements. NGFW Engines that are managed by a
different Management Server or administrative Domain are also External VPN Gateway elements.

Due to the various authentication and encryption methods that the IPsec protocol supports, the number of
settings is rather high. To reduce configuration work, you can use reusable profiles for storing different types of
settings. These and other elements related to route-based VPN configurations are pictured in this illustration.
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Figure 162: Route-based VPN configuration example
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1 The NGFW Engine and External Gateway refer to a Gateway Profile element that contains information
about the capabilities of different types of gateways.

2 The NGFW Engine optionally refers to a Gateway Settings element that defines settings for advanced
VPN performance tuning.

3 The NGFW Engine has a Tunnel Interface element defined.
The Tunnel Interface refers to a Route-Based VPN Tunnel element.

4 The NGFW Engine has a VPN Gateway element defined.
One VPN Gateway is automatically created for each NGFW Engine in the Firewall/VPN role.

5 The Route-Based VPN Tunnel element refers to both ends of the VPN tunnel: the VPN Gateway and
External Gateway.
The Route-Based VPN Tunnel also refers to a VPN Profile, which contains the IPsec authentication
and encryption settings (IKE settings)

Limitations
It is not possible to create a mobile VPN tunnel using route-based VPN tunnels.
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IPsec protocol in VPNs
The IPsec protocol allows any IP traffic to be transported in IPsec VPNs regardless of which higher-level protocol
the traffic uses on top of the IP protocol.

Hosts can communicate through the IPsec VPN as if it was a normal link without the need for application-specific
configurations on the gateway device. IPsec is part of both the IPv4 and IPv6 standards. IPsec is defined in RFC
4301.

When traffic is sent through an IPsec VPN, the gateway or VPN client at the communication source contacts
the gateway at the communication destination to establish a VPN tunnel. The original packets are encapsulated
when they enter the tunnel, and de-encapsulated when they exit the tunnel at their destination. In between, only
the encrypted packets can be detected in the traffic. The hosts that communicate through the tunnel are not
aware of the VPN. Communications are sent through the tunnel as if the two gateways were connected directly to
each other.

Tunnel and transport modes
The IPsec protocol supports tunnel mode and transport mode for securing traffic.
• Tunnel mode encapsulates the complete original packet into a new IPsec packet and is meant for site-to-site

and mobile VPNs. IPsec tunnels in policy-based VPNs always use tunnel mode. Tunnels in route-based VPNs
can use tunnel mode.

• Transport mode does not encapsulate the packets into new IPsec packets. Instead, additional encapsulation,
such as Generic Routing Encapsulation (GRE) or IP in IP (IP-IP), is used to encapsulate the tunneled traffic.
Tunnels in route-based VPNs can use transport mode.

Security associations (SA) in IPsec VPNs
The settings that are used for a tunnel are stored in Security Associations (SA). There are two SAs for each
IPsec VPN tunnel: one for outgoing traffic, and another one for incoming traffic.

For any communications to be able to use the VPN, the gateways must construct and maintain the VPN tunnels.
The gateways negotiate which settings to use between each other. The gateways store this information so that it
can be used for handling the traffic throughout the lifetime of the VPN tunnel.

The term SPI (security parameter index) is sometimes used with SAs in IPsec VPNs. SPIs are used to identify
the SAs.

For security reasons, each SA has an expiration time. After the expiration time, the gateways discard the old SAs
and agree on new ones if there is still traffic going through the VPN.

Internet key exchange (IKE) in IPsec VPNs
SAs for IPsec VPNs are created in a process called the Internet key exchange (IKE) negotiations.

During the IKE negotiations, the VPN gateways negotiate the parameters to use, such as the encryption keys and
the authentication methods. This information is then stored in the SAs. Both IKEv1 and IKEv2 are supported with
Forcepoint NGFW.

The IKE negotiations consist of two phases:
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• Phase 1 — During the IKE SA negotiations, the gateways authenticate themselves to each other and establish
a secure (encrypted) channel for the IPsec SA negotiations. Authentication in IKE SA negotiations can be
done with signatures, or with pre-shared keys. These parameters are then stored in IKE SAs.

• Phase 2 — During the IPsec SA negotiations, the gateways select parameters for encrypting the traffic going
through the VPN tunnels. These parameters are then stored in IPsec SAs.

The IPsec SA negotiations are much faster than the IKE SA negotiations. Because IKE SA negotiations involve
heavy computation, it is common to configure the IKE SAs to expire less frequently than the IPsec SAs.

IKEv2 also provides support for IKEv2 Mobility and Multihoming Protocol (MOBIKE) protocol. MOBIKE enables
transparent recovery for VPN clients when the VPN clients change their IP addresses. For example, the
IP address can change when a laptop is connected to a different network while a VPN connection is open.
MOBIKE also allows the IP addresses associated with IKE SAs and IPsec SAs to change in a VPN Multi-Link
configuration. When a VPN client fails to connect to a gateway, it checks if another gateway address is available.
If the VPN client can connect using the new gateway address, the gateway’s IP address is updated in the IKE
SAs and the IPsec SAs. VPN traffic can continue uninterrupted. There is no need to renegotiate the SAs.

Perfect forward secrecy (PFS) in IPsec VPNs
PFS guarantees that the encryption keys for IPsec SA negotiations are created separately for each negotiation.

It is possible to configure the IKE SA negotiations to occur less frequently than IPsec SA negotiations to
improve performance. However, this arrangement is less secure than renegotiating both phases again, because
the IPsec SA negotiations generate encryption keys based on information from the IKE SA negotiations. To
improve security, you can activate PFS. When the encryption keys are created separately for each negotiation,
a compromised key can only be used to decrypt communications sent before the next IPsec SA negotiation.
Otherwise, compromising one key can potentially breach all communications between two IKE SA negotiations,
which cover a longer period.

Authentication header (AH) and encapsulating
security payload (ESP) in IPsec VPNs
After an IPsec VPN tunnel is established, any traffic going through the tunnel is sent either as Authentication
Header (AH) or Encapsulating Security Payload (ESP) packets.

• The IPsec AH protocol does not provide data encryption, so plain AH does not result in a VPN in the full
meaning of the word. Anyone who can intercept the packets in transit can see the transferred data. AH can be
used to provide authentication and data integrity in communications that do not need encryption.
There is rarely any need to use AH alone. AH alone can be used when no encryption is required for the data,
but ESP with Null encryption can also be used to achieve the same purpose.

• The IPsec ESP protocol provides authentication, encryption, and integrity checking, providing secure data
transfer. This protocol is what is usually meant with the term VPN, as the transferred data is hidden from
outsiders.
As a general guideline, use ESP for any normal VPN tunneling (data encapsulated in ESP payload).

• The IPsec standards also support a combination of ESP and AH. However, this option does not provide
significant security improvements in the type of VPNs the Forcepoint NGFW establishes.
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Authentication in IPsec VPNs
Authentication requires an exchange of information between the two authenticating parties. The exchange must
be done securely, so that the exchanged information is unusable, even if intercepted.

The confidentiality of authentication exchanges is most often achieved through digital signatures or through
encrypting the authentication messages with a pre-shared key.

• Digital signatures use a public-private key pair to sign messages. This method requires that digital certificates
signed by a mutually trusted certificate authority (CA) are present.

• VPN authentication with a pre-shared key does not require the presence of digital certificates. It requires the
exchange of a secret encryption key that is known by both communicating parties.

Both methods can be secure enough for VPNs if used correctly, but the security of the pre-shared key method
is much more dependent on administrator actions. If pre-shared keys are used for authentication, the keys must
be long and random to be sufficiently secure. The pre-shared key must be kept secret, since the security of this
configuration relies on the assumption that only the legitimate parties know the key.

Related concepts
Supported encryption methods for IPsec VPNs on page 1137

Supported authentication methods for IPsec
VPNs
Authentication verifies that the remote party is who they claim they are.

The IPsec standards mandate support for some options, but also allow other options to be provided by IPsec-
compatible products. RFC 4305 lists the IPsec standard requirements that all IPsec-compliant products must
follow.

Using pre-shared key (PSK) authentication
A pre-shared key is a string of characters that is used as an authentication key. You can use pre-shared keys for
site-to-site VPN authentication and with third-party VPN clients.

Both gateways create a hash value based on the pre-shared key and other information. The hash values are
then exchanged and verified to authenticate the other party. As its name suggests, the pre-shared key has to be
distributed beforehand to all devices that use it. Pre-shared keys must be transferred confidentially, since their
security benefit is immediately lost if the key is exposed to unauthorized parties.

The pre-shared keys must also be long and random to be secure. Short or predictable pre-shared keys can
be easily broken in brute-force attacks. Administrators must also remember to renew the pre-shared keys
periodically to maintain a high level of security. Forcepoint NGFW includes tools for generating sufficiently long,
random pre-shared keys for VPN components. The keys are automatically transferred to any NGFW Engines that
need them using the secure system communications channel.
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Using certificate-based authentication
You can use certificates for authentication in any IPsec VPN, and also with route-based VPNs.

In all site-to-site VPNs and in mobile VPNs with third-party VPN clients, you can select whether to use certificates
or a pre-shared key for authentication. With the Stonesoft VPN Client, the following types of authentication are
available:

• Hybrid authentication requires the presence of a valid certificate on the gateway and some other form of
authentication from the VPN client user.

• Certificate exchange authentication requires a certificate from both the gateway and the VPN client.

Certificates often provide better real-world security than pre-shared keys. Certificates only have to be renewed
at an interval of a few years, and have an automatic expiration mechanism that makes sure the certificate
is renewed. Certificate files cannot be compromised in transit, since they cannot be used without a private
encryption key. This illustration outlines the basics of how a certificate is generated.

 
Figure 163: VPN certificate creation

1 When a certificate request process is started, a private encryption key is generated and stored.

2 The certificate requester uses the private key to generate an encrypted certificate request that is
transferred to the certificate authority (CA).

3 The CA signs the encrypted certificate request, which validates the certificate.

4 The signed certificate is transferred to the original certificate requester.

5 The requester uses its stored private key to access the certificate.

The certificate creation is either automatic or manual:

• For VPN gateways, all steps can be automatic if the default internal certificate authority is used for signing
the certificate. If another certificate authority is used, the certificate request is exported from the SMC and the
signed certificate is imported back into the SMC as a file.

• For VPN clients, the certificate request file is created manually in the VPN client and transferred manually
to be signed by an internal certificate authority or another certificate authority. The signed certificate is then
transferred manually into the VPN client computer.

Private keys are always generated automatically. If the private key is lost (for example, due to a hardware failure),
any associated certificate becomes unusable and a new certificate has to be created. The private key is securely
and automatically synchronized between clustered firewall nodes to allow all nodes to use the same certificate.

Unlike pre-shared keys, certificates do not need to be distributed to all gateways in the VPN. Instead, the other
gateways are configured to trust the certificate issuer (the CA that signed the certificate), after which they trust
all certificates from that issuer. This trust relationship also allows renewing or re-creating the certificate on one
gateway without having to reconfigure the other gateways. Only certificates from trusted sources are accepted in
authentication. For this reason, VPN gateways must be configured to trust the certificate authorities that sign the
certificates that the other gateways use for authentication.
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Validity of certificates
Certificates are always valid starting from a specific date and time and expire at a specific date and time in the
future.

All components that use (or sign) certificates must have the correct time settings to avoid unexpected certificate
rejections. The Internal RSA CA for Gateways and the Internal ECDSA CA for Gateways of the Management
Server generate certificates that are valid starting immediately until three years from their creation.

Certificate revocation lists (CRL) can be used to cancel a certificate before it reaches its expiration. For example,
a certificate might be revoked if unauthorized parties have obtained a copy of both the certificate and the
associated private key. The Internal RSA CA for Gateways and the Internal ECDSA CA for Gateways do not
support certificate revocation lists. If you want to use CRLs, you must use an external certificate authority (either
one you maintain yourself or a commercial service). The CRL servers are accessed using LDAP or HTTP
(depending on what the certificate specifies). If all defined CRL servers are unreachable, the certificates are
treated as invalid until the CRL can be checked. You can set up the NGFW Engine to access CRL servers
directly or use the OCSP protocol.

Internal VPN certificate authorities
The Management Server includes a dedicated Internal RSA CA for Gateways and optionally an Internal ECDSA
CA for Gateways for signing VPN certificates for creating self-signed certificates.

You can use both an Internal ECDSA CA for Gateways and an Internal RSA CA for Gateways at the same time.

The internal certificate authorities run on the same computer as the Management Server. If you have both types
of internal certificate authorities, only one certificate authority can be selected as the default certificate authority.
Only the default CA is used in automated RSA certificate management. You must manually create and renew any
certificates that are not signed by the default CA.

If you want to use the internal certificate authorities to sign certificates, you must export, transfer, and import
certificate requests and signed certificates manually. The Internal RSA CA for Gateways and the Internal ECDSA
CA for Gateways do not support certificate revocation lists. We do not recommend using the internal certificate
authorities to sign certificates for components that are outside the control of your organization.

The Internal RSA CA for Gateways and the Internal ECDSA CA for Gateways are each valid for 10 years. A new
Internal RSA CA for Gateways or Internal ECDSA CA for Gateways is automatically created to replace the default
certificate authority 6 months before the expiration date. The internal certificate authority that is not selected as
the default certificate authority is not automatically renewed.

If automatic RSA certificate management is activated for an NGFW Engine, RSA certificates issued by the default
certificate authority are renewed automatically. You must manually renew certificates if the certificate-related files,
including the private key stored on the engines, are damaged or lost. You must also manually create and renew
any certificates that are signed not signed by the default certificate authority. If certificates for authenticating VPN
client users were signed by the expiring Internal CA for Gateways, you must manually create new certificates for
the VPN clients. You must also create new certificates manually for external components that have certificates
signed by the Internal RSA CA for Gateways or the Internal ECDSA CA for Gateways.

External certificate authorities
External certificate authorities can create certificates for VPN Gateways, External VPN Gateways, or VPN clients.

All IPsec certificates follow the ITU-T X.509 standard, which is also used in protocols such as TLS/SSL and
HTTPS. External certificate authorities are especially useful when creating VPNs with partner organizations.
Using external certificate authorities allows both organizations to use their preferred certificate authority. Different
gateways in a VPN can have certificates signed by different certificate authorities.

To make NGFW Engines accept externally signed certificates of external components, you simply import the
public key of the external certificate authority into the SMC.
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To create a certificate for NGFW Engines or the Stonesoft VPN Client, you must generate a certificate request
and have it signed by the external certificate authority. The external certificate authority must support PKCS#10
certificate requests in PEM format and the signed certificates must also be in the PEM format. Furthermore, the
certificate authority must be able to copy all attributes from the certificate request into the certificate. Especially,
the X.509 extension Subject Alternative Name must be copied into the certificate because its value is used for
identification.

Supported encryption methods for IPsec
VPNs

Select encryption settings in your IPsec VPN according to the guidelines in your organization's security policy.

The message digest algorithms (for integrity checking) and encryption methods that are available in IPsec VPNs
are listed. The IPsec standards mandate support for some options, but also allow other options to be provided
by IPsec-compatible products. RFC 4305 lists the IPsec standard requirements that all IPsec-compliant products
must follow.

Estimates of how common support for the various algorithms is in IPsec-compatible products are listed. This
information can be helpful when deciding which methods to use when establishing a VPN with a third-party VPN
device.

FIPS mode
If your organization is required to follow FIPS encryption standards, some of the options presented are not
available in your system. See the Common Criteria Certification User’s Guide for more information.

GOST-compliant systems
If your organization is required to follow GOST encryption standards, the options in your system are mostly
different from the options presented.
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Supported message digest algorithms for
IPsec VPNs
Message digest algorithms are used to guarantee the integrity of data (that the packets have not been changed in
transit). These algorithms are often also referred to using the MAC or HMAC abbreviations (keyed-hash message
authentication code).

Table 131: Supported message digest algorithms

Algorithm Description

AES-XCBC-
MAC

128-bit hash algorithm.

Available only for checking the integrity of IPsec traffic.

Many IPsec-compatible VPN devices do not support this algorithm, but support is becoming
increasingly common.

Reference: RFC 3566.

MD5 Message-Digest algorithm 5

A 128-bit hash algorithm (also referred to as HMACMD5).

Available for checking the integrity of the IKE negotiations and IPsec traffic.

Most IPsec-compliant VPN devices still support this algorithm, but support might become
less common in the future.

Reference: RFC 2403.

SHA-1 Secure Hash Algorithm

Has a 160-bit hash (sometimes referred to as HMAC-SHA-1).

Available for checking the integrity of the IKE negotiations and IPsec traffic.

All VPN devices must support this algorithm to be fully IPsec-compliant.

Reference: RFC 2404.

SHA-2 Secure Hash Algorithm

Has 256-bit, 384-bit, and 512-bit hashes (includes SHA- 224, SHA-256, SHA-384, and
SHA-512).

Available for checking the integrity of the IKE negotiations and IPsec traffic.

Most IPsec-compliant VPN devices support this method.

Reference: RFC 4868.

Note:  The restricted (-R) product version has no strong encryption algorithms.
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Supported encryption algorithms for IPsec
VPNs
Encryption algorithms scramble data, so that it is not viewable while in transit.

Table 132: Supported encryption methods

Method Description

AES-128

AES-256

Advanced Encryption Standard (also referred to as Rijndael) with a 128-bit/192-bit/256- bit
encryption key. The AES-128 option uses 128-bit keys by default, but accepts stronger 192-
bit or 256-bit keys if requested by the other gateway.

Most IPsec-compliant VPN devices support one or both key lengths of these methods, and
support is becoming more common.

Reference: RFC 4309.

AES-GCM-128

AES-GCM-256

Advanced Encryption Standard (also referred to as Rijndael) in GCM (galois/counter mode),
uses a 16-octet ICV (integrity check value). AES-GCM-128 uses a 128-bit encryption
key, and AES-GCM-256 uses a 256-bit encryption key. Provides both authentication
and encryption. These methods replace the selected message digest algorithm. In high-
performance networks, these encryption methods are recommended.

Many IPsec compatible VPN devices do not support one or both key lengths of these
methods, but support is becoming more common.

Reference: RFC 4106.

DES Data Encryption Standard (also referred to as the Data Encryption Algorithm, DEA) uses a
56-bit encryption key.

Do not use DES if you can avoid it. DES has been largely abandoned because the short key
makes it vulnerable to attacks. If you must use DES, make sure that PFS is enabled and that
the encryption keys are frequently renegotiated.

Many IPsec-compliant VPN devices still support this method, but support is becoming less
common.

Reference: RFC 2405.

Blowfish Uses up to 448-bit keys. Policy-based VPNs use 128-bit keys by default, but accept up to
448-bit keys if requested by the other gateway.

Many IPsec-compatible VPN devices do not support this method.

Reference: RFC 2451.

3DES Triple-DES (also referred to as TDES or TDEA, Triple Data Encryption Algorithm), uses 168-
bit encryption achieved with three different 56-bit encryption keys.

3DES is processor-intensive compared to the level of protection it offers and is therefore not
the most efficient method. It might not be optimal for VPNs that handle large traffic volumes
or systems that otherwise have a high load.

Most IPsec-compliant VPN devices support this method.

Reference: RFC 2451.
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Method Description

Null No encryption. Traffic is sent as cleartext just like any non-VPN traffic. Anyone who
intercepts the VPN traffic in transit can view the traffic.

Null encryption is useful only in special cases. Do not select it for any VPN that requires
protected data transfer.

Most IPsec-compliant VPN devices support this method.

Reference: RFC 2410.

Note:  The restricted (-R) product version has no strong encryption algorithms.

Configuring IPsec VPNs with external
gateway devices

An External VPN Gateway is any VPN gateway that is not controlled by the same Management Server (and the
same administrative Domain) on which you are configuring the gateway element.

Often, external gateway devices are at a partner organization, not under your control, and not Forcepoint NGFW
devices. Because IPsec is a networking standard, you can create a VPN between gateways of different brands
by selecting the settings you want identically for both gateways. Any option that both gateways support is a valid
option for the VPN.

The settings that must match are:
• The IKE SA settings.
• The IPsec SA settings.
• The site definitions (IP addresses) defined for both gateways at both ends (possibly translated using NAT).
• The endpoint identity type and value. The endpoint identity value is often the IP address of each gateway, but

other options are also possible.

When the listed settings are identical, the VPN works. Unfortunately, there are some practical problems that
complicate matching the settings.

The first problem you might experience when you configure a VPN between different brands of gateways is how
to agree on common settings. Every setting must match to produce a fully functional VPN, and the supported
options can be partly different on the different gateways. There is not a single common standard for naming
the different options. The two gateways might use a different name for the same authentication or encryption
method. If Forcepoint NGFW devices are used as External VPN Gateways, you can export and import some
settings between the two Management Servers (or between administrative Domains). However, many of the
configurations must still be manually constructed.

The IP addresses accessible through each gateway are a commonly mismatched setting. In VPN Gateways
controlled by the Management Server on which the VPN is configured, the IP addresses included in the policy-
based VPN are defined as separate Site elements. The security association (SA) granularity setting defines
whether a new VPN tunnel is established per each communicating host or per each network. In most gateways,
there is an option for the SA setting. However, some gateways might select the SA automatically based on the
type of IP address definition or even have a fixed setting.

Note:  Site definitions are always defined for the VPN Gateway or External VPN Gateway element
and are used in all policy-based VPNs where the same gateway is used. If you add a site to a
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gateway in one policy-based VPN, disable it in other policy-based VPNs where you do not want
the site to be included.

Related concepts
Supported encryption methods for IPsec VPNs on page 1137

Logs related to VPNs
VPN negotiations and VPN traffic are logged as informational messages and can be viewed in the Logs view like
any other logs.

New connections that are allowed through the policy-based VPN are logged like any other traffic according to the
logging options in the Access rules.

If there are VPN-related problems, you can activate IPsec diagnostics for the firewall to get more detailed
information about the VPN negotiations. The Troubleshooting topics contain further information about possible
problems, including explanations for the most common messages you might see in the logs.

Using a dynamic IP address for a VPN
endpoint

There are some restrictions when a VPN endpoint has a Dynamic IP address (assigned using DHCP, PPPoA, or
PPPoE).

The following restrictions apply:

• The VPN gateway must be use some other identifier than the IP address, such as DNS name, email address,
or (if certificate authentication is used) the certificate’s Distinguished Name (DN) as the phase-1 ID.

• IKEv1 main mode with pre-shared key authentication is not supported. Aggressive mode allows the use of
pre-shared keys, but for security reasons certificate-based authentication is also recommended when IKEv1 is
set in aggressive mode.

Using a NAT address for a VPN endpoint
VPN traffic is protected against modifications, so there are some restrictions when NAT is applied to the
encrypted traffic.

If a gateway does not have a public IP address as a VPN endpoint, you might need to configure NAT traversal.

You might also need to configure the policy-based VPN with contact addresses so that the gateways are aware
of the NAT operation:
• Firewalls that are used as VPN Gateways in a NAT environment must have Locations and Contact Addresses

defined for the endpoint interfaces involved. On Firewall Clusters, CVIs must have Locations and Contact
Addresses defined. If Contact Addresses have already been configured for non-VPN use, the same general
configuration applies to VPN communications as well. The Stonesoft VPN Client downloads its configuration
from the gateway, including any contact address configuration as needed.
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• Usually, External VPN Gateways must be defined using their private IP addresses. The public IP address
must be added as the Contact Address for the Location of the contacting Forcepoint NGFW in the Firewall/
VPN role.

Clustering and VPNs
A Forcepoint NGFW cluster can be used as a gateway in policy-based and route-based VPNs. There are no
additional configuration steps compared to a Single Firewall.

Clustering provides high availability and load balancing at the VPN gateway with multiple nodes in a cluster. If
one of the nodes is commanded offline or fails, the remaining nodes in the cluster take over the VPN traffic that
was handled by that node. To allow the nodes to use the same certificate, the associated private encryption key
is exchanged securely through the heartbeat channel. To external VPN gateways, the cluster presents itself as a
single device with a single endpoint (CVI IP address) to contact.

Multi-Link and VPNs
Using Multi-Link enhances the reliability of the VPN communications by offering network connection high
availability.

Forcepoint NGFW can balance the traffic load between multiple network links and redistribute traffic when a link
goes down. Using Multi-Link reduces the possibility of link congestion or ISP network connectivity breaks. Multi-
Link is not a part of the IPsec standards.

Note:  Multi-Link is only supported with Forcepoint NGFW gateways at both ends. If an external
gateway device allows configuring multiple VPN tunnels between two devices, you might still be
able to use some Multi-Link features. Not all Multi-Link features are available with an external
gateway device.

In a Multi-Link configuration, the traffic can use one or several alternative tunnels to reach the same destination.
Multi-Link guarantees that even if one or more tunnels fail, the VPN service continues as long as some tunnel is
available.

Multi-Link can be used between two Forcepoint NGFW gateways when one or both gateways use multiple
network connections. VPN traffic is balanced between the tunnels based on the link availability checks on each
VPN tunnel. If one of the links fails or becomes congested, the VPN traffic is routed through the other tunnels.

The VPN links can be in three different modes: active, aggregate, or standby. If there are multiple links in active
mode, traffic is dynamically balanced across the links. The balancing decision can be based on a performance
measurement or based on the links’ relative bandwidths. In active mode, a single connection uses one of the
active links. With multiple connections, all links are used. If there are multiple links in aggregate mode, each
connection is balanced on a packet-by-packet basis between all aggregate links in round robin fashion. Standby
tunnels are used only if all active or aggregate tunnels become unavailable. Individual tunnels can also be
disabled so that they are never used in the VPN.

Note:  Aggregate mode in a Multi-Link VPN is likely to cause packet reordering due to different
latencies of different links. Packet reordering can decrease performance if the TCP stacks of the
connection endpoints do not handle reordering well. Use Active mode instead.

This illustration shows a Multi-Link VPN between two VPN Gateways that both have multiple Internet
connections. In this configuration, ISP 2 at Gateway B acts as a backup link for VPN traffic. The three tunnels
(one from each ISP at Gateway A) with their endpoints in the ISP 2 network have been set to standby. They
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are only used if ISP 1 fails. The standby setting is not tied to a particular ISP (NetLink). It is possible to set, for
example, only the ISP A to ISP 2 tunnel to active mode while leaving the other tunnels in standby mode.

 
Figure 164: Example of a Multi-Link VPN with standby tunnels

The Stonesoft VPN Client can also use Multi-Link. If one of the gateway’s links fails, the client automatically
connects to the next available NetLink.
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VPNs allow creating secure, private connections through networks that are not otherwise secure.

VPN configuration overview
Many steps might be required to configure a VPN, depending on the complexity of the configuration.

Devices that provide VPN access to other computers are called VPN gateways. There are two general types of
VPN gateways in the Forcepoint NGFW Firewall/VPN:
• VPN Gateway elements represent NGFW Engines that are managed by the Management Server (and

administrative Domain) you are currently connected to with your Management Client.
• All other gateway devices are represented by External VPN Gateway elements. Forcepoint NGFW Engines

that are managed by a different Management Server (or administrative Domain) are also External VPN
Gateways.

Due to the various authentication and encryption methods that are supported in VPNs, there are many settings in
policy-based VPNs. To prevent repeated configuration work, reusable profiles are used for storing different types
of settings. These profiles and other elements related to the configuration of policy-based VPNs are shown in the
following illustration, excluding the elements that are related to managing certificates.
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Figure 165: Elements in the VPN configuration (excluding certificate-related elements)
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1 The VPN Gateway element represents a Firewall/VPN device in VPNs. One VPN Gateway element is
automatically created for each NGFW Engine in the Firewall/VPN role. You can optionally add more
VPN Gateways to the NGFW Engine. Each VPN Gateway element can be used in several VPNs. The
Gateway element refers to the following other elements:
• The NGFW Engine element contains the VPN settings for the VPN Gateway. The NGFW Engine

element refers to a Gateway Settings element that defines settings for advanced VPN performance
tuning.

• Gateway Profile elements contain information about the capabilities of different gateways, so
that the system can disable unsupported options and find incompatible combinations of settings
automatically. Gateway Profiles can be created and selected for External VPN Gateways. The
Gateway Profiles of VPN Gateways are selected based on the installed software version.

• Site elements define real or translated IP addresses that are routable through the policy-based
VPNs. The system can add the IP addresses automatically from routing or you can adjust the sites
yourself.

2 The Policy-Based VPN element combines other elements together to define the settings used in one
particular policy-based VPN and defines the topology for the VPN.
Route-Based VPN Tunnel elements define endpoints for tunnels in route-based VPNs.
The VPN elements refer to a VPN Profile, which contains the IPsec authentication and encryption
settings (IKE settings) for establishing a VPN.

3 The Firewall Policy controls VPN traffic in the same way as any other traffic.
• The Access rules determine which connections are directed out through each VPN and which traffic

is allowed in from each VPN.
• The NAT rules define how address translation is done for VPN connections. The VPN

communications between the gateway devices are always subject to NAT as usual. The traffic that
uses the tunnels is subject to NAT only if address translation is enabled for the VPN.

Except for endpoint IP addresses, the same elements used in the configuration of policy-based VPNs can also be
used when configuring route-based VPNs.
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Configuration workflow
The Gateway Settings element shown in the figure is not part of this workflow. The default settings are usually
recommended. Otherwise, the following workflow covers all VPN configurations:

1) (Optional) If you are configuring a VPN with an external device, you might want to create a custom Gateway
Profile specific to the device.

2) (External VPN gateways only) Add the necessary number of External VPN Gateway elements to represent
the physical VPN devices. External VPN Gateway elements define the VPN endpoints (gateway IP
addresses) and the sites (see the next point).

Note:  VPN Gateways elements are automatically created for NGFW Engines.

3) (Policy-based VPNs only) Configure the sites. Sites define the IP addresses that can be made routable
through VPNs. The sites can be adjusted in different VPNs that the gateway establishes.

4) (Optional) If the existing VPN Profiles do not have suitable settings for your new VPN, create a custom VPN
Profile element. The custom VPN Profile element defines the IPsec settings (authentication, encryption, and
integrity checking).

5) Define the VPN in one of the following ways:
• Create a Policy-Based VPN element. The Policy-Based VPN element defines the topology (which

gateways create tunnels with each other).
• Create Route-Based VPN Tunnel elements to define endpoints for tunnels in route-based VPNs.

6) Create certificates, if necessary.

7) Add the necessary Access rules according to the type of VPN:
• (Policy-based VPNs) Add the IPv4 Access rules and, if necessary, the IPv4 NAT rules for VPN traffic.

Adding rules for policy-based VPNs also activates the VPN on the engines.
• (Route-based VPN) Add Access rules to allow traffic between the internal network and the networks that

are reachable through the route-based VPN tunnels.

This workflow contains steps for all kinds of VPN configurations. Alternative next steps are included as necessary
to achieve a particular type of configuration. Alternatively, you might want to follow a simplified workflow for
building a particular type of VPN.

Related concepts
Getting started with Access rules on page 817
Defining VPN gateways on page 1149
Defining VPN profiles on page 1162
Defining Policy-Based VPN elements on page 1164
Defining Site elements for VPN gateways on page 1156
Using certificate-based authentication on page 1135
Access rules for policy-based VPNs on page 1172
VPN certificates and how they work on page 1221
Gateway settings for VPNs on page 1245
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Related tasks
Add tunnel interfaces for firewalls on page 556

Default elements for policy-based VPNs
There are several default elements for policy-based VPN configuration.

Table 133: Default elements for policy-based VPN configuration

Element type Default elements

Gateways The predefined VPN Client gateway element that represents VPN clients, including the
Stonesoft VPN Client and third-party VPN clients. You can change the Gateway Profile
associated with this default element.

Certifications The Internal RSA CA for Gateways VPN Certificate Authority represents the
Management Server’s internal RSA Certificate Authority. You can use the element to
define certificate trust relationships if you configure other CAs in the SMC.

Gateway Profiles Several different Gateway Profiles are included for different Firewall/VPN and Stonesoft
VPN Client versions. With third-party VPN devices, you can use the Default (All
Capabilities) profile, which enables all options. You can also create a more restrictive
profile yourself for better automatic configuration validation.

Gateway Settings Gateway Default Settings is a predefined Gateway Settings element that contains the
default recommended settings for most environments.
Each firewall has settings that are common to all VPNs the firewall establishes, set
in the Gateway Settings element. These settings are mostly for performance tuning.
Usually there is no need to change them at all. If there is some particular need to change
the settings, you must create a custom Gateway Setting element. You cannot edit the
Gateway Default Settings system element.

VPN Profiles The predefined VPN Profiles are provided to allow you to quickly try out VPNs without
creating a VPN Profile yourself.
• The VPN-A Suite VPN Profile contains the VPN settings specified for the

cryptographic suite “VPN-A” in RFC 4308.
• The Suite-B-GCM-128 and Suite-B-GCM-256 VPN Profiles contain the VPN settings

specified for the respective cryptographic suites in RFC 6379.
• The iOS Suite VPN Profile contains only iOS-compatible encryption algorithms and

protocols. For example, iOS VPN clients only support IKEv1 key exchange, which
must be enabled in the profile.

The predefined VPN Profiles also allow you to change settings that are not specified in
RFC 4308 and RFC 6379. You might need to adjust the settings to achieve a valid VPN
in some configurations.
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Define a custom Gateway Profile
element

The Gateway Profile element introduces information about the features and options available so that the VPN
configuration can be automatically validated.

The general settings directly affect the settings used in VPNs. The authentication and encryption settings defined
in the Gateway Profile do not directly influence which of the displayed settings are used for any VPNs. The
settings in the Gateway Profile help you make sure that the settings defined for the VPNs correspond to the
options supported by the gateway devices involved.

For VPN Gateways that represent firewalls, the Gateway Profiles are automatically selected according to the
software version, and you cannot change the selection. If you use an NGFW Engine managed by a different
Management Server or administrative Domain as an External VPN Gateway, select the Gateway Profile
according to the software version. If you use a third-party device as an External VPN Gateway, you have the
following options:
• You can use the Default (all capabilities) profile, which allows any of the options to be selected for the

External VPN Gateway.
• You can define a custom Gateway Profile to set certificate-related options and to restrict the options to a

supported set to prevent configuration errors.

For the Stonesoft VPN Client, there are predefined Gateway Profiles.

There are some advanced properties on the General tab, meant for advanced users only. The default values are
the recommended values. These options affect the VPN directly.

The IKE Capabilities and IPsec Capabilities are not directly used in a VPN. The settings are selected for use
in the VPN Profile element. The settings define a set of options that the gateway supports, so that the SMC can
automatically check for misconfigured settings.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Other Elements > Profiles.

3) Right-click Gateway Profiles, then select New Gateway Profile.

4) Configure the settings.

5) Click OK.

Defining VPN gateways
VPN Gateway and External VPN Gateway elements represent the physical devices that establish the VPN in the
configuration.

VPN Gateway elements represent NGFW Engines that are managed by the Management Server (and
administrative Domain) you are currently connected to with your Management Client. One VPN Gateway element
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is automatically created for each Forcepoint NGFW in the Firewall/VPN role. You can optionally add more VPN
Gateways to the Firewall.

All other gateway devices are represented by External VPN Gateway elements. NGFW Engines that are
managed by a different Management Server (or administrative Domain) are also External VPN Gateways.
External VPN Gateway elements define settings for the external gateway devices in their role as VPN gateways.

Only one VPN Gateway or External VPN Gateway element per device is needed, even if there are many VPNs.
You can use the same Gateway in several different VPNs, possibly overriding some of the Gateway’s settings as
necessary. You can create several Gateway elements to represent the same Firewall. However, each Gateway
element reserves a VPN endpoint (IP address) that other Gateway elements cannot use. If you use the same
Gateway element in both policy-based and route-based VPNs, you must define unique endpoints for each type of
VPN.

The predefined VPN Client element represents all instances of the Stonesoft VPN Client and third-party IPsec
VPN clients in mobile VPNs. When you set up a mobile VPN with the Stonesoft VPN Client, the VPN Client
element must always be used. Usually, we recommend using the element with third-party VPN clients as well.
However, it is possible to configure an individual third-party VPN client using an External VPN Gateway element if
there is a specific need to do so. In this configuration, only one client at a time can connect to each gateway.

Define endpoints for VPN Gateway elements
Each endpoint is dedicated for one VPN Gateway element.

Any IP address that is already an endpoint for another VPN Gateway element is not shown on the Endpoints
list for other Gateways that you create for the same NGFW Engine. Each VPN Gateway element can be used in
several VPNs. However, you cannot use the same endpoint in a Route-Based VPN Tunnel element and a tunnel
in a policy-based VPN. If you want to create VPN tunnels for both policy-based and route-based VPNs using the
same Gateway, you must define unique endpoints for each type of VPN.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Firewall, then select Edit Single Firewall or Edit Firewall Cluster.

2) Browse to VPN > Endpoints.

3) (Optional) Change the selection of IP addresses that you want to use as endpoints in VPNs.

• Typically, these are IP addresses that belong to interfaces toward the Internet, which are automatically
selected based on the firewall’s default routing table.

• If loopback IP addresses are defined for the NGFW Engine, you can select a loopback IP address as
the endpoint IP address. On clustered firewalls, the IP addresses are CVIs.

• (Policy-based VPNs only) If you have more than one Internet connection, select an IP address from
each ISP.

4) Double-click the endpoint, then configure the following optional settings according to your environment.

a) (Optional) In the Name field, enter a descriptive name for the endpoint.

b) (Policy-Based VPNs only) From the Mode drop-down list, select an option to define how the endpoint
is used in a Multi-Link configuration.
You can override these settings in each individual VPN.
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c) (Optional) From the Use NAT-T drop-down list, select an option to activate encapsulation for NAT
traversal in site-to-site VPNs.
You might need NAT traversal to traverse a NAT device at the local or at the remote gateway end.
The gateway always allows VPN clients to use NAT-T regardless of these settings. NAT-T always
uses the standard UDP port 4500.

Note:  If a private external IP address is translated to a public IP address by an
external NAT device, make sure that Contact Addresses and Locations are defined for
the Firewall.

Note:  The TCP Tunneling option is included for backward compatibility with legacy
Forcepoint NGFW software versions. Selecting this option has no effect on Forcepoint
NGFW version 5.9.0 or later.

5) In the Phase-1 ID settings, select an option from the ID Type drop-down list according to your
environment.

• The ID identifies the Gateways during the IKE SA negotiations.
• The Distinguished Name type is only valid in certificate-based authentication.
• The IP Address type is not valid for endpoints with a dynamic IP address.

6) In the ID Value field, enter an ID value according to the selected ID type.
• If you selected DNS Name, enter a DNS name.
• If you selected Email, enter an email address.
• If you selected Distinguished Name, enter the distinguished name that is used in the gateway

certificate.
• If the endpoint has a dynamic IP address, enter a specific IP address as the value for the IP Address

type.

Note:  If the endpoint has a static IP address, the value for the IP Address type is filled
in automatically.

7) (Optional) If the endpoint must use different Phase-1 ID settings in individual policy-based VPNs, add
VPN-specific exceptions.

a) Click Exceptions.

b) Click Add, then select the type of ID from the drop-down list.

c) Select a Policy-Based VPN element, then click Select.

d) In the ID Value cell, enter the value of the ID.

8) (Optional) In the VPN Type settings, restrict the types of VPNs that the endpoint can be used in.

a) Select Selected types only.

b) Select one or more types of VPNs.

9) Click OK to save your changes to the endpoint.
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10) Save the changes.
• To save the changes, click  Save.
• To save the changes and refresh the security policy on the engine, click  Save and Refresh.

Related concepts
Considerations for setting up system communications on page 127
Defining VPN profiles on page 1162

Related tasks
Add loopback IP addresses for Single Firewalls on page 571
Create Route-Based VPN Tunnel elements on page 1182

Create an External VPN Gateway element
You must create an External VPN Gateway element to represent third-party VPN devices or Forcepoint NGFW
devices managed by a different Management Server in VPNs.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Right-click Gateways, then select New External VPN Gateway.

3) Configure the settings.

4) Click OK.

Related concepts
Defining VPN profiles on page 1162
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Define endpoints for External VPN Gateways
Each endpoint is dedicated for one External VPN Gateway element.

Before you begin
You must have an External VPN Gateway element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the External VPN Gateway element, then select Properties.

2) On the Endpoints tab, click Add.

3) Configure the following optional settings according to your environment if needed.

a) (Optional) In the Name field, enter a descriptive name for the endpoint.

b) (Policy-Based VPNs only) From the Mode drop-down list, select an option to define how the endpoint is
used in a Multi-Link configuration.
You can override these settings in each individual VPN.

c) (Optional) From the Use NAT-T drop-down list, select an option to activate encapsulation for NAT
traversal in site-to-site VPNs.
You might need NAT traversal to traverse a NAT device at the local or at the remote gateway end. The
gateway always allows VPN clients to use NAT-T regardless of these settings. NAT-T always uses the
standard UDP port 4500.

Note:  If a private external IP address is translated to a public IP address by an external
NAT device, make sure that Contact Addresses and Locations are defined for the
Firewall.

d) If necessary, change the default Contact Address or add Exceptions for the Locations of other gateways
involved in the VPN.
The Contact Address must be defined if the IP address for contacting this gateway is different from the
IP address that the gateway actually has on its interface (for example, because of NAT).
Example: An external gateway is behind a NAT device. The real address is defined as the endpoint
address, because the IP address is also used as the Phase 1 ID inside the encrypted traffic. Contact
must be made using the translated address, so it is defined as a Contact Address.

4) In the Phase-1 settings, select an option from the ID Type drop-down list to according to your environment.

• The ID identifies the Gateways during the IKE SA negotiations.
• The Distinguished Name type is only valid in certificate-based authentication.
• The IP Address might not work as an ID if the address is translated using NAT.

5) In the ID Value field, enter an ID value according to the selected ID type.

Note:  Make sure that the ID value matches the identity configured on the external gateway
device.
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• If you selected DNS Name, enter the DNS name that is configured on the external gateway device.
• If you selected Email, enter the email address that is configured on the external gateway device.
• If you selected Distinguished Name, enter the distinguished name that is used in the gateway certificate.
• If the endpoint has a dynamic IP address, enter a specific IP address as the value for the IP Address

type.

Note:  If the endpoint has a static IP address, the value for the IP Address type is filled in
automatically.

6) (Optional) If the endpoint must use different Phase-1 ID settings in individual policy-based VPNs, add VPN-
specific exceptions.

a) Click Exceptions.

b) Click Add, then select the type of ID from the drop-down list.

c) Select a Policy-Based VPN element, then click Select.

d) In the ID Value cell, enter the value of the ID.

7) Click OK to save your changes to the endpoint.

Related concepts
Considerations for setting up system communications on page 127
Defining VPN profiles on page 1162

Related tasks
Create Route-Based VPN Tunnel elements on page 1182

Define trusted CAs for a gateway
Certificate Authorities (CA) verify certificate authenticity with their signatures. Gateways accept certificates only
from the trusted CAs that you define.

Before you begin
You must have more than one VPN Certificate Authority element.

By default, the gateways trust all VPN CAs that are currently defined, but you can restrict the trusted CAs. You
can also restrict trusted CAs in VPN Profiles.

For VPN Gateways that represent NGFW Engines, you define the trusted CAs in the Engine Editor.

For External VPN Gateways, you define the trusted CAs in the External VPN Gateway Properties dialog box. The
system uses the trusted CA definition in the External VPN Gateway element to check that all gateways have the
necessary certificates.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Access the Trusted VPN Certificate Authorities settings in one of the following ways:
• Right-click a Firewall element, select Edit <element type>, then browse to VPN > Certificates.
• Right-click an External VPN Gateway element, select Properties, then click the Trusted CAs tab.

2) Select Trust only selected, then select one or more CAs.

3) Save the changes in one of the following ways:
• In the Engine Editor, click  Save.
• In the External VPN Gateway Properties dialog box, click OK.

Related tasks
Define additional VPN certificate authorities on page 1223

Define VPN client settings for Forcepoint
NGFW
The Engine Editor contains settings for assigning valid IP addresses to VPN clients for connections through the
VPN to the internal network.

If you use Stonesoft VPN Client, configure the Virtual Adapter. The alternative NAT Pool method does not allow
the Stonesoft VPN Client computers to use your organization’s internal DNS servers. Virtual IP addresses work
with all Stonesoft VPN Client versions and with third-party VPN clients that support this feature.

If you use Stonesoft VPN Client, the policy-based VPN configuration defined in the Management Client is also
used for creating the configuration for Stonesoft VPN Client. Stonesoft VPN Client downloads the settings from
the VPN gateway either manually or automatically whenever there are relevant changes. All IPsec and address
management settings are included in the download. For example, the download includes information about which
encryption methods are used and which internal networks clients can access through the gateway. The decision
whether a VPN tunnel is used is based on the IP addresses you have defined for the Sites of the gateway.

For third-party VPN clients and external VPN gateways, you must duplicate the VPN Gateway settings in the
configuration of the VPN client or gateway. You must also duplicate the VPN Gateway settings for engines under
a different administrative Domain. The settings that you must duplicate include the following:
• All IPsec-related settings, such as the authentication, encryption, and integrity checking options.
• The encryption domain (the IP addresses that are allowed in the VPN as a source or destination IP address).

If a VPN Gateway that contains VPN Client settings is used in a route-based VPN, the VPN Client settings are
ignored.

Note:  The Virtual Adapter IP addresses must be assigned by a DHCP server. It is not possible to
define the IP addresses in the VPN client or in the VPN gateway configuration. When you use a
Single Firewall's internal DHCP server, use the IP address of the interface on which the internal
DHCP server is enabled as the IP address of the DHCP Server element.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall element, then select Edit <element type>.

2) Browse to VPN > VPN Client.

3) Configure the settings.

4) Click  Save.

Related concepts
Configuring IPsec VPNs with external gateway devices on page 1140
Defining IP addresses for VPN clients on page 1250

Defining Site elements for VPN gateways
The protected IP addresses behind each gateway are defined using Site elements.

In the IPsec standard, these IP addresses are called traffic selectors. The IP addresses work like routing
definitions when the gateway selects which VPN tunnel a packet is sent through. The Site elements must contain
the IP addresses of all protected hosts that potentially send or receive VPN traffic through any site-to-site or
mobile VPN. IP addresses that are not included in the Site elements are not allowed as source or destination
addresses in policy-based VPNs. You cannot add or change Site elements under the VPN Client Gateway
element. The Site elements are always added globally for all policy-based VPNs where a Gateway is used, but
unnecessary Site elements can be disabled in individual VPNs.

The VPN settings for NGFW Engines include a Site that is automatically populated and updated according to the
routing definitions. All interfaces and networks are included in the automatic Site, except interfaces with the Any
Network element. If loopback IP addresses are defined for the engine, you can use a loopback IP address as an
endpoint IP address.

The Site elements must always contain the actual IP addresses that are used inside the VPN tunnel. If you
enable NAT for a policy-based VPN and translate the local IP addresses, you must define the Site elements
using the translated (after NAT) addresses. The NAT addresses are not added to the Site automatically.

A hub gateway forwards traffic from one VPN tunnel to another. If you want to use a central gateway as a hub,
include all IP addresses that are accessible through the central gateway in the central gateway’s Site elements.

Note:  An IP address must be included in a Site to be valid in the VPN. The Access rules define
which connections are allowed to enter and exit a VPN tunnel.

The IP address information is also checked in the VPN establishment phase. When creating VPNs with external
Gateways, make sure that the IP address spaces of both gateways are defined identically in the SMC and on the
external device. Otherwise, the VPN establishment can fail in one or both directions. Make sure to update the
policies of any firewalls that are involved in the VPN when there are changes in the Site elements at either end.
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Automatic VPN Site management
Automatic Site management copies the internal IP addresses from the Routing tree (except interfaces with the
“Any Network” element) and updates the information when you change the routing.

You can change this automatic Site in the following ways:
• You can disable individual interfaces through their right-click menu. This way, you can exclude some of the

internal interfaces from VPNs.
• You can add addresses to the automatic Site at the top level (at the same level with the Interface elements,

not inside them) by dragging and dropping the correct Networks or other elements.
• You can add more Sites alongside the automatic Site.
• You can define the automatic Site as Private in some VPNs.

Related concepts
Defining VPN profiles on page 1162
Defining Policy-Based VPN elements on page 1164

Related tasks
Add a VPN site on page 1158
Adjust VPN-specific Site settings on page 1159

Disable or enable automatic VPN Site
management
Automatic Site management is active by default in the VPN settings for NGFW Engines.

If you prefer not to update the information automatically for any interface, you can disable automatic site
management.

When you disable automatic site management, the automatic Site is removed. There must be another Site
configured for the gateway for it to be valid in a VPN.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click a Firewall element, then select Edit <element type>.

2) Browse to VPN > Sites.

3) Deselect or select the Add and Update Addresses Based on Routing option.

• When the option is not selected, you must manually define the addresses that you want to be routable
through the VPN.

• When the option is selected, the Site content updates automatically according to changes made in the
routing configuration for the firewall (for interfaces that are not disabled).

4) Click  Save.
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Related concepts
Automatic VPN Site management on page 1157

Add a VPN site
The Site element defines the internal IP addresses that send or receive traffic through the VPN.

You must define sites for all NGFW Engines and External VPN Gateways that are used in policy-based VPNs.
You must also define sites for NGFW Engines and External VPN Gateways that are used in route-based VPN
tunnels that have the tunnel type VPN.

By default, each site is included in all VPNs where the gateway is used. Individual sites can be manually disabled
in any VPN without affecting the other VPNs. It is not possible to partially disable sites. If the IP address space
must be different in different VPNs, you need several sites. You can add as many Site elements as you need.

If traffic in the tunnel is subject to NAT, you must add the NAT addresses to the site. For NGFW Engines, you
must add both the NAT addresses and any untranslated IP addresses that are not automatically added to the
site. Sites for External VPN Gateways only require the translated address space that the NGFW Engine actually
contacts.

The local and remote site definitions must match the same information about the other gateways involved in
the VPN because the gateways verify this information. It might also make a difference whether addresses are
entered as individual IP addresses, address ranges, or networks.

Note:  Site definitions are applied globally to every VPN in which the Gateway is used unless you
specifically adjust the VPN-specific site settings.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Gateways.

3) Right-click a VPN Gateway or an External VPN Gateway, then select New > Site.

4) Select the elements that represent the protected IP addresses behind the Gateway, then click Add to include
them in this site.

• Do not include IP addresses outside the Gateway’s local networks in the site. There is no need to
include the Gateways’ own IP addresses in the sites. However, there is usually no need to exclude those
addresses if they are in the networks you add to the site.

• IP address ranges might be interpreted differently from lists of IP addresses and networks depending
on the VPN device. The system converts Group or Expression elements into address ranges, networks,
or individual IP addresses depending on the IP addresses included. Other VPN devices might treat the
same types of values differently.

• VPN Traffic Selector elements allow you to define the IP addresses, protocols, and ports used by a
specific host in a VPN site.

5) Click OK.
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Next steps

If you edited a previously configured VPN, make sure that the configuration of any external VPN gateway device
involved contains the same IP address information. Refresh the policy on all affected gateways to transfer the
changes.

Adjust VPN-specific Site settings
Site elements allow you to adjust how the Site is used in each VPN.

Before you begin
You must have manually added Site elements to VPN Gateways or External VPN Gateways.

Note:  To adjust settings for the automatic sites for VPN Gateway elements that represent NGFW
Engines, use the Engine Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Gateways.

3) Expand the gateway, right-click a manually added Site, then select Properties.

4) Click the VPN References tab.

5) In the table, select or deselect the Enable option for the existing VPNs displayed to include or exclude the
Site from the configuration.
When a Site is disabled, it is grayed out.
You can disable a Site that contains translated address in VPNs in which NAT is not used, or in which a
different address space is used for translation.

6) Select the Mode for the Site for each VPN in which it is enabled.
• Normal mode is the default. Use this mode for all active Site elements that do not require one of the other

two modes.
• Hub mode is used on a hub gateway in tunnel-to-tunnel forwarding. Hub mode Sites contain the IP

addresses of the networks that are behind the remote spoke gateways (the networks between which the
hub gateway forwards traffic). The automatically generated Site cannot be used as a Hub Site.

• (VPN Gateways on NGFW Engines only) Private mode is used for the local untranslated addresses
when addresses are translated using NAT in the VPN. You must include the translated IP addresses (the
addresses that the other end sees) as a Normal-mode Site element in these types of VPNs. If NAT is
disabled in the VPN, any Sites in the Private mode are ignored.
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Related concepts
Defining Policy-Based VPN elements on page 1164

Related tasks
Use a policy-based VPN to encrypt tunnels in route-based VPNs on page 1184

Temporarily disable a VPN site in all VPNs
You can disable a site that has been manually added to the Gateway. The site is disabled globally in all VPNs.

To remove the automatic site from an NGFW Engine that acts as a VPN Gateway, disable automatic VPN site
management. There must be at least one enabled site.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the list of sites for the gateway in one of the following ways:
• Right-click a Firewall element, select Edit <element type>, then browse to VPN > Sites.
• Open the properties of the External VPN Gateway element, then click the Sites tab.

2) Right-click the site, then select Properties.

3) On the VPN References tab, deselect the Enable cell.

4) Click OK.

5) Save the changes in one of the following ways:
• In the Engine Editor, click  Save and Refresh.
• In the External VPN Gateway Properties dialog box, click OK.

Next steps

If you edited a previously configured VPN, refresh the policy on all affected gateways to transfer the changes.
The configurations of external gateways might also require an update.

Related tasks
Disable or enable automatic VPN Site management on page 1157
Add a VPN site on page 1158
Define VPN topology for policy-based VPNs on page 1168
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Remove a VPN site from all policy-based VPNs
You can remove a site that has been manually added to the Gateway. The site is removed from all VPNs where
the Gateway is used.

To remove the automatic site from an NGFW Engine that acts as a VPN Gateway, disable automatic VPN site
management. There must be at least one enabled site.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the list of sites for the gateway in one of the following ways:
• Right-click a Firewall element, select Edit <element type>, then browse to VPN > Sites.
• Open the properties of the External VPN Gateway element, then click the Sites tab.

2) Right-click the site, then select Remove.

3) Save the changes in one of the following ways:
• In the Engine Editor, click  Save and Refresh.
• In the External VPN Gateway Properties dialog box, click OK.

Next steps

If you edited a previously configured VPN, refresh the policy on all affected gateways to transfer the changes.
The configurations of external gateways might also require an update.

Related tasks
Disable or enable automatic VPN Site management on page 1157
Add a VPN site on page 1158

Define VPN Traffic Selector elements
VPN Traffic Selector elements allow you to define the IP addresses, protocols, and ports used by a specific host
in a VPN site.

Before you begin
You must have sites for VPN Gateways.

You can use VPN Traffic Selector elements in policy-based VPNs. VPN Traffic Selector elements are intended to
be used in specific advanced VPN configurations.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the list of sites for the gateway in one of the following ways:
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• Right-click a Firewall element, select Edit <element type>, then browse to VPN > Sites.
• Open the properties of the External VPN Gateway element, then click the Sites tab.

2) Select  Tools > New > VPN Traffic Selector.

3) Configure the settings.

4) Click OK.

Defining VPN profiles
VPN Profile elements contain settings related to authentication, integrity checking, and encryption.

The VPN Profile element is the main point of configuration for IKE and IPsec settings. These settings are used or
agreed on during IKE SA and IPsec SA negotiations. You can select any combination of settings as long as all
gateways and VPN clients involved in the VPN support those settings and are configured to accept them.

The authentication methods for VPN clients are selected separately in the VPN Profile. A certificate-based
method is always included in the VPN, but you can optionally add other authentication methods.

If you want to use certificates signed by a particular certificate authority (CA), you must define the CA as an
element. By default, all VPN CAs are considered trusted, but you can restrict the trusted CAs for particular VPNs.

Each VPN refers to a VPN Profile. You can use the same VPN Profile in several VPNs if the settings are
compatible. You can use the same VPN Profile in both policy-based and route-based VPNs. You can also
easily copy the element to create custom versions of the same basic settings. There are predefined VPN Profile
elements, which are mostly useful for site-to-site VPNs between firewalls that act as VPN Gateways.

Mobile VPNs usually require a custom profile. However, there is a predefined VPN Profile element that simplifies
configuration for VPNs between iOS devices and Forcepoint NGFW VPN gateways. The iOS Suite VPN profile
contains only iOS-compatible encryption algorithms and protocols.

Before editing a VPN Profile that is used in active VPNs, we recommend backing up the settings. You can back
up the settings by duplicating the element, exporting it, or creating a Management Server backup. After editing
a VPN profile that is used in active VPNs, check all VPNs that use the profile for issues that the changes might
have caused.

Related concepts
Defining Policy-Based VPN elements on page 1164
Supported encryption methods for IPsec VPNs on page 1137

Related tasks
Use a policy-based VPN to encrypt tunnels in route-based VPNs on page 1184

Create VPN Profile elements
If the default VPN Profile elements do not meet your needs, create a custom VPN Profile element.

The options you select are a balance between performance and security. A higher level of security generally
requires more processing power.
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If External VPN Gateways are involved, you must make sure that all settings match between the gateways.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Other Elements > Profiles > VPN Profiles.

3) Right-click VPN Profiles, then select New VPN Profile.

4) Configure the settings.

5) Click OK.

Export iOS VPN configuration profiles
Exporting iOS VPN configuration profiles simplifies the VPN client configuration for iOS VPN client users.

Before you begin
The mobile VPN must be fully configured. These steps are for the native iOS VPN client only. The VPN
must use the iOS Suite VPN profile.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Policy-Based VPNs.

3) Right-click the VPN to which iOS VPN client users connect, then select Tools > Export iOS VPN
Configuration Profile.

4) Select where to save the configuration file.

5) Select the VPN gateway and endpoint to which iOS VPN client users connect.

6) (Optional) To require users to enter a password to open the configuration file, enter a password in the
Password field.

7) Click Export.

Next steps

Make the configuration file available to the iOS VPN client users. The VPN client setup procedure automatically
starts when the users open the configuration file on the iOS device.
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Defining Policy-Based VPN elements
The Policy-Based VPN element collects together the gateways and the VPN Profile, and provides the settings for
defining the topology and the tunnels of the policy-based VPN.

The main configuration for the VPN consists of defining which gateways are in the VPN and which of the
gateways form tunnels with each other. You can also enter and renew pre-shared keys if you use them for
authentication in this VPN.

The topology is determined by selecting whether the Gateways are Central or Satellite in each particular policy-
based VPN:
• A central gateway establishes VPN tunnels with any other central or satellite gateway in the VPN, unless you

specifically disable the tunnels.
• A satellite gateway establishes VPN tunnels only with central gateways.
• You can also create a VPN hub by adding a gateway so that it is listed under some other (central or satellite)

gateway in the topology. Other gateways connect to the higher-level gateway, which forwards the connections
to the lower-level gateway.

The Sites and networks for each gateway element can be adjusted in the policy-based VPN, but most of the
settings are not specific to the policy-based VPN. The only change that is specific to the policy-based VPN is
to disable a Site element in the policy-based VPN. Disabling a Site excludes the IP addresses from that policy-
based VPN only. Any other adjustments to the Sites and networks affect all other VPNs where the same gateway
element is used.

Tunnels are generated from each central gateway to all other gateways based on the overall topology. You can
adjust the tunnels to limit which gateways and endpoints form tunnels with each other. You can also change
some of the properties for tunnels between two particular gateways or endpoints, such as the VPN Profile used.
You can also define Multi-Link VPN settings that allow you to select standby and active tunnels and to set tunnels
to aggregate mode. In aggregate mode, each connection is automatically balanced between the aggregate
tunnels. Aggregate mode is likely to cause packet reordering that can actually decrease performance, depending
on the TCP stacks in the connection endpoints.

Note:  Although the VPN endpoints usually correspond to the NetLink interfaces in a Multi-Link
configuration, the VPN endpoint settings are separate from the NetLink and Multi-Link definitions.
For example, a NetLink that is set to standby for cleartext can still be used as an active endpoint
for VPN traffic.

When you configure the policy-based VPN, the validity of the VPN is automatically checked. If problems are
found, they are shown in the Issues view. While useful in many cases, the automatic check does not detect all
problems, especially regarding external gateways or interference between several separate policy-based VPNs.

Consider the following when creating new policy-based VPNs:
• Check whether you can use an existing policy-based VPN instead. Most settings can be set individually for

each site-to-site tunnel even within a single policy-based VPN. The VPN Profile, pre-shared key, and Multi-
Link settings can all be selected separately for each VPN tunnel. Site definitions are the only major exception
to this rule.

• There must not be duplicate tunnels (two tunnels between the same two endpoints) in the configuration of any
Firewall. Duplicate tunnels cause a policy installation failure. The easiest way to avoid duplicate tunnels is to
define all VPNs between your Firewalls in the same policy-based VPN.

• If you are creating VPNs with partner organizations, you might only want to include a subset of the internal IP
address space in the Site definitions. Limiting the IP address space allows you to avoid revealing all internal
addresses to your partner. Any cases where Site definitions must be different for different VPN tunnels
requires creating separate policy-based VPNs.
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VPN topologies
policy-based VPN tunnels can be defined using different topologies:
• Full-mesh topology connects each site to every other site in the same VPN. All gateways are central

gateways, which means that all gateways can establish tunnels with all other gateways in the VPN.
• Star topology connects sites behind satellite gateways to the sites behind central gateways. No VPN tunnels

are established between the satellite gateways.
• VPN hub topology routes site-to-site or mobile VPN connections to other sites through a central (hub) gateway

using other site-to-site VPNs. The hub is usually a central gateway, but it can also be a satellite gateway.

The full mesh topology, is formed between sites that must all be able to connect to any other site.

 
Figure 166: Full mesh VPN topology

In VPNs with partner organizations or remote offices, VPN connectivity is needed between remote sites and a
main site, but not from one remote site to another. This topology is a star topology.

The star topology is defined with satellite gateways that connect only to the central gateway. There is no VPN
between the satellite gateways. This topology reduces the number of VPN tunnels that the gateways maintain
compared to full-mesh topology. Having fewer tunnels can save resources on the remote gateways.

Sometimes the star topology is preferred even if VPN connectivity is needed between the remote offices. In this
case, the central gateway can be used as a hub that relays traffic from one VPN tunnel to another. Traffic can be
forwarded from either a site-to-site tunnel or a mobile VPN tunnel.
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Figure 167: Star VPN topology

The hub topology simplifies VPN client use if the clients connect to several gateways. It can also make setting
up site-to-site VPNs easier, especially if the satellite gateways are third-party devices. VPN encryption and
decryption require heavy computing. Consider hardware performance before high volumes of traffic are
concentrated at a hub gateway.

 
Figure 168: Hub VPN topology

The VPN configuration can be a mix of the different topologies, since the connectivity requirements vary from
location to location. The following illustration shows an example of a mixed topology.

Replacing two of the central gateways from the full mesh example with satellite gateways results in a VPN where
all but two gateways still have a VPN with each other.
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Figure 169: Combination of different topologies

Related concepts
Defining VPN gateways on page 1149

Create a Policy-Based VPN element
The configuration of a Policy-Based VPN element has two stages: first you define some basic properties for the
element, then you can add gateways and adjust the tunnels.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Policy-Based VPNs.

3) Right-click Policy-Based VPNs, then select New Policy-Based VPN.

4) Configure the settings.

5) Click OK.
The Policy-Based VPN opens for editing.

Next steps

Define the VPN topology.
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Related concepts
Defining VPN gateways on page 1149

Related tasks
Define QoS Policy elements on page 958

Edit a policy-based VPN
The policy-based VPN element can be configured in two ways: the basic properties are defined in the Policy-
Based VPN element’s properties. All other settings, including the included gateways, Sites, and tunnels are
configured in the Policy-Based VPN editing view.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Policy-Based VPNs.

3) Open the correct view for the settings that you want to edit:
• To edit the basic properties, right-click the Policy-Based VPN element, then select Properties.
• To adjust the other settings, right-click the Policy-Based VPN element, then select Edit <element name>.

Define VPN topology for policy-based VPNs
For a valid policy-based VPN, you must have at least two gateways in the VPN. At least one of the gateways
must be listed as a central gateway. The satellite gateways list can be left empty (for a full-mesh topology).

The Policy-Based VPN editing view has three tabs. The gateway selection on the Site-to-Site VPN tab
determines the following:
• Which gateways are included in the VPN.
• Which gateways form tunnels with each other.
• Which gateways contact each other through a hub gateway instead of contacting each other directly.

You define general VPN topology by classifying gateways as Central Gateways or Satellite Gateways. This
classification defines which tunnels are generated on the Tunnels tab, and which gateways can be selected for
mobile VPN access on the Mobile VPN tab.

IPv4 Access rules control which connections use the VPN tunnels. Always check the Access rules after you add
or remove tunnels.

Note:  Each endpoint-to-endpoint tunnel can only exist in one active VPN. If you use the same
two gateway elements in more than one VPN, make sure that the topology does not create
duplicate tunnels. You can also disable any duplicates of existing tunnels on the Tunnels tab.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Policy-Based VPNs.

3) Right-click the Policy-Based VPN element, then select Edit.

4) On the Site-to-Site VPN tab, drag and drop the Gateways you want to include in this VPN into either of the
two panes for the VPN topology.

• If you add a gateway under Central Gateways, the gateway can establish a VPN with any other gateway
in the VPN. The Tunnels tab is populated with tunnels between the endpoints of the gateway you add
and the endpoints of all other gateways in the VPN.

• If you add a gateway under Satellite Gateways, the gateway can establish a VPN only with central
gateways in this VPN. The Tunnels tab is populated with tunnels between the endpoints of the gateway
you add and the endpoints of the central gateways.

• The Issues pane alerts you to any incompatible or missing settings that you must correct.

Note:  Be careful to not unintentionally drop gateways on top of other gateways. Dropping
gateways on top of other gateways creates a forwarding relationship on a hub gateway.

5) (Optional) If you want to forward connections from one VPN tunnel into another through a hub gateway, drag
and drop a gateway on top of another gateway. The gateway is added under the other gateway at the same
level as the Sites.
The Gateway used as a hub requires a special Site configuration.

6) (Optional) If you want to exclude a gateway’s Site (some IP addresses) from this VPN, right-click the Site
element under the gateway, then select Disable.

7) (Optional) Define which VPN Gateways provide Mobile VPN access.

a) On the Mobile VPN tab, select one of the following options:

• Only central Gateways from overall topology — Only the VPN Gateways in the Central
Gateways listed on the Site-to-Site VPN tab provide mobile VPN access.

• All Gateways from overall topology — All VPN Gateways included in the VPN provide mobile VPN
access.

• Selected Gateways below — Only the VPN Gateways that you add to the Mobile VPN Gateways
tree provide mobile VPN access. Drag and drop the VPN Gateways from the Resources pane.

8) Click  Save.

Related concepts
Defining VPN gateways on page 1149
Configuration 4: Basic VPN hub on page 1216

Related tasks
Adjust VPN-specific Site settings on page 1159
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Define VPN tunnel settings for policy-based
VPNs
The Tunnels tab in the Policy-Based VPN editing view allows you to define settings particular to individual
tunnels or disable some tunnels altogether.

The topology of the policy-based VPN (defined on the Site-to-Site VPN tab) determines which tunnels are shown
on the Tunnels tab. If you have set up connection forwarding between the gateways on the Site-to-Site VPN tab,
the number of generated tunnels is reduced according to the relationships and the capabilities of the gateway that
forwards the traffic. The forwarding relationships are shown under Forwarding Gateways.

There are two types of tunnels:

• The Gateway<->Gateway list shows connections between pairs of gateways.
• The Endpoint<->Endpoint list shows the individual connections that form the tunnels in the Gateway<-

>Gateway list. There can be several connections at this level for any Gateway pair if one or both of the
Gateways have multiple endpoints (Multi-Link). If both Gateways have only one endpoint, there is only one
tunnel also at this level for the Gateway pair.

If a VPN Gateway has a Multi-Link VPN configuration, you can select whether to use tunnels as backups or
actively balance traffic between them. Multi-Link is specific to Forcepoint NGFW, and is not part of the IPsec
standard. You might not be able to use Multi-Link with third-party gateways. Satisfactory results can be achieved
if the third-party gateway allows ICMP probes, RTT ICMP probes, and supports DPD. You can disable redundant
tunnels to the third-party gateway on the Tunnels tab if necessary.

This tab is also where you can view the link summary. The link summary is a summary of addresses and settings
that have been configured for individual tunnels. You might want to check the link summary when there are
complex setups involving external components (such as a VPN hub configuration).

Before editing a policy-based VPN that is used in active VPNs, we recommend making a backup of the
Management Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Policy-Based VPNs.

3) Right-click the Policy-Based VPN element, then select Edit.

4) Click the Tunnels tab.

5) (Optional) If there are tunnels listed that are not needed, right-click the tunnel, then select Disable.
Duplicate tunnels are not allowed between VPNs. If another VPN already defines a tunnel between the
same endpoints, disable the duplicate tunnel in one of the VPNs.
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6) If you use pre-shared keys for authentication with external gateways, either set a key with your partner or
export the keys that have been generated for your partner.
To view, change, or export the pre-shared key for a particular tunnel, double-click  in the Key column in
the Gateway<->Gateway list. This pre-shared key is used only with gateway devices. Set pre-shared keys
for third-party VPN clients in the User elements. The Stonesoft VPN Client does not allow pre-shared key
authentication.

CAUTION:  The pre-shared key must be long and random to provide a secure VPN.
Change the pre-shared key periodically (for example, monthly). Make sure that it is not
possible for outsiders to obtain the key while you transfer it to other devices.

7) (Optional) Change the VPN Profile used at the tunnel level to override the profile selected for the VPN
element:
• If you change a profile for a tunnel on the Gateway<->Gateway list, both IKE SA and IPsec SA settings

are overridden from the default for the VPN.
• If you change a profile for a tunnel on the Endpoint<->Endpoint list, only the IPsec SA settings are

overridden from the selection for the main tunnel on the gateway level.

8) (Optional, Multi-Link only) Select the Mode in which Endpoint<->Endpoint links are used.

a) Select a tunnel on the Gateway<->Gateway list.

b) Right-click the Mode column for a link on the Endpoint<->Endpoint list, then select the mode from
the right-click menu.

The Mode that you select for a link overrides the Mode setting in the endpoint properties. You can also
configure the link’s Mode to be automatically calculated based on the Mode defined for the endpoints. You
can also define QoS Exceptions to select the Mode based on the QoS class of the traffic that is directed to
the link.

9) (Optional) To review the IP addresses and settings used in the individual tunnels, right-click the tunnels on
the Endpoint<->Endpoint list, then select View Link Summary.

10) After making all changes, check the Validity column for all tunnels.

a) If a tunnel has a warning icon in the Validity column, right-click the tunnel, then select View Issues.

b) Resolve all problems indicated in the messages shown.

If all tunnels are shown as valid, the policy-based VPN is correctly configured, although the Management
Server cannot check all possible problems in this view. More issues might be shown at policy installation.
Any validation and issues that are shown for external gateways are based only on the definitions that have
been entered manually into the related elements.

11) Click  Save.

Next steps

Add Access rules and possibly also NAT rules to direct outgoing traffic to the VPN and allow incoming traffic from
the VPN.
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Related concepts
Defining VPN gateways on page 1149
Defining Policy-Based VPN elements on page 1164
VPN certificates and how they work on page 1221

Related tasks
Back up system configurations on page 1263

Change VPN link modes in policy-based VPNs
The mode of a VPN link determines how the link is used for VPN traffic.

You can select the Mode in which End-Point<->End-Point tunnels are used if there are multiple links between
two Gateways (Multi-Link configuration). The Mode you select is the default mode for the link.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Policy-Based VPNs.

3) Right-click the Policy-Based VPN element, then select Edit <element name>.

4) On the Tunnels tab, select a tunnel on the Gateway<->Gateway list.
The links between the gateways are displayed in the End-Point<->End-Point list.

5) Right-click the Mode column for a link on the End-Point<->End-Point list, then select Edit Mode.

6) Configure the settings.

7) Click OK.

Related tasks
Create QoS Class elements on page 957

Access rules for policy-based VPNs
The firewall IPv4 Access rules define which traffic is sent to the policy-based VPN and which traffic is allowed out
of the policy-based VPN.

These checks are made in addition to the enforcement of the Site definitions of the Gateways, which define the
allowed source and destination addresses for each VPN.
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No traffic is sent through the policy-based VPN until you direct traffic to the VPN in the IPv4 or IPv6 Access rules.
The Policy-Based VPN element must be referenced in at least one IPv4 Access rule or IPv6 Access rule. The
communications required to establish the VPN are allowed based on the policy-based VPN definitions and the
rules in the Firewall Template. You do not need to specifically include the gateway addresses in the Access rules
if your policy is based on the Firewall Template. You might need to allow traffic to the gateway addresses if you
use your own customized top-level template policy.

VPN Access rules behave basically the same as all other Access rules: you define certain matching criteria and
all traffic that matches is then handled according to the Action set for the rule. The Use VPN rule action has three
main options, which have different effects depending on the source and destination of the traffic:
• Apply — Directs traffic from protected local networks into the policy-based VPN tunnel. It allows traffic

that arrives through a policy-based VPN to proceed. The rule does not match non-VPN traffic from outside
networks into the protected networks regardless of whether the other cells in the rule match. This action allows
handling special cases in which VPN and cleartext traffic that match the same rule must be passed through
the firewall.

• Enforce — Directs traffic from protected local networks into the policy-based VPN tunnel. It allows traffic that
arrives through a policy-based VPN to proceed. The rule drops non-VPN connections from outside networks
into the protected networks if the other cells in the rule match the connection.

• Forward — Directs traffic from protected local networks or from a policy-based VPN tunnel into another
policy-based VPN tunnel. This action is useful for forwarding connections from one policy-based VPN tunnel
into another (VPN hub configuration), or from local networks to VPN client computers that are currently
connected.

When traffic is sent out through a policy-based VPN, the correct tunnel is selected based on the Sites of the
gateway elements. If a VPN Access rule matches a connection with a source or destination IP address that is not
included in the Sites, tunnel selection fails. The connection is dropped.

Incoming connections that arrive through the policy-based VPN are matched just like connections that do not use
a VPN. Incoming connections do not have to match a VPN Access rule to be allowed in through the policy-based
VPN. Any Access rule can match a policy-based VPN connection. You can use the Source VPN cell to match
traffic based on whether the traffic is coming from a policy-based VPN tunnel. When the Source VPN cell is set to
match policy-based VPNs, the rule only matches traffic from the selected policy-based VPNs. The cell can also
be set to only match non-VPN traffic, or traffic from VPN clients. Access rules that do not have any Source VPN
definition can match any traffic, including traffic that is received through a VPN.

Note:  We recommend activating logging for the policy-based VPN rules for initial testing even
if you do not plan to log the connections that use the policy-based VPN later. VPN negotiations
between the gateways are always logged.

NAT rules only apply to the encrypted packets (the VPN tunnel) by default. The addresses of the packets going
through the policy-based VPN tunnel are translated if you specifically enable NAT for the policy-based VPN. With
NAT, the traffic in the policy-based VPN tunnel uses the translated addresses, so you must define the Sites using
the translated addresses.

Note:  NAT is needed for the NAT Pool feature in VPN client communications and for the Server
Pool feature in inbound traffic management. To use these features in a policy-based VPN, NAT
must be enabled in the properties of the Policy-Based VPN element.
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Create rules for gateway connections in policy-
based VPNs
The Firewall Template policy contains rules that allow the policy-based VPN traffic to form and maintain tunnels.
If you use a custom top-level template, you must allow this traffic in the policy.

If you use a custom top-level template, make sure that at least the ISAKMP (UDP) Service is allowed between
the gateways. You might also need to open other ports if encapsulation is used.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Create rules for incoming site-to-site VPN traffic,

a) To allow traffic from a single policy-based VPN with an Apply or Enforce action, insert the following
type of rule:

Table 134: Basic rule for allowing incoming VPN traffic from a single policy-based VPN

Source Destination Service Action

Remote
networks.

Local
networks.

Set as
needed.

Select Use VPN, change the Action to Apply or
Enforce, then click Select to add the Policy-Based VPN
element.

b) (Optional) To match the rule based on whether traffic is using a policy-based VPN, insert the following
type of rule:

Table 135: Rule for allowing incoming policy-based VPN traffic from any number of different
policy-based VPNs

Source Destination Service Action Source VPN

Remote
networks.

Local
networks.

Set as
needed.

Select
Allow.

Double-click the cell to edit it. To ignore this
rule for non- VPN traffic, select Match traffic
based on source VPN. Add one or more
Policy-Based VPN elements according to
where the traffic is coming from. This rule does
not match traffic from other sources.

2) To create rules for outgoing policy-based VPN traffic, insert the following type of rule:

Table 136: Basic rule for outgoing VPN traffic

Source Destination Service Action

Local
networks.

Remote
networks.

Set as
needed.

Select Use VPN, then click Select to add the Policy-Based
VPN element (the Apply, Enforce, and Forward actions are
all identical in this use).

Note:  If Access rules send traffic into a policy-based VPN, but the source or destination IP
addresses are not included in the Site definitions, the traffic is dropped. This configuration
error is shown as the message “tunnel selection failed” in the logs.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Configuring VPNs | 1175

Create rules for VPN client connections in
policy-based VPNs
The Firewall Template policy contains rules that allows policy-based VPN traffic to form and maintain the tunnels.
VPN client user authentication is also allowed as part of this VPN connection establishment process. If you use a
custom top-level template, you must allow this traffic in the policy.

If your Firewall Policy is based on the Firewall Template policy, there is no need to create rules for VPN client
connections. If your Firewall Policy is based on a custom top-level template, make sure that the policy allows the
correct Services.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) To allow incoming connections from VPN clients, insert the following type of rule:

Table 137: Rule for allowing incoming traffic from VPN clients

Source Destination Service Action Authentication

VPN clients’
Virtual
Adapter
address
space or
ANY if Virtual
Adapters are
not used.

Local
networks.

Set as
needed.

Select Use VPN, change the
Action to Apply or Enforce,
then click Select to add the
Policy-Based VPN element.

Double-click the cell to edit.
Add User or User Group
elements and allowed
Authentication Methods.

• When a policy-based VPN and Authentication Methods are specified in the installed policy, the
corresponding configurations are activated on the firewall. Connections from VPN client users are also
matched against all other rules.

• Any users who can authenticate using the specified authentication method can connect with a VPN client.
Any such connected users can access resources if there is a matching rule that allows connections
without specific Users defined. You can also use the Source VPN cell to prevent unwanted matches in
Access rules.

• When filled in, the User and Authentication cells are equal to Source, Destination, and Service as rule
matching criteria. Matching continues from the next rule if the defined User and Authentication Method do
not match the connection that is being examined. You can, for example, create rules that give the same
user access to different resources depending on the authentication method used.
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2) (Optional) To allow internal hosts to open connections to the VPN client computers when the VPN is active,
insert the following type of rule:

Table 138: Rule for sending traffic to VPN clients

Source Destination Service Action

Local networks. VPN clients’
Virtual Adapter
address space.

Set as needed. Select Use VPN, then change the Action to
Forward. Add a specific Policy-Based VPN element
or select the Any Mobile VPN option to match any
VPN client connection.

• To use the policy-based VPN, the connecting hosts’ IP addresses must be included in the gateway’s Site
definition.

• If NAT is used inside tunnels of this policy-based VPN, add a NAT rule for this traffic direction.

Related concepts
Defining VPN gateways on page 1149
Defining Policy-Based VPN elements on page 1164
Defining Site elements for VPN gateways on page 1156

Create forwarding rules on hub gateways for
policy-based VPNs
Create rules for forwarding policy-based VPN traffic from one tunnel to another and for forwarding tunneled traffic
to the Internet.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) To forward policy-based VPN traffic from one tunnel to another, insert the following type of rule:

Table 139: Basic rule for forwarding policy-based VPN traffic

Source Destination Service Action Source VPN

Addresses
in remote
(spoke)
networks as
needed.

Addresses
in remote
(spoke)
networks as
needed.

Set as
needed.

Select Use VPN, change
the Action to Forward,
then click Select to add the
Policy-Based VPN element
into which matching traffic is
forwarded.

Double-click the cell to edit.
Select Match traffic based
on source VPN, then add
one or more Policy-Based
VPN elements according to
where the traffic is coming
from.
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2) To forward tunneled traffic to the Internet, insert the following type of rule:

Table 140: Rule for allowing traffic except if it arrives through policy-based VPNs

Source Destination Service Action Source VPN

Set as
needed.

Set as
needed.

Set as
needed.

Select
Allow.

Double-click the cell to edit. Select Match traffic
based on source VPN, then add one or more
Policy-Based VPN elements according to where
the traffic is coming from. This rule does not
match traffic from other sources.

In most cases, the source IP addresses are from a private address space. You must add a NAT rule to
translate them to publicly routable IP addresses. Make sure that NAT is enabled in the properties of the
Policy-Based VPN element. Add a NAT rule for the VPN traffic if a suitable NAT rule does not exist already.

3) Configure the remote gateway or VPN clients to forward all traffic to the VPN.
• VPN clients — Configure the DHCP server to assign the hub gateway as the default gateway for the VPN

clients.
• Forcepoint NGFW gateways — Create a VPN rule that directs all traffic to the policy-based VPN with the

hub gateway.

Note:  For the traffic to be allowed into the VPN, the destination IP address must be part
of the Site definition of the hub gateway. When you forward Internet traffic, the hub’s Site
must usually include the Any Network element. This Site can interfere with other VPN
configurations. We recommend disabling it in other VPNs.

Related concepts
Defining VPN gateways on page 1149
Defining Policy-Based VPN elements on page 1164
Configuration 4: Basic VPN hub on page 1216
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Prevent other Access rules from matching
policy-based VPN traffic
Create rules that do not match connections opened through a policy-based VPN.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Insert the following type of rule:

Table 141: Rule for allowing traffic except if it arrives through VPNs

Source Destination Service Action Source VPN

Set as
needed.

Set as
needed.

Set as
needed.

Set as
needed.

Double-click the cell to change settings. Select
Match traffic based on source VPN option,
then select Rule does not match traffic from
any VPN.

Create NAT rules for policy-based VPN traffic
If you want to apply NAT to traffic inside a policy-based VPN tunnel, you must allow NAT in the properties of the
Policy-Based VPN element.

NAT rules are always applied to encrypted communications that have the gateways as their source and
destination. NAT is not applied to traffic that uses a policy-based VPN tunnel.
Observe the following guidelines:

• Define Sites (encryption domains) that contain the translated IP addresses that the packets use when they
are inside the policy-based VPN tunnel. Set the Sites that contain the real IP addresses to Private mode in the
policy-based VPN.
For example, if you translate IP addresses of traffic going into the policy-based VPN, add a Site that includes
the translated IP addresses to your VPN Gateway element. The Sites that contain the internal addresses are
set to Private mode.

• If address translation for VPN clients is enabled for the firewall in the Engine Editor, NAT Pool translation is
applied before the NAT rules. NAT rules cannot match traffic to which NAT pool translation is applied. NAT
Pool is the preferred method for translating VPN client addresses.

• If you want to forward traffic originating from VPN clients to the Internet, you must typically have at least
two NAT rules. The first rule is for connections to internal resources to prevent NAT from being applied or
to translate to an internal IP address as necessary. The second rule translates internal IP addresses to an
external IP address for the Internet connections.

The order of processing for traffic going into a policy-based VPN tunnel is:

Access Rules | NAT Rules | VPN tunnel.

The order of processing for traffic coming out of a VPN tunnel is:

Access Rules | (VPN client NAT Pool) | NAT Rules | Internal Network.

Other than these guidelines, there are no other VPN-specific issues with NAT rules. The first matching NAT rule
is applied to those connections that are matched against the NAT rules and the rest of the NAT rules are ignored.
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Related concepts
Defining VPN gateways on page 1149
Defining Policy-Based VPN elements on page 1164
Getting started with NAT rules on page 835

Related tasks
Adjust VPN-specific Site settings on page 1159

Monitoring policy-based VPNs
You can monitor the status of VPNs in the Home view. The overall status of the VPNs and the tunnels they
contain is shown in the tree of monitored elements.

Logging for policy-based VPNs is separate for the tunnels and the traffic that uses the tunnels:
• VPN negotiations are always logged (regardless of the logging options in Access rules) as informational

messages.
• More detailed logging is available when you activate IPsec diagnostic logging for the Firewall/ VPN engine for

troubleshooting purposes.
• The traffic using the VPN tunnels is logged according to the logging options in the rule that allows the traffic in

or out of the VPN.
• The Home view provides shortcuts to logs filtered for the specific policy-based VPN or VPN Gateway element

referenced in the log event.
• Right-click a policy-based VPN in the Status tree, then select Monitoring > Logs by VPN.
• Right-click a VPN Gateway in the Status tree or connectivity diagram, then select Monitoring > Logs by

VPN Gateway.
• Right-click the connection between two VPN Gateways in the connectivity diagram, then select

Monitoring > Logs by VPN Gateways to view logs of traffic between the two VPN Gateways.

Log pruning filters can delete some (or even all) of the generated messages.

Related concepts
Access rules for policy-based VPNs on page 1172
Defining VPN gateways on page 1149
Defining Policy-Based VPN elements on page 1164
How component statuses are indicated on page 193
Information about IPsec tunnels in logs on page 1401

Related tasks
Enable or disable diagnostics on engines on page 339
Define logging options for Access rules on page 875
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Define Mobile VPNs
You can use both SSL VPN and IPsec tunnels together in the mobile VPN configuration in the same policy-based
VPN.

Mobile VPNs are not supported with route-based VPNs.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Configure VPN Client settings in the Engine Editor.

a) Right-click a Firewall element, then select Edit <element type>.

b) Browse to VPN > VPN Client.

c) Configure the settings.

d) (Optional) Configure the settings on the Advanced branch.

e) Click  Save and Refresh to save the changes to the configuration and refresh the policy on the
engine.

2) Create a policy-based VPN or edit an existing policy-based VPN.

3) On the Mobile VPN tab of the policy-based VPN, select one of the following options to define which VPN
Gateways provide mobile VPN access:
• Only central Gateways from overall topology — Only the VPN Gateways in the Central Gateways list

on the Site-to-Site VPN tab provide mobile VPN access.
• All Gateways from overall topology — All VPN Gateways included in the VPN provide mobile VPN

access.
• Selected Gateways below — Only the VPN Gateways that you add to the Mobile VPN Gateways list

provide mobile VPN access. Drag and drop the VPN Gateways from the Resources pane.

4) Click  Save.

Configuring route-based VPNs
Route-based VPNs are implemented according to IPsec standards.

The information here assumes that you are already familiar with the basic concepts of building IPsec VPNs and
concentrates on the features available in Forcepoint NGFW. Understanding basic IPsec concepts helps you
configure VPNs. We recommend reading the general overview to VPNs and IPsec before moving on to this
section.

Route-Based VPN Tunnel elements represent endpoints on the engine. Tunnel Interfaces allow routing
information to be used to determine the correct VPN tunnel to use.

When route-based VPN tunnels uses IPsec in transport mode between tunnel endpoints, the packets are not
encapsulated into new IPsec packets. Instead, the original headers of the packet are left intact, and the IP
payload of the packet is encrypted. IPsec transport mode is used to encrypt the packets. Other encapsulation,
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such as generic routing encapsulation (GRE) or IP in IP (IP-IP), must be used to add the tunnel endpoint IP
addresses in front of the original packet header.

When a route-based VPN tunnel uses IPsec in tunnel mode, the encryption is provided by a policy-based VPN.

In route-based VPNs, the routing defines which traffic is sent through the VPN tunnel. The Antispoofing
configuration is automatically generated for tunnel interfaces. The routing configuration also determines the
physical network interfaces on the engine to which the tunnel interfaces are automatically mapped. You can
statically define which networks are reachable through each tunnel interface. You can also use dynamic routing
to create the routes for traffic to be sent through the VPN tunnels.

1) Create a tunnel interface for one end of the VPN.

2) Create a tunnel interface for the other end of the VPN.

3) Create a Route-Based VPN Tunnel element that references both ends of the VPN.

4) (Optional) Create Monitoring Groups to group Route-Based VPN Tunnel elements.

5) Create Access rules to allow traffic between the internal network and the networks that are reachable
through the route-based VPNs.

Default elements for route-based VPNs
Route-based VPNs use Route-Based VPN Tunnel elements to define the endpoints on the engine.

In the Route-Based VPN Tunnel element, you can select the tunnel type and a VPN Profile to use.

If you have not defined all the VPN Gateways, when creating the tunnel, you can define only one of the gateways
to use, and add the missing VPN Gateway later, when it is available.

Each tunnel can be added to a Monitoring Group element. The groups allow you to organize the tunnels, and you
can view the groups in the VPN section in the Home view.

Using route-based VPNs for dynamic routing
Route-based VPNs can protect and route dynamic routing communications between sites to protect the
confidentiality and integrity of the dynamic routing communications.

Routing protocols, such as RIP, OSPF, and BGP, send non-routable multicast packets between routing devices,
such as routers and firewalls. Because IPsec accepts only unicast traffic, these packets cannot be directly
sent into IPsec tunnels. Instead, dynamic routing communications are forwarded to tunnel interfaces, which
encapsulate the traffic and send it into the route-based VPN tunnel. The following configuration considerations
apply when route-based VPNs are used to protect dynamic routing protocols:

• The TTL value for the tunnel must be high enough to allow the packets to be routed through each hop in the
route.

• If IP addresses are defined for tunnel interfaces, the netmask must be defined according to the functionality of
the interface. For OSPF, the peers must belong to the same subnet.
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Add tunnel interfaces for NGFW Engines
Tunnel interfaces are logical interfaces.

Any traffic that is routed to a tunnel interface and allowed by Access rules is automatically sent through the tunnel
to the peer endpoint defined in the Route-Based VPN Tunnel element. Tunnel interfaces are only used in route-
based VPNs.

You can optionally add IPv4 or IPv6 addresses to a tunnel interface. Tunnel interfaces can only have static IP
addresses. Any IP address can be added to a tunnel interface, even if the same IP address is used on another
interface or as a loopback IP address. Adding an IP address to a tunnel interface allows you to define the source
IP address of traffic sent from the NGFW Engine itself. For example, an IP address is recommended to provide
a source IP address for dynamic routing daemons, for IGMP proxy, and for Protocol Independent Multicast -
Sparse-Mode (PIM-SM) configuration. If no IP address is added to the tunnel interface, the source IP address
for traffic sent from the NGFW Engine is automatically selected. The selection is done according to the Bypass
Default IP Address setting in the interface options for the NGFW Engine.

The mapping of tunnel interfaces to physical network interfaces on the NGFW Engine is done automatically
based on the routing configuration.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an NGFW Engine, then select Edit <element type>.

2) Browse to Interfaces.

3) Click Add, then select Tunnel Interface.

4) Configure the settings.

5) Click OK.

6) If you want to add a source IP address for traffic sent from the engine node, add IPv4 addresses or IPv6
addresses to the tunnels.

7) If you do not want to add IP addresses, select system communication roles for firewall interfaces to define
how the source IP address for traffic sent from the engine node is selected.

8) Click  Save and Refresh.

Create Route-Based VPN Tunnel elements
Create tunnels to use in route-based VPNs.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Route-Based VPN Tunnels.
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3) Right-click Route-Based VPN Tunnels, then select New Route-Based VPN Tunnel.

4) Configure the settings.

5) Click OK.

6) Click  Save.

Related concepts
Defining VPN gateways on page 1149
Getting started with Access rules on page 817
Changing pre-shared keys for VPNs on page 1244

Related tasks
Add tunnel interfaces for firewalls on page 556
Define endpoints for VPN Gateway elements on page 1150
Add loopback IP addresses for Single Firewalls on page 571

Create Monitoring Group elements
You can group Route-Based VPN Tunnel elements, then monitor them in the Home view.

Note:  To add multiple existing Route-Based VPN Tunnel elements to a monitoring group, select
the elements, right-click, then select Tools > Select Monitoring Group.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Other Elements > Monitoring Groups.

3) Right-click Monitoring Groups, then select New Monitoring Group.

4) Configure the settings.

5) Click OK.
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Use a policy-based VPN to encrypt tunnels in
route-based VPNs
You can use a policy-based VPN to provide encryption for route-based VPN tunnels.

Before you begin
Define the policy-based VPNs that provide the encryption.

Using a policy-based VPN to encrypt tunnels in a route-based VPN allows you to do the following:

• Encrypt multiple tunnels in the same VPN tunnel. This configuration improves compatibility with third-party
devices and cloud-based services that do not support multiple, separately encrypted tunnels.

• Create multiple tunnels between remote and local sites when only one public IP address is available.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Create a Host element.

a) Select  Configuration, then browse to Network Elements.

b) Right-click Hosts, then select New Host.

c) In the IPv4 Address or IPv6 Address field, enter the same IP address as the endpoint you use in the
route-based VPN.

Note:  You might receive a warning that the IP address of the Host element is not unique.
Ignore the warning and save the element.

d) Configure the other settings according to your needs.

e) Click OK.

2) Configure the VPN settings for the firewall that acts as the VPN gateway.

a) Right-click the NGFW Engine, then select Edit <element type>.

b) Browse to VPN > Endpoints, then define at least two endpoints: one for the policy-based VPN and one
for the route-based VPN.

c) Browse to Sites, then add the Host element to the site for the VPN Gateway.

d) Click  Save.

3) Configure the policy-based VPN that provides the encryption.

a) Open the policy-based VPN for editing.

b) On the Site-to-Site VPN tab, add the VPN Gateway that represents the firewall to the Central
Gateways or Satellite Gateways list.
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c) Click  Save.

4) Create the Route-Based VPN Tunnel element.

a) Select  Configuration, then browse to VPN.

b) Browse to Route-Based VPN Tunnels.

c) Right-click Route-Based VPN Tunnels, then select New Route-Based VPN Tunnel.

d) Use the following settings:

Setting Configuration

Tunnel type GRE, IP-IP, or SIT.

Encryption Tunnel Mode.

VPN Select the policy-based VPN that provides the encryption.

Local firewall Select the same VPN Gateway that is used in the policy-based VPN.

CVI Select the CVI that has the same IP address as the endpoint that is used in
the policy-based VPN.

Configure the other settings according to your needs.

e) Click OK.

5) Add Access rules to allow traffic between the internal network and the networks that are reachable through
the route-based VPN tunnels.

Note:  The Access rules that direct the route-based VPN traffic into the policy-based VPN are
automatically generated for the Firewalls associated with the VPN Gateway elements. The
rules are not visible in the Firewall policy, and cannot be edited. If a policy that contains the
automatically generated rules is installed on a Firewall that is not involved in the VPN, the
rules are ignored.

a) Open the Firewall policy for editing.

b) Add IPv4 Access rules or IPv6 Access rules that have the following settings:

Source Destination Service Action

Elements that
represent
the internal
network

Elements that represent the
networks that are reachable
through the route-based VPN
tunnels.

Select a service, or set to ANY. Allow

Configure the other settings for the rules according to your needs.

c) Click  Save.

d) Install the policy on all Firewalls that are involved in the VPNs.
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Related concepts
Getting started with Access rules on page 817

Related tasks
Create an External VPN Gateway element on page 1152
Add a VPN site on page 1158

SSL VPN configuration
SSL VPNs use secure sockets layer (SSL) encryption to provide secure remote access. SSL VPNs allow
authenticated users to establish secure connections to internal HTTP and HTTPS services through a standard
web browser or through a client application that allows direct network access.

Access to HTTP-based services is provided by the SSL VPN Portal. The SSL VPN Portal is an integrated feature
of Forcepoint NGFW. It provides remote access to applications and information in the protected network from
standard web browsers. End users must authenticate to access the SSL VPN Portal webpage. You can configure
single sign-on (SSO), to allow users to access different services under the same Domain without logging on
to each service separately. The SSL VPN Portal proxies end-user connections to HTTP-based services in the
protected network. The end user is never directly connected to the back-end services.

Encrypted connections to other services are provided by SSL VPN tunnels for the Stonesoft VPN Client solution.
SSL VPN tunnels can be used with the Stonesoft VPN Client solution in mobile VPNs. You can use SSL VPN
tunnels alone, IPsec tunnels alone, or both SSL VPN and IPsec tunnels together in the same policy-based VPN.

Set up the SSL VPN Portal
The SSL VPN Portal provides secure browser-based access to services in the protected network.

Make services available in the SSL VPN Portal
SSL VPN Portal Services map external URLs to HTTP-based services in the protected network.

SSL VPN Portal Service elements contain settings that define how the internal URLs of the HTTP-based services
are translated to external URLs. URL translation makes sure that all traffic to registered web resource hosts is
routed through the SSL VPN Portal. End users can access the SSL VPN Portal Services through the SSL VPN
Portal, or directly through web browser bookmarks.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to SSL VPN Portal > SSL VPN Portal Services.

3) Right-click SSL VPN Portal Services, then select New SSL VPN Portal Service.
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4) In the Name field, enter a unique name.

Note:  The name must only contain letters, numbers, dashes (-), and underscores (_).The
name cannot contain spaces.

5) From the Link Translation drop-down list, select how incoming connections are routed to services in the
protected network.

6) (Only when the link translation method is URL Rewrite or DNS Mapping) Click Select next to the Profile
field to select an SSL VPN Service Profile element.
The profile contains settings for SSO and cookie protection.

7) If you selected URL Rewrite, configure the following settings to define URL translation:

a) In the External URL Prefix field, enter a forward slash (/) followed by a unique prefix.

b) In the Internal URL field, enter the URL of the service in the protected network.

8) If you selected DNS Mapping, configure the following settings to define URL translation:

a) In the External URL field, enter the URL where users can access the service. The URL must be an
HTTPS URL and a valid host name with a top-level domain.

b) In the Internal URL field, enter the URL of the service in the protected network.

c) Specify the certificate that is used for HTTPS connections in one of the following ways:

• Click Select, then select a TLS Credentials element.
• To create and use a self-signed certificate, select Use Self-Signed Certificate.

9) If you selected Freeform URL, configure the following settings to define URL translation:

a) From the Cookie Protection options, select On or Off.

b) Below the Allowed URLs table, click Add, then enter one or more host names or IP addresses.

c) Below the Trusted CAs field, click Add, then select the Certificate Authority to be used with the
service.

10) On the Look & Feel tab, configure how the service appears on the SSL VPN Portal webpage.

11) Click OK.

Next steps

You are now ready to define which users are allowed to access the services.
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Allow access to services using the SSL VPN
Portal
The SSL VPN Portal Policy defines which services are available in the SSL VPN Portal and which users can
access the services.

Before you begin
You must have one or more SSL VPN Portal Service elements.

The SSL VPN Portal Policy contains rules that define which users can use each SSL VPN Portal Service, and the
authentication requirements for accessing the SSL VPN Portal Services.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Create an SSL VPN Portal Policy.

a) Expand the SSL VPN Portal branch.

b) Right-click SSL VPN Portal Policies and select New SSL VPN Portal Policy.

c) In the Name field, enter a unique name.

d) Click OK.
The SSL VPN Portal Policy opens for editing in a new tab.

3) Add rules in one of the following ways:
• Right-click the last row of an empty policy and select Add Rule.
• Right-click the ID cell of an existing rule and select Add Rule Before or Add Rule After.

4) Drag and drop one or more SSL VPN Portal Service elements from the Resources pane to the SSL VPN
Portal Service cell.

5) Drag and drop one or more User or User Group elements from the Resources pane to the Authentication
cell.

6) Save the SSL VPN Portal Policy.

Next steps

You are now ready to select the SSL VPN Portal Policy for an SSL VPN Portal element.
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Enable the SSL VPN Portal
Create and enable the SSL VPN Portal to make the SSL VPN Portal available through one or more firewalls.

Before you begin
You must have an SSL VPN Portal Policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to SSL VPN Portal > SSL VPN Portals.

3) Right-click SSL VPN Portals, then select New SSL VPN Portal.

4) In the Name field, enter a unique name.

Note:  The name must only contain letters, numbers, dashes (-), and underscores (_).The
name cannot contain spaces.

5) Next to the SSL VPN Portal Policy field, click Select, then select an SSL VPN Portal Policy.

6) Next to the Hostnames table, click Add, then add one or more host names.
Enter the domain name or IP address that the user enters in their web browser to access the SSL VPN
Portal.

7) Next to the Server Credentials table, click Select, then select a TLS Credentials element. Alternatively,
select Use Self-Signed Certificate to create and use a self-signed certificate.

8) On the Look & Feel tab, configure the look and feel settings.

a) In the Title field, enter the title to show in the end user's web browser when they access the SSL VPN
Portal webpage.

b) From the Look & Feel drop-down list, select an option, or select Custom to create a customized look
and feel for the SSL VPN Portal.

c) If you selected Custom, configure the options.

d) (Optional) To view the changes you have made, select Preview SSL VPN Portal Webpage or
Preview SSL VPN Portal Logon Webpage .

9) On the Target Engine tab, select one or more firewalls for which you want to enable the SSL VPN Portal.

a) Click Add to add a row to the table.

b) Double-click the Target Engine cell, then select the firewall for which you want to enable the SSL
VPN Portal.
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10) On the Advanced tab, configure the advanced settings.

11) Click OK.

Note:  After you have created an SSL VPN Portal element, you can enable it in an engine
in the Engine Editor.

The SSL VPN Portal is now available through the firewalls that you added to the Target Engine table.

Edit the engine-specific SSL VPN Portal
settings
You can edit the engine-specific SSL VPN Portal settings in the Engine Editor.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click an engine element, then select Edit <element type>.

2) Browse to VPN > SSL VPN Portal.
The SSL VPN Properties pane opens on the right.

3) Click Select to select the SSL VPN Portal you want to use.

4) Click  Save and Refresh to transfer the new configuration to the engines.

Select SSL cryptographic algorithms for the
SSL VPN
If you need to change the SSL cryptographic algorithms used by the SSL VPN Portal, you can create a TLS
Cryptography Suite Set element to define which cryptographic algorithms are allowed.

The default NIST (SP 800-52) Compatible SSL Cryptographic Algorithms element allows SSL cryptographic
algorithms that are compatible with the following standard: NIST SP 800-52 Rev. 1 Guidelines for the Selection,
Configuration, and Use of Transport Layer Security (TLS) Implementations. If the default SSL cryptographic
algorithms meet your needs, there is no need to create a custom TLS Cryptography Suite Set element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Expand the Other Elements branch.

3) Right-click TLS Cryptography Suite Sets and select New TLS Cryptography Suite Set.
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4) In the Name field, give the TLS Cryptography Suite Set element a name to easily identify it.

5) Select one or more SSL cryptographic algorithms.
SSL cryptographic algorithms in the Common section are compatible with SSL 3.0, TLS 1.0, TLS 1.1, and
TLS 1.2. SSL cryptographic algorithms in the TLS 1.2 Only section are only compatible with TLS 1.2.

6) Click OK.

Next steps

Select the custom TLS Cryptography Suite Set element in the Engine Editor.

Examples of policy-based VPNs
These examples illustrate some common uses for policy-based VPNs and general steps on how each example is
configured.

Example: creating a policy-based VPN between
three offices
An example of a VPN between two or more locations.

Company A has a central office and two remote offices, each with their own Forcepoint NGFW Firewall/ VPN
device. The company needs secured communications links between the remote offices and the central office for
access to various services, such as file servers, at the central office.

 
Figure 170: Company A’s networks

All shared servers are at the central office, and internal emails and other communications are also handled by the
central servers. There is no need for secure connectivity between the remote offices.

All Firewalls have a public IP address toward the Internet. The internal networks at each site use private IP
addresses. There is no need to translate the VPN traffic, since all offices use their own distinct address space.

The security policy of the company requires certificate-based authentication. The administrators decide to use the
Management Server’s Internal RSA CA for Gateways for issuing the VPN certificates.

The administrators:
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1) Select each engine’s public IP address as the VPN endpoint, then activate automatic certificate
management.

2) Add Site elements for all gateways, then add the entire local internal network as the content for each Site.

3) Create a VPN Profile, and select RSA Encryption as the authentication method. RSA certificates are
automatically generated for each gateway.

4) Create a Policy-Based VPN element called “Inter-Office VPN” that includes the central office gateway as a
central gateway and the two remote site gateways as satellite gateways.

5) Add the following types of Access rules in the policy of the central office firewall:

Source Destination Action

Network elements for remote
office 1 and remote office 2
internal IP addresses

Network elements for central
office’s internal networks

Use VPN - Enforce VPN “Inter-
office VPN”

Network elements for central
office’s internal networks

Network elements for remote
office 1 and remote office 2
internal IP addresses

Use VPN - Enforce VPN “Inter-
office VPN”

6) Add the following types of Access rules in the policies of both remote office firewalls:

Source Destination Action

Network element for each remote
office’s internal IP addresses

Network elements for central
office’s internal networks

Use VPN - Enforce VPN “Inter-
office VPN”

Network elements for central
office’s internal networks

Network element for each remote
office’s internal IP addresses

Use VPN - Enforce VPN “Inter-
office VPN”

Example: creating a policy-based VPN for
mobile users
An example of a policy-based VPN that allows mobile users to authenticate and connect to internal networks.

Company A has service technicians and salespeople who must be able to connect to their office networks to
access information when they are on customer visits. The administrators need to add VPN client access to
the existing VPN infrastructure. The administrators decide to use Stonesoft VPN Client. As the authentication
method, the administrators decide to use passwords stored in the Management Server’s internal database.

The administrators also want to provide only one point of access so that the users do not have to select which
gateway to connect to. The central office has site-to-site VPN tunnels to both remote offices that can be used
for forwarding traffic to those sites as needed. The existing DHCP server at the central office can be used
for assigning IP addresses to the VPN clients’ Virtual Adapter. A Virtual Adapter is required for this type of
forwarding.

The administrators:

1) Edit the central office firewall element, then activate the Virtual Adapter method for VPN client address
management.
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2) Edit the VPN Profile to use Hybrid Authentication for authenticating the VPN client users.

3) Create a Policy-Based VPN element called “Remote User VPN” that includes the central office gateway as
a Central Gateway.

4) Select the Only central Gateways from overall topology option on the Mobile VPN tab.

5) Create a “Forward Addresses” Site element under the central office gateway.

6) Populate the site with the remote office networks to route those IP addresses through the “Remote User
VPN”.

7) Disable the “Forward Addresses” Site in the existing “Inter-Office VPN” between the central office and
the remote offices. Sites are global for all policy-based VPNs, so this Site must be disabled to avoid a
misconfiguration in the Inter-Office VPN.

8) Create User Group and User elements to define the user names and passwords for the VPN client users.

9) Add the following Access rules in the policy of the central office firewall:

Source Destination Action Users Authentication Source VPN

ANY Central office
internal
networks

Use VPN -
Enforce VPN
“Remote User
VPN”

“VPN Client
Users” User
Group

“User
Password”
Authentication
Service

VPN Client
DHCP
addresses

Remote offices’
internal IP
addresses

Use VPN -
Forward VPN
“Inter- Office
VPN”

Rule matches
traffic from any
VPN client

10) Create a customized Stonesoft VPN Client installation package for Windows. A customized installation
package allows users of Stonesoft VPN Client for Windows to install using a silent installation package that
does not require their input. The administrators include the gateway contact information in the package so
that the users do not need to enter it manually even when they use the Stonesoft VPN Client for the first
time.

Example: creating a policy-based VPN that
requires NAT
An example of a policy-based VPN where NAT is used to translate between its internal and external IP
addresses.

Company B has decided to partner with Company C for a large project. Since the companies need to exchange
sensitive information, they decide to establish a VPN.

The external gateway device is behind a NAT device that translates between its internal and external IP address.
Both addresses are needed in the policy-based VPN configuration.

Both companies also use the same address space internally, so they must apply NAT for all connections through
the policy-based VPN as well.
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Figure 171: NAT for a policy-based VPN between two gateways

NAT is applied at both companies before traffic enters the VPN from each end. Routing problems caused by the
same address space appearing in two different networks can be avoided, since traffic that is routed into the VPN
uses unique translated addresses.

The administrators:

1) Edit the firewall element and select the engine’s public IP address as the VPN endpoint.

2) Create a Location element and select it for their firewall element.

3) Create an External VPN Gateway element called “Partner Gateway” for the partner’s VPN device and
configure the following IP addresses:
• Select the internal IP address as the VPN endpoint.
• Add the external (translated) IP address as the Contact Address for the Location created in the

previous step.

4) Create a Network element called “HQ NAT Address Space” for the addresses that Company B plans to
use for translating their internal IP addresses. They make sure that these addresses are routable and
unique in Company C’s internal network.

5) Add only the Network element created in the previous step in the Site for the NGFW Engine.

6) Create a Network element called “Partner Network” for the addresses that Company C plans to use for
translating their internal IP addresses. They make sure that these addresses are routable and unique in
Company B’s internal network.

7) Add the “Partner Network” as the only network in the Partner Gateway’s Site.

8) Create a VPN Profile and make sure all settings match the settings agreed with Company C.

9) Create a Policy-Based VPN element called “Partner VPN” that includes the VPN Gateway that represents
the NGFW Engine as a central gateway and the External VPN Gateway as a satellite gateway.

10) Add the following types of Access rules in the policy of their firewall:

Source Destination Action

Network element “Partner
Network”

Network element “HQ NAT
Address Space”

Use VPN - Enforce “Partner
VPN”

Company B’s internal network
(real IP addresses)

Network element “Partner
Network”

Use VPN - Enforce “Partner
VPN”

11) Add the following types of NAT rules in the same policy:
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Source Destination Action

Company B’s internal network
(real IP addresses)

Network element “Partner
Network”

Static source translation to “HQ
NAT Address Space”

To make the static address translation work, the administrators make sure that the translated address
space is as large as the original address space.

Examples of route-based VPNs
These examples illustrate some common uses of route-based VPNs and general steps on how each example is
configured.

Example: protecting dynamic routing
communications with a route-based VPN
An example of protecting communications when public Internet networks are used for backup connectivity.

Company A is a large company with enterprise networks at multiple sites. The networks are currently connected
with a private backbone network that is built with dynamic routing using OSPF. The administrators want to use
public Internet networks for backup connectivity in case the private backbone fails. To route the traffic and to
protect the confidentiality and integrity of the dynamic routing communications, the administrators decide to send
dynamic routing communications through tunnels in a route-based VPN.

The administrators:

1) Define tunnel interfaces on the firewalls that act as VPN Gateways at each site.

2) Add IP addresses to each tunnel interface.

3) Create a Route-Based VPN Tunnel element that specifies the gateways, endpoints, and tunnel interfaces,
and select the appropriate tunnel type and VPN Profile. The following options are used:
• TTL: Default.
• MTU: Default.
• PMTU Discovery: Enabled.

4) Create Access rules that allow traffic between the internal networks and the networks that are reachable
through the route-based VPN.

5) Refresh the policy on the firewalls that act as VPN Gateways.

6) Configure dynamic routing on the engines.
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Example: configuring route-based VPNs with
external gateways
An example of creating a route-based VPN tunnel between an internal and external network.

The administrators at Company B want to create a route-based VPN tunnel between their own network and a
partner’s network. The administrators:

1) Create a Network element to represent the partner’s network.

2) Define a Tunnel Interface on the Company B firewall that acts as the VPN Gateway.

3) Configure routing to define a route to the partner’s network through the Tunnel Interface.

4) Define an External VPN Gateway element to represent the partner company’s gateway device.

5) Add a Route-Based VPN Tunnel element with the following settings:

Local Gateway Remote Gateway

Gateway — VPN Gateway element that represents
the firewall

Gateway — External VPN Gateway element

Endpoint — Endpoint IP address in the Internal
Network

Endpoint — Endpoint IP address in the Partner
Network

Interface — Tunnel Interface defined on the firewall

6) Select an IPsec Profile and an encapsulation Mode that is compatible with the External VPN Gateway.

7) Create an Access rule that allows traffic from the internal network to the partner network that is reachable
through the route-based VPN.

8) Refresh the policy on the firewall that acts as a VPN Gateway.
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 CHAPTER 69

Basic policy-based VPN
configurations

Contents

• Getting started with basic policy-based VPN configurations on page 1197
• Configuration 1: Basic VPN between NGFW Engines on page 1198
• Configuration 2: Basic VPN with a partner gateway on page 1201
• Configuration 3: Basic VPN for remote clients on page 1209
• Configuration 4: Basic VPN hub on page 1216

The following configurations outline specific examples for common policy-based VPN configuration scenarios.

Getting started with basic policy-based
VPN configurations

You can use these examples when setting up your own policy-based VPNs and add other features after the basic
scenario is configured and working.

Note:  VPNs are not supported on Layer 2 Firewalls or on layer 2 physical interfaces on Firewalls.

The following basic configurations are explained:
• Configuration 1 is for creating a site-to-site VPN between two or more NGFW Engines that are managed

through the same Management Server. A default set of VPN settings is used to simplify the configuration.
• Configuration 2 is for creating a site-to-site VPN between an NGFW Engine and an IPsec-compatible VPN

gateway that is not managed through the same Management Server. A customized set of VPN settings is
created. Customized settings are typically mandatory for this configuration. A pre-shared key is used for
authentication.

• Configuration 3 is for creating a mobile VPN between an NGFW Engine and the Stonesoft VPN Client
installed on individual computers. A default set of VPN settings is used to simplify the configuration.

• Configuration 4 is for creating a site-to-site VPN in which several remote gateway connect to a hub gateway.
The hub gateway forwards connections to the other remote gateways as necessary. A default set of VPN
settings is used to simplify the configuration.
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Related concepts
Configuration 1: Basic VPN between NGFW Engines on page 1198
Configuration 2: Basic VPN with a partner gateway on page 1201
Configuration 3: Basic VPN for remote clients on page 1209
Configuration 4: Basic VPN hub on page 1216
VPNs and how they work on page 1127

Configuration 1: Basic VPN between
NGFW Engines

This basic configuration scenario walks you through creating a policy-based VPN between two or more NGFW
Engines managed through the same SMC.

This example VPN requires all firewalls to have a fixed IP address (not DHCP- or PPPoE-assigned).

The address spaces protected by the different NGFW Engines that act as gateways must not overlap within
any single VPN. If you use the same IP addresses at the different locations, you must apply NAT to the
communications. You must also define the sites using the translated IP addresses (the addresses that are used
inside the VPN tunnels).

This scenario uses the default VPN-A Suite VPN profile that contains the VPN settings specified for the VPN-A
cryptographic suite in RFC 4308. The profile uses pre-shared keys for authentication.

Configure the firewall's VPN settings for
configuration 1
You can optionally configure the Sites to use NAT to translate the IP addresses of the hosts that make
connections through this VPN.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Firewall element and select Edit Single Firewall or Edit Firewall Cluster.
The Engine Editor opens.

2) In the navigation pane on the left, browse to VPN > Sites.

3) Drag and drop the networks for the NAT address space on top of the (top-level) automatic Site element on
the right.
The Sites must include only internal networks. Do not add interfaces with the Any Network element in this
type of VPN.

4) Click  Save.
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Related concepts
Defining VPN gateways on page 1149

Create a Policy-Based VPN element for
configuration 1
In this configuration, you must create a Policy-Based VPN element.

Note:  This basic configuration scenario does not explain all settings related to Policy-Based VPN
elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Right-click Policy-Based VPNs in the element tree and select New Policy-Based VPN.

3) In the Name field, enter a unique name.

4) From the Default VPN Profile drop-down list, select VPN-A Suite.

Note:  The VPN Profile element defines most of the IPsec settings. You can optionally
create a custom VPN Profile element.

5) If you want to apply NAT rules to the communications that go through the VPN, select Apply NAT to
traffic that uses this VPN.
This setting does not affect the communications that the two gateways have with each other to set up and
maintain the VPN. Communications between the gateways are always matched to the NAT rules.

6) Click OK.
The VPN Editing view opens on the Site-to-Site VPN tab.

7) To define which gateways can create a VPN with each other, drag and drop two or more VPN Gateway
elements from the Resources pane to the Central Gateways or Satellite Gateways lists.
• If you add a VPN Gateway to the Central Gateways, the VPN Gateway can establish a VPN with any

other VPN Gateway in this VPN (both Central and Satellite). Add at least one of the VPN Gateways
under Central Gateways.

• If you add a VPN Gateway to the Satellite Gateways, the VPN Gateway can establish a VPN only
with VPN Gateways defined as Central in this VPN. You do not have to add any VPN Gateways to the
Satellite Gateways (all gateways can be Central).

Note:  Be careful that you do not accidentally drop VPN Gateway elements on top of other
VPN Gateway elements. This configuration creates a hub topology where the top-level VPN
Gateway forwards connections from other components to the lower-level VPN Gateway.
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8) Click the Tunnels tab.

9) Check that the Validity column in the Gateway<->Gateway and the End-Point<->End-Point tables has a
green checkmark to indicate that there are no problems.

a) If the Validity column of a tunnel has a warning icon, see the Issues pane to check what the problem
is. If the pane is not displayed, select  Menu > View > Panels > Issues.

b) If issues are displayed, correct them as indicated. Long issues are easiest to read by hovering the
cursor over the issue text so that the text is shown as a tooltip.

10) Click  Save to save the Policy-Based VPN.

Related concepts
Defining VPN profiles on page 1162
Defining Policy-Based VPN elements on page 1164

Create Access rules for VPN configuration 1
The rules in this example allow protected hosts to open connections both ways. Two rules are created here to
allow the different directions of traffic separately.

VPN rules are matched based on source, destination, and service like any other rules.

Note:  This basic configuration scenario does not explain all settings related to Access rules for
VPNs.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the Firewall policy used by the NGFW Engines involved in the VPN for editing.

2) Add two IPv4 Access rules in a suitable location in the policy.

• Make sure that these rules are above other rules that match the same traffic with Allow, Discard, or
Refuse as their action.

• Traffic that you do not want to send through the VPN must not match these rules. Traffic that is not
routable through the VPN is dropped if it matches these rules.
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3) Fill in the rules.
If NAT is enabled in the VPN, remember that the Access rules are checked before the NAT rules are applied.

Table 142: Example VPN rules

Source Destination Service Action

Local internal
networks

Remote internal
networks

Set as needed. Select Use VPN, then change the Action
to Enforce, and click Select  to add the
Policy-Based VPN element you created.

Remote internal
networks

Local internal
networks

Set as needed. Select Use VPN, then change the Action
to Enforce, and click Select  to add the
Policy-Based VPN element you created.

4) Save the policy.

5) Add the same rules in the policies of all firewalls involved in the VPN.

CAUTION:  If you continue to use this VPN, change the pre-shared key periodically (for
example, monthly) to guarantee continued confidentiality of your data. Alternatively, you can
switch to certificate-based authentication by creating a custom VPN profile.

6) Refresh the policies of all firewalls involved in the VPN to activate the new configuration.

Result

The VPN is established when traffic matches the Access rules.

Related concepts
Access rules for policy-based VPNs on page 1172
Monitoring policy-based VPNs on page 1179
Changing pre-shared keys for VPNs on page 1244

Related tasks
Find VPN issues on page 1401

Configuration 2: Basic VPN with a
partner gateway

This scenario walks you through creating a site-to-site VPN between one NGFW Engine and one external VPN
gateway that is not managed through the same SMC.

To be able to configure this example VPN, your local firewall must have a fixed IP address (not DHCP- or
PPPoE-assigned).

The address spaces protected by the different VPN Gateways must not overlap within any single VPN. If you use
the same IP addresses at the different locations, you must apply NAT to the communications and define the Sites
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using the translated IP addresses. The translated addresses are the addresses that are used inside the VPN
tunnels.

You can create VPNs with IPsec-compliant gateway devices from many different manufacturers. You can create
VPNs with partner organizations that use a third-party VPN solution. The authentication and encryption options to
use must be decided beforehand in co-operation with the administrator of the other gateway.

This scenario creates a VPN Profile that contains the VPN settings that you match with settings defined on the
external VPN gateway.

Configure the firewall's VPN settings for
configuration 2
If you have already configured VPN settings for the firewall engine, there is no need to change any of the
settings.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Firewall element and select Edit Single Firewall or Edit Firewall Cluster.

2) If the firewall has a dynamic IP address on an interface that faces the Internet, switch to the End-Points tab
and

a) In the navigation pane on the left, browse to VPN > End-Points.

b) Double-click the endpoint in the table.

c) In the Phase 1 ID section at the bottom of the dialog box, change the ID Type to E-mail.

d) Type in an email address in the ID value field and click OK. This email address can be any address that
is not used as an ID in any of your other endpoints.
The address entered here is used only as an identification, not for sending email.

3) In the navigation pane on the left, browse to VPN > Sites. The Sites pane opens on the right.

• The Sites represent the addresses that are routable through the VPN. Sites do not grant any host access
directly. The Access rules define the allowed connections.

• Leave the Add and update addresses based on routing option selected. This option automatically
updates this information based on routing changes. You can exclude some interfaces while keeping the
others automatically updated as explained in the next step.

4) (Optional) Select the internal networks that you want to exclude from the VPN by disabling the interface they
are under in the automatic site. Disabled interfaces are grayed-out.

• If you want to include some individual network that is under an otherwise disabled interface, drag and
drop it from under the disabled interface onto the Site element. The element is copied to the higher level.
The copied definition is not updated automatically.

• The Sites must include only internal networks. Do not add interfaces with the Any Network element to this
type of VPN.
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5) To use NAT to translate the IP addresses of the hosts that make connections through this VPN, drag and
drop the networks for the translated addresses on top of the (top-level) automatic Site element on the right.

6) Click  Save.

Related concepts
Defining VPN gateways on page 1149

Create an External VPN Gateway element for
configuration 2
You need an External VPN Gateway element for this configuration.

Note:  This basic configuration scenario does not explain all settings related to External VPN
Gateway elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Right-click Gateways in the element tree, then select New External VPN Gateway.

3) In the Name field, enter a unique name.

4) Click Select for Gateway Profile, then select one of the following profiles:
• Select the Default (All Capabilities) profile for third-party gateways.
• Select the appropriate version-specific profile for Forcepoint NGFW Firewalls managed by a different

Management Server.

5) Click the Endpoints tab.

6) Click Add.

7) Define the IP address for the endpoint:
• If the endpoint has a static (manually defined) IP address, enter in the IPv4 Address.
• If the endpoint has a dynamic (DHCP-assigned) IP address, select Dynamic.

8) If the external gateway has a dynamic IP address:

a) In the Phase 1 ID section at the bottom of the dialog box, change the ID Type to E-mail.

b) Enter an email address in the ID value field.
This email address can be any address that is not used as an ID in any of your other endpoints. The
address entered here is used only as an identification, not for actually sending email.
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c) Click OK.

Note:  Make sure that the ID Type and ID Value match the identity configured on the external
gateway device. If the device has a static IP address, make sure that the device uses it as its
identity in this VPN or change the External VPN Gateway element configuration.

9) Leave the properties dialog box open.

Related concepts
Defining VPN gateways on page 1149

Define a site for the External VPN Gateway for
configuration 2
The External VPN Gateway element needs a Site element.

Before you begin
You must have created an External VPN Gateway element for configuration 2. The External VPN
Gateway Properties dialog box should still be open.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the External VPN Gateway Properties dialog box, click the Sites tab.

2) Double-click the New Site element on the right.

3) (Optional) In the Name field, enter a descriptive name for the site.

4) Select or create the elements that represent the protected IP addresses behind the Gateway in the left pane,
then click Add to include them.
The internal IP address used as the source or destination address must be included in the site of the
Gateway. Other traffic cannot use the VPN.

5) Click OK in both open dialog boxes.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Basic policy-based VPN configurations | 1205

Create a VPN Profile element for configuration
2
You must create a VPN Profile element for this configuration.

Before you begin
You must have defined a site for the external VPN gateway in configuration 2.

Note:  This basic configuration scenario does not explain all settings related to VPN Profiles.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Configuration view, browse to VPN > Other Elements > Profiles.

2) Right-click VPN Profiles in the element tree and select New VPN Profile.

3) In the Name field, enter a unique name.

4) On the IKE SA tab, configure the IKE SA settings.

a) Select the Version.
You can select IKEv1, IKEv2, or both. If both versions are selected, IKEv2 is tried first in the
negotiations, and IKEv1 is only used if the remote gateway does not support IKEv2.

b) In the Cipher Algorithms section, select one or more encryption methods that match the settings of the
external gateway device.
We recommend that you limit the selection to as few choices as possible. Do not select DES unless
you are required to do so. DES is no longer secure, since it is relatively easy to break DES encryption
with modern computers. 3DES (Triple-DES) has a relatively high overhead compared to other protocols
with a comparable level of security. For this reason, 3DES is not a good choice when high throughput is
required.

Note:  The restricted (-R) product version has no strong encryption algorithms.

c) Select the Message Digest Algorithm that matches the settings of the external gateway device.

• In IKE, the message digest algorithm is used for integrity checking and key derivation.
• If you select SHA-2, define the Minimum Length for the digest: 256, 384, or 512 bits. Set the length

so that it is in line with the overall security strength.

d) Select the Diffie-Hellman group or groups (used for key exchange) to be allowed to be used with the
external gateway device.
We recommend that you select from groups 14-21 according to the security requirements for the
VPN. Groups 1, 2, and 5 are not sufficiently secure in all cases, although they might be required for
interoperability with legacy systems.

e) Select the Authentication Method.
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f) If IKEv1 is selected as the Version, adjust the SA Lifetime in Minutes to match the settings of the
external gateway device.
In IKEv2, lifetime is set locally, so it does not have to match the lifetime settings of the external gateway.

g) If one of the Gateways has a dynamic IP address, change the IKEv1 Negotiation Mode to Aggressive.

5) On the IPsec SA tab, configure the IPsec SA settings.

a) Select the IPsec Type:

• The recommended setting is ESP (the communications are encrypted).
• Usually, AH is not a valid option. The AH setting disables encryption for the VPN, fully exposing all

traffic that uses the VPN to anyone who intercepts it in transit. You can use AH to authenticate and
check the integrity of communications without encrypting them.

b) In the Cipher Algorithms section, select one or more encryption methods that match the settings of the
external gateway device

• Do not select Null. This option disables encryption and allows anyone to view the data in transit.
• Do not select DES unless you are required to do so. DES is no longer secure, as it is relatively easy

to break DES encryption with modern computers.
• 3DES (Triple-DES) has a relatively high overhead compared to other protocols with a comparable

level of security. It is not a good choice when high throughput is required.
• AES-GCM-128 or AES-GCM-256 are recommended for high-speed networks.

Note:  The restricted (-R) product version has no strong encryption algorithms.

c) Select the Message Digest Algorithm that matches the settings of the external gateway device.

• In IPsec, the message digest algorithm is used for integrity checking (except when authenticated
encryption such as AES-GCM is used).

• If you select SHA-2, define the Minimum Length for the digest: 256, 384, or 512 bits. Set the length
so that it is in line with the overall security strength.

d) Make sure that Compression Algorithm is set to None.
The external gateway must not use compression.

e) Adjust the IPsec Tunnel Lifetime to match the settings of the external gateway device.

f) Select the Security Association Granularity for Tunnel Mode that matches the settings of the
external gateway device.

g) (Recommended) Select Use PFS with Diffie-Hellman Group if the external gateway device can use
perfect forward secrecy (PFS), and select the Diffie-Hellman group to use with PFS.
We recommend that you select from groups 14-21 according to the security requirements for the
VPN. Groups 1, 2, and 5 are not sufficiently secure in all cases, although they might be required for
interoperability with legacy systems.

6) Click OK.

Related concepts
Defining VPN profiles on page 1162
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Create a Policy-Based VPN element for
configuration 2
You must add a Policy-Based VPN element for this configuration.

Before you begin
You must have created a VPN Profile for configuration 2.

Note:  This basic configuration scenario does not explain all settings related to Policy-Based VPN
elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click Policy-Based VPNs in the element tree, then select New Policy-Based VPN.

2) In the Name field, enter a unique name.

3) From the Default VPN Profile drop-down list, select the VPN profile.

4) If you want to apply NAT rules to the communications that go through the VPN, select Apply NAT to
traffic that uses this VPN.
This setting does not affect the communications that the gateways have with each other to set up and
maintain the VPN. Communications between the gateways are always matched to the NAT rules.

5) Click OK.
The VPN Editing view opens on the Site-to-Site VPN tab.

6) Drag and drop the VPN Gateway element that represents the firewall to Central Gateways.

7) Drag and drop the External VPN Gateway element to Satellite Gateways.

8) Click the Tunnels tab.

9) Double-click the Key cell for the tunnel displayed in the Gateway<->Gateway pane.

10) To match the pre-shared key between the two gateways:
• To use the key that is automatically generated on the Management Server, click Export, then transfer

the key securely to the external gateway.
• To use a different key, replace the displayed key with the one that you have agreed on with the

administrator of the external gateway device.

CAUTION:  The pre-shared key must be long and random to provide a secure VPN.
Change the pre-shared key periodically (for example, monthly).

11) Click OK to close the Pre-Shared Key dialog box.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Basic policy-based VPN configurations | 1208

12) Check that the Validity column in the Gateway<->Gateway and the End-Point<->End-Point tables has a
green checkmark to indicate that there are no problems.

a) If the Validity column of a tunnel has a warning icon, see the Issues pane to check what the problem
is. If the pane is not displayed, select  Menu > View > Panels > Issues.

b) If issues are displayed, correct them as indicated. Long issues are easiest to read by hovering over
the issue text so that the text is shown as a tooltip.

13) Click  Save.

Related concepts
Defining Policy-Based VPN elements on page 1164

Create Access rules for VPN configuration 2
The rules in this example allow protected hosts to open connections both ways. Two rules are created here to
allow the different directions of traffic separately.

Before you begin
You must have created a VPN element for configuration 2.

VPN rules are matched based on source, destination, and service like any other rules.

Note:  This basic configuration scenario does not explain all settings related to VPN Access rules.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the Firewall policy of the NGFW Engine involved in the VPN for editing.

2) Add two IPv4 Access rules in a suitable location in the policy.

• Make sure that rules for sending traffic through the VPN are above other rules that match the same traffic
the Allow, Discard, or Refuse action.

• Traffic that you do not want to send through the VPN must not match these rules. Traffic that is not
routable through the VPN is dropped if it matches these rules.
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3) Fill in the rules as outlined here. If NAT is enabled in the VPN, remember that the Access rules are checked
before the NAT rules are applied.

Table 143: Example VPN rules

Source Destination Service Action

Local internal
networks

Remote internal
networks

Set as needed. Select Use VPN, then change the Action
to Enforce, and click Select  to add the
Policy-Based VPN element you created.

Remote internal
networks

Local internal
networks

Set as needed. Select Use VPN, then change the Action
to Enforce, and click Select  to add the
Policy-Based VPN element you created.

4) Save the policy.

CAUTION:  If you continue to use this VPN, change the pre-shared key periodically (for
example, monthly) to guarantee continued confidentiality of your data. Alternatively, you can
switch to certificate-based authentication by creating a custom VPN profile.

5) Refresh the policies of all firewalls involved in the VPN to activate the new configuration.

Result

The VPN is established when traffic matches the Access rules created here.

Related concepts
Access rules for policy-based VPNs on page 1172
Monitoring policy-based VPNs on page 1179
Changing pre-shared keys for VPNs on page 1244

Related tasks
Find VPN issues on page 1401

Configuration 3: Basic VPN for remote
clients

This basic configuration scenario walks you through creating a mobile VPN between an NGFW Engine and more
than one Stonesoft VPN Client.

To be able to configure a mobile VPN, the firewall must have a static IP address (not assigned using DHCP or
PPPoE).

Depending on the configuration that you want to use, you can add VPN client access to an existing site-to-site
VPN as well. However, in this example scenario, a separate policy-based VPN is created for VPN clients.

This scenario assumes that automatic Site management is used, and that the Sites do not need to be changed.
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In this scenario, the VPN settings are defined in a copy of the default VPN-A Suite VPN Profile. The VPN-A Suite
VPN Profile contains the VPN settings specified for the VPN-A cryptographic suite in RFC 4308.

Manage VPN client addresses in configuration
3
VPN clients cannot use their local IP address in the internal corporate network. In this scenario, NAT is used to
solve this problem.

This address management method allows connection opening from the VPN client end only. This method is
simpler to set up for testing, as it does not require an external DHCP server. However, this method has some
restrictions:

• It does not allow connections to be opened from hosts in the internal network to VPN clients.
• It prevents the Stonesoft VPN Client from using internal DNS servers.

You might want to change the IP address allocation method to Virtual IP after you have tested the basic VPN
connectivity with the configuration explained here.

This basic configuration scenario does not explain all settings related to VPN client address management.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the firewall element and select Edit Single Firewall or Edit Firewall Cluster.
The Engine Editor opens.

2) In the navigation pane on the left, browse to VPN > Advanced.

3) Select Translate IP Addresses Using NAT Pool.

4) Enter the IP Address Range of addresses and the Port Range you want to use for translating VPN client
traffic.
The VPN clients use these IP addresses when they connect to services in your internal network. Make sure
that these IP addresses are not used elsewhere in your network. The translation is dynamic, so the number
of IP addresses you enter does not need to correspond to the number of clients connecting. Typically,
each connection a VPN client user opens to a resource reserves one port from whichever IP address has
unreserved ports within the configured range. The reverse NAT for the reply packets is done automatically.

5) Click  Save.

Related concepts
VPN client settings and how they work on page 1247
Virtual IP addresses for VPN clients on page 1251
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Configure the firewall's VPN settings for
configuration 3
You must create Gateway elements for the configuration.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the firewall element and select Edit Single Firewall or Edit Firewall Cluster.
The Engine Editor opens.

2) In the navigation pane on the left, browse to VPN > Certificates.
The Certificates pane opens on the right.

3) Make sure that Automated RSA Certificate Management is selected.
The gateway must have a certificate for a mobile VPN.

4) In the navigation pane on the left, browse to VPN > Sites. The Sites pane opens on the right. A Site element
is displayed with each internal network interface on the engine as the content.
The Sites represent the internal addresses that VPN clients can reach through the VPN. This definition alone
does not grant access to any hosts. The Access rules define the allowed connections.

5) Leave Add and update addresses based on routing selected.
This option automatically updates this information based on routing changes. You can exclude some
interfaces while keeping the others automatically updated.

6) If you need to make changes in the Sites (add or remove destination addresses that VPN clients route
through the VPN), see the topic about defining Site elements.

7) Click  Save.

Related concepts
Defining VPN gateways on page 1149
Defining Site elements for VPN gateways on page 1156

Create a VPN Profile element for configuration
3
You must create a custom VPN Profile element to define the settings for VPN clients.

Note:  This basic configuration scenario does not explain all settings related to authenticating
VPN client users.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) In the element tree, browse to Other Elements > Profiles > VPN Profiles.
The defined VPN Profiles are displayed.

3) Right-click VPN-A Suite and select New > Duplicate.
The settings from the default profile are copied into the VPN Profile Properties dialog box that opens.

4) In the Name field, enter a unique name.

5) On the IKE SA tab, configure the IKE SA settings.

a) In the Version drop-down list, select the IKE version.
You can select IKEv1, IKEv2, or both. If both versions are selected, IKEv2 is tried first in the
negotiations, and IKEv1 is only used if the remote gateway does not support IKEv2.

b) (Only if IKEv1 is selected) Make sure IKEv1 Negotiation Mode is set to Main.
Using Main mode helps guarantee that the user names and passwords of the VPN client users remain
confidential.

Note:  The restricted (-R) product version has no strong encryption algorithms.

6) On the IPsec Client tab, configure the VPN client settings.

a) Make sure that the Authentication Method is set to RSA Signatures.

b) Select Allow Hybrid/EAP Authentication.
Hybrid authentication is used with IKEv1. EAP (Extensible Authentication Protocol) is used with IKEv2.

c) Make sure IPsec Security Association Granularity for Tunnel Mode is set to SA Per Net.

7) Click OK.

Create a Policy-Based VPN element for
configuration 3
You must add a Policy-Based VPN element for this configuration.

Before you begin
You must have a custom VPN Profile element for configuration 3.

Note:  This basic configuration scenario does not explain all settings related to VPN elements.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Right-click Policy-Based VPNs in the element tree, then select New Policy-Based VPN.

3) In the Name field, enter a unique name.

4) From the Default VPN Profile drop-down list, select the custom VPN Profile that you created.

5) Select Apply NAT Rules to Traffic That Uses This VPN.
This option applies the NAT rules in the policy and the global NAT definition for the Firewall.

6) Click OK.
The VPN Editing view opens on the Site-to-Site VPN tab.

7) Drag and drop the VPN Gateway element that represents the firewall to Central Gateways.

8) On the Mobile VPN tab, select Only central Gateways from overall topology to define which VPN
Gateways provide Mobile VPN access.

9) Click the Tunnels tab.

10) Check that the Validity column in the Gateway<->Gateway and the End-Point<->End-Point tables has a
green checkmark to indicate that there are no problems.

a) If the Validity column of a tunnel has a warning icon, see the Issues pane to check what the problem
is. If the pane is not displayed, select  Menu > View > Panels > Issues.

b) If issues are displayed, correct them as indicated. Long issues are easiest to read by hovering over
the issue text so that the text is shown as a tooltip.

11) Click  Save.

Related concepts
Defining Policy-Based VPN elements on page 1164
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Create users for VPN configuration 3
User authentication is configured in the same way for VPN client connections and normal, unencrypted
connections. The same User elements (user accounts) can be used for both.

Before you begin
You must have a VPN element for configuration 3.

Note:  This basic configuration scenario does not explain all settings related to user
authentication.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to User Authentication.

2) Browse to Users > InternalDomain.
A list of Internal User Groups and Internal Users in the InternalDomain opens on the right.

3) Right-click the stonegate Internal User Group and select New > Internal User.

4) In the Name field, enter the user name that the end user uses to authenticate to the VPN.

5) (Optional) In the Comment field, enter the full name of the user.

6) Click the Authentication tab.

7) Click Add in the Authentication Method section.

8) Select User Password and click Select.
This default element allows user password authentication for the internal LDAP database.

9) In the Password and Confirm Password fields, enter and confirm the password.
Make a note of the password so that you can communicate it to the user. The passwords entered in the
VPN client are encrypted so that they remain confidential as they are transferred over the Internet.

10) Click OK.

Result

The information is added to the Management Server’s internal LDAP user database.

Related concepts
Getting started with user authentication on page 1097
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Create Access rules for VPN configuration 3
Create a rule to allow specific users access to internal networks after having authenticated.

The authentication connection from VPN clients is allowed in the Firewall Template. Authentication is always
required to establish a VPN tunnel. VPN client connections are matched based on Source, Destination, and
Service like any other traffic. The example rule matches only specific users and only after the users have already
successfully authenticated. We recommend always adding the authentication requirement to rules that are
specific to VPN clients.

After the VPN tunnel is established, any connection from the VPN clients to the internal network is matched
against the Access rules as usual. The example rule that is created here allows these connections.

Note:  This basic configuration scenario does not explain all settings related to VPN Access rules.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the Firewall policy that is used by the NGFW Engines involved in the VPN for editing.

2) Add an IPv4 Access rule in a suitable location in the policy and configure the rule as outlined here:
If NAT is active and applied to translate the destination, remember that the Access rules are checked before
the NAT rules are applied.

Table 144: Example VPN rule

Source Destination Service Action Authentication Users

Set to
ANY.

Local
internal
networks

Set as
needed.

Select Use VPN, then
change the Action
to Enforce, and click
Select  to add the
Policy-Based VPN
element you created.

Set to ANY or to a
particular method.

The stonegate
Internal User Group
(in InternalDomain)

3) Save the policy.

4) Refresh the policies of all firewalls involved in the VPN to activate the new configuration.

Result

The VPN is established when traffic matches the created Access rules.

Related concepts
Getting started with user authentication on page 1097
VPNs and how they work on page 1127
Monitoring policy-based VPNs on page 1179
Access rules for policy-based VPNs on page 1172

Related tasks
Find VPN issues on page 1401
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Configuration 4: Basic VPN hub
In a VPN hub configuration, a gateway is configured to forward VPN traffic between different VPN tunnels.

The gateway that does this forwarding is called a hub gateway. The gateways that contact each other through a
hub are called spoke gateways.

The hub gateway must be set up specifically as a hub. The hub configuration is reflected in the topology, the
Site definitions, and the VPN rules. The spoke gateways do not require any hub-specific configuration. In this
example configuration, VPN tunnels are established from all spoke gateways to the hub gateway. All networks
of all gateways are configured as reachable through the hub. Connections are allowed only as defined in the
Firewall Access rules.

Note:  There must not be duplicate endpoint-to-endpoint tunnels in different VPNs. If there are
existing VPNs between the Firewalls involved in the hub, overlapping configurations must be
removed.

This basic configuration scenario explains a configuration in which all connections are defined within the same
Policy-Based VPN element. A single Policy-Based VPN element is simpler to set up and maintain than forwarding
traffic between VPN tunnels defined in different Policy-Based VPN elements. In this scenario, all gateways are
Firewalls controlled by the same Management Server. You can add External VPN Gateways to this configuration
even though their creation is not covered in detail in this workflow.

Create a VPN element for configuration 4
You must add a VPN element for this configuration.

Note:  This basic configuration scenario does not explain all settings related to VPN elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Right-click Policy-Based VPNs in the element tree, then select New Policy-Based VPN.

3) In the Name field, enter a unique name.

4) From the Default VPN Profile drop-down list, select VPN-A Suite.

5) If you want to apply NAT rules to the communications that go through the VPN, select Apply NAT Rules to
Traffic That Uses This VPN.
This option does not affect the communications that the two VPN gateways have with each other to set up
and maintain the VPN. Those connections are always matched against the NAT rules.

6) Click OK.
The VPN Editing view opens on the Site-to-Site VPN tab.
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7) Drag and drop the firewall that acts as the hub gateway to Central Gateways.
 
Figure 172: VPN editing view - Site-to-Site VPN tab

8) Drag and drop the other firewalls on top of the hub gateway so that the firewalls are added as branches
(spokes) under the hub gateway.
Spoke gateways can be any other firewalls or External VPN Gateways.

9) Click  Save, but do not close the VPN Editing view.

Related concepts
Defining Policy-Based VPN elements on page 1164

Define a Site element for the hub gateway for
configuration 4
The VPN Gateway that acts as the hub gateway needs a Site element.

Note:  This basic configuration scenario does not explain all settings related to Site elements.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the VPN Gateway that acts as the hub gateway, then select New > Site.

2) In the Name field, enter a unique name.

3) Add all networks protected by the spoke gateways to the site contents on the right.
After you add the protected networks, the site contains all remote IP addresses that are used in spoke-to-
hub traffic that is forwarded from the hub to other spokes. The site should not contain the hub gateway’s
local networks. These are defined using the automatic site management features in this example.

4) Click the VPN References tab.

5) Select Enable for this VPN element, then deselect it for all other VPNs.
The site is still shown in all VPNs, but is grayed-out (disabled) and not included in the configuration.
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6) In the Mode cell, select Hub to activate VPN hub-related features for the VPN Gateway.

7) Click OK to close the dialog box.
You return to the main VPN editing view.

8) Click the Tunnels tab.

9) Check that the Validity column in the Gateway<->Gateway and the End-Point<->End-Point tables has a
green checkmark to indicate that there are no problems.

a) If the Validity column of a tunnel has a warning icon, see the Issues pane to check what the problem
is. If the pane is not displayed, select  Menu > View > Panels > Issues.

b) If issues are displayed, correct them as indicated. Long issues are easiest to read by hovering over
the issue text so that the text is shown as a tooltip.

10) Click  Save.

Related concepts
Defining Site elements for VPN gateways on page 1156

Create Access rules for VPN configuration 4
The rules in this example allow connections between hosts in protected networks of all gateways to connect to all
other protected networks.

VPN rules are matched based on Source, Destination, and Service like any other rules.

Note:  This basic configuration scenario does not explain all settings related to VPN Access rules.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Open the Firewall policy of the NGFW Engine that is configured as the hub gateway in the VPN for editing.

2) Add an IPv4 Access rule in a suitable location in the policy.
Make sure that rules for sending traffic through the VPN are above other rules that match the same traffic
with the Allow, Discard, or Refuse action. Traffic that you do not want to send through the VPN must not
match this rule. Traffic that is not routable through the VPN is dropped if it matches this rule.

3) Fill in the rule as outlined here.
• If NAT is enabled in the VPN, remember that the Access rules are checked before the NAT rules are

applied.
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• To prevent this rule from matching other traffic, you can add the VPN you created in the Source VPN cell.

Table 145: Example VPN rule for spoke-to-spoke forwarding

Source Destination Service Action

Remote internal
networks

Remote internal
networks

Set as needed. Select Use VPN, then change the Action
to Forward, and click Select  to add the
Policy-Based VPN element you created.

4) Add two more rules to allow traffic between the hub gateway’s local protected networks to the spoke
gateway’s protected networks.
Two rules are created here to allow the different directions of traffic.

Table 146: Example VPN rules

Source Destination Service Action

Local internal
networks

Remote internal
networks

Set as needed. Select Use VPN, then change the Action
to Forward, and click Select  to add the
Policy-Based VPN element you created.

Remote internal
networks

Local internal
networks

Set as needed. Select Use VPN, then change the Action
to Forward, and click Select  to add the
Policy-Based VPN element you created.

5) Save the policy.

6) Add similar rules in the policies of all NGFW Engines involved in the VPN.

CAUTION:  If you continue to use this VPN, change the pre-shared key periodically (for
example, monthly) to guarantee continued confidentiality of your data. Alternatively, you can
switch to certificate-based authentication by creating a custom VPN profile.

7) Refresh the policies of all firewalls involved in the VPN to activate the new configuration.

Result

The VPN is established when traffic matches the created Access rules.

Related concepts
Access rules for policy-based VPNs on page 1172
Changing pre-shared keys for VPNs on page 1244
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 CHAPTER 70

Managing VPN certificates
Contents

• VPN certificates and how they work on page 1221
• Define additional VPN certificate authorities on page 1223
• Create an internal ECDSA certificate authority for VPN gateways on page 1225
• Select the default internal certificate authority on page 1226
• Create a VPN certificate or certificate request for a VPN Gateway element on page 1226
• Sign external VPN certificate requests with an internal certificate authority on page 1228
• Select which internal certificate authority signs each certificate on page 1229
• Replace expired VPN certificates on page 1230
• Export signed VPN gateway certificates or VPN certificate authority certificates on page 1232
• Import an externally signed VPN gateway certificate on page 1233
• Check when VPN gateway certificates expire on page 1234
• Check when VPN certificate authorities expire on page 1234

A digital certificate is a proof of identity. Forcepoint NGFW in the Firewall/VPN role supports using certificates for
authenticating gateways and the Stonesoft VPN Client.

VPN certificates and how they work
Certificates can be used for authenticating VPN gateways and the Stonesoft VPN Client.

In site-to-site VPNs, you can use both pre-shared keys and certificates as the authentication method. In mobile
VPNs, certificates are always needed when the Stonesoft VPN Client is involved. However, if you use the hybrid
authentication method with the Stonesoft VPN Client, only the gateway needs a certificate.

What VPN certificates do
Certificates do not contain information that is specific to a particular VPN. You can use certificates for
authentication in both the policy-based and route-based VPNs. A certificate authority (CA) issues certificates as
proof of identity. Gateways that form a VPN tunnel are configured to trust the CA that signed the other gateway’s
certificate. All certificates issued by a trusted CA are accepted as valid, so certificates can be added, renewed,
and changed without affecting the VPN as long as the actual identity information is correct. The same certificate
can be used for any number of VPNs with any number of gateways and VPN clients.

Certificates are always required for gateways to which the Stonesoft VPN Client connects. Certificates can
optionally be used to identify VPN clients, but are not mandatory.

Certificates reduce the required maintenance work, because they do not have to be changed as frequently as
pre-shared keys. All certificates are created with an expiration date, after which the certificate is no longer valid.
Certificates signed by an Internal RSA CA for Gateways or an Internal ECDSA CA for Gateways are valid for
three years from their creation. When a certificate expires, a new certificate is needed.
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Certificate management
Certificate-related tasks in the SMC mostly involve VPN Gateways that represent firewalls. There are two options
for signing VPN Gateway certificates:

• The Management Server includes a dedicated Internal RSA CA for Gateways and optionally an Internal
ECDSA CA for Gateways for signing VPN certificates. You use these certificate authorities through the
Management Client.

• One Internal CA for Gateways can be selected as the default CA. Certificate management can be automatic if
the certificate is signed using the Management Server’s internal default CA.

• You can create certificate requests in the Management Client, export them, sign them using an external CA,
and then import the signed certificate back into the SMC.

RSA certificates can be created and renewed automatically using the default CA. Some manual steps are
required in the following cases:

• You have both an Internal RSA CA for Gateways and an Internal ECDSA CA for Gateways. Only one Internal
CA for Gateways can be selected as the default certificate authority. You must manually create and renew any
certificates that are not signed by the default CA.

• You use DSA certificates.
• You want to use an external CA to sign certificates.

The Internal RSA CA for Gateways or Internal ECDSA CA for Gateways can also sign certificate requests
created by external components. This feature is meant to support VPN client deployments. If you have used
the Internal RSA CA for Gateways or Internal ECDSA CA for Gateways to sign certificate requests, you cannot
cancel the issued certificates. Consider how widely you can use them for signing external certificate requests
within your organization.

Limitations
All gateways in the same VPN must support the same CA algorithm. Otherwise, VPN communication fails. For
example, if you use an Internal ECDSA CA for Gateways as the default CA, all other gateways used in the same
VPN must support ECDSA.

Related tasks
Replace expired VPN certificates on page 1230
Create an internal ECDSA certificate authority for VPN gateways on page 1225
Select the default internal certificate authority on page 1226

VPN certificate configuration overview
Configuring VPN certificates involves several main steps.

The configuration consists of the following steps:

1) (Optional) If you want to use certificates that are signed by some external certificate authority (CA), define
the CA in the Management Client.

2) (Optional) If you want to use an Internal ECDSA CA for Gateways to sign certificates, create an Internal
ECDSA CA for Gateways.
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3) (Optional) If you have both an Internal RSA CA for Gateways and an Internal ECDSA CA for Gateways,
select which CA is the default.

4) Start by creating a VPN certificate or certificate request for a VPN Gateway in the following cases:
• To use an externally signed certificate.
• To use a DSA certificate.
• If automated RSA certificate management is disabled for gateways.

5) (For externally signed certificates) When the certificate is signed, import the certificate.

6) Select a certificate-based Authentication Method on the IKE SA tab of the VPN Profile.

Define additional VPN certificate
authorities

You can define several certificate authorities.

Before you begin
You must have the root certificate (or a valid certificate) from the certificate authority.

You must define additional CAs in the following cases:
• In a VPN with an external gateway where you do not want to use the Internal RSA CA for Gateways or the

Internal ECDSA CA for Gateways to create a certificate for the external gateway. The external gateway must
also be configured to trust the issuer of the certificate.

• If you want to use a certificate signed by an external CA for a VPN Gateway or for a VPN client.

Note:  Only the Internal RSA CA for Gateways and Internal ECDSA CA for Gateways of your
SMC are configured as trusted CAs for gateways in VPNs by default. The Internal RSA CA for
Gateways is automatically created when you install the SMC.

You can configure the CA as trusted by importing its root certificate or a valid certificate signed by the CA. The
certificates must be X.509 certificates in PEM format (Base64 encoding). It might be possible to convert between
formats using, for example, OpenSSL or the certificate tools included in Windows.

The CAs you use can be either private (for self-signed certificates) or public (commercial certificate issuers).
When you define a CA as trusted, all certificates signed by that CA are valid until their expiration date (or until the
CA’s certificate expires). Optionally, you can also set up the SMC to check the certificate revocation status from
certificate revocation lists (CRLs) or through the OCSP protocol. The CA can cancel a certificate, for example,
because it is compromised.

By default, all CAs you have defined are trusted by all gateways and in all VPNs. If necessary, you can limit
trust to a subset of the defined CAs when you configure the VPN Gateway and VPN Profile elements. The trust
relationships can be changed at the gateway level and in the VPN Profiles.

To obtain a certificate from an external certificate authority, first create a certificate request.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Other Elements > Certificates > VPN Certificate Authorities.

3) Right-click VPN Certificate Authorities, then select New VPN Certificate Authority.

4) Type a Name for the element. This name is only for your reference.

Note:  All fields but the Name on the General tab are grayed out. The grayed out fields are
always filled in automatically based on information contained in the certificate you import. You
cannot change the information in the grayed out fields. The information is shown when you
close and reopen the VPN Certificate Authority element after importing the information.

5) Click the Certificate tab, then do one of the following:
• Click Import, then import a certificate file.
• Copy and paste the information into the field on the tab (including the “Begin Certificate” header and “End

Certificate” footer).

Tip:  You can copy and paste the certificate information for many public certificate authorities
from the default Trusted Certificate Authority elements. The default Trusted Certificate
Authority elements are in the Configuration view under Administration  >  > Certificates >
Certificate Authorities > Trusted Certificate Authorities.

6) (Optional) If you want the Firewalls to check the revocation status of certificates signed by this CA, on the
Validation tab, select the following options:
• To activate CRLs for certificate status checking, select Check Validity on Certificate-Specified CRLs.
• To activate OCSP certificate status checking, select Check Validity on Certificate-Specified OCSP

Servers.

7) (Optional) To define more CRL servers to check in addition to those defined in the certificates, click Add,
then select an option:
• To select an existing element or to define a new LDAP Server element, LDAP Server Element.
• To enter the address, select Manual LDAP Server Address.

Example: ldap://example.com:389

8) (Optional) To define more OCSP servers to check in addition to those defined in the certificates, click Add,
then enter an address.
Example: http://ocsp.example.com

CAUTION:  When certificate checking is defined, all certificates signed by the CA are treated
as invalid if the validity check cannot be performed. For example, the validity check might not
be performed due to incorrectly entered addresses or connectivity problems.
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9) Click OK. If you see an invalid certificate error, the certificate you imported might be in an unsupported
format. Try converting the certificate to an X.509 certificate in PEM format (Base64 encoding) using
OpenSSL or the certificate tools included in Windows.
If your Firewall Policy is based on the Firewall Template, both LDAP (port 389) and HTTP (port 80)
connections from the Firewall are allowed. If your firewall or server configuration differs from these standard
definitions, edit the Firewall Policy to allow the necessary connections from the Firewalls.

Related tasks
Create an internal ECDSA certificate authority for VPN gateways on page 1225
Create LDAP Server elements on page 1080
Define trusted CAs for a gateway on page 1154
Create a VPN certificate or certificate request for a VPN Gateway element on page 1226
Import an externally signed VPN gateway certificate on page 1233

Create an internal ECDSA certificate
authority for VPN gateways

You can create one Internal ECDSA CA for Gateways.

The Elliptic Curve Digital Signature Algorithm (ECDSA) is a digital signature algorithm that uses elliptic curve
cryptography. You can use both an Internal ECDSA CA for Gateways and an Internal RSA CA for Gateways at
the same time. When there is more than one valid CA, you can select which CA signs each certificate.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Other Elements > Certificates > VPN Certificate Authorities.

3) Right-click VPN Certificate Authorities and select Create New VPN ECDSA Certificate Authority.
A new Internal ECDSA CA for Gateways is created.

Result

The ECDSA CA for Gateways is ready to use for signing certificates.
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Select the default internal certificate
authority

If you have both an Internal RSA CA for Gateways and an Internal ECDSA CA for Gateways, only one certificate
authority can be selected as the default certificate authority.

Only the default certificate authority is used in automated RSA certificate management. You must manually
create and renew any certificates that are not signed by the default CA.

CAUTION:  All gateways in the same VPN must support the CA algorithm used by the default
certificate authority. Otherwise, VPN communication fails.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Other Elements > Certificates > VPN Certificate Authorities.

3) Right-click the Internal CA for Gateways that is not currently the default certificate authority and select
Tools > Set Default Certificate Authority.
The selected Internal CA for Gateways is set as the default certificate authority.

Create a VPN certificate or certificate
request for a VPN Gateway element

You can create a certificate request and sign it either using an Internal CA for Gateways or an external certificate
authority (CA).

If automated RSA certificate management is active for the VPN Gateway, these steps are necessary only in the
following cases:
• You have both an Internal RSA CA for Gateways and an Internal ECDSA CA for Gateways. Only the default

CA is used in automated RSA certificate management. You must manually create and renew any certificates
that are not signed by the default CA.

• You want to use DSA certificates.
• You want to create a certificate request to be signed by an external CA.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Select Gateways.
The gateways are displayed.
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3) Right-click the VPN Gateway element and select Tools > Generate Certificate.

4) In the Generate Certificate dialog box, enter the certificate information.

5) Select the Public Key Algorithm according to the requirements of your organization.

Note:  The Public Key Algorithm can be different from the internal CA type. For example,
you can use RSA key algorithm with an Internal ECDSA CA for Gateways.

6) Select how you want to Sign the certificate.

7) (Optional) Select the Signature Algorithm that the certificate authority uses to sign the certificate.
• If you selected an Internal CA for Gateways, you can define the Signature Algorithm if the selected

Public Key Algorithm is compatible with the algorithm used by the Internal CA. In other cases, the
default algorithm for the Internal CA is used (for example, RSA / SHA-1 for Internal RSA CA for
Gateways).

• If you selected an external certificate authority, you can define a Signature Algorithm that is compatible
with the selected Public Key Algorithm type.

8) (Optional, if supported by the Public Key Algorithm) Enter the Key Length for the generated public-private
key pair.
• The default Key Length depends on the Public Key Algorithm.
• The Key Length cannot be changed for some Public Key Algorithms.

9) Click OK.
There might be a slight delay while the certificate request is generated. If you signed the certificate using
an Internal CA for Gateways, the certificate is automatically transferred to the Firewall and no further
action is needed.
The signed certificate or unsigned certificate request is added under the gateway in the gateway list.

10) (With external certificate authorities only) Right-click the certificate request, select Export Certificate
Request, and save it.
• To generate certificates for a VPN Gateway element, the CA must support PKCS#10 certificate

requests in PEM format (Base64 encoding). The signed certificates must also be in the PEM format.
It might be possible to convert between formats using, for example, OpenSSL or the certificate tools
included in Windows.

• The CA must be able to copy all attributes from the certificate request into the certificate. In particularly,
the X.509 extension Subject Alternative Name must be copied as it is in the request because the value
is used for authentication.

When you receive the signed certificate, import it.

Related tasks
Select the default internal certificate authority on page 1226
Import an externally signed VPN gateway certificate on page 1233
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Sign external VPN certificate requests
with an internal certificate authority

You can use an internal certificate authority to sign VPN certificate requests for VPN clients and internal VPN
gateways.

Before you begin
For VPN clients, you must have a PKCS#10 certificate request file in PEM format. For internal VPN
gateways, you must have already generated a certificate request.

The SMC’s Internal RSA CA for Gateways and Internal ECDSA CA for Gateways can be used to sign external
certificate requests. You can also use an internal certificate authority to sign any certificate request that is in
the supported format (PKCS#10 certificate requests in PEM format). An alternative is to configure the Internal
Gateway to accept an externally signed certificate by defining the external certificate issuer as trusted.

If more than one valid internal certificate authority is available, you can select which internal CA signs the
certificate request. There can be multiple valid Internal CAs for Gateways in the following cases:
• There is both an Internal RSA CA for Gateways and an Internal ECDSA CA for Gateways.
• The Internal CA for Gateways is in the process of being renewed and both the previous CA and the new CA

are temporarily available.

Make sure that the date, time, and time zone are all set correctly on the Management Server and on the external
component that uses the certificate. Certificates are valid for three years starting from the date and time they
are created. The validity start and end date and time are written in the certificate and are enforced in the
authentication.

Note:  The Internal RSA CA for Gateways and the Internal ECDSA CA for Gateways do not
support certificate revocation lists. It is not possible to cancel an internally signed certificate before
it expires.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Sign VPN Client certificates.

a) Select  Tools > Sign VPN Client Certificate.

Tip:  You can sign any X.509 certificate requests in this dialog box (not only VPN client
certificate requests).

b) If more than one valid internal certificate authority is available, select which internal CA signs the
certificate request.

Note:  If the Internal CA for Gateways is in the process of being renewed and both the
previous CA and the new CA are temporarily available, select the new CA.
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c) Browse to the certificate request file on your local workstation or copy and paste the content of the
certificate request into the dialog box.
If you copy and paste the certificate request, include the Begin Certificate Request header and the End
Certificate Request footer.

d) Click Sign.
The certificate is signed and the Export Certificate dialog box opens. Click the Certificate tab to view
the validity information for the certificate.

e) Click the General tab, then click Export to save the certificate for transfer to the device that needs it.

f) Click OK.

3) Sign certificate requests for internal VPN gateways.

a) Click Gateways, then expand the VPN Gateway element for which you generated a certificate request.

b) Right-click the certificate request, then select Sign Internally.

c) If more than one valid internal certificate authority is available, select which internal CA signs the
certificate request.

Note:  If the Internal CA for Gateways is in the process of being renewed and both the
previous CA and the new CA are temporarily available, select the new CA.

d) Click Sign.

Related tasks
Define additional VPN certificate authorities on page 1223

Select which internal certificate authority
signs each certificate

When there is more than one valid CA, you can select which CA signs each certificate.

The Management Server includes a dedicated Internal RSA CA for Gateways for signing VPN certificates.
You can optionally also create an Internal ECDSA CA for Gateways. If you have both an Internal RSA CA for
Gateways and an Internal ECDSA CA for Gateways, only one certificate authority can be selected as the
default certificate authority. If you want to sign a certificate with the certificate authority that is not the default CA,
you must select which Internal CA for Gateways you want to use.

The Internal RSA CA for Gateways and the Internal ECDSA CA for Gateways are each valid for 10 years. A new
Internal RSA CA for Gateways or Internal ECDSA CA for Gateways is automatically created to replace the default
certificate authority six months before the expiration date. The certificate authority that is not selected as the
default certificate authority is not automatically renewed. You must manually renew the Certificate Authority.

If the default Certificate Authority is in the process of being renewed, there is temporarily an extra valid Internal
CA for Gateways. In this case, select the new Internal CA for Gateways to sign the certificate.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Certificate Properties dialog box, select Other in the Internally with field.

2) (Optional) Right-click an Internal CA for Gateways and select Properties. Check the following information in
the Properties dialog box to make sure that you are selecting the correct Internal CA for Gateways:
• Validity information in the Valid from and Valid to fields.
• Status information:

• Active — You can use this Internal CA for Gateways to sign certificates.
• Renewal Started — This certificate authority is a new Internal CA for Gateways that the SMC has

created automatically. The process of renewing VPN certificates has begun.
• Expires Soon — A new Internal CA for Gateways has been created but some components might still

use certificates signed by this Internal CA for Gateways.
• Inactive — This Internal CA for Gateways has expired or no SMC components use a certificate signed

by this internal VPN CA.

3) Select the CA you want to use and click Select.

Related concepts
Problems with certificates on page 1355

Related tasks
Troubleshoot expiring certificate authorities on page 1360

Replace expired VPN certificates
For security reasons, VPN certificates have an expiration date, after which the certificates must be replaced with
new ones.

The VPN certificates issued by the Internal RSA CA for Gateways and the Internal ECDSA CA for Gateways are
valid for three years.

If you have both an Internal RSA CA for Gateways and an Internal ECDSA CA for Gateways, only one
certificate authority can be selected as the default certificate authority. If automatic RSA certificate management
is activated for an NGFW Engine, RSA certificates issued by the default certificate authority are renewed
automatically as long as the certificate-related files, including the private key stored on the engines, are intact.
You must manually create and renew any certificates that are not signed by the default Certificate Authority.

New certificates signed by the new default Certificate Authority are automatically created for VPN Gateway
elements. You must manually create and renew any certificates that are not signed by the default Certificate
Authority.

If certificates signed by the expiring Internal CA for Gateways are used to authenticate VPN client users, you
must manually create new certificates for the VPN clients. You must also create new certificates manually for any
other external components that have certificates signed by the expiring Internal RSA CA for Gateways or Internal
ECDSA CA for Gateways.
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Note:  When you renew the VPN certificate, Stonesoft VPN Client users receive a notification
about the certificate fingerprint change. Notify users before you renew the certificate if possible.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) To renew an externally signed certificate for a VPN Gateway element, follow these steps.

a) Create a certificate request.

b) Sign the certificate with the external CA.

c) Import the signed certificate.

2) To renew an internally signed certificate for an external component, follow these steps.

a) Create a certificate request in the external component.

b) Sign the certificate with the internal CA.

c) Export the signed certificate and import it to the external component.

3) To renew an internally signed certificate for a VPN Gateway element, follow these steps.

a) Select  Configuration, then browse to VPN.

b) Browse to Other Elements > Certificates > Gateway Certificates.
The certificates are shown with their expiration dates and signer information.

c) Right-click the certificate you want to renew and select Renew Certificate.
You are prompted to confirm that you want to renew the certificate.

d) Click Yes.
There is a delay while the certificate is renewed, after which you are notified that the certificate was
renewed. The certificate is transferred to the engine automatically.

e) Refresh the policy of the Firewall to activate the new certificate.

This procedure renews the certificate when the certificate-related information is intact on the engine and
on the Management Server. If the certificate has not expired but has other problems, delete the existing
certificate element in the Management Client and create a new one.

Related tasks
Select the default internal certificate authority on page 1226
Troubleshoot expiring certificate authorities on page 1360
Create a VPN certificate or certificate request for a VPN Gateway element on page 1226
Import an externally signed VPN gateway certificate on page 1233
Sign external VPN certificate requests with an internal certificate authority on page 1228



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Managing VPN certificates | 1232

Export signed VPN gateway certificates
or VPN certificate authority certificates

You can export signed gateway certificates, the certificates of the Internal RSA CA for Gateways, and the
certificates of the Internal ECDSA CA for Gateways.

Before you begin
You must have a signed certificate or a new internal VPN CA.

In most cases, it is not necessary to export signed VPN gateway certificates or VPN certificate authority
certificates, but can be done as needed.

If the SMC has created a new Internal RSA CA for Gateways or Internal ECDSA CA for Gateways to replace an
expiring default certificate authority, you must export the certificate of the new default certificate authority. You
must import the certificate on external gateways that use certificates signed by the default certificate authority or
communicate with gateways that use certificates signed by the default certificate authority. If the external gateway
itself uses a certificate signed by the default Certificate Authority, you must also create a new certificate for the
external gateway.

You must export certificates that are created when an internal certificate authority signs an external certificate
request at the time of signing the certificate request. They are not stored for exporting later.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) To export a signed certificate, follow these steps.

a) Select  Configuration, then browse to VPN.

b) Browse to Other Elements > Certificates > Gateway Certificates.

c) Right-click a certificate and select Export Certificate.

d) Browse to the location where you want to save the file on your local workstation and click Save.

2) To export the certificate of an internal CA for gateways, follow these steps.

a) Select  Configuration, then browse to VPN.

b) Browse to Other Elements > Certificates > VPN Certificate Authorities.

c) Right-click a VPN Certificate Authority and select Tools > Export Certificate.

d) Browse to the location where you want to save the file on your local workstation and click Save.
If the external gateway uses a certificate signed by the internal certificate authority that has been
renewed, you must create a new certificate for the external gateway.
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Related tasks
Select the default internal certificate authority on page 1226
Replace expired VPN certificates on page 1230

Import an externally signed VPN
gateway certificate

You can import a certificate signed by an external certificate issuer for a VPN Gateway element when the
certificate request has been created in the SMC.

For security reasons, it is not possible to import externally generated private keys.

Note:  All CAs that issue certificates for your VPNs must be configured in the SMC and be
included as trusted both at the gateway and VPN Profile levels.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Open the Gateways branch and expand the tree under the VPN Gateway element.

3) Right-click the certificate request and select Import Certificate.

4) Select the certificate authority that signed the certificate.

5) Browse to the certificate request file on your local workstation or copy and paste the content of the certificate
request into the dialog box.
If you copy and paste the certificate request, include the“Begin Certificate Request” header and the “End
Certificate Request” footer.

6) After the signed certificate is imported, delete the certificate request, which is still displayed under the
Gateway with the signed certificate.
The certificate is transferred to the engine automatically.

Related tasks
Define additional VPN certificate authorities on page 1223
Create a VPN certificate or certificate request for a VPN Gateway element on page 1226
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Check when VPN gateway certificates
expire

Certificates expire according to the information written in the certificate when it was generated

Before you begin
A signed certificate must be present.

By default, RSA certificates issued by the default certificate authority for VPN Gateway elements are renewed
automatically. VPN Gateways never accept expired certificates.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Other Elements > Certificates > Gateway Certificates.
The existing certificates are displayed.

3) See the Expiration Date column for information about the certificate’s expiration date.
• You can renew internally signed certificates through their right-click menu. You must manually renew

certificates if automated RSA certificate management is not active, or if the certificate was not signed by
the default Certificate Authority. VPN client users might be prompted to accept the change of certificate.

• Elements with no expiration date are certificate requests (Status: To be signed).

Related tasks
Select the default internal certificate authority on page 1226

Check when VPN certificate authorities
expire

The Internal RSA CA for Gateways and the Internal ECDSA CA for Gateways are valid for 10 years.

The Management Server includes a dedicated Internal RSA CA for Gateways for signing VPN certificates.
You can optionally also create an Internal ECDSA CA for Gateways. If you have both an Internal RSA CA for
Gateways and an Internal ECDSA CA for Gateways, only one certificate authority can be selected as the default
certificate authority.

A new Internal RSA CA for Gateways or Internal ECDSA CA for Gateways is automatically created to replace the
default certificate authority six months before the expiration date. The certificate authority that is not selected as
the default certificate authority is not automatically renewed.
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) Browse to Other Elements > Certificates > VPN Certificate Authorities.

3) See the Expiration Date column for information about the CA’s expiration date.

4) To view detailed information, right-click an Internal RSA CA for Gateways or an Internal ECDSA CA for
Gateways, then select Properties. Check the following information in the Properties dialog box:
• Validity information in the Valid from and Valid to fields.
• Status information:

• Active: You can use this Internal CA for Gateways to sign certificates.
• Renewal Started: This certificate authority is a new Internal CA for Gateways that the SMC has

created automatically. The process of renewing VPN certificates has begun.
• Expires Soon: A new Internal CA for Gateways has been created but some components might still

use certificates signed by this Internal CA for Gateways.
• Inactive: This Internal CA for Gateways has expired or no SMC components use a certificate signed

by this internal VPN CA.

Related concepts
Problems with certificates on page 1355

Related tasks
Select the default internal certificate authority on page 1226



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Managing VPN certificates | 1236



Reconfiguring existing VPNs | 1237

 CHAPTER 71

Reconfiguring existing VPNs
Contents

• Changing tunnels in a VPN on page 1237
• NAT traversal in VPNs on page 1238
• NAT for VPN gateway communications on page 1238
• NAT for traffic in VPN tunnels on page 1239
• Add gateways to an existing VPN on page 1239
• Changing gateway IP addresses in an existing VPN on page 1240
• Giving VPN access to more hosts on page 1241
• Route all Internet traffic through policy-based VPNs on page 1241
• Redirect traffic between VPN tunnels on page 1242
• Changing pre-shared keys for VPNs on page 1244
• Gateway settings for VPNs on page 1245

You can reconfigure and tune existing VPNs.

Changing tunnels in a VPN
You can add or remove tunnels in a VPN.

Note:  Before changing the tunnels that are used in active VPNs, we recommend that you back up
the Management Server.

You must add or remove Route-Based VPN Tunnel elements manually.

In a policy-based VPN, the gateway topology and the number of active endpoints in each gateway element
determine the number of tunnels generated for a VPN. After changing the topology of a policy-based VPN,
always check that all new or changed tunnels are valid on the Tunnels tab.

• Each central gateway forms a tunnel with each central and satellite gateway in the VPN. No other Gateway<-
>Gateway tunnels are created. Tunnels are not generated between endpoints that cannot connect to each
other. For example, tunnels are not generated between two endpoints if they both have a dynamic IP address.

• Adding a gateway under another gateway instead of directly at the main level in the central gateways list can
prevent tunnel generation. This configuration implies that the gateway at the main level forwards connections
to the gateways below it in the hierarchy. For the forwarding to work, it must be explicitly configured in the
central gateway’s Access rules with the Use VPN > Forward action.

• Endpoint<->endpoint tunnels are created between all endpoints defined in the properties of any two gateways
that form a Gateway<->Gateway tunnel.

Related concepts
Defining VPN gateways on page 1149
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Related tasks
Back up system configurations on page 1263
Create Route-Based VPN Tunnel elements on page 1182
Define VPN topology for policy-based VPNs on page 1168
Define endpoints for VPN Gateway elements on page 1150

NAT traversal in VPNs
NAT traversal (NAT-T) prevents intermediary devices from applying NAT to VPN communications if NAT is found
to prevent the communications from working.

NAT traversal encapsulates the IKE and IPsec communications inside UDP packets. The NAT-T encapsulation
option does not affect mobile VPNs. NAT-T is always active in mobile VPNs.

Note:  The TCP Tunneling option is included for backward compatibility with legacy Forcepoint
NGFW software versions. Selecting this option has no effect on Forcepoint NGFW version 5.9.0 or
later.

Encapsulation is not always necessary. Usually, you can define Contact Addresses so that the VPN works even
when NAT is applied. The encapsulation options are activated in the endpoint properties in the Engine Editor or in
the External VPN Gateway element.

Related concepts
Considerations for setting up system communications on page 127

Related tasks
Define endpoints for VPN Gateway elements on page 1150
Define endpoints for External VPN Gateways on page 1153

NAT for VPN gateway communications
You can apply NAT to the communications between VPN Gateways.

The communications that establish and maintain VPN tunnels between VPN Gateways are always translated
according to the NAT rules. Create a matching NAT rule to translate addresses in these communications and
make sure that the communications do not match the wrong NAT rule unintentionally.

When you add NAT, you might need to change VPN settings. Add contact addresses for the firewalls. Contact
Addresses can be used with both internal and external gateways.

There is nothing VPN-specific about creating the actual NAT rules.

Related concepts
Getting started with NAT rules on page 835
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NAT for traffic in VPN tunnels
You can configure NAT for traffic in VPN tunnels in the properties of the Policy-Based VPN element.

By default, IP addresses in traffic that enters or leaves a VPN tunnel are not translated. An option in the
properties of the Policy-Based VPN element, accessible through the right-click menu for the policy-based VPN,
defines whether NAT is applied to traffic in VPN tunnels.

If the option to translate the IP addresses is enabled, the IP addresses in traffic that uses site-to-site VPN tunnels
are translated according to the NAT rules. There is nothing VPN-specific in creating these NAT rules. However,
the VPN configuration is affected if local protected addresses are translated using NAT:
• Set the Site element that contains the private local addresses (before translation) in the Private mode in VPNs

in which those addresses are translated using NAT.
• Add the translated addresses as a new Site for the gateway (disable the Site in other VPNs). This Site is in the

default Normal mode.

VPN client traffic is translated according to the NAT Pool settings defined for the Firewall in the Engine Editor, or
as defined in the NAT rules.

Related concepts
Defining IP addresses for VPN clients on page 1250
Getting started with NAT rules on page 835

Add gateways to an existing VPN
You can add new gateways to route-based and policy-based VPNs.

If you have already configured a policy-based VPN, you can add new gateways as needed.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Create a gateway element to represent the physical gateway device in VPNs if the element does not exist
already.
VPN Gateway elements are automatically created for Forcepoint NGFW in the Firewall/VPN role. The same
element can be used in many VPNs.

2) If the VPN uses certificates for authentication, you might need to create a VPN certificate for the gateway.
The same certificate can be used in many VPNs, providing it fulfills the following criteria:
• The certificate must match the type of certificate selected for the VPN in the VPN Profile.
• The certificate must be issued by a certificate authority that the other Gateways trust.

3) Add the gateway to a policy-based VPN or to a Route-Based VPN Tunnel element.
• Edit the Policy-Based VPN element to add the gateway on the Site-to-Site VPN tab.
• Edit the Route-Based VPN Tunnel, and select the gateway.

4) Check and adjust the tunnels between the new gateway and the existing gateways.
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5) Refresh the policies of all NGFW Engines that are involved in the tunnels.

Related concepts
VPN certificates and how they work on page 1221

Changing gateway IP addresses in an
existing VPN

There are special considerations depending on whether you change the IP address of a VPN Gateway element
or an External VPN Gateway element.

For VPN Gateway elements, the IP addresses you have defined for the firewall's interfaces determine the VPN
endpoint addresses. On Firewall Clusters, only CVI addresses are used as VPN endpoints.

Note:  If the gateway’s identity in the VPN is based on its IP address, you must update the
configurations of all gateways in the VPN. You must update the configurations even if the IP
address is NATed and not directly used for contact. For VPN Gateway elements, you update the
configuration by refreshing the engine’s policy after you change the IP addresses. For External
VPN Gateways, change the information in the configuration of the gateway device.

• If you change the IP address for a firewall interface, the corresponding VPN endpoint IP address also changes
automatically. The existing tunnels in the Policy-Based VPN element and the Route-Based VPN Tunnel
elements are preserved.

• If continuous connectivity is required, define the new address as a second endpoint before you change the IP
address. The Multi-Link VPN automatically selects the IP address that works before and after the change.

• If you add or remove interfaces, you might need to select or deselect endpoints manually and then check the
tunnel configuration in the Policy-Based VPN element or the Route-Based VPN Tunnel elements.

Note:  You cannot use the same endpoint in a policy-based VPN and a route-based VPN.

For External VPN Gateways, you always enter the VPN endpoint addresses manually. Change the IP address
configured in the Management Client, then refresh the policies of all affected firewalls.

Related tasks
Define VPN tunnel settings for policy-based VPNs on page 1170
Define endpoints for VPN Gateway elements on page 1150
Define endpoints for External VPN Gateways on page 1153
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Giving VPN access to more hosts
If you want to give access to hosts with IP addresses that are not already configured for your policy-based VPN,
you must follow several general steps.

With route-based VPNs, it is not necessary to change the VPN configuration to allow access through the VPN for
more hosts. Any traffic that is routed to a tunnel interface and allowed by the Access rules automatically uses the
route-based VPN tunnel.

In policy-based VPNs, proceed according to this general workflow:

1) Make sure that the IP addresses are included in one of the Sites of the correct gateway. If the IP addresses
must not be included in other VPNs where the same gateway element is used, add them to a separate Site.
Disable the Site in other VPNs.

2) (VPN with external gateways) Add the new IP addresses to the configuration of the external gateway device,
so that it routes the traffic through the VPN.

3) Check that the Access rules of all gateways involved specify that this traffic is sent or allowed through the
policy-based VPN. If NAT is enabled in the policy-based VPN, also check the NAT rules.

Related tasks
Create NAT rules for policy-based VPN traffic on page 1178
Add a VPN site on page 1158
Create rules for gateway connections in policy-based VPNs on page 1174

Route all Internet traffic through policy-
based VPNs

You can force all traffic from VPN clients or clients in protected networks to be routed through a policy-based
VPN.

Before you begin
You must have a working VPN between all gateways.

Routing all traffic from VPN clients or clients in protected networks through a policy-based VPN allows the traffic
to be inspected centrally.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Enable NAT for tunneled traffic in the Policy-Based VPN element’s properties.

2) Change the mode of the central gateway’s sites in this policy-based VPN to Private and replace them with a
Site element that contains the Any Network element. Disable the Any Network Site in other VPNs.
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3) Reconfigure the policy:

a) Create Access rules.

b) Create NAT rules that translate any private IP addresses to public addresses for the Internet.

4) Redirect the traffic from external components to the central gateway as necessary.
For VPN Gateways elements, add an Access rule that sends the allowed traffic to the VPN.

5) (VPN Clients only) Configure the Virtual Adapter.

Related concepts
Defining Site elements for VPN gateways on page 1156
Virtual IP addresses for VPN clients on page 1251

Related tasks
Create NAT rules for policy-based VPN traffic on page 1178
Edit a policy-based VPN on page 1168
Create forwarding rules on hub gateways for policy-based VPNs on page 1176
Create rules for gateway connections in policy-based VPNs on page 1174

Redirect traffic between VPN tunnels
In policy-based VPNs, you can redirect traffic from one VPN tunnel to another VPN tunnel through a hub
gateway.

Before you begin
You must have a policy-based VPN configured. If VPN client traffic is forwarded, you must configure
virtual IP addressing for VPN clients.

Redirecting traffic between VPN tunnels is especially useful for VPN client users who need access to resources
at different locations. When you redirect traffic between VPN tunnels, users do not have to separately connect to
different gateways.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Reconfiguring existing VPNs | 1243

 For more details about the product and how to configure features, click Help or press F1.Steps

1) On the Site-to-Site VPN tab of the Policy-Based VPN editing view, place the forwarding hub gateway at the
top level of the Central Gateways list.

 

2) Place the gateways that are contacted through the hub under the hub gateway.

Note:  Duplicate tunnels are not allowed. There must not be site-to-site connections between
the hub and the other gateways in other active VPNs.

3) Add a Site element that contains the IP addresses behind the spoke gateways under the hub gateway.

a) Set the Mode of the Site element to Hub.

b) Disable the Site element in any other VPNs where it is used.

The protected IP addresses are behind the spoke gateways.

4) To forward VPN client traffic, add a Site element that contains the virtual IP address space used for the VPN
clients under the hub gateway.

5) Add Access rules that forward the traffic between tunnels.

6) Refresh the policies of all firewalls involved in the VPN, starting from the firewall that acts as the hub
gateway.
Optionally, all traffic (including Internet traffic) can be routed through the hub gateway.

Related concepts
Virtual IP addresses for VPN clients on page 1251
VPNs and how they work on page 1127
Configuration 4: Basic VPN hub on page 1216

Related tasks
Create forwarding rules on hub gateways for policy-based VPNs on page 1176
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Changing pre-shared keys for VPNs
You can renew or generate pre-shared keys automatically or manually.

Replace pre-shared keys for VPNs
You can replace pre-shared keys for policy-based and route-based VPNs. You can replace with an automatically
generated key or then manually paste or enter a key.

Before you begin
Pre-shared key authentication must be selected in the VPN Profile and allowed in the Gateway Profiles

As a security precaution, we recommend that you periodically change the pre-shared key (for example, monthly).

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.

2) For policy-based VPNs, right-click the Policy-Based VPN element, select Edit <element type>, then follow
these steps.

a) Click the Tunnels tab.

b) To automatically generate pre-shared keys for multiple tunnels, select the tunnels.

c) Right-click the selected tunnels, then select Delete Pre-Shared Key.

d) Right-click the selected tunnels again, then select Generate Missing Pre-Shared Key.
A new pre-shared key is generated for each tunnel.

e) To manually enter the key for a single tunnel, double-click the Key column, then enter or paste the key.

f) To transfer the key for a tunnel to external components, double-click the Key column, then copy the key,
or click Export.

Note:  Make sure that outsiders cannot obtain the key while you transfer it to other
devices. The key must remain secret to be an effective security measure.

3) For route-based VPNs, right-click a Route-Based VPN Tunnel element, select Properties, then follow these
steps.

a) Next to Pre-Shared Key, select Edit.

• To automatically generate a key, click Generate.
• To manually enter the key, enter or paste the key.
• To transfer the key to external components, copy the key, or click Export.
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b) Click OK.

4) Click  Save.

Gateway settings for VPNs
The Gateway Settings element defines performance-related VPN options for the Firewalls.

The gateway settings are used internally and there is no need to match them exactly with settings of other
gateways in VPNs.

MOBIKE settings in Gateway Settings
MOBIKE (mobile IKE) return routablility checks (RRC) can be used with IKEv2 to verify the validity of VPN client
or gateway IP addresses if the IP address changes in the middle of an open VPN connection.

The IP address is updated in the negotiated SAs when the new IP address has been verified. If the new IP
address cannot be verified, the VPN connection is closed. By default, no return routablility checks are done.

Negotiation Retry settings in Gateway Settings
If a negotiation for a VPN does not complete successfully, the VPN establishment is retried according to settings
in the Negotiation Retry section in Gateway Settings properties.

The default settings are the recommended values. VPN establishment might fail because you have frequent
intermittent problems with network connectivity or because your network connection is too slow. In these cases,
increasing Negotiation Retry values might be a work-around solution for getting the VPN to establish.

Certificate Cache settings in Gateway Settings
The CRL Validity setting in the Certificate Cache section in Gateway Settings properties has effect only if you
use certificates to authenticate VPN gateways in IKE negotiations.

The default setting is the recommended value. Adjust the setting only if you need to do so.

Define a custom Gateway Settings element
The Gateway Settings element defines performance-related VPN options for the Firewalls.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to VPN.
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2) Browse to Other Elements > Profiles > Gateway Settings.

3) Right-click Gateway Settings branch in the element, then select New Gateway Settings.

Assign gateway settings to a Firewall
You can change the gateway settings to a set you have created yourself.

By default, all Firewalls use the Gateway Default Settings Gateway Settings element.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration.

2) Right-click a Firewall, then select Edit <element type>.

3) Browse to VPN > Advanced.

4) Select an Gateway Settings element from the Gateway Settings list.
To browse for an element, click Select. To create an element, select New.

5) Click  Save and Refresh to transfer the changes.
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 CHAPTER 72

VPN client settings
Contents

• VPN client settings and how they work on page 1247
• VPN client settings in the Management Client on page 1248
• Defining IP addresses for VPN clients on page 1250

Stonesoft VPN Client does not have controls for many settings that are needed for establishing a VPN. These settings
are defined in the SMC. Stonesoft VPN Client downloads the settings from the gateways it connects to. VPN clients are
only supported in policy-based VPNs.

VPN client settings and how they work
Stonesoft VPN Client settings are configured centrally in the SMC. The settings are automatically updated to the
Stonesoft VPN Client from the engines when the clients connect.

What VPN client settings in the SMC do
The following settings are transferred from the gateway to the client:
• Routing information (VPN Site definitions). Generally, if an IP address that the client wants to contact is

included in the Site definition, the traffic is routed into the VPN.
• Authentication settings
• Encryption settings
• Information about the gateway’s endpoints
• Settings for NAT traversal methods allowed
• Settings for local security checks on the client computer
• Secondary IPsec VPN gateways to contact in case there is a disruption at the IPsec VPN gateway end

Limitations
• When the Stonesoft VPN Client is first installed, it has no configuration. Either the user or the administrator

must add the basic information about gateways, such as the IP address to use for connecting.
• There are version-specific dependencies between the Stonesoft VPN Client and Firewall/ VPN software. See

the Release Notes of the Stonesoft VPN Client version you intend to use for information about compatibility
with your Firewall/VPN gateway’s software version.

• The SMC does not create configurations for third-party VPN clients. You must create the configuration through
the controls and tools of the third-party VPN client product.

https://support.forcepoint.com/Documentation
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Related concepts
VPNs and how they work on page 1127
Configuration 3: Basic VPN for remote clients on page 1209

Related tasks
Create rules for VPN client connections in policy-based VPNs on page 1175

VPN client settings in the Management
Client

Several settings for Stonesoft VPN Client are available in the Management Client.

Table 147: Stonesoft VPN Client settings in the Management Client

Location Setting Explanation

TCP Tunneling
Port

This option is included for backward compatibility with legacy
Forcepoint NGFW software versions. Selecting this option has no
effect on Forcepoint NGFW version 5.9.0 or later.

Engine Editor >
VPN > Advanced

Translate IP
Addresses Using
NAT Pool

• Address range for translating IP addresses of incoming
Stonesoft VPN Client connections for internal networks

• Alternative to using the Virtual Adapter (next setting in this
table)

VPN Type Defines the type of tunnels the mobile VPN supports.
• IPsec VPN — The mobile VPN only supports IPsec tunnels.
• SSL VPN — The mobile VPN only supports SSL VPN tunnels.
• Both IPsec & SSL VPN — The mobile VPN supports IPsec

and SSL VPN tunnels.

SSL Port (SSL VPN
types only)

The port for SSL VPN tunnels.

TLS Cryptography
Suite Set (SSL VPN
types only)

The cryptographic suite for SSL VPN tunnels.

Authentication
Timeout (SSL VPN
types only)

The timeout for Stonesoft VPN Client user authentication.

Engine Editor >
VPN > VPN Client

Local Security
Checks

Defines whether Stonesoft VPN Client checks for the presence of
basic security software to stop connections from risky computers.
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Location Setting Explanation

Virtual IP address
(Using Virtual
Adapter)

• Options for configuring Stonesoft VPN Client with a second,
virtual network adapter with a DHCP-assigned IP address for
connections inside the VPN.

• Alternative to using the NAT Pool (previous setting in this
table).

Secondary IPsec
VPN Gateways

IPsec VPN gateways to contact in case there is a disruption at the
IPsec VPN gateway end (in the order of contact).

Versions IKE versions used in IKE SA negotiations

Cipher Algorithms

Message Digest
Algorithms

The supported algorithms for the current version of Stonesoft VPN
Client.

Diffie-Hellman
Groups

Diffie-Hellman groups used in IKE SA negotiations.

VPN Profile
element
properties > IKE
SA tab

Authentication
Method

SA Lifetime in
Minutes

IKEv1 Negotiation
Mode

These settings have no effect on Stonesoft VPN Client
connections. See IPsec Client tab instead.

IPsec Type Only ESP is supported.

Cipher Algorithms

Message Digest
Algorithms

The supported algorithms for the current version of Stonesoft VPN
Client.

Compression
Algorithm
Deflate

VPN Profile
element
properties > IPsec
SA tab

Use PFS with
Diffie-Hellman
Group

Diffie-Hellman group used in IKE SA negotiations when PFS can
be used.

Authentication
Method

The selected authentication method used with Stonesoft VPN
Client.

Allow Hybrid/EAP
Authentication

Stonesoft VPN Client users authenticate by user name and
password (or other type of passcode), and the gateway
authenticates itself to the client with a certificate.

Allow CN
authentication

Allows authentication using the common name in the certificate as
the user name. The CN is checked against a value entered in the
User elements.

VPN Profile
element
properties > IPsec
Client tab

Allow Pre-Shared
Key Authentication
with IKEv1

This setting has no effect on Stonesoft VPN Client connections,
as pre-shared key authentication is not supported.
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Location Setting Explanation

IPsec Security
Association
Granularity

Defines whether SAs are negotiated per network or per each
connecting IP address.
Stonesoft VPN Client only supports the SA Per Net setting.

Policy-Based VPN
element > Tunnels
tab

Pre-shared Key
fields

This setting has no effect on Stonesoft VPN Client connections.
Pre-shared keys for Stonesoft VPN Client connections are defined
per-user account in the User elements.

Defining IP addresses for VPN clients
There are two different methods to define the IP addresses that VPN clients use in the internal network.

You must always configure one of the following methods for the mobile VPN to be valid:

1) You can use NAT to translate the IP addresses in communications. Using NAT gives the VPN clients an
‘internal’ IP address in the internal network without the need for a DHCP server. This method is called a NAT
Pool.
• This method is not recommended for the Stonesoft VPN Client. It does not allow the clients to make

queries to internal DNS servers without manual configuration.
• NAT rules are not applied to communications from clients that receive their address through the NAT Pool

feature. The NAT Pool translation is applied before the NAT rules.
• The NAT Pool method does not require any other client-side features.

2) (Recommended for the Stonesoft VPN Client) You can use a DHCP server to assign a virtual IP address that
VPN clients use in communications through the VPN tunnel. The IP address is attached to a Virtual Adapter.
Using this method provides the following benefits over the NAT Pool:
• Centrally configure the DNS settings for VPN clients when connected (using the DHCP server).
• Control how the IP address each VPN client is assigned (depending on the DHCP server).
• Forward mobile VPN traffic to a site-to-site VPN or route the Internet traffic from the client computer

through the gateway for inspection.
• Open new connections from the internal network to the VPN client computers through the VPN.

To use the Virtual Adapter, the VPN client software must support this feature. Not all third-party VPN clients
have a Virtual Adapter feature. The Virtual Adapter is required when there is a need to open connections from
the internal network to the VPN client. Activating both the NAT Pool and the Virtual Adapter is technically
possible. However, the NAT Pool address translation is applied to all VPN client traffic when activated, including
connections from hosts that use a Virtual Adapter.

Note:  For a detailed technical discussion on using a virtual IP address, see RFC 3456.

Related concepts
VPNs and how they work on page 1127



 Forcepoint Next Generation Firewall 6.4 | Product Guide

VPN client settings | 1251

Translate VPN client IP addresses using NAT
Pool
The NAT pool defines a range of IP addresses that the firewall can use to translate the source address of
connections from VPN clients.

The NAT pool translates the addresses in the same way as NAT rules do. Connections that use the NAT Pool
must not match any NAT rules.

Note:  Make sure that NAT is enabled for this VPN. The Enable NAT with this VPN option in the
properties of the VPN element must be selected. Otherwise, the NAT pool options have no effect.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the firewall element and select Edit <element type>.
The Engine Editor opens.

2) In the navigation pane on the left, select VPN > Advanced.

3) Select the Translate IP Addresses Using NAT Pool option.

Note:  If the NAT Pool is active, it is also used for translating connections from VPN clients
that have a virtual IP address. It is not possible to exclude hosts with a virtual IP address from
being subject to the NAT Pool address translation.

4) In the IP Address Range and Port Range fields, enter the IP addresses and ports you want to use for
translating VPN client traffic.

CAUTION:  Make sure the addresses that you define here do not overlap with addresses that
are in use in your networks. Also, the addresses must not overlap with any translated address
space in your NAT rules.

Virtual IP addresses for VPN clients
You can use a Virtual Adapter to assign the VPN client an IP address in the VPN, independent of the address the
VPN client computer uses in its local network.

The virtual IP address is only used in communications through the VPN tunnels. The VPN gateway gets the
IP address and network settings of the Stonesoft VPN Client from the an external DHCP server and forwards
the information to the Stonesoft VPN Client. For one-way access without DNS resolving, the VPN gateway can
alternatively be set up to apply NAT to translate the Stonesoft VPN Client connections. This method is meant for
testing purposes.

The VPN gateway specifies the destination IP addresses for traffic that the Stonesoft VPN Client sends into
the VPN tunnel. The IP addresses are configured as Site elements for each gateway in the Management
Client. When the Sites contain specific internal networks, the Stonesoft VPN Client receives a configuration for
split tunneling. Split tunneling means that only the specified portion of traffic uses the VPN tunnel, and other
connections use the local network as usual.

This feature requires the following:
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• You use an external DHCP server to assign the IP addresses.
• The users use a VPN client that has a Virtual Adapter feature. The Stonesoft VPN Client always has this

feature installed and active.

Most DHCP servers allow a configuration in which a particular client computer is always assigned a particular IP
address. For example, the DHCP server might assign the IP address based on the MAC address if VPN clients
have fixed MAC addresses for their Virtual Adapters. By default, when the Stonesoft VPN Client virtual adapter
requests an IP address, it uses the MAC address of the physical interface used in the VPN connection.

Define virtual IP addresses for VPN clients in
the Engine Editor
You can use a Virtual Adapter to assign the VPN client an IP address in the VPN.

Before you begin
• You have defined an external DHCP server to assign the IP addresses.
• The users have installed a VPN client that has a Virtual Adapter feature. The Stonesoft VPN Client

always has this feature installed and active.

Most DHCP servers allow a configuration in which a particular client computer is always assigned a particular IP
address. For example, the DHCP server might assign the IP address based on the MAC address if VPN clients
have fixed MAC addresses for their Virtual Adapters.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the firewall, then select Edit <element type>.

2) Browse to VPN > VPN Client.

3) From the DHCP Mode drop-down list, select how DHCP requests from VPN clients are sent.

Note:  If SSL VPN or Both IPsec & SSL VPN is selected from the VPN Type drop-down list,
only Direct and DHCP Relay are shown.

4) From the Interface or Interface for DHCP Relay drop-down list, select the source address for the DHCP
packets when querying the DHCP server (the interface toward the DHCP server).

5) Click Add, then select the DHCP server element that assigns IP addresses for the VPN clients.

6) (Optional) From the Add Information drop-down list, select what VPN Client user information is added to the
Remote ID option field in the DHCP Request packets.
• Add User information — VPN Client user information (in the form user@domain) is automatically added

to the Remote ID option field in the DHCP Request packets.
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• Add Group information — VPN Client user information (in the form group@domain) is automatically
added to the Remote ID option field in the DHCP Request packets.

Your DHCP server must support the DHCP Relay Agent Information option to use this information.
Depending on your DHCP server configuration, this information can be used as a basis for IP address
selection.

7) (Optional) Select Restrict Virtual Address Ranges, then enter the IP address range in the field on the right.
With this option, you can restrict the VPN clients’ addresses to a set range, even if the DHCP server tries
to assign another IP address. If an incorrect address is assigned, the user might not be able to access
resources. These address ranges must not overlap with the NAT Pool.

Note:  If the NAT Pool is active, it is also used for translating connections from VPN clients
that have a virtual IP address. It is not possible to exclude hosts with a virtual IP address from
being subject to the NAT Pool address translation.

8) (Optional) Configure the Firewall to act as a proxy for the VPN client’s ARP requests.

a) Select Proxy ARP.

b) In the field on the right, enter the IP address range for proxy ARP.

Note:  The Proxy ARP option might be required for a working VPN depending on your
network configuration.

9) Click  Save and Refresh.
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 PART XII
Maintenance and upgrades

Contents

• Configuration of automatic updates and upgrades on page 1257
• Backing up and restoring system configurations on page 1261
• Managing log data on page 1273
• Managing and scheduling Tasks on page 1291
• Managing licenses on page 1305
• Upgrading the SMC on page 1315
• Upgrading the engines on page 1321
• Manual dynamic updates on page 1327
• Managing SMC Appliance patches on page 1331

Maintenance includes procedures that you do not typically need to do frequently.
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 CHAPTER 73

Configuration of automatic
updates and upgrades

Contents

• Getting started with automatic updates and upgrades on page 1257
• Configure automatic updates and upgrades on page 1258

You can configure the Management Server to automatically download and install dynamic update packages, remote
upgrades for engines, and licenses.

Getting started with automatic updates
and upgrades

Automatic updates are available for dynamic update packages, remote upgrades for engines, and licenses.

Before dynamic updates and engine upgrades are downloaded and activated or installed, they are verified.
The Management Server and the NGFW Engines check the digital signature of each dynamic update or engine
upgrade using a valid Trusted Update Certificate. Only updates and upgrades with a valid signature can be
downloaded and installed. If there is a verification failure, the administrator receives an error. Verification failure
can result from an out-of-date SMC version or an invalid or missing signature.

What automatic updates and engine upgrades do
The Management Server can automatically perform the following tasks:

• Check for new dynamic update packages and automatically download and install them according to your
selection.

• Check for new engine upgrade packages. Engine upgrades can also be automatically downloaded, but they
must always be installed manually.

• Upgrade the licenses.

When automatic updates and engine upgrades are active, you can also view information regarding the
maintenance contract and support level of your licenses in the Management Client.

Limitations
• (Multiple Management Servers only) Dynamic update packages are downloaded and activated on the active

Management Server (the Management Server that controls all Domains). The settings for automatic updates
and upgrades are configured in the properties of the active Management Server.

• There are no automatic updates for the SMC software.
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• New engine software versions might require an upgraded version of the SMC. Check the Release Notes for
compatibility information before upgrading the engines.

• Upgrades and updates (both automatic and manual) require an active maintenance or support contract.
• If you select the Notify When Updates Become Available setting, you must manually download the updates

and engine upgrades.

Related concepts
Checking maintenance contract information on page 217

Related tasks
Configure automatic updates and upgrades on page 1258

Configure automatic updates and
upgrades

There are several options for handling automatic updates and engine upgrades.

Before you begin
The automatic updates and engine upgrades require the Management Server to be able to connect to
the servers at https://update-pool.stonesoft.com and https://smc-pool.stonesoft.com either using HTTPS
on port 443 or through an HTTP proxy. You must also have a valid maintenance or support contract.

The Management Server can periodically check for new dynamic update packages, engine upgrades, and
licenses. This feature is active by default. In an environment with multiple Management Servers, automatic
updates and upgrades must be enabled on the active Management Server (the Management Server that controls
all Domains).

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Global System Properties.

2) On the Updates tab, select Enable Sending Proof-of-License Codes to FORCEPOINT Servers.
Selecting this option allows you to select settings for dynamic updates and for engine and license upgrades.

3) Configure the Dynamic Updates settings.

Note:  Because update packages can change system elements, the policies might require
editing after update activation.

4) Select one of the Remote Upgrades for Engines settings.

https://support.forcepoint.com/Documentation
https://update-pool.stonesoft.com
https://smc-pool.stonesoft.com
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5) (Optional) Select Generate and Install New Licenses Automatically to automatically regenerate and install
the licenses required for upgrading SMC components to a major new release.

6) (Optional) Select the Update Check Interval to define how often the SMC checks for new updates.

7) Click OK.

Related concepts
Checking maintenance contract information on page 217
Getting Started with licenses on page 1305
Getting started with upgrading the SMC on page 1315
Getting started with upgrading NGFW Engines on page 1321
Getting started with manual dynamic updates on page 1327

Related tasks
Schedule Tasks on page 1300
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 CHAPTER 74

Backing up and restoring system
configurations

Contents

• Backups and how they work on page 1261
• Back up system configurations on page 1263
• Copy backup files to a storage location on page 1263
• Import backup files into the SMC on page 1264
• Restoring backups on page 1265
• Restore system configurations after a hardware failure on page 1268
• Managing SMC Appliance backups on page 1269

Backups contain the necessary configuration information to restore the SMC to the state it was in when the backup
was taken.

Backups and how they work
Backups are needed to recover from the loss of the system configurations, for example, due to hardware failure.
Backups also allow you to relocate the SMC servers onto different hardware.

The Management Server is the only component that contains usable, complete configuration information for any
individual engine component. The engines contain a working copy of the configuration details that allows them
to carry out traffic inspection independently. It is not possible to extract this information from the engines if the
Management Server is lost. For this reason, regular Management Server backups are essential and must be
stored in a safe storage location outside of the computer where the SMC servers are installed.

Always take the backups using the proprietary backup tools in the Management Client, on the Management
Server command line, or on the SMC Appliance command line. Third-party backup applications that back up the
host system might not produce usable backups of your SMC servers, especially if the SMC servers are running
when you take the backup.

Restoring backups allows you to restore the configurations to the state they were when the backup was taken,
even if you restore the backup in a different SMC.

Different types of backups contain different information:

• The Management Server backup contains the policies, elements, and other configuration details for all NGFW
Engines that they manage. The Management Server backup also contains the configuration information of the
Web Portal Server and of the Management Server itself.

• The Log Server backup contains the Log Server’s local configuration and optionally the logs.
• On the SMC Appliance, the Management Server and Log Server backups also contain the SMC Appliance

configuration files.

Note:  If your configuration includes TLS Credentials and Client Protection Certificate Authority
elements, the private keys and certificates used in these elements are included as plain text in the
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Management Server backup. Use the encryption option for the backups when the configuration
contains these kinds of elements.

The backup files are saved in the <installation directory>/backups/ directory of the server on which they were
created.

Note:  If you installed the Management Server in the C:\Program Files\Forcepoint\SMC directory
in Windows, some program data might be stored in the C:\ProgramData\Forcepoint\SMC
directory.

The following limitations apply:

• In FIPS-compatible operating mode, you can only restore backups that were created for an SMC in FIPS-
compatible operating mode.

• You cannot restore backups that were created in an SMC in FIPS-compatible operating mode on an SMC that
is not in FIPS-compatible operating mode.

• The private keys of engine certificates are stored locally on the engines and are not backed up.
• If you restore an SMC Appliance backup onto third-party hardware, SMC Appliance configuration information

is ignored. Only the Management Server and Log Server backups are applied.

Related concepts
TLS inspection and how it works on page 1037

Backup configuration overview
Managing backups involves several main steps.

1) Back up the Management Servers and Log Servers regularly or schedule backup tasks to run at regular
intervals.

2) Store the backup files in a safe location.

3) When necessary, restore a backup.
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Back up system configurations
Backups are needed to recover from the loss of the system configurations, for example, due to hardware failure.
A backup also allows you to relocate the SMC servers onto different hardware.

Before you begin
To back up a Management Server, there must be enough free disk space on the server. Twice the
size of the management database is required. If there is not enough available disk space, the backup
process does not start.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Management Server or Log Server you want to back up, then select Backup.

2) (Optional) To back up other servers, select the servers from the list on the left, then click Add.

3) (Optional) To encrypt the backup, select Encrypted, then enter and confirm a password.
We recommend this option if the configuration contains TLS Credentials and Client Protection Certificate
Authority elements.

4) (Optional) If you are creating a backup of Log Servers and you want to back up the log files, select Back up
Log Files.

5) Click OK.
The backup starts and the progress is shown on a new tab.

Next steps

Copy the backup files to a storage location.

Related concepts
Log data management and how it works on page 1273

Related tasks
Create Backup Tasks on page 1295
Schedule Tasks on page 1300

Copy backup files to a storage location
Copying backups to a storage location guarantees that the backup files are available if the data on the server on
which they were created is lost.

We recommend copying the backup file to a safe location, for example, to removable media or another host.
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The backup files are compressed to .zip files (unencrypted backups) or .enc files (encrypted backups) and they
can also be decompressed manually if needed. If necessary, the backups are split into several files to fit the
maximum file size. Each backup has its own subdirectory.

Note:  Handle the backup files securely. They contain all configuration information for the system.

On the SMC Appliance, backup files can be automatically stored in a remote location through a CIFS share.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Backups > Management Server or Backups > Log Server.

3) Right-click the backup file, then select Export.

4) Browse to the directory where you want to save the backup file, then click Open.
The backup file is exported.

5) To open the directory where you saved the backup file, click Open Directory.

6) From the computer where you use the Management Client, copy the backup files to a safe storage location.

Related tasks
Mount a CIFS share on page 1270

Import backup files into the SMC
To restore a backup of the Management Server, Log Server, or SMC Appliance, import the backup file into the
SMC.

When you import backup files, the backup files are added to the <installation directory>/backups/ directory of the
Management Server, Log Server, or SMC Appliance.

Note:  Handle the backup files securely. They contain all configuration information for the system.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Backups > Management Server or Backups > Log Server.

3) Right-click Management Server or Log Server, then select New > Import Backup.
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4) Browse to the backup file, then click Open.
The backup file is imported into the SMC.

5) When the import finishes, click OK.

Next steps

You can now restore the backup on a Management Server, Log Server, or the SMC Appliance.

Restoring backups
Restoring backups allows you to recover from the loss of the system configurations, or to relocate the SMC
servers onto different hardware.

You can restore backups that were created in one operating system to an installation running on another
operating system. You can also restore Management Server and Log Server backups that were created on a
non-appliance installation to an SMC Appliance.

Note:  In FIPS-compatible operating mode, you can only restore backups that were created for
an SMC in FIPS-compatible operating mode. You cannot restore backups that were created in
an SMC in FIPS-compatible operating mode on an SMC that is not in FIPS-compatible operating
mode.

You can restore backups from the previous major version of the SMC in the current major version of the SMC.
You might not be able to restore Backups taken from older versions. Generally, you can restore backups between
versions that support direct upgrades between the versions. See the upgrade instructions in the Release Notes.
If an intermediate upgrade is required between your current version and the newest version, upgrade the existing
installation to the intermediate version to create a working backup.

When you restore a backup, the backup restoration process checks that there is enough disk space on the
destination drive. Twice the size of the backup file is required. If there is not enough available disk space, the
restoration fails.

Restore Management Server backups
Restoring Management Server backups allows you to recover from the loss of the system configurations, or to
relocate the SMC servers onto different hardware.

Before you begin
Import the backup files into the SMC or copy the backup files to the <installation directory>/backups/
directory.

Note:  Handle the backup files securely. They contain all configuration information for the
system.

Note:  If the restore operation fails, the original configuration remains unchanged.

https://support.forcepoint.com/Documentation
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 For more details about the product and how to configure features, click Help or press F1.Steps

1) To restore a backup on a Management Server installed in Windows or Linux, stop the Management Server
service through the operating system’s service management features or using the command-line script, then
start the backup restoration script.
• In Windows, run <installation directory>/bin/sgRestoreMgtBackup.bat
• In Linux, run <installation directory>/bin/sgRestoreMgtBackup.sh

2) To restore a backup on the SMC Appliance, run the following command to stop the Management Server
service and start the backup restoration script:

sudo smca-restore

Note:  To exclude SMC Appliance configuration files from being restored, use the –nosmca
option.
To restore only the SMC Appliance configuration files, use the -smcaonly option.

3) Select the backup file to be restored.
The default backup file names have the following structure: sgm_vVERSION.
[BUILD]_YYYYMMDD_HHMMSS[comment].

4) Type y, then press Enter to confirm the restoration.

5) If the backup is encrypted, enter the password.

6) If you are restoring the backup on a system that uses a different IP address, change the IP address of the
Management Server.

7) If components have certificates from a different certificate authority (CA) than the one contained in the
backup, regenerate the certificates.
The backup contains the internal CAs. If components have certificates from a different CA than the one
contained in the backup, the certificates are not accepted as valid after restoring the backup.

8) In Windows or Linux, start the Management Server.
The SMC Appliance automatically starts the Management Server after the backup has been restored.

9) (SMC Appliance only) Restart the SMC Appliance if you are prompted to do so.

Related concepts
Problems with certificates on page 1355

Related tasks
Change the Management Server IP address on page 458
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Restore Log Server backups
The Log Server backup contains the Log Server’s local configuration and optionally the logs.

Before you begin
Import the backup files into the SMC or copy the backup files to the <installation directory>/backups/
directory.

Note:  Handle the backup files securely. They contain all configuration information for the
system.

For Log Servers installed in Windows or Linux, if it is not possible to transfer the logs through a backup, you can
copy log files to the Log Server through the operating system.

Note:  If the restore operation fails, the original configuration remains unchanged.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) To restore a backup on a Log Server installed in Windows or Linux, stop the Management Server service
through the operating system’s service management features or using the command-line script, then start
the backup restoration script.
• In Windows, run <installation directory>/bin/sgRestoreLogBackup.bat
• In Linux, run <installation directory>/bin/sgRestoreLogBackup.sh

2) To restore a backup on the SMC Appliance, run the following command to stop the Log Server service and
start the backup restoration script:

sudo smca-restore

Note:  To exclude SMC Appliance configuration files from being restored, use the –nosmca
option.
To restore only the SMC Appliance configuration files, use the -smcaonly option.

3) Select the backup file to be restored.
The default backup file names have the following structure: sgl_vVERSION.
[BUILD]_YYYYMMDD_HHMMSS[comment].

4) Type y, then press Enter to confirm the restoration.

5) If the backup is encrypted, enter the password.

6) If you are restoring the backup on a system that uses a different IP address, change the IP address of the
Log Server.

7) In Windows or Linux, start the Log Server.
The SMC Appliance automatically starts the Log Server after the backup has been restored.
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8) (SMC Appliance only) Restart the SMC Appliance if you are prompted to do so.

Related tasks
Change the Log Server IP address on page 459

Restore system configurations after a
hardware failure

Restoring backups on replacement hardware restores the SMC configurations to the state they were in when you
took the backup.

Steps

1) Restore the Management Server configurations on replacement hardware.

a) Install the Management Server software.
The same exact version is not required for recovery, but all SMC components must run the same
version to work together.

b) Restore the Management Server backup.

2) Restore Log Server configurations on replacement hardware.

a) Install the Log Server software, if not installed together with the Management Server software.
The same exact version is not required for recovery, but all SMC components must run the same
version to work together.

b) Restore the Log Server backup.

3) Restore engine configurations on replacement hardware.

a) Generate an initial configuration for the engine in the SMC.

b) Add the hardware to the network and configure it in the same way as a new installation.

c) When contact with the Management Server is established, install the policy.
The full working configuration is transferred to the engine.

Note:  In some cases, the IPsec VPN certificate information can be lost and the policy
installation fails. If VPN certificate information is lost, delete the old VPN certificates in
the Management Client and create new VPN certificates for the engine. When you use
the same CA and certificate details, the other components accept the new certificates.
Policy installation is also possible if you disable the invalid configurations (for example, by
disabling all VPN-specific Access rules in the policy).
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Related concepts
Connect engines to the SMC on page 641

Managing SMC Appliance backups
You can create and manage Management Server and Log Server backups for SMC Appliance using the
Management Client. You can also use the smca-backup script on the command line of the SMC Appliance.

When you create a Management Server or Log Server backup for the SMC Appliance using the Management
Client, SMC Appliance configuration files are included in a directory in the backup .zip file.

There are two ways to restore backups:

• You can use the smca-restore command to restore Management Server and Log Server backups, and SMC
Appliance configuration files on the SMC Appliance.

• You can use the sgRestoreMgtSrv and sgRestoreLogSrv commands to restore Management Server and Log
Server backups on another platform. When you restore a backup that includes SMC Appliance configuration
information on another platform, the SMC Appliance configuration information is ignored.

To manage backups on the SMC Appliance command line, you must have SMC Appliance Superuser
administrator permissions. The backup commands must be run with elevated permissions using sudo. A list of
available sudo commands can be found by running sudo -l at the command line.

The SMC Appliance has a dedicated partition for storing logs and backups. There are several files included in a
full backup of the system.
• Log Server backup
• Management Server backup
• SMC Appliance OS configuration backup

Note:  If password protection is enabled for backups, the files are saved with AES 128-bit
encryption.

Backup files can be automatically stored in a remote location through a CIFS share.

Related reference
Security Management Center commands on page 1409
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Mount a CIFS share
Setting up a CIFS share allows the SMC Appliance to export backups and other files to a remote storage
location. A CIFS share is persistent, even if the appliance is restarted.

Before you begin
If there is a firewall between the SMC Appliance and the CIFS share location, make sure that CIFS
traffic is allowed.

Note:  CIFS shares are not supported in FIPS mode.

Steps

1) Log on to the appliance from the command line.

2) Enter the CIFS command.

sudo smca-cifs add -n <name> -s //<server>/<share> -u <username> -p <password> -d <domain>

Where <name> is the locally used name, <server>/<share> is the server or IP address and share name on
that server, and <domain> is the domain of the share.

3) Press Enter.

Result

The CIFS share is mounted in the /mnt/cifs/<name> directory. The CIFS credentials are stored in the /etc/smca/
cifs/<name> file.

Create an SMC Appliance backup on the
command line
You can create a backup of the SMC Appliance configuration from the command line.

Steps

1) Use the command line to log on to the appliance.

2) Run the backup command.

sudo smca-backup

You can append various options to the command to customize the backup process.

3) Press Enter.
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Move backups to remote storage
Regularly storing appliance backups in a remote location allows for a complete appliance recovery in the event of
an unexpected failure.

Before you begin
Mount a CIFS share.

Steps

1) Log on to the appliance from the command line.

2) (Optional) Create a backup of the appliance.

3) Enter the rsync command.

sudo smca-rsync add -i <source directory> -o <destination directory>

<source directory> is where the backups are stored when they are created and <destination directory> is the
remote location to store the backups. If you do not include the -i, the appliance defaults to the SMC backup
directory file.

4) Press Enter.

Result

The rsync command copies the backup files to the destination hourly. The command also runs a check to verify
that there are no duplicate files in the destination directory.

Restore SMC Appliance backups
You can use the smca-restore command to restore Management Server backups, Log Server backups, and SMC
Appliance configuration files on the SMC Appliance.

Steps

1) Log on to the SMC Appliance command line.

2) Run the restore command.

sudo smca-restore [options]

You can append various options to the command to customize the backup process.
• To specify the backup file to restore, use the -backup option.
• To restore the Management Server or Log Server backup without restoring the SMC Appliance

configuration, use the -nosmca option.
• To restore the SMC Appliance configuration without restoring the Management Server or Log Server

backup, use the -smcaonly option.
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3) If you did not specify the backup file, select the backup file to be restored.
The default backup file names have the following structure:
• sgm_vVERSION.[BUILD]_YYYYMMDD_HHMMSS[comment]
• sgl_vVERSION.[BUILD]_YYYYMMDD_HHMMSS[comment]

4) If the backup is encrypted, enter the password.

5) When the backup restoration has finished, restart the SMC Appliance if you are prompted to do so.
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 CHAPTER 75

Managing log data
Contents

• Log data management and how it works on page 1273
• Reducing unnecessary log generation on page 1276
• Archive log data on page 1277
• Delete log data on page 1279
• Export log data on page 1283
• View history of completed Log Tasks on page 1285
• Overwrite old log or audit entries when log storage is full on page 1285
• Examples of log management on page 1289

Log management consists of configuring when log data produced, which log entries are stored, and when stored log
entries are deleted or archived. To prevent the Log Server storage from filling up, log data management tools help you
manage log entries automatically.

Log data management and how it works
Log data management keeps the number of logs at a reasonable level and prevents log files from filling the
storage space.

Log entries are stored in log files on the Log Server. Audit entries are stored on the Log Server or Management
Server that originally created them. If these files are never removed, they eventually fill up the storage space on
the Log Server or Management Server. In the properties of the Log Server and the Management Server, you can
optionally specify what happens when the log storage is full. For the Log Server, an alert is automatically sent
when the amount of log and audit data on the Log Server exceeds 75% of the total storage capacity.

You can manage the log data in the following ways:

• Configure logging options in rules to prevent unnecessary log entries from being created.
• Export log data so that it can be used elsewhere.
• Copy log data to an archive location.
• Delete old or unnecessary log data.
• Set up automatic log management tasks to run automatically at regular intervals for exporting, copying, and

deleting selected data.
• Discard irrelevant log entries by pruning some of the log entries before they are stored on the Log Server.

This illustration demonstrates how log pruning filters are used in log data management.
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Figure 173: Log pruning

The engines send their logs to their configured Log Server. The Log Server either stores the log entries or
just relays them to be viewed immediately in the Current Events mode in the Logs view. Some logs might be
discarded through pruning before these operations. When you view logs, the information is fetched directly from
the Log Servers. Some other tasks, such as processing data for statistical reports, are also partially carried out by
the Log Server.

You can prune log entries in two phases using Immediate Discard filters and Discard Before Storing filters.
Immediate Discard filters delete log entries as they arrive to the Log Server. The Discard Before Storing filters
delete log entries before the log entries are stored on the Log Server.

Note:  Alert entries and audit entries cannot be pruned.

Limitations
Only the logs in the active storage are used in reporting. If you archive logs, you can still view them in the Logs
view, but they are no longer available when you generate reports.

Alert and audit logs cannot be pruned.

Related concepts
Getting started with reports on page 269

What log entries are
Most often, Access rules trigger Log entries.

Other types of rules can be set to create log entries as well. However, in most recommended configurations,
the volumes are much smaller than in Access rules. The system can also produce detailed Diagnostic logs and
always produces some other internal log entries (such as entries related to policy installation).
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What Alert entries are
Alert entries are notifications of important events that require the administrator’s attention.

The difference between alerts and normal log entries is that alerts are highlighted in the Management Client and
they can be escalated through external notification channels. In addition to rule matches, alerts can be produced
when an automatic test fails, a monitored element becomes unreachable, or if there is a system error.

Related concepts
Alert escalation and how it works on page 377

What Audit entries are
Audit entries provide a record of administrator actions and some internal events in the SMC.

Internal events in the SMC that produce audit entries include creation, modification and deletion of
elements, administrator logons, and the execution of scheduled tasks. This data is useful, for example, when
troubleshooting the cause of malfunctions caused by undocumented configuration changes.

Only the Management Server and the Log Server send audit entries. The audit entries are stored on the
Management Server or the Log Server that originally created them.

Where log data files are stored
Logs are stored as a file on the Log Server.

A separate folder is created for the logged events each hour. The log files are stored by default in the <installation
directory>/data/ storage/ directory on the Log Server.

The log files have the following naming: YYYYMMDD_hh_C<ORIGINATOR>_MMDDhhmmsssss.arch.
• The date YYYYMMDD_hh refers to the date and hour of the logged events.
• The rest of the file name starting with “_C” refers to the file creation date and the <ORIGINATOR> refers to

the originator of the logged events.

The time and date in the file name always use the UTC time zone, which is the system’s internal time zone.

Archive directory options for the Log Server
You can change the Log Server’s default archive directory and define up to 32 alternative or additional
directories.

For example, you can directly archive some or all logs on a network drive to free resources on the Log Server.
The Log Server’s default archive directory is <installation directory>data/archive.
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Domain boundaries in viewing and managing
log data
If administrative Domains are configured, all log, alert, and audit entries are Domain-specific.

When you log on to a Domain, only the entries related to that specific Domain can be viewed or managed.
However, Audit entries from all Domains are displayed to administrators who are logged on to the Shared
Domain.

Log data management configuration overview
Log data management involves several main steps.

1) Configure logging to generate only the log entries you need.

2) (Optional) Set up log archiving to store older important logs for possible later use and free up the space on
the Log Server.

3) (Recommended) Set up scheduled log data tasks for deleting logs that are not needed in the long term.

4) (Optional) Configure log pruning to prune out any unnecessary logs if any are generated.

Reducing unnecessary log generation
The primary way to manage logging is to set up the system to create all necessary logs and alerts and a
minimum of unnecessary log entries.

The main generator of logs that you can configure are the rules in traffic handling policies. Another major point
of configuration is the automatic tester, which you can set up to create alerts on various events. Some other
features also generate logs and alerts, but it is not always possible to reduce the generation of logs from these
features.

Normal and Alert logs are generated both based on internal conditions in the operation of a component and
based on traffic that the engines handle.

Internal conditions that trigger logs or alerts:
• There is a system error or warning.
• An engine test fails. You can configure the engine tester in detail and select whether test failures trigger an

alert.
• The status of an engine changes (not active by default).
• When the values of a monitored item exceed a threshold limit in an Overview (not active by default).
• Diagnostics are active on a Firewall engine (not active by default).

Traffic conditions that trigger logs and alerts:
• An IPS engine’s or a Layer 2 Firewall’s limit for the number of times tunneled traffic is rematched has been

reached (not active by default).
• Traffic matches a rule in your policy.
• Diagnostics are active on an engine (not active by default).
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You can also set up Log Servers to receive logs from any devices that can be set up to send syslog.

In addition to activating and deactivating logging and the listed features, you can optimize the number of
generated logs on the engines in the following ways:
• You can configure log compression for Discard logs for Firewalls, IPS engines, and Layer 2 Firewalls.
• On Firewalls, you can configure log compression also for antispoofing logs.

Log Tasks can export, archive, and delete logs. It is possible to schedule these tasks to run automatically. The
greater the volume of log data, the more frequently cleanup operations must run. For example, if the number of
stored log entries is constantly high, you might need to export and delete logs daily. The schedules are defined in
the Management Client’s local time. The Log Server might have a different time zone.

If administrative Domains are used, Log Tasks are always Domain-specific. You must define and run the Log
Tasks in a specific Domain to apply them to the log data in that Domain.

Related concepts
Getting started with the engine tester on page 649
Getting started with editing policies on page 855
Getting started with monitoring third-party devices on page 221

Related tasks
Enable or disable engine status monitoring on page 338
Set thresholds for monitored items in Overview elements on page 200
Configure inspection of tunneled traffic on page 692
Enable or disable diagnostics on engines on page 339
Configure log handling settings for engines on page 695

Archive log data
You can set up an Archive Log Task to copy log data from the active storage on the Log or Management Server
to some other location.

The same task can also delete the log data from the active storage. You do not have to set up a separate task for
freeing up the space.

By default, the log archive location is on the same disk drive as the active storage.

Note:  The Archive Log Task copies the existing log files without compression. Copying the files
without compression enables you to view the archived logs in the Logs view but they are not used
in the Reports view when reports are generated.
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Create an Archive Log Task
You can set up an Archive Log Task to copy log data from the active storage on the Log or Management Server
to some other location.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Tasks in the Administration tree and select New > Archive Log Task.

3) Enter a unique Name and an optional free-form Comment for your own reference.

4) Select the server from which the logs are archived and click Add.

Select log data to archive
You can specify the type of log data to archive and select additional options for the Archive Log Task.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Archive Log Task properties, switch to the Task tab.

2) Select the type of log data to archive using the Target Data options.

3) Select the Time Range of the log entries.
You have several options to limit the time range. For example, select Absolute Time Range in the Time
Range list and define the Start and End Time.

4) (Optional) Specify a script in the Script to Execute After the Task field.
The Log Server triggers this script after completing the task.

Define how log data is archived
You can define where the archived data is stored, and how the source data is handled after it has been copied to
the target location.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Archive Log Task properties, switch to the Operation tab.

2) (Optional) Select Filter for Copying.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Managing log data | 1279

3) In the Source Data Deletion section, select whether the data to be archived is kept in active storage after it
has been copied to the target location. You can also select that the task removes some other data from the
active storage. For example, the archive operation can copy important logs from within the time range and
then clear the active storage of all logs within the time range.
• To delete the archived data from the active storage, select the Delete Source Data option.
• To delete other data from active storage, select the Delete Other Data option and optionally a log filter for

deleting the other data.

4) Select the Archive Target Directory from the list. The directory is determined in the Log Server’s
configuration file (LogServerConfiguration.txt).

5) Click OK.
The task appears under Task Definitions in the Tasks branch of the Administration tree. You can run the
task either manually or according to a fixed schedule.

Related concepts
Getting started with filtering data on page 291

Related tasks
Edit Log Server configuration parameters on page 432
Start Tasks manually on page 1301
Schedule Tasks on page 1300
View log entries from specific servers and archive folders on page 252

Delete log data
To permanently delete generated log data, you can delete it from the active storage or delete it as it arrives to the
Log Server using pruning filters.

Create a Delete Log Task
The recommended way to delete logs is to set up a Delete Log Task.

In an emergency, you can also delete some of the log files from the Log Server (the default location for logs is in
the <installation directory>/data/storage folder).

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Tasks.

3) Right-click Tasks, then select New > Delete Log Task.
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4) Configure the settings.

5) Select the server from which the logs are deleted, then click Add.

Select log data to delete
You can specify the type of log data to delete and select additional options for the Delete Log Task.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Tasks in the Administration tree and select New > Delete Log Task.

3) In the Delete Log Task properties, click to the Task tab.

4) Select the type of log data for deletion using the Target Data options.

5) Select the Time Range of the log entries.
You have several options to limit the time range. For example, select Absolute Time Range in the Time
Range list and define the Start and End Time.

6) (Optional) Specify a script in the Script to Execute After the Task field. The Log Server triggers this script
after completing the task.

Filter log data to be deleted
You can use Filter elements to select log data to be deleted.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Tasks in the Administration tree and select New > Delete Log Task.

3) In the Delete Log Task Properties properties, click the Operation tab.

4) (Optional) Select a Filter element that defines which log entries are deleted.
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5) Click OK.
The task appears under Task Definitions in the Tasks branch of the Administration tree. You can run the task
either manually or according to a fixed schedule.

CAUTION:  When this task starts (either manually or as according to the schedule), all logs
matching the selected filter and time range are permanently deleted from the active storage.
Make sure that the data you want to keep is exported or copied to a safe location before the
operation is started.

Related concepts
Getting started with filtering data on page 291

Discard unnecessary logs
Log data pruning allows you to discard some of the generated logs according to detailed filtering criteria you set.

Before you begin
If Domains are in use, you must log on to the Shared Domain.

You can manage the amount of log data by defining log pruning filters. Log pruning is needed, for example, when
a rule generates both useful and unnecessary logs. Log pruning gives you the ability to discard newly generated
irrelevant logs entries on the Log Server. Only logs can be pruned: alerts and audit entries are never pruned.

It is better to adjust log generation options instead of letting log entries be generated and then pruning
them. Pruning log entries after they are generated wastes system resources by creating and transferring the
unnecessary logs.

You can define two types of log pruning filters:
• Immediate Discard filters delete log entries immediately as they arrive to the Log Server. The deleted log

entries are not displayed in the Management Client.
• Discard Before Storing filters deletes log entries before they are saved. Log entries are shown the Current

Events mode in the Logs view before they are deleted. This option converts Essential or Stored type log
entries to Transient log entries.

If Domain elements have been configured, log pruning filters can only be defined in the Shared Domain. The
same log pruning filters are used in all Domains. Administrators who have the right to manage log pruning can
view the log pruning filters when they are logged on to other Domains.

CAUTION:  Be careful when defining the pruning filters. The matching log events are irreversibly
deleted at the Log Server.

You can prune log entries as soon as they arrive on the Log Server or before they are stored. When you prune
log entries before they are stored, you can still view them in the Current logs view).

Use pruning with caution. The data is deleted without leaving any traces and there is no way to recover
incorrectly pruned entries. Pruning also wastes resources compared to preventing the entries from being
generated. Pruned entries still have to be created and transferred to the Log Server, and the Log Server still has
to process them.

You can prune normal log entries; alert and audit entries cannot be pruned. The logs are pruned using log filters.
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Note:  Pruning has no effect on logs that have already been stored.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > File > New Tab, then select Log Data Pruning.

2) Select the tab of the log data type you want to prune.

3) Select a log filter for pruning log data from the tree in the Resources pane. If you add several Log Filters,
they are combined with a logical OR. Each filter is matched individually, so all logs that match any of the
selected filters are deleted.
To create a Filter, select  New > Filter.

CAUTION:  Never select the Match All filter for log pruning. Pruning with the Match All filter
irreversibly destroys all new logs that are created.

4) Activate the pruning for the correct stage:
• Click Add below the Immediate Discard field to prune logs before they are even shown in the Current

Logs view.
• Click Add below the Discard Before Storing field to show the log entries in the Current Logs view and

then delete them before they are permanently stored.

CAUTION:  Any log entry that matches the filter you have selected is irrevocably deleted. The
changes you make to pruning filters are applied immediately.

5) A warning message is displayed. Click Yes to prune the selected log entries. This change is applied
immediately without any further action.

Related concepts
Getting started with filtering data on page 291

Cancel log pruning
You can disable Pruning filters by removing them from the Log Data Pruning panes.

An empty pane means that no logs are pruned.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > File > New Tab, then select Log Data Pruning.

2) Select the correct tab according to log data type.

3) Select the filter you want to remove from pruning in the Immediate Discard or Discard Before Storing field.
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4) Click Remove below the field that contains the filter.

Note:  Log Filters that are removed from pruning remain available for other use until you
delete them separately.

5) Click OK in the dialog box that is displayed to affirm this action. This change is applied immediately without
any further action.

Export log data
Exporting log data allows you to copy log data to a location outside of the Security Management Center (SMC)
without archiving the log data.

You can use Log Export tasks to export log data from the Log Server or from the Management Server. You can
either run the Log Export Task manually or schedule the task to run automatically. If administrative Domains have
been configured, you must run the Log Export Task in the Domain to which the Log Server belongs.

You can also export extracts of log data while browsing logs.

Create an Export Log Task
You can use Log Export tasks to export log data from the Log Server or from the Management Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Tasks in the Administration tree and select New > Export Log Task.

3) Enter a unique Name and an optional free-form Comment for your own reference.

4) Set the Operation Type to select the format for the exported data.

5) Select the server from which the log data is exported and click Add.

Select log data to export
You can specify the type of log data to export and select additional options for the Export Log Task.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.
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2) Right-click Tasks in the Administration tree and select New > Export Log Task.

3) In the Export Log Task Properties, click the Task tab.

4) Select the type of log data for export using the Target Data options.
If you selected Export IPS Recordings as PCAP or Export IPS Recordings as Snoop as the Operation
Type on the General tab, IPS Recording is automatically selected.

5) Select the Time Range of the log entries.
You have several options to limit the time range. For example, select Absolute Time Range in the Time
Range list and define the Start and End Time.

6) (Optional) Specify a script in the Script to Execute After the Task field.
The Log Server triggers this script after completing the task.

Define how log data is exported
You can define which log data to export, and the destination for the exported log data.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Tasks in the Administration tree and select New > Export Log Task.

3) In the Export Log Task Properties, click to the Operation tab.

4) Select the Storage directories to export from.

5) (Optional) Select the Filter for Exporting.

6) (Optional, IPS traffic recordings only) Enter the IPS Record ID of the traffic capture.

7) Define Server (‘export’ Directory) as the destination file location.
The file is exported to the export directory on the server.

8) Specify a name for the destination file (for example, ExampleExportLogTask.xml) or click Browse to
browse for an existing export file.

9) In If file already exists, specify what happens when a previous file with the same name exists in the same
folder.

10) Click OK.

Result

The task appears under Task Definitions in the Tasks branch of the Administration view. If you want to delete the
data after exporting, set up a scheduled task.
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Related concepts
Getting started with filtering data on page 291

Related tasks
Start Tasks manually on page 1301
Delete log data on page 1279

View history of completed Log Tasks
You can view all previously executed tasks related to logs from a history file.

The history file includes information related to Export Logs Tasks, Archive Log Tasks, and Delete Log Tasks. The
SMC never erases this file.

Steps

1) Open the <installation directory>/data/logfile.txt file in a text editor to view the previously
executed tasks.

Related concepts
Log data management and how it works on page 1273

Overwrite old log or audit entries when
log storage is full

By default, Log Servers stop receiving log entries when the log storage is full, and Management Servers shut
down when the audit storage is full. You can optionally overwrite old log entries when the log storage is full.

When you configure Log Servers or Management Servers to overwrite old log entries or audit entries when the
log or audit storage is full, the Log Server or Management Server writes new log entries or audit entries over the
existing entries, starting with the oldest entries, until more disk space is available.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Network Elements.

2) Browse to Servers, right-click a Log Server or Management Server element, then select Properties.

3) Configure the option to overwrite old log or audit entries depending on the type of server.
• Log Server — From the Log Storage Full drop-down list, select Overwrite Oldest.
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• Management Server — From the Audit Storage Full drop-down list, select Overwrite Oldest Audit
Entries.

4) Click OK.

Log Server Properties dialog box
Use this dialog box to define Log Server properties.

Option Definition

General tab

Name The name of the element.

IPv4 Address Enter the IPv4 address of the server. The server can have both an IPv4 and an IPv6
address.

IPv6 Address Enter the IPv6 address of the server. The server can have both an IPv4 and an IPv6
address.

Resolve Automatically resolves the IP address of the server.

Location Specifies the location for the server if there is a NAT device between the server and
other SMC components.

Contact Addresses section

Default Used by default when a component that belongs to another Location connects to this
server.

Exceptions Opens the Exceptions dialog box.

Port
(Optional)

Enter the Log Server's TCP Port Number.
We recommend that you always use the default port 3020 if possible.

Log Storage Full Specifies the action when the log storage on the Log Server is full.

• Stop Receiving — The Log Server stops receiving log entries.
• Overwrite Oldest — The Log Server overwrites log entries, starting with the oldest

log entries.

Category
(Optional)

Includes the element in predefined categories. Click Select to select a category.

Tools Profile Adds commands to the element right-click menu.Click Select to select an element.

Comment
(Optional)

A comment for your own reference.

Exclude from
Log Browsing,
Statistics and
Reporting
(Optional)

Select this option if you do not want the Log Server to gather statistical information
for monitoring and you do not want its logging data to be included in Reports. In most
situations, it is better to leave this option deselected.
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Option Definition

High Availability tab

Secondary Log
Servers

Shows the secondary Log Servers.

Add Opens the Select Element dialog box.

Remove Removes the selected row.

Option Definition

Monitoring tab

Log Server Selects the Log Server to which the logs from the third-party device are sent.

Status Monitoring When selected, activates status monitoring for the device. You must also select the
Probing Profile that contains the definitions for the monitoring. When you select Status
Monitoring, the element is added to the tree in the Home view.

Probing Profile Shows the name of the selected Probing Profile. Click Select to select a Probing Profile
element.

Log Reception Activates syslog reception from this device. You must select the Logging Profile that
contains the definitions for converting the syslog entries to SMC log entries. You must
also select the Time Zone in which the device is located. By default, the local time zone
of the computer you are using is selected.

Logging Profile Shows the name of the selected Logging Profile. Click Select to select a Logging Profile
element.

Time Zone Selects the time zone for the logs.

Encoding Selects the character set for log files.

SNMP Trap
Reception

Enables the reception of SNMP traps from the third-party device.

NetFlow Reception Enables the reception of NetFlow data from the third-party device. The supported
versions are NetFlow v5, NetFlow v9, and IPFIX (NetFlow v10).

Option Definition

Log Forwarding tab

Target Host The Host element that represents the target host to which the log data is forwarded.
Double-clicking this cell opens the Select Host dialog box.

Service The network protocol for forwarding the log data. Click the cell, then select the Service
from the drop-down list.
• TCP
• UDP (For IPFIX and NetFlow v9, this is the only available network protocol.)
• TCP with TLS

Note:  You might have to define an Access rule that allows traffic to the
target host. In this case, make sure that the Service you select is also used
as the Service in the Access rule.
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Option Definition

Port The port that is used for log forwarding. The default port used by IPFIX/NetFlow data
collectors is 2055. Double-click to edit the cell.

Note:  You might have to define an Access rule that allows traffic to the
target host. In this case, make sure that the port you select is also used as
the port in the Access rule.

Format Click the cell, then select the log forwarding format from the drop-down list. Logs are
forwarded in one of the following formats:
• CEF
• CSV
• LEEF
• NetFlow v9
• IPFIX
• XML
• McAfee ESM

Filter
(Optional)

An optional local filter that defines which log data is forwarded. The local filter is only
applied to the log data that matches the Log Forwarding rule. Double-clicking this cell
opens the Select Local Filter Properties dialog box.

TLS Profile Allows you to select a TLS Profile element that contains, for example, the settings for
cryptography, trusted certificate authorities, and the TLS version used in TLS-protected
traffic. Double-clicking this cell opens the Select a TLS Profile dialog box. The TLS
Profile is only available if you have selected TCP with TLS as the Service.

TLS Server Identity
(Optional, only if
a TLS Profile is
selected)

Select the identity of a TLS server to secure the TLS-protected traffic from the Log
Server to an external syslog server. Double-clicking this cell opens the TLS Server
Identity dialog box.

Data Type The type of log data that is forwarded. Click the cell, then select the log data type from
the drop-down list. Click Add to add a row to the table, or Remove to remove the
selected row.

Log Server TLS
Certificate Used for
Forwarding Logs

Select the certificate for TLS-protected log forwarding.
• Use Internal Certificate — Log Server certificate (signed by the Internal CA) is used

for TLS-protected syslog communication.
• Use Imported Certificate — A certificate signed by an external CA is used. Click

Select to select a certificate or to create a TLS Credentials element.
• No Client Authentication — The Log Server's certificate is not authenticated.

Option Definition

NAT tab

Firewall Shows the selected firewall.

NAT Type Shows the NAT translation type: Static or Dynamic.

Private IP Address Shows the Private IP Address.
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Option Definition

Public IP Address Shows the defined Public IP Address.

Port Filter Shows the selected Port Filters.

Comment An optional comment for your own reference.

Add NAT Definition Opens the NAT Definition Properties dialog box.

Edit NAT Definition Opens the NAT Definition Properties dialog box for the selected definition.

Remove NAT
Definition

Removes the selected NAT definition from the list.

Examples of log management
These examples illustrate some common uses for log management and general steps on how each scenario is
configured.

Example: archiving old log data
This scenario shows an example of archiving and deleting logs to free up disk space on the Log Server.

Old logs are taking up too much disk space on the Log Servers at Company A, but some of the logs are still
needed for the company’s records. The administrators decide to archive the needed logs on another server and
to delete last month’s log data from the Log Servers. Because not all old logs need to be archived, they delete the
unnecessary logs. They want to repeat the same archiving operation once a month. The administrators do the
following:

1) Create an Archive Log Task for archiving the data with the following settings:

Table 148: Archive Log Task for Company A

Option Setting

Time Range Last Full Month

Filter for Copying A custom filter that matches the important log data
that the administrators want to archive.

Delete Other Data Match All to delete all last month’s logs from the
Log Server.

Archive Target Directory A network drive.

2) Save the Archive Log Task.

3) Create a Scheduled Task for running the Archive Log Task and set it to be repeated monthly.

4) Save the Scheduled Task.
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Example: filtering out irrelevant logs
This scenario shows an example of using Log Data Pruning to temporarily discard unnecessary logs.

 
Figure 174: Company B's network

Server A provides services to users in network X, as well as to Server B. The administrators are interested in
tracking how many of the users in network X actually use Server A. Server B also connects frequently to Server
A, and generates a large amount of traffic.

The administrators are only interested in connections from other hosts in network X to Server A. The
administrators decide to temporarily eliminate logs related to Server B’s connections. All hosts in network X
including Server B are currently logged according to a single rule. Creating a separate rule to handle Server
B's connections with logging set to “None” would create unnecessary clutter in the policy. The administrators
decide to set up log pruning to filter the logs so that only the relevant ones are stored on the Log Server. The
administrators do the following:

1) Select one of the irrelevant log entries in the Logs view.

2) Create a temporary filter based on the log entry, and save the filter as a permanent filter.

3) Add the new filter to the Discard Before Storing list in the Log Data Pruning view.
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Managing and scheduling Tasks
Contents

• Getting started with Tasks on page 1291
• Task configuration overview on page 1292
• Task types on page 1293
• Creating Task Definitions on page 1294
• Schedule Tasks on page 1300
• Start Tasks manually on page 1301
• Pause the scheduled execution of Tasks on page 1301
• Remove Tasks from schedules on page 1302
• Stop running Tasks on page 1302

Tasks define parameters of system maintenance operations. You can run maintenance operations manually or
automatically according to a schedule you set.

Getting started with Tasks
You can use Task elements for manual or automatic maintenance operations in the SMC.

What Tasks do
With Task elements, you can start maintenance operations either manually or according to a schedule. You can
do the following with Tasks:
• Back up the Management Servers and Log Servers.
• Refresh policies.
• Upload policies.
• Validate policies.
• Upgrade engine software remotely.
• Export, archive, and delete logs.

There are also certain predefined system tasks.

Scheduling the Tasks allows you to run regular or one-time maintenance operations automatically, for example,
during a regular maintenance window.
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Limitations
Tasks are Domain-specific. The elements that are the target of the Task must belong to the Domain in which the
Task is run. For example, to export log data from a Log Server you must run the Log Export Task in the Domain
to which the Log Server belongs.

What do I need to know before I begin?
When scheduling automatic backups, you might want the data to be moved to a safe place automatically. This
can be achieved through operating system scripts, which Tasks can start automatically upon completion. With
Log Servers, you can change the backup and log archive locations in the Log Server’s local configuration file.

Related reference
Task types on page 1293

Task configuration overview
Before you can run a Task, you must define the parameters for the Task element. If you want the task to be run
automatically, you can also set up the Task execution schedule.

Follow these general steps to configure and use Tasks:

1) Define the Task parameters.

2) (Optional) Set up automatic Task execution.

3) Run Tasks when necessary.

Related concepts
Creating Task Definitions on page 1294

Related tasks
Schedule Tasks on page 1300
Start Tasks manually on page 1301
Pause the scheduled execution of Tasks on page 1301
Remove Tasks from schedules on page 1302
Stop running Tasks on page 1302
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Task types
There are several types of predefined system Task Definitions. In addition, you can create custom Task
Definitions.

Tasks are based on Task Definitions. There are two kinds of Task Definitions: custom Task Definitions and
predefined System Task Definitions. To view Task Definitions or to create new Task Definitions, browse to
Administration > Tasks > Definition in the Configuration view.

The following table explains the types of custom Tasks that you can create.

Table 149: Custom Task Definitions

Task Definition Explanation

Backup Task Creates backup files for the selected Management
Servers and Log Servers.

sgInfo Task Creates a .zip file that contains copies of configuration
files and system trace files for the selected
components for Forcepoint support.

Refresh Policy Task Refreshes the currently installed policy on the selected
engines and Master NGFW Engines, the currently
installed Alert Policy on the selected Domains.

Refresh Policy on Master Engines and Virtual Security
Engines Task

Refreshes the currently installed policy on the selected
Master NGFW Engines and the Virtual NGFW Engines
associated with the Master NGFW Engines. If a Virtual
Engine belongs to another administrative Domain, the
policy is refreshed in that Domain.

Upload Policy Task Uploads the selected policy to the selected engines.

Validate Policy Task Validates the selected policy on the selected engines.

Remote Upgrade Task Remotely upgrades the software on the selected
engines.

Export Log Task Copies log data from the active storage or archive to
the selected location.

Archive Log Task Copies log data from the active storage to the selected
location.

Delete Log Task Deletes log data from the active storage.

In addition to Task Definitions that you create and customize, there are predefined Task Definitions for several
system tasks. You can run the System Tasks manually or reschedule them, but you cannot change the options in
System Task Definitions.

Table 150: System Task Definitions

Task Definition Explanation

Create Snapshot of All System Elements Automatically creates a snapshot of all system
elements after an update package has been activated.
The snapshot information is used when administrators
compare policy snapshots.

https://support.forcepoint.com
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Task Definition Explanation

Delete Old Executed Tasks Deletes the list of entries in the History branch.

Delete Old Snapshots Deletes Policy Snapshots.

Disable Unused Administrator Accounts Disables the accounts of administrators who have
not been active within the time period defined in the
SGConfiguration.txt file. The accounts are disabled if
the Enforce Password Settings option is enabled. An
Administrator with unrestricted permissions can re-
enable the disabled accounts.

Fetch Certificate Revocation Lists Downloads Certificate Revocation Lists (CRLs) from a
CRL server.

Renew Gateway Certificates Generates new certificates for NGFW Engines that act
as VPN Gateways if automatic certificate renewal is
enabled for the NGFW Engines.

Renew Internal Certificate Authorities Checks the status of Internal Certificate Authorities for
automatic renewal. To make sure that the automatic
certificate authority renewal works correctly, do not
change the schedule of this Task.

This Task can only be run in the Shared Domain.
If administrative Domains have been configured, it
renews the Internal Certificate Authority elements in all
Domains.

Renew Internal Certificates Checks the status of internal certificates for automatic
renewal. To make sure that the automatic certificate
renewal works correctly, do not change the schedule
of this Task.

Related tasks
Create Backup Tasks on page 1295
Create sgInfo Tasks on page 1299
Create Refresh Policy Tasks on page 1295
Create Refresh Policy on Master Engines and Virtual Security Engines Tasks on page 1297
Create Upload Policy Tasks on page 1298
Create Remote Upgrade Tasks on page 1298
Enable and define password policy settings on page 366

Creating Task Definitions
You can create new Tasks to help you maintain your system. All Tasks are Domain-specific.

Related concepts
Log data management and how it works on page 1273
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Related reference
Task types on page 1293

Create Backup Tasks
Create a Task for backing up servers.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Tasks, then select New > Backup Task.

3) Give the Task a descriptive Name and optionally a free-form Comment.

4) Select the servers you want to back up from the list on the left, then click Add.
The selected servers are added to the list on the right.

5) (Optional) Write a Backup Comment, which is shown in the Management Client and added to the backup
file name.

6) (Optional) If you want to create an encrypted backup, select Encrypted, then enter and confirm a password.

7) (Optional) If you are backing up Log Servers, select the Back up Log Files option to back up the logs on
addition to the server’s configuration.

8) Click OK.
The new Backup Task is added to the list of Task Definitions.

Create Refresh Policy Tasks
Create a Task for refreshing a policy on selected engines or Domains.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Tasks, then select New > Refresh Policy Task.

3) Give the Task a descriptive Name and optionally a free-form Comment.
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4) Select the engines on which you want to refresh the policy, the Domains on which you want to refresh the
Alert Policy from the list on the left. Click Add to add the policy to the list.

Note:  If engines are the Target of the Task and you want already established connections
to continue using the same configuration information (such as NAT rules), verify that Keep
Previous Configuration Definitions is selected.

The selected elements are added to the list on the right.

5) (Optional, only if Domains or a single engine is the Target.) To validate the rules when the Task is started
manually, verify that Validate Policy before Upload is selected and select the related settings.

6) (Optional) Add an Upload Comment that is shown in Policy Snapshots or Alert Snapshots created from the
policy installations.

7) Click OK.
The new Refresh Policy Task is added to the list of Task Definitions.

Related tasks
Validate rules automatically on page 890
Create Refresh Policy on Master Engines and Virtual Security Engines Tasks on page 1297
Create Upload Policy Tasks on page 1298

Create Validate Policy Tasks
Create a Task for validating a policy on selected engines.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Tasks, then select New > Validate Policy Task.

3) Configure the settings.

4) Click OK.

Result

The new task is added to the list of Task Definitions.
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Create Refresh Policy on Master Engines and
Virtual Security Engines Tasks
The Refresh Policy on Master Engines and Virtual Security Engines Task is used for refreshing the currently
installed policy on the selected Master NGFW Engines and all Virtual NGFW Engines that are associated with the
Master NGFW Engines.

The policies of the Virtual NGFW Engines are installed in the administrative Domains to which the Virtual NGFW
Engines belong.

This Task is primarily meant for situations in which it is necessary to refresh the policy on many Master NGFW
Engines and Virtual NGFW Engines. This might be necessary, for example, after replacing the hardware on
which the Master NGFW Engines run). In most cases, use the Refresh Policy Task if you want to refresh the
policy on the Master NGFW Engines.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Tasks, then select New > Refresh Policy on Master Engines and Virtual Security Engines
Task.

3) Give the Task a descriptive Name and optionally a free-form Comment.

4) Select the Master NGFW Engines on which you want to refresh the policy from the list on the left, then click
Add.

Note:  If you want already established connections to continue using the same configuration
information (such as NAT rules), verify that Keep Previous Configuration Definitions is
selected.

The selected Master NGFW Engines are added to the list on the right.

5) (Optional) Add an Upload Comment that is shown in Policy Snapshots created from the policy installations.

6) Click OK.
The new Refresh Policy on Master Engines and Virtual Security Engines Task is added to the list of Task
Definitions.

Related tasks
Create Refresh Policy Tasks on page 1295
Create Upload Policy Tasks on page 1298
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Create Upload Policy Tasks
Create a Task for uploading a policy on selected engines.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Tasks, then select New > Upload Policy Task.

3) Give the Task a descriptive Name and optionally a free-form Comment.

4) Select the engines on which you want to upload the policy, the Domains on which you want to upload the
Alert Policy from the list on the left. Click Add.
The selected elements are added to the list on the right.

5) (Only if engines or Domains are selected as the Target). Click Select next to the Policy field, then select the
policy you want to upload.

Note:  If engines are the Target of the Task and you want already established connections
to continue using the same configuration information (such as NAT rules), verify that Keep
Previous Configuration Definitions is selected.

6) (Optional, only if Domains or a single engine is the Target). To validate the rules when the Task is started
manually, verify that Validate Policy before Upload is selected, then select the related settings.

7) (Optional) Add an Upload Comment that is shown in Policy Snapshots or Alert Policy Snapshots created
from the policy installations.

8) Click OK.
The new Upload Policy Task is added to the list of Task Definitions.

Related tasks
Validate rules automatically on page 890
Create Refresh Policy Tasks on page 1295
Create Refresh Policy on Master Engines and Virtual Security Engines Tasks on page 1297

Create Remote Upgrade Tasks
Create a Task for remotely upgrading the software on selected engines.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.
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2) Right-click Tasks, then select New > Remote Upgrade Task.

3) Give the Task a descriptive Name and optionally a free-form Comment.

4) Select the upgrade Operation:
• Remote Upgrade (transfer + activate) — Loads the new configuration and reboots the node.
• Remote Upgrade (transfer) — Loads the new configuration without rebooting the node.
• Remote Upgrade (activate) — Reboots the node to activate a previously loaded configuration.

CAUTION:  Do not activate the new configuration simultaneously on all nodes of a cluster.
If you want to schedule a Remote Upgrade Task for several nodes, create two separate
Remote Upgrade Tasks: one to transfer the new configuration and another to activate it.
Schedule the Activate Task to run only after the Transfer Task is complete.

5) Select the engines that you want to upgrade from the list on the left, then click Add.
The selected engines are added to the list on the right.

6) Select the correct previously imported Engine Upgrade file for the upgrade.

7) Click OK.
The new Remote Upgrade Task is added to the list of Task Definitions.

Related tasks
Schedule Tasks on page 1300

Create sgInfo Tasks
Create a sgInfo Task to collect information about your system for Forcepoint support.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Right-click Tasks, then select New > sgInfo Task.

3) Give the Task a descriptive Name and optionally a free-form Comment.

4) Select the engines whose configuration files and system trace files you want to get from the list on the left,
then click Add.
The selected engines are added to the list on the right.

5) If instructed to do so by Forcepoint support, select Include core files to include the core files for
troubleshooting.

https://support.forcepoint.com
https://support.forcepoint.com
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6) Click OK.
The new sgInfo Task is added to the list of Task Definitions.

Schedule Tasks
After creating Task Definition elements, you can schedule tasks to run at a convenient time.

If necessary, you can also schedule system tasks.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Tasks > Definition.
A list of defined tasks opens.

3) Right-click the task, then select Schedule.

4) Set the schedule properties.

Tip:  The date and time can be entered manually in the format YYYY-MM-DD HH:MM:SS.
You can also right-click the Up or Down arrows next to the date field to select a date from the
calendar.

5) From the Final Action drop-down list, select the action when the task finishes running.

6) Click OK.
The Task schedule is added under the Task Definition.

Related concepts
Creating Task Definitions on page 1294

Related tasks
Start Tasks manually on page 1301
Pause the scheduled execution of Tasks on page 1301
Remove Tasks from schedules on page 1302

Related reference
Task types on page 1293
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Start Tasks manually
To run a Task immediately, start it from the Task Definitions list.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Tasks > Definition.
A list of Task Definitions opens.

3) Right-click the Task you want to start, then select Start.
The Task starts.

4) (Optional) Click the History branch to view the progress of the Task.
To view the Task, verify that Tools > Show Executed Tasks Show is enabled in the History branch.

Related tasks
Schedule Tasks on page 1300
Stop running Tasks on page 1302

Related reference
Task types on page 1293

Pause the scheduled execution of Tasks
If you want to temporarily stop a Scheduled Task from running at the scheduled time, you can suspend the
Scheduled Task.

When a Scheduled Task is suspended, the schedule remains under the Task Definition, but the Task does not
run at the scheduled time.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Tasks > Definition.
The Task Definitions list opens.

3) Expand the Task Definition you want to suspend.
The schedule information for the Task is displayed below the Task Definition.
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4) Right-click the schedule information, then select Suspend.
The Task is suspended.

5) To restart a suspended Task, right-click the schedule information, then select Continue.
The Task resumes and runs at the next scheduled time.

Remove Tasks from schedules
You can remove Tasks from the schedule by moving the schedule information (Task Schedule) from the Task
Definition to the Trash.

Moving the schedule information to the Trash does not delete the Task Definition: the same Task can be
scheduled again.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Tasks > Definition.
The Task Definitions list opens.

3) Expand the Task you want to remove from the schedule.
The schedule information for the Task is displayed below the Task Definition.

4) Right-click the schedule information, then select Delete.
The schedules of default System Tasks cannot be deleted.
A confirmation dialog box opens.

5) To confirm that you want to move the selected Task Schedule to the Trash, click Yes.
The Task Schedule is removed from the Scheduled Tasks list.

Stop running Tasks
Abort a Task that is no longer needed.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Tasks > History.
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3) Right-click the Task you want to abort, then select Abort.
A confirmation dialog box opens.

4) To stop the running Task, click Yes.
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Managing licenses
Contents

• Getting Started with licenses on page 1305
• Generate licenses on page 1308
• Upgrading licenses manually on page 1309

All SMC components must be licensed as a proof of purchase. In addition, some additional features can be activated
by installing a feature license.

Getting Started with licenses
Licenses prove that your organization has legally purchased the SMC components you configure. You can
upgrade them to new supported versions as part of each component’s support and maintenance contract.

Licenses are issued when you purchase a product. They are generated at
https://stonesoftlicenses.forcepoint.com and installed in the SMC as files. Licenses are shown as elements in the
Administration Configuration view.

Related concepts
Getting started with automatic updates and upgrades on page 1257

When do I have to generate new licenses?
Generally, you must generate and install a license for each engine and each SMC server to start using the
component. However, there are some exceptions.

• All Management Servers in the same SMC share a single license. A high availability environment has multiple
Management Servers.

• All currently available Forcepoint NGFW appliance models can fetch a license automatically through the
Management Server if automatic updates are enabled. If automatic licensing fails, the appliances have a 30-
day temporary initial license to allow time for manual licensing.

• Forcepoint NGFW Engines deployed in the AWS cloud with the Bring Your Own License image must have a
license in the SMC. Forcepoint NGFW Engines deployed in the AWS cloud with the Hourly (pay as you go)
license image do not require a separate license in the SMC.

• Some optional features are activated by purchasing and installing a feature-specific license.

https://stonesoftlicenses.forcepoint.com
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When do I have to upgrade licenses?
Components do not run without a valid license. Always make sure that you have an updated license before you
make any change that is not supported by the current license.

Licenses must be updated for new software versions and if the binding detail in the license changes:

• Software upgrades — No action is required if automatic license upgrades have been enabled on the
Management Server. In an environment with multiple Management Servers, no action is required if the
automatic license upgrade feature has been enabled on the active Management Server that controls the
Shared Domain. Otherwise, upgrade the licenses manually. License upgrades are available shortly before a
new version is released.

• Changes in license binding — Change licenses manually if:
• You change a control IP address used for license binding in a static IP-address-bound license.
• You move a dynamic Management Server POL-bound license to a different Management Server.

If you have IP-address-bound licenses for engine components, you must switch the license to a Management
Server POL-bound license if you change the engine’s control IP address.

Each license indicates the maximum version for which the license is valid, but the license is also valid for all
previous software versions. You must update the license if you upgrade a component to a new major release
indicated by a change in the first two digits of the version number (for example, an upgrade from 1.2.3 to 1.3.0
or an upgrade from 1.2.3 to 2.0.0). If only the last number changes, the existing license is valid also for the later
software version.

Appliance licenses do not allow upgrading an appliance beyond the last supported software version on which the
appliance can run. See Knowledge Base article 9743 to check which appliance models have a last supported
software version. With third-party hardware, be careful not to upgrade the software to a version that exceeds the
hardware’s capabilities.

What do the different license types mean?
Licenses can be bound to a component in three different ways. The possible binding methods depend on the
licensed component and the software version.

Table 151: License binding methods

License binding Description

IP address binding The license is statically bound to the IP address of the licensed component.

Note:  Only licenses for SMC servers can be bound to an IP address.
Existing IP-address-bound licenses for other components continue to
work and can be upgraded. Any new licenses for other components
must be bound to the Management Server’s proof-of-license (POL)
code.

Management Server
proof-of-license (POL)
code binding

Licenses are dynamically bound to the Management Server’s proof-of-license
(POL) code. You must manually bind Management Server POL-bound licenses to
the correct element. Licenses are valid only for components that are managed by
the Management Server that has the same POL code.

https://support.forcepoint.com/KBArticle?id=Next-Generation-Firewall-appliance-software-support-table
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License binding Description

Appliance proof-of-serial
(POS) code binding

The license is bound to the unique POS code of a pre-installed Forcepoint NGFW
appliance. The appliance identifies itself when contacting the Management
Server. The Management Server allows the use of the appliance if the license
POS code matches the reported code. The Management Server automatically
binds the correct license to the engine element based on the POS code. For the
Management Server and pre-installed appliances, the Management Server can use
this licensing method automatically with new appliances.

The license types that are available depend on the SMC component.

Table 152: Possible license types for SMC components

License binding Description

Management Servers Always a static IP-address-bound license.

Log Servers

Web Portal Servers

A static IP-address-bound license or a dynamic license bound to the Management
Server’s POL code

Pre-installed Forcepoint
NGFW appliances

A license bound to the POS code of the appliance (all current models) or a dynamic
license bound to the Management Server’s POL code (older models)

Engines installed on your
own hardware

Always a dynamic license bound to the Management Server’s POL code

Engines installed on a
virtualization platform

Always a dynamic license bound to the Management Server’s POL code

Feature-specific licenses A dynamic license bound to the Management Server’s POL code or a license
bound to the POS code of the appliance depending on the feature

Management Server license limits
Some Management Server licenses impose a restriction on the number of managed or monitored elements.

If your Management Server license allows an unlimited number of managed components, this restriction does not
apply to you. To check this information, see the properties of the Management Server’s License.

Each engine is counted as one managed unit in the limitation, with some exceptions:

• Any number of clustered engines counts as a single managed unit, regardless of the number of engines in the
cluster. (One cluster equals one managed unit.)

• Third-party components that are monitored through the SMC count as one-fifth of a unit. (Five components
equal one managed unit.)

• Virtual NGFW Engines are not counted against the license limit.

You cannot combine licenses in the SMC. For example, two Management Server licenses that each contain
a restriction for five managed components only allow you to manage five components even if you bind both
licenses to a single Management Server.

Check the appliance data sheets at https://www.forcepoint.com/resources/datasheets/next-generation-firewall to
see the Management Count for your appliance.

https://www.forcepoint.com/resources/datasheets/next-generation-firewall
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Master NGFW Engine license limits
Master NGFW Engines use the same NGFW Engine licenses as other engines. The NGFW Engine licenses
enable the Virtual NGFW Engine features.

Virtual NGFW Engines do not require their own licenses. However, the NGFW Engine license limits the number
of Virtual Resources that can be created. The limit for the number of Virtual Resources limits how many Virtual
NGFW Engines can be created. You can optionally increase the allowed number of Virtual Resources by
purchasing and installing a feature-specific license.

Generate licenses
Generally, each SMC component must have a separate license. Some additional features might also require a
separate license.

Note:  Forcepoint NGFW Engines deployed in the AWS with Hourly (pay as you go) licenses do
not require a separate license in the SMC.

Licenses always indicate the newest software version that you are entitled to, but they are valid for licensing any
older software versions as well.

Note:  Your SMC might be able to automatically generate licenses for new Forcepoint NGFW
appliances. For automatic licensing to work, install a license for the SMC components and make
sure that automatic updates are enabled on the Management Server. The temporary initial license
is automatically replaced with a permanent POS-bound license after the policy is first installed on
the appliance.

Steps

1) Go to https://stonesoftlicenses.forcepoint.com.

2) In the License Identification field, enter the POL or POS code, as follows.
• Proof-of-license (POL) code — Identifies the license. For previously licensed components, the POL code

is shown in the Licenses tree in the Administration Configuration view.
• Proof-of-serial (POS) number — The Forcepoint NGFW appliances additionally have a proof-of-serial

number that you can find on a label attached to the appliance hardware.

3) Click Submit.

4) Check which components are listed as included in this license, then click Register.

5) Read the instructions on the page, then fill in the required fields for all included components.

6) Enter the details that bind each license to a component, as follows:
• Management Server(s) — Enter the IP address you plan to use on the server. If your license allows

several Management Servers in the same SMC (for high availability), enter a comma-separated list of the
IP addresses of all Management Servers.

• Other SMC servers — Enter the Management Server’s POL code or the IP address you plan to use on
the server.

https://stonesoftlicenses.forcepoint.com
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• Master NGFW Engines — Enter the POS code of a Forcepoint NGFW appliance (see the label attached
to the appliance).

• NGFW Engines — For Forcepoint NGFW appliances, enter the POS code of the appliance (see the
label attached to the appliance). For Forcepoint NGFW software installed on your own hardware or on a
virtualization platform, enter the POL code of the Management Server that you use to manage the engine.

Note:  POS binding is always recommended when the option is available.

Note:  If the binding information is incorrect, the license is unusable. If you accidentally
generated a license with the wrong binding information, request a license change through the
License Center.

7) Click Submit Request.
The license file is sent to you and is also available for download at the License Center.

Upgrading licenses manually
Licenses are valid for any older software versions in addition to the version indicated on the license. You can
upgrade the licenses at any time without affecting the system’s operation.

Note:  IP-address-bound licenses have been previously available for Firewalls and IPS engines.
You can use and update a previously generated IP-address-bound engine license, but you
must switch the license binding to the Management Server’s POL code if the engine’s control IP
address changes.

You can view, change, and download your current licenses at https://stonesoftlicenses.forcepoint.com by logging
on with your personal account (to view all licenses linked to that account) or by entering a proof-of-license (POL)
or proof-of-serial (POS) code (to view information related to a particular license).

If automatic license upgrades have been enabled in the Management Server properties, your licenses are kept
up to date automatically. Otherwise, you can upgrade licenses manually in the following ways:
• When you log on to the online License Center, you can upgrade the license for the displayed components

through the link provided. Save the license as a file that you can install in the SMC.
• You can export information about licenses through the Management Client and use the resulting text file to

upgrade the licenses.

Related tasks
Upgrade licenses manually on page 1309

Upgrade licenses manually
If you have not enabled automatic license upgrades in the Management Server properties, upgrade licenses
manually through the Management Client.

Licenses are valid for any older software versions in addition to the version indicated on the license. You can
upgrade the licenses at any time without affecting the system’s operation.

https://stonesoftlicenses.forcepoint.com
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Note:  IP-address-bound licenses have been previously available for Firewalls and IPS engines.
You can use and update a previously generated IP-address-bound engine license, but you must
change the license binding to the Management Server’s POL code if the engine’s control IP
address changes.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Licenses, then browse to the type of licenses that you want to upgrade.

3) Select the license that you want to upgrade.
Details about the selected license open in the Info pane.

4) In the Info pane, copy the license information to the clipboard in one of the following ways:
• From the Proof of License field, copy the POL code.
• From the Proof of Serial field, copy the POS code.

5) Go to https://stonesoftlicenses.forcepoint.com.

6) In the License Identification field, paste the POL or POS code, then click Submit.

7) Under the license information, click Update.

8) Enter any information needed for the upgrade request, then select the license files to update.

9) To send the license request, click Submit.
A confirmation page opens, showing the details of your request. The licenses are available for download on
the license page.

Changing license binding details
License binding details must be updated manually for licenses that are bound to IP addresses or POL codes.

Licenses that are bound to an IP address must be changed if the IP address of the component changes.
Licenses that are bound to the POL code of the Management Server must be changed if:

• you want to transfer the licenses to a different Management Server.
• if you replace the Management Server’s license with a license that has a different POL code.

Note:  Only licenses for SMC servers can be bound to an IP address. If you have IP-address-
bound licenses for engine components, you must switch to a Management Server POL-bound
license if you change the engine’s control IP address.

Forcepoint NGFW appliances use POS-based licenses. The licenses are bound to the serial number of the
appliance hardware and are automatically bound to the correct element.

You must change IP address binding and POL-based binding manually. To view, change, and download your
current licenses at https://stonesoftlicenses.forcepoint.com, log on with your personal account (for all licenses

https://stonesoftlicenses.forcepoint.com
https://stonesoftlicenses.forcepoint.com
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that your account is authorized to view). Alternatively, you can enter a POL or POS code (to view information
related to a particular license).

Note:  If automatic license updates have been enabled in the Management Server properties,
changed licenses are automatically downloaded and bound to the correct element as long as the
license’s identification code remains the same.

Install licenses for unlicensed components
All components must have a valid license. You must install licenses for any unlicensed components.

If you have configured Domains, licenses can be viewed only in the Shared Domain. When the license is bound
to an element (automatically or manually), the license is shown only in the Shared Domain, regardless of the
Domain to which the element belongs. Licenses that are not allocated to any Domain can be manually allocated
to a particular Domain through their right-click menu.

CAUTION:  If you use Management Server POL code-based licenses for Forcepoint NGFW
appliances, verify that the licenses are bound to the correct engine elements. Remember to
change the license if you change the appliance hardware.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Menu > System Tools > Install Licenses.

2) Select one or more license files, then click Install.
The licenses are installed. Most types of licenses are also automatically bound to the correct components.

3) Select  Configuration, then browse to Administration.

4) Expand the Licenses branch, then browse to the types of licenses you installed.

5) If you installed a dynamic engine license (bound to the Management Server’s POL code), right-click the
newly installed license, then select Bind to select the correct engine.
If the license is bound to an incorrect element, right-click the license, then select Unbind.

CAUTION:  The license is permanently bound to the engine and cannot be bound to another
engine after you install or refresh the policy on the engine. Permanently bound licenses
cannot be rebound unless you relicense or delete the engine element that the license is
bound to. When unbound, a permanently bound license is shown as Retained.

6) Check that components are now licensed as intended.

• The list of Unlicensed Components might show engines that have a license bound to the POS code of an
appliance. The reason for this is that POS-bound licenses are bound to the correct engines automatically
when the engine is installed and makes initial contact with the Management Server. The engine is moved
to the correct type of Licenses branch after initial contact with the Management Server.

• Engine licenses are applied when you upload or refresh the policy on the engines.
• If any engines are not correctly licensed, you might need to upgrade or generate the licenses again.
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Related tasks
Check validity and status of licenses on page 1314
Check that all components are licensed on page 1313

Replace licenses of previously licensed
components
All components must have a valid license. You must replace any invalid or missing licenses with new ones.

If you have configured administrative Domains, licenses can be viewed only in the Shared Domain. When the
license is bound to an element (automatically or manually), the license is shown only in the Shared Domain,
regardless of the Domain to which the element belongs. Licenses that are not allocated to any Domain can be
manually allocated to a particular Domain through their right-click menu.

CAUTION:  If you use Management Server POL code-based licenses for Forcepoint NGFW
appliances, verify that the licenses are bound to the correct engine elements. Remember to
change the license if you change the appliance hardware.

Invalid or missing licenses can prevent components from working. If you are manually replacing working licenses
with new ones, we recommend that you take a backup of the Management Server before you make changes.
Then you can easily roll back the changes, if needed.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select  Menu > System Tools > Install Licenses.

3) Select one or more license files, then click Install.

• If the licenses only upgrade the software version in a previously installed license (the license identifier
does not change), the previous license is replaced with the new one automatically. No further action is
needed.

• An IP-address-bound license is automatically bound to the component with the correct IP address.
• A POS-bound license is automatically bound to the appliance with the correct POS code.

Note:  If you bind an IP-address-bound license or a POS-bound license to a component that
already has a Management Server POL-bound license, the component has two licenses.
Replace the Management Server POL-bound license as instructed in the next step.

The licenses are installed.

4) To replace a Management Server POL-bound license with an IP-address-bound license or a POS-bound
license, follow these steps.

a) Expand the Licenses branch, then browse to the correct type of license.
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b) Right-click the Management Server POL-bound license that is bound to the element, then select
Replace by Static License.

c) Select the license to bind to the engine.

5) To replace a Management Server POL-bound license that is not bound to the Management Server with a
Management Server POL-bound license that is bound to the Management Server, follow these steps.

a) Expand the Licenses branch, then browse to the correct type of license.

b) If there is a previous Management Server POL-bound license bound to the element, right-click the old
license, then select Unbind.

c) Right-click the new license, then select Bind.

d) Select the engine to bind to the license.

6) Check the displayed license information and verify that all components you meant to license have the correct
new license.

7) Right-click any old licenses that might still be displayed, then select Delete.

8) Refresh or install the policy to transfer the license changes to the engine.

CAUTION:  After you install or refresh the policy on the engine, the license is permanently
bound to the engine and cannot be bound to any other engine. Permanently bound licenses
cannot be rebound unless you relicense or delete the engine element that the license is
currently bound to. When unbound, a permanently bound license is shown as Retained.

Related tasks
Back up system configurations on page 1263
Check validity and status of licenses on page 1314

Check that all components are licensed
Each SMC Server, NGFW Engine, and Master NGFW Engine must have its own license. There is no difference
between licenses for nodes in a cluster and licenses for single engines.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Licenses > Unlicensed Components > All.
This view displays all elements that require a license, but do not currently have a valid license.

3) If any components are shown as unlicensed, check the following:
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• Engine licenses generated based on a Forcepoint NGFW appliance POS code are bound when the
engine makes initial contact with the Management Server. It is normal to see the corresponding elements
as unlicensed until initial contact is made.

• If you have already generated and installed licenses, check that the binding details are correct (POS
code, POL code, or IP address).

4) If needed, generate and install new licenses for the components listed.

Related tasks
Generate licenses on page 1308

Check validity and status of licenses
You can check license validity and binding information in the Management Client.

The view displays each license and the component it is bound to, with the newest software version that the
license allows you to install. Licenses are valid for all minor releases within the displayed major version (for
example, a 5.1 license allows installing 5.1.0, 5.1.1, and 5.1.2) and for any previous software version.

It is not possible to create new IP-address-bound licenses for engine components. Previously created IP-
address-bound engine licenses can be upgraded to new versions. However, if a license is changed in any other
way, the binding must also be changed.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Select Licenses > All Licenses.

Related tasks
Troubleshoot licenses that are shown as retained on page 1367
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Upgrading the SMC
Contents

• Getting started with upgrading the SMC on page 1315
• Upgrading the SMC configuration overview on page 1316
• Obtain SMC installation files on page 1317
• Upgrade SMC servers on page 1318
• Default SMC installation directories on page 1319

You can upgrade the Management Servers, Management Clients, Log Servers, and Web Portal Servers in your SMC.

Getting started with upgrading the SMC
Upgrading the SMC updates the system software version, activates the newest dynamic update package, and
can include changes to elements. Backing up the system before an upgrade is recommended.

What SMC upgrades do
In addition to updating the SMC software, the upgrade makes other changes in your SMC:
• New system elements and policies can be added and obsolete system elements can be removed. Elements

that are used are not deleted, but instead converted from system elements to regular elements when they
have no default role anymore.

• Any element can be updated with new types of options (related to new or changed features), and occasionally
obsolete options can be removed or changed.

• A new dynamic update package is activated, unless you have already installed the same or a newer update
package before the installation. The previous installation can be the cause of some, but not necessarily all, of
the preceding changes listed.

• The Management Client’s online Help can be updated with new or corrected information.

A summary of changes to elements is created during each upgrade; a link to these HTML reports is displayed
when the Management Server upgrade is finished.

Limitations
All SMC components (Management Server, Management Client, Log Server, and the optional Web Portal Server)
must have the same software version. All other components try to connect to the Management Server when they
start. They do not start if their software version does not match with the Management Server software version. If
you have multiple Management Servers or Log Servers, you must upgrade each server separately so that they
have the same software version.
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What do I need to know before I begin?
Although the need to do so is unlikely, the upgrade can be easily reversed if you take the correct precautions.
If the SMC upgrade fails, you can automatically revert to the previous installation if you select the option in the
installer before the upgrade starts. In any case, we recommend that you take a backup of the Management
Server using the SMC’s internal backup tool before you upgrade.

The backup contains all necessary information to restore the configurations (including the engine configurations).
The backup does not contain software version or operating system specific information. It can always be restored
from an older version of the SMC to a newer version of the SMC if a direct upgrade is supported between the
software versions involved.

The SMC is offline during the upgrade. The engines continue to operate normally and store their generated
log data in their local spool while the Management Servers and Log Servers are offline. Once connectivity is
restored, the spooled log data is transferred from the engines to the Log Servers.

To check which version of the SMC you are currently using, select  Menu > Help > About in the Management
Client. Also, the Management Client’s version is displayed in the Management Client’s logon dialog box.

Related tasks
Back up system configurations on page 1263

Upgrading the SMC configuration
overview

All SMC components must be upgraded at the same time. Before upgrading, make sure that SMC licenses are
up to date.

Follow these general steps to upgrade the SMC:

1) Prepare the installation files.

2) (If automatic license updates have been disabled) Update the licenses.

3) Upgrade all components that work as parts of the same SMC.

4) (Multiple Management Servers only) Synchronize the management database between the Management
Servers.

5) If you distribute Web Start Management Clients from some external server (instead of the Management
Server), update the Web Start distribution.

Related concepts
Upgrading licenses manually on page 1309
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Related tasks
Distribute Web Start from external servers on page 423
Synchronize databases between active Management Server and additional Management Servers on page 447
Obtain SMC installation files on page 1317
Upgrade SMC servers on page 1318

Obtain SMC installation files
Before running the installer, you must download the correct installation file from the download page and make
sure that the checksums are correct.

You can check the installation file integrity using the file checksums. The checksums are on the installation DVD
and in the release notes.

Windows does not have checksum programs by default, but there are several third-party programs available.

We provide only recent versions of the software for download. We recommend that you store the upgrade files
yourself to make sure you can install the exact same version later (for example, if there is a hardware failure).
This is recommended especially if your organization’s policies mandate lengthy testing periods that limit the
speed of adopting new versions.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Download the installation file from https://support.forcepoint.com/Downloads.
Separate .zip packages are available for downloading installation files for all supported platforms or just one
supported platform.

2) Change to the directory that contains the files to be checked.

3) Generate a checksum of the file using one of the following commands, where filename is the name of the
installation file:
• sha1sum filename

• sha256sum filename

• sha512sum filename

Example:

sha1sum smc_1.0.1.1000.zip

79785edab5d2a1191a3065510756f72883952455 smc_1.0.1.1000.zip

4) Compare the displayed output to the checksum on the website.

CAUTION:  Do not use files that have invalid checksums. If downloading the files again does
not help, contact Forcepoint support to resolve the issue.

5) Unzip all folders and files in the archive to the server you want to upgrade.

https://support.forcepoint.com/Downloads
https://support.forcepoint.com
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Upgrade SMC servers
You can upgrade SMC servers without uninstalling the previous version. A change in the Management platform,
such as a new operating system or different hardware, requires reinstalling the SMC.

CAUTION:  All SMC components (Management Server, Management Client, Log Server, and the
optional Web Portal Server) must use the same SMC software version to work together. If you
have multiple Management Servers or Log Servers, you must upgrade each server separately.

The same installer works with all SMC components, including locally installed Management Clients.

If you have multiple Management Servers or Log Servers, you can upgrade them in any order. Management
Servers are automatically isolated from database replication during the upgrade. There is no need to explicitly
isolate the Management Servers before upgrading.

If you are upgrading from a very old version of the SMC, you might have to upgrade to an intermediate version
first before upgrading to the latest version. See the Release Notes.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Start the installation in one of the following ways:
• From a .zip file — Unzip the file, then run setup.exe on Windows or setup.sh on Linux.
• From a DVD — Insert the installation DVD, then run the setup executable from the DVD.

Operating system Path to executable

Windows 64-bit \Forcepoint_SMC_Installer\Windows-x64\setup.exe

Linux 32-bit /Forcepoint_SMC_Installer/Linux/setup.sh

Linux 64-bit /Forcepoint_SMC_Installer/Linux-x64/setup.sh

Note:  If the DVD is not automatically mounted in Linux, mount the DVD with “mount /dev/
cdrom /mnt/cdrom”.

2) To continue with the installation, read and accept the License Agreement.
The Installation Wizard automatically detects the previous installation directory.

3) To accept the installation directory, click Next.
The Installation Wizard displays the components to be upgraded.

4) (Management Server only, optional) To save a copy of the current installation that you can revert to at any
time after the upgrade, select Save Current Installation.

5) Click Next.

6) (Management Server only) Select whether to back up the server, then click Next:
• To create a backup that can be used and viewed without a password, select Yes.
• To create a password-protected backup, select Yes, encrypt the backup. You are prompted for the

password as you confirm the selection.

https://support.forcepoint.com/Documentation
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• If you already have a recent backup of the Management Server, select No.

7) Check the preinstallation summary, then click Install.
The upgrade begins.

8) (Optional) When the upgrade is complete, click the links in the notification to view the reports of changes
the installer has made.
The report opens in your web browser.

9) To close the installer, click Done.

10) Upgrade any SMC components that run on other computers (for example, additional Management Servers
or Log Servers) in the same way.

11) (Multiple Management Servers only) Synchronize the management database between the Management
Servers.

Related tasks
Change the Management Server or Log Server platform on page 457
Synchronize databases between active Management Server and additional Management Servers on page 447

Default SMC installation directories
The location of the SMC installation directory depends on the operating system.

Default SMC installation directories:
• Default installation directory on Windows — C:\Program Files\Forcepoint\SMC

Note:  If you installed the Management Server in the C:\Program Files\Forcepoint\SMC
directory in Windows, some program data might be stored in the C:\ProgramData\Forcepoint
\SMC directory.

• Default installation directory on Linux — /usr/local/forcepoint/smc

Under the installation directory, note especially the following folders:
• /backups/ — Stores Management Server (sgm_) and Log Server (sgl_) backups. The backups must be in this

directory to be listed in the Management Client and when running scripts without specifying a backup file.
• /bin/ — Contains the SMC command-line tools as well as some additional scripts that are used by the

Installation Wizard.

Related reference
Security Management Center commands on page 1409
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Upgrading the engines
Contents

• Getting started with upgrading NGFW Engines on page 1321
• Upgrading the engines configuration overview on page 1322
• Obtain and import NGFW Engine upgrade files on page 1323
• Upgrade engines remotely on page 1324

You can upgrade Firewalls, IPS engines, Layer 2 Firewalls, and Master NGFW Engines.

Getting started with upgrading NGFW
Engines

You can remotely upgrade engines using the Management Client or locally on the engine command line.

Remote upgrade is recommended in most cases. See the Forcepoint Next Generation Firewall Installation Guide
for detailed instructions if you want to upgrade engines locally.

How engine upgrades work
The upgrade package is imported to the Management Server manually or automatically. Before the import,
the Management Server verifies the digital signature of the upgrade package using a valid Trusted Update
Certificate. The signature must be valid for the import to succeed. Verification failure can result from an out-of-
date SMC version, in which case the SMC must be upgraded, or an invalid or missing signature, in which case
the administrator must obtain an official upgrade package.

After the upgrade package has been imported, you can apply it to selected engines through the Management
Client. Before the upgrade is installed on the engines, the Management Server verifies the digital signature of
the upgrade package. Also the engines verify the digital signature of the upgrade package before the upgrade is
installed. Upgrade package digests are calculated using an SHA-512 hash and signed with an ECDSA key.

The engines have two alternative partitions for the software. When you install a new software version, it is
installed on the inactive partition and the current version is preserved. This allows rollback to the previous version
in case the installation is interrupted or other problems arise. If the engine is not able to return to operation after
the upgrade, it automatically switches back to the previous software version at the next restart. You can also
switch the active partition manually.

You can upload and activate the new software separately. For example, you can upload the upgrade during office
hours but activate it during a service window.

The currently installed working configuration (routing, policies) is stored separately and is not changed in
an upgrade or a rollback. Although parts of the configuration can be version-specific (for example, if system
communications ports are changed), the new software version can use the existing configuration. Possible
version-specific adjustments are made when you refresh the policy after the upgrade.
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Limitations
It is not possible to upgrade between a 32-bit version and a 64-bit version of the software. If you are running the
software on third-party hardware, you can reinstall the software using the other version. In clusters, 32-bit and 64-
bit nodes cannot be online simultaneously. Appliances support only the software architecture version that they
are pre-installed with.

You cannot upgrade Virtual NGFW Engines directly. To upgrade Virtual NGFW Engines, you must upgrade the
Master NGFW Engine that hosts the Virtual NGFW Engines.

What do I need to know before I begin?
The SMC must be up to date before you upgrade the engines. An old SMC version might not be able to
recognize the new version engines and can generate an invalid configuration for them. The Management
Server can control several older versions of engines. See the Release Notes for version-specific compatibility
information.

During a cluster upgrade, it is possible to have the upgraded nodes online and operational side by side with
the older version nodes. This way, you can upgrade the nodes one by one while the other nodes handle the
traffic. However, you must upgrade all nodes to the same version as soon as possible, as prolonged use with
mismatched versions is not supported.

The current engine version is displayed on the General tab in the Info pane when you select the engine. If the
Info pane is not shown, select  Menu > View > Info.

Related concepts
Configure anti-malware on engines on page 678

Upgrading the engines configuration
overview

You can upgrade engines remotely using the Management Client.

Follow these general steps to upgrade engines:

1) (Manual download of engine upgrade files) Prepare the installation files.

2) (Manual license updates) Update the licenses.

3) Upgrade the engines.

Related concepts
Upgrading licenses manually on page 1309

Related tasks
Manually update the anti-malware database on engines on page 679
Upgrade engines remotely on page 1324

https://support.forcepoint.com/Documentation
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Obtain and import NGFW Engine
upgrade files

If the Management Server is not set up to download engine upgrades automatically, download the installation
files manually.

You must also check the installation file integrity using the file checksums. Windows does not have checksum
programs by default, but there are several third-party programs available.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Go to https://support.forcepoint.com.

2) Enter your license code or log on using an existing user account.

3) Select Downloads.

4) Under Network Security, click the version of the Forcepoint NGFW software that you want to download,
then download the .zip file installation file.

5) On your local computer, change to the directory that contains the files to be checked.

6) (Linux only) Generate a checksum of the file using one of the following commands, where filename is the
name of the installation file:
• sha1sum filename

• sha256sum filename

• sha512sum filename

For Windows, see the documentation for the third-party checksum program.
Example:

$ sha1sum sg_engine_1.0.0.1000.iso
869aecd7dc39321aa2e0cfaf7fafdb8f sg_engine_1.0.0.1000.iso

7) Compare the displayed output to the checksum on the website.

CAUTION:  Do not use files that have invalid checksums. If downloading the files again does
not help, contact Forcepoint support to resolve the issue.

8) Log on to the Management Client, then select  Menu > File > Import > Import Engine Upgrades.

9) Select the engine upgrade (sg_engine_version_platform.zip file), then click Import.
The import takes a while. You can see the related messages in the status bar at the bottom of the
Management Client window.

Note:  The Management Server verifies the digital signature of the .zip file before importing
it. The signature must be valid for the import to succeed. If the verification fails, an error
message is shown. Verification failure can result from an out-of-date SMC version or an
invalid or missing signature.

https://support.forcepoint.com
https://support.forcepoint.com
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Related concepts
Getting started with automatic updates and upgrades on page 1257

Upgrade engines remotely
The Management Server can remotely upgrade engine components that it manages.

Before you begin
Read the Release Notes for the new version, especially the required SMC version and any
other version-specific upgrade issues that might be listed. To access the release notes, select 
Configuration, then browse to Administration > Other Elements > Engine Upgrades. Select
the type of engine you are upgrading. A link to the release notes is included in the upgrade file’s
information. If the Management Server has no Internet connectivity, you can find the release notes at
https://support.forcepoint.com/Documentation.

CAUTION:  If McAfee Endpoint Intelligence Agent (McAfee EIA) is configured on the
NGFW Engine when you upgrade to version 6.3 or later, the NGFW Engine node is
returned to the initial configuration state and stops processing traffic. You must remove
the McAfee Endpoint Intelligence Agent (McAfee EIA) configuration and refresh the
policy before you upgrade to version 6.3 or later. For more information, see Knowledge
Base article 14093.

You can upgrade several engines of the same type in the same operation. However, we recommend that you
upgrade clusters one node at a time and wait until an upgraded node is back online before you upgrade the other
nodes. Clusters operate normally throughout the upgrade when the upgrade is done in stages. However, it is
recommended to upgrade all nodes in the cluster to the same version as soon as possible. Prolonged use with
mismatched versions is not supported. It is not possible to have 32-bit and 64-bit engines online in the cluster at
the same time.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Home.

2) Browse to Engines, then expand the nodes of the engine that you want to upgrade.

3) Right-click the node you want to upgrade, then select Commands > Go Offline.

4) (Optional) Enter an Audit Comment to be shown in the audit log entry that is generated when you send the
command to the engine.

5) Click Yes.
The engine is turned offline shortly.

https://support.forcepoint.com/Documentation
https://support.forcepoint.com/Documentation
https://support.forcepoint.com/KBArticle?id=000014093
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6) Right-click the node you want to upgrade, then select Upgrade Software or Configuration > Upgrade
Software depending on your selection.

Note:  You cannot upgrade Virtual NGFW Engines directly. To upgrade Virtual NGFW
Engines, you must upgrade the Master NGFW Engine that hosts the Virtual NGFW Engines.

7) Select the type of Operation you want to perform:
• Select Remote Upgrade (transfer + activate) to install the new software and reboot the node with the

new version of the software.
• Select Remote Upgrade (transfer) to install the new software on the node without an immediate reboot

and activation. The node continues to operate with the currently installed version until you choose to
activate the new version.

• Select Remote Upgrade (activate) to reboot the node and activate the new version of the software that
was installed earlier.

CAUTION:  To avoid an outage, do not activate the new configuration simultaneously on all
nodes of a cluster. Activate the new configuration one node at a time, and proceed to the next
node only after the previous node is back online.

8) If necessary, add or remove Target engines.
All engines in the same Upgrade Task must be of the same type.

9) Select the correct Engine Upgrade file, then click OK.
If you choose to activate the new configuration, you are prompted to acknowledge a warning that the node
will be rebooted. A new tab opens showing the progress of the upgrade. The time the upgrade takes varies
depending on the performance of your system and the network environment. The engine is automatically
rebooted and brought back online.

The upgrade overwrites the inactive partition and then switches the active partition. To undo the upgrade,
use the sg-toggle-active command or the engine’s boot menu to switch back to the previous software
version on the other partition. This switch can also happen automatically at the next reboot if the engine is
not able to successfully return to operation when it boots up after the upgrade.

Note:  The Management Server verifies the digital signature of the upgrade package before
installing it. The signature must be valid for the upgrade to succeed. If the verification fails, an
error message is shown. Verification failure can result from an out-of-date SMC version or an
invalid or missing signature.

Related tasks
Access the engine command line on page 346
Create Remote Upgrade Tasks on page 1298

Related reference
Forcepoint NGFW Engine commands on page 1421
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Manual dynamic updates
Contents

• Getting started with manual dynamic updates on page 1327
• Dynamic update configuration overview on page 1328
• Import dynamic update packages on page 1328
• Activate dynamic update packages on page 1329

Dynamic Update packages include changes and additions to the system Policies, Situations, and other elements of the
SMC.

Getting started with manual dynamic
updates

It is important to keep the system policies and situations up to date so that newly discovered vulnerabilities can
be detected. Changes and additions are provided in dynamic update packages.

Dynamic updates are available at https://my.stonesoft.com/download.do.

Dynamic update packages are imported to the Management Server manually or automatically. Before the import,
the Management Server verifies the digital signature of the dynamic update package using a valid Trusted
Update Certificate. The signature must be valid for the import to succeed. Verification failure can result from an
out-of-date SMC version, in which case the SMC must be upgraded, or an invalid or missing signature, in which
case the administrator must obtain an official dynamic update package.

What dynamic updates do
Dynamic updates provide updates particularly to the deep inspection features on the NGFW Engines. For
example, new threat patterns and changes in the system Templates and Policies are introduced in dynamic
updates for up-to-date detection. They can also revise the default elements you use to configure the system.

Limitations
Some limitations apply to installing dynamic updates:
• You might need to upgrade first before you can use a certain dynamic update package. For more information

about the update packages, see the Release Notes.
• If there are several Domains defined in the SMC, manual dynamic updates can only be installed in the Shared

Domain.

https://my.stonesoft.com/download.do
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What do I need to know before I begin?
As an alternative to downloading the updates manually as explained here, you can configure the dynamic
updates to be downloaded and optionally activated automatically.

Malware database updates are always done automatically and directly by the engines. Updates are always active
when the anti-malware feature is active.

Related concepts
Getting started with automatic updates and upgrades on page 1257
Configure anti-malware on engines on page 678

Dynamic update configuration overview
Download and activate dynamic update packages using the Management Client.

Follow these general steps to import and activate dynamic updates:

1) Download the latest dynamic update package and import it in the Management Client.

2) Activate the dynamic update package in the Management Client.

Related tasks
Import dynamic update packages on page 1328
Activate dynamic update packages on page 1329

Import dynamic update packages
Download the latest dynamic update package and import it in the Management Client.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Go to https://my.stonesoft.com/download.do.

2) Click Forcepoint Dynamic Updates.

3) Download the latest dynamic update package .jar file.
For details about the dynamic update package, click Release Notes under the .jar file.

4) Save the update package file to a location accessible from the computer you use to run the Management
Client.

Note:  Make sure that the checksums for the original files and the files that you have
downloaded match.

https://my.stonesoft.com/download.do
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5) In the Management Client, select  Menu > File > Import > Import Update Packages.

6) Browse to the file, select it, then click Import.
The import takes some time, and the completion of the import is displayed in the status bar of the
Management Client window.

Note:  The Management Server verifies the digital signature of the dynamic update package
before importing it. The signature must be valid for the import to succeed. If the verification
fails, an error message is shown. Verification failure can result from an out-of-date SMC
version or an invalid or missing signature.

Activate dynamic update packages
To introduce the changes from an imported dynamic update package into your SMC, activate the dynamic update
package in the Management Client.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Expand the Other Elements tree, then select Updates.
A list of all imported and activated dynamic update packages opens.

3) Right-click the new dynamic update package, then select Activate.
The Management Server Backup dialog box opens.

4) Unless you have a fresh installation, click Yes.
After the backup is taken, the dynamic update package activation starts. The progress of the import and the
items included are shown on a new tab. The included items are shown so that you can view them after the
activation is complete.

Note:  The Management Server verifies the digital signature of the dynamic update package
before activating it. The signature must be valid for the activation to succeed. If the verification
fails, an error message is shown. Verification failure can result from an out-of-date SMC
version or an invalid or missing signature.

5) When the activation is finished, click Close.
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Managing SMC Appliance patches
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• Getting started with SMC Appliance patches on page 1331
• Manage SMC Appliance patches in the Management Client on page 1331
• Manage SMC Appliance patches on the command line on page 1333
• Roll back the SMC Appliance on page 1336

The SMC Appliance has a specific patching process that keeps the SMC and hardware current.

Getting started with SMC Appliance
patches

SMC Appliance patches can include improvements and enhancements to the SMC software, the operating
system, or the appliance hardware.

You can manage SMC Appliance patches remotely using the Management Client or locally on the SMC
Appliance command line. Patch digests are calculated using an SHA-512 hash and signed with an ECDSA key.

SMC Appliance patches apply to the SMC Appliance only. Management Servers installed on third-party platforms
do not offer a patching and rollback feature that combines SMC, the hardware, and the operating system.

Manage SMC Appliance patches in the
Management Client

The Management Client includes tools for downloading, importing, and activating SMC Appliance patches.

The details of each patch indicate whether the appliance must restart as part of the installation. You can use the
Management Client to install SMC Appliance patches regardless of whether the installation requires restarting the
SMC Appliance.

Patch digests are calculated using an SHA-512 hash and signed with an ECDSA key.

When you activate a patch, a configuration backup and a file system snapshot are automatically created for the
SMC Appliance. The backup and snapshot allow the SMC Appliance to revert to its previous configuration if
needed. If the patch activation fails, the appliance reverts to the snapshot automatically. Some patches, such as
upgrades of the SMC software, update the alternate partition. With these patches, you can toggle between the
partitions and restart the SMC Appliance to revert to the previous configuration.

Managing SMC Appliance patches in the Management Client consists of the following general steps:

1) Obtain SMC Appliance patches in one of the following ways:
• Download SMC Appliance patches.
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• Import SMC Appliance patches.

2) Activate SMC Appliance patches.

Download SMC Appliance patches
There is no automatic notification when new SMC Appliance patches are available. You must download SMC
Appliance patches manually.

We recommend checking for new SMC Appliance patches once a month.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to SMC Appliance Patches.

3) Right-click SMC Appliance Patches, then select Download SMC Appliance Patches.

Result

The SMC Appliance patches are automatically loaded and are ready to be activated.

Import SMC Appliance patches
In environments without Internet connectivity, you can download SMC Appliance patches, then import the SMC
Appliance patches into the SMC.

Before you begin
Download the SMC Appliance patch file from https://update.stonesoft.com/download/appliance/
patches/, then save the file in a location that is accessible from the Management Client.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to SMC Appliance Patches.

3) Right-click SMC Appliance Patches, then select Import SMC Appliance Patches.

4) Browse to the SMC Appliance patch file, then click Import.

https://update.stonesoft.com/download/appliance/patches/
https://update.stonesoft.com/download/appliance/patches/
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Result

The SMC Appliance patch is automatically loaded and is ready to be activated.

Activate SMC Appliance patches
To install the SMC Appliance patch on the SMC Appliance, load and activate the patch.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to SMC Appliance Patches.

3) Right-click the SMC Appliance patch file, then select Activate.

Result

The SMC Appliance patch is installed on the SMC Appliance. Installing some SMC Appliance patches might
restart the SMC Appliance.

Manage SMC Appliance patches on the
command line

You can manage SMC Appliance patches from the command line.

If you do not have physical access, use an SSH client to access the appliance remotely.

Note:  In FIPS mode, SSH access to the SMC Appliance command line is not supported.

The appliance maintenance and bug remediation (AMBR) patching utility allows you to load and install patches.
The SMC Appliance patch (SAP) format is specific to the appliance and can contain changes for SMC Appliance
OS, the hardware, or the SMC software. Patch digests are calculated using an SHA-512 hash and signed with an
ECDSA key.

The SAP numbering is appended to the version number; for example, 6.4.0P01, 6.4.0P02, or 6.4.0P03.

After verifying the available patches, you must load them to the appliance before they can be installed. When the
patch installation is initiated, the utility creates a configuration backup and a file system snapshot. The backup
and snapshot are created to allow the system to revert if needed. The details of the patch indicate whether the
appliance must restart as part of the installation.

If the patch installation fails, the appliance reverts to the snapshot automatically. Some patches, such as
upgrades of the SMC software, update the alternate partition. With these patches, you can toggle between the
partitions and restart.

You must have SMC Appliance Superuser permissions to log on to the SMC Appliance command line.
Administrators with unrestricted permissions (superusers) are allowed to log on to the SMC Appliance command
line only if there are no administrators with SMC Appliance Superuser permissions.
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Use sudo if you need elevated privileges. For a list of available sudo commands, enter sudo -l on the
command line.

In environments where the SMC Appliance does not have Internet connectivity, you must download patches from
https://support.forcepoint.com/Downloads, then transfer the files to the SMC Appliance.

All steps are done manually from the command line.

1) Check for available patches.

2) Load the patch.

3) Install the patch.

Related tasks
Configuring SSH access to the SMC Appliance on page 145
Add administrator accounts on page 359

Related reference
Security Management Center commands on page 1409

Check for available SMC Appliance patches on
the command line
Use the query command to see what patches are available for, loaded on, or installed on the SMC Appliance.

Steps

1) From the command line, log on to the appliance.

2) Run the query command.

sudo ambr-query

You can append various options to the command to customize the check.

3) Press Enter.

Load SMC Appliance patches on the command
line
Use the load command to add a patch to the SMC Appliance. These patches are not yet installed.

https://support.forcepoint.com/Downloads
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Steps

1) From the command line, log on to the appliance.

2) Run the load command.

sudo ambr-load <patch>

Note:  If you downloaded the patch and transferred it to the SMC Appliance, append the -
f option to the load command and specify the full path to the patch file. For example, sudo
ambr-load –f /var/tmp/6.3.0U001.sap.

3) Press Enter.

Result

The patch is now loaded to the appliance. You can run the ambr-query command to verify that it has loaded.

Install SMC Appliance patches on the
command line
Use the install command to install a patch on the SMC Appliance.

When a patch is installed, a configuration backup and a file system snapshot are created before applying the
patch.

Steps

1) From the command line, log on to the appliance.

2) Run the install command.

sudo ambr-install <patch>

3) Press Enter.

Result

The patch is now installed on the appliance.

Unload SMC Appliance patches on the
command line
Use the unload command to remove a patch that has been loaded but not installed on the SMC Appliance.

Note:  To uninstall a patch that has been installed, do a rollback of the appliance to the previous
state.
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Steps

1) From the command line, log on to the appliance.

2) Run the unload command.

sudo ambr-unload <patch>

3) Press Enter.

Result

The patch is now removed from the appliance. To verify that it has been removed, run the ambr-query command.

Roll back the SMC Appliance
After an upgrade, you can roll the SMC Appliance back to the previous version if needed.

Note:  During a rollback, configuration changes made after the last version are lost. We
recommend rolling back as a recovery option only for a short time after an upgrade.

Steps

1) From the command line, log on to the appliance.

2) Run the rollback command.

sudo smca-system toggle

3) Press Enter.

Result

The appliance restarts to the previous version.
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 PART XIII
Troubleshooting

Contents

• General troubleshooting tips on page 1339
• Troubleshooting accounts and passwords on page 1341
• Messages for troubleshooting on page 1345
• Troubleshooting certificates on page 1355
• Troubleshooting engine operation on page 1363
• Troubleshooting licenses on page 1367
• Troubleshooting logging on page 1371
• Troubleshooting the Management Client on page 1375
• Troubleshooting NAT on page 1383
• Troubleshooting policies on page 1387
• Troubleshooting reporting on page 1395
• Troubleshooting upgrades on page 1399
• Troubleshooting VPNs on page 1401

Troubleshooting helps you resolve common problems in the Forcepoint NGFW and SMC.
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General troubleshooting tips
Contents

• If your problem is not listed on page 1339
• Tools for further troubleshooting on page 1339

General troubleshooting tips help you troubleshoot situations that are not covered by more specific troubleshooting
topics.

If your problem is not listed
There are several possible causes and solutions for problems that are not listed in the troubleshooting topics.

When having problems with your system, first make sure that you have followed the relevant instructions.

Some problems you are having can be related to known issues, which you can view at:

https://support.forcepoint.com

If your organization is entitled to technical support, contact Forcepoint support.

Tools for further troubleshooting
Information in logs and alerts, and networking tools on engine can be useful for troubleshooting.

Logs and alerts provide useful information about what the components do and what is happening in your system.
You can increase the detail level of logs on certain areas of operation. To gain useful information from the logs
produced, you must be able to filter the logs efficiently.

There are Forcepoint NGFW-specific as well as standard networking tools available on the engines.

Related concepts
Benefits of filtering log entries on page 250
Considerations for working on the engine command line on page 345

Related tasks
Enable or disable diagnostics on engines on page 339

Related reference
Forcepoint NGFW Engine commands on page 1421

https://support.forcepoint.com
https://support.forcepoint.com
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Troubleshooting accounts and
passwords

Contents

• Replace forgotten passwords on page 1341
• Troubleshoot user accounts on page 1342
• Create an emergency administrator account on page 1342

There are several common problems and solutions related to accounts and passwords.

Replace forgotten passwords
There are several ways to replace forgotten passwords depending on the type of account.

Problem description: You or someone else in your organization forgets one of the passwords related to the
SMC.

Solution: You can regain access by changing the password. If none of the administrators can log on due to
account issues, you can create an emergency administrator account. An administrator who has unrestricted
permissions can change any password in the SMC. The password recovery procedures for the different
passwords are as follows:

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Change Management Client logon passwords in the Administrator elements. Administrator elements can be
found in the Administration branch of the Configuration view under Access Rights > Administrators.

2) Change Web Portal logon passwords in the Web Portal User elements. Web Portal elements can be found in
the Administration branch of the Configuration view under Access Rights > Web Portal Users.

3) Change the Engine Root account password (for command-line access) by right-clicking the individual engine
node and selecting Commands > Change Password.
If the engine is not connected to the Management Server (because, for example, it is a spare appliance), you
can reset all the engine’s settings. You can reset settings through a boot menu option in the local console
accessible through a serial connection or through a directly connected monitor and keyboard.

CAUTION:  Resetting the engine through the boot menu stops the engine from processing
traffic since all configurations are cleared.

4) Change user passwords used for end-user authentication in the User element. User elements are stored in
the User Authentication branch of the Configuration view under Users (if the user is stored in the internal
LDAP database or an external LDAP database that the SMC is configured to use).
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5) To change the Management Server Database password, select  Menu > System Tools > Password >
Change Database Password.
The default Management Server Database user account is dba, and the password is created automatically.

Related tasks
Add administrator accounts on page 359
Create an emergency administrator account on page 1342

Troubleshoot user accounts
Resolve problems when end-user passwords are not accepted for authentication.

Problem description: You add a User element (end user account for authentication) or change the password
in a User element, but the new user account or new password are not accepted when the end user tries to
authenticate. Previously created and unmodified user accounts work as expected. If you changed the password,
the previous password is still accepted.

Reason: There might be a replication problem that prevents synchronizing the user database information from
the Management Server to the local database on the Firewalls.

Steps

1) Reset the user database by right-clicking an individual Firewall node (not the upper-level Single Firewall/
Firewall Cluster element) and selecting Commands > Reset User Database. This action copies all user
information from the Management Server to the engine.

2) Make sure User DB Replication (automatic user database replication) is active under Options in the right-
click menu for the Single Firewall/Firewall Cluster (top-level) element.

Create an emergency administrator
account

If none of the administrators can log to the Management Client because of account-related issues, you can create
an emergency administrator account.

Steps

1) On the command line of the Management Server computer, stop the Management Server service.

2) Create an account with unrestricted permissions using the sgCreateAdmin script (located in the
<installation directory>/bin folder).

Note:  If you installed the Management Server in the C:\Program Files\Forcepoint\SMC
directory in Windows, some program data might be stored in the C:\ProgramData\Forcepoint
\SMC directory.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Troubleshooting accounts and passwords | 1343

Result

You can now log on to the Management Client using this account, change passwords, and create new accounts
normally.
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Messages for troubleshooting
Contents

• Alert log messages for troubleshooting on page 1345
• Log messages for troubleshooting on page 1347
• Error messages for troubleshooting on page 1353

Some common alert and log messages that you might see in the Logs view are useful for troubleshooting.

Alert log messages for troubleshooting
Alert log messages provide useful information for troubleshooting.

Respond to Log spool filling alerts
The “Log spool filling” alert indicates that logs are not being transferred from the engine at all, or the engine is
generating logs more quickly than they can be transferred to the Log Server.

Follow the instructions in the topics about troubleshooting log storage.

Related tasks
Troubleshoot log storage on page 1372

Respond to alerts about inoperative NGFW
Engines
The Inoperative NGFW Engines alert is triggered when the Management Server does not receive the expected
status updates from an NGFW Engine. The Status Surveillance option must also be selected for the engine.

If you see these alerts, one of the problems listed here might exist or might have existed temporarily:

• The connection between the engine and the Management Server might have been lost due to network
connectivity problems or due to a technical issue on the Management Server. Problems that affect only
management communications do not interfere with the operation of the engines - the engines continue
processing traffic.

• The engine might be experiencing technical problems.

A console connection to the affected engine is recommended, if possible, when you suspect that the engine
might not be operating properly. Connecting to the engine allows you to see any possible error messages printed
out to the console before you take corrective actions, such as rebooting the node.
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Steps

1) Check if the status of the engine or the system connections (shown in the info view when the engine is
selected) still shows problems.

2) Check if there is a steady log stream from the affected engine. Also check if there are any further alerts or
logs from the engine that could explain the reason for the message.

3) Check if the engine is actually processing traffic normally even if the Management Server is not able to
monitor the engine and show the log stream.

4) If you suspect technical problems on the engine, run the sginfo script on the engine before rebooting it (if
possible) and contact Forcepoint support.

Related reference
Security Management Center commands on page 1409

Respond to System Alerts
“System Alert” is a general category for alert messages that are generated because something in the operation of
the SMC components or NGFW Engines requires your attention.

Steps

1) Select the alert entry in the Logs view and click Details in the toolbar to view the alert entry information.

Respond to Tester alerts
Tester alerts indicate that the automatic tester running on the engines has detected a failure in one of the tests
that the tester is configured to run.

The Tester is configured to run some tests by default. You can add more tests in the Engine Editor for each
engine.

Steps

1) Make sure the condition that caused the test to fail is resolved.

Related concepts
Getting started with the engine tester on page 649

https://support.forcepoint.com
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Respond to throughput-based license
exceeded alerts
Throughput-based license exceeded alerts are triggered traffic exceeds the throughput limits allowed by your
license.

Some licenses limit the throughput of the engine to a certain fixed value. If the throughput limit is reached at
any particular moment, the exceeding traffic is dropped and an alert is created to notify you how many packets
have been dropped. The throughput limit is counted as the total throughput of all traffic handled by the engine at
any one moment. All traffic is taken into consideration, regardless of type, direction, or the links used. Usually,
temporary spikes in traffic trigger the messages, and the messages do not cause major problems. If you see
these messages often, you should take action.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Make sure that your appliance licenses are matched to the correct elements according to the type of
appliance. If the license generated with the POS code of a lower-throughput appliance is applied to a higher-
throughput appliance, the throughput is needlessly limited.

2) If the hardware can handle a higher throughput than what it is licensed for, you can switch to a higher-
throughput license (contact your reseller).

3) If the license throughput corresponds to the maximum throughput achievable with your hardware, you might
be able to install an additional cluster node. Alternatively, you can switch to hardware with a higher maximum
throughput (contact your reseller).

4) You can restrict the traffic in a more controlled way, for example, using the traffic management features of a
Firewall. See Getting Started with QoS for more information.

Related concepts
Quality of Service (QoS) and how it works on page 949

Log messages for troubleshooting
Log messages provide useful information for troubleshooting.

Respond to Connection closed abnormally log
messages
Logs might contain the message “connection closed abnormally” if the connection closing does not occur in the
expected order of a normal TCP connection.

Connection closed by client/by server or connection reset by client/by server messages in logs inform you about
an event that the Firewall has detected in the network. Connection closing is an expected event at the end of
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each standard TCP connection. The logging settings in the Access rules determine whether connection closing
is logged. Frequent abnormal connection closing or resets might indicate problems in the network, such as an
overloaded server.

Steps

1) If connection problems affect services, perform standard network troubleshooting steps along the whole
communication path.

Related concepts
Traffic captures and how they work on page 216

Respond to Connection removed during
connection setup log messages
The “Connection removed during connection setup” message in logs notifies you that a connection was
abnormally cut during the TCP connection setup phase because of an RST (reset) sent by one of the
communicating parties.

Steps

1) Check why the connection is torn down, for example, if the server is overloaded or if the service is down or
using a non-standard port.

Respond to Connection state might be too
large log messages
Logs that contain “connection state might be too large” messages indicate problems with synchronizing state
information between nodes in a Firewall Cluster.

Problem description: You see “error when serializing for state sync” messages with a “connection state might
be too large” clarification log entries for a Firewall Cluster. You might also experience intermittent or continuous
problems with clustering and traffic flow, which are typically alleviated for some time by rebooting all clustered
nodes.

Reason: The Firewall keeps a record of all connections that are handled statefully to be able to track the
connection. When the Firewall is clustered, this connection table must be synchronized between the nodes to
allow connections to continue if a node goes down. When the state table grows excessively large, the Firewall
engines can no longer effectively use it.

A misconfiguration usually causes this message. Typical configuration problems include:

• Using the Oracle Protocol Agent on the actual database connections between the client and the server. The
Oracle Protocol Agent is meant for cases where TCP port 1521 is used only for negotiating the port number
for Oracle database connections. The port number for the actual connection is assigned dynamically. The
Oracle Protocol Agent must not be used in any other cases.

• Excessive idle timeouts defined in Access Rules. All TCP connections are normally explicitly closed by the
communicating parties and can therefore be cleared from the state table based on actual connection state.
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Non-TCP protocols do not establish connections. The communications are still handled as virtual connections
on the Firewall to allow all Firewall features to be used on the traffic. Since the communicating parties do not
have a closing mechanism, these virtual connections are never cleared from the Firewalls’ connection records
before the communications are left idle (unused) for the duration of the defined timeout. If Access rules define
excessively long timeouts for such traffic between many different hosts, the connection state table can grow
very large.

Steps

1) If you use the Oracle Protocol Agent, make sure that it is not applied incorrectly.
If necessary, replace the default service that has a Protocol Agent attached with a custom service that
matches the correct port without a Protocol Agent.

2) Check the Access Rules to see if there are rules that override the default idle timeout value for non-TCP
traffic.
• Make sure that the override is not applied to any traffic that does not absolutely need a longer timeout

(make the rule as specific as possible)
• Try reducing the timeout (generally, the idle timeout should not be more than a few minutes).
• In some cases, allowing both communications directions separately might remove the need for long

timeouts

Respond to Connection timeout log messages
Connection timeout log messages are generated for inactive connections that the Firewall clears out from its
connection tracking table.

Connections are inactive when the hosts involved in the connection stop transmitting packets between each
other.

Most connection timeouts are normal and necessary to ensure that the Firewall cleans up inactive connections
from its records, freeing up the resources. However, sometimes the timeout can prevent communications from
continuing.

Steps

1) If some application in your network leaves connections inactive for long periods of time before continuing
again, you can increase the timeout for those connections. You can change the timeout in the Action options
for the Access rule that allows the connection. The rule-specific timeouts override the global timeouts that
are set per connection state in the Firewall element’s properties (Advanced Settings).

CAUTION:  Setting long timeouts for a high number of connections considerably increases
the resource consumption of the Firewall and can even lead to performance problems.
This issue applies especially to non-TCP protocols that do not include connection closing
messages, because such virtual connections are never closed before the timeout is reached.

2) If the protocol is not connection-oriented (for example, if the protocol is SNMP), you can disable connection
tracking for the traffic in the Access rule’s Action options. Disabling connection tracking requires that you
explicitly allow both directions of the communications in the rule, since without connection tracking, reply
packets cannot be automatically allowed. NAT rules are not applied to connections that are not tracked. We
recommend that you deactivate logging in rules that have connection tracking off, since these rules create a
separate log entry for each packet transmitted. The number of log entries generated greatly increases, and
can potentially lead to an unmanageable level of logging traffic.
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Respond to Incomplete connection closed log
messages
Logs that contain “incomplete connection closed” messages indicate that a Firewall determined that a connection
was unsuccessful and removed it from its records.

“Incomplete connection closed” messages are shown in logs when the Firewall allows a connection and passes
the first packet of a connection (the SYN packet), but the reply packet (SYN/ACK) from the destination host does
not arrive at the Firewall.

One of the following situations can cause the connection to be incomplete:

• The SYN packet did not reach the destination.
• The SYN packet reached its destination, but the destination host did not send any reply.
• The SYN packet reached its destination and the destination host replied, but the reply packet did not reach the

Firewall.

It is normal to see a few of these messages in the log from time to time. However, a higher number of these
messages can indicate problems in your network or the communicating applications.

Steps

1) If this message appears in the logs often for legitimate traffic, there is a networking problem that you must
address. Use normal network troubleshooting tools to find out where the packets are lost. You can generate
a tcpdump file by taking a Traffic Capture from the SMC.

2) In some cases, SYN packets can be sent maliciously to random hosts as an attempt to find out your network
structure. These attempts can sometimes be seen as SYN packets to hosts that do not exist. If access
to those addresses is allowed and routable, this process can trigger the Incomplete Connection Closed
messages. The possibility of successful scans can be reduced by using dynamic NAT on the Firew all.

Related concepts
Traffic captures and how they work on page 216
Getting started with NAT rules on page 835

Respond to NAT balance log messages
Logs that contain NAT balance messages indicate that connections were dropped when the Firewall tried to
forward the connections after applying NAT.

NAT balance messages are shown in the logs when a connection has been allowed, the Firewall has applied a
NAT rule that defines source and/or destination translation, and the traffic has been forwarded according to the
Firewall’s routing configuration, but a reply is never received.

Steps

1) If NAT is applied to the connection in error, adjust your NAT rules accordingly. It is also possible to create a
NAT rule that defines no translation to disable NAT for any matching connection.

2) Make sure that the Firewall routes the traffic correctly. The routing decision is made based on the translated
destination IP address.
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3) Make sure that the destination host is up and providing the requested service, and that any intermediary
Firewall allows the connection.

4) Try to trace the path that the communications take and use traffic captures as necessary to find the point of
failure.

Respond to Not a Valid SYN Packet log
messages
Logs that contain “Not a Valid SYN Packet” messages indicate that packets were discarded due to connection
tracking.

Problem description: The “Not a Valid SYN Packet” message appears in logs with entries on discarded packets.

Reason: “Not a Valid SYN Packet” is a TCP packet that is not the first packet of a TCP connection (the packet
does not have the SYN flag set), but is not part of an existing connection either (there is no connection tracking
entry on the Firewall matching this packet). The policy would allow this packet if the packet was part of an
existing tracked connection.

The message usually also contains a code inside square brackets that indicates the flags set in the discarded
packet (A=Ack, F=FIN, R=RST, P=Push, S=SYN).

Some examples of situations, where “Not a Valid SYN packet” messages can be seen:

• Asymmetric routing, which means that the opening packet does not go through the Firewall, but the reply (the
SYN/ACK) does. If so, there is a configuration error in the routing of the surrounding network that must be
fixed.

• Connections that are idle for more than the defined connection timeout (connection has been erased from
the Firewall records). This happens from time to time, but if necessary, the timeout can be increased or you
can use the TCP Proxy Protocol Agent, which can reset the connection at the host and server when the
connection is left idle (if the application in question does not properly close connections).

• Connections that have been made to look like TCP connections while they are not. If necessary, these
connections can be allowed as individual packets without connection tracking.

• Network scans or attacks that use ACK packets.
• Heavily loaded server or client that sends a packet after the host at the other end of the connection has

already timed out and closed the connection.

It is normal to see some messages like this in the logs. If a certain type of communication that you want to allow
is always prevented because of connection tracking, check these troubleshooting steps.

Steps

1) If there are connections that are left idle for a long time, you can change the idle timeout value for the Access
rule that allows that specific traffic. There are also default values that you can set globally for different TCP
connection states in the Firewall element’s properties (Advanced settings). This solution does not usually
apply to non-TCP connections, so take care that the rule only matches the specific connections involved.

CAUTION:  Setting long idle timeouts for a high number of connections considerably
increases the resource consumption of the Firewall and can even lead to performance
problems. Especially, non-TCP protocols do not include connection closing messages, so
such virtual connections are never closed before the timeout is reached.
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2) You might have to disable connection tracking in the rule allowing the connection. We recommend that you
deactivate logging in rules that have connection tracking off. These rules create a separate log entry for each
packet transmitted, which increases the number of log entries generated. NAT cannot be applied to traffic
that is allowed without connection tracking, and both communication directions must be explicitly allowed in
the Access rules (replies are not automatically allowed).

3) For some types of connections, problems can be solved by using a Service that includes a special Protocol
Agent for that traffic.

Related concepts
Protocol elements and how they work on page 907

Related tasks
Define Action options for the Allow action in Firewall Access rules on page 873

Respond to Requested NAT cannot be done
log messages
Logs that contain “Requested NAT cannot be done” error messages can indicate problems with dynamic NAT or
Server Pools.

Steps

1) A Dynamic NAT operation might be applied to the wrong type of traffic. Dynamic (many-to-one) NAT is done
by assigning different hosts the same IP address, but different ports. For this reason, dynamic NAT does not
work when the protocol in question does not use ports. Only the TCP and UDP transport protocols use ports.
See the TCP and UDP branches in the Services tree in the Management Client to check which protocols are
transported over TCP or UDP.

2) Dynamic NAT can run out of ports if there are too many simultaneous connections in relation to the IP
addresses and the port range you have configured for dynamic NAT. You can increase the available ports
for translation by adding a new IP address for your dynamic NAT rule. Alternatively, you can expand the port
range, if the rule does not currently use the whole range of high ports.

3) If the Server Pool element is used, check the NAT rules. Because the Server Pool element always does
NAT, errors can occur when the Server Pool element is used and the same connection matches an
overlapping NAT rule.

4) Check if the information message in the log states that dynamic NAT is denied due to excessive number
of connections. This can happen when a single host is opening connections at an excessive rate to a
single destination IP address and port through dynamic source NAT. This message indicates the triggering
of a self-protection mechanism, which prevents excessive use of processing resources to dynamic NAT
operations. Set up a static NAT rule to allow these types of connections if it is not possible to adjust the
connection settings of the application.
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Error messages for troubleshooting
Error messages provide useful information for troubleshooting.

Respond to Command Failed or Connect Timed
out errors
There are several possible causes and solutions when to command an engine using the Management Client and
receive an error.

Steps

1) Make sure that there is connectivity between the Management Server and the engine.
The most common connectivity problems include traffic filtering by an intermediate firewall and incorrectly
configured NAT configuration. When NAT is configured incorrectly, a required NAT rule for the connection
is missing, or the engine’s contact address is missing. The engine sends its status reports through the Log
Server, so a green operating status does not guarantee that the Management Server can reach the engine.

2) Try to refresh the engine’s policy. Read all messages displayed and make sure that none of the nodes
perform a rollback to the previous policy. If policy installation fails, see Troubleshooting Policy Installation.

Related tasks
Troubleshoot policy installation on page 1387

Respond to Unexpected Error messages
In some cases, the Management Client might display a pop-up message stating that an “unexpected error” has
occurred.

Steps

1) Exit and restart the Management Client.

2) If the condition persists, contact Forcepoint support.

https://support.forcepoint.com


 Forcepoint Next Generation Firewall 6.4 | Product Guide

Messages for troubleshooting | 1354



Troubleshooting certificates | 1355

 CHAPTER 85

Troubleshooting certificates
Contents

• Problems with certificates on page 1355
• Renew SMC server certificates on page 1357
• Renew engine certificates on page 1359
• Troubleshoot expiring certificate authorities on page 1360
• Revert to an Internal RSA Certificate Authority on page 1361

Digital certificates allow components to prove their identity to each other. SMC components use certificates in system
communications and in VPNs.

Problems with certificates
Problems with certificates can be related to certificate validity time, certificate authority validity time, or other
issues that cause a certificate to be invalid.

Note:  Do not confuse certificates with licenses. Certificates are proof of identity that components
use to authenticate themselves in communications. Licenses are a proof of purchase used for
ensuring that your organization is a legal license holder of the software.

There are two types of certificates that are used in the SMC:

• Components use certificates to identify each other in system communications. When a component has no
valid certificate, contact between that component and other SMC components is not possible. Depending
on the components, policy installation and log traffic might be affected. The certificates used in system
communications are always generated by the Internal Certificate Authority that runs on the Management
Server. The Internal Certificate Authority can be an Internal RSA Certificate Authority or an Internal ECDSA
Certificate Authority. Only one type of Internal Certificate Authority can be used at a time.

• Certificates are also used in VPNs for authentication between remote gateways. These certificates can be
generated by any internal or external certificate authorities that both gateways are configured to trust.

Problems related to certificate validity time
All certificates have a validity start date (“not before”) and a validity end date (“not after”). In the SMC, internally
generated certificates are valid for three years from their creation. Expired certificates must be replaced with new
ones. Since each component interprets the certificate validity according to their own internal clock, incorrect date
or time settings can lead to unexpected certificate rejections.

Example: An external VPN gateway device defaults to 1970 when an error occurs in setting its time. In this state,
the device thinks a certificate issued today is not valid until decades into the future and certificate authentication
fails.

You can check the validity of internal certificates (of SMC servers, Firewalls, IPS engines, and Layer 2 Firewalls)
and VPN Gateway Certificates in the Management Client:
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• Internal certificates: Select  Configuration, then browse to Administration > Other Elements > Internal
Certificates, and open the properties of the certificate.

• VPN Gateway Certificates: Select  Configuration, then browse to VPN > Other Elements > Certificates >
Gateway Certificates, and open the properties of the certificate.

Problems related to certificate authority validity time
The SMC’s internal Certificate Authorities are valid for 10 years. A new Internal RSA CA or a new Internal
ECDSA CA and a new VPN CA are automatically created six months before the expiration date. The components
that use certificates signed by the internal CAs must receive new certificates that have been signed by the new
internal CAs. Otherwise, the system communications and VPN connections cannot function.

You can check the validity of internal CAs in the Management Client:

• Internal Certificate Authorities: Select  Configuration, then browse to Administration > Other Elements >
Internal Certificate Authorities.

• Internal VPN CAs: Select  Configuration, then browse to VPN > Other Elements > Certificates > VPN
Certificate Authorities, and open the properties of the certificate authority.

When the system has created an Internal CA, SMC components gradually start using the new Internal CA to sign
certificates. Initially, the new Internal CA is in the “Ready to Use” state, and only Management Server certificates
are signed by the new Internal CA. Certificates for other components are signed by whichever Internal CA is used
by the Management Server. In an environment with multiple Management Servers, the new Internal CA changes
to the “Active” state when all Management Servers are using the new Internal CA.

Each component must receive a new certificate signed by the new internal CA. The system automatically tries to
create new certificates for NGFW Engines, and Master NGFW Engines. For other components, you must always
manually create new certificates. If the automatic certificate creation fails, you must create new certificates
manually for NGFW Engines, and Master NGFW Engines.

When a new internal VPN CA has been created, the VPN gateways that trust the old VPN CA must be made
to trust the new VPN CA. VPN clients that use certificates for user authentication also require new certificates
signed by the new VPN CA.

Other problems
Common certificate-related issues not related to the validity time include:

• Certificates used in system communications become invalid when the certificate authority changes.
• This happens if the Management Server is reinstalled and the configuration is recreated manually or

by importing elements instead of importing a backup (backups contain certificate authority information).
If backup restoration is not an option, all SMC components must receive a new certificate for system
communications.

• In some cases, restoring the Management Server backup might also result in the internal certificate
authority being different from the certificate authority that was used to create certificates for some
components. The invalid certificates must be replaced with new ones.

• In this case, internally signed VPN certificates can be made valid by configuring the issuing certificate
authority as an additional trusted certificate authority for the VPNs.

• Certificates created for the VPN gateways for establishing the VPN during the VPN configuration are stored on
the VPN gateway devices (Firewalls). These certificates are not included in the Management Server backup,
and are not changed in any way when a Management Server backup is restored.

• Certificates can become unusable if the private key for that certificate is lost. The key can be lost, for example,
if the Firewall engine hardware fails and has to be replaced. Firewall Clusters share each VPN certificate
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and can synchronize the private key from node-to-node as needed. If the private key is erased from a Single
Firewall or from all the nodes of a Firewall Cluster, a new certificate must be created.

• If one or more of the certificates needed for securing the internal connection has expired or is damaged, you
might see a Java-related error with messages about “PKIX.”

• Externally issued VPN certificates can be revoked by the certificate authority that issued them. This safety
measure is used when the certificate is suspected to be compromised. This problem can only be solved by
contacting the certificate issuer.

Related concepts
Problems with licenses on page 1367

Related tasks
Check when internal certificates or CAs expire on page 219
Create Internal ECDSA Certificate Authority elements on page 462
Check when VPN certificate authorities expire on page 1234

Renew SMC server certificates
You must renew SMC server certificates when the certificates are about to expire, have expired, or are lost.

The following situations require you to renew SMC server certificates:

• The system indicates that the certificate of a Management Server, Log Server, or Web Portal Server is about
to expire.

• The system indicates that the certificate of a Management Server, Log Server, or Web Portal Server has
expired.

• The system indicates that the Certificate Authority that signed the certificate of a Management Server, Log
Server, or Web Portal Server is about to expire. A new Certificate Authority has been created, and the server
requires a new certificate.

• The SMC components refuse communication attempts with each other.

If the Management Server certificate expires or is lost, it is not possible to log on using Management Clients.
Log Server certificate expiration or loss prevents log browsing, reporting, and status monitoring from working
correctly, and forces the engines to spool logs locally.

The certificates of any of the SMC server components can be renewed without impacting any of the other
components. The certificate generation requires you to authenticate as an administrator unrestricted permissions.

Steps

1) Stop the SMC server you want to recertify.

Note:  To certify a Log Server or a Web Portal Server, the Management Server must be
running and accessible through the network.
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2) On the command line of the server that you want to certify, open the <installation directory>/bin
folder.

Note:  If you installed the Management Server in the C:\Program Files\Forcepoint\SMC
directory in Windows, some program data might be stored in the C:\ProgramData\Forcepoint
\SMC directory.

Note:  Command-line scripts can be found in the C:\Program Files\Forcepoint\SMC\bin
directory.

3) Run the correct script for the server type:
• Management Server — sgCertifyMgtSrv.[bat|sh].

In an environment with only one Management Server, or to certify the active Management Server, stop
the Management Server before running the sgCertifyMgtSrv command. Run the command without
parameters. Restart the Management Server after running this command.

To certify an additional Management Server, stop the additional Management Server before running
the sgCertifyMgtSrv command. The active Management Server must be running when you run this
command. The management database is replicated to the additional Management Server during the
certification. The additional Management Server must have a connection to the active Management
Server when you run this command.

• Log Server — sgCertifyLogSrv.[bat|sh]
• Web Portal Server — sgCertifyWebPortalServer.[bat|sh]

4) If prompted, log on using an administrator account with unrestricted permissions.
• If Domains are in use, you can also specify the Domain the Log Server or the Web Portal Server belongs

to. If you do not specify the Domain, the Shared Domain is used.

5) Make sure that the Recertify an Existing Server option is selected, and that the correct server is selected in
the list.

6) Click OK, then wait for a confirmation that the server certificate has been renewed.

Result

When you restart the server, all other components accept the new certificate, since it is issued by a certificate
authority they trust. In this context, components only trust the Internal Certificate Authority that issued also their
own certificate.
When administrators log on to the Management Client or to the Web Portal for the first time after the server’s
certificate is changed, they receive a notification of the certificate fingerprint change on the Management
Server or Web Portal Server. If you want to check the certificate fingerprint before accepting it, run the
sgShowFingerprint command on the server.

Related tasks
Check when internal certificates or CAs expire on page 219

Related reference
Security Management Center commands on page 1409
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Renew engine certificates
Engine certificates are usually renewed automatically. You might have to renew engine certificates manually in
some cases.

The following situations might require you to manually renew engine certificates:

• The system indicates that an engine component’s certificate has expired.
• The system indicates that the Certificate Authority that signed the component’s certificate is about to expire or

has expired. A new Certificate Authority has been created, and the engine requires a new certificate.
• Components refuse connection attempts with each other.
• You have created an ECDSA CA and the engine has lost connectivity to the Management Server. You might

also have to manually enable 256-bit security strength for the engine.

If the certificate for system communications expires or is deleted, the Firewalls, IPS engines, and Layer 2
Firewalls continue processing traffic normally but all communications with other components cease. For clusters,
traffic might be disturbed if expired certificates prevent nodes from synchronizing information. The same also
happens if the Internal Certificate Authority that signs the certificates for system communications is about to
expire, and engines do not have new certificates signed by the new Internal Certificate Authority that the system
has automatically created.

If a certificate for VPN authentication expires or is deleted, VPNs that are configured to use certificates (including
any VPN involving the Stonesoft VPN Client) cannot be established before the certificate is renewed. A VPN
certificate renewal or change can cause a security warning to appear to VPN client users connecting to the
gateway.

Engine certificates might expire because automatic certificate renewal is disabled in your system. Automatic
certificate renewal might also fail due to the lack of required information, or due to information loss or
incompatibility issues that depend on the software versions used when the system was originally installed.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) For the engine certificates used for SMC system communications, renew the contact between the engine
and the Management Server using a new one-time password.

2) If a VPN certificate has expired, renew the certificate. If the VPN certificate is invalid for some other reason,
delete the Gateway Certificate element in the Management Client and then create a new certificate.
The VPN gateway certificates are created and managed separately from the certificates used in system
communications.

Related concepts
Management connections for engines and how they work on page 639

Related tasks
Check when internal certificates or CAs expire on page 219
Reconfigure engine settings on page 347
Enable 256-bit security strength for engines on page 463
Replace expired VPN certificates on page 1230
Check when VPN gateway certificates expire on page 1234
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Related reference
Forcepoint NGFW Engine commands on page 1421

Troubleshoot expiring certificate
authorities

Messages about expiring certificate authorities are triggered when a certificate authority is about to expire, a new
certificate authority has been automatically created, or a certificate authority has expired.

Messages about expiring certificate authorities can also indicate that administrator actions are required so that
the SMC components can start using the new Certificate Authority.

You might need to renew certificate authorities in the following cases:

• The system indicates that the Certificate Authority that signed the certificate of a component is about to expire.
A new Certificate Authority has been created, and a new certificate must be generated for the component
because the Certificate Authority has been renewed.

• The system indicates that a VPN gateway must be set to trust a new internal VPN Certificate Authority that
was created automatically.

• Components refuse connection attempts with each other.

If a Certificate Authority is about to expire, the components that use certificates signed by the Certificate Authority
require new certificates that are signed by a valid Certificate Authority.

No administrator actions are usually needed to create a new certificate for the engines. Once a new Internal CA
has been created, new certificates are automatically created for the engines. However, if the automatic certificate
renewal fails for certificates used in system communications, you must make initial contact from the engine to the
Management Server. After successful initial contact, a new certificate is automatically created for the engine.

New certificates are automatically created for NGFW Engines. You only have to refresh the policy on the engine
to use the new certificate.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Renew an external certificate authority used in VPN configurations:

a) Configure a new certificate authority and make sure that it is a trusted certificate authority in the VPN
configurations.

b) Create new certificates for the components involved in the VPN configuration, signed by the new
certificate authority.

2) Renew internal certificate authorities used in securing system communications and in VPNs:

a) The system automatically generates a new Internal Certificate Authority and a new internal VPN
Certificate Authority six months before their expiration dates.
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b) Each component that uses certificates signed by the Internal Certificate Authority or the internal VPN
Certificate Authority requires a new certificate that is signed by the new Internal Certificate Authority or
internal VPN Certificate Authority.

3) To renew system communications certificates for the SMC servers, manually create a certificate for each
Management Server, Log Server, and Web Portal Server using command-line tools.

4) If an external gateway trusts the internal VPN CA and the internal VPN CA has been renewed, create a
certificate for the external gateway and sign it with the new internal VPN CA.
You must also set the new VPN CA as a trusted CA in the External Gateway’s properties and also in the
properties of the VPN Profile element that is used in the VPN configuration.

5) If certificates are used to authenticate VPN client users and the certificates have been signed with the
internal VPN CA, you must create new certificates for the VPN client users using the new VPN CA.
When a VPN client connects to a gateway that trusts the new internal VPN CA, the VPN client users must
accept the fingerprint of the gateway’s certificate before they can connect to the gateway. Inform the users
that the fingerprint of the gateway’s certificate has changed and provide the information for checking the
fingerprint in the VPN client.

Related concepts
Management connections for engines and how they work on page 639
VPN certificates and how they work on page 1221

Related tasks
Replace expired VPN certificates on page 1230
Renew SMC server certificates on page 1357

Revert to an Internal RSA Certificate
Authority

If you created an Internal ECDSA Certificate Authority but you want to go back to using an Internal RSA
Certificate Authority, you can revert to an Internal RSA Certificate Authority.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Select  Configuration, then browse to Administration.

2) Browse to Other Elements > Internal Certificate Authorities.

3) Right-click Internal Certificate Authorities and select Create New Internal RSA Certificate Authority.
You are prompted to confirm that you want to create an Internal RSA Certificate Authority.
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4) Click Yes.

• The Internal RSA Certificate Authority creation process begins and a new tab opens to show the
progress of the process.

• When the process is finished, the progress report shows the steps that you must take next.
• The status of the RSA CA is “Created for Different Certificate Type.”

5) Restart the Log Server and the Web Portal Server.

6) Start the Renew Internal Certificate Authorities Task.
When the Task is finished, the status of the RSA CA is “Ready to Use for Different Certificate Type.”

7) Right-click the Renew Internal Certificate Authorities Task in the History branch and select Show
Progress Report.
The progress report shows which steps you must take next.

8) Follow the instructions to resolve any issues. For example, you might be prompted to check the status or
connectivity of some engines.

9) Recertify the Management Server.

10) Start the Renew Internal Certificate Authorities Task again.
When the Task is finished, the status of the RSA CA is “Active.”

11) Recertify the Log Server and the Web Portal Server.

Result

When you create an Internal RSA Certificate Authority, SMC components gradually start using the new Internal
RSA CA to sign certificates. Initially, the new Internal RSA CA is in the “Created for Different Certificate Type”
state. When the new Internal RSA CA is ready to begin signing certificates, it changes to the “Ready to Use for
Different Certificate Type” state. At first, only Management Server certificates are signed by the new Internal RSA
CA. Certificates for other components are signed by whichever Internal CA is used by the Management Server.
In an environment with multiple Management Servers, the new RSA CA changes to the “Active” state when all
Management Servers use the new Internal RSA CA.

Related tasks
Create Internal ECDSA Certificate Authority elements on page 462
Start Tasks manually on page 1301
Renew SMC server certificates on page 1357

Related reference
Security Management Center commands on page 1409
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Troubleshooting engine operation
Contents

• Troubleshoot engines that do not go or stay online on page 1363
• Troubleshoot errors when commanding engines on page 1364
• Troubleshoot heartbeat and synchronization errors on page 1365
• Troubleshoot contact between engines and the Management Server on page 1365

There are several common errors and problems that are directly related to the operation of Firewalls, IPS engines, and
Layer 2 Firewalls.

Troubleshoot engines that do not go or
stay online

There are several possible causes and solutions when you command a node online, but it does not go online or
turns itself offline shortly after going online.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If you have just updated the engines or you are using an evaluation license, open the Administration
Configuration view and browse to Licenses to check that your licenses are valid for the version of engines
you are using.

2) If the nodes are in a cluster, and only one node at a time stays online, try the following troubleshooting steps:
• Check whether the cluster is in Standby mode. Standby mode keeps one node online at a time and uses

the other nodes as backups in case the online node fails.
• Refresh the policy of the cluster and check that the installation is successful so that no nodes roll back

to the previous configuration. All nodes in the cluster must have the same configuration that has been
installed in the same policy installation operation. You might have to adjust the rollback timeout in the
cluster’s properties if policy rollback on some node is the problem.

• Check for alerts in the Logs view about tests failing. Check if any of the failed tests are configured to turn
the node offline when they fail. The tester leaves one node in a cluster online even if the test fails on
all nodes. If you see a test failure, it might indicate a genuine problem that you need to solve or the test
might be misconfigured and might have to be disabled or reconfigured.

3) See the Logs view for any alerts or logs regarding the functioning of the nodes.
Certain internal error conditions (for example, heartbeat connection failures or missing certificates) can
cause nodes to go offline. These events are shown as logs and alerts.
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Related concepts
Getting started with the engine tester on page 649
Adjusting Firewall clustering options on page 684

Related tasks
Adjust IPS clustering options on page 688
Generate licenses on page 1308
Troubleshoot policy installation on page 1387

Troubleshoot errors when commanding
engines

There are several possible causes and solutions when you try to command an engine using the Management
Client and receive an error.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If there are disabled nodes in the same cluster, enable them before refreshing the policy.

2) Refresh the engine’s policy.

3) Read all messages displayed and make sure none of the nodes roll back to the previous policy.

4) If policy installation fails, see Troubleshooting Policy Installation.
If policy installation fails and the status and statistics information displayed in the Management Client is
missing (status is displayed as unknown) even though the engine is online and processing traffic, the
problem might be due to an expired certificate.

Related concepts
Problems with certificates on page 1355

Related tasks
Troubleshoot policy installation on page 1387
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Troubleshoot heartbeat and
synchronization errors

There are several possible causes and solutions when you receive alerts regarding the heartbeat connection
between the nodes in a cluster.

Steps

1) Apply normal network troubleshooting (for example, check speed and duplex settings and cabling) to make
sure that the heartbeat link works reliably.

2) Use a primary and a backup heartbeat connection using separate physical links.
It is highly recommended that you use a dedicated link for both the primary and the backup heartbeat. The
heartbeat and state synchronization are time-critical communications. The heartbeat connection is critical to
the operation of a cluster. The cluster cannot work without a reliable heartbeat connection.

3) If you have installed two or more clusters with a single LAN as a shared heartbeat, and you see extra log
entries about unauthenticated heartbeat messages, change the Heartbeat IP and the Synchronization IP so
that each cluster uses a different address.

Related concepts
Traffic captures and how they work on page 216
Adjusting Firewall clustering options on page 684

Related tasks
Adjust IPS clustering options on page 688
Adjust Layer 2 Firewall clustering options on page 688

Troubleshoot contact between engines
and the Management Server

Sometimes, the engine cannot establish initial contact to the Management Server, or all subsequent attempts to
command the engine through the Management Client fail. There are several possible causes and solutions for
these failures.

For a full list of all system communications in all configurations, see Default Communication Ports.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Apply normal network troubleshooting (for example, check speed and duplex settings and cabling).



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Troubleshooting engine operation | 1366

2) If there is a local Firewall between a remote site Firewall and the Management Server, make sure that the
local Firewall does not block the communication.
A Firewall with reversed management connections (for example, because it has a dynamic IP address)
contacts the Management Server on port 8906. Create an Access rule in the policy of the main site Firewall
to allow the connection:
• Source: Remote site Firewall
• Destination: Contact address of the Management Server
• Service: SG-dynamic-control
• Action: Allow

Related concepts
Traffic captures and how they work on page 216

Related reference
Security Management Center ports on page 1429
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Troubleshooting licenses
Contents

• Problems with licenses on page 1367
• Troubleshoot licenses that are shown as retained on page 1367
• Troubleshoot licenses that are shown as unassigned on page 1368

Licenses are a proof of purchase used for ensuring that your organization is a legal license holder of the software.

Problems with licenses
Components that do not have a license do not work.

Note:  Do not confuse Licenses with Certificates. Licenses are a proof of purchase used for
ensuring that your organization is a legal license holder of the software. Certificates are proof of
identity that components use to authenticate themselves in system communications.

Licenses are introduced to the SMC as elements that you install in your Management Server. You must install
licenses to set up the components your organization has purchased. However, on current Forcepoint NGFW
appliance models, the licenses can be generated automatically.

If the Management Server does not have a valid license, you see a license-related dialog box each time you
log on using the Management Client. You cannot create a working configuration without a Management Server
license, since most controls are disabled. If an engine component is missing a license, you can create a
configuration for it, but you cannot transfer that configuration to the engine.

Related concepts
Getting Started with licenses on page 1305
Problems with certificates on page 1355

Troubleshoot licenses that are shown as
retained

There are several possible solutions when the State of a license is shown as “retained” in the Management
Client.

Licenses can be generated based on the Management Server's proof-of-license (POL) code, the appliance’s
proof-of-serial (POS) code, or a fixed IP address. When you start using a Management Server POL-based
license, you bind it to the correct component, and the binding is fixed when you install the component's policy.
Because of this fixed binding, if you unbind a Management Server POL-based license, it is shown as “Retained.”
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In this case, it is not possible to reuse the Management Server POL-based license on another component, or
delete the Management Server POL-based license.

You can resolve issues with licenses shown as "retained" in the following ways:
• You can rebind the license to the component it was previously bound to.
• You can replace the Management Server POL-based license with a new Management Server POL-based

license.
• You can replace the Management Server POL-based license with a new IP-address-bound license or POS-

bound license.
• You can delete the element to which the Management Server POL-based license is bound. After the element

is deleted, the state of the Management Server POL-based license changes to Unassigned and it can be
rebound to some other component or deleted.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) To rebind the license to the component it was previously bound to, right-click the license and select Cancel
Unbind.

2) To replace the Management Server POL-based license with a new Management Server POL-based license,
do the following:

a) Install a new Management Server POL-based license.

b) Bind the license to the component that the retained license is bound to.
The state of the previous Management Server POL-based license changes to Unassigned and it can be
rebound to some other component or deleted.

3) To replace the Management Server POL-based license with a new IP-address-bound license or POS-bound
license, do the following:

a) Install a new IP-address-bound license or POS-bound license.

b) Right-click the Management Server POL-based license and select Replace by Static License.

Troubleshoot licenses that are shown as
unassigned

When you install a new license, it does not bind itself to any component and is shown as “unassigned.”

The license does not contain identifying information that the Management Server could use to attach the license
to a component. This is normal for Management Server POL-based licenses.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the license and select Bind to select which component you want to license.
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Related tasks
Check validity and status of licenses on page 1314
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Troubleshooting logging
Contents

• Troubleshoot the Logs view on page 1371
• Troubleshoot log storage on page 1372
• Troubleshoot Log Server operation on page 1373

There are some common problems you might encounter when viewing logs or performing tasks related to the log files.

Troubleshoot the Logs view
There are some common problems and solutions related to viewing logs.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If the Logs view is unable to contact some Log Server, do one of the following:

a) Check that the Log Server is running, and that the Log Server is reachable from the computer used
for running the Management Client. The status shown for a Log Server in the Management Client is
based on information that the Management Server has. However, logged data is not routed through the
Management Server, so a green status is not an indication of whether the Log Server is reachable for
log browsing or not.

b) If there is a NAT device between some Management Client and a Log Server, administrators must
select the correct Location for the Management Client in the status bar at the bottom right corner of the
Management Client window.

2) If some or all logs are not visible in the Logs view, do one of the following:

a) Check that the filtering, time range, and source settings in the Logs view are correct. Also make sure
that you have clicked Apply after making the latest changes in these settings.

b) Check the logging options in your policies. Not all connections automatically create log entries. The
Alert, Stored, and Essential options create permanent log entries. The Transient option means that logs
are not stored, and they can only be viewed in the Current Events mode in the Logs view when they
reach the Log Server.

c) Check that logs you want to keep are not being pruned. The Log Server deletes selected logs according
to how pruning is configured.

d) Check that the logs are being transferred from the engines to the Log Server. The log entries are
spooled on the engines if a connection to the Log Server is unavailable. Connections between engines
and the Log Server should be shown as green in the Home view.
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e) The logging process might slow down due to a lack of resources on the engine, in the network, or on
the Log Server. Your logging settings and the number of engines that send data to the same Log Server
affect the speed of the logging process.

Related concepts
Considerations for setting up system communications on page 127

Related tasks
Discard unnecessary logs on page 1281

Troubleshoot log storage
There are several possible causes and solutions when alerts indicate that the disk of an engine or a Log Server is
filling up with log files.

The “Log spool filling” alert indicates that logs are not being transferred from the engine at all, or the engine is
generating logs more quickly than they can be transferred to the Log Server.

Steps

1) If an engine is filling up with logs, do one of the following:

a) Check that the Log Server is running. If it is not running, try to start it. If the Log Server is running,
check for network problems between the engine and the Log Server. The log entries are spooled on the
engines if they cannot be sent to the Log Server. Stopping and restarting the Log Server process can
help in resetting the connection.

b) If the volume of logs is high, they might not be transferred quick enough, and logs must be spooled
even though they are being transferred. If you suspect this is the case, turn off all diagnostics logs for all
engines that you are not actively troubleshooting. Also turn off logging for all rules that have connection
tracking set to off (because these rules log each packet individually). Finally, check if logs that are
currently pruned could be prevented from being generated in the first place.

2) If the Log Server is filling up with logs, do one of the following:

a) Set up log management tasks that archive and remove the oldest Log entries from the Log Server hard
disk. To avoid problems in the future, set up tasks to run automatically at regular intervals.

b) In an emergency, you can also move or delete old log entries manually. The logs are stored on the
Log Server machine under a folder structure based on dates and times (default location is <installation
directory>/data/storage). You should always avoid manual handling of the newest entries.

Related concepts
Log data management and how it works on page 1273
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Related tasks
Enable or disable diagnostics on engines on page 339

Troubleshoot Log Server operation
There are several possible causes and solutions when the Log Server is not running and does not stay running
when you try to start it.

Steps

1) On the Log Server command line, try to start the Log Server using the script <installation directory>/bin/
sgStartLogSrv[.bat|.sh] to get more information.
Startup messages are shown on the command line.

2) Check for the following possible problems and solutions:

• The software version might be incorrect. The Log Server must have the exact same software version as
the Management Server. Upgrade components as necessary.

• The Log Server’s certificate for system communications might have expired, been deleted, or become
otherwise invalid.

• The Log Server might not have a license, the license might be bound to the wrong IP address, or the IP
address the license is bound to might not be active on the server.

• There might not be enough space for logs on the hard disk.
• Sometimes files that are necessary for the Log Server to run might be moved or deleted by external

processes, such as a malware scanner, or lost due to hard disk errors. In these types of cases, Java
shows an error message stating “Could not find the main class.” Reinstall the same software version and
check the configuration of the host computer to prevent the same from occurring in the future.

Related concepts
Problems with certificates on page 1355
Problems with licenses on page 1367

Related tasks
Troubleshoot log storage on page 1372
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Troubleshooting the Management
Client

Contents

• Troubleshoot disabled options in the Management Client on page 1375
• Troubleshoot slow Management Client startup and use on page 1376
• Troubleshoot logging on to the Management Client on page 1377
• Troubleshoot Management Client layout and views on page 1378
• Troubleshoot missing or incomplete statistics on page 1378
• Troubleshoot status monitoring on page 1379
• Troubleshoot Web Start installation on an external server on page 1379
• Troubleshoot Management Server commands on page 1380

There are several general problems that you might encounter when using the Management Client.

Troubleshoot disabled options in the
Management Client

There are several possible causes and solutions when some Management Client options are disabled.

When Management options are disabled, you can see them but they are grayed out and you cannot change
them.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Make sure that the IP address in the license is correct and that the network interface with that IP address is
active on the Management Server.
If nearly all controls are disabled, the Management Server license might not be installed or valid.

2) Make sure that your administrator permissions allow you to use the Management Client options.
Your administrator permissions might restrict your actions. For example, Operator administrators are only
allowed to view the contents of the elements granted to them. They are not allowed to change the elements’
properties. If you want to edit an element that is locked, first unlock the element.

3) Check whether the disabled options are part of an element or object created by the installation. Select the
element in the Configuration view and check the History tab in the Info pane.
System elements display “System” as the Creator. System objects cannot be edited, but usually you can
make copies of them and edit and use the copies instead.
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4) Check whether the options are part of a feature that is not supported by the engine version you are using.
If so, upgrade the engines before you can use the feature. See the Release Notes for information about new
and enhanced features in different versions.

5) Check whether you must select some other option before you can change the disabled options. Look for an
option to activate the feature or override the default values, or a way to change the default values instead.

Related concepts
Getting started with administrator accounts on page 353

Related tasks
Lock elements on page 165
Unlock elements on page 165
Generate licenses on page 1308

Troubleshoot slow Management Client
startup and use

There are several possible causes and solutions when Management Client logon and other operations are slow.

For example, refreshing a list of network elements might take a long time.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Make sure the Management Server and Log Server host names can be resolved on the computer running
the Management Client (even if the Management Client is running on the same computer as the SMC server
components). Add the IP address and host name pairs into the local hosts file on the client computer:

• In Linux: /etc/hosts
• In Windows: \WINNT\system32\drivers\etc\hosts

2) Exclude temporarily unavailable Log Servers from Sources. If there is a NAT device in between your client
and a Log Server, also make sure that the Location is set correctly for your Management Client (in the status
bar).
Log browsing is slowed down if some of the selected Sources (Log Servers) are not available (data is
displayed only after queries time out).

https://support.forcepoint.com/Documentation
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Troubleshoot logging on to the
Management Client

If you have trouble logging on to the Management Client, check the connectivity, certificate, and password.

Steps

1) If the Management Client reports a connection problem:

a) Make sure you entered the address correctly on the logon screen.
If there is a NAT device between the Management Client and the Management Server, the IP address
used must be the translated address. Locations and Contact Addresses are not used for selecting the
correct address when you are just logging on.

b) Make sure that the Management Server is running.

c) Make sure that the network between the Management Client and the Management Server is working
and routing the traffic correctly. Make sure that the correct ports and protocols are used for the
communications.
These communications are not allowed in the predefined Firewall Template for Firewalls.

2) Make sure that the Management Server certificate has not expired.

3) Make sure that your password is correct.

Related tasks
Replace forgotten passwords on page 1341
Renew SMC server certificates on page 1357

Related reference
Security Management Center ports on page 1429
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Troubleshoot Management Client layout
and views

There are some common problems and solutions related to the Management Client layout.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If a view that was previously visible is now missing:

a) Select the appropriate view from the  Menu > View menu. If the view is not listed, it is not available in
this window.

b) If the view is still not visible, select  Menu > View > Layout > Reset Layout.

2) If all views that you want to be displayed on the screen are visible, but you want to change the layout:
• You can drag and drop the views by their titles to different predefined positions on the screen and resize

them by dragging the borders.
• You can reset the layout to the default positions, select  Menu > View > Layout > Reset Layout.

Troubleshoot missing or incomplete
statistics

There are some common causes and solutions when some or all types of statistics are not visible.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If you can see some types of statistics for an element, but not other types:

• This is normal. Not all statistics are compatible with all element types.

2) If an element does not show any statistics at all:

a) If it is a server element, this is normal. Servers do not produce statistical information. Only engine
elements do.

b) Check that the Log Server is selected correctly in the Management Server properties and that the Log
Server is running. Also check that the network connections are up between the engines, the Log Server,
and the Management Server. Statistical information is sent from the engines to the Log Server, which
relays the information to the Management Server.
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Troubleshoot status monitoring
There are some common problems and solutions related to viewing the status of elements in the Management
Client.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If a status icon for an element is always white, turn on status monitoring for the element.
A white status icon indicates that status monitoring for the element is turned off.

2) If you do not know what the status icon means, place the cursor over the status icon and wait for a tooltip to
show the element’s status as text.

3) If the status of the Management Server indicates problems, but the engine is processing traffic normally,
check network connectivity.
Status information is normally sent from the engines to the Log Server, which then relays the information
to the Management Server. There is also a backup channel directly from the engines to the Management
Server.

4) If no information is available on the Status tab in the Info pane, click Refresh View.
By default, the appliance status information is not displayed automatically.

Related concepts
Getting started with monitoring the system on page 179

Related tasks
Monitor tasks on page 215

Related reference
Security Management Center ports on page 1429

Troubleshoot Web Start installation on
an external server

You might need to manually configure the Web Start files if the automatic Web Start installation fails.

Automatic Web Start installation is done using the webstart_setup.vbs or webstart_setup.sh scripts.

Solution: Manually configure the Web Start files as instructed here.
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Steps

1) Copy the Web Start folder to your workstation.
The Web Start software can be found on your product DVD in the Forcepoint_SMC_Installer/Webstart
directory.

2) Edit the following files in a text editor and enter the correct path of the Web Start folder on your web server or
network drive on the codebase row at the beginning of each file.

Table 153: Files to be edited

File name Example

smcclient.jnlp codebase="http://www.example.com/webstart" or
codebase="file://localhost/C:/webstart"

bouncycastle.jnlp codebase="http://www.example.com/webstart" or
codebase="file://localhost/C:/webstart"

smc_help.jnlp codebase="http://www.example.com/webstart" or
codebase="file://localhost/C:/webstart"

3) Save and close each file.

4) Put a link to the smcclient.jnlp file on your website.
An example start page is provided with the Web Start package, containing the link to start the application.

5) If necessary, edit the configuration of the web server to return the appropriate MIME type for .jnlp-files
(application/x-java-jnlp-file).
See the manual of your web server for instructions on how to configure the MIME type.

Troubleshoot Management Server
commands

Commands sent to the Management Server might fail, or the status of the Management Server might indicate a
replication error.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If commands sent to the Management Servers using the Control Management Servers dialog box fail, an
error message indicating that the Management Client is unable to connect to a Management Server might
appear.

a) Make sure that the Management Client Location is selected correctly so that the Management Client
connects to the Management Server at the correct Contact Address.

b) Make sure that the Location and Contact Address are correctly configured for the Management Server.
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2) If the Status of the Management Server on the General tab in the Info pane reads "Replication error":

a) Switch to the Replication tab in the Info pane for more information.

Related tasks
Define Management Server or Log Server contact addresses on page 130
Select the Location for the Management Client on page 135
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Troubleshooting NAT
Contents

• Problems with NAT and possible causes on page 1383
• Troubleshoot NAT that is not applied correctly on page 1384
• Troubleshoot NAT that is applied when it should not be on page 1385

There are some common problems you might encounter with NAT.

Problems with NAT and possible causes
There are several possible causes and solutions for problems with NAT.

Consider the following when troubleshooting NAT issues:
• A Dynamic NAT operation can be applied to most types of traffic. For TCP and UDP connections, dynamic

(many-to-one) NAT is done by assigning different hosts the same IP address but different ports, so that the
subsequent replies can be recognized and forwarded correctly. For ICMP connections, different hosts are also
assigned the same IP address. The ICMP ID in the packets is used to recognize the replies and to forward
them to the correct recipients. Only the TCP and UDP transport protocols use ports. See the TCP and UDP
branches in the Services tree in the Management Client to check which protocols are transported over TCP
or UDP. Dynamic NAT is suitable when different internal hosts communicate with different external hosts. If a
single internal host communicates with a single external host, we recommend the use of static NAT, especially
if the number of simultaneous connections is high.

• Dynamic NAT can run out of ports if there are too many simultaneous connections in relation to the IP
addresses and the port range you have configured for dynamic NAT. You can increase the available ports for
translation by adding a new IP address for your dynamic NAT rule. If the rule does not currently use the whole
range of high ports, you can also expand the port range. The number of simultaneous NATed connections
equals the number of IP addresses multiplied by the number of ports.

• Check the NAT rules for configurations that overlap with the following NAT configurations:
• Address translation configured in an Outbound Multi-Link or Server Pool element
• A NAT pool defined for VPN clients in the Firewall element’s properties
• Element-based NAT

Errors can occur when one of the listed elements is used and the same connection matches an overlapping NAT
rule, because the elements also use NAT. Only one address translation operation can be done for each packet
and overlapping configurations can cause conflicts. Overlap within the NAT rules is allowed because the rules
are resolved based on their order (first matching rule is applied). If you use element-based NAT, a more specific
manually created NAT rule can prevent traffic from matching the automatically generated NAT rules.
• Check that the NAT configurations do not overlap with an IP address that is used by some physical host in

the network. This configuration error is most common with source address translation for a DMZ or external
IP address. Overlapping NAT configurations can create conflicts between IP addresses and other hosts in the
network.
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Troubleshoot NAT that is not applied
correctly

Resolve problems when NAT is not applied at all or is applied incorrectly.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Make sure that any connection that you want to NAT is allowed by an Access rule that has Connection
Tracking enabled.

2) If the target of the translation is traffic that is entering or exiting a VPN tunnel, enable address translation for
traffic transmitted over that VPN in the properties of the VPN element.
The default setting is to disable all address translation for tunneled VPN traffic. The setting affects only traffic
inside the VPN tunnel, not the tunnel itself (the encrypted packets).

3) If traffic is not translated at all or the wrong translation is applied, check the NAT rules:

a) Search the rules using the original (before translation) source and destination addresses and check
if the traffic matches the wrong NAT rule higher up in the rule table. Only the first matching rule is
considered. Note that NAT rules with an empty NAT cell are valid and specify that addresses are not
translated for matching traffic.

b) In addition to NAT rules, NAT is also used in NetLink or Server Pool elements, and as a NAT pool
defined for VPN clients in the Firewall element’s properties. There must not be overlapping NAT rules
that match the same connections.

c) NAT rules are automatically generated from NAT definitions that are added to an element’s properties.
The NAT rules that are generated from NAT definitions do not override the rules that have been
manually added to the Firewall policy. However, a more specific manually created NAT rule can prevent
traffic from matching automatically generated NAT rules.

Related concepts
Element-based NAT and how it works on page 645
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Troubleshoot NAT that is applied when it
should not be

Resolve problems when the Firewall translates an IP address to some other IP address even though it should
not.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Check the order of the NAT rules.
The Firewall reads the NAT rules from top to bottom. Only the first rule that matches is considered, so you
can make exceptions to rules by placing a different, partially overlapping rule above. Leaving the NAT cell
empty tells the Firewall that addresses in any connections that match the rule should not be translated.

2) Check for other configurations that apply NAT.
For VPN traffic, you can also enable and disable address translation for all traffic transmitted over a VPN
in the properties of the VPN element. The default setting is to disable all address translation for tunneled
VPN traffic. The setting affects only traffic wrapped inside the VPN tunnel, not the tunnel itself (the encrypted
packets).

In addition to NAT rules, NAT is also used in NetLink or Server Pool elements, and as a NAT pool defined
for VPN clients in the Firewall element’s properties. There must not be overlapping NAT rules that match the
same connections. For NetLinks, NAT rules are used to select traffic for balancing, and only the actual IP
addresses used for the translation are defined in the NetLink elements. NAT is required for the operation of
these features and you must exclude the connections in question from the scope of these features to disable
NAT.

Related concepts
Getting started with NAT rules on page 835



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Troubleshooting NAT | 1386



Troubleshooting policies | 1387

 CHAPTER 91

Troubleshooting policies
Contents

• Troubleshoot policy installation on page 1387
• Troubleshoot rules on page 1390
• Troubleshooting packets incorrectly dropped by antispoofing on page 1393
• Troubleshooting unsupported definitions in IPv6 Access rules on page 1394

There are some common problems you might encounter when working with policies and the rules that they contain.

Troubleshoot policy installation
There are several possible causes and solutions when policy installation fails, or there is a warning message
indicating problems in the policy installation window.

Troubleshoot unintended policy rollback
Resolve problems when policy installation results in a rollback to the previously installed policy version.

Problem description: The policy installation reports that the Management Server can contact the engines and
installs the new policy successfully. However, the policy installation results in a rollback to the previously installed
policy version.

Reason: The rollback is a safety mechanism that prevents changing the engines’ policy in ways that cut the
connectivity between the engines and the Management Server. After each policy installation, the engine contacts
the SMC using its new configuration and automatically reverts its policy if the contact does not succeed within a
time-out period.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Make sure the policy and the configuration changes that you have made do not prevent communications
between the Management Server and the engine.

a) Check the IPv4 Access Rules and NAT rules (as applicable). You can also validate the policy to see if
there are issues in it that prevent the policy installation. The rule search is useful for finding the first rule
that matches the connections.

b) Check the Routing. You can use the Route Query tool to check where the packets will be routed after a
policy installation.

c) Check the Locations and Contact Addresses of the SMC components, which are required if NAT is
applied to these system communications.
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2) The rollback occurs after a timeout set in the engine element’s advanced properties. If you are sure that
there are no configuration or policy design issues, you can increase the timeout to allow for longer delays in
contact. Increasing the timeout can help if the timeout is caused by poor network reliability or delays caused
by processing a policy that is very large considering the engine’s available resources.

Related concepts
Considerations for setting up system communications on page 127
Searching in rules on page 864

Related tasks
Check routes with a Route Query on page 722
Validate rules automatically on page 890

Troubleshoot policy installation failure due to
connection timeouts
Resolve problems when policy installation fails because the connection between the engine and the Management
Server times out.

The engine is up and running, but policy installation fails when the Management Server is contacting the nodes.
When node-initiated contact is active, the Management Server might also wait for contact from a node, but the
contact never happens.

The connection might time out for the following reasons:
• There is no network-level connectivity.
• The engine or the Management Server uses the wrong IP address.
• The engine and the Management Server reject each others’ certificates.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Check for network problems, such as faulty or loose cables, mismatching speed/duplex settings, IP
addresses, and routing.

2) Check the Locations and Contact Addresses of the SMC components, which are required if NAT is applied to
these system communications.

3) In a cluster, all nodes that the Management Server tries to contact must be reachable and operational
to install a policy on any of the clustered engines. If you have taken down an engine for maintenance,
temporarily disable it to install the policy on the other cluster members.

4) If the problem seems to be related to certificates, you can recertify the engine to re-establish contact
between the engine and the SMC.

5) Check the engine software version (shown in the Info pane when you select the element in the Management
Client). See the Release Notes for information regarding version compatibility between the engine and SMC
software versions.

https://support.forcepoint.com/Documentation
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Related concepts
Considerations for setting up system communications on page 127
Management connections for engines and how they work on page 639

Related tasks
Disable cluster nodes temporarily on page 342

Troubleshoot policy installation failure for
other reasons
Resolve problems with policy installation that are not related to the connection between the engine and the
Management Server.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If the policy installation ends with an error, read the messages both in the main window and in the Issues tab
and correct as necessary. Warnings do not prevent policy installation; you can still press Continue in the
policy installation even if a warning is triggered. You can also validate the policy separately to see if there are
issues that prevent you from installing it.

2) Try installing the policy with the Keep Previous Configuration Definitions option deselected. Normally, the
option should be selected. Under certain conditions, the old configuration definitions might not be compatible
with the new policy, so the engine cannot fulfill this request and policy installation fails.

CAUTION:  When the policy is installed with the Keep Previous Configuration Definitions
option deselected, even some currently active connections that are allowed in the new policy
can be cut. The applications must then reopen the connections.

3) Make sure that a current dynamic update package is imported and activated on the Management Server.

Related tasks
Validate rules automatically on page 890

Policy installation warnings about ignored
Automatic Proxy ARP options
Misconfigurations can result in warnings about ignored Automatic Proxy ARP options.

When installing a Firewall policy, the “Automatic Proxy ARP option in NAT rule <rule tag> is ignored: none of the
CVI interfaces are directly connected to the network in question” warning is shown when proxy ARP has been
defined, but there is no matching CVI network configured in the Firewall element. Automatic proxy ARP is used in
NAT to handle ARP requests to the translated IP address for hosts in networks that are directly connected to the
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Firewall. This warning can be due to an incorrect IP address or netmask setting, or the (not directly connected)
Network in question missing from the Routing tree. It can also result from selecting the option for a NAT rule that
involves an IP address for which the Firewall cannot act as an ARP proxy.

Related settings can be configured in NAT rules, in a Server Pool element, and in the Engine Editor for the
Firewall element.

Related concepts
Configuring interfaces for Firewalls on page 543
Getting started with routing on page 701
Getting started with outbound traffic management on page 739
Getting started with NAT rules on page 835

Troubleshoot rules
There are several possible causes and solutions for problems with rules in policies.

Policy validation for troubleshooting rules
You can automatically validate a policy and check the rules for invalid configurations, for example, if policy
installation fails.

Related tasks
Validate rules automatically on page 890

Troubleshoot traffic that is blocked even
though rules allow ANY Service
The possible causes and solutions depend on the engine role when a connection that you want to allow is
stopped.

In IPS policies, Access rules allow all connections by default. If a connection you want to allow is stopped
because of an IPS Access rule, your Access rules contain a specific rule that stops these connections.

In Firewall and Layer 2 Firewall Access rules, even if you set the Source, Destination, and Service to ANY and
set the rule to allow the traffic, certain connections might still be discarded.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Use a Protocol Agent to allow connections with a protocol that assigns ports dynamically.
The Protocol Agent enables the Firewall to track the assigned port.
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2) Make sure that there is a matching rule with Continue as the action further up in the rule table with a Service
in which the correct Protocol Agent is used if you want to use a Protocol Agent in a rule with ANY as the
Service.

3) Add your own rules as necessary.
The Firewall Template contains a rule that does uses a Protocol Agent for some, but not all protocols that
use a dynamic port assignment.

4) If you must allow connections in your network for some application that implements TCP incorrectly, you
might need to adjust or even disable connection tracking in the Access rules for those connections.
Connections that violate the standard TCP connection sequence are dropped due to connection tracking. We
recommend that you disable logging for rules that have connection tracking set to off, because such rules
create a log entry for each packet.

Related tasks
Define Action options for the Allow action in Firewall Access rules on page 873

Troubleshoot false positives in the Inspection
Policy
There are several possible causes and solutions when the Inspection Policy produces alerts or terminates traffic
that you consider to be normal.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If a Situation is not valid in your environment under any conditions, change the action for the Situation to
Permit on the Rules tab.

2) If a Situation is not valid between some hosts, add an Exception for the Source, Destination, and Situation
that produce false positives. Then set the action to Permit. This editing can be done manually or based on a
log entry through its right-click menu.

3) If a custom Situation produces false positives, adjust the parameters in the Situation to better match the
traffic pattern that you want to detect.
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Enable passthrough for PPTP traffic
You might need to specifically allow Point-to-Point Tunneling Protocol (PPTP) traffic if you use PPTP tunneling.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) To allow PPTP passthrough, add matching Access rules with the following two services:

• The TCP Service for PPTP. The default Service element for PPTP uses the standard destination port
1723. Check the actual port used and create a Service with a different port, if necessary.

• The IP Service for GE (IP protocol 47).

2) Make sure that the GRE traffic is not matched against any dynamic NAT rule, including the dynamic NAT
rule required to load-balance connections between NetLinks in a Multi-Link configuration.
Use static NAT instead if IP address translation is required or configure the communicating applications to
encapsulate the traffic in TCP or UDP (NAT traversal mode).

Dynamic NAT cannot be applied because it uses ports to track connections using the same IP address.
GRE works directly on top of IP and does not have the concept of ports, so it is not possible to do the same
with GRE. It requires a static translation that forms a fixed one-to-one relationship between an original and
translated IP address. Use a static IP address to IP address or network to same-size network mapping in the
NAT rules.

Even with static NAT, some PPTP implementations require extra setup (for example, encapsulation of the
packets) to work correctly when IP addresses are translated.

Troubleshoot traffic that is incorrectly stopped
by the firewall
The Firewall might incorrectly stop traffic that you want to allow. To check possible configuration errors, use log
entries to locate the correct policy.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) In the Logs view, check whether the connection is logged.

• Add a quick filter for both the source and destination IP address of the traffic you want to allow in the
Query pane and click Apply.

• If the logs show that the connection is discarded or refused by a rule, click the Rule Tag link in the log
entry to check the rule.

2) Check the Access rules and NAT rules of the active policy for rules that match the same source, destination,
and service.

a) Open the Search Rules pane through the policy view’s toolbar, then drag and drop the corresponding
elements to the search fields at the bottom of the rule table.

b) Select Show Only Matching Rules from Options in the search pane.
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c) Deselect Do Not Match ANY from Options in the search pane.

d) If several rules are shown, the topmost rule is the one that is applied, unless the Source VPN cell (in
IPv4 Access rules) has a definition that does not match. The other cells are not used for matching, but
define options for what happens when traffic does match.

3) If the first matching Access rule is set to allow the traffic, check that other parts of the rule are correct:

• Some protocols require the correct Protocol Agent, which is set by including the correct Service with the
correct Protocol attached. In some cases, you might need to change the options of the Protocol Agent.

• ANY rules do not use most Protocol Agents by default.
• You can create new Services for any source or destination port or port range as needed.
• The Connection Tracking Action options define if stateful inspection is used and how strict the checks

are. Connection tracking allows NAT rules to be applied to the connection and a rule table where reply
packets do not need to be separately allowed. The Firewall checks that the communications follow the
standards of the protocol used and discards invalid communications. If invalid communications must be
allowed, you might need to adjust connection tracking options.

4) If there is a matching NAT rule, make sure that they are applied correctly. Particularly, dynamic NAT must
only be used for protocols that work on top of TCP or UDP, since dynamic NAT uses ports to track the
translated connections.

5) Check your routing configuration. If Routing is incorrectly configured on the Firewall, packets can be dropped
because the Firewall has no route where to send them.

Related concepts
Getting started with routing on page 701
Protocol elements and how they work on page 907
Alert log messages for troubleshooting on page 1345

Related tasks
Define Action options for the Allow action in Firewall Access rules on page 873
Troubleshoot traffic that is blocked even though rules allow ANY Service on page 1390

Troubleshooting packets incorrectly
dropped by antispoofing

You can add exceptions to antispoofing if traffic that should be allowed is incorrectly dropped as spoofed.

The antispoofing rules are automatically generated based on your routing configuration. Generally, traffic is only
allowed if the IP address seen in the communications corresponds to the IP address space that is defined for
routing through that interface in the Routing tree. Normally, communications require this routing information in
any case for any reply packets to be correctly routed. In cases where communications are one way, however, you
can make exceptions to the antispoofing in the Antispoofing tree.

By default, the antispoofing tree is read by selecting the most specific entry defined. For example, a definition of
a single IP address is selected over a definition of a whole network. If some IP address must be allowed access
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through two or more different interfaces, the definition for each interface must be at the same level of detail for
the IP address in question.

If Interface A contains a Host element for 192.168.10.101 and Interface B contains a Network element for
192.168.10.0/24, connections from 192.168.10.101 are considered spoofed if they enter through Interface B. If
this behavior is not wanted, the Host element must be added also under Interface B (in addition to the Network
element already included).

The preceding behavior can be changed by setting the more general setting (network) as Absolute through its
right-click menu in the antispoofing tree. This setting allows the address through the interface even if there is a
more specific definition attached to some other interface.

Antispoofing also discards packets that are in a routing loop: if the Firewall accepts a packet, but then receives
the exact same packet again through a different interface, the Firewall drops it. This behavior does not affect
communications, but saves the Firewall and other equipment in your network from handling the same packet
over and over again until it finally expires. If so, you must correct the routing in your network. Often, routing loops
are indicated by “NIC index changed” information in logs that discard the connection. The same packet enters
the Firewall a second time, but through a different interface - usually because the device where the Firewall is
configured to send the packet routes the packet right back to the Firewall.

Troubleshooting unsupported
definitions in IPv6 Access rules

Using elements that do not contain an IPv6 address in the Source and Destination fields of the IPv6 Access rules
causes an error message indicating the rule is invalid.

Elements that contain only an IPv4 address cannot be used. Make sure that all elements used in the Source and
Destination field of the IPv6 Access Rules contain an IPv6 address.
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Troubleshooting reporting
Contents

• Error messages for reports on page 1395
• Troubleshoot report generation on page 1395
• Troubleshoot reports with empty sections or incomplete data on page 1396

There are some common problems that you might encounter when generating reports from raw statistical and log data
stored on the Log Server.

Error messages for reports
Error messages for reports are shown in the Comment column of the Stored Reports view. Check the status of
the report task there before you proceed with the troubleshooting.

Related tasks
Troubleshoot report generation on page 1395
Troubleshoot reports with empty sections or incomplete data on page 1396

Troubleshoot report generation
There are some common causes and solutions for problems with generating reports.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If the report generation seems to work, but you cannot find it in the Stored Reports view, you might have
created the report without selecting the Stored option. Try creating the report again and make sure that you
have selected all outputs you want to produce.

2) If the report generation does not begin, and there is no error indicated, you might have defined a start time
that is in the future. The delay in the Start Earliest field can affect when report generation begins. Check the
start time for the report task. The time is interpreted according to the clock of the computer you are using to
run the Management Client. Make sure that the time and time zone settings are correct.
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3) If the “out of memory” error appears, check if you have placed one or more IP address-based top rate items
under progress sections in the Report Design:

• Generating reports with such a design consumes large amounts of memory. The report collects the
full progress information for every IP address that appears in the logs over the chosen period. Any
unnecessary data is discarded only after the top items are selected at the completion of the report task.

• To reduce the memory load, use a Drill-down top rate design. The Drill-down top rate design first finds the
top IP addresses and then gets the progress information about those IP addresses.

• Memory consumption can also be reduced by restricting the amount of data included in the report (for
example, set a shorter time range).

4) If the “unreachable server” error is shown, a Log Server is not running or is not reachable from the
Management Server. If there are Log Server elements that do not represent any physical, running Log
Server, those Log Servers might cause this error. Select the Exclude This Log Server from Statistics and
Reporting option in the properties of the Log Server elements.

CAUTION:  Be careful when excluding Log Servers from reporting. If you select this setting
for a Log Server that is actively used, there is no warning that the reports are missing parts of
the log data.

Troubleshoot reports with empty
sections or incomplete data

There are several possible causes and solutions when reports are generated, but the reports contain empty
sections or incorrect data.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) If sections show a “No Data” message, check that the log data that the section requires is in the active log
data directory of your Log Servers. Archived logs are not included in reporting.

a) Open the Logs view.

b) Make sure only Active Log Data is selected for all Log Servers on the Sources tab.

c) Select the same time period and filter that you used in the report, and click Apply.

The logs shown correspond to the log data available for generating the logs. Also take note of the following
point.
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2) If you are only missing information about traffic volumes (for example, Traffic by Source IP) check your
Access rules. Traffic information is available only for connections that match rules for which you collect
accounting information.

• The collected accounting information is shown in the Logs view for log entries that have “Connection
Closed” as their Event (see the Details pane for those entries).

Note:  Connection closing might not be logged at all, depending on the logging options of
your Access rules.

• If accounting data has not been collected at all, traffic volumes are unknown and the report sections on
traffic volumes return “No Data”.

• If only some rules collect accounting data, only the traffic that matches those rules is included in the
report sections on traffic volumes.

• Alternatively, the report items listed under Counters can be used to generate reports on traffic volumes.
The data for these items comes from stored summaries of the statistical data that you can view as live
statistics in an Overview. This data is always stored and includes information about all traffic.

• To start collecting information about traffic volumes from now on.

3) If you are missing all data from one or more Log Servers, make sure that the Exclude This Log Server
from Statistics and Reporting option is not selected. Log Servers with this option selected are ignored in all
reporting.

4) The time range you enter is interpreted according to the clock and time zone setting of the computer you are
using to run the Management Client. If the clock and time zone are not correctly set in the operating system,
the report period might be different from what you intend.

Related tasks
Define logging options for Ethernet rules on page 868
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Troubleshooting upgrades
Contents

• Troubleshoot upgrade failure because of running services on page 1399
• Respond to Security Management Center installation failed messages on page 1399

There are some common problems that you might encounter when upgrading SMC components.

Troubleshoot upgrade failure because of
running services

Troubleshoot when you are unable to upgrade because the upgrade reports that some services are still running.

Steps

1) In the Windows environment, check the Services window and stop any SMC services that are still running
(Management Server, Log Server, or Web Portal Server).

2) If all Services are stopped in the Windows Services window, but the upgrade still reports that services are
still running, follow these steps:

a) Set the services to Manual startup.

b) Restart the computer.

Respond to Security Management
Center installation failed messages

If any anomaly is detected during the installation or upgrade, you might see the “Security Management Center
installation failed” message.
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Steps

1) To find the cause of the problem:

a) Check the installation log in the installation directory for messages regarding the upgrade.

Note:  If you installed the Management Server in the C:\Program Files\Forcepoint
\SMC directory in Windows, some program data might be stored in the C:\ProgramData
\Forcepoint\SMC directory.

b) If you are skipping versions, check the Release Notes for the version you are installing, and make sure
the upgrade that you attempted is possible. The Release Notes also list any known issues that can
cause errors during the upgrade.

2) To solve problems indicated:

a) Missing files are one of the most common errors. Files might be missing if you copy installation source
files manually. Make sure that you have copied all necessary installation source files and folders, and
run the installation again. If you have not checked the integrity of the installation files, compare the
checksum of your local files to the correct checksum.

b) Start the component in question. The message is shown for many types of errors, and the component
might still be able to run without problems.

c) If you are unable to get the component running, uninstall the existing installation and install the
component as a new installation. To upgrade, you can restore elements from a Management Server
backup. You can restore a backup taken with the previous version on the upgraded SMC. See the
Release Notes for any version-specific limitations or exceptions.

Related tasks
Obtain SMC installation files on page 1317

https://support.forcepoint.com/Documentation
https://support.forcepoint.com/Documentation
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Troubleshooting VPNs
Contents

• Find VPN issues on page 1401
• Information about IPsec tunnels in logs on page 1401
• VPN certificate issues on page 1402
• Problems with VPNs with external gateways on page 1403
• Stonesoft VPN Client connection issues on page 1404
• If traffic is not sent into route-based VPNs on page 1404

There are some common problems that you might encounter when creating and managing VPNs.

Find VPN issues
The Management Client has automatic VPN validation that checks the settings you have selected are compatible
with each other.

 For more details about the product and how to configure features, click Help or press F1.Steps

1) Right-click the Policy-Based VPN element, then select Preview VPN or Edit VPN.

2) Switch to the Issues tab.
If the tab is not visible, select  Menu > View > Panels > Issues.

3) If issues are shown, read the descriptions, then fix the problems that are described.

Information about IPsec tunnels in logs
The Firewall logs contain information about IPsec tunnel negotiations.

Log messages related to IPsec tunnel negotiations contain the value IPsec in the Facility field. You can use
this value to filter logs for viewing IPsec messages. The IKE Cookie and IPsec SPI fields contain identifiers
related to each particular VPN instance, which helps further in reading and filtering the logs. The Situation and
Information Message fields include the actual VPN-related events. If possible, examine logs from the devices at
both ends of the IPsec tunnel for more information.

Tip:  Right-click a VPN log entry and select Search Related Events to see logs related to the
same IPsec VPN negotiation.
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You can collect more detailed information by enabling the IPsec diagnostics. For VPN clients, also enable
authentication and DHCP relay diagnostics.

Log messages generated by Access rules might also contain relevant information. These logs contain information
about the connections that the gateway processes, and whether policy-based VPN traffic is directed correctly to
VPN tunnels by the policy. Log messages generated by Access rules are not included if you are filtering the logs
to only show IPsec logs.

A normal IPsec tunnel negotiation proceeds as follows:

1) The negotiations start when a connection matches a rule in the Firewall Policy that triggers the VPN
negotiation (or a similar mechanism at the other end).

2) The gateway at the source end of the connection or the VPN client (the initiator, I) contacts the gateway
at the other end (the responder, R). The gateways establish trust and exchange keys in the IKE Phase 1
negotiations.

3) If Phase 1 negotiation succeeds, IKE Phase 2 negotiations begin. At this stage, the gateways agree on
further settings used for handling the connection.

4) If Phase 2 negotiations succeed, the VPN tunnel is ready and ESP or AH packets (the actual traffic) can be
seen in the logs. New connections that are opened through the VPN are logged using a VPN-specific log
message “New Connection Through VPN.”

Related concepts
IPsec VPN log messages on page 1499
Monitoring policy-based VPNs on page 1179

Related tasks
Enable or disable diagnostics on engines on page 339

VPN certificate issues
Your VPN Gateway always needs a certificate if VPN clients connect to it. In a site-to-site VPN, certificates are
required when the VPN Profile used includes a certificate-based authentication method (ECDSA signatures, RSA
signatures, or DSS (DSA) signatures).

Certificate acceptance
By default, the gateways only accept certificates signed by your Management Server. To accept certificates from
other sources, you must define the Certificate Authority (CA) that signed the certificate as trusted. By default, all
Gateways and all VPNs accept any valid CA that you have configured. You can configure the trusted CAs at the
Gateway level and at the VPN level. A CA must be trusted on both levels to be accepted as a trusted CA for a
VPN.
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Creating, signing, renewing, transferring to gateways
Internally signed certificates are created, uploaded to the engines, and renewed automatically if automatic
certificate management is enabled for the NGFW Engine.

You can manually create certificate requests, import certificates, and sign certificate requests in the VPN
Configuration view under the Other Elements > Certificates branch of the tree. Any certificate request you
create is, by default, also immediately signed using the internal CA and uploaded to the engine. To disable this
action (for example, to sign the certificate using an external CA), you must deactivate this option in the new
certificate request you create.

To sign or upload a certificate, display the certificates, then select  Tools and the corresponding option.

Related concepts
VPN certificates and how they work on page 1221
Problems with certificates on page 1355

Related tasks
Define additional VPN certificate authorities on page 1223
Define trusted CAs for a gateway on page 1154

Problems with VPNs with external
gateways

There are some common problems and solutions when you create a VPN with an external gateway.

Both policy-based and route-based VPNs can form IPsec VPN tunnels with any other fully IPsec compliant
device. Lists of VPN solutions that have been tested to be compatible are published by ICSA labs
(https://www.icsalabs.com).

Note:  Make sure that you have successfully installed or refreshed the policy on all affected
Firewalls after you have changed any part of the VPN configuration.

When creating a VPN with an external gateway:
• There are no settings that always work with a device of a certain brand and model. Most IPsec settings

depend on user preference and there are many alternative settings that you can use, regardless of the type of
gateway.

• Make sure that all VPN settings are the same at both ends (for both gateways at both ends: typically, four
definitions in all).

• Make sure that matching networks and netmasks are defined at both ends. In the SMC, all networks you want
to be accessible through the VPN must be placed in a Site element attached to the correct Gateway element.
The networks defined must be identical at the other end.

• One commonly missed setting is the SA (Security Association) setting, which can be per net or per host.
Some gateways might not have an explicit setting for the SA setting. Find out the setting used.

• For third-party devices, check for parameters that are set in the VPN configuration in the Management Client
but not on the other device. Find out the default settings used.

• The problem might be due to an overlapping, but mismatching lifetime or encryption domain in the SMC, or
the IP address definitions in Site elements under the following conditions:

https://www.icsalabs.com
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• The VPN works when the connection is initiated from one end, but not when initiated from the other.
• The Firewall’s policy has rules for both ways.

Stonesoft VPN Client connection issues
If you experience connection issues, there are several troubleshooting processes to follow.

Mobile VPNs are only supported in policy-based VPNs.

If NAT is used and the configuration download succeeds, but the Stonesoft VPN Client cannot connect to the
VPN Gateway, follow these troubleshooting steps:

1) If NAT is done between the Stonesoft VPN Client and the Firewall, set the Contact Address for interfaces
that are used as a VPN endpoint. The Contact Address tells the VPN clients the external NATed address
they must contact.

2) Refresh the Firewall Policy and make sure the Stonesoft VPN Client downloads a new configuration from the
engine.

If NAT is configured to translate the Stonesoft VPN Client address, but NAT is not done, check the following:
• In the VPN properties, make sure that the Apply NAT to traffic that uses this VPN option is selected. NAT is

only done if the option is selected.
• Make sure that the NAT rules are correct. Usually, NAT is performed using the NAT Pool address range

defined for the Firewall element in the VPN > Advanced  branch in the Engine Editor. The same traffic must
not match any of the NAT rules in the Firewall’s policy. The only exception is a rule that specifically defines
that no NAT is performed on this traffic to prevent subsequent NAT rules from matching.

For any general problems:
• Make sure that the Stonesoft VPN Client version is up to date. Older clients might have known issues that

prevent correct operation and might not support all features configured for the gateway.
• Check for any VPN-capable devices between the Firewall/VPN device and the Stonesoft VPN Client. These

devices can sometimes attempt to take part in the VPN negotiations.
• Check the Firewall logs for information about mobile VPN connections.

Related concepts
Define contact IP addresses on page 129
Information about IPsec tunnels in logs on page 1401

If traffic is not sent into route-based
VPNs

There are some common causes and solutions when traffic is not sent into route-based VPNs.

It is possible to create a half-configured route-based VPN by configuring only one tunnel interface and the
routing. This configuration creates a black-hole routing situation in which traffic routed to the tunnel interface
is silently discarded. No warnings are given when you install the Firewall policy, as the configuration is treated
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as valid. Traffic is only sent into the a route-based VPN after you fully define the Route-Based VPN Tunnel
elements.

Related concepts
Default elements for route-based VPNs on page 1181
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 Appendix A

Command line tools
Contents

• Security Management Center commands on page 1409
• Forcepoint NGFW Engine commands on page 1421
• Server Pool Monitoring Agent commands on page 1428

There are command line tools for the SMC and the NGFW Engines.

Security Management Center commands
SMC commands include commands for the Management Server, Log Server, and Web Portal Server.

Most of the commands are found in the <installation directory>/bin/ directory. In Windows, the command line tools
are *.bat script files. In Linux, the files are *.sh scripts.

Commands that require parameters must be run through the command line (cmd.exe in Windows). Commands
that do not require parameters can alternatively be run through a graphical user interface, and can be added as
shortcuts during installation.

CAUTION:  login and password parameters are optional. Giving them as command-line
parameters can pose a security vulnerability. Do not enter logon and password information unless
explicitly prompted to do so by a command line tool.

Table 154: Security Management Center commands

Command Description

ambr-crl
(SMC Appliance only)

[-a ADD|--add=ADD]
[-d DELETE|--delete=DELETE]

[-q|--query]
[-i IMPORT_CRL|--
import=IMPORT_CRL]

[-v]
[-l <log file path>]

[-h|--help]

Fetches the certificate revocation lists (CRLs) for the CA certificates used by the
appliance maintenance and bug remediation (AMBR) utilities.

-a ADD, --add=ADD adds a CRL distribution point URL in the form of http://<url>.

-d DELETE, --delete=DELETE deletes a CRL distribution point URL.

-q, --query lists CRL distribution points.

-i IMPORT_CRL, --import=IMPORT_CRL imports a CRL from a file.

-v increases the verbosity of the command. You can repeat this command up to two
times (-vv or -v -v) to further increase the verbosity.

-l <log file path> specifies the path to a log file.

-h, --help shows information about the command.

ambr-decrypt
(SMC Appliance only)

Decrypts an ambr patch; not normally used by administrators. ambr-install
automatically decrypts patches.
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Command Description

ambr-install <patch>
(SMC Appliance only)

[-F|--force]
[-r|--skip-revocation]

[--no-backup]
[--no-snapshot]

[--no-prompt]

[-v]
[-l <log file path>]

[-h|--help]

Installs an ambr patch that has been loaded on the system.

You can install multiple patches with a space between each patch name.

-F, --force forces the reinstallation of the patch or patches.

-r, --skip-revocation skips the certificate revocation checks.

--no-backup does not create a configuration backup.

--no-snapshot does not create a recovery snapshot.

--no-prompt does not prompt before restarting.

-v increases the verbosity of the command. You can repeat this command up to two
times to further increase the verbosity.

-l <log file path> specifies the path to a log file.

-h, --help shows information about the command.

ambr-load <patch>
(SMC Appliance only)

[-f IN_FILES|--file=IN_FILES]
[-r|--skip-revocation]

[-v]

[-l <log file path>]
[-h|--help]

Loads an ambr patch onto the system from either the patch server or from the local
file system. A loaded patch means that the file is copied to the local file system, but
not installed.

You can load multiple patches with a space between each patch name.

-f IN_FILES, --file=IN_FILES specifies the local file to load.

-r, --skip-revocation skips the certificate revocation checks.

-v increases the verbosity of the command. You can repeat this command up to two
times to further increase the verbosity.

-l <log file path> specifies the path to a log file.

-h, --help shows information about the command.

ambr-query
(SMC Appliance only)

[-c|--clean]

[-u|--update]

[-a|--all]

[-j|--json]

[-i INFO|--info=INFO <patch>]

[-L <log file path>]

[-v]

[-h|--help]

Shows patch information including:

• What is loaded or installed on the system

• A list of available updates from the patch server

• Detailed information about a specific patch

-u , --update updates the remote patch list from a web server .

-c, --clean cleans the remote patch cache.

-a, --all shows all local and remote patches.

-j, --json formats output as JSON.

-i INFO, --info=INFO <patch> shows detailed information about the patch.
You can get information about multiple patches in one command by separating the
patch names with a space.

-v increases the verbosity of the command. You can repeat this command up to two
times to further increase the verbosity.

-L <log file path> specifies the path to the file where log messages are written.

-h, --help shows information about the command.
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Command Description

ambr-unload <patch>
(SMC Appliance only)

[-a|--all]
[-v]

[-l <log file path>]
[-h|--help]

Unloads an ambr patch from the system. The command deletes the patch file if it has
not been installed, but it does not uninstall the patch.

You can unload multiple patches with a space between each patch name.

-a, --all unloads all loaded patches.

-v increases the verbosity of the command. You can repeat this command up to two
times to further increase the verbosity.

-l <log file path> specifies the path to a log file.

-h, --help shows information about the command.

ambr-verify
(SMC Appliance only)

Verifies the signature of a patch file; not normally used by administrators. ambr-
install automatically verifies patches.

cloudDiscoveryCLI
(Requires installation of the Cloud
Discovery Tool)

Processes log data exported from the SMC to produce a summary report about cloud
application usage.

To use exported log data with the Cloud Discovery Tool, the data must be in Short
CSV format.

sgArchiveExport

[host=<Management Server
Address[\Domain>]

[login=<login name>]

[pass=<password>]

[format=<exporter format: CSV
or XML>]

i=<input files and/or
directories>

[o=<output file name>]

[f=<filter file name>]

[e=<filter expression>]

[-h|-help|-?]

[-v]

Shows and exports logs from archive. Supports CEF, LEEF, and ESM formats in
addition to CSV and XML.

This command is only available on the Log Server. The operation checks permissions
for the supplied administrator account from the Management Server to prevent
unauthorized access to the logs.

Enclose details in double quotes if they contain spaces.

Host specifies the address of the Management Server. If the parameter is not
defined, the loopback address (localhost) is used.
login defines the user name for the account that is used for this operation. If this
parameter is not defined, the user name root is used.

pass defines the password for the user account.

format defines the file format for the output file. If this parameter is not defined, the
XML format is used.

i defines the source from which the logs are exported. Can be a folder or a file. The
processing recurses into subfolders.

o defines the destination file where the logs are exported. If this parameter is not
defined, the output is shown on screen.

f defines a file that contains the filtering criteria you want to use for filtering the log
data. You can export log filters individually in the Management Client through Tools >
Save for Command Line Tools in the filter's right-click menu.

e allows you to enter a filter expression manually (using the same syntax as exported
filter files).

-h, -help, or -? shows information about using the script.

-v shows verbose output on the command execution.

Example (exports logs from one full day to a file using a filter): sgArchiveExport
login=admin pass=abc123 i=C:\Program Files\Forcepoint\SMC\data\archive\firewall
\year2011\month12\.\sgB.day01\ f=C:\Program Files\Forcepoint\SMC\export
\MyExportedFilter.flp format=CSV o=MyExportedLogs.csv
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Command Description

sgBackupLogSrv

[pwd=<password>]

[path=<destpath>]destpath

[nodiskcheck]

[comment=<comment>]

[nofsstorage]

[-h|--help]

Note:  For the SMC Appliance, use the smca-backup command.

Creates a backup of Log Server configuration data.

The backup file is stored in the <installation directory>/backups/ directory.

Twice the size of the log database is required on the destination drive. Otherwise, the
operation fails.

pwd enables encryption.

path defines the destination path.

nodiskcheck ignores the free disk check before creating the backup.

comment allows you to enter a comment for the backup. The maximum length of a
comment is 60 characters.

nofsstorage creates a backup only of the Log Server configuration without the log
data.

-h or --help shows information about using the script.

Also see sgRestoreLogBackup.

sgBackupMgtSrv

[pwd=<password>]

[path=<destpath>]

[nodiskcheck]

[comment=<comment>]

[-h|--help]

Note:  For the SMC Appliance, use the smca-backup command.

Creates a complete backup of the Management Server (including both the local
configuration and the stored information in the configuration database). The backup
file is stored in the <installation directory>/backups/ directory.

Twice the size of the Management Server database is required on the destination
drive. Otherwise, the operation fails.

pwd enables encryption.

path defines the destination path.

nodiskcheck ignores the free disk check before creating the backup.

comment allows you to enter a comment for the backup. The maximum length of a
comment is 60 characters.

-h or --help shows information about using the script.

Also see sgRestoreMgtBackup and  sgRecoverMgtDatabase.

sgCertifyLogSrv

[host=<Management Server
Address[\Domain]>

Contacts the Management Server and creates a certificate for the Log Server to allow
secure communications with other SMC components. Renewing an existing certificate
does not require changing the configuration of any other SMC components.

host specifies the address of the Management Server. If the parameter is not
defined, the loopback address (localhost) is used.

Domain specifies the administrative Domain the Log Server belongs to if the system
is divided into administrative Domains. If the Domain is not specified, the Shared
Domain is used.

Stop the Log Server before running this command. Restart the server after running
this command.
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Command Description

sgCertifyMgtSrv
[login=<login name>]

[pass=<password>]

[standby-server=<name of
additional Management Server>]

[active-server=<IP address of
active Management Server>]

[-nodisplay]

[-h|-help|-?]

Creates a certificate for the Management Server to allow secure communications
between the SMC components. Renewing an existing certificate does not require
changes on any other SMC components.

In an environment with only one Management Server, or to certify the active
Management Server, stop the Management Server before running the
sgCertifyMgtSrv command. Run the command without parameters. Restart the
Management Server after running this command.

To certify an additional Management Server, stop the additional Management
Server before running the sgCertifyMgtSrv command. The active Management
Server must be running when you run this command. The management database is
replicated to the additional Management Server during the certification. The additional
Management Server must have a connection to the active Management Server when
you run this command.

[login=<login name>] defines the user name for the account that is used for this
operation. If this parameter is not defined, the user name root is used.

[pass=<password>] defines the password for the user account.

[standby-server] specifies the name of the additional Management Server to be
certified.

[active-server] specifies the IP address of the active Management Server.

-nodisplay sets a text-only console.

-h, -help, or -? shows information about using the script.

sgCertifyWebPortalSrv

[host=<Management Server
Address[\Domain]>]

Contacts the Management Server and creates a certificate for the Web Portal Server
to allow secure communications with other SMC components. Renewing an existing
certificate does not require changing the configuration of any other SMC components.

host specifies the address of the Management Server. If the parameter is not
defined, the loopback address (localhost) is used.

Domain specifies the administrative Domain the Web Portal Server belongs to if the
system is divided into administrative Domains. If the Domain is not specified, the
Shared Domain is used.

Stop the Web Portal Server before running this command. Restart the server after
running this command.

sgChangeMgtIPOnLogSrv <IP
address>

Changes the Management Server's IP address in the Log Server's local configuration
to the IP address you give as a parameter.

Use this command if you change the Management Server's IP address. Restart the
Log Server service after running this command.

sgChangeMgtIPOnMgtSrv <IP
address>

Changes the Management Server's IP address in the local configuration to the IP
address you give as a parameter.

Use this command if you change the Management Server's IP address. Restart the
Management Server service after running this command.

sgClient Starts a locally installed Management Client.

sgCreateAdmin Creates an unrestricted (superuser) administrator account.

The Management Server must be stopped before running this command.
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Command Description

sgExport
[host=<Management Server
Address[\Domain]>]

[login=<login name>]

[pass=password]

file=<file path and name>

[type=<all|nw|ips|sv|rb|al|vpn>

[name=<element name 1, element
name 2, ...>]

[recursion]

[-system]

[-h|-help|-?]

Exports elements stored on the Management Server to an XML file.

Enclose details in double quotes if they contain spaces.

host specifies the address of the Management Server. If the parameter is not
defined, the loopback address (localhost) is used.

Domain specifies the administrative Domain for this operation if the system is divided
into administrative Domains. If the Domain is not specified, the Shared Domain is
used.

login defines the user name for the account that is used for this operation. If this
parameter is not defined, the user name root is used.

pass defines the password for the user account.

file defines the name and location of the export .zip file.

type specifies which types of elements are included in the export file:

• all for all exportable elements

• nw for network elements

• ips for IPS elements

• sv for services

• rb for security policies

• al for alerts

• vpn for VPN elements.

name allows you to specify by name the elements that you want to export.

recursion includes referenced elements in the export, for example, the network
elements used in a policy that you export.

-system includes any system elements that are referenced by the other elements in
the export.

-h, -help, or -? shows information about using the script.
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Command Description

sgHA

[host=<Management Server
Address[\Domain]>]

[login=<login name>]

[pass=<password>]

[master=<Management Server
used as master server for the
operation>]

[-set-active]

[-set-standby]

[-check]

[-retry]

[-force]

[-restart]

[-h|-help|-?]

Controls active and standby Management Servers.

If you want to perform a full database synchronization, use the
sgOnlineReplication command.

host specifies the address of the Management Server. If the parameter is not
defined, the loopback address (localhost) is used.

Domain specifies the administrative Domain for this operation if the system is divided
into administrative Domains. If the Domain is not specified, the Shared Domain is
used.

login defines the user name for the account that is used for this operation. If this
parameter is not defined, the user name root is used.

pass defines the password for the user account.

master defines the Management Server used as a master Management Server for
the operation.

-set-active activates and locks all administrative Domains.

-set-standby deactivates and unlocks all administrative Domains.

-check checks that the Management Server's database is in sync with the master
Management Server.

-retry retries replication if this has been stopped due to a recoverable error.

-force enforces the operation even if all Management Servers are not in sync.

Note:  This option can cause instability if used carelessly.

-restart restarts the specified Management Server.

-h, -help, or -? shows information about using the script.

sgImport

[host=<Management Server
Address[\Domain]>]

[login=<login name>]

[pass=<password>]

file=<file path and name>

[-replace_all]

[-h|-help|-?]

Imports Management Server database elements from an XML file.

When importing, existing (non-default) elements are overwritten if both the name and
type match.

host specifies the address of the Management Server. If the parameter is not
defined, the loopback address (localhost) is used.

Domain specifies the administrative Domain for this operation if the system is divided
into administrative Domains. If the Domain is not specified, the Shared Domain is
used.

login defines the user name for the account that is used for this operation. If this
parameter is not defined, the user name root is used.

pass defines the password for the user account.

file defines the .zip file whose contents you want to import.

-replace_all ignores all conflicts by replacing all existing elements with new ones.

-h, -help, or -? shows information about using the script.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Command line tools | 1416

Command Description

sgImportExportUser

[host=<<Management Server
Address[\Domain]>>]

[login=<login name>]

[pass=password]

action=<import|export>

file=<file path and name>

[-h|-help|-?]

Imports and exports a list of Users and User Groups in an LDIF file from/to a
Management Server's internal LDAP database.

To import User Groups, all User Groups in the LDIF file must be directly under the
stonegate top-level group (dc=stonegate).

CAUTION:  The user information in the export file is stored as plaintext.
Handle the file securely.

host specifies the address of the Management Server. If the parameter is not
defined, the loopback address (localhost) is used.

Domain specifies the administrative Domain for this operation if the system is divided
into administrative Domains. If the Domain is not specified, the Shared Domain is
used.

login defines the user name for the account that is used for this operation. If this
parameter is not defined, the user name root is used.

pass defines the password for the user account.

action defines whether users are imported or exported.

file defines the file that is used for the operation.

Example: sgImportExportUser login=admin pass=abc123 action=export
file=c:\temp\exportedusers.ldif

-h, -help, or -? shows information about using the script.

sgInfo

SG_ROOT_DIR

FILENAME

[fast=<timestamp>]

[list]

[hprof=none|limited|all]

[-nolog]

[-client]

[-h|-help|-?]

Creates a .zip file that contains copies of configuration files and the system trace files.

The resulting .zip file is stored in the logged on user's home directory. The file location
is shown on the last line of screen output. Provide the generated file to support for
troubleshooting purposes.

SG_ROOT_DIR SMC installation directory.

FILENAME name of output file.

fast collects only traces that changed after the specified time stamp. Enter the time
stamp in milliseconds or in the format yyyy-MM-dd HH:mm:ss. No other information is
collected, except for threaddumps.

[list] only lists files. It does not create a .zip file or generate threaddumps.

hprof defines whether hprof memory dump files are included.

• none does not include hprof memory dump files.

• limited includes only hprof memory dump files that are created with makeheap.

• all includes memory dump files that are created with makeheap and java_pid.

-nolog extended Log Server information is not collected.

-client collects traces only from the Management Client.

-h, -help, or -? shows information about using the script.
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Command Description

sgOnlineReplication

[active-server=<name of active
Management Server>]

[-nodisplay]

[-h|-help|-?]

Replicates the Management Server's database from the active Management Server to
an additional Management Server.

Stop the Management Server to which the database is replicated before running this
command. Restart the Management Server after running this command.

Use this script to replicate the database only in the following cases:

• The additional Management Server's configuration has been corrupted.

• In new SMC installations if the automatic database replication between the
Management Servers has not succeeded.

Otherwise, synchronize the database through the Management Client.

CAUTION:  This script also has parameters that are for the internal
use of the Management Server only. Do not use this script with any
parameters other than the ones listed here.

active-server specifies the IP address of the active Management Server from
which the Management database is replicated.

-nodisplay sets a text-only console.

-h, -help, or -? shows information about using the script.

sgReinitializeLogServer Creates a Log Server configuration if the configuration file has been lost.

Note:  This script is located in <installation directory>/bin/install.

sgRestoreArchive <ARCHIVE_DIR> Restores logs from archive files to the Log Server.

This command is available only on the Log Server.

ARCHIVE_DIR is the number of the archive directory (0–31) from where the logs will
be restored. By default, only archive directory 0 is defined. The archive directories
can be defined in the <installation directory>/data/LogServerConfiguration.txt file:
ARCHIVE_DIR_ xx=PATH.

sgRestoreLogBackup

[-pwd=<password>]

[-backup=<backup file name>]

[-nodiskcheck]

[-overwrite-syslog-template]

[-h|-help]

Restores the Log Server (logs or configuration files) from a backup file in the
<installation directory>/backups/ directory.

-pwd defines a password for encrypted backup.

-backup defines a name for the backup file.

-nodiskcheck ignores the free disk check before backup restoration.

-overwrite-syslog-template overwrites a syslog template file if found in the
backup.

-h or -help shows information about using the script.

sgRestoreMgtBackup

[-pwd=<password>]

[-backup=<backup file name>]

[-import-license <license file
name>]

[-nodiskcheck]

[-h|-help]

Restores the Management Server (database or configuration files) from a backup file
in the <installation directory>/backups/ directory.

-pwd defines a password for encrypted backup.

-backup defines a name for the backup file.

-import-license specifies a license file to import during the backup restoration.

-nodiskcheck ignores the free disk check before backup restoration.

-h or -help shows information about using the script.
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Command Description

sgRevert Reverts to the previous installation saved during the upgrade process.

The previous installation can be restored at any time, even after a successful upgrade.

Note:  This script is located in <installation directory>/bin/uninstall.

sgShowFingerPrint Shows the CA certificate's fingerprint on the Management Server.

sgStartLogSrv Starts the Log Server and its database.

sgStartMgtDatabase Starts the Management Server's database.

There is usually no need to use this script.

sgStartMgtSrv Starts the Management Server and its database.

sgStartWebPortalSrv Starts the Web Portal Server.

sgStopLogSrv Stops the Log Server.

sgStopMgtSrv Stops the Management Server and its database.

sgStopMgtDatabase Stops the Management Server's database.

There is usually no need to use this script.

sgStopWebPortalSrv Stops the Web Portal Server.

sgStopRemoteMgtSrv

[host=<Management Server
address[\Domain]>]

[login=<login name>]

[pass=<password>]

[-h|-help|-?]

Stops the Management Server service when run without arguments.

To stop a remote Management Server service, provide the arguments to connect to
the Management Server.

host is the Management Server's host name if not localhost.

login is an SMC administrator account for the logon.

pass is the password for the administrator account.

-h, -help, or -? shows information about using the script.
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Command Description

sgTextBrowser
[host=<Management Server
address[\Domain]>]

[login=<login name>]
[pass=<password>]

[format=<CSV|XML>]
[o=<output file>]

[f=<filter file>]
[e=<filter expression>]

[m=<current|stored>]
[limit=<maximum number of
unique records to fetch>]

[-h|-help|-?]

Shows or exports current or stored logs.

This command is available on the Log Server.

Enclose the file and filter names in double quotes if they contain spaces.

host defines the address of the Management Server used for checking the logon
information. If this parameter is not defined, Management Server is expected to be
on the same host where the script is run. If Domains are in use, you can specify the
Domain the Log Server belongs to. If domain is not specified, the Shared Domain is
used.

login defines the user name for the account that is used for this export. If this
parameter is not defined, the user name root is used.

pass defines the password for the user account used for this operation.

format defines the file format for the output file. If this parameter is not defined, the
XML format is used.

o defines the destination output file where the logs will be exported. If this parameter
is not defined, the output is shown on screen.

f defines the exported filter file that you want to use for filtering the log data.

e defines the filter that you want to use for filtering the log data. Type the name as
shown in the Management Client.

m defines whether you want to view or export logs as they arrive on the Log Server
(current) or logs stored in the active storage directory (stored). If this option is not
defined, the current logs are used.

limit defines the maximum number of unique records to be fetched. The default
value is unlimited.

-h, -help, or -? shows information about using the script.

smca-agent

(SMC Appliance only)

SMC uses it to exchange configuration data between SMC and the operating system;
not normally used by administrators. The agent configures the NTP and SNMP
daemons and sets the logon and SSH banners.

smca-backup

(SMC Appliance only)

[-pwd <password>]

[-comment <comment>]

[-nodiskcheck]

[-nofsstorage]

[-path <destination>]

[-log]

[-mgt]

[-h|--help]

Creates a configuration backup of the SMC Appliance operating system and includes
an SMC backup.

-pwd <password> enables the encryption of the backup file and sets the password.

-comment <comment> adds a comment to the backup file name.

-nodiskcheck turns off the available disk space check.

-nofsstorage excludes the log files for the Log Server from the backup.

-path <destination> specifies a path for backup file storage. The default
directory for backups is /usr/local/forcepoint/smc/backups.

-log creates a Log Server backup.

-mgt creates a Management Server backup.

-h, --help shows information about the command.

Also see sgRestoreLogBackup and sgRestoreMgtBackup.
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Command Description

smca-cifs

(SMC Appliance only)

[add]

[remove]

[-n <name>]

[-s //<server>/<share>]

[-u <username>]

[-p <password>]

[-d <domain>]

Configures the mounting of remote CIFS file shares on the SMC Appliance.

add adds the CIFS share.

remove removes the CIFS share. Use with the name option.

-n <name> specifies the name of the share.

-s //<server>/<share> specifies the server or IP address of the share.

-u <username> specifies the user name to authenticate with the CIFS server to get
access to the share.

-p <password> specifies the password on remote system.

-d <domain> specifies the domain of the share.

smca-restore

(SMC Appliance only)

[-pwd <password>]

[-nodiskcheck]

[-backup <filename>]

[-nosmca]

[-smcaonly]

[-overwrite-syslog-template]

[-h|-help]

Restores a backup on the SMC Appliance.

-pwd <password> specifies the password for decrypting an encrypted backup file.

-nodiskcheck turns off the available disk space check.

-backup <filename> specifies the backup file name. If you do not specify the
backup file name, you are prompted to select the backup file.

[-nosmca] restores the Management Server or Log Server backup without restoring
the SMC Appliance configuration

[-smcaonly] restores the SMC Appliance configuration without restoring the
Management Server or Log Server backup.

-overwrite-syslog-template overwrites any existing syslog templates in the log
backup file.

-h, --help shows information about the command.

smca-rsync

(SMC Appliance only)

[add]

[modify]

[remove]

[enable]

[disable]

[list]

[run]

[-t task_id]

[-i <source directory>]

[-o <destination directory>]

[-m <mode>]

[-h|-help]

Configures automated backup tasks. Typically used with the smca-cifs command to
move backups off the appliance.

add adds a backup task. You can specify an existing source and destination
directories. If not specified, the default is /usr/local/forcepoint/smc/backups/.

modify changes an existing backup task by its task ID. All attributes can be changed,
except for the task ID. To change an attribute, use the appropriate option with a new
value.

remove removes an existing backup task by its task ID.

enable enables an existing backup task by its task ID.

disable disables an existing backup task by its task ID.

list provides a list of all configured backup tasks.

run runs all enabled backup tasks.

-t task_id specifies the task ID. Use the list command to view the task IDs.

-i <source directory> specifies the directory where the backups are stored
when they are created. If omitted, the source directory defaults to the SMC backups
directory /usr/local/forcepoint/smc/backups/.

-o <destination directory> specifies the remote location to store the backups.

-m <mode> specifies the rsync mode. You can indicate whether rsync appends or
mirrors the source directory to the destination directory. Appending the directory
means that existing files in the destination directory, that are not in the source
directory or are newer than those files in the source directory, are not changed. If
omitted, the mode defaults to append.

-h, --help shows information about the command.
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Command Description

smca-system

(SMC Appliance only)

[toggle]

[toggle-vcdrom]

[mirror [-n <name>]]

[snapshot [-C|--create] [-R|--
restore] [-D, --delete] [-n
<name>]]

[serial-number]

[fingerprint]

[toggle-console]

[bootloader-password [-s|--set]
[-r|--remove]]

[netconfig]

[fips-config]

[-f]

[-h|-help]

Manages recovery snapshots, alternate partition mirroring, and changing system
partition boot preference.

toggle restarts the appliance to the alternate partition.

toggle-vcdrom sets the appliance's default boot option to the vcdrom.

mirror mirrors the active system to the alternate system. -n <name> specifies the
name of the snapshot used for mirror operations.

snapshot manages recovery snapshots.

• -C, --create creates a snapshot.

• -D, --delete deletes the snapshot.

• -R, --restore restores the snapshot.

• -n <name> specifies the name of the snapshot used for snapshot operations.

[serial-number] shows the hardware serial number for the SMC Appliance.

[fingerprint] shows the fingerprint for the CA used by the Management Client.

toggle-console enables or disables the serial console on the SMC Appliance.

bootloader-password manages the bootloader password for the SMC Appliance.

• -s, --set sets or changes the bootloader password.

• -r, --remove removes the bootloader password.

netconfig sets up network-related configuration, such as IPv6 configuration.

fips-config modifies the SMC Appliance configuration to support FIPS
certification.

-f forces the procedure, does not prompt for any confirmation.

-h, --help shows information about the command.

smca-user

(SMC Appliance only)

This utility is used by the SMC Appliance to keep user accounts in sync between the
SMC and the operating system; not normally used by administrators.

Forcepoint NGFW Engine commands
There are commands that can be run on the command line on Firewall, Layer 2 Firewall, IPS engines, or Master
NGFW Engines.

Note:  Using the Management Client is the recommended configuration method, as most of the
same tasks can be done through it.

Note:  All command line tools that are available for single NGFW Engines are also available
for Virtual NGFW Engines that have the same role. However, there is no direct access to the
command line of Virtual NGFW Engines. Commands to Virtual NGFW Engines must be sent from
the command line of the Master NGFW Engine using the se-virtual-engine command.
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Table 155: Forcepoint NGFW command line tools

Command Engine role Description

sg-blacklist

show [-v] [-f
FILENAME ] |

add [

[-i FILENAME]|

[src IP_ADDRESS/MASK]

[src6 IPv6_ADDRESS/
PREFIX]

[dst IP_ADDRESS/MASK]

[dst6 IPv6_ADDRESS/
PREFIX]

[proto {tcp|udp|icmp|
NUM}]

[srcport PORT {-PORT}]

[dstport PORT {-PORT}]

[duration NUM]

] |

del [

[-i FILENAME]|

[src IP_ADDRESS/MASK]

[src6 IPv6_ADDRESS/
PREFIX]

[dst IP_ADDRESS/MASK]

[dst6 IPv6_ADDRESS/
PREFIX]

[proto {tcp|udp|icmp|
NUM}]

[srcport PORT{-PORT}]

[dstport PORT{-PORT}]

[duration NUM]

] |

iddel NODE_ID ID |

flush

Firewall

Layer 2 Firewall

IPS

Used to view, add, or delete active blacklist entries.

The blacklist is applied as defined in Access Rules.

show displays the current active blacklist entries in format: engine node ID
| blacklist entry ID | (internal) | entry creation time | (internal) | address and
port match | originally set duration | (internal) | (internal). Use the -f option to
specify a storage file to view (/data/blacklist/db_<number>). The -v option
adds operation's details to the output.

add creates a blacklist entry. Enter the parameters or use the -i option to
import parameters from a file.

del deletes the first matching blacklist entry. Enter the parameters or use the
-i option to import parameters from a file.

iddel removes one specific blacklist entry on one specific engine. NODE_ID
is the engine's ID, ID is the blacklist entry's ID (as shown by the show
command).

flush deletes all blacklist entries.

Add/Del Parameters:

Enter at least one parameter. The default value is used for the parameters that
you omit. You can also save parameters in a text file; each line in the file is
read as one blacklist entry.

src defines the source IP address and netmask to match. Matches any IP
address by default.

src6 defines the source IPv6 and prefix length to match. Matches any IPv6
address by default.

dst defines the destination IP address and netmask to match. Matches any IP
address by default.

dst6 defines the destination IPv6 address and prefix length to match.
Matches any IPv6 address by default.

proto defines the protocol to match by name or protocol number. Matches all
IP traffic by default.

srcport defines the TCP/UDP source port or range to match. Matches any
port by default.

dstport defines the TCP/UDP destination port or range to match. Matches
any port by default.

duration defines in seconds how long the entry is kept. Default is 0, which
cuts current connections, but is not kept.

Examples:

sg-blacklist add src 192.168.0.2/32 proto tcp dstport 80
duration 60

sg-blacklist add -i myblacklist.txt

sg-blacklist del dst 192.168.1.0/24 proto 47
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Command Engine role Description

sg-bootconfig

[--primary-
console=tty0|ttyS
PORT,SPEED]

[--secondary-
console=[tty0|ttyS
PORT,SPEED]]

[--flavor=up|smp]

[--initrd=yes|no]

[--crashdump=yes|no|
Y@X]

[--append=kernel
options]

[--help]

apply

Firewall

Layer 2 Firewall

IPS

Used to edit boot command parameters for future bootups.

--primary-console defines the terminal settings for the primary console.

--secondary-console defines the terminal settings for the secondary
console.

--flavor defines whether the kernel is uniprocessor or multiprocessor.

--initrd defines whether Ramdisk is enabled or disabled.

--crashdump defines whether kernel crashdump is enabled or disabled, and
how much memory is allocated to the crash dump kernel (Y). The default is
24M. X must always be 16M.

--append defines any other boot options to add to the configuration.

--help displays usage information.

apply applies the specified configuration options.

sg-clear-all
[--help]

[--flash-defaults]

[--dry-run]

[--on-boot]

[--reboot | --shutdown]

[--fast] | --wipe
<number>]

[--debug | --verbose]

Firewall

Layer 2 Firewall

IPS

This command restores the factory default settings on the engine.
[--help] displays usage information.

[--flash-defaults] assumes that the engine has a flash data partition
and a RAM spool partition.

[--dry-run] exits without shutting down or restarting when command
execution finishes.

[--on-boot] indicates that engine is starting up. This option is not intended
to be used in normal command line usage.

[--reboot] the engine always restarts when command execution finishes.

[--shutdown] the engine always shuts down when command execution
finishes.

[--fast] runs a minimal, non-interactive clear for testing purposes.

[--wipe <number>] globally specifies the number of times to wipe
partitions.

[--debug] shows full debug messages during command execution.

[--verbose] shows additional informational messages during command
execution.

Note:  If you run the command without specifying any options,
the engine requests confirmation before restarting. When the
engine restarts, you are prompted to select the system restore
options.

After using this command, you can reconfigure the engine using the sg-
reconfigure command.
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Command Engine role Description

sg-cluster

[-v <virtual engine
ID>]

[status [-c SECONDS]]

[versions]

[online]

[lock-online]

[offline]

[lock-offline]

[standby]

[safe-offline]

[force-offline]

Firewall

Layer 2 Firewall

IPS

Used to display or change the status of the node.

-v (Master NGFW Engine only) specifies the ID of the Virtual NGFW Engine
on which to execute the command.

status displays cluster status. When -c SECONDS is used, the status is
shown continuously with the specified number of seconds between updates.

version displays the engine software versions of the nodes in the cluster.

online sends the node online.

lock-online sends the node online and keeps it online, even if another
process tries to change its state.

offline sends the node offline.

lock-offline sends the node offline and keeps it offline, even if another
process tries to change its state.

standby sets an active node to standby.

safe-offline sets the node to offline only if there is another online node.

force-offline sets the node online regardless of state or any limitations.
Also sets all other nodes offline.

sg-contact-mgmt Firewall

Layer 2 Firewall

IPS

Used for establishing a trust relationship with the Management Server as part
of engine installation or reconfiguration (see sg-reconfigure).

The engine contacts the Management Server using the one-time password
created when the engine's initial configuration is saved.

sg-dynamic-routing

[start]

[stop]

[restart]

[force-reload]

[backup <file>]

[restore <file>]

[sample-config]

[route-table]

[info]

Firewall start starts the Quagga routing suite.

stop stops the Quagga routing suite and flushes all routes made by zebra.

restart restarts the Quagga routing suite.

force-reload forces reload of the saved configuration.

backup backs up the current configuration to a compressed file.

restore restores the configuration from the specified file.

sample-config creates a basic configuration for Quagga.

route-table prints the current routing table.

info displays the help information for the sg-dynamic-routing command,
and detailed information about Quagga suite configuration with vtysh.

sg-ipsec -d

[-u <username[@domain]>
|

-si <session id>|

-ck <ike cookie> |

-tri <transform id> |

-ri <remote ip> |

-ci <connection id>]

Firewall Deletes VPN-related information (use the vpntool command to view the
information). Option -d (for delete) is mandatory.

-u deletes the VPN session of the named VPN client user. You can enter
the user account in the form <user_name@domain> if there are several user
storage locations (LDAP domains).

-si deletes the VPN session of a VPN client user based on session identifier.

-ck deletes the IKE SA (Phase one security association) based on IKE
cookie.

-tri deletes the IPSEC SAs (Phase two security associations) for both
communication directions based on transform identifier.

-ri deletes all SAs related to a remote IP address in site-to-site VPNs.

-ci deletes all SAs related to a connection identifier in site-to-site VPNs.
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Command Engine role Description

sg-logger

-f FACILITY_NUMBER

-t TYPE_NUMBER

[-e EVENT_NUMBER]

[-i "INFO_STRING"]

[-s]

[-h]

Firewall

Layer 2 Firewall

IPS

Used in scripts to create log messages with the specified properties.

-f defines the facility for the log message.

-t defines the type for the log message.

-e defines the log event for the log message. The default is 0
(H2A_LOG_EVENT_UNDEFINED).

-i defines the information string for the log message.

-s dumps information about option numbers to stdout

-h displays usage information.

sg-raid

[-status] [-add] [-re-
add]

[-force] [-help]

Firewall

Layer 2 Firewall

IPS

Configures a new hard drive.

This command is only for Forcepoint NGFW appliances that support RAID
(Redundant Array of Independent Disks) and have two hard drives.

-status displays the status of the hard drive.

-add adds a new empty hard drive. Use -add -force if you want to add a
hard drive that already contains data and you want to overwrite it.

-re-add adds a hard drive that is already partitioned. This command prompts
for the drive and partition for each degraded array. Use -re-add -force if
you want to check all arrays.

-help displays usage information.

sg-reconfigure

[--maybe-contact]

[--no-shutdown]

[--stop-autocontact]

Firewall

Layer 2 Firewall

IPS

Starts the NGFW Initial Configuration Wizard. Used for reconfiguring the node
manually.

CAUTION:  This script also has parameters that are for the
internal use of the engine only. Do not use this script with any
parameters other than the ones listed here.

--maybe-contact contacts the Management Server if requested. This
option is only available on firewall engines.

--no-shutdown allows you to make limited configuration changes on the
node without shutting it down. Some changes might not be applied until the
node is rebooted.

--stop-autocontact (unconfigured Forcepoint NGFW appliances with
valid POS codes only) prevents the engine from contacting the installation
server for plug-and-play configuration when it reboots.

sg-selftest [-d] [-h] Firewall Runs cryptography tests on the engine.

-d runs the tests in debug mode.

-h displays usage information.

sg-status [-l] [-h] Firewall

Layer 2 Firewall

IPS

Displays information about the engine's status.

-l displays all available information about engine status.

-h displays usage information.
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Command Engine role Description

sg-toggle-active

SHA1 SIZE |

--force [--debug ]

Firewall

Layer 2 Firewall

IPS

Switches the engine between the active and the inactive partition.

This change takes effect when you reboot the engine.

You can use this command, for example, if you have upgraded an engine
and want to switch back to the earlier engine version. When you upgrade the
engine, the active partition is switched. The earlier configuration remains on
the inactive partition. To see the currently active (and inactive) partition, see
the directory listing of /var/run/stonegate (ls -l /var/run/stonegate).

The SHA1 option is used to verify the signature of the inactive partition before
changing it to active. If you downgrade the engine, check the checksum and
the size of the earlier upgrade package by extracting the signature and size
files from the sg_engine_[version.build]_i386.zip file.

--debug reboots the engine with the debug kernel.

--force switches the active configuration without first verifying the signature
of the inactive partition.

sg-upgrade Firewall Upgrades the node by rebooting from the installation DVD.

Alternatively, the node can be upgraded remotely using the Management
Client.

sg-version Firewall

Layer 2 Firewall

IPS

Displays the software version and build number for the node.

se-virtual-engine

-l | --list

-v <virtual engine ID>

-e | --enter

-E "<command
[options]>"

-h | --help

Firewall (Master
NGFW Engine
only)

Used to send commands to Virtual Firewalls from the command line of the
Master NGFW Engine.

All commands that can be used for the Firewall role can also be used for
Virtual Firewalls.

-l or --list  list the active Virtual NGFW Engines.

-v specifies the ID of the Virtual NGFW Engine on which to execute the
command.

-e or --enter enters the command shell for the Virtual NGFW Engine
specified with the -v option. To exit the command shell, type exit.

-E executes the specified command on the Virtual NGFW Engine specified
with the -v option.

-h or --help displays usage information.

sginfo

[-f]

[-d]

[-s]

[-p]

[--]

[--help]

Firewall

Layer 2 Firewall

IPS

Gathers system information you can send to Forcepoint support.

Use this command only when instructed to do so by Forcepoint support.

-f forces sgInfo even if the configuration is encrypted.

-d includes core dumps in the sgInfo file.

-s includes slapcat output in the sgInfo file.

-p includes passwords in the sgInfo file (by default passwords are erased
from the output).

-- creates the sgInfo file without displaying the progress.

--help displays usage information.

The following table lists some general Linux operating system commands that can be useful in running your
engines. Some commands can be stopped by pressing Ctrl+C.

https://support.forcepoint.com
https://support.forcepoint.com
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Table 156: General command line tools on engines

Command Description

dmesg Shows system logs and other information.

Use the -h option to see usage.

halt Shuts down the system.

ip Displays IP address information.

Type the command without options to see usage.

Example: type ip addr for basic information about all interfaces.

ping Tests connectivity with ICMP echo requests.

Type the command without options to see usage.

ps Reports the status of running processes.

reboot Reboots the system.

scp Secure copy.

Type the command without options to see usage.

sftp Secure FTP.

Type the command without options to see usage.

ssh SSH client (for opening a terminal connection to other hosts).

Type the command without options to see usage.

tcpdump Gives information about network traffic.

Use the -h option to see usage.

You can also analyze network traffic by creating tcpdump files from the Management Client with the Traffic
Capture feature.

top Displays the top CPU processes taking most processor time.

Use the -h option to see usage.

traceroute Traces the route packets take to the specified destination.

Type the command without options to see usage.

vpntool Displays VPN information and allows you to issue some basic commands.

Type the command without options to see usage.
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Server Pool Monitoring Agent
commands

You can test and monitor the Server Pool Monitoring Agents on the command line.

Table 157: Server Pool Monitoring Agent commands

Command Description

agent

[-v level]

[-c path]

[test [files]]

[syntax [files]]

(Windows only) Allows you to test different configurations before activating them.

-v sets the verbosity level. The default level is 5. Levels 6–8 are for debugging where available.

-c uses the specified path as the first search directory for the configuration.

test runs in the test mode - status queries do not receive a response. If you specify the files,
they are used for reading the configuration instead of the default files.

syntax checks the syntax in the configuration file. If no files are specified, the default
configuration files are checked.

sgagentd [-d]

[-v level]

[-c path]

[test [files]]

[syntax [files]]

(Linux only) Allows you to test different configurations before activating them.

-d means Don't Fork as a daemon. All log messages are printed to stdout or stderr only.

-v sets the verbosity level. The default level is 5. Levels 6–8 are for debugging where available.

-c  uses the specified path as the first search directory for the configuration.

test runs in the test mode - status queries do not receive a response. If you specify the files,
they are used for reading the configuration instead of the default files. The output is directed to
syslog or eventlog instead of the console where the command was run unless you use the -d
option.

syntax checks the syntax in the configuration file. If no files are specified, the default
configuration files are checked. The output is directed to syslog or eventlog instead of the
console where the command was run unless you use the -d option.

sgmon

[status|info|proto]

[-p port]

[-t timeout]

[-a id]

host

Sends a UDP query to the specified host and waits for a response until received, or until the
timeout limit is reached. The request type can be defined as a parameter. If no parameter is
given, status is requested. The commands are:
status queries the status.

info queries the agent version.

proto queries the highest supported protocol version.

-p connects to the specified port instead of the default port.

-t sets the timeout (in seconds) to wait for a response.

-a acknowledge the received log messages up to the specified id. Each response message
has an id, and you can acknowledge more than one message at a given time by using the id
parameter. Messages acknowledged by sgmon will no longer appear in the firewall logs.

host is the IP address of the host to connect to. To get the status locally, you can give localhost
as the host argument. This parameter is mandatory.
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 Appendix B

Default communication ports
Contents

• Security Management Center ports on page 1429
• Forcepoint NGFW Engine ports on page 1432

There are default ports used in connections between SMC components and default ports that SMC components use
with external components.

Security Management Center ports
The most important default ports used in communications to and from SMC components are presented in the
following illustrations.

 
Figure 175: Destination ports for basic communications within the SMC
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Figure 176: Default destination ports for optional SMC components and features

This table lists the default ports SMC uses internally and with external components. Many of these ports can be
changed. The names of corresponding default Service elements are also included for your reference.

Table 158: SMC default ports

Listening host Port/protocol Contacting hosts Service description Service element name

Additional
Management
Servers

8902- 8913/TCP Management Server Database replication (push) to the
additional Management Server.

SG Control

DNS server 53/UDP, 53/TCP Management Client,
Management Server, Log
Server

DNS queries. DNS (UDP)

LDAP server 389/TCP Management Server External LDAP queries for display/
editing in the Management Client.

LDAP (TCP)

Log Server 162/UDP, 5162/
UDP

Monitored third-party
components

SNMPv1 trap reception from third-
party components.

Port 162 is used if installed on
Windows, port 5162 if installed on
Linux.

SNMP (UDP)

Log Server 514/TCP, 514/
UDP, 5514/TCP,
5514/UDP

Monitored third-party
components

Syslog reception from third-party
components.

Port 514 is used if installed on
Windows, port 5514 if installed on
Linux.

Syslog (UDP) [Partial
match]
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Listening host Port/protocol Contacting hosts Service description Service element name

Log Server 2055/UDP Monitored third-party
components

NetFlow or IPFIX reception from
third-party components. Port 2055
is used in both Windows and Linux.

NetFlow (UDP)

Log Server 3020/TCP Log Server, Web Portal
Server, NGFW Engines

Alert sending from the Log Server
and Web Portal Server.

Log and alert messages; monitoring
of blacklists, connections, status,
and statistics from NGFW Engines.

SG Log

Log Server 8914-8918/TCP Management Client Log browsing. SG Data Browsing

Log Server 8916-8917/TCP Web Portal Server Log browsing. SG Data Browsing (Web
Portal Server)

Management
Server

3021/TCP Log Server, Web Portal
Server

System communications certificate
request/renewal.

SG Log Initial Contact

Management
Server

8902-8913/TCP Management Client, Log
Server, Web Portal Server

Monitoring and control connections. SG Control

Management
Server

3023/TCP Additional Management
Servers, Log Server, Web
Portal Server

Log Server and Web Portal Server
status monitoring.

Status information from an
additional Management Server to
the active Management Server.

SG Status Monitoring

Management
Server

8903, 8907/TCP Additional Management
Servers

Database replication (pull) to the
additional Management Server.

SG Control

Monitored
third-party
components

161/UDP Log Server SNMP status probing to external IP
addresses.

SNMP (UDP)

NTP server 123/TCP or UDP SMC Appliance Receiving NTP information. NTP

RADIUS server 1812/UDP Management Server RADIUS authentication requests for
administrator logon.

The default ports can be edited
in the properties of the RADIUS
Server element.

RADIUS (Authentication)

Forcepoint
NGFW update
service

443/TCP SMC servers Update packages, engine
upgrades, and licenses.

HTTPS

SMC Appliance 161/UDP Third-party components Requesting health and other
information about the SMC
Appliance.

SNMP

Update servers 443/TCP SMC Appliance Receiving appliance patches and
updates.

HTTPS

SMC Appliance 22/TCP Terminal clients SSH connections to the command
line of the SMC Appliance.

Note:  Do not use SSH
in FIPS mode.

SSH
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Listening host Port/protocol Contacting hosts Service description Service element name

Syslog server 514/UDP, 5514/
UDP

Log Server Log data forwarding to syslog
servers.

The default ports can be edited in
the LogServerConfiguration.txt file.

Syslog (UDP) [Partial
match]

Terminal Client

Firewall, Layer
2 Firewall, IPS,
Master NGFW
Engine

22/TCP SMC Appliance Contacting engines and moving
SMC Appliance backups off the
appliance.

Note:  Do not use SSH
in FIPS mode.

SSH

Third-party
components

2055/UDP Log Server NetFlow or IPFIX forwarding to
third-party components.

Port 2055 is used in both Windows
and Linux.

NetFlow (UDP)

Third-party
components

162/UDP SMC Appliance Sending SNMP status probing to
external devices.

SNMP

Third-party
components

445/TCP SMC Appliance Moving SMC Appliance backups off
the appliance.

Note:  You cannot use
CIFS in FIPS mode.

CIFS

Web Portal
Server

8931/TCP Log Server Connections from the Log Server to
the Web Portal Server

SG Web Portal Control

Forcepoint NGFW Engine ports
The most important default ports used in communications to and from NGFW Engines and Master NGFW
Engines are presented in the following illustrations.

See the table for a complete list of default ports for the engines.

Note:  Master NGFW Engines use the same default ports as clustered NGFW Engines. Virtual
NGFW Engines do not communicate directly with other system components.
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Figure 177: Destination ports for basic NGFW Engine communications

 
Figure 178: Default destination ports for NGFW Engine service communications

This table lists the default ports for NGFW Engines and Master NGFW Engines. Many of these ports can be
changed. The names of corresponding default Service elements are also included for your reference.
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Table 159: NGFW Engine and Master NGFW Engine default ports

Listening host Port/protocol Contacting hosts Service description Service element name

Certificate
Revocation List
(CRL) server

80/TCP Firewall Online certificate status protocol
(OCSP) queries and fetching CRLs.

HTTP

DHCP server 67/UDP Firewall Relayed DHCP requests and
requests from a firewall that uses
dynamic IP address.

BOOTPS (UDP)

DHCPv6 server 547/UDP Firewall Requests from a firewall that uses
dynamic IPv6 address.

N/A

External DNS
server

53/UDP, 53/TCP Firewall, Master NGFW
Engine

DNS resolution and dynamic DNS
updates.

DNS (TCP), DNS (UDP)

File reputation
server

443/TCP Firewall, Layer 2 Firewall,
IPS, Master NGFW
Engine

GTI File Reputation Server HTTPS

Firewall 67/UDP Any DHCP relay on firewall engine. BOOTPS (UDP)

Firewall 68/UDP DHCP server Replies to DHCP requests. BOOTPC (UDP)

Firewall 80/TCP Clients that need to
authenticate to the
Firewall

Browser Based User Authentication HTTP

Firewall 443/TCP Clients that need to
authenticate to the
Firewall

Browser Based User Authentication HTTPS

Firewall 443/TCP VPN clients using SSL
tunneling

VPN client SSL tunneling TLS

Firewall 443/TCP SSL Portal users SSL VPN Portal HTTPS

Firewall 546/UDP DHCPv6 server Replies to DHCPv6 requests. N/A

Firewall, Master
NGFW Engine

53/UDP, 53/TCP Clients in the internal
network

DNS relay DNS (TCP), DNS (UDP)

Firewall, Master
NGFW Engine

500/UDP VPN clients, VPN
gateways

VPN negotiations, VPN traffic. ISAKMP (UDP)

Firewall, Master
NGFW Engine

636/TCP Management Server Internal user database replication. LDAPS (TCP)

Firewall, Master
NGFW Engine

4500/UDP VPN client, VPN
gateways

VPN traffic using NAT-traversal. NAT-T

Firewall Cluster
Node, Master
NGFW Engine
cluster node

3000-3001/UDP,
3002–3003,
3010/TCP

Firewall Cluster Node,
Master NGFW Engine
cluster node

Heartbeat and state
synchronization between clustered
Firewalls.

SG State Sync
(Multicast), SG State
Sync (Unicast), SG Data
Sync

Firewall, Layer
2 Firewall, IPS,
Master NGFW
Engine

22/TCP Terminal clients SSH connections to the engine
command line.

Note:  Do not use SSH
in FIPS mode.

SSH
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Listening host Port/protocol Contacting hosts Service description Service element name

Firewall, Layer
2 Firewall, IPS,
Master NGFW
Engine

4950/TCP Management Server Remote upgrade. SG Remote Upgrade

Firewall, Layer
2 Firewall, IPS,
Master NGFW
Engine

4987/TCP Management Server Management Server commands
and policy upload.

SG Commands

Firewall, Layer
2 Firewall, IPS,
Master NGFW
Engine

15000/TCP Management Server, Log
Server

Blacklist entries. SG Blacklisting

Firewall, Layer
2 Firewall, IPS,
Master NGFW
Engine

161/UDP SNMP server SNMP monitoring. SNMP (UDP)

IPS Cluster
Node

3000-3001/UDP,
3002–3003,
3010/TCP

IPS Cluster Node Heartbeat and state
synchronization between clustered
IPS engines.

SG State Sync
(Multicast), SG State
Sync (Unicast), SG Data
Sync

LDAP server 389/TCP Firewall, Master NGFW
Engine

External LDAP queries, including
StartTLS connections.

LDAP (TCP)

Layer 2 Firewall
Cluster Node

3000-3001/UDP,
3002–3003,
3010/TCP

Layer 2 Firewall Cluster
Node

Heartbeat and state
synchronization between clustered
Layer 2 Firewalls.

SG State Sync
(Multicast), SG State
Sync (Unicast), SG Data
Sync

Log Server 3020/TCP Firewall, Layer 2 Firewall,
IPS, Master NGFW
Engine

Log and alert messages; monitoring
of blacklists, connections, status,
and statistics.

SG Log

Malware
signature server

80/TCP Firewall, Layer 2 Firewall,
IPS, Master NGFW
Engine

Malware signature update service. HTTP

Management
Server

3021/TCP Firewall, Layer 2 Firewall,
IPS, Master NGFW
Engine

System communications certificate
request/renewal (initial contact).

SG Initial Contact

Management
Server

8906/TCP Firewall, Layer 2 Firewall,
IPS

Management connection for single
engines with "Node-Initiated
Contact to Management Server"
selected.

SG Dynamic Control

RADIUS server 1812, 1645/UDP Firewall, Master NGFW
Engine

RADIUS authentication requests. RADIUS (Authentication),
RADIUS (Old)

RPC server 111/UDP, 111/
TCP

Firewall, Master NGFW
Engine

RPC number resolve. SUNRPC (UDP), Sun
RPC (TCP)

Server Pool
Monitoring
Agents

7777/UDP Firewall, Master NGFW
Engine

Polls to the servers' Server Pool
Monitoring Agents for availability
and load information.

SG Server Pool
Monitoring

SNMP server 162/UDP Firewall, Layer 2 Firewall,
IPS, Master NGFW
Engine

SNMP traps from the engine. SNMP Trap (UDP)
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Listening host Port/protocol Contacting hosts Service description Service element name

TACACS+
server

49/TCP Firewall, Master NGFW
Engine

TACACS+ authentication requests. TACACS (TCP)

ThreatSeeker
Intelligence
Cloud server

443/TCP Firewall, Layer 2 Firewall,
IPS, Master NGFW
Engine

ThreatSeeker Intelligence Cloud
URL categorization service.

HTTPS

VPN gateways 500, 4500/UDP Firewall, Master NGFW
Engine

VPN traffic. Ports 443/TCP (or
custom port) can also be used,
depending on encapsulation
options.

ISAKMP (UDP)
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Working with expressions
Contents

• Introduction to expressions on page 1437
• Using operands on page 1438
• Expression processing order on page 1440
• Grouping operands using parentheses on page 1440
• Nesting expressions on page 1441

Expressions are elements that allow you to create simple definitions for representing complex sets of IP addresses by
using logical operands.

Introduction to expressions
An expression is an element that combines other network elements (IP addresses) with logical operands.

Expressions make it easier to define complex sets of network resources, even though you can arrive at the same
definitions without expressions. For example, a single, simple expression can include a whole network except
for a few individual IP addresses scattered throughout the address space. Otherwise, several Address Range
elements might be needed for defining the same set of IP addresses.

The expressions consist of the following parts:
• Parentheses group sets of elements and define the processing order in the same way as they do in

mathematical equations. The parentheses in expressions are always the basic curved type “(” and “)”.
• Negation operators take a set and form a new set that includes every possible element except the ones in the

original set. Negations are expressed with “~”.
• Intersection operators take two sets and forms a new set that includes only those IP addresses that are found

in both sets. Intersections are expressed with “#”.
• Union operators combine two sets and form a new set that includes every IP address in both sets. Unions are

expressed with “#”.
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Using operands
When creating expressions, you can use the negation, intersection, and union operands.

Negation
The negation operand can be understood based on common language use: it corresponds to the word “NOT”.

 
Figure 179: Graphical representation of a negation

1

2

1 Address space to which the negation applies

2 The negation excludes a subset

Example
~1.2.3.4 (negation of IP address 1.2.3.4) includes all other possible (IPv4) addresses except the IP address
1.2.3.4. As you see, negations are a good way to create a simple element that includes large IP address spaces
with some exceptions. Usually, the negation appears in constructions like the following: 192.168.10.0/24 #
~192.168.10.200. This example basically means “include all addresses in network 192.168.10.0/24, but do not
include address 192.168.10.200”.

This definition uses the intersection operand, which is explained next. We return to this same example to explain
the intersection part of the equation. Also, the section explaining the union operand returns to this example once
more to explain why a union operand is not appropriate here.
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Intersection
Intersection means “include only those IP addresses that are a part of both sets”.

 
Figure 180: Graphical representation of an intersection

1 2

3

1 Address Space A

2 Address Space B

3 IP addresses that are in common. This is the intersection.

Example
We could intersect two address ranges, A (192.168.10.200 – 192.168.10.300) and B (192.168.10.250 –
192.168.10.350). The expression reads A # B and it resolves to the following IP addresses: 192.168.10.250 –
192.168.10.300 (the IP addresses that appear in both ranges).

We now return to the previous example on the negation operand, where an intersection was also used:
192.168.10.0/24 # ~192.168.10.200. On the left side, there is a specific network that we intersect with the right
side that contains all possible IP addresses except one IP address. The intersection resolves to the IP addresses
that the left side and the right side have in common. These addresses include the IP addresses in network
192.168.10.0/24 except the one IP address that is excluded on the right side of the equation. As shown here,
intersections allow us to make expressions more specific.

Union
The common language equivalent for the union operand is the word “AND”. The union operand’s role is to widen
the scope of the expression.

 
Figure 181: Graphical representation of a union

1

1 The union includes all IP addresses in both sets combined

Example
The expression 1.2.3.0/24 # 2.3.4.0/24 includes all IP addresses in the two networks. As is evident from this
example, using unions is the same as including the elements in the same Group element. For this reason, unions
are not the only operand in an expression. Perhaps a better example is: ~192.168.1.1 # ~192.168.1.255 (includes
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all IP addresses except the two IP addresses mentioned). However, this example is wide in scope and might
require further restriction to be practical. For example, adding an intersection with the network 192.168.1.0/24
restricts the result to addresses in that network.

Unions do have the potential to become too wide in scope if you are not careful. In the preceding example, we
used the example expression: 192.168.10.0/24 # ~192.168.10.200. If we replace the intersection (“#”) with a
union (“#”), the expression then includes all addresses from the left side (network 192.168.10.0/24) and the right
side (all IPv4 addresses except for one). The expression includes even the single IP address that is excluded on
the right side, since it is part of the network on the left side. The result corresponds to the default “Any Network”
element that matches all possible IP addresses. The processing order of the operands is also a factor in this
result.

Expression processing order
The processing order of expressions is fixed.

As in mathematical equations, items inside parentheses are always resolved before other comparisons. Next, the
operands are processed by type: first the negations, then intersections, and last the unions.

For example, the expression A # ~(B # C) # D is processed as follows:

1) The formula between parentheses is solved first (the union of B and C). If we replace this result with X, the
expression becomes A # ~X # D.

2) The negation is processed next, inverting the value of X. If we replace this result with Y, the expression
becomes A # Y # D.

3) Next, the intersection between Y and D is resolved. If we replace this result with Z, the expression becomes
A # Z.

4) Finally, the union of A and Z yields the actual value that the expression represents (the full contents of both A
and Z).

As shown here, the order in which the operand-value combinations appear in the expression have no significance
to the order of processing. The only way to change the processing order is by using parentheses as explained
next.

Grouping operands using parentheses
Parentheses allow grouping the expression so that the operands you add are processed in a non-standard order.

Operands inside parentheses are always processed before other operands. Parentheses can also be placed
inside parentheses, in which case the operands are processed starting from the innermost parentheses.

We can change the earlier example by adding a set of parentheses like this: (A # ~(B # C)) # D. With the two
sets of parentheses, the inner parentheses are processed first (B # C as before), and the negation is processed
next (~X as before). However, the outer parentheses are processed next instead of processing the intersection,
changing the result. If ~(B # C) results in Y (as before), the expression becomes (A # Y) # D. The order of
processing is then different than without the parentheses: instead of intersecting Y and D, the expression
performs a union of A and Y, and the intersection is then the last operand to be processed.

Complicated expressions with extensive use of parentheses can become difficult to read and edit. In these
situations, nested expressions might sometimes be a better option.
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Nesting expressions
You can nest expressions by placing other expressions inside an expression. Nesting is a good way to simplify
the creation of complex expressions.

When you construct complex expressions from smaller incremental units, you can more easily find and fix
problems. You can also reuse the smaller units in other expressions or policies as appropriate. Arguably, the
expressions are also easier to read and edit when broken down into smaller units.

For example, if we want to create an expression that includes all IP addresses in three networks, except for
one IP address in each, we have a long expression: (192.168.1.0/24 # ~192.168.1.1) # (192.168.2.0/24 #
~192.168.2.1) # (192.168.3.0/24 # ~192.168.3.1).

Instead of creating just one expression, it might make more sense to create several expressions: one for each
set of parentheses (for example, Expression A: 192.168.1.0/24 # ~192.168.1.1) and then add an expression that
collects those three expressions together as follows: Expression A # Expression B # Expression C, or simply
create a Group element that contains the three expressions.

All three subexpressions can be used individually or easily combined in other ways as needed, for example,
Expression A # Expression C. Naturally, when changes are made to an expression used inside some other
expression, the definitions are updated in both places.

You can also create expressions that you use as templates for creating new expressions: when you insert an
expression into another expression, you have the choice of extracting the contents from the expression instead
of just inserting the expression. Extracting the contents allows you to make further changes and additions to the
expression you insert. Extracting the contents also removes the link between the expressions, so changes are
not propagated if the inserted expression is later changed.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Working with expressions | 1442



Predefined Aliases | 1443

 Appendix D

Predefined Aliases
Contents

• Predefined User Aliases on page 1443
• System Aliases on page 1443

Predefined Aliases are used in the default policies. Some of them might be useful when you create your own rules.

Predefined User Aliases
User Aliases are usually created by administrators, but there are also some predefined User Aliases in the SMC.

User Aliases are preceded with one $ character. The following table lists all editable automatically created User
Aliases.

Table 160: System-defined User Aliases

Predefined User Alias Description

$ DHCP address pools Addresses that can be allocated by DHCP servers.

$ DHCP address pools for Mobile VPN clients Address pools for assigning virtual IP addresses to mobile
VPN clients.

$ DHCP servers All DHCP servers defined for the Firewall.

$ DHCP servers for Mobile VPN clients The DHCP servers defined for assigning virtual IP addresses
to mobile VPN clients.

System Aliases
System Aliases are automatically created non-editable Aliases.

The System Aliases are preceded with two $$ characters. The following table lists the definitions of all System
Aliases. These Aliases are used in the Firewall’s default policies.

Table 161: System Aliases

System Alias Description

$$ DHCP Enabled Interface Addresses IP addresses (of CVIs on clusters) which have DHCP relay
enabled.

$$ DHCP Enabled interface addresses for Mobile VPN
clients

IP addresses (of NDIs on clusters) which have DHCP relay
enabled for mobile VPN clients.

$$ DHCP Interface X.dns IP address of the DHCP-assigned DNS server for interface
number X.
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System Alias Description

$$ DHCP Interface X.gateways IP address of the DHCP-assigned default router for interface
number X.

$$ DHCP Interface X.ip DHCP-assigned IP address for interface number X.

$$ DHCP Interface X.net Network behind the dynamic IP interface number X.

$$ Interface ID X.ip First IP address (CVI) of Physical Interface ID X.

$$ Interface ID X.net Directly connected networks behind Physical Interface ID X.

$$ Local Cluster All addresses of the cluster.

$$ Local Cluster (CVI addresses only) All CVI addresses of the cluster.

$$ Local Cluster (DHCP Interface Addresses) All DHCP-assigned IP addresses of the engine.

$$ Local Cluster (NDI addresses only) All NDI addresses of all nodes in the cluster.

$$ Local Cluster (NDI for heartbeat addresses only) Heartbeat NDI addresses of all nodes in the cluster.

$$ Local Cluster (NDI for management addresses only) Management NDI addresses of all nodes in the cluster.

$$ Log Servers IP addresses of all Log Servers.

$$ Management Servers IP addresses of all Management Servers.

$$ Valid DHCP Address Pools for Mobile VPN clients Address pools defined for assigning virtual IP addresses to
mobile VPN clients.

$$ Valid DHCP Servers All DHCP servers defined for the Firewall.

$$ Valid DHCP Servers for Mobile VPN clients The DHCP servers defined for assigning virtual IP addresses
to mobile VPN clients.
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Situation Context parameters
Contents

• Correlation Context parameters on page 1445
• Other Context parameters on page 1448

There are parameters you can define for Situation Contexts.

Note:  The details related to the Contexts in your system might be different from what is described
here. The Contexts might have been updated through dynamic update packages after this guide was
published. Read the Release Notes of each update package you import to see which elements are
affected.

Correlation Context parameters
You can configure Correlation Context parameters to find patterns in event data.

Event Compress
Event Compress combines repeated similar events into the same log entry, reducing clutter in the Logs view.

Table 162: Event Compress parameters

Field Option (if any) Explanation

Correlated
Situations

Situations you want to compress.

Time Window All matches to the Situations selected are combined to a common
log entry when they are triggered within the defined time from
each other.

Select Events triggered by the selected Situations are regarded as the
same when the values those entries have in the Log Fields you
place in Lognames are identical.

Log Fields Enabled

Ignore Events triggered by the selected Situations are regarded as the
same, except when the values those entries have in the Log
Fields you place in Lognames are identical.

Lognames The selected log fields are used by the matching option you
selected in the previous step.

https://support.forcepoint.com/Documentation
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Field Option (if any) Explanation

Very Early

Early

Late

Location

Very Late

The execution order of the Compress operation in relation to other
operations. Compress operations that share the Location are
executed in parallel; each compress operation receives the same
events as the other compress operations in the same Location.
“Very Early” and “Early” locations can affect the operation of other
Correlations.

Compress Filter Filters in data for the compression.

Event Count
Event Count finds recurring patterns in traffic by counting the times certain Situations occur within the defined
period, so that action can be taken if the threshold values you set are exceeded.

Table 163: Event Count parameters

Field Option (if any) Explanation

Correlated
Situations

Situations you want to count.

Time Window The period of time within which the matches to the Situation must
occur the specified number of times.

Alarm Threshold The number of times that the selected Situations must occur for
the Correlation Situation to match.

Select Events triggered by the selected Situations are regarded as the
same when the values those entries have in the Log Fields you
place in Lognames are identical.

Log Fields Enabled

Ignore Events triggered by the selected Situations are regarded as the
same, except when the values those entries have in the Log
Fields you place in Lognames are identical.

Lognames The selected log fields are used by the matching option you
selected in the previous step.

Event Group
Event Group finds event patterns in traffic by following if all events in the defined set of Situations match at least
once in any order within the defined time period.

Table 164: Event Group parameters

Field Option (if any) Explanation

Event Match Filter for grouping.

Needed Number How many occurrences of the Event selected for this Member are
required for them to be included in the grouping.

Member (column)

Binding Log field used for the grouping.
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Field Option (if any) Explanation

Correlated
Situations

Situations you want to group.

Yes Makes the Correlation Situation examine the events and trigger
the response defined in the Inspection Policy but does not actually
group the matching events into one. All individual events are still
available for further inspection, even though they have already
triggered a response.

Keep and Forward
Events

No Makes the Correlation Situation group the matching events
together. Only the response defined in the Inspection Policy is
triggered, and no further processing is done on the individual
events.

Time Window Size The period of time within which the Situation must occur for them
to be grouped.

Yes Makes the NGFW Engine or Log Server respond as defined in the
Inspection Policy to each occurrence of the defined event within
the selected Time Window.

Continuous
Responses

No Makes the NGFW Engine or Log Server respond only to the first
occurrence of the defined event within the selected Time Window.

Event Match
Event Match allows filtering event data produced by specific Situations using Filter expressions.

Table 165: Event Match parameters

Field Explanation

Correlated
Situations

Situations you want the Correlation Situation to match.

Filter Filter for finding a pattern in the event data.

Event Sequence
Event Sequence finds event patterns in traffic by following if all events in the defined set of Situations match in a
specific order within the defined time period.

Table 166: Event Sequence parameters

Field Option (if any) Explanation

Event Match Filter for selecting data for the sequencing.Entry to/Exit from
(columns)

Binding Log field that the Correlation Situation traces to find a sequence.

Correlated
Situations

Situations from which you want to find sequences.
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Field Option (if any) Explanation

Yes Makes the Correlation Situation examine the events and trigger
the response defined in the Inspection Policy but does not actually
group the matching events into one. All individual events are still
available for further inspection, even though they have already
triggered a response.

Keep and Forward
Events

No Makes the Correlation Situation group the matching events
together. Only the response defined in the Inspection Policy is
triggered, and no further processing is done on the individual
events.

Time Window Size The period of time within which the Situation must occur for them
to be reagarded as a sequence.

Other Context parameters
See the properties dialog box of the Context in question.

The Contexts are shown as branches/sub-branches in the Other Elements > Situations > By Context tree in
the Configuration view.
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Regular expression syntax
Contents

• SMC regular expression syntax on page 1449
• Special character sequences on page 1451
• Pattern-matching modifiers on page 1452
• Variable expression evaluation on page 1454
• Stream operations on page 1456
• System variables on page 1457
• Independent subexpressions on page 1459
• Parallel matching groups on page 1459
• Tips for working with regular expressions on page 1459

The SMC has its own regular expression syntax. Regular expressions are used in Situations for matching network
traffic. Situations are used in the Inspection rules on NGFW Engines.

SMC regular expression syntax
A regular expression is a sequence of characters that defines a matching pattern. These patterns are used for
matching byte sequences in network traffic.

The expression matching always starts from the beginning of the traffic stream, defined by the associated
Situation Context. Depending on the context, this can mean:
• The beginning of a TCP stream.
• The beginning of a UDP packet.
• A protocol-specific field or header, such as the beginning of an HTTP request header or the beginning of an

HTTP Request URI.

A regular expression consists of one or more branches that are separated by a logical OR symbol “|”. A Situation
match occurs if any of the branches matches the traffic stream.

Regular expression matching

# This regular expression matches
# if any of the following patterns are seen
# at the beginning of the traffic stream: "aaa", "bbb", "ccc"
aaa|bbb|ccc

The basic sequences that can be used in an SMC regular expression are listed in the following table:
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Table 167: SMC regular expression syntax

Sequence Description Example

<char> Matches only the defined characters. "2", "A", "foo" match exactly to the defined
characters: "2", "A", and "foo" respectively.

. (dot) Matches any character, including the null
character \x00 and a missing character.
Matches also other than printable characters,
such as the linefeed.
A missing character is a special character used
by the engine to represent characters missing
from a TCP connection.

For example, in capture mode, the engine might
not see all traffic of a TCP connection.

"." matches any single character or byte.

\x<hex> Matches the hexadecimal byte value ranging
from \x00 to \xFF.

"\x4d" matches hexadecimal value "4d" which
represents the decimal value 77 and the ASCII
character "M".

[<char>] Matches any single character in the list. "[15aB]" matches when any of the characters
" 1 ", "5", "a", or "B" are in the matching location
of the inspected string.

[^<char>] Matches any single character that is not on the
list.

"[^aBc]" matches if none of the characters "a ",
"B", or "c" is present in the matching location of
the inspected string.

[<char1>-<char2>] Matches all characters ranging from <char1> to
<char2>, these two characters included.

"[a-f]" matches any character within the range
from "a" to "f ", with "a" and "f" included.

\<char> Used for escaping special metacharacters
to be interpreted as normal characters. The
metacharacters are:  \|)(][^-*+?.#

"\[" matches the "[" character instead of
interpreting it as the regular expression class
metacharacter.

#<text> Anything starting with "#" up to the linefeed
(\x0a) or the carriage return character (\x0d)
is regarded as a comment and not used in the
matching process.

"# my comment." is not used in the matching
process.

(<expr1>|<expr2>) Matches if either expression <expr1> or
<expr2> matches.

"a(bc|de)" matches "abc" and "ade".

Example regular expressions

# This regular expression matches any of the following strings: 
# "login.php", "login1.php", "login2.php", "login_internal.php"
# Note: to match the "." character, the character must be escaped in the 
# regular expression by prefixing the character with "\"
login\.php|login[12]\.php|login_internal\.php

# Alternatively, the branches of the above regular expression can be 
# combined into one single branch as shown below
login([123]|_internal)?\.php

It is also possible to indicate repeated, consecutive characters, or regular expressions using quantifiers. The
quantifiers available in SMC regular expression syntax are listed in the following table.
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Table 168: SMC regular expression quantifiers

Sequence Description Example

<expr>* Matches if there are zero or more consecutive
<expr> strings.

"a*" matches "<empty>", "a", "aa" and so on.

<expr>+ Matches if there are one or more consecutive
<expr> strings.

"a+" matches "a", "aa", "aaa" and so on, but not
the empty string.

<expr>? Matches if there is zero or one <expr> string. "a?" matches "<empty>" and "a".

<expr>{n,m} {num} matches exactly num times the
expression.
{num,} matches num or more times the
expression.

{num,max} matches at least num and no more
than max times the expression.

" a{5,}" matches five or more consecutive "a"
characters.
"a{5,7}" matches 5, 6, or 7 consecutive "a"
characters.

The quantifiers always apply only to the single previous character (or special character sequence), unless
otherwise indicated by parentheses. For example, the regular expression “login*” matches “logi”, “login” or
“loginnnn”, whereas the regular expression “(login)*“ matches the empty string “”, “login” or “loginloginlogin”.

As the matching of a regular expression is always started from the beginning of the traffic stream, “.*” (any
character zero or more times) is often needed when writing SMC regular expressions. For example, the regular
expression “.*/etc/passwd” searches for the string “/etc/passwd” anywhere in the traffic stream.

Note:  Use the wildcard characters '*' and '+', as well as '<expr>{n,m}' (where m has a large
value) with care. If used in the middle of a regular expression, they can result in an expression
that has a very large number of matching states, and that is too complex for efficient use. It is
recommended to use these wildcards only in the beginning of a branch.

Special character sequences
Printable characters, such as “a” or “b”, are defined by simply typing them into a regular expression. In addition,
there are some shorthands for common non-printable characters and character classes.

Special character sequences are listed in the following table:

Table 169: Special character sequences

Sequence Description

\a Bell (BEL) = \x07

\t Horizontal tab (HT) = \x09

\n Linefeed (LF) = \x0A

\f Formfeed (FF) = \x0C

\r Carriage return (CR) = \x0D

\e Escape (ESC) = \x1B

\OOO Octal code OOO of the character.

\xHH Hexadecimal code HH of the character. Case-insensitive. For example, "\xaa" is regarded to be
the same as "\xAA".
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Sequence Description

\c<char> Control character that corresponds to Ctrl+<char >, where <char> is an uppercase letter.

\w "word" class character = [A-Za-z0-9_]

\W Non-"word" class character = [^A-Za-z0-9_]

\s Whitespace character = [ \t\r\n\f]

\S Non-whitespace character = [^ \t\r\n\f]

\d Digit character = [0-9]

\D Non-digit character = [^0-9]

\b Backspace (BS) = \x08

Note:  Allowed only in bracket expressions.

\Q
<expr>

\E

Quotes all metacharacters between \Q and \E. Backslashes are regarded as normal characters.
For example, "\QC:\file.exe\E" matches the "C:\file.exe" string, not the "C:
\x0Cile.exe" string, where \x0C is the formfeed "\f".

Example of using special character sequences

# This fingerprint matches HTTP content
# for which the length is >= 10000
# The situation context for this regular expression could be either 
# "HTTP Request Header Line" or "HTTP Reply Header Line"
Content-Length: \d\d\d\d\d

# The regular expression could be also written as shown below
Content-Length: \d{5}

Pattern-matching modifiers
The regular expression syntax has Perl-like extensions. The pattern-matching modifiers are extensions that can
be used to control the matching process in more detail.

The modifiers are enabled with (?<modifiers>) and disabled with a minus (?-<modifiers>), where
<modifiers> is a list of one or more modifiers.

Example of pattern-matching modifiers

# This fingerprint is identical to the special character sequence example,
# except for the (?i) modifier.
# HTTP Header names are case-insensitive. For this reason,
# case-insensitivity is enabled in this fingerprint.
(?i)Content-Length: \d\d\d\d\d

The modifiers (?C), (?L), and (?s)are enabled by default.

The pattern-matching modifiers are listed in the following table:



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Regular expression syntax | 1453

Table 170: Pattern-matching modifiers

Sequence Description

(?i) Case insensitive mode

When enabled, case insensitive matching is used for the uppercase and lowercase letters.
Thus, a letter matches regardless of its capitalization.

When disabled, the letters are matched case-sensitively so that capitalization is taken into
account in the matching process.

(?s) Single line mode

When enabled, the dot character "." matches also the null character \x00 and a missing
character in addition to matching any character (including linefeed and other non-printable
characters).

When disabled, the linefeed or a missing character are not matched.

This modifier is enabled by default. Use (?-s) to disable it.

(?x) Extended readability mode

When enabled, equals to enabling (?C), (?L), and (?S). Comments, linefeeds and spaces
are not used in the matching process, allowing to use them for readability of the expression.

When disabled, equals to disabling (?C), (?L), and (?S). Comments, linefeeds, and
spaces are used in the matching process.

(?C) Allow comments mode

When enabled, anything after the hash character "# " is regarded as a comment and not
included in the matching process.

When disabled, the hash character "# " and anything following are used in the matching
process.

This modifier is enabled by default. Use (?-C) to disable it.

(?L) Ignore linefeeds mode

When enabled, linefeed and carriage return characters are not included in the matching
process unless defined (\x0A or \n for linefeed and \x0D or \r for carriage return).

When disabled, linefeeds and carriage returns are used in the matching process.

This modifier is enabled by default. Use (?-L) to disable it.

(?S) Ignore spaces mode

When enabled, the space and horizontal tab characters are not used in the matching
process unless defined (\x20 for space and \x09 or \t for horizontal tab).

When disabled, the space and horizontal tab characters are used in the matching process.

(?<modifiers>:<expr>) Applies the <modifiers> modifiers only to the expression <expr>.

These modifiers are not used in other parts of the regular expression.
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Variable expression evaluation
Variable expression evaluation is an extension to regular expression syntax that provides the ability to use
variables, parse values from the traffic stream and perform arithmetic operations.

Table 171: Variable expression syntax

Sequence Description

(?[<expression>]) <expression> is one or more comma-separated expressions

Example of setting a variable in a variable expression

# This regular expression searches for "aaa" anywhere in the traffic stream,
# and then sets the value of "parameter1" to 1
.*aaa(?[parameter1=1])

The default variable size is one bit. Variable size can be changed by appending “@<size>” to the variable name.
For example, “parameter1@8” is an 8-bit variable. Possible variable sizes, in addition to 1, are 8, 16, 32 and
64 bits. By default variables are visible within a situation context. For example, a variable used in a situation with
context “HTTP Request URI” is visible to all other situations in that context. Prefixing the variable name with a
dollar sign “$” makes it a connection variable. A connection variable is visible in all situations contexts for a single
TCP connection, for example in both client and server stream contexts.

By default, no situation match is created when the end of a variable expression in reached. To create a match
when a variable expression is used, the “sid()” function must be called.

Table 172: Variable expression syntax

Sequence Description

<varexpr_a> -> <varexpr_b> varexpr_b is executed only if varexpr_a is true

The following example shows a typical case where we want to search one string followed by another, for example
“aaa” followed by “bbb”. An expression such as “.*aaa.*bbb” breaks the guideline of not using “.*” in the
middle of a regular expression. You can circumvent this issue using variable expressions.

Example of setting and checking a variable value in a variable expression

# This regular expression searches for "aaa" anywhere in the traffic stream,
# and then sets the value of 'my_var' to 1.
# It also searches for "bbb", and checks whether "aaa" has already been 
# seen earlier (i.e. the value of 'my_var' is one). If "aaa" has been seen
# already, a match is created using the "sid()" function.

# The following traffic matches this regular expression: "aaabbb", 
# "xxaaaxxxxxxbbbxx", "aaaxbbb"
# The following traffic does not match this regular expression:
#"bbbaaa", "aabbbxxaaa"
(?x)
.*aaa(?[my_var=1]) |
.*bbb(?[my_var==1 -> sid()])
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Example of setting and checking a variable

# This regular expression matches when "login.php" is seen in the traffic 
# stream before "user=admin" Situation Context, e.g. "HTTP Request URI"
(?x)
.*login\.php(?[login_page_seen=1]) |
.*user=admin(?[login_page_seen==1 -> sid()])

All the arithmetic operations that are available in SMC regular expressions are listed in the table below. Operator
precedence is the same as in the C programming language, except that '->' is the lowest in precedence.
Statements inside parentheses '()' are always evaluated first, so the order of operations can be overridden with
parentheses.

Table 173: Operations on expression results

Sequence Description

false Always evaluates to a false.

true Always evaluates to a true.

<number> A literal number in decimal, octal, and hexadecimal format, for example "32" or "0x20".

<var> = <expr> Sets a value returned by expression <expr> to a variable <var>. See variable syntax
below.

<var> += <expr> Adds the value of variable <var> with the value returned by expression <expr> and sets
the result to variable <var>.

<var> -= <expr> Subtracts the value from variable <var> by the value returned by expression <expr> and
sets the result to variable <var>.

<var> *= <expr> Multiplies the value of <var> by the value returned by expression <expr> and sets the
result to variable <var>.

<var> /= <expr> Divides the value of <var> with the value returned by expression <expr> and sets the
result to variable <var>.

<var> %= <expr> Divides the value of <var> with the value returned by expression <expr> and sets the
modulo of the result to variable <var>.

<var> <<= <expr> Shifts the value of <var> to left by number of steps returned by expression <expr> and
sets the result to variable <var>.

<var> >>= <expr> Shifts the value of <var> to right by number of steps returned by expression <expr> and
sets the result to variable <var>.

<var> &= <expr> Performs bitwise AND with the value of variable <var> and the value returned by
expression <expr> and sets the result to variable <var>.

<var> |= <expr> Performs bitwise OR with the value of variable <var> and the value returned by expression
<expr> and sets the result to variable <var>.

<var> ^= <expr> Performs bitwise XOR with the value of variable <var> and the value returned by
expression <expr> and sets the result to variable <var>.

<expr_a> -> <expr_b> Expression <expr b> is evaluated only if <expr a> is true.

<expr_a> ? <expr_b> :
<expr_c>

Expression <expr b> is evaluated only if <expr b> is true and expression <expr c> is
evaluated if <expr a> is false.

<expr_a> == <expr_b> Test if expressions <expr a> and <expr b> return an equal value.

<expr_a> != <expr_b> Test if expressions <expr a> and <expr b> do not return an equal value.

<expr_a> < <expr_b> Test if expression <expr b> returns higher value than expression <expr a>.
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Sequence Description

<expr_a> <= <expr_b> Test if expression <expr b> returns higher or equal value than expression <expr a>.

<expr_a> > <expr_b> Test if expression <expr a> returns higher value than expression <expr b>.

<expr_a> >= <expr_b> Test if expression <expr a> returns higher or equal value than expression <expr b>.

<expr_a> & <expr_b> Performs bitwise AND with expressions <expr_a> and <expr b> and returns the result.

<expr_a> | <expr_b> Performs bitwise OR with expressions <expr a> and <expr b> and returns the result.

<expr_a> ^ <expr_b> Performs bitwise XOR with expressions <expr a> and <expr b> and returns the result.

<expr_a> && <expr_b> Performs AND with expressions <expr a> and <expr b> and returns the result.

<expr_a> || <expr_b> Performs OR with if expressions <expr a> and <expr b> and returns the result.

<var>++, ++<var> Increase value of variable <var> by one.

<var>--, --<var> Decrease value of variable <var> by one.

-<expr> Negate the result of the expression <expr>.

~<expr> Bitwise invert the result of the expression <expr>.

!<expr> Perform NOT operation with the expression <expr>.

Note:  In a regular expression such as “.*aaa(?[var1=1])”, the starting of the variable
expression “(?[var1=1])” is the most time-consuming operation, whereas setting or checking
a variable value is a relatively fast operation. For example, the regular expression “.*/(?
[parameter1=1])” in an HTTP context would cause the starting of a variable expression after
every “/” character in the traffic stream. As this character is common in HTTP protocol, the regular
expression might degrade the system performance.

Stream operations
Stream operations can be used to read data from the traffic stream.

The value returned by stream operations can either be written to a variable or used directly in an arithmetic
operation. The stream operations are listed in the tables below.

Table 174: ASCII data variable expressions

Sequence Description

parse_dec(<length>) Parse ASCII decimal value. <length> is the maximum number of the characters to parse.
The actual number of parsed digits is available in the variable $parse_length@32. If no
characters could be parsed, then the variable is set to zero.

parse_hex(<length>) Parse ASCII hexadecimal value. <length> is the maximum number of the characters to
parse. The actual number of parsed digits is available in the variable $parse_length@32.
If no characters could be parsed, then the variable is set to zero.

parse_int(<length>) Parse ASCII value; parses hexadecimal if the string starts with "0x", octal if the string
starts with zero ("0") and decimal otherwise. <length> is the maximum number of
the characters to parse. The actual number of parsed digits is available in the variable
$parse_length@32. If no characters could be parsed, then the variable is set to zero.
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Sequence Description

parse_oct(<length>) Parse ASCII octal value. <length> is the maximum number of the characters to parse.
The actual number of parsed digits is available in the variable $parse_length@32. If no
characters could be parsed, then the variable is set to zero.

Table 175: Miscellaneous input stream operations

Sequence Description

CRC(<length>) Calculates a 32-bit CRC value starting from the current byte up to number of bytes
specified by the <length> parameter. This function can be used as a space optimizer for
probabilistically matching against a specific large binary block by its CRC. The CRC used is
the 32-bit CRC with polynomial 0x104C11DB7 (used for example in Ethernet).

skip(<length>) Skip <length> number of bytes.

regex(<regexp>) Launch an independent subexpression.

The binary data from the input stream can be read into variables with the following expressions.

Table 176: Binary data variable expressions

Sequence Description

parse_be@<size> Parse big endian value. <size> is the size of the value to be read in bits, and it can be one
of the following: 8, 16, 24, 32, 40, 48, 56 or 64.

parse_le@<size> Parse little endian value. <size> is the size of the value to be read in bits, and it can be one
of the following: 8, 16, 24, 32, 40, 48, 56 or 64.

Example of parsing a value from the traffic stream

# This regular expression finds the string "&parameter1=", parses the 
# following three bytes as an ASCII decimal number, and writes the values 
# to the "var1@8" variable
# The regular expression matches only if the number is greater than 100
(?x)
.*&parameter1=(?[var1@8=parse_dec(3), var1@8>100 -> sid()])

System variables
System variables are connection variables whose values are set by the NGFW Engine.

A regular expression can only read the value of these variables. The two most commonly used variables are
$dport and $offset. The $dport variable contains the destination port of the connection/datagram, and it is
useful especially in:
• “Any Application Protocols” contexts, which receive all traffic (any TCP/UDP port).
• Unknown Application Protocols” contexts, which receive traffic that does not have a dedicated, protocol-

specific context (mostly high TCP/UDP ports).

The $offset variable contains the number of bytes that have been matched since the beginning of the traffic
stream. The following table lists all system variables.
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Table 177: System variables

Sequence Description

$major The major version number of the NGFW Engine.

$minor The minor version number of the NGFW Engine.

$patch The patch level number of the NGFW Engine.

$build The build number of the NGFW Engine.

$dir 32-bit integer type expression that is evaluated to the current direction of the current fingerprinted
data. The expression returns the following values:

• 0 — Client direction

• 1 — Server direction

Note:  The value is relative to direction from which the connection was established.
If a connection was detected while it was in progress, the value might not
correspond to the actual client or server direction.

$dport The current destination port of the connection.

For TCP, $dport is the destination port of the SYN packet. For UDP, $dport is the destination
port of the first UDP packet sent between two hosts.

$icmp_code A 32-bit integer type expression that is evaluated to the current ICMP code number of the
connection.

$icmp_type A 32-bit integer type expression that is evaluated to the current ICMP type number of the
connection.

$ipproto A a 32-bit integer type expression that is evaluated to the current IP-protocol number of the
connection.

$offset The byte that is under inspection when counted from the beginning of the traffic stream.

For implementation-specific reasons, the value is increased only after the first byte of a traffic
stream (after the first byte, the value is still 0). For this reason, the value of $offset is actually the
real offset minus one.

$parse_length@32 Number of digits parsed by last parse_dec(), parse_hex(), parse_oct(), or parse_in()
expression.

$sport A 32-bit integer type expression that is evaluated to the current source port of the connection.

Example of system variable use
# This regular expression matches
# if hexadecimal bytes "0x01", "0x02",
# and "0x03" are seen in port 5000
.*\x01\x02\x03(?[$dport==5000 -> sid()])

Related reference
Stream operations on page 1456
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Independent subexpressions
Independent subexpressions allow starting another regular expression from inside a variable expression.

The function used for starting the subexpression is “regex()”. The “cancel” function must always be called
after a match in a subexpression. This function stops the execution of the subexpression and frees resources.
The “cancel” function is always called without parentheses “()” unlike other functions.

Subexpressions are useful for splitting a single complex regular expression into two. For example,
".*&filename=[^&]{256}" breaks the guideline of not using ".*" or "<expr>{n,m}" with a large m in the
middle of a regular expression. The following illustration shows how to circumvent this limitation by using an
independent subexpression.

Example of independent subexpression use

# This fingerprint detects an HTTP parameter file name with value longer than # 256 bytes
(?x)
.*&filename=(?[
    regex(
        [^&]{256}(?[sid(),cancel])
    )
])

Parallel matching groups
With complex regular expressions, you might need to set up different regular expressions for matching in parallel
groups.

You can set different regular expressions to be matched in parallel groups within one Situation Context. Normally,
manual Situation group definitions are not needed and the engine automatically compiles all your custom
Situations in the same group (group 0). Manual group definitions are needed if the policy upload fails due to
fingerprint/DFA compilation problems that can occur with complex regular expressions.

To use grouping, add a new preprocessing tag to the beginning of the regular expression.

Table 178: Preprocessing tag for setting a group for matching

Syntax Description

#!!GROUP(X)

Comment

#!!#

'X' is the group number from 0 to 7. The comment is optional. If you do not specify the group
with this tag, the Situation is processed in group zero.

Tips for working with regular
expressions

Before you work with regular expressions, review the following tips.

• For more examples of regular expressions, you can view the Context tab of the Situation Properties dialog
box.
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• When adding a Situation to an Inspection rule, it is often useful to select the “Excerpt” logging option. This
option includes an excerpt of the traffic that the regular expression matches and also the matching position
(“Excerpt position”) in the log entry. This helps in verifying that the regular expression works as expected.

• Freely available tools, such as wget, can be used for generating traffic for testing regular expressions.
• If a policy upload fails with an error message such as “Fingerprint compilation failed”, it indicates that a regular

expression is too complex. In this case, the regular expression must be edited. For example, use a variable
expression or an independent subexpression. If it is not possible to edit the regular expression, the regular
expression can be moved to a parallel matching group.

Related reference
Parallel matching groups on page 1459
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 Appendix G

SNMP traps and MIBs
Contents

• SNMP traps and MIBs on page 1461

For information about SNMP traps (notifications) and MIBs (objects), see the following reference.

SNMP traps and MIBs
The following tables describe the SNMP traps and MIB objects that you might encounter when using the SMC.

The SMC Appliance can be configured for SNMP access. The list of Net-SNMP common MIBs for the SMC
Appliance can be found in the /usr/share/snmp/mibs directory. Visit http://www.net-snmp.org for Net-SNMP MIB
descriptions.

Firewall/VPN, IPS, and Layer 2 Firewall engines can send SNMP traps on system events. The traps are
configured using SNMP Agent elements. Also, Tester entries can be configured to send SNMP traps. The SNMP
traps are listed in the table.

Table 179: SNMP traps for Firewall/VPN, IPS, and Layer 2 Firewalls

Trap name Objects included Description

fwPolicyInstall fwSecurityPolicy (Firewall and Layer 2 Firewall) Policy was installed on the Firewall
engine.

ipsPolicyInstall ipsSecurityPolicy (IPS) Policy was installed on the IPS engine.

nodeBoot - Node bootup complete.

nodeHwmon nodeHwmonEvent Hardware monitoring system has detected problems.

nodeOffline nodeOperState Node changed to offline or standby state.

nodeOnline nodeOperState Node changed to online state.

nodeShutdown - Node is shutting down.

nodeTestFailure nodeTestIdentity Test subsystem reported a test failure on the node.

nodeFailedUserLogin nodeLastLogin (Firewall and Layer 2 Firewall) Logon failed on the firewall engine's
console or through SSH.

nodeUserLogin nodeLastLogin Log on initiated on the engine's console or through SSH.

nodeUserLogout nodeLastLogin (Firewall and Layer 2 Firewall) Log off on the firewall engine's console or
through SSH.

The STONESOFT-SMI-MIB defines the top-level enterprise registrations for the Forcepoint NGFW products
in the .iso.org.dod.internet.private.enterprises.stonesoft branch (OID .1.3.6.1.4.1.1369). The Forcepoint
NGFW-specific MIB files can be downloaded at https://support.forcepoint.com/Downloads.

The Forcepoint NGFW-specific MIBs are:

http://www.net-snmp.org
https://support.forcepoint.com/Downloads
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• STONESOFT-FIREWALL-MIB
• STONESOFT-IPS-MIB
• STONESOFT-NETNODE-MIB

NGFW Engines in the Firewall/VPN and Layer 2 Firewall roles support objects in STONESOFT-FIREWALL-MIB.
NGFW Engines in the IPS role support objects in STONESOFT-IPS-MIB. NGFW Engines in all roles support
objects in STONESOFT-NETNODE-MIB.

NGFW Engines in the Firewall/VPN role also support objects in the following standard MIBs:
• IF-MIB (RFC 2863 and RFC 2233)
• IP-MIB (RFC 2011)
• SNMP-USER-BASED-SM-MIB (RFC 3414)
• SNMPv2 MIB (RFC 3418)

Table 180: STONESOFT-FIREWALL-MIB objects

Object name Object description in MIB

fwPolicyTime The time when the security policy was installed to the Firewall or Layer 2 Firewall

fwSecurityPolicy Name of the current security policy on the Firewall or Layer 2 Firewall

fwSoftwareVersion Version string of the Firewall or Layer 2 Firewall software

fwConnNumber Number of current connections

fwAccepted Number of accepted packets

fwDropped Number of dropped packets

fwLogged Number of logged packets

fwAccounted Number of accounted packets

fwRejected Number of rejected packets

fwIfTable This table contains an entry for each interface in system

fwIfStatsEntry Row for an interface

fwIfStatsIndex A unique value, greater than zero, for each interface or interface sublayer in the managed
system

fwIfName Name of interface

fwIfAcceptedPkts Number of accepted packets by Firewall or Layer 2 Firewall rules

fwIfDroppedPkts Number of dropped packets by Firewall or Layer 2 Firewall rules

fwIfForwardedPkts Number of forwarded packets by Firewall or Layer 2 Firewall rules

fwIfLoggedPkts Number of logged packets by Firewall or Layer 2 Firewall rules

fwIfRejectedPkts Number of rejected packets by Firewall or Layer 2 Firewall rules

fwIfAccountedPkts Number of accounted packets by Firewall or Layer 2 Firewall rules

fwIfAcceptedBytes Number of accepted bytes by Firewall or Layer 2 Firewall rules

fwIfForwardedBytes Number of forwarded bytes by Firewall or Layer 2 Firewall rules

fwIfDroppedBytes Number of dropped bytes by Firewall or Layer 2 Firewall rules

fwIfLoggedBytes Number of logged bytes by Firewall or Layer 2 Firewall rules

fwIfRejectedBytes Number of rejected bytes by Firewall or Layer 2 Firewall rules
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Object name Object description in MIB

fwIfAccountedBytes Number of accounted bytes by Firewall or Layer 2 Firewall rules

fwCpuTable This table contains an entry for each CPU in a system and total usage of all CPUs

fwCpuStats Row with information about CPU usage

fwCpuStatsId A unique value, greater than zero, for each CPU in the managed system. First element with
Id '0' is designed for total values

fwCpuName Name of data current line concern

fwCpuTotal The total CPU load percentage

fwCpuUser The percentage of time the CPU has spent running users' processes that are not niced

fwCpuSystem The percentage of time the CPU has spent running the kernel and its processes

fwCpuNice The percentage of time the CPU has spent running user's processes that have been niced

fwCpuIdle The percentage of time the CPU was idle

fwCpuIoWait The percentage of time the CPU has been waiting for I/O to complete

fwCpuHwIrq The percentage of time the CPU has been servicing hardware interrupts

fwCpuSoftIrq The percentage of time the CPU has been servicing software interrupts

fwSwapBytesTotal Total swap space

fwSwapBytesUsed Used space of swap

fwSwapBytesUnused Amount of unused space of swap

fwMemBytesTotal Number of available bytes of physical memory

fwMemBytesUsed Amount of memory being in use

fwMemBytesUnused Number of unused bytes of physical memory

fwMemBytesBuffers Amount of memory used as buffers

fwMemBytesCached Amount of memory used as cache

fwDiskSpaceUsageTable Table contains an entry for each partition mounted in a system

fwDiskStats Row of information concerning one partition

fwPartitionIndex A unique value, greater than zero, for each partition

fwPartitionDevName A unique name of a device

fwMountPointName Name of a mount point

fwPartitionSize Total size of the partition

fwPartitionUsed Amount of used space of the partition (in kilobytes)

fwPartitionAvail Information about amount of free space on partition (in kilobytes)

fwVpnEp4Local Local IPv4 endpoint address

fwVpnEp4Remote Remote IPv4 endpoint address

fwVpnEp4RemoteType The type of remote VPN endpoint (static, dynamic, or mobile)

fwVpnEp4ReceivedBytes Number of received bytes between the endpoint pair

fwVpnEp4SentBytes Number of sent bytes between the endpoint pair

fwVpnEp4IpsecSa Number of currently established IPsec SAs between the endpoint pair
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Object name Object description in MIB

fwVpnEp6Local Local IPv6 endpoint address

fwVpnEp6Remote Remote IPv6 endpoint address

fwVpnEp6RemoteType The type of remote VPN endpoint (static, dynamic, or mobile)

fwVpnEp6ReceivedBytes Number of received bytes between the endpoint pair

fwVpnEp6SentBytes Number of sent bytes between the endpoint pair

fwVpnEp6IpsecSa Number of currently established IPsec SAs between the endpoint pair

adslModulation Modulation protocol

adslChannel Channel type

adslConnStatus The status of the DSL link or communication status with DSL modem in case of
communication error

adslConnUptime Uptime of current ADSL connection

adslLineStatus Status of DSL line

adslInOctets Number of bytes received by ADSL interface

adslOutOctets Number of bytes transmitted by ADSL interface

adslSynchroSpeedUp The actual rate at which data is flowing upstream

adslSynchroSpeedDown The actual rate at which data is flowing downstream

adslAttenuationUp An estimate of the average loop attenuation upstream

adslAttenuationDown An estimate of the average loop attenuation downstream

adslNoiseMarginUp This is a signal-to-noise ratio (SNR) margin for traffic going upstream

adslNoiseMarginDown This is a signal-to-noise ratio (SNR) margin for traffic going downstream

adslHecErrorsUp The total number of header error checksum errors upstream

adslHecErrorsDown The total number of header error checksum errors downstream

adslOcdErrorsUp The number of out-of-cell delineation errors upstream

adslOcdErrorsDown The number of out-of-cell delineation errors downstream

adslLcdErrorsUp The total of lost-cell-delineation errors upstream

adslLcdErrorsDown The total of lost-cell-delineation errors downstream

adslBitErrorsUp The number of bit errors upstream

adslBitErrorsDown The number of bit errors downstream

Table 181: STONESOFT IPS-MIB objects

Object name Object description in MIB

ipsPolicyTime The time when the security policy was installed to the IPS engine

ipsSecurityPolicy Name of the current security policy on the IPS engine

ipsSoftwareVersion Version string of the IPS software
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Table 182: STONESOFT-NETNODE-MIB objects

Object name Object description in MIB

nodeClusterId The identification number of the cluster this node belongs to

nodeCPULoad The CPU load percentage on the node

nodeHwmonEvent Reason for the hardware monitoring event

nodeLastLogin The most recent logon event on the node

nodeLastLoginTime Time stamp of the most recent logon event on the node

nodeMemberId Node's member identification within the cluster

nodeOperState The operative (clustering) state of the node

nodeTestIdentity Identification string of a nodeTest

nodeTestResult The most recent result of the nodeTest

nodeTestResultTime The time stamp of the most recent result of the nodeTest

Table 183: IF-MIB supported objects

Object name Object description in MIB

ifAdminStatus The state of the interface that the administrator wants. The testing(3) state indicates that no
operational packets can be passed. When a managed system initializes, all interfaces start
with ifAdminStatus in the down(2) state. As a result of either explicit management action
or per configuration information retained by the managed system, ifAdminStatus is then
changed to either the up(1) or testing(3) states (or remains in the down(2) state).

ifAlias This object is an 'alias' name for the interface as specified by a network manager, and
provides a non-volatile 'handle' for the interface. On the first instantiation of an interface,
the value of ifAlias associated with that interface is the zero-length string. As and when a
value is written into an instance of ifAlias through a network management set operation,
then the agent must retain the supplied value in the ifAlias instance associated with the
same interface for as long as that interface remains instantiated, including across all
reinitializations or reboots of the network management system, including those which
result in a change of the interface's ifIndex value. An example of the value which a network
manager might store in this object for a WAN interface is the (Telco's) circuit number or
identifier of the interface. Some agents can support write-access only for interfaces having
particular values of ifType. An agent which supports write access to this object is required to
keep the value in non-volatile storage, but it can limit the length of new values depending on
how much storage is already occupied by the current values for other interfaces.

ifDescr A textual string containing information about the interface. This string includes the name of
the manufacturer, the product name, and the version of the interface hardware or software.

ifHCInMulticastPkts The 64-bit wide number of packets, delivered by this sublayer to a higher (sub)layer,
which were addressed to a multicast address at this sublayer. For a MAC layer protocol,
this includes both Group and Functional addresses. This object is a 64-bit version of
ifInMulticastPkts. Discontinuities in the value of this counter can occur at reinitialization
of the network management system, and at other times as indicated by the value of
ifCounterDiscontinuityTime.

The 32-bit ifInMulticastPkts reports the low 32-bits of this counter's value.

ifHCInOctets The 64-bit wide total number of octets received on the interface, including framing
characters. This object is a 64-bit version of ifInOctets. Discontinuities in the value of this
counter can occur at reinitialization of the network management system, and at other times
as indicated by the value of ifCounterDiscontinuityTime.

The 32-bit ifInOctets reports the low 32-bits of this counter's value.
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Object name Object description in MIB

ifHCInUcastPkts The 64-bit wide number of packets, delivered by this sublayer to a higher (sub-)layer, which
were not addressed to a multicast or broadcast address at this sublayer. This object is
a 64-bit version of ifInUcastPkts. Discontinuities in the value of this counter can occur at
reinitialization of the network management system, and at other times as indicated by the
value of ifCounterDiscontinuityTime.

The 32-bit ifInUcastPkts reports the low 32-bits of this counter's value.

ifHCOutOctets The 64-bit wide total number of octets transmitted out of the interface, including framing
characters. This object is a 64-bit version of ifOutOctets. Discontinuities in the value of this
counter can occur at reinitialization of the network management system, and at other times
as indicated by the value of ifCounterDiscontinuityTime.

The 32-bit ifOutOctets reports the low 32-bits of this counter's value.

ifHCOutUcastPkts The 64-bit wide total number of packets that higher-level protocols requested to be
transmitted, and which were not addressed to a multicast or broadcast address at this
sublayer, including those packets that were discarded or not sent. This object is a 64-
bit version of ifOutUcastPkts. Discontinuities in the value of this counter can occur at
reinitialization of the network management system, and at other times as indicated by the
value of ifCounterDiscontinuityTime.

The 32-bit ifOutUcastPkts reports the low 32-bits of this counter's value.

ifHighSpeed An estimate of the interface's current bandwidth in units of 1,000,000 bits per second. If this
object reports a value of 'n', then the speed of the interface is somewhere in the range of
'n-500,000' to 'n+499,999'. For interfaces which do not vary in bandwidth or for those where
no accurate estimation can be made, this object contains the nominal bandwidth. For a
sublayer which has no concept of bandwidth, this object must be zero.

ifIndex A unique value, greater than zero, for each interface. It is recommended that values are
assigned contiguously starting from 1. The value for each interface sublayer must remain
constant at least from one reinitialization of the entity's network management system to the
next reinitialization.

ifInDiscards The number of inbound packets which were chosen to be discarded even though no errors
had been detected to prevent their being deliverable to a higher-layer protocol. One possible
reason for discarding such a packet could be to free up buffer space. Discontinuities in the
value of this counter can occur at reinitialization of the network management system, and at
other times as indicated by the value of ifCounterDiscontinuityTime.

ifInErrors For packet-oriented interfaces, the number of inbound packets that contained errors
preventing them from being deliverable to a higher-layer protocol. For character- oriented
or fixed-length interfaces, the number of inbound transmission units that contained errors
preventing them from being deliverable to a higher-layer protocol. Discontinuities in the value
of this counter can occur at reinitialization of the network management system, and at other
times as indicated by the value of ifCounterDiscontinuityTime.

ifInMulticastPkts The 32-bit wide number of packets, delivered by this sublayer to a higher (sub)layer, which
were addressed to a multicast address at this sublayer. For a MAC layer protocol, this
includes both Group and Functional addresses. Discontinuities in the value of this counter
can occur at reinitialization of the network management system, and at other times as
indicated by the value of ifCounterDiscontinuityTime.

This object reports the low 32-bits of the 64-bit ifHCInMulticastPkts counter's value.

ifInOctets The 32-bit wide total number of octets received on the interface, including framing
characters. Discontinuities in the value of this counter can occur at reinitialization of
the network management system, and at other times as indicated by the value of
ifCounterDiscontinuityTime.

This object reports the low 32-bits of the 64-bit ifHCInOctets counter's value.
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Object name Object description in MIB

ifInUcastPkts The 32-bit wide number of packets, delivered by this sublayer to a higher (sub-)layer, which
were not addressed to a multicast or broadcast address at this sublayer. Discontinuities in
the value of this counter can occur at reinitialization of the network management system, and
at other times as indicated by the value of ifCounterDiscontinuityTime.

This object reports the low 32-bits of the 64-bit ifHCInUcastPkts counter's value.

ifLastChange The value of sysUpTime at the time the interface entered its current operational state. If the
current state was entered before the last reinitialization of the local network management
subsystem, this object contains a zero value.

ifLinkUpDownTrapEnable Indicates whether linkUp or linkDown traps are generated for this interface. By default, this
object must have the value enabled(1) for interfaces which do not operate on 'top' of any
other interface (as defined in the ifStackTable), and disabled(2) otherwise.

ifMtu The size of the largest packet which can be sent or received on the interface, specified in
octets. For interfaces that are used for transmitting network datagrams, this is the size of the
largest network datagram that can be sent on the interface.

ifName The textual name of the interface. The value of this object must be the name of the interface
as assigned by the local device. It must be suitable for use in commands entered at the
device's 'console'. This name might be a text name, such as 'le0' or a simple port number,
such as '1', depending on the interface naming syntax of the device. If several entries in
the ifTable together represent a single interface as named by the device, each will have
the same value of ifName. For an agent which responds to SNMP queries concerning an
interface on some other (proxied) device, then the value of ifName for such an interface is
the proxied device's local name for it. If there is no local name, or this object is otherwise not
applicable, this object contains a zero-length string.

ifNumber The number of network interfaces (regardless of their current state) present on this system.

ifOperStatus The current operational state of the interface. The testing(3) state indicates that no
operational packets can be passed. If ifAdminStatus is down(2), then ifOperStatus is
down(2). If ifAdminStatus is changed to up(1), then ifOperStatus changes to up(1) if
the interface is ready to transmit and receive network traffic; it changes to dormant(5) if
the interface is waiting for external actions (such as a serial line waiting for an incoming
connection); it remains in the down(2) state if and only if there is a fault that prevents it from
going to the up(1) state; it remains in the notPresent(6) state if the interface has missing
(typically, hardware) components.

ifOutDiscards The number of outbound packets which were chosen to be discarded even though no errors
had been detected to prevent their being transmitted. One possible reason for discarding
such a packet could be to free up buffer space. Discontinuities in the value of this counter
can occur at reinitialization of the network management system, and at other times as
indicated by the value of ifCounterDiscontinuityTime.

ifOutErrors For packet-oriented interfaces, the number of outbound packets that could not be
transmitted because of errors. For character-oriented or fixed-length interfaces,
the number of outbound transmission units that could not be transmitted because
of errors. Discontinuities in the value of this counter can occur at reinitialization of
the network management system, and at other times as indicated by the value of
ifCounterDiscontinuityTime.

ifOutOctets The 32-bit wide total number of octets transmitted out of the interface, including framing
characters. Discontinuities in the value of this counter can occur at reinitialization of
the network management system, and at other times as indicated by the value of
ifCounterDiscontinuityTime.

This object reports the low 32-bits of the 64-bit ifHCOutOctets counter's value.
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Object name Object description in MIB

ifOutUcastPkts The 32-bit wide total number of packets that higher-level protocols requested to be
transmitted, and which were not addressed to a multicast or broadcast address at this
sublayer, including the packets that were discarded or not sent. Discontinuities in the value
of this counter can occur at reinitialization of the network management system, and at other
times as indicated by the value of ifCounterDiscontinuityTime.

This object reports the low 32-bits of the 64-bit ifHCOutUcastPkts counter's value.

ifPhysAddress The interface's address at its protocol sublayer. For example, for an 802.x interface, this
object normally contains a MAC address. The interface's media-specific MIB must define
the bit and byte ordering and the format of the value of this object. For interfaces that do not
have such an address (for example, a serial line), this object must contain an octet string of
zero length.

ifPromiscuousMode This object has a value of false(2) if this interface only accepts packets or frames that
are addressed to this station. This object has a value of true(1) when the station accepts
all packets or frames transmitted on the media. The value true(1) is only legal on certain
types of media. If legal, setting this object to a value of true(1) might require the interface
to be reset before becoming effective. The value of ifPromiscuousMode does not affect the
reception of broadcast and multicast packets or frames by the interface.

ifSpeed An estimate of the interface's current bandwidth in bits per second. For interfaces which
do not vary in bandwidth or for those where no accurate estimation can be made, this
object must contain the nominal bandwidth. If the bandwidth of the interface is greater than
the maximum value reportable by this object, then this object must report its maximum
value (4,294,967,295) and ifHighSpeed must be used to report the interface's speed. For a
sublayer which has no concept of bandwidth, this object must be zero.

ifType The type of interface. Additional values for ifType are assigned by the Internet Assigned
Numbers Authority (IANA), through updating the syntax of the IANAifType textual
convention.

Table 184: SNMP-USER-BASED-SM-MIB objects

Object name Object description in MIB

usmStatsDecryptionErrors The total number of packets received by the SNMP engine which were dropped
because they could not be decrypted.

usmStatsNotInTimeWindows The total number of packets received by the SNMP engine which were dropped
because they appeared outside of the authoritative SNMP engine's window.

usmStatsUnknownEngineIDs The total number of packets received by the SNMP engine which were dropped
because they referenced an snmpEngineID that was not known to the SNMP
engine.

usmStatsUnknownUserNames The total number of packets received by the SNMP engine which were dropped
because they referenced a user that was not known to the SNMP engine.

usmStatsUnsupportedSecLevels The total number of packets received by the SNMP engine which were dropped
because they requested a security Level that was unknown to the SNMP engine
or otherwise unavailable.

usmStatsWrongDigests The total number of packets received by the SNMP engine which were dropped
because they did not contain the expected digest value.

usmUserSpinLock An advisory lock used to allow several cooperating Command Generator
Applications to coordinate their use of facilities to change secrets in the
usmUserTable.
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Object name Object description in MIB

usmUserStatus The status of this conceptual row. Until instances of all corresponding columns
are appropriately configured, the value of the corresponding instance of the
usmUserStatus column is 'notReady'. In particular, a newly created row for a
user who employs authentication cannot be made active until the corresponding
usmUserCloneFrom and usmUserAuthKeyChange have been set. Further, a
newly created row for a user who also employs privacy cannot be made active
until the usmUserPrivKeyChange has been set. The RowStatus TC [RFC2579]
requires that this DESCRIPTION clause states under which circumstances
other objects in this row can be edited: The value of this object has no effect
on whether other objects in this conceptual row can be edited, except for
usmUserOwnAuthKeyChange and usmUserOwnPrivKeyChange. For these 2
objects, the value of usmUserStatus MUST be active.

Table 185: SNMPv2-MIB supported objects

Object name Object description in MIB

snmpEnableAuthenTraps Indicates whether the SNMP entity is permitted to generate authenticationFailure
traps. The value of this object overrides any configuration information; as such,
it provides a means whereby all authenticationFailure traps can be disabled. It is
recommended that this object is stored in non-volatile memory so that it remains
constant across reinitializations of the network management system.

snmpInASNParseErrs The total number of ASN.1 or BER errors encountered by the SNMP entity when
decoding received SNMP messages.

snmpInBadCommunityNames The total number of SNMP messages delivered to the SNMP entity which used an
SNMP community name not known to said entity.

snmpInBadCommunityUses The total number of SNMP messages delivered to the SNMP entity which
represented an SNMP operation which was not allowed by the SNMP community
named in the message.

snmpInBadVersions The total number of SNMP messages which were delivered to the SNMP entity
and were for an unsupported SNMP version.

snmpInPkts The total number of messages delivered to the SNMP entity from the transport
service.

snmpProxyDrops The total number of GetRequest-PDUs, GetNextRequest-PDUs, GetBulkRequest-
PDUs, SetRequest-PDUs, and InformRequest-PDUs delivered to the SNMP entity
which were silently dropped because the transmission of the (possibly translated)
message to a proxy target failed in a manner (other than a time-out) such that no
Response-PDU could be returned.

snmpSetSerialNo An advisory lock used to allow several cooperating SNMPv2 entities, all acting in
a manager role, to coordinate their use of the SNMPv2 set operation. This object
is used for coarse-grain coordination. To achieve fine-grain coordination, one or
more similar objects might be defined within each MIB group, as appropriate.

snmpSilentDrops The total number of GetRequest-PDUs, GetNextRequest-PDUs, GetBulkRequest-
PDUs, SetRequest-PDUs, and InformRequest-PDUs delivered to the SNMP entity
which were silently dropped because the size of a reply containing an alternate
Response-PDU with an empty variable-bindings field was greater than either a
local constraint or the maximum message size associated with the originator of
the request.

sysContact The textual identification of the contact person for this managed node, together
with information about how to contact this person. If no contact information is
known, the value is the zero-length string.
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Object name Object description in MIB

sysDescr A textual description of the entity. This value must include the full name and
version identification of the system's hardware type, software operating-system,
and networking software.

sysLocation The physical location of this node (for example, 'telephone closet, 3rd floor'). If the
location is unknown, the value is the zero-length string.

sysName An administratively assigned name for this managed node. By convention, this is
the node's fully qualified domain name. If the name is unknown, the value is the
zero-length string.

sysObjectID The vendor's authoritative identification of the network management subsystem
contained in the entity. This value is allocated within the SMI enterprises subtree
(1.3.6.1.4.1) and provides an easy and unambiguous means for determining
'what kind of box' is being managed. For example, if vendor 'Flintstones,
Inc.' was assigned the subtree 1.3.6.1.4.1.4242, it could assign the identifier
1.3.6.1.4.1.4242.1.1 to its 'Fred Router'.

sysServices A value which indicates the set of services that this entity potentially offers. The
value is a sum. This sum initially takes the value zero. Then, for each layer, L, in
the range 1 through 7, that this node performs transactions for, 2 raised to (L - 1)
is added to the sum. For example, a node which performs only routing functions
would have a value of 4 (2^(3–1)). In contrast, a node which is a host offering
application services would have a value of 72 (2^(4–1) + 2^(7–1)). In the context
of the Internet suite of protocols, values must be calculated accordingly:

• layer functionality 1 physical (for example, repeaters).

• 2 datalink or subnetwork (for example, bridges).

• 3 Internet (for example, supports IP).

• 4 end-to-end (for example, supports TCP).

• 7 applications (for example, supports SMTP).

• For systems including OSI protocols, layers 5 and 6 can also be counted.

sysUpTime The time (in hundredths of a second) since the network management portion of
the system was last reinitialized.
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 Appendix H

Schema updates for external
LDAP servers

Contents

• Schema updates for external LDAP servers on page 1471

There are SMC-specific LDAP classes and attributes that you add to the schema of external LDAP servers.

Schema updates for external LDAP
servers

When adding SMC-specific LDAP classes and attributes to the schema of external LDAP servers, see the
following tables.

The SMC-specific attribute and class names start with “sg”. The classes are listed in the following table.

Table 186: SMC-specific LDAP classes

Class Description

sggroup SMC user group

sguser SMC user account

The SMC-specific attributes are listed in the following table.

Table 187: SMC-specific LDAP attributes

Attribute Related classes Description

sgactivation sguser Activation date for the user account.

sgauth sggroup, sguser Authentication service for the user or group.

sgdelay sggroup, sguser Number of days the user account is valid after the activation.

sgexpiration sguser Last day when the user account is valid and the user can log in.

sggrouptype sggroup Indicates the type of the group: a subtree or discrete group.

sgmember sggroup The Distinguished Name (DN) for the user member of this group.

sgpassword sguser MD5 message digest hash of the user password.

sgpresharedkey sguser IPsec PreSharedKey for the user account.

sgsubjectaltnames sguser IPsec certificate SubjectAltNames for the user account.
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Attribute Related classes Description

sgvirtualip sggroup, sguser Virtual IP allocation allowed for the user.

In addition to updating the directory schema, there can be some server-specific requirements. For Netscape
and OpenLDAP version 1.2.11 servers, you must configure the following lines to the LDAP server’s slapd.conf
configuration file after stopping the LDAP service.

Additional configuration for OpenLDAP v1.2.11 and Netscape server

include /etc/openldap/slapd.at.conf
include /etc/openldap/slapd.oc.conf
include /etc/openldap/sg-schema.conf
schemacheck on

For OpenLDAP server versions 2.0 and later, you must configure the following lines to the LDAP server’s
slapd.conf configuration file after stopping the LDAP service.

Additional configuration for OpenLDAP version 2.0 or later

include /etc/openldap/schema/core.schema
include /etc/openldap/schema/cosine.schema
include /etc/openldap/schema/inetorgperson.schema
include /etc/openldap/schema/sg-v3.schema
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 Appendix I

Log fields
Contents

• Log entry fields on page 1473
• Facility field values on page 1493
• Type field values on page 1495
• Action field values on page 1495
• Event field values on page 1496
• IPsec VPN log messages on page 1499
• Audit entry types on page 1504
• Syslog entries on page 1508
• Connection states on page 1508

For descriptions of all log fields, see the following reference.

Log entry fields
The following tables list the fields of the log entry table and the corresponding XML fields exported to syslog for
exportable log entry fields.

The rights of the administrator who views the logs and the log types that the administrator has selected for
viewing determine which fields are displayed.

Related reference
Non-exportable log entry fields on page 1474
Exportable alert log entry fields on page 1478
Exportable alert trace log entry fields on page 1478
Exportable audit log entry fields on page 1479
Exportable Firewall and Layer 2 Firewall log entry fields on page 1480
Exportable IPS log entry fields on page 1482
Exportable IPS recording log entry fields on page 1492
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Non-exportable log entry fields
The following log entry fields can be displayed in the log table, but cannot be exported to syslog.

Table 188: Non-exportable log entry fields

Field Description

Additional Situation Identifier of an additional situation that was detected simultaneously with the
situation that triggered the log event.

APN The access point name (APN) of the mobile service in GTP traffic.

Blacklist response.Blacklist duration Duration of blacklisting in seconds.

Blacklist response.Blacklist executor Firewall or sensor that blacklisted the traffic that triggered the log event.

Blacklist response.Endpoint1 addr Blacklisted IP addresses for Endpoint1.

Blacklist response.Endpoint1 mask Netmask for blacklisted Endpoint1 IP address (32 = host address).

Blacklist response.Endpoint1 port Blacklisted Endpoint1 port (empty = all ports).

Blacklist response.Endpoint1 port range Blacklisted Endpoint1 port range.

Blacklist response.Endpoint2 addr Blacklisted IP addresses for Endpoint2.

Blacklist response.Endpoint2 mask Netmask for blacklisted Endpoint2 IP address (32 = host address).

Blacklist response.Endpoint2 port Blacklisted Endpoint2 port (empty = all ports).

Blacklist response.Endpoint2 port range Blacklisted Endpoint2 port range.

Blacklist response.Firewall ID ID number of firewall node for which the blacklist request is assigned (this must
match the Firewall ID given to the blacklist Analyzer module).

Blacklist response.IP Protocol IP protocol of the blacklist response.

Blacklist response.Value missing in Blacklist Response field for which value resolving failed.

Certificate verify error TLS/SSL Certificate verify error code related to this event.

Client Application The client application that opened the connection.

Client Executable The product name and version of the client executable file, when available, or the
file name of the client executable file when the product name and version are not
available.

Connection analysis end The application could not continue analyzing the traffic stream after this event.

Correlation base component ID The policy used to decide a response after successful correlation. Usually the
value of this field is the same as "Component ID", and the field is omitted.

Data type Data type of the log.

Dst VPN The destination VPN of the connection.

Element Domain Administrative Domain of the element associated with the event.

Endpoint The VPN Endpoint through which the traffic that triggered the log event was sent
or received.

Ethernet main type Ethernet frame main type (Ethernet 2, IPX, LLC, SNAP).

Event type Description of the event triggered the log creation.

Executable File The file name part of the pathname to the client executable file that connects
through the firewall.
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Field Description

Executable MD5 The MD5 checksum of the client executable file that connects through the firewall.

Executable Path The path to the client executable file that connects through the firewall.

Executable Product The product name of the client executable file, when available. The EIA client
reports the product name when the executable file is signed.

Executable Signer The signer of the client executable file that connects through the firewall.

Executable Signer SHA1 The SHA1 checksum of the signer of the client executable file that connects
through the firewall.

Executable Version The product version of the client executable file, when available. The EIA client
reports the product version when the executable file is signed.

File The file name part of the pathname to the file that the anti-malware engine scans.

File MD5 The MD5 checksum of the pathname to the file that the anti-malware engine
scans.

GRE protocol Protocol number of the GRE payload packet.

GRE version Version of the GRE header.

GTI Reputation The file reputation from the McAfee Global Threat Intelligence cloud service.

HTTP User Agent The HTTP header that identifies the web browser used to access the service.

HTTP Referrer The HTTP header that includes the referrer information.

HTTP XFF Client The originating IP address of the client that connects to the destination server
through one or several HTTP proxies.

HTTP XFF Proxies The IP addresses of the HTTP proxy between the originating client IP address
and the destination server.

IMSI The international mobile subscriber identity of mobile subscriber connecting to the
network in GTP traffic.

IP frag conflict range.IP frag different
bytes

Total number of conflicting bytes.

IP frag conflict range.IP frag different
bytes first

First conflicting byte in the IP fragment.

IP frag conflict range.IP frag different
bytes last

Last conflicting byte in the IP fragment.

IP frag conflict range.IP frag different
new first

Value of the first conflicting byte in the latest fragment.

IP frag conflict range.IP frag different
new last

Value of the last conflicting byte in the latest fragment.

IP frag conflict range.IP frag different
old first

Value of the first conflicting byte in an earlier fragment.

IP frag conflict range.IP frag different
old last

Value of the last conflicting byte in an earlier fragment.

IPv6 extension header type IPv6 extension header type as indicated by the next header value of the
preceding header.

IPv6 extension header's length IPv6 extension header length as indicated by the value of the hdr_ext_len field in
the extension header.

IPv6 hop limit Hop limit field in the IPv6 header.
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Field Description

IPv6 option data length IPv6 option data length.

IPv6 option offset IPv6 option offset from the beginning of the IPv6 extension header.

IPv6 option type IPv6 option type.

IPv6 routing final destination Final destination address in the IPv6 routing header.

IPv6 routing header type IPv6 routing header type.

IPv6 routing segments left Segments left value in the IPv6 routing header.

LLC DSAP Logical Link Control Destination Service Access Point.

LLC SSAP Logical Link Control Source Service Access Point.

Log Data Tags The number of different Log Data Tags associated with the log event. You can
see a detailed listing of the Log Data Tags in the Fields pane or the Details view.

Login Domain The administrative Domain in which the action that triggered the log event was
taken.

Malware Malware identifier (if available) provided by the responding scanner. If the
malware identifier is not available, contains the reputation returned by the
responding scanner.

Message ID The Message Type Value of the GTP message.

MSISDN The mobile subscriber-integrated services digital network-number (MSISDN) of
the GTP message.

Normalized URI normalization was used to find the match.

Overview Observed overview.

Overview Name Name of the observed overview.

Overview Section Summary of the observed section definition.

Packets Rcvd The number of packets that are received during the connection.

Packets Sent The number of packets that are sent during the connection.

Peer VPN Gateway The peer of the VPN Gateway through which the log event was sent or received.

Reference event ID Reference to a related event.

Reference event ID.Ref Comp Id Sender identifier of the referred event.

Reference event ID.Ref Creation Time Creation time of the referred event.

Reference event ID.Ref Event ID Identifier of the referred event.

Responding Scanner The name of the scanner or service that produced a file reputation or a scan result
for a file filtering event.

Roles Roles of the Administrator who triggered the event.

Sandbox Reputation The file reputation from the Forcepoint Advanced Malware Detection sandbox
service.

Scan Report A link to the Forcepoint Advanced Malware Detection sandbox analysis report.
For the cloud sandbox, the report opens in an external portal.

Scanner Details More detailed information about how the file reputation or scan result was
acquired in a file filtering event.

Sender Domain Administrative Domain from which the log entry was sent.
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Field Description

Sender module version.Sender build Build number of the engine that generated the event.

Sender module version.Sender module
major

Major version of the engine module that generated the event.

Sender module version.Sender module
minor

Minor version of the engine module that generated the event.

Sender module version.Sender module
pl

Patch version of the engine module that generated the event.

Sequence Number The sequence number of the GTP message.

Situation Type The type of the situation that triggered the log event.

SNAP Organization Code Subnetwork Access Protocol Organization Code.

SNMP Return Src IF The SNMP index of the return source interface.

SNMP Src IF The SNMP index of the source interface.

Src VPN The source VPN of the connection.

SSL/TLS Domain Domain name field in SSL/TLS certificate related to the event.

SSL VPN Portal Service Name The title for the service shown on the SSL VPN Portal webpage.

State Connection state in connection monitoring.

Subexpression Count The number of concurrent independent subexpressions.

TEID The tunnel endpoint identifier (TEID) of the GTP message.

TIE/ePO Reputation The value that is configured for the file on the McAfee ePO server and received
via the McAfee® Threat Intelligence Exchange (TIE) server.

TCP urgent pointer Urgent pointer value in the TCP header.

TCP window size TCP receive window size.

TCP window shrinkage The amount by which the TCP window shrunk.

Threshold Check Time Threshold measurement end time.

Threshold Description Description of threshold limitation.

Threshold Measured Value Value exceeding the threshold.

TLS Alert Description TLS/SSL alert message description.

TLS Alert Level TLS/SSL alert message alert level.

TLS cipher suite TLS/SSL cipher suite.

TLS compression method TLS/SSL compression method.

TLS Protocol Version TLS/SSL protocol version.

Tunneled destination The destination IP address of tunneled GTP traffic.

Tunneled source The source IP address of tunneled GTP traffic.

Tunneling level Number of tunneling protocol layers encapsulating this protocol layer.

User and Group Information User and Group Information related to the event.

Version The GTP version of the GTP message.
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VPN The VPN through which the traffic that triggered the log event was sent or
received.

VPN Gateway The VPN Gateway through which the log event was sent or received.

Exportable alert log entry fields
Alert log entry fields are described in the following table. Because the fields are exportable, the table includes the
syslog export field.

Table 189: Alert log entry fields

Field Syslog export field Description

Acknowledged ACK Acknowledged alert.

Alert Type ALERT Type of alert.

Component ID COMP_ID The identifier of the creator of the log entry.

Creation Time TIMESTAMP Log entry creation time.

Dst Addr DST Packet destination IP address.

Dst Port DPORT TCP or UDP destination port in the packet header.

Event ID EVENT_ID Event identifier, unique within one sender.

Information message INFO_MSG A description of the log event that further explains the entry.

Protocol PROTOCOL Connection IP protocol.

Reception time RECEPTION_TIME Time when the entry was received by the Log Server.

Reference event ID REF_EVENT Reference to a related event.

Rule Tag RULE_ID Rule tag of the rule that triggered the log event.

Sender NODE_ID IP address of the engine or server that sent the log entry.

Sender type SENDER_TYPE The type of engine or server that sent the log entry.

Severity ALERT_SEVERITY Severity of the situation related to the alert event.

Situation SITUATION The identifier of the situation that triggered the log event.

Src Port SPORT TCP or UDP source port in the packet header.

Exportable alert trace log entry fields
Alert trace log entry fields are described in the following table. Because the fields are exportable, the table
includes the syslog export field.

Table 190: Alert trace log entry fields

Field Syslog export field Description

Address EVENT_ADDRESS Destination for the alert notification.
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Field Syslog export field Description

Alert Event EVENT_TYPE Type of alert event.

Alert Identifier EVENT_LOG_ID Data Identifier of the alert.

Alert Time EVENT_TIME Time stamp of the alert.

Component ID COMP_ID The identifier of the creator of the log entry.

Creation Time TIMESTAMP Log entry creation time.

Data Identifier LOG_ID Data Identifier of the log entry.

Event description EVENT_INFO Description of the alert event.

Storage Server STORAGE_SERVER_ID Server where the alert is stored.

User EVENT_USER User who executed the action that produced the alert.

Exportable audit log entry fields
Audit log entry fields are described in the following table. Because the fields are exportable, the table includes the
syslog export field.

Table 191: Exportable audit log entry fields

Field Syslog export field Description

Administrator USER_ORIGINATOR Administrator who triggered the audit event.

Client IP address CLIENT_IP_ADDRESS Address of the client that triggered the audit event.

Component ID COMP_ID The identifier of the creator of the log entry.

Creation Time TIMESTAMP Log entry creation time.

Elements OBJECT_NAME Elements being manipulated in the audit event.

Event ID EVENT_ID Event identifier, unique within one sender.

Incident case INCIDENT_CASE The Incident case to which the logs or audit events are
related.

Information message INFO_MSG A description of the log event that further explains the entry.

Operation type TYPE_DESCRIPTION Type of action that triggered the audit entry.

Origin name ORIGIN_NAME Name of the component that triggered the audit event.

Result RESULT Result state after the audited event.

Rule Tag RULE_ID Rule tag of the rule that triggered the log event.

Sender NODE_ID IP address of the engine or server that sent the log entry.

Sender type SENDER_TYPE The type of engine or server that sent the log entry.
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Exportable Firewall and Layer 2 Firewall log
entry fields
Firewall and Layer 2 Firewall log entry fields are described in the following table. Because the fields are
exportable, the table includes the syslog export field.

Table 192: Firewall log entry fields

Field Syslog export field Description

Acknowledged ACK Acknowledged alert.

Action ACTION Action of the rule that triggered the log event. The action
values are Allow, Discard, Refuse, Terminate, Wait for
further actions, and Wait for authentication.

Alert Type ALERT Type of alert.

Auth. Rule Tag AUTH_RULE_ID Rule number of the rule that triggered the log event.

Auth. User AUTH_NAME User name of the authorized user related to this event.

Bytes Rcvd ACC_RX_BYTES Number of bytes received during the connection.

Bytes Sent ACC_TX_BYTES Number of bytes sent during the connection. The number of
bytes sent is counted when accounting entries are created.

Component ID COMP_ID The identifier of the creator of the log entry.

Creation Time TIMESTAMP Log entry creation time.

Data Identifier LOG_ID Data Identifier of the log entry.

DSCP Mark DSCP_MARK The DSCP Mark associated with the traffic that triggered the
log event.

Dst Addr DST Packet destination IP address.

Dst Port Dport TCP or UDP destination port in the packet header.

Elapsed Time ACC_ELAPSED Elapsed time of the connection in seconds. The elapsed time
is recorded when accounting entries are created at the time
of connection closing.

Event EVENT The event that triggered the log creation, for example, New
connection, Connection closed, Connection discarded.

Event ID EVENT_ID Event identifier, unique within one sender.

Facility FACILITY Firewall subsystem that generated the log event.

FP situation FP_SITUATION Situation identifier of a matching fingerprint.

ICMP code ICMP_CODE ICMP code field. ICMP code provides further information
about message type (for example, network unreachable). For
more information, see RFC 792 and RFC 950.

ICMP ID ICMP_ID The ICMP identifier recorded by the engine when ICMP
packets pass through the firewall. The ICMP identifier can be
used by the echo sender to aid in matching the replies with
the echo requests. For example, the identifier might be used
like a port in TCP or UDP to identify a session. For more
information about ICMP ID and the ICMP protocol, see RFC
792 and RFC 950.
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Field Syslog export field Description

ICMP Type ICMP_TYPE The ICMP type attribute ecorded by the engine when ICMP
packets pass through the firewall.

IKE Cookie IKE_COOKIE IKE Cookie used in the VPN negotiation.

Information message INFO_MSG A description of the log event that further explains the entry.

IPsec SPI IPSEC_SSPI The IPsec Security Parameter Index (SPI) is the connection
identifier of the IPsec connection. The IPsec SPI value is
displayed as a hexadecimal number.

NAT Dst NAT_DST Translated packet destination IP address.

NAT Dst Port NAT_DPORT Translated packet destination protocol port.

Nat Rule Tag NAT_RULE_ID The rule number of the NAT rule that triggered the log event.

NAT Src NAT_SRC Translated packet source IP address.

NAT Src Port NAT_SPORT Translated packet source protocol port.

Priority QOS_PRIORITY The priority assigned to the traffic according to the QoS
policy.

Protocol PROTOCOL Connection IP protocol.

Protocol Agent SRVHELPER_ID Protocol Agent numeric ID code.

QoS Class QOS_CLASS The Quality of Service class assigned to the traffic according
to the QoS policy.

Reception time RECEPTION_TIME Time when the Log Server received the entry.

Round trip RTT Round-trip time for outbound Multi-Link link testing. Time
indicated is from sending queries to the first reply. The unit is
0.01 seconds.

Rule Tag RULE_ID Rule tag of the rule that triggered the log event.

Sender NODE_ID IP address of the engine or server that sent the log entry.

Sender type SENDER_TYPE The type of engine or server that sent the log entry.

Service SERVICE Special field for filtering logs using the defined services.
Does not appear in the log entry table.

Severity ALERT_SEVERITY Severity of the situation related to the log event.

Situation SITUATION The identifier of the situation that triggered the log event.

Src Addr SRC Packet source IP address.

Src IF Srcif Defined source interface number for the firewall cluster.

Src Port Sport TCP or UDP source port in the packet header.

Src VLAN SRC_VLAN The source VLAN ID number (up to 4095).

Syslog SYSLOG_TYPE Syslog is a system service used in some operating systems,
for example, UNIX, and software packages. For more
information about syslog and syslog types, see RFC 3164.

Type TYPE Log entry severity type.
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Exportable IPS log entry fields
IPS log entry fields are described in the following table. Because the fields are exportable, the table includes the
syslog export field.

Table 193: IPS log entry fields

Field Syslog export field Description

Action ACTION Action of the rule that triggered the log
event.

Alert Type ALERT Type of alert.

Attacker IP IP_ATTACKER IPv4 address of the attacking host.

Blacklist executor FIREWALL_ID Firewall that blacklisted the traffic that
triggered the log event.

Blacklist response BLACKLIST_RESPONSE Firewall blacklist response that
triggered the log event.

Cluster ID CLUSTER_ID The identifier of the cluster to which the
node that created the log entry belongs.

Component ID COMP_ID The identifier of the creator of the log
entry.

Connection Analysis End CONNECTION_ANALYSIS_END The Application module could not
continue analyzing the traffic stream
after this event.

Connection dropped DROP_CONNECTION The connection was dropped by a Drop
Response in the rule.

Content type of message
body

SIP_CONTENT_TYPE Content type of the SIP message body.

Correlation base
component ID

CORRELATION_COMP_ID The policy that decides the response
after successful correlation.

Correlation begin time TIME_FRAME_BEGIN NTP stamp of the beginning of the
time frame for a match to a correlation
situation.

Correlation end time TIME_FRAME_END NTP stamp of the end of the time frame
for a match to a correlation situation.

Creation Time TIMESTAMP Log entry creation time.

Data Identifier LOG_ID Data Identifier of the log entry.

Datagram dropped DROP_DATAGRAM The datagram was dropped by a Drop
Response in the rule.

Destination port PORT_DEST TCP or UDP destination port in the
packet header. Included only for
backwards compatibility with legacy IPS
engines. For other cases, use Dst Port.

DNS class DNS_CLASS DNS resource record class.

DNS hdr ancount DNS_HDR_ANCOUNT DNS answers count.

DNS hdr arcount DNS_HDR_ARCOUNT DNS additional section count.

DNS hdr flag tc DNS_HDR_FLAG_TC DNS header flag TC.



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Log fields | 1483

Field Syslog export field Description

DNS hdr id DNS_HDR_ID DNS message ID.

DNS hdr is request DNS_HDR_IS_REQUEST DNS message is a request.

DNS hdr nscount DNS_HDR_NSCOUNT DNS authority section count.

DNS hdr opcode DNS_HDR_OPCODE DNS operation code.

DNS hdr qdcount DNS_HDR_QDCOUNT DNS questions count.

DNS hdr rcode DNS_HDR_RCODE DNS return code.

DNS name length DNS_NAME_LENGTH Length of DNS name in a message.

DNS offset DNS_OFFSET DNS message offset where the
situation occurs.

DNS pointer DNS_POINTER Name pointer in a DNS message.

DNS qclass DNS_QCLASS Query resource record class in a DNS
message.

DNS qname DNS_QNAME First queried name in a DNS message.

DNS qtype DNS_QTYPE Query type in a DNS message.

DNS section DNS_SECTION Section name in a DNS message.

DNS type DNS_TYPE DNS resource record type.

DNS UDP payload DNS_UDP_PAYLOAD UDP payload size of a DNS message.

DNS UDP payload by opt DNS_UDP_PAYLOAD_BY_OPT UDP payload advertised in a DNS OPT
record.

Dst Addr DST Packet destination IP address.

Dst Port DPORT TCP or UDP destination port in the
packet header.

Error Id ERROR_ID Identifier of the error that triggered the
log event.

Eth frame length ETH_FRAME_LENGTH Length of the Ethernet frame.

Eth min frame length ETH_MIN_FRAME_LENGTH Minimum length for Ethernet frame.

Ethernet type ETH_TYPE Type field in Ethernet frame.

Event count EVENT_COUNT Event count in the defined time frame.

Event ID EVENT_ID Event identifier, unique within one
sender.

Event update EVENT_UPDATE Event ID for which this event is an
update.

Excerpt data EXCERPT Short recording of the application level
data stream of the attack.

Excerpt position EXCERPT_POS Position in the attached short recording.

Facility FACILITY The firewall subsystem that created the
log entry.

Fields updatable FIELDS_UPDATABLE Map of updatable log fields.
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Field Syslog export field Description

Forward Rule Tag FORWARD_RULE_TAG The tag of the last matching rule when
forwarding the traffic to the agent that
created this log entry.

Frame dropped DROP_FRAME The frame was dropped by a Drop
Response in the rule.

From address SIP_FROM SIP From address.

FTP account len FTP_ACCOUNT_LEN Length of the FTP account string.

FTP adat argument len FTP_ADAT_ARG_LEN Length of ADAT command argument.

FTP allocate size FTP_ALLOCATE_SIZE Size of FTP allocate.

FTP arg len FTP_ARG_LEN Length of the FTP command argument.

FTP auth arg len FTP_AUTH_ARG_LEN Length of the AUTH argument.

FTP Cmd Name FTP_CMD_NAME The name of the FTP command without
any arguments.

FTP client state name FTP_CLIENT_STATE_NAME The detected FTP client state.

FTP clnt arg len FTP_CLNT_ARG_LEN Length of the FTP CLNT argument.

FTP command FTP_COMMAND Name of the FTP command.

FTP conf arg len FTP_CONF_ARG_LEN Length of the CONF command
argument.

FTP enc arg len FTP_ENC_ARG_LEN Length of the ENC command argument.

FTP eprt arg len FTP_EPRT_ARG_LEN Length of the EPRT command
argument.

FTP estp arg len FTP_ESTP_ARG_LEN Length of the ESTP command
argument.

FTP help arg len FTP_HELP_ARG_LEN Length of the HELP command
argument.

FTP lang arg len FTP_LANG_ARG_LEN Length of the LANG command
argument.

FTP lprt arg len FTP_LPRT_ARG_LEN Length of the LPRT command
argument.

FTP marker len FTP_MARKER_LEN Length of the REST command
argument.

FTP mic arg len FTP_MIC_ARG_LEN Length of the MIC command argument.

FTP opts arg len FTP_OPTS_ARG_LEN Length of the OPTS command
argument.

FTP password len FTP_PASSWORD_LEN Length of the detected FTP password.

FTP pathname len FTP_PATHNAME_LEN Length of the detected FTP pathname.

FTP protection buffer size FTP_PROTECTION_BUFFER_SIZE Size of the detected PBSZ protection
buffer.

FTP reply FTP_REPLY The detected FTP server reply.

FTP reply code FTP_REPLY_CODE The detected FTP server reply code.
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FTP reply len FTP_REPLY_LEN Length of an FTP server reply that is
too long.

FTP reply line len FTP_REPLY_LINE_LEN Length of an FTP server reply line that
is too long.

FTP server action FTP_SERVER_ACTION FTP server action after a suspicious
client command.

FTP server banner FTP_SERVER_BANNER The detected FTP server banner.

FTP server state name FTP_SERVER_STATE_NAME The detected FTP server state.

FTP site arg len FTP_SITE_ARG_LEN Length of the SITE command
argument.

FTP state name FTP_STATE_NAME The detected FTP session state.

FTP username len FTP_USERNAME_LEN Length of the detected FTP user name.

HTTP header HTTP_HEADER The detected HTTP header field.

HTTP header name HTTP_HEADER_NAME The detected HTTP header field name.

HTTP no request HTTP_NO_REQUEST The detected HTTP response could not
be associated to any request.

HTTP request host HTTP_REQUEST_HOST HTTP request host.

HTTP request line HTTP_REQUEST_LINE The detected HTTP request line.

HTTP request message
field name length

HTTP_REQUEST_MESSAGE_FIELD_
NAME_LENGTH

Length of the HTTP request header
field name.

HTTP request message
field value length

HTTP_REQUEST_MESSAGE_FIELD_
VALUE_LENGTH

Length of the HTTP request header
field value.

HTTP request method HTTP_REQUEST_METHOD The detected HTTP request method.

HTTP request URI HTTP_REQUEST_URI The detected HTTP request URI.

HTTP request version HTTP_REQUEST_VERSION The detected HTTP request version.

HTTP requests not stored HTTP_REQUESTS_NOT_STORED Number of requests not stored due to
HTTP pipeline overflow.

HTTP response code HTTP_RESPONSE_CODE The detected HTTP response code.

HTTP response message
field name length

HTTP_RESPONSE_MESSAGE_FIELD_
NAME_LENGTH

Length of the HTTP response header
field name.

HTTP response message
field value length

HTTP_RESPONSE_MESSAGE_FIELD_
VALUE_LENGTH

Length of the HTTP response header
field value.

HTTP URI length HTTP_URI_LENGTH Length of HTTP request URI

ICMP code ICMP_CODE ICMP code field. ICMP code provides
further information about message type
(for example, network unreachable).
For more information, see RFC 792
andRFC 950.

ICMP expected message
length

ICMP_EXPECTED_MESSAGE_LENGTH Expected length of the ICMP message.

ICMP field addr entry size ICMP_FIELD_ADDR_ENTRY_SIZE Value of the detected ICMP address
entry size field.
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Field Syslog export field Description

ICMP field address mask ICMP_FIELD_ADDRESS_MASK Value of detected ICMP address mask
field.

ICMP field domain name ICMP_FIELD_DOMAIN_NAME Value of the detected ICMP domain
name field.

ICMP field gateway IP
addr

ICMP_FIELD_GATEWAY_IP_ADDR Value of the detected ICMP gateway
address field.

ICMP field lifetime ICMP_FIELD_LIFETIME Value of the ICMP lifetime field.

ICMP field num addrs ICMP_FIELD_NUM_ADDRS Value of the ICMP number of
addresses field.

ICMP field originate
timestamp

ICMP_FIELD_ORIGINATE_TIMESTAMP Value of the ICMP originate time stamp
field.

ICMP field outbound hop
count

ICMP_FIELD_OUTBOUND_HOP_COUNT Value of the ICMP outbound hop count
field.

ICMP field output link mtu ICMP_FIELD_OUTPUT_LINK_MTU Value of the ICMP output link MTU
field.

ICMP field output link
speed

ICMP_FIELD_OUTPUT_LINK_SPEED Value of the ICMP output link speed
field.

ICMP field pointer ICMP_FIELD_POINTER The offset in the related datagram
where the situation occurred.

ICMP field preference
level

ICMP_FIELD_PREFERENCE_LEVEL Value of the ICMP preference level
field.

ICMP field receive
timestamp

ICMP_FIELD_RECEIVE_TIMESTAMP Value of the ICMP receive time stamp
field.

ICMP field return hop
count

ICMP_FIELD_RETURN_HOP_COUNT Value of the ICMP return hop count
field.

ICMP field router addr ICMP_FIELD_ROUTER_ADDRESS Value of the ICMP router address field.

ICMP field sequence num ICMP_FIELD_SEQUENCE_NUMBER Value of the ICMP sequence number
field.

ICMP field traceroute id ICMP_FIELD_TRACEROUTE_ID Value of the ICMP traceroute ID field.

ICMP field transmit
timestamp

ICMP_FIELD_TRANSMIT_TIMESTAMP Value of the ICMP transmit time stamp
field.

ICMP ID ICMP_ID The ICMP identifier recorded by the
engine when ICMP packets pass
through the firewall. The ICMP identifier
can be used by the echo sender to aid
in matching the replies with the echo
requests. For example, the identifier
might be used like a port in TCP or
UDP to identify a session. For more
information about ICMP ID and the
ICMP protocol, see RFC 792 and RFC
950.

ICMP message length ICMP_MESSAGE_LENGTH Length of the ICMP message.

ICMP referenced
destination IP addr

ICMP_REFERENCED_DESTINATION_ IP_ADDR Destination IP address of the datagram
related to the ICMP message.
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ICMP referenced
destination port

ICMP_REFERENCED_DESTINATION_PORT Destination port of the datagram related
to the ICMP message.

ICMP referenced IP proto ICMP_REFERENCED_IP_PROTO IP Protocol field of the datagram related
to the ICMP message.

ICMP referenced source
IP addr

ICMP_REFERENCED_SOURCE_IP_ADDR Source IP address of the datagram
related to the ICMP message.

ICMP referenced source
port

ICMP_REFERENCED_SOURCE_PORT Source port of IP datagram related to
the ICMP message.

ICMP Type ICMP_TYPE The Internet Control Message Protocol
is an extension to the Internet Protocol
(IP) that supports packets containing
error, control, and informational
messages. ICMP messages are
sent using the basic IP header. The
first octet of the data portion of the
datagram is an ICMP type field. For
more information, see RFC 792 and
RFC 950.

Imf encoded word IMF_ENCODED_WORD Encoded word token related to this
event.

Imf header field IMF_HEADER_FIELD Contents (possibly partial) of the mail
header field related to this event.

Imf header field name IMF_HEADER_FIELD_NAME Name of the mail header field related to
this event.

Imf header field position IMF_HEADER_FIELD_POSITION Number of characters processed in
this header field when this event was
generated.

Imf token IMF_TOKEN Syntactical token in the mail body
related to this event.

Imf token length IMF_TOKEN_LENGTH Length of the syntactical token in the
mail body related to this event.

Information message INFO_MSG A description of the log event that
further explains the entry.

IP checksum IP_CHECKSUM Value of the IP header checksum.

IP datagram length IP_DATAGRAM_LENGTH Length of the IP datagram.

IP datagram new length IP_DATAGRAM_NEW_LENGTH The new suggested length for the IP
datagram.

IP destination IP_DEST Destination IP address in the packet
header. Included only for backwards
compatibility for legacy IPS. For other
cases, use Dst Addr.

IP frag conflict range IP_FRAG_CONFLICT_RANGE Conflicting byte range in a fragment.

IP fragment offset IP_FRAGMENT_OFFSET Fragment offset in the IP header.

IP header length IP_HEADER_LENGTH Length of the IP header.

IP identification IP_IDENTIFICATION Identification field in the IP header.
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IP offset IP_OFFSET Start IP offset from the beginning of the
Ethernet frame.

IP option length IP_OPTION_LENGTH Length of the IP option that triggered
the response.

IP option number IP_OPTION_NUMBER IP option number that triggered the
response.

IP protocol PROTOCOL IP protocol of the traffic that generated
the log event.

IP source IP_SOURCE Source IP address in the packet
header. Included for backwards
compatibility with legacy IPS. For other
cases, use Src Addr.

IP total length IP_TOTAL_LENGTH Total length of the IP datagram.

IP version IP_VERSION Version field value in the IP header.

Length of message body SIP_CONTENT_LENGTH Length of the SIP message body.

Logical interface IF_LOGICAL Logical interface for a packet.

MAC destination MAC_DEST Destination MAC address in the packet
header.

MAC source MAC_SOURCE Source MAC address in the packet
header.

Module SENDER_MODULE_ID Sender module identification.

Node configuration NODE_CONFIGURATION Current configuration of the node that
sent the log entry.

Node dynup NODE_DYNUP Dynamic update package level of the
node that sent the log entry.

Node version NODE_VERSION Node version of the node that sent the
log entry.

Not final value NOT_FINAL_VALUE Entry is not final.

One LAN ONE_LAN The "View interface as one LAN" option
was enabled on the logical interface
through which the packet was received.

Orig config id ORIG_CONFIG_ID Configuration identifier related to the
Situation in the referred event.

Orig sender module
version

ORIG_SENDER_MODULE_VERSION Module version in the referred event.

Orig sender os ver ORIG_SENDER_OS_VER The operating system version of the
sender of the referred event.

Original Alert Type ORIG_ALERT Type of alert in the referred event.

Original correlation begin
time

ORIG_TIME_FRAME_BEGIN NTP stamp of the beginning of the time
frame in the referred event.

Original correlation end
time

ORIG_TIME_FRAME_END NTP stamp of the end of the time frame
in the referred event.

Original event count ORIG_EVENT_COUNT Number of events in the time frame of
the referred event.
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Original module ORIG_SENDER_MODULE_ID Sender module identification in the
referred event.

Original severity ORIG_ALERT_SEVERITY Severity of the referred event.

Original situation ORIG_SITUATION Identifier of the situation that triggered
the referred event.

Original time ORIG_TIMESTAMP Creation time of the referred event.

Packet analysis end PACKET_ANALYSIS_END Module could not continue analyzing
packet or datagram after this event.

Packet not seen PACKET_NOT_SEEN Flag indicating that the related packet
was not seen.

Physical interface IF_PHYSICAL Physical interface for a packet.

Protocol PROTOCOL Connection IP protocol.

Protocol Agent SRVHELPER_ID Protocol Agent numerical ID code.

Reception time RECEPTION_TIME Time when the entry was received by
the Log Server.

Record ID RECORD_ID Identifier of the traffic recording.

Reference event ID REF_EVENT Reference to a related event.

Rule Tag RULE_ID Rule tag of the rule that triggered the
log event.

Scan ICMP Echo No
Reply Cnt

SCAN_ICMP_ECHO_ NO_RESPONSE_ COUNTER Number of distinct ICMP Echo Request
(ping) destinations that did not reply to
a request.

Scan ICMP Echo
Request Cnt

SCAN_ICMP_ECHO_REQUEST_ COUNTER Number of distinct ICMP Echo Request
(ping) destinations detected.

Scan ICMP Echo Targets SCAN_ICMP_ECHO_TARGETS List of the detected ICMP Echo
Request (ping) destinations.

Scan ICMP Mask No
Reply Cnt

SCAN_ICMP_NETMASK_ NO_RESPONSE_
COUNTER

Number of distinct ICMP Netmask
Request destinations that did not reply
to a request.

Scan ICMP Mask
Request Cnt

SCAN_ICMP_NETMASK_ REQUEST_COUNTER Number of distinct ICMP Netmask
Request destinations detected.

Scan ICMP Mask Targets SCAN_ICMP_NETMASK_ TARGETS List of the detected ICMP Netmask
Request destinations.

Scan ICMP No Reply Cnt SCAN_ICMP_NO_RESPONSE_COUNTER Number of the distinct ICMP request
destinations for any of counted ICMP
requests (Echo Request, Timestamp
Request, Netmask Request) that did
not reply to a request.

Scan ICMP Request Cnt SCAN_ICMP_REQUEST_COUNTER Number of the distinct ICMP request
destinations for the counted ICMP
requests (Echo Request, Timestamp
Request, Netmask Request).

Scan ICMP Time No
Reply Cnt

SCAN_ICMP_TIMESTAMP_NO_RESPONSE_
COUNTER

Number of the distinct ICMP Timestamp
Request destinations that did not reply
to a request.
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Field Syslog export field Description

Scan ICMP Time Request
Cnt

SCAN_ICMP_TIMESTAMP_REQUEST_ COUNTER Number of the distinct ICMP Timestamp
Request destinations detected.

Scan ICMP Time Targets SCAN_ICMP_TIMESTAMP_TARGETS List of the detected ICMP Timestamp
Request destinations.

Scan Start Time SCAN_START_TIME The starting time of the detected port
scanning activity.

Scan TCP Negative Cnt SCAN_TCP_NEGATIVE_COUNTER Number of distinct TCP destinations
that denied attempted connections with
TCP RST.

Scan TCP Normal Cnt SCAN_TCP_NORMAL_COUNTER Number of distinct TCP destinations
with successful connection
establishment and bidirectional data
transfer.

Scan TCP No Ack Cnt SCAN_TCP_NO_ACK_COUNTER Number of distinct TCP destinations
targeted for illegal TCP segments.

Scan TCP No Ack
Targets

SCAN_TCP_NO_ACK_TARGETS List of TCP destinations targeted for
illegal TCP segments.

Scan TCP No Reply Cnt SCAN_TCP_NO_RESPONSE_COUNTER Number of distinct TCP destinations
that did not reply to connection
attempts.

Scan TCP Positive Cnt SCAN_TCP_POSITIVE_COUNTER Number of distinct TCP destinations
with successful connection
establishment but no data sent by the
client within the defined time limit.

Scan TCP Targets SCAN_TCP_TARGETS List of the detected TCP port scan
destinations.

Scan UDP Negative Cnt SCAN_UDP_NEGATIVE_COUNTER Number of distinct destinations
detected that replied with ICMP Port
Unreachable (successful scan of closed
UDP port).

Scan UDP Positive Cnt SCAN_UDP_POSITIVE_COUNTER Number of bi-directional UDP
conversations detected.

Scan UDP Probe Cnt SCAN_UDP_PROBE_COUNTER Number of destinations that did not
reply using UDP.

Scan UDP Target Cnt SCAN_UDP_TARGET_COUNTER Total number of UDP destinations
detected.

Scan UDP Targets SCAN_UDP_TARGETS List of the detected UDP destinations.

Sender NODE_ID IP address of the engine or server that
sent the log entry.

Sender module version SENDER_MODULE_VERSION Version of the engine module that
generated the event.

Sender type SENDER_TYPE The type of engine or server that sent
the log entry.

Service SERVICE Special field for filtering logs using the
defined services. Does not appear in
the log entry table.
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Severity ALERT_SEVERITY Severity of the situation related to the
alert event.

SIP call ID SIP_CALL_ID SIP call ID.

SIP contact address SIP_CONTACT SIP contact address.

SIP header field contents SIP_HEADER SIP header field contents.

SIP header field name SIP_HEADER_NAME SIP header field name.

SIP request method SIP_REQUEST_METHOD Method of the SIP request.

SIP request URI SIP_REQUEST_URI URI of the SIP request.

SIP request version SIP_REQUEST_VERSION Version of the SIP request.

SIP response reason-
phrase

SIP_RESPONSE_REASON_PHRASE SIP response reason-phrase.

SIP response status code SIP_RESPONSE_STATUS_CODE Status code of the SIP response.

SIP VIA address SIP_VIA SIP VIA address.

Situation SITUATION The identifier of the situation that
triggered the log event.

Situation Type SIT_CATEGORY The type of the situation that triggered
the log event.

SMTP command SMTP_COMMAND Suspicious SMTP command sent by the
client.

SMTP mail stats SMTP_MAIL_STATS Statistics on email messages.

SMTP misplaced
command

SMTP_MISPLACED_COMMAND Command given in the wrong place in
the command sequence.

SMTP recipient SMTP_RECIPIENT Recipient forward path in RCPT
command parameter.

SMTP reply SMTP_REPLY Suspicious SMTP reply message sent
by the server.

SMTP reverse path SMTP_REVERSE_PATH SMTP reverse path in MAIL FROM
command parameter.

SMTP server action SMTP_SERVER_ACTION Suspicious server action after a
suspicious client command.

SMTP server banner SMTP_SERVER_BANNER Banner sent by the SMTP server at the
beginning of the connection.

SMTP transaction state SMTP_TRANSACTION_STATE Session state of the SMTP transaction.

Source file SOURCE_FILE Name of the source file.

Source file line SOURCE_FILE_LINE Line number in the source file.

Source port PORT_SOURCE TCP or UDP source port in the packet
header. Included for backwards
compatibility with legacy IPS. For other
cases, see Src Port.

Src Addr SRC Packet source IP address.

Src Port SPORT TCP or UDP source port in the packet
header.
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Src VLAN SRC_VLAN The VLAN ID of the source VLAN.

SSH calc client crypto bit
ratio

SSH_CALC_CLIENT_CRYPTO_BIT_RATIO Calculated SSH client crypto bit ratio.

SSH calc server crypto bit
ratio

SSH_CALC_SERVER_CRYPTO_BIT_RATIO Calculated SSH server crypto bit ratio.

SSH1 host key bits SSH1_HOST_KEY_BITS Bit length of the SSHv1 host key.

SSH1 server key bits SSH1_SERVER_KEY_BITS Bit length of the SSHv1 server key.

Syslog SYSLOG_TYPE Syslog is a system service used in
some operating systems, for example,
UNIX- and software packages. For
more information about syslog and
syslog types, see RFC 3164.

Syslog Facility SYSLOG_FACILITY Syslog entry facility.

Syslog Level SYSLOG_LEVEL Syslog entry level.

Syslog Message SYSLOG_MSG Syslog entry message string.

Target IP IP_TARGET IPv4 address of the target host in a
detected attack.

TCP connection start time TCP_CONNECTION_START_TIME Start time of the TCP connection.

TCP handshake seen TCP_HANDSHAKE_SEEN Initial handshake of the TCP connection
detected.

TCP option kind TCP_OPTION_KIND Type of the TCP option.

TCP option length TCP_OPTION_LENGTH Length of the TCP option that caused
the response.

To address SIP_TO SIP To address.

UDP datagram size UDP_DATAGRAM_SIZE Size of the UDP datagram.

Vulnerability References VULNERABILITY_REFERENCES References to known vulnerabilities in a
vulnerability database. Generated from
situation and original situation.

Whole session seen WHOLE_SESSION_SEEN True if no data of this session has been
missed up to this point.

Exportable IPS recording log entry fields
IPS recording log entry fields are described in the following table. Because the fields are exportable, the table
includes the syslog export field.

The following log entry fields are included in log data when you export IPS traffic recordings.

Table 194: IPS recording log entry fields

Field Syslog export field Description

Component ID COMP_ID The identifier of the creator of the log entry.

Creation Time TIMESTAMP Log entry creation time.
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Packet data PACKET_DATA Recorded packet data.

Record frame cached RECORD_FRAME_CACHED Marker showing that this frame was received before the
recording was started. The frame included in the recording
was taken from a memory cache.

Record ID RECORD_ID (IPS and IPS
recording only)

Identifier of the traffic recording.

Sender NODE_ID IP address of the engine or server that sent the log entry.

Facility field values
The following table lists the possible values for the Facility field in the log table.

Table 195: Facility field values

Value

Accounting

Antispam

Antivirus

Authentication

Blacklisting

Browser based authentication

Cluster Daemon

Cluster Protocol

Connection Tracking

Data eXchange Layer

Data Synchronization

DHCP Client

DHCP Relay

DHCP Service

DNS

Dynamic routing

Endpoint Intelligence Agent

File Filtering

GTI

IGMP Proxy

Inspection

Invalid
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Value

IPsec

Key Management Server

License

Load-Balancing Filter

Log Server

Logging System

Management

Monitoring

NetLink Incoming HA

Network Address Translation

Packet Filter

Protocol Agent

Radius Forwarder

Sandbox

Server Pool

SNMP Monitoring

SSL VPN Portal

SSL VPN Session Manager

SSL VPN Tunnel

SSM Proxy

State Synchronization

Syslog

System

Tester

Undefined

User Agent

User Defined

Wireless Access Point
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Type field values
The following table lists the possible values for the Type field in the log table.

Table 196: Type field values

Value

Critical Error

Debug high

Debug low

Debug mid

Diagnostic

Emergency - System Unusable

Error

Informational

Internal max

Max

Notification

System Alert

Undefined

Warning

Action field values
The following table shows the most common log occurrences for the Action field.

Table 197: Action field values

Action Description

Allow A connection was allowed through the engine. This can be:

• A new connection.

• Related connection (for example, an FTP data connection).

• Related packet (for example ICMP error messages related to an earlier TCP connection).

• New connection through an existing VPN tunnel.

Discard A connection or packet was discarded by the engine.

Permit A connection was allowed through according to the Inspection Rules on the engine.

Refuse A connection was refused by the engine.

Terminate A connection was terminated by the engine.

Terminate (failed) An attempt to terminate a connection failed.
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Action Description

Terminate (passive) A connection matched a rule with the passive Terminate action, and a log entry indicating that the
connection would have been terminated was produced.

Terminate (reset) A connection was terminated by the engine and TCP resets were sent to both communicating
hosts.

Wait for Authentication A connection was waiting for successful user authentication before it could continue.

Wait for Further
Actions

A connection was waiting for some other action before it could continue.

Wait for RPC Reply A connection was waiting for an RPC reply before it could continue.

Event field values
The following table shows the most common log occurrences for the Event field.

Table 198: Event field values

Event Description

Allowed a connection from blacklister A connection from a blacklister was allowed.

Application protocol version is not
supported

The application protocol version used in the traffic is not supported.

Application protocol version not
recognized

The application protocol version used in the traffic was not recognized.

Authentication error There was an error in the user authentication process.

Authentication failed A user did not successfully authenticate.

Authentication Server does not respond There is no response from the legacy Stonesoft Authentication Server component.

Authentication succeeded A user successfully authenticated.

Automatic online transition An engine automatically went online.

Automatic standby transition An engine automatically went to standby.

Blacklister not allowed The component that attempted to send a blacklist request is not on the list of
Allowed Blacklisters.

Blacklisting connection closed A connection from a blacklister was closed.

Blacklisting entries flushed All entries were removed from the engine's blacklist.

Blacklisting entry deleted An entry was removed from the engine's blacklist.

Blacklisting entry expired A blacklisting entry reached the end of its Duration time.

Can't connect to Log Server The engine is unable to connect to the Log Server.

Configuration changed The engine's configuration changed.

Configuration information for this
connection

The engine's configuration at the time the connection was logged.

Connection closed A connection was closed.

Connection Discarded A connection was discarded by the engine.
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Event Description

Connection Queued A connection was queued according to the QoS rules.

Connection redirected to Proxy Server A connection was redirected to a proxy service.

Connection Refused A connection was refused by the engine.

Connection Terminated A connection was terminated by the engine.

Data connection redirected to Proxy
Server

A data connection was redirected to a proxy service.

DHCP message received A DHCP message was received.

DHCP Relay address not configured,
reply discarded

A DHCP reply was discarded because no DCHP address is configured for the
engine.

DHCP Relay address spoofed, request
discarded

A DHCP request was discarded because the DHCP relay address was regarded
as spoofed.

DHCP reply received A DHCP reply was received.

DHCP reply sent A DHCP reply was sent.

DHCP request forwarded A DHCP request was forwarded.

DHCP request received A DHCP request was received.

DHCP request sent A DHCP request was sent.

Dropped AH packet An IPsec AH packet was dropped.

Dropped ESP packet An IPsec ESP packet was dropped.

Error in receiving a new configuration There was an error when trying to transfer a new configuration to the engine.

Error with Proxy Server There was an error when attempting to redirect a connection to a proxy service.

Failed to allow a related connection to
open

The engine failed to open a related connection for a connection that had already
been allowed.

Force offline by test failure The engine was forced offline as the result of an automated test failing.

Going locked offline by command An administrator commanded the engine to go to the locked offline state.

Going locked online by command An administrator commanded the engine to go to the locked online state.

Going offline by command An administrator commanded the engine to go offline.

Going offline by test failure The engine went offline as the result of an automated test failing.

Going online by command An administrator commanded the engine to go online.

Going standby by command An administrator commanded the engine to go to standby.

Hybrid authentication done Hybrid authentication successfully completed.

Hybrid authentication failed Hybrid authentication failed.

Incomplete connection closed A connection for which the TCP handshake did not complete was closed.

Internal engine error An internal error occurred on the engine.

Internal error An internal error occurred.

Invalid license The engine has an invalid license.

Invalid properties of custom Protocol
Agent

Invalid options have been configured for a custom Protocol Agent.
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IPsec authentication error An error occurred in IPsec authentication.

IPsec client cfg download done The configuration for an IPsec VPN Client has finished downloading.

IPsec client cfg download failed An attempt to download the configuration for an IPsec VPN Client failed.

IPsec client cfg download from The configuration for an IPsec VPN Client was downloaded by the client at the
source address.

IPsec IKE error There was an error in the IKE negotiation for an IPsec VPN.

LDAP Server does not respond An LDAP Server is not responding.

License exceeded A throughput-based license was exceeded.

Log spool corrupted The data in the engine's log spool partition has become corrupted.

Log spool is becoming full The engine's log spool partition is becoming full.

New blacklisting entry A new entry was added to the engine's blacklist.

New configuration successfully installed A new configuration was installed on the engine.

New connection A new connection was allowed through the engine.

New VPN connection A new connection through an existing VPN tunnel was allowed.

No space left on device The engine's hard drive is full.

No suitable NAT rule found No NAT rule matched a connection.

No suitable NAT rule found for related
connection

No NAT rule matched a related connection.

Node booted An engine node booted up.

Node down An engine node is down.

Node up An engine node is up.

Oversized DHCP message discarded An excessively large DHCP message was discarded.

Packet Discarded A packet was discarded by the engine.

Packet too long A packet was too long.

Packet too short A packet was too short.

Receive ICMP echo An ICMP echo (ping) was received.

Related Connection A related connection was allowed through the engine. For example, an FTP data
connection.

Related Packet A related packet was allowed through the engine. For example, ICMP error
messages related to an earlier TCP connection.

Requested NAT cannot be done There was an error when applying NAT to the traffic.

Security Policy reload New security policy is loaded on the engine.

Send ICMP echo An ICMP echo (ping) was sent.

Sending DHCP reply failed The engine failed to send a DHCP reply.

Sending DHCP request failed The engine failed to send a DHCP request.

Sending sync messages The engine is sending synchronization messages.

Server pool member went offline A Server Pool member went offline.
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Event Description

Server pool member went online A Server Pool member went online.

SSL Handshake failed An SSL handshake failed.

Starting hybrid authentication Hybrid authentication started.

Starting IKE initiator negotiation KE initiator negotiation started.

Starting IKE responder negotiation IKE responder negotiation started.

State sync communication failure State synchronization communication between cluster nodes failed.

State sync configuration changed The configuration of the synchronization communication between cluster nodes
changed.

Unknown DCHP Relay error An unknown error occurred in DHCP relay.

Unrecognized protocol A protocol in the logged traffic was not recognized.

Went locked offline The engine went to the locked offline state.

Went locked online The engine went to the locked online state.

Went offline The engine went offline.

Went online The engine went online.

Went standby The engine went to standby.

A successful engine logon causes an event that is displayed in the Logs view with the following type of message
in the Info Message field:

date time login[id]:USERNAME LOGIN on ‘device’

A failed logon causes an info message of the following type:

date time login[id]:FAILED LOGIN (#) on ‘device’ FOR ‘UNKNOWN’

IPsec VPN log messages
These tables list the most common IPsec VPN log messages (Facility=IPsec).

The messages listed appear in the Information Message fields of logs as information or error messages. The
Situation field in some of the logs contains similar messages.

Note:  Some messages can only be seen when the IPsec diagnostics are enabled during the VPN
negotiations.

Related reference
VPN notifications on page 1500
VPN errors on page 1501
VPN error codes on page 1503
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VPN notifications
The following table lists messages that are seen in the logs as part of normal IPsec VPN operation.

Table 199: Common IPsec VPN messages in normal operation

Information message Description

SA traffic selectors local: [...] This message is visible only when IPsec diagnostics are enabled.

The first message generated when new VPN negotiations are triggered.
Negotiation of a new VPN tunnel follows.

IKE SA proposal [...] This message is visible only when IPsec diagnostics are enabled.

Shows the proposal that the initiator in the negotiations sent to the responder
(displayed in both roles).

Starting IKE main mode initiator
negotiation

Starting IKE main mode responder
negotiation

The beginning of IKE negotiations (in main mode).

Which message is displayed depends on whether the gateway is the initiator or
the responder in the negotiation.

Repeated negotiations for the same connection are normal in a Multi-Link
environment.

IKE Phase-1 initiator done [...]

IKE Phase-1 responder done [...]

IKE Phase-1 negotiations were successfully completed, Phase-2 negotiations
begin.

Which message is displayed depends on whether the gateway is the initiator or
the responder in the negotiation.

IKE Phase-2 initiator done [...]

IKE Phase-2 responder done [...]

IKE Phase-2 negotiations were successfully completed. The VPN tunnel is now
established and ESP or AH messages should appear shortly.

Which message is displayed depends on whether the gateway is the initiator or
the responder in the negotiation.

Starting Hybrid Authentication Hybrid authentication is started for an IPsec VPN client user.

Hybrid Authentication Done Hybrid authentication succeeded for an IPsec VPN client user.

IKE SA import succeeded

IPsec SA import succeeded

This message is visible only when IPsec diagnostics are enabled.

Synchronization of Phase 1 (IKE) and Phase 2 (IPsec) information between
clustered firewall engines was successful.

ESP [...]

AH [...]

Encrypted traffic going through the VPN tunnel. When you enable IPsec
diagnostics, you might see more of these messages.

Unknown IKE cookie This message is visible only when IPsec diagnostics are enabled.

The other gateway identified an SA that does not exist on this node. If this is
a cluster, this message is normal when the SA has been negotiated with a
different node. The correct SA is then queried from the other nodes, allowing the
connection to continue.

This message can also appear if the SA has been deleted, for example, because
of a timeout or dead peer detection (DPD).

Sending delete notification [...]

Delete notification received [...]

This message is visible only when IPsec diagnostics are enabled.

Messages between the gateways forming the tunnel informing the other party that
the gateway has removed the settings indicated in the message. As a result, the
other gateway also clears the settings, allowing for renegotiations if the tunnel is
still needed.
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Information message Description

Sending IKE SA delete sync

Receiving IKE SA expire/delete sync

This message is visible only when IPsec diagnostics are enabled.

Synchronization of SA deletion information between clustered firewall engines.

Initial contact notification received The gateway at the other end of the tunnel has sent an Initial-Contact message
(indicating that it has no knowledge of previous negotiations). If there are old SAs
with the gateway, they are deleted (recently negotiated SAs are not, as might be
indicated by a further log message). If SAs exist, the notification may indicate that
the other end has been cleared, for example, in a reboot.

VPN errors
The following table lists common errors that indicate problems in an IPsec VPN tunnel.

The log messages inform you about the stage of negotiations and then give the actual error message, for
example, “IKE Phase-2 error: No proposal chosen.” The table lists only the actual message part without more
variable details such as IP addresses or identifiers.

Table 200: Common IPsec VPN errors

Error message Description

Access group mismatch The connecting VPN client is not authorized.

Authentication failed One of the parties rejected the authentication credentials or something went
wrong during the authentication process. If the problem is not apparent in the
available logs, activate diagnostics to generate more verbose logs that give you
more information about the next negotiations.

Authentication method mismatch The authentication method used by the other gateway is not allowed in the
configuration of this gateway. Check the settings in the VPN Profile that is
selected for this VPN.

Cannot get policy [...] No matching
connection

Might indicate that the gateway has no valid VPN certificate.

Can not get QM policy [...] Indicates that there is a mismatch in granularity settings between the negotiating
gateways.

In the Firewall/VPN, granularity is controlled with the Security Association
Granularity setting on the IPsec Settings tab of the VPN Profile.

Could not allocate inbound SPI

Could not create outbound IPsec rule

Could not register outbound SPI

Old outbound SPI entry not found

Out of memory

SA install failed

Session attaching failed

Transform creation failed

Indications that the gateway has run out of memory. The reason for this might
be inappropriate configuration settings (such as using the "SA per host" setting
with a very large number of hosts) in addition to other reasons (such as hardware
specifications).

Dead peer detection failed

IKE peer was found dead [...]

Dead peer detection checks the other gateway periodically when the VPN is
established. If no response is received, the VPN tunnel is closed. Indicates that
the other gateway is down, unreachable, or considers the VPN tunnel already
closed.
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Encapsulation mode mismatch Encapsulation modes (AH or ESP) did not match between gateways.

IKE error notify received: [...] This message is visible only when IPsec diagnostics are enabled.

The other gateway has sent the error notification that is shown in this message.

IKE negotiation rate-limit reached,
discard connection

This message is visible only when IPsec diagnostics are enabled.

There is an excessive number of new VPN connection attempts within a short
period of time. This mechanism is meant to protect the firewall from certain types
of denial-of-service attacks.

Invalid argument

Invalid syntax

Generic error. Check the other log messages for more useful information. If the
problem is not apparent in the available logs, activate diagnostics to generate
more verbose logs that give you more information about the next negotiations.

IPsec SA proposal not accepted This message is visible only when IPsec diagnostics are enabled.

The VPN gateway at the other end of the tunnel sent a proposal that the Firewall/
VPN gateway could not accept. This message includes information about the
rejected proposal and a further log message should contain information about the
Firewall/VPN's local proposal.

NAT-T is not allowed for this peer This message is visible only when IPsec diagnostics are enabled.

NAT-T was requested by the other gateway but it is not allowed in the
configuration of the gateway that sends this message.

No proposal chosen IKE negotiations failed. If the problem is not apparent in the available logs,
activate diagnostics to generate more verbose logs that give you more information
about the next negotiations.

Payload malformed [...] Most likely due to a mismatch in preshared keys between the initiator and the
responder. The reason might also be corruption of packets in transit.

Peer IP address mismatch The IP address of the other gateway uses is not configured as a VPN gateway
end-point on this gateway.

Proposal did not match policy There is a mismatch in the configurations of the two negotiating parties.

Remote address not allowed A VPN client is trying to use an IP address that is out of the allowed address
range. Make sure that all valid IP addresses are actually included in the range of
allowed addresses for VPN Gateway and check the DHCP server configuration.

Remote ID mismatch

Remote identity [...] used in IKE
negotiation doesn't match to policy [...]

The IKE Phase 1 ID defined for the external VPN gateway in the SMC is different
from the ID with which the gateway actually identified itself. The ID and its type
are set for each tunnel End-Point in the properties of the external Gateway. Note
that if an IP address is used as identity, the IP address used as the identity can be
different from the IP address used for communications.

SA unusable Usually means that an SA is being deleted when some new traffic arrives to use
the tunnel.

Sending error notify: [...] This message is visible only when IPsec diagnostics are enabled.

Negotiations have failed and the Firewall/VPN is sending the error notification that
is shown in this message to the other gateway.

SPD doesn't allow connection [...] Most likely indicates that the Site definitions do not match the IP addresses
used. Check the addresses included under the Sites for both Gateways, and
also that the translated addresses are included under the Site, if NAT is used for
communications inside the VPN.

Timed out Indicates connection problems or that the other end has deleted the SA that the
Firewall/VPN is using in the negotiation. Check the logs at the other end to see if
the connection makes it through.
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Traffic selector mismatch There is a mismatch in the configurations of the two negotiating parties. You must
define a matching pair for all settings; double-check all settings at both ends.

Tunnel policy mismatch [...] This message is visible only when IPsec diagnostics are enabled.

Usually indicates that IKE negotiations failed because of a mismatch in the
configurations of the two negotiating parties.

Tunnel selection failed An Access rule matched this connection, but the traffic could not be sent across
the VPN. Most likely, this is due to the (possibly NATed) source or destination IP
address not being included in the local or remote gateway's Site as required. This
message also appears if a connection that is not intended for the VPN matches
the VPN rule. Inbound cleartext traffic can be allowed from the same addresses
as tunneled traffic with the Apply action in the VPN rule).

Tunnel type mismatch [...] This message is visible only when IPsec diagnostics are enabled.

Only site-to-site VPN or mobile VPN is configured, but the connecting device is of
the other type. For example, a VPN client tries to connect, but VPN client access
is not configured (correctly) on the gateway.

VPN error codes
Under some conditions, multiple IPsec VPN errors can be detected simultaneously and combined in a single log
message.

The most significant error is shown as text, and the other detected errors are indicated using a combined (with
bitwise OR) hexadecimal error code.

IKE Phase-1 Initiator error: Proposal did not match policy (100002).

Here, the hexadecimal codes

00100000 for “Proposal did not match policy” and

00000002 for “Peer IP address mismatch”) produces the code

00100002 = 100002.

The following table lists codes that are valid for engine software versions 5.0 and later.

Table 201: Hexadecimal error codes in VPN log messages

Hex code Error message

00000020 Access group mismatch

00008000 Authentication method mismatch

00020000 Encapsulation mode mismatch

00000002 Peer IP address mismatch

00100000 Proposal did not match policy

00400000 Remote address not allowed

00000040 Traffic selector mismatch (local)

00000080 Traffic selector mismatch (remote)
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Hex code Error message

00200000 Tunnel type mismatch

00000200 Remote ID mismatch

00000100
00000004

00000001

Internal configuration-related problems. See the other messages to troubleshoot.

Audit entry types
The following table explains the audit entry types.

Table 202: Audit entry types

Type Definition

admin.attachLog.mgtserver A Log Server was associated with a Management Server.

admin.attachLog.webportalserver A Log Server was associated with a Web Portal Server.

admin.authenticationkey.change The authentication key of an API Client element was changed.

admin.changeIp.mgtserver The Management Server IP address changed.

dmin.changeMgtIp.logserver The Management Server IP address on the Log Server changed.

admin.changeMgtIp.webportalserver The Management Server IP address on the Web Portal Server changed.

admin.create A superuser administrator was created.

admin.defaultfiltercolors.change The default filter colors for an administrator were changed.

admin.disabled An administrator was disabled.

admin.enabled An administrator was enabled.

admin.enginepassword.change An administrator's engine password changed.

admin.login An administrator logged on to the Management Server.

admin.logout An administrator logged out from the Management Server.

admin.password.change An administrator's password changed.

admin.permission.change Permissions for an administrator changed.

admin.sendmessage.disabled The sending of messages was disabled.

admin.sendmessage.enabled The sending of messages was enabled.

admin.update The properties of an Administrator account were changed.

alert.ack.policy An active alert was automatically acknowledged according to the Alert Policy.

alert.ack.user An administrator acknowledged an active alert.

alert.policy.upload A policy was uploaded to the Log Server.

alert.test A test alert was sent.

archive.export An administrator ran a script to export an archive.
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Type Definition

audit.start The Audit Service started.

audit.stop The Audit Service stopped.

backup.create A backup was created on the server where the audit entry was created.

backup.delete A backup was deleted from the server where the audit entry was created.

backup.restore A backup was restored io the server where the audit entry was created.

ca.certificate.download An Internal Certificate Authority was uploaded to an engine.

ca.certificate.stoptrusting An engine was commanded to stop trusting an Internal Certificate Authority.

certificate.delete A certificate was deleted.

certificate.export A certificate was exported.

certificate.generate A certificate was generated.

certificate.import A certificate was imported.

certificate.signed A certificate was signed.

crypto.start Cryptographic functions started.

database.migrate The database of the Log Server was migrated.

database.password.change The database password of the server where the audit entry was created was
changed.

diff.start An XML comparison started.

diff.stop An XML comparison ended.

engine.initial.contact An engine performed initial contact to the Management Server.

engine.initial.generate The initial configuration was generated for an engine.

engine.upgrade.end An engine upgrade ended.

engine.upgrade.start An engine upgrade started.

export.start An export operation started.

firewall.diagnostic Diagnostic mode was selected for a Firewall.

firewall.policy.upload A policy was uploaded to a Firewall.

firewall.reset.database The user database on the firewall was reset.

gui.lock The Management Client window was locked due to inactivity.

gui.unlock The Management Client was unlocked.

ha.sync A Management Server retrieved a database backup in a high-availability
environment.

https.certificate.request An HTTPS certificate request was created.

import.start An import operation started.

import.stop An import operation ended.

incident.attachment.add An attachment was added to an Incident Case.

incident.attachment.remove An attachment was removed from an Incident Case.

incident.attachment.update An attachment for an Incident Case was updated.
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Type Definition

incident.player.add A player was added to an Incident Case.

incident.player.remove A player was removed from an Incident Case.

incident.player.update A player attached to an Incident Case was updated.

installserver.log An initial configuration for an engine was uploaded to the Installation
Server or an engine sent logs to the Installation Server in plug-and-play
configuration.

installserver.trace An engine sent traces to the Installation Server in plug-and-play
configuration.

ips.policy.upload A policy was uploaded to an IPS engine.

license.activate A license file or a license component was activated.

license.delete A license component was deleted.

license.install A license was installed.

log.browse An administrator performed a query in the Logs view.

log.forward The current log forwarding rules were saved when saving the Log Server
element.

log.forward.deleted A log forwarding rule was deleted.

log.forward.new A log forwarding rule was added.

logdatamanager.abort A scheduled task was aborted in the Log Server.

logdatamanager.complete A scheduled task was completed in the Log Server.

logdatamanager.start An administrator manually started a task.

logpruningfilter.apply A pruning filter was applied to the Log Server.

logpruningfilter.delete A pruning filter was deleted from the Log Server.

logpruningfilter.refresh After a Log Server reconnected to the Management Server, all pruning filters
were retrieved on the Management Server and reapplied.

logreception.start The log reception process started.

logreception.stop The log reception process ended.

logserver.certify The Log Server was certified.

mgtserver.blacklist The Management Server added a blacklist entry to a Firewall.

mgtserver.blacklist.flush The Management Server removed all blacklist entries from a Firewall.

mgtserver.certify The Management Server was certified.

mgtserver.ha.activation A Management Server was set to active in a high-availability environment.

mgtserver.ha.exclusion A Management Server was excluded or included in database replication in a
high-availability environment.

mgtserver.ha.replication A Management Server is executing a full database replication in a high-
availability environment.

mgtserver.smc_api.enabled The SMC API was enabled.

mgtserver.smc_api.disabled The SMC API was disabled.

mgtserver.unblacklist The Management Server removed a blacklist entry from a Firewall.
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Type Definition

mgtserver.update.activation A dynamic update package was activated.

mgtserver.update.download A dynamic update package was downloaded.

mgtserver.update.import A dynamic update package was imported.

mgtserver.update.update_server_availability The availability of the update server for dynamic update packages and
engine upgrade images changed.

mgtserver.upgrade.download An engine upgrade image was downloaded.

mgtserver.upgrade.import An engine upgrade image was imported.

mgtserver.web_start.disabled Web Start was disabled for the Management Server.

mgtserver.web_start.enabled Web Start was enabled for the Management Server.

object.delete An object was deleted.

object.insert A new object was added.

object.move An object was moved to another Domain.

object.update An object was updated or saved.

password.verification An administrator entered an incorrect password.

policy.upload.end A policy upload ended.

policy.upload.start A policy upload started.

report.preview A Report was previewed.

report.print A Report was printed.

securityengine.policy.upload A policy was uploaded on an NGFW Engine.

server.migrate The data of a server was migrated.

server.sginfo An sgInfo package was created.

server.start A Log Server was started.

server.stop A Log Server was stopped.

session.terminated The Management Client session was terminated due to inactivity.

trash.add An element was sent to the trash.

trash.undelete An element was restored from the trash.

trusted.certificate.validation.failure TLS certificate validation failed.

trusted.connection.end A TLS connection ended.

trusted.connection.failure A TLS connection failed.

trusted.connection.start A TLS connection started.

vpn.certificate.request A VPN certificate request was created.

vpn.certificate.sign A VPN certificate was signed.

vpn.configuration.export A VPN Client configuration file was exported.

vpn.psk.create A pre-shared key was added in a VPN tunnel.

vpn.psk.delete A pre-shared key was removed from a VPN tunnel.

vpn.psk.modify A pre-shared key was removed from a VPN tunnel.
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Type Definition

webportal.log.browse The filtering or the data type in the Web Portal Log Browser was changed.

webportal.log.pdf The Log Details were viewed as a PDF from the Web Portal Log Browser.

webportal.report.pdf A Report was printed as a PDF from the Web Portal.

webportal.report.preview A Report was previewed as HTML from the Web Portal.

Syslog entries
The following table presents the categories for messages that appear in log entries sent to an external syslog
server.

Table 203: Syslog entries

Value

Clock daemon for BSD systems

Clock daemon for System V systems

File transfer protocol

Kernel messages

Line printer subsystem

Mail system

Messages generated internally by syslogd

Network news subsystem

Network time protocol

Random user-level messages

Security/authorization messages

Security/authorization messages (private)

System daemons

UUCP subsystem

Connection states
The following states are used in the State column in the Connections view and (in part) in the Logs view with info
messages or logs on the closing of connections.

They reflect the standard states regarding the initiation and termination of TCP connections as seen by the
firewall in the transmissions. The following table lists the possible states.
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Table 204: Connection states

State Description

CP established Forcepoint NGFW cluster protocol packet is recognized.

ICMP echo Ping reply is expected.

ICMP reply wait Other ICMP request or reply types.

Invalid The communication has violated the protocol.

IPsec established IPsec tunnel packet is recognized.

New New connection is being opened.

Related New connection related to an existing one is expected soon.

Remove Connection cannot be physically removed yet.

Remove soon Expecting to still see some packets (multiple reset packet), so delaying the removal for a few
seconds. Eliminates unnecessary packet filtering and possible logging of dropped packets.

TCP close wait One end of the connection waits for the FIN packet (passive close).

TCP close wait ack Waiting for ACK for the FIN before going to close wait status (passive close).

TCP closing Closing packet (FIN) sent by one end of the connection (simultaneous).

TCP closing ack Waiting for ACK for the FIN before going to closing status (active close).

TCP established Normal status of TCP connections for data transfer.

TCP fin wait 1 One end of the connection waits for sending the FIN packet (active close).

TCP fin wait 2 One end of the connection waits for receiving ACK packet.

TCP last ack One end of the connection sent a FIN packet (passive close).

TCP last ack wait Waiting for the FIN packet to be acknowledged.

TCP syn ack seen Second phase of the TCP three-way handshake, the server has replied to client sent SYN
with SYN+ACK, next status will be established.

TCP syn fin seen T/TCP (Transactional TCP) connection, RFC 1644.

TCP syn return Received simultaneous SYN from the other end (simultaneous open).

TCP syn seen First packet sent by one end of the connection.

TCP time wait One end of the connection acknowledged closing packet (FIN).

TCP time wait ack Waiting for ACK for the FIN status before going to time wait status (active close).

UDP established UDP connection is recognized.

Unknown established Connection from other transport level protocol.
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Keyboard shortcuts
Contents

• General shortcuts on page 1511
• Shortcuts for browsing logs and alerts on page 1512
• Other view-specific shortcuts on page 1513

The keyboard shortcut reference describes the available shortcut keys in the Management Client.

Most of these shortcuts are also shown in the menus of the Management Client next to each menu item that has a
shortcut.

General shortcuts
The following table lists general shortcuts that are available in most views in the Management Client.

Table 205: General shortcuts

Action Shortcut

Bookmark all tabs Ctrl+Shift+D

Bookmark current view Ctrl+D

Cancel Escape

Close tab Ctrl+W

Close view Ctrl+Q

Close window ALT+F4

Collapse all folders in element tree Ctrl+NumPad /

Copy Ctrl+C

Cut Ctrl+X

Delete, Remove Delete

Expand all folders in element tree Ctrl+NumPad *

Go up/down/left/right Up/down/left/right arrow key

Manage bookmarks Ctrl+B

Maximize/Restore Ctrl+M

Move element to Trash Delete

Move to home level in element tree F12, Alt+Up arrow key



 Forcepoint Next Generation Firewall 6.4 | Product Guide

Keyboard shortcuts | 1512

Action Shortcut

Move to parent folder in element tree Backspace

Open action in new tab Ctrl+left mouse click

Open action in new window Shift+left mouse click

Open a new tab Ctrl+T

Open a new window Ctrl+N

Open current view in new tab Ctrl+Shift+T

Open current view in new window Ctrl+Shift+N

Open help topics F1

Open Info pane Shift+F1

Open list of view-specific tools Alt+T

Open Logs view Ctrl+1

Open shared properties of selected engines Ctrl+R

Open properties of the selected element Ctrl+R

Open sidebar F4

Paste Ctrl+V

Print Ctrl+P

Refresh F5

Save Ctrl+S

Search Ctrl+F

Search references Ctrl+G

Select all Ctrl+A

Start quick search Enter

Switch between open tabs Ctrl+Tab

Shortcuts for browsing logs and alerts
The following table explains the shortcuts available for browsing different types of logs in the Audit, Blacklist,
Connections, and Logs views.

Table 206: Keyboard shortcuts in log browsing views

Context Action Shortcut

Audit view, Logs view Abort query Escape

Audit view, Logs view Acknowledge selected alert Space

Audit view, Logs view Apply query Ctrl+Enter
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Context Action Shortcut

Audit view, Logs view Cancel query Shift+Escape

Audit view, Logs view Select columns Ctrl+L

Audit view, Logs view Current Events mode on/off F11

Audit view, Logs view Decrease text size Ctrl+Shift+Minus

Audit view, Logs view Go to first log record Ctrl+Home

Audit view, Logs view Go to last log record Ctrl+End

Audit view, Logs view Increase text size Ctrl+Shift+Plus

Audit view, Logs view Jump backward in timeline Ctrl+Page Up

Audit view, Logs view Jump forward in timeline Ctrl+Page Down

Audit view, Logs view Open Columns menu Alt+C

Audit view, Logs view Refresh statistics F6

Audit view, Logs view Scroll horizontally Left/Right arrow key

Audit view, Logs view Scroll one page up/down Page Up/Page Down

Audit view, Logs view Scroll up and down Up/Down arrow key

Audit view, Logs view Normal text size Ctrl+Shift+Zero

Audit view, Logs view Zoom in on timeline Ctrl+Plus

Audit view, Logs view Zoom out on timeline Ctrl+Minus

Blacklist view, Connections view Pause F7

Blacklist view, Connections view Play F11

Blacklist view Remove entry Delete

Connections view Terminate connection Delete

Details view Go to next log record Ctrl+Page Down

Details view Go to previous log record Ctrl+Page Up

Query pane Apply query Ctrl+Enter

Query pane Cancel query Shift+Escape

Other view-specific shortcuts
The following table lists other useful shortcuts that are available in different views in the Management Client.

Table 207: Other keyboard shortcuts

Context Action Shortcut

Active Alerts view Acknowledge all active alerts Ctrl+Space
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Context Action Shortcut

Diagram Editor Zoom in Ctrl+Plus

Diagram Editor Zoom out Ctrl+Minus

Diagram Editor, Policy Editing view Redo Ctrl+Y

Diagram Editor, Policy Editing view Undo Ctrl+Z

Diagram Editor, Policy Editing view,
VPN Editing view

Close editor Shift+Escape

Diagram Editor, Policy Editing view,
VPN Editing view

Start editing Ctrl+E

Incident Case view, Journal tab Commit additional comment Ctrl+Enter

Info pane Open/close Info pane Ctrl+Space

Logging Profile view, General tab Toggle a Comment section Ctrl+T

Logging Profile view, General tab Toggle an Ignore field CTRL+I

Overviews view, Reports view Revert to last saved version Shift+Escape

Policy Editing view Add rule after Ctrl+Insert

Policy Editing view Clear cell Delete

Policy Editing view Collapse all Comment Rule
sections

Shift+Minus

Policy Editing view Collapse Comment Rule section/
sub-policy section

Left arrow key

Policy Editing view Copy rule Ctrl+C

Policy Editing view Cut rule Ctrl+X

Policy Editing view Delete rule Ctrl+Delete

Policy Editing view Edit cell F2

Policy Editing view Expand all Comment Rule sections Shift+Plus

Policy Editing view Expand Comment Rule section/
subpolicy section

Right arrow key

Policy Editing view Move rule down Alt+Down arrow key

Policy Editing view Move rule up Alt+Up arrow key

Policy Editing view Paste rule Ctrl+V

Policy Editing view Search for next matching rule F3

Policy Editing view Search for previous matching rule Shift+F3
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 Appendix K

Multicasting
Contents

• Multicasting vs. unicasting or broadcasting on page 1515
• Overview of IP Multicasting on page 1516
• Internet Group Management Protocol and how it works on page 1517
• Ethernet multicasting on page 1517
• Multicasting and Forcepoint NGFW Firewalls on page 1518

The multicasting reference describes the general principles of multicasting and how it can be used with CVIs (cluster
virtual IP addresses) in Firewall Clusters.

Note:  Use the Packet Dispatch CVI mode instead of multicast CVIs as it uses unicast and requires
no additional switch or router configuration. The other CVI modes are provided mainly for backward
compatibility.

Multicasting vs. unicasting or
broadcasting

Multicasting differs in certain important respects from unicasting and broadcasting as a transmission technique.

A distinction can be made between multicasting traffic at the network layer (based on special class D IP
addresses) and at the data link layer (based on multicast MAC addresses). The general differences how
multicasting can be distinguished from unicasting and broadcasting are highlighted in the following sections.

Multicasting vs. unicasting
In unicasting, the transmitted datagrams are intended only for a single host having a unique address. In
multicasting, the data is transmitted likewise to a single address (that is, the multicast group address), but the
actual data reaches all hosts that belong to the group identified by the multicast address. This way the data
needs only to be sent once, and not separately to each host. This naturally saves bandwidth.

Multicasting vs. broadcasting
In broadcasting, the data is sent from a host to other hosts within a given network, so they must all use their
resources to process the data. In contrast, in multicasting, the hosts that do not belong to a multicast group do
not have to use their resources for multicast data. Moreover, multicasting is not restricted to a single network.
Hosts on remote networks can receive IP multicast datagrams if they belong to a specific host group, and that
there are multicast routers forwarding the traffic. Thus, IP multicasting can in principle be used globally whereas
broadcasting is limited to a single network.
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Overview of IP Multicasting
In the RFC 1112, IP multicasting is defined as the transmission of an IP datagram to a group of hosts identified
by a single IP destination address.

In addition to this common multicast group address, the hosts in the group all have separate and unique unicast
addresses. The actual multicast host group can consist of any number of hosts, possibly even located in different
networks. The number can vary over time, as hosts can join in and leave from a group at any time. Moreover, a
particular host can belong to several groups simultaneously.

The multicast group addresses are class D addresses. They are identified by the high-order initial four-bit
sequence 1110. In the dotted decimal notation, the multicast group address range runs from 224.0.0.0 to
239.255.255.255. There are certain special addresses:
• 224.0.0.0 is never assigned.
• 224.0.0.1 is assigned to the permanent group of all hosts, including gateways, in the local network.
• 224.0.0.2 is assigned to all local multicast routers.

Multicast IP addresses are not allowed to be used as source addresses. A multicast source address implies
forging of an IP address.

The multicast groups are either permanent or transient. Permanent groups have administratively assigned IP
addresses, while the addresses of the transient multicast groups can be assigned dynamically from the pool
of multicast addresses not reserved for permanent groups. The IP address of an established permanent group
persists even if the group would not have any members at a given time. The transient groups cease to exist as
soon as they no longer have member hosts, and the assigned multicast address is released.

See, for example, http://www.iana.org/assignments/multicast-addresses for a list of addresses registered with
IANA.

How Multicasting can be used with
applications
Multicasting is a viable option for many types of transmissions.

Multicasting is widely used in local area networks for various purposes. Moreover, multicasting can be used
both for receiving a publicly transmitted session on an intranet, or for transmitting an internal communication to a
public network (for example, for announcing a product launch). Multicasting is particularly important solution for
bandwidth-intensive applications, such as multimedia. The most typical protocol for multicast traffic is UDP.

Multicasting can be a suitable solution, for example, for the following applications:
• Work groups, electronic whiteboards.
• Video/voice-over-IP conferences.
• Real-time streaming media (for example, Internet radio).
• File transfer.
• Spreading of any information to certain selected destinations.

http://www.iana.org/assignments/multicast-addresses


 Forcepoint Next Generation Firewall 6.4 | Product Guide

Multicasting  | 1517

Internet Group Management Protocol
and how it works

Internet Group Management Protocol (IGMP) is an integral part of Internet Protocol.

The IGMP messages are encapsulated in IP datagrams. IGMP is used both between hosts and multicast routers,
and between multicast routers. It keeps multicast routers informed of the multicast group memberships on a given
local network. Each host supporting multicasting must join the multicast group with the address 224.0.0.1 on each
network interface at the initialization time. They shall remain members of this group as long as they are active.
With IGMP, the hosts on a LAN can inform the routers that they want to be able to receive multicast messages
from external networks.

How membership messages are used with
IGMP
Multicast routers use IGMP for enquiring periodically which multicast groups have members in the connected
local networks.

This inquiry is carried out by sending Host Membership Query messages to the all-hosts address 224.0.0.1. The
hosts receiving the query respond by sending Host Membership Reports to all neighboring multicast routers.

A host joining a new group immediately transmits a report, instead of waiting for a query. When a host wants to
stop receiving a multicast transmission, it sends a Leave Report message with the destination address 224.0.0.2
to all subnet routers. A router receiving a Leave Report message sends in response a Group Specific Query
to the multicast address to check whether there still are hosts in that group. In case no response is received,
multicasting to that address is stopped.

Ethernet multicasting
When multicasting is implemented at the data link layer, stations are identified by their Media Access Control
(MAC) addresses as well as their network level IP addresses.

So far we have seen how multicasting is implemented at the network layer and how multicast IP addresses differ
from other types of IP addresses. In addition, we must also distinguish multicasting at the data link layer where
stations are identified, not only by their network level IP addresses, but also by their MAC addresses. As opposed
to unicast and broadcast addresses, the relation of multicast addressing to IP addressing applies also at this
level.

Most local area network (LAN) topologies allow for multicasting by using a group addressing scheme. Some
topologies offer better support for multicasting than others. In Ethernet (as defined in IEEE 802.3), all MAC
addresses that have the least significant bit of the most significant byte as “1” are multicast addresses. Thus, for
example, 01:00:00:00:00:00 and 49:aa:bb:cc:dd:ee are both multicast MAC addresses; while 02:00:00:00:00:00
and fe:fe:fe:fe:fe:fe are not. The devices with a given multicast MAC defined are able to listen to all traffic sent to
that particular MAC address.

A specific subset of MAC addresses is reserved for mapping the IP multicasting addresses to data link layer
addresses. In Ethernet, the multicast MAC addresses that correspond to multicast IP addresses range from
01:00:5e:00:00:00 to 01:00:5e:7f:ff:ff.
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Multicasting and Forcepoint NGFW
Firewalls

After distinguishing between network layer multicasting and data link layer multicasting, we can now have a look
at how the firewall uses multicasting and unicasting.

Note:  Use the Packet Dispatch CVI mode instead of multicast CVIs as it uses unicast and
requires no additional switch or router configuration. The other CVI modes are provided mainly for
backward compatibility.

When using clustering technology, the clustered firewall nodes share a common unicast IP address, which is
called a CVI (cluster virtual IP address). This shared IP address is assigned to the node that receives traffic that
arrives from the network for distributing and load-balancing between all nodes. Any traffic that has a specific
node in the cluster as its final destination (such as management connections) is sent to NDIs (node dedicated IP
addresses).

CVIs allow the cluster to appear as a single virtual entity to other network devices, rather than a group of
individual nodes. Traffic addressed to CVIs is load-balanced between the nodes according to the cluster’s load-
balancing filters. The load-balancing filters determine which traffic is distributed to which individual nodes. This
way, a specific node in a cluster handles all packets in the connection as long as the node stays online.

In addition to the shared unicast IP address, each node must also share a data link layer address (MAC) at the
CVI. Only this way will each of the nodes be provided with the exact same traffic. There are different options for
the cluster-wide MAC address, and the selection depends on the features of the other connected networking
devices, such as switches and hubs. This document is not a definitive reference for different types of switch
configurations, but it gives an overview of possible considerations when implementing firewall clusters in different
types of network environments.

The method can be selected based on the surrounding network devices. Unicast MAC configuration can be used
with hubs and with switches that support sending a specified unicast MAC address to several ports at the same
time. When a layer2 network is not able to do this, multicast MAC can be used instead. Since send all packets to
all ports anyway, unicast MAC mode gives better performance with hubs. However, in large networks with large
amounts of traffic, the action of sending packets to all ports can create extra load. In that situation, static MAC
address forwarding tables can be used to limit traffic to Cluster multicast MAC to cluster ports only. With switches
that do not support static MAC address forwarding tables, IGMP snooping can be used for the same task. With
switches, Packet Dispatch mode creates less load to switches than unicast MAC or multicast MAC modes.

The different configuration options are presented in the following sections.

Unicast MAC
A common unicast MAC can be defined at the CVIs if the cluster is connected to hubs or switches that can
forward frames with a unicast destination to multiple ports.

This way the network devices forward the same packets to each of the connected firewall nodes sharing this
combination of unicast IP and MAC addresses. This mode is recommended whenever the networking devices
support sending packets to a specified unicast MAC address to a predefined set of ports at the same time (as
opposed to one port, which is typically the default). Hubs by default support this; however, with switches this
is not as frequent, and they usually need additional configuration. With unicast MAC, only the switches directly
connected to the cluster need special configuration.
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Note:  Unlike multicast MAC addresses, there can be only one unicast MAC address defined per
Interface ID. Thus, all NDIs and the unicast CVIs on the same physical interface use the same
MAC address.

In addition to the common CVI IP address, each node can optionally have unique unicast IP addresses defined
at the same physical interface as the CVI. These unicast IP addresses are assigned to NDIs (node dedicated
IP addresses), and used when an individual node is the endpoint of a connection. Since there can only be one
unicast MAC address at a given interface, also the node-specific NDI IP addresses are mapped to the common
unicast MAC.

The following illustration exemplifies the IP and MAC address configuration of a cluster’s interfaces that are
connected to an external network. By default, the CVI of each node share one unicast IP address. The CVI is
mapped to a common unicast MAC address. In addition, for each node, an NDI is defined at the same physical
interface as the CVI. The NDI IP addresses are unique, but they all are mapped to the same unicast MAC as the
CVI IP address, as there can be only one unicast MAC defined for a physical interface. Traffic directed from the
Internet to the cluster’s external CVI IP address is sent by the connected switch or hub to all nodes, since they all
are identified by the same unicast MAC.

 
Figure 182: CVI with unicast MAC

Multicast MAC
In case it is not feasible to use a switch that works in unicast mode with clusters, a shared multicast MAC can be
defined for the cluster nodes.

Most switches support this mode, however, not all switches in the same virtual LAN (VLAN) need to be
configured. By default, most switches send packets with a multicast MAC address to all ports connected to the
same VLAN. If the size of the VLAN is small, this type of flooding is acceptable. However, with larger VLANs
performance problems can occur as the device needs to send each packet to each port connected to the same
VLAN. In some switches, it’s possible to prevent this type of flooding by statically restricting multicast traffic with a
given MAC address to some predefined ports only.

Note:  Some networking devices discard ARP replies specifying a multicast MAC. In this case,
static ARP entries must be used.
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The following illustration presents an example where a common multicast MAC is configured for all cluster nodes.
For instance, if a switch is not able to send packets with the same unicast MAC to multiple ports, this type of
configuration might be used. Each node has also a unique unicast MAC address mapped to the corresponding IP
addresses defined at the NDIs.

 
Figure 183: CVI with multicast MAC

Multicast MAC with IGMP
Internet Group Management Protocol (IGMP) can be used in combination with multicast MAC addresses to avoid
flooding with switches that do not support statically defined destinations for multicast.

In this mode, switches are configured to send multicast traffic only to the ports from which they have received
IGMP Host Membership Report messages corresponding to the MAC address in question. Multicast with
IGMP must be selected as the mode for the cluster, and IGMP snooping enabled on the switch. For the IGMP
messaging, a common multicast IP address for the cluster nodes should be specified. The multicast MAC
address is then computed automatically based on it. Do note, however, that the CVIs are still identified solely
by the common unicast IP address; the multicast IP address is only used as the source address for the IGMP
messages sent to the switch.

Note:  Some routers that use router redundancy protocols such as HSRP or VRRP listen to all
multicast traffic in addition to the routing-related traffic. Thus, multicast packets are rerouted to the
network. To prevent the rerouting, you can either configure the router to send this traffic only to
the cluster ports or define the router’s access control list (ACL) to drop all incoming packets with
the cluster’s multicast MAC.
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TCP/IP protocol headers
Contents

• Internet Protocol on page 1521
• Internet Control Message Protocol on page 1522
• Transmission Control Protocol on page 1522
• User Datagram Protocol on page 1523

Some common TCP/IP protocol headers can be used.

Internet Protocol
For information about Internet Protocol (IP) headers, see the following table.

For the IP specification, see RFC791 available at http://www.rfc-editor.org.

Table 208: IP datagram

bits 0–7 bits 8–15 bits 16–23 bits 24–31

Version

(4 bits)

IP Header Length

(4 bits)

Type of Service

(8 bits)

Total Length

(in number of bytes)
(16 bits)

IP Identification Number

(16 bits)

Flags

(3 bits)

Fragment Offset

(13 bits)

Time to Live

(8 bits)

Protocol Number

(8 bits)

Header Checksum

(16 bits)

Source IP Address

(32 bits)

Destination IP Address

(32 bits)

Options (if any)

+

Padding (matching to 32-bit boundary)

( data . . . )

http://www.rfc-editor.org
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Internet Control Message Protocol
For information about Internet Control Message Protocol (ICMP) headers, see the following table.

For the ICMP specification, see RFC792 available at http://www.rfc-editor.org.

Table 209: ICMP message

bits 0–7 bits 8–15 bits 16–23 bits 24 - 31

Type

(8 bits)

Code

(8 bits)

Checksum

(16 bits)

(data . . . )

Transmission Control Protocol
For information about Transmission Control Protocol (TCP) headers, see the following table.

For the TCP specification, see RFC793 available at http://www.rfc-editor.org.

Table 210: TCP datagram

bits 0–7 bits 8–15 bits 16–23 bits 24–31

Source Port Number

(16 bits)

Destination Port Number

(16 bits)

Sequence Number

(32 bits)

Acknowledgment Number

(32 bits)

TCP
Header
Length

(4 bits)

Reserved

(6 bits)

URG ACK PSH RST SYN FIN Window Size

(16 bits)

Checksum

(16 bits)

Urgent Pointer

(16 bits)

Options (if any)

+

Padding (matching to 32-bit boundary)

( data . . . )

http://www.rfc-editor.org
http://www.rfc-editor.org
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User Datagram Protocol
For information about User Datagram Protocol (UDP) headers, see the following table.

For the UDP specification, see RFC768 available at http://www.rfc-editor.org.

Table 211: UDP Datagram

bits 0–7 bits 8–15 bits 16–23 bits 24–31

Source Port Number

(16 bits)

Destination Port Number

(16 bits)

User Datagram Length

(16 bits)

Checksum

(16 bits)

( data . . . )

http://www.rfc-editor.org
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 Appendix M

ASCII character codes
Contents

• ASCII character codes on page 1525
• ASCII control codes on page 1529

The decimal and hexadecimal values of the ASCII characters are presented for interpreting traffic captures and
predefined Situation Contexts.

ASCII character codes
In the following table, you can view the decimal and hexadecimal values for each ASCII character code.

Table 212: ASCII character codes

ASCII Dec Hex

NUL 0 0x00

SOH 1 0x01

STX 2 0x02

ETX 3 0x03

EOT 4 0x04

ENQ 5 0x05

ACK 6 0x06

BEL 7 0x07

BS 8 0x08

HT 9 0x09

LF 10 0x0A

VT 11 0x0B

FF 12 0x0C

CR 13 0x0D

SO 14 0x0E

SI 15 0x0F

DLE 16 0x10

DC1 17 0x11
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ASCII Dec Hex

DC2 18 0x12

DC3 19 0x13

DC4 20 0x14

NAK 21 0x15

SYN 22 0x16

ETB 23 0x17

CAN 24 0x18

EM 25 0x19

SUB 26 0x1A

ESC 27 0x1B

FS 28 0x1C

GS 29 0x1D

RS 30 0x1E

US 31 0x1F

SPACE 32 0x20

! 33 0x21

" 34 0x22

# 35 0x23

$ 36 0x24

% 37 0x25

& 38 0x26

' 39 0x27

( 40 0x28

) 41 0x29

* 42 0x2A

+ 43 0x2B

, 44 0x2C

- 45 0x2D

. 46 0x2E

/ 47 0x2F

0 48 0x30

1 49 0x31

2 50 0x32
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ASCII Dec Hex

3 51 0x33

4 52 0x34

5 53 0x35

6 54 0x36

7 55 0x37

8 56 0x38

9 57 0x39

: 58 0x3A

; 59 0x3B

< 60 0x3C

= 61 0x3D

> 62 0x3E

? 63 0x3F

@ 64 0x40

A 65 0x41

B 66 0x42

C 67 0x43

D 68 0x44

E 69 0x45

F 70 0x46

G 71 0x47

H 72 0x48

I 73 0x49

J 74 0x4A

K 75 0x4B

L 76 0x4C

M 77 0x4D

N 78 0x4E

O 79 0x4F

P 80 0x50

Q 81 0x51

R 82 0x52

S 83 0x53
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ASCII Dec Hex

T 84 0x54

U 85 0x55

V 86 0x56

W 87 0x57

X 88 0x58

Y 89 0x59

Z 90 0x5A

[ 91 0x5B

\ 92 0x5C

] 93 0x5D

^ 94 0x5E

_ 95 0x5F

` 96 0x60

a 97 0x61

b 98 0x62

c 99 0x63

d 100 0x64

e 101 0x65

f 102 0x66

g 103 0x67

h 104 0x68

i 105 0x69

j 106 0x6A

k 107 0x6B

l 108 0x6C

m 109 0x6D

n 110 0x6E

o 111 0x6F

p 112 0x70

q 113 0x71

r 114 0x72

s 115 0x73

t 116 0x74
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ASCII Dec Hex

u 117 0x75

v 118 0x76

w 119 0x77

x 120 0x78

y 121 0x79

z 122 0x7A

{ 123 0x7B

| 124 0x7C

} 125 0x7D

~ 126 0x7E

DELETE 127 0x7F

ASCII control codes
In the following table, you can view a hexadecimal value and a description for each ASCII control code.

Table 213: ASCII control codes

ASCII ASCII Control Codes Hex Description

NUL 0 0x00 Null

SOH 1 0x01 Start of Heading

STX 2 0x02 Start of Text

ETX 3 0x03 End of Text

EOT 4 0x04 End of Transmission

ENQ 5 0x05 Enquiry

ACK 6 0x06 Acknowledge

BEL 7 0x07 Bell

BS 8 0x08 Backspace

HT 9 0x09 Horizontal Tabulation

LF 10 0x0A Line Feed

VT 11 0x0B Vertical Tabulation

FF 12 0x0C Form Feed

CR 13 0x0D Carrier Return

SO 14 0x0E Shift Out
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ASCII ASCII Control Codes Hex Description

SI 15 0x0F Shift In

DLE 16 0x10 Data Line Escape

DC1 17 0x11 Device Control 1

DC2 18 0x12 Device Control 2

DC3 19 0x13 Device Control 3

DC4 20 0x14 Device Control 4

NAK 21 0x15 Negative Acknowledge

SYN 22 0x16 Synchronous Idle

ETB 23 0x17 End of Transmission Block

CAN 24 0x18 Cancel

EM 25 0x19 End of Medium

SUB 26 0x1A Substitute

ESC 27 0x1B Escape

FS 28 0x1C File Separator

GS 29 0x1D Group Separator

RS 30 0x1E Record Separator

US 31 0x1F Unit Separator
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